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     [bookmark: pgfId-998217]About This Guide 
      
      
 
     
 
 
    [bookmark: pgfId-1022646]This guide applies to the Cisco ASA series. Throughout this guide, the term “ASA” applies generically to supported models, unless specified otherwise.
 
     
      
    
 
    
 
    [bookmark: pgfId-1033889]Note ASDM supports many ASA versions. The ASDM documentation and online help includes all of the latest features supported by the ASA. If you are running an older version of ASA software, the documentation might include features that are not supported in your version. Similarly, if a feature was added into a maintenance release for an older major or minor version, then the ASDM documentation includes the new feature even though that feature might not be available in all later ASA releases. Please refer to the feature history table for each chapter to determine when features were added. For the minimum supported version of ASDM for each ASA version, see Cisco ASA Series Compatibility. 
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1009667][bookmark: 59628]Related Documentation
 
    [bookmark: pgfId-1009670]For more information, see Navigating the Cisco ASA Series Documentation at http://www.cisco.com/go/asadocs.
 
   
 
    
     [bookmark: pgfId-1028120][bookmark: 76447]Conventions
 
    [bookmark: pgfId-1028121]This document uses the following conventions:
 
    [bookmark: pgfId-1028167]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1028124]Convention 
         
  
        	 
          
          [bookmark: pgfId-1028126]Indication 
         
  
       
 
        
        	[bookmark: pgfId-1028128]bold font
  
        	[bookmark: pgfId-1028130]Commands and keywords and user-entered text appear in bold font.
  
       
 
        
        	[bookmark: pgfId-1028132]italic font
  
        	[bookmark: pgfId-1028134]Document titles, new or emphasized terms, and arguments for which you supply values are in italic font.
  
       
 
        
        	[bookmark: pgfId-1028136][ ]
  
        	[bookmark: pgfId-1028138]Elements in square brackets are optional.
  
       
 
        
        	[bookmark: pgfId-1028140]{x | y | z }
  
        	[bookmark: pgfId-1028142]Required alternative keywords are grouped in braces and separated by vertical bars.
  
       
 
        
        	[bookmark: pgfId-1028144][ x | y | z ]
  
        	[bookmark: pgfId-1028146]Optional alternative keywords are grouped in brackets and separated by vertical bars.
  
       
 
        
        	[bookmark: pgfId-1028148]string
  
        	[bookmark: pgfId-1028150]A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.
  
       
 
        
        	[bookmark: pgfId-1028152]courier font
  
        	[bookmark: pgfId-1028154]Terminal sessions and information the system displays appear in courier font.
  
       
 
        
        	[bookmark: pgfId-1029444]courier bold font
  
        	[bookmark: pgfId-1029464]Commands and keywords and user-entered text appear in bold courier font.
  
       
 
        
        	[bookmark: pgfId-1029446]courier italic font
  
        	[bookmark: pgfId-1029476]Arguments for which you supply values are in courier italic font.
  
       
 
        
        	[bookmark: pgfId-1028156]< >
  
        	[bookmark: pgfId-1028158]Nonprinting characters such as passwords are in angle brackets.
  
       
 
        
        	[bookmark: pgfId-1028160][ ]
  
        	[bookmark: pgfId-1028162]Default responses to system prompts are in square brackets.
  
       
 
        
        	[bookmark: pgfId-1028164]!, #
  
        	[bookmark: pgfId-1028166]An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1028168]Note Means reader take note.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1028169]Tip Means the following information will help you solve a problem. 
 
     
     
 
    
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1028170] 
     Caution Means 
     reader be careful. In this situation, you might perform an action that could result in equipment damage or loss of data. 
      
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1034771][bookmark: 70056][bookmark: 74565]Obtaining Documentation and Submitting a Service Request
 
    [bookmark: pgfId-1034772]For information on obtaining documentation, using the Cisco Bug Search Tool (BST), submitting a service request, and gathering additional information, see What’s New in Cisco Product Documentation.
 
    [bookmark: pgfId-1034774]Toreceivenew and revised Ciscotechnical content directly to your desktop, you can subscribeto theWhat’s New in Cisco Product DocumentationRSS feed. The RSS feeds are a free service.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1160826][bookmark: 85373]Configuring a Service Policy 
      
      
 
     
 
 
    [bookmark: pgfId-1502721]Service policies provide a consistent and flexible way to configure ASA features. For example, you can use a service policy to create a timeout configuration that is specific to a particular TCP application, as opposed to one that applies to all TCP applications. A service policy consists of multiple service policy rules applied to an interface or applied globally.
 
    [bookmark: pgfId-1204847]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1163987]Information About Service Policies
 
     	 [bookmark: pgfId-1163991]Licensing Requirements for Service Policies
 
     	 [bookmark: pgfId-1163995]Guidelines and Limitations
 
     	 [bookmark: pgfId-1163999]Default Settings
 
     	 [bookmark: pgfId-1174865]Task Flows for Configuring Service Policies
 
     	 [bookmark: pgfId-1521082]Adding a Service Policy Rule for Through Traffic
 
     	 [bookmark: pgfId-1521086]Adding a Service Policy Rule for Management Traffic
 
     	 [bookmark: pgfId-1521090]Managing the Order of Service Policy Rules
 
     	 [bookmark: pgfId-1164011]Feature History for Service Policies
 
    
 
   
 
    
     [bookmark: pgfId-1162692][bookmark: 63027]Information About Service Policies[bookmark: marker-1162691]
 
    [bookmark: pgfId-1162693]This section describes how service policies work and includes the following topics:
 
     
     	 [bookmark: pgfId-1167761]Supported Features
 
     	 [bookmark: pgfId-1162697]Feature Directionality
 
     	 [bookmark: pgfId-1162701]Feature Matching Within a Service Policy
 
     	 [bookmark: pgfId-1162705]Order in Which Multiple Feature Actions are Applied
 
     	 [bookmark: pgfId-1162709]Incompatibility of Certain Feature Actions
 
     	 [bookmark: pgfId-1162713]Feature Matching for Multiple Service Policies
 
    
 
     
      [bookmark: pgfId-1167296][bookmark: 32993]Supported Features
 
     [bookmark: pgfId-1167301]Table 1-1 lists the features supported by service policy rules[bookmark: marker-1167300].
 
     [bookmark: pgfId-1167398]
 
      
       
        
        [bookmark: pgfId-1167305]Table 1-1 [bookmark: 55752] Service Policy Rule Features
 
        
        
         
         	 
           
           [bookmark: pgfId-1167309]Feature 
          
  
         	 
           
           [bookmark: pgfId-1470591]For Through Traffic? 
          
  
         	 
           
           [bookmark: pgfId-1470593]For Management Traffic? 
          
  
         	 
           
           [bookmark: pgfId-1167311]See: 
          
  
        
 
         
         	[bookmark: pgfId-1167313]Application inspection (multiple types)
  
         	[bookmark: pgfId-1470595]All except RADIUS accounting
  
         	[bookmark: pgfId-1470597]RADIUS accounting only
  
         	 
           
           	 [bookmark: pgfId-1167317]Chapter10, “Getting Started with Application Layer Protocol Inspection”
 
           	 [bookmark: pgfId-1167321]Chapter11, “Configuring Inspection of Basic Internet Protocols”
 
           	 [bookmark: pgfId-1377088]Chapter12, “Configuring Inspection for Voice and Video Protocols”
 
           	 [bookmark: pgfId-1167325]Chapter13, “Configuring Inspection of Database and Directory Protocols”
 
           	 [bookmark: pgfId-1167329]Chapter14, “Configuring Inspection for Management Application Protocols”
 
           	 [bookmark: pgfId-1167333]Chapter25, “Configuring the ASA for Cisco Cloud Web Security”
 
          
  
        
 
         
         	[bookmark: pgfId-1167336]ASA CSC
  
         	[bookmark: pgfId-1470599]Yes
  
         	[bookmark: pgfId-1470601]No
  
         	[bookmark: pgfId-1167340]Chapter32, “Configuring the ASA CSC Module”
  
        
 
         
         	[bookmark: pgfId-1167343]ASA IPS
  
         	[bookmark: pgfId-1471173]Yes
  
         	[bookmark: pgfId-1471175]No
  
         	[bookmark: pgfId-1167347]Chapter31, “Configuring the ASA IPS Module”
  
        
 
         
         	[bookmark: pgfId-1377057]ASA CX
  
         	[bookmark: pgfId-1471181]Yes
  
         	[bookmark: pgfId-1471183]No
  
         	[bookmark: pgfId-1377062]Chapter30, “Configuring the ASA CX Module”
  
        
 
         
         	[bookmark: pgfId-1167350]NetFlow Secure Event Logging filtering
  
         	[bookmark: pgfId-1471189]Yes
  
         	[bookmark: pgfId-1471197]Yes
  
         	[bookmark: pgfId-1167354]“Configuring NetFlow Secure Event Logging (NSEL),” in the general operations configuration guide.
  
        
 
         
         	[bookmark: pgfId-1167357]QoS input and output policing
  
         	[bookmark: pgfId-1471267]Yes
  
         	[bookmark: pgfId-1471205]No
  
         	[bookmark: pgfId-1167362]Chapter23, “Configuring QoS”
  
        
 
         
         	[bookmark: pgfId-1167364]QoS standard priority queue
  
         	[bookmark: pgfId-1471269]Yes
  
         	[bookmark: pgfId-1471213]No
  
         	[bookmark: pgfId-1167369]Chapter23, “Configuring QoS”
  
        
 
         
         	[bookmark: pgfId-1167371]QoS traffic shaping, hierarchical priority queue
  
         	[bookmark: pgfId-1471219]Yes
  
         	[bookmark: pgfId-1471221]Yes
  
         	[bookmark: pgfId-1167376]Chapter23, “Configuring QoS”
  
        
 
         
         	[bookmark: pgfId-1167378]TCP and UDP connection limits and timeouts, and TCP sequence number randomization
  
         	[bookmark: pgfId-1471227]Yes
  
         	[bookmark: pgfId-1471229]Yes
  
         	[bookmark: pgfId-1167383]Chapter22, “Configuring Connection Settings”
  
        
 
         
         	[bookmark: pgfId-1167385]TCP normalization
  
         	[bookmark: pgfId-1471259]Yes
  
         	[bookmark: pgfId-1471237]No
  
         	[bookmark: pgfId-1167390]Chapter22, “Configuring Connection Settings”
  
        
 
         
         	[bookmark: pgfId-1167392]TCP state bypass
  
         	[bookmark: pgfId-1471261]Yes
  
         	[bookmark: pgfId-1471245]No
  
         	[bookmark: pgfId-1167397]Chapter22, “Configuring Connection Settings”
  
        
 
         
         	[bookmark: pgfId-1465275]User statistics for Identity Firewall
  
         	[bookmark: pgfId-1471251]Yes
  
         	[bookmark: pgfId-1471253]Yes
  
         	[bookmark: pgfId-1465277]See the user-statistics command in the command reference.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1162717][bookmark: 75445][bookmark: 85500][bookmark: 36183]Feature Directionality
 
     [bookmark: pgfId-1162718]Actions are applied to traffic bidirectionally or unidirectionally depending on the feature. For features that are applied bidirectionally, all traffic that enters or exits the interface to which you apply the policy map is affected if the traffic matches the class map for both directions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1162719]Note When you use a global policy, all features are unidirectional; features that are normally bidirectional when applied to a single interface only apply to the ingress of each interface when applied globally. Because the policy is applied to all interfaces, the policy will be applied in both directions so bidirectionality in this case is redundant.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1162730]Table 1-2 [bookmark: 68206]Feature Directionality
 
        
        
         
         	 
           
           [bookmark: pgfId-1162736]Feature 
          
  
         	 
           
           [bookmark: pgfId-1162738]Single Interface Direction 
          
  
         	 
           
           [bookmark: pgfId-1162740]Global Direction 
          
  
        
 
         
         	[bookmark: pgfId-1162742]Application inspection (multiple types)
  
         	[bookmark: pgfId-1162744]Bidirectional
  
         	[bookmark: pgfId-1162746]Ingress
  
        
 
         
         	[bookmark: pgfId-1162748]ASA CSC
  
         	[bookmark: pgfId-1162750]Bidirectional
  
         	[bookmark: pgfId-1162752]Ingress
  
        
 
         
         	[bookmark: pgfId-1376384]ASA CX
  
         	[bookmark: pgfId-1376390]Bidirectional
  
         	[bookmark: pgfId-1376392]Ingress
  
        
 
         
         	[bookmark: pgfId-1392002]ASA CX authentication proxy
  
         	[bookmark: pgfId-1392008]Ingress
  
         	[bookmark: pgfId-1392014]Ingress
  
        
 
         
         	[bookmark: pgfId-1162754]ASA IPS
  
         	[bookmark: pgfId-1162756]Bidirectional
  
         	[bookmark: pgfId-1162758]Ingress
  
        
 
         
         	[bookmark: pgfId-1162760]NetFlow Secure Event Logging filtering
  
         	[bookmark: pgfId-1162762]N/A
  
         	[bookmark: pgfId-1162764]Ingress
  
        
 
         
         	[bookmark: pgfId-1162766]QoS input policing
  
         	[bookmark: pgfId-1162768]Ingress
  
         	[bookmark: pgfId-1162770]Ingress
  
        
 
         
         	[bookmark: pgfId-1162772]QoS output policing
  
         	[bookmark: pgfId-1162774]Egress
  
         	[bookmark: pgfId-1162776]Egress
  
        
 
         
         	[bookmark: pgfId-1162778]QoS standard priority queue
  
         	[bookmark: pgfId-1162780]Egress
  
         	[bookmark: pgfId-1162782]Egress
  
        
 
         
         	[bookmark: pgfId-1162784]QoS traffic shaping, hierarchical priority queue
  
         	[bookmark: pgfId-1162786]Egress
  
         	[bookmark: pgfId-1162788]Egress
  
        
 
         
         	[bookmark: pgfId-1162790]TCP and UDP connection limits and timeouts, and TCP sequence number randomization
  
         	[bookmark: pgfId-1162792]Bidirectional
  
         	[bookmark: pgfId-1162794]Ingress
  
        
 
         
         	[bookmark: pgfId-1162796]TCP normalization
  
         	[bookmark: pgfId-1162798]Bidirectional
  
         	[bookmark: pgfId-1162800]Ingress
  
        
 
         
         	[bookmark: pgfId-1162802]TCP state bypass
  
         	[bookmark: pgfId-1162804]Bidirectional
  
         	[bookmark: pgfId-1162806]Ingress
  
        
 
         
         	[bookmark: pgfId-1465309]User statistics for Identity Firewall
  
         	[bookmark: pgfId-1465315]Bidirectional
  
         	[bookmark: pgfId-1465317]Ingress
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1162809][bookmark: 56325]Feature Matching Within a Service Policy
 
     [bookmark: pgfId-1162810]See the following information for how a packet matches rules in a policy for a given interface:
 
     [bookmark: pgfId-1162811] 1. A packet can match only one rule for an interface for each feature type.
 
     [bookmark: pgfId-1162815] 2. When the packet matches a rule for a feature type, the ASA does not attempt to match it to any subsequent rules for that feature type.
 
     [bookmark: pgfId-1162818] 3. If the packet matches a subsequent rule for a different feature type, however, then the ASA also applies the actions for the subsequent rule, if supported. See the “Incompatibility of Certain Feature Actions” section for more information about unsupported combinations.
 
      
       
     
 
     
 
     [bookmark: pgfId-1376457]Note Application inspection includes multiple inspection types, and most are mutually exclusive. For inspections that can be combined, each inspection is considered to be a separate feature.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1162823]For example, if a packet matches a rule for connection limits, and also matches a rule for an application inspection, then both actions are applied.
 
     [bookmark: pgfId-1162824]If a packet matches a rulefor HTTP inspection, but also matches another rule that includes HTTP inspection, then the second rule actions are not applied.
 
     [bookmark: pgfId-1376504]If a packet matches a rulefor HTTP inspection, but also matches another rule that includes FTP inspection, then the second rule actions are not applied because HTTP and FTP inspections cannpt be combined.
 
     [bookmark: pgfId-1376523]If a packet matches a rule for HTTP inspection, but also matches another rule that includes IPv6 inspection, then both actions are applied because the IPv6 inspection can be combined with any other type of inspection.
 
    
 
     
      [bookmark: pgfId-1162828][bookmark: 79823][bookmark: 21524]Order in Which Multiple Feature Actions are Applied
 
     [bookmark: pgfId-1162829]The order in which different types of actions in a service policy are performed is independent of the order in which the actions appear in the table.
 
      
       
     
 
     
 
     [bookmark: pgfId-1162830]Note NetFlow Secure Event Logging filtering and User statistics for Identity Firewall are order-independent.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1162831]Actions are performed in the following order:
 
     [bookmark: pgfId-1162832] 1. QoS input policing
 
     [bookmark: pgfId-1162833] 2. TCP normalization, TCP and UDP connection limits and timeouts, TCP sequence number randomization, and TCP state bypass.
 
      
       
     
 
     
 
     [bookmark: pgfId-1162837]Note When a the ASA performs a proxy service (such as AAA or CSC) or it modifies the TCP payload (such as FTP inspection), the TCP normalizer acts in dual mode, where it is applied before and after the proxy or payload modifying service.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1365931] 3. ASA CSC
 
     [bookmark: pgfId-1162839] 4. Application inspections that can be combined with other inspections:
 
     [bookmark: pgfId-1376742] a. IPv6
 
     [bookmark: pgfId-1376763] b. IP options
 
     [bookmark: pgfId-1376768] c. WAAS
 
     [bookmark: pgfId-1376574] 5. Application inspections that cannot be combined with other inspections. See the “Incompatibility of Certain Feature Actions” section for more information.
 
     [bookmark: pgfId-1365936] 6. ASA IPS
 
     [bookmark: pgfId-1376775] 7. ASA CX
 
     [bookmark: pgfId-1162870] 8. QoS output policing
 
     [bookmark: pgfId-1162871] 9. QoS standard priority queue
 
     [bookmark: pgfId-1162872] 10. QoS traffic shaping, hierarchical priority queue
 
    
 
     
      [bookmark: pgfId-1162874][bookmark: 24124]Incompatibility of Certain Feature Actions
 
     [bookmark: pgfId-1376888]Some features are not compatible with each other for the same traffic. The following list may not include all incompatibilities; for information about compatibility of each feature, see the chapter or section for your feature:
 
      
      	 [bookmark: pgfId-1376786]You cannot configure QoS priority queueing and QoS policing for the same set of traffic. 
 
      	 [bookmark: pgfId-1376798]Most inspections should not be combined with another inspection, so the ASA only applies one inspection if you configure multiple inspections for the same traffic. HTTP inspection can be combined with the Cloud Web Security inspection. Other exceptions are listed in the “Order in Which Multiple Feature Actions are Applied” section.
 
      	 [bookmark: pgfId-1376817]You cannot configure traffic to be sent to multiple modules, such as the ASA CX and ASA IPS.
 
      	 [bookmark: pgfId-1376834]HTTP inspection is not compatible with the ASA CX.
 
      	 [bookmark: pgfId-1376944]The ASA CX is not compatible with Cloud Web Security.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1404299]Note The Default Inspection Traffic traffic class, which is used in the default global policy, is a special CLI shortcut to match the default ports for all inspections. When used in a policy map, this class map ensures that the correct inspection is applied to each packet, based on the destination port of the traffic. For example, when UDP traffic for port 69 reaches the ASA, then the ASA applies the TFTP inspection; when TCP traffic for port 21 arrives, then the ASA applies the FTP inspection. So in this case only, you can configure multiple inspections for the same class map. Normally, the ASA does not use the port number to determine which inspection to apply, thus giving you the flexibility to apply inspections to non-standard ports, for example.

This traffic class does not include the default ports for Cloud Web Security inspection (80 and 443).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1162926][bookmark: 75382]Feature Matching for Multiple Service Policies
 
     [bookmark: pgfId-1162928]For TCP and UDP traffi[bookmark: marker-1162927]c (and ICMP when you enable stateful ICMP inspection), service policies operate on traffic flows, and not just individual packets. If traffic is part of an existing connection that matches a feature in a policy on one interface, that traffic flow cannot also match the same feature in a policy on another interface; only the first policy is used.
 
     [bookmark: pgfId-1162929]For example, if HTTP traffic matches a policy on the inside interface to inspect HTTP traffic, and you have a separate policy on the outside interface for HTTP inspection, then that traffic is not also inspected on the egress of the outside interface. Similarly, the return traffic for that connection will not be inspected by the ingress policy of the outside interface, nor by the egress policy of the inside interface.
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1535911]Model 
          
  
         	 
           
           [bookmark: pgfId-1535913]License Requirement 
          
  
        
 
         
         	[bookmark: pgfId-1535915]All models
  
         	[bookmark: pgfId-1535917]Base License.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1162949][bookmark: 58316]Guidelines and Limitations
 
     [bookmark: pgfId-1162950]This section includes the guidelines and limitations for this feature.
 
     [bookmark: pgfId-1162952][bookmark: 87419]Context Mode Guidelines
 
     [bookmark: pgfId-1162953]Supported in single and multiple context mode.
 
     [bookmark: pgfId-1162955][bookmark: 16807]Firewall Mode Guidelines
 
     [bookmark: pgfId-1162956]Supported in routed and transparent firewall mode.
 
     [bookmark: pgfId-1162957][bookmark: 91261]IPv6 Guidelines
 
     [bookmark: pgfId-1162958]Supports IPv6 for the following features:
 
      
      	 [bookmark: pgfId-1162959]Application inspection for DNS, FTP, HTTP, ICMP, ScanSafe, SIP, SMTP, IPsec-pass-thru, and IPv6.
 
      	 [bookmark: pgfId-1365946]ASA IPS
 
      	 [bookmark: pgfId-1376993]ASA CX
 
      	 [bookmark: pgfId-1162961]NetFlow Secure Event Logging filtering
 
      	 [bookmark: pgfId-1162962]TCP and UDP connection limits and timeouts, TCP sequence number randomization
 
      	 [bookmark: pgfId-1162963]TCP normalization
 
      	 [bookmark: pgfId-1162964]TCP state bypass
 
      	 [bookmark: pgfId-1465385]User statistics for Identity Firewall
 
     
 
     [bookmark: pgfId-1162965] Traffic Class Guidelines
 
     [bookmark: pgfId-1162966]The maximum number of traffic classes of all types is 255 in single mode or per context in multiple mode. Class maps include the following types:
 
      
      	 [bookmark: pgfId-1162967]Layer 3/4 class maps (for through traffic and management traffic).
 
      	 [bookmark: pgfId-1162968]Inspection class maps
 
      	 [bookmark: pgfId-1234484]Regular expression class maps
 
      	 [bookmark: pgfId-1234503] match commands used directly underneath an inspection policy map
 
     
 
     [bookmark: pgfId-1234504]This limit also includes default traffic classes of all types, limiting user-configured traffic classes to approximately 235. See the “Default Traffic Classes” section.
 
     [bookmark: pgfId-1162984]Service Policy Guidelines
 
      
      	 [bookmark: pgfId-1162985]Interface service policies take precedence over the global service policy for a given feature. For example, if you have a global policy with FTP inspection, and an interface policy with TCP normalization, then both FTP inspection and TCP normalization are applied to the interface. However, if you have a global policy with FTP inspection, and an interface policy with FTP inspection, then only the interface policy FTP inspection is applied to that interface.
 
      	 [bookmark: pgfId-1162986]You can only apply one global policy. For example, you cannot create a global policy that includes feature set 1, and a separate global policy that includes feature set 2. All features must be included in a single policy.
 
      	 [bookmark: pgfId-1465209]When you make service policy changes to the configuration, all  new connections use the new service policy. Existing connections continue to use the policy that was configured at the time of the connection establishment.  show command output will not include data about the old connections.
 
     
 
     [bookmark: pgfId-1465075]For example, if you remove a QoS service policy from an interface, then re-add a modified version, then the show service-policy command only displays QoS counters associated with new connections that match the new service policy; existing connections on the old policy no longer show in the command output.
 
     [bookmark: pgfId-1465076]To ensure that all connections use the new policy, you need to disconnect the current connections so they can reconnect using the new policy. See the clear conn or clear local-host commands.
 
    
 
     
      [bookmark: pgfId-1162989][bookmark: 26624]Default Settings[bookmark: marker-1162988]
 
     [bookmark: pgfId-1162990]The following topics describe the default settings for Modular Policy Framework:
 
      
      	 [bookmark: pgfId-1162994]Default Configuration
 
      	 [bookmark: pgfId-1162998]Default Traffic Classes
 
     
 
      
       [bookmark: pgfId-1163004][bookmark: 83876]Default Configuration
 
      [bookmark: pgfId-1163005]By default, the configuration includes a policy that matches all default application inspection traffic and applies certain inspections to the traffic on all interfaces (a global policy). Not all inspections are enabled by default. You can only apply one global policy, so if you want to alter the global policy, you need to either edit the default policy or disable it and apply a new one. (An interface policy overrides the global policy for a particular feature.)
 
      [bookmark: pgfId-1165578]The default policy includes the following application inspections:
 
       
       	 [bookmark: pgfId-1165579]DNS
 
       	 [bookmark: pgfId-1165580]FTP
 
       	 [bookmark: pgfId-1165581]H323 (H225)
 
       	 [bookmark: pgfId-1165582]H323 (RAS)
 
       	 [bookmark: pgfId-1165583]RSH
 
       	 [bookmark: pgfId-1165584]RTSP
 
       	 [bookmark: pgfId-1165585]ESMTP
 
       	 [bookmark: pgfId-1165586]SQLnet
 
       	 [bookmark: pgfId-1165587]Skinny (SCCP)
 
       	 [bookmark: pgfId-1165588]SunRPC
 
       	 [bookmark: pgfId-1165589]XDMCP
 
       	 [bookmark: pgfId-1165590]SIP
 
       	 [bookmark: pgfId-1165591]NetBios
 
       	 [bookmark: pgfId-1165592]TFTP 
 
       	 [bookmark: pgfId-1311081]IP Options
 
      
 
     
 
      
       [bookmark: pgfId-1163034][bookmark: 60796]Default Traffic Classes
 
      [bookmark: pgfId-1163038]The configuration includes a default traffic class that the ASA uses in the default global policy called Default Inspection Traffic; it matches the default inspection traffic. This class, which is used in the default global policy, is a special shortcut to match the default ports for all inspections. When used in a policy, this class ensures that the correct inspection is applied to each packet, based on the destination port of the traffic. For example, when UDP traffic for port 69 reaches the ASA, then the ASA applies the TFTP inspection; when TCP traffic for port 21 arrives, then the ASA applies the FTP inspection. So in this case only, you can configure multiple inspections for the same class map. Normally, the ASA does not use the port number to determine which inspection to apply, thus giving you the flexibility to apply inspections to non-standard ports, for example.
 
       
       	 [bookmark: pgfId-1521238]Task Flow for Configuring a Service Policy Rule
 
      
 
       
        [bookmark: pgfId-1521244][bookmark: 65943]Task Flow for Configuring a Service Policy Rule
 
       [bookmark: pgfId-1521245]Configuring a service policy consists of adding one or more service policy rules per interface or for the global policy. For each rule, you identify the following elements:
 
       
 
       [bookmark: pgfId-1521246]Step 1 Identify the interface to which you want to apply the rule, or identify the global policy.
 
       [bookmark: pgfId-1521247]Step 2 Identify the traffic to which you want to apply actions. You can identify Layer 3 and 4 through traffic.
 
       [bookmark: pgfId-1521248]Step 3 Apply actions to the traffic class. You can apply multiple actions for each traffic class.
 
       [bookmark: pgfId-1521249]
 
        
        
 
       
 
       
 
      
 
     
 
      
       [bookmark: pgfId-1521266][bookmark: 74622][bookmark: 11456]Adding a Service Policy Rule for Through Traffic
 
      [bookmark: pgfId-1521270]See the “Supported Features” section for more information. To add a service policy rule for through traffic, perform the following steps:
 
      
 
      [bookmark: pgfId-1521271]Step 1 Choose Configuration > Firewall > Service Policy Rules pane, and click Add.
 
       
       [image: ] 
      
 
       
        
      
 
      
 
      [bookmark: pgfId-1521277]Note When you click the Add button, and not the small arrow on the right of the Add button, you add a through traffic rule by default. If you click the arrow on the Add button, you can choose between a through traffic rule and a management traffic rule.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1521278]Step 2 In the Create a Service Policy and Apply To area, click one of the following options:
 
       
        
        	 [bookmark: pgfId-1521279] Interface . This option applies the service policy to a single interface. Interface service policies take precedence over the global service policy for a given feature. For example, if you have a global policy with FTP inspection, and an interface policy with TCP connection limits, then both FTP inspection and TCP connection limits are applied to the interface. However, if you have a global policy with FTP inspection, and an interface policy with FTP inspection, then only the interface policy FTP inspection is applied to that interface.
 
       
 
      
 
      [bookmark: pgfId-1521280] a. Choose an interface from the drop-down list.
 
      [bookmark: pgfId-1521281]If you choose an interface that already has a policy, then the wizard lets you add a new service policy rule to the interface.
 
      [bookmark: pgfId-1521282] b. If it is a new service policy, enter a name in the Policy Name field.
 
      [bookmark: pgfId-1521283] c. (Optional) Enter a description in the Description field.
 
      [bookmark: pgfId-1521284] d. (Optional) Check the Drop and log unsupported IPv6 to IPv6 traffic check box to generate a syslog (767001) for IPv6 traffic that is dropped by application inspections that do not support IPv6 traffic. By default, syslogs are not generated. For a list of inspections that support IPv6, see the “IPv6 Guidelines” section.
 
       
        
        	 [bookmark: pgfId-1521288] Global - applies to all interfaces . This option applies the service policy globally to all interfaces. By default, a global policy exists that includes a service policy rule for default application inspection. See the “Default Settings” section for more information. You can add a rule to the global policy using the wizard.
 
       
 
      
 
      [bookmark: pgfId-1521292] a. If it is a new service policy, enter a name in the Policy Name field.
 
      [bookmark: pgfId-1521293] b. (Optional) Enter a description in the Description field.
 
      [bookmark: pgfId-1521294] c. (Optional) Check the Drop and log unsupported IPv6 to IPv6 traffic check box to generate a syslog (767001) for IPv6 traffic that is dropped by application inspections that do not support IPv6 traffic. By default, syslogs are not generated. For a list of inspections that support IPv6, see the “IPv6 Guidelines” section.
 
      [bookmark: pgfId-1521298]Step 3 Click Next.
 
      [bookmark: pgfId-1521299]The Add Service Policy Rule Wizard - Traffic Classification Criteria dialog box appears.
 
      [bookmark: pgfId-1521300]Step 4 Click one of the following options to specify the traffic to which to apply the policy actions:
 
       
        
        	 [bookmark: pgfId-1521301] Create a new traffic class . Enter a traffic class name in the Create a new traffic class field, and enter an optional description.
 
       
 
      
 
      [bookmark: pgfId-1521302]Identify the traffic using one of several criteria:
 
      [bookmark: pgfId-1521303] – Default Inspection Traffic—The class matches the default TCP and UDP ports used by all applications that the ASA can inspect.
 
      [bookmark: pgfId-1521307]This option, which is used in the default global policy, is a special shortcut that when used in a rule, ensures that the correct inspection is applied to each packet, based on the destination port of the traffic. For example, when UDP traffic for port 69 reaches the ASA, then the ASA applies the TFTP inspection; when TCP traffic for port 21 arrives, then the ASA applies the FTP inspection. So in this case only, you can configure multiple inspections for the same rule (See the “Incompatibility of Certain Feature Actions” section for more information about combining actions). Normally, the ASA does not use the port number to determine the inspection applied, thus giving you the flexibility to apply inspections to non-standard ports, for example. 
 
      [bookmark: pgfId-1521329]See the “Default Settings and NAT Limitations” section for a list of default ports. The ASA includes a default global policy that matches the default inspection traffic, and applies common inspections to the traffic on all interfaces. Not all applications whose ports are included in the Default Inspection Traffic class are enabled by default in the policy map.
 
      [bookmark: pgfId-1521330]You can specify a Source and Destination IP Address (uses ACL) class along with the Default Inspection Traffic class to narrow the matched traffic. Because the Default Inspection Traffic class specifies the ports and protocols to match, any ports and protocols in the ACL are ignored.
 
      [bookmark: pgfId-1521331] – Source and Destination IP Address (uses ACL)—The class matches traffic specified by an extended ACL. If the ASA is operating in transparent firewall mode, you can use an EtherType ACL.
 
       
        
      
 
      
 
      [bookmark: pgfId-1521335]Note When you create a new traffic class of this type, you can only specify one access control entry (ACE) initially. After you finish adding the rule, you can add additional ACEs by adding a new rule to the same interface or global policy, and then specifying Add rule to existing traffic class on the Traffic Classification dialog box (see below).
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1521336] – Tunnel Group—The class matches traffic for a tunnel group to which you want to apply QoS. You can also specify one other traffic match option to refine the traffic match, excluding Any Traffic, Source and Destination IP Address (uses ACL), or Default Inspection Traffic.
 
      [bookmark: pgfId-1521337] – TCP or UDP Destination Port—The class matches a single port or a contiguous range of ports.
 
       
        
      
 
      
 
      [bookmark: pgfId-1521338]Tip For applications that use multiple, non-contiguous ports, use the Source and Destination IP Address (uses ACL) to match each port.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1521339] – RTP Range—The class map matches RTP traffic.
 
      [bookmark: pgfId-1521340] – IP DiffServ CodePoints (DSCP)—The class matches up to eight DSCP values in the IP header.
 
      [bookmark: pgfId-1521341] – IP Precedence—The class map matches up to four precedence values, represented by the TOS byte in the IP header.
 
      [bookmark: pgfId-1521342] – Any Traffic—Matches all traffic.
 
       
        
        	 [bookmark: pgfId-1521343] Add rule to existing traffic class . If you already have a service policy rule on the same interface, or you are adding to the global service policy, this option lets you add an ACE to an existing ACL. You can add an ACE to any ACL that you previously created when you chose the Source and Destination IP Address (uses ACL) option for a service policy rule on this interface. For this traffic class, you can have only one set of rule actions even if you add multiple ACEs. You can add multiple ACEs to the same traffic class by repeating this entire procedure. See the “Managing the Order of Service Policy Rules” section for information about changing the order of ACEs.
 
        	 [bookmark: pgfId-1521347] Use an existing traffic class. If you created a traffic class used by a rule on a different interface, you can reuse the traffic class definition for this rule. Note that if you alter the traffic class for one rule, the change is inherited by all rules that use that traffic class. If your configuration includes any  class-map commands that you entered at the CLI, those traffic class names are also available (although to view the definition of the traffic class, you need to create the rule).
 
        	 [bookmark: pgfId-1521348] Use class default as the traffic class . This option uses the class-default class, which matches all traffic. The class-default class is created automatically by the ASA and placed at the end of the policy. If you do not apply any actions to it, it is still created by the ASA, but for internal purposes only. You can apply actions to this class, if desired, which might be more convenient than creating a new traffic class that matches all traffic. You can only create one rule for this service policy using the class-default class, because each traffic class can only be associated with a single rule per service policy.
 
       
 
      
 
      [bookmark: pgfId-1521355]Step 5 Click Next.
 
      [bookmark: pgfId-1521356]Step 6 The next dialog box depends on the traffic match criteria you chose.
 
       
        
      
 
      
 
      [bookmark: pgfId-1521357]Note The Any Traffic option does not have a special dialog box for additional configuration.
 
       
       
 
      
 
      
 
       
        
        	 [bookmark: pgfId-1521358]Default Inspections—This dialog box is informational only, and shows the applications and the ports that are included in the traffic class.
 
        	 [bookmark: pgfId-1521359]Source and Destination Address—This dialog box lets you set the source and destination addresses:
 
       
 
      
 
      [bookmark: pgfId-1521360] a. Click Match or Do Not Match.
 
      [bookmark: pgfId-1521361]The Match option creates a rule where traffic matching the addresses have actions applied. The Do Not Match option exempts the traffic from having the specified actions applied. For example, you want to match all traffic in 10.1.1.0/24 and apply connection limits to it, except for 10.1.1.25. In this case, create two rules, one for 10.1.1.0/24 using the Match option and one for 10.1.1.25 using the Do Not Match option. Be sure to arrange the rules so that the Do Not Match rule is above the Match rule, or else 10.1.1.25 will match the Match rule first.
 
      [bookmark: pgfId-1521362] b. In the Source field, enter the source IP address, or click the ... button to choose an IP address that you already defined in ASDM.
 
      [bookmark: pgfId-1521363]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.
 
      [bookmark: pgfId-1521364]Enter any to specify any source address.
 
      [bookmark: pgfId-1521365]Separate multiple addresses by a comma.
 
      [bookmark: pgfId-1521366] c. In the Destination field, enter the destination IP address, or click the ... button to choose an IP address that you already defined in ASDM.
 
      [bookmark: pgfId-1521367]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.
 
      [bookmark: pgfId-1521368]Enter any to specify any destination address.
 
      [bookmark: pgfId-1521369]Separate multiple addresses by a comma.
 
      [bookmark: pgfId-1521370] d. In the Service field, enter an IP service name or number for the destination service, or click the ... button to choose a service.
 
      [bookmark: pgfId-1521371]If you want to specify a TCP or UDP port number, or an ICMP service number, enter protocol/port. For example, enter TCP/8080.
 
      [bookmark: pgfId-1521372]By default, the service is IP.
 
      [bookmark: pgfId-1521373]Separate multiple services by a comma.
 
      [bookmark: pgfId-1521374] e. (Optional) Enter a description in the Description field.
 
      [bookmark: pgfId-1521375] f. (Optional) To specify a source service for TCP or UDP, click the More Options area open, and enter a TCP or UDP service in the Source Service field.
 
      [bookmark: pgfId-1521376]The destination service and source service must be the same. Copy and paste the destination Service field to the Source Service field.
 
      [bookmark: pgfId-1521377] g. (Optional) To make the rule inactive, click the More Options area open, and uncheck Enable Rule.
 
      [bookmark: pgfId-1521378]This setting might be useful if you do not want to remove the rule, but want to turn it off.
 
      [bookmark: pgfId-1521379] h. (Optional) To set a time range for the rule, click the More Options area open, and from the Time Range drop-down list, choose a time range.
 
      [bookmark: pgfId-1521382]To add a new time range, click the ... button. See the “Configuring Time Ranges” section in the general operations configuration guide for more information.
 
      [bookmark: pgfId-1521387]This setting might be useful if you only want the rule to be active at predefined times.
 
       
        
        	 [bookmark: pgfId-1521388]Tunnel Group—Choose a tunnel group from the Tunnel Group drop-down list, or click  New to add a new tunnel group. See the “Add or Edit an IPsec Remote Access Connection Profile” section in the VPN configuration guide for more information.
 
       
 
      
 
      [bookmark: pgfId-1521395]To police each flow, check Match flow destination IP address. All traffic going to a unique IP destination address is considered a flow.
 
       
        
        	 [bookmark: pgfId-1521396]Destination Port—Click  TCP or  UDP .
 
       
 
      
 
      [bookmark: pgfId-1521397]In the Service field, enter a port number or name, or click ... to choose one already defined in ASDM.
 
       
        
        	 [bookmark: pgfId-1521398]RTP Range—Enter an RTP port range, between 2000 and 65534. The maximum number of port sin the range is 16383.
 
        	 [bookmark: pgfId-1521399]IP DiffServ CodePoints (DSCP)—In the DSCP Value to Add area, choose a value from the  Select Named DSCP Values  or enter a value in the  Enter DSCP Value (0-63) field , and click  Add .
 
       
 
      
 
      [bookmark: pgfId-1521400]Add additional values as desired, or remove them using the Remove button.
 
       
        
        	 [bookmark: pgfId-1521401]IP Precedence—From the Available IP Precedence area, choose a value and click  Add .
 
       
 
      
 
      [bookmark: pgfId-1521402]Add additional values as desired, or remove them using the Remove button.
 
      [bookmark: pgfId-1521403]Step 7 Click Next.
 
      [bookmark: pgfId-1521404]The Add Service Policy Rule - Rule Actions dialog box appears.
 
      [bookmark: pgfId-1521407]Step 8 Configure one or more rule actions. See the “Supported Features” section for a list of features.
 
      [bookmark: pgfId-1521409]Step 9 Click Finish.
 
      [bookmark: pgfId-1521410]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-1521412][bookmark: 57282]Adding a Service Policy Rule for Management Traffic
 
      [bookmark: pgfId-1521418]You can create a service policy for traffic directed to the ASA for management purposes. See the “Supported Features” section for more information. This section includes the following topics:
 
       
        [bookmark: pgfId-1521423][bookmark: 90512]Configuring a Service Policy Rule for Management Traffic
 
       [bookmark: pgfId-1521424]To add a service policy rule for management traffic, perform the following steps:
 
       
 
       [bookmark: pgfId-1521425]Step 1 From the Configuration > Firewall > Service Policy Rules pane, click the down arrow next to Add.
 
       [bookmark: pgfId-1521426]Step 2 Choose Add Management Service Policy Rule.
 
       [bookmark: pgfId-1521427]The Add Management Service Policy Rule Wizard - Service Policy dialog box appears.
 
       [bookmark: pgfId-1521428]Step 3 In the Create a Service Policy and Apply To area, click one of the following options:
 
        
         
         	 [bookmark: pgfId-1521429] Interface . This option applies the service policy to a single interface. Interface service policies take precedence over the global service policy for a given feature. For example, if you have a global policy with RADIUS accounting inspection, and an interface policy with connection limits, then both RADIUS accounting and connection limits are applied to the interface. However, if you have a global policy with RADIUS accounting, and an interface policy with RADIUS accounting, then only the interface policy RADIUS accounting is applied to that interface.
 
        
 
       
 
       [bookmark: pgfId-1521430] a. Choose an interface from the drop-down list.
 
       [bookmark: pgfId-1521431]If you choose an interface that already has a policy, then the wizard lets you add a new service policy rule to the interface.
 
       [bookmark: pgfId-1521432] b. If it is a new service policy, enter a name in the Policy Name field.
 
       [bookmark: pgfId-1521433] c. (Optional) Enter a description in the Description field.
 
        
        	 [bookmark: pgfId-1521434] Global - applies to all interfaces . This option applies the service policy globally to all interfaces. By default, a global policy exists that includes a service policy rule for default application inspection. See the “Default Settings” section for more information. You can add a rule to the global policy using the wizard.
 
       
 
       [bookmark: pgfId-1521438]Step 4 Click Next.
 
       [bookmark: pgfId-1521439]The Add Management Service Policy Rule Wizard - Traffic Classification Criteria dialog box appears.
 
       [bookmark: pgfId-1521440]Step 5 Click one of the following options to specify the traffic to which to apply the policy actions:
 
        
         
         	 [bookmark: pgfId-1521441] Create a new traffic class . Enter a traffic class name in the Create a new traffic class field, and enter an optional description.
 
        
 
       
 
       [bookmark: pgfId-1521442]Identify the traffic using one of several criteria:
 
       [bookmark: pgfId-1521443] – Source and Destination IP Address (uses ACL)—The class matches traffic specified by an extended ACL. If the ASA is operating in transparent firewall mode, you can use an EtherType ACL.
 
        
         
       
 
       
 
       [bookmark: pgfId-1521447]Note When you create a new traffic class of this type, you can only specify one access control entry (ACE) initially. After you finish adding the rule, you can add additional ACEs by adding a new rule to the same interface or global policy, and then specifying Add rule to existing traffic class on the Traffic Classification dialog box (see below).
 
        
        
 
       
 
       
 
       [bookmark: pgfId-1521448] – TCP or UDP Destination Port—The class matches a single port or a contiguous range of ports.
 
        
         
       
 
       
 
       [bookmark: pgfId-1521449]Tip For applications that use multiple, non-contiguous ports, use the Source and Destination IP Address (uses ACL) to match each port.
 
        
        
 
       
 
       
 
        
         
         	 [bookmark: pgfId-1521450] Add rule to existing traffic class . If you already have a service policy rule on the same interface, or you are adding to the global service policy, this option lets you add an ACE to an existing ACL. You can add an ACE to any ACL that you previously created when you chose the Source and Destination IP Address (uses ACL) option for a service policy rule on this interface. For this traffic class, you can have only one set of rule actions even if you add multiple ACEs. You can add multiple ACEs to the same traffic class by repeating this entire procedure. See the “Managing the Order of Service Policy Rules” section for information about changing the order of ACEs.
 
         	 [bookmark: pgfId-1521454] Use an existing traffic class. If you created a traffic class used by a rule on a different interface, you can reuse the traffic class definition for this rule. Note that if you alter the traffic class for one rule, the change is inherited by all rules that use that traffic class. If your configuration includes any  class-map commands that you entered at the CLI, those traffic class names are also available (although to view the definition of the traffic class, you need to create the rule).
 
        
 
       
 
       [bookmark: pgfId-1521455]Step 6 Click Next.
 
       [bookmark: pgfId-1521456]Step 7 The next dialog box depends on the traffic match criteria you chose.
 
        
         
         	 [bookmark: pgfId-1521457]Source and Destination Address—This dialog box lets you set the source and destination addresses:
 
        
 
       
 
       [bookmark: pgfId-1521458] a. Click Match or Do Not Match.
 
       [bookmark: pgfId-1521459]The Match option creates a rule where traffic matching the addresses have actions applied. The Do Not Match option exempts the traffic from having the specified actions applied. For example, you want to match all traffic in 10.1.1.0/24 and apply connection limits to it, except for 10.1.1.25. In this case, create two rules, one for 10.1.1.0/24 using the Match option and one for 10.1.1.25 using the Do Not Match option. Be sure to arrange the rules so that the Do Not Match rule is above the Match rule, or else 10.1.1.25 will match the Match rule first.
 
       [bookmark: pgfId-1521460] b. In the Source field, enter the source IP address, or click the ... button to choose an IP address that you already defined in ASDM.
 
       [bookmark: pgfId-1521461]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.
 
       [bookmark: pgfId-1521462]Enter any to specify any source address.
 
       [bookmark: pgfId-1521463]Separate multiple addresses by a comma.
 
       [bookmark: pgfId-1521464] c. In the Destination field, enter the destination IP address, or click the ... button to choose an IP address that you already defined in ASDM.
 
       [bookmark: pgfId-1521465]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.
 
       [bookmark: pgfId-1521466]Enter any to specify any destination address.
 
       [bookmark: pgfId-1521467]Separate multiple addresses by a comma.
 
       [bookmark: pgfId-1521468] d. In the Service field, enter an IP service name or number for the destination service, or click the ... button to choose a service.
 
       [bookmark: pgfId-1521469]If you want to specify a TCP or UDP port number, or an ICMP service number, enter protocol/port. For example, enter TCP/8080.
 
       [bookmark: pgfId-1521470]By default, the service is IP.
 
       [bookmark: pgfId-1521471]Separate multiple services by a comma.
 
       [bookmark: pgfId-1521472] e. (Optional) Enter a description in the Description field.
 
       [bookmark: pgfId-1521473] f. (Optional) To specify a source service for TCP or UDP, click the More Options area open, and enter a TCP or UDP service in the Source Service field.
 
       [bookmark: pgfId-1521474]The destination service and source service must be the same. Copy and paste the destination Service field to the Source Service field.
 
       [bookmark: pgfId-1521475] g. (Optional) To make the rule inactive, click the More Options area open, and uncheck Enable Rule.
 
       [bookmark: pgfId-1521476]This setting might be useful if you do not want to remove the rule, but want to turn it off.
 
       [bookmark: pgfId-1521477] h. (Optional) To set a time range for the rule, click the More Options area open, and from the Time Range drop-down list, choose a time range.
 
       [bookmark: pgfId-1521480]To add a new time range, click the ... button. See the “Configuring Time Ranges” section in the general operations configuration guide for more information.
 
       [bookmark: pgfId-1521485]This setting might be useful if you only want the rule to be active at predefined times.
 
        
         
         	 [bookmark: pgfId-1521486]Destination Port—Click  TCP or  UDP .
 
        
 
       
 
       [bookmark: pgfId-1521487]In the Service field, enter a port number or name, or click ... to choose one already defined in ASDM.
 
       [bookmark: pgfId-1521488]Step 8 Click Next.
 
       [bookmark: pgfId-1521489]The Add Management Service Policy Rule - Rule Actions dialog box appears.
 
       [bookmark: pgfId-1521490]Step 9 To configure RADIUS accounting inspection, choose an inspect map from the RADIUS Accounting Map drop-down list, or click Configure to add a map.
 
       [bookmark: pgfId-1521494]See the “Supported Features” section for more information.
 
       [bookmark: pgfId-1521497]Step 10 To configure connection settings, see the “Configuring Connection Settings” section.
 
       [bookmark: pgfId-1521499]Step 11 Click Finish.
 
       [bookmark: pgfId-1521500]
 
        
        
 
       
 
       
 
      
 
     
 
      
       [bookmark: pgfId-1521502][bookmark: 75857]Managing the Order of Service Policy Rules
 
      [bookmark: pgfId-1521503]The order of service policy rules on an interface or in the global policy affects how actions are applied to traffic. See the following guidelines for how a packet matches rules in a service policy:
 
       
       	 [bookmark: pgfId-1521504]A packet can match only one rule in a service policy for each feature type.
 
       	 [bookmark: pgfId-1521508]When the packet matches a rule that includes actions for a feature type, the ASA does not attempt to match it to any subsequent rules including that feature type.
 
       	 [bookmark: pgfId-1521512]If the packet matches a subsequent rule for a different feature type, however, then the ASA also applies the actions for the subsequent rule.
 
      
 
      [bookmark: pgfId-1521513]For example, if a packet matches a rule for connection limits, and also matches a rule for application inspection, then both rule actions are applied.
 
      [bookmark: pgfId-1521514]If a packet matches a rule for application inspection, but also matches another rule that includes application inspection, then the second rule actions are not applied.
 
      [bookmark: pgfId-1521515]If your rule includes an ACL with multiple ACEs, then the order of ACEs also affects the packet flow. The ASA tests the packet against each ACE in the order in which the entries are listed. After a match is found, no more ACEs are checked. For example, if you create an ACE at the beginning of an ACL that explicitly permits all traffic, no further statements are ever checked.
 
      [bookmark: pgfId-1521519]To change the order of rules or ACEs within a rule, perform the following steps:
 
      
 
      [bookmark: pgfId-1521520]Step 1 From the Configuration > Firewall > Service Policy Rules pane, choose the rule or ACE that you want to move up or down.
 
      [bookmark: pgfId-1521524]Step 2 Click the Move Up or Move Down cursor (see Figure 1-1).
 
      [bookmark: pgfId-1533095]Figure 1-1 [bookmark: 41731]Moving an ACE
 
      [bookmark: pgfId-1533099]
 
       
       [image: ] 
      
 
       
        
      
 
      
 
      [bookmark: pgfId-1521531]Note If you rearrange ACEs in an ACL that is used in multiple service policies, then the change is inherited in all service policies.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1521532]Step 3 When you are done rearranging your rules or ACEs, click Apply.
 
      [bookmark: pgfId-1521533]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-1166520][bookmark: 52709]Feature History for Service Policies
 
       
        
         
         [bookmark: pgfId-1166531]Table 1-3 [bookmark: 50557]Feature History for Service Policies 
 
         
         
          
          	 
            
            [bookmark: pgfId-1166537]Feature Name 
           
  
          	 
            
            [bookmark: pgfId-1166539]Releases 
           
  
          	 
            
            [bookmark: pgfId-1166541]Feature Information 
           
  
         
 
          
          	[bookmark: pgfId-1166543]Modular Policy Framework
  
          	[bookmark: pgfId-1166545]7.0(1)
  
          	[bookmark: pgfId-1166547]Modular Policy Framework was introduced.
  
         
 
          
          	[bookmark: pgfId-1166549]Management class map for use with RADIUS accounting traffic
  
          	[bookmark: pgfId-1166551]7.2(1)
  
          	[bookmark: pgfId-1166553]The management class map was introduced for use with RADIUS accounting traffic. The following commands were introduced: class-map type management, and inspect radius-accounting.
  
         
 
          
          	[bookmark: pgfId-1166555]Inspection policy maps
  
          	[bookmark: pgfId-1166557]7.2(1)
  
          	[bookmark: pgfId-1166559]The inspection policy map was introduced. The following command was introduced: class-map type inspect.
  
         
 
          
          	[bookmark: pgfId-1166561]Regular expressions and policy maps
  
          	[bookmark: pgfId-1166563]7.2(1)
  
          	[bookmark: pgfId-1166565]Regular expressions and policy maps were introduced to be used under inspection policy maps. The following commands were introduced: class-map type regex, regex, match regex.
  
         
 
          
          	[bookmark: pgfId-1166567]Match any for inspection policy maps
  
          	[bookmark: pgfId-1166569]8.0(2)
  
          	[bookmark: pgfId-1166571]The match any keyword was introduced for use with inspection policy maps: traffic can match one or more criteria to match the class map. Formerly, only match all was available.
  
         
 
         
       
 
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1102147][bookmark: 73321]Information About NAT (ASA 8.3 and Later) 
      
      
 
     
 
 
    [bookmark: pgfId-1180410]This chapter provides an overview of how Network Address Translation (NAT) works on the ASA. This chapter includes the following sections[bookmark: marker-1180411]:
 
     
     	 [bookmark: pgfId-1180415]Why Use NAT?
 
     	 [bookmark: pgfId-1107216]NAT Terminology
 
     	 [bookmark: pgfId-1090244]NAT Types
 
     	 [bookmark: pgfId-1107508]NAT in Routed and Transparent Mode
 
     	 [bookmark: pgfId-1220866]NAT and IPv6
 
     	 [bookmark: pgfId-1090731]How NAT is Implemented 
 
     	 [bookmark: pgfId-1090252]NAT Rule Order
 
     	 [bookmark: pgfId-1090256]Routing NAT Packets
 
     	 [bookmark: pgfId-1286177]NAT for VPN
 
     	 [bookmark: pgfId-1090260]DNS and NAT
 
     	 [bookmark: pgfId-1090954]Where to Go Next
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1122057]Note To start configuring NAT, see “Configuring Network Object NAT (ASA 8.3 and Later),” or Chapter5, “Configuring Twice NAT (ASA 8.3 and Later)”
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1096010][bookmark: 98207]Why Use NAT?
 
    [bookmark: pgfId-1096014]One of the main functions of NAT is to enable private IP networks to connect to the Internet. NAT replaces a private IP address with a public IP address, translating the private addresses in the internal private network into legal, routable addresses that can be used on the public Internet. In this way, NAT conserves public addresses because it can be configured to advertise at a minimum only one public address for the entire network to the outside world.
 
    [bookmark: pgfId-1105944]Other functions of NAT include:
 
     
     	 [bookmark: pgfId-1105969]Security—Keeping internal IP addresses hidden discourages direct attacks.
 
     	 [bookmark: pgfId-1106026]IP routing solutions—Overlapping IP addresses are not a problem when you use NAT.
 
     	 [bookmark: pgfId-1220243]Flexibility—You can change internal IP addressing schemes without affecting the public addresses available externally; for example, for a server accessible to the Internet, you can maintain a fixed IP address for Internet use, but internally, you can change the server address.
 
     	 [bookmark: pgfId-1220244]Translating between IPv4 and IPv6 (Routed mode only) (Version 9.0(1) and later)—If you want to connect an IPv6 network to an IPv4 network, NAT lets you translate between the two types of addresses.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1220245]Note NAT is not required. If you do not configure NAT for a given set of traffic, that traffic will not be translated, but will have all of the security policies applied as normal.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1106505][bookmark: 83887]NAT Terminology[bookmark: marker-1124985]
 
    [bookmark: pgfId-1106517]This document uses the following terminology:
 
     
     	 [bookmark: pgfId-1106570]Real address/host/network/interface—The real address is the address that is defined on the host, before it is translated. In a typical NAT scenario where you want to translate the inside network when it accesses the outside, the inside network would be the “real” network. Note that you can translate any network connected to the ASA, not just an inside network, Therefore if you configure NAT to translate outside addresses, “real” can refer to the outside network when it accesses the inside network.
 
     	 [bookmark: pgfId-1106545]Mapped address/host/network/interface—The mapped address is the address that the real address is translated to. In a typical NAT scenario where you want to translate the inside network when it accesses the outside, the outside network would be the “mapped” network.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1319958]Note During address translation, IP addresses residing on the ASA’s interfaces are not translated.
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1106975]Bidirectional initiation[bookmark: marker-1124986]—Static NAT allows connections to be initiated  bidirectionally , meaning both to the host and from the host.
 
     	 [bookmark: pgfId-1107047]Source and destination NAT—For any given packet, both the source and destination IP addresses are compared to the NAT rules, and one or both can be translated/untranslated. For static NAT, the rule is bidirectional, so be aware that “source” and “destination” are used in commands and descriptions throughout this guide even though a given connection might originate at the “destination” address.
 
    
 
   
 
    
     [bookmark: pgfId-1094702][bookmark: 91605]NAT Typ[bookmark: marker-1094701]es
 
     
     	 [bookmark: pgfId-1197226]NAT Types Overview
 
     	 [bookmark: pgfId-1197369]Static NAT
 
     	 [bookmark: pgfId-1197230]Dynamic NAT
 
     	 [bookmark: pgfId-1197234]Dynamic PAT
 
     	 [bookmark: pgfId-1197238]Identity NAT
 
    
 
     
      [bookmark: pgfId-1094727][bookmark: 32772]NAT Types Overview
 
     [bookmark: pgfId-1197283]You can implement NAT using the following methods:
 
      
      	 [bookmark: pgfId-1106389]Static NAT—A consistent mapping between a real and mapped IP address. Allows bidirectional traffic initiation. See the “Static NAT” section.
 
      	 [bookmark: pgfId-1106398]Dynamic NAT—A group of real IP addresses are mapped to a (usually smaller) group of mapped IP addresses, on a first come, first served basis. Only the real host can initiate traffic. See the “Dynamic NAT” section.
 
      	 [bookmark: pgfId-1128538]Dynamic Port Address Translation (PAT)—A group of real IP addresses are mapped to a single IP address using a unique source port of that IP address. See the “Dynamic PAT” section.
 
      	 [bookmark: pgfId-1128539]Identity NAT—A real address is statically translated to itself, essentially bypassing NAT. You might want to configure NAT this way when you want to translate a large group of addresses, but then want to exempt a smaller subset of addresses. See the “Identity NAT” section.
 
     
 
    
 
     
      [bookmark: pgfId-1094158][bookmark: 15394]Static NAT[bookmark: marker-1124987]
 
     [bookmark: pgfId-1108063]This section describes static NAT and includes the following topics:
 
      
      	 [bookmark: pgfId-1108027]Information About Static NAT
 
      	 [bookmark: pgfId-1108045]Information About Static NAT with Port Translation
 
      	 [bookmark: pgfId-1108054]Information About One-to-Many Static NAT
 
      	 [bookmark: pgfId-1112105]Information About Other Mapping Scenarios (Not Recommended)
 
     
 
    
 
     
      [bookmark: pgfId-1108001][bookmark: 11517]Information About Static NAT
 
     [bookmark: pgfId-1107530]Static NAT creates a fixed translation of a real address to a mapped address. Because the mapped address is the same for each consecutive connection, static NAT allows bidirectional connection initiation, both to and from the host (if an access rule exists that allows it). With dynamic NAT and PAT, on the other hand, each host uses a different address or port for each subsequent translation, so bidirectional initiation is not supported. 
 
     [bookmark: pgfId-1107535]Figure 3-1 shows a typical static NAT scenario. The translation is always active so both real and remote hosts can initiate connections.
 
     [bookmark: pgfId-1107537]Figure 3-1 [bookmark: 61004]Static NAT
 
     [bookmark: pgfId-1107541]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1221088]Note You can disable bidirectionality if desired.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1107574][bookmark: 78277]Information About Static NAT with Port Translation[bookmark: marker-1124988]
 
     [bookmark: pgfId-1108013]Static NAT with port translation lets you specify a real and mapped protocol (TCP or UDP) and port. 
 
     [bookmark: pgfId-1123143]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1123151]Information About Static NAT with Port Address Translation
 
      	 [bookmark: pgfId-1123293]Static NAT with Identity Port Translation
 
      	 [bookmark: pgfId-1123365]Static NAT with Port Translation for Non-Standard Ports
 
      	 [bookmark: pgfId-1123565]Static Interface NAT with Port Translation
 
     
 
    
 
     
      [bookmark: pgfId-1123144][bookmark: 23482]Information About Static NAT with Port Address Translation
 
     [bookmark: pgfId-1123145]When you specify the port with static NAT, you can choose to map the port and/or the IP address to the same value or to a different value.
 
     [bookmark: pgfId-1107578]Figure 3-2 shows a typical static NAT with port translation scenario showing both a port that is mapped to itself and a port that is mapped to a different value; the IP address is mapped to a different value in both cases. The translation is always active so both translated and remote hosts can initiate connections. 
 
     [bookmark: pgfId-1107580]Figure 3-2 [bookmark: 67208]Typical Static NAT with Port Translation Scenario
 
     [bookmark: pgfId-1107584]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1107585]Note For applications that require application inspection for secondary channels (for example, FTP and VoIP), the ASA automatically translates the secondary ports.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1123474][bookmark: 49011]Static NAT with Identity Port Translation
 
     [bookmark: pgfId-1117550]The following static NAT with port translation example provides a single address for remote users to access FTP, HTTP, and SMTP. These servers are actually different devices on the real network, but for each server, you can specify static NAT with port translation rules that use the same mapped IP address, but different ports. (See Figure 3-3. See the “Single Address for FTP, HTTP, and SMTP (Static NAT-with-Port-Translation)” section for details on how to configure this example.)
 
     [bookmark: pgfId-1324429]Figure 3-3 [bookmark: 40720]Static NAT with Port Translation
 
     [bookmark: pgfId-1324433]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1107613][bookmark: 88126]Static NAT with Port Translation for Non-Standard Ports
 
     [bookmark: pgfId-1123429]You can also use static NAT with port translation to translate a well-known port to a non-standard port or vice versa. For example, if inside web servers use port 8080, you can allow outside users to connect to port 80, and then undo translation to the original port 8080. Similarly, to provide extra security, you can tell web users to connect to non-standard port 6785, and then undo translation to port 80.
 
    
 
     
      [bookmark: pgfId-1121540][bookmark: 88772]Static Interface NAT with Port Translation
 
     [bookmark: pgfId-1121630]You can configure static NAT to map a real address to an interface address/port combination. For example, if you want to redirect Telnet access for the ASA outside interface to an inside host, then you can map the inside host IP address/port 23 to the ASA interface address/port 23. (Note that although Telnet to the ASA is not allowed to the lowest security interface, static NAT with interface port translation redirects the Telnet session instead of denying it).
 
    
 
     
      [bookmark: pgfId-1107407][bookmark: 57732]Information About One-to-Many Static NAT[bookmark: marker-1107406][bookmark: marker-1124989]
 
     [bookmark: pgfId-1108650]Typically, you configure static NAT with a one-to-one mapping. However, in some cases, you might want to configure a single real address to several mapped addresses (one-to-many). When you configure one-to-many static NAT, when the real host initiates traffic, it always uses the first mapped address. However, for traffic initiated to the host, you can initiate traffic to any of the mapped addresses, and they will be untranslated to the single real address.
 
     [bookmark: pgfId-1113782]Figure 3-4 shows a typical one-to-many static NAT scenario. Because initiation by the real host always uses the first mapped address, the translation of real host IP/1st mapped IP is technically the only bidirectional translation.
 
     [bookmark: pgfId-1113784]Figure 3-4 [bookmark: 22496]One-to-Many Static NAT
 
     [bookmark: pgfId-1113788]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1113715]For example, you have a load balancer at 10.1.2.27. Depending on the URL requested, it redirects traffic to the correct web server (see Figure 3-5). (See the “Inside Load Balancer with Multiple Mapped Addresses (Static NAT, One-to-Many)” section for details on how to configure this example.)
 
     [bookmark: pgfId-1324455]Figure 3-5 [bookmark: 55156]One-to-Many Static NAT
 
     [bookmark: pgfId-1324459]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1109039][bookmark: 13402]Information About Other Mapping Scenarios (Not Recommended)[bookmark: marker-1124990]
 
     [bookmark: pgfId-1112085]The ASA has the flexibility to allow any kind of static mapping scenario: one-to-one, one-to-many, but also few-to-many, many-to-few, and many-to-one mappings. We recommend using only one-to-one or one-to-many mappings. These other mapping options might result in unintended consequences. 
 
     [bookmark: pgfId-1109590]Functionally, few-to-many is the same as one-to-many; but because the configuration is more complicated and the actual mappings may not be obvious at a glance, we recommend creating a one-to-many configuration for each real address that requires it. For example, for a few-to-many scenario, the few real addresses are mapped to the many mapped addresses in order (A to 1, B to 2, C to 3). When all real addresses are mapped, the next mapped address is mapped to the first real address, and so on until all mapped addresses are mapped (A to 4, B to 5, C to 6). This results in multiple mapped addresses for each real address. Just like a one-to-many configuration, only the first mappings are bidirectional; subsequent mappings allow traffic to be initiated to the real host, but all traffic from the real host uses only the first mapped address for the source. 
 
     [bookmark: pgfId-1113918]Figure 3-6 shows a typical few-to-many static NAT scenario.
 
     [bookmark: pgfId-1113920]Figure 3-6 [bookmark: 31912]Few-to-Many Static NAT
 
     [bookmark: pgfId-1113924]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1113862]For a many-to-few or many-to-one configuration, where you have more real addresses than mapped addresses, you run out of mapped addresses before you run out of real addresses. Only the mappings between the lowest real IP addresses and the mapped pool result in bidirectional initiation. The remaining higher real addresses can initiate traffic, but traffic cannot be initiated to them (returning traffic for a connection is directed to the correct real address because of the unique 5-tuple (source IP, destination IP, source port, destination port, protocol) for the connection).
 
      
       
     
 
     
 
     [bookmark: pgfId-1147395]Note Many-to-few or many-to-one NAT is not PAT. If two real hosts use the same source port number and go to the same outside server and the same TCP destination port, and both hosts are translated to the same IP address, then both connections will be reset because of an address conflict (the 5-tuple is not unique).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1113954]Figure 3-7 shows a typical many-to-few static NAT scenario.
 
     [bookmark: pgfId-1113955]Figure 3-7 [bookmark: 65928]Many-to-Few Static NAT
 
     [bookmark: pgfId-1113959]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1113173]Instead of using a static rule this way, we suggest that you create a one-to-one rule for the traffic that needs bidirectional initiation, and then create a dynamic rule for the rest of your addresses.
 
    
 
     
      [bookmark: pgfId-1112794][bookmark: 76809]Dynamic NAT[bookmark: marker-1124991]
 
     [bookmark: pgfId-1113367]This section describes dynamic NAT and includes the following topics:
 
      
      	 [bookmark: pgfId-1113371]Information About Dynamic NAT
 
      	 [bookmark: pgfId-1113401]Dynamic NAT Disadvantages and Advantages
 
     
 
    
 
     
      [bookmark: pgfId-1107740][bookmark: 91211]Information About Dynamic NAT
 
     [bookmark: pgfId-1113656]Dynamic NAT translates a group of real addresses to a pool of mapped addresses that are routable on the destination network. The mapped pool typically includes fewer addresses than the real group. When a host you want to translate accesses the destination network, the ASA assigns the host an IP address from the mapped pool. The translation is created only when the real host initiates the connection. The translation is in place only for the duration of the connection, and a given user does not keep the same IP address after the translation times out. Users on the destination network, therefore, cannot initiate a reliable connection to a host that uses dynamic NAT, even if the connection is allowed by an access rule.
 
     [bookmark: pgfId-1113694]Figure 3-8 shows a typical dynamic NAT scenario. Only real hosts can create a NAT session, and responding traffic is allowed back.
 
     [bookmark: pgfId-1113696]Figure 3-8 [bookmark: 44804]Dynamic NAT
 
     [bookmark: pgfId-1113700]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1324467]Figure 3-9 shows a remote host attempting to initiate a connection to a mapped address. This address is not currently in the translation table; therefore, the ASA drops the packet.
 
     [bookmark: pgfId-1324472]Figure 3-9 [bookmark: 75757]Remote Host Attempts to Initiate a Connection to a Mapped Address
 
     [bookmark: pgfId-1324476]
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     [bookmark: pgfId-1107789]Note For the duration of the translation, a remote host can initiate a connection to the translated host if an access rule allows it. Because the address is unpredictable, a connection to the host is unlikely. Nevertheless, in this case you can rely on the security of the access rule.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1113320][bookmark: 19827]Dynamic NAT Disadvantages and Advantages
 
     [bookmark: pgfId-1113321]Dynamic NAT has these disadvantages:
 
      
      	 [bookmark: pgfId-1113322]If the mapped pool has fewer addresses than the real group, you could run out of addresses if the amount of traffic is more than expected.
 
     
 
     [bookmark: pgfId-1113323]Use PAT or a PAT fallback method if this event occurs often because PAT provides over 64,000 translations using ports of a single address.
 
      
      	 [bookmark: pgfId-1113324]You have to use a large number of routable addresses in the mapped pool, and routable addresses may not be available in large quantities.
 
     
 
     [bookmark: pgfId-1113325]The advantage of dynamic NAT is that some protocols cannot use PAT. PAT does not work with the following:
 
      
      	 [bookmark: pgfId-1107795]IP protocols that do not have a port to overload, such as GRE version 0. 
 
      	 [bookmark: pgfId-1107796]Some multimedia applications that have a data stream on one port, the control path on another port, and are not open standard. 
 
     
 
     [bookmark: pgfId-1107800]See the “Default Settings and NAT Limitations” section for more information about NAT and PAT support.
 
    
 
     
      [bookmark: pgfId-1094168][bookmark: 21816]Dynamic PAT[bookmark: marker-1124992][bookmark: marker-1124996][bookmark: marker-1125024]
 
     [bookmark: pgfId-1114317]This section describes dynamic PAT and includes the following topics:
 
      
      	 [bookmark: pgfId-1114321]Information About Dynamic PAT
 
      	 [bookmark: pgfId-1219876]Per-Session PAT vs. Multi-Session PAT (Version 9.0(1) and Later)
 
      	 [bookmark: pgfId-1114325]Dynamic PAT Disadvantages and Advantages
 
     
 
    
 
     
      [bookmark: pgfId-1114283][bookmark: 73370]Information About Dynamic PAT
 
     [bookmark: pgfId-1198122]Dynamic PAT translates multiple real addresses to a single mapped IP address by translating the real address and source port to the mapped address and a unique port. If available, the real source port number is used for the mapped port. However, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 0 to 511, 512 to 1023, and 1024 to 65535. Therefore, ports below 1024 have only a small PAT pool that can be used. If you have a lot of traffic that uses the lower port ranges, you can specify a flat range of ports to be used instead of the three unequal-sized tiers.
 
     [bookmark: pgfId-1171779]Each connection requires a separate translation session because the source port differs for each connection. For example, 10.1.1.1:1025 requires a separate translation from 10.1.1.1:1026.
 
     [bookmark: pgfId-1114234]Figure 3-10 shows a typical dynamic PAT scenario. Only real hosts can create a NAT session, and responding traffic is allowed back. The mapped address is the same for each translation, but the port is dynamically assigned.
 
     [bookmark: pgfId-1114236]Figure 3-10 [bookmark: 22013]Dynamic PAT
 
     [bookmark: pgfId-1114240]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1107879]After the connection expires, the port translation also expires. For multi-session PAT, the PAT timeout is used, 30 seconds by default. For per-session PAT (9.0(1) and later), the xlate is immediately removed. Users on the destination network cannot reliably initiate a connection to a host that uses PAT (even if the connection is allowed by an access rule).
 
      
       
     
 
     
 
     [bookmark: pgfId-1114419]Note For the duration of the translation, a remote host can initiate a connection to the translated host if an access rule allows it. Because the port address (both real and mapped) is unpredictable, a connection to the host is unlikely. Nevertheless, in this case you can rely on the security of the access rule.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1218712][bookmark: 86271]Per-Session PAT vs. Multi-Session PAT (Version 9.0(1) and Later)
 
     [bookmark: pgfId-1218713]The per-session PAT feature improves the scalability of PAT and, for clustering, allows each member unit to own PAT connections; multi-session PAT connections have to be forwarded to and owned by the master unit. At the end of a per-session PAT session, the ASA sends a reset and immediately removes the xlate. This reset causes the end node to immediately release the connection, avoiding the TIME_WAIT state. Multi-session PAT, on the other hand, uses the PAT timeout, by default 30 seconds. For “hit-and-run” traffic, such as HTTP or HTTPS, the per-session feature can dramatically increase the connection rate supported by one address. Without the per-session feature, the maximum connection rate for one address for an IP protocol is approximately 2000 per second. With the per-session feature, the connection rate for one address for an IP protocol is 65535/average-lifetime.
 
     [bookmark: pgfId-1218873]By default, all TCP traffic and UDP DNS traffic use a per-session PAT xlate. For traffic that can benefit from multi-session PAT, such as H.323, SIP, or Skinny, you can disable per-session PAT be creating a per-session deny rule. See the “Configuring Per-Session PAT Rules” section.
 
    
 
     
      [bookmark: pgfId-1218727][bookmark: 92356]Dynamic PAT Disadvantages and Advantages
 
     [bookmark: pgfId-1107889]Dynamic PAT lets you use a single mapped address, thus conserving routable addresses. You can even use the ASA interface IP address as the PAT address. 
 
     [bookmark: pgfId-1114356]Dynamic PAT does not work with some multimedia applications that have a data stream that is different from the control path. See the “Default Settings and NAT Limitations” section for more information about NAT and PAT support.
 
     [bookmark: pgfId-1169959]Dynamic PAT may also create a large number of connections appearing to come from a single IP address, and servers might interpret the traffic as a DoS attack. (8.4(2)/8.5(1) and later) You can configure a PAT pool of addresses and use a round-robin assignment of PAT addresses to mitigate this situation.
 
    
 
     
      [bookmark: pgfId-1102289][bookmark: 25608]Identity NAT[bookmark: marker-1125025]
 
     [bookmark: pgfId-1098588]You might have a NAT configuration in which you need to translate an IP address to itself. For example, if you create a broad rule that applies NAT to every network, but want to exclude one network from NAT, you can create a static NAT rule to translate an address to itself. Identity NAT is necessary for remote access VPN, where you need to exempt the client traffic from NAT.
 
     [bookmark: pgfId-1107688][bookmark: 57240]Figure 3-11 shows a typical identity NAT scenario.
 
     [bookmark: pgfId-1107690]Figure 3-11 [bookmark: 35682]Identity NAT
 
     [bookmark: pgfId-1107694]
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     [bookmark: pgfId-1107431][bookmark: 30487]NAT in Routed and Transparent Mode
 
    [bookmark: pgfId-1123796]You can configure NAT in both routed and transparent firewall mode. This section describes typical usage for each firewall mode and includes the following topics:
 
     
     	 [bookmark: pgfId-1107456]NAT in Routed Mode
 
     	 [bookmark: pgfId-1107485]NAT in Transparent Mode
 
    
 
     
      [bookmark: pgfId-1102433][bookmark: 18560][bookmark: 44516][bookmark: 32632]NAT in Routed Mode[bookmark: marker-1125033]
 
     [bookmark: pgfId-1092187]Figure 3-12 shows a typical NAT example in routed mode, with a private network on the inside.
 
     [bookmark: pgfId-1123910]Figure 3-12 [bookmark: 82980]NAT Example: Routed Mode
 
     [bookmark: pgfId-1123914]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1123823] 1. When the inside host at 10.1.2.27 sends a packet to a web server, the real source address of the packet, 10.1.2.27, is changed to a mapped address, 209.165.201.10.
 
     [bookmark: pgfId-1123835] 2. When the server responds, it sends the response to the mapped address, 209.165.201.10, and the ASA receives the packet because the ASA performs proxy ARP to claim the packet.
 
     [bookmark: pgfId-1123840] 3. The ASA then changes the translation of the mapped address, 209.165.201.10, back to the real address, 10.1.2.27, before sending it to the host.
 
    
 
     
      [bookmark: pgfId-1092205][bookmark: 43881]NAT in Transparent Mode[bookmark: marker-1125029]
 
     [bookmark: pgfId-1092206]Using NAT in transparent mode eliminates the need for the upstream or downstream routers to perform NAT for their networks.
 
     [bookmark: pgfId-1092210]NAT in transparent mode has the following requirements and limitations:
 
      
      	 [bookmark: pgfId-1092229]Because the transparent firewall does not have any interface IP addresses, you cannot use interface PAT.
 
      	 [bookmark: pgfId-1092230]ARP inspection is not supported. Moreover, if for some reason a host on one side of the ASA sends an ARP request to a host on the other side of the ASA, and the initiating host real address is mapped to a different address on the same subnet, then the real address remains visible in the ARP request.
 
      	 [bookmark: pgfId-1220313]Translating between IPv4 and IPv6 networks is not supported. Translating between two IPv6 networks, or between two IPv4 networks is supported.
 
     
 
     [bookmark: pgfId-1092235]Figure 3-13 shows a typical NAT scenario in transparent mode, with the same network on the inside and outside interfaces. The transparent firewall in this scenario is performing the NAT service so that the upstream router does not have to perform NAT. 
 
     [bookmark: pgfId-1124142]Figure 3-13 [bookmark: 59658]NAT Example: Transparent Mode
 
     [bookmark: pgfId-1124146]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1124010] 1. When the inside host at 10.1.1.75 sends a packet to a web server, the real source address of the packet, 10.1.1.75, is changed to a mapped address, 209.165.201.15.
 
     [bookmark: pgfId-1124345] 2. When the server responds, it sends the response to the mapped address, 209.165.201.15, and the ASA receives the packet because the upstream router includes this mapped network in a static route directed to the ASA management IP address. See the “Mapped Addresses and Routing” section for more information about required routes.
 
     [bookmark: pgfId-1124370] 3. The ASA then undoes the translation of the mapped address, 209.165.201.15, back to the real address, 10.1.1.1.75. Because the real address is directly-connected, the ASA sends it directly to the host.
 
     [bookmark: pgfId-1196682] 4. For host 192.168.1.2, the same process occurs, except for returning traffic, the ASA looks up the route in its routing table and sends the packet to the downstream router at 10.1.1.3 based on the ASA static route for 192.168.1.0/24. See the “Transparent Mode Routing Requirements for Remote Networks” section for more information about required routes.
 
    
 
   
 
    
     [bookmark: pgfId-1220768][bookmark: 71280]NAT and IPv6
 
    [bookmark: pgfId-1220835]You can use NAT to translate between IPv6 networks, and also to translate between IPv4 and IPv6 networks (routed mode only). We recommend the following best practices:
 
     
     	 [bookmark: pgfId-1220941]NAT66 (IPv6-to-IPv6)—We recommend using static NAT. Although you can use dynamic NAT or PAT, IPv6 addresses are in such large supply, you do not have to use dynamic NAT. If you do not want to allow returning traffic, you can make the static NAT rule unidirectional (twice NAT only).
 
     	 [bookmark: pgfId-1226067]NAT46 (IPv4-to-IPv6)—We recommend using static NAT. Because the IPv6 address space is so much larger than the IPv4 address space, you can easily accommodate a static translation. If you do not want to allow returning traffic, you can make the static NAT rule unidirectional (twice NAT only). When translating to an IPv6 subnet (/96 or lower), the resulting mapped address is by default an IPv4-embedded IPv6 address, where the 32-bits of the IPv4 address is embedded after the IPv6 prefix. For example, if the IPv6 prefix is a /96 prefix, then the IPv4 address is appended in the last 32-bits of the address. For example, if you map 192.168.1.0/24 to 201b::0/96, then 192.168.1.4 will be mapped to 201b::0.192.168.1.4 (shown with mixed notation). If the prefix is smaller, such as /64, then the IPv4 address is appended after the prefix, and a suffix of 0s is appended after the IPv4 address. You can also optionally translate the addresses net-tonet, where the first IPv4 address maps to the first IPv6 address, the second to the second, and so on. 
 
     	 [bookmark: pgfId-1226068]NAT64 (IPv6-to-IPv4)—You may not have enough IPv4 addresses to accommodate the number of IPv6 addresses. We recommend using a dynamic PAT pool to provide a large number of IPv4 translations.
 
    
 
    [bookmark: pgfId-1229441]For specific implementation guidelines and limitations, see the configuration chapters.
 
   
 
    
     [bookmark: pgfId-1202843][bookmark: 71708]How NAT is Implemented[bookmark: marker-1202842]
 
    [bookmark: pgfId-1122019]The ASA can implement address translation in two ways: network object NAT and twice NAT. This section includes the following topics:
 
     
     	 [bookmark: pgfId-1090306]Main Differences Between Network Object NAT and Twice NAT
 
     	 [bookmark: pgfId-1118710]Information About Network Object NAT
 
     	 [bookmark: pgfId-1090310]Information About Twice NAT
 
    
 
     
      [bookmark: pgfId-1118634][bookmark: 64594]Main Differences Between Network Object NAT and Twice NAT[bookmark: marker-1125035]
 
     [bookmark: pgfId-1118635]The main differences between these two NAT types are:
 
      
      	 [bookmark: pgfId-1118636]How you define the real address.
 
     
 
     [bookmark: pgfId-1118637] – Network object NAT—You define NAT as a parameter for a network object. A network object names an IP host, range, or subnet so you can then use the object in configuration instead of the actual IP addresses. The network object IP address serves as the real address. This method lets you easily add NAT to network objects that might already be used in other parts of your configuration.
 
     [bookmark: pgfId-1118638] – Twice NAT—You identify a network object or network object group for both the real and mapped addresses. In this case, NAT is not a parameter of the network object; the network object or group is a parameter of the NAT configuration. The ability to use a network object group for the real address means that twice NAT is more scalable.
 
      
      	 [bookmark: pgfId-1118639]How source and destination NAT is implemented.
 
     
 
     [bookmark: pgfId-1118640] – Network object NAT— Each rule can apply to either the source or destination of a packet. So two rules might be used, one for the source IP address, and one for the destination IP address. These two rules cannot be tied together to enforce a specific translation for a source/destination combination.
 
     [bookmark: pgfId-1118641] – Twice NAT—A single rule translates both the source and destination. A matching packet only matches the one rule, and further rules are not checked. Even if you do not configure the optional destination address for twice NAT, a matching packet still only matches one twice NAT rule. The source and destination are tied together, so you can enforce different translations depending on the source/destination combination. For example, sourceA/destinationA can have a different translation than sourceA/destinationB.
 
      
      	 [bookmark: pgfId-1118645]Order of NAT Rules.
 
     
 
     [bookmark: pgfId-1118647] – Network object NAT—Automatically ordered in the NAT table.
 
     [bookmark: pgfId-1119033] – Twice NAT—Manually ordered in the NAT table (before or after network object NAT rules).
 
     [bookmark: pgfId-1118653]See the “NAT Rule Order” section for more information.
 
     [bookmark: pgfId-1119249]We recommend using network object NAT unless you need the extra features that twice NAT provides. Network object NAT is easier to configure, and might be more reliable for applications such as Voice over IP (VoIP). (For VoIP, because twice NAT is applicable only between two objects, you might see a failure in the translation of indirect addresses that do not belong to either of the objects.)
 
    
 
     
      [bookmark: pgfId-1096304][bookmark: 59596]Information About Network Object NAT[bookmark: marker-1125036][bookmark: marker-1125037]
 
     [bookmark: pgfId-1117355]All NAT rules that are configured as a parameter of a network object are considered to be network object NAT rules. Network object NAT is a quick and easy way to configure NAT for a network object, which can be a single IP address, a range of addresses, or a subnet.
 
     [bookmark: pgfId-1115397]After you configure the network object, you can then identify the mapped address for that object, either as an inline address or as another network object or network object group.
 
     [bookmark: pgfId-1115401]When a packet enters the ASA, both the source and destination IP addresses are checked against the network object NAT rules. The source and destination address in the packet can be translated by separate rules if separate matches are made. These rules are not tied to each other; different combinations of rules can be used depending on the traffic.
 
     [bookmark: pgfId-1115039]Because the rules are never paired, you cannot specify that sourceA/destinationA should have a different translation than sourceA/destinationB. Use twice NAT for that kind of functionality (twice NAT lets you identify the source and destination address in a single rule).
 
     [bookmark: pgfId-1122115]To start configuring network object NAT, see Chapter4, “Configuring Network Object NAT (ASA 8.3 and Later)”
 
    
 
     
      [bookmark: pgfId-1090322][bookmark: 55613]Information About Twice NAT[bookmark: marker-1125038]
 
     [bookmark: pgfId-1091756]Twice NAT lets you identify both the source and destination address in a single rule. Specifying both the source and destination addresses lets you specify that sourceA/destinationA can have a different translation than sourceA/destinationB.
 
     [bookmark: pgfId-1119159]The destination address is optional. If you specify the destination address, you can either map it to itself (identity NAT), or you can map it to a different address. The destination mapping is always a static mapping.
 
     [bookmark: pgfId-1119216]Twice NAT also lets you use service objects for static NAT with port translation; network object NAT only accepts inline definition.
 
     [bookmark: pgfId-1245017]To start configuring twice NAT, see Chapter5, “Configuring Twice NAT (ASA 8.3 and Later)”
 
     [bookmark: pgfId-1245021]Figure 3-14 shows a host on the 10.1.2.0/24 network accessing two different servers. When the host accesses the server at 209.165.201.11, the real address is translated to 209.165.202.129. When the host accesses the server at 209.165.200.225, the real address is translated to 209.165.202.130. (See the “Single Address for FTP, HTTP, and SMTP (Static NAT-with-Port-Translation)” section for details on how to configure this example.)
 
     [bookmark: pgfId-1245026]Figure 3-14 [bookmark: 11178]Twice NAT with Different Destination Addresses
 
     [bookmark: pgfId-1090355]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1090385]Figure 3-15 shows the use of source and destination ports. The host on the 10.1.2.0/24 network accesses a single host for both web services and Telnet services. When the host accesses the server for web services, the real address is translated to 209.165.202.129. When the host accesses the same server for Telnet services, the real address is translated to 209.165.202.130.
 
     [bookmark: pgfId-1090387]Figure 3-15 [bookmark: 57995]Twice NAT with Different Destination Ports
 
     [bookmark: pgfId-1090391]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1090422]Figure 3-16 shows a remote host connecting to a mapped host. The mapped host has a twice static NAT translation that translates the real address only for traffic to and from the 209.165.201.0/27 network. A translation does not exist for the 209.165.200.224/27 network, so the translated host cannot connect to that network, nor can a host on that network connect to the translated host.
 
     [bookmark: pgfId-1090424]Figure 3-16 [bookmark: 59922]Twice Static NAT with Destination Address Translation
 
     [bookmark: pgfId-1090428]
 
      
      [image: ] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1118157][bookmark: 31590][bookmark: 19135]NAT Rule Order[bookmark: marker-1118156] 
 
     
      
       
       [bookmark: pgfId-1124475]Table 3-1 [bookmark: 87472]NAT Rule Table
 
       
       
        
        	 
          
          [bookmark: pgfId-1124479]Table Section 
         
  
        	 
          
          [bookmark: pgfId-1124705]Rule Type 
         
  
        	 
          
          [bookmark: pgfId-1124481]Order of Rules within the Section 
         
  
       
 
        
        	[bookmark: pgfId-1124483]Section 1
  
        	[bookmark: pgfId-1124707]Twice NAT
  
        	[bookmark: pgfId-1326351]Applied on a first match basis, in the order they appear in the configuration. Because the first match is applied, you must ensure that specific rules come before more general rules, or the specific rules might not be applied as desired. By default, twice NAT rules are added to section 1.
 [bookmark: pgfId-1133597]Note [bookmark: marker-1133791]If you configure EasyVPN remote, the ASA dynamically adds invisible NAT rules to the end of this section. Be sure that you do not configure a twice NAT rule in this section that might match your VPN traffic, instead of matching the invisible rule. If VPN does not work due to NAT failure, consider adding twice NAT rules to section 3 instead.
  
       
 
        
        	[bookmark: pgfId-1124487]Section 2
  
        	[bookmark: pgfId-1124709]Network object NAT
  
        	[bookmark: pgfId-1326374]If a match in section 1 is not found, section 2 rules are applied in the following order, as automatically determined by the ASA:
 [bookmark: pgfId-1124575] 1. Static rules.
 [bookmark: pgfId-1124576] 2. Dynamic rules.
 [bookmark: pgfId-1124577]Within each rule type, the following ordering guidelines are used:
 [bookmark: pgfId-1124578] a. Quantity of real IP addresses—From smallest to largest. For example, an object with one address will be assessed before an object with 10 addresses.
 [bookmark: pgfId-1124579] b. For quantities that are the same, then the IP address number is used, from lowest to highest. For example, 10.1.1.0 is assessed before 11.1.1.0.
 [bookmark: pgfId-1124580] c. If the same IP address is used, then the name of the network object is used, in alphabetical order. For example, abracadabra is assessed before catwoman.
  
       
 
        
        	[bookmark: pgfId-1124547]Section 3
  
        	[bookmark: pgfId-1124711]Twice NAT
  
        	[bookmark: pgfId-1326429]If a match is still not found, section 3 rules are applied on a first match basis, in the order they appear in the configuration. This section should contain your most general rules. You must also ensure that any specific rules in this section come before general rules that would otherwise apply. You can specify whether to add a twice NAT rule to section 3 when you add the rule.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1090505]For section 2 rules, for example, you have the following IP addresses defined within network objects:
 
    [bookmark: pgfId-1090507]192.168.1.0/24 (static)
 
    [bookmark: pgfId-1090508]192.168.1.0/24 (dynamic)
 
    [bookmark: pgfId-1090509]10.1.1.0/24 (static)
 
    [bookmark: pgfId-1090510]192.168.1.1/32 (static)
 
    [bookmark: pgfId-1090511]172.16.1.0/24 (dynamic) (object def)
 
    [bookmark: pgfId-1090512]172.16.1.0/24 (dynamic) (object abc)
 
    [bookmark: pgfId-1090514]The resultant ordering would be:
 
    [bookmark: pgfId-1090515]192.168.1.1/32 (static)
 
    [bookmark: pgfId-1090516]10.1.1.0/24 (static)
 
    [bookmark: pgfId-1090517]192.168.1.0/24 (static)
 
    [bookmark: pgfId-1090518]172.16.1.0/24 (dynamic) (object abc)
 
    [bookmark: pgfId-1090519]172.16.1.0/24 (dynamic) (object def)
 
    [bookmark: pgfId-1090520]192.168.1.0/24 (dynamic)
 
   
 
    
     [bookmark: pgfId-1115467]NAT Interfaces[bookmark: marker-1125039]
 
    [bookmark: pgfId-1115503]You can configure a NAT rule to apply to any interface (in other words, all interfaces), or you can identify specific real and mapped interfaces. You can also specify any interface for the real address, and a specific interface for the mapped address, or vice versa.
 
    [bookmark: pgfId-1115519]For example, you might want to specify any interface for the real address and specify the outside interface for the mapped address if you use the same private addresses on multiple interfaces, and you want to translate them all to the same global pool when accessing the outside (Figure 3-17).
 
    [bookmark: pgfId-1324498]Figure 3-17 [bookmark: 97898]Specifying Any Interface
 
    [bookmark: pgfId-1324502]
 
     
     [image: ] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1167456]Note For transparent mode, you must choose specific source and destination interfaces.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1165188][bookmark: 94324][bookmark: 31793][bookmark: 33371][bookmark: 77575][bookmark: marker-1165187]Routing NAT Packets
 
    [bookmark: pgfId-1165197]The ASA needs to be the destination for any packets sent to the mapped address. The ASA also needs to determine the egress interface for any packets it receives destined for mapped addresses. This section describes how the ASA handles accepting and delivering packets with NAT, and includes the following topics:
 
     
     	 [bookmark: pgfId-1165234]Mapped Addresses and Routing
 
     	 [bookmark: pgfId-1176807]Transparent Mode Routing Requirements for Remote Networks
 
     	 [bookmark: pgfId-1165242]Determining the Egress Interface
 
    
 
     
      [bookmark: pgfId-1165189][bookmark: 31003]Mapped Addresses and Routing
 
     [bookmark: pgfId-1165193]When you translate the real address to a mapped address, the mapped address you choose determines how to configure routing, if necessary, for the mapped address.
 
     [bookmark: pgfId-1178608]See additional guidelines about mapped IP addresses in “Configuring Network Object NAT (ASA 8.3 and Later),” and Chapter5, “Configuring Twice NAT (ASA 8.3 and Later)”
 
     [bookmark: pgfId-1178647]See the following mapped address types:
 
      
      	 [bookmark: pgfId-1165190]Addresses on the same network as the mapped interface.
 
     
 
     [bookmark: pgfId-1090531]If you use addresses on the same network as the mapped interface, the ASA uses proxy ARP to answer any ARP requests for the mapped addresses, thus intercepting traffic destined for a mapped address. This solution simplifies routing because the ASA does not have to be the gateway for any additional networks. This solution is ideal if the outside network contains an adequate number of free addresses, a consideration if you are using a 1:1 translation like dynamic NAT or static NAT. Dynamic PAT greatly extends the number of translations you can use with a small number of addresses, so even if the available addresses on the outside network is small, this method can be used. For PAT, you can even use the IP address of the mapped interface.
 
      
       
     
 
     
 
     [bookmark: pgfId-1117284]Note If you configure the mapped interface to be any interface, and you specify a mapped address on the same network as one of the mapped interfaces, then if an ARP request for that mapped address comes in on a different interface, then you need to manually configure an ARP entry for that network on the ingress interface, specifying its MAC address (see Configuration > Device Management > Advanced > ARP > ARP Static Table). Typically, if you specify any interface for the mapped interface, then you use a unique network for the mapped addresses, so this situation would not occur.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1090542]Addresses on a unique network.
 
     
 
     [bookmark: pgfId-1128591]If you need more addresses than are available on the mapped interface network, you can identify addresses on a different subnet. The upstream router needs a static route for the mapped addresses that points to the ASA. Alternatively for routed mode, you can configure a static route on the ASA for the mapped addresses, and then redistribute the route using your routing protocol. For transparent mode, if the real host is directly-connected, configure the static route on the upstream router to point to the ASA: in 8.3, specify the global management IP address; in 8.4(1) and later, specify the bridge group IP address. For remote hosts in transparent mode, in the static route on the upstream router, you can alternatively specify the downstream router IP address.
 
      
      	 [bookmark: pgfId-1167807]The same address as the real address (identity NAT).
 
     
 
     [bookmark: pgfId-1317169](8.3(1), 8.3(2), and 8.4(1)) The default behavior for identity NAT has proxy ARP disabled. You cannot configure this setting.
 
     [bookmark: pgfId-1186911](8.4(2) and later) The default behavior for identity NAT has proxy ARP enabled, matching other static NAT rules. You can disable proxy ARP if desired. Note: You can also disable proxy ARP for regular static NAT if desired, in which case you need to be sure to have proper routes on the upstream router.
 
     [bookmark: pgfId-1186912]Normally for identity NAT, proxy ARP is not required, and in some cases can cause connectivity issues. For example, if you configure a broad identity NAT rule for “any” IP address, then leaving proxy ARP enabled can cause problems for hosts on the network directly-connected to the mapped interface. In this case, when a host on the mapped network wants to communicate with another host on the same network, then the address in the ARP request matches the NAT rule (which matches “any” address). The ASA will then proxy ARP for the address, even though the packet is not actually destined for the ASA. (Note that this problem occurs even if you have a twice NAT rule; although the NAT rule must match both the source and destination addresses, the proxy ARP decision is made only on the “source” address). If the ASA ARP response is received before the actual host ARP response, then traffic will be mistakenly sent to the ASA (see Figure 3-18).
 
     [bookmark: pgfId-1307646]Figure 3-18 [bookmark: 21400]Proxy ARP Problems with Identity NAT
 
     [bookmark: pgfId-1307650]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1186934]In rare cases, you need proxy ARP for identity NAT; for example for virtual Telnet. When using AAA for network access, a host needs to authenticate with the ASA using a service like Telnet before any other traffic can pass. You can configure a virtual Telnet server on the ASA to provide the necessary login. When accessing the virtual Telnet address from the outside, you must configure an identity NAT rule for the address specifically for the proxy ARP functionality. Due to internal processes for virtual Telnet, proxy ARP lets the ASA keep traffic destined for the virtual Telnet address rather than send the traffic out the source interface according to the NAT rule. (See Figure 3-19).
 
     [bookmark: pgfId-1307664]Figure 3-19 [bookmark: 14915]Proxy ARP and Virtual Telnet
 
     [bookmark: pgfId-1307668]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1176608][bookmark: 43758]Transparent Mode Routing Requirements for Remote Networks
 
     [bookmark: pgfId-1304052]When you use NAT in transparent mode,some types of traffic require static routes. See the “MAC Address vs. Route Lookups” section for more information.
 
    
 
     
      [bookmark: pgfId-1165152][bookmark: 17243]Determining the Egress Interface
 
     [bookmark: pgfId-1304861]When the ASA receives traffic for a mapped address, the ASA unstranslates the destination address according to the NAT rule, and then it sends the packet on to the real address. The ASA determines the egress interface for the packet in the following ways:
 
      
      	 [bookmark: pgfId-1167380]Transparent mode—The ASA determines the egress interface for the real address by using the NAT rule; you must specify the source and destination interfaces as part of the NAT rule.
 
      	 [bookmark: pgfId-1167247]Routed mode—The ASA determines the egress interface in one of the following ways:
 
     
 
     [bookmark: pgfId-1167222] – You configure the interface in the NAT rule—The ASA uses the NAT rule to determine the egress interface. (8.3(1) through 8.4(1)) The only exception is for identity NAT, which always uses a route lookup, regardless of the NAT configuration. (8.4(2) and later) For identity NAT, the default behavior is to use the NAT configuration. However, you have the option to always use a route lookup instead. In certain scenarios, a route lookup override is required; for example, see the “NAT and VPN Management Access” section.
 
     [bookmark: pgfId-1167223] – You do not configure the interface in the NAT rule—The ASA uses a route lookup to determine the egress interface.
 
     [bookmark: pgfId-1308184]Figure 3-20 shows the egress interface selection method in routed mode. In almost all cases, a route lookup is equivalent to the NAT rule interface, but in some configurations, the two methods might differ.
 
     [bookmark: pgfId-1308152]Figure 3-20 [bookmark: 34991]Routed Mode Egress Interface Selection
 
     [bookmark: pgfId-1308085]
 
      
      [image: ] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1285893][bookmark: 45508]NA[bookmark: marker-1285892]T for VPN
 
     
     	 [bookmark: pgfId-1285897]NAT and Remote Access VPN
 
     	 [bookmark: pgfId-1285901]NAT and Site-to-Site VPN
 
     	 [bookmark: pgfId-1285905]NAT and VPN Management Access
 
     	 [bookmark: pgfId-1285909]Troubleshooting NAT and VPN
 
    
 
     
      [bookmark: pgfId-1285911][bookmark: 89309]NAT and Remote Access VPN
 
     [bookmark: pgfId-1285915]Figure 3-21 shows both an inside server (10.1.1.6) and a VPN client (209.165.201.10) accessing the Internet. Unless you configure split tunnelling for the VPN client (where only specified traffic goes through the VPN tunnel), then Internet-bound VPN traffic must also go through the ASA. When the VPN traffic enters the ASA, the ASA decrypts the packet; the resulting packet includes the VPN client local address (10.3.3.10) as the source. For both inside and VPN client local networks, you need a public IP address provided by NAT to access the Internet. The below example uses interface PAT rules. To allow the VPN traffic to exit the same interface it entered, you also need to enable intra-interface communication (AKA “hairpin” networking).
 
     [bookmark: pgfId-1285926]Figure 3-21 [bookmark: 37346]Interface PAT for Internet-Bound VPN Traffic (Intra-Interface)
 
     [bookmark: pgfId-1285930]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1285937]Figure 3-22 shows a VPN client that wants to access an inside mail server. Because the ASA expects traffic between the inside network and any outside network to match the interface PAT rule you set up for Internet access, traffic from the VPN client (10.3.3.10) to the SMTP server (10.1.1.6) will be dropped due to a reverse path failure: traffic from 10.3.3.10 to 10.1.1.6 does not match a NAT rule, but returning traffic from 10.1.1.6 to 10.3.3.10 should match the interface PAT rule for outgoing traffic. Because forward and reverse flows do not match, the ASA drops the packet when it is received. To avoid this failure, you need to exempt the inside-to-VPN client traffic from the interface PAT rule by using an identity NAT rule between those networks. Identity NAT simply translates an address to the same address.
 
     [bookmark: pgfId-1285942]Figure 3-22 [bookmark: 15544]Identity NAT for VPN Clients
 
     [bookmark: pgfId-1285946]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1285971]Figure 3-23 [bookmark: 70844]Interface PAT and Identity NAT for Site-to-Site VPN
 
     [bookmark: pgfId-1285975]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1285979]Figure 3-24 shows a VPN client connected to ASA1 (Boulder), with a Telnet request for a server (10.2.2.78) accessible over a site-to-site tunnel between ASA1 and ASA2 (San Jose). Because this is a hairpin connection, you need to enable intra-interface communication, which is also required for non-split-tunneled Internet-bound traffic from the VPN client. You also need to configure identity NAT between the VPN client and the Boulder & San Jose networks, just as you would between any networks connected by VPN to exempt this traffic from outbound NAT rules.
 
     [bookmark: pgfId-1285981]Figure 3-24 [bookmark: 23845]VPN Client Access to Site-to-Site VPN
 
     [bookmark: pgfId-1285985]
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      [bookmark: pgfId-1286017]! Identify inside San Jose network, & perform object interface PAT when going to Internet: 
     
 
      
      [bookmark: pgfId-1286018]object network sanjose_inside 
     
 
      
      [bookmark: pgfId-1286019]subnet 10.2.2.0 255.255.255.0 
     
 
      
      [bookmark: pgfId-1286020]nat (inside,outside) dynamic interface 
     
 
      
      [bookmark: pgfId-1286021] 
     
 
      
      [bookmark: pgfId-1286022]! Identify inside Boulder network for use in twice NAT rule: 
     
 
      
      [bookmark: pgfId-1286023]object network boulder_inside 
     
 
      
      [bookmark: pgfId-1286024]subnet 10.1.1.0 255.255.255.0 
     
 
      
      [bookmark: pgfId-1286025] 
     
 
      
      [bookmark: pgfId-1286026]! Identify local VPN network for use in twice NAT rule: 
     
 
      
      [bookmark: pgfId-1286027]object network vpn_local 
     
 
      
      [bookmark: pgfId-1286028]subnet 10.3.3.0 255.255.255.0 
     
 
      
      [bookmark: pgfId-1286029] 
     
 
      
      [bookmark: pgfId-1286030]! Use twice NAT to pass traffic between the San Jose network and Boulder without 
     
 
      
      [bookmark: pgfId-1286031]! address translation (identity NAT): 
     
 
      
      [bookmark: pgfId-1286032]nat (inside,outside) source static sanjose_inside sanjose_inside destination static boulder_inside boulder_inside 
     
 
      
      [bookmark: pgfId-1286033] 
     
 
      
      [bookmark: pgfId-1286034]! Use twice NAT to pass traffic between the San Jose network and the VPN client without 
     
 
      
      [bookmark: pgfId-1286035]! address translation (identity NAT): 
     
 
      
      [bookmark: pgfId-1286036]nat (inside,outside) source static sanjose_inside sanjose_inside destination static vpn_local vpn_local 
     
 
      
      [bookmark: pgfId-1286037] 
     
 
    
 
     
      [bookmark: pgfId-1286039]NAT and [bookmark: 85867]VPN Management Access
 
     [bookmark: pgfId-1286040]When using VPN, you can allow management access to an interface other than the one from which you entered the ASA ( “Configuring Management Access Over a VPN Tunnel” section). For example, if you enter the ASA from the outside interface, the management-access feature lets you connect to the inside interface using ASDM, SSH, Telnet, or SNMP; or you can ping the inside interface.
 
     [bookmark: pgfId-1286056]Figure 3-25 shows a VPN client Telnetting to the ASA inside interface. When you use a management-access interface, and you configure identity NAT according to the “NAT and Remote Access VPN” or “NAT and Site-to-Site VPN” section, you must configure NAT with the route lookup option. Without route lookup, the ASA sends traffic out the interface specified in the NAT command, regardless of what the routing table says; in the below example, the egress interface is the inside interface. You do not want the ASA to send the management traffic out to the inside network; it will never return to the inside interface IP address. The route lookup option lets the ASA send the traffic directly to the inside interface IP address instead of to the inside network. For traffic from the VPN client to a host on the inside network, the route lookup option will still result in the correct egress interface (inside), so normal traffic flow is not affected. See the “Determining the Egress Interface” section for more information about the route lookup option.
 
     [bookmark: pgfId-1286076]Figure 3-25 [bookmark: 61157]VPN Management Access
 
     [bookmark: pgfId-1286080]
 
      
      [image: ] 
     
 
      
      	 [bookmark: pgfId-1286105]Packet tracer—When used correctly, a packet tracer shows which NAT rules a packet is hitting.
 
      	 [bookmark: pgfId-1286106] show nat detail —Shows hit counts and untranslated traffic for a given NAT rule.
 
      	 [bookmark: pgfId-1286107] show conn all —Lets you see active connections including to and from the box traffic.
 
     
 
     [bookmark: pgfId-1286108]To familiarize yourself with a non-working configuration vs. a working configuration, you can perform the following steps:
 
     [bookmark: pgfId-1286109] 1. Configure VPN without identity NAT.
 
     [bookmark: pgfId-1286110] 2. Enter show nat detail and show conn all.
 
     [bookmark: pgfId-1286111] 3. Add the identity NAT configuration.
 
      
      	 [bookmark: pgfId-1285889]Repeat  show nat detail and  show conn all .
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1090556][bookmark: 20365]DNS and N[bookmark: marker-1090554][bookmark: marker-1090555]AT
 
    [bookmark: pgfId-1090560]You might need to configure the ASA to modify DNS replies by replacing the address in the reply with an address that matches the NAT configuration. You can configure DNS modification when you configure each translation rule.
 
    [bookmark: pgfId-1310428]This feature rewrites the address in DNS queries and replies that match a NAT rule (for example, the A record for IPv4, the AAAA record for IPv6, or the PTR record for reverse DNS queries). For DNS replies traversing from a mapped interface to any other interface, the record is rewritten from the mapped value to the real value. Inversely, for DNS replies traversing from any interface to a mapped interface, the record is rewritten from the real value to the mapped value.
 
     
      
    
 
    
 
    [bookmark: pgfId-1310429]Note DNS rewrite is not applicable for PAT because multiple PAT rules are applicable for each A-record, and the PAT rule to use is ambiguous.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1310430]Note If you configure a twice NAT rule, you cannot configure DNS modification if you specify the source address as well as the destination address. These kinds of rules can potentially have a different translation for a single address when going to A vs. B. Therefore, the ASA cannot accurately match the IP address inside the DNS reply to the correct twice NAT rule; the DNS reply does not contain information about which source/destination address combination was in the packet that prompted the DNS request.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1314478]Note This feature requires DNS application inspection to be enabled, which it is by default. See the “DNS Inspection” section for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1181651]Figure 3-26 shows a DNS server that is accessible from the outside interface. A server, ftp.cisco.com, is on the inside interface. You configure the ASA to statically translate the ftp.cisco.com real address (10.1.3.14) to a mapped address (209.165.201.10) that is visible on the outside network. In this case, you want to enable DNS reply modification on this static rule so that inside users who have access to ftp.cisco.com using the real address receive the real address from the DNS server, and not the mapped address. When an inside host sends a DNS request for the address of ftp.cisco.com, the DNS server replies with the mapped address (209.165.201.10). The ASA refers to the static rule for the inside server and translates the address inside the DNS reply to 10.1.3.14. If you do not enable DNS reply modification, then the inside host attempts to send traffic to 209.165.201.10 instead of accessing ftp.cisco.com directly.
 
    [bookmark: pgfId-1090573]Figure 3-26 [bookmark: 80741]DNS Reply Modification, DNS Server on Outside
 
    [bookmark: pgfId-1090577]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1181319]Figure 3-27 shows a user on the inside network requesting the IP address for ftp.cisco.com, which is on the DMZ network, from an outside DNS server. The DNS server replies with the mapped address (209.165.201.10) according to the static rule between outside and DMZ even though the user is not on the DMZ network. The ASA translates the address inside the DNS reply to 10.1.3.14. If the user needs to access ftp.cisco.com using the real address, then no further configuration is required. If there is also a static rule between the inside and DMZ, then you also need to enable DNS reply modification on this rule. The DNS reply will then be modified two times.In this case, the ASA again translates the address inside the DNS reply to 192.168.1.10 according to the static rule between inside and DMZ.
 
    [bookmark: pgfId-1181195]Figure 3-27 [bookmark: 51368]DNS Reply Modification, DNS Server, Host, and Server on Separate Networks
 
    [bookmark: pgfId-1181220]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1181760]Figure 3-28 shows an FTP server and DNS server on the outside. The ASA has a static translation for the outside server. In this case, when an inside user requests the address for ftp.cisco.com from the DNS server, the DNS server responds with the real address, 209.165.20.10. Because you want inside users to use the mapped address for ftp.cisco.com (10.1.2.56) you need to configure DNS reply modification for the static translation.
 
    [bookmark: pgfId-1181762]Figure 3-28 [bookmark: 32827]DNS Reply Modification, DNS Server on Host Network
 
    [bookmark: pgfId-1181766]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1227879]Figure 3-28 shows an FTP server and DNS server on the outside IPv4 network. The ASA has a static translation for the outside server. In this case, when an inside IPv6 user requests the address for ftp.cisco.com from the DNS server, the DNS server responds with the real address, 209.165.200.225. Because you want inside users to use the mapped address for ftp.cisco.com (2001:DB8::D1A5:C8E1) you need to configure DNS reply modification for the static translation. This example also includes a static NAT translation for the DNS server, and a PAT rule for the inside IPv6 hosts.
 
    [bookmark: pgfId-1227880]Figure 3-29 DNS64 Reply Modification Using Outside NAT
 
    [bookmark: pgfId-1227884]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1300433]Figure 3-30 shows an FTP server and DNS server on the outside. The ASA has a static translation for the outside server. In this case, when an inside user performs a reverse DNS lookup for 10.1.2.56, the ASA modifies the reverse DNS query with the real address, and the DNS server responds with the server name, ftp.cisco.com.
 
    [bookmark: pgfId-1300438]Figure 3-30 [bookmark: 11565]PTR Modification, DNS Server on Host Network
 
    [bookmark: pgfId-1300442]
 
     
     [image: ] 
    
 
   
 
    
     [bookmark: pgfId-1101626][bookmark: 89097][bookmark: 29596]Where to Go Next
 
    [bookmark: pgfId-1091016]To configure network object NAT, see Chapter4, “Configuring Network Object NAT (ASA 8.3 and Later)” 
 
    [bookmark: pgfId-1091025]To configure twice NAT, see Chapter5, “Configuring Twice NAT (ASA 8.3 and Later)”
 
    [bookmark: pgfId-1068794]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1043201][bookmark: 16871]Configuring Access Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1043202]This chapter describes how to control network access through the ASA using access rules and includes the following sections:
 
     
     	 [bookmark: pgfId-1057264]Information About Access Rules
 
     	 [bookmark: pgfId-1057268]Licensing Requirements for Access Rules
 
     	 [bookmark: pgfId-1046652]Guidelines and Limitations
 
     	 [bookmark: pgfId-1068149]Default Settings
 
     	 [bookmark: pgfId-1046685]Configuring Access Rules
 
     	 [bookmark: pgfId-1068119]Feature History for Access Rules
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1227770]Note You use access rules to control network access in both routed and transparent firewall modes. In transparent mode, you can use both access rules (for Layer 3 traffic) and EtherType rules (for Layer 2 traffic).

To access the ASA interface for management access, you do not also need an access rule allowing the host IP address. You only need to configure management access according to “Configuring Management Access,” in the general operations configuration guide.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1227779]Information About [bookmark: 27167]Access Rules
 
    [bookmark: pgfId-1274222] Your access policy is [bookmark: marker-1274221]made up of one or more access rules and/or EtherType rules per interface or globally for all interfaces.
 
    [bookmark: pgfId-1083499]You can use access rules in routed and transparent firewall mode to control IP traffic. An access rule permits or denies traffic based on the protocol, a source and destination IP address or network, and optionally the source and destination ports.
 
    [bookmark: pgfId-1083507]For transparent mode only, an EtherType rule controls network access for non-IP traffic. An EtherType rule permits or denies traffic based on the EtherType.
 
    [bookmark: pgfId-1083508]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1083512]General Information About Rules
 
     	 [bookmark: pgfId-1083516]Information About Access Rules
 
     	 [bookmark: pgfId-1083520]Information About EtherType Rules
 
    
 
     
      [bookmark: pgfId-1083522][bookmark: 81018]General Information About Rules
 
     [bookmark: pgfId-1083523]This section describes information for both access rules and EtherType rules, and it includes the following topics:
 
      
      	 [bookmark: pgfId-1083527]Implicit Permits
 
      	 [bookmark: pgfId-1194529]Information About Interface Access Rules and Global Access Rules
 
      	 [bookmark: pgfId-1112238]Using Access Rules and EtherType Rules on the Same Interface
 
      	 [bookmark: pgfId-1274243]Rule Order
 
      	 [bookmark: pgfId-1193820]Implicit Deny
 
      	 [bookmark: pgfId-1274251]Using Remarks
 
      	 [bookmark: pgfId-1274255]NAT and Access Rules
 
      	 [bookmark: pgfId-1268760]Inbound and Outbound Rules
 
      	 [bookmark: pgfId-1269885]Transactional-Commit Model
 
     
 
    
 
     
      [bookmark: pgfId-1268762][bookmark: 48682]Implicit Permits
 
     [bookmark: pgfId-1268763]For routed mode, the following types of traffic are allowed through by default:
 
      
      	 [bookmark: pgfId-1112119]Unicast IPv4 traffic from a higher security interface to a lower security interface.
 
      	 [bookmark: pgfId-1112120]Unicast IPv6 traffic from a higher security interface to a lower security interface.
 
     
 
     [bookmark: pgfId-1112121]For transparent mode, the following types of traffic are allowed through by default:
 
      
      	 [bookmark: pgfId-1112122]Unicast IPv4 traffic from a higher security interface to a lower security interface.
 
      	 [bookmark: pgfId-1112123]Unicast IPv6 traffic from a higher security interface to a lower security interface.
 
      	 [bookmark: pgfId-1112124]ARPs in both directions.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1112125]Note ARP traffic can be controlled by ARP inspection, but cannot be controlled by an access rule.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1112126]BPDUs in both directions.
 
     
 
     [bookmark: pgfId-1112127]For other traffic, you need to use either an access rule (IPv4 and IPv6) or an EtherType rule (non-IPv4/IPv6).
 
    
 
     
      [bookmark: pgfId-1194648][bookmark: 39208]Information About Interface Access Rules and Global Access Rules[bookmark: marker-1194647] 
 
     [bookmark: pgfId-1194649]You can apply an access rule to a specific interface, or you can apply an access rule globally to all interfaces. You can configure global access rules in conjunction with interface access rules, in which case, the specific interface access rules are always processed before the general global access rules.
 
      
       
     
 
     
 
     [bookmark: pgfId-1194652]Note Global access rules apply only to inbound traffic. See the “Inbound and Outbound Rules” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1083543][bookmark: 70047][bookmark: 71236]Using Access Rules an[bookmark: marker-1083542]d EtherType Rules on the Same Interface
 
     [bookmark: pgfId-1083544]You can apply both access rules and EtherType rules to each direction of an interface.
 
    
 
     
      [bookmark: pgfId-1274314][bookmark: 92504]Rule Order
 
     [bookmark: pgfId-1274321]The order of rules is important. When the ASA decides whether to forward or drop a packet, the ASA tests the packet against each rule in the order in which the rules are listed. After a match is found, no more rules are checked. For example, if you create an access rule at the beginning that explicitly permits all traffic for an interface, no further rules are ever checked. For more information, see the “Implicit Deny” section.
 
     [bookmark: pgfId-1274325]You can disable a rule by making it inactive.
 
    
 
     
      [bookmark: pgfId-1186609][bookmark: 12364]Implicit Deny
 
     [bookmark: pgfId-1194706]ACLs have an implicit deny at the end of the list, so unless you explicitly permit it, [bookmark: marker-1194705]traffic cannot pass. For example, if you want to allow all users to access a network through the ASA except for particular addresses, then you need to deny the particular addresses and then permit all others.
 
     [bookmark: pgfId-1194711]For EtherT[bookmark: marker-1194710]ype ACLs, the implicit deny at the end of the ACL does not affect IP traffic or ARPs; for example, if you allow EtherType 8037, the implicit deny at the end of the ACL does not now block any IP traffic that you previously allowed with an extended ACL (or implicitly allowed from a high security interface to a low security interface). However, if you explicitly deny all traffic with an EtherType ACE, then IP and ARP traffic is denied.
 
     [bookmark: pgfId-1194712]If you configure a global access rule, then the implicit deny comes after the global rule is processed. See the following order of operations:
 
     [bookmark: pgfId-1194713] 1. Interface access rule.
 
     [bookmark: pgfId-1194714] 2. Global access rule.
 
     [bookmark: pgfId-1194715] 3. Implicit deny.
 
    
 
     
      [bookmark: pgfId-1274331][bookmark: 12785]Using Remarks
 
     [bookmark: pgfId-1274332]In the ASDM access rule window, a remark that displays next to the rule is the one that was configured before the rule, so when you configure a remark from the CLI and then view it in an ASDM access rule window, the remark displays next to the rule that was configured after the remark in the CLI. However, the packet tracer in ASDM matches the remark that is configured after the matching rule in the CLI.
 
    
 
     
      [bookmark: pgfId-1274334][bookmark: 23449]NAT and Access Rules
 
     [bookmark: pgfId-1274335]Access rules always use the real IP addresses when determining an access rule match, even if you configure NAT. For example, if you configure NAT for an inside server, 10.1.1.5, so that it has a publicly routable IP address on the outside, 209.165.201.5, then the access rule to allow the outside traffic to access the inside server needs to reference the server’s real IP address (10.1.1.5), and not the mapped address (209.165.201.5).
 
    
 
     
      [bookmark: pgfId-1083569][bookmark: 38915]Inbound and Outboun[bookmark: marker-1083566][bookmark: marker-1083567][bookmark: marker-1083568]d Rules[bookmark: marker-1084861][bookmark: marker-1084873][bookmark: marker-1084901][bookmark: marker-1084913][bookmark: marker-1084925][bookmark: marker-1084937]
 
     [bookmark: pgfId-1083574]The ASA supports two types of ACLs:
 
      
      	 [bookmark: pgfId-1194788]Inbound—Inbound access rules apply to traffic as it enters an interface. Global access rules are always inbound.
 
      	 [bookmark: pgfId-1083576]Outbound—Outbound ACLs apply to traffic as it exits an interface.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1083577]Note “Inbound” and “outbound” refer to the application of an ACL on an interface, either to traffic entering the ASA on an interface or traffic exiting the ASA on an interface. These terms do not refer to the movement of traffic from a lower security interface to a higher security interface, commonly known as inbound, or from a higher to lower interface, commonly known as outbound.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1083585]An outbound ACL is useful, for example, if you want to allow only certain hosts on the inside networks to access a web server on the outside network. Rather than creating multiple inbound ACLs to restrict access, you can create a single outbound ACL that allows only the specified hosts. (See Figure 7-1.) The outbound ACL prevents any other hosts from reaching the outside network.
 
     [bookmark: pgfId-1083589]Figure 7-1 [bookmark: 63128]Outbound ACL
 
     [bookmark: pgfId-1083593]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1270273][bookmark: 61351]Transactional-Commit Model
 
     [bookmark: pgfId-1270274]The ASA rule-engine supports a new feature for rule updation called the Transactional-Commit Model. When this feature is enabled, a rule update is applied after the rule compilation is completed; without affecting the rule matching performance. With the legacy model, rule updates take effect immediately but rule matching slows down during the rule compilation period. This feature is useful to prevent potential packet drops during large compilation of rules under high traffic conditions. This feature is also useful to reduce the rule compilation time under two specific patterns of configurations:
 
      
      	 [bookmark: pgfId-1270275]Preventing packet drops while compiling large rules during high traffic rates.
 
      	 [bookmark: pgfId-1270276]Reducing rule compilation time while updating a large number of similar rules.
 
     
 
    
 
     
      [bookmark: pgfId-1270277]Guidelines and Limitations
 
     [bookmark: pgfId-1270278]Context Mode Guidelines
 
     [bookmark: pgfId-1270279]Supported in single and multiple context mode.
 
     [bookmark: pgfId-1270280]Firewall Mode Guidelines
 
     [bookmark: pgfId-1270281]Supported in routed and transparent firewall mode. 
 
     [bookmark: pgfId-1270282]IPv6 Guidelines
 
     [bookmark: pgfId-1270283]Supports IPv6.
 
     [bookmark: pgfId-1270285][bookmark: 23253]Additional Guidelines and Limitations
 
     [bookmark: pgfId-1270286]Evaluate the following alternatives before using the transactional commit model:
 
      
      	 [bookmark: pgfId-1270287]While using large rules, try to optimize the number of rules by using the Object Group Search setting in Advanced Access Rule Configuration settings. For more information see, Advanced Access Rule Configuration.
 
      	 [bookmark: pgfId-1270291]Perform an incremental rule update instead of a bulk rule update. If a bulk update is necessary perform the bulk update during the maintenance window, when traffic is low.
 
     
 
    
 
     
      [bookmark: pgfId-1266767][bookmark: 47440][bookmark: 51074]Information About Access Rules
 
     [bookmark: pgfId-1266768]This section describes information about access rules and includes the following topics:
 
      
      	 [bookmark: pgfId-1083600]Access Rules for Returning Traffic
 
      	 [bookmark: pgfId-1083603]Allowing Broadcast and Multicast Traffic through the Transparent Firewall Using Access Rules
 
      	 [bookmark: pgfId-1086846]Management Access Rules
 
     
 
    
 
     
      [bookmark: pgfId-1083607][bookmark: 17901]Access Rules for Returning Traffic
 
     [bookmark: pgfId-1083608]For TCP and UDP connections for both routed and transparent mode, you do not need an access rule to allow returning traffic because the ASA allows all returning traffic for established, bidirectional connections.
 
     [bookmark: pgfId-1111209]For connectionless protocols such as ICMP, however, the ASA establishes unidirectional sessions, so you either need access rules to allow ICMP in both directions (by applying ACLs to the source and destination interfaces), or you need to enable the ICMP inspection engine. The ICMP inspection engine treats ICMP sessions as bidirectional connections.
 
    
 
     
      [bookmark: pgfId-1111741][bookmark: 21471]Allowing Broadcast and Multicast Traffic through the[bookmark: marker-1083616] Transparent Firewall[bookmark: marker-1083617] Using Access Rules
 
     [bookmark: pgfId-1083619]In routed firewall mode, broadcast and multicast traffic is blocked even if you allow it in an access rule, including unsupported dynamic routing protocols and DHCP (unless you configure DHCP relay). Transparent firewall mode can allow any IP traffic through.
 
      
       
     
 
     
 
     [bookmark: pgfId-1083620]Note Because these special types of traffic are connectionless, you need to apply an access rule to both interfaces, so returning traffic is allowed through.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1083624]Table 7-1 lists common traffic types that you can allow through the transparent firewall.
 
     [bookmark: pgfId-1083678]
 
      
       
        
        [bookmark: pgfId-1083631]Table 7-1 [bookmark: 49151]Transparent Firewall Special Traffic 
 
        
        
         
         	 
           
           [bookmark: pgfId-1083637]Traffic Type 
          
  
         	 
           
           [bookmark: pgfId-1083639]Protocol or Port 
          
  
         	 
           
           [bookmark: pgfId-1083641]Notes 
          
  
        
 
         
         	[bookmark: pgfId-1083645][bookmark: marker-1083643][bookmark: marker-1083644]DHCP
  
         	[bookmark: pgfId-1083647]UDP ports 67 and 68
  
         	[bookmark: pgfId-1083651]If you enable the DHCP server, then the ASA does not pass DHCP packets.
  
        
 
         
         	[bookmark: pgfId-1083655][bookmark: marker-1083654]EIGRP
  
         	[bookmark: pgfId-1083657]Protocol 88
  
         	[bookmark: pgfId-1083659]—
  
        
 
         
         	[bookmark: pgfId-1083661]OSPF
  
         	[bookmark: pgfId-1083663]Protocol 89
  
         	[bookmark: pgfId-1083665]—
  
        
 
         
         	[bookmark: pgfId-1083667]Multicast streams
  
         	[bookmark: pgfId-1083669]The UDP ports vary depending on the application.
  
         	[bookmark: pgfId-1083671]Multicast streams are always destined to a Class D address (224.0.0.0 to 239.x.x.x).
  
        
 
         
         	[bookmark: pgfId-1083673]RIP (v1 or v2)
  
         	[bookmark: pgfId-1083675]UDP port 520
  
         	[bookmark: pgfId-1083677]—
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1086468][bookmark: 26030]Management Access Rules
 
     [bookmark: pgfId-1086561]You can configure access rules that control management traffic destined to the ASA. Access control rules for to-the-box management traffic (such as HTTP, Telnet, and SSH) have higher precedence than an management access rule. Therefore, such permitted management traffic will be allowed to come in even if explicitly denied by the to-the-box ACL. 
 
    
 
     
      [bookmark: pgfId-1083680]Information About [bookmark: 77107]EtherType Rules
 
     [bookmark: pgfId-1083681]This section describes EtherType rules and includes the following topics:
 
      
      	 [bookmark: pgfId-1083685]Supported EtherTypes and Other Traffic
 
      	 [bookmark: pgfId-1112546]Access Rules for Returning Traffic
 
      	 [bookmark: pgfId-1083697]Allowing MPLS
 
     
 
    
 
     
      [bookmark: pgfId-1083699][bookmark: 60214]Supported EtherTypes and Other Traffic
 
     [bookmark: pgfId-1221134]An EtherType rule controls the following:
 
      
      	 [bookmark: pgfId-1221508]EtherType identified by a 16-bit hexadecimal number, including common types IPX and MPLS unicast or multicast.
 
      	 [bookmark: pgfId-1083701]Ethernet V2 frames.
 
      	 [bookmark: pgfId-1221339]BPDUs, which are permitted by default. BPDUs are SNAP-encapsulated, and the ASA is designed to specifically handle BPDUs.
 
      	 [bookmark: pgfId-1221346]Trunk port (Cisco proprietary) BPDUs. Trunk BPDUs have VLAN information inside the payload, so the ASA modifies the payload with the outgoing VLAN if you allow BPDUs.
 
      	 [bookmark: pgfId-1248592]IS-IS.
 
     
 
     [bookmark: pgfId-1221215]The following types of traffic are not supported:
 
      
      	 [bookmark: pgfId-1083702]802.3-formatted frames—These frames are not handled by the rule because they use a length field as opposed to a type field.
 
     
 
    
 
     
      [bookmark: pgfId-1112500][bookmark: 44016]Access Rules for Returning Traffic
 
     [bookmark: pgfId-1112501]Because EtherTypes are connectionless, you need to apply the rule to both interfaces if you want traffic to pass in both directions.
 
    
 
     
      [bookmark: pgfId-1083723][bookmark: 53682]Allowing MPLS
 
     [bookmark: pgfId-1083724]If you allow MPLS, ensure that Label Distribution Protocol and Tag Distribution Protocol TCP connections are established through the ASA by configuring both MPLS routers connected to the ASA to use the IP address on the ASA interface as the router-id for LDP or TDP sessions. (LDP and TDP allow MPLS routers to negotiate the labels (addresses) used to forward packets.)
 
     [bookmark: pgfId-1083734]On Cisco IOS routers, enter the appropriate command for your protocol, LDP or TDP. The interface is the interface connected to the ASA.
 
      
      [bookmark: pgfId-1083744]ciscoasa(config)# mpls ldp router-id[bookmark: marker-1083741][bookmark: marker-1083742][bookmark: marker-1083743] interface force 
     
 
      
      [bookmark: pgfId-1083745] 
     
 
     [bookmark: pgfId-1083746]Or
 
      
      [bookmark: pgfId-1083750]ciscoasa(config)# tag-switching tdp router-id interface force 
     
 
      
      [bookmark: pgfId-1084884] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1095316][bookmark: 29596]Licensing Requirements for Access Rules
 
    [bookmark: pgfId-1280190]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1280183]Model 
         
  
        	 
          
          [bookmark: pgfId-1280185]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1280187]All models
  
        	[bookmark: pgfId-1280189]Base License.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1080863][bookmark: 81207][bookmark: 16098][bookmark: 58316]Guidelines and Limitations
 
    [bookmark: pgfId-1071208]This section includes the guidelines and limitations for this feature.
 
    [bookmark: pgfId-1071231][bookmark: 87419]Context Mo[bookmark: marker-1071230]de Guidelines
 
    [bookmark: pgfId-1071232]Supported in single and multiple context mode.
 
    [bookmark: pgfId-1071235][bookmark: 16807]Firewall Mode Guidelines
 
    [bookmark: pgfId-1071236]Supported in routed and transparent firewall modes.
 
    [bookmark: pgfId-1081429][bookmark: 90732]IPv6 Guidelines
 
    [bookmark: pgfId-1081430]Supports IPv6. (9.0 and later) The source and destination addresses can include any mix of IPv4 and IPv6 addresses. For pre-9.0 versions, you must create a separate IPv6 access rule.
 
     
      [bookmark: pgfId-1231224][bookmark: 60355]Default [bookmark: marker-1231223]Settings
 
     [bookmark: pgfId-1086770]See the “Implicit Permits” section.
 
    
 
     
      [bookmark: pgfId-1268936][bookmark: 71793]Configuring Access Rules
 
     [bookmark: pgfId-1274518]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1274522]Adding an Access Rule
 
      	 [bookmark: pgfId-1274526]Adding an EtherType Rule (Transparent Mode Only)
 
      	 [bookmark: pgfId-1274530]Configuring Management Access Rules
 
      	 [bookmark: pgfId-1274534]Advanced Access Rule Configuration
 
      	 [bookmark: pgfId-1274538]Configuring HTTP Redirect
 
      	 [bookmark: pgfId-1274542]Configuring Transactional Commit Model
 
     
 
    
 
     
      [bookmark: pgfId-1274547][bookmark: 37398]Adding an Access Rule 
 
     [bookmark: pgfId-1267710]To apply an access rule, perform the following steps.
 
    
 
     
      [bookmark: pgfId-1111909]Detailed Steps
 
     
 
     [bookmark: pgfId-1274552]Step 1 Choose Configuration > Firewall > Access Rules.
 
     [bookmark: pgfId-1274553]Step 2 Click Add, and choose one of the following options:
 
     [bookmark: pgfId-1274554]The Add Access Rule dialog box appears.
 
     [bookmark: pgfId-1274555]Step 3 From the Interface drop-down list, choose the interface on which to apply the rule. Choose Any to apply a global rule.
 
     [bookmark: pgfId-1274556]Step 4 In the Action field, click one of the following radio buttons next to the desired action:
 
      
       
       	 [bookmark: pgfId-1274557] Permit —Permits access if the conditions are matched.
 
       	 [bookmark: pgfId-1274558] Deny —Denies access if the conditions are matched.
 
      
 
     
 
     [bookmark: pgfId-1274559]Step 5 In the Source field, enter an IP address that specifies the network, interface IP, or any address from which traffic is permitted or denied to the specified destination. You may use either an IPv4 or IPv6 address.
 
     [bookmark: pgfId-1274562]For more information about enabling IPv6 on an interface, see the “Configuring IPv6 Addressing” section in the general operations configuration guide.
 
     [bookmark: pgfId-1274567]Step 6 In the User field, enter a user name or group to the ACL. Enter the user name in the format domain_NetBIOS_name\user_name. Enter the group name in the format domain_NetBIOS_name\group_name. 
 
     [bookmark: pgfId-1274568]You can configure access rules based on user names and user group names rather than through source IP addresses. The ASA applies the security policies based on an association of IP addresses to Windows Active Directory login information and reports events based on the mapped user names instead of network IP addresses.
 
     [bookmark: pgfId-1274577]See the “Configuring Identity-Based Security Policy” section in the general operations configuration guide for more information. 
 
     [bookmark: pgfId-1274579]Step 7 To browse for a user name or user group, click the ellipsis (...) button. The Browse User dialog box appears.
 
     [bookmark: pgfId-1274580]Step 8 In the Destination field, enter an IP address that specifies the network, interface IP, any address to which traffic is permitted or denied from the source specified in the Source field. You may use either an IPv4 or IPv6 address.
 
     [bookmark: pgfId-1274581]Step 9 Select the service type.
 
     [bookmark: pgfId-1274582]Step 10 (Optional) To add a time range to your access rule that specifies when traffic can be allowed or denied, click More Options to expand the list.
 
     [bookmark: pgfId-1274583] a. To the right of the Time Range drop down list, click the browse button. 
 
     [bookmark: pgfId-1274584]The Browse Time Range dialog box appears.
 
     [bookmark: pgfId-1274585] b. Click Add.
 
     [bookmark: pgfId-1274586]The Add Time Range dialog box appears.
 
     [bookmark: pgfId-1274587] c. In the Time Range Name field, enter a time range name, with no spaces.
 
     [bookmark: pgfId-1274588] d. Choose the Start Time and the End Time.
 
     [bookmark: pgfId-1274589] e. To specify additional time constraints for the time range, such as specifying the days of the week or the recurring weekly interval in which the time range will be active, click Add, and choose the specifications.
 
     [bookmark: pgfId-1274590] f. Click OK to apply the optional time range specifications.
 
     [bookmark: pgfId-1274591]Step 11 (Optional) In the Description field, add a text description about the access rule.
 
     [bookmark: pgfId-1274592]The description can contain multiple lines; however, each line can be no more than 100 characters in length.
 
     [bookmark: pgfId-1274593]Step 12 (Optional) Logging is enabled by default. You can disable logging by unchecking the check box, or you can change the logging level from the drop-down list. The default logging level is Informational.
 
     [bookmark: pgfId-1274594]Step 13 Click OK. The access rule appears with the newly configured access rules.
 
     [bookmark: pgfId-1274595]Step 14 Click Apply to save the access rule to your configuration.
 
     [bookmark: pgfId-1274596]You can edit or delete a particular access rule by selecting the rule and then clicking Edit or Delete.
 
     [bookmark: pgfId-1274597]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1274650][bookmark: 37128]Adding an EtherType Rule (Transparent Mode Only) 
 
     [bookmark: pgfId-1274651]The EtherType Rules window shows access rules based on packet EtherTypes. EtherType rules are used to configure non-IP related traffic policies through the ASA when operating in transparent mode. In transparent mode, you can apply both extended and EtherType access rules to an interface. EtherType rules take precedence over the extended access rules.
 
     [bookmark: pgfId-1274657]For more information about EtherType rules, see the “Information About Access Rules” section.
 
     [bookmark: pgfId-1274659]To add an EtherType rule, perform the following steps:
 
     
 
     [bookmark: pgfId-1274660]Step 1 Choose Configuration > Device Management > Management Access > EtherType Rules. 
 
     [bookmark: pgfId-1274661]Step 2 Click Add.
 
     [bookmark: pgfId-1274662]The Add EtherType rules window appears.
 
     [bookmark: pgfId-1274663]Step 3 (Optional) To specify the placement of the new EtherType rule, select an existing rule, and click Insert... to add the EtherType rule before the selected rule, or click Insert After... to add the EtherType rule after the selected rule. 
 
     [bookmark: pgfId-1274664]Step 4 From the Interface drop-down list, choose the interface on which to apply the rule. Choose Any to apply a global rule.
 
     [bookmark: pgfId-1274665]Step 5 In the Action field, click one of the following radio buttons next to the desired action:
 
      
       
       	 [bookmark: pgfId-1274666] Permit —Permits access if the conditions are matched.
 
       	 [bookmark: pgfId-1274667] Deny —Denies access if the conditions are matched.
 
      
 
     
 
     [bookmark: pgfId-1274668]Step 6 In the EtherType field, choose an EtherType value from the drop-down list.
 
     [bookmark: pgfId-1274669]Step 7 (Optional) In the Description field, add a test description about the rule.
 
     [bookmark: pgfId-1274670]The description can contain multiple lines; however, each line can be no more than 100 characters in length.
 
     [bookmark: pgfId-1274671]Step 8 (Optional) To specify the direction for this rule, click More Options to expand the list, and then specify the direction by clicking one of the following radio buttons:
 
      
       
       	 [bookmark: pgfId-1274672] In —Incoming traffic
 
       	 [bookmark: pgfId-1274673] Out —Outgoing traffic
 
      
 
     
 
     [bookmark: pgfId-1274674]Step 9 Click OK.
 
     [bookmark: pgfId-1274675]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1274679][bookmark: 96544]Configuring Management Access Rules 
 
     [bookmark: pgfId-1274680]You can configure an interface ACL that supports access control for to-the-box management traffic from a specific peer (or set of peers) to the security appliance. One scenario in which this type of ACL would be useful is when you want to block IKE Denial of Service attacks.
 
     [bookmark: pgfId-1274681]To configure an extended ACL that permits or denies packets for to-the-box traffic, perform the following steps:
 
     
 
     [bookmark: pgfId-1274682]Step 1 Choose Configuration > Device Management > Management Access > Management Access Rules. 
 
     [bookmark: pgfId-1274683]Step 2 Click Add, and choose one of the following actions:
 
     [bookmark: pgfId-1274684]The Add Management Access Rule dialog box appears.
 
     [bookmark: pgfId-1274685]Step 3 From the Interface drop-down list, choose an interface on which to apply the rule. Choose Any to apply a global rule.
 
     [bookmark: pgfId-1274686]Step 4 In the Action field, click one of the following radio buttons to choose the action:
 
      
       
       	 [bookmark: pgfId-1274687] Permit —Permits access if the conditions are matched.
 
       	 [bookmark: pgfId-1274688] Deny —Denies access if the conditions are matched.
 
      
 
     
 
     [bookmark: pgfId-1274689]Step 5 In the Source field, enter an IP address that specifies the network object group, interface IP, or any address from which traffic is permitted or denied. You may use either an IPv4 or IPv6 address. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1274690]Note IPv6 must be enabled on at least one interface before you can configure an extended ACL with an IPv6 address. For more information about enabling IPv6 on an interface, see the “Configuring IPv6 Addressing” section in the general operations configuration guide.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1274697]Step 6 In the Service field, add a service name for rule traffic, or click the ellipsis (...) to browse for a service.
 
     [bookmark: pgfId-1274698]Step 7 (Optional) In the Description field, add a description for this management access rule.
 
     [bookmark: pgfId-1274699]The description can contain multiple lines; however, each line can be no more than 100 characters in length.
 
     [bookmark: pgfId-1274700]Step 8 (Optional) Logging is enabled by default. You can disable logging by unchecking the check box, or you can change the logging level from the drop-down list. The default logging level is Informational.
 
     [bookmark: pgfId-1274701]Step 9 (Optional) To add a source service (TCP, UDP, and TCP-UDP only) and a time range to your access rule that specifies when traffic can be allowed or denied, click More Options to expand the list.If you want to turn off this Management Access Rule, uncheck Enable Rule.
 
      
       
       	 [bookmark: pgfId-1274702]Add a source service in the Source Service field, or click the ellipsis (...) to browse for a service. 
 
      
 
     
 
     [bookmark: pgfId-1274703]The destination service and source service must be the same. Copy and paste the destination Service field to the Source Service field.
 
      
       
       	 [bookmark: pgfId-1274704]To configure the logging interval (if you enable logging and choose a non-default setting), enter a value in seconds in the Logging Interval field.
 
       	 [bookmark: pgfId-1274705]To select a predefined time range for this rule, from the Time Range drop-down list, choose a time range; or click the ellipsis (...) to browse for a time range. You can also specify additional time constraints for the time range, such as specifying the days of the week or the recurring weekly interval in which the time range will be active.
 
      
 
     
 
     [bookmark: pgfId-1274706]Step 10 Click OK. The dialog box closes, and the Management Access rule is added.
 
     [bookmark: pgfId-1274707]Step 11 Click Apply. The rule is saved in the running configuration.
 
     [bookmark: pgfId-1274708]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1274712][bookmark: 69936][bookmark: 28302]Advanced Access Rule Configuration
 
     [bookmark: pgfId-1274713]The Advanced Access Rule Configuration dialog box lets you to set global access rule logging options. 
 
     [bookmark: pgfId-1274717]When you enable logging, if a packet matches the access rule, the ASA creates a flow entry to track the number of packets received within a specific interval. The ASA generates a system log message at the first hit and at the end of each interval, identifying the total number of hits during the interval and reporting the time of the last hit. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1274724]Note The ASApane displays the hit count information in the “last rule hit” row. To view the rule hit count and timestamp, choose Configuration > Firewall > Advanced > ACL Manager, and hover the mouse pointer over a cell in the ACL Manager table. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1274728]At the end of each interval, the ASA resets the hit count to 0. If no packets match the access rule during an interval, the ASA deletes the flow entry.
 
     [bookmark: pgfId-1274732]A large number of flows can exist concurrently at any point of time. To prevent unlimited consumption of memory and CPU resources, the ASA places a limit on the number of concurrent deny flows; the limit is placed only on deny flows (and not permit flows) because they can indicate an attack. When the limit is reached, the ASA does not create a new deny flow until the existing flows expire. If someone initiates a denial of service attack, the ASA can create a very large number of deny flows in a very short period of time. Restricting the number of deny-flows prevents unlimited consumption of memory and CPU resources.
 
     [bookmark: pgfId-1274742]Prerequisites
 
     [bookmark: pgfId-1274743]These settings only apply if you enable the newer logging mechanism for the access rule.
 
     [bookmark: pgfId-1274744]Fields
 
      
      	 [bookmark: pgfId-1274748]Maximum Deny-flows—The maximum number of deny flows permitted before the ASA stops logging, between 1 and the default value. The default is 4096.
 
      	 [bookmark: pgfId-1274749]Alert Interval—The amount of time (1-3600 seconds) between system log messages (number 106101) that identify that the maximum number of deny flows was reached. The default is 300 seconds.
 
      	 [bookmark: pgfId-1274750]Per User Override table—Specifies the state of the per user override feature. If the per user override feature is enabled on the inbound access rule, the access rule provided by a RADIUS server replaces the access rule configured on that interface. If the per user override feature is disabled, the access rule provided by the RADIUS server is combined with the access rule configured on that interface. If the inbound access rule is not configured for the interface, per user override cannot be configured.
 
     
 
     [bookmark: pgfId-1280128]By default, VPN remote access traffic is not matched against interface ACLs. However, if you deselect the Enable inbound VPN sessions to bypass interface access lists setting on the Configuration > Remote Access VPN > Network (Client) Access > AnyConnect Connection Profiles pane), the behavior depends on whether there is a VPN filter applied in the group policy (see the Configuration > Remote Access VPN > Network (Client) Access > Group Policies > Add/Edit > General > More Options > Filter field) and whether you set the Per User Override option:
 
     [bookmark: pgfId-1280129] – No Per User Override, no VPN filter —Traffic is matched against the interface ACL.
 
     [bookmark: pgfId-1280130] – No Per User Override, VPN filter —Traffic is matched first against the interface ACL, then against the VPN filter.
 
     [bookmark: pgfId-1280131] – Per User Override, VPN filter —Traffic is matched against the VPN filter only.
 
      
      	 [bookmark: pgfId-1274755]Object Group Search Setting—Reduces the amount of memory used to store service rules, but lengthens the amount of time to search for a matching access rule.
 
     
 
    
 
     
      [bookmark: pgfId-1274756]Access Rule Explosion
 
     [bookmark: pgfId-1274758]The security appliance allows you to turn[bookmark: marker-1274757] off the expansion of access rules that contain certain object groups. When expansion is turned off, an object group search is used for lookup, which lowers the memory requirements for storing expanded rules but decreases the lookup performance. Because of the trade-off of performance for memory utilization, you can turn on and turn off the search.
 
     [bookmark: pgfId-1274759]To configure the option of turning off the expansion of access rules that contain s, perform the following steps:
 
     
 
     [bookmark: pgfId-1274760]Step 1 Choose Configuration > Firewall > Access Rules.
 
     [bookmark: pgfId-1274761]Step 2 Click the Advanced button.
 
     [bookmark: pgfId-1274762]Step 3 Check the Enable Object Group Search Algorithm check box.
 
     [bookmark: pgfId-1274763]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1274768][bookmark: 12994]Configuring HTTP Redirect 
 
     [bookmark: pgfId-1274772]The HTTP Redirect table displays each interface on the ASA, shows whether it is configured to redirect HTTP connections to HTTPS, and the port number from which it redirects those connections.
 
      
       
     
 
     
 
     [bookmark: pgfId-1274773]Note To redirect HTTP, the interface requires an ACL that permits HTTP. Otherwise, the interface cannot listen to the HTTP port.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1274774]The Configuration > Device Management > Advanced > HTTP Redirect > Edit pane lets you change the HTTP redirect setting of an interface or the port from which it redirects HTTP connections. Select the interface in the table and click Edit. You can also double-click an interface. The Edit HTTP/HTTPS Settings dialog box opens.
 
    
 
     
      [bookmark: pgfId-1274775]Edit HTTP/HTTPS Settings
 
     [bookmark: pgfId-1274776]The Edit HTTP/HTTPS Settings dialog box lets you change the HTTP redirect setting of an interface or the port number.
 
     [bookmark: pgfId-1274778]Fields
 
     [bookmark: pgfId-1274779]The Edit HTTP/HTTPS Settings dialog box includes the following fields:
 
      
      	 [bookmark: pgfId-1274783] Interface—Identifies the interface on which the ASA redirects or does not redirect HTTP requests to HTTPS. 
 
      	 [bookmark: pgfId-1274784] Redirect HTTP to HTTPS—Check to redirect HTTP requests to HTTPS, or uncheck to not redirect HTTP requests to HTTPS. 
 
      	 [bookmark: pgfId-1274785] HTTP Port—Identifies the port  from which the interface redirects HTTP connections . By default it listens to port 80. 
 
     
 
     [bookmark: pgfId-1274788]For more information about access rules, see the “Information About Access Rules” section.
 
    
 
     
      [bookmark: pgfId-1274791][bookmark: 18205]Configuring Transactional Commit Model
 
     [bookmark: pgfId-1274792]The ASA allows you to enable the Transactional commit model on the rule engine for access groups. With this model, new rules will not take effect until the rules are compiled and stable. During compilation packets will continue to match the old rules, but the connections per second limit will remain unaffected. 
 
     [bookmark: pgfId-1274793]To enable the Transactional Commit Model, perform the following steps:
 
     
 
     [bookmark: pgfId-1274794]Step 1 Choose Configuration > Device Management > Advanced > Rule Engine.
 
     [bookmark: pgfId-1274795]Step 2 Check the Enable Transactional commit model on Rule engine for Access Groups check box.
 
     [bookmark: pgfId-1274796]Step 3 Click Apply.
 
     [bookmark: pgfId-1274797]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1112632][bookmark: 92503]Feature History for Access Rules
 
    [bookmark: pgfId-1112636]Table 7-2 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
    [bookmark: pgfId-1112708]
 
     
      
       
       [bookmark: pgfId-1112681]Table 7-2 [bookmark: 50557]Feature History for Access Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1112687]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1112689]Platform Releases 
         
  
        	 
          
          [bookmark: pgfId-1112691]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1112693]Interface access rules
  
        	[bookmark: pgfId-1112695]7.0(1)
  
        	[bookmark: pgfId-1112697]Controlling network access through the ASA using ACLs.
 [bookmark: pgfId-1112699]We introduced the following screen: Configuration > Firewall > Access Rules.
  
       
 
        
        	[bookmark: pgfId-1112701]Global access rules
  
        	[bookmark: pgfId-1112703]8.3(1)
  
        	[bookmark: pgfId-1112705]Global access rules were introduced.
 [bookmark: pgfId-1112707]We modified the following screen: Configuration > Firewall > Access Rules.
  
       
 
        
        	[bookmark: pgfId-1211597]Support for Identity Firewall
  
        	[bookmark: pgfId-1211599]8.4(2)
  
        	[bookmark: pgfId-1211601]You can now use identity firewall users and groups for the source and destination. You can use an identity firewall ACL with access rules, AAA rules, and for VPN authentication.
 [bookmark: pgfId-1211602]
  
       
 
        
        	[bookmark: pgfId-1221634]EtherType ACL support for IS-IS traffic
  
        	[bookmark: pgfId-1221618]8.4(5), 9.1(2)
  
        	[bookmark: pgfId-1221671]In transparent firewall mode, the ASA can now pass IS-IS traffic using an EtherType ACL.
 [bookmark: pgfId-1242653]We modified the following screen: Configuration > Device Management > Management Access > EtherType Rules.
  
       
 
        
        	[bookmark: pgfId-1211604]Support for TrustSec
  
        	[bookmark: pgfId-1211606]9.0(1)
  
        	[bookmark: pgfId-1211608]You can now use TrustSec security groups for the source and destination. You can use an identity firewall ACL with access rules.
 [bookmark: pgfId-1211609]
  
       
 
        
        	[bookmark: pgfId-1211646]Unified ACL for IPv4 and IPv6
  
        	[bookmark: pgfId-1211648]9.0(1)
  
        	[bookmark: pgfId-1211650]ACLs now support IPv4 and IPv6 addresses. You can even specify a mix of IPv4 and IPv6 addresses for the source and destination. The any keyword was changed to represent IPv4 and IPv6 traffic. The any4 and any6 keywords were added to represent IPv4-only and IPv6-only traffic, respectively. The IPv6-specific ACLs are deprecated. Existing IPv6 ACLs are migrated to extended ACLs. See the release notes for more information about migration.
 [bookmark: pgfId-1275001]We modified the following screens:
 [bookmark: pgfId-1211654]Configuration > Firewall > Access Rules
Configuration > Remote Access VPN > Network (Client) Access > Group Policies > General > More Options 
  
       
 
        
        	[bookmark: pgfId-1211735]Extended ACLand object enhancement to filter ICMP traffic by ICMP code
  
        	[bookmark: pgfId-1211737]9.0(1)
  
        	[bookmark: pgfId-1211739]ICMP traffic can now be permitted/denied based on ICMP code.
 [bookmark: pgfId-1275034]We introduced or modified the following screens:
 [bookmark: pgfId-1211742]Configuration > Firewall > Objects > Service Objects/Groups
Configuration > Firewall > Access Rule 
  
       
 
        
        	[bookmark: pgfId-1270427]Transactional Commit Model on Rule Engine for Access groups
  
        	[bookmark: pgfId-1270429]9.1(5)
  
        	[bookmark: pgfId-1270431]When enabled, a rule update is applied after the rule compilation is completed; without affecting the rule matching performance.
 [bookmark: pgfId-1272961]We introduced the following screen: Configuration > Device Management > Advanced > Rule Engine.
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1313159][bookmark: 74169]Getting Started with Application Layer Protocol Inspection 
      
      
 
     
 
 
    [bookmark: pgfId-1434717]This chapter describes how to configure application layer protocol inspection. Inspection engines are required for services that embed IP addressing information in the user data packet or that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep packet inspection instead of passing the packet through the fast path (see the “Stateful Inspection Overview” section in the general operations configuration guide for more information about the fast path). As a result, inspection engines can affect overall throughput. Several common inspection engines are enabled on the ASA by default, but you might need to enable others depending on your network. 
 
    [bookmark: pgfId-1536785]This chapter includes the following sections:[bookmark: marker-1350354]
 
     
     	 [bookmark: pgfId-1146604] Information about Application Layer Protocol Inspection 
 
     	 [bookmark: pgfId-1346246] Guidelines and Limitations 
 
     	 [bookmark: pgfId-1436678] Default Settings and NAT Limitations 
 
     	 [bookmark: pgfId-1303277]Configuring Application Layer Protocol Inspection
 
    
 
   
 
    
     [bookmark: pgfId-1435177][bookmark: 23695]Information about Application Layer Protocol Inspection [bookmark: marker-1435176]
 
    [bookmark: pgfId-1435178]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1435182]How Inspection Engines Work
 
     	 [bookmark: pgfId-1535883]When to Use Application Protocol Inspection
 
    
 
     
      [bookmark: pgfId-1535900][bookmark: 71284]How Inspection Engines Work
 
     [bookmark: pgfId-1535907]As illustrated in Figure 10-1, the ASA uses three databases for its basic operation:
 
      
      	 [bookmark: pgfId-1535908]ACLs—Used for authentication and authorization of connections based on specific networks, hosts, and services (TCP/UDP port numbers).
 
      	 [bookmark: pgfId-1535909]Inspections—Contains a static, predefined set of application-level inspection functions.
 
      	 [bookmark: pgfId-1535910]Connections (XLATE and CONN tables)—Maintains state and other information about each established connection. This information is used by the Adaptive Security Algorithm and cut-through proxy to efficiently forward traffic within established sessions.
 
     
 
     [bookmark: pgfId-1535911]Figure 10-1 [bookmark: 15435]How Inspection Engines Work
 
     [bookmark: pgfId-1535915]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1535919]In Figure 10-1, operations are numbered in the order they occur, and are described as follows:
 
     [bookmark: pgfId-1535923] 1. A TCP SYN packet arrives at the ASA to establish a new connection.
 
     [bookmark: pgfId-1535927] 2. The ASA checks the ACL database to determine if the connection is permitted.
 
     [bookmark: pgfId-1535931] 3. The ASA creates a new entry in the connection database (XLATE and CONN tables).
 
     [bookmark: pgfId-1535935] 4. The ASA checks the Inspections database to determine if the connection requires application-level inspection.
 
     [bookmark: pgfId-1535939] 5. After the application inspection engine completes any required operations for the packet, the ASA forwards the packet to the destination system.
 
     [bookmark: pgfId-1535940] 6. The destination system responds to the initial request.
 
     [bookmark: pgfId-1535944] 7. The ASA receives the reply packet, looks up the connection in the connection database, and forwards the packet because it belongs to an established session.
 
     [bookmark: pgfId-1535948]The default configuration of the ASA includes a set of application inspection entries that associate supported protocols with specific TCP or UDP port numbers and that identify any special handling required.
 
    
 
     
      [bookmark: pgfId-1434827][bookmark: 31654]When to Use Application Protocol Inspection
 
     [bookmark: pgfId-1434831]When a user establishes a connection, the ASA checks the packet against ACLs, creates an address translation, and creates an entry for the session in the fast path, so that further packets can bypass time-consuming checks. However, the fast path relies on predictable port numbers and does not perform address translations inside a packet.
 
     [bookmark: pgfId-1434832]Many protocols open secondary TCP or UDP ports. The initial session on a well-known port is used to negotiate dynamically assigned port numbers.
 
     [bookmark: pgfId-1434833]Other applications embed an IP address in the packet that needs to match the source address that is normally translated when it goes through the ASA.
 
     [bookmark: pgfId-1434837]If you use applications like these, then you need to enable application inspection.
 
     [bookmark: pgfId-1434841]When you enable application inspection for a service that embeds IP addresses, the ASA translates embedded addresses and updates any checksum or other fields that are affected by the translation.
 
     [bookmark: pgfId-1434845]When you enable application inspection for a service that uses dynamically assigned ports, the ASA monitors sessions to identify the dynamic port assignments, and permits data exchange on these ports for the duration of the specific session.
 
    
 
   
 
    
     [bookmark: pgfId-1434847][bookmark: 27126]Guidelines and Limitations
 
    [bookmark: pgfId-1536973]This section includes the guidelines and limitations for this feature.
 
    [bookmark: pgfId-1536976]Context Mode Guidelines
 
    [bookmark: pgfId-1536977]Supported in single and multiple context mode.
 
    [bookmark: pgfId-1536981][bookmark: 16807]Firewall Mode Guidelines
 
    [bookmark: pgfId-1536982]Supported in routed and transparent firewall mode.
 
    [bookmark: pgfId-1580053][bookmark: 25023]Failover Guidelines 
 
    [bookmark: pgfId-1537196]State information for multimedia sessions that require inspection are not passed over the state link for stateful failover. The exception is GTP, which is replicated over the state link.
 
    [bookmark: pgfId-1536989]IPv6 Guidelines
 
    [bookmark: pgfId-1537320]Supports IPv6 for the following inspections:
 
     
     	 [bookmark: pgfId-1537321]DNS
 
     	 [bookmark: pgfId-1604681]FTP
 
     	 [bookmark: pgfId-1537337]HTTP
 
     	 [bookmark: pgfId-1537346]ICMP
 
     	 [bookmark: pgfId-1537355]SIP
 
     	 [bookmark: pgfId-1537360]SMTP
 
     	 [bookmark: pgfId-1537365]IPsec pass-through
 
     	 [bookmark: pgfId-1605292]IPv6
 
    
 
    [bookmark: pgfId-1604690]Supports NAT64 for the following inspections:
 
     
     	 [bookmark: pgfId-1604716]DNS
 
     	 [bookmark: pgfId-1604717]FTP
 
     	 [bookmark: pgfId-1604718]HTTP
 
     	 [bookmark: pgfId-1604719]ICMP
 
    
 
    [bookmark: pgfId-1537001]Additional Guidelines and Limitations 
 
    [bookmark: pgfId-1434856]Some inspection engines do not support PAT, NAT, outside NAT, or NAT between same security interfaces. See “Default Settings and NAT Limitations” for more information about NAT support.
 
    [bookmark: pgfId-1537774]For all the application inspections, the ASA limits the number of simultaneous, active data connections to 200 connections. For example, if an FTP client opens multiple secondary connections, the FTP inspection engine allows only 200 active connections and the 201 connection is dropped and the adaptive security appliance generates a system error message. 
 
    [bookmark: pgfId-1564255]Inspected protocols are subject to advanced TCP-state tracking, and the TCP state of these connections is not automatically replicated. While these connections are replicated to the standby unit, there is a best-effort attempt to re-establish a TCP state.
 
   
 
    
     [bookmark: pgfId-1536127][bookmark: 53568]Default Settings and NAT Limitations
 
    [bookmark: pgfId-1536128]By default, the configuration includes a policy that matches all default application inspection traffic and applies inspection to the traffic on all interfaces (a global policy). Default application inspection traffic includes traffic to the default ports for each protocol. You can only apply one global policy, so if you want to alter the global policy, for example, to apply inspection to non-standard ports, or to add inspections that are not enabled by default, you need to either edit the default policy or disable it and apply a new one.
 
    [bookmark: pgfId-1536132]Table 10-1 lists all inspections supported, the default ports used in the default class map, and the inspection engines that are on by default, shown in bold. This table also notes any NAT limitations.
 
    [bookmark: pgfId-1542643]
 
     
      
       
       [bookmark: pgfId-1542328]Table 10-1 [bookmark: 96657]Supported Application Inspection Engines 
 
       
       
        
        	 
          
          [bookmark: pgfId-1542341]Application 
          1 
         
  
        	 
          
          [bookmark: pgfId-1542343]Default Port 
         
  
        	 
          
          [bookmark: pgfId-1542345]NAT Limitations 
         
  
        	 
          
          [bookmark: pgfId-1542356]Standards 
          2 
         
  
        	 
          
          [bookmark: pgfId-1542358]Comments 
         
  
       
 
        
        	[bookmark: pgfId-1542360]CTIQBE
  
        	[bookmark: pgfId-1542362]TCP/2748
  
        	[bookmark: pgfId-1542364]No extended PAT.
 [bookmark: pgfId-1604738]No NAT64.
 [bookmark: pgfId-1627265](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542366]—
  
        	[bookmark: pgfId-1542368]—
  
       
 
        
        	[bookmark: pgfId-1542370]DCERPC
  
        	[bookmark: pgfId-1542372]TCP/135
  
        	[bookmark: pgfId-1604740]No NAT64.
  
        	[bookmark: pgfId-1542376]—
  
        	[bookmark: pgfId-1542378]—
  
       
 
        
        	[bookmark: pgfId-1542380]DNS over UDP
  
        	[bookmark: pgfId-1542382]UDP/53
  
        	[bookmark: pgfId-1542384]No NAT support is available for name resolution through WINS.
  
        	[bookmark: pgfId-1542386]RFC 1123
  
        	[bookmark: pgfId-1623317]—
  
       
 
        
        	[bookmark: pgfId-1542390]FTP
  
        	[bookmark: pgfId-1542392]TCP/21
  
        	[bookmark: pgfId-1542394](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542396]RFC 959
  
        	[bookmark: pgfId-1542398]—
  
       
 
        
        	[bookmark: pgfId-1542400]GTP
  
        	[bookmark: pgfId-1542402]UDP/3386
UDP/2123
  
        	[bookmark: pgfId-1542404]No extended PAT.
 [bookmark: pgfId-1604852]No NAT64.
  
        	[bookmark: pgfId-1542406]—
  
        	[bookmark: pgfId-1542408]Requires a special license.
  
       
 
        
        	[bookmark: pgfId-1542410]H.323 H.225 and RAS
  
        	[bookmark: pgfId-1542412]TCP/1720 UDP/1718
UDP (RAS) 1718-1719
  
        	[bookmark: pgfId-1624809]No dynamic NAT or PAT.
 [bookmark: pgfId-1624810]Static PAT may not work.
 [bookmark: pgfId-1627256](Clustering) No static PAT.
 [bookmark: pgfId-1624811]No extended PAT.
 [bookmark: pgfId-1627129]No per-session PAT.
 [bookmark: pgfId-1624812]No NAT on same security interfaces.
 [bookmark: pgfId-1624813]No outside NAT.
 [bookmark: pgfId-1624814]No NAT64.
  
        	[bookmark: pgfId-1542417]ITU-T H.323, H.245, H225.0, Q.931, Q.932
  
        	[bookmark: pgfId-1542419]—
  
       
 
        
        	[bookmark: pgfId-1542421]HTTP
  
        	[bookmark: pgfId-1542423]TCP/80
  
        	[bookmark: pgfId-1542425]—
  
        	[bookmark: pgfId-1542427]RFC 2616
  
        	[bookmark: pgfId-1542429]Beware of MTU limitations stripping ActiveX and Java. If the MTU is too small to allow the Java or ActiveX tag to be included in one packet, stripping may not occur.
  
       
 
        
        	[bookmark: pgfId-1542431]ICMP
  
        	[bookmark: pgfId-1542433]—
  
        	[bookmark: pgfId-1542435]—
  
        	[bookmark: pgfId-1542437]—
  
        	[bookmark: pgfId-1623319]—
  
       
 
        
        	[bookmark: pgfId-1542441]ICMP ERROR
  
        	[bookmark: pgfId-1542443]—
  
        	[bookmark: pgfId-1542445]—
  
        	[bookmark: pgfId-1542447]—
  
        	[bookmark: pgfId-1623321]—
  
       
 
        
        	[bookmark: pgfId-1542451]ILS (LDAP)
  
        	[bookmark: pgfId-1542453]TCP/389
  
        	[bookmark: pgfId-1542455]No extended PAT.
 [bookmark: pgfId-1604983]No NAT64.
  
        	[bookmark: pgfId-1542457]—
  
        	[bookmark: pgfId-1542459]—
  
       
 
        
        	[bookmark: pgfId-1542461]Instant Messaging (IM)
  
        	[bookmark: pgfId-1542463]Varies by client
  
        	[bookmark: pgfId-1542465]No extended PAT.
 [bookmark: pgfId-1604990]No NAT64.
  
        	[bookmark: pgfId-1542467]RFC 3860
  
        	[bookmark: pgfId-1542469]—
  
       
 
        
        	[bookmark: pgfId-1542471]IP Options
  
        	[bookmark: pgfId-1623566]—
  
        	[bookmark: pgfId-1605012]No NAT64.
  
        	[bookmark: pgfId-1542477]RFC 791, RFC 2113
  
        	[bookmark: pgfId-1623564]—
  
       
 
        
        	[bookmark: pgfId-1623451]IPsec Pass Through
  
        	[bookmark: pgfId-1623453]UDP/500
  
        	[bookmark: pgfId-1623455]No PAT.
 [bookmark: pgfId-1623479]No NAT64.
  
        	[bookmark: pgfId-1623474]—
  
        	[bookmark: pgfId-1623476]—
  
       
 
        
        	[bookmark: pgfId-1623544]IPv6
  
        	[bookmark: pgfId-1623568]—
  
        	[bookmark: pgfId-1623576]No NAT64.
  
        	[bookmark: pgfId-1623572]RFC 2460
  
        	[bookmark: pgfId-1623574]—
  
       
 
        
        	[bookmark: pgfId-1542491]MGCP
  
        	[bookmark: pgfId-1542493]UDP/2427, 2727
  
        	[bookmark: pgfId-1542495]No extended PAT.
 [bookmark: pgfId-1605043]No NAT64.
 [bookmark: pgfId-1627272](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542497]RFC 2705bis-05
  
        	[bookmark: pgfId-1542499]—
  
       
 
        
        	[bookmark: pgfId-1580743]MMP
  
        	[bookmark: pgfId-1580745]TCP 5443
  
        	[bookmark: pgfId-1580747]No extended PAT.
 [bookmark: pgfId-1605050]No NAT64.
  
        	[bookmark: pgfId-1580749]—
  
        	[bookmark: pgfId-1580751]—
  
       
 
        
        	[bookmark: pgfId-1542501]NetBIOS Name Server over IP
  
        	[bookmark: pgfId-1542503]UDP/137, 138 (Source ports)
  
        	[bookmark: pgfId-1580753]No extended PAT.
 [bookmark: pgfId-1605057]No NAT64.
  
        	[bookmark: pgfId-1542507]—
  
        	[bookmark: pgfId-1542509]NetBIOS is supported by performing NAT of the packets for NBNS UDP port 137 and NBDS UDP port 138.
  
       
 
        
        	[bookmark: pgfId-1542511]PPTP
  
        	[bookmark: pgfId-1542513]TCP/1723
  
        	[bookmark: pgfId-1605063]No NAT64.
 [bookmark: pgfId-1627203](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542517]RFC 2637
  
        	[bookmark: pgfId-1542519]—
  
       
 
        
        	[bookmark: pgfId-1542521]RADIUS Accounting
  
        	[bookmark: pgfId-1542523]1646
  
        	[bookmark: pgfId-1605069]No NAT64.
  
        	[bookmark: pgfId-1542527]RFC 2865
  
        	[bookmark: pgfId-1542529]—
  
       
 
        
        	[bookmark: pgfId-1542531]RSH
  
        	[bookmark: pgfId-1542533]TCP/514
  
        	[bookmark: pgfId-1542535]No PAT.
 [bookmark: pgfId-1605076]No NAT64.
 [bookmark: pgfId-1627210](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542537]Berkeley UNIX
  
        	[bookmark: pgfId-1542539]—
  
       
 
        
        	[bookmark: pgfId-1542541]RTSP
  
        	[bookmark: pgfId-1542543]TCP/554
  
        	[bookmark: pgfId-1580778]No extended PAT.
 [bookmark: pgfId-1542546]No outside NAT.
 [bookmark: pgfId-1605083]No NAT64.
 [bookmark: pgfId-1627279](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542548]RFC 2326, 2327, 1889
  
        	[bookmark: pgfId-1542550]No handling for HTTP cloaking.
  
       
 
        
        	[bookmark: pgfId-1591309]ScanSafe (Cloud Web Security)
  
        	[bookmark: pgfId-1591311]TCP/80
TCP/413
  
        	[bookmark: pgfId-1605128]—
  
        	[bookmark: pgfId-1591315]—
  
        	[bookmark: pgfId-1605150]These ports are not included in the default-inspection-traffic class for the ScanSafe inspection.
  
       
 
        
        	[bookmark: pgfId-1542552]SIP
  
        	[bookmark: pgfId-1542554]TCP/5060
UDP/5060
  
        	[bookmark: pgfId-1580770]No outside NAT.
 [bookmark: pgfId-1542557]No NAT on same security interfaces.
 [bookmark: pgfId-1580782]No extended PAT.
 [bookmark: pgfId-1627136]No per-session PAT.
 [bookmark: pgfId-1605184]No NAT64.
 [bookmark: pgfId-1627297](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542559]RFC 2543
  
        	[bookmark: pgfId-1542561]—
  
       
 
        
        	[bookmark: pgfId-1542563]SKINNY (SCCP)
  
        	[bookmark: pgfId-1542565]TCP/2000
  
        	[bookmark: pgfId-1542567]No outside NAT.
 [bookmark: pgfId-1542568]No NAT on same security interfaces.
 [bookmark: pgfId-1580787]No extended PAT.
 [bookmark: pgfId-1627395]No per-session PAT.
 [bookmark: pgfId-1605191]No NAT64.
 [bookmark: pgfId-1627440](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542570]—
  
        	[bookmark: pgfId-1542572]Does not handle TFTP uploaded Cisco IP Phone configurations under certain circumstances.
  
       
 
        
        	[bookmark: pgfId-1542574]SMTP and ESMTP
  
        	[bookmark: pgfId-1542576]TCP/25
  
        	[bookmark: pgfId-1605197]No NAT64.
  
        	[bookmark: pgfId-1542580]RFC 821, 1123
  
        	[bookmark: pgfId-1542582]—
  
       
 
        
        	[bookmark: pgfId-1542584]SNMP
  
        	[bookmark: pgfId-1542586]UDP/161, 162
  
        	[bookmark: pgfId-1542588]No NAT or PAT.
  
        	[bookmark: pgfId-1542590]RFC 1155, 1157, 1212, 1213, 1215
  
        	[bookmark: pgfId-1542592]v.2 RFC 1902-1908; v.3 RFC 2570-2580.
  
       
 
        
        	[bookmark: pgfId-1542594]SQL*Net
  
        	[bookmark: pgfId-1542596]TCP/1521 
  
        	[bookmark: pgfId-1542598]No extended PAT.
 [bookmark: pgfId-1605204]No NAT64.
 [bookmark: pgfId-1627222](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542600]—
  
        	[bookmark: pgfId-1542602]v.1 and v.2.
  
       
 
        
        	[bookmark: pgfId-1542604]Sun RPC over UDP and TCP
  
        	[bookmark: pgfId-1542606]UDP/111
  
        	[bookmark: pgfId-1542608]No extended PAT.
 [bookmark: pgfId-1605211]No NAT64.
  
        	[bookmark: pgfId-1542610]—
  
        	[bookmark: pgfId-1542612]The default rule includes UDP port 111; if you want to enable Sun RPC inspection for TCP port 111, you need to create a new rule that matches TCP port 111 and performs Sun RPC inspection.
  
       
 
        
        	[bookmark: pgfId-1542614]TFTP
  
        	[bookmark: pgfId-1542616]UDP/69
  
        	[bookmark: pgfId-1605217]No NAT64.
 [bookmark: pgfId-1627229](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542620]RFC 1350
  
        	[bookmark: pgfId-1542622]Payload IP addresses are not translated.
  
       
 
        
        	[bookmark: pgfId-1542624]WAAS
  
        	[bookmark: pgfId-1542626]—
  
        	[bookmark: pgfId-1542628]No extended PAT.
 [bookmark: pgfId-1605249]No NAT64.
  
        	[bookmark: pgfId-1542630]—
  
        	[bookmark: pgfId-1542632]—
  
       
 
        
        	[bookmark: pgfId-1542634]XDCMP
  
        	[bookmark: pgfId-1542636]UDP/177
  
        	[bookmark: pgfId-1542638]No extended PAT.
 [bookmark: pgfId-1605256]No NAT64.
 [bookmark: pgfId-1627248](Clustering) No static PAT.
  
        	[bookmark: pgfId-1542640]—
  
        	[bookmark: pgfId-1542642]—
  
       
 
       
     
 
    
 
     
      
       
       	 1.[bookmark: pgfId-1542340]Inspection engines that are enabled by default for the default port are in bold.
 2.[bookmark: pgfId-1542352]The ASA is in compliance with these standards, but it does not enforce compliance on packets being inspected. For example, FTP commands are supposed to be in a particular order, but the ASA does not enforce the order.
  
      
 
      
    
 
   
 
    
     [bookmark: pgfId-1543386] Configu [bookmark: 89043][bookmark: marker-1543384] ring Application Layer Protocol Inspection [bookmark: marker-1543842][bookmark: marker-1543849]
 
    [bookmark: pgfId-1543387]This feature uses Security Policy Rules to create a service policy. Service policies provide a consistent and flexible way to configure ASA features. For example, you can use a service policy to create a timeout configuration that is specific to a particular TCP application, as opposed to one that applies to all TCP applications. See “Configuring a Service Policy,” for more information.
 
    [bookmark: pgfId-1543394]Inspection is enabled by default for some applications. See the “Default Settings and NAT Limitations” section for more information. Use this section to modify your inspection policy.
 
     
      [bookmark: pgfId-1543853]Detailed Steps
 
      
      	 [bookmark: pgfId-1623511]
 
     
 
     
 
     [bookmark: pgfId-1625940]Step 1 Choose Configuration > Firewall > Service Policy Rules.
 
     [bookmark: pgfId-1625943]Step 2 Add or edit a service policy rule according to the “Adding a Service Policy Rule for Through Traffic” section.
 
     [bookmark: pgfId-1625945]If you want to match non-standard ports, then create a new rule for the non-standard ports. See the “Default Settings and NAT Limitations” section for the standard ports for each inspection engine. You can combine multiple rules in the same service policy if desired, so you can create one rule to match certain traffic, and another to match different traffic. However, if traffic matches a rule that contains an inspection action, and then matches another rule that also has an inspection action, only the first matching rule is used.
 
     [bookmark: pgfId-1625949]Step 3 In the Edit Service Policy Rule > Rule Actions dialog box, click the Protocol Inspection tab.
 
     [bookmark: pgfId-1625950]For a new rule, the dialog box is called Add Service Policy Rule Wizard - Rule Actions.
 
     [bookmark: pgfId-1625951]Step 4 Select each inspection type that you want to apply.
 
     [bookmark: pgfId-1625952]Step 5 (Optional) Some inspection engines let you control additional parameters when you apply the inspection to the traffic. Click Configure for each inspection type to configure an inspect map.
 
     [bookmark: pgfId-1625953]You can either choose an existing map, or create a new one. You can predefine inspect maps in the Configuration > Firewall > Objects > Inspect Maps pane.
 
     [bookmark: pgfId-1625954]Step 6 You can configure other features for this rule if desired using the other Rule Actions tabs.
 
     [bookmark: pgfId-1625955]Step 7 Click OK (or Finish from the wizard).
 
     [bookmark: pgfId-1625958]
 
      
      
 
     
 
     [bookmark: 92511] 
     [bookmark: 71372] 
     
 
     [bookmark: pgfId-1548565]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1050709]Information About Cisco Unified Communications Proxy Features 
      
      
 
     
 
 
    [bookmark: pgfId-1050727]This chapter describes how to configure the adaptive security appliance for Cisco Unified Communications Proxy features. 
 
    [bookmark: pgfId-1051135]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1057910]Information About the Adaptive Security Appliance in Cisco Unified Communications
 
     	 [bookmark: pgfId-1054026]TLS Proxy Applications in Cisco Unified Communications
 
     	 [bookmark: pgfId-1142492]Licensing for Cisco Unified Communications Proxy Features
 
    
 
   
 
    
     [bookmark: pgfId-1057004][bookmark: 98252]Information About the Adaptive Security Appliance in Cisco Unified Communications[bookmark: marker-1139942] [bookmark: marker-1139943]
 
    [bookmark: pgfId-1070777]This section describes the Cisco UC Proxy features on the Cisco ASA 5500 series appliances. The purpose of a proxy is to terminate and reoriginate connections between a client and server. The proxy delivers a range of security functions such as traffic inspection, protocol conformance, and policy control to ensure security for the internal network. An increasingly popular function of a proxy is to terminate encrypted connections in order to apply security policies while maintaining confidentiality of connections. The Cisco ASA 5500 Series appliances are a strategic platform to provide proxy functions for unified communications deployments. 
 
    [bookmark: pgfId-1218386]The Cisco UC Proxy includes the following solutions:
 
    [bookmark: pgfId-1178099]Phone Proxy: Secure remote access for Cisco encrypted endpoints, and VLAN traversal for Cisco softphones 
 
    [bookmark: pgfId-1178101]The phone proxy feature enables termination of Cisco SRTP/TLS-encrypted endpoints for secure remote access. The phone proxy allows large scale deployments of secure phones without a large scale VPN remote access hardware deployment. End-user infrastructure is limited to just the IP endpoint, without VPN tunnels or hardware. 
 
    [bookmark: pgfId-1183047]The Cisco adaptive security appliance phone proxy is the replacement product for the Cisco Unified Phone Proxy. Additionally, the phone proxy can be deployed for voice/data VLAN traversal for softphone applications. Cisco IP Communicator (CIPC) traffic (both media and signaling) can be proxied through the ASA, thus traversing calls securely between voice and data VLANs.
 
    [bookmark: pgfId-1219931]For information about the differences between the TLS proxy and phone proxy, go to the following URL for Unified Communications content, including TLS Proxy vs. Phone Proxy white paper:
 
    [bookmark: pgfId-1219948]http://www.cisco.com/go/secureuc
 
    [bookmark: pgfId-1223636]TLS Proxy: Decryption and inspection of Cisco Unified Communications encrypted signaling
 
    [bookmark: pgfId-1223637]End-to-end encryption often leaves network security appliances “blind” to media and signaling traffic, which can compromise access control and threat prevention security functions. This lack of visibility can result in a lack of interoperability between the firewall functions and the encrypted voice, leaving businesses unable to satisfy both of their key security requirements. 
 
    [bookmark: pgfId-1223641]The ASA is able to intercept and decrypt encrypted signaling from Cisco encrypted endpoints to the Cisco Unified Communications Manager (Cisco UCM), and apply the required threat protection and access control. It can also ensure confidentiality by re-encrypting the traffic onto the Cisco UCM servers. 
 
    [bookmark: pgfId-1223645]Typically, the ASA TLS Proxy functionality is deployed in campus unified communications network. This solution is ideal for deployments that utilize end to end encryption and firewalls to protect Unified Communications Manager servers.
 
    [bookmark: pgfId-1178121][bookmark: marker-1184322]Mobility Proxy: Secure connectivity between Cisco Unified Mobility Advantage server and Cisco Unified Mobile Communicator clients
 
    [bookmark: pgfId-1178126]Cisco Unified Mobility solutions include the Cisco Unified Mobile Communicator (Cisco UMC), an easy-to-use software application for mobile handsets that extends enterprise communications applications and services to mobile phones and the Cisco Unified Mobility Advantage (Cisco UMA) server. The Cisco Unified Mobility solution streamlines the communication experience, enabling single number reach and integration of mobile endpoints into the Unified Communications infrastructure. 
 
    [bookmark: pgfId-1183386]The security appliance acts as a proxy, terminating and reoriginating the TLS signaling between the Cisco UMC and Cisco UMA. As part of the proxy security functionality, inspection is enabled for the Cisco UMA Mobile Multiplexing Protocol (MMP), the protocol between Cisco UMC and Cisco UMA.
 
    [bookmark: pgfId-1178146][bookmark: marker-1184352]Presence Federation Proxy: Secure connectivity between Cisco Unified Presence servers and Cisco/Microsoft Presence servers
 
    [bookmark: pgfId-1185476]Cisco Unified Presence solution collects information about the availability and status of users, such as whether they are using communication devices, such as IP phones at particular times. It also collects information regarding their communications capabilities, such as whether web collaboration or video conferencing is enabled. Using user information captured by Cisco Unified Presence, applications such as Cisco Unified Personal Communicator and Cisco UCM can improve productivity by helping users connect with colleagues more efficiently through determining the most effective way for collaborative communication.
 
    [bookmark: pgfId-1184330]Using the ASA as a secure presence federation proxy, businesses can securely connect their Cisco Unified Presence (Cisco UP) servers to other Cisco or Microsoft Presence servers, enabling intra-enterprise communications. The security appliance terminates the TLS connectivity between the servers, and can inspect and apply policies for the SIP communications between the servers. 
 
    [bookmark: pgfId-1230672]Cisco Intercompany Media Engine Proxy: Secure connectivity between Cisco UCM servers in different enterprises for IP Phone traffic
 
    [bookmark: pgfId-1230693]As more unified communications are deployed within enterprises, cases where business-to-business calls utilize unified communications on both sides with the Public Switched Network (PSTN) in the middle become increasingly common. All outside calls go over circuits to telephone providers and from there are delivered to all external destinations.
 
    [bookmark: pgfId-1230695]The Cisco Intercompany Media Engine gradually creates dynamic, encrypted VoIP connections between businesses, so that a collection of enterprises that work together end up looking like one giant business with secure VoIP interconnections between them. 
 
    [bookmark: pgfId-1230697]There are three components to a Cisco Intercompany Media Engine deployment within an enterprise: a Cisco Intercompany Media Engine server, a call agent (the Cisco Unified Communications Manager) and an ASA running the Cisco Intercompany Media Engine Proxy. 
 
    [bookmark: pgfId-1230775]The ASA provides perimeter security by encrypting signaling connections between enterprises and preventing unathorized calls. An ASA running the Cisco Intercompany Media Engine Proxy can either be deployed as an Internet firewall or be designated as a Cisco Intercompany Media Engine Proxy and placed in the DMZ, off the path of the regular Internet traffic.
 
   
 
    
     [bookmark: pgfId-1070189][bookmark: 45660]TLS Proxy Applications in Cisco Unified Communications[bookmark: marker-1139884]
 
    [bookmark: pgfId-1060058]Table 15-1 shows the Cisco Unified Communications applications that utilize the TLS proxy on the ASA. 
 
    [bookmark: pgfId-1057911]
 
     
      
       
       [bookmark: pgfId-1083262]Table 15-1 [bookmark: 55617]TLS Proxy Applications and the Security Appliance
 
       
       
        
        	 
          
          [bookmark: pgfId-1057923]Application 
         
  
        	 
          
          [bookmark: pgfId-1057925]TLS Client 
         
  
        	 
          
          [bookmark: pgfId-1057927]TLS Server 
         
  
        	 
          
          [bookmark: pgfId-1057929]Client Authentication 
         
  
        	 
          
          [bookmark: pgfId-1057931]Security Appliance Server Role 
         
  
        	 
          
          [bookmark: pgfId-1057933]Security Appliance Client Role 
         
  
       
 
        
        	[bookmark: pgfId-1143565][bookmark: marker-1143564]Phone Proxy and TLS Proxy
  
        	[bookmark: pgfId-1143567]IP phone
  
        	[bookmark: pgfId-1143569]Cisco UCM
  
        	[bookmark: pgfId-1143571]Yes
  
        	[bookmark: pgfId-1143573]Proxy certificate, self-signed or by internal CA
  
        	[bookmark: pgfId-1143575]Local dynamic certificate signed by the ASA CA (might not need certificate for phone proxy application)
  
       
 
        
        	[bookmark: pgfId-1057947][bookmark: marker-1139885]Mobility Proxy
  
        	[bookmark: pgfId-1057949]Cisco UMC
  
        	[bookmark: pgfId-1057951]Cisco UMA
  
        	[bookmark: pgfId-1057953]No
  
        	[bookmark: pgfId-1057955]Using the Cisco UMA private key or certificate impersonation
  
        	[bookmark: pgfId-1057957]Any static configured certificate
  
       
 
        
        	[bookmark: pgfId-1057959][bookmark: marker-1139886]Presence Federation Proxy
  
        	[bookmark: pgfId-1057961]Cisco UP or MS LCS/OCS
  
        	[bookmark: pgfId-1057963]Cisco UP or MS LCS/OCS
  
        	[bookmark: pgfId-1057965]Yes
  
        	[bookmark: pgfId-1057967]Proxy certificate, self-signed or by internal CA
  
        	[bookmark: pgfId-1057969]Using the Cisco UP private key or certificate impersonation
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1067765]The ASA supports TLS proxy for various voice applications. [bookmark: marker-1139888]For the phone proxy, the TLS proxy running on the ASA has the following key features:
 
     
     	 [bookmark: pgfId-1067766]The ASA forces remote IP phones connecting to the phone proxy through the Internet to be in secured mode even when the Cisco UCM cluster is in non-secure mode.
 
     	 [bookmark: pgfId-1106144]The TLS proxy is implemented on the ASA to intercept the TLS signaling from IP phones.
 
     	 [bookmark: pgfId-1067767]The TLS proxy decrypts the packets, sends packets to the inspection engine for NAT rewrite and protocol conformance, optionally encrypts packets, and sends them to Cisco UCM or sends them in clear text if the IP phone is configured to be in nonsecure mode on the Cisco UCM.
 
     	 [bookmark: pgfId-1106200]The ASA acts as a media terminator as needed and translates between SRTP and RTP media streams. 
 
     	 [bookmark: pgfId-1139890]The TLS proxy is a transparent proxy that works based on establishing trusted relationship between the TLS client, the proxy (the ASA), and the TLS server.
 
    
 
    [bookmark: pgfId-1144398]For the Cisco Unified Mobility solution, the TLS client is a Cisco UMA client and the TLS server is a Cisco UMA server. The ASA is between a Cisco UMA client and a Cisco UMA server. The mobility proxy (implemented as a TLS proxy) for Cisco Unified Mobility allows the use of an imported PKCS-12 certificate for server proxy during the handshake with the client. Cisco UMA clients are not required to present a certificate (no client authentication) during the handshake.
 
    [bookmark: pgfId-1144408]For the Cisco Unified Presence solution, the ASA acts as a TLS proxy between the Cisco UP server and the foreign server. This allows the ASA to proxy TLS messages on behalf of the server that initiates the TLS connection, and route the proxied TLS messages to the client. The ASA stores certificate trustpoints for the server and the client, and presents these certificates on establishment of the TLS session.
 
   
 
    
     [bookmark: pgfId-1139894][bookmark: 76871]Licensing for Cisco Unified Communications Proxy Features[bookmark: marker-1139901] [bookmark: marker-1139902]
 
    [bookmark: pgfId-1231638]The Cisco Unified Communications proxy features supported by the ASA require a Unified Communications Proxy license:
 
     
     	 [bookmark: pgfId-1231639]Phone proxy
 
     	 [bookmark: pgfId-1231640]TLS proxy for encrypted voice inspection
 
     	 [bookmark: pgfId-1231641]Presence federation proxy
 
     	 [bookmark: pgfId-1231656]Intercompany media engine proxy
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1231642]Note In Version 8.2(2) and later, the Mobility Advantage proxy no longer requires a Unified Communications Proxy license. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1086188]The following table shows the Unified Communications Proxy license details by platform for the phone proxy, TLS proxy for encrypted voice inspection, and presence federation proxy: 
 
     
      
    
 
    
 
    [bookmark: pgfId-1248206]Note This feature is not available on No Payload Encryption models.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1248302]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1248209]Model 
         
  
        	 
          
          [bookmark: pgfId-1248218]License Requirement 
          1 
         
  
       
 
        
        	[bookmark: pgfId-1248220]ASA 5505
  
        	[bookmark: pgfId-1248222]Base License and Security Plus License: 2 sessions.
 [bookmark: pgfId-1248223]Optional license: 24 sessions.
  
       
 
        
        	[bookmark: pgfId-1248225]ASA 5510
  
        	[bookmark: pgfId-1248227]Base License and Security Plus License: 2 sessions.
 [bookmark: pgfId-1248228]Optional licenses: 24, 50, or 100 sessions.
  
       
 
        
        	[bookmark: pgfId-1248230]ASA 5520
  
        	[bookmark: pgfId-1248232]Base License: 2 sessions.
 [bookmark: pgfId-1248233]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248235]ASA 5540
  
        	[bookmark: pgfId-1248237]Base License: 2 sessions.
 [bookmark: pgfId-1248238]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248240]ASA 5550
  
        	[bookmark: pgfId-1248242]Base License: 2 sessions.
 [bookmark: pgfId-1248243]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248245]ASA 5580
  
        	[bookmark: pgfId-1248247]Base License: 2 sessions.
 [bookmark: pgfId-1248252]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2
  
       
 
        
        	[bookmark: pgfId-1248254]ASA 5512-X
  
        	[bookmark: pgfId-1248256]Base License: 2 sessions.
 [bookmark: pgfId-1248257]Optional licenses: 24, 50, 100, 250, or 500 sessions.
  
       
 
        
        	[bookmark: pgfId-1248259]ASA 5515-X
  
        	[bookmark: pgfId-1248261]Base License: 2 sessions.
 [bookmark: pgfId-1248262]Optional licenses: 24, 50, 100, 250, or 500 sessions.
  
       
 
        
        	[bookmark: pgfId-1248264]ASA 5525-X
  
        	[bookmark: pgfId-1248266]Base License: 2 sessions.
 [bookmark: pgfId-1248267]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248269]ASA 5545-X
  
        	[bookmark: pgfId-1248271]Base License: 2 sessions.
 [bookmark: pgfId-1248272]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248274]ASA 5555-X
  
        	[bookmark: pgfId-1248276]Base License: 2 sessions.
 [bookmark: pgfId-1248277]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248279]ASA 5585-X with SSP-10
  
        	[bookmark: pgfId-1248281]Base License: 2 sessions.
 [bookmark: pgfId-1248282]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.
  
       
 
        
        	[bookmark: pgfId-1248284]ASA 5585-X with SSP-20, -40, or -60
  
        	[bookmark: pgfId-1248286]Base License: 2 sessions.
 [bookmark: pgfId-1248290]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2
  
       
 
        
        	[bookmark: pgfId-1248295]ASASM
  
        	[bookmark: pgfId-1248297]Base License: 2 sessions.
 [bookmark: pgfId-1248301]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2
  
       
 
       
     
 
    
 
     
      
       
       	 1.[bookmark: pgfId-1248214][bookmark: 98139]The following applications use TLS proxy sessions for their connections. Each TLS proxy session used by these applications (and only these applications) is counted against the UC license limit:
- Phone Proxy
- Presence Federation Proxy
- Encrypted Voice Inspection

Other applications that use TLS proxy sessions do not count towards the UC limit, for example, Mobility Advantage Proxy (which does not require a license) and IME (which requires a separate IME license).

Some UC applications might use multiple sessions for a connection. For example, if you configure a phone with a primary and backup Cisco Unified Communications Manager, there are 2 TLS proxy connections, so 2 UC Proxy sessions are used.

You independently set the TLS proxy limit using the Configuration > Firewall > Unified Communications > TLS Proxy pane. When you apply a UC license that is higher than the default TLS proxy limit, the ASA automatically sets the TLS proxy limit to match the UC limit. The TLS proxy limit takes precedence over the UC license limit; if you set the TLS proxy limit to be less than the UC license, then you cannot use all of the sessions in your UC license.

Note: For license part numbers ending in “K8” (for example, licenses under 250 users), TLS proxy sessions are limited to 1000. For license part numbers ending in “K9” (for example, licenses 250 users or larger), the TLS proxy limit depends on the configuration, up to the model limit. K8 and K9 refer to whether the license is restricted for export: K8 is unrestricted, and K9 is restricted.

Note: If you clear the configuration, then the TLS proxy limit is set to the default for your model; if this default is lower than the UC license limit, then you see an error message to use the to raise the limit again (in ASDM, use the TLS Proxy pane). If you use failover and use File > Save Running Configuration to Standby Unit on the primary unit to force a configuration synchronization, the clear configure all command is generated on the secondary unit automatically, so you may see the warning message on the secondary unit. Because the configuration synchronization restores the TLS proxy limit set on the primary unit, you can ignore the warning.

You might also use SRTP encryption sessions for your connections:
- For K8 licenses, SRTP sessions are limited to 250.
- For K9 licenses, there is not limit.

Note: Only calls that require encryption/decryption for media are counted towards the SRTP limit; if passthrough is set for the call, even if both legs are SRTP, they do not count towards the limit.
 2.[bookmark: pgfId-1248251][bookmark: 21190]With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of Phone Proxy sessions is 5000.
  
      
 
      
    
 
    [bookmark: pgfId-1233220]Table 15-2 shows the default and maximum TLS session details by platform. 
 
    [bookmark: pgfId-1233271]
 
     
      
       
       [bookmark: pgfId-1233224]Table 15-2 [bookmark: 64493]Default and Maximum TLS Sessions on the Security Appliance
 
       
       
        
        	 
          
          [bookmark: pgfId-1233230]Security Appliance Platform 
         
  
        	 
          
          [bookmark: pgfId-1233232]Default TLS Sessions 
         
  
        	 
          
          [bookmark: pgfId-1233234]Maximum TLS Sessions 
         
  
       
 
        
        	[bookmark: pgfId-1233236]ASA 5505
  
        	[bookmark: pgfId-1233238]10
  
        	[bookmark: pgfId-1233240]80
  
       
 
        
        	[bookmark: pgfId-1233242]ASA 5510
  
        	[bookmark: pgfId-1233244]100
  
        	[bookmark: pgfId-1233246]200
  
       
 
        
        	[bookmark: pgfId-1233248]ASA 5520
  
        	[bookmark: pgfId-1233250]300
  
        	[bookmark: pgfId-1233252]1200
  
       
 
        
        	[bookmark: pgfId-1233254]ASA 5540
  
        	[bookmark: pgfId-1233256]1000
  
        	[bookmark: pgfId-1233258]4500
  
       
 
        
        	[bookmark: pgfId-1233260]ASA 5550
  
        	[bookmark: pgfId-1233262]2000
  
        	[bookmark: pgfId-1233264]4500
  
       
 
        
        	[bookmark: pgfId-1233266]ASA 5580
  
        	[bookmark: pgfId-1233268]4000
  
        	[bookmark: pgfId-1233270]13,000
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1233211]The following table shows the Unified Communications Proxy license details by platform for intercompany media engine proxy: 
 
     
      
    
 
    
 
    [bookmark: pgfId-1248375]Note This feature is not available on No Payload Encryption models.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1248396]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1248378]Model 
         
  
        	 
          
          [bookmark: pgfId-1248380]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1248382]All models
  
        	[bookmark: pgfId-1248384]Intercompany Media Engine license.
 [bookmark: pgfId-1248385]When you enable the Intercompany Media Engine (IME) license, you can use TLS proxy sessions up to the configured TLS proxy limit. If you also have a Unified Communications (UC) license installed that is higher than the default TLS proxy limit, then the ASA sets the limit to be the UC license limit plus an additional number of sessions depending on your model. You can manually configure the TLS proxy limit using the Configuration > Firewall > Unified Communications > TLS Proxy pane. If you also install the UC license, then the TLS proxy sessions available for UC are also available for IME sessions. For example, if the configured limit is 1000 TLS proxy sessions, and you purchase a 750-session UC license, then the first 250 IME sessions do not affect the sessions available for UC. If you need more than 250 sessions for IME, then the remaining 750 sessions of the platform limit are used on a first-come, first-served basis by UC and IME.
 
          
          	 [bookmark: pgfId-1248389]For a license part number ending in “K8”, TLS proxy sessions are limited to 1000.
 
          	 [bookmark: pgfId-1248390]For a license part number ending in “K9”, the TLS proxy limit depends on your configuration and the platform model.
 
         
 [bookmark: pgfId-1248391]Note K8 and K9 refer to whether the license is restricted for export: K8 is unrestricted, and K9 is restricted.
 [bookmark: pgfId-1248392]You might also use SRTP encryption sessions for your connections:
 
          
          	 [bookmark: pgfId-1248393]For a K8 license, SRTP sessions are limited to 250.
 
          	 [bookmark: pgfId-1248394]For a K9 license, there is no limit.
 
         
 [bookmark: pgfId-1248395]Note Only calls that require encryption/decryption for media are counted toward the SRTP limit; if passthrough is set for the call, even if both legs are SRTP, they do not count toward the limit.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1086060]For more information about licensing, see “Managing Feature Licenses,” in the general operations configuration guide.
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1042020][bookmark: 80031]Configuring Conn[bookmark: marker-1088395]ection Settings 
      
      
 
     
 
 
    [bookmark: pgfId-1080692]This chapter describes how to configure connection settings for connections that go through the ASA, or for management connections, that go to the ASA. Connection settings include:
 
     
     	 [bookmark: pgfId-1088684]Maximum connections (TCP and UDP connections, embryonic connections, per-client connections)
 
     	 [bookmark: pgfId-1088692]Connection timeouts
 
     	 [bookmark: pgfId-1088698]Dead connection detection
 
     	 [bookmark: pgfId-1088707]TCP sequence randomization
 
     	 [bookmark: pgfId-1088793]TCP normalization customization
 
     	 [bookmark: pgfId-1088798]TCP state bypass
 
     	 [bookmark: pgfId-1091900]Global timeouts
 
    
 
    [bookmark: pgfId-1088765]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1080701]Information About Connection Settings
 
     	 [bookmark: pgfId-1080705]Licensing Requirements for Connection Settings
 
     	 [bookmark: pgfId-1091612]Guidelines and Limitations
 
     	 [bookmark: pgfId-1091644]Default Settings
 
     	 [bookmark: pgfId-1091664]Configuring Connection Settings
 
     	 [bookmark: pgfId-1091820]Feature History for Connection Settings
 
    
 
   
 
    
     [bookmark: pgfId-1080715]Information About [bookmark: 69133]Connection Settings
 
    [bookmark: pgfId-1080716]This section describes why you might want to limit connections and includes the following topics:
 
     
     	 [bookmark: pgfId-1080719]TCP Intercept and Limiting Embryonic Connections
 
     	 [bookmark: pgfId-1080723]Disabling TCP Intercept for Management Packets for Clientless SSL Compatibility
 
     	 [bookmark: pgfId-1080727]Dead Connection Detection (DCD)
 
     	 [bookmark: pgfId-1080731]TCP Sequence Randomization
 
     	 [bookmark: pgfId-1091541]TCP Normalization
 
     	 [bookmark: pgfId-1091570]TCP State Bypass
 
    
 
     
      [bookmark: pgfId-1080734][bookmark: 51287]TCP Intercept and Limiting Embryonic Connections
 
     [bookmark: pgfId-1080737]Limiting the number of embryonic connections protects you from a DoS attack. The ASA uses the per-client limits and the embryonic connection limit to trigger TCP Intercept, which protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. TCP Intercept uses the SYN cookies algorithm to prevent TCP SYN-flooding attacks. A SYN-flooding attack consists of a series of SYN packets usually originating from spoofed IP addresses. The constant flood of SYN packets keeps the server SYN queue full, which prevents it from servicing connection requests. When the embryonic connection threshold of a connection is crossed, the ASA acts as a proxy for the server and generates a SYN-ACK response to the client SYN request. When the ASA receives an ACK back from the client, it can then authenticate the client and allow the connection to the server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1122978]Note When you use TCP SYN cookie protection to protect servers from SYN attacks, you must set the embryonic connection limit lower than the TCP SYN backlog queue on the server that you want to protect. Otherwise, valid clients can nolonger access the server during a SYN attack.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1086480]To view TCP Intercept statistics, including the top 10 servers under attack, see Chapter27, “Configuring Threat Detection”
 
    
 
     
      [bookmark: pgfId-1080746][bookmark: 13060]Disabling TCP Intercept for Management Packets for Clientless SSL Compatibility
 
     [bookmark: pgfId-1080747]By default, TCP management connections have TCP Intercept always enabled. When TCP Intercept is enabled, it intercepts the 3-way TCP connection establishment handshake packets and thus deprives the ASA from processing the packets for clientless SSL. Clientless SSL requires the ability to process the 3-way handshake packets to provide selective ACK and other TCP options for clientless SSL connections. To disable TCP Intercept for management traffic, you can set the embryonic connection limit; only after the embryonic connection limit is reached is TCP Intercept enabled.
 
    
 
     
      [bookmark: pgfId-1080752][bookmark: 97842]Dead Connection Detection (DCD)
 
     [bookmark: pgfId-1080753]DCD detects a dead connection and allows it to expire, without expiring connections that can still handle traffic. You configure DCD when you want idle, but valid connections to persist.
 
     [bookmark: pgfId-1080754]When you enable DCD, idle timeout behavior changes. With idle timeout, DCD probes are sent to each of the two end-hosts to determine the validity of the connection. If an end-host fails to respond after probes are sent at the configured intervals, the connection is freed, and reset values, if configured, are sent to each of the end-hosts. If both end-hosts respond that the connection is valid, the activity timeout is updated to the current time and the idle timeout is rescheduled accordingly.
 
     [bookmark: pgfId-1080755]Enabling DCD changes the behavior of idle-timeout handling in the TCP normalizer. DCD probing resets the idle timeout on the connections seen in the show conn command. To determine when a connection that has exceeded the configured timeout value in the timeout command but is kept alive due to DCD probing, the show service-policy command includes counters to show the amount of activity from DCD.
 
    
 
     
      [bookmark: pgfId-1080757][bookmark: 32741]TCP Sequence Randomization
 
     [bookmark: pgfId-1080760]Each TCP connection has two ISNs: one generated by the client and one generated by the server. The ASA randomizes the ISN of the TCP SYN passing in both the inbound and outbound directions.
 
     [bookmark: pgfId-1080762]Randomizing the ISN of the protected host prevents an attacker from predecting the next ISN for a new connection and potentially hijacking the new session.
 
     [bookmark: pgfId-1080763]TCP initial sequence number randomization can be disabled if required. For example:
 
      
      	 [bookmark: pgfId-1080764]If another in-line firewall is also randomizing the initial sequence numbers, there is no need for both firewalls to be performing this action, even though this action does not affect the traffic.
 
      	 [bookmark: pgfId-1080767]If you use eBGP multi-hop through the ASA, and the eBGP peers are using MD5. Randomization breaks the MD5 checksum.
 
      	 [bookmark: pgfId-1080771]You use a WAAS device that requires the ASA not to randomize the sequence numbers of connections.
 
     
 
    
 
     
      [bookmark: pgfId-1090664][bookmark: 69801]TCP Normalization[bookmark: marker-1090663]
 
     [bookmark: pgfId-1090668]The TCP normalization feature identifies abnormal packets that the ASA can act on when they are detected; for example, the ASA can allow, drop, or clear the packets. TCP normalization helps protect the ASA from attacks. TCP normalization is always enabled, but you can customize how some features behave.
 
     [bookmark: pgfId-1090675]The TCP normalizer includes non-configurable actions and configurable actions. Typically, non-configurable actions that drop or clear connections apply to packets that are always bad. Configurable actions (as detailed in “Customizing the TCP Normalizer with a TCP Map” section) might need to be customized depending on your network needs.
 
     [bookmark: pgfId-1090679]See the following guidelines for TCP normalization:
 
      
      	 [bookmark: pgfId-1090683]The normalizer does not protect from SYN floods. The ASA includes SYN flood protection in other ways.
 
      	 [bookmark: pgfId-1090686]The normalizer always sees the SYN packet as the first packet in a flow unless the ASA is in loose mode due to failover.
 
     
 
    
 
     
      [bookmark: pgfId-1089825][bookmark: 68345]TCP State Bypass[bookmark: marker-1089823][bookmark: marker-1089824]
 
     [bookmark: pgfId-1089830][bookmark: 61902]By default, all traffic that goes through the ASA is inspected using the Adaptive Security Algorithm and is either allowed through or dropped based on the security policy. The ASA maximizes the firewall performance by checking the state of each packet (is this a new connection or an established connection?) and assigning it to either the session management path (a new connection SYN packet), the fast path (an established connection), or the control plane path (advanced inspection). See the “Stateful Inspection Overview” section in the general operations configuration guide for more detailed information about the stateful firewall.
 
     [bookmark: pgfId-1089839]TCP packets that match existing connections in the fast path can pass through the ASA without rechecking every aspect of the security policy. This feature maximizes performance. However, the method of establishing the session in the fast path using the SYN packet, and the checks that occur in the fast path (such as TCP sequence number), can stand in the way of asymmetrical routing solutions: both the outbound and inbound flow of a connection must pass through the same ASA.
 
     [bookmark: pgfId-1089847]For example, a new connection goes to ASA 1. The SYN packet goes through the session management path, and an entry for the connection is added to the fast path table. If subsequent packets of this connection go through ASA 1, then the packets will match the entry in the fast path, and are passed through. But if subsequent packets go to ASA 2, where there was not a SYN packet that went through the session management path, then there is no entry in the fast path for the connection, and the packets are dropped. Figure 22-1 shows an asymmetric routing example where the outbound traffic goes through a different ASA than the inbound traffic:
 
     [bookmark: pgfId-1089861]Figure 22-1 [bookmark: 66160]Asymmetric Routing
 
     [bookmark: pgfId-1089865]
 
      
      [image: ] 
     
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1230897]Model 
          
  
         	 
           
           [bookmark: pgfId-1230899]License Requirement 
          
  
        
 
         
         	[bookmark: pgfId-1230901]All models
  
         	[bookmark: pgfId-1230903]Base License.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1090059][bookmark: 98828]Guidelines and Limitations
 
     [bookmark: pgfId-1207230][bookmark: 87419]Context Mo[bookmark: marker-1207229]de Guidelines
 
     [bookmark: pgfId-1207231]Supported in single and multiple context mode.
 
     [bookmark: pgfId-1207234][bookmark: 16807]Firewall Mode Guidelines[bookmark: marker-1207233]
 
     [bookmark: pgfId-1207235]Supported in routed and transparent mode.
 
     [bookmark: pgfId-1207239][bookmark: 25023]Failover Guidelines[bookmark: marker-1207237][bookmark: marker-1207238]
 
     [bookmark: pgfId-1207240]Failover is supported.
 
     [bookmark: pgfId-1090076]TCP State Bypass [bookmark: 23253]Unsupported Features[bookmark: marker-1090075]
 
     [bookmark: pgfId-1090077]The following features are not supported when you use TCP state bypass:
 
      
      	 [bookmark: pgfId-1090079]Applicati[bookmark: marker-1090078]on inspection—Application inspection requires both inbound and outbound traffic to go through the same ASA, so application inspection is not supported with TCP state bypass.
 
      	 [bookmark: pgfId-1090087]AAA au[bookmark: marker-1090083]thenticated sessions—When a user authenticates with one ASA, traffic returning via the other ASA will be denied because the user did not authenticate with that ASA.
 
      	 [bookmark: pgfId-1090095]TCP Intercep[bookmark: marker-1090094]t, maximum embryonic connection limit, TCP sequence number randomization—The ASA does not keep track of the state of the connection, so these features are not applied.
 
      	 [bookmark: pgfId-1090100]TCP normal[bookmark: marker-1090099]ization—The TCP normalizer is disabled.
 
      	 [bookmark: pgfId-1090102]SSM and SSC function[bookmark: marker-1090101]ality—You cannot use TCP state bypass and any application running on an SSM or SSC, such as IPS or CSC.
 
     
 
     [bookmark: pgfId-1090104]TCP State Bypass NAT Guid[bookmark: marker-1090103]elines
 
     [bookmark: pgfId-1090108]Because the translation session is established separately for each ASA, be sure to configure static NAT on both ASAs for TCP state bypass traffic; if you use dynamic NAT, the address chosen for the session on ASA 1 will differ from the address chosen for the session on ASA 2.
 
     [bookmark: pgfId-1207122]Maximum Concurrent and Embryonic Connection Guidelines
 
     [bookmark: pgfId-1207171]Depending on the number of CPU cores on your ASA model, the maximum concurrent and embryonic connections may exceed the configured numbers due to the way each core manages connections. In the worst case scenario, the ASA allows up to n-1 extra connections and embryonic connections, where n is the number of cores. For example, if your model has 4 cores, if you configure 6 concurrent connections and 4 embryonic connections, you could have an additional 3 of each type. To determine the number of cores for your model, enter the show cpu core command.
 
    
 
     
      [bookmark: pgfId-1157289][bookmark: 42354]Default Settings
 
     [bookmark: pgfId-1156162]TCP State Bypass
 
     [bookmark: pgfId-1090175]TCP state bypass is disabled by default.
 
    
 
     
      [bookmark: pgfId-1128660][bookmark: 64885]Configuring Connection Settings
 
     [bookmark: pgfId-1128661]This section includes the following topics:
 
      
      	 [bookmark: pgfId-1092177]Customizing the TCP Normalizer with a TCP Map
 
      	 [bookmark: pgfId-1092195]Configuring Connection Settings
 
      	 [bookmark: pgfId-1224502]Configuring Global Timeouts
 
     
 
      
       [bookmark: pgfId-1091713]Task Flow For Configuring Connection Settings
 
      
 
      [bookmark: pgfId-1092771]Step 1 For TCP normalization customization, create a TCP map according to the “Customizing the TCP Normalizer with a TCP Map” section.
 
      [bookmark: pgfId-1092785]Step 2 For all connection settings except for global timeouts, configure a service policy according to Chapter1, “Configuring a Service Policy”
 
      [bookmark: pgfId-1092145]Step 3 Configure connection settings according to the “Configuring Connection Settings” section.
 
      [bookmark: pgfId-1224514]Step 4 Configure global timeouts according to the “Configuring Global Timeouts” section.
 
      [bookmark: pgfId-1092165]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-1091018][bookmark: 53790]Customizing the TCP Normalizer with a TCP Map 
 
      [bookmark: pgfId-1091019]To customize the TCP normalizer, first define the settings using a TCP map.
 
     
 
      
       [bookmark: pgfId-1092751]Detailed Steps
 
      
 
      [bookmark: pgfId-1224520]Step 1 Choose the Configuration > Firewall > Objects > TCP Maps pane, and click Add.
 
      [bookmark: pgfId-1224521]The Add TCP Map dialog box appears.
 
      [bookmark: pgfId-1224522]Step 2 In the TCP Map Name field, enter a name.
 
      [bookmark: pgfId-1224523]Step 3 In the Queue Limit field, enter the maximum number of out-of-order packets, between 0 and 250 packets.
 
      [bookmark: pgfId-1224524]The Queue Limit sets the maximum number of out-of-order packets that can be buffered and put in order for a TCP connection. The default is 0, which means this setting is disabled and the default system queue limit is used depending on the type of traffic:
 
       
        
        	 [bookmark: pgfId-1224525]Connections for application inspection, IPS, and TCP check-retransmission have a queue limit of 3 packets. If the ASA receives a TCP packet with a different window size, then the queue limit is dynamically changed to match the advertised setting.
 
        	 [bookmark: pgfId-1224529]For other TCP connections, out-of-order packets are passed through untouched.
 
       
 
      
 
      [bookmark: pgfId-1224530]If you set the Queue Limit to be 1 or above, then the number of out-of-order packets allowed for all TCP traffic matches this setting. For example, for application inspection, IPS, and TCP check-retransmission traffic, any advertised settings from TCP packets are ignored in favor of the Queue Limit setting. For other TCP traffic, out-of-order packets are now buffered and put in order instead of passed through untouched.
 
      [bookmark: pgfId-1224531]Step 4 In the Timeout field, set the maximum amount of time that out-of-order packets can remain in the buffer, between 1 and 20 seconds.
 
      [bookmark: pgfId-1224532]If they are not put in order and passed on within the timeout period, then they are dropped. The default is 4 seconds. You cannot change the timeout for any traffic if the Queue Limit is set to 0; you need to set the limit to be 1 or above for the Timeout to take effect.
 
      [bookmark: pgfId-1224533]Step 5 In the Reserved Bits area, click Clear and allow, Allow only, or Drop.
 
      [bookmark: pgfId-1224534]Allow only allows packets with the reserved bits in the TCP header. 
 
      [bookmark: pgfId-1224535]Clear and allow clears the reserved bits in the TCP header and allows the packet. 
 
      [bookmark: pgfId-1224536]Drop drops the packet with the reserved bits in the TCP header.
 
      [bookmark: pgfId-1224537]Step 6 Check any of the following options:
 
       
        
        	 [bookmark: pgfId-1224541]Clear urgent flag—Clears the URG flag through the ASA. The URG flag is used to indicate that the packet contains information that is of higher priority than other data within the stream. The TCP RFC is vague about the exact interpretation of the URG flag, therefore end systems handle urgent offsets in different ways, which may make the end system vulnerable to attacks.
 
        	 [bookmark: pgfId-1224542]Drop connection on window variation—Drops a connection that has changed its window size unexpectedly. The window size mechanism allows TCP to advertise a large window and to subsequently advertise a much smaller window without having accepted too much data. From the TCP specification, “shrinking the window” is strongly discouraged. When this condition is detected, the connection can be dropped.
 
        	 [bookmark: pgfId-1224543]Drop packets that exceed maximum segment size—Drops packets that exceed MSS set by peer.
 
        	 [bookmark: pgfId-1224544]Check if transmitted data is the same as original—Enables the retransmit data checks.
 
        	 [bookmark: pgfId-1224545]Drop packets which have past-window sequence—Drops packets that have past-window sequence numbers, namely the sequence number of a received TCP packet is greater than the right edge of the TCP receiving window. If you do not check this option, then the Queue Limit must be set to 0 (disabled).
 
        	 [bookmark: pgfId-1224546]Drop SYN Packets with data—Drops SYN packets with data.
 
        	 [bookmark: pgfId-1224550]Enable TTL Evasion Protection—Enables the TTL evasion protection offered by the ASA. Do not enable this option if you want to prevent attacks that attempt to evade security policy.
 
        	 [bookmark: pgfId-1224551]For example, an attacker can send a packet that passes policy with a very short TTL. When the TTL goes to zero, a router between the ASA and the endpoint drops the packet. It is at this point that the attacker can send a malicious packet with a long TTL that appears to the ASA to be a retransmission and is passed. To the endpoint host, however, it is the first packet that has been received by the attacker. In this case, an attacker is able to succeed without security preventing the attack.
 
        	 [bookmark: pgfId-1224558]Verify TCP Checksum—Enables checksum verification.
 
        	 [bookmark: pgfId-1224559]Drop SYNACK Packets with data—Drops TCP SYNACK packets that contain data.
 
        	 [bookmark: pgfId-1224560]Drop packets with invalid ACK—Drops packets with an invalid ACK. You might see invalid ACKs in the following instances:
 
       
 
      
 
      [bookmark: pgfId-1224561] – In the TCP connection SYN-ACK-received status, if the ACK number of a received TCP packet is not exactly same as the sequence number of the next TCP packet sending out, it is an invalid ACK.
 
      [bookmark: pgfId-1224562] – Whenever the ACK number of a received TCP packet is greater than the sequence number of the next TCP packet sending out, it is an invalid ACK.
 
       
        
      
 
      
 
      [bookmark: pgfId-1224563]Note TCP packets with an invalid ACK are automatically allowed for WAAS connections.
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1224564]Step 7 To set TCP options, check any of the following options:
 
       
        
        	 [bookmark: pgfId-1224565]Clear Selective Ack—Sets whether the selective-ack TCP option is allowed or cleared.
 
        	 [bookmark: pgfId-1224566]Clear TCP Timestamp—Sets whether the TCP timestamp option is allowed or cleared.
 
        	 [bookmark: pgfId-1224567]Clear Window Scale—Sets whether the window scale timestamp option is allowed or cleared.
 
        	 [bookmark: pgfId-1224568]Range—Sets the valid TCP options ranges, which should fall within 6-7 and 9-255. The lower bound should be less than or equal to the upper bound. Choose  Allow or  Drop for each range.
 
       
 
      
 
      [bookmark: pgfId-1224569]Step 8 Click OK.
 
      [bookmark: pgfId-1224570]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-1080774][bookmark: 78658]Configuring Connection Settings[bookmark: marker-1090843]
 
      
 
      [bookmark: pgfId-1224575]Step 1 Configure a service policy on the Configuration > Firewall > Service Policy Rules pane according to Chapter1, “Configuring a Service Policy”
 
      [bookmark: pgfId-1224579]You can configure connection limits as part of a new service policy rule, or you can edit an existing service policy.
 
      [bookmark: pgfId-1224580]Step 2 On the Rule Actions dialog box, click the Connection Settings tab.
 
      [bookmark: pgfId-1224581]Step 3 To set maximum connections, configure the following values in the Maximum Connections area:
 
       
        
        	 [bookmark: pgfId-1224582]TCP & UDP Connections—Specifies the maximum number of simultaneous TCP and UDP connections for all clients in the traffic class, up to 2000000. The default is 0 for both protocols, which means the maximum possible connections are allowed.
 
        	 [bookmark: pgfId-1224583]Embryonic Connections—Specifies the maximum number of embryonic connections per host up to 2000000. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. This limit enables the TCP Intercept feature. The default is  0 , which means the maximum embryonic connections. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help to minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server.
 
        	 [bookmark: pgfId-1224584]Per Client Connections—Specifies the maximum number of simultaneous TCP and UDP connections for each client up to 2000000. When a new connection is attempted by a client that already has opened the maximum per-client number of connections, the ASA rejects the connection and drops the packet.
 
        	 [bookmark: pgfId-1224588]Per Client Embryonic Connections—Specifies the maximum number of simultaneous TCP embryonic connections for each client up to 2000000. When a new TCP connection is requested by a client that already has the maximum per-client number of embryonic connections open through the ASA, the ASA proxies the request to the TCP Intercept feature, which prevents the connection.
 
       
 
      
 
      [bookmark: pgfId-1224595]Step 4 To configure connection timeouts, configure the following values in the TCP Timeout area:
 
       
        
        	 [bookmark: pgfId-1224596]Connection Timeout—Specifies the idle time until a connection slot (of  any protocol, not just TCP) is freed. Enter 0:0:0 to disable timeout for the connection. This duration must be at least 5 minutes. The default is 1 hour.
 
        	 [bookmark: pgfId-1224600]Send reset to TCP endpoints before timeout—Specifies that the ASA should send a TCP reset message to the endpoints of the connection before freeing the connection slot.
 
        	 [bookmark: pgfId-1224601]Embryonic Connection Timeout—Specifies the idle time until an embryonic (half-open) connection slot is freed. Enter 0:0:0 to disable timeout for the connection. The default is 30 seconds.
 
        	 [bookmark: pgfId-1224602]Half Closed Connection Timeout—Sets the idle timeout period until a half-closed connection is closed, between 0:5:0 (for 9.1(1) and earlier) or 0:0:30 (for 9.1(2) and later) and 1193:0:0. The default is 0:10:0. Half-closed connections are not affected by DCD. Also, the ASA does not send a reset when taking down half-closed connections.
 
       
 
      
 
      [bookmark: pgfId-1224606]Step 5 To disable randomized sequence numbers, uncheck Randomize Sequence Number.
 
      [bookmark: pgfId-1224607]TCP initial sequence number randomization can be disabled if another in-line firewall is also randomizing the initial sequence numbers, because there is no need for both firewalls to be performing this action. However, leaving ISN randomization enabled on both firewalls does not affect the traffic.
 
      [bookmark: pgfId-1224608]Each TCP connection has two ISNs: one generated by the client and one generated by the server. The security appliance randomizes the ISN of the TCP SYN passing in the outbound direction. If the connection is between two interfaces with the same security level, then the ISN will be randomized in the SYN in both directions.
 
      [bookmark: pgfId-1224609]Randomizing the ISN of the protected host prevents an attacker from predecting the next ISN for a new connection and potentially hijacking the new session.
 
      [bookmark: pgfId-1224610]Step 6 To configure TCP normalization, check Use TCP Map. Choose an existing TCP map from the drop-down list (if available), or add a new one by clicking New.
 
      [bookmark: pgfId-1224613]The Add TCP Map dialog box appears. See the “Customizing the TCP Normalizer with a TCP Map” section.
 
      [bookmark: pgfId-1224615]Step 7 Click OK.
 
      [bookmark: pgfId-1224616]Step 8 To set the time to live, check Decrement time to live for a connection.
 
      [bookmark: pgfId-1224617]Step 9 To enable TCP state bypass, in the Advanced Options area, check TCP State Bypass.
 
      [bookmark: pgfId-1224618]Step 10 Click OK or Finish.
 
      [bookmark: pgfId-1224619]
 
       
       
 
      
 
      
 
     
 
      
       [bookmark: pgfId-1224622][bookmark: 30429]Configuring Global Timeouts
 
      [bookmark: pgfId-1224623]The Configuration > Firewall > Advanced > Global Timeouts pane lets you set the timeout durations for use with the ASA. All durations are displayed in the format hh:mm:ss. It sets the idle time for the connection and translation slots of various protocols. If the slot has not been used for the idle time specified, the resource is returned to the free pool. TCP connection slots are freed approximately 60 seconds after a normal connection close sequence.
 
      [bookmark: pgfId-1224627]Fields
 
      [bookmark: pgfId-1224628]In all cases, except for Authentication absolute and Authentication inactivity, unchecking the check boxes means there is no timeout value. For those two cases, clearing the check box means to reauthenticate on every new connection. 
 
       
       	 [bookmark: pgfId-1224629]Connection—Modifies the idle time until a connection slot is freed. Enter 0:0:0 to disable timeout for the connection. This duration must be at least 5 minutes. The default is 1 hour.
 
       	 [bookmark: pgfId-1224630]Half-closed—Modifies the idle time until a TCP half-closed connection closes. The minimum is 5 minutes. The default is 10 minutes. Enter 0:0:0 to disable timeout for a half-closed connection. 
 
       	 [bookmark: pgfId-1224631]UDP—Modifies the idle time until a UDP protocol connection closes. This duration must be at least 1 minute. The default is 2 minutes. Enter 0:0:0 to disable timeout. 
 
       	 [bookmark: pgfId-1224632]ICMP—Modifies the idle time after which general ICMP states are closed.
 
       	 [bookmark: pgfId-1224633]H.323—Modifies the idle time until an H.323 media connection closes. The default is 5 minutes. Enter 0:0:0 to disable timeout. 
 
       	 [bookmark: pgfId-1224634]H.225—Modifies the idle time until an H.225 signaling connection closes. The H.225 default timeout is 1 hour (1:0:0). Setting the value of 0:0:0 means never close this connection. To close this connection immediately after all calls are cleared, a value of 1 second (0:0:1) is recommended. 
 
       	 [bookmark: pgfId-1224635]MGCP—Modifies the timeout value for MGCP which represents the idle time after which MGCP media ports are closed. The MGCP default timeout is 5 minutes (0:5:0). Enter 0:0:0 to disable timeout. 
 
       	 [bookmark: pgfId-1224636]MGCP PAT—Modifies the idle time after which an MGCP PAT translation is removed. The default is 5 minutes (0:5:0). The minimum time is 30 seconds. Uncheck the check box to return to the default value.
 
       	 [bookmark: pgfId-1224637]TCP Proxy Reassembly—Configures the idle timeout after which buffered packets waiting for reassembly are dropped, between 0:0:10 and 1193:0:0. The default is 1 minute (0:1:0).
 
       	 [bookmark: pgfId-1224638]Floating Connection—When multiple static routes exist to a network with different metrics, the ASA uses the one with the best metric at the time of connection creation. If a better route becomes available, then this timeout lets connections be closed so a connection can be reestablished to use the better route. The default is 0 (the connection never times out). To take advantage of this feature, change the timeout to a new value between 0:1:0 and 1193:0:0.
 
       	 [bookmark: pgfId-1224642]SUNRPC—Modifies the idle time until a SunRPC slot is freed. This duration must be at least 1 minute. The default is 10 minutes. Enter 0:0:0 to disable timeout.
 
       	 [bookmark: pgfId-1224643]SIP—Modifies the idle time until an SIP signalling port connection closes. This duration must be at least 5 minutes. The default is 30 minutes. 
 
       	 [bookmark: pgfId-1224644]SIP Media—Modifies the idle time until an SIP media port connection closes. This duration must be at least 1 minute. The default is 2 minutes. 
 
       	 [bookmark: pgfId-1224645]SIP Provisional Media—Modifies the timeout value for SIP provisional media connections, between 0:1:0 and 1193:0:0. The default is 2 minutes.
 
       	 [bookmark: pgfId-1224646]SIP Invite—Modifies the idle time after which pinholes for PROVISIONAL responses and media xlates will be closed. The minimum value is 0:1:0, the maximum value is 0:30:0. The default value is 0:3:0. 
 
       	 [bookmark: pgfId-1224647]SIP Disconnect—Modifies the idle time after which SIP session is deleted if the 200 OK is not received for a CANCEL or a BYE message. The minimum value is 0:0:1, the maximum value is 0:10:0. The default value is 0:2:0.
 
       	 [bookmark: pgfId-1224648]Authentication absolute—Modifies the duration until the authentication cache times out and you have to reauthenticate a new connection. This duration must be shorter than the Translation Slot value. The system waits until you start a new connection to prompt you again. Enter 0:0:0 to disable caching and reauthenticate on every new connection. 
 
      
 
       
        
      
 
      
 
      [bookmark: pgfId-1224649]Note Do not set this value to 0:0:0 if passive FTP is used on the connections. 
 
       
       
 
      
 
      
 
       
        
      
 
      
 
      [bookmark: pgfId-1224650]Note When Authentication Absolute = 0, HTTPS authentication may not work. If a browser initiates multiple TCP connections to load a web page after HTTPS authentication, the first connection is permitted through, but subsequent connections trigger authentication. As a result, users are continuously presented with an authentication page, even after successful authentication. To work around this, set the authentication absolute timeout to 1 second. This workaround opens a 1-second window of opportunity that might allow non-authenticated users to go through the firewall if they are coming from the same source IP address. 
 
       
       
 
      
 
      
 
       
       	 [bookmark: pgfId-1224651]Authentication inactivity—Modifies the idle time until the authentication cache times out and users have to reauthenticate a new connection. This duration must be shorter than the Translation Slot value. 
 
       	 [bookmark: pgfId-1224652]Translation Slot—Modifies the idle time until a translation slot is freed. This duration must be at least 1 minute. The default is 3 hours. Enter 0:0:0 to disable the timeout.
 
       	 [bookmark: pgfId-1224653](8.4(3) and later, not including 8.5(1) and 8.6(1)) PAT Translation Slot—Modifies the idle time until a PAT translation slot is freed, between 0:0:30 and 0:5:0. The default is 30 seconds. You may want to increase the timeout if upstream routers reject new connections using a freed PAT port because the previous connection might still be open on the upstream device.
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1090436][bookmark: 17305]Feature History for Connection Settings
 
      
       
        
        [bookmark: pgfId-1158070]Table 22-1 [bookmark: 93569]Feature History for Connection Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1158076]Feature Name 
          
  
         	 
           
           [bookmark: pgfId-1158078]Platform Releases 
          
  
         	 
           
           [bookmark: pgfId-1158080]Feature Information 
          
  
        
 
         
         	[bookmark: pgfId-1158082]TCP state bypass
  
         	[bookmark: pgfId-1158084]8.2(1)
  
         	[bookmark: pgfId-1158086]This feature was introduced. The following command was introduced: set connection advanced-options tcp-state-bypass.
  
        
 
         
         	[bookmark: pgfId-1158088]Connection timeout for all protocols
  
         	[bookmark: pgfId-1158090]8.2(2)
  
         	[bookmark: pgfId-1158092]The idle timeout was changed to apply to all protocols, not just TCP.
 [bookmark: pgfId-1158094]The following screen was modified: Configuration > Firewall > Service Policies > Rule Actions > Connection Settings.
  
        
 
         
         	[bookmark: pgfId-1158096]Timeout for connections using a backup static route
  
         	[bookmark: pgfId-1158098]8.2(5)/8.4(2)
  
         	[bookmark: pgfId-1158100]When multiple static routes exist to a network with different metrics, the ASA uses the one with the best metric at the time of connection creation. If a better route becomes available, then this timeout lets connections be closed so a connection can be reestablished to use the better route. The default is 0 (the connection never times out). To take advantage of this feature, change the timeout to a new value.
 [bookmark: pgfId-1158105]We modified the following screen: Configuration > Firewall > Advanced > Global Timeouts.
  
        
 
         
         	[bookmark: pgfId-1158126]Configurable timeout for PAT xlate
  
         	[bookmark: pgfId-1158113]8.4(3)
  
         	[bookmark: pgfId-1158118]When a PAT xlate times out (by default after 30 seconds), and the ASA reuses the port for a new translation, some upstream routers might reject the new connection because the previous connection might still be open on the upstream device. The PAT xlate timeout is now configurable, to a value between 30 seconds and 5 minutes.
 [bookmark: pgfId-1224679]We modified the following screen: Configuration > Firewall > Advanced > Global Timeouts.
 [bookmark: pgfId-1158121]This feature is not available in 8.5(1) or 8.6(1).
  
        
 
         
         	[bookmark: pgfId-1186701]Increased maximum connection limits for service policy rules
  
         	[bookmark: pgfId-1186686]9.0(1)
  
         	[bookmark: pgfId-1207350]The maximum number of connections for service policy rules was increased from 65535 to 2000000.
 [bookmark: pgfId-1186690]We modified the following screen: Configuration > Firewall > Service Policy Rules > Connection Settings.
  
        
 
         
         	[bookmark: pgfId-1207306]Decreased the half-closed timeout minimum value to 30 seconds
  
         	[bookmark: pgfId-1207308]9.1(2)
  
         	[bookmark: pgfId-1207310]The half-closed timeout minimum value for both the global timeout and connection timeout was lowered from 5 minutes to 30 seconds to provide better DoS protection.
 [bookmark: pgfId-1224663]We modified the following screens:
 [bookmark: pgfId-1207401]Configuration > Firewall > Service Policy Rules > Connection Settings
Configuration > Firewall > Advanced > Global Timeouts.
  
        
 
        
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1559223][bookmark: 26170]Configuring the ASA for Cisco Cloud Web Security 
      
      
 
     
 
 
    [bookmark: pgfId-1698497]Cisco Cloud Web Security provides web security and web filtering services through the Software-as-a-Service (SaaS) model. Enterprises with the ASA in their network can use Cloud Web Security services without having to install additional hardware.
 
    [bookmark: pgfId-1698513]When Cloud Web Security is enabled on the ASA, the ASA transparently redirects selected HTTP and HTTPS traffic to the Cloud Web Security proxy servers. The Cloud Web Security proxy servers then scan the content and allow, block, or send a warning about the traffic based on the policy configured in Cisco ScanCenter to enforce acceptable use and to protect users from malware.
 
    [bookmark: pgfId-1698523]The ASA can optionally authenticate and identify users with Identity Firewall (IDFW) and AAA rules. The ASA encrypts and includes the user credentials (including usernames and/or user groups) in the traffic it redirects to Cloud Web Security. The Cloud Web Security service then uses the user credentials to match the traffic to the policy. It also uses these credentials for user-based reporting. Without user authentication, the ASA can supply an (optional) default username and/or group, although usernames and groups are not required for the Cloud Web Security service to apply policy.
 
    [bookmark: pgfId-1698536]You can customize the traffic you want to send to Cloud Web Security when you create your service policy rules. You can also configure a “whitelist” so that a subset of web traffic that matches the service policy rule instead goes directly to the originally requested web server and is not scanned by Cloud Web Security.
 
    [bookmark: pgfId-1698549]You can configure a primary and a backup Cloud Web Security proxy server, each of which the ASA polls regularly to check for availability.
 
     
      
    
 
    
 
    [bookmark: pgfId-1574300]Note This feature is also called “ScanSafe,” so the ScanSafe name appears in some commands.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1737510]This chapter includes the following sections:
 
     
     	 [bookmark: pgfId-1575676]Information About Cisco Cloud Web Security
 
     	 [bookmark: pgfId-1575680]Licensing Requirements for Cisco Cloud Web Security
 
     	 [bookmark: pgfId-1686132]Prerequisites for Cloud Web Security
 
     	 [bookmark: pgfId-1575696]Guidelines and Limitations
 
     	 [bookmark: pgfId-1575701]Default Settings
 
     	 [bookmark: pgfId-1575715]Configuring Cisco Cloud Web Security
 
     	 [bookmark: pgfId-1575728]Monitoring Cloud Web Security
 
     	 [bookmark: pgfId-1686108]Related Documents
 
     	 [bookmark: pgfId-1575759]Feature History for Cisco Cloud Web Security
 
    
 
   
 
    
     [bookmark: pgfId-1323971][bookmark: 38541]Information About Cisco Cloud Web Security
 
    [bookmark: pgfId-1575675]This section includes the following topics:
 
     
     	 [bookmark: pgfId-1577706]Redirection of Web Traffic to Cloud Web Security
 
     	 [bookmark: pgfId-1721509]User Authentication and Cloud Web Security
 
     	 [bookmark: pgfId-1685905]Authentication Keys
 
     	 [bookmark: pgfId-1579396]ScanCenter Policy
 
     	 [bookmark: pgfId-1579150]Cloud Web Security Actions
 
     	 [bookmark: pgfId-1723921]Bypassing Scanning with Whitelists
 
     	 [bookmark: pgfId-1685867]IPv4 and IPv6 Support
 
     	 [bookmark: pgfId-1584715]Failover from Primary to Backup Proxy Server
 
    
 
     
      [bookmark: pgfId-1721421][bookmark: 25618]Redirection of Web Traffic to Cloud Web Security
 
     [bookmark: pgfId-1577487]When an end user sends an HTTP or HTTPS request, the ASA receives it and optionally retrieves the user and/or group information. If the traffic matches an ASA service policy rule for Cloud Web Security, then the ASA redirects the request to the Cloud Web Security proxy servers. The ASA acts as an intermediary between the end user and the Cloud Web Security proxy server by redirecting the connection to the proxy server. The ASA changes the destination IP address and port in the client requests and adds Cloud Web Security-specific HTTP headers and then sends the modified request to the Cloud Web Security proxy server. The Cloud Web Security HTTP headers include various kinds of information, including the username and user group (if available).
 
    
 
     
      [bookmark: pgfId-1723451][bookmark: 51023]User Authentication and Cloud Web Security
 
     [bookmark: pgfId-1723452]User identity can be used to apply policy in Cloud Web Security. User identity is also useful for Cloud Web Security reporting. User identity is not required to use Cloud Web Security. There are other methods to identify traffic for Cloud Web Security policy. 
 
     [bookmark: pgfId-1723459]The ASA supports the following methods of determining the identity of a user, or of providing a default identity:
 
      
      	 [bookmark: pgfId-1723463]AAA rules—When the ASA performs user authentication using a AAA rule, the username is retrieved from the AAA server or local database. Identity from AAA rules does not include group information. If configured, the default group is used. For information about configuring AAA rules, see Chapter8, “Configuring AAA Rules for Network Access” 
 
      	 [bookmark: pgfId-1725913]IDFW—When the ASA uses IDFW with the Active Directory (AD), the username and group is retrieved from the AD agent when you activate a user and/or group by using an ACL in a feature such as an access rule or in your service policy, or by configuring the user identity monitor to download user identity information directly.
 
     
 
     [bookmark: pgfId-1725878]For information about configuring IDFW, see “Configuring the Identity Firewall,” in the general operations configuration guide.
 
      
      	 [bookmark: pgfId-1723477]Default username and group—Without user authentication, the ASA uses an optional default username and/or group for all users that match a service policy rule for Cloud Web Security.
 
     
 
    
 
     
      [bookmark: pgfId-1721741][bookmark: 54255][bookmark: 43720][bookmark: 66205][bookmark: 45469][bookmark: 76174]Authentication Keys
 
     [bookmark: pgfId-1721745]Each ASA must use an authentication key that you obtain from Cloud Web Security. The authentication key lets Cloud Web Security identify the company associated with web requests and ensures that the ASA is associated with valid customer.
 
     [bookmark: pgfId-1721960]Y[bookmark: 79252]ou can use one of two types of authentication keys for your ASA: the company key or the group key.
 
      
      	 [bookmark: pgfId-1722009]Company Authentication Key
 
      	 [bookmark: pgfId-1722017]Group Authentication Key
 
     
 
    
 
     
      [bookmark: pgfId-1721755][bookmark: 73878]Company Authentication Key
 
     [bookmark: pgfId-1721756]A Company authentication key can be used on multiple ASAs within the same company. This key simply enables the Cloud Web Security service for your ASAs. The administrator generates this key in ScanCenter (https://scancenter.scansafe.com/portal/admin/login.jsp); you have the opportunity to e-mail the key for later use. You cannot look up this key later in ScanCenter; only the last 4 digits are shown in ScanCenter. For more information, see the Cloud Web Security documentation: http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html.
 
    
 
     
      [bookmark: pgfId-1721989][bookmark: 41375]Group Authentication Key
 
     [bookmark: pgfId-1721770]A Group authentication key is a special key unique to each ASA that performs two functions:
 
      
      	 [bookmark: pgfId-1722028]Enables the Cloud Web Security service for one ASA.
 
      	 [bookmark: pgfId-1722043]Identifies all traffic from the ASA so you can create ScanCenter policy per ASA.
 
     
 
     [bookmark: pgfId-1722029]For information about using the Group authentication key for policy, see the “ScanCenter Policy” section).
 
     [bookmark: pgfId-1723713]The administrator generates this key in ScanCenter (https://scancenter.scansafe.com/portal/admin/login.jsp); you have the opportunity to e-mail the key for later use. You cannot look up this key later in ScanCenter; only the last 4 digits are shown in ScanCenter. For more information, see the Cloud Web Security documentation: http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html.
 
    
 
     
      [bookmark: pgfId-1721437][bookmark: 12776]ScanCenter Policy
 
     [bookmark: pgfId-1577670]In ScanCenter, traffic is matched against policy rules in order until a rule is matched. Cloud Web Security then applies the configured action for the rule. User traffic can match a policy rule in ScanCenter based on group association: a directory group or a custom group.
 
      
      	 [bookmark: pgfId-1722194]Directory Groups
 
      	 [bookmark: pgfId-1722250]Custom Groups
 
      	 [bookmark: pgfId-1722953]How Groups and the Authentication Key Interoperate
 
     
 
    
 
     
      [bookmark: pgfId-1722168][bookmark: 58779]Directory Groups
 
     [bookmark: pgfId-1721624]Directory groups define the group to which traffic belongs. The group, if present, is included in the HTTP header of the client request. The ASA includes the group in the HTTP header when you configure IDFW. If you do not use IDFW, you can configure a default group for traffic matching an ASA rule for Cloud Web Security inspection.
 
     [bookmark: pgfId-1722499]When you configure a directory group, you must enter the group name exactly.
 
      
      	 [bookmark: pgfId-1724236]IDFW group names are sent in the following format:
 
     
 
     [bookmark: pgfId-1723993]domain-name\group-name
 
     [bookmark: pgfId-1723997]When the ASA learns the IDFW group name, the format on the ASA is domain-name\\group-name. However, the ASA modifies the name to use only one backslash (\) to conform to typical ScanCenter notation.
 
      
      	 [bookmark: pgfId-1722589]The default group name is sent in the following format:
 
     
 
     [bookmark: pgfId-1722703][domain\]group-name
 
     [bookmark: pgfId-1723954]On the ASA, you need to configure the optional domain name to be followed by 2 backslashes (\\); however, the ASA modifies the name to use only one backslash (\) to conform to typical ScanCenter notation. For example, if you specify “Cisco\\Boulder1,” the ASA modifies the group name to be “Cisco\Boulder1” with only one backslash (\) when sending the group name to Cloud Web Security.
 
    
 
     
      [bookmark: pgfId-1722178][bookmark: 92170]Custom Groups
 
     [bookmark: pgfId-1721651]Custom groups are defined using one or more of the following criteria:
 
      
      	 [bookmark: pgfId-1721334]ScanCenter Group authentication key—You can generate a Group authentication key for a custom group. Then, if you identify this group key when you configure the ASA, all traffic from the ASA is tagged with the Group key.
 
      	 [bookmark: pgfId-1721339]Source IP address—You can identify source IP addresses in the custom group. Note that the ASA service policy is based on source IP address, so you might want to configure any IP address-based policy on the ASA instead.
 
      	 [bookmark: pgfId-1721405]Username—You can identify usernames in the custom group.
 
     
 
     [bookmark: pgfId-1724051] – IDFW usernames are sent in the following format:
 
     [bookmark: pgfId-1722704]domain-name\username
 
     [bookmark: pgfId-1722713] – AAA usernames, when using RADIUS or TACACS+, are sent in the following format:
 
     [bookmark: pgfId-1724038]LOCAL\username
 
     [bookmark: pgfId-1724183] – AAA usernames, when using LDAP, are sent in the following format:
 
     [bookmark: pgfId-1724184]domain-name\username
 
     [bookmark: pgfId-1724035] – For the default username, it is sent in the following format:
 
     [bookmark: pgfId-1722722][domain-name\]username
 
     [bookmark: pgfId-1724420]For example, if you configure the default username to be “Guest,” then the ASA sends “Guest.” If you configure the default username to be “Cisco\Guest,” then the ASA sends “Cisco\Guest.”
 
    
 
     
      [bookmark: pgfId-1722440][bookmark: 22081]How Groups and the Authentication Key Interoperate
 
     [bookmark: pgfId-1722791]Unless you need the per-ASA policy that a custom group+group key provides, you will likely use a company key. Note that not all custom groups are associated with a group key. Non-keyed custom groups can be used to identify IP addresses or usernames, and can be used in your policy along with rules that use directory groups. 
 
     [bookmark: pgfId-1723853]Even if you do want per-ASA policy and are using a group key, you can also use the matching capability provided by directory groups and non-keyed custom groups. In this case, you might want an ASA-based policy, with some exceptions based on group membership, IP address, or username. For example, if you want to exempt users in the America\Management group across all ASAs:
 
     [bookmark: pgfId-1723882] 1. Add a directory group for America\Management.
 
     [bookmark: pgfId-1723897] 2. Add an exempt rule for this group.
 
     [bookmark: pgfId-1723900] 3. Add rules for each custom group+group key after the exempt rule to apply policy per-ASA.
 
     [bookmark: pgfId-1723901] 4. Traffic from users in America\Management will match the exempt rule, while all other traffic will match the rule for the ASA from which it originated.
 
     [bookmark: pgfId-1722891]Many combinations of keys, groups, and policy rules are possible.
 
    
 
     
      [bookmark: pgfId-1721488][bookmark: 75156]Cloud Web Security Actions
 
     [bookmark: pgfId-1721360]After applying the configured policies, Cloud Web Security either blocks, allows, or sends a warning about the user request:
 
      
      	 [bookmark: pgfId-1577695]Allows—When Cloud Web Security allows the client request, it contacts the originally requested server and retrieves the data. It forwards the server response to the ASA, which then forwards it to the user.
 
      	 [bookmark: pgfId-1595707]Blocks—When Cloud Web Security blocks the client request, it notifies the user that access has been blocked. It sends an HTTP 302 “Moved Temporarily” response that redirects the client application to a web page hosted by the Cloud Web Security proxy server showing the blocked error message. The ASA forwards the 302 response to the client. 
 
      	 [bookmark: pgfId-1595811]Warns—When the Cloud Web Security proxy server determines that a site may be in breach of the acceptable use policy, it displays a warning page about the site. You can choose to heed the warning and drop the request to connect, or you can click through the warning and proceed to the requested site.
 
     
 
     [bookmark: pgfId-1628839]You can also choose how the ASA handles web traffic when it cannot reach either the primary or backup Cloud Web Security proxy server. It can block or allow all web traffic. By default, it blocks web traffic.
 
    
 
     
      [bookmark: pgfId-1700219][bookmark: 90362]Bypassing Scanning with Whitelists
 
     [bookmark: pgfId-1700223]If you use AAA rules or IDFW, you can configure the ASA so that web traffic from specific users or groups that otherwise match the service policy rule is not redirected to the Cloud Web Security proxy server for scanning. When you bypass Cloud Web Security scanning, the ASA retrieves the content directly from the originally requested web server without contacting the proxy server. When it receives the response from the web server, it sends the data to the client. This process is called “whitelisting” traffic.
 
     [bookmark: pgfId-1727453]Although you can achieve the same results of exempting traffic based on user or group when you configure the class of traffic using ACLs to send to Cloud Web Security, you might find it more straightforward to use a whitelist instead. Note that the whitelist feature is only based on user and group, not on IP address.
 
    
 
     
      [bookmark: pgfId-1601173][bookmark: 63559]IPv4 and IPv6 Support
 
     [bookmark: pgfId-1581768]Cloud Web Security currently supports only IPv4 addresses. If you use IPv6 internally, NAT 64 must be performed for any IPv6 flows that need to be sent to Cloud Web Security. 
 
     [bookmark: pgfId-1581832]The following table shows the class map traffic that is supported by Cloud Web Security redirection:
 
     [bookmark: pgfId-1581827]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1581846]Class Map Traffic 
          
  
         	 
           
           [bookmark: pgfId-1581848]Cloud Web Security Inspection 
          
  
        
 
         
         	[bookmark: pgfId-1581850]From IPv4 to IPv4
  
         	[bookmark: pgfId-1581852]Supported
  
        
 
         
         	[bookmark: pgfId-1581854]From IPv6 to IPv4 (using NAT64)
  
         	[bookmark: pgfId-1581856]Supported
  
        
 
         
         	[bookmark: pgfId-1581862]From IPv4 to IPv6
  
         	[bookmark: pgfId-1581864]Not Supported
  
        
 
         
         	[bookmark: pgfId-1581866]From IPv6 to IPv6
  
         	[bookmark: pgfId-1581868]Not Supported
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1584756][bookmark: 81552]Failover from Primary to Backup Proxy Server
 
     [bookmark: pgfId-1587495]When you subscribe to the Cisco Cloud Web Security service, you are assigned a primary Cloud Web Security proxy server and backup proxy server.
 
     [bookmark: pgfId-1779167]If any client is unable to reach the primary server, then the ASA starts polling the tower to determine availability. (If there is no client activity, the ASA polls every 15 miniutes.) If the proxy server is unavailable after a configured number of retries (the default is 5; this setting is configurable), the server is declared unreachable, and the backup proxy server becomes active.
 
     [bookmark: pgfId-1779168]If a client or the ASA can reach the server at least twice consecutively before the retry count is reached, the polling stops and the tower is determined to be reachable.
 
     [bookmark: pgfId-1779169]After a failover to the backup server, the ASA continues to poll the primary server. If the primary server becomes reachable, then the ASA returns to using the primary server.
 
    
 
   
 
    
     [bookmark: pgfId-1546618]  [bookmark: 69315][bookmark: 86669][bookmark: 19163][bookmark: 29596]Licensing Requirements for Cisco Cloud Web Security
 
    [bookmark: pgfId-1830103]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1830093]Model 
         
  
        	 
          
          [bookmark: pgfId-1830095]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1830097]All models
  
        	[bookmark: pgfId-1830102]Strong Encryption (3DES/AES) License to encrypt traffic between the ASA and the Cloud Web Security server.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1753303]On the Cloud Web Security side, you must purchase a Cisco Cloud Web Security license and identify the number of users that the ASA handles. Then log into ScanCenter, and generate your authentication keys.
 
   
 
    
     [bookmark: pgfId-1683422][bookmark: 73294]Prerequisites for Cloud Web Security
 
    [bookmark: pgfId-1683459](Optional) User Authentication Prerequisites
 
    [bookmark: pgfId-1683561]To send user identity information to Cloud Web Security, configure one of the following on the ASA:
 
     
     	 [bookmark: pgfId-1683598]AAA rules (username only)—See Chapter8, “Configuring AAA Rules for Network Access” 
 
     	 [bookmark: pgfId-1683566]IDFW (username and group)—See “Configuring the Identity Firewall,” in the general operations configuration guide.
 
    
 
    [bookmark: pgfId-1683502](Optional) Fully Qualified Domain Name Prerequisites
 
    [bookmark: pgfId-1683533]If you use FQDNs in ACLs for your service policy rule, or for the Cloud Web Security server, you must configure a DNS server for the ASA according to the “Configuring the DNS Server” section in the general operations configuration guide.
 
   
 
    
     [bookmark: pgfId-1326437][bookmark: 24122]Guidelines and Limitations
 
    [bookmark: pgfId-1546905][bookmark: 87419]Context Mode Guidelines
 
    [bookmark: pgfId-1546934]Supported in single and multiple context modes.
 
    [bookmark: pgfId-1574395]In multiple context mode, the server configuration is allowed only in the system, and the service policy rule configuration is allowed only in the security contexts.
 
    [bookmark: pgfId-1729939]Each context can have its own authentication key, if desired.
 
    [bookmark: pgfId-1326453][bookmark: 16807]Firewall Mode Guidelines
 
    [bookmark: pgfId-1573970]Supported in routed firewall mode only. Does not support transparent firewall mode.
 
    [bookmark: pgfId-1547092]IPv6 Guidelines
 
    [bookmark: pgfId-1574027]Does not support IPv6. See the “IPv4 and IPv6 Support” section.
 
    [bookmark: pgfId-1547104]Additional Guidelines
 
     
     	 [bookmark: pgfId-1548366]Cloud Web Security is not supported with ASA clustering.
 
     	 [bookmark: pgfId-1574065]Clientless SSL VPN is not supported with Cloud Web Security; be sure to exempt any clientless SSL VPN traffic from the ASA service policy for Cloud Web Security.
 
     	 [bookmark: pgfId-1606789]When an interface to the Cloud Web Security proxy servers goes down, output from the  show scansafe server command shows both servers up for approximately 15-25 minutes. This condition may occur because the polling mechanism is based on the active connection, and because that interface is down, it shows zero connection, and it takes the longest poll time approach.
 
     	 [bookmark: pgfId-1653956]Cloud Web Security is not supported with the ASA CX module. If you configure both the ASA CX action and Cloud Web Security inspection for the same traffic, the ASA only performs the ASA CX action.
 
     	 [bookmark: pgfId-1708582]Cloud Web Security inspection is compatibile with HTTP inspection for the same traffic. HTTP inspection is enabled by default as part of the default global policy.
 
     	 [bookmark: pgfId-1708583]Cloud Web Security is not supported with extended PAT or any application that can potentially use the same source port and IP address for separate connections. For example, if two different connections (targeted to separate servers) use extended PAT, the ASA might reuse the same source IP and source port for both connection translations because they are differentiated by the separate destinations. When the ASA redirects these connections to the Cloud Web Security server, it replaces the destination with the Cloud Web Security server IP address and port (8080 by default). As a result, both connections now appear to belong to the same flow (same source IP/port and destination IP/port), and return traffic cannot be untranslated properly.
 
     	 [bookmark: pgfId-1708584]The Default Inspection Traffic traffic class does not include the default ports for the Cloud Web Security inspection (80 and 443).
 
    
 
   
 
    
     [bookmark: pgfId-1326530][bookmark: 23986]Default Settings
 
    [bookmark: pgfId-1581572]By default, Cisco Cloud Web Security is not enabled.
 
   
 
    
     [bookmark: pgfId-1581575][bookmark: 24282]Configuring Cisco Cloud Web Security
 
     
     	 [bookmark: pgfId-1660102]Configuring Communication with the Cloud Web Security Proxy Server
 
     	 [bookmark: pgfId-1720617](Multiple Context Mode) Allowing Cloud Web Security Per Security Context
 
     	 [bookmark: pgfId-1686559]Configuring a Service Policy to Send Traffic to Cloud Web Security
 
     	 [bookmark: pgfId-1660122](Optional) Configuring Whitelisted Traffic
 
     	 [bookmark: pgfId-1687001]Configuring the Cloud Web Security Policy
 
    
 
     
      [bookmark: pgfId-1654648][bookmark: 18585]Configuring Communication with the Cloud Web Security Proxy Server
 
    
 
     
      [bookmark: pgfId-1655467]Guidelines
 
     [bookmark: pgfId-1655462]The public key is embedded in the ASA software, so there is no need for you to configure it.
 
    
 
     
      [bookmark: pgfId-1654649]Detailed Steps
 
     
 
     [bookmark: pgfId-1815928]Step 1 Choose Configuration > Device Management > Cloud Web Security.
 
     [bookmark: pgfId-1826564]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1815933]Step 2 In the Primary Server area, enter the following:
 
      
       
       	 [bookmark: pgfId-1815934]IP Address/Domain Name—Enter the IPv4 address or FQDN of the primary server.
 
       	 [bookmark: pgfId-1815935]HTTP Port—Enter the HTTP port of the primary server (port to which traffic must be redirected). By default the port is 8080; do not change this value unless directed to do so.
 
      
 
     
 
     [bookmark: pgfId-1815936]Step 3 In the Backup Server area, enter the following:
 
      
       
       	 [bookmark: pgfId-1815937]IP Address/Domain Name—Enter the IPv4 address or FQDN of the backup server.
 
       	 [bookmark: pgfId-1815938]HTTP Port—Enter the HTTP port of the backup server (port to which traffic must be redirected). By default the port is 8080. Valid values are from 1 to 65535.
 
      
 
     
 
     [bookmark: pgfId-1815939]Step 4 In the Other area, enter the following:
 
      
       
       	 [bookmark: pgfId-1815940]Retry Counter—Enter the value for the number of consecutive polling failures to the Cloud Web Security proxy server before determining the server is unreachable. Polls are performed every 30 seconds. Valid values are from 2 to 100, and the default is 5.
 
       	 [bookmark: pgfId-1815947]License Key—Configure the authentication key that the ASA sends to the Cloud Web Security proxy servers to indicate from which organization the request comes. The authentication key is a 16-byte hexidecimal number. See the “Authentication Keys” section.
 
       	 [bookmark: pgfId-1815951]Confirm License Key—Confirm the authentication key.
 
      
 
     
 
     [bookmark: pgfId-1815952]Step 5 Click Apply. 
 
     [bookmark: pgfId-1815953]
 
      
      
 
     
 
     
 
      
      [bookmark: pgfId-1748797] 
     
 
    
 
     
      [bookmark: pgfId-1720583][bookmark: 12251][bookmark: 19076](Multiple Context Mode) Allowing Cloud Web Security Per Security Context
 
     [bookmark: pgfId-1820108]In multiple context mode, you must allow Cloud Web Security per context. See the “Configuring a Security Context” section in the general operations configuration guide.
 
      
       
     
 
     
 
     [bookmark: pgfId-1820113]Note You must configure a route pointing to the Scansafe towers in both; the admin context and the specific context. This ensures that the Scansafe tower does not become unreachable in the Active/Active failover scenario.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1656854][bookmark: 83482]Configuring a Service Policy to Send Traffic to Cloud Web Security
 
     [bookmark: pgfId-1815958]Your service policy consists of multiple service policy rules, applied globally, or applied to each interface. Each service policy rule can either send traffic to Cloud Web Security (Match) or exempt traffic from Cloud Web Security (Do Not Match). Create rules for traffic destined for the Internet. The order of these rules is important. When the ASA decides whether to forward or exempt a packet, the ASA tests the packet with each rule in the order in which the rules are listed. After a match is found, no more rules are checked. For example, if you create a rule at the beginning of a policy that explicitly Matches all traffic, no further statements are ever checked. You can reorder the rules as needed after you add them.
 
     [bookmark: pgfId-1691584]See “Configuring a Service Policy,” for more information about service policy rules.
 
    
 
     
      [bookmark: pgfId-1683218]Prerequisites
 
     [bookmark: pgfId-1683226](Optional) If you need to use a whitelist to exempt some traffic from being sent to Cloud Web Security, first create the whitelist according to the “(Optional) Configuring Whitelisted Traffic” section so you can refer to the whitelist in your service policy rule.
 
    
 
     
      [bookmark: pgfId-1683109]Detailed Steps
 
     
 
     [bookmark: pgfId-1815969]Step 1 Choose Configuration > Firewall > Service Policy Rules, and click Add > Service Policy Rule to add a service policy rule.
 
     [bookmark: pgfId-1815971]Step 2 [bookmark: 60267]On the Service Policy dialog box, you can configure Cloud Web Security as part of a new service policy, or you can edit an existing service policy. Click Next.
 
     [bookmark: pgfId-1826932]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1815977]Step 3 [bookmark: 36962]On the Traffic Classification Criteria dialog box, name the traffic class (or accept the default name), keep the Create a new traffic class option selected, and click Source and Destination IP address (Uses ACL), then click Next.
 
     [bookmark: pgfId-1815978]When you create a new traffic class of this type, you can only specify one access control entry (ACE) initially. After you finish adding the rule, you can add additional ACEs by adding a new rule to the same interface or global policy, and then specifying Add rule to existing traffic class on the Traffic Classification dialog box.
 
     [bookmark: pgfId-1815979]The Traffic Match - Source and Destination dialog box appears.
 
     [bookmark: pgfId-1826940]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1815984] a. Click Match or Do Not Match.
 
     [bookmark: pgfId-1815985]Match specifies that traffic matching the source and destination is sent to Cloud Web Security. Do Not Match exempts matching traffic from Cloud Web Security. You can later add additional rules to match or not match other traffic.
 
     [bookmark: pgfId-1815986]When creating your rules, consider how you can match appropriate traffic that is destined for the Internet, but not match traffic that is destined for other internal networks. For example, to prevent inside traffic from being sent to Cloud Web Security when the destination is an internal server on the DMZ, be sure to add a deny ACE to the ACL that exempts traffic to the DMZ. 
 
     [bookmark: pgfId-1815987] b. In the Source Criteria area, enter or browse for a Source IP address or network object, an optional IDFW Username or group, and an optional TrustSec Security Group.
 
     [bookmark: pgfId-1815988] c. In the Destination Criteria area, enter or browse for a Destination IP address or network object, and an optional TrustSec Security Group.
 
     [bookmark: pgfId-1815989]FQDN network objects might be useful in matching or exempting traffic to specific servers.
 
     [bookmark: pgfId-1815991] d. [bookmark: 29510]In the Service field, enter http or https, and click Next.
 
      
       
     
 
     
 
     [bookmark: pgfId-1815992]Note Cloud Web Security only operates on HTTP and HTTPS traffic. Each type of traffic is treated separately by the ASA. Therefore, you need to create HTTP-only rules and HTTPS-only rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1815996]The Rule Actions dialog box appears.
 
     [bookmark: pgfId-1826948]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816001]Step 4 On the Protocol Inspection tab, check the Cloud Web Security check box.
 
     [bookmark: pgfId-1816002]Step 5 Click Configure to set the traffic action (fail open or fail close) and add the inspection policy map.
 
     [bookmark: pgfId-1816005]The inspection policy map configures essential parameters for the rule and also optionally identifies the whitelist. An inspection policy map is required for each class of traffic that you want to send to Cloud Web Security. You can also pre-configure inspection policy maps from the Configuration > Firewall > Objects > Inspect Maps > Cloud Web Security pane.
 
     [bookmark: pgfId-1816006]The Select Cloud Web Security Inspect Map dialog box appears.
 
     [bookmark: pgfId-1826956]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816011] a. For the Cloud Web Security Traffic Action, choose one:
 
     [bookmark: pgfId-1816012] – Fail Close—Drops all traffic if the Cloud Web Security servers are unavailable.
 
     [bookmark: pgfId-1816016] – Fail Open—Allows traffic to pass through the ASA if the Cloud Web Security servers are unavailable.
 
     [bookmark: pgfId-1816017] b. Choose an existing inspection policy map, or add one using the Add button.
 
     [bookmark: pgfId-1816018] c. Click Add to add a new inspection policy map.
 
     [bookmark: pgfId-1816019]The Add Cloud Web Security Inspect Map dialog box appears.
 
     [bookmark: pgfId-1826964]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816024] d. In the Name field, specify a name for the inspection policy map, up to 40 characters in length.
 
     [bookmark: pgfId-1816025] e. (Optional) Enter a description.
 
     [bookmark: pgfId-1816029] f. (Optional) On the Parameters tab, specify a Default User and/or a Default Group. If the ASA cannot determine the identity of the user coming into the ASA, then the default user and/or group is applied.
 
     [bookmark: pgfId-1816039] g. For the Protocol, click HTTP or HTTPS, to match the service you set in Step 3d. Cloud Web Security treats each type of traffic separately.
 
     [bookmark: pgfId-1816040] h. (Optional) To identify a whitelist, click the Inspections tab.
 
     [bookmark: pgfId-1826972]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816047] – Click Add to choose the inspection class map you created in the “(Optional) Configuring Whitelisted Traffic” section.
 
     [bookmark: pgfId-1816049]The Add Cloud Web Security Match Criterion dialog box appears.
 
     [bookmark: pgfId-1816050] – From the Cloud Web Security Traffic Class drop-down menu, choose an inspection class map.
 
     [bookmark: pgfId-1816051]To add or edit a class map, click Manage.
 
     [bookmark: pgfId-1816052] – For the Action, click Whitelist.
 
     [bookmark: pgfId-1816053] – Click OK to add the whitelist to the policy map.
 
     [bookmark: pgfId-1816054] – Click OK.
 
     [bookmark: pgfId-1816055]Step 6 Click Finish. The rule is added to the Service Policy Rules table.
 
     [bookmark: pgfId-1816056]Step 7 To add additional sub-rules (ACEs) for this traffic class, to match or exempt additional traffic:
 
     [bookmark: pgfId-1816057] a. Choose Configuration > Firewall > Service Policy Rules, and click Add > Service Policy Rule.
 
     [bookmark: pgfId-1816061] b. Choose the same service policy as Step 2. Click Next.
 
     [bookmark: pgfId-1826980]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816066] c. On the Traffic Classification Criteria dialog box, choose Add Rule to Existing Traffic Class, and choose the name you created in Step 3. Click Next.
 
     [bookmark: pgfId-1826988]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816074] d. In the Traffic Match - Source and Destination dialog box, choose Match to add inspect additional traffic, or Do Not Match to exempt traffic from Cloud Web Security inspections. Be sure to set the service to match the previous rules in this class (HTTP or HTTPS); you cannot mix HTTP and HTTPS in the same traffic class for Cloud Web Security. Click Next.
 
     [bookmark: pgfId-1826996]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816079] e. On the Rule Actions dialog box, do not make any changes; click Finish. For this traffic class, you can have only one set of rule actions even if you add multiple ACEs, so the previously-specified actions are inherited.
 
     [bookmark: pgfId-1816080]Step 8 Repeat this entire procedure to create an additional traffic class, for example for HTTPS traffic. You can create as many rules and sub-rules as needed.
 
     [bookmark: pgfId-1816081]Step 9 Arrange the order of Cloud Web Security rules and sub-rules on the Service Policy Rules pane. See the “Managing the Order of Service Policy Rules” section for information about changing the order of ACEs.
 
     [bookmark: pgfId-1827004]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1827008]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816093]Step 10 Click Apply.
 
     [bookmark: pgfId-1816094]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1739958]Examples
 
     [bookmark: pgfId-1816099]The following example exempts all IPv4 HTTP and HTTPS traffic going to the 10.6.6.0/24 (test_network), and sends all other HTTPS and HTTPS traffic to Cloud Web Security, and applies this service policy rule to all interfaces as part of the existing global policy. If the Cloud Web Security server is unreachable, the ASA drops all matching traffic (fail close). If a user is not have user identity information, the default user Boulder and group Cisco is used.
 
     
 
     [bookmark: pgfId-1816103]Step 1 Choose Configuration > Firewall > Service Policy Rules, and click Add > Service Policy Rule. Add this rule to the default global_policy:
 
     [bookmark: pgfId-1816107]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816108]Step 2 Add a new traffic class called “scansafe-http,” and specify an ACL for traffic matching:
 
     [bookmark: pgfId-1816112]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816113]Step 3 Choose Match, and specify any4 for the Source and Destination. Specify tcp/http for the Service.
 
     [bookmark: pgfId-1816117]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816118]Step 4 Check Cloud Web Security and click Configure.
 
     [bookmark: pgfId-1816122]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816123]Step 5 Accept the default Fail Close action, and click Add.
 
     [bookmark: pgfId-1816127]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816128]Step 6 Name the inspection policy map “http-map,” set the Default User to Boulder and the default group to Cisco. Choose HTTP.
 
     [bookmark: pgfId-1816132]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816133]Step 7 Click OK, OK, and then Finish. The rule is added to the Service Policy Rules table.
 
     [bookmark: pgfId-1816134]Step 8 Choose Configuration > Firewall > Service Policy Rules, and click Add > Service Policy Rule. Add the new rule to the default global_policy:
 
     [bookmark: pgfId-1816138]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816139]Step 9 Click Add rule to existing traffic class, and choose scansafe-http.
 
     [bookmark: pgfId-1816143]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816144]Step 10 Choose Do not match, set any4 as the Source, and 10.6.6.0/24 as the Destination. Set the Service to tcp/http.
 
     [bookmark: pgfId-1816148]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816149]Step 11 Click Finish.
 
     [bookmark: pgfId-1816153]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816154]Step 12 Reorder the rules so the Do not match rule is above the Match rule.
 
     [bookmark: pgfId-1816158]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816159]User traffic is compared to these rules in order; if this Match rule is first in the list, then all traffic, including traffic to test_network, will match only that rule and the Do not match rule will never be hit. If you move the Do not match rule above the Match rule, then traffic to test_network will match the Do not match rule, and all other traffic will match the Match rule.
 
     [bookmark: pgfId-1816160]Step 13 Repeat the above steps with the following changes: add a new traffic class called “scansafe-https,” and choose HTTPS for the inspection policy map.
 
     [bookmark: pgfId-1816164]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816165]Step 14 Click Apply.
 
     [bookmark: pgfId-1816166]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1682939][bookmark: 26482](Optional) Configuring Whitelisted Traffic 
 
     [bookmark: pgfId-1682940]If you use user authentication, you can exempt some traffic from being filtered by Cloud Web Security based on the username and/or groupname. When you configure your Cloud Web Security service policy rule, you can reference the whitelisting inspection class map. Both IDFW and AAA user credentials can be used with this feature.
 
     [bookmark: pgfId-1728033]Although you can achieve the same results of exempting traffic based on user or group when you configure the service policy rule, you might find it more straightforward to use a whitelist instead. Note that the whitelist feature is only based on user and group, not on IP address.
 
    
 
     
      [bookmark: pgfId-1682941]Detailed Steps
 
     
 
     [bookmark: pgfId-1816172]Step 1 [bookmark: 21120]Choose Configuration > Firewall > Objects > Class Maps > Cloud Web Security.
 
     [bookmark: pgfId-1816173]Step 2 Click Add to create a new class map.
 
     [bookmark: pgfId-1816174]The Add Cloud Web Security Traffic Class Map screen appears.
 
     [bookmark: pgfId-1827109]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1816179]Step 3 In the Name field, enter the name of the new class map (40 characters or less).
 
     [bookmark: pgfId-1816180]Step 4 In the Description field, provide a description for the class map (200 characters or less). 
 
     [bookmark: pgfId-1816181]Step 5 Choose the Match Option for the criteria you define when you click ADD:
 
      
       
       	 [bookmark: pgfId-1816182]Match All—Specifies that traffic must match all criteria to match the class map.
 
       	 [bookmark: pgfId-1816183]Match Any—Specifies that the traffic matches the class map if it matches at least one of the criteria.
 
      
 
     
 
     [bookmark: pgfId-1816184]Step 6 Click Add.
 
     [bookmark: pgfId-1816185]The Add Cloud Web Security Match Criterion Window appears.
 
     [bookmark: pgfId-1816187]Step 7 [bookmark: 57397]Choose the Match Type:
 
      
       
       	 [bookmark: pgfId-1816188]Match—Specifies the user and/or group that you want to whitelist.
 
       	 [bookmark: pgfId-1816189]No Match—Specifies the user and/or group that you do  not want to whitelist; for example, if you whitelist the group “cisco,” but you want to scan traffic from users “johncrichton” and “aerynsun,” you can specify No Match for those users.
 
      
 
     
 
     [bookmark: pgfId-1816191]Step 8 [bookmark: 40429]Choose the Match Criterion:
 
      
       
       	 [bookmark: pgfId-1816192]User—Specifies the user. 
 
       	 [bookmark: pgfId-1816193]Group—Specifies the group. 
 
       	 [bookmark: pgfId-1816194]User and Group—Specifies a user and group.
 
      
 
     
 
     [bookmark: pgfId-1816195]Step 9 Click OK.
 
     [bookmark: pgfId-1816196]Step 10 Continue to add match criteria as desired.
 
     [bookmark: pgfId-1816197]Step 11 Click OK to add the class map.
 
     [bookmark: pgfId-1816198]Step 12 Click Apply.
 
     [bookmark: pgfId-1816201]Step 13 Use the whitelist in the Cloud Web Security policy according to the “Configuring a Service Policy to Send Traffic to Cloud Web Security” section.
 
     [bookmark: pgfId-1816203]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1726611](Optional) Configuring the User Identity Monitor
 
     [bookmark: pgfId-1728443]When you use IDFW, the ASA only downloads user identity information from the AD server for users and groups included in active ACLs; the ACL must be used in a feature such as an access rule, AAA rule, service policy rule, or other feature to be considered active. Because Cloud Web Security can base its policy on user identity, you may need to download groups that are not part of an active ACL to get full IDFW coverage for all your users. For example, although you can configure your Cloud Web Security service policy rule to use an ACL with users and groups, thus activating any relevant groups, it is not required; you could use an ACL based entirely on IP addresses.The user identity monitor feature lets you download group information directly from the AD agent.
 
    
 
     
      [bookmark: pgfId-1728060]Restrictions
 
     [bookmark: pgfId-1728097]The ASA can only monitor a maximum of 512 groups, including those configured for the user identity monitor and those monitored through active ACLs.
 
    
 
     
      [bookmark: pgfId-1726394]Detailed Steps
 
     
 
     [bookmark: pgfId-1816208]Step 1 Choose Configuration > Firewall > Identity Options, and scroll to the Cloud Web Security Configuration section.
 
     [bookmark: pgfId-1816209]Step 2 Click Add.
 
     [bookmark: pgfId-1816210]The Add Monitor User dialog box appears.
 
     [bookmark: pgfId-1816211]Step 3 To add a domain, click Manage, and then click Add. You can only monitor groups for domains you have pre-defined on the ASA.
 
     [bookmark: pgfId-1816215]The Configure Identity Domains dialog box appears. For detailed information about adding domains, see the “Configuring Identity Options” section in the general operations configuration guide.
 
     [bookmark: pgfId-1816222]Step 4 When you are finished adding domains, click OK.
 
     [bookmark: pgfId-1816223]Step 5 You can either type in a group name, or you can search for groups on the AD agent per domain. 
 
      
       
       	 [bookmark: pgfId-1816224]To type in a group name directly, enter the name in the bottom field in the following format, and click  OK :
 
      
 
     
 
      
      [bookmark: pgfId-1816225]domain-name\\group 
     
 
      
      [bookmark: pgfId-1816226] 
     
 
      
       
       	 [bookmark: pgfId-1816227]To search for a group on the AD agent:
 
      
 
     
 
     [bookmark: pgfId-1816228] a. Choose the domain from the Domain drop-down list.
 
     [bookmark: pgfId-1816229] b. In the Find field, enter a text string to match group names, and click Find.
 
     [bookmark: pgfId-1816233]The ASA downloads names from the AD agent for the specified domain.
 
     [bookmark: pgfId-1816234] c. Double-click the name you want to monitor; it is added to the bottom field.
 
     [bookmark: pgfId-1816235] d. Click OK.
 
     [bookmark: pgfId-1816236]Repeat for additional groups.
 
     [bookmark: pgfId-1816237]Step 6 After you add the groups you want to monitor, click Apply.
 
     [bookmark: pgfId-1816238]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1686606][bookmark: 88153]Configuring the Cloud Web Security Policy
 
     [bookmark: pgfId-1686645]After you configure the ASA service policy rules, launch the ScanCenter Portal to configure Web content scanning, filtering, malware protection services, and reports.
 
    
 
     
      [bookmark: pgfId-1686718]Detailed Steps
 
     [bookmark: pgfId-1686757]Go to: https://scancenter.scansafe.com/portal/admin/login.jsp.
 
     [bookmark: pgfId-1686931]For more information, see the Cisco ScanSafe Cloud Web Security Configuration Guides:
 
     [bookmark: pgfId-1686957]http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html
 
    
 
   
 
    
     [bookmark: pgfId-1686935][bookmark: 76844]Monitoring Cloud Web Security
 
    [bookmark: pgfId-1660755][bookmark: 47786]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1541498]Command 
         
  
        	 
          
          [bookmark: pgfId-1541500]Purpose 
         
  
       
 
        
        	[bookmark: pgfId-1660857]Monitoring > Properties > Cloud Web Security
  
        	[bookmark: pgfId-1660899]Shows the status of the server, whether it is the current active server, the backup server, or unreachable.
 [bookmark: pgfId-1660930]Shows total and current HTTP(S) connections. In multiple context mode, statistics are only shown within a context.
  
       
 
        
        	[bookmark: pgfId-1737573]See the following URL:
 [bookmark: pgfId-1737578]http://Whoami.scansafe.net[bookmark: message URL http]
  
        	[bookmark: pgfId-1686156]From a client, access this web site to determine if your traffic is going to the Cloud Web Security server.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1693321][bookmark: 12973]Related Documents 
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1693313]Related Documents 
         
  
        	 
          
          [bookmark: pgfId-1693315]URL 
         
  
       
 
        
        	[bookmark: pgfId-1693317]Cisco ScanSafe Cloud Web Security Configuration Guides
  
        	[bookmark: pgfId-1693320]http://www.cisco.com/en/US/products/ps11720/products_installation_and_configuration_guides_list.html
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1649204][bookmark: 59114][bookmark: 92503]Feature History for Cisco Cloud Web Security
 
    [bookmark: pgfId-1735476]Table 25-1 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
    [bookmark: pgfId-1649245]
 
     
      
       
       [bookmark: pgfId-1649218]Table 25-1 [bookmark: 50557]Feature History for Cloud Web Security 
 
       
       
        
        	 
          
          [bookmark: pgfId-1649224]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1649226]Platform Releases 
         
  
        	 
          
          [bookmark: pgfId-1649228]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1649233]Cloud Web Security
  
        	[bookmark: pgfId-1649235]9.0(1)
  
        	[bookmark: pgfId-1649237]This feature was introduced.
 [bookmark: pgfId-1649241]Cisco Cloud Web Security provides content scanning and other malware protection service for web traffic. It can also redirect and report about web traffic based on user identity. 
 [bookmark: pgfId-1816248]We introduced or modified the following screens: 
 [bookmark: pgfId-1649244]Configuration > Device Management > Cloud Web Security
Configuration > Firewall > Objects > Class Maps > Cloud Web Security
Configuration > Firewall > Objects > Class Maps > Cloud Web Security > Add/Edit 
Configuration > Firewall > Objects > Inspect Maps > Cloud Web Security
Configuration > Firewall > Objects > Inspect Maps > Cloud Web Security > Add/Edit 
Configuration > Firewall > Objects > Inspect Maps > Cloud Web Security > Add/Edit > Manage Cloud Web Security Class Maps
Configuration > Firewall > Identity Options
Configuration > Firewall > Service Policy Rules 
Monitoring > Properties > Cloud Web Security
  
       
 
       
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1115562][bookmark: 62651]Configuring the ASA CX Module 
      
      
 
     
 
 
    [bookmark: pgfId-1141051]This chapter describes how to configure the ASA CX module that runs on the ASA.
 
     
     	 [bookmark: pgfId-1059391]Information About the ASA CX Module
 
     	 [bookmark: pgfId-1104619]Licensing Requirements for the ASA CX Module
 
     	 [bookmark: pgfId-1104627]Guidelines and Limitations
 
     	 [bookmark: pgfId-1177305]Default Settings
 
     	 [bookmark: pgfId-1104606]Configuring the ASA CX Module
 
     	 [bookmark: pgfId-1306994]Managing the ASA CX Module
 
     	 [bookmark: pgfId-1271144]Monitoring the ASA CX Module
 
     	 [bookmark: pgfId-1177280]Troubleshooting the ASA CX Module
 
     	 [bookmark: pgfId-1167911]Feature History for the ASA CX Module
 
    
 
   
 
    
     [bookmark: pgfId-1067381]Information About the [bookmark: 42923]ASA CX Module[bookmark: marker-1067400]
 
    [bookmark: pgfId-1257851]The ASA CX module lets you enforce security based on the full context of a situation. This context includes the identity of the user (who), the application or website that the user is trying to access (what), the origin of the access attempt (where), the time of the attempted access (when), and the properties of the device used for the access (how). With the ASA CX module, you can extract the full context of a flow and enforce granular policies such as permitting access to Facebook but denying access to games on Facebook, or permitting finance employees access to a sensitive enterprise database but denying the same access to other employees.
 
     
     	 [bookmark: pgfId-1087301]How the ASA CX Module Works with the ASA
 
     	 [bookmark: pgfId-1369411]Monitor-Only Mode
 
     	 [bookmark: pgfId-1174966]Information About ASA CX Management
 
     	 [bookmark: pgfId-1265462]Information About Authentication Proxy
 
     	 [bookmark: pgfId-1275772]Information About VPN and the ASA CX Module
 
     	 [bookmark: pgfId-1266771]Compatibility with ASA Features
 
    
 
     
      [bookmark: pgfId-1087140][bookmark: 73577]How the ASA CX Module Works wit[bookmark: marker-1110642]h the ASA
 
     [bookmark: pgfId-1087077]The ASA CX module runs a separate application from the ASA. The ASA CX module includes external management interface(s) so you can connect to the ASA CX module directly. Any data interfaces on the ASA CX module are used for ASA traffic only.
 
     [bookmark: pgfId-1124444]Traffic goes through the firewall checks before being forwarded to the ASA CX module. When you identify traffic for ASA CX inspection on the ASA, traffic flows through the ASA and the ASA CX module as follows:
 
     [bookmark: pgfId-1090588] 1. Traffic enters the ASA.
 
     [bookmark: pgfId-1147745] 2. Incoming VPN traffic is decrypted.
 
     [bookmark: pgfId-1147752] 3. Firewall policies are applied.
 
     [bookmark: pgfId-1147759] 4. Traffic is sent to the ASA CX module.
 
     [bookmark: pgfId-1090664] 5. The ASA CX module applies its security policy to the traffic, and takes appropriate actions.
 
     [bookmark: pgfId-1147820] 6. Valid traffic is sent back to the ASA; the ASA CX module might block some traffic according to its security policy, and that traffic is not passed on.
 
     [bookmark: pgfId-1147821] 7. Outgoing VPN traffic is encrypted.
 
     [bookmark: pgfId-1147969] 8. Traffic exits the ASA.
 
     [bookmark: pgfId-1091068]Figure 30-1 shows the traffic flow when using the ASA CX module. In this example, the ASA CX module automatically blocks traffic that is not allowed for a certain application. All other traffic is forwarded through the ASA.
 
     [bookmark: pgfId-1090830]Figure 30-1 [bookmark: 12935]ASA CX Module Traffic Flow in the ASA
 
     [bookmark: pgfId-1245339]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1289129]Note If you have a connection between hosts on two ASA interfaces, and the ASA CX service policy is only configured for one of the interfaces, then all traffic between these hosts is sent to the ASA CX module, including traffic originating on the non-ASA CX interface (because the feature is bidirectional). However, the ASA only performs the authentication proxy on the interface to which the service policy is applied, because authentication proxy is applied only to ingress traffic (see the “Information About Authentication Proxy” section).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1369417][bookmark: 53590]Monitor-Only Mode
 
     [bookmark: pgfId-1369418]For demonstration purposes, you can configure a service policy or a traffic-forwarding interface in monitor-only mode.
 
     [bookmark: pgfId-1369421]For guidelines and limitations for monitor-only mode, see the “Guidelines and Limitations” section.
 
      
      	 [bookmark: pgfId-1369426]Service Policy in Monitor-Only Mode
 
      	 [bookmark: pgfId-1369430]Traffic-Forwarding Interface in Monitor-Only Mode
 
     
 
    
 
     
      [bookmark: pgfId-1369432][bookmark: 41111]Service Policy in Monitor-Only Mode
 
     [bookmark: pgfId-1369436]For testing and demonstration purposes, you can configure the ASA to send a duplicate stream of read-only traffic to the ASA CX module, so you can see how the module inspects the traffic without affecting the ASA traffic flow. In this mode, the ASA CX module inspects the traffic as usual, makes policy decisions, and generates events. However, because the packets are read-only copies, the module actions do not affect the actual traffic. Instead, the module drops the copies after inspection. Figure 30-2 shows the ASA CX module in monitor-only mode.
 
     [bookmark: pgfId-1369444]Figure 30-2 [bookmark: 29573]ASA CX Monitor-Only Mode
 
     [bookmark: pgfId-1369448]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1369450][bookmark: 98499]Traffic-Forwarding Interface in Monitor-Only Mode
 
     [bookmark: pgfId-1369454]You can alternatively configure ASA interfaces to be traffic-forwarding interfaces, where all traffic received is forwarded directly to the ASA CX module without any ASA processing. For testing and demonstration purposes, traffic-forwarding removes the extra complication of ASA processing. Traffic-forwarding is only supported in monitor-only mode, so the ASA CX module drops the traffic after inspecting it. Figure 30-3 shows the ASA GigabitEthernet 0/3 interface configured for traffic-forwarding. That interface is connected to a switch SPAN port so the ASA CX module can inspect all of the network traffic.
 
     [bookmark: pgfId-1369468]Figure 30-3 [bookmark: 97935]ASA CX Traffic-Forwarding
 
     [bookmark: pgfId-1369472]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1347145][bookmark: 59068]Information About ASA CX Management[bookmark: marker-1347144]
 
      
      	 [bookmark: pgfId-1260874]Initial Configuration
 
      	 [bookmark: pgfId-1260913]Policy Configuration and Management
 
     
 
    
 
     
      [bookmark: pgfId-1174445][bookmark: 46560]Initial Configuration
 
     [bookmark: pgfId-1260778]For initial configuration, you must use the CLI on the ASA CX module to run the setup command and configure other optional settings.
 
     [bookmark: pgfId-1258267]To access the CLI, you can use the following methods:
 
      
      	 [bookmark: pgfId-1316931]ASA 5585-X:
 
     
 
     [bookmark: pgfId-1258297] – ASA CX console port—The ASA CX console port is a separate external console port.
 
     [bookmark: pgfId-1258301] – ASA CX Management 1/0 interface using SSH—You can connect to the default IP address (192.168.8.8), or you can use ASDM to change the management IP address and then connect using SSH. The ASA CX management interface is a separate external Gigabit Ethernet interface.
 
      
       
     
 
     
 
     [bookmark: pgfId-1266092]Note You cannot access the ASA CX hardware module CLI over the ASA backplane using the session command.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1316936]ASA 5512-X through ASA 5555-X:
 
     
 
     [bookmark: pgfId-1316943] – ASA session over the backplane—If you have CLI access to the ASA, then you can session to the module and access the module CLI.
 
     [bookmark: pgfId-1316944] – ASA CX Management 0/0 interface using SSH—You can connect to the default IP address (192.168.1.2), or you can use ASDM to change the management IP address and then connect using SSH. These models run the ASA CX module as a software module. The ASA CX management interface shares the Management 0/0 interface with the ASA. Separate MAC addresses and IP addresses are supported for the ASA and ASA CX module. You must perform configuration of the ASA CX IP address within the ASA CX operating system (using the CLI or ASDM). However, physical characteristics (such as enabling the interface) are configured on the ASA. You can remove the ASA interface configuration (specifically the interface name) to dedicate this interface as an ASA CX-only interface. This interface is management-only.
 
    
 
     
      [bookmark: pgfId-1260813][bookmark: 70881]Policy Configuration and Management
 
     [bookmark: pgfId-1287716]After you perform initial configuration, configure the ASA CX policy using Cis[bookmark: marker-1288483]co Prime Security Manager (PRSM). Then configure the ASA policy for sending traffic to the ASA CX module using ASDM or the ASA CLI.
 
      
       
     
 
     
 
     [bookmark: pgfId-1258377]Note When using PRSM in multiple device mode, you can configure the ASA policy for sending traffic to the ASA CX module within PRSM, instead of using ASDM or the ASA CLI. Using PRSM lets you consolodate management to a single management system. However, PRSM has some limitations when configuring the ASA service policy; see the ASA CX user guide for more information.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1265342][bookmark: 55430]Information About Authentica[bookmark: marker-1288484]tion Proxy
 
     [bookmark: pgfId-1265343]When the ASA CX needs to authenticate an HTTP user (to take advantage of identity policies), you must configure the ASA to act as an authentication proxy: the ASA CX module redirects authentication requests to the ASA interface IP address/proxy port. By default, the port is 885 (user configurable). Configure this feature as part of the service policy to divert traffic from the ASA to the ASA CX module. If you do not enable the authentication proxy, only passive authentication is available.
 
      
       
     
 
     
 
     [bookmark: pgfId-1289181]Note If you have a connection between hosts on two ASA interfaces, and the ASA CX service policy is only configured for one of the interfaces, then all traffic between these hosts is sent to the ASA CX module, including traffic orginiating on the non-ASA CX interface (the feature is bidirectional). However, the ASA only performs the authentication proxy on the interface to which the service policy is applied, because this feature is ingress-only.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1275646][bookmark: 70381]Information About V[bookmark: marker-1288485]PN and the ASA CX Module
 
     [bookmark: pgfId-1275668]The ASA includes VPN client and user authentication metadata from the Cisco AnyConnect client when forwarding traffic to the ASA CX module, which allows the ASA CX module to include this information as part of its policy lookup criteria. The VPN metadata is sent only at VPN tunnel establishment time along with a type-length-value (TLV) containing the session ID. The ASA CX module caches the VPN metadata for each session. Each tunneled connection sends the session ID so the ASA CX module can look up that session’s metadata.
 
    
 
     
      [bookmark: pgfId-1266392][bookmark: 96338]Compatibility with ASA Fe[bookmark: marker-1288486]atures
 
     [bookmark: pgfId-1267021]The ASA includes many advanced application inspection features, including HTTP inspection. However, the ASA CX module provides more advanced HTTP inspection than the ASA provides, as well as additional features for other applications, including monitoring and controlling application usage.
 
     [bookmark: pgfId-1267243]To take full advantage of the ASA CX module features, see the following guidelines for traffic that you send to the ASA CX module:
 
      
      	 [bookmark: pgfId-1267078]Do not configure ASA inspection on HTTP traffic.
 
      	 [bookmark: pgfId-1267156]Do not configure Cloud Web Security (ScanSafe) inspection. If you configure both the ASA CX action and Cloud Web Security inspection for the same traffic, the ASA only performs the ASA CX action.
 
      	 [bookmark: pgfId-1277553]Other application inspections on the ASA are compatible with the ASA CX module, including the default inspections.
 
      	 [bookmark: pgfId-1267236]Do not enable the Mobile User Security (MUS) server; it is not compatible with the ASA CX module.
 
      	 [bookmark: pgfId-1277558]Do not enable ASA clustering; it is not compatible with the ASA CX module.
 
      	 [bookmark: pgfId-1288335]If you enable failover, when the ASA fails over, any existing ASA CX flows are transferred to the new ASA, but the traffic is allowed through the ASA without being acted upon by the ASA CX module. Only new flows recieved by the new ASA are acted upon by the ASA CX module.
 
      	 [bookmark: pgfId-1360393](9.1(1) and earlier) Does not support NAT 64. In 9.1(2) and later, NAT 64 is supported.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1288344][bookmark: 53684][bookmark: 87160]Licensing Requirements for the AS[bookmark: marker-1288487]A CX Module
 
    [bookmark: pgfId-1401241]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1401234]Model 
         
  
        	 
          
          [bookmark: pgfId-1401236]License Requirement 
         
  
       
 
        
        	[bookmark: pgfId-1401238]All models
  
        	[bookmark: pgfId-1401240]Base License.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1261708]The ASA CX module and PRSM require additional licenses. See the ASA CX documentation for more information.
 
   
 
    
     [bookmark: pgfId-1380125]Prerequisites
 
    [bookmark: pgfId-1380169]To use PRSM to configure the ASA, you need to install a certificate on the ASA for secure communications. By default, the ASA generates a self-signed certificate. However, this certificate can cause browser prompts asking you to verify the certificate because the publisher is unknown. To avoid these browser prompts, you can instead install a certificate from a known certificate authority (CA). If you request a certificate from a CA, be sure the certificate type is both a server authentication certificate and a client authentication certificate. See the “Configuring Digital Certificates,” in the general operations configuration guide for more information.
 
   
 
    
     [bookmark: pgfId-1104732][bookmark: 58316]Guidelines and Limitations
 
    [bookmark: pgfId-1104737][bookmark: 87419]Context Mode Guidelines
 
    [bookmark: pgfId-1255382](9.1(2) and earlier) Supported in single context mode only. Does not support multiple context mode.
 
    [bookmark: pgfId-1381641](9.1(3) and later) Supported in multiple context mode. See the following guidelines:
 
     
     	 [bookmark: pgfId-1384655]The ASA CX module itself (configured in PRSM) is a single context mode device; the context-specific traffic coming from the ASA is checked against the common ASA CX policy.
 
     	 [bookmark: pgfId-1389467]For ASA CX module support, you cannot use the same IP addresses in multiple contexts; each context must include unique networks.
 
    
 
    [bookmark: pgfId-1389469][bookmark: 16807]Firewall Mode Guidelines
 
    [bookmark: pgfId-1106524]Supported in routed and transparent firewall mode. Traffic-forwarding interfaces are only supported in transparent mode.
 
    [bookmark: pgfId-1255544]Failover [bookmark: marker-1288488]Guidelines
 
    [bookmark: pgfId-1255765]Does not support failover directly; when the ASA fails over, any existing ASA CX flows are transferred to the new ASA, but the traffic is allowed through the ASA without being inspected by the ASA CX.
 
    [bookmark: pgfId-1255546]ASA Clustering Guidelines
 
    [bookmark: pgfId-1255350]Does not support clustering.
 
    [bookmark: pgfId-1255415]IPv6 Guidelines
 
     
     	 [bookmark: pgfId-1255416]Supports IPv6.
 
     	 [bookmark: pgfId-1360427](9.1(1) and earlier) Does not support NAT 64. In 9.1(2) and later, NAT 64 is supported.
 
    
 
    [bookmark: pgfId-1106529][bookmark: 34265]Model Guidelines
 
     
     	 [bookmark: pgfId-1104751]Supported only on the ASA 5585-X and 5512-X through ASA 5555-X. See the  Cisco ASA Compatibility Matrix  for more information:
 
    
 
    [bookmark: pgfId-1256116]http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html
 
     
     	 [bookmark: pgfId-1336541]For the 5512-X through ASA 5555-X, you must install a Cisco solid state drive (SSD). For more information, see the ASA 5500-X hardware guide.
 
    
 
    [bookmark: pgfId-1369502]Monitor-Only Mode Guidelines
 
     
     	 [bookmark: pgfId-1369506]You cannot configure both monitor-only mode and normal inline mode at the same time on the ASA. Only one type of security policy is allowed. In multiple context mode, you cannot configure monitor-only mode for some contexts, and regular inline mode for others.
 
     	 [bookmark: pgfId-1369507]The following features are not supported in monitor-only mode:
 
    
 
    [bookmark: pgfId-1369508] – Deny policies
 
    [bookmark: pgfId-1369509] – Active authentication
 
    [bookmark: pgfId-1369510] – Decryption policies
 
     
     	 [bookmark: pgfId-1369511]The ASA CX does not perform packet buffering in monitor-only mode, and events will be generated on a best-effort basis. For example, some events, such as ones with long URLs spanning packet boundaries, may be impacted by the lack of buffering.
 
     	 [bookmark: pgfId-1369515]Be sure to configure both the ASA policy and the ASA CX to have matching modes: both in monitor-only mode, or both in normal inline mode.
 
    
 
    [bookmark: pgfId-1369516]Additional guidelines for traffic-forwarding interfaces:
 
     
     	 [bookmark: pgfId-1369520]The ASA must be in transparent mode.
 
     	 [bookmark: pgfId-1369524]You can configure up to 4 interfaces as traffic-forwarding interfaces. Other ASA interfaces can be used as normal.
 
     	 [bookmark: pgfId-1369525]Traffic-forwarding interfaces must be physical interfaces, not VLANs or BVIs. The physical interface also cannot have any VLANs associated with it.
 
     	 [bookmark: pgfId-1369529]Traffic-forwarding interfaces cannot be used for ASA traffic; you cannot name them or configure them for ASA features, including failover or management-only.
 
     	 [bookmark: pgfId-1369533]You cannot configure both a traffic-forwarding interface and a service policy for ASA CX traffic.
 
    
 
    [bookmark: pgfId-1256117]Additional Guidelines and Limitations
 
     
     	 [bookmark: pgfId-1260270]See the “Compatibility with ASA Features” section.
 
     	 [bookmark: pgfId-1256048]You cannot change the software type installed on the hardware module; if you purchase an ASA CX module, you cannot later install other software on it.
 
    
 
   
 
    
     [bookmark: pgfId-1172934][bookmark: 54487]Default Set[bookmark: marker-1172933]tings
 
    [bookmark: pgfId-1172938]Table 30-1 lists the default settings for the ASA CX module.
 
    [bookmark: pgfId-1172968]
 
     
      
       
       [bookmark: pgfId-1172945]Table 30-1 [bookmark: 51687]Default Network Parameters 
 
       
       
        
        	 
          
          [bookmark: pgfId-1172949]Parameters 
         
  
        	 
          
          [bookmark: pgfId-1172951]Default 
         
  
       
 
        
        	[bookmark: pgfId-1172957]Management IP address
  
        	[bookmark: pgfId-1172959]ASA 5585-X: Management 1/0 192.168.8.8/24
 [bookmark: pgfId-1305809]ASA 5512-X through ASA 5555-X: Management 0/0 192.168.1.2/24
  
       
 
        
        	[bookmark: pgfId-1172965]Gateway
  
        	[bookmark: pgfId-1172967]ASA 5585-X: 192.168.8.1/24
 [bookmark: pgfId-1305894]ASA 5512-X through ASA 5555-X: 192.168.1.1/24
  
       
 
        
        	[bookmark: pgfId-1183535]SSH or session Username
  
        	[bookmark: pgfId-1183537]admin
  
       
 
        
        	[bookmark: pgfId-1183531]Password
  
        	[bookmark: pgfId-1183533]Admin123
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1111978][bookmark: 97360][bookmark: 61249]Configuring the ASA CX Module
 
    [bookmark: pgfId-1111979]This section describes how to configure the ASA CX module.
 
     
     	 [bookmark: pgfId-1106217]Task Flow for the ASA CX Module
 
     	 [bookmark: pgfId-1106224]Connecting the ASA CX Management Interface
 
     	 [bookmark: pgfId-1256894](ASA 5585-X) Changing the ASA CX Management IP Address
 
     	 [bookmark: pgfId-1320381](ASA 5512-X through ASA 5555-X; May Be Required) Installing the Software Module
 
     	 [bookmark: pgfId-1256918]Configuring Basic ASA CX Settings at the ASA CX CLI
 
     	 [bookmark: pgfId-1177412]Configuring the Security Policy on the ASA CX Module Using PRSM
 
     	 [bookmark: pgfId-1106253]Redirecting Traffic to the ASA CX Module
 
    
 
     
      [bookmark: pgfId-1097278][bookmark: 43748][bookmark: marker-1097277]Task Flow for the ASA CX Module
 
     [bookmark: pgfId-1107334]Configuring the ASA CX module is a process that includes configuration of the ASA CX security policy on the ASA CX module and then configuration of the ASA to send traffic to the ASA CX module. To configure the ASA CX module, perform the following steps:
 
     
 
     [bookmark: pgfId-1178227]Step 1 Cable the ASA CX management interfaces interface. See the “Connecting the ASA CX Management Interface” section.
 
     [bookmark: pgfId-1320389]Step 2 (ASA 5512-X through ASA 5555-X; May be required) Install the software module. See the “(ASA 5512-X through ASA 5555-X; May Be Required) Installing the Software Module” section.
 
     [bookmark: pgfId-1321378]Step 3 (ASA 5585-X) Configure the ASA CX module management IP address for initial SSH access. See the “(ASA 5585-X) Changing the ASA CX Management IP Address” section.
 
     [bookmark: pgfId-1256816]Step 4 On the ASA CX module, configure basic settings. You must use the CLI to configure these settings. See the “Configuring Basic ASA CX Settings at the ASA CX CLI” section.
 
     [bookmark: pgfId-1177328]Step 5 On the ASA CX module, configure the security policy using PRSM. See the “Configuring the Security Policy on the ASA CX Module Using PRSM” section.
 
     [bookmark: pgfId-1265611]Step 6 (Optional) On the ASA, configure the authentication proxy port. See the “(Optional) Configuring the Authentication Proxy Port” section.
 
     [bookmark: pgfId-1286918]Step 7 On the ASA, identify traffic to divert to the ASA CX module. See the “Redirecting Traffic to the ASA CX Module” section.
 
      
       
     
 
     
 
     [bookmark: pgfId-1288088]Note When using PRSM in multiple device mode, you can configure the ASA policy for sending traffic to the ASA CX module within PRSM, instead of using ASDM or the ASA CLI. However, PRSM has some limitations when configuring the ASA service policy; see the ASA CX user guide for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1105095]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1181923][bookmark: 60816]Connecting the ASA CX Management Interfa[bookmark: marker-1288489]ce
 
     [bookmark: pgfId-1305065]In addition to providing management access to the ASA CX module, the ASA CX management interface needs access to an HTTP proxy server or a DNS server and the Internet for signature updates and more. This section describes recommended network configurations. Your network may differ.
 
    
 
     
      [bookmark: pgfId-1316968]ASA 5585-X (Hardware Module)
 
     [bookmark: pgfId-1305070]The ASA CX module includes a separate management interface from the ASA. For initial setup, you can connect with SSH to the ASA CX Management 1/0 interface using the default IP address (192.168.8.8/24). If you cannot use the default IP address, you can either use the console port or use ASDM to change the management IP address so you can use SSH.
 
     [bookmark: pgfId-1305074]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1305075]If you have an inside router
 
     [bookmark: pgfId-1305076]If you have an inside router, you can route between the management network, which can include both the ASA Management 0/0 and ASA CX Management 1/0 interfaces, and the ASA inside network for Internet access. Be sure to also add a route on the ASA to reach the Management network through the inside router.
 
     [bookmark: pgfId-1305089]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1305091][bookmark: 64939]If you do not have an inside router
 
     [bookmark: pgfId-1305092]If you have only one inside network, then you cannot also have a separate management network, which would require an inside router to route between the networks. In this case, you can manage the ASA from the inside interface instead of the Management 0/0 interface. Because the ASA CX module is a separate device from the ASA, you can configure the ASA CX Management 1/0 address to be on the same network as the inside interface.
 
     [bookmark: pgfId-1305102]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1316973]ASA 5512-X through ASA 5555-X (Software Module)
 
     [bookmark: pgfId-1316974]These models run the ASA CX module as a software module, and the ASA CX management interface shares the Management 0/0 interface with the ASA.
 
     [bookmark: pgfId-1316981]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1316982]If you have an inside router
 
     [bookmark: pgfId-1316983]If you have an inside router, you can route between the Management 0/0 network, which includes both the ASA and ASA CX management IP addresses, and the inside network for Internet access. Be sure to also add a route on the ASA to reach the Management network through the inside router.
 
     [bookmark: pgfId-1316993]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1316995][bookmark: 73633]If you do not have an inside router
 
     [bookmark: pgfId-1316996]If you have only one inside network, then you cannot also have a separate management network. In this case, you can manage the ASA from the inside interface instead of the Management 0/0 interface. If you remove the ASA-configured name from the Management 0/0 interface, you can still configure the ASA CX IP address for that interface. Because the ASA CX module is essentially a separate device from the ASA, you can configure the ASA CX management address to be on the same network as the inside interface.
 
     [bookmark: pgfId-1317009]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1317013]Note You must remove the ASA-configured name for Management 0/0; if it is configured on the ASA, then the ASA CX address must be on the same network as the ASA, and that excludes any networks already configured on other ASA interfaces. If the name is not configured, then the ASA CX address can be on any network, for example, the ASA inside network.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1192897]What to Do Next
 
      
      	 [bookmark: pgfId-1183631]Configure the ASA CX management IP address. See the “(ASA 5585-X) Changing the ASA CX Management IP Address” section.
 
     
 
    
 
     
      [bookmark: pgfId-1319730][bookmark: 44446](ASA 5512-X through ASA 5555-X; May Be Required) Installing the Software Module
 
     [bookmark: pgfId-1319734]If you purchase the ASA with the ASA CX module, the module software and required solid state drive(s) (SSDs) come pre-installed and ready to go. If you want to add the ASA CX to an existing ASA, or need to replace the SSD, you need to install the ASA CX boot software and partition the SSD according to this procedure. To physically install the SSD, see the ASA hardware guide.
 
      
       
     
 
     
 
     [bookmark: pgfId-1323750]Note [bookmark: 73926][bookmark: 34678][bookmark: 37556]For the ASA 5585-X hardware module, you must install or upgrade your image from within the ASA CX module. See the ASA CX module documentation for more information.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1379035]Prerequisites
 
      
      	 [bookmark: pgfId-1379036]The free space on flash (disk0) should be at least 3GB plus the size of the boot software.
 
      	 [bookmark: pgfId-1381646]In multiple context mode, perform this procedure in the system execution space.
 
     
 
    
 
     
      [bookmark: pgfId-1379037]Detailed Steps
 
     
 
     [bookmark: pgfId-1319741]Step 1 Download the ASA CX boot software from Cisco.com to your computer. If you have a Cisco.com login, you can obtain the boot software from the following website:
 
     [bookmark: pgfId-1319743]http://www.cisco.com/cisco/software/release.html?mdfid=284325223&softwareid=284399946
 
     [bookmark: pgfId-1319744]The boot software lets you set basic ASA CX network configuration, partition the SSD, and download the larger system software from a server of your choice to the SSD.
 
     [bookmark: pgfId-1319745]Step 2 Download the ASA CX system software from Cisco.com to an HTTP, HTTPS, or FTP server accessible from the ASA CX management interface. If you have a Cisco.com login, you can obtain the boot software from the following website:
 
     [bookmark: pgfId-1319747]http://www.cisco.com/cisco/software/release.html?mdfid=284325223&softwareid=284399946
 
     [bookmark: pgfId-1392444]Step 3 In ASDM, choose Tools > File Management, and then choose File Transfer > Between Local PC and Flash. Transfer the boot software to disk0 on the ASA. Do not transfer the system software; it is downloaded later to the SSD.
 
     [bookmark: pgfId-1392451]Step 4 Connect to the ASA CLI, and enter privileged EXEC mode. See the “Getting Started” chapter in the general operations configuration guide to access the ASA CLI.
 
     [bookmark: pgfId-1323117]Step 5 If you are replacing the IPS module with the ASA CX module, shut down and uninstall the IPS module, and then reload the ASA:
 
      
      [bookmark: pgfId-1323124]ciscoasa# sw-module module ips shutdown 
     
 
      
      [bookmark: pgfId-1323128]ciscoasa# sw-module module ips uninstall 
     
 
      
      [bookmark: pgfId-1319777]ciscoasa# reload 
     
 
      
      [bookmark: pgfId-1319778] 
     
 
     [bookmark: pgfId-1319785]After the ASA reloads, reconnect to the ASA CLI.
 
     [bookmark: pgfId-1319789]Step 6 Set the ASA CX module boot image location in ASA disk0 by entering the following command:
 
      
      [bookmark: pgfId-1319793]ciscoasa# sw-module module cxsc recover configure image disk0:file_path 
     
 
      
      [bookmark: pgfId-1319794] 
     
 
     [bookmark: pgfId-1319795]Example:
 
      
      [bookmark: pgfId-1319799]ciscoasa# sw-module module cxsc recover configure image disk0:asacx-boot-9.1.1.img 
     
 
      
      [bookmark: pgfId-1319800] 
     
 
     [bookmark: pgfId-1319801]Step 7 Load the ASA CX boot image by entering the following command:
 
      
      [bookmark: pgfId-1319805]ciscoasa# sw-module module cxsc recover boot 
     
 
      
      [bookmark: pgfId-1319806] 
     
 
     [bookmark: pgfId-1319807]Step 8 Wait approximately 5 minutes for the ASA CX module to boot up, and then open a console session to the now-running ASA CX boot image. The default username is admin and the default password is Admin123.
 
      
      [bookmark: pgfId-1319811]ciscoasa# session cxsc console 
     
 
      
      [bookmark: pgfId-1319812]Establishing console session with slot 1 
     
 
      
      [bookmark: pgfId-1319813]Opening console session with module cxsc. 
     
 
      
      [bookmark: pgfId-1319814]Connected to module cxsc. Escape character sequence is 'CTRL-SHIFT-6 then x'. 
     
 
      
      [bookmark: pgfId-1319815]cxsc login: admin 
     
 
      
      [bookmark: pgfId-1319816]Password: Admin123 
     
 
      
      [bookmark: pgfId-1319817] 
     
 
     [bookmark: pgfId-1319818]Step 9 Partition the SSD:
 
      
      [bookmark: pgfId-1319819]asacx-boot> partition 
     
 
      
      [bookmark: pgfId-1319820].... 
     
 
      
      [bookmark: pgfId-1319821]Partition Successfully Completed 
     
 
      
      [bookmark: pgfId-1319822] 
     
 
     [bookmark: pgfId-1319825]Step 10 Perform the basic network setup using the setup command according to the “Configuring Basic ASA CX Settings at the ASA CX CLI” section (do not exit the ASA CX CLI), and then return to this procedure to install the software image.
 
     [bookmark: pgfId-1319827]Step 11 Install the system software from the server:
 
      
      [bookmark: pgfId-1319828]asacx-boot> system install url 
     
 
      
      [bookmark: pgfId-1319829] 
     
 
     [bookmark: pgfId-1319830]Example:
 
     [bookmark: pgfId-1319831]The following command installs the asacx-sys-9.1.1.pkg system software.
 
      
      [bookmark: pgfId-1319832]asacx-boot> system install https://upgrades.example.com/packages/asacx-sys-9.1.1.pkg 
     
 
      
      [bookmark: pgfId-1319833] 
     
 
      
      [bookmark: pgfId-1319834]Username: buffy 
     
 
      
      [bookmark: pgfId-1319835]Password: angelforever 
     
 
      
      [bookmark: pgfId-1319836]Verifying 
     
 
      
      [bookmark: pgfId-1319837]Downloading 
     
 
      
      [bookmark: pgfId-1319838]Extracting 
     
 
      
      [bookmark: pgfId-1319839]Package Detail 
     
 
      
      [bookmark: pgfId-1319840] Description: 
     
 
      
      [bookmark: pgfId-1319841] Requires reboot: 
     
 
      
      [bookmark: pgfId-1319842]Cisco ASA CX System Upgrade 
     
 
      
      [bookmark: pgfId-1319843]Yes 
     
 
      
      [bookmark: pgfId-1319844]Do you want to continue with upgrade? [n]: Y 
     
 
      
      [bookmark: pgfId-1319845]Warning: Please do not interrupt the process or turn off the system. Doing so might leave system in unusable state. 
     
 
      
      [bookmark: pgfId-1319846]Upgrading 
     
 
      
      [bookmark: pgfId-1319847]Stopping all the services ... 
     
 
      
      [bookmark: pgfId-1319848]Starting upgrade process ... 
     
 
      
      [bookmark: pgfId-1319849]Reboot is required to complete the upgrade. Press Enter to reboot the system. 
     
 
      
      [bookmark: pgfId-1319850] 
     
 
     [bookmark: pgfId-1319851]Step 12 Press Enter to reboot the ASA CX module. Rebooting the module closes the console session. Allow 10 or more minutes for application component installation and for the ASA CX services to start.
 
     [bookmark: pgfId-1319852]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1321790](ASA 5585-X) [bookmark: 82926]Changing the ASA CX Ma[bookmark: marker-1321788]nagement IP Address
 
     [bookmark: pgfId-1321791]If you cannot use the default management IP address (192.168.8.8), then you can set the management IP address from the ASA. After you set the management IP address, you can access the ASA CX module using SSH to perform initial setup.
 
      
       
     
 
     
 
     [bookmark: pgfId-1321798]Note For a software module, you can access the ASA CX CLI to perform setup by sessioning from the ASA CLI; you can then set the ASA CX management IP address as part of setup. See the “Configuring Basic ASA CX Settings at the ASA CX CLI” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1381651]Guidelines
 
     [bookmark: pgfId-1381652]In multiple context mode, perform this procedure in the system execution space.
 
    
 
     
      [bookmark: pgfId-1321802]Detailed Steps
 
     [bookmark: pgfId-1392462]Multiple Context Mode
 
     
 
     [bookmark: pgfId-1392463]Step 1 In the System, choose Tools > Command Line Interface.
 
     [bookmark: pgfId-1392464]Step 2 Enter the following command:
 
     [bookmark: pgfId-1377012]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1377000]Command 
          
  
         	 
           
           [bookmark: pgfId-1377002]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1377004]session 1 do setup host ip ip_address/mask,gateway_ip
 
           
           [bookmark: pgfId-1377005] 
          
 [bookmark: pgfId-1377009]ciscoasa# session 1 do setup host ip 10.1.1.2/24,10.1.1.1
  
         	[bookmark: pgfId-1377011]Sets the ASA CX management IP address, mask, and gateway.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1392469]Step 3 Click Send.
 
     [bookmark: pgfId-1392470]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1392471]Single Context Mode
 
     
 
     [bookmark: pgfId-1392472]Step 1 In ASDM, choose Wizards > Startup Wizard.
 
     [bookmark: pgfId-1392473]Step 2 Click Next to advance through the initial screens until you reach the ASA CX Basic Configuration screen.
 
     [bookmark: pgfId-1392477]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1392478]Step 3 Enter the new management IP address, subnet mask, and default gateway.
 
     [bookmark: pgfId-1392479]Step 4 (Optional) Change the Auth Proxy Port. You can set this later if desired. See the “(Optional) Configuring the Authentication Proxy Port” section for more information.
 
     [bookmark: pgfId-1392483]Step 5 Click Finish to skip the remaining screens, or click Next to advance through the remaining screens and complete the wizard.
 
     [bookmark: pgfId-1392484]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1319433][bookmark: 34124]Configuring Basi[bookmark: marker-1319432]c ASA CX Settings at the ASA CX CLI
 
     [bookmark: pgfId-1261732]You must configure basic network settings and other parameters on the ASA CX module before you can configure your security policy.
 
    
 
     
      [bookmark: pgfId-1254700]Detailed Steps
 
     
 
     [bookmark: pgfId-1320149]Step 1 Do one of the following:
 
      
       
       	 [bookmark: pgfId-1320150](All models) Use SSH to connect to the ASA CX management IP address.
 
       	 [bookmark: pgfId-1320154](ASA 5512-X through ASA 5555-X) Open a console session to the module from the ASA CLI (see the “Getting Started” chapter in the general operations configuration guide to access the ASA CLI). In multiple context mode, session from the system execution space.
 
      
 
     
 
      
      [bookmark: pgfId-1320164]ciscoasa# session cxsc console 
     
 
      
      [bookmark: pgfId-1320165] 
     
 
     [bookmark: pgfId-1320166]Step 2 Log in with the username admin and the password Admin123. You will change the password as part of this procedure.
 
     [bookmark: pgfId-1261812]Step 3 Enter the following command:
 
      
      [bookmark: pgfId-1262744]asacx> setup 
     
 
      
      [bookmark: pgfId-1320195] 
     
 
     [bookmark: pgfId-1262000]Example:
 
      
      [bookmark: pgfId-1262001]asacx> setup 
     
 
      
      [bookmark: pgfId-1262002]Welcome to Cisco Prime Security Manager Setup 
     
 
      
      [bookmark: pgfId-1262003][hit Ctrl-C to abort] 
     
 
      
      [bookmark: pgfId-1262004]Default values are inside [ ] 
     
 
      
      [bookmark: pgfId-1262179] 
     
 
     [bookmark: pgfId-1262005]You are prompted through the setup wizard. The following example shows a typical path through the wizard; if you enter Y instead of N at a prompt, you will be able to configure some additional settings. This example shows how to configure both IPv4 and IPv6 static addresses. You can configure IPv6 stateless auto configuration by answering N when asked if you want to configure a static IPv6 address.
 
      
      [bookmark: pgfId-1262013]Enter a hostname [asacx]: asa-cx-host 
     
 
      
      [bookmark: pgfId-1262014]Do you want to configure IPv4 address on management interface?(y/n) [Y]: Y 
     
 
      
      [bookmark: pgfId-1262015]Do you want to enable DHCP for IPv4 address assignment on management interface?(y/n)[N]: N 
     
 
      
      [bookmark: pgfId-1262017]Enter an IPv4 address [192.168.8.8]: 10.89.31.65 
     
 
      
      [bookmark: pgfId-1262018]Enter the netmask [255.255.255.0]: 255.255.255.0 
     
 
      
      [bookmark: pgfId-1262019]Enter the gateway [192.168.8.1]: 10.89.31.1 
     
 
      
      [bookmark: pgfId-1262020]Do you want to configure static IPv6 address on management interface?(y/n) [N]: Y 
     
 
      
      [bookmark: pgfId-1262021]Enter an IPv6 address: 2001:DB8:0:CD30::1234/64 
     
 
      
      [bookmark: pgfId-1262022]Enter the gateway: 2001:DB8:0:CD30::1 
     
 
      
      [bookmark: pgfId-1262023]Enter the primary DNS server IP address [ ]: 10.89.47.11 
     
 
      
      [bookmark: pgfId-1262024]Do you want to configure Secondary DNS Server? (y/n) [N]: N 
     
 
      
      [bookmark: pgfId-1262025]Do you want to configure Local Domain Name? (y/n) [N] Y 
     
 
      
      [bookmark: pgfId-1262026]Enter the local domain name: example.com 
     
 
      
      [bookmark: pgfId-1262027]Do you want to configure Search domains? (y/n) [N] Y 
     
 
      
      [bookmark: pgfId-1262028]Enter the comma separated list for search domains: example.com 
     
 
      
      [bookmark: pgfId-1262029]Do you want to enable the NTP service?(y/n) [N]: Y 
     
 
      
      [bookmark: pgfId-1262030]Enter the NTP servers separated by commas: 1.ntp.example.com, 2.ntp.example.com 
     
 
      
      [bookmark: pgfId-1262374] 
     
 
     [bookmark: pgfId-1262035]Step 4 After you complete the final prompt, you are presented with a summary of the settings. Look over the summary to verify that the values are correct, and enter Y to apply your changed configuration. Enter N to cancel your changes.
 
     [bookmark: pgfId-1320204]Example:
 
      
      [bookmark: pgfId-1262039]Apply the changes?(y,n) [Y]: Y 
     
 
      
      [bookmark: pgfId-1262040]Configuration saved successfully! 
     
 
      
      [bookmark: pgfId-1262041]Applying... 
     
 
      
      [bookmark: pgfId-1262042]Done. 
     
 
      
      [bookmark: pgfId-1262043]Generating self-signed certificate, the web server will be restarted after that 
     
 
      
      [bookmark: pgfId-1262044]... 
     
 
      
      [bookmark: pgfId-1262045]Done. 
     
 
      
      [bookmark: pgfId-1262046]Press ENTER to continue... 
     
 
      
      [bookmark: pgfId-1262047]asacx> 
     
 
      
      [bookmark: pgfId-1262430] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1262048]Note If you change the host name, the prompt does not show the new name until you log out and log back in.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1262834]Step 5 If you do not use NTP, configure the time settings. The default time zone is the UTC time zone. Use the show time command to see the current settings. You can use the following commands to change time settings:
 
      
      [bookmark: pgfId-1262761]asacx> config timezone 
     
 
      
      [bookmark: pgfId-1262769]asacx> config time 
     
 
      
      [bookmark: pgfId-1262774] 
     
 
     [bookmark: pgfId-1262057]Step 6 Change the admin password by entering the following command:
 
      
      [bookmark: pgfId-1262629]asacx> config passwd 
     
 
      
      [bookmark: pgfId-1320210] 
     
 
     [bookmark: pgfId-1320211]Example:
 
      
      [bookmark: pgfId-1262873]asacx> config passwd 
     
 
      
      [bookmark: pgfId-1262063]The password must be at least 8 characters long and must contain 
     
 
      
      [bookmark: pgfId-1262064]at least one uppercase letter (A-Z), at least one lowercase letter 
     
 
      
      [bookmark: pgfId-1262065](a-z) and at least one digit (0-9). 
     
 
      
      [bookmark: pgfId-1262066]Enter password: Farscape1 
     
 
      
      [bookmark: pgfId-1262067]Confirm password: Farscape1 
     
 
      
      [bookmark: pgfId-1262068]SUCCESS: Password changed for user admin 
     
 
      
      [bookmark: pgfId-1262697] 
     
 
     [bookmark: pgfId-1262706]Step 7 Enter the exit command to log out.
 
     [bookmark: pgfId-1262144]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1092401][bookmark: 85498][bookmark: 95720][bookmark: 28907]Configuring the Security Policy on the ASA CX M[bookmark: marker-1288491]odule Using PRSM
 
     [bookmark: pgfId-1092520]This section describes how to launch PRSM to configure the ASA CX module application. For details on using PRSM to configure your ASA CX security policy, see the ASA CX user guide.
 
    
 
     
      [bookmark: pgfId-1109444]Detailed Steps
 
     [bookmark: pgfId-1263249]You can launch PRSM from your web browser, or you can launch it from ASDM.
 
      
      	 [bookmark: pgfId-1263287]Launch PRSM from a web browser by enter the following URL:
 
     
 
      
      [bookmark: pgfId-1263307]https://ASA_CX_management_IP 
     
 
      
      [bookmark: pgfId-1263328] 
     
 
     [bookmark: pgfId-1263336]Where the ASA CX management IP address is the one you set in the “Configuring Basic ASA CX Settings at the ASA CX CLI” section.
 
      
      	 [bookmark: pgfId-1263312]Launch PRSM from ASDM by choosing  Home > ASA CX Status , and clicking the Connect to the ASA CX application  link.
 
     
 
     [bookmark: pgfId-1263385]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1109433]What to Do Next
 
      
      	 [bookmark: pgfId-1109522](Optional) Configure the authentication proxy port. See the “(Optional) Configuring the Authentication Proxy Port” section.
 
      	 [bookmark: pgfId-1288415]Redirect traffic to the ASA CX module. See the “Redirecting Traffic to the ASA CX Module” section.
 
     
 
    
 
     
      [bookmark: pgfId-1261376](Optional) [bookmark: 27726]Configuring the Authenticati[bookmark: marker-1288492]on Proxy Port
 
     [bookmark: pgfId-1390065]The default authentication port is 885. To change the authentication proxy port, perform the following steps. For more information about the authentication proxy, see the “Information About Authentication Proxy” section.
 
      
       
     
 
     
 
     [bookmark: pgfId-1392489]Note (Single mode) You can also set the port as part of the ASDM startup wizard. See the “(ASA 5585-X) Changing the ASA CX Management IP Address” section.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1381666]Guidelines
 
     [bookmark: pgfId-1381667]In multiple context mode, perform this procedure within each security context.
 
    
 
     
      [bookmark: pgfId-1379373]Detailed Steps
 
     
 
     [bookmark: pgfId-1392497]Step 1 In ASDM, choose Configuration > Firewall > Advanced > ASA CX Auth Proxy.
 
     [bookmark: pgfId-1392501]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1392502]Step 2 Enter a port greater than 1024. The default is 885.
 
     [bookmark: pgfId-1392503]Step 3 Click Apply.
 
     [bookmark: pgfId-1392504]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1288788][bookmark: 30698][bookmark: 44497]Redirecting Traffic to the ASA CX Module
 
     [bookmark: pgfId-1369538]You can redirect traffic to the ASA CX module by creating a service policy that identifies specific traffic. For demonstration purposes only, you can also enable monitor-only mode for the service policy, which forwards a copy of traffic to the ASA CX module, while the original traffic remains unaffected.
 
     [bookmark: pgfId-1369539]Another option for demonstration purposes is to configure a traffic-forwarding interface instead of a service policy in monitor-only mode. The traffic-forwarding interface sends all traffic directly to the ASA CX module, bypassing the ASA.
 
      
      	 [bookmark: pgfId-1369546]Creating the ASA CX Service Policy
 
      	 [bookmark: pgfId-1369550]Configuring Traffic-Forwarding Interfaces (Monitor-Only Mode)
 
     
 
    
 
     
      [bookmark: pgfId-1369552][bookmark: 39735]Creating the ASA CX Service Policy
 
     [bookmark: pgfId-1288792][bookmark: marker-1350028]This section identifies traffic to redirect from the ASA to the ASA CX module. Configure this policy on the ASA. If you want to use a traffic-forwarding interface for demonstration purposes, skip this procedure and see the “Configuring Traffic-Forwarding Interfaces (Monitor-Only Mode)” section instead.
 
      
       
     
 
     
 
     [bookmark: pgfId-1320280]Note When using PRSM in multiple device mode, you can configure the ASA policy for sending traffic to the ASA CX module within PRSM, instead of using ASDM or the ASA CLI. However, PRSM has some limitations when configuring the ASA service policy; see the ASA CX user guide for more information.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1320287]Prerequisites
 
      
      	 [bookmark: pgfId-1266132]If you enable the authentication proxy on the ASA using this procedure, be sure to also configure a directory realm for authentication on the ASA CX module. See the ASA CX user guide for more information.
 
      	 [bookmark: pgfId-1350523]If you have an active service policy redirecting traffic to an IPS module (that you replaced with the ASA CX), you must remove that policy before you configure the ASA CX service policy.
 
      	 [bookmark: pgfId-1369568]Be sure to configure both the ASA policy and the ASA CX to have matching modes: both in monitor-only mode, or both in normal inline mode.
 
      	 [bookmark: pgfId-1381688]In multiple context mode, perform this procedure within each security context.
 
     
 
    
 
     
      [bookmark: pgfId-1350528]Detailed Steps
 
     
 
     [bookmark: pgfId-1392510]Step 1 C[bookmark: 56720]hoose Configuration > Firewall > Service Policy Rules.
 
     [bookmark: pgfId-1392514]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1392515]Step 2 Choose Add > Add Service Policy Rule. The Add Service Policy Rule Wizard - Service Policy dialog box appears.
 
     [bookmark: pgfId-1392516]Step 3 Complete the Service Policy dialog box as desired. See the ASDM online help for more information about these screens.
 
     [bookmark: pgfId-1392517]Step 4 Click Next. The Add Service Policy Rule Wizard - Traffic Classification Criteria dialog box appears.
 
     [bookmark: pgfId-1392518]Step 5 Complete the Traffic Classification Criteria dialog box as desired. See the ASDM online help for more information about these screens.
 
     [bookmark: pgfId-1392519]Step 6 Click Next to show the Add Service Policy Rule Wizard - Rule Actions dialog box.
 
     [bookmark: pgfId-1392520]Step 7 Click the ASA CX Inspection tab.
 
     [bookmark: pgfId-1399210]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1392525]Step 8 Check the Enable ASA CX for this traffic flow check box.
 
     [bookmark: pgfId-1392526]Step 9 In the If ASA CX Card Fails area, click one of the following:
 
      
       
       	 [bookmark: pgfId-1392530] Permit traffic —Sets the ASA to allow all traffic through, uninspected, if the ASA CX module is unavailable.
 
       	 [bookmark: pgfId-1392534] Close traffic —Sets the ASA to block all traffic if the ASA CX module is unavailable. 
 
      
 
     
 
     [bookmark: pgfId-1392535]Step 10 (Optional) To enable the authentication proxy, which is required for active authentication, check the Enable Auth Proxy check box. This option is not available in monitor-only mode.
 
     [bookmark: pgfId-1392536]Step 11 (Optional) For demonstration purposes only, check the Monitor-only check box to send a read-only copy of traffic to the ASA CX module. See the “Monitor-Only Mode” section for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1392540]Note You must configure all classes and policies to be either in monitor-only mode, or in normal inline mode; you cannot mix both modes on the same ASA.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1392544]Step 12 Click OK and then Apply.
 
     [bookmark: pgfId-1392545]Step 13 Repeat this procedure to configure additional traffic flows as desired.
 
     [bookmark: pgfId-1392546]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1369612][bookmark: 98883]Configuring Traffic-Forwarding Interfaces (Monitor-Only Mode)
 
     [bookmark: pgfId-1369613]This section configures traffic-forwarding interfaces, where all traffic is forwarded directly to the ASA CX module. This method is for demonstration purposes only. For a normal ASA CX service policy, see the “Creating the ASA CX Service Policy” section.
 
     [bookmark: pgfId-1369620]For more information see the “Monitor-Only Mode” section. See also the “Guidelines and Limitations” section for guidelines and limitations specific to traffic-forwarding interfaces.
 
     [bookmark: pgfId-1392551]You can only configure this feature at the CLI; you can use the Command Line Interface tool.
 
    
 
     
      [bookmark: pgfId-1369622]Prerequisites
 
      
      	 [bookmark: pgfId-1369626]Be sure to configure both the ASA policy and the ASA CX to have matching modes: both in monitor-only.
 
      	 [bookmark: pgfId-1383933]In multiple context mode, perform this procedure within each security context.
 
     
 
    
 
     
      [bookmark: pgfId-1369627]Detailed Steps
 
     
 
     [bookmark: pgfId-1392556]Step 1 Choose Tools > Command Line Interface.
 
     [bookmark: pgfId-1392557]Step 2 Click the Multiple Line radio button.
 
     [bookmark: pgfId-1392558]Step 3 Enter the following commands:
 
     [bookmark: pgfId-1369686]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1369633] 
          
  
         	 
           
           [bookmark: pgfId-1369635]Command 
          
  
         	 
           
           [bookmark: pgfId-1369637]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1369639]Step 1
  
         	[bookmark: pgfId-1369641]interface physical_interface
 
           
           [bookmark: pgfId-1369642] 
          
 [bookmark: pgfId-1369646]ciscoasa(config)# interface gigabitethernet 0/5
  
         	[bookmark: pgfId-1369648]Enters interface configuration mode for the physical interface you want to use for traffic-forwarding.
  
        
 
         
         	[bookmark: pgfId-1369650]Step 2
  
         	[bookmark: pgfId-1369652]no nameif
 
           
           [bookmark: pgfId-1369653] 
          
 [bookmark: pgfId-1369657]ciscoasa(config-ifc)# no nameif
  
         	[bookmark: pgfId-1369659]Removes any name configured for the interface. If this interface was used in any ASA configuration, that configuration is removed. You cannot configure traffic-forwarding on a named interface.
  
        
 
         
         	[bookmark: pgfId-1369664]Step 3
  
         	[bookmark: pgfId-1369666]traffic-forward cxsc monitor-only
 
           
           [bookmark: pgfId-1369667] 
          
 [bookmark: pgfId-1369671]ciscoasa(config-ifc)# traffic-forward cxsc monitor-only
  
         	[bookmark: pgfId-1369673]Enables traffic-forwarding. You see a warning similar to the following:
 [bookmark: pgfId-1369674]WARNING: This configuration is purely for demo of CX functionality and shouldn't be used on a production ASA and any issues found when mixing demo feature with production ASA is not supported.
  
        
 
         
         	[bookmark: pgfId-1369676]Step 4
  
         	[bookmark: pgfId-1369678]no shutdown
 
           
           [bookmark: pgfId-1369679] 
          
 [bookmark: pgfId-1369683]ciscoasa(config-ifc)# no shutdown
  
         	[bookmark: pgfId-1369685]Enables the interface.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1370466]Step 4 Repeat for any additional interfaces.
 
     [bookmark: pgfId-1370467]Step 5 Click Send.
 
     [bookmark: pgfId-1370468]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1369690]Examples
 
     [bookmark: pgfId-1369691]The following example makes GigabitEthernet 0/5 a traffic-forwarding interface:
 
     [bookmark: pgfId-1392566]
 
      
      [image: ] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1349827][bookmark: 55088]Managing the ASA CX Module
 
    [bookmark: pgfId-1306715]This section includes procedures that help you manage the module.
 
     
     	 [bookmark: pgfId-1306719]Resetting the Password
 
     	 [bookmark: pgfId-1306723]Reloading or Resetting the Module
 
     	 [bookmark: pgfId-1306727]Shutting Down the Module
 
     	 [bookmark: pgfId-1326256](ASA 5512-X through ASA 5555-X) Uninstalling a Software Module Image
 
     	 [bookmark: pgfId-1323996](ASA 5512-X through ASA 5555-X) Sessioning to the Module From the ASA
 
    
 
     
      [bookmark: pgfId-1306734]Resetting the [bookmark: 70014]Passw[bookmark: marker-1306733]ord
 
     [bookmark: pgfId-1306737][bookmark: 74370][bookmark: 87026]You can reset the module password to the default. For the user admin, the default password is Admin123. After resetting the password, you should change it to a unique value using the module application.
 
     [bookmark: pgfId-1306738]Resetting the module password causes the module to reboot. Services are not available while the module is rebooting.
 
     [bookmark: pgfId-1392571]If you cannot connect to ASDM with the new password, restart ASDM and try to log in again. If you defined a new password and still have an existing password in ASDM that is different from the new password, clear the password cache by choosing File > Clear ASDM Password Cache, then restart ASDM and try to log in again.
 
     [bookmark: pgfId-1379460]To reset the module password to the default of Admin123, perform the following steps.
 
    
 
     
      [bookmark: pgfId-1381693]Guidelines
 
     [bookmark: pgfId-1381694]In multiple context mode, perform this procedure in the system execution space.
 
    
 
     
      [bookmark: pgfId-1379461]Detailed Steps
 
     [bookmark: pgfId-1379480]
 
     
 
     [bookmark: pgfId-1392579]Step 1 From the ASDM menu bar, choose Tools > ASA CX Password Reset.
 
     [bookmark: pgfId-1392580]The Password Reset confirmation dialog box appears.
 
     [bookmark: pgfId-1399249]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1392585]Step 2 Click OK to reset the password to the default Admin123. 
 
     [bookmark: pgfId-1392586]A dialog box displays the success or failure of the password reset.
 
     [bookmark: pgfId-1392587]Step 3 Click Close to close the dialog box.
 
     [bookmark: pgfId-1392588]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1306773][bookmark: 60064]Reloading or Resetting the Module[bookmark: marker-1306772]
 
     [bookmark: pgfId-1306777]To reload or reset the module, enter one of the following commands at the ASA CLI.
 
    
 
     
      [bookmark: pgfId-1381699]Guidelines
 
     [bookmark: pgfId-1381700]In multiple context mode, perform this procedure in the system execution space.
 
    
 
     
      [bookmark: pgfId-1306778]Detailed Steps
 
     [bookmark: pgfId-1306804]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1306781]Command 
          
  
         	 
           
           [bookmark: pgfId-1306783]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1325948]For a hardware module (ASA 5585-X):
 
           
           [bookmark: pgfId-1325949] 
            hw-module module 1 reload 
          
 
           
           [bookmark: pgfId-1325950] 
          
 [bookmark: pgfId-1325951]For a software module (ASA 5512-X through ASA 5555-X):
 
           
           [bookmark: pgfId-1325952] 
            sw-module module cxsc reload 
          
 
           
           [bookmark: pgfId-1325953] 
          
 [bookmark: pgfId-1325957]ciscoasa# hw-module module 1 reload
  
         	[bookmark: pgfId-1325959]Reloads the module software.
  
        
 
         
         	[bookmark: pgfId-1325961]For a hardware module:
 
           
           [bookmark: pgfId-1325962] 
            hw-module module 1 reset 
          
 
           
           [bookmark: pgfId-1325963] 
          
 [bookmark: pgfId-1325964]For a software module:
 
           
           [bookmark: pgfId-1325965] 
            sw-module module cxsc reset 
          
 
           
           [bookmark: pgfId-1325966] 
          
 [bookmark: pgfId-1325970]ciscoasa# hw-module module 1 reset
  
         	[bookmark: pgfId-1325972]Performs a reset, and then reloads the module.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1306807][bookmark: 56378]Shutting Down the Module[bookmark: marker-1306806]
 
     [bookmark: pgfId-1325899]Shutting down the module software prepares the module to be safely powered off without losing configuration data. Note: If you reload the ASA, the module is not automatically shut down, so we recommend shutting down the module before reloading the ASA. To gracefully shut down the module, perform the following steps at the ASA CLI.
 
    
 
     
      [bookmark: pgfId-1381705]Guidelines
 
     [bookmark: pgfId-1381706]In multiple context mode, perform this procedure in the system execution space.
 
    
 
     
      [bookmark: pgfId-1306815]Detailed Steps
 
     [bookmark: pgfId-1306832][bookmark: 31943]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1306818]Command 
          
  
         	 
           
           [bookmark: pgfId-1306820]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1326425]For a hardware module (ASA 5585-X):
 
           
           [bookmark: pgfId-1325838] 
            hw-module module 1 shutdown 
          
 
           
           [bookmark: pgfId-1325839] 
          
 [bookmark: pgfId-1326445]For a software module (ASA 5512-X through ASA 5555-X):
 
           
           [bookmark: pgfId-1325841] 
            sw-module module cxsc shutdown 
          
 
           
           [bookmark: pgfId-1325842] 
          
 [bookmark: pgfId-1325846]ciscoasa# hw-module module 1 shutdown
  
         	[bookmark: pgfId-1306830]Shuts down the module.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1326156](ASA 5512-X through ASA 5555-X) [bookmark: 40995]Uninstalling a Software Module Image[bookmark: marker-1326153][bookmark: marker-1326154][bookmark: marker-1326155]
 
     [bookmark: pgfId-1326157]To uninstall a software module image and associated configuration, perform the following steps.
 
    
 
     
      [bookmark: pgfId-1381711]Guidelines
 
     [bookmark: pgfId-1381712]In multiple context mode, perform this procedure in the system execution space.
 
    
 
     
      [bookmark: pgfId-1326158]Detailed Steps
 
     [bookmark: pgfId-1326199]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1326161] 
          
  
         	 
           
           [bookmark: pgfId-1326163]Command 
          
  
         	 
           
           [bookmark: pgfId-1326165]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1326167]Step 1
  
         	[bookmark: pgfId-1326169]sw-module module cxsc uninstall
 
           
           [bookmark: pgfId-1326170] 
          
 [bookmark: pgfId-1326174]ciscoasa# sw-module module cxsc uninstall
 [bookmark: pgfId-1326175]Module cxsc will be uninstalled. This will completely remove the
 [bookmark: pgfId-1326176]disk image associated with the sw-module including any configuration
 [bookmark: pgfId-1326177]that existed within it.
 [bookmark: pgfId-1326178]
 [bookmark: pgfId-1326179]Uninstall module <id>? [confirm]
  
         	[bookmark: pgfId-1326181]Permanently uninstalls the software module image and associated configuration.
  
        
 
         
         	[bookmark: pgfId-1326183]Step 2
  
         	[bookmark: pgfId-1326185]reload
 
           
           [bookmark: pgfId-1326186] 
          
 [bookmark: pgfId-1326190]ciscoasa# reload
  
         	[bookmark: pgfId-1326198]Reloads the ASA. You must reload the ASA before you can install a new module type.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1322916][bookmark: 91732](ASA 5512-X through ASA 5555-X) Sessioning to the Module From the ASA
 
     [bookmark: pgfId-1322923]To access the ASA CX software module CLI from the ASA, you can session from the ASA. You can either session to the module (using Telnet) or create a virtual console session. A console session might be useful if the control plane is down and you cannot establish a Telnet session.
 
     [bookmark: pgfId-1392593]You may need to access the CLI if you are using multiple context mode and you need to set basic network settings using the CLI, or for troubleshooting.
 
    
 
     
      [bookmark: pgfId-1381718]Guidelines
 
     [bookmark: pgfId-1381719]In multiple context mode, perform this procedure in the system execution space.
 
    
 
     
      [bookmark: pgfId-1322925]Detailed Steps
 
     [bookmark: pgfId-1322965]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1322928]Command 
          
  
         	 
           
           [bookmark: pgfId-1322930]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1322932]Telnet session.
 
           
           [bookmark: pgfId-1322933] 
            session cxsc 
          
 
           
           [bookmark: pgfId-1322934] 
          
 
           
           [bookmark: pgfId-1322935] 
          
 [bookmark: pgfId-1322939]ciscoasa# session cxsc
 [bookmark: pgfId-1322940]
 [bookmark: pgfId-1322941]Opening command session with slot 1.
 [bookmark: pgfId-1322942]Connected to module cxsc. Escape character sequence is 'CTRL-^X'.
 [bookmark: pgfId-1322943]
 [bookmark: pgfId-1322944]cxsc login: admin
 [bookmark: pgfId-1322945]Password: Admin123
  
         	[bookmark: pgfId-1322947]Accesses the module using Telnet. You are prompted for the username and password. The default username is admin, and the default password is Admin123.
  
        
 
         
         	[bookmark: pgfId-1322949]Console session.
 
           
           [bookmark: pgfId-1322950] 
            session cxsc console 
          
 
           
           [bookmark: pgfId-1322951] 
          
 [bookmark: pgfId-1322955]ciscoasa# session cxsc console
 [bookmark: pgfId-1322956]
 [bookmark: pgfId-1322957]Establishing console session with slot 1
 [bookmark: pgfId-1322958]Opening console session with module cxsc.
 [bookmark: pgfId-1322959]Connected to module cxsc. Escape character sequence is 'CTRL-SHIFT-6 then x'.
 [bookmark: pgfId-1322960]
 [bookmark: pgfId-1322961]cxsc login: admin
 [bookmark: pgfId-1322962]Password: Admin123
  
         	[bookmark: pgfId-1322964]Accesses the module console. You are prompted for the username and password. The default username is admin, and the default password is Admin123.
 command instead.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1271368][bookmark: 59279]Monitoring the ASA CX Mod[bookmark: marker-1288493]ule
 
    [bookmark: pgfId-1392598]Use Tools > Command Line Interface to use monitoring commands.
 
     
     	 [bookmark: pgfId-1271777]Showing Module Status
 
     	 [bookmark: pgfId-1271787]Showing Module Statistics
 
     	 [bookmark: pgfId-1273049]Monitoring Module Connections
 
     	 [bookmark: pgfId-1277265]Capturing Module Traffic
 
     	 [bookmark: pgfId-1277337]Problems with the Authentication Proxy
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1288801]Note For ASA CX-related syslog messages, see the syslog messages guide. ASA CX syslog messages start with message number 429001.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1271761][bookmark: 17516]Showing Module Status
 
     [bookmark: pgfId-1392609]See the “ASA CX Status Tab” section in the general operations configuration guide.
 
    
 
     
      [bookmark: pgfId-1271810][bookmark: 58192]Showing Module Statistics
 
     [bookmark: pgfId-1271883]To show module statistics, enter the following command:
 
     [bookmark: pgfId-1271901]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1271886]Command 
          
  
         	 
           
           [bookmark: pgfId-1271888]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1271890]show service-policy cxsc
  
         	[bookmark: pgfId-1271892]Displays the ASA CX statistics and status per service policy.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1271902]Examples
 
     [bookmark: pgfId-1272046]The following is sample output from the show service-policy command showing the ASA CX policy and the current statistics as well as the module status when the authentication proxy is disabled:
 
      
      [bookmark: pgfId-1272149]hostname# show service-policy cxsc 
     
 
      
      [bookmark: pgfId-1272150]Global policy:  
     
 
      
      [bookmark: pgfId-1272151] Service-policy: global_policy 
     
 
      
      [bookmark: pgfId-1272152] Class-map: bypass 
     
 
      
      [bookmark: pgfId-1272153] CXSC: card status Up, mode fail-open, auth-proxy disabled 
     
 
      
      [bookmark: pgfId-1272154] packet input 2626422041, packet output 2626877967, drop 0, reset-drop 0, proxied 0 
     
 
      
      [bookmark: pgfId-1272155] 
     
 
     [bookmark: pgfId-1272242]The following is sample output from the show service-policy command showing the ASA CX policy and the current statistics as well as the module status when the authentication proxy is enabled; in this case, the proxied counters also increment:
 
      
      [bookmark: pgfId-1272238]hostname# show service-policy cxsc 
     
 
      
      [bookmark: pgfId-1272159]Global policy:  
     
 
      
      [bookmark: pgfId-1272160] Service-policy: pmap 
     
 
      
      [bookmark: pgfId-1272161] Class-map: class-default 
     
 
      
      [bookmark: pgfId-1272162] Default Queueing Set connection policy: random-sequence-number disable 
     
 
      
      [bookmark: pgfId-1272163] drop 0 
     
 
      
      [bookmark: pgfId-1272164] CXSC: card status Up, mode fail-open, auth-proxy enabled 
     
 
      
      [bookmark: pgfId-1272165] packet input 7724, packet output 7701, drop 0, reset-drop 0, proxied 10 
     
 
      
      [bookmark: pgfId-1272047] 
     
 
    
 
     
      [bookmark: pgfId-1272263][bookmark: 51692]Monitoring Module Connections
 
     [bookmark: pgfId-1272291]To show connections through the ASA CX module, enter one of the following commands:
 
     [bookmark: pgfId-1272301]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1272294]Command 
          
  
         	 
           
           [bookmark: pgfId-1272296]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1272298]show asp table classify domain cxsc
  
         	[bookmark: pgfId-1272300]Shows the NP rules created to send traffic to the ASA CX module.
  
        
 
         
         	[bookmark: pgfId-1272378]show asp table classify domain cxsc-auth-proxy
  
         	[bookmark: pgfId-1272868]Shows the NP rules created for the authentication proxy for the ASA CX module.
  
        
 
         
         	[bookmark: pgfId-1272374]show asp drop
  
         	[bookmark: pgfId-1273335]Shows dropped packets. The following drop types are used:
 [bookmark: pgfId-1273336]Frame Drops:
 
           
           	 [bookmark: pgfId-1273337]cxsc-bad-tlv-received—This occurs when ASA receives a packet from CXSC without a Policy ID TLV. This TLV must be present in non-control packets if it does not have the Standy Active bit set in the actions field.
 
           	 [bookmark: pgfId-1273338]cxsc-request—The frame was requested to be dropped by CXSC due a policy on CXSC whereby CXSC would set the actions to Deny Source, Deny Destination, or Deny Pkt.
 
           	 [bookmark: pgfId-1273339]cxsc-fail-close—The packet is dropped because the card is not up and the policy configured was 'fail-close' (rather than 'fail-open' which allows packets through even if the card was down).
 
           	 [bookmark: pgfId-1273340]cxsc-fail—The CXSC configuration was removed for an existing flow and we are not able to process it through CXSC it will be dropped. This should be very unlikely.
 
           	 [bookmark: pgfId-1273341]cxsc-malformed-packet—The packet from CXSC contains an invalid header. For instance, the header length may not be correct.
 
          
 [bookmark: pgfId-1273342]Flow Drops:
 
           
           	 [bookmark: pgfId-1273343]cxsc-request—The CXSC requested to terminate the flow. The actions bit 0 is set.
 
           	 [bookmark: pgfId-1273344]reset-by-cxsc—The CXSC requested to terminate and reset the flow. The actions bit 1 is set.
 
           	 [bookmark: pgfId-1273345]cxsc-fail-close—The flow was terminated because the card is down and the configured policy was 'fail-close'.
 
          
  
        
 
         
         	[bookmark: pgfId-1273669]show asp event dp-cp cxsc-msg
  
         	[bookmark: pgfId-1272372]This output shows how many ASA CX module messages are on the dp-cp queue. Currently, only VPN queries from the ASA CX module are sent to dp-cp.
  
        
 
         
         	[bookmark: pgfId-1272366]show conn
  
         	[bookmark: pgfId-1274214]This command already shows if a connection is being forwarded to a module by displaying the ‘X - inspected by service module’ flag. Connections being forwarded to the ASA CX module will also display the ‘X’ flag.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1272302]Examples
 
     [bookmark: pgfId-1272303]The following is sample output from the show asp table classify domain cxsc command:
 
      
      [bookmark: pgfId-1272304]ciscoasa# show asp table classify domain cxsc 
     
 
      
      [bookmark: pgfId-1272392]Input Table 
     
 
      
      [bookmark: pgfId-1272393]in id=0x7ffedb4acf40, priority=50, domain=cxsc, deny=false 
     
 
      
      [bookmark: pgfId-1272394] hits=15485658, user_data=0x7ffedb4ac840, cs_id=0x0, use_real_addr, flags=0x0, protocol=0 
     
 
      
      [bookmark: pgfId-1272395] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272396] dst ip/id=0.0.0.0, mask=0.0.0.0, port=0, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272397] input_ifc=outside, output_ifc=any 
     
 
      
      [bookmark: pgfId-1272398]in id=0x7ffedb4ad4a0, priority=50, domain=cxsc, deny=false 
     
 
      
      [bookmark: pgfId-1272399] hits=992053, user_data=0x7ffedb4ac840, cs_id=0x0, use_real_addr, flags=0x0, protocol=0 
     
 
      
      [bookmark: pgfId-1272400] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272401] dst ip/id=0.0.0.0, mask=0.0.0.0, port=0, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272402] input_ifc=inside, output_ifc=any 
     
 
      
      [bookmark: pgfId-1272403]in id=0x7ffedb4ada00, priority=50, domain=cxsc, deny=false 
     
 
      
      [bookmark: pgfId-1272404] hits=0, user_data=0x7ffedb4ac840, cs_id=0x0, use_real_addr, flags=0x0, protocol=0 
     
 
      
      [bookmark: pgfId-1272405] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272406] dst ip/id=0.0.0.0, mask=0.0.0.0, port=0, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272407] input_ifc=m, output_ifc=any 
     
 
      
      [bookmark: pgfId-1272408] 
     
 
      
      [bookmark: pgfId-1272409]Output Table: 
     
 
      
      [bookmark: pgfId-1272410] 
     
 
      
      [bookmark: pgfId-1272411]L2 - Output Table: 
     
 
      
      [bookmark: pgfId-1272412] 
     
 
      
      [bookmark: pgfId-1272413]L2 - Input Table: 
     
 
      
      [bookmark: pgfId-1272414] 
     
 
      
      [bookmark: pgfId-1272287]Last clearing of hits counters: Never 
     
 
      
      [bookmark: pgfId-1272795] 
     
 
     [bookmark: pgfId-1272972]The following is sample output from the show asp table classify domain cxsc-auth-proxy command. For the first rule in the output, the destination “port=2000” is the auth-proxy port configured by the cxsc auth-proxy port 2000 command, and the destination “ip/id=192.168.0.100” is the ASA interface IP address.
 
      
      [bookmark: pgfId-1272798]ciscoasa# show asp table classify domain cxsc-auth-proxy  
     
 
      
      [bookmark: pgfId-1272609]Input Table 
     
 
      
      [bookmark: pgfId-1272610]in id=0x7ffed86cc470, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1272611] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1272612] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272613] dst ip/id=192.168.0.100, mask=255.255.255.255, port=2000, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272614] input_ifc=inside, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1272615]in id=0x7ffed86cce20, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1272616] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1272617] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272618] dst ip/id=2.2.2.2, mask=255.255.255.255, port=2000, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272619] input_ifc=new2, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1272620]in id=0x7ffed86cd7d0, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1272621] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1272622] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272623] dst ip/id=172.23.58.52, mask=255.255.255.255, port=2000, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272624] input_ifc=mgmt, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1272625]in id=0x7ffed86caa80, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1272626] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1272627] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1272628] dst ip/id=192.168.5.172, mask=255.255.255.255, port=2000, dscp=0x0 
     
 
      
      [bookmark: pgfId-1272629] input_ifc=outside, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1272630]in id=0x7ffed86cb3c0, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1272631] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1272632] src ip/id=::/0, port=0 
     
 
      
      [bookmark: pgfId-1272633] dst ip/id=fe80::5675:d0ff:fe5b:1102/128, port=2000 
     
 
      
      [bookmark: pgfId-1272634] input_ifc=outside, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1272635]in id=0x7ffed742be10, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1272636] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1272637] src ip/id=::/0, port=0 
     
 
      
      [bookmark: pgfId-1272638] dst ip/id=1:1:1:1::10/128, port=2000 
     
 
      
      [bookmark: pgfId-1272639] input_ifc=outside, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1272640] 
     
 
      
      [bookmark: pgfId-1272641]Output Table: 
     
 
      
      [bookmark: pgfId-1272642] 
     
 
      
      [bookmark: pgfId-1272643]L2 - Output Table: 
     
 
      
      [bookmark: pgfId-1272644] 
     
 
      
      [bookmark: pgfId-1272645]L2 - Input Table: 
     
 
      
      [bookmark: pgfId-1272646] 
     
 
      
      [bookmark: pgfId-1272575]Last clearing of hits counters: Never 
     
 
      
      [bookmark: pgfId-1273067] 
     
 
     [bookmark: pgfId-1273225]The following is sample output from the show asp drop command. This output is just an example and lists all the possible reasons for a dropped frame or flow from the ASA CX module:
 
      
      [bookmark: pgfId-1273202]ciscoasa# show asp drop 
     
 
      
      [bookmark: pgfId-1273136]Frame drop: 
     
 
      
      [bookmark: pgfId-1273137] CXSC Module received packet with bad TLV's (cxsc-bad-tlv-received) 2 
     
 
      
      [bookmark: pgfId-1273138] CXSC Module requested drop (cxsc-request) 1 
     
 
      
      [bookmark: pgfId-1273139] CXSC card is down (cxsc-fail-close) 1 
     
 
      
      [bookmark: pgfId-1273140] CXSC config removed for flow (cxsc-fail) 3 
     
 
      
      [bookmark: pgfId-1273141] CXSC Module received malformed packet (cxsc-malformed-packet) 1 
     
 
      
      [bookmark: pgfId-1273142]  
     
 
      
      [bookmark: pgfId-1273143]Last clearing: 18:12:58 UTC May 11 2012 by enable_15 
     
 
      
      [bookmark: pgfId-1273144] 
     
 
      
      [bookmark: pgfId-1273145]Flow drop: 
     
 
      
      [bookmark: pgfId-1273146] Flow terminated by CXSC (cxsc-request) 2 
     
 
      
      [bookmark: pgfId-1273147] Flow reset by CXSC (reset-by-cxsc) 1 
     
 
      
      [bookmark: pgfId-1273148] CXSC fail-close (cxsc-fail-close) 1 
     
 
      
      [bookmark: pgfId-1273149] 
     
 
      
      [bookmark: pgfId-1273150]Last clearing: 18:12:58 UTC May 11 2012 by enable_15 
     
 
      
      [bookmark: pgfId-1273151] 
     
 
     [bookmark: pgfId-1273576]The following is sample output from the show asp event dp-cp cxsc-msg command:
 
      
      [bookmark: pgfId-1273577]ciscoasa# show asp event dp-cp cxsc-msg 
     
 
      
      [bookmark: pgfId-1273578]DP-CP EVENT QUEUE QUEUE-LEN HIGH-WATER 
     
 
      
      [bookmark: pgfId-1273579]Punt Event Queue 0 5 
     
 
      
      [bookmark: pgfId-1273580]Identity-Traffic Event Queue 0 0 
     
 
      
      [bookmark: pgfId-1273581]General Event Queue 0 4 
     
 
      
      [bookmark: pgfId-1273582]Syslog Event Queue 4 90 
     
 
      
      [bookmark: pgfId-1273583]Non-Blocking Event Queue 0 2 
     
 
      
      [bookmark: pgfId-1273584]Midpath High Event Queue 0 53 
     
 
      
      [bookmark: pgfId-1273585]Midpath Norm Event Queue 8074 8288 
     
 
      
      [bookmark: pgfId-1273586]SRTP Event Queue 0 0 
     
 
      
      [bookmark: pgfId-1273587]HA Event Queue 0 0 
     
 
      
      [bookmark: pgfId-1273588]Threat-Detection Event Queue 0 3 
     
 
      
      [bookmark: pgfId-1273589]ARP Event Queue 0 2048 
     
 
      
      [bookmark: pgfId-1273590]IDFW Event Queue 0 0 
     
 
      
      [bookmark: pgfId-1273591]CXSC Event Queue 0 1 
     
 
      
      [bookmark: pgfId-1273592]EVENT-TYPE ALLOC ALLOC-FAIL ENQUEUED ENQ-FAIL RETIRED 15SEC-RATE 
     
 
      
      [bookmark: pgfId-1273593]cxsc-msg 1 0 1 0 1 0 
     
 
      
      [bookmark: pgfId-1274121] 
     
 
     [bookmark: pgfId-1274159]The following is sample output from the show conn detail command:
 
      
      [bookmark: pgfId-1274073]ciscoasa# show conn detail  
     
 
      
      [bookmark: pgfId-1274074]0 in use, 105 most used 
     
 
      
      [bookmark: pgfId-1274075]Flags: A - awaiting inside ACK to SYN, a - awaiting outside ACK to SYN, 
     
 
      
      [bookmark: pgfId-1274076] B - initial SYN from outside, b - TCP state-bypass or nailed, C - CTIQBE media, 
     
 
      
      [bookmark: pgfId-1274077] D - DNS, d - dump, E - outside back connection, F - outside FIN, f - inside FIN, 
     
 
      
      [bookmark: pgfId-1274078] G - group, g - MGCP, H - H.323, h - H.225.0, I - inbound data, 
     
 
      
      [bookmark: pgfId-1274079] i - incomplete, J - GTP, j - GTP data, K - GTP t3-response 
     
 
      
      [bookmark: pgfId-1274080] k - Skinny media, M - SMTP data, m - SIP media, n - GUP 
     
 
      
      [bookmark: pgfId-1274081] O - outbound data, P - inside back connection, p - Phone-proxy TFTP connection, 
     
 
      
      [bookmark: pgfId-1274082] q - SQL*Net data, R - outside acknowledged FIN, 
     
 
      
      [bookmark: pgfId-1274083] R - UDP SUNRPC, r - inside acknowledged FIN, S - awaiting inside SYN, 
     
 
      
      [bookmark: pgfId-1274084] s - awaiting outside SYN, T - SIP, t - SIP transient, U - up, 
     
 
      
      [bookmark: pgfId-1274085] V - VPN orphan, W - WAAS, 
     
 
      
      [bookmark: pgfId-1274086] X - inspected by service module 
     
 
      
      [bookmark: pgfId-1274087] 
     
 
      
      [bookmark: pgfId-1274036]TCP outside 208.80.152.2:80 inside 192.168.1.20:59928, idle 0:00:10, bytes 79174, flags XUIO 
     
 
    
 
     
      [bookmark: pgfId-1274377][bookmark: 45693]Capturing Module Traffic
 
     [bookmark: pgfId-1274772]To configure and view packet captures for the ASA CX module, enter one of the following commands:
 
     [bookmark: pgfId-1274808]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1274775]Command 
          
  
         	 
           
           [bookmark: pgfId-1274777]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-1275098]capture name interface asa_dataplane 
  
         	[bookmark: pgfId-1275019]Captures packets between ASA CX module and the ASA on the backplane.
  
        
 
         
         	[bookmark: pgfId-1275283]copy capture
  
         	[bookmark: pgfId-1275404]Copies the capture file to a server.
  
        
 
         
         	[bookmark: pgfId-1274787]show capture
  
         	[bookmark: pgfId-1274799]Shows the capture at the ASA console.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1306417]Note Captured packets contain an additional AFBP header that your PCAP viewer might not understand; be sure to use the appropriate plugin to view these packets.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1306419][bookmark: 84647]Troubleshooting the ASA CX Module
 
     
     	 [bookmark: pgfId-1306496]Problems with the Authentication Proxy
 
    
 
     
      [bookmark: pgfId-1279072][bookmark: 34691][bookmark: 24077]Problems with the Authenticatio[bookmark: marker-1288494]n Proxy
 
     [bookmark: pgfId-1279301]If you are having a problem using the authentication proxy feature, follow these steps to troubleshoot your configuration and connections:
 
     [bookmark: pgfId-1279225] 1. Check your configurations.
 
      
      	 [bookmark: pgfId-1279226]On the ASA, check the output of the  show asp table classify domain cxsc-auth-proxy command and make sure there are rules installed and that they are correct.
 
      	 [bookmark: pgfId-1279446]In PRSM, ensure the directory realm is created with the correct credentials and test the connection to make sure you can reach the authentication server; also ensure that a policy object or objects are configured for authentication.
 
     
 
     [bookmark: pgfId-1279228] 2. Check the output of the show service-policy cxsc command to see if any packets were proxied.
 
     [bookmark: pgfId-1279519] 3. Perform a packet capture on the backplane, and check to see if traffic is being redirected on the correct configured port. See the “Capturing Module Traffic” section. You can check the configured port using the show running-config cxsc command or the show asp table classify domain cxsc-auth-proxy command.
 
      
       
     
 
     
 
     [bookmark: pgfId-1289063]Note If you have a connection between hosts on two ASA interfaces, and the ASA CX service policy is only configured for one of the interfaces, then all traffic between these hosts is sent to the ASA CX module, including traffic orginiating on the non-ASA CX interface (the feature is bidirectional). However, the ASA only performs the authentication proxy on the interface to which the service policy is applied, because this feature is ingress-only.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1279230]Example 30-1 Make sure port 2000 is used consistently:
 
     [bookmark: pgfId-1279232] 1. Check the authentication proxy port:
 
      
      [bookmark: pgfId-1279233]ciscoasa# show running-config cxsc  
     
 
      
      [bookmark: pgfId-1279234]cxsc auth-proxy port 2000 
     
 
      
      [bookmark: pgfId-1279780] 
     
 
     [bookmark: pgfId-1279236] 2. Check the authentication proxy rules:
 
      
      [bookmark: pgfId-1279237]ciscoasa# show asp table classify domain cxsc-auth-proxy  
     
 
      
      [bookmark: pgfId-1279238] 
     
 
      
      [bookmark: pgfId-1279239]Input Table 
     
 
      
      [bookmark: pgfId-1279240]in id=0x7ffed86cc470, priority=121, domain=cxsc-auth-proxy, deny=false 
     
 
      
      [bookmark: pgfId-1279241] hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6 
     
 
      
      [bookmark: pgfId-1279242] src ip/id=0.0.0.0, mask=0.0.0.0, port=0 
     
 
      
      [bookmark: pgfId-1279243] dst ip/id=192.168.0.100, mask=255.255.255.255, port=2000, dscp=0x0 
     
 
      
      [bookmark: pgfId-1279244] input_ifc=inside, output_ifc=identity 
     
 
      
      [bookmark: pgfId-1279245] 
     
 
     [bookmark: pgfId-1279246] 3. In the packet captures, the redirect request should be going to destination port 2000.
 
    
 
   
 
    
     [bookmark: pgfId-1105767][bookmark: 31892][bookmark: 55352]Feature History for the ASA CX Module
 
    [bookmark: pgfId-1115677]Table 30-2 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.
 
    [bookmark: pgfId-1105805]
 
     
      
       
       [bookmark: pgfId-1105778]Table 30-2 [bookmark: 50557]Feature History for the ASA CX Module 
 
       
       
        
        	 
          
          [bookmark: pgfId-1115681]Feature Name 
         
  
        	 
          
          [bookmark: pgfId-1115683]Platform Releases 
         
  
        	 
          
          [bookmark: pgfId-1115685]Feature Information 
         
  
       
 
        
        	[bookmark: pgfId-1379725]ASA 5585-X with SSP-10 and -20 support for the ASA CX SSP-10 and -20
  
        	[bookmark: pgfId-1378743]ASA 8.4(4.1)
ASA CX 9.0(1)
  
        	[bookmark: pgfId-1266336]The ASA CX module lets you enforce security based on the complete context of a situation. This context includes the identity of the user (who), the application or website that the user is trying to access (what), the origin of the access attempt (where), the time of the attempted access (when), and the properties of the device used for the access (how). With the ASA CX module, you can extract the full context of a flow and enforce granular policies such as permitting access to Facebook but denying access to games on Facebook or permitting finance employees access to a sensitive enterprise database but denying the same access to other employees.
 [bookmark: pgfId-1392619]We introduced the following screens:
 [bookmark: pgfId-1316704]Home > ASA CX Status
Wizards > Startup Wizard > ASA CX Basic Configuration
Configuration > Firewall > Service Policy Rules > Add Service Policy Rule > Rule Actions > ASA CX Inspection
  
       
 
        
        	[bookmark: pgfId-1320376]ASA 5512-X through ASA 5555-X support for the ASA CX SSP
  
        	[bookmark: pgfId-1378749]ASA 9.1(1)
ASA CX 9.1(1)
  
        	[bookmark: pgfId-1320357]We introduced support for the ASA CX SSP software module for the ASA 5512-X, ASA 5515-X, ASA 5525-X, ASA 5545-X, and ASA 5555-X.
 [bookmark: pgfId-1320359]We did not modify any screens.
  
       
 
        
        	[bookmark: pgfId-1355009]Monitor-only mode for demonstration purposes
  
        	[bookmark: pgfId-1355011]ASA 9.1(2)
ASA CX 9.1(2)
  
        	[bookmark: pgfId-1355039]For demonstration purposes only, you can enable monitor-only mode for the service policy, which forwards a copy of traffic to the ASA CX module, while the original traffic remains unaffected.
 [bookmark: pgfId-1355013]Another option for demonstration purposes is to configure a traffic-forwarding interface instead of a service policy in monitor-only mode. The traffic-forwarding interface sends all traffic directly to the ASA CX module, bypassing the ASA.
 [bookmark: pgfId-1392635]We modified the following screen: Configuration > Firewall > Service Policy Rules > Add Service Policy Rule > Rule Actions > ASA CX Inspection.
 [bookmark: pgfId-1355179]The traffic-forwarding feature is supported by CLI only. 
  
       
 
        
        	[bookmark: pgfId-1360460]NAT 64 support for the ASA CX module
  
        	[bookmark: pgfId-1378755]ASA 9.1(2)
ASA CX 9.1(2)
  
        	[bookmark: pgfId-1360464]You can now use NAT 64 in conjunction with the ASA CX module.
 [bookmark: pgfId-1360532]We did not modify any screens. 
  
       
 
        
        	[bookmark: pgfId-1380012]ASA 5585-X with SSP-40 and -60 support for the ASA CX SSP-40 and -60
  
        	[bookmark: pgfId-1379650]ASA 9.1(3)
ASA CX 9.2(1)
  
        	[bookmark: pgfId-1379652]ASA CX SSP-40 and -60 modules can be used with the matching level ASA 5585-X with SSP-40 and -60.
 [bookmark: pgfId-1379809]We did not modify any screens.
  
       
 
        
        	[bookmark: pgfId-1378708]Multiple context mode support for the ASA CX module
  
        	[bookmark: pgfId-1378710]ASA 9.1(3)
ASA CX 9.2(1)
  
        	[bookmark: pgfId-1389381]You can now configure ASA CX service policies per context on the ASA.
 [bookmark: pgfId-1389385]Note Although you can configure per context ASA service policies, the ASA CX module itself (configured in PRSM) is a single context mode device; the context-specific traffic coming from the ASA is checked against the common ASA CX policy.
 [bookmark: pgfId-1379614]We did not modify any screens.
  
       
 
        
        	[bookmark: pgfId-1379839]Filtering packets captured on the ASA CX backplane
  
        	[bookmark: pgfId-1379841]ASA 9.1(3)
ASA CX 9.2(1)
  
        	[bookmark: pgfId-1379860]You can now filter packets captured on the ASA CX backplane using the match or access-list keyword with the capture interface asa_dataplane command.
 [bookmark: pgfId-1379863]Control traffic specific to the ASA CX module is not affected by the access-list or match filtering; the ASA captures all control traffic.
 [bookmark: pgfId-1379843]In multiple context mode, configure the packet capture per context. Note that all control traffic in multiple context mode goes only to the system execution space. Because control traffic cannot be filtered using an access-list or match, these options are not available in the system execution space.
 [bookmark: pgfId-1379957]We did not modify any ASDM screens.
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     [bookmark: pgfId-1078144][bookmark: 48696]Configuring the ASA CSC Module 
      
      
 
     
 

 
    [bookmark: pgfId-1078148]This chapter describes how to configure the Content Security and Control (CSC) application that is installed in a CSC SSM in the ASA.

 
    [bookmark: pgfId-1103851]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1190399]Information About the CSC SSM

 
     		 [bookmark: pgfId-1190410]Licensing Requirements for the CSC SSM

 
     		 [bookmark: pgfId-1190415]Prerequisites for the CSC SSM

 
     		 [bookmark: pgfId-1190420]Guidelines and Limitations

 
     		 [bookmark: pgfId-1190425]Default Settings

 
     		 [bookmark: pgfId-1190430]Configuring the CSC SSM

 
     		 [bookmark: pgfId-1356799]CSC SSM Setup Wizard

 
     		 [bookmark: pgfId-1356803]Using the CSC SSM GUI

 
     		 [bookmark: pgfId-1190435]Monitoring the CSC SSM

 
     		 [bookmark: pgfId-1202947]Troubleshooting the CSC Module

 
     		 [bookmark: pgfId-1190445]Additional References

 
     		 [bookmark: pgfId-1190455]Feature History for the CSC SSM

 
    

 
   
 
    
     [bookmark: pgfId-1241592][bookmark: 82998]Information About the CSC SSM[bookmark: marker-1241591]

 
    [bookmark: pgfId-1241602]Some ASA models support the CSC SSM, which runs Content Security and Control software. The CSC SSM provides protection against viruses, spyware, spam, and other unwanted traffic by scanning the FTP, HTTP/HTTPS, POP3, and SMTP packets that you configure the ASA to send to it.

 
    [bookmark: pgfId-1119455]For more information about the CSC SSM, see the following URL:

 
    [bookmark: pgfId-1119457]http://www.cisco.com/en/US/products/ps6823/index.html

 
    [bookmark: pgfId-1119017]Figure 32-1 shows the flow of traffic through an ASA that has the following:

 
     
     		 [bookmark: pgfId-1072230]A CSC SSM installed and configured.

 
     		 [bookmark: pgfId-1072251]A service policy that determines what traffic is diverted to the CSC SSM for scanning.

 
    

 
    [bookmark: pgfId-1072252]In this example, the client could be a network user who is accessing a website, downloading files from an FTP server, or retrieving mail from a POP3 server. SMTP scans differ in that you should configure the ASA to scan traffic sent from the outside to SMTP servers protected by the ASA.

 
    [bookmark: pgfId-1070599]Figure 32-1 [bookmark: 17253]Flow of Scanned Traffic with the CSC SSM

 
     
     [image: ] 
    
 
    [bookmark: pgfId-1102919]You use ASDM for system setup and monitoring of the CSC SSM. For advanced configuration of content security policies in the CSC SSM software, you access the web-based GUI for the CSC SSM by clicking links within ASDM. The CSC SSM GUI appears in a separate web browser window. To access the CSC SSM, you must enter the CSC SSM password. To use the CSC SSM GUI, see the Cisco Content Security and Control SSM Administrator Guide.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1072292]Note ASDM and the CSC SSM maintain separate passwords. You can configure their passwords to be identical; however, changing one of these two passwords does not affect the other password.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1068759]The connection between the host running ASDM and the ASA is made through a management port on the ASA. The connection to the CSC SSM GUI is made through the SSM management port. Because these two connections are required to manage the CSC SSM, any host running ASDM must be able to reach the IP address of both the ASA management port and the SSM management port.

 
    [bookmark: pgfId-1070544]Figure 32-2 shows an ASA with a CSC SSM that is connected to a dedicated management network. While use of a dedicated management network is not required, we recommend it. In this configuration, the following items are of particular interest:

 
     
     		 [bookmark: pgfId-1072153]An HTTP proxy server is connected to the inside network and to the management network. This HTTP proxy server enables the CSC SSM to contact the Trend Micro Systems update server.

 
     		 [bookmark: pgfId-1070577]The management port of the ASA is connected to the management network. To allow management of the ASA and the CSC SSM, hosts running ASDM must be connected to the management network.

 
     		 [bookmark: pgfId-1085568]The management network includes an SMTP server for e-mail notifications for the CSC SSM and a syslog server to which the CSC SSM can send syslog messages.

 
    

 
    [bookmark: pgfId-1085579]Figure 32-2 [bookmark: 84412]CSC SSM Deployment with a Management Network

 
     
     [image: ] 
    
 
     
      [bookmark: pgfId-1113285][bookmark: 89812]Determining What Traffic to Scan[bookmark: marker-1113284]

 
     [bookmark: pgfId-1113289]The CSC SSM can scan FTP, HTTP/HTTPS, POP3, and SMTP traffic only when the destination port of the packet requesting the connection is the well-known port for the specified protocol. The CSC SSM can scan only the following connections:

 
      
      		 [bookmark: pgfId-1113293]FTP connections opened to TCP port 21.

 
      		 [bookmark: pgfId-1113294]HTTP connections opened to TCP port 80.

 
      		 [bookmark: pgfId-1183528]HTTPS connections opened to TCP port 443.

 
      		 [bookmark: pgfId-1113295]POP3 connections opened to TCP port 110.

 
      		 [bookmark: pgfId-1113296]SMTP connections opened to TCP port 25.

 
     

 
     [bookmark: pgfId-1113297]You can choose to scan traffic for all of these protocols or any combination of them. For example, if you do not allow network users to receive POP3 e-mail, do not configure the ASA to divert POP3 traffic to the CSC SSM. Instead, block this traffic.

 
     [bookmark: pgfId-1113313]To maximize performance of the ASA and the CSC SSM, divert only the traffic to the CSC SSM that you want the CSC SSM to scan. Diverting traffic that you do not want scanned, such as traffic between a trusted source and destination, can adversely affect network performance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1118391]Note When traffic is first classified for CSC inspection, it is flow-based. If traffic is part of a pre-existing connection, the traffic goes directly to the service policy set for that connection.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1119569]You can apply service policies that include CSC scanning globally or to specific interfaces; therefore, you can choose to enable CSC scans globally or for specific interfaces. For more information, see the “Determining Service Policy Rule Actions for CSC Scanning” section.

 
     [bookmark: pgfId-1113326]Based on the configuration shown in Figure 32-3, configure the ASA to divert to the CSC SSM only requests from clients on the inside network for HTTP, FTP, and POP3 connections to the outside network, and incoming SMTP connections from outside hosts to the mail server on the DMZ network. Exclude from scanning HTTP requests from the inside network to the web server on the DMZ network.

 
     [bookmark: pgfId-1113331]Figure 32-3 [bookmark: 27301]Common Network Configuration for CSC SSM Scanning

 
     [bookmark: pgfId-1118118] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1118122]There are many ways you could configure the ASA to identify the traffic that you want to scan. One approach is to define two service policies: one on the inside interface and the other on the outside interface, each with ACLs that match traffic to be scanned.

 
     [bookmark: pgfId-1118065]Figure 32-4 shows service policy rules that select only the traffic that the ASA should scan.

 
     [bookmark: pgfId-1118142]Figure 32-4 [bookmark: 17909]Optimized Traffic Selection for CSC Scans

 
     [bookmark: pgfId-1118146] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1118069]In the inside-policy, the first class, inside-class1, ensures that the ASA does not scan HTTP traffic between the inside network and the DMZ network. The Match column indicates this setting by displaying the “Do not match” icon. This setting does not mean the ASA blocks traffic sent from the 192.168.10.0 network to TCP port 80 on the 192.168.20.0 network. Instead, this setting exempts the traffic from being matched by the service policy applied to the inside interface, which prevents the ASA from sending the traffic to the CSC SSM.

 
     [bookmark: pgfId-1117240]The second class of the inside-policy, inside-class matches FTP, HTTP, and POP3 traffic between the inside network and any destination. HTTP connections to the DMZ network are exempted because of the inside-class1 setting. As previously mentioned, policies that apply CSC scanning to a specific interface affect both incoming and outgoing traffic, but by specifying 192.168.10.0 as the source network, inside-class1 matches only connections initiated by the hosts on the inside network.

 
     [bookmark: pgfId-1117241]In the outside-policy, outside-class matches SMTP traffic from any outside source to the DMZ network. This setting protects the SMTP server and inside users who download e-mail from the SMTP server on the DMZ network, without having to scan connections from SMTP clients to the server.

 
     [bookmark: pgfId-1118497]If the web server on the DMZ network receives files uploaded by HTTP from external hosts, you can add a rule to the outside policy that matches HTTP traffic from any source to the DMZ network. Because the policy is applied to the outside interface, the rule would only match connections from HTTP clients outside the ASA.

 
    
 
   
 
    
     [bookmark: pgfId-1103992][bookmark: 10244]Licensing Requirements for the CSC SSM[bookmark: marker-1113681]

 
    [bookmark: pgfId-1370651] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1370627]Model 
         
  
        		 
          
          [bookmark: pgfId-1370629]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1370631]ASA 5510

  
        		 
          
          		 [bookmark: pgfId-1370633]Base License—Supports SMTP virus scanning, POP3 virus scanning and content filtering, web mail virus scanning, HTTP file blocking, FTP virus scanning and file blocking, logging, and automatic updates. Supports two contexts.

 
         

 [bookmark: pgfId-1370634]Optional licenses: 5 contexts.

 
          
          		 [bookmark: pgfId-1370635]Security Plus License—Supports the Base license features, plus SMTP anti-spam, SMTP content filtering, POP3 anti-spam, URL blocking, and URL filtering. Supports two contexts. 

 
         

 [bookmark: pgfId-1370636]Optional license: 5 contexts.

  
       

 
        
        		[bookmark: pgfId-1370638]ASA 5520

  
        		[bookmark: pgfId-1370640]Base License—Supports all features. Supports two contexts.

 [bookmark: pgfId-1370641]Optional licenses: 5, 10, or 20 contexts.

  
       

 
        
        		[bookmark: pgfId-1370643] ASA 5540

  
        		[bookmark: pgfId-1370645]Base License—Supports all features. Supports two contexts.

 [bookmark: pgfId-1370646]Optional licenses: 5, 10, 20, or 50 contexts.

  
       

 
        
        		[bookmark: pgfId-1370648]All other models

  
        		[bookmark: pgfId-1370650]No support.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1104002][bookmark: 98655]Prerequisites for the CSC SSM[bookmark: marker-1113682]

 
    [bookmark: pgfId-1104440]The CSC SSM has the following prerequisites:

 
     
     		 [bookmark: pgfId-1106579]A CSC SSM card must be installed in the ASA.

 
     		 [bookmark: pgfId-1106774]A Product Authorization Key (PAK) for use in registering the CSC SSM.

 
     		 [bookmark: pgfId-1106775]Activation keys that you receive by e-mail after you register the CSC SSM.

 
     		 [bookmark: pgfId-1104458]The management port of the CSC SSM must be connected to your network to allow management and automatic updates of the CSC SSM software.

 
     		 [bookmark: pgfId-1106747]The CSC SSM management port IP address must be accessible by the hosts used to run ASDM. 

 
     		 [bookmark: pgfId-1106785]You must obtain the following information to use in configuring the CSC SSM:

 
    

 
    [bookmark: pgfId-1106812] – The CSC SSM management port IP address, netmask, and gateway IP address.

 
    [bookmark: pgfId-1106840] – DNS server IP address.

 
    [bookmark: pgfId-1106841] – HTTP proxy server IP address (needed only if your security policies require the use of a proxy server for HTTP access to the Internet).

 
    [bookmark: pgfId-1106845] – Domain name and hostname for the CSC SSM.

 
    [bookmark: pgfId-1106846] – An e-mail address and an SMTP server IP address and port number for e-mail notifications.

 
    [bookmark: pgfId-1183218] – E-mail address(es) for product license renewal notifications.

 
    [bookmark: pgfId-1106850] – IP addresses of hosts or networks that are allowed to manage the CSC SSM. The IP addresses for the CSC SSM management port and the ASA management interface can be in different subnets.

 
    [bookmark: pgfId-1106854] – Password for the CSC SSM.

 
   
 
    
     [bookmark: pgfId-1107307][bookmark: 53405]Guidelines and Limitations

 
    [bookmark: pgfId-1107308]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1107312]Context Mo[bookmark: marker-1107311]de Guidelines

 
    [bookmark: pgfId-1107313]Supported in single and multiple context modes.

 
    [bookmark: pgfId-1107316]Firewall Mode Guidelines

 
    [bookmark: pgfId-1107317]Supported in routed and transparent firewall modes.

 
    [bookmark: pgfId-1107885]Failover Guidelines[bookmark: marker-1107882] 

 
    [bookmark: pgfId-1107890]Does not support sessions in Stateful Failover. The CSC SSM does not maintain connection information, and therefore cannot provide the failover unit with the required information. The connections that a CSC SSM is scanning are dropped when the ASA in which the CSC SSM is installed fails. When the standby ASA becomes active, it forwards the scanned traffic to the CSC SSM and the connections are reset.

 
    [bookmark: pgfId-1113749]IPv6 Guidelines

 
    [bookmark: pgfId-1113777]Does not support IPv6.

 
    [bookmark: pgfId-1107326]Model Guidelines

 
    [bookmark: pgfId-1107419]Supported on the ASA 5510, ASA 5520, and ASA 5540 only. Not supported on the ASA 5580 and the ASA 5585-X.

 
    [bookmark: pgfId-1205701]Additional Guidelines

 
    [bookmark: pgfId-1205652]You cannot change the software type installed on the module; if you purchase a CSC module, you cannot later install IPS software on it.

 
   
 
    
     [bookmark: pgfId-1107454][bookmark: 64961]Default Settings

 
    [bookmark: pgfId-1107459][bookmark: marker-1189277]Table 32-1 lists the default settings for the CSC SSM.

 
    [bookmark: pgfId-1107485] 

 
     
      
       
       [bookmark: pgfId-1107466]Table 32-1 [bookmark: 93724]Default CSC SSM Parameters 

 
       
       
        
        		 
          
          [bookmark: pgfId-1107470]Parameter 
         
  
        		 
          
          [bookmark: pgfId-1107472]Default 
         
  
       

 
        
        		[bookmark: pgfId-1107474]FTP inspection on the ASA

  
        		[bookmark: pgfId-1107476]Enabled

  
       

 
        
        		[bookmark: pgfId-1107478]All features included in the license(s) that you have purchased

  
        		[bookmark: pgfId-1107480]Enabled

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1104416][bookmark: 58112]Configuring the CSC SSM

 
    [bookmark: pgfId-1107926]This section describes how to configure the CSC SSM and includes the following topics:

 
     
     		 [bookmark: pgfId-1190497]Before Configuring the CSC SSM

 
     		 [bookmark: pgfId-1190589]Connecting to the CSC SSM

 
     		 [bookmark: pgfId-1356819]Determining Service Policy Rule Actions for CSC Scanning

 
    

 
     
      [bookmark: pgfId-1107939][bookmark: 51525]Before Configuring the CSC SSM

 
     [bookmark: pgfId-1073157]Before configuring the ASA and the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1072354]Step 1 If the CSC SSM did not come preinstalled in a Cisco ASA, install it and connect a network cable to the management port of the SSM. For assistance with installation and connecting the SSM, see the Cisco ASA 5500 Series Quick Start Guide.

 
     [bookmark: pgfId-1072434]The management port of the CSC SSM must be connected to your network to allow management of and automatic updates to the CSC SSM software. Additionally, the CSC SSM uses the management port for e-mail notifications and syslog messages.

 
     [bookmark: pgfId-1072537]Step 2 You should have received a Product Authorization Key (PAK) with the CSC SSM. Use the PAK to register the CSC SSM at the following URL.

 
     [bookmark: pgfId-1072542]http://www.cisco.com/go/license

 
     [bookmark: pgfId-1072544]After you register, you receive activation keys by e-mail. The activation keys are required before you can complete Step 6.

 
     [bookmark: pgfId-1072596]Step 3 Obtain the following information for use in Step 6:

 
      
       
       		 [bookmark: pgfId-1072603]Activation keys

 
       		 [bookmark: pgfId-1072607]CSC SSM management port IP address, netmask, and gateway IP address

 
       		 [bookmark: pgfId-1072618]DNS server IP address

 
       		 [bookmark: pgfId-1072619]HTTP proxy server IP address (needed only if your security policies require the use of a proxy server for HTTP access to the Internet)

 
       		 [bookmark: pgfId-1072623]Domain name and hostname for the CSC SSM

 
       		 [bookmark: pgfId-1072624]An e-mail address, and SMTP server IP address and port number for e-mail notifications

 
       		 [bookmark: pgfId-1183219]E-mail address(es) for product license renewal notifications

 
       		 [bookmark: pgfId-1072628]IP addresses of hosts or networks that are allowed to manage the CSC SSM

 
       		 [bookmark: pgfId-1072632]Password for the CSC SSM

 
      

 
     

 
     [bookmark: pgfId-1072783]Step 4 In a web browser, access ASDM for the ASA in which the CSC SSM is installed.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1108628]Note If you are accessing ASDM for the first time, see the “Additional References” section.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1073177]For more information about enabling ASDM access, see the “Configuring ASA Access for ASDM, Telnet, or SSH” section in the general operations configuration guide.

 
     [bookmark: pgfId-1072792]Step 5 Verify time settings on the ASA. Time setting accuracy is important for logging of security events and for automatic updates of CSC SSM software. Do one of the following:

 
      
       
       		 [bookmark: pgfId-1072800]If you manually control time settings, verify the clock settings, including time zone. Choose  Configuration > Properties > Device Administration > Clock .

 
       		 [bookmark: pgfId-1072801]If you are using NTP, verify the NTP configuration. Choose  Configuration > Properties > Device Administration > NTP .

 
      

 
     

 
     [bookmark: pgfId-1103931]Step 6 [bookmark: 83458]Open ASDM.

 
     [bookmark: pgfId-1108639]Step 7 Connect to and log in to the CSC SSM. For instructions, see the “Connecting to the CSC SSM” section.

 
     [bookmark: pgfId-1116944]Step 8 Run the CSC Setup Wizard. 

 
      
       
       		 [bookmark: pgfId-1116965]To access the CSC Setup Wizard, choose  Configuration > Trend Micro Content Security > CSC Setup > Wizard Setup > Launch Setup Wizard . 

 
       		 [bookmark: pgfId-1116977]If you are rerunning the CSC Setup Wizard, perform the same step listed in the previous bullet.

 
      

 
     

 
     [bookmark: pgfId-1108645]The CSC Setup Wizard appears. 

 
     [bookmark: pgfId-1120874]Step 9 Complete the CSC Setup Wizard, which includes configuration of service policies to divert traffic that you want scanned to the CSC SSM.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1120881]Note If you create a global service policy to divert traffic for CSC scans, all traffic (inbound and outbound) for the supported protocols is scanned. To maximize performance of the ASA and the CSC SSM, scan traffic only from untrusted sources. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1116982]Step 10 To reduce the load on the CSC SSM, configure the service policy rules that send packets to the CSC SSM to support only HTTP/HTTPS, SMTP, POP3, or FTP traffic. For instructions, see the “Determining Service Policy Rule Actions for CSC Scanning” section.

 
     [bookmark: pgfId-1102979]Step 11 (Optional) Review the default content security policies in the CSC SSM GUI, which are suitable for most implementations. You review the content security policies by viewing the enabled features in the CSC SSM GUI. For the availability of features, see the “Licensing Requirements for the CSC SSM” section. For the default settings, see the “Default Settings” section.

 
     [bookmark: pgfId-1117176]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1122557]What to Do Next

 
     [bookmark: pgfId-1122579]See the “Connecting to the CSC SSM” section.

 
    
 
     
      [bookmark: pgfId-1118815][bookmark: 12042]Connecting to the CSC SSM

 
     [bookmark: pgfId-1118822]With each session you start in ASDM, the first time you access features related to the CSC SSM, you must specify the management IP address and provide the password for the CSC SSM. After you successfully connect to the CSC SSM, you are not prompted again for the management IP address and password. If you start a new ASDM session, the connection to the CSC SSM is reset and you must specify the IP address and the CSC SSM password again. The connection to the CSC SSM is also reset if you change the time zone on the ASA. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1118850]Note The CSC SSM has a password that is maintained separately from the ASDM password. You can configure the two passwords to be identical, but changing the CSC SSM password does not affect the ASDM password.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1118857]To connect to the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1118858]Step 1 In the ASDM main application window, click the Content Security tab.

 
     [bookmark: pgfId-1118859]Step 2 In the Connecting to CSC dialog box, click one of the following radio buttons:

 
      
       
       		 [bookmark: pgfId-1118860]To connect to the IP address of the management port on the SSM, click  Management IP Address . ASDM automatically detects the IP address for the SSM in the ASA. If this detection fails, you can specify the management IP address manually.

 
       		 [bookmark: pgfId-1118870]To connect to an alternate IP address or hostname on the SSM, click  Other IP Address or Hostname .

 
      

 
     

 
     [bookmark: pgfId-1118871]Step 3 Enter the port number in the Port field, and then click Continue.

 
     [bookmark: pgfId-1118872]Step 4 In the CSC Password field, type your CSC password, and then click OK. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1118873]Note If you have not completed the CSC Setup Wizard (choose Configuration > Trend Micro Content Security > CSC Setup > Wizard Setup), complete the configuration in the CSC Setup Wizard, which includes changing the default password, “cisco.” 

For ten minutes after you have entered the password, you do not need to reenter the CSC SSM password to access other parts of the CSC SSM GUI. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1118883]Step 5 To access the CSC SSM GUI, choose Configuration > Trend Micro Content Security, and then click one of the following tabs: Web, Mail, File Transfer, or Updates.

 
     [bookmark: pgfId-1118884]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1356840]What to Do Next

 
     [bookmark: pgfId-1356844]See the “Determining Service Policy Rule Actions for CSC Scanning” section.

 
    
 
     
      [bookmark: pgfId-1356847][bookmark: 46497]Determining Service Policy Rule Actions for CSC Scanning

 
     [bookmark: pgfId-1356851]The CSC SSM scans only HTTP/HTTPS, SMTP, POP3, and FTP traffic. If your service policy includes traffic that supports other protocols in addition to these four, packets for other protocols are passed through the CSC SSM without being scanned. You should configure the service policy rules that send packets to the CSC SSM to support only HTTP/HTTPS, SMTP, POP3, or FTP traffic.

 
     [bookmark: pgfId-1356858]The CSC Scan tab in the Add Service Policy Rule Wizard lets you determine whether or not the CSC SSM scans traffic identified by the current traffic class. This tab appears only if a CSC SSM is installed in the ASA. 

 
     [bookmark: pgfId-1356868]To configure service policy rules for CSC scanning, perform the following steps:

 
     
 
     [bookmark: pgfId-1356869]Step 1 In the ASDM main application window, choose Configuration > Firewall > Service Policy Rules.

 
     [bookmark: pgfId-1356870]Step 2 On the toolbar, click Add. 

 
     [bookmark: pgfId-1356871]The Add Service Policy Rule Wizard screen appears.

 
     [bookmark: pgfId-1356872]Step 3 Click the Global - applies to all interfaces option, and then click Next.

 
     [bookmark: pgfId-1356873]The Traffic Classification Criteria screen appears.

 
     [bookmark: pgfId-1356874]Step 4 Click the Create a new traffic class option, type a name for the traffic class in the adjacent field, check the Any traffic check box, and then click Next.

 
     [bookmark: pgfId-1356875]The Rule Actions screen appears.

 
     [bookmark: pgfId-1356876]Step 5 Click the CSC Scan tab, and then check the Enable CSC scan for this traffic flow check box.

 
     [bookmark: pgfId-1356882]Step 6 Choose whether the ASA should permit or deny selected traffic to pass if the CSC SSM is unavailable by making the applicable selection in the area labeled: If CSC card fails, then. When this check box is checked, the other parameters on this tab become active.

 
     [bookmark: pgfId-1356887]Step 7 In the If CSC card fails area, if the CSC SSM becomes inoperable, choose one of the following actions:

 
      
       
       		 [bookmark: pgfId-1356888]To allow traffic, check the  Permit traffic check box.

 
       		 [bookmark: pgfId-1356889]To block traffic, check the  Close traffic check box.

 
      

 
     

 
     [bookmark: pgfId-1356890]Step 8 Click Finish.

 
     [bookmark: pgfId-1356891]The new service policy rule appears in the Service Policy Rules pane.

 
     [bookmark: pgfId-1356892]Step 9 Click Apply.

 
     [bookmark: pgfId-1356899]The ASA begins diverting traffic to the CSC SSM, which performs the content security scans that have been enabled according to the license that you purchased.

 
     [bookmark: pgfId-1356900]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1356905][bookmark: 62190]CSC SSM Setup Wizard

 
    [bookmark: pgfId-1356909]The CSC Setup Wizard lets you configure basic operational parameters for the CSC SSM. You must complete this wizard at least once before you can configure options in each screen separately. After you complete the CSC Setup Wizard, you can modify each screen individually without using this wizard again.

 
    [bookmark: pgfId-1356911]Additionally, you cannot access the panes under Configuration > Trend Micro Content Security > CSC Setup or under Monitoring > Trend Micro Content Security > Content Security until you complete the CSC Setup Wizard. If you try to access these panes before completing this wizard, a dialog box appears and lets you access the wizard directly to complete the configuration.

 
    [bookmark: pgfId-1356912]To start the CSC Setup Wizard, click Launch Setup Wizard. 

 
    [bookmark: pgfId-1356913]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1356917]Activation/License

 
     		 [bookmark: pgfId-1356921]IP Configuration

 
     		 [bookmark: pgfId-1356925]Host/Notification Settings

 
     		 [bookmark: pgfId-1356929]Management Access Host/Networks

 
     		 [bookmark: pgfId-1356933]Password

 
     		 [bookmark: pgfId-1356937]Restoring the Default Password

 
     		 [bookmark: pgfId-1356941]Wizard Setup

 
    

 
     
      [bookmark: pgfId-1356945][bookmark: 56570]Activation/Licen[bookmark: marker-1356943]se

 
     [bookmark: pgfId-1356946]The Activation/License pane lets you review or renew activation codes for the CSC SSM Basic License and the Plus License.

 
     [bookmark: pgfId-1356950]You can use ASDM to configure CSC licenses only once each for the two licenses. Renewed license activation codes are downloaded automatically with scheduled software updates. Links to the licensing status pane and the CSC UI home pane appear at the bottom of this window. The serial number for the assigned license is filled in automatically.

 
     [bookmark: pgfId-1356951]To review license status or renew a license, perform the following steps:

 
     
 
     [bookmark: pgfId-1356952]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Activation/License.

 
     [bookmark: pgfId-1356953]Step 2 The Activation/License pane shows the following display-only information for the Basic License and the Plus License:

 
      
       
       		 [bookmark: pgfId-1356954]The name of the component. 

 
       		 [bookmark: pgfId-1356955]The activation code for the corresponding Product field.

 
       		 [bookmark: pgfId-1356956]The status of the license. If the license is valid, the expiration date appears. If the expiration date has passed, this field indicates that the license has expired.

 
       		 [bookmark: pgfId-1356957]The maximum number of network devices that the Basic License supports. The Plus License does not affect the number of network devices supported; therefore, the Nodes field does not appear in the Plus License area. The Basic License includes anti-virus, anti-spyware, and file blocking. The Plus License includes anti-spam, anti-phishing, content filtering, URL blocking and filtering, and web reputation.

 
      

 
     

 
     [bookmark: pgfId-1356958]Step 3 To review license status or renew your license, click the link provided.

 
     [bookmark: pgfId-1356959]Step 4 To go to the CSC home pane in ASDM, click the link provided.

 
     [bookmark: pgfId-1356960]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1356961]What to Do Next

 
     [bookmark: pgfId-1356965]See the “IP Configuration” section.

 
    
 
     
      [bookmark: pgfId-1356969][bookmark: 52560]IP Conf[bookmark: marker-1356967]iguration

 
     [bookmark: pgfId-1356973]The IP Configuration pane lets you configure management access for the CSC SSM, the DNS servers it should use, and a proxy server for retrieving CSC SSM software updates.

 
     [bookmark: pgfId-1356977]To configure management access and other related details for the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1356978]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > IP Configuration.

 
     [bookmark: pgfId-1356982]Step 2 Set the following parameters for management access to the CSC SSM:

 
      
       
       		 [bookmark: pgfId-1356986]Enter the IP address for management access to the CSC SSM.

 
       		 [bookmark: pgfId-1356990]Enters the netmask for the network containing the management IP address of the CSC SSM.

 
       		 [bookmark: pgfId-1356991]Enter the IP address of the gateway device for the network that includes the management IP address of the CSC SSM.

 
      

 
     

 
     [bookmark: pgfId-1356995]Step 3 Set parameters of the DNS servers for the network that includes the management IP address of the CSC SSM.

 
      
       
       		 [bookmark: pgfId-1356999]Enter the IP address of the primary DNS server.

 
       		 [bookmark: pgfId-1357000](Optional) Enter the IP address of the secondary DNS server, if configured.

 
      

 
     

 
     [bookmark: pgfId-1357004]Step 4 (Optional) Enter parameters for an HTTP proxy server, used by the CSC SSM to contact a CSC SSM software update server. If your network configuration does not require the CSC SSM to use a proxy server, leave the fields in this group blank.

 
      
       
       		 [bookmark: pgfId-1357011]Enter the IP address of the proxy server, if configured.

 
       		 [bookmark: pgfId-1357012]Enter the listening port of the proxy server, if configured.

 
      

 
     

 
     [bookmark: pgfId-1357013]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357014]What to Do Next

 
     [bookmark: pgfId-1357018]See the “Host/Notification Settings” section.

 
    
 
     
      [bookmark: pgfId-1357022][bookmark: 88394]Host/Notification [bookmark: marker-1357020]Settings

 
     [bookmark: pgfId-1357023]The Host/Notification Settings pane lets you configure details about hostname, domain name, e-mail notifications, and a domain name for e-mail to be excluded from detailed scanning.

 
     [bookmark: pgfId-1357024]To configure host and notification settings, perform the following steps:

 
     
 
     [bookmark: pgfId-1357025]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Host/Notification Settings.

 
     [bookmark: pgfId-1357026]Step 2 In the Host and Domain Names area, set the hostname and domain name of the CSC SSM.

 
     [bookmark: pgfId-1357030]Step 3 In the Incoming E-mail Domain Name area, set the trusted incoming e-mail domain name for SMTP-based e-mail. The CSC SSM scans SMTP e-mail sent to this domain. The types of threats that the CSC SSM scans for depend on the license that you purchased for the CSC SSM and the configuration of the CSC SSM software.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357049]Note CSC SSM lets you configure a list of many incoming e-mail domains. ASDM displays only the first domain in the list. To configure additional incoming e-mail domains, access the CSC SSM interface. To do so, choose Configuration > Trend Micro Content Security > CSC Setup > Mail, and then click one of the links. After logging in to the CSC SSM, choose Mail (SMTP) > Configuration, and then click the Incoming Mail tab.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357056]Step 4 Configure the following settings for e-mail notification of events:

 
      
       
       		 [bookmark: pgfId-1357057]The administrator e-mail address for the account to which notification e-mails should be sent.

 
       		 [bookmark: pgfId-1357058]The IP address of the SMTP server.

 
       		 [bookmark: pgfId-1357059]The port to which the SMTP server listens.

 
       		 [bookmark: pgfId-1357060]The e-mail address(es) for the product license renewal to which notification e-mails should be sent. Separate multiple e-mail addresses with semicolons. The maximum number of characters allowed for e-mail addresses is 1024. Make sure that the specified e-mail addresses are valid.

 
      

 
     

 
     [bookmark: pgfId-1357061]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357062]What to Do Next

 
     [bookmark: pgfId-1357066]See the “Management Access Host/Networks” section.

 
    
 
     
      [bookmark: pgfId-1357070][bookmark: 19895]Management Access Host/[bookmark: marker-1357068]Networks

 
     [bookmark: pgfId-1357071]The Management Access Host/Networks pane lets you specify the hosts and networks for which management access to the CSC SSM is permitted. You must specify at least one permitted host or network, up to a maximum of eight permitted hosts or networks.

 
     [bookmark: pgfId-1357075]To specify hosts and networks for which management access to the CSC SSM is allowed, perform the following steps:

 
     
 
     [bookmark: pgfId-1357076]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Management Access Host/Networks.

 
     [bookmark: pgfId-1357077]Step 2 Enter the IP address of a host or network that you want to add to the Selected Hosts/Network list.

 
     [bookmark: pgfId-1357078]Step 3 Enter the netmask for the host or network that you specified in the IP Address field. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357079]Note To allow all hosts and networks, enter 0.0.0.0 in the IP Address field, and choose 0.0.0.0 from the Mask list.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357080]The Selected Hosts/Networks list displays the hosts or networks trusted for management access to the CSC SSM. 

 
     [bookmark: pgfId-1357084]Step 4 To add the host or network that you specified in the IP Address field in the Selected Hosts/Networks list, click Add.

 
     [bookmark: pgfId-1357085]The Selected Hosts/Networks table lists the IP addresses of networks and hosts whose connection to the CSC SSM you have added.

 
     [bookmark: pgfId-1357086]Step 5 To remove a host or network from the Selected Hosts/Networks list, choose an entry from the list and click Delete.

 
     [bookmark: pgfId-1357087]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357088]What to Do Next

 
     [bookmark: pgfId-1357092]See the “Password” section.

 
    
 
     
      [bookmark: pgfId-1357096][bookmark: 19415]Pass[bookmark: marker-1357094]word

 
     [bookmark: pgfId-1357100]The Password pane lets you change the password required for management access to the CSC SSM. The CSC SSM has a password that is maintained separately from the ASDM password. You can configure them to be identical; however, changing the CSC SSM password does not affect the ASDM password.

 
     [bookmark: pgfId-1357122]If ASDM is connected to the CSC SSM and you change the CSC SSM password, the connection to the CSC SSM is dropped. As a result, ASDM displays a confirmation dialog box that you must respond to before the password is changed.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357132]Tip Whenever the connection to the CSC SSM is dropped, you can reestablish it. To do so, click the Connection to Device icon on the status bar to display the Connection to Device dialog box, and then click Reconnect. ASDM prompts you for the CSC SSM password, which is the new password that you have defined.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357139]Passwords must be 5 - 32 characters long.

 
     [bookmark: pgfId-1357140]Passwords appears as asterisks when you type them.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357141]Note The default password is “cisco.”

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357145]To change the password required for management access to the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1357146]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Password.

 
     [bookmark: pgfId-1357147]Step 2 In the Old Password field, enter the current password for management access to the CSC SSM.

 
     [bookmark: pgfId-1357151]Step 3 In the New Password field, enter the new password for management access to the CSC SSM.

 
     [bookmark: pgfId-1357155]Step 4 In the Confirm New Password field, reenter the new password for management access to the CSC SSM.

 
     [bookmark: pgfId-1357159]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357160]What to Do Next

 
     [bookmark: pgfId-1357164]If required, see the “Restoring the Default Password” section.

 
     [bookmark: pgfId-1357168]See the “Wizard Setup” section.

 
    
 
     
      [bookmark: pgfId-1357170][bookmark: 51850]Restoring the Default Password

 
     [bookmark: pgfId-1357171]You can use ASDM to reset the CSC SSM password. You can reset this password to the default value, which is “cisco” (excluding quotation marks). If the CSC password-reset policy has been set to “Denied,” then you cannot reset the password through the ASDM CLI. To change this policy, you must access the CSC SSM through the ASA CLI by entering the session command. For more information, see the Cisco Content Security and Control SSM Administrator Guide.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357178]Note This option does not appear in the menu if an SSM is not installed.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357179]To reset the CSC SSM password to the default value, perform the following steps:

 
     
 
     [bookmark: pgfId-1357180]Step 1 Choose Tools > CSC Password Reset.

 
     [bookmark: pgfId-1357181]The CSC Password Reset confirmation dialog box appears.

 
     [bookmark: pgfId-1357182]Step 2 Click OK to reset the CSC SSM password to the default value.

 
     [bookmark: pgfId-1357183]A dialog box appears, indicating the success or failure of the password reset. If the password was not reset, make sure you are using Version 8.0(2) software on the ASA and the most recent Version 6.1.x software on the CSC SSM.

 
     [bookmark: pgfId-1357187]Step 3 Click Close to close the dialog box.

 
     [bookmark: pgfId-1357188]Step 4 After you have reset the password, you should change it to a unique value.

 
     [bookmark: pgfId-1357189]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357190]What to Do Next

 
     [bookmark: pgfId-1357194]See the “Password” section.

 
    
 
     
      [bookmark: pgfId-1357198][bookmark: 12797]Wizard [bookmark: marker-1357196]Setup

 
     [bookmark: pgfId-1357199]The Wizard Setup screen lets you start the CSC Setup Wizard. To start the CSC Setup Wizard, click Launch Setup Wizard. To access the Wizard Setup screen, choose Configuration > Trend Micro Content Security > CSC Setup > Wizard Setup.

 
     [bookmark: pgfId-1357200]Before you can directly access any of the other screens under CSC Setup, you must complete the CSC Setup Wizard. This wizard includes the following screens:

 
      
      		 [bookmark: pgfId-1357204]CSC Setup Wizard Activation Codes Configuration

 
      		 [bookmark: pgfId-1357208]CSC Setup Wizard IP Configuration

 
      		 [bookmark: pgfId-1357212]CSC Setup Wizard Host Configuration

 
      		 [bookmark: pgfId-1357216]CSC Setup Wizard Management Access Configuration

 
      		 [bookmark: pgfId-1357220]CSC Setup Wizard Password Configuration

 
      		 [bookmark: pgfId-1357224]CSC Setup Wizard Traffic Selection for CSC Scan

 
      		 [bookmark: pgfId-1357228]CSC Setup Wizard Summary

 
     

 
     [bookmark: pgfId-1357229]After you complete the CSC Setup Wizard once, you can change any settings in screens related to the CSC SSM without using the CSC Setup Wizard again.

 
    
 
     
      [bookmark: pgfId-1357234][bookmark: 29214]CSC Setup Wizard Activation Codes Configuration

 
     [bookmark: pgfId-1357236]To display the activation codes that you have entered to enable features on the CSC SSM, perform the following steps: [bookmark: marker-1357237]

 
     [bookmark: pgfId-1357238]Choose Configuration > Trend Micro Content Security > CSC Setup > Activation/License.

 
     [bookmark: pgfId-1357239]The activation code settings that you have made appear on this screen, according to the type of license you have, as follows:

 
      
      		 [bookmark: pgfId-1357240]The activation code for the Basic License appears. The Basic License includes anti-virus, anti-spyware, and file blocking.

 
      		 [bookmark: pgfId-1357241]The activation code for the Plus License appears, if you have entered one. If not, this field is blank. The Plus License includes anti-spam, anti-phishing, content filtering, URL blocking and filtering, and web reputation.

 
     

 
    
 
     
      [bookmark: pgfId-1357242]What to Do Next

 
     [bookmark: pgfId-1357246]See the “CSC Setup Wizard IP Configuration” section.

 
    
 
     
      [bookmark: pgfId-1357248][bookmark: 60186]CSC Setup Wizard IP Configuration

 
     [bookmark: pgfId-1357250][bookmark: marker-1357249]To display the IP configuration settings that you have entered for the CSC SSM, perform the following steps:

 
     [bookmark: pgfId-1357252]Choose Configuration > Trend Micro Content Security > CSC Setup > IP Configuration.

 
     [bookmark: pgfId-1357253]The IP configuration settings that you have entered for the CSC SSM appear, including the following:

 
      
      		 [bookmark: pgfId-1357257]The IP address for the management interface of the CSC SSM.

 
      		 [bookmark: pgfId-1357258]The network mask for the management interface of the CSC SSM that you have selected from the drop-down list.

 
      		 [bookmark: pgfId-1357262]The IP address of the gateway device for the network that contains the CSC SSM management interface.

 
      		 [bookmark: pgfId-1357263]The primary DNS server IP address.

 
      		 [bookmark: pgfId-1357264]The secondary DNS server IP address (if configured).

 
      		 [bookmark: pgfId-1357265]The proxy server (if configured).

 
      		 [bookmark: pgfId-1357266]The proxy port (if configured).

 
     

 
    
 
     
      [bookmark: pgfId-1357267]What to Do Next

 
     [bookmark: pgfId-1357271]See the “CSC Setup Wizard Host Configuration” section.

 
    
 
     
      [bookmark: pgfId-1357273][bookmark: 32039]CSC Setup Wizard Host Configuration 

 
     [bookmark: pgfId-1357275][bookmark: marker-1357274]To display the host configuration settings that you have entered for the CSC SSM, perform the following steps:

 
     [bookmark: pgfId-1357277]Choose Configuration > Trend Micro Content Security > CSC Setup > Host Configuration.

 
     [bookmark: pgfId-1357278]The host configuration settings that you have entered for the CSC SSM appear, including the following:

 
      
      		 [bookmark: pgfId-1357282]The hostname of the CSC SSM.

 
      		 [bookmark: pgfId-1357283]The name of the domain in which the CSC SSM resides.

 
      		 [bookmark: pgfId-1357284]The domain name for incoming e-mail.

 
      		 [bookmark: pgfId-1357285]The e-mail address of the domain administrator.

 
       
       		 [bookmark: pgfId-1357286]The IP address of the SMTP server.

 
       		 [bookmark: pgfId-1357287]The port to which the SMTP server listens.

 
      

 
      		 [bookmark: pgfId-1357288]The e-mail address(es) for the product license renewal notification.

 
     

 
    
 
     
      [bookmark: pgfId-1357289]What to Do Next

 
     [bookmark: pgfId-1357293]See the “CSC Setup Wizard Management Access Configuration” section.

 
    
 
     
      [bookmark: pgfId-1357295][bookmark: 43784]CSC Setup Wizard Management Access Configuration

 
     [bookmark: pgfId-1357297][bookmark: marker-1357296]To display the subnet and host settings that you have entered to grant access to the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1357299]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Management Access Configuration.

 
     [bookmark: pgfId-1357300]The management access configuration settings that you have entered for the CSC SSM appear, including the following:

 
      
       
       		 [bookmark: pgfId-1357304]The IP address for networks and hosts that are allowed to connect to the CSC SSM.

 
       		 [bookmark: pgfId-1357305]The network mask for networks and hosts that are allowed to connect to the CSC SSM that you have selected from the drop-down list.

 
      

 
     

 
     [bookmark: pgfId-1357306]Step 2 To add the IP address of the networks and hosts that you want to allow to connect to the CSC SSM, click Add.

 
     [bookmark: pgfId-1357307]Step 3 To remove the IP address of a network or host whose ability to connect to the CSC SSM you no longer want, click Delete.

 
     [bookmark: pgfId-1357308]The Selected Hosts/Networks table lists the IP addresses of networks and hosts whose connection to the CSC SSM you have added.

 
     [bookmark: pgfId-1357309]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357310]What to Do Next

 
     [bookmark: pgfId-1357314]See the “CSC Setup Wizard Password Configuration” section.

 
    
 
     
      [bookmark: pgfId-1357316][bookmark: 54896]CSC Setup Wizard Password Configuration

 
     [bookmark: pgfId-1357322][bookmark: marker-1357317]To change the password required for management access to the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1357323]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Password.

 
     [bookmark: pgfId-1357324]Step 2 In the Old Password field, enter the current password for management access to the CSC SSM.

 
     [bookmark: pgfId-1357328]Step 3 In the New Password field, enter the new password for management access to the CSC SSM.

 
     [bookmark: pgfId-1357332]Step 4 In the Confirm New Password field, reenter the new password for management access to the CSC SSM.

 
     [bookmark: pgfId-1357336]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357337]What to Do Next

 
     [bookmark: pgfId-1357341]See the “CSC Setup Wizard Traffic Selection for CSC Scan” section.

 
    
 
     
      [bookmark: pgfId-1357343][bookmark: 83507]CSC Setup Wizard Traffic Selection for CSC Scan

 
     [bookmark: pgfId-1357345][bookmark: marker-1357344]To display the settings that you have made to select traffic for CSC scanning, perform the following steps:

 
     
 
     [bookmark: pgfId-1357347]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Traffic Selection for CSC Scan.

 
     [bookmark: pgfId-1357348]The traffic selection for CSC scanning configuration settings that you have entered for the CSC SSM appear, including the following:

 
      
       
       		 [bookmark: pgfId-1357349]The interface to the CSC SSM that you have chosen from the drop-down list. 

 
       		 [bookmark: pgfId-1357350]The source of network traffic for the CSC SSM to scan.

 
       		 [bookmark: pgfId-1357351]The destination of network traffic for the CSC SSM to scan.

 
       		 [bookmark: pgfId-1357352]The source or destination service for the CSC SSM to scan.

 
      

 
     

 
     [bookmark: pgfId-1357353]Step 2 Do one of the following:

 
      
       
       		 [bookmark: pgfId-1357354]To specify additional traffic details for CSC scanning, click  Add . For more information, see “Specifying Traffic for CSC Scanning” section.

 
       		 [bookmark: pgfId-1357358]To modify additional traffic details for CSC scanning, click  Edit . For more information, see “Specifying Traffic for CSC Scanning” section.

 
       		 [bookmark: pgfId-1357362]To remove additional traffic details for CSC scanning, click  Delete .

 
      

 
     

 
     [bookmark: pgfId-1357363]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357365][bookmark: 58077]Specifying Traffic for CSC Scanning

 
     [bookmark: pgfId-1357367][bookmark: marker-1357366]To define, modify, or remove additional settings for selecting traffic for CSC scanning, perform the following steps:

 
     
 
     [bookmark: pgfId-1357369]Step 1 In the Traffic Selection for CSC Scan screen, click Specify traffic for CSC Scan.

 
     [bookmark: pgfId-1357370]The Specify traffic for CSC Scan dialog box appears.

 
     [bookmark: pgfId-1357371]Step 2 Choose the type of interface to the CSC SSM from the drop-down list. Available settings are global (all interfaces), inside, management, and outside.

 
     [bookmark: pgfId-1357372]Step 3 Choose the source of network traffic for the CSC SSM to scan from the drop-down list.

 
     [bookmark: pgfId-1357373]Step 4 Choose the destination of network traffic for the CSC SSM to scan from the drop-down list.

 
     [bookmark: pgfId-1357374]Step 5 Choose the type of service for the CSC SSM to scan from the drop-down list.

 
     [bookmark: pgfId-1357375]Step 6 Enter a description for the network traffic that you define for the CSC SSM to scan.

 
     [bookmark: pgfId-1357376]Step 7 Specify whether or not to allow the CSC SSM to scan network traffic if the CSC card fails. Choose one of the following options:

 
      
       
       		 [bookmark: pgfId-1357377]To allow traffic through without being scanned, click  Permit . 

 
       		 [bookmark: pgfId-1357378]To prevent traffic from going through without being scanned, click  Close . 

 
      

 
     

 
     [bookmark: pgfId-1357379]Step 8 Click OK to save your settings. 

 
     [bookmark: pgfId-1357380]The added traffic details appear on the CSC Setup Wizard Traffic selection for CSC Scan screen. 

 
     [bookmark: pgfId-1357381]Step 9 Click Cancel to discard these settings and return to the CSC Setup Wizard Traffic selection for CSC Scan screen. If you click Cancel, ASDM displays a dialog box to confirm your decision.

 
     [bookmark: pgfId-1357385]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357386]What to Do Next

 
     [bookmark: pgfId-1357390]See the “CSC Setup Wizard Summary” section.

 
    
 
     
      [bookmark: pgfId-1357394][bookmark: 97344]CSC Setup Wizard Sum[bookmark: marker-1357392]mary

 
     [bookmark: pgfId-1357395]To review the settings that you have made with the CSC Setup Wizard, perform the following steps:

 
     
 
     [bookmark: pgfId-1357396]Step 1 Choose Configuration > Trend Micro Content Security > CSC Setup > Summary.

 
     [bookmark: pgfId-1357397]The CSC Setup Wizard Summary screen shows the following display-only settings:

 
      
       
       		 [bookmark: pgfId-1357398]The settings that you made in the Activation Codes Configuration screen, including the Base License activation code and the Plus License activation code, if you entered one. If not, this field is blank.

 
       		 [bookmark: pgfId-1357399]The settings that you made in the IP Configuration screen, including the following information:

 
      

 
     

 
     [bookmark: pgfId-1357403] – IP address and netmask for the management interface of the CSC SSM.

 
     [bookmark: pgfId-1357407] – IP address of the gateway device for the network that includes the CSC SSM management interface.

 
     [bookmark: pgfId-1357408] – Primary DNS server IP address.

 
     [bookmark: pgfId-1357409] – Secondary DNS server IP address (if configured).

 
     [bookmark: pgfId-1357410] – Proxy server and port (if configured).

 
      
       
       		 [bookmark: pgfId-1357411]The settings that you made in the Host Configuration screen, including the following information:

 
      

 
     

 
     [bookmark: pgfId-1357415] – Hostname of the CSC SSM.

 
     [bookmark: pgfId-1357419] – Domain name for the domain that includes the CSC SSM.

 
     [bookmark: pgfId-1357420] – Domain name for incoming e-mail.

 
     [bookmark: pgfId-1357421] – Administrator e-mail address.

 
     [bookmark: pgfId-1357422] – E-mail server IP address and port number.

 
     [bookmark: pgfId-1357423] – E-mail address(es) for product licensing renewal notifications.

 
      
       
       		 [bookmark: pgfId-1357424]The settings that you made in the Management Access Configuration screen. The drop-down list includes the hosts and networks from which the CSC SSM allows management connections.

 
       		 [bookmark: pgfId-1357428]Indicates whether or not you have changed the password in the Password Configuration screen.

 
      

 
     

 
     [bookmark: pgfId-1357429]Step 2 (Optional) Click Back to return to the previous screens of the CSC Setup Wizard to change any settings.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357430]Note The Next button is dimmed; however, if you click Back to access any of the preceding screens in this wizard, click Next to return to the Summary screen.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357431]Step 3 Click Finish to complete the CSC Setup Wizard and save all settings that you have specified. After you click Finish, you can change any settings related to the CSC SSM without using the CSC Setup Wizard again.

 
     [bookmark: pgfId-1357435]A summary of the status of commands that were sent to the device appears. 

 
     [bookmark: pgfId-1357436]Step 4 Click Close to close this screen, and then click Next.

 
     [bookmark: pgfId-1357437]A message appears indicating that the CSC SSM has been activated and is ready for use.

 
     [bookmark: pgfId-1357438]Step 5 (Optional) Click Cancel to exit the CSC Setup Wizard without saving any of the selected settings. If you click Cancel, a dialog box appears to confirm your decision.

 
     [bookmark: pgfId-1357439]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357440]What to Do Next

 
     [bookmark: pgfId-1357444]See the “Using the CSC SSM GUI” section.

 
    
 
   
 
    
     [bookmark: pgfId-1357447][bookmark: 28849]Using the CSC SSM GUI[bookmark: marker-1357446]

 
    [bookmark: pgfId-1357448]This section describes how to configure features using the CSC SSM GUI, and includes the following topics:

 
     
     		 [bookmark: pgfId-1357452]Web

 
     		 [bookmark: pgfId-1357456]Mail

 
     		 [bookmark: pgfId-1357460]SMTP Tab

 
     		 [bookmark: pgfId-1357464]POP3 Tab

 
     		 [bookmark: pgfId-1357468]File Transfer

 
     		 [bookmark: pgfId-1357472]Updates

 
    

 
     
      [bookmark: pgfId-1357476][bookmark: 87801]We[bookmark: marker-1357474]b

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357483]Note To access the CSC SSM, you must reenter the CSC SSM password. Sessions in the CSC SSM browser time out after ten minutes of inactivity. If you close the CSC SSM browser and click another link in ASDM, you are not prompted for the CSC SSM password again, because one session is already open.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357496]To view whether or not web-related features are enabled and access the CSC SSM GUI for configuring these features, perform the following steps:

 
     
 
     [bookmark: pgfId-1357497]Step 1 Choose Configuration > Trend Micro Content Security > Web.

 
     [bookmark: pgfId-1357498]The URL Blocking and Filtering area is display-only and shows whether or not URL blocking is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357502]Step 2 Click Configure URL Blocking to open a screen for configuring URL blocking on the CSC SSM.

 
     [bookmark: pgfId-1357508]The URL Filtering area is display-only and shows whether or not URL filtering is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357510]Step 3 Click Configure URL Filtering to open a screen for configuring URL filtering rules on the CSC SSM.

 
     [bookmark: pgfId-1357514]The File Blocking area is display-only and shows whether or not URL file blocking is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357518]Step 4 Click Configure File Blocking to open a screen for configuring file blocking settings on the CSC SSM.

 
     [bookmark: pgfId-1357522]The HTTP Scanning area is display-only and shows whether or not HTTP scanning is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357526]Step 5 Click Configure Web Scanning to open a screen for configuring HTTP scanning settings on the CSC SSM.

 
     [bookmark: pgfId-1357530]The Web Reputation area is display-only and shows whether or not the Web Reputation service is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357534]Step 6 Click Configure Web Reputation to open a screen for configuring the Web Reputation service on the CSC SSM.

 
     [bookmark: pgfId-1357538]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357539]What to Do Next

 
     [bookmark: pgfId-1357543]See the “Mail” section.

 
    
 
     
      [bookmark: pgfId-1357547][bookmark: 82300]M[bookmark: marker-1357545]ail

 
     [bookmark: pgfId-1357548]The Mail pane lets you see whether or not e-mail-related features are enabled and lets you access the CSC SSM GUI to configure these features. To configure e-mail related features, choose Configuration > Trend Micro Content Security > Mail.

 
     [bookmark: pgfId-1357552]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1357556]SMTP Tab

 
      		 [bookmark: pgfId-1357560]POP3 Tab

 
     

 
    
 
     
      [bookmark: pgfId-1357563][bookmark: 77993]SMTP Tab

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357570]Note To access the CSC SSM, you must reenter the CSC SSM password. Sessions in the CSC SSM browser time out after ten minutes of inactivity. If you close the CSC SSM browser and click another link in ASDM, you are not prompted for the CSC SSM password again, because one session is already open.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357580]To configure SMTP scanning, perform the following steps:

 
     
 
     [bookmark: pgfId-1357581]Step 1 Click the SMTP Tab. 

 
     [bookmark: pgfId-1357582]Step 2 The Incoming Scan area is display-only and shows whether or not the incoming SMTP scanning feature is enabled on the CSC SSM. Click Configure Incoming Scan to open a screen for configuring incoming SMTP scan settings on the CSC SSM.

 
     [bookmark: pgfId-1357589]Step 3 The Outgoing Scan area is display-only and shows whether or not the outgoing SMTP scanning feature is enabled on the CSC SSM. Click Configure Outgoing Scan to open a screen for configuring outgoing SMTP scan settings on the CSC SSM.

 
     [bookmark: pgfId-1357596]Step 4 The Incoming Filtering area is display-only and shows whether or not content filtering for incoming SMTP e-mail is enabled on the CSC SSM. Click Configure Incoming Filtering to open a screen for configuring incoming SMTP e-mail content filtering settings on the CSC SSM.

 
     [bookmark: pgfId-1357603]Step 5 The Outgoing Filtering area is display-only and shows whether or not content filtering for outgoing SMTP e-mail is enabled on the CSC SSM. Click Configure Outgoing Filtering to open a screen for configuring outgoing SMTP e-mail content filtering settings on the CSC SSM.

 
     [bookmark: pgfId-1357610]Step 6 The Anti-spam area is display-only and shows whether or not the SMTP anti-spam feature is enabled on the CSC SSM. Click Configure Anti-spam to open a screen for configuring SMTP anti-spam settings, including E-mail Reputation, on the CSC SSM.

 
     [bookmark: pgfId-1357617]Step 7 The Global Approved List area is display-only and shows whether or not the SMTP global approved list feature is enabled on the CSC SSM. Click Configure Global Approved List to open a screen for configuring SMTP global approved list settings on the CSC SSM.

 
     [bookmark: pgfId-1357624]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357627][bookmark: 34723]POP3 Tab

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357634]Note To access the CSC SSM, you must reenter the CSC SSM password. Sessions in the CSC SSM browser time out after ten minutes of inactivity. If you close the CSC SSM browser and click another link in ASDM, you are not prompted for the CSC SSM password again, because one session is already open.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357644]To configure POP3 scanning, perform the following steps:

 
     
 
     [bookmark: pgfId-1357645]Step 1 Click the POP3 Tab. 

 
     [bookmark: pgfId-1357646]Step 2 The Scanning area is display-only and shows whether or not POP3 e-mail scanning is enabled on the CSC SSM. Click Configure Scanning to open a window for configuring POP3 e-mail scanning on the CSC SSM.

 
     [bookmark: pgfId-1357653]Step 3 The Anti-spam area is display-only and shows whether or not the POP3 anti-spam feature is enabled on the CSC SSM. Click Configure Anti-spam to open a window for configuring the POP3 anti-spam feature on the CSC SSM.

 
     [bookmark: pgfId-1357660]Step 4 The Content Filtering area is display-only and shows whether or not POP3 e-mail content filtering is enabled on the CSC SSM. Click Configure Content Filtering to open a window for configuring POP3 e-mail content filtering on the CSC SSM.

 
     [bookmark: pgfId-1357667]Step 5 The Global Approved List area is display-only and shows whether or not the POP3 global approved list feature is enabled on the CSC SSM. Click Configure Global Approved List to open a screen for configuring POP3 global approved list settings on the CSC SSM.

 
     [bookmark: pgfId-1357674]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357675]What to Do Next

 
     [bookmark: pgfId-1357679]See the “File Transfer” section.

 
    
 
     
      [bookmark: pgfId-1357683][bookmark: 42131]File [bookmark: marker-1357681]Transfer

 
     [bookmark: pgfId-1357684]The File Transfer pane lets you view whether or not FTP-related features are enabled and lets you access the CSC SSM for configuring FTP-related features.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357694]Note To access the CSC SSM, you must reenter the CSC SSM password. Sessions in the CSC SSM browser time out after ten minutes of inactivity. If you close the CSC SSM browser and click another link in ASDM, you are not prompted for the CSC SSM password again, because one session is already open.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357704]To view the status or configure FTP-related features, perform the following steps:

 
     
 
     [bookmark: pgfId-1357705]Step 1 Click the File Transfer tab.

 
     [bookmark: pgfId-1357706]The File Scanning area is display-only and shows whether or not FTP file scanning is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357710]Step 2 Click Configure File Scanning to open a window for configuring FTP file scanning settings on the CSC SSM.

 
     [bookmark: pgfId-1357716]The File Blocking area is display-only and shows whether or not FTP blocking is enabled on the CSC SSM.

 
     [bookmark: pgfId-1357718]Step 3 Click Configure File Blocking to open a window for configuring FTP file blocking settings on the CSC SSM.

 
     [bookmark: pgfId-1357722]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357723]What to Do Next

 
     [bookmark: pgfId-1357727]See the “Updates” section.

 
    
 
     
      [bookmark: pgfId-1357731][bookmark: 23738]Upd[bookmark: marker-1357729]ates

 
     [bookmark: pgfId-1357732]The Updates pane lets you view whether or not scheduled updates are enabled and lets you access the CSC SSM for configuring scheduled updates.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357742]Note To access the CSC SSM, you must reenter the CSC SSM password. Sessions in the CSC SSM browser time out after ten minutes of inactivity. If you close the CSC SSM browser and click another link in ASDM, you are not prompted for the CSC SSM password again, because one session is already open.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1357752]To view the status or configure scheduled update settings, perform the following steps:

 
     
 
     [bookmark: pgfId-1357753]Step 1 Click the Updates tab.

 
     [bookmark: pgfId-1357754]The Scheduled Updates area is display-only and shows whether or not scheduled updates are enabled on the CSC SSM.

 
     [bookmark: pgfId-1357758]The Scheduled Update Frequency area displays information about when updates are scheduled to occur, such as “Hourly at 10 minutes past the hour.”

 
     [bookmark: pgfId-1357762]The Component area displays names of parts of the CSC SSM software that can be updated.

 
     [bookmark: pgfId-1357763]In the Components area, the Scheduled Updates area is display-only and shows whether or not scheduled updates are enabled for the corresponding components.

 
     [bookmark: pgfId-1357764]Step 2 Click Configure Updates to open a window for configuring scheduled update settings on the CSC SSM.

 
     [bookmark: pgfId-1357768]

 
      
      
 
     
  
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1357772]Note If you restart the ASA, the SSM is not automatically restarted. For more information, see the “Managing SSMs and SSCs” section in the CLI configuration guide.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1119336]What to Do Next

 
     [bookmark: pgfId-1240139]See the “Monitoring the CSC SSM” section.

 
    
 
   
 
    
     [bookmark: pgfId-1116590][bookmark: 50781]Monitoring the CSC SSM[bookmark: marker-1116597]

 
    [bookmark: pgfId-1357789]ASDM lets you monitor the CSC SSM statistics as well as CSC SSM-related features.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1357790]Note If you have not completed the CSC Setup Wizard in Configuration > Trend Micro Content Security > CSC Setup, you cannot access the panes under Monitoring > Trend Micro Content Security. Instead, a dialog box appears and lets you access the CSC Setup Wizard directly from Monitoring > Trend Micro Content Security.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1357791]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1357795]Threats

 
     		 [bookmark: pgfId-1357799]Live Security Events

 
     		 [bookmark: pgfId-1357803]Live Security Events Log

 
     		 [bookmark: pgfId-1357807]Software Updates

 
     		 [bookmark: pgfId-1357811]Resource Graphs

 
    

 
     
      [bookmark: pgfId-1357813][bookmark: 39683]Threats

 
     [bookmark: pgfId-1357818][bookmark: marker-1357814]To view information about various types of threats detected by the CSC SSM in a graph, perform the following steps:

 
     
 
     [bookmark: pgfId-1357820]Step 1 Choose Monitoring > Trend Micro Content Security > Threats.

 
     [bookmark: pgfId-1357821]The Available Graphs area lists the components whose statistics you can view in a graph. You can include a maximum of four graphs in one frame. The graphs display real-time data in 12-second intervals for the following:

 
      
       
       		 [bookmark: pgfId-1357822]Viruses detected

 
       		 [bookmark: pgfId-1357823]URLs filtered, URLs blocked 

 
       		 [bookmark: pgfId-1357824]Spam detected

 
       		 [bookmark: pgfId-1357825]Files blocked

 
       		 [bookmark: pgfId-1357826]Spyware blocked 

 
       		 [bookmark: pgfId-1357827]Damage Cleanup Services 

 
      

 
     

 
     [bookmark: pgfId-1357828]Step 2 The Graph Window Title lists the types of statistics available for monitoring. You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time. The statistics already included in the graph window appear in the Selected Graphs list.

 
     [bookmark: pgfId-1357829]Step 3 To move the selected statistics type in the Available Graphs For list to the Selected Graphs list, click Add.

 
     [bookmark: pgfId-1357830]Step 4 To remove the selected statistics type from the Selected Graphs list, click Remove. The button name changes to Delete if the item you are removing was added from another pane, and is not being returned to the Available Graphs pane.

 
     [bookmark: pgfId-1357831]Step 5 To display a new window that shows a Graph tab and an updated graph with the selected statistics, click Show Graphs. Click the Table tab to display the same information in tabular form.

 
     [bookmark: pgfId-1357832]Step 6 From the Graph or Table tab, click Export in the menu bar or choose File > Export to save the graph or tabular information as a file on your local PC.

 
     [bookmark: pgfId-1357833]Step 7 From the Graph or Table tab, click Print in the menu bar or choose File > Print to print the information displayed in the window.

 
     [bookmark: pgfId-1357834]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357835]What to Do Next

 
     [bookmark: pgfId-1357839]See the “Live Security Events” section.

 
    
 
     
      [bookmark: pgfId-1357841][bookmark: 16452]Live Security Events

 
     [bookmark: pgfId-1357844]To view live, real-time security events[bookmark: marker-1357842] in a separate window, perform the following steps:

 
     
 
     [bookmark: pgfId-1357845]Step 1 Choose Monitoring > Trend Micro Content Security > Live Security Events.

 
     [bookmark: pgfId-1357846]The Buffer Limit field shows the maximum number of log messages that you may view. The default is 1000.

 
     [bookmark: pgfId-1357847]Step 2 Click View to display the Live Security Events Log dialog box. You can pause incoming messages, clear the message window, and save event messages. You can also search messages for specific text.

 
     [bookmark: pgfId-1357848]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357849]What to Do Next

 
     [bookmark: pgfId-1357853]See the “Live Security Events Log” section.

 
    
 
     
      [bookmark: pgfId-1357856][bookmark: 29868]Live Security Events Log

 
     [bookmark: pgfId-1357857]To view live security events messages that are received from the CSC SSM, perform the following steps:

 
     
 
     [bookmark: pgfId-1357858]Step 1 To filter security event messages from the Filter By drop-down list, choose one of the following:

 
      
       
       		 [bookmark: pgfId-1357859]Filter by Text, type the text, then click  Filter .

 
       		 [bookmark: pgfId-1357860]Show All, to display all messages or remove the filter.

 
      

 
     

 
     [bookmark: pgfId-1357861]Step 2 To use the Latest CSC Security Events pane, in which all columns are display-only, choose one of the following options:

 
      
       
       		 [bookmark: pgfId-1357862]The time an event occurred.

 
       		 [bookmark: pgfId-1357863]The IP address or hostname from which the threat came.

 
       		 [bookmark: pgfId-1357864]The type of threat, or the security policy that determines event handling, or in the case of a URL filtering event, the filter that triggered the event.

 
       		 [bookmark: pgfId-1357865]The subject of e-mails that include a threat, or the names of FTP files that include a threat, or blocked or filtered URLs.

 
       		 [bookmark: pgfId-1357866]The recipient of e-mails that include a threat, or the IP address or hostname of a threatened node, or the IP address of a threatened client.

 
       		 [bookmark: pgfId-1357867]The type of event (such as Web, Mail, or FTP), or the name of a user or group for HTTP or FTP events, which include a threat.

 
       		 [bookmark: pgfId-1357868]The action taken upon the content of a message, such as cleaning attachments or deleting attachments.

 
       		 [bookmark: pgfId-1357869]The action taken on a message, such as delivering it unchanged, delivering it after deleting the attachments, or delivering it after cleaning the attachments.

 
      

 
     

 
     [bookmark: pgfId-1357870]Step 3 To search security event messages based on the text that you enter, choose one of the following: 

 
      
       
       		 [bookmark: pgfId-1357871]In the Text field, enter the text to search for in the security event messages log, then click  Find Messages .

 
       		 [bookmark: pgfId-1357872]To find the next entry that matches the text you typed in this field, click  Find .

 
      

 
     

 
     [bookmark: pgfId-1357873]Step 4 To pause scrolling of the Latest CSC Security Events pane, click Pause. To resume scrolling of the Latest CSC Security Events pane, click Resume.

 
     [bookmark: pgfId-1357874]Step 5 To save the log to a file on your PC, click Save.

 
     [bookmark: pgfId-1357875]Step 6 To clear the list of messages shown, click Clear Display.

 
     [bookmark: pgfId-1357876]Step 7 To close the pane and return to the previous one, click Close.

 
     [bookmark: pgfId-1357877]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357878]What to Do Next

 
     [bookmark: pgfId-1357882]See the “Software Updates” section.

 
    
 
     
      [bookmark: pgfId-1357884][bookmark: 97777]Software Updates

 
     [bookmark: pgfId-1357886][bookmark: marker-1357885]To view information about CSC SSM software updates, choose Monitoring > Trend Micro Content Security > Software Updates.

 
     [bookmark: pgfId-1357888]The Software Updates pane displays the following information, which is refreshed automatically about every 12 seconds:

 
      
      		 [bookmark: pgfId-1357892]The names of parts of the CSC SSM software that can be updated.

 
      		 [bookmark: pgfId-1357893]The current version of the corresponding component.

 
      		 [bookmark: pgfId-1357894]The date and time that the corresponding component was last updated. If the component has not been updated since the CSC SSM software was installed, None appears in this column.

 
      		 [bookmark: pgfId-1357898]The date and time that ASDM last received information about CSC SSM software updates.

 
     

 
    
 
     
      [bookmark: pgfId-1357899]What to Do Next

 
     [bookmark: pgfId-1357903]See the “CSC CPU” section.

 
    
 
     
      [bookmark: pgfId-1357906][bookmark: 99198]Resource Graphs

 
     [bookmark: pgfId-1357913]The ASA lets you monitor CSC SSM status, including CPU resources and memory usage. This section includes the following topics:

 
      
      		 [bookmark: pgfId-1357917]CSC CPU

 
      		 [bookmark: pgfId-1357921]CSC Memory

 
     

 
    
 
     
      [bookmark: pgfId-1357925][bookmark: 17934]CSC [bookmark: marker-1357923]CPU

 
     [bookmark: pgfId-1357929]To view CPU usage by the CSC SSM in a graph, perform the following steps:

 
     
 
     [bookmark: pgfId-1357930]Step 1 Choose Monitoring > Trend Micro Content Security > Resource Graphs > CSC CPU.

 
     [bookmark: pgfId-1357931]The CSC CPU pane displays the components whose statistics you can view in a graph, including statistics for CPU usage on the CSC SSM.

 
     [bookmark: pgfId-1357938]Step 2 To continue, go to Step 2 of the “Threats” section. 

 
     [bookmark: pgfId-1357939]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1357940]What to Do Next

 
     [bookmark: pgfId-1357944]See the “CSC Memory” section.

 
    
 
     
      [bookmark: pgfId-1357948][bookmark: 62422]CSC Mem[bookmark: marker-1357946]ory

 
     [bookmark: pgfId-1357952]To view information about memory usage on the CSC SSM in a graph, perform the following steps: 

 
     
 
     [bookmark: pgfId-1357953]Step 1 Choose Monitoring > Trend Micro Content Security > Resource Graphs > CSC Memory.

 
     [bookmark: pgfId-1357954]The Available Graphs area lists the components whose statistics you can view in a graph, including the following:

 
      
       
       		 [bookmark: pgfId-1357955]The amount of memory not in use.

 
       		 [bookmark: pgfId-1357956]The amount of memory in use.

 
      

 
     

 
     [bookmark: pgfId-1357960]Step 2 To continue, go to Step 2 of the “Threats” section. 

 
     [bookmark: pgfId-1357961]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1201846][bookmark: 84647]Troubleshooting the CSC Module

 
    [bookmark: pgfId-1243768]This section includes procedures that help you recover or troubleshoot the module and includes the following topics:

 
     
     		 [bookmark: pgfId-1243771]Installing an Image on the Module

 
     		 [bookmark: pgfId-1243779]Resetting the Password

 
     		 [bookmark: pgfId-1243783]Reloading or Resetting the Module

 
     		 [bookmark: pgfId-1243787]Shutting Down the Module

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1243791]Note This section covers all ASA module types; follow the steps appropriate for your module.

 
     
     
 
    
 
    

 
     
      [bookmark: pgfId-1243799][bookmark: 73926][bookmark: 34678][bookmark: 37556]Installing an Image on the Module[bookmark: marker-1243796][bookmark: marker-1243797][bookmark: marker-1243798]

 
     [bookmark: pgfId-1243800]If the module suffers a failure, and the module application image cannot run, you can reinstall a new image on the module from a TFTP server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1243801]Note Do not use the upgrade command within the module software to install the image.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1243802]Prerequisites

 
     [bookmark: pgfId-1243803]Be sure the TFTP server that you specify can transfer files up to 60 MB in size.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1243804]Note This process can take approximately 15 minutes to complete, depending on your network and the size of the image.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1243807]Detailed Steps

 
     [bookmark: pgfId-1243876] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1243810]  
          
  
         		 
           
           [bookmark: pgfId-1243812]Command 
          
  
         		 
           
           [bookmark: pgfId-1243814]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1243816]Step 1

  
         		 
           
           [bookmark: pgfId-1243819] 
            hw-module module  
            1  
            recover configure 
          
 
           
           [bookmark: pgfId-1243820]  
          
 
           
           [bookmark: pgfId-1243823]  
          
 [bookmark: pgfId-1243826]ciscoasa# hw-module module 1 recover configure

 [bookmark: pgfId-1243828]Image URL [tftp://127.0.0.1/myimage]: tftp://10.1.1.1/ids-newimg

 [bookmark: pgfId-1243829]Port IP Address [127.0.0.2]: 10.1.2.10

 [bookmark: pgfId-1243830]Port Mask [255.255.255.254]: 255.255.255.0

 [bookmark: pgfId-1243831]Gateway IP Address [1.1.2.10]: 10.1.2.254

 [bookmark: pgfId-1243832]VLAN ID [0]: 100

  
         		[bookmark: pgfId-1243834]Specifies the location of the new image. This command prompts you for the URL for the TFTP server, the management interface IP address and netmask, gateway address, and VLAN ID (ASA 5505 only). These network parameters are configured in ROMMON; the network parameters you configured in the module application configuration are not available to ROMMON, so you must set them separately here.

 [bookmark: pgfId-1243837]You can view the recovery configuration using the show module 1 recover command.

 [bookmark: pgfId-1243838]In multiple context mode, enter this command in the system execution space.

  
        

 
         
         		[bookmark: pgfId-1243840]Step 2

  
         		 
           
           [bookmark: pgfId-1243843] 
            hw-module module  
            1 
            recover boot 
          
 
           
           [bookmark: pgfId-1243844]  
          
 
           
           [bookmark: pgfId-1243847]  
          
 [bookmark: pgfId-1243850]ciscoasa# hw-module module 1 recover boot

  
         		[bookmark: pgfId-1243853]Transfers the image from the TFTP server to the module and restarts the module.

  
        

 
         
         		[bookmark: pgfId-1243855]Step 3

  
         		 
           
           [bookmark: pgfId-1243858] 
            show module  
            1 
             
            details 
          
 
           
           [bookmark: pgfId-1243859]  
          
 
           
           [bookmark: pgfId-1243862]  
          
 [bookmark: pgfId-1243865]ciscoasa# show module 1 details

  
         		[bookmark: pgfId-1243868]Checks the progress of the image transfer and module restart process. 

 [bookmark: pgfId-1243869]The Status field in the output indicates the operational status of the module. A module operating normally shows a status of “Up.” While the ASA transfers an application image to the module, the Status field in the output reads “Recover.” When the ASA completes the image transfer and restarts the module, the newly transferred image is running.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1243906]Resetting the [bookmark: 70014]Passw[bookmark: marker-1243905]ord

 
     [bookmark: pgfId-1243909][bookmark: 74370][bookmark: 87026]You can reset the module password to the default. The default password is cisco. After resetting the password, you should change it to a unique value using the module application.

 
     [bookmark: pgfId-1243910]Resetting the module password causes the module to reboot. Services are not available while the module is rebooting.

 
     [bookmark: pgfId-1357966]If you cannot connect to ASDM with the new password, restart ASDM and try to log in again. If you defined a new password and still have an existing password in ASDM that is different from the new password, clear the password cache by choosing File > Clear ASDM Password Cache, then restart ASDM and try to log in again.

 
     [bookmark: pgfId-1243912]To reset the module password to the default of cisco, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1243913]Detailed Steps

 
     [bookmark: pgfId-1243932] 

 
     
 
     [bookmark: pgfId-1357974]Step 1 From the ASDM menu bar, choose Tools > CSC Password Reset.

 
     [bookmark: pgfId-1357975]The Password Reset confirmation dialog box appears.

 
     [bookmark: pgfId-1357976]Step 2 Click OK to reset the password to the default. 

 
     [bookmark: pgfId-1357977]A dialog box displays the success or failure of the password reset.

 
     [bookmark: pgfId-1357978]Step 3 Click Close to close the dialog box.

 
     [bookmark: pgfId-1357979]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1243944][bookmark: 60064]Reloading or Resetting the Module[bookmark: marker-1243943]

 
     [bookmark: pgfId-1243947]To reload or reset the module, enter one of the following commands at the ASA CLI.

 
    
 
     
      [bookmark: pgfId-1243949]Detailed Steps

 
     [bookmark: pgfId-1243981] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1243952]Command 
          
  
         		 
           
           [bookmark: pgfId-1243954]Purpose 
          
  
        

 
         
         		 
           
           [bookmark: pgfId-1243957] 
            hw-module module 1 reload 
          
 
           
           [bookmark: pgfId-1243958]  
          
 
           
           [bookmark: pgfId-1243961]  
          
 [bookmark: pgfId-1243964]ciscoasa# hw-module module 1 reload

  
         		[bookmark: pgfId-1243967]Reloads the module software.

  
        

 
         
         		 
           
           [bookmark: pgfId-1243970] 
            hw-module module 1 reset 
          
 
           
           [bookmark: pgfId-1243971]  
          
 
           
           [bookmark: pgfId-1243974]  
          
 [bookmark: pgfId-1243977]ciscoasa# hw-module module 1 reset

  
         		[bookmark: pgfId-1243980]Performs a reset, then reloads the module.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1243984][bookmark: 56378]Shutting Down the Module[bookmark: marker-1243983]

 
     [bookmark: pgfId-1243987]If you restart the ASA, the module is not automatically restarted. To shut down the module, perform the following steps at the ASA CLI.

 
    
 
     
      [bookmark: pgfId-1243992]Detailed Steps

 
     [bookmark: pgfId-1244012][bookmark: 31943] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1243995]Command 
          
  
         		 
           
           [bookmark: pgfId-1243997]Purpose 
          
  
        

 
         
         		 
           
           [bookmark: pgfId-1244000] 
            hw-module module 1 shutdown 
          
 
           
           [bookmark: pgfId-1244001]  
          
 
           
           [bookmark: pgfId-1244004]  
          
 [bookmark: pgfId-1244007]ciscoasa# hw-module module 1 shutdown

  
         		[bookmark: pgfId-1244010]Shuts down the module.

  
        

 
        
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1107950][bookmark: 46657][bookmark: 34672]Additional References

 
    [bookmark: pgfId-1107952]For additional information related to implementing the CSC SSM, see the following documents:

 
    [bookmark: pgfId-1120867] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1120826]Related Topic 
         
  
        		 
          
          [bookmark: pgfId-1120828]Document Title 
         
  
       

 
        
        		[bookmark: pgfId-1246552]Instructions on use of the CSC SSM GUI.
Additional licensing requirements of specific windows available in the CSC SSM GUI.
Reviewing the default content security policies in the CSC SSM GUI before modifying them or entering advanced configuration settings.

  
        		[bookmark: pgfId-1246560]Cisco Content Security and Control SSM Administrator Guide

  
       

 
        
        		[bookmark: pgfId-1246565]Accessing ASDM for the first time and assistance with the Startup Wizard.

  
        		[bookmark: pgfId-1246570]Cisco ASA 5500 Series Quick Start Guide

  
       

 
        
        		[bookmark: pgfId-1123145]Assistance with SSM hardware installation and connection to the ASA.

  
        		[bookmark: pgfId-1123153]hardware guide

  
       

 
        
        		[bookmark: pgfId-1123125]Accessing ASDM for the first time and assistance with the Startup Wizard.

  
        		[bookmark: pgfId-1123130]Cisco ASA 5500 Series Quick Start Guide

  
       

 
        
        		[bookmark: pgfId-1123135]Instructions on use of the CSC SSM GUI.
Additional licensing requirements of specific windows available in the CSC SSM GUI.
Reviewing the default content security policies in the CSC SSM GUI before modifying them or entering advanced configuration settings.

  
        		[bookmark: pgfId-1123143]Cisco Content Security and Control SSM Administrator Guide

  
       

 
        
        		[bookmark: pgfId-1120863]Technical Documentation, Marketing, and Support-related information.

  
        		[bookmark: pgfId-1120866]See the following URL:

 [bookmark: pgfId-1154979]http://www.cisco.com/en/US/products/ps6823/index.html.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1108025][bookmark: 46142]Feature History for the CSC SSM[bookmark: marker-1113685]

 
    [bookmark: pgfId-1108029]Table 32-2 lists each feature change and the platform release in which it was implemented. ASDM is backward-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1108063] 

 
     
      
       
       [bookmark: pgfId-1139991]Table 32-2 [bookmark: 45258]Feature History for the CSC SSM 

 
       
       
        
        		 
          
          [bookmark: pgfId-1139997]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1139999]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1140001]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1140003]CSC SSM

  
        		[bookmark: pgfId-1140005]7.0(1)

  
        		[bookmark: pgfId-1140010]The CSC SSM runs Content Security and Control software, which provides protection against viruses, spyware, spam, and other unwanted traffic.

 [bookmark: pgfId-1357989]The CSC Setup Wizard enables you to configure the CSC SSM in ASDM. 

 [bookmark: pgfId-1183343]We introduced the following screen: Configuration > Trend Micro Content Security > CSC Setup.

  
       

 
        
        		[bookmark: pgfId-1140020]CSC SSM

  
        		[bookmark: pgfId-1140022]8.1(1) and 8.1(2)

  
        		[bookmark: pgfId-1140024]This feature is not supported on the ASA 5580.

  
       

 
        
        		[bookmark: pgfId-1140026]CSC syslog format

  
        		[bookmark: pgfId-1140028]8.3(1) 

  
        		[bookmark: pgfId-1140033]CSC syslog format is consistent with the ASA syslog format. Syslog message explanations have been added to the Cisco Content Security and Control SSM Administrator Guide. The source and destination IP information has been added to the ASDM Log Viewer GUI. All syslog messages include predefined syslog priorities and cannot be configured through the CSC SSM GUI.

  
       

 
        
        		[bookmark: pgfId-1166507]Clearing CSC events

  
        		[bookmark: pgfId-1166509]8.4(1)

  
        		[bookmark: pgfId-1166511]Support for clearing CSC events in the Latest CSC Security Events pane has been added. We modified the following screen: Home > Content Security.

  
       

 
        
        		[bookmark: pgfId-1183018]CSC SSM 

  
        		[bookmark: pgfId-1183020]8.4(2)

  
        		[bookmark: pgfId-1183324]Support for the following features has been added:

 
          
          		 [bookmark: pgfId-1183325]HTTPS traffic redirection: URL filtering and WRS queries for incoming HTTPS connections.

 
          		 [bookmark: pgfId-1183326]Configuring global approved whitelists for incoming and outgoing SMTP and POP3 e-mail. 

 
          		 [bookmark: pgfId-1183327]E-mail notification for product license renewals.

 
         

 [bookmark: pgfId-1183090]We modified the following screens: 

Configuration > Trend Micro Content Security > Mail > SMTP.
Configuration > Trend Micro Content Security > Mail > POP3.
Configuration > Trend Micro Content Security > Host/Notification Settings.
Configuration > Trend Micro Content Security > CSC Setup > Host Configuration.
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     [bookmark: pgfId-1042020][bookmark: 80031]Configuring Threat Detection 
      
      
 
     
 

 
    [bookmark: pgfId-1058278]This chapter describes how to configure threat detection statistics and scanning threat detection and includes the following sections:

 
     
     		 [bookmark: pgfId-1096723]Information About Threat Detection

 
     		 [bookmark: pgfId-1143009]Licensing Requirements for Threat Detection

 
     		 [bookmark: pgfId-1096983]Configuring Basic Threat Detection Statistics

 
     		 [bookmark: pgfId-1096727]Configuring Advanced Threat Detection Statistics

 
     		 [bookmark: pgfId-1067604]Configuring Scanning Threat Detection

 
    

 
   
 
    
     [bookmark: pgfId-1096812][bookmark: 93837]Information About Threat Detection

 
    [bookmark: pgfId-1096934]The threat detection feature consists of the following elements:

 
     
     		 [bookmark: pgfId-1103207]Different levels of statistics gathering for various threats.

 
    

 
    [bookmark: pgfId-1179810]Threat detection statistics can help you manage threats to your ASA; for example, if you enable scanning threat detection, then viewing statistics can help you analyze the threat. You can configure two types of threat detection statistics:

 
    [bookmark: pgfId-1103320] – Basic threat detection statistics—Includes information about attack activity for the system as a whole. Basic threat detection statistics are enabled by default and have no performance impact.

 
    [bookmark: pgfId-1103323] – Advanced threat detection statistics—Tracks activity at an object level, so the ASA can report activity for individual hosts, ports, protocols, or ACLs. Advanced threat detection statistics can have a major performance impact, depending on the statistics gathered, so only the ACL statistics are enabled by default.

 
     
     		 [bookmark: pgfId-1103233]Scanning threat detection, which determines when a host is performing a scan.

 
    

 
    [bookmark: pgfId-1103234]You can optionally shun any hosts determined to be a scanning threat.

 
   
 
    
     [bookmark: pgfId-1142668][bookmark: 38115]Licensing Requirements for Threat Detection

 
    [bookmark: pgfId-1142670]The following table shows the licensing requirements for this feature:

 
    [bookmark: pgfId-1294434] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1294427]Model 
         
  
        		 
          
          [bookmark: pgfId-1294429]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1294431]All models

  
        		[bookmark: pgfId-1294433]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1091017][bookmark: 96885]Configuring Basic Threat Detection Statistics

 
    [bookmark: pgfId-1058653]Basic threat detection statistics include activity that might be related to an attack, such as a DoS attack.

 
    [bookmark: pgfId-1078586]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1067571]Information About Basic Threat Detection Statistics

 
     		 [bookmark: pgfId-1090610]Guidelines and Limitations

 
     		 [bookmark: pgfId-1090628]Default Settings

 
     		 [bookmark: pgfId-1067590]Configuring Basic Threat Detection Statistics

 
     		 [bookmark: pgfId-1067592]Monitoring Basic Threat Detection Statistics

 
     		 [bookmark: pgfId-1094247]Feature History for Basic Threat Detection Statistics

 
    

 
     
      [bookmark: pgfId-1067533][bookmark: 21840]Information About Basic Threat Detecti[bookmark: marker-1076619]on[bookmark: marker-1076618] Statistics

 
     [bookmark: pgfId-1067545]Using basic threat detection statistics, the ASA monitors the rate of dr[bookmark: marker-1076621]opped packets and security events due to the following reasons:

 
      
      		 [bookmark: pgfId-1058685]Denial by ACLs

 
      		 [bookmark: pgfId-1058697]Bad packet format (such as invalid-ip-header or invalid-tcp-hdr-length)

 
      		 [bookmark: pgfId-1058723]Connection limits exceeded (both system-wide resource limits, and limits set in the configuration)

 
      		 [bookmark: pgfId-1058735]DoS attack detected (such as an invalid SPI, Stateful Firewall check failure)

 
      		 [bookmark: pgfId-1058742]Basic firewall checks failed (This option is a combined rate that includes all firewall-related packet drops in this bulleted list. It does not include non-firewall-related drops such as interface overload, packets failed at application inspection, and scanning attack detected.)

 
      		 [bookmark: pgfId-1058747]Suspicious ICMP packets detected

 
      		 [bookmark: pgfId-1058752]Packets failed application inspection

 
      		 [bookmark: pgfId-1058757]Interface overload

 
      		 [bookmark: pgfId-1060882]Scanning attack detected (This option monitors scanning attacks; for example, the first TCP packet is not a SYN packet, or the TCP connection failed the 3-way handshake. Full scanning threat detection (see the “Configuring Scanning Threat Detection” section) takes this scanning attack rate information and acts on it by classifying hosts as attackers and automatically shunning them, for example.)

 
      		 [bookmark: pgfId-1076694]Incomplete session detection such as TCP SYN attack detected or no data UDP session attack detected

 
     

 
     [bookmark: pgfId-1088371]When the ASA detects a threat, it immediately sends a system log message (733100). The ASA trac[bookmark: marker-1088372]ks two types of rates: the average event rate over an interval, and the burst event rate over a shorter burst interval. The burst rate interval is 1/30th of the average rate interval or 10 seconds, whichever is higher. For each received event, the ASA checks the average and burst rate limits; if both rates are exceeded, then the ASA sends two separate system messages, with a maximum of one message for each rate type per burst period.

 
     [bookmark: pgfId-1068804]Basic threat detection affects perform[bookmark: marker-1076623]ance only when there are drops or potential threats; even in this scenario, the performance impact is insignificant.

 
    
 
     
      [bookmark: pgfId-1088111][bookmark: 51918]Guidelines and Limitations

 
     [bookmark: pgfId-1088112]This section includes the guidelines and limitations for this feature:

 
     [bookmark: pgfId-1088113][bookmark: 33490]Security Context Guidelines

 
     [bookmark: pgfId-1087586]Supported in single mode only. Multiple mode is not supported.

 
     [bookmark: pgfId-1087986][bookmark: 48729]Firewall Mode Guidelines

 
     [bookmark: pgfId-1088006]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1099778]Types of Traffic Monitored

 
     [bookmark: pgfId-1099825]Only through-the-box traffic is monitored; to-the-box traffic is not included in threat detection.

 
    
 
     
      [bookmark: pgfId-1087593][bookmark: 66558]Default Settings

 
     [bookmark: pgfId-1087765]Basic threat detection statistics are enabled by default.

 
     [bookmark: pgfId-1088446]Table 27-1 lists the default settings. You can view all these default settings using the show running-config all threat-detection command in Tools > Command Line Interface.

 
     [bookmark: pgfId-1087865] 

 
      
       
        
        [bookmark: pgfId-1087772]Table 27-1 [bookmark: 16445]Basic Threat Detection Default Settings 

 
        
        
         
         		 
           
           [bookmark: pgfId-1087778]Packet Drop Reason 
          
  
         		 
           
           [bookmark: pgfId-1087780]Trigger Settings 
          
  
        

 
         
         		 
           
           [bookmark: pgfId-1087786]Average Rate 
          
  
         		 
           
           [bookmark: pgfId-1087788]Burst Rate 
          
  
        

 
         
         		 
           
           		 [bookmark: pgfId-1087790]DoS attack detected

 
           		 [bookmark: pgfId-1087791]Bad packet format

 
           		 [bookmark: pgfId-1087792]Connection limits exceeded

 
           		 [bookmark: pgfId-1087793]Suspicious ICMP packets detected

 
          

  
         		[bookmark: pgfId-1087795]100 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1087797]400 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1087801]80 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1087803]320 drops/sec over the last 120 second period.

  
        

 
         
         		 [bookmark: pgfId-1087805]Scanning attack detected

  
         		[bookmark: pgfId-1087807]5 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1087809]10 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1087813]4 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1087815]8 drops/sec over the last 120 second period.

  
        

 
         
         		 [bookmark: pgfId-1087817]Incomplete session detected such as TCP SYN attack detected or no data UDP session attack detected (combined)

  
         		[bookmark: pgfId-1087819]100 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1087821]200 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1087825]80 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1087827]160 drops/sec over the last 120 second period.

  
        

 
         
         		 [bookmark: pgfId-1087829]Denial by ACLs

  
         		[bookmark: pgfId-1087831]400 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1087833]800 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1087837]320 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1087839]640 drops/sec over the last 120 second period.

  
        

 
         
         		 
           
           		 [bookmark: pgfId-1087841]Basic firewall checks failed

 
           		 [bookmark: pgfId-1087842]Packets failed application inspection

 
          

  
         		[bookmark: pgfId-1087844]400 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1087846]1600 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1087850]320 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1087852]1280 drops/sec over the last 120 second period.

  
        

 
         
         		 [bookmark: pgfId-1087854]Interface overload

  
         		[bookmark: pgfId-1087856]2000 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1087858]8000 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1087862]1600 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1087864]6400 drops/sec over the last 120 second period.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1067519][bookmark: 64270]Configuring Basic Th[bookmark: marker-1076622]reat Detection Statistics

 
     [bookmark: pgfId-1058841]This section describes how to configure basic threat detection statistics, including enabling or disabling it and changing the default limits.

 
    
 
     
      [bookmark: pgfId-1091498]Detailed Steps

 
     
 
     [bookmark: pgfId-1285732]Step 1 To enable or disable basic threat detection, choose the Configuration > Firewall > Threat Detection pane, and check the Enable Basic Threat Detection check box.

 
     [bookmark: pgfId-1285733]Step 2 Click Apply.

 
     [bookmark: pgfId-1285734]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1100275][bookmark: 50832]Monitoring Basic Threat Detection Statistics

 
     [bookmark: pgfId-1092813]To monitor basic threat detection statistics, perform the following task:

 
     [bookmark: pgfId-1110301] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1116182]Path 
          
  
         		 
           
           [bookmark: pgfId-1108602]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1109220]Home > Firewall Dashboard > Traffic Overview

  
         		[bookmark: pgfId-1108608]Displays basic thre[bookmark: marker-1108607]at detection statistics.

 [bookmark: pgfId-1108612]For a description of each event type, see the “Information About Basic Threat Detection Statistics” section.

 [bookmark: pgfId-1108616] 

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1090706][bookmark: 53857]Feature History for Basic Threat Detection Statistics

 
     [bookmark: pgfId-1116315]Table 27-2 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1092339] 

 
      
       
        
        [bookmark: pgfId-1092305]Table 27-2 [bookmark: 50557]Feature History for Basic Threat Detection Statistics

 
        
        
         
         		 
           
           [bookmark: pgfId-1116327]Feature Name 
          
  
         		 
           
           [bookmark: pgfId-1116329]Platform Releases 
          
  
         		 
           
           [bookmark: pgfId-1116331]Feature Information 
          
  
        

 
         
         		[bookmark: pgfId-1092318]Basic threat detection statistics

  
         		[bookmark: pgfId-1092320]8.0(2)

  
         		[bookmark: pgfId-1094553]Basic threat detection statistics was introduced.

 [bookmark: pgfId-1103945]The following screen was introduced: Configuration > Firewall > Threat Detection, Home > Firewall Dashboard > Traffic Overview.

  
        

 
         
         		[bookmark: pgfId-1099290]Burst rate interval changed to 1/30th of the average rate.

  
         		[bookmark: pgfId-1099292]8.2(1)

  
         		[bookmark: pgfId-1099294]In earlier releases, the burst rate interval was 1/60th of the average rate. To maximize memory usage, the sampling interval was reduced to 30 times during the average rate.

  
        

 
         
         		[bookmark: pgfId-1103630]Improved memory usage

  
         		[bookmark: pgfId-1103632]8.3(1)

  
         		[bookmark: pgfId-1103634]The memory usage for threat detection was improved.

  
        

 
        
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1091680][bookmark: 11688]Configuring Advanced Threat Detection Statistics

 
    [bookmark: pgfId-1091684]You can configure the ASA to collect extensive statistics. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1091689]Information About Advanced Threat Detection Statistics

 
     		 [bookmark: pgfId-1094277]Guidelines and Limitations

 
     		 [bookmark: pgfId-1094286]Default Settings

 
     		 [bookmark: pgfId-1091693]Configuring Advanced Threat Detection Statistics

 
     		 [bookmark: pgfId-1091697]Monitoring Advanced Threat Detection Statistics

 
     		 [bookmark: pgfId-1094268]Feature History for Advanced Threat Detection Statistics

 
    

 
     
      [bookmark: pgfId-1091699][bookmark: 17788]Information About Advanced Threat Detection Statistics

 
     [bookmark: pgfId-1091700]Advanced threat detection statistics show both allowed and dropped traffic rates for individual objects such as hosts, ports, protocols, or ACLs.

 
      
      [image: ] 
     
 
     
 
      
      [bookmark: pgfId-1091711] 
      Caution En 
      [bookmark: marker-1091707]abling advanced statistics can affect the ASA performance, depending on the type of statistics enabled. Enabling host statistics affects performance in a significant way; if you have a high traffic load, you might consider enabling this type of statistics temporarily. Port statistics, however, has modest impact. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1091712][bookmark: 60852]Guidelines and Limitations

 
     [bookmark: pgfId-1091713]This section includes the guidelines and limitations for this feature:

 
     [bookmark: pgfId-1091722]Security Context Guidelines

 
     [bookmark: pgfId-1091723]Only TCP Intercept statistics are available in multiple mode.

 
     [bookmark: pgfId-1091724]Firewall Mode Guidelines

 
     [bookmark: pgfId-1091725]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1099848]Types of Traffic Monitored

 
     [bookmark: pgfId-1099849]Only through-the-box traffic is monitored; to-the-box traffic is not included in threat detection.

 
    
 
     
      [bookmark: pgfId-1091726][bookmark: 75608]Default Settings

 
     [bookmark: pgfId-1095626]By default, statistics for ACLs are enabled.

 
    
 
     
      [bookmark: pgfId-1095633][bookmark: 46159]Configuring Advanced Threat Detection St[bookmark: marker-1095632]atistics

 
     [bookmark: pgfId-1100784]By default, statistics for ACLs are enabled. To enable other statistics, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1100772]Detailed Steps

 
     [bookmark: pgfId-1104159] 

 
     
 
     [bookmark: pgfId-1285754]Step 1 Choose the Configuration > Firewall > Threat Detection pane.

 
     [bookmark: pgfId-1285755]Step 2 In the Scanning Threat Statistics area, choose one of the following options:

 
      
       
       		 [bookmark: pgfId-1285756]Enable  all statistics—Click the Enable All Statistics  radio button.

 
      

 
      		 [bookmark: pgfId-1285757]Disable  all statistics—Click the Disable All Statistics  radio button.

 
      		 [bookmark: pgfId-1285758]Enable only certain statistics—Click the Enable Only Following Statistics  radio button.

 
     

 
     [bookmark: pgfId-1285759]Step 3 If you chose to Enable Only Following Statistics, then check one or more of the following check boxes: 

 
      
       
       		 [bookmark: pgfId-1285760] Hosts —Enables host statistics. The host statistics accumulate for as long as the host is active and in the scanning threat host database. The host is deleted from the database (and the statistics cleared) after 10 minutes of inactivity.

 
       		 [bookmark: pgfId-1285761] Access Rules (enabled by default)—Enables statistics for access rules.

 
       		 [bookmark: pgfId-1285762] Port —Enables statistics for TCP and UDP ports.

 
       		 [bookmark: pgfId-1285763] Protocol —Enables statistics for non-TCP/UDP IP protocols.

 
       		 [bookmark: pgfId-1285767] TCP-Intercept —En[bookmark: marker-1285764]ables statistics for attacks intercepted by TCP Intercept (see the “Configuring Connection Settings” section to enable TCP Intercept). 

 
      

 
     

 
     [bookmark: pgfId-1285769]Step 4 For host, port, and protocol statistics, you can change the number of rate intervals collected. In the Rate Intervals area, choose 1 hour, 1 and 8 hours, or 1, 8 and 24 hours for each statistics type. The default interval is 1 hour, which keeps the memory usage low[bookmark: 10747][bookmark: 29889].

 
     [bookmark: pgfId-1285772]Step 5 For TCP Intercept statistics, you can set the following options in the TCP Intercept Threat Detection area:

 
      
       
       		 [bookmark: pgfId-1285773] Monitoring Window Size —Sets the size of the history monitoring window, between 1 and 1440 minutes. The default is 30 minutes. The ASA samples the number of attacks 30 times during the rate interval, so for the default 30 minute period, statistics are collected every 60 seconds.

 
       		 [bookmark: pgfId-1285777] Burst Threshold Rate —Sets the threshold for syslog message generation, between 25 and 2147483647. The default is 400 per second. When the burst rate is exceeded, syslog message 733104 is generated.

 
       		 [bookmark: pgfId-1285778] Average Threshold Rate —Sets the average rate threshold for syslog message generation, between 25 and 2147483647. The default is 200 per second. When the average rate is exceeded, syslog message 733105 is generated.

 
      

 
     

 
     [bookmark: pgfId-1285779]Click Set Default to restore the default values.

 
     [bookmark: pgfId-1285780]Step 6 Click Apply.

 
     [bookmark: pgfId-1285781]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1104293][bookmark: 56617]Monitoring Advanced Threat Detection Statis[bookmark: marker-1104292]tics

 
     [bookmark: pgfId-1093239]To monitor advanced threat detection statistics, perform one of the following tasks:

 
     [bookmark: pgfId-1093265] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1116228]Path 
          
  
         		 
           
           [bookmark: pgfId-1093244]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1285821]Home > Firewall Dashboard > Top 10 Access Rules

 [bookmark: pgfId-1104725]Home > Firewall Dashboard > Top Usage Statistics

  
         		[bookmark: pgfId-1093257]Displays the top 10 statistics.

 [bookmark: pgfId-1093370]For the Top 10 Access Rules, permitted and denied traffic are not differentiated in this display. In the Traffic Overview > Dropped Packets Rate graph, you can track ACL denies.

 [bookmark: pgfId-1093371]The Top 10 Sources and Top 10 Destinations tabs show statistics for hosts. Note: Due to the threat detction algorithm, an interface used as a combination failover and state link could appear in the top 10 hosts; this is expected behavior, and you can ignore this IP address in the display.

 [bookmark: pgfId-1093372]The Top 10 Services tab shows statistics for both ports and protocols (both must be enabled for the display), and shows the combined statistics of TCP/UDP port and IP protocol types. TCP (protocol 6) and UDP (protocol 17) are not included in the display for IP protocols; TCP and UDP ports are, however, included in the display for ports. If you only enable statistics for one of these types, port or protocol, then you will only view the enabled statistics.

 [bookmark: pgfId-1093373]The Top Ten Protected Servers under SYN Attack area shows the TCP Intercept statistics. The display includes the top 10 protected servers under attack. The detail button shows history sampling data. The ASA samples the number of attacks 30 times during the rate interval, so for the default 30 minute period, statistics are collected every 60 seconds.

 [bookmark: pgfId-1093377]From the Interval drop-down list, choose Last 1 hour, Last 8 hour, or Last 24 hour. 

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1092007][bookmark: 96117]Feature History for Advanced Threat Detection Statistics

 
     [bookmark: pgfId-1116308]Table 27-3 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1094693] 

 
      
       
        
        [bookmark: pgfId-1094676]Table 27-3 [bookmark: 29063]Feature History for Advanced Threat Detection Statistics 

 
        
        
         
         		 
           
           [bookmark: pgfId-1116299]Feature Name 
          
  
         		 
           
           [bookmark: pgfId-1116301]Platform Releases 
          
  
         		 
           
           [bookmark: pgfId-1116303]Feature Information 
          
  
        

 
         
         		[bookmark: pgfId-1094688]Advanced threat detection statistics

  
         		[bookmark: pgfId-1094690]8.0(2)

  
         		[bookmark: pgfId-1094692]Advanced threat detection statistics was introduced.

 [bookmark: pgfId-1104858]The following screens were introduced: Configuration > Firewall > Threat Detection, Home > Firewall Dashboard > Top 10 Access Rules, Home > Firewall Dashboard > Top Usage Status, Home > Firewall Dashboard > Top 10 Protected Servers Under SYN Attack.

  
        

 
         
         		[bookmark: pgfId-1094840]TCP Intercept statistics

  
         		[bookmark: pgfId-1094906]8.0(4)/8.1(2)

  
         		[bookmark: pgfId-1094844]TCP Intercept statistics were introduced.

 [bookmark: pgfId-1104883]The following screens were introduced or modified: Configuration > Firewall > Threat Detection, Home > Firewall Dashboard > Top 10 Protected Servers Under SYN Attack.

  
        

 
         
         		[bookmark: pgfId-1095087]Customize host statistics rate intervals

  
         		[bookmark: pgfId-1094836]8.1(2)

  
         		[bookmark: pgfId-1103551]You can now customize the number of rate intervals for which statistics are collected. The default number of rates was changed from 3 to 1.

 [bookmark: pgfId-1104945]The following screen was modified: Configuration > Firewall > Threat Detection.

  
        

 
         
         		[bookmark: pgfId-1099349]Burst rate interval changed to 1/30th of the average rate.

  
         		[bookmark: pgfId-1099351]8.2(1)

  
         		[bookmark: pgfId-1099353]In earlier releases, the burst rate interval was 1/60th of the average rate. To maximize memory usage, the sampling interval was reduced to 30 times during the average rate.

  
        

 
         
         		[bookmark: pgfId-1103473]Customize port and protocol statistics rate intervals

  
         		[bookmark: pgfId-1103435]8.3(1)

  
         		[bookmark: pgfId-1103567]You can now customize the number of rate intervals for which statistics are collected. The default number of rates was changed from 3 to 1.

 [bookmark: pgfId-1104985]The following screen was modified: Configuration > Firewall > Threat Detection.

  
        

 
         
         		[bookmark: pgfId-1103427]Improved memory usage

  
         		[bookmark: pgfId-1103429]8.3(1)

  
         		[bookmark: pgfId-1103431]The memory usage for threat detection was improved.

 [bookmark: pgfId-1103582] 

  
        

 
        
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1072953][bookmark: 36843]Configuring Scanning Threat Dete[bookmark: marker-1076629]ction

 
    [bookmark: pgfId-1092622]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1088593]Information About Scanning Threat Detection

 
     		 [bookmark: pgfId-1089865]Guidelines and Limitations

 
     		 [bookmark: pgfId-1089897]Default Settings

 
     		 [bookmark: pgfId-1094062]Configuring Scanning Threat Detection

 
     		 [bookmark: pgfId-1094066]Feature History for Scanning Threat Detection

 
    

 
     
      [bookmark: pgfId-1094068][bookmark: 23808]Information About Scanning Threat Detection

 
     [bookmark: pgfId-1065283]A typical scanning attack consists of a host that tests the accessibility of every IP address in a subnet (by scanning through many hosts in the subnet or sweeping through many ports in a host or subnet). The scanning threat detection feature determines when a host is performing a scan. Unlike IPS scan detection that is based on traffic signatures, the ASA scanning threat detection feature maintains an extensive database that contains host statistics that can be analyzed for scanning activity.

 
     [bookmark: pgfId-1065517]The host dat[bookmark: marker-1076631]abase tracks suspicious activity such as connections with no return activity, access of closed service ports, vulnerable TCP behaviors such as non-random IPID, and many more behaviors.

 
     [bookmark: pgfId-1065502]If the scanning threat rate is exceeded, then the ASA sends a syslog message (733101), and optionally shuns the attacker. The ASA tracks two types of rates: the average event rate over an interval, and the burst event rate over a shorter burst interval. The burst event rate is 1/30th of the average rate interval or 10 seconds, whichever is higher. For each event detected that is considered to be part of a scanning attack, the ASA checks the average and burst rate limits. If either rate is exceeded for traffic sent from a host, then that host is considered to be an attacker. If either rate is exceeded for traffic received by a host, then that host is considered to be a target.

 
      
      [image: ] 
     
 
     
 
      
      [bookmark: pgfId-1089308] 
      Caution The scanning threat detection feature can affect th 
      [bookmark: marker-1089304]e ASA performance and memory significantly while it creates and gathers host- and subnet-based data structure and information. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1088839][bookmark: 76443]Guidelines and Limitations

 
     [bookmark: pgfId-1088840]This section includes the guidelines and limitations for this feature:

 
     [bookmark: pgfId-1088850]Security Context Guidelines

 
     [bookmark: pgfId-1088851]Supported in single mode only. Multiple mode is not supported.

 
     [bookmark: pgfId-1088853]Firewall Mode Guidelines

 
     [bookmark: pgfId-1088854]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1099868]Types of Traffic Monitored

 
      
      		 [bookmark: pgfId-1099869]Only through-the-box traffic is monitored; to-the-box traffic is not included in threat detection.

 
      		 [bookmark: pgfId-1099905]Traffic that is denied by an ACL does not trigger scanning threat detection; only traffic that is allowed through the ASA and that creates a flow is affected by scanning threat detection.

 
     

 
    
 
     
      [bookmark: pgfId-1089416][bookmark: 98255]Default Settings

 
     [bookmark: pgfId-1089436]Table 27-4 lists the default rate limits for scanning threat detection.

 
     [bookmark: pgfId-1089454] 

 
      
       
        
        [bookmark: pgfId-1089439]Table 27-4 [bookmark: 61136]Default Rate Limits for Scanning Threat Detection

 
        
        
         
         		 
           
           [bookmark: pgfId-1089443]Average Rate 
          
  
         		 
           
           [bookmark: pgfId-1089445]Burst Rate 
          
  
        

 
         
         		[bookmark: pgfId-1089447]5 drops/sec over the last 600 seconds.

  
         		[bookmark: pgfId-1089449]10 drops/sec over the last 20 second period.

  
        

 
         
         		[bookmark: pgfId-1089451]5 drops/sec over the last 3600 seconds.

  
         		[bookmark: pgfId-1089453]10 drops/sec over the last 120 second period.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1089660]The burst rate is calculated as the average rate every N seconds, where N is the burst rate interval. The burst rate interval is 1/30th of the rate interval or 10 seconds, whichever is larger.

 
    
 
     
      [bookmark: pgfId-1089664][bookmark: 45880]Configuring Scanning Threat Detec[bookmark: marker-1089663]tion

 
    
 
     
      [bookmark: pgfId-1065471]Detailed Steps

 
     [bookmark: pgfId-1088927] 

 
     
 
     [bookmark: pgfId-1285791]Step 1 Choose the Configuration > Firewall > Threat Detection pane, and check the Enable Scanning Threat Detection check box.

 
     [bookmark: pgfId-1285795]Step 2 (Optional) To automatically terminate a host connection when the ASA identifies the host as an attacker, check the Shun Hosts detected by scanning threat[bookmark: marker-1285796] check box.

 
     [bookmark: pgfId-1285797]Step 3 (Optional) To except host IP addresses from being shunned, enter an address in the Networks excluded from shun field.

 
     [bookmark: pgfId-1285798]You can enter multiple addresses or subnets separated by commas. To choose a network from the list of IP address objects, click the ... button.

 
     [bookmark: pgfId-1285800]Step 4 (Optional) To set [bookmark: marker-1285799]the duration of a shun for an attacking host, check the Set Shun Duration check box and enter a value between 10 and 2592000 seconds. The default length is 3600 seconds (1 hour). To restore the default value, click Set Default.

 
     [bookmark: pgfId-1285801]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1094165][bookmark: 86869][bookmark: 35999]Feature History for Scanning Threat Detection

 
     [bookmark: pgfId-1116259]Table 27-5 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
     [bookmark: pgfId-1095132] 

 
      
       
        
        [bookmark: pgfId-1095102]Table 27-5 [bookmark: 12416]Feature History for Scanning Threat Detection 

 
        
        
         
         		 
           
           [bookmark: pgfId-1116281]Feature Name 
          
  
         		 
           
           [bookmark: pgfId-1116283]Platform Releases 
          
  
         		 
           
           [bookmark: pgfId-1116285]Feature Information 
          
  
        

 
         
         		[bookmark: pgfId-1095114]Scanning threat detection

  
         		[bookmark: pgfId-1095116]8.0(2)

  
         		[bookmark: pgfId-1095183]Scanning threat detection was introduced.

 [bookmark: pgfId-1105114]The following screen was introduced: Configuration > Firewall > Threat Detection.

  
        

 
         
         		[bookmark: pgfId-1095120]Shun duration

  
         		[bookmark: pgfId-1095122]8.0(4)/8.1(2)

  
         		[bookmark: pgfId-1095125]You can now set the shun duration,

 [bookmark: pgfId-1105204]The following screen was modified: Configuration > Firewall > Threat Detection.

  
        

 
         
         		[bookmark: pgfId-1099376]Burst rate interval changed to 1/30th of the average rate.

  
         		[bookmark: pgfId-1099378]8.2(1)

  
         		[bookmark: pgfId-1099380]In earlier releases, the burst rate interval was 1/60th of the average rate. To maximize memory usage, the sampling interval was reduced to 30 times during the average rate.

  
        

 
         
         		[bookmark: pgfId-1103618]Improved memory usage

  
         		[bookmark: pgfId-1103620]8.3(1)

  
         		[bookmark: pgfId-1103622]The memory usage for threat detection was improved.

  
        

 
        
      

 
     
 
      
      [bookmark: pgfId-1095947]  
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     [bookmark: pgfId-1124391][bookmark: 30884]Configuring the Botnet Traffic Filter 
      
      
 
     
 

 
    [bookmark: pgfId-1129351]Malware is malicious software that is installed on an unknowing host. Malware that attempts network activity such as sending private data (passwords, credit card numbers, key strokes, or proprietary data) can be detected by the Botnet Traffic Filter when the malware starts a connection to a known bad IP address. The Botnet Traffic Filter checks incoming and outgoing connections against a dynamic database of known bad domain names and IP addresses (the blacklist), and then logs or blocks any suspicious activity.

 
    [bookmark: pgfId-1143051]You can also supplement the Cisco dynamic database with blacklisted addresses of your choosing by adding them to a static blacklist; if the dynamic database includes blacklisted addresses that you think should not be blacklisted, you can manually enter them into a static whitelist. Whitelisted addresses still generate syslog messages, but because you are only targeting blacklist syslog messages, they are informational.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1129352]Note If you do not want to use the Cisco dynamic database at all, because of internal requirements, you can use the static blacklist alone if you can identify all the malware sites that you want to target.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1129353]This chapter describes how to configure the Botnet Traffic Filter and includes the following sections:

 
     
     		 [bookmark: pgfId-1129357]Information About the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1129361]Licensing Requirements for the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1425710]Prerequisites for the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1129365]Guidelines and Limitations

 
     		 [bookmark: pgfId-1129369]Default Settings

 
     		 [bookmark: pgfId-1129373]Configuring the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1129377]Monitoring the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1129385]Where to Go Next

 
     		 [bookmark: pgfId-1129389]Feature History for the Botnet Traffic Filter

 
    

 
   
 
    
     [bookmark: pgfId-1129392][bookmark: 15525]Information About the Botnet Traffic Filter[bookmark: marker-1129391]

 
    [bookmark: pgfId-1129393]This section includes information about the Botnet Traffic Filter and includes the following topics:

 
     
     		 [bookmark: pgfId-1129397]Botnet Traffic Filter Address Types

 
     		 [bookmark: pgfId-1129401]Botnet Traffic Filter Actions for Known Addresses

 
     		 [bookmark: pgfId-1129405]Botnet Traffic Filter Databases

 
     		 [bookmark: pgfId-1129409]How the Botnet Traffic Filter Works

 
    

 
     
      [bookmark: pgfId-1143172][bookmark: 27639][bookmark: 92182]Botnet Traffic Filter Address Types[bookmark: marker-1143171]

 
     [bookmark: pgfId-1143173]Addresses monitored by the Botnet Traffic Filter include:

 
      
      		 [bookmark: pgfId-1143174]Known malware addresses—These addresses are on the blacklist identified by the dynamic database and the static blacklist.[bookmark: marker-1143175]

 
      		 [bookmark: pgfId-1129418]Known allowed addresses—These addresses are on the whitelist. The whitelist is useful when an address is blacklisted by the dynamic database and also identified by the static whitelist.[bookmark: marker-1129417]

 
      		 [bookmark: pgfId-1129419]Ambiguous addresses—These addresses are associated with multiple domain names, but not all of these domain names are on the blacklist. These addresses are on the  greylist .[bookmark: marker-1129420]

 
      		 [bookmark: pgfId-1129421]Unlisted addresses—These addresses are unknown, and not included on any list.

 
     

 
    
 
     
      [bookmark: pgfId-1129424][bookmark: 27410]Botnet Traffic Filter Actions for Known Addresses[bookmark: marker-1129423]

 
     [bookmark: pgfId-1129425]You can configure the Botnet Traffic Filter to log suspicious activity, and you can optionally configure it to block suspicious traffic automatically.

 
     [bookmark: pgfId-1146905]Unlisted addresses do not generate any syslog messages, but addresses on the blacklist, whitelist, and greylist generate syslog messages differentiated by type. See the “Botnet Traffic Filter Syslog Messaging” section for more information.

 
    
 
     
      [bookmark: pgfId-1129432][bookmark: 92459]Botnet Traffic Filter Databases[bookmark: marker-1129431]

 
     [bookmark: pgfId-1129433]The Botnet Traffic Filter uses two databases for known addresses. You can use both databases together, or you can disable use of the dynamic database and use the static database alone. This section includes the following topics:

 
      
      		 [bookmark: pgfId-1129437]Information About the Dynamic Database

 
      		 [bookmark: pgfId-1129441]Information About the Static Database

 
      		 [bookmark: pgfId-1129445]Information About the DNS Reverse Lookup Cache and DNS Host Cache

 
     

 
    
 
     
      [bookmark: pgfId-1129448][bookmark: 83895]Information About the Dynamic Database[bookmark: marker-1129447]

 
     [bookmark: pgfId-1129449]The Botnet Traffic Filter can receive periodic updates for the dynamic database from the Cisco update server. This database lists thousands of known bad domain names and IP addresses.

 
    
 
     
      [bookmark: pgfId-1330276]How the ASA Uses the Dynamic Database

 
     [bookmark: pgfId-1143137]The ASA uses the dynamic database as follows:

 
     [bookmark: pgfId-1142908] 1. When the domain name in a DNS reply matches a name in the dynamic database, the Botnet Traffic Filter adds the name and IP address to the DNS reverse lookup cache.

 
     [bookmark: pgfId-1142928] 2. When the infected host starts a connection to the IP address of the malware site, then the ASA sends a syslog message informing you of the suspicious activity and optionally drops the traffic if you configured the ASA to do so.

 
     [bookmark: pgfId-1142960] 3. In some cases, the IP address itself is supplied in the dynamic database, and the Botnet Traffic Filter logs or drops any traffic to that IP address without having to inspect DNS requests.

 
    
 
     
      [bookmark: pgfId-1330294]Database Files

 
     [bookmark: pgfId-1141145]The database files are downloaded from the Cisco update server, and then stored in running memory; they are not stored in flash memory.[bookmark: marker-1141144] Be sure to identify a DNS server for the ASA so that it can access the Cisco update server URL. In multiple context mode, the system downloads the database for all contexts using the admin context interface; be sure to identify a DNS server in the admin context.

 
     [bookmark: pgfId-1425225]If you need to delete the database, use theConfiguration > Firewall > Botnet Traffic Filter > Botnet Database pane Purge Botnet Database button instead. Be sure to first disable use of the database by unchecking the Use Botnet data dynamically downloaded from updater server check box in the Configuration > Firewall > Botnet Traffic Filter > Botnet Database > Dynamic Database Configuration area.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1142966]Note To filter on the domain names in the dynamic database, you need to enable DNS packet inspection with Botnet Traffic Filter snooping; the ASA looks inside the DNS packets for the domain name and associated IP address.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1330082]Database Traffic Types

 
     [bookmark: pgfId-1411386]The dynamic database includes the following types of addresses:

 
      
      		 [bookmark: pgfId-1411676]Ads—These are advertising networks that deliver banner ads, interstitials, rich media ads, pop-ups, and pop-unders for websites, spyware and adware. Some of these networks send ad-oriented HTML emails and email verification services.

 
      		 [bookmark: pgfId-1411680]Data Tracking—These are sources associated with companies and websites that offer data tracking and metrics services to websites and other online entities. Some of these also run small advertising networks.

 
      		 [bookmark: pgfId-1411684]Spyware—These are sources that distribute spyware, adware, greyware, and other potentially unwanted advertising software. Some of these also run exploits to install such software.

 
      		 [bookmark: pgfId-1411688]Malware—These are sources that use various exploits to deliver adware, spyware and other malware to victim computers. Some of these are associated with rogue online vendors and distributors of dialers which deceptively call premium-rate phone numbers.

 
      		 [bookmark: pgfId-1411692]Adult—These are sources associated with adult networks/services offering web hosting for adult content, advertising, content aggregation, registration & billing, and age verification. These may be tied to distribution of adware, spyware, and dialers.

 
      		 [bookmark: pgfId-1411395]Bot and Threat Networks—These are rogue systems that control infected computers. They are either systems hosted on threat networks or systems that are part of the botnet itself.

 
     

 
    
 
     
      [bookmark: pgfId-1411398]Information About the [bookmark: 12666]Static Database[bookmark: marker-1411397]

 
     [bookmark: pgfId-1129469]You can manually enter domain names or IP addresses (host or subnet) that you want to tag as bad names in a blacklist. Static blacklist entries are always designated with a Very High threat level. You can also enter names or IP addresses in a whitelist, so that names or addresses that appear on both the dynamic blacklist and the whitelist are identified only as whitelist addresses in syslog messages and reports. Note that you see syslog messages for whitelisted addresses even if the address is not also in the dynamic blacklist. 

 
     [bookmark: pgfId-1129473]When you add a domain name to the static database, the ASA waits 1 minute, and then sends a DNS request for that domain name and adds the domain name/IP address pairing to the DNS host cache. (This action is a background process, and does not affect your ability to continue configuring the ASA). We recommend also enabling DNS packet inspection with Botnet Traffic Filter snooping. The ASA uses Botnet Traffic Filter snooping instead of the regular DNS lookup to resolve static blacklist domain names in the following circumstances:

 
      
      		 [bookmark: pgfId-1167539]The ASA DNS server is unavailable.

 
      		 [bookmark: pgfId-1167558]A connection is initiated during the 1 minute waiting period before the ASA sends the regular DNS request.

 
     

 
     [bookmark: pgfId-1129480]If DNS snooping is used, when an infected host sends a DNS request for a name on the static database, the ASA looks inside the DNS packets for the domain name and associated IP address and adds the name and IP address to the DNS reverse lookup cache.

 
     [bookmark: pgfId-1167587]If you do not enable Botnet Traffic Filter snooping, and one of the above circumstances occurs, then that traffic will not be monitored by the Botnet Traffic Filter.

 
    
 
     
      [bookmark: pgfId-1129486][bookmark: 99577]Information About the DNS Reverse Lookup Cache and DNS Host Cache[bookmark: marker-1129485]

 
     [bookmark: pgfId-1129487]When you use the dynamic database with DNS snooping, entries are added to the DNS reverse lookup cache. If you use the static database, entries are added to the DNS host cache (see the “Information About the Static Database” section about using the static database with DNS snooping and the DNS reverse lookup cache).

 
     [bookmark: pgfId-1129491]Entries in the DNS reverse lookup cache and the DNS host cache have a time to live (TTL) value provided by the DNS server. The largest TTL value allowed is 1 day (24 hours); if the DNS server provides a larger TTL, it is truncated to 1 day maximum.

 
     [bookmark: pgfId-1129495]For the DNS reverse lookup cache, after an entry times out, the ASA renews the entry when an infected host initiates a connection to a known address, and DNS snooping occurs.

 
     [bookmark: pgfId-1129499]For the DNS host cache, after an entry times out, the ASA periodically requests a refresh for the entry.

 
     [bookmark: pgfId-1129500]For the DNS host cache, the maximum number of blacklist entries and whitelist entries is 1000 each. The number of entries in the DNS reverse lookup cache varies per model.

 
    
 
     
      [bookmark: pgfId-1129543][bookmark: 44672]How the Botnet Traffic Filter Works[bookmark: marker-1129542]

 
     [bookmark: pgfId-1129547]Figure 26-1 shows how the Botnet Traffic Filter works with the dynamic database plus DNS inspection with Botnet Traffic Filter snooping.

 
     [bookmark: pgfId-1129549]Figure 26-1 [bookmark: 54132]How the Botnet Traffic Filter Works with the Dynamic Database

 
     [bookmark: pgfId-1129553] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1129557]Figure 26-2 shows how the Botnet Traffic Filter works with the static database.

 
     [bookmark: pgfId-1129559]Figure 26-2 [bookmark: 18888]How the Botnet Traffic Filter Works with the Static Database

 
     [bookmark: pgfId-1129563] 
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     [bookmark: pgfId-1129566][bookmark: 29596]Licensing Requirements for the Botnet Traffic Filter[bookmark: marker-1129565]

 
    [bookmark: pgfId-1129567]The following table shows the licensing requirements for this feature:

 
    [bookmark: pgfId-1481733] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1481724]Model 
         
  
        		 
          
          [bookmark: pgfId-1481726]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1481728]All models

  
        		[bookmark: pgfId-1481730]You need the following licenses:

 
          
          		 [bookmark: pgfId-1481731]Botnet Traffic Filter License.

 
          		 [bookmark: pgfId-1481732]Strong Encryption (3DES/AES) License to download the dynamic database.

 
         

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1425298][bookmark: 71752]Prerequisites for the Botnet Traffic Filter

 
    [bookmark: pgfId-1425419]To use the dynamic database, identify a DNS server for the ASA so that it can access the Cisco update server URL. In multiple context mode, the system downloads the database for all contexts using the admin context interface; be sure to identify a DNS server in the admin context.

 
   
 
    
     [bookmark: pgfId-1129586][bookmark: 16098][bookmark: 58316]Guidelines and Limitations[bookmark: marker-1129585]

 
    [bookmark: pgfId-1129587]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1129589][bookmark: 87419]Context Mode Guidelines

 
    [bookmark: pgfId-1129590]Supported in single and multiple context mode.

 
    [bookmark: pgfId-1129592][bookmark: 16807]Firewall Mode Guidelines

 
    [bookmark: pgfId-1129593]Supported in routed and transparent firewall mode.

 
    [bookmark: pgfId-1129594]Failover Guidelines

 
    [bookmark: pgfId-1129595]Does not support replication of the DNS reverse lookup cache, DNS host cache, or the dynamic database in Stateful Failover.

 
    [bookmark: pgfId-1129597][bookmark: 23253]IPv6 Guidelines

 
    [bookmark: pgfId-1129598]Does not support IPv6.

 
    [bookmark: pgfId-1129599]Additional Guidelines and Limitations

 
     
     		 [bookmark: pgfId-1129600]TCP DNS traffic is not supported.

 
     		 [bookmark: pgfId-1129601]You can add up to 1000 blacklist entries and 1000 whitelist entries in the static database.

 
     		 [bookmark: pgfId-1376914]The packet tracer is not supported.

 
    

 
   
 
    
     [bookmark: pgfId-1129604][bookmark: 60355]Default Settings[bookmark: marker-1129603]

 
    [bookmark: pgfId-1129605]By default, the Botnet Traffic Filter is disabled, as is use of the dynamic database.

 
    [bookmark: pgfId-1129606]For DNS inspection, which is enabled by default, Botnet Traffic Filter snooping is disabled by default.

 
   
 
    
     [bookmark: pgfId-1129609][bookmark: 71793]Configuring the Botnet Traffic Filter[bookmark: marker-1129608]

 
    [bookmark: pgfId-1129610]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1129614]Task Flow for Configuring the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1129618]Configuring the Dynamic Database

 
     		 [bookmark: pgfId-1129622]Enabling DNS Snooping

 
     		 [bookmark: pgfId-1129626]Adding Entries to the Static Database

 
     		 [bookmark: pgfId-1129630]Enabling Traffic Classification and Actions for the Botnet Traffic Filter

 
     		 [bookmark: pgfId-1129634]Blocking Botnet Traffic Manually

 
     		 [bookmark: pgfId-1129638]Searching the Dynamic Database

 
    

 
     
      [bookmark: pgfId-1129641][bookmark: 67641]Task Flow for Configuring the Botnet Traffic Filter[bookmark: marker-1129640]

 
     [bookmark: pgfId-1129642]To configure the Botnet Traffic Filter, perform the following steps:

 
     
 
     [bookmark: pgfId-1129646]Step 1 Enable use of the dynamic database. See the “Configuring the Dynamic Database” section. 

 
     [bookmark: pgfId-1129647]This procedure enables database updates from the Cisco update server, and also enables use of the downloaded dynamic database by the ASA. Disallowing use of the downloaded database is useful in multiple context mode so you can configure use of the database on a per-context basis.

 
     [bookmark: pgfId-1129653]Step 2 (Optional) Add static entries to the database. See the “Adding Entries to the Static Database” section. 

 
     [bookmark: pgfId-1129655]This procedure lets you augment the dynamic database with domain names or IP addresses that you want to blacklist or whitelist. You might want to use the static database instead of the dynamic database if you do not want to download the dynamic database over the Internet.

 
     [bookmark: pgfId-1129659]Step 3 Enable DNS snooping. See the “Enabling DNS Snooping” section. 

 
     [bookmark: pgfId-1129660]This procedure enables inspection of DNS packets, compares the domain name with those in the dynamic database or the static database (when a DNS server for the ASA is unavailable), and adds the name and IP address to the DNS reverse lookup cache. This cache is then used by the Botnet Traffic Filter when connections are made to the suspicious address.

 
     [bookmark: pgfId-1129666]Step 4 Enable traffic classification and actions for the Botnet Traffic Filter. See the “Enabling Traffic Classification and Actions for the Botnet Traffic Filter” section. 

 
     [bookmark: pgfId-1129668]This procedure enables the Botnet Traffic Filter, which compares the source and destination IP address in each initial connection packet to the IP addresses in the dynamic database, static database, DNS reverse lookup cache, and DNS host cache, and sends a syslog message or drops any matching traffic.

 
     [bookmark: pgfId-1147156]Step 5 (Optional) Block traffic manually based on syslog message information. See the “Blocking Botnet Traffic Manually” section.

 
     [bookmark: pgfId-1147200]If you choose not to block malware traffic automatically, you can block traffic manually by configuring an access rule to deny traffic, or by using the shun command in the Command Line Interface tool to block all traffic to and from a host.

 
     [bookmark: pgfId-1129674]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1129678][bookmark: 81008][bookmark: 74091]Configuring the Dynamic Database[bookmark: marker-1129677]

 
     [bookmark: pgfId-1426241]This procedure enables database updates, and also enables use of the downloaded dynamic database by the ASA. In multiple context mode, the system downloads the database for all contexts using the admin context interface. You can configure use of the database on a per-context basis.

 
     [bookmark: pgfId-1129683]By default, downloading and using the dynamic database is disabled.

 
    
 
     
      [bookmark: pgfId-1129684]Prerequisites

 
     [bookmark: pgfId-1466403]Enable ASA use of a DNS server in the Device Management > DNS > DNS Client > DNS Lookup area. In multiple context mode, the system downloads the database for all contexts using the admin context interface; be sure to identify a DNS server in the admin context.

 
    
 
     
      [bookmark: pgfId-1425855]Detailed Steps

 
     
 
     [bookmark: pgfId-1466408]Step 1 Enable downloading of the dynamic database.

 
      
       
       		 [bookmark: pgfId-1466409]In Single mode, choose the  Configuration > Firewall > Botnet Traffic Filter > Botnet Database pane, then check the  Enable Botnet Updater Client  check box.

 
       		 [bookmark: pgfId-1466410]In multiple context mode in the System execution space, choose the  Configuration > Device Management > Botnet Database pane, then check the  Enable Botnet Updater Client check box.

 
      

 
     

 
     [bookmark: pgfId-1466411]This setting enables downloading of the dynamic database from the Cisco update server. In multiple context mode, enter this command in the system execution space. If you do not have a database already installed on the ASA, it downloads the database after approximately 2 minutes. The update server determines how often the ASA polls the server for future updates, typically every hour.

 
     [bookmark: pgfId-1466418]Step 2 (Multiple context mode only) In multiple context mode, click Apply. Then change to the context where you want to configure the Botnet Traffic Filter by double-clicking the context name in the Device List.

 
     [bookmark: pgfId-1466419]Step 3 In the Configuration > Firewall > Botnet Traffic Filter > Botnet Database > Dynamic Database Configuration area, check the Use Botnet data dynamically downloaded from updater server check box.

 
     [bookmark: pgfId-1466420]Step 4 Click Apply.

 
     [bookmark: pgfId-1466421]Step 5 (Optional) If you want to later remove the database from running memory, perform the following steps:

 
     [bookmark: pgfId-1466422] a. Disable use of the database by unchecking the Use Botnet data dynamically downloaded from updater server check box.

 
     [bookmark: pgfId-1466423] b. Click Apply.

 
     [bookmark: pgfId-1466424] c. Click Purge Botnet Database.

 
     [bookmark: pgfId-1466425] d. To redownload the database, re-check the Use Botnet data dynamically downloaded from updater server check box.

 
     [bookmark: pgfId-1466426] e. Click Apply.

 
     [bookmark: pgfId-1466427]

 
      
      
 
     
  
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1466428]Note The Fetch Botnet Database button is for testing purposes only; it downloads and verifies the dynamic database, but does not store it in running memory.

For information about the Search Dynamic Database area, see the “Searching the Dynamic Database” section.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1129800]What to Do Next

 
     [bookmark: pgfId-1129804]See the “Adding Entries to the Static Database” section.

 
    
 
     
      [bookmark: pgfId-1129808][bookmark: 22316][bookmark: 96672]Adding Entries to the Static Database[bookmark: marker-1129807]

 
     [bookmark: pgfId-1129809]The static database lets you augment the dynamic database with domain names or IP addresses that you want to blacklist or whitelist. Static blacklist entries are always designated with a Very High threat level. See the “Information About the Static Database” section for more information. 

 
    
 
     
      [bookmark: pgfId-1129813]Prerequisites

 
      
      		 [bookmark: pgfId-1129814]In multiple context mode, perform this procedure in the context execution space.

 
      		 [bookmark: pgfId-1466439]Enable ASA use of a DNS server in the Device Management > DNS > DNS Client > DNS Lookup area. In multiple context mode, enable DNS per context.

 
     

 
    
 
     
      [bookmark: pgfId-1129823]Detailed Steps

 
     [bookmark: pgfId-1129913] 

 
     
 
     [bookmark: pgfId-1466444]Step 1 Choose the Configuration > Firewall > Botnet Traffic Filter > Black or White List pane, click Add for the Whitelist or Blacklist.

 
     [bookmark: pgfId-1466445]The Enter hostname or IP Address dialog box appears.

 
     [bookmark: pgfId-1466446]Step 2 In the Addresses field, enter one or more domain names, IP addresses, and IP address/netmasks.

 
     [bookmark: pgfId-1466447]Enter multiple entries separated by commas, spaces, lines, or semi-colons. You can enter up to 1000 entries for each type.

 
     [bookmark: pgfId-1466448]Step 3 Click OK.

 
     [bookmark: pgfId-1466449]Step 4 Click Apply.

 
     [bookmark: pgfId-1466450]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1129960]What to Do Next

 
     [bookmark: pgfId-1129964]See the “Enabling DNS Snooping” section.

 
    
 
     
      [bookmark: pgfId-1129967][bookmark: 14767]Enabling DNS Snooping[bookmark: marker-1129966]

 
     [bookmark: pgfId-1129968]This procedure enables inspection of DNS packets and enables Botnet Traffic Filter snooping, which compares the domain name with those on the dynamic database or static database, and adds the name and IP address to the Botnet Traffic Filter DNS reverse lookup cache. This cache is then used by the Botnet Traffic Filter when connections are made to the suspicious address.

 
    
 
     
      [bookmark: pgfId-1129980]Prerequisites

 
      
      		 [bookmark: pgfId-1466455]In multiple context mode, perform this procedure in the context execution space.

 
      		 [bookmark: pgfId-1466456]You must first configure DNS inspection for traffic that you want to snoop using the Botnet Traffic Filter. See the “DNS Inspection” section and “Configuring a Service Policy,” for detailed information about configuring advanced DNS inspection options using the Modular Policy Framework.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1466463]Note You can also configure DNS snooping directly in the Configuration > Firewall > Service Policy Rules > Rule Actions > Protocol Inspection > Select DNS Inspect Map dialog box by checking the Enable Botnet traffic filter DNS snooping check box.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1129991]Restrictions

 
     [bookmark: pgfId-1129992]TCP DNS traffic is not supported.

 
    
 
     
      [bookmark: pgfId-1143486]Default DNS Inspection Configuration and Recommended Configuration

 
     [bookmark: pgfId-1143509]The default configuration for DNS inspection inspects all UDP DNS traffic on all interfaces, and does not have DNS snooping enabled. 

 
     [bookmark: pgfId-1143493]We suggest that you enable DNS snooping only on interfaces where external DNS requests are going. Enabling DNS snooping on all UDP DNS traffic, including that going to an internal DNS server, creates unnecessary load on the ASA.

 
     [bookmark: pgfId-1143524]For example, if the DNS server is on the outside interface, you should enable DNS inspection with snooping for all UDP DNS traffic on the outside interface. 

 
    
 
     
      [bookmark: pgfId-1129993]Detailed Steps

 
     
 
     [bookmark: pgfId-1466468]Step 1 Choose the Configuration > Firewall > Botnet Traffic Filter > DNS Snooping pane.

 
     [bookmark: pgfId-1466469]All existing service rules that include DNS inspection are listed in the table.

 
     [bookmark: pgfId-1466470]Step 2 For each rule for which you want to enable DNS snooping, in the DNS Snooping Enabled column, check the check box.

 
     [bookmark: pgfId-1466471]Step 3 Click Apply.

 
     [bookmark: pgfId-1466472]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1130116]What to Do Next

 
     [bookmark: pgfId-1130120]See the “Enabling Traffic Classification and Actions for the Botnet Traffic Filter” section.

 
    
 
     
      [bookmark: pgfId-1130123][bookmark: 30332]Enabling Traffic Classification and Actions for the Botnet Traffic Filter[bookmark: marker-1130122]

 
     [bookmark: pgfId-1130124]This procedure enables the Botnet Traffic Filter. The Botnet Traffic Filter compares the source and destination IP address in each initial connection packet to the following:

 
      
      		 [bookmark: pgfId-1143580]Dynamic database IP addresses

 
      		 [bookmark: pgfId-1143593]Static database IP addresses

 
      		 [bookmark: pgfId-1143622]DNS reverse lookup cache (for dynamic database domain names)

 
      		 [bookmark: pgfId-1143627]DNS host cache (for static database domain names)

 
     

 
     [bookmark: pgfId-1143635]When an address matches, the ASA sends a syslog message. The only additional action currently available is to drop the connection.

 
    
 
     
      [bookmark: pgfId-1130129]Prerequisites

 
     [bookmark: pgfId-1130130]In multiple context mode, perform this procedure in the context execution space.

 
    
 
     
      [bookmark: pgfId-1143537]Recommended Configuration

 
     [bookmark: pgfId-1143709]Although DNS snooping is not required, we recommend configuring DNS snooping for maximum use of the Botnet Traffic Filter (see the “Enabling DNS Snooping” section). Without DNS snooping for the dynamic database, the Botnet Traffic Filter uses only the static database entries, plus any IP addresses in the dynamic database; domain names in the dynamic database are not used.

 
     [bookmark: pgfId-1143552]We recommend enabling the Botnet Traffic Filter on all traffic on the Internet-facing interface, and enabling dropping of traffic with a severity of moderate and higher. 

 
    
 
     
      [bookmark: pgfId-1130131]Detailed Steps[bookmark: marker-1153053][bookmark: marker-1153060]

 
     [bookmark: pgfId-1130168] 

 
     
 
     [bookmark: pgfId-1466477]Step 1 Choose the Configuration > Firewall > Botnet Traffic Filter > Traffic Settings pane.

 
     [bookmark: pgfId-1466478]Step 2 To enable the Botnet Traffic Filter on specified traffic, perform the following steps:

 
     [bookmark: pgfId-1466479] a. In the Traffic Classification area, check the Traffic Classified check box for each interface on which you want to enable the Botnet Traffic Filter.

 
     [bookmark: pgfId-1466480]You can configure a global classification that applies to all interfaces by checking the Traffic Classified check box for Global (All Interfaces). If you configure an interface-specific classification, the settings for that interface overrides the global setting.

 
     [bookmark: pgfId-1466481] b. For each interface, from the ACL Used drop-down list choose either --ALL TRAFFIC-- (the default), or any ACL configured on the ASA.

 
     [bookmark: pgfId-1466485]For example, you might want to monitor all port 80 traffic on the outside interface.

 
     [bookmark: pgfId-1466488]To add or edit ACLs, click Manage ACL to bring up the ACL Manager. See the “Adding ACLs and ACEs” section in the general operations configuration guide for more information.

 
     [bookmark: pgfId-1466493]Step 3 (Optional) To treat greylisted traffic as blacklisted traffic for action purposes, in the Ambiguous Traffic Handling area, check the Treat ambiguous (greylisted) traffic as malicious (blacklisted) traffic check box.

 
     [bookmark: pgfId-1466494]If you do not enable this option, greylisted traffic will not be dropped if you configure a rule in the Blacklisted Traffic Actions area. See the “Botnet Traffic Filter Address Types” section for more information about the greylist.

 
     [bookmark: pgfId-1466498]Step 4 (Optional) To automatically drop malware traffic, perform the following steps.

 
     [bookmark: pgfId-1466502]To manually drop traffic, see the “Blocking Botnet Traffic Manually” section.

 
     [bookmark: pgfId-1466504] a. [bookmark: 11142]In the Blacklisted Traffic Actions area, click Add.

 
     [bookmark: pgfId-1466505]The Add Blacklisted Traffic Action dialog box appears.

 
     [bookmark: pgfId-1466506] b. From the Interface drop-down list, choose the interface on which you want to drop traffic. Only interfaces on which you enabled Botnet Traffic Filter traffic classification are available.

 
     [bookmark: pgfId-1466507] c. In the Threat Level area, choose one of the following options to drop traffic specific threat levels. The default level is a range between Moderate and Very High.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1466508]Note We highly recommend using the default setting unless you have strong reasons for changing the setting. 

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1466509]Value—Specify the threat level you want to drop:

 
      

 
     

 
     [bookmark: pgfId-1466510] – Very Low

 
     [bookmark: pgfId-1466511] – Low

 
     [bookmark: pgfId-1466512] – Moderate

 
     [bookmark: pgfId-1466513] – High

 
     [bookmark: pgfId-1466514] – Very High

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1466515]Note Static blacklist entries are always designated with a Very High threat level. 

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1466516]Range—Specify a range of threat levels.

 
      

 
     

 
     [bookmark: pgfId-1466517] d. In the ACL Used area, from the ACL Used drop-down list choose either --ALL TRAFFIC-- (the default), or any ACL configured on the ASA.
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     [bookmark: pgfId-1466521]Note Be sure the ACL is a subset of the traffic you specified in the Traffic Classification area.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1466524]To add or edit ACLs, click Manage to bring up the ACL Manager. See the “Adding ACLs and ACEs” section in the general operations configuration guide for more information.

 
     [bookmark: pgfId-1466530] e. [bookmark: 17738]Click OK.

 
     [bookmark: pgfId-1466531]You return to the Traffic Settings pane.

 
     [bookmark: pgfId-1466538] f. If you want to apply additional rules to a given interface, repeat steps a through e.

 
     [bookmark: pgfId-1466539]Make sure you do not specify overlapping traffic in multiple rules for a given interface. Because you cannot control the exact order that rules are matched, overlapping traffic means you do not know which command will be matched. For example, do not specify both a rule that matches --ALL TRAFFIC-- as well as a command with and ACL for a given interface. In this case, the traffic might never match the command with the ACL. Similarly, if you specify multiple commands with ACLs, make sure each ACL is unique, and that the networks do not overlap.

 
     [bookmark: pgfId-1466540]Step 5 Click Apply.

 
     [bookmark: pgfId-1466541]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1130197][bookmark: 43646]Blocking Botnet Traffic Manually[bookmark: marker-1130196]

 
     [bookmark: pgfId-1403881]If you choose not to block malware traffic automatically (see the “Enabling Traffic Classification and Actions for the Botnet Traffic Filter” section), you can block traffic manually by configuring an access rule to deny traffic, or by using the shun command in the Command Line Interface tool to block all traffic to and from a host. For some messages, you can automatically configure access rules in ASDM.

 
     [bookmark: pgfId-1130199]For example, you receive the following syslog message:

 
      
      [bookmark: pgfId-1130200]ASA-4-338002: Dynamic Filter permitted black listed TCP traffic from inside:10.1.1.45/6798 (209.165.201.1/7890) to outside:209.165.202.129/80 (209.165.202.129/80), destination 209.165.202.129 resolved from dynamic list: bad.example.com 
     
 
      
      [bookmark: pgfId-1130201]  
     
 
     [bookmark: pgfId-1130202]You can then perform one of the following actions:

 
      
      		 [bookmark: pgfId-1130203]Create an access rule to deny traffic.

 
     

 
     [bookmark: pgfId-1130204]For example, using the syslog message above, you might want to deny traffic from the infected host at 10.1.1.45 to the malware site at 209.165.202.129. Or, if there are many connections to different blacklisted addresses, you can create an ACL to deny all traffic from 10.1.1.45 until you resolve the infection on the host computer. 

 
     [bookmark: pgfId-1466556]For the following syslog messages, a reverse access rule can be automatically created from the Real Time Log Viewer:

 
     [bookmark: pgfId-1466557] – 338001, 338002, 338003, 338004 (blacklist)

 
     [bookmark: pgfId-1466558] – 338201, 338202 (greylist)

 
     [bookmark: pgfId-1466565]See “Configuring Logging,” in the general operations configuration guide and “Configuring Access Rules,” for more information about creating an access rule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1138869]Note If you create a reverse access rule form a Botnet Traffic Filter syslog message, and you do not have any other access rules applied to the interface, then you might inadvertently block all traffic. Normally, without an access rule, all traffic from a high security to a low security interface is allowed. But when you apply an access rule, all traffic is denied except traffic that you explicitly permit. Because the reverse access rule is a deny rule, be sure to edit the resulting access policy for the interface to permit other traffic.

ACLs block all future connections. To block the current connection, if it is still active, enter the clear conn command. For example, to clear only the connection listed in the syslog message, enter the clear conn address 10.1.1.45 address 209.165.202.129 command. See the command reference for more information.

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1130224]Shun the infected host.

 
     

 
     [bookmark: pgfId-1130225]Shunning blocks all connections from the host, so you should use an ACL if you want to block connections to certain destination addresses and ports. To shun a host, enter the following command in Tools > Command Line Interface. To drop the current connection as well as blocking all future connections, enter the destination address, source port, destination port, and optional protocol.

 
      
      [bookmark: pgfId-1130229]shun src_ip [dst_ip src_port dest_port [protocol]] 
     
 
      
      [bookmark: pgfId-1130230]  
     
 
     [bookmark: pgfId-1130231]For example, to block future connections from 10.1.1.45, and also drop the current connection to the malware site in the syslog message, enter:

 
      
      [bookmark: pgfId-1130235]shun 10.1.1.45 209.165.202.129 6798 80 
     
 
      
      [bookmark: pgfId-1130236]  
     
 
     [bookmark: pgfId-1130241]After you resolve the infection, be sure to remove the ACL or the shun. To remove the shun, enter no shun src_ip.

 
    
 
     
      [bookmark: pgfId-1130244][bookmark: 16884]Searching the Dynamic Database[bookmark: marker-1130243]

 
     [bookmark: pgfId-1130245]If you want to check if a domain name or IP address is included in the dynamic database, you can search the database for a string.

 
    
 
     
      [bookmark: pgfId-1130246]Detailed Steps

 
     
 
     [bookmark: pgfId-1466579]Step 1 Go to the Search Dynamic Database area:

 
      
       
       		 [bookmark: pgfId-1466580]In Single mode or within a context, choose the  Configuration > Firewall > Botnet Traffic Filter > Botnet Database Update pane.

 
       		 [bookmark: pgfId-1466581]In multiple context mode in the System execution space, choose the  Configuration > Device Management > Botnet Database Update pane.

 
      

 
     

 
     [bookmark: pgfId-1466582]Step 2 In the Search string field, enter a string at least 3 characters in length, and click Find Now.

 
     [bookmark: pgfId-1466583]The first two matches are shown. To refine your search for a more specific match, enter a longer string.

 
     [bookmark: pgfId-1466584]Step 3 To clear the displayed matches and the search string, click Clear, or you can just enter a new string and click Find Now to get a new display.

 
     [bookmark: pgfId-1466585]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1130293][bookmark: 47786]Monitoring the Botnet Traffic Filter[bookmark: marker-1130292]

 
    [bookmark: pgfId-1130294]Whenever a known address is classified by the Botnet Traffic Filter, then a syslog message is generated. You can also monitor Botnet Traffic Filter statistics and other parameters by entering commands on the ASA. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1130301]Botnet Traffic Filter Syslog Messaging

 
     		 [bookmark: pgfId-1130305]Botnet Traffic Filter Monitor Panes

 
    

 
     
      [bookmark: pgfId-1130308][bookmark: 85955]Botnet Traffic Filter Syslog Messaging[bookmark: marker-1130307]

 
     [bookmark: pgfId-1130309]The Botnet Traffic Filter generates detailed syslog messages numbered 338nnn. Messages differentiate between incoming and outgoing connections, blacklist, whitelist, or greylist addresses, and many other variables. (The greylist includes addresses that are associated with multiple domain names, but not all of these domain names are on the blacklist.)

 
     [bookmark: pgfId-1130313]See the syslog messages guide for detailed information about syslog messages.

 
     [bookmark: pgfId-1466590]For the following syslog messages, a reverse access rule can be automatically created from the Real Time Log Viewer:

 
      
      		 [bookmark: pgfId-1466591]338001, 338002, 338003, 338004 (blacklist)

 
      		 [bookmark: pgfId-1466592]338201, 338202 (greylist)

 
     

 
     [bookmark: pgfId-1466599]See “Configuring Logging,” in the general operations configuration guide.

 
    
 
     
      [bookmark: pgfId-1130315][bookmark: 66537]Botnet Traffic Filter Monitor Panes 

 
     [bookmark: pgfId-1130316]To monitor the Botnet Traffic Filter, see the following panes:

 
     [bookmark: pgfId-1130358] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1152214]Command 
          
  
         		 
           
           [bookmark: pgfId-1152216]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1152218]Home > Firewall Dashboard

  
         		[bookmark: pgfId-1152220]Shows the Top Botnet Traffic Filter Hits, which shows reports of the top 10 malware sites, ports, and infected hosts. This report is a snapshot of the data, and may not match the top 10 items since the statistics started to be collected. If you right-click an IP address, you can invoke the whois tool to learn more about the botnet site.

 
           
           		 [bookmark: pgfId-1152221]Top Malware Sites—Shows top malware sites.

 
           		 [bookmark: pgfId-1152222]Top Malware Ports—Shows top malware ports.

 
           		 [bookmark: pgfId-1152223]Top Infected Hosts—Shows the top infected hosts.

 
          

  
        

 
         
         		[bookmark: pgfId-1152226]Monitoring > Botnet Traffic Filter > Statistics

  
         		[bookmark: pgfId-1222570]Shows how many connections were classified as whitelist, blacklist, and greylist connections, and how many connections were dropped. (The greylist includes addresses that are associated with multiple domain names, but not all of these domain names are on the blacklist.) The Details button shows how many packets at each threat level were classified or dropped.

  
        

 
         
         		[bookmark: pgfId-1152232]Monitoring > Botnet Traffic Filter > Real-time Reports

  
         		[bookmark: pgfId-1152234]Generates reports of the top 10 malware sites, ports, and infected hosts monitored. The top 10 malware-sites report includes the number of connections dropped, and the threat level and category of each site. This report is a snapshot of the data, and may not match the top 10 items since the statistics started to be collected.

 [bookmark: pgfId-1466649]If you right-click a site IP address, you can invoke the whois tool to learn more about the malware site. Reports can be saved as a PDF file.

 [bookmark: pgfId-1152236] 

  
        

 
         
         		[bookmark: pgfId-1152238]Monitoring > Botnet Traffic Filter > Infected Hosts 

  
         		[bookmark: pgfId-1152307]Generates reports about infected hosts. These reports contain detailed history about infected hosts, showing the correlation between infected hosts, visited malware sites, and malware ports. The Maximum Connections option shows the 20 infected hosts with the most number of connections. The Latest Activity option shows the 20 hosts with the most recent activity. The Highest Threat Level option shows the 20 hosts that connected to the malware sites with the highest threat level. The Subnet option shows up to 20 hosts within the specified subnet.

 [bookmark: pgfId-1466704]Reports can be saved as a PDF file, as either the Current View or the Whole Buffer. The Whole Buffer option shows all buffered infected-hosts information.

 [bookmark: pgfId-1152309] 

  
        

 
         
         		[bookmark: pgfId-1152243]Monitoring > Botnet Traffic Filter > Updater Client

  
         		[bookmark: pgfId-1152245]Shows information about the updater server, including the server IP address, the next time the ASA will connect with the server, and the database version last installed.

  
        

 
         
         		[bookmark: pgfId-1152251]Monitoring > Botnet Traffic Filter > DNS Snooping

  
         		[bookmark: pgfId-1152254]Shows the Botnet Traffic Filter DNS snooping actual IP addresses and names. All inspected DNS data is included in this output, and not just matching names in the blacklist. DNS data from static entries are not included.

  
        

 
         
         		[bookmark: pgfId-1152257]Monitoring > Botnet Traffic Filter > Dynamic Database

  
         		[bookmark: pgfId-1152259]Shows information about the dynamic database, including when the dynamic database was last downloaded, the version of the database, how many entries the database contains, and 10 sample entries.

  
        

 
         
         		[bookmark: pgfId-1152262]Monitoring > Botnet Traffic Filter > ASP Table Hits

  
         		[bookmark: pgfId-1152264]Shows the Botnet Traffic Filter rules that are installed in the accelerated security path.

  
        

 
        
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1130583][bookmark: 48330]Where to Go Next

 
     
     		 [bookmark: pgfId-1466619]To configure the syslog server, see “Configuring Logging,” in the general operations configuration guide.

 
     		 [bookmark: pgfId-1466624]To block connections with an access rule, see Chapter7, “Configuring Access Rules”

 
    

 
   
 
    
     [bookmark: pgfId-1130609][bookmark: 92503]Feature History for the Botnet Traffic Filter[bookmark: marker-1130608]

 
    [bookmark: pgfId-1161744]Table 26-1 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1130637] 

 
     
      
       
       [bookmark: pgfId-1130620]Table 26-1 [bookmark: 50557]Feature History for the Botnet Traffic Filter 

 
       
       
        
        		 
          
          [bookmark: pgfId-1130626]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1130628]Platform 
         
 
          
          [bookmark: pgfId-1161739]Releases 
         
  
        		 
          
          [bookmark: pgfId-1130630]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1130632]Botnet Traffic Filter

  
        		[bookmark: pgfId-1130634]8.2(1)

  
        		[bookmark: pgfId-1130636]This feature was introduced.

  
       

 
        
        		[bookmark: pgfId-1146393]Automatic blocking, and blacklist category and threat level reporting.

  
        		[bookmark: pgfId-1146395]8.2(2)

  
        		[bookmark: pgfId-1146414]The Botnet Traffic Filter now supports automatic blocking of blacklisted traffic based on the threat level. You can also view the category and threat level of malware sites in statistics and reports.

 [bookmark: pgfId-1175318]The 1 hour timeout for reports for top hosts was removed; there is now no timeout.

 [bookmark: pgfId-1161692]The following screens were introduced or modified: Configuration > Firewall > Botnet Traffic Filter > Traffic Settings, and Monitoring > Botnet Traffic Filter > Infected Hosts.

  
       

 
       
     

 
    
 
   
 
  

 
  
  
 

OPS/nat_objects-34.jpg





OPS/inspect_basic-5.jpg
[E=
e otormncs [T i s | s
e ettt et s 8 s o
[ —

S e rre

e e e e

s s st o s by

T (e ()





OPS/nat_objects-10.jpg





OPS/modules_cx-13.jpg
[Prcaty of DINS Sarvor {lor axamplo)

Y —

ASACK Dol
Gy

SRR 10

Mot pe. H





OPS/nat_overview-14.jpg
Wb Sorvar
i e e

2
Comary N
ot z0nz
om0
cucety
fie
w0121
)
i

b2z





OPS/protect_cloud_web_security-29.jpg





OPS/nat_rules-16.jpg
—— = ) st i

[EERT— D) e
0 s e





OPS/nat_objects-89.jpg
0D e

[ —
.
!






OPS/modules_cx-20.jpg





OPS/nat_rules-24.jpg
bt e ki)






OPS/nat_objects-42.jpg





OPS/nat_rules-101.jpg
o | e

= il





OPS/nat_objects-25.jpg





OPS/unified_comm_cups-2.jpg
prste

[Em i

Cicoup
0

\ 10002

i sl

oy
oy tos
(ciseo 0P

o6 | [ o0
oo oo ||
)






OPS/nat_82-23.jpg
R

smrtbind

201082011
2001682012,

s /s

Sacuy
s
10101028

101111026

101121025

s /vt

200 16520112020

I
s a0z
200165200 12022

ontty NAT

Socuny
Ao

s /ot

w201,
w2z,






OPS/nat_overview-22.jpg
s @E@






OPS/nat_rules-95.jpg
bt e ki)






OPS/nat_rules-78.jpg





OPS/modules_ips-18.jpg





OPS/nat_objects-66.jpg
e
o
e

[P

[ e o






OPS/nat_objects-74.jpg
[Ei——






OPS/unified_comm_ucime-5.jpg





OPS/nat_rules-108.jpg
(==

i





OPS/nat_rules-62.jpg
it by b

[ B - B )

=
o i
e e





OPS/protect_cloud_web_security-14.jpg





OPS/nat_82-9.jpg
(ousw)
e antz
101227

socuty
optanca

wize
=
)

Ky |

el





OPS/nat_rules-38.jpg
ez =)
3






OPS/nat_objects-41.jpg
Web Server
o [ e
-

Tt
1012:10 > 200.16520120

o Tansistion
20016520112 - 101220

(”nﬁ«?u
o0 1052011

Secuiy
Aoprance

10121





OPS/nat_rules-116.jpg
B — P

bl 5






OPS/nat_rules-72.jpg





OPS/nat_objects-80.jpg
Boie 43 MB - i)






OPS/unified_comm_phoneproxy.html
  
   
    
     [bookmark: pgfId-1050709][bookmark: 23761]Configuring the Cisco Phone Proxy 
      
      
 
     
 

 
    [bookmark: pgfId-1050727]This chapter describes how to configure the ASA for Cisco Phone Proxy feature. 

 
    [bookmark: pgfId-1051135]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1142492]Information About the Cisco Phone Proxy

 
     		 [bookmark: pgfId-1235230]Licensing Requirements for the Phone Proxy

 
     		 [bookmark: pgfId-1235279]Prerequisites for the Phone Proxy

 
     		 [bookmark: pgfId-1235324]Phone Proxy Guidelines and Limitations

 
     		 [bookmark: pgfId-1232283]Configuring the Phone Proxy

 
     		 [bookmark: pgfId-1327946]Feature History for the Phone Proxy

 
    

 
   
 
    
     [bookmark: pgfId-1144845]Information About the Cisco Phone Proxy[bookmark: Phone Proxy]

 
    [bookmark: pgfId-1232434]The Cisco Phone Proxy on the ASA bridges IP telephony between the corporate IP telephony network and the Internet in a secure manner by forcing data from remote phones on an untrusted network to be encrypted. 

 
     
      [bookmark: pgfId-1241387]Phone Proxy Functionality

 
     [bookmark: pgfId-1241396]Telecommuters can connect their IP phones to the corporate IP telephony network over the Internet securely via the phone proxy without the need to connect over a VPN tunnel as illustrated by Figure 17-1. [bookmark: Phone Proxy]

 
     [bookmark: pgfId-1226045]Figure 17-1 [bookmark: 76282]Phone Proxy Secure Deployment 

 
     [bookmark: pgfId-1227327] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1226049] 

 
     [bookmark: pgfId-1226051][bookmark: Phone Proxy]The phone proxy supports a Cisco UCM cluster in mixed mode or nonsecure mode. Regardless of the cluster mode, the remote phones that are capable of encryption are always forced to be in encrypted mode. TLS (signaling) and SRTP (media) are always terminated on the ASA. The ASA can also perform NAT, open pinholes for the media, and apply inspection policies for the SCCP and SIP protocols. In a nonsecure cluster mode or a mixed mode where the phones are configured as nonsecure, the phone proxy behaves in the following ways:

 
      
      		 [bookmark: pgfId-1144870]The TLS connections from the phones are terminated on the ASA and a TCP connection is initiated to the Cisco UCM.

 
      		 [bookmark: pgfId-1144874]SRTP sent from external IP phones to the internal network IP phone via the ASA is converted to RTP.

 
     

 
     [bookmark: pgfId-1224990]In a mixed mode cluster where the internal IP phones are configured as authenticated, the TLS connection is not converted to TCP to the Cisco UCM but the SRTP is converted to RTP.

 
     [bookmark: pgfId-1224991]In a mixed mode cluster where the internal IP phone is configured as encrypted, the TLS connection remains a TLS connection to the Cisco UCM and the SRTP from the remote phone remains SRTP to the internal IP phone.

 
     [bookmark: pgfId-1144877]Since the main purpose of the phone proxy is to make the phone behave securely while making calls to a nonsecure cluster, the phone proxy performs the following major functions:

 
      
      		 [bookmark: pgfId-1144878]Creates the certificate trust list (CTL) file, which is used to perform certificate based authentication with remote phones.

 
      		 [bookmark: pgfId-1144879]Modifies the IP phone configuration file when it is requested via TFTP, changes security fields from nonsecure to secure, and signs all files sent to the phone. These modifications secure remote phones by forcing the phones to perform encrypted signaling and media. 

 
      		 [bookmark: pgfId-1144880]Terminates TLS signaling from the phone and initiates TCP or TLS to Cisco UCM

 
      		 [bookmark: pgfId-1144881]Inserts itself into the media path by modifying the Skinny and SIP signaling messages.

 
      		 [bookmark: pgfId-1144882]Terminates SRTP and initiates RTP/SRTP to the called party.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1279581]Note As an alternative to authenticating remote IP phones through the TLS handshake, you can configure authentication via LSC provisioning. With LSC provisioning you create a password for each remote IP phone user and each user enters the password on the remote IP phones to retrieve the LSC. 

Because using LSC provisioning to authenticate remote IP phones requires the IP phones first register in nonsecure mode, Cisco recommends LSC provisioning be done inside the corporate network before giving the IP phones to end-users. Otherwise, having the IP phones register in nonsecure mode requires the Administrator to open the nonsecure signaling port for SIP and SCCP on the ASA. 

See also the Cisco Unified Communications Manager Security Guide for information on Using the Certificate Authority Proxy Function (CAPF) to install a locally significant certificate (LSC).

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1241209][bookmark: 34457]Supported Cisco UCM and IP Phones for the Phone Proxy

 
     [bookmark: pgfId-1241211]Cisco Unified Communications Manager[bookmark: marker-1241210]

 
     [bookmark: pgfId-1241212]The following release of the Cisco Unified Communications Manager are supported with the phone proxy: 

 
      
      		 [bookmark: pgfId-1241213]Cisco Unified CallManager Version 4. x 

 
      		 [bookmark: pgfId-1241214]Cisco Unified CallManager Version 5.0

 
      		 [bookmark: pgfId-1267582]Cisco Unified CallManager Version 5.1

 
      		 [bookmark: pgfId-1241215]Cisco Unified Communications Manager 6.1

 
      		 [bookmark: pgfId-1657356]Cisco Unified Communications Manager 7.0

 
      		 [bookmark: pgfId-1657357]Cisco Unified Communications Manager 8.0

 
     

 
     [bookmark: pgfId-1657360]Cisco Unified IP Phones[bookmark: marker-1657358][bookmark: marker-1657359]

 
     [bookmark: pgfId-1374010]The phone proxy supports these IP phone features:

 
      
      		 [bookmark: pgfId-1374013]Enterprise features like conference calls on remote phones connected through the phone proxy

 
      		 [bookmark: pgfId-1374059]XML services

 
     

 
     [bookmark: pgfId-1374035]The following IP phones in the Cisco Unified IP Phones 7900 Series are supported with the phone proxy:

 
      
      		 [bookmark: pgfId-1241221]Cisco Unified IP Phone 7975

 
      		 [bookmark: pgfId-1241222]Cisco Unified IP Phone 7971

 
      		 [bookmark: pgfId-1241223]Cisco Unified IP Phone 7970

 
      		 [bookmark: pgfId-1241224]Cisco Unified IP Phone 7965

 
      		 [bookmark: pgfId-1241225]Cisco Unified IP Phone 7962

 
      		 [bookmark: pgfId-1241226]Cisco Unified IP Phone 7961

 
      		 [bookmark: pgfId-1241227]Cisco Unified IP Phone 7961G-GE

 
      		 [bookmark: pgfId-1241228]Cisco Unified IP Phone 7960 (SCCP protocol support only)

 
      		 [bookmark: pgfId-1241229]Cisco Unified IP Phone 7945

 
      		 [bookmark: pgfId-1241230]Cisco Unified IP Phone 7942

 
      		 [bookmark: pgfId-1241231]Cisco Unified IP Phone 7941

 
      		 [bookmark: pgfId-1241232]Cisco Unified IP Phone 7941G-GE

 
      		 [bookmark: pgfId-1241233]Cisco Unified IP Phone 7940 (SCCP protocol support only)

 
      		 [bookmark: pgfId-1241234]Cisco Unified Wireless IP Phone 7921

 
      		 [bookmark: pgfId-1366228]Cisco Unified Wireless IP Phone 7925 

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1366229]Note To support Cisco Unified Wireless IP Phone 7925, you must also configure MIC or LSC on the IP phone so that it properly works with the phone proxy. 

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1241235]CIPC for softphones ( CIPC versions with Authenticated mode only)

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1241236]Note The Cisco IP Communicator is supported with the phone proxy VLAN Traversal in authenticated TLS mode. We do not recommend it for remote access because SRTP/TLS is not supported currently on the Cisco IP Communicator.

 
      
      
 
     
 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1288570]Note The ASA supports inspection of traffic from Cisco IP Phones running SCCP protocol version 19 and earlier. 

 
      
      
 
     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-1232480][bookmark: 35593]Licensing Requirements for the Phone Proxy

 
    [bookmark: pgfId-1376781]The Cisco Phone Proxy feature supported by the ASA require a Unified Communications Proxy license.

 
    [bookmark: pgfId-1376821]The following table shows the Unified Communications Proxy license details by platform:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1762324]Note This feature is not available on No Payload Encryption models.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1762420] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1762327]Model 
         
  
        		 
          
          [bookmark: pgfId-1762336]License Requirement 
          1 
         
  
       

 
        
        		[bookmark: pgfId-1762338]ASA 5505

  
        		[bookmark: pgfId-1762340]Base License and Security Plus License: 2 sessions.

 [bookmark: pgfId-1762341]Optional license: 24 sessions.

  
       

 
        
        		[bookmark: pgfId-1762343]ASA 5510

  
        		[bookmark: pgfId-1762345]Base License and Security Plus License: 2 sessions.

 [bookmark: pgfId-1762346]Optional licenses: 24, 50, or 100 sessions.

  
       

 
        
        		[bookmark: pgfId-1762348]ASA 5520

  
        		[bookmark: pgfId-1762350]Base License: 2 sessions.

 [bookmark: pgfId-1762351]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762353]ASA 5540

  
        		[bookmark: pgfId-1762355]Base License: 2 sessions.

 [bookmark: pgfId-1762356]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762358]ASA 5550

  
        		[bookmark: pgfId-1762360]Base License: 2 sessions.

 [bookmark: pgfId-1762361]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762363]ASA 5580

  
        		[bookmark: pgfId-1762365]Base License: 2 sessions.

 [bookmark: pgfId-1762370]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
        
        		[bookmark: pgfId-1762372]ASA 5512-X

  
        		[bookmark: pgfId-1762374]Base License: 2 sessions.

 [bookmark: pgfId-1762375]Optional licenses: 24, 50, 100, 250, or 500 sessions.

  
       

 
        
        		[bookmark: pgfId-1762377]ASA 5515-X

  
        		[bookmark: pgfId-1762379]Base License: 2 sessions.

 [bookmark: pgfId-1762380]Optional licenses: 24, 50, 100, 250, or 500 sessions.

  
       

 
        
        		[bookmark: pgfId-1762382]ASA 5525-X

  
        		[bookmark: pgfId-1762384]Base License: 2 sessions.

 [bookmark: pgfId-1762385]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762387]ASA 5545-X

  
        		[bookmark: pgfId-1762389]Base License: 2 sessions.

 [bookmark: pgfId-1762390]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762392]ASA 5555-X

  
        		[bookmark: pgfId-1762394]Base License: 2 sessions.

 [bookmark: pgfId-1762395]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762397]ASA 5585-X with SSP-10

  
        		[bookmark: pgfId-1762399]Base License: 2 sessions.

 [bookmark: pgfId-1762400]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1762402]ASA 5585-X with SSP-20, -40, or -60

  
        		[bookmark: pgfId-1762404]Base License: 2 sessions.

 [bookmark: pgfId-1762408]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
        
        		[bookmark: pgfId-1762413]ASASM

  
        		[bookmark: pgfId-1762415]Base License: 2 sessions.

 [bookmark: pgfId-1762419]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
       
     

 
    
 
     
      
       
       		 1.[bookmark: pgfId-1762332][bookmark: 98139]The following applications use TLS proxy sessions for their connections. Each TLS proxy session used by these applications (and only these applications) is counted against the UC license limit:
- Phone Proxy
- Presence Federation Proxy
- Encrypted Voice Inspection

Other applications that use TLS proxy sessions do not count towards the UC limit, for example, Mobility Advantage Proxy (which does not require a license) and IME (which requires a separate IME license).

Some UC applications might use multiple sessions for a connection. For example, if you configure a phone with a primary and backup Cisco Unified Communications Manager, there are 2 TLS proxy connections, so 2 UC Proxy sessions are used.

You independently set the TLS proxy limit using the Configuration > Firewall > Unified Communications > TLS Proxy pane. When you apply a UC license that is higher than the default TLS proxy limit, the ASA automatically sets the TLS proxy limit to match the UC limit. The TLS proxy limit takes precedence over the UC license limit; if you set the TLS proxy limit to be less than the UC license, then you cannot use all of the sessions in your UC license.

Note: For license part numbers ending in â��K8â�� (for example, licenses under 250 users), TLS proxy sessions are limited to 1000. For license part numbers ending in â��K9â�� (for example, licenses 250 users or larger), the TLS proxy limit depends on the configuration, up to the model limit. K8 and K9 refer to whether the license is restricted for export: K8 is unrestricted, and K9 is restricted.

Note: If you clear the configuration, then the TLS proxy limit is set to the default for your model; if this default is lower than the UC license limit, then you see an error message to use the to raise the limit again (in ASDM, use the TLS Proxy pane). If you use failover and use File > Save Running Configuration to Standby Unit on the primary unit to force a configuration synchronization, the clear configure all command is generated on the secondary unit automatically, so you may see the warning message on the secondary unit. Because the configuration synchronization restores the TLS proxy limit set on the primary unit, you can ignore the warning.

You might also use SRTP encryption sessions for your connections:
- For K8 licenses, SRTP sessions are limited to 250.
- For K9 licenses, there is not limit.

Note: Only calls that require encryption/decryption for media are counted towards the SRTP limit; if passthrough is set for the call, even if both legs are SRTP, they do not count towards the limit.

 2.[bookmark: pgfId-1762369][bookmark: 21190]With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of Phone Proxy sessions is 5000.

  
      

 
      
    

 
    [bookmark: pgfId-1376834]For more information about licensing, see Chapter5, â��Managing Feature Licensesâ�� in the general operations configuration guide.

 
   
 
    
     [bookmark: pgfId-1376787][bookmark: 72167]Prerequisites for the Phone Proxy

 
    [bookmark: pgfId-1236157]This section contains the following topics:

 
     
     		 [bookmark: pgfId-1236162]Media Termination Instance Prerequisites

 
     		 [bookmark: pgfId-1246245]Certificates from the Cisco UCM

 
     		 [bookmark: pgfId-1241646]DNS Lookup Prerequisites

 
     		 [bookmark: pgfId-1241667]Cisco Unified Communications Manager Prerequisites

 
     		 [bookmark: pgfId-1241688]ACL Rules

 
     		 [bookmark: pgfId-1241992]NAT and PAT Prerequisites

 
     		 [bookmark: pgfId-1236174]Prerequisites for IP Phones on Multiple Interfaces

 
     		 [bookmark: pgfId-1236225]7960 and 7940 IP Phones Support

 
     		 [bookmark: pgfId-1241956]Cisco IP Communicator Prerequisites

 
     		 [bookmark: pgfId-1243739]Prerequisites for Rate Limiting TFTP Requests

 
     		 [bookmark: pgfId-1243801]End-User Phone Provisioning

 
    

 
     
      [bookmark: pgfId-1236241][bookmark: 96688]Media Termination Instance Prerequisites

 
     [bookmark: pgfId-1270347]The ASA must have a media termination instance [bookmark: marker-1270346]that meets the following criteria:

 
      
      		 [bookmark: pgfId-1270348]You must configure one media termination for each phone proxy on the ASA. Multiple media termination instances on the ASA are not supported. 

 
      		 [bookmark: pgfId-1270655]For the media termination instance, you can configure a global media-termination address for all interfaces or configure a media-termination address for different interfaces. However, you cannot use a global media-termination address and media-termination addresses configured for each interface at the same time.

 
      		 [bookmark: pgfId-1270641]If you configure a media termination address for multiple interfaces, you must configure an address on each interface that the ASA uses when communicating with IP phones. 

 
     

 
     [bookmark: pgfId-1267832]For example, if you had three interfaces on the ASA (one internal interface and two external interfaces) and only one of the external interfaces were used to communicate with IP phones, you would configure two media termination addresses: one on the internal interface and one on the external interface that communicated with the IP phones. 

 
      
      		 [bookmark: pgfId-1269264]Only one media-termination address can be configured per interface.

 
      		 [bookmark: pgfId-1269257]The IP addresses are publicly routable addresses that are unused IP addresses within the address range on that interface.

 
      		 [bookmark: pgfId-1267761]The IP address on an interface cannot be the same address as that interface on the ASA.

 
      		 [bookmark: pgfId-1233913]The IP addresses cannot overlap with existing static NAT pools or NAT rules.

 
      		 [bookmark: pgfId-1233914]The IP addresses cannot be the same as the Cisco UCM or TFTP server IP address. 

 
      		 [bookmark: pgfId-1267666]For IP phones behind a router or gateway, you must also meet this prerequisite. On the router or gateway, add routes to the media termination address on the ASA interface that the IP phones communicate with so that the phone can reach the media termination address.

 
     

 
    
 
     
      [bookmark: pgfId-1267669][bookmark: 79073]Certificates from the Cisco UCM

 
     [bookmark: pgfId-1245456]Import the following certificates which are stored on the Cisco UCM. These certificates are required by the ASA for the phone proxy. 

 
      
      		 [bookmark: pgfId-1245460]Cisco_Manufacturing_CA

 
      		 [bookmark: pgfId-1245461]CAP-RTP-001

 
      		 [bookmark: pgfId-1245462]CAP-RTP-002

 
      		 [bookmark: pgfId-1245541]CAPF certificate (Optional)

 
     

 
     [bookmark: pgfId-1245591]If LSC provisioning is required or you have LSC enabled IP phones, you must import the CAPF certificate from the Cisco UCM. If the Cisco UCM has more than one CAPF certificate, you must import all of them to the ASA.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1268659]Note You can configure LSC provisioning for additional end-user authentication. See the Cisco Unified Communications Manager configuration guide for information. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1246329]For example, the CA Manufacturer certificate is required by the phone proxy to validate the IP phone certificate. 

 
    
 
     
      [bookmark: pgfId-1245444][bookmark: 99635]DNS Lookup Prerequisites

 
      
      		 [bookmark: pgfId-1239075]If you have an fully qualified domain name (FQDN) configured for the Cisco UCM rather than an IP address, you must configure and enable DNS lookup on the ASA. 

 
      		 [bookmark: pgfId-1233928]After configuring the DNS lookup, make sure that the ASA can ping the Cisco UCM with the configured FQDN.

 
      		 [bookmark: pgfId-1268790]You must configure DNS lookup when you have a CAPF service enabled and the Cisco UCM is not running on the Publisher but the Publisher is configured with a FQDN instead of an IP address. 

 
     

 
    
 
     
      [bookmark: pgfId-1268792][bookmark: 28189]Cisco Unified Communications Manager Prerequisites

 
      
      		 [bookmark: pgfId-1268793]The TFTP server must reside on the same interface as the Cisco UCM.

 
      		 [bookmark: pgfId-1239173]The Cisco UCM can be on a private network on the inside but you need to have a static mapping for the Cisco UCM on the ASA to a public routable address.

 
      		 [bookmark: pgfId-1239670]If NAT is required for Cisco UCM, it must be configured on the ASA, not on the existing firewall.

 
     

 
    
 
     
      [bookmark: pgfId-1238658][bookmark: 86210]ACL Rules

 
     [bookmark: pgfId-1239368][bookmark: marker-1233930][bookmark: marker-1233931]If the[bookmark: marker-1239366][bookmark: marker-1239367] phone proxy is deployed behind an existing firewall, access-list rules to permit signaling, TFTP requests, and media traffic to the phone proxy must be configured. 

 
     [bookmark: pgfId-1239977]If NAT is configured for the TFTP server or Cisco UCMs, the translated â��globalâ�� address must be used in the ACLs.

 
     [bookmark: pgfId-1239507]Table 17-1 lists the ports that are required to be configured on the existing firewall:

 
     [bookmark: pgfId-1234043] 

 
      
       
        
        [bookmark: pgfId-1233988]Table 17-1 [bookmark: 52975]Port Configuration Requirements

 
        
        
         
         		 
           
           [bookmark: pgfId-1233996]Address 
          
  
         		 
           
           [bookmark: pgfId-1233998]Port 
          
  
         		 
           
           [bookmark: pgfId-1234000]Protocol 
          
  
         		 
           
           [bookmark: pgfId-1234002]Description 
          
  
        

 
         
         		[bookmark: pgfId-1234004]Media Termination

  
         		[bookmark: pgfId-1234006]1024-65535

  
         		[bookmark: pgfId-1234008]UDP

  
         		[bookmark: pgfId-1234010]Allow incoming SRTP

  
        

 
         
         		[bookmark: pgfId-1234012]TFTP Server

  
         		[bookmark: pgfId-1234014]69

  
         		[bookmark: pgfId-1234016]UDP

  
         		[bookmark: pgfId-1234018]Allow incoming TFTP

  
        

 
         
         		[bookmark: pgfId-1234020]Cisco UCM

  
         		[bookmark: pgfId-1234022]2443

  
         		[bookmark: pgfId-1234024]TCP

  
         		[bookmark: pgfId-1234026]Allow incoming secure SCCP

  
        

 
         
         		[bookmark: pgfId-1234028]Cisco UCM

  
         		[bookmark: pgfId-1234030]5061

  
         		[bookmark: pgfId-1234032]TCP

  
         		[bookmark: pgfId-1234034]Allow incoming secure SIP

  
        

 
         
         		[bookmark: pgfId-1234036]CAPF Service (on Cisco UCM)

  
         		[bookmark: pgfId-1234038]3804

  
         		[bookmark: pgfId-1234040]TCP

  
         		[bookmark: pgfId-1234042]Allow CAPF service for LSC provisioning

  
        

 
        
      

 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1234044]Note All these ports are configurable on the Cisco UCM, except for TFTP. These are the default values and should be modified if they are modified on the Cisco UCM. For example, 3804 is the default port for the CAPF Service. This default value should be modified if it is modified on the Cisco UCM. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1234045][bookmark: 31871]NAT and PAT Prerequisites

 
     [bookmark: pgfId-1239221]NAT Prerequisites

 
      
      		 [bookmark: pgfId-1240241]If NAT is configured for the TFTP server, the NAT configuration must be configured prior to configuring the TFTP Server for the phone proxy.

 
      		 [bookmark: pgfId-1266756]If NAT is configured for the TFTP server or Cisco UCMs, the translated â��globalâ�� address must be used in the ACLs.

 
     

 
     [bookmark: pgfId-1266758][bookmark: marker-1266757]PAT Prerequisites

 
      
      		 [bookmark: pgfId-1266759]When the Skinny inspection global port is configured to use a non-default port, then you must configure the nonsecure port as the  global_sccp_port+443 . 

 
     

 
     [bookmark: pgfId-1234053]Therefore, if global_sccp_port is 7000, then the global secure SCCP port is 7443. Reconfiguring the port might be necessary when the phone proxy deployment has more than one Cisco UCM and they must share the interface IP address or a global IP address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1234061]Note Both PAT configurationsâ��for the nonsecure and secure portsâ��must be configured. 

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1234062]When the IP phones must contact the CAPF on the Cisco UCM and the Cisco UCM is configured with static PAT (LCS provisioning is required), you must configure static PAT for the default CAPF port 3804.

 
     

 
    
 
     
      [bookmark: pgfId-1236018][bookmark: 95181]Prerequisites for [bookmark: marker-1236016][bookmark: marker-1236017]IP Phones on Multiple Interfaces

 
     [bookmark: pgfId-1236019]When IP phones reside on multiple interfaces, the phone proxy configuration must have the correct IP address set for the Cisco UCM in the CTL file. 

 
     [bookmark: pgfId-1236020]See the following example topology for information about how to correctly set the IP address:

 
      
      [bookmark: pgfId-1236021]phones --- (dmz)-----| 
     
 
      
      [bookmark: pgfId-1236022] |----- ASA PP --- (outside Internet) --- phones 
     
 
      
      [bookmark: pgfId-1236023]phones --- (inside)--| 
     
 
      
      [bookmark: pgfId-1236024]  
     
 
     [bookmark: pgfId-1236025]In this example topology, the following IP address are set:

 
      
      		 [bookmark: pgfId-1236026]Cisco UCM on the inside interface is set to 10.0.0.5

 
      		 [bookmark: pgfId-1236027]The DMZ network is 192.168.1.0/24

 
      		 [bookmark: pgfId-1236028]The inside network is 10.0.0.0/24

 
     

 
     [bookmark: pgfId-1236029]The Cisco UCM is mapped with different global IP addresses from DMZ > outside and inside interfaces > outside interface.

 
     [bookmark: pgfId-1236030]In the CTL file, the Cisco UCM must have two entries because of the two different IP addresses. For example, if the static statements for the Cisco UCM are as follows:

 
      
      [bookmark: pgfId-1236031]object network obj-10.0.0.5-01 
     
 
      
      [bookmark: pgfId-1408366]host 10.0.0.5 
     
 
      
      [bookmark: pgfId-1408367]nat (inside,outside) static 209.165.202.129 
     
 
      
      [bookmark: pgfId-1408374]object network obj-10.0.0.5-02 
     
 
      
      [bookmark: pgfId-1408375]host 10.0.0.5 
     
 
      
      [bookmark: pgfId-1408376]nat (inside,dmz) static 198.168.1.2 
     
 
      
      [bookmark: pgfId-1408369]  
     
 
     [bookmark: pgfId-1236034]There must be two CTL file record entries for the Cisco UCM:

 
      
      [bookmark: pgfId-1236035]record-entry cucm trustpoint cucm_in_to_out address 209.165.202.129 
     
 
      
      [bookmark: pgfId-1236036]record-entry cucm trustpoint cucm_in_to_dmz address 192.168.1.2 
     
 
    
 
     
      [bookmark: pgfId-1236904][bookmark: 48305]7960 and 7940 IP Phones Support

 
      
      		 [bookmark: pgfId-1236906]An LSC must be installed on these IP phones because they do not come pre installed with a MIC. Install the LSC on each phone before using them with the phone proxy to avoid opening the nonsecure SCCP port for the IP phones to register in nonsecure mode with the Cisco UCM. 

 
     

 
     [bookmark: pgfId-1236907]See the following document for the steps to install an LSC on IP phones:

 
     [bookmark: pgfId-1236909]http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/security/7_0_1/secugd/secucapf.html#wp1093518

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1236910]Note If an IP phone already has an LSC installed on it from a different Cisco UCM cluster, delete the LSC from the different cluster and install an LSC from the current Cisco UCM cluster.

 
      
      
 
     
 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1268702]Note You can configure LSC provisioning for additional end-user authentication. See the Cisco Unified Communications Manager configuration guide for information. 

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1236914]The CAPF certificate must be imported onto the ASA.

 
      		 [bookmark: pgfId-1236918]The CTL file created on the ASA must be created with a CAPF record-entry.

 
      		 [bookmark: pgfId-1236919]The phone must be configured to use only the SCCP protocol because the SIP protocol does not support encryption on these IP phones.

 
      		 [bookmark: pgfId-1236920]If LSC provisioning is done via the phone proxy, you must add an ACL to allow the IP phones to register with the Cisco UCM on the nonsecure port 2000.

 
     

 
    
 
     
      [bookmark: pgfId-1241855][bookmark: 44210][bookmark: marker-1241853]Cisco IP Communicator Prerequisites[bookmark: marker-1241854]

 
     [bookmark: pgfId-1241856]To configure Cisco IP Communicator (CIPC) with the phone proxy, you must meet the following prerequisites:

 
      
      		 [bookmark: pgfId-1738378]Go to Configuration > Firewall > Unified Communications > Phone Proxy and select the â��Enable CICP security mode authenticationâ�� check box under the Call Manager and Phone Settings area. 

 
      		 [bookmark: pgfId-1241858]Create an ACL to allow CIPC to register with the Cisco UCM in nonsecure mode.

 
      		 [bookmark: pgfId-1241859]Configure null-sha1 as one of the SSL encryption ciphers.

 
     

 
     [bookmark: pgfId-1241861]Current versions of Cisco IP Communicator (CIPC) support authenticated mode and perform TLS signaling but not voice encryption. 

 
     [bookmark: pgfId-1241862]Because CIPC requires an LSC to perform the TLS handshake, CIPC needs to register with the Cisco UCM in nonsecure mode using cleartext signaling. To allow the CIPC to register, create an ACL that allows the CIPC to connect to the Cisco UCM on the nonsecure SIP/SCCP signalling ports (5060/2000). 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1268747]Note You can configure LSC provisioning for additional end-user authentication. See the Cisco Unified Communications Manager configuration guide for information. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1241863]CIPC uses a different cipher when doing the TLS handshake and requires the null-sha1 cipher and SSL encryption be configured. To add the null-shal cipher, use the show run all ssl command to see the output for the ssl encryption command and add null-shal to the end of the SSL encryption list. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1278770]Note When used with CIPC, the phone proxy does not support end-users resetting their device name in CIPC (Preferences > Network tab > Use this Device Name field) or Administrators resetting the device name in Cisco Unified CM Administration console (Device menu > Phone Configuration > Device Name field). To function with the phone proxy, the CIPC configuration file must be in the format: SEP<mac_address>.cnf.xml. If the device name does not follow this format (SEP<mac_address>), CIPC cannot retrieve its configuration file from Cisco UMC via the phone proxy and CIPC will not function. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1243583][bookmark: 77636]Prerequisites for Rate Limiting TFTP [bookmark: marker-1243581]Requests[bookmark: marker-1243582] 

 
     [bookmark: pgfId-1243584]In a remote access scenario, we recommend that you configure rate limiting of TFTP requests because any IP phone connecting through the Internet is allowed to send TFTP requests to the TFTP server. 

 
     [bookmark: pgfId-1243585]To configure rate limiting of TFTP requests, configure the police command in the Modular Policy Framework. See the command reference for information about using the police command. 

 
     [bookmark: pgfId-1243589]Policing is a way of ensuring that no traffic exceeds the maximum rate (in bits/second) that you configure, thus ensuring that no one traffic flow can take over the entire resource. When traffic exceeds the maximum rate, the ASA drops the excess traffic. Policing also sets the largest single burst of traffic allowed. 

 
    
 
     
      [bookmark: pgfId-1243593]Rate Limiting Configuration Example

 
     [bookmark: pgfId-1243594]The following example describes how you configure rate limiting for TFTP requests by using the police command and the Modular Policy Framework.

 
     [bookmark: pgfId-1243599]X = requests per second

 
     [bookmark: pgfId-1243600]Y = size of each packet, which includes the L2, L3, and L4 plus the payload

 
    
 
     
      [bookmark: pgfId-1242722][bookmark: 47105]End-User Phone Provisioning[bookmark: marker-1242720][bookmark: marker-1242721]

 
     [bookmark: pgfId-1242723]The phone proxy is a transparent proxy with respect to the TFTP and signaling transactions. If NAT is not configured for the Cisco UCM TFTP server, then the IP phones need to be configured with the Cisco UCM cluster TFTP server address. 

 
     [bookmark: pgfId-1242724]If NAT is configured for the Cisco UCM TFTP server, then the Cisco UCM TFTP server global address is configured as the TFTP server address on the IP phones.

 
    
 
     
      [bookmark: pgfId-1242832]Ways to Deploy IP Phones to End Users

 
     [bookmark: pgfId-1243049]In both options, deploying a remote IP phone behind a commercial Cable/DSL router with NAT capabilities is supported. 

 
     [bookmark: pgfId-1243013]Option 1 (Recommended)

 
     [bookmark: pgfId-1242873]Stage the IP phones at corporate headquarters before sending them to the end users:

 
      
      		 [bookmark: pgfId-1242726]The phones register inside the network. IT ensures there are no issues with the phone configurations, image downloads, and registration.

 
      		 [bookmark: pgfId-1242727]If Cisco UCM cluster was in mixed mode, the CTL file should be erased before sending the phone to the end user.

 
     

 
     [bookmark: pgfId-1242728]Advantages of this option are:

 
      
      		 [bookmark: pgfId-1242729]Easier to troubleshoot and isolate problems with the network or phone proxy because you know whether the phone is registered and working with the Cisco UCM.

 
      		 [bookmark: pgfId-1242730]Better user experience because the phone does not have to download firmware from over a broadband connection, which can be slow and require the user to wait for a longer time. 

 
     

 
     [bookmark: pgfId-1242731]Option 2

 
     [bookmark: pgfId-1242897]Send the IP phone to the end user. When using option 2, the user must be provided instructions to change the settings on phones with the appropriate Cisco UCM and TFTP server IP address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1277999]Note As an alternative to authenticating remote IP phones through the TLS handshake, you can configure authentication via LSC provisioning. With LSC provisioning you create a password for each remote IP phone user and each user enters the password on the remote IP phones to retrieve the LSC. 

Because using LSC provisioning to authenticate remote IP phones requires the IP phones first register in nonsecure mode, Cisco recommends LSC provisioning be done inside the corporate network before giving the IP phones to end-users. Otherwise, having the IP phones register in nonsecure mode requires the Administrator to open the nonsecure signaling port for SIP and SCCP on the ASA. 

See also the Cisco Unified Communications Manager Security Guide for information on Using the Certificate Authority Proxy Function (CAPF) to install a locally significant certificate (LSC).

 
      
      
 
     
 
     

 
    
 
   
 
    
     [bookmark: pgfId-1211924][bookmark: 69192]Phone Proxy Guidelines and Limitations

 
    [bookmark: pgfId-1277366]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1277367]General Guidelines and Limitations

 
     		 [bookmark: pgfId-1277708]Media Termination Address Guidelines and Limitations

 
    

 
     
      [bookmark: pgfId-1277382][bookmark: 55800]General Guidelines and Limitations

 
     [bookmark: pgfId-1211949]The phone proxy has the following general limitations:

 
      
      		 [bookmark: pgfId-1366029]Only one phone proxy instance can be configured on the ASA by using the  phone-proxy command. See the command reference for information about the  phone-proxy command. See also Creating the Phone Proxy Instance.

 
      		 [bookmark: pgfId-1366053]The phone proxy only supports one Cisco UCM cluster. See Creating the CTL File for the steps to configure the Cisco UCM cluster for the phone proxy. 

 
      		 [bookmark: pgfId-1366181]The phone proxy is not supported when the ASA is running in transparent mode or multiple context mode. 

 
      		 [bookmark: pgfId-1366129]When a remote IP phone calls an invalid internal or external extension, the phone proxy does not support playing the annunciator message from the Cisco UCM. Instead, the remote IP phone plays a fast busy signal instead of the annunciator message "Your call cannot be completed ..." However, when an internal IP phone dials in invalid extension, the annunciator messages plays "Your call cannot be completed ..."

 
      		 [bookmark: pgfId-1366188]Packets from phones connecting to the phone proxy over a VPN tunnel are not inspected by the ASA inspection engines. 

 
      		 [bookmark: pgfId-1366196]The phone proxy does not support IP phones sending Real-Time Control Protocol (RTCP) packets through the ASA. Disable RTCP packets in the Cisco Unified CM Administration console from the Phone Configuration page. See your Cisco Unified Communications Manager (CallManager) documentation for information about setting this configuration option. 

 
      		 [bookmark: pgfId-1278733]When used with CIPC, the phone proxy does not support end-users resetting their device name in CIPC (Preferences > Network tab > Use this Device Name field) or Administrators resetting the device name in Cisco Unified CM Administration console (Device menu > Phone Configuration > Device Name field). To function with the phone proxy, the CIPC configuration file must be in the format: SEP<mac_address>.cnf.xml. If the device name does not follow this format (SEP<mac_address>), CIPC cannot retrieve its configuration file from Cisco UMC via the phone proxy and CIPC will not function. 

 
      		 [bookmark: pgfId-1269801]The phone proxy does not support IP phones sending SCCP video messages using Cisco VT Advantage because SCCP video messages do not support SRTP keys. 

 
      		 [bookmark: pgfId-1276734]For mixed-mode clusters, the phone proxy does not support the Cisco Unified Call Manager using TFTP to send encrypted configuration files to IP phones through the ASA.

 
      		 [bookmark: pgfId-1276896]Multiple IP phones behind one NAT device must be configured to use the same security mode.

 
     

 
     [bookmark: pgfId-1276897]When the phone proxy is configured for a mixed-mode cluster and multiple IP phones are behind one NAT device and registering through the phone proxy, all the SIP and SCCP IP phones must be configured as authenticated or encrypted, or all as non-secure on the Unified Call Manager.

 
     [bookmark: pgfId-1276898]For example, if there are four IP phones behind one NAT device where two IP phones are configured using SIP and two IP phones are configured using SCCP, the following configurations on the Unified Call Manager are acceptable:

 
     [bookmark: pgfId-1276899] â�� Two SIP IP phones: one IP phone in authenticated mode and one in encrypted mode, both in authenticated mode, or both in encrypted mode

 
     [bookmark: pgfId-1276900]Two SCCP IP phones: one IP phone in authenticated mode and one in encrypted mode, both in authenticated mode, or both in encrypted mode

 
     [bookmark: pgfId-1276901] â�� Two SIP IP phones: both in non-secure mode

 
     [bookmark: pgfId-1276902]Two SCCP IP phones: one IP phone in authenticated mode and one in encrypted mode, both in authenticated mode, both in encrypted mode

 
     [bookmark: pgfId-1276903] â�� Two SIP IP phones: one IP phone in authenticated mode and one in encrypted mode, both in authenticated mode, both in encrypted mode

 
     [bookmark: pgfId-1276904]Two SCCP IP phones: both in non-secure mode

 
     [bookmark: pgfId-1276905]This limitation results from the way the application-redirect rules (rules that convert TLS to TCP) are created for the IP phones. 

 
    
 
     
      [bookmark: pgfId-1277354][bookmark: 91454]Media Termination Address Guidelines and Limitations

 
     [bookmark: pgfId-1277568]The phone proxy has the following limitations relating to configuring the media-termination address:

 
      
      		 [bookmark: pgfId-1277509]When configuring the media-termination address, the phone proxy does not support having internal IP phones (IP phones on the inside network) being on a different network interface from the Cisco UCM unless the IP phones are forced to use the non-secure Security mode. 

 
     

 
     [bookmark: pgfId-1277510]When internal IP phones are on a different network interface than the Cisco UCM, the IP phones signalling sessions still go through ASA; however, the IP phone traffic does not go through the phone proxy. Therefore, Cisco recommends that you deploy internal IP phones on the same network interface as the Cisco UMC. 

 
     [bookmark: pgfId-1277514]If the Cisco UMC and the internal IP phones must be on different network interfaces, you must add routes for the internal IP phones to access the network interface of the media-termination address where Cisco UMC resides. 

 
     [bookmark: pgfId-1277515]When the phone proxy is configured to use a global media-termination address, all IP phones see the same global address, which is a public routable address.

 
      
      		 [bookmark: pgfId-1277647]If you decide to configure a media-termination address on interfaces (rather than using a global interface), you must configure a media-termination address on at least two interfaces (the inside and an outside interface) before applying the phone-proxy service policy. Otherwise, you will receive an error message when enabling the Phone Proxy with SIP and Skinny Inspection.

 
      		 [bookmark: pgfId-1277648]The phone proxy can use only one type of media termination instance at a time; for example, you can configure a global media-termination address for all interfaces or configure a media-termination address for different interfaces. However, you cannot use a global media-termination address and media-termination addresses configured for each interface at the same time. 

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1269804][bookmark: 33336]Configuring the Phone Proxy

 
    [bookmark: pgfId-1144893]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1738391]Task Flow for Configuring the Phone Proxy

 
     		 [bookmark: pgfId-1256321]Creating the CTL File

 
     		 [bookmark: pgfId-1738399]Adding or Editing a Record Entry in a CTL File

 
     		 [bookmark: pgfId-1273210]Creating the Media Termination Instance

 
     		 [bookmark: pgfId-1273214]Creating the Phone Proxy Instance

 
     		 [bookmark: pgfId-1738407]Adding or Editing the TFTP Server for a Phone Proxy

 
     		 [bookmark: pgfId-1194546]Configuring Linksys Routers with UDP Port Forwarding for the Phone Proxy

 
    

 
     
      [bookmark: pgfId-1738413][bookmark: 96820]Task Flow for Configuring the Phone Proxy 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738414]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738415]Configuring the Phone Proxy requires the following steps:

 
     [bookmark: pgfId-1738419]Step 1: Create the CTL file. See Creating the CTL File. 

 
     [bookmark: pgfId-1738422]Step 2: Create the TLS Proxy instance to handle the encrypted signaling. See Adding a TLS Proxy Instance. 

 
     [bookmark: pgfId-1738426]Step 3: Create the Phone Proxy instance. See the â��Creating the Phone Proxy Instanceâ�� section.

 
     [bookmark: pgfId-1738430]Step 4: Configure the media termination address for the Phone Proxy. See Creating the Media Termination Instance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738432]Note Before you enable SIP and Skinny inspection for the Phone Proxy (which is done by applying the Phone Proxy to a service policy rule), the Phone Proxy must have an MTA instance, TLS Proxy, and CTL file assigned to it before the Phone Proxy can be applied to a service policy. Additionally, once a Phone Proxy is applied to a service policy rule, the Phone Proxy cannot be changed or removed. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738436]Step 5: Enable the Phone Proxy with SIP and Skinny inspection. See SIP Inspection and Skinny (SCCP) Inspection. 

 
    
 
     
      [bookmark: pgfId-1244195][bookmark: 18944][bookmark: 43097][bookmark: 65827]Creating the CTL File

 
     [bookmark: pgfId-1738444]Create a Certificate Trust List (CTL) file that is required by the Phone Proxy. Specify the certificates needed by creating a new CTL file or by specifying the path of an exiting CTL file to parse from Flash memory. 

 
     [bookmark: pgfId-1738445]Create trustpoints and generate certificates for each entity in the network (CUCM, CUCM and TFTP, TFTP server, CAPF) that the IP phones must trust. The certificates are used in creating the CTL file. You need to create trustpoints for each CUCM (primary and secondary if a secondary CUCM is used) and TFTP server in the network. The trustpoints need to be in the CTL file for the phones to trust the CUCM.

 
     [bookmark: pgfId-1738446]Create the CTL File that will be presented to the IP phones during the TFTP. The address must be the translated or global address of the TFTP server or CUCM if NAT is configured.

 
     [bookmark: pgfId-1738447]When the file is created, it creates an internal trustpoint used by the Phone Proxy to sign the TFTP files. The trustpoint is named _internal_PP_ctl-instance_filename. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738448]Note When a CTL file instance is assigned to the Phone Proxy, you cannot modify it in the CTL File pane and the pane is disabled. To modify a CTL File that is assigned to the Phone Proxy, go to the Phone Proxy pane (Configuration > Firewall > Unified Communications > Phone Proxy), and deselect the Use the Certificate Trust List File generated by the CTL instance check box. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738449]Use the Create a Certificate Trust List (CTL) File pane to create a CTL file for the Phone Proxy. This pane creates the CTL file that is presented to the IP phones during the TFTP handshake with the ASA. For a detailed overview of the CTL file used by the Phone Proxy, see the â��Creating the CTL Fileâ�� section.

 
     [bookmark: pgfId-1738456]The Create a Certificate Trust List (CTL) File pane is used to configure the attributes for generating the CTL file. The name of the CTL file instance is generated by the ASDM. When the user tries to edit the CTL file instance configuration, the ASDM automatically generates the shutdown CLI command first and the no shutdown CLI command as the last command.

 
     [bookmark: pgfId-1738457]This pane is available from the Configuration > Firewall > Unified Communications > CTL File pane. 

 
     
 
     [bookmark: pgfId-1738459]Step 1 Open the Configuration > Firewall > Unified Communications > CTL File pane. 

 
     [bookmark: pgfId-1738460]Step 2 Check the Enable Certificate Trust List File check box to enable the feature. 

 
     [bookmark: pgfId-1738461]Step 3 To specify the CTL file to use for the Phone Proxy, perform one of the following:

 
      
       
       		 [bookmark: pgfId-1738462]If there is an existing CTL file available, download the CTL file to Flash memory by using the File Management Tool in the ASDM Tools menu. Select the Use certificates present in the CTL stored in flash radio button and specify the CTL file name and path in the text box.

 
      

 
     

 
     [bookmark: pgfId-1738463]Use an existing CTL file to install the trustpoints for each entity in the network (CUCM, CUCM and TFTP, TFTP server, CAPF) that the IP phones must trust. If you have an existing CTL file that contains the correct IP addresses of the entities (namely, the IP address that the IP phones use for the CUCM or TFTP servers), you can be use it to create a new CTL file. Store a copy of the existing CTL file to Flash memory and rename it something other than CTLFile.tlv 

 
      
       
       		 [bookmark: pgfId-1738464]If there is no existing CTL file available, select Create new CTL file radio button.

 
      

 
     

 
     [bookmark: pgfId-1738465]Add Record entries for each entity in the network such as CUCM, TFTP, and CUCM-TFTP option by clicking Add. The Add Record Entry dialog box opens. See Adding or Editing a Record Entry in a CTL File.

 
     [bookmark: pgfId-1738469]Step 4 Specify the number SAST certificate tokens required. The default is 2. maximum allowed is 5.

 
     [bookmark: pgfId-1738470]Because the Phone Proxy generates the CTL file, it needs to create the System Administrator Security Token (SAST) key to sign the CTL file itself. This key can be generated on the ASA. A SAST is created as a self-signed certificate. Typically, a CTL file contains more than one SAST. In case a SAST is not recoverable, the other one can be used to sign the file later. 

 
     [bookmark: pgfId-1738474]Step 5 Click Apply to save the CTL file configuration settings. 

 
     [bookmark: pgfId-1738475]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1738478][bookmark: 43327]Adding or Editing a Record Entry in a CTL File

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738479]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738480]Use the Add/Edit Record Entry dialog box to specify the trustpoints to be used for the creation of the CTL file. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738481]Note You can edit an entry in the CTL file by using the Edit Record Entry dialog box; however, changing a setting in this dialog box does not change related settings for the phone proxy. For example, editing the IP address for the CUCM or TFTP servers in this dialog changes the setting only in the CTL file and does not change the actual addresses of those servers or update the address translations required by the phone proxy. 
To modify CTL file settings, we strongly recommend you re-run the Unified Communications Wizard to edit CTL file settings and ensure proper synchronization with all phone proxy settings. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738482]Add additional record-entry configurations for each entity that is required in the CTL file.

 
     
 
     [bookmark: pgfId-1738483]Step 1 Open the Configuration > Firewall > Unified Communications > CTL File pane. 

 
     [bookmark: pgfId-1738484]Step 2 Check the Enable Certificate Trust List File check box to enable the feature. 

 
     [bookmark: pgfId-1738485]Step 3 In the Type field, specify the type of trustpoint to create: 

 
      
      		 [bookmark: pgfId-1738486]cucm: Specifies the role of this trustpoint to be CCM. Multiple CCM trustpoints can be configured.

 
      		 [bookmark: pgfId-1738487]cucm-tftp: Specifies the role of this trustpoint to be CCM+TFTP. Multiple CCM+TFTP trustpoints can be configured.

 
      		 [bookmark: pgfId-1738488]tftp: Specifies the role of this trustpoint to be TFTP. Multiple TFTP trustpoints can be configured.

 
      		 [bookmark: pgfId-1738489]capf: Specifies the role of this trustpoint to be CAPF. Only one CAPF trustpoint can be configured.

 
     

 
     [bookmark: pgfId-1738490]Step 4 In the Host field, specify the IP address of the trustpoint. The IP address you specify must be the global address of the TFTP server or CUCM if NAT is configured. The global IP address is the IP address as seen by the IP phones because it will be the IP address used for the CTL record for the trustpoint.

 
     [bookmark: pgfId-1738491]Step 5 In the Certificate field, specify the Identity Certificate for the record entry in the CTL file. You can create a new Identity Certificate by clicking Manage. The Manage Identify Certificates dialog box opens. See the â��Configuring Identity Certificates Authenticationâ�� section in the general operations configuration guide. 

 
     [bookmark: pgfId-1738498]You can add an Identity Certificate by generating a self-signed certificate, obtaining the certificate through SCEP enrollment, or by importing a certificate in PKCS-12 format. Choose the best option based on the requirements for configuring the CTL file.

 
     [bookmark: pgfId-1738499]Step 6 (Optional) In the Domain Name field, specify the domain name of the trustpoint used to create the DNS field for the trustpoint. This is appended to the Common Name field of the Subject DN to create the DNS Name. The domain name should be configured when the FQDN is not configured for the trustpoint. Only one domain-name can be specified.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738500]Note If you are using domain names for your CUCM and TFTP server, you must configure DNS lookup on the ASA. Add an entry for each of the outside interfaces on the ASA into your DNS server, if such entries are not already present. Each ASA outside IP address should have a DNS entry associated with it for lookups. These DNS entries must also be enabled for Reverse Lookup. Additionally, define your DNS server IP address on the ASA; for example: dns name-server 10.2.3.4 (IP address of your DNS server).

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1254442][bookmark: 55657][bookmark: 72023]Creating the Media Termination Instance

 
     [bookmark: pgfId-1270852]Create the media termination instance that you will use in the phone proxy.

 
     [bookmark: pgfId-1286604]The media termination address you configure must meet the requirements as described in Media Termination Instance Prerequisites.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738517]Note In versions before 8.2(1), you configured one media-termination address (MTA) on the outside interface of the adaptive security appliance where the remote Cisco IP phones were located. In Version 8.2(1) and later, you can configure a global media-termination address for all interfaces or configure a media-termination address for different interfaces.

As a result of this enhancement, the old configuration has been deprecated. You can continue to use the old configuration if desired. However, if you need to change the configuration at all, only the new configuration method is accepted; you cannot later restore the old configuration. If you need to maintain downgrade compatibility, you should keep the old configuration as is.

 
      
      
 
     
 
     

 
     
 
     [bookmark: pgfId-1738518]Step 1 Open the Configuration > Firewall > Unified Communications > Media Termination Address pane. 

 
     [bookmark: pgfId-1738519]Step 2 Check the Enable Media Termination Address check box to enable the feature. 

 
     [bookmark: pgfId-1738520]Step 3 In the Media Termination Address Settings area, specify whether to configure a media-termination address (MTA) per interface or to configure a global MTA. You can configure a global media-termination address for all interfaces or configure a media-termination address for different interfaces. 

 
      
       
       		 [bookmark: pgfId-1738521]To configure an MTA per interface, click the Configure MTA per Interface radio button and click the Add button. In the dialog box that appears, specify the interface name and enter an IP address or hostname. 

 
      

 
     

 
     [bookmark: pgfId-1738522]If you configure a media termination address for multiple interfaces, you must configure an address on each interface that the ASA uses when communicating with IP phones. The IP addresses are publicly routable addresses that are unused IP addresses within the address range on that interface.

 
     [bookmark: pgfId-1738529]See Media Termination Instance Prerequisites for the complete list of requirements that you must follow when creating the media termination instance and configuring the media termination addresses.

 
      
       
       		 [bookmark: pgfId-1738530]To configure a global MTA, click the Configure global MTA on interface radio button and enter the IP address in the text box. See Media Termination Instance Prerequisites for the complete list of requirements that you must follow when configuring a global media termination address.

 
      

 
     

 
     [bookmark: pgfId-1738534]Step 4 Specify the minimum and maximum values for the RTP port range for the media termination instance. The minimum port and the maximum port can be a value from 1024 to 65535.

 
     [bookmark: pgfId-1738535]Step 5 Click Apply to save the media termination address configuration settings.

 
     [bookmark: pgfId-1738536]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1270838][bookmark: 70241]Creating the Phone Proxy Instance

 
     [bookmark: pgfId-1248338]Create the phone proxy instance. To have a fully functional phone proxy, you must also complete additional tasks, such as creating the MTA and enabling SIP and SCCP (Skinny) inspection. See Task Flow for Configuring the Phone Proxy for the complete list of tasks. 

 
     [bookmark: pgfId-1297571]Prerequisites

 
     [bookmark: pgfId-1297574]You must have already created the CTL file and TLS proxy instance for the phone proxy. 

 
     [bookmark: pgfId-1738561]See Creating the CTL File and Adding a TLS Proxy Instance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738566]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738567]Use the Configure Phone Proxy pane to add a Phone Proxy.

 
     [bookmark: pgfId-1738568]This pane is available from the Configuration > Firewall > Unified Communications > Phone Proxy pane. 

 
     
 
     [bookmark: pgfId-1738569]Step 1 Open the Configuration > Firewall > Unified Communications > Phone Proxy pane. 

 
     [bookmark: pgfId-1738570]Step 2 Check the Enable Phone Proxy check box to enable the feature. 

 
     [bookmark: pgfId-1738571]Step 3 Check the Apply MTA instance to Phone Proxy check box to add the media termination address to the Phone Proxy instance. You must have a media termination address instance configured. The configured address is added to the Phone Proxy instance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738572]Note To configure the media termination address, click the Configure MTA button. The Media Termination Address dialog box appears. Once you click the Add MTA instance to Phone Proxy check box, the media termination address instance cannot be modified and the button changes to View MTA Configuration. To change the media termination address, uncheck the Add MTA instance to Phone Proxy check box. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738573]Step 4 If necessary, add a TFTP server for the Phone Proxy. To add a new TFTP server for the Phone Proxy, click Add. The Add TFTP Server dialog box opens. See Adding or Editing the TFTP Server for a Phone Proxy. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738577]Note The TFTP server must reside on the same interface as the Cisco Unified Call Manager. Additionally, If NAT is configured for the TFTP server, the NAT configuration must be configured prior to configuring the specifying the TFTP server while creating the Phone Proxy instance. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738578]Step 5 Specify the CTL File to use for the Phone Proxy by doing one of the following:

 
      
       
       		 [bookmark: pgfId-1738579]To use an existing CTL File, check the Use the Certificate Trust List File generated by the CTL instance check box.

 
       		 [bookmark: pgfId-1738580]To create a new CTL file for the Phone Proxy, click the link Generate Certificate Trust List File. The Create a Certificate Trust List (CTL) File pane opens. See â��Creating the CTL Fileâ�� section. 

 
      

 
     

 
     [bookmark: pgfId-1738584]Step 6 To specify the security mode of the CUCM cluster, click one of the following options in the CUCM Cluster Mode field:

 
      
       
       		 [bookmark: pgfId-1738585]Non-secureâ��Specifies the cluster mode to be in nonsecure mode when configuring the Phone Proxy feature.

 
       		 [bookmark: pgfId-1738586]Mixedâ��Specifies the cluster mode to be in mixed mode when configuring the Phone Proxy feature.

 
      

 
     

 
     [bookmark: pgfId-1738587]Step 7 To configure the idle timeout after which the secure-phone entry is removed from the Phone Proxy database (the default is 5 minutes), enter a value in the format hh:mm:ss.

 
     [bookmark: pgfId-1738588]Since secure phones always request a CTL file upon bootup, the Phone Proxy creates a database that marks the phone as secure. The entries in the secure phone database are removed after a specified configured timeout. The entry timestamp is updated for each registration refresh the Phone Proxy receives for SIP phones and KeepAlives for SCCP phones.

 
     [bookmark: pgfId-1738589]Specify a value that is greater than the maximum timeout value for SCCP KeepAlives and SIP Register refresh. For example, if the SCCP KeepAlives are configured for 1 minute intervals and the SIP Register Refresh is configured for 3 minutes, configure this timeout value greater than 3 minutes.

 
     [bookmark: pgfId-1738590]Step 8 To preserve Call Manager configuration on the IP phones, check the Preserve the Call Managerâ��s configuration on the phone... check box. When this check box is uncheck, the following service settings are disabled on the IP phones: 

 
      
      		 [bookmark: pgfId-1738591]PC Port

 
      		 [bookmark: pgfId-1738592]Gratuitous ARP

 
      		 [bookmark: pgfId-1738593]Voice VLAN access

 
      		 [bookmark: pgfId-1738594]Web Access

 
      		 [bookmark: pgfId-1738595]Span to PC Port

 
     

 
     [bookmark: pgfId-1738596]Step 9 To force Cisco IP Communicator (CIPC) softphones to operate in authenticated mode when CIPC softphones are deployed in a voice and data VLAN scenario, check the Enable CIPC security mode authentication check box. 

 
     [bookmark: pgfId-1738597]Because CIPC requires an LSC to perform the TLS handshake, CIPC needs to register with the CUCM in nonsecure mode using cleartext signaling. To allow the CIPC to register, create an ACL that allows the CIPC to connect to the CUCM on the nonsecure SIP/SCCP signalling ports (5060/2000). 

 
     [bookmark: pgfId-1738598]CIPC uses a different cipher when doing the TLS handshake and requires the null-sha1 cipher and SSL encryption be configured. To add the null-shal cipher, go to Configuration > Device Management > Advanced > SSL Settings > Encryption section. Select the null-shal SSL encryption type and add it to the Available Algorithms.

 
     [bookmark: pgfId-1738599]Current versions of Cisco IP Communicator (CIPC) support authenticated mode and perform TLS signaling but not voice encryption.

 
     [bookmark: pgfId-1738600]Step 10 To configure an HTTP proxy for the Phone Proxy feature that is written into the IP phone's configuration file under the <proxyServerURL> tag, do the following:

 
     [bookmark: pgfId-1738601] a. Check the Configure a http-proxy which would be written into the phoneâ��s config file... check box.

 
     [bookmark: pgfId-1738602] b. In the IP Address field, type the IP address of the HTTP proxy and the listening port of the HTTP proxy. 

 
     [bookmark: pgfId-1738603]The IP address you enter should be the global IP address based on where the IP phone and HTTP proxy server is located. You can enter a hostname in the IP Address field when that hostname can be resolved to an IP address by the ASA (for example, DNS lookup is configured) because the ASA will resolve the hostname to an IP address. If a port is not specified, the default will be 8080. 

 
     [bookmark: pgfId-1738613] c. In the Interface field, select the interface on which the HTTP proxy resides on the ASA.

 
     [bookmark: pgfId-1342221]Setting the proxy server configuration option for the Phone Proxy allows for an HTTP proxy on the DMZ or external network in which all the IP phone URLs are directed to the proxy server for services on the phones. This setting accommodates nonsecure HTTP traffic, which is not allowed back into the corporate network. 

 
     [bookmark: pgfId-1738619]Step 11 Click Apply to save the Phone Proxy configuration settings. 

 
     [bookmark: pgfId-1738620]
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     [bookmark: pgfId-1738621]Note After creating the Phone Proxy instance, you enable it with SIP and Skinny inspection. See SIP Inspection and Skinny (SCCP) Inspection. 

However, before you enable SIP and Skinny inspection for the Phone Proxy (which is done by applying the Phone Proxy to a service policy rule), the Phone Proxy must have an MTA instance, TLS Proxy, and CTL file assigned to it before the Phone Proxy can be applied to a service policy. Additionally, once a Phone Proxy is applied to a service policy rule, the Phone Proxy cannot be changed or removed. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1738630][bookmark: 43427]Adding or Editing the TFTP Server for a Phone Proxy

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1738631]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.
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     [bookmark: pgfId-1738632]Note You can edit the TFTP server setting by using the Edit TFTP Server dialog box; however, changing a setting in this dialog box does not change related settings for the phone proxy. For example, editing the IP address for the TFTP server in this dialog does not change the setting in the CTL file and does not update the address translations required by the phone proxy. 
To modify TFTP server settings, we strongly recommend you re-run the Unified Communications Wizard to ensure proper synchronization with all phone proxy settings. 

 
      
      
 
     
 
     

 
     
 
     [bookmark: pgfId-1738633]Step 1 Open the Configuration > Firewall > Unified Communications > Phone Proxy pane. 

 
     [bookmark: pgfId-1738634]Step 2 Check the Enable Phone Proxy check box to enable the feature. 

 
     [bookmark: pgfId-1738635]Step 3 To add or edit the TFTP Server information for the phone proxy, click the Add or Edit button. The Add/Edit TFTP Server dialog box appears. 

 
     [bookmark: pgfId-1738636]Use the Add/Edit TFTP Server dialog box to specify the IP address of the TFTP server and the interface on which the TFTP server resides. 

 
     [bookmark: pgfId-1738637]The Phone Proxy must have at least one CUCM TFTP server configured. Up to five TFTP servers can be configured for the Phone Proxy. 

 
     [bookmark: pgfId-1738638]The TFTP server is assumed to be behind the firewall on the trusted network; therefore, the Phone Proxy intercepts the requests between the IP phones and TFTP server.
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     [bookmark: pgfId-1738639]Note If NAT is configured for the TFTP server, the NAT configuration must be configured prior to specifying the TFTP server while creating the Phone Proxy instance. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1738640]Step 4 In the TFTP Server IP Address field, specify the address of the TFTP server. Create the TFTP server using the actual internal IP address. 

 
     [bookmark: pgfId-1738641]Step 5 (Optional) In the Port field, specify the port the TFTP server is listening in on for the TFTP requests. This should be configured if it is not the default TFTP port 69.

 
     [bookmark: pgfId-1738642]Step 6 In the Interface field, specify the interface on which the TFTP server resides. The TFTP server must reside on the same interface as the Cisco Unified Call Manager (CUCM).

 
     [bookmark: pgfId-1738643]Step 7 Click OK to apply the settings. 

 
    
 
     
      [bookmark: pgfId-1194487][bookmark: 34120][bookmark: 66121]Configuring [bookmark: marker-1202426]Linksys Routers with UDP Port Forwarding for the Phone Proxy

 
     [bookmark: pgfId-1204758]When IP phones are behind a NAT-capable router, the router can be configured to forward the UDP ports to the IP address of the IP phone. Specifically, configure the router for UDP port forwarding when an IP phone is failing during TFTP requests and the failure is due to the router dropping incoming TFTP data packets. Configure the router to enable UDP port forwarding on port 69 to the IP phone.

 
     [bookmark: pgfId-1197186]As an alternative of explicit UDP forwarding, some Cable/DSL routers require you to designate the IP phone as a DMZ host. For Cable/DSL routers, this host is a special host that receives all incoming connections from the public network.

 
     [bookmark: pgfId-1197187]When configuring the phone proxy, there is no functional difference between an IP phone that has UDP ports explicitly forwarded or an IP phone designated as a DMZ host. The choice is entirely dependent upon the capabilities and preference of the end user.

 
    
 
     
      [bookmark: pgfId-1197188]Configuring Your Router

 
     [bookmark: pgfId-1197189]Your firewall/router needs to be configured to forward a range of UDP ports to the IP phone. This will allow the IP phone to receive audio when you make/receive calls.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1197190]Note Different Cable/DSL routers have different procedures for this configuration. Furthermore most NAT-capable routers will only allow a given port range to be forwarded to a single IP address

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1197192]The configuration of each brand/model of firewall/router is different, but the task is the same. For specific instructions for your brand and model of router, please contact the manufacturerâ��s website. 

 
     [bookmark: pgfId-1197193]Linksys Routers

 
     
 
     [bookmark: pgfId-1197195]Step 1 From your web browser, connect to the router administrative web page. For Linksys, this is typically something like http://192.168.1.1.

 
     [bookmark: pgfId-1197196]Step 2 Click Applications & Gaming or the Port Forwarding tab (whichever is present on your router).

 
     [bookmark: pgfId-1197930]Step 3 Locate the table containing the port forwarding data and add an entry containing the following values:

 
     [bookmark: pgfId-1197931] 

 
      
       
        
        [bookmark: pgfId-1197948]Table 17-2 Port Forwarding Values to Add to Router

 
        
        
         
         		 
           
           [bookmark: pgfId-1197952]Application 
          
  
         		 
           
           [bookmark: pgfId-1197954]Start 
          
  
         		 
           
           [bookmark: pgfId-1197990]End 
          
  
         		 
           
           [bookmark: pgfId-1198012]Protocol 
          
  
         		 
           
           [bookmark: pgfId-1198034]IP Address 
          
  
         		 
           
           [bookmark: pgfId-1198056]Enabled 
          
  
        

 
         
         		[bookmark: pgfId-1197956]IP phone

  
         		[bookmark: pgfId-1197958]1024

  
         		[bookmark: pgfId-1197992]65535

  
         		[bookmark: pgfId-1198014]UDP

  
         		[bookmark: pgfId-1198036]Phone IP address

  
         		[bookmark: pgfId-1198058]Checked

  
        

 
         
         		[bookmark: pgfId-1197960]TFTP

  
         		[bookmark: pgfId-1197962]69

  
         		[bookmark: pgfId-1197994]69

  
         		[bookmark: pgfId-1198016]UDP

  
         		[bookmark: pgfId-1198217]Phone IP address

  
         		[bookmark: pgfId-1198219]Checked

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1198518]Step 4 Click Save Settings. Port forwarding is configured.

 
     [bookmark: pgfId-1198520]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1330251][bookmark: 80615]Feature History for the Phone Proxy

 
     
      
       
       [bookmark: pgfId-1330262]Table 17-3 [bookmark: 12416]Feature History for Cisco Phone Proxy 

 
       
       
        
        		 
          
          [bookmark: pgfId-1330268]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1330270]Releases 
         
  
        		 
          
          [bookmark: pgfId-1330272]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1330274]Cisco Phone Proxy

  
        		[bookmark: pgfId-1330276]8.0(4)

  
        		[bookmark: pgfId-1738663]The phone proxy feature was introduced. The Phone Proxy feature was accessible in ASDM by choosing the following options:

 [bookmark: pgfId-1334042]Configuration > Firewall > Advanced > Encrypted Traffic Inspection > Phone Proxy pane 

  
       

 
        
        		[bookmark: pgfId-1330281]NAT for the media termination address

  
        		[bookmark: pgfId-1330283]8.1(2)

  
        		[bookmark: pgfId-1738669]The Media Termination fields were removed from the Phone Proxy pane and added to the Media Termination pane:
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     [bookmark: pgfId-1050709][bookmark: 69308]Configuring Cisco Intercompany Media Engine Proxy 
      
      
 
     
 

 
    [bookmark: pgfId-1050727]This chapter describes how to configure the ASA for Cisco Intercompany Media Engine Proxy. 

 
    [bookmark: pgfId-1051135]This chapter includes the following sections: 

 
     
     		 [bookmark: pgfId-1054670]Information About Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1233283]Licensing for Cisco Intercompany Media Engine

 
     		 [bookmark: pgfId-1244885]Guidelines and Limitations

 
     		 [bookmark: pgfId-1233361]Configuring Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1244881]Feature History for Cisco Intercompany Media Engine Proxy

 
    

 
   
 
    
     [bookmark: pgfId-1243793][bookmark: 81583]Information About Cisco Intercompany Media Engine Proxy

 
    [bookmark: pgfId-1146518]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1146522]Features of Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1350333]How the UC-IME Works with the PSTN and the Internet

 
     		 [bookmark: pgfId-1233426]Tickets and Passwords

 
     		 [bookmark: pgfId-1248696]Call Fallback to the PSTN

 
     		 [bookmark: pgfId-1243748]Architecture and Deployment Scenarios for Cisco Intercompany Media Engine

 
    

 
     
      [bookmark: pgfId-1243952][bookmark: 33101]Features of Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1244564]Cisco Intercompany Media Engine enables companies to interconnect on-demand, over the Internet with advanced features made available by VoIP technologies. Cisco Intercompany Media Engine allows for business-to-business federation between Cisco Unified Communications Manager clusters in different enterprises by utilizing peer-to-peer, security, and SIP protocols to create dynamic SIP trunks between businesses. A collection of enterprises work together to end up looking like one large business with inter-cluster trunks between them. 

 
     [bookmark: pgfId-1244742]The adaptive security appliance applies its existing TLS proxy, SIP Application Layer Gateway (ALG), and SIP verification features to the functioning of Cisco Intercompany Media Engine. 

 
     [bookmark: pgfId-1244562]Cisco Intercompany Media Engine has the following key features:

 
      
      		 [bookmark: pgfId-1243954]Works with existing phone numbers: Cisco Intercompany Media Engine works with the phone numbers an enterprise currently has and does not require an enterprise to learn new numbers or change providers to use Cisco Intercompany Media Engine.

 
      		 [bookmark: pgfId-1243955]Works with existing IP phones: Cisco Intercompany Media Engine works with the existing IP phones within an enterprise. However, the feature set in business-to-business calls is limited to the capabilities of the IP phones.

 
      		 [bookmark: pgfId-1243956]Does not require purchasing new services: Cisco Intercompany Media Engine does not require any new services from any service providers. Customers continue to use the PSTN connectivity they have and the Internet connectivity they have today. Cisco Intercompany Media Engine gradually moves calls off the PSTN and onto the Internet.

 
      		 [bookmark: pgfId-1243957]Provides a full Cisco Unified Communications experience: Because Cisco Intercompany Media Engine creates inter-cluster SIP trunks between enterprises, any Unified Communication features that work over the SIP trunk and only require a SIP trunk work with the Cisco Intercompany Media Engine, thus providing a Unified Communication experience across enterprises.

 
      		 [bookmark: pgfId-1243958]Works on the Internet: Cisco Intercompany Media Engine was designed to work on the Internet. It can also work on managed extranets.

 
      		 [bookmark: pgfId-1243959]Provides worldwide reach: Cisco Intercompany Media Engine can connect to any enterprise anywhere in the world, as long as the enterprise is running Cisco Intercompany Media Engine technology. There are no regional limitations. This is because Cisco Intercompany Media Engine utilizes two networks that both have worldwide reach—the Internet and the PSTN.

 
      		 [bookmark: pgfId-1243960]Allows for unlimited scale: Cisco Intercompany Media Engine can work with any number of enterprises.

 
      		 [bookmark: pgfId-1243961]Is self-learning: The system is primarily self-learning. Customers do not have to enter information about other businesses: no phone prefixes, no IP address, no ports, no domain names, nor certificates. Customers need to configure information about their own networks, and provide policy information if they want to limit the scope of Cisco Intercompany Media Engine.

 
      		 [bookmark: pgfId-1243962]Is secure: Cisco Intercompany Media Engine is secure, utilizing a large number of different technologies to accomplish this security.

 
      		 [bookmark: pgfId-1243963]Includes anti-spam: Cisco Intercompany Media Engine prevents people from setting up software on the Internet that spams enterprises with phone calls. It provides an extremely high barrier to entry.

 
      		 [bookmark: pgfId-1243964]Provides for QoS management: Cisco Intercompany Media Engine provides features that help customers manage the QoS on the Internet, such as the ability to monitor QoS of the RTP traffic in real-time and fallback to PSTN automatically if problems arise.

 
     

 
    
 
     
      [bookmark: pgfId-1332728][bookmark: 51471]How the UC-IME Works with the PSTN and the Internet

 
     [bookmark: pgfId-1333419]The Cisco Intercompany Media Engine utilizes two networks that both have worldwide reach—the Internet and the PSTN. Customers continue to use the PSTN connectivity they have. The Cisco Intercompany Media Engine gradually moves calls off the PSTN and onto the Internet. However, if QoS problems arise, the Cisco Intercompany Media Engine Proxy monitors QoS of the RTP traffic in real-time and fallbacks to PSTN automatically.

 
     [bookmark: pgfId-1332822]The Cisco Intercompany Media Engine uses information from PSTN calls to validate that the terminating side owns the number that the originated side had called. After the PSTN call terminates, the enterprises involved in the call send information about the call to their Cisco IME server. The Cisco IME server on the originating side validates the call. Figure 21-1 shows the initial call flow through the PSTN.

 
     [bookmark: pgfId-1334057]On successful verification, the terminating side creates a ticket that grants permission to the call originator to make a Cisco IME call to a specific number. See Tickets and Passwords for information.

 
     [bookmark: pgfId-1456565]Figure 21-1 [bookmark: 54686]Interaction of the UC-IME Proxy with the PSTN

 
     [bookmark: pgfId-1456569] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1244158][bookmark: 17233]Tickets and Passwords

 
     [bookmark: pgfId-1247647]Cisco Intercompany Media Engine utilizes tickets and passwords to provide enterprise verification. Verification through the creation of tickets ensures an enterprise is not subject to denial-of-service (DOS) attacks from the Internet or endless VoIP spam calls. Ticket verification prevents spam and DOS attacks because it introduces a cost to the VoIP caller; namely, the cost of a PSTN call. A malicious user cannot set up just an open source asterisk PBX on the Internet and begin launching SIP calls into an enterprise running Cisco Intercompany Media Engine. Having the Cisco Intercompany Media Engine Proxy verify tickets allows incoming calls from a particular enterprise to a particular number only when that particular enterprise has previously called that phone number on the PSTN.

 
     [bookmark: pgfId-1247822]To send a spam VoIP call to every phone within an enterprise, an organization would have to purchase the Cisco Intercompany Media Engine and Cisco Unified Communications Manager and have called each phone number within the enterprise over the PSTN and completed each call successfully. Only then can it launch a VoIP call to each number. 

 
     [bookmark: pgfId-1423410]The Cisco Intercompany Media Engine server creates tickets and the ASA validates them. The ASA and Cisco Intercompany Media Engine server share a password that is configured so that the ASA detects the ticket was created by a trusted Cisco Intercompany Media Engine server. The ticket contains information that indicates that the enterprise is authorized to call specific phone numbers at the target enterprise. See Figure 21-2 for the ticket verification process and how it operates between the originating and terminating-call enterprises. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1423417]Note Because the initial calls are over the PSTN, they are subject to any national regulations regarding telemarketing calling. For example, within the United States, they would be subject to the national do-not-call registry.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1244166]Figure 21-2 [bookmark: 49964]Ticket Verification Process with Cisco Intercompany Media Engine

 
     [bookmark: pgfId-1308546] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1244173]As illustrated in Figure 21-2. Enterprise B makes a PSTN call to enterprise A. That call completes successfully. Later, Enterprise B Cisco Intercompany Media Engine server initiates validation procedures with Enterprise A. These validation procedures succeed. During the validation handshake, Enterprise B sends Enterprise A its domain name. Enterprise A verifies that this domain name is not on the blacklisted set of domains. Assuming it is not, Enterprise A creates a ticket. 

 
     [bookmark: pgfId-1244174]Subsequently, someone in Enterprise B calls that number again. That call setup message from Enterprise B to Enterprise A includes the ticket in the X-Cisco-UC-IME-Ticket header field in the SIP INVITE message. This message arrives at the Enterprise A ASA. The ASA verifies the signature and computes several checks on the ticket to make sure it is valid. If the ticket is valid, the ASA forwards the request to Cisco UCM (including the ticket). Because the ASA drops requests that lack a valid ticket, unauthorized calls are never received by Cisco UCM. 

 
     [bookmark: pgfId-1350291]The ticket password is a 128 bit random key, which can be thought of as a shared password between the adaptive security appliance and the Cisco Intercompany Media Engine server. This password is generated by the Cisco Intercompany Media Engine server and is used by a Cisco Intercompany Media Engine SIP trunk to generate a ticket to allow a call to be made between Cisco Intercompany Media Engine SIP trunks. A ticket is a signed object that contains a number of fields that grant permission to the calling domain to make a Cisco Intercompany Media Engine call to a specific number. The ticket is signed by the ticket password. 

 
     [bookmark: pgfId-1350295]The Cisco Intercompany Media Engine also required that you configure an epoch for the password. The epoch contains an integer that updates each time that the password is changed. When the proxy is configured the first time and a password entered for the first time, enter 1 for the epoch integer. Each time you change the password, increment the epoch to indicate the new password. You must increment the epoch value each time your change the password. 

 
     [bookmark: pgfId-1350299]Typically, you increment the epoch sequentially; however, the ASA allows you to choose any value when you update the epoch. If you change the epoch value, the tickets in use at remote enterprises become invalid. The incoming calls from the remote enterprises fallback to the PSTN until the terminating enterprise reissues tickets with the new epoch value and password.

 
     [bookmark: pgfId-1350303]The epoch and password that you configure on the ASA must match the epoch and password configured on the Cisco Intercompany Media Engine server. If you change the password or epoch on the ASA, you must update them on the Cisco Intercompany Media Engine server. See the Cisco Intercompany Media Engine server documentation for information. 

 
    
 
     
      [bookmark: pgfId-1248626][bookmark: 97817]Call Fallback to the PSTN

 
     [bookmark: pgfId-1248627]Cisco Intercompany Media Engine provides features that manage the QoS on the Internet, such as the ability to monitor QoS of the RTP traffic in real-time and fallback to PSTN automatically if problems arise. Call fallback from Internet VoIP calls to the public switched telephone network (PSTN) can occur for two reasons changes in connection quality and signal failure for the Cisco Intercompany Media Engine. 

 
     [bookmark: pgfId-1327110]Internet connections can vary wildly in their quality and vary over time. Therefore, even if a call is sent over VoIP because the quality of the connection was good, the connection quality might worsen mid-call. To ensure an overall good experience for the end user, Cisco Intercompany Media Engine attempts to perform a mid-call fallback.

 
     [bookmark: pgfId-1248631]Performing a mid-call fallback requires the adaptive security appliance to monitor the RTP packets coming from the Internet and send information into an RTP Monitoring Algorithm (RMA) API, which will indicates to the adaptive security appliance whether fallback is required. If fallback is required, the adaptive security appliance sends a REFER message to Cisco UCM to tell it that it needs to fallback the call to PSTN.

 
     [bookmark: pgfId-1359528]The TLS signaling connections from the Cisco UCM are terminated on the adaptive security appliance and a TCP or TLS connection is initiated to the Cisco UCM. SRTP (media) sent from external IP phones to the internal network IP phone via the adaptive security appliance is converted to RTP. The adaptive security appliance inserts itself into the media path by modifying the SIP signaling messages that are sent over the SIP trunk between Cisco UCMs. TLS (signaling) and SRTP are always terminated on the adaptive security appliance. 

 
     [bookmark: pgfId-1359535]If signaling problems occur, the call falls back to the PSTN; however, the Cisco UCM initiates the PSTN fall back and the adaptive security appliance does not send REFER message.

 
    
 
     
      [bookmark: pgfId-1241039][bookmark: 34857]Architecture and Deployment Scenarios for Cisco Intercompany Media Engine

 
     [bookmark: pgfId-1244655]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1249251]Architecture

 
      		 [bookmark: pgfId-1244656]Basic Deployment

 
      		 [bookmark: pgfId-1244657]Off Path Deployment

 
     

 
    
 
     
      [bookmark: pgfId-1248717][bookmark: 67833]Architecture

 
     [bookmark: pgfId-1244479]Within the enterprise, Cisco Intercompany Media Engine is deployed with the following components for the following purposes: 

 
      
      		 [bookmark: pgfId-1249678]The adaptive security appliance—Enabled with the Cisco Intercompany Media Engine Proxy, provides perimeter security functions and inspects SIP signaling between SIP trunks.

 
      		 [bookmark: pgfId-1249661]Cisco Intercompany Media Engine (UC-IME) server— Located in the DMZ, provides an automated provisioning service by learning new VoIP routes to particular phone numbers, and recording those routes in Cisco UCM. The Cisco Intercompany Media Engine server does not perform call control.

 
      		 [bookmark: pgfId-1249291]Cisco Unified Communications Manager (Cisco UCM)—Responsible for call control and processing. Cisco UCM connects to the Cisco Intercompany Media Engine server by using the Access Protocol to publish and exchange updates. The architecture can consist of a single Cisco UCM or a Cisco UCM cluster within the enterprise. 

 
      		 [bookmark: pgfId-1249328]Cisco Intercompany Media Engine (UC-IME) Bootstrap server—Provides a certificate required admission onto the public peer-to-peer network for Cisco Intercompany Media Engine. 

 
     

 
     [bookmark: pgfId-1284276]Figure 21-3 illustrates the components of the Cisco Intercompany Media Engine in a basic deployment. 

 
     [bookmark: pgfId-1248951]Figure 21-3 [bookmark: 87013]Cisco Intercompany Media Engine Architecture in a Basic Deployment

 
     [bookmark: pgfId-1248955] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1248772][bookmark: 22631]Basic Deployment

 
     [bookmark: pgfId-1249963]In a basic deployment, the Cisco Intercompany Media Engine Proxy sits in-line with the Internet firewall such that all Internet traffic traverses the adaptive security appliance. In this deployment, a single Cisco UCM or a Cisco UCM cluster is centrally deployed within the enterprise, along with a Cisco Intercompany Media Engine server (and perhaps a backup). 

 
     [bookmark: pgfId-1250046]As shown in Figure 21-4, the adaptive security appliance sits on the edge of the enterprise and inspects SIP signaling by creating dynamic SIP trunks between enterprises.

 
     [bookmark: pgfId-1342807]Figure 21-4 [bookmark: 17116]Basic Deployment Scenario

 
     [bookmark: pgfId-1342118] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1309165][bookmark: 44459]Off Path Deployment

 
     [bookmark: pgfId-1250431]In an off path deployment, inbound and outbound Cisco Intercompany Media Engine calls pass through an adaptive security appliance enabled with the Cisco Intercompany Media Engine Proxy. The adaptive security appliance is located in the DMZ and is configured to support only the Cisco Intercompany Media Engine traffic (SIP signaling and RTP traffic). Normal Internet facing traffic does not flow through this adaptive security appliance. 

 
     [bookmark: pgfId-1243410]For all inbound calls, the signaling is directed to the adaptive security appliance because destined Cisco UCMs are configured with the global IP address on the adaptive security appliance. For outbound calls, the called party could be any IP address on the Internet; therefore, the adaptive security appliance is configured with a mapping service that dynamically provides an internal IP address on the adaptive security appliance for each global IP address of the called party on the Internet. 

 
     [bookmark: pgfId-1250412]Cisco UCM sends all outbound calls directly to the mapped internal IP address on the adaptive security appliance instead of the global IP address of the called party on the Internet. The adaptive security appliance then forwards the calls to the global IP address of the called party. 

 
     [bookmark: pgfId-1284314]Figure 21-5 illustrates the architecture of the Cisco Intercompany Media Engine in an off path deployment. 

 
     [bookmark: pgfId-1243627]Figure 21-5 [bookmark: 43959]Off Path Deployment of the Adaptive Security Appliance

 
     [bookmark: pgfId-1243631] 

 
      
      [image: ] 
     
 
    
 
   
 
    
     [bookmark: pgfId-1282061][bookmark: 97407]Licensing for Cisco Intercompany Media Engine[bookmark: marker-1282059][bookmark: marker-1282060]

 
    [bookmark: pgfId-1282065]The Cisco Intercompany Media Engine feature supported by the ASA require a Unified Communications Proxy license.

 
    [bookmark: pgfId-1233156]The following table shows the details of the Unified Communications Proxy license:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1457469]Note This feature is not available on No Payload Encryption models.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1457490] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1457472]Model 
         
  
        		 
          
          [bookmark: pgfId-1457474]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1457476]All models

  
        		[bookmark: pgfId-1457478]Intercompany Media Engine license.

 [bookmark: pgfId-1457479]When you enable the Intercompany Media Engine (IME) license, you can use TLS proxy sessions up to the configured TLS proxy limit. If you also have a Unified Communications (UC) license installed that is higher than the default TLS proxy limit, then the ASA sets the limit to be the UC license limit plus an additional number of sessions depending on your model. You can manually configure the TLS proxy limit using the Configuration > Firewall > Unified Communications > TLS Proxy pane. If you also install the UC license, then the TLS proxy sessions available for UC are also available for IME sessions. For example, if the configured limit is 1000 TLS proxy sessions, and you purchase a 750-session UC license, then the first 250 IME sessions do not affect the sessions available for UC. If you need more than 250 sessions for IME, then the remaining 750 sessions of the platform limit are used on a first-come, first-served basis by UC and IME.

 
          
          		 [bookmark: pgfId-1457483]For a license part number ending in “K8”, TLS proxy sessions are limited to 1000.

 
          		 [bookmark: pgfId-1457484]For a license part number ending in “K9”, the TLS proxy limit depends on your configuration and the platform model.

 
         

 [bookmark: pgfId-1457485]Note K8 and K9 refer to whether the license is restricted for export: K8 is unrestricted, and K9 is restricted.

 [bookmark: pgfId-1457486]You might also use SRTP encryption sessions for your connections:

 
          
          		 [bookmark: pgfId-1457487]For a K8 license, SRTP sessions are limited to 250.

 
          		 [bookmark: pgfId-1457488]For a K9 license, there is no limit.

 
         

 [bookmark: pgfId-1457489]Note Only calls that require encryption/decryption for media are counted toward the SRTP limit; if passthrough is set for the call, even if both legs are SRTP, they do not count toward the limit.

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1280480]For more information about licensing, see “Managing Feature Licenses,” in the general operations configuration guide.

 
   
 
    
     [bookmark: pgfId-1359964][bookmark: 81503]Guidelines and Limitations

 
    [bookmark: pgfId-1444111][bookmark: 87419]Context Mode Guidelines

 
    [bookmark: pgfId-1444112]Supported in single context mode only.

 
    [bookmark: pgfId-1444114][bookmark: 16807]Firewall Mode Guidelines

 
    [bookmark: pgfId-1444115]Supported in routed firewall mode only.

 
    [bookmark: pgfId-1444117][bookmark: 84518]IPv6 Guidelines

 
    [bookmark: pgfId-1444118]Does not support IPv6 addresses.

 
    [bookmark: pgfId-1444120][bookmark: 23253]Additional Guidelines and Limitations 

 
    [bookmark: pgfId-1444121]Cisco Intercompany Media Engine has the following limitations:

 
     
     		 [bookmark: pgfId-1444122]Fax is not supported. Fax capability needs to be disabled on the SIP trunk.

 
     		 [bookmark: pgfId-1444123]Stateful failover of Cisco Unified Intercompany Media Engine is not supported. During failover, existing calls traversing the Cisco Intercompany Media Engine Proxy disconnect; however, new calls successfully traverse the proxy after the failover completes.

 
     		 [bookmark: pgfId-1444126]Having Cisco UCMs on more than one of the ASA interfaces is not supported with the Cisco Intercompany Media Engine Proxy. Having the Cisco UCMs on one trusted interface is especially necessary in an off path deployment because the ASA requires that you specify the listening interface for the mapping service and the Cisco UCMs must be connected on one trusted interface.

 
     		 [bookmark: pgfId-1444131]Multipart MIME is not supported.

 
     		 [bookmark: pgfId-1444132]Only existing SIP features and messages are supported.

 
     		 [bookmark: pgfId-1444133]H.264 is not supported.

 
     		 [bookmark: pgfId-1444136]RTCP is not supported. The ASA drops any RTCP traffic sent from the inside interface to the outside interface. The ASA does not convert RTCP traffic from the inside interface into SRTP traffic.

 
     		 [bookmark: pgfId-1444143]The Cisco Intercompany Media Engine Proxy configured on the ASA creates a dynamic SIP trunk for each connection to a remote enterprise. However, you cannot configure a unique subject name for each SIP trunk. The Cisco Intercompany Media Engine Proxy can have only one subject name configured for the proxy. 

 
    

 
    [bookmark: pgfId-1444145]Additionally, the subject DN you configure for the Cisco Intercompany Media Engine Proxy match the domain name that has been set for the local Cisco UCM.

 
     
     		 [bookmark: pgfId-1444146]If a service policy rule for the Cisco Intercompany Media Engine Proxy is removed (by using the no service policy command) and reconfigured, the first call traversing the ASA will fail. The call fails over to the PSTN because the Cisco UCM does not know the connections are cleared and tries to use the recently cleared IME SIP trunk for the signaling. 

 
    

 
    [bookmark: pgfId-1444150]To resolve this issue, you must additionally enter the clear connection all command and restart the ASA. If the failure is due to failover, the connections from the primary ASA are not synchronized to the standby ASA. 

 
     
     		 [bookmark: pgfId-1444162]After the  clear connection all command is issued on an ASA enabled with a UC-IME Proxy and the IME call fails over to the PSTN, the next IME call between an originating and terminating SCCP IP phone completes but does not have audio and is dropped after the signaling session is established. 

 
    

 
    [bookmark: pgfId-1444164]An IME call between SCCP IP phones use the IME SIP trunk in both directions. Namely, the signaling from the calling to called party uses the IME SIP trunk. Then, the called party uses the reverse IME SIP trunk for the return signaling and media exchange. However, this connection is already cleared on the ASA, which causes the IME call to fail. 

 
    [bookmark: pgfId-1444168]The next IME call (the third call after the clear connection all command is issued), will be completely successful.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1444169]Note This limitation does not apply when the originating and terminating IP phones are configured with SIP.

 
     
     
 
    
 
    

 
     
     		 [bookmark: pgfId-1444172]The ASA must be licensed and configured with enough TLS proxy sessions to handle the IME call volume. See “Licensing for Cisco Intercompany Media Engine” section for information about the licensing requirements for TLS proxy sessions. 

 
    

 
    [bookmark: pgfId-1444177]This limitation occurs because an IME call cannot fall back to the PSTN when there are not enough TLS proxy sessions left to complete the IME call. An IME call between two SCCP IP phones requires the ASA to use two TLS proxy sessions to successfully complete the TLS handshake.

 
    [bookmark: pgfId-1444183]Assume for example, the ASA is configured to have a maximum of 100 TLS proxy sessions and IME calls between SCCP IP phones establish 101 TLS proxy sessions. In this example, the next IME call is initiated successfully by the originating SCCP IP phone but fails after the call is accepted by the terminating SCCP IP phone. The terminating IP phone rings and on answering the call, the call hangs due to an incomplete TLS handshake. The call does not fall back to the PSTN.

 
   
 
    
     [bookmark: pgfId-1360005][bookmark: 64121]Configuring Cisco Intercompany Media Engine Proxy

 
    [bookmark: pgfId-1434031]This section contains the following topics:

 
     
     		 [bookmark: pgfId-1434034]Task Flow for Configuring Cisco Intercompany Media Engine

 
     		 [bookmark: pgfId-1434038]Configuring NAT for Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1434042]Configuring PAT for the Cisco UCM Server

 
     		 [bookmark: pgfId-1434046]Creating ACLs for Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1434050]Creating the Media Termination Instance

 
     		 [bookmark: pgfId-1434054]Creating the Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1434058]Creating Trustpoints and Generating Certificates

 
     		 [bookmark: pgfId-1434062]Creating the TLS Proxy

 
     		 [bookmark: pgfId-1434066]Enabling SIP Inspection for the Cisco Intercompany Media Engine Proxy

 
     		 [bookmark: pgfId-1434070](Optional) Configuring TLS within the Local Enterprise

 
     		 [bookmark: pgfId-1434074](Optional) Configuring Off Path Signaling

 
    

 
     
      [bookmark: pgfId-1434077][bookmark: 95081]Task Flow for Configuring Cisco Intercompany Media Engine 

 
     [bookmark: pgfId-1434080]Figure 21-6 provides an example for a basic deployment of the Cisco Intercompany Media Engine. The following tasks include command line examples based on Figure 21-6.

 
     [bookmark: pgfId-1434086]Figure 21-6 [bookmark: 38230]Example for Basic (in-line) Deployment Tasks

 
     [bookmark: pgfId-1434090] 
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     [bookmark: pgfId-1434093]Note Step 1 through Step 8 apply to both basic (in-line) and off path deployments and Step 9 applies only to off path deployment. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1434101]To configure a Cisco Intercompany Media Engine for a basic deployment, perform the following tasks. 

 
     
 
     [bookmark: pgfId-1434105]Step 1 [bookmark: 21050]Configure static NAT for Cisco UCM. See Configuring NAT for Cisco Intercompany Media Engine Proxy.

 
     [bookmark: pgfId-1434107]Or

 
     [bookmark: pgfId-1434110]Configure PAT for the UCM server. See Configuring PAT for the Cisco UCM Server. 

 
     [bookmark: pgfId-1434114]Step 2 Create ACLs for Cisco Intercompany Media Engine Proxy. See Creating ACLs for Cisco Intercompany Media Engine Proxy.

 
     [bookmark: pgfId-1434116]Step 3 Create the media termination address instance for Cisco Intercompany Media Engine Proxy. See Creating the Media Termination Instance. 

 
     [bookmark: pgfId-1434122]Step 4 Create the Cisco Intercompany Media Engine Proxy. See Creating the Cisco Intercompany Media Engine Proxy.

 
     [bookmark: pgfId-1434124]Step 5 Create trustpoints and generate certificates for the Cisco Intercompany Media Engine Proxy. See Creating Trustpoints and Generating Certificates. 

 
     [bookmark: pgfId-1434130]Step 6 Create the TLS proxy. See Creating the TLS Proxy.

 
     [bookmark: pgfId-1434134]Step 7 Configure SIP inspection for the Cisco Intercompany Media Engine Proxy. See Enabling SIP Inspection for the Cisco Intercompany Media Engine Proxy.

 
     [bookmark: pgfId-1434139]Step 8 [bookmark: 42068](Optional) Configure TLS within the enterprise. See (Optional) Configuring TLS within the Local Enterprise.

 
     [bookmark: pgfId-1434144]Step 9 [bookmark: 32646](Optional) Configure off path signaling. See (Optional) Configuring Off Path Signaling.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1434148]Note You only perform Step 9 when you are configuring the Cisco Intercompany Media Engine Proxy in an off path deployment. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1434150]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1434152][bookmark: 83242]Configuring NAT for Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1434153]To configure auto NAT, you first configure an object; then use the nat command in the object configuration mode.

 
     [bookmark: pgfId-1434156]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
     [bookmark: pgfId-1434160]Alternatively, you can configure PAT for the Cisco Intercompany Media Engine Proxy. See Configuring PAT for the Cisco UCM Server.

 
     [bookmark: pgfId-1434162]Figure 21-7 Example for Configuring NAT for a Deployment

 
     [bookmark: pgfId-1434166] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1434167]To configure auto NAT rules for the Cisco UCM server, perform the following steps:

 
     [bookmark: pgfId-1434259] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434170]  
          
  
         		 
           
           [bookmark: pgfId-1434172]Command 
          
  
         		 
           
           [bookmark: pgfId-1434174]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434177]Step 1[bookmark: 98439]

  
         		 
           
           [bookmark: pgfId-1434179]hostname(config)# 
            object network  
            name 
          
 
           
           [bookmark: pgfId-1434180] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434181]hostname(config)# object network ucm_real_192.168.10.30 
          
 
           
           [bookmark: pgfId-1434182]hostname(config)# object network ucm_real_192.168.10.31 
          
  
         		[bookmark: pgfId-1434184]Configures a network object for the real address of Cisco UCM that you want to translate.

  
        

 
         
         		[bookmark: pgfId-1434186]Step 2

  
         		 
           
           [bookmark: pgfId-1434188]hostname(config-network-object)# 
            host 
            ip_address 
          
 
           
           [bookmark: pgfId-1434189] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434190]hostname(config-network-object)# host 192.168.10.30 
          
 
           
           [bookmark: pgfId-1434191]hostname(config-network-object)# host 192.168.10.31 
          
  
         		[bookmark: pgfId-1434193]Specifies the real IP address of the Cisco UCM host for the network object. 

  
        

 
         
         		[bookmark: pgfId-1434195]Step 3

  
         		[bookmark: pgfId-1434197](Optional) 

 
           
           [bookmark: pgfId-1434198]hostname(config-network-object)# 
            description 
            string 
          
 
           
           [bookmark: pgfId-1434199] 
            Example: 
          
 
           
           [bookmark: pgfId-1434200]hostname(config-network-object)# description “Cisco UCM Real Address” 
          
  
         		[bookmark: pgfId-1434202]Provides a description of the network object.

  
        

 
         
         		[bookmark: pgfId-1434204]Step 4

  
         		 
           
           [bookmark: pgfId-1434206]hostname(config-network-object)# 
            exit 
          
  
         		[bookmark: pgfId-1434208]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1434211]Step 5[bookmark: 46625]

  
         		 
           
           [bookmark: pgfId-1434213]hostname(config)# 
            object network  
            name 
          
 
           
           [bookmark: pgfId-1434214] 
            Example: 
          
 
           
           [bookmark: pgfId-1434215]hostname(config)# object network ucm_map_209.165.200.228 
          
  
         		[bookmark: pgfId-1434217]Configures a network object for the mapped address of the Cisco UCM.

  
        

 
         
         		[bookmark: pgfId-1434219]Step 6

  
         		 
           
           [bookmark: pgfId-1434221]hostname(config-network-object)# 
            host 
            ip_address 
          
 
           
           [bookmark: pgfId-1434222] 
            Example: 
          
 
           
           [bookmark: pgfId-1434223]hostname(config-network-object)# host 209.165.200.228 
          
  
         		[bookmark: pgfId-1434225]Specifies the mapped IP address of the Cisco UCM host for the network object. 

  
        

 
         
         		[bookmark: pgfId-1434228]Step 7[bookmark: 22292]

  
         		[bookmark: pgfId-1434230](Optional) 

 
           
           [bookmark: pgfId-1434231]hostname(config-network-object)# 
            description 
            string 
          
 
           
           [bookmark: pgfId-1434232] 
            Example: 
          
 
           
           [bookmark: pgfId-1434233]hostname(config-network-object)# description “Cisco UCM Mapped Address” 
          
  
         		[bookmark: pgfId-1434235]Provides a description of the network object.

  
        

 
         
         		[bookmark: pgfId-1434237]Step 8

  
         		 
           
           [bookmark: pgfId-1434239]hostname(config-network-object)# 
            exit 
          
  
         		[bookmark: pgfId-1434241]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1434243]Step 9

  
         		 
           
           [bookmark: pgfId-1434245]hostname(config)# 
            nat (inside,outside) 
            source 
            static 
            real_obj mapped_obj  
          
 
           
           [bookmark: pgfId-1434246] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434247]hostname(config)# nat (inside,outside) source static ucm_real_192.168.10.30 ucm_209.165.200.228 
          
 
           
           [bookmark: pgfId-1434248]hostname(config)# nat (inside,outside) source static ucm_real_192.168.10.31 ucm_209.165.200.228 
          
  
         		[bookmark: pgfId-1434250]Specifies the address translation on the network objects created in this procedure. 

 [bookmark: pgfId-1434251]Where real_obj is the name that you created in  in this task.

 [bookmark: pgfId-1434255]Where mapped_obj is the name that you created in  in this task.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1434260]What to Do Next

 
     [bookmark: pgfId-1434263]Create the ACLs for the Cisco Intercompany Media Engine Proxy. See Creating ACLs for Cisco Intercompany Media Engine Proxy. 

 
    
 
     
      [bookmark: pgfId-1434266][bookmark: 31343]Configuring PAT for the Cisco UCM Server

 
     [bookmark: pgfId-1434267]Perform this task as an alternative to configuring NAT for the Cisco Intercompany Media Engine Proxy. 

 
     [bookmark: pgfId-1434268]Figure 21-8 Example for Configuring PAT for a Deployment

 
     [bookmark: pgfId-1434272] 

 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1434273]Note You only perform this step when NAT is not configured for the Cisco UCM server. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1434274]To configure PAT for the Cisco UCM server, perform the following steps:

 
     [bookmark: pgfId-1434403] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434277]  
          
  
         		 
           
           [bookmark: pgfId-1434279]Command 
          
  
         		 
           
           [bookmark: pgfId-1434281]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434283]Step 1

  
         		 
           
           [bookmark: pgfId-1434285]hostname(config)# 
            object network 
            name 
          
 
           
           [bookmark: pgfId-1434286] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434287]hostname(config)# object network ucm-pat-209.165.200.228 
          
  
         		[bookmark: pgfId-1434289]Configures a network object for the outside IP address of Cisco UCM that you want to translate.

  
        

 
         
         		[bookmark: pgfId-1434291]Step 2

  
         		 
           
           [bookmark: pgfId-1434293]hostname(config-network-object)# 
            host 
            ip_address 
          
 
           
           [bookmark: pgfId-1434294] 
            Example: 
          
 
           
           [bookmark: pgfId-1434295]hostname(config-network-object)# host 209.165.200.228 
          
  
         		[bookmark: pgfId-1434297]Specifies the real IP address of the Cisco UCM host for the network object. 

  
        

 
         
         		[bookmark: pgfId-1434299]Step 3

  
         		 
           
           [bookmark: pgfId-1434301]hostname(config-network-object)# 
            exit 
          
  
         		[bookmark: pgfId-1434303]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1434306]Step 4[bookmark: 21203]

  
         		 
           
           [bookmark: pgfId-1434308]hostname(config)# 
            object service 
            name 
          
 
           
           [bookmark: pgfId-1434309] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434310]hostname(config)# object service tcp_5070 
          
 
           
           [bookmark: pgfId-1434311]hostname(config)# object service tcp_5071 
          
  
         		[bookmark: pgfId-1434313]Creates a service object for the outside Cisco Intercompany Media Engine port.

  
        

 
         
         		[bookmark: pgfId-1434315]Step 5

  
         		 
           
           [bookmark: pgfId-1434317]hostname(config-service-object)# 
            tcp source eq 
            port 
          
 
           
           [bookmark: pgfId-1434318] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434319]hostname(config-service-object)# tcp source eq 5070 
          
 
           
           [bookmark: pgfId-1434320]hostname(config-service-object)# tcp source eq 5071 
          
  
         		[bookmark: pgfId-1434322]Specifies the port number. 

  
        

 
         
         		[bookmark: pgfId-1434324]Step 6

  
         		 
           
           [bookmark: pgfId-1434326]hostname(config-service-object)# 
            exit 
          
  
         		[bookmark: pgfId-1434328]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1434330]Step 7

  
         		 
           
           [bookmark: pgfId-1434332]hostname(config)# 
            object network 
            name 
          
 
           
           [bookmark: pgfId-1434333] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434334]hostname(config)# object network ucm-real-192.168.10.30 
          
 
           
           [bookmark: pgfId-1434335]hostname(config)# object network ucm-real-192.168.10.31 
          
  
         		[bookmark: pgfId-1434337]Configures a network object to represent the real IP address of Cisco UCM.

  
        

 
         
         		[bookmark: pgfId-1434339]Step 8

  
         		 
           
           [bookmark: pgfId-1434341]hostname(config-network-object)# 
            host 
            ip_address 
          
 
           
           [bookmark: pgfId-1434342] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434343]hostname(config-network-object)# host 192.168.10.30 
          
 
           
           [bookmark: pgfId-1434344]hostname(config-network-object)# host 192.168.10.31 
          
  
         		[bookmark: pgfId-1434346]Specifies the real IP address of the Cisco UCM host for the network object. 

  
        

 
         
         		[bookmark: pgfId-1434348]Step 9

  
         		 
           
           [bookmark: pgfId-1434350]hostname(config-network-object)# 
            exit 
          
  
         		[bookmark: pgfId-1434352]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1434355]Step 10[bookmark: 29973]

  
         		 
           
           [bookmark: pgfId-1434357]hostname(config)# 
            object service 
            name 
          
 
           
           [bookmark: pgfId-1434358] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434359]hostname(config)# object service tcp_5570 
          
 
           
           [bookmark: pgfId-1434360]hostname(config)# object service tcp_5571 
          
  
         		[bookmark: pgfId-1434362]Creates a service objects for Cisco UCM SIP port.

  
        

 
         
         		[bookmark: pgfId-1434364]Step 11

  
         		 
           
           [bookmark: pgfId-1434366]hostname(config-service-object)# 
            tcp source eq 
            port 
          
 
           
           [bookmark: pgfId-1434367] 
            Example: 
          
 
           
           [bookmark: pgfId-1434368]hostname(config-service-object)# tcp source eq 5570 
          
 
           
           [bookmark: pgfId-1434369]hostname(config-service-object)# tcp source eq 5571 
          
  
         		[bookmark: pgfId-1434371]Specifies the port number. 

  
        

 
         
         		[bookmark: pgfId-1434373]Step 12

  
         		 
           
           [bookmark: pgfId-1434375]hostname(config-service-object)# 
            exit 
          
  
         		[bookmark: pgfId-1434377]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1434379]Step 13

  
         		 
           
           [bookmark: pgfId-1434381]hostname(config)# 
            nat (inside,outside) 
            source 
            static 
            real_obj mapped_obj  
            service  
            real_port 
            mapped_port 
          
 
           
           [bookmark: pgfId-1434382] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434383]hostname(config)# nat (inside,outside) source static ucm-real-192.168.10.30 ucm-pat-209.165.200.228 service tcp_5070 tcp_5570 
          
 
           
           [bookmark: pgfId-1434384]hostname(config)# nat (inside,outside) source static ucm-real-192.168.10.31 ucm-pat-128.106.254.5 service tcp_5071 tcp_5571 
          
  
         		[bookmark: pgfId-1434386]Creates a static mapping for Cisco UCM.

 [bookmark: pgfId-1434387]Where real_obj is the name that you created in  in this task.

 [bookmark: pgfId-1434391]Where mapped_obj is the name that you created in  in this task.

 [bookmark: pgfId-1434395]Where real_port is the name that you created in  in this task.

 [bookmark: pgfId-1434399]Where mapped_obj is the name that you created in  in this task.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1434405][bookmark: 95996]Creating ACLs for Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1434406]To configure ACLs for the Cisco Intercompany Media Engine Proxy to reach the Cisco UCM server, perform the following steps. 

 
     [bookmark: pgfId-1434409]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
     [bookmark: pgfId-1434486] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434413]  
          
  
         		 
           
           [bookmark: pgfId-1434415]Command 
          
  
         		 
           
           [bookmark: pgfId-1434417]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434419]Step 1

  
         		 
           
           [bookmark: pgfId-1434421]hostname(config)# 
            access-list 
            id 
            extended 
            permit 
            tcp 
            any 
            host 
            ip_address 
            eq 
            port 
          
 
           
           [bookmark: pgfId-1434422] 
            Example: 
          
 
           
           [bookmark: pgfId-1434423]hostname(config)# access-list incoming extended permit tcp any host 192.168.10.30 eq 5070 
          
  
         		[bookmark: pgfId-1434425]Adds an Access Control Entry (ACE). An ACL is made up of one or more ACEs with the same ACL ID. This ACE provides access control by allowing incoming access for Cisco Intercompany Media Engine connections on the specified port. 

 [bookmark: pgfId-1434426]In the ip_address argument, provide the real IP address of Cisco UCM.

  
        

 
         
         		[bookmark: pgfId-1434428]Step 2

  
         		 
           
           [bookmark: pgfId-1434430]hostname(config)# 
            access-group 
            access-list 
            in 
            interface 
            interface_name 
          
 
           
           [bookmark: pgfId-1434431] 
            Example: 
          
 
           
           [bookmark: pgfId-1434432]hostname(config)# access-group incoming in interface outside 
          
  
         		[bookmark: pgfId-1434434]Binds the ACL to an interface.

  
        

 
         
         		[bookmark: pgfId-1434437]Step 3[bookmark: 72701]

  
         		 
           
           [bookmark: pgfId-1434439]hostname(config)# 
            access-list 
            id 
            extended 
            permit 
            tcp 
            any 
            host 
            ip_address 
            eq 
            port 
          
 
           
           [bookmark: pgfId-1434440] 
            Example: 
          
 
           
           [bookmark: pgfId-1434441]hostname(config)# access-list ime-inbound-sip extended permit tcp any host 192.168.10.30 eq 5070 
          
  
         		[bookmark: pgfId-1434445]Adds an ACE. This ACE allows the ASA to allow inbound SIP traffic for Cisco Intercompany Media Engine. This entry is used to classify traffic for the class and policy map.

 [bookmark: pgfId-1434447]Note The port that you configure here must match the trunk settings configured on Cisco UCM. See the Cisco Unified Communications Manager documentation for information about this configuration setting. 

  
        

 
         
         		[bookmark: pgfId-1434450]Step 4[bookmark: 22767]

  
         		 
           
           [bookmark: pgfId-1434452]hostname(config)# 
            access-list 
            id 
            extended 
            permit 
            tcp 
            ip_address 
            mask 
            any 
            range 
            range 
          
 
           
           [bookmark: pgfId-1434453] 
            Example: 
          
 
           
           [bookmark: pgfId-1434454]hostname(config)# access-list ime-outbound-sip extended permit tcp 192.168.10.30 255.255.255.255 any range 5000 6000 
          
  
         		[bookmark: pgfId-1434458]Adds an ACE. This ACE allows the ASA to allow outbound SIP traffic for Cisco Intercompany Media Engine (in the example, any TCP traffic with source as 192.168.10.30 and destination port range between 5000 and 6000). This entry is used to classify traffic for the class and policy map.

 [bookmark: pgfId-1434460]Note Ensure that TCP traffic between Cisco UCM and the Cisco Intercompany Media Engine server does not use this port range (if that connection goes through the ASA).

  
        

 
         
         		[bookmark: pgfId-1434465]Step 5

  
         		 
           
           [bookmark: pgfId-1434467]hostname(config)# 
            access-list 
            id 
            permit 
            tcp any host  
            ip_address 
            eq 6084 
          
 
           
           [bookmark: pgfId-1434468] 
            Example: 
          
 
           
           [bookmark: pgfId-1434469]hostname(config)# access-list ime-traffic permit tcp any host 192.168.10.12 eq 6084 
          
  
         		[bookmark: pgfId-1434473]Adds an ACE. This ACE allows the ASA to allow traffic from the Cisco Intercompany Media Engine server to remote Cisco Intercompany Media Engine servers.

  
        

 
         
         		[bookmark: pgfId-1434476]Step 6

  
         		 
           
           [bookmark: pgfId-1434478]hostname(config)# 
            access-list 
            id 
            permit 
            tcp any host  
            ip_address 
            eq 8470 
          
 
           
           [bookmark: pgfId-1434479] 
            Example: 
          
 
           
           [bookmark: pgfId-1434480]hostname(config)# access-list ime-bootserver-traffic permit tcp any host 192.168.10.12 eq 8470 
          
  
         		[bookmark: pgfId-1434484]Adds an ACE. This ACE allows the ASA to allow traffic from the Cisco Intercompany Media Engine server to the Bootstrap server for the Cisco Intercompany Media Engine.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1434487]What to Do Next

 
     [bookmark: pgfId-1434490]Create the media termination instance on the ASA for the Cisco Intercompany Media Engine Proxy. See Creating the Media Termination Instance. 

 
    
 
     
      [bookmark: pgfId-1434496][bookmark: 62350]Creating the Media Termination Instance

 
     [bookmark: pgfId-1434497]Guidelines

 
     [bookmark: pgfId-1434498]The media termination address you configure must meet these requirements:

 
      
      		 [bookmark: pgfId-1434499]If you decide to configure a media-termination address on interfaces (rather than using a global interface), you must configure a media-termination address on at least two interfaces (the inside and an outside interface) before applying the service policy for the Cisco Intercompany Media Engine Proxy. Otherwise, you will receive an error message when enabling the proxy with SIP inspection.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1434500]Note Cisco recommends that you configure the media-termination address for the Cisco Intercompany Media Engine Proxy on interfaces rather than configuring a global media-termination address.

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1434501]The Cisco Intercompany Media Engine Proxy can use only one type of media termination instance at a time; for example, you can configure a global media-termination address for all interfaces or configure a media-termination address for different interfaces. However, you cannot use a global media-termination address and media-termination addresses configured for each interface at the same time. 

 
     

 command, and then reconfiguring it as described in this procedure. 
     

 
     [bookmark: pgfId-1434503]Procedure

 
     [bookmark: pgfId-1434504]Create the media termination instance to use with the Cisco Intercompany Media Engine Proxy.

 
     [bookmark: pgfId-1434507]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
     [bookmark: pgfId-1434509]To create the media termination instance for the Cisco Intercompany Media Engine Proxy, perform the following steps:

 
     [bookmark: pgfId-1434568] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434512]  
          
  
         		 
           
           [bookmark: pgfId-1434514]Command 
          
  
         		 
           
           [bookmark: pgfId-1434516]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434519]Step 1[bookmark: 95873]

  
         		 
           
           [bookmark: pgfId-1434521]hostname(config)# 
            media-termination 
            instance_name 
          
 
           
           [bookmark: pgfId-1434522] 
            Example:  
          
 
           
           [bookmark: pgfId-1434523]hostname(config)# 
            media-termination 
            uc-ime-media-term 
          
  
         		[bookmark: pgfId-1434525]Creates the media termination instance that you attach to the Cisco Intercompany Media Engine Proxy.

  
        

 
         
         		[bookmark: pgfId-1434527]Step 2

  
         		 
           
           [bookmark: pgfId-1434529]hostname(config-media-termination)# 
            address 
            ip_address  
            interface 
            intf_name 
          
 
           
           [bookmark: pgfId-1434530] 
            Examples:  
          
 
           
           [bookmark: pgfId-1434531]hostname(config-media-termination)# address 209.165.200.228 interface outside 
          
  
         		[bookmark: pgfId-1434533]Configures the media-termination address used by the outside interface of the ASA. 

 [bookmark: pgfId-1434537]The outside IP address must be a publicly routable address that is an unused IP address within the address range on that interface.

 [bookmark: pgfId-1434540]See Creating the Cisco Intercompany Media Engine Proxy for information about the UC-IME proxy settings. See CLI configuration guide for information about the no service-policy command.

  
        

 
         
         		[bookmark: pgfId-1434546]Step 3

  
         		 
           
           [bookmark: pgfId-1434548]hostname(config-media-termination)# 
            address 
            ip_address  
            interface 
            intf_name 
          
 
           
           [bookmark: pgfId-1434549] 
            Examples:  
          
 
           
           [bookmark: pgfId-1434550]hostname(config-media-termination)# address 192.168.10.3 interface inside 
          
  
         		[bookmark: pgfId-1434552]Configures a media termination address used by the inside interface of the ASA.

 [bookmark: pgfId-1434556]Note The IP address must be an unused IP address within the same subnet on that interface.

  
        

 
         
         		[bookmark: pgfId-1434558]Step 4

  
         		 
           
           [bookmark: pgfId-1434560](Optional) 
          
 
           
           [bookmark: pgfId-1434561]hostname(config-media-termination)# 
            rtp-min-port 
            port1  
            rtp-maxport 
            port2 
          
 
           
           [bookmark: pgfId-1434562] 
            Examples:  
          
 
           
           [bookmark: pgfId-1434563]hostname(config-media-termination)# rtp-min-port 1000 rtp-maxport 2000 
          
  
         		[bookmark: pgfId-1434565]Configures the rtp-min-port and rtp-max-port limits for the Cisco Intercompany Media Engine Proxy. Configure the RTP port range for the media termination point when you need to scale the number of calls that the Cisco Intercompany Media Engine supports.

 [bookmark: pgfId-1434566]Where port1 specifies the minimum value for the RTP port range for the media termination point, where port1 can be a value from 1024 to 65535. By default, the value for port1 is 16384.

 [bookmark: pgfId-1434567]Where port2 specifies the maximum value for the RTP port range for the media termination point, where port2 can be a value from 1024 to 65535. By default, the value for port2 is 32767.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1434569]What To Do Next

 
     [bookmark: pgfId-1434570]Once you have created the media termination instance, create the Cisco Intercompany Media Engine Proxy. See Creating the Cisco Intercompany Media Engine Proxy. 

 
    
 
     
      [bookmark: pgfId-1434577][bookmark: 54632][bookmark: 74137]Creating the Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1434578]To create the Cisco Intercompany Media Engine Proxy, perform the following steps.

 
     [bookmark: pgfId-1434581]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
     [bookmark: pgfId-1434583]Note You cannot change any of the configuration settings for the Cisco Intercompany Media Engine Proxy described in this procedure when the proxy is enabled for SIP inspection. Remove the Cisco Intercompany Media Engine Proxy from SIP inspection before changing any of the settings described in this procedure. 
     

 
     [bookmark: pgfId-1434706] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434586]  
          
  
         		 
           
           [bookmark: pgfId-1434588]Command 
          
  
         		 
           
           [bookmark: pgfId-1434590]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434593]Step 1[bookmark: 61741]

  
         		 
           
           [bookmark: pgfId-1434595]hostname(config)# 
            uc-ime 
            uc_ime_name 
          
 
           
           [bookmark: pgfId-1434596] 
            Example: 
          
 
           
           [bookmark: pgfId-1434597]hostname(config)# uc-ime local-ent-ime 
          
  
         		[bookmark: pgfId-1434599]Configures the Cisco Intercompany Media Engine Proxy.

 [bookmark: pgfId-1434600]Where uc_ime_name is the name of the Cisco Intercompany Media Engine Proxy. The name is limited to 64 characters.

 [bookmark: pgfId-1434601]Only one Cisco Intercompany Media Engine Proxy can be configured on the ASA. 

  
        

 
         
         		[bookmark: pgfId-1434606]Step 2

  
         		 
           
           [bookmark: pgfId-1434608]hostname(config-uc-ime)# 
            media-termination 
            mta_instance_name 
          
 
           
           [bookmark: pgfId-1434609] 
            Example: 
          
 
           
           [bookmark: pgfId-1434610]hostname(config-uc-ime)# media-termination ime-media-term 
          
  
         		[bookmark: pgfId-1434612]Specifies the media termination instance used by the Cisco Intercompany Media Engine Proxy. 

 [bookmark: pgfId-1434613]Note You must create the media termination instance before you specify it in the Cisco Intercompany Media Engine Proxy. 

 [bookmark: pgfId-1434614]Where mta_instance_name is the instance_name that you created in  of Creating the Media Termination Instance. 

 [bookmark: pgfId-1434623]See Creating the Media Termination Instance for the steps to create the media termination instance. 

  
        

 
         
         		[bookmark: pgfId-1434627]Step 3[bookmark: 94458]

  
         		 
           
           [bookmark: pgfId-1434629]hostname(config-uc-ime)# 
            ucm address 
            ip_address 
            trunk-security-mode [ 
            nonsecure | 
            secure ] 
          
 
           
           [bookmark: pgfId-1434630] 
            Example: 
          
 
           
           [bookmark: pgfId-1434631]hostname(config-uc-ime)# ucm address 192.168.10.30 trunk-security-mode non-secure 
          
  
         		[bookmark: pgfId-1434633]Specifies the Cisco UCM server in the enterprise. You must specify the real IP address of the Cisco UCM server. Do not specify a mapped IP address for the server.

 [bookmark: pgfId-1434634]Note You must include an entry for each Cisco UCM in the cluster with Cisco Intercompany Media Engine that has a SIP trunk enabled. 

 [bookmark: pgfId-1434635]Where the nonsecure and secure options specify the security mode of the Cisco UCM or cluster of Cisco UCMs.

 for Cisco UCM or Cisco UCM cluster indicates that Cisco UCM or Cisco UCM cluster is initiating TLS; therefore, you must configure TLS for components. See (Optional) Configuring TLS within the Local Enterprise. 

 [bookmark: pgfId-1434640]You can specify the secure option in this task or you can update it later while configuring TLS for the enterprise. See Step 11 in (Optional) Configuring TLS within the Local Enterprise. 

  
        

 
         
         		[bookmark: pgfId-1434648]Step 4

  
         		 
           
           [bookmark: pgfId-1434650]hostname(config-uc-ime)# 
            ticket 
            epoch 
            n 
            password 
            password 
          
 
           
           [bookmark: pgfId-1434651] 
            Example: 
          
 
           
           [bookmark: pgfId-1434652]hostname(config-uc-ime)# ticket epoch 1 password password1234 
          
  
         		[bookmark: pgfId-1434654]Configures the ticket epoch and password for Cisco Intercompany Media Engine. 

 [bookmark: pgfId-1434655]Where n is an integer from 1-255. The epoch contains an integer that updates each time that the password is changed. When the proxy is configured the first time and a password entered for the first time, enter 1 for the epoch integer. Each time you change the password, increment the epoch to indicate the new password. You must increment the epoch value each time your change the password. 

 [bookmark: pgfId-1434656]Typically, you increment the epoch sequentially; however, the ASA allows you to choose any value when you update the epoch. 

 [bookmark: pgfId-1434660]If you change the epoch value, the current password is invalidated and you must enter a new password. 

 [bookmark: pgfId-1434661]Where password contains a minimum of 10 and a maximum of 64 printable character from the US-ASCII character set. The allowed characters include 0x21 to 0x73 inclusive, and exclude the space character. 

 [bookmark: pgfId-1434662]We recommend a password of at least 20 characters. Only one password can be configured at a time.

 [bookmark: pgfId-1434663]The ticket password is stored onto flash. The output of the show running-config uc-ime command displays ***** instead of the password string.

 [bookmark: pgfId-1434664]Note The epoch and password that you configure on the ASA must match the epoch and password configured on the Cisco Intercompany Media Engine server. See the Cisco Intercompany Media Engine server documentation for information. 

  
        

 
         
         		[bookmark: pgfId-1434669]Step 5

  
         		[bookmark: pgfId-1434671](Optional)

 
           
           [bookmark: pgfId-1434672]hostname(config-uc-ime)# 
            fallback 
            monitoring 
            timer 
            timer_millisec  | 
            hold-down timer  
            timer_sec 
          
 
           
           [bookmark: pgfId-1434673] 
            Examples: 
          
 
           
           [bookmark: pgfId-1434674]hostname(config-uc-ime)# fallback monitoring timer 120 
          
 
           
           [bookmark: pgfId-1434675]hostname(config-uc-ime)# fallback hold-down timer 30 
          
  
         		[bookmark: pgfId-1434677]Specifies the fallback timers for Cisco Intercompany Media Engine. 

 [bookmark: pgfId-1434678]Specifying monitoring timer sets the time between which the ASA samples the RTP packets received from the Internet. The ASA uses the data sample to determine if fallback to the PSTN is needed for a call. 

 [bookmark: pgfId-1434685]Where timer_millisec specifies the length of the monitoring timer. By default, the length is 100 milliseconds for the monitoring timer and the allowed range is 10-600 ms.

 [bookmark: pgfId-1434686]Specifying hold-down timer sets the amount of time that ASA waits before notifying Cisco UCM whether to fall back to PSTN.

 [bookmark: pgfId-1434690]Where timer_sec specifies the length of the hold-down timer. By default, the length is 20 seconds for the hold-down timer and the allowed range is 10-360 seconds. 

 [bookmark: pgfId-1434691]If you do not use this command to specify fallback timers, the ASA uses the default settings for the fallback timers.

  
        

 
         
         		[bookmark: pgfId-1434696]Step 6

  
         		[bookmark: pgfId-1434698](Optional)

 
           
           [bookmark: pgfId-1434699]hostname(config-uc-ime)# 
            fallback 
            sensitivity-file  
            file_name 
          
 
           
           [bookmark: pgfId-1434700] 
            Example: 
          
 
           
           [bookmark: pgfId-1434701]hostname(config-uc-ime)# fallback sensitivity-file ime-fallback-sensitvity.fbs 
          
  
         		[bookmark: pgfId-1434703]Specifies the file to use for mid-call PSTN fallback. 

 [bookmark: pgfId-1434704]Where file_name must be the name of a file on disk that includes the .fbs file extension. 

 [bookmark: pgfId-1434705]The fallback file is used to determine whether the QoS of the call is poor enough for the Cisco Intercompany Media Engine to move the call to the PSTN. 

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1434707]What to Do Next

 
     [bookmark: pgfId-1434708]Install the certificate on the local entity truststore. You could also enroll the certificate with a local CA trusted by the local entity. 

 
    
 
     
      [bookmark: pgfId-1434710][bookmark: 17821]Creating Trustpoints and Generating Certificates

 
     [bookmark: pgfId-1434713]You need to generate the keypair for the certificate used by the ASA, and configure a trustpoint to identify the certificate sent by the ASA in the TLS handshake. 

 
     [bookmark: pgfId-1434720]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1434722]Note This task instructs you on how to create trustpoints for the local enterprise and the remote enterprise and how to exchange certificates between these two enterprises. This task does not provide steps for creating trustpoints and exchanging certificates between the local Cisco UCM and the local ASA. However, if you require additional security within the local enterprise, you must perform the optional task (Optional) Configuring TLS within the Local Enterprise. Performing that task allows for secure TLS connections between the local Cisco UCM and the local ASA. The instructions in that task describe how to create trustpoints between the local Cisco UCM and the local ASA.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1434735]Prerequisites for Installing Certificates

 
     [bookmark: pgfId-1434738]To create a proxy certificate on the ASA that is trusted by the remote entity, obtain a certificate from a trusted CA or export it from the remote enterprise ASA. 

 
     [bookmark: pgfId-1434743]To export the certificate from the remote enterprise, you enter the following command on the remote ASA: 

 
     [bookmark: pgfId-1434747]hostname(config)# crypto ca export trustpoint identity-certificate

 
     [bookmark: pgfId-1434750]The ASA prompts displays the certificate in the terminal screen. Copy the certificate from the terminal screen. You will need the certificate text in Step 5 of this task.

 
     [bookmark: pgfId-1434755]Procedure

 
     [bookmark: pgfId-1434756]To create the trustpoints and generate certificates, perform the following steps:

 
     [bookmark: pgfId-1434874] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434759]  
          
  
         		 
           
           [bookmark: pgfId-1434761]Command 
          
  
         		 
           
           [bookmark: pgfId-1434763]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434765]Step 1

  
         		 
           
           [bookmark: pgfId-1434767]hostname(config)# 
            crypto key generate rsa label 
            key-pair-label  
            modulus 
            size 
          
 
           
           [bookmark: pgfId-1434768] 
            Example: 
          
 
           
           [bookmark: pgfId-1434769]hostname(config)# crypto key generate rsa label local-ent-key modulus 2048 
          
  
         		[bookmark: pgfId-1434773]On the local ASA, creates the RSA keypair that can be used for the trustpoints. This is the keypair and trustpoint for the local entities signed certificate.

 [bookmark: pgfId-1434775]The modulus key size that you select depends on the level of security that you want to configure and on any limitations imposed by the CA from which you are obtaining the certificate. The larger the number that you select, the higher the security level will be for the certificate. Most CAs recommend 2048 for the key modulus size; however, 

 [bookmark: pgfId-1434776]Note GoDaddy requires a key modulus size of 2048.

  
        

 
         
         		[bookmark: pgfId-1434779]Step 2[bookmark: 88374]

  
         		 
           
           [bookmark: pgfId-1434781]hostname(config)# 
            crypto 
            ca 
            trustpoint 
            trustpoint_name 
          
 
           
           [bookmark: pgfId-1434782] 
            Example: 
          
 
           
           [bookmark: pgfId-1434783]hostname(config)# crypto ca trustpoint local_ent 
          
  
         		[bookmark: pgfId-1434785]Enters the trustpoint configuration mode for the specified trustpoint so that you can create the trustpoint for the local entity. 

 [bookmark: pgfId-1434786]A trustpoint represents a CA identity and possibly a device identity, based on a certificate issued by the CA. Maximum name length is 128 characters.

  
        

 
         
         		[bookmark: pgfId-1434788]Step 3

  
         		 
           
           [bookmark: pgfId-1434790]hostname(config-ca-trustpoint)# 
            subject-name 
            X.500_name 
          
 
           
           [bookmark: pgfId-1434791] 
            Example: 
          
 
           
           [bookmark: pgfId-1434792]hostname(config-ca-trustpoint)# subject-name cn=Ent-local-domain-name** 
          
  
         		[bookmark: pgfId-1434794]Includes the indicated subject DN in the certificate during enrollment. 

 For information about how to configure the domain name for Cisco UCM, see the Cisco Unified Communications Manager documentation for information. 

  
        

 
         
         		[bookmark: pgfId-1434797]Step 4

  
         		 
           
           [bookmark: pgfId-1434799]hostname(config-ca-trustpoint)# 
            keypair 
            keyname 
          
 
           
           [bookmark: pgfId-1434800] 
            Example: 
          
 
           
           [bookmark: pgfId-1434801]hostname(config-ca-trustpoint)# keypair local-ent-key 
          
  
         		[bookmark: pgfId-1434803]Specifies the key pair whose public key is to be certified.

  
        

 
         
         		[bookmark: pgfId-1434806]Step 5[bookmark: 66393]

  
         		 
           
           [bookmark: pgfId-1434808]hostname(config-ca-trustpoint)# 
            enroll terminal 
          
  
         		[bookmark: pgfId-1434810]Specifies that you will use the “copy and paste” method of enrollment with this trustpoint (also known as manual enrollment).

  
        

 
         
         		[bookmark: pgfId-1434812]Step 6

  
         		 
           
           [bookmark: pgfId-1434814]hostname(config-ca-trustpoint)# 
            exit 
          
  
         		[bookmark: pgfId-1434816]Exits from the CA Trustpoint configuration mode.

  
        

 
         
         		[bookmark: pgfId-1434818]Step 7

  
         		 
           
           [bookmark: pgfId-1434820]hostname(config)# 
            crypto 
            ca 
            enroll 
            trustpoint 
          
 
           
           [bookmark: pgfId-1434821] 
            Example: 
          
 
           
           [bookmark: pgfId-1434822]hostname(config)# crypto ca enroll remote-ent 
          
 
           
           [bookmark: pgfId-1434823]% 
          
 
           
           [bookmark: pgfId-1434824]% Start certificate enrollment ... 
          
 
           
           [bookmark: pgfId-1434825]% The subject name in the certificate will be: 
           
 % cn=enterpriseA 
          
 
           
           [bookmark: pgfId-1434826]% The fully-qualified domain name in the certificate will @ be: ciscoasa 
          
 
           
           [bookmark: pgfId-1434827]% Include the device serial number in the subject name? [yes/no]: no 
          
 
           
           [bookmark: pgfId-1434828]Display Certificate Request to terminal? [yes/no]: yes 
          
 
           
           [bookmark: pgfId-1434829]  
          
  
         		[bookmark: pgfId-1434831]Starts the enrollment process with the CA. 

 [bookmark: pgfId-1434832]Where trustpoint is the same as the value you entered for trustpoint_name in Step 2. 

 [bookmark: pgfId-1434836]When the trustpoint is configured for manual enrollment (enroll terminal command), the ASA writes a base-64-encoded PKCS10 certification request to the console and then displays the CLI prompt. Copy the text from the prompt.

 [bookmark: pgfId-1434840]Submit the certificate request to the CA, for example, by pasting the text displayed at the prompt into the certificate signing request enrollment page on the CA website.

 [bookmark: pgfId-1434841]When the CA returns the signed identity certificate, proceed to Step 8 in this procedure.

  
        

 
         
         		[bookmark: pgfId-1434847]Step 8[bookmark: 15496]

  
         		 
           
           [bookmark: pgfId-1434849]hostname(config)# 
            crypto 
            ca 
            import 
            trustpoint  
            certificate 
          
 
           
           [bookmark: pgfId-1434850] 
            Example: 
          
 
           
           [bookmark: pgfId-1434851]hostname(config)# crypto ca import remote-ent certificate 
          
  
         		[bookmark: pgfId-1434853]Imports the signed certificate received from the CA in response to a manual enrollment request. 

 [bookmark: pgfId-1434854]Where trustpoint specifies the trustpoint you created in Step 2.

 [bookmark: pgfId-1434860]The ASA prompts you to paste the base-64 formatted signed certificate onto the terminal. 

  
        

 
         
         		[bookmark: pgfId-1434863]Step 9

  
         		 
           
           [bookmark: pgfId-1434865]hostname(config)# 
            crypto 
            ca 
            authenticate 
            trustpoint 
          
 
           
           [bookmark: pgfId-1434866] 
            Example: 
          
 
           
           [bookmark: pgfId-1434867]hostname(config)# crypto ca authenticate remote-ent 
          
  
         		[bookmark: pgfId-1434869]Authenticates the third-party identity certificate received from the CA. The identity certificate is associated with a trustpoint created for the remote enterprise. 

 [bookmark: pgfId-1434872]The ASA prompts you to paste the base-64 formatted identity certificate from the CA onto the terminal. 

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1434875]What to Do Next

 
     [bookmark: pgfId-1434878]Create the TLS proxy for the Cisco Intercompany Media Engine. See the “Creating the TLS Proxy” section. 

 
    
 
     
      [bookmark: pgfId-1434881][bookmark: 60002]Creating the TLS Proxy 

 
     [bookmark: pgfId-1434882]Because either enterprise, namely the local or remote Cisco UCM servers, can initiate the TLS handshake (unlike IP Telephony or Cisco Mobility Advantage, where only the clients initiate the TLS handshake), you must configure by-directional TLS proxy rules. Each enterprise can have an ASA as the TLS proxy.

 
     [bookmark: pgfId-1434886]Create TLS proxy instances for the local and remote entity initiated connections respectively. The entity that initiates the TLS connection is in the role of “TLS client.” Because the TLS proxy has a strict definition of “client” and “server” proxy, two TLS proxy instances must be defined if either of the entities could initiate the connection.

 
     [bookmark: pgfId-1434889]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
     [bookmark: pgfId-1434891]To create the TLS proxy, perform the following steps:

 
     [bookmark: pgfId-1434994] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1434894]  
          
  
         		 
           
           [bookmark: pgfId-1434896]Command 
          
  
         		 
           
           [bookmark: pgfId-1434898]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1434901]Step 1[bookmark: 51471]

  
         		 
           
           [bookmark: pgfId-1434903]hostname(config)# 
            tls-proxy proxy_name 
          
 
           
           [bookmark: pgfId-1434904] 
            Example: 
          
 
           
           [bookmark: pgfId-1434905]hostname(config)# tls-proxy local_to_remote-ent 
          
  
         		[bookmark: pgfId-1434907]Creates the TLS proxy for the outbound connections. 

  
        

 
         
         		[bookmark: pgfId-1434910]Step 2[bookmark: 76487]

  
         		 
           
           [bookmark: pgfId-1434912]hostname(config-tlsp)# 
            client 
            trust-point 
            proxy_trustpoint 
          
 
           
           [bookmark: pgfId-1434913] 
            Example: 
          
 
           
           [bookmark: pgfId-1434914]hostname(config-tlsp)# client trust-point local-ent 
          
  
         		[bookmark: pgfId-1434916]For outbound connections, specifies the trustpoint and associated certificate that the adaptive security appliance uses in the TLS handshake when the adaptive security appliance assumes the role of the TLS client. The certificate must be owned by the adaptive security appliance (identity certificate). 

 [bookmark: pgfId-1434917]Where proxy_trustpoint specifies the trustpoint defined by the crypto ca trustpoint command in Step 2 in “Creating Trustpoints and Generating Certificates” section. 

  
        

 
         
         		[bookmark: pgfId-1434928]Step 3

  
         		 
           
           [bookmark: pgfId-1434930]hostname(config-tlsp)# 
            client 
            cipher-suite 
            cipher_suite 
          
 
           
           [bookmark: pgfId-1434931] 
            Example: 
          
 
           
           [bookmark: pgfId-1434932]hostname(config-tlsp)# client cipher-suite aes128-sha1 aes256-sha1 3des-sha1 null-sha1 
          
  
         		[bookmark: pgfId-1434934]For outbound connections, controls the TLS handshake parameter for the cipher suite. 

 [bookmark: pgfId-1434935]Where cipher_suite includes des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, or null-sha1. 

 [bookmark: pgfId-1434936]For client proxy (the proxy acts as a TLS client to the server), the user-defined cipher suite replaces the default cipher suite, or the one defined by the ssl encryption command. Use this command to achieve difference ciphers between the two TLS sessions. You should use AES ciphers with the Cisco UCM server. 

  
        

 
         
         		[bookmark: pgfId-1434938]Step 4

  
         		 
           
           [bookmark: pgfId-1434940]hostname(config-tlsp)# 
            exit 
          
  
         		[bookmark: pgfId-1434942]Exits from the TLS proxy configuration mode.

  
        

 
         
         		[bookmark: pgfId-1434945]Step 5[bookmark: 57366]

  
         		 
           
           [bookmark: pgfId-1434947]hostname(config)# 
            tls-proxy 
            proxy_name 
          
 
           
           [bookmark: pgfId-1434948] 
            Example: 
          
 
           
           [bookmark: pgfId-1434949]hostname(config)# tls-proxy remote_to_local-ent 
          
  
         		[bookmark: pgfId-1434951]Create the TLS proxy for inbound connections.

  
        

 
         
         		[bookmark: pgfId-1434954]Step 6[bookmark: 76558]

  
         		 
           
           [bookmark: pgfId-1434956]hostname(config-tlsp)# 
            server 
            trust-point 
            proxy_trustpoint 
          
 
           
           [bookmark: pgfId-1434957] 
            Example: 
          
 
           
           [bookmark: pgfId-1434958]hostname(config-tlsp)# server trust-point local-ent 
          
  
         		[bookmark: pgfId-1434960]For inbound connections, specifies the proxy trustpoint certificate presented during TLS handshake. The certificate must be owned by the adaptive security appliance (identity certificate). 

 [bookmark: pgfId-1434961]Where proxy_trustpoint specifies the trustpoint defined by the crypto ca trustpoint command in Step 2 in “Creating Trustpoints and Generating Certificates” section. 

 [bookmark: pgfId-1434971]Because the TLS proxy has strict definition of client proxy and server proxy, two TLS proxy instances must be defined if either of the entities could initiate the connection. 

  
        

 
         
         		[bookmark: pgfId-1434973]Step 7

  
         		 
           
           [bookmark: pgfId-1434975]hostname(config-tlsp)# 
            client 
            cipher-suite 
            cipher_suite 
          
 
           
           [bookmark: pgfId-1434976] 
            Example:  
          
 
           
           [bookmark: pgfId-1434977]hostname(config-tlsp)# client cipher-suite aes128-sha1 aes256-sha1 3des-sha1 null-sha1 
          
  
         		[bookmark: pgfId-1434979]For inbound connections, controls the TLS handshake parameter for the cipher suite. 

 [bookmark: pgfId-1434980]Where cipher_suite includes des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, or null-sha1. 

  
        

 
         
         		[bookmark: pgfId-1434982]Step 8

  
         		 
           
           [bookmark: pgfId-1434984]hostname(config-tlsp)# 
            exit 
          
  
         		[bookmark: pgfId-1434986]Exits from the TSL proxy configuration mode.

  
        

 
         
         		[bookmark: pgfId-1434988]Step 9

  
         		 
           
           [bookmark: pgfId-1434990]hostname(config)# 
            ssl 
            encryption 
            3des-shal 
            aes128-shal [ 
            algorithms ] 
          
  
         		[bookmark: pgfId-1434992]Specifies the encryption algorithms that the SSL/TLS protocol uses. Specifying the 3des-shal and aes128-shal is required. Specifying other algorithms is optional. 

 [bookmark: pgfId-1434993]Note The Cisco Intercompany Media Engine Proxy requires that you use strong encryption. You must specify this command when the proxy is licensed using a K9 license. 

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1434995]What to Do Next

 
     [bookmark: pgfId-1434996]Once you have created the TLS proxy, enable it for SIP inspection. 

 
    
 
     
      [bookmark: pgfId-1434998][bookmark: 69920]Enabling SIP Inspection for the Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1434999]Enable the TLS proxy for SIP inspection and define policies for both entities that could initiate the connection. 

 
     [bookmark: pgfId-1435002]The example command lines in this task are based on a basic (in-line) deployment. See Figure 21-6 for an illustration explaining the example command lines in this task.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1435004]Note If you want to change any Cisco Intercompany Media Engine Proxy settings after you enable SIP inspection, you must enter the no service-policy command, and then reconfigure the service policy as described in this procedure. Removing and reconfiguring the service policy does not affect existing calls; however, the first call traversing the Cisco Intercompany Media Engine Proxy will fail. Enter the clear connection command and restart the ASA. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1435008]To enable SIP inspection for the Cisco Intercompany Media Engine Proxy, perform the following steps:

 
     [bookmark: pgfId-1435162] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1435011]  
          
  
         		 
           
           [bookmark: pgfId-1435013]Command 
          
  
         		 
           
           [bookmark: pgfId-1435015]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1435018]Step 1[bookmark: 51239]

  
         		 
           
           [bookmark: pgfId-1435020]hostname(config)# 
            class-map 
            class_map_name 
          
 
           
           [bookmark: pgfId-1435021] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435022]hostname(config)# class-map ime-inbound-sip 
          
  
         		[bookmark: pgfId-1435024]Defines a class for the inbound Cisco Intercompany Media Engine SIP traffic. 

  
        

 
         
         		[bookmark: pgfId-1435026]Step 2

  
         		 
           
           [bookmark: pgfId-1435028]hostname(config-cmap)# 
            match access-list 
            access_list_name 
          
 
           
           [bookmark: pgfId-1435029] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435030]hostname(config-cmap)# match access-list ime-inbound-sip 
          
  
         		[bookmark: pgfId-1435032]Identifies the SIP traffic to inspect. 

 [bookmark: pgfId-1435033]Where the access_list_name is the ACL you created in  of the task Creating ACLs for Cisco Intercompany Media Engine Proxy.

  
        

 
         
         		[bookmark: pgfId-1435041]Step 3

  
         		 
           
           [bookmark: pgfId-1435043]hostname(config-cmap)# 
            exit 
          
  
         		[bookmark: pgfId-1435045]Exits from the class map configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435048]Step 4[bookmark: 83196]

  
         		 
           
           [bookmark: pgfId-1435050]hostname(config)# 
            class-map 
            class_map_name 
          
 
           
           [bookmark: pgfId-1435051] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435052]hostname(config)# class-map ime-outbound-sip 
          
  
         		[bookmark: pgfId-1435054]Defines a class for the outbound SIP traffic from Cisco Intercompany Media Engine. 

  
        

 
         
         		[bookmark: pgfId-1435056]Step 5

  
         		 
           
           [bookmark: pgfId-1435058]hostname(config)# 
            match access-list 
            access_list_name 
          
 
           
           [bookmark: pgfId-1435059] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435060]hostname(config-cmap)# match access-list ime-outbound-sip 
          
  
         		[bookmark: pgfId-1435062]Identifies which outbound SIP traffic to inspect. 

 [bookmark: pgfId-1435063]Where the access_list_name is the ACL you created in  of the task Creating ACLs for Cisco Intercompany Media Engine Proxy.

  
        

 
         
         		[bookmark: pgfId-1435071]Step 6

  
         		 
           
           [bookmark: pgfId-1435073]hostname(config-cmap)# 
            exit 
          
  
         		[bookmark: pgfId-1435075]Exits from the class map configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435078]Step 7[bookmark: 39478]

  
         		 
           
           [bookmark: pgfId-1435080]hostname(config)# 
            policy-map 
            name 
          
 
           
           [bookmark: pgfId-1435081] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435082]hostname(config)# policy-map ime-policy 
          
  
         		[bookmark: pgfId-1435084]Defines the policy map to which to attach the actions for the class of traffic. 

  
        

 
         
         		[bookmark: pgfId-1435086]Step 8

  
         		 
           
           [bookmark: pgfId-1435088]hostname(config-pmap)# 
            class 
            classmap_name 
          
 
           
           [bookmark: pgfId-1435089] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435090]hostname(config-pmap)# class ime-outbound-sip 
          
  
         		[bookmark: pgfId-1435092]Assigns a class map to the policy map so that you can assign actions to the class map traffic. 

 [bookmark: pgfId-1435093]Where classmap_name is the name of the SIP class map that you created in  in this task. 

  
        

 
         
         		[bookmark: pgfId-1435098]Step 9

  
         		 
           
           [bookmark: pgfId-1435100]hostname(config-pmap-c)# 
            inspect sip [ 
            sip_map ] 
             
            tls-proxy 
            proxy_name 
            uc-ime 
            uc_ime_map 
          
 
           
           [bookmark: pgfId-1435101] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435102]hostname(config-pmap-c)# inspect sip tls-proxy local_to_remote-ent uc-ime local-ent-ime 
          
  
         		[bookmark: pgfId-1435104]Enables the TLS proxy and Cisco Intercompany Media Engine Proxy for the specified SIP inspection session.

  
        

 
         
         		[bookmark: pgfId-1435106]Step 10

  
         		 
           
           [bookmark: pgfId-1435108]hostname(config-cmap-c)# 
            exit 
          
  
         		[bookmark: pgfId-1435110]Exits from the policy map class configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435112]Step 11

  
         		 
           
           [bookmark: pgfId-1435114]hostname(config-pmap)# 
            class 
            class_map_name 
          
 
           
           [bookmark: pgfId-1435115] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435116]hostname(config-pmap)# class ime-inbound-sip 
          
  
         		[bookmark: pgfId-1435118]Assigns a class map to the policy map so that you can assign actions to the class map traffic. 

 [bookmark: pgfId-1435119]Where classmap_name is the name of the SIP class map that you created in  in this task.

  
        

 
         
         		[bookmark: pgfId-1435124]Step 12

  
         		 
           
           [bookmark: pgfId-1435126]hostname(config-pmap-c)# 
            inspect sip [ 
            sip_map ] 
             
            tls-proxy 
            proxy_name 
            uc-ime 
            uc_ime_map 
          
 
           
           [bookmark: pgfId-1435127] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435128]hostname(config-pmap-c)# inspect sip tls-proxy remote-to-local-ent uc-ime local-ent-ime 
          
  
         		[bookmark: pgfId-1435130]Enables the TLS proxy and Cisco Intercompany Media Engine Proxy for the specified SIP inspection session.

  
        

 
         
         		[bookmark: pgfId-1435132]Step 13

  
         		 
           
           [bookmark: pgfId-1435134]hostname(config-pmap-c)# 
            exit 
          
  
         		[bookmark: pgfId-1435136]Exits from the policy map class configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435138]Step 14

  
         		 
           
           [bookmark: pgfId-1435140]hostname(config-pmap)# 
            exit 
          
  
         		[bookmark: pgfId-1435142]Exits from the policy map configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435144]Step 15

  
         		 
           
           [bookmark: pgfId-1435146]hostname(config)# 
            service-policy 
            policymap_name 
            global 
          
 
           
           [bookmark: pgfId-1435147] 
            Examples: 
          
 
           
           [bookmark: pgfId-1435148]hostname(config)# service-policy ime-policy global 
          
  
         		[bookmark: pgfId-1435150]Enables the service policy for SIP inspection for all interfaces. 

 [bookmark: pgfId-1435151]Where policymap_name is the name of the policy map you created in  of this task.

 [bookmark: pgfId-1435157]See Creating the Cisco Intercompany Media Engine Proxy for information about the UC-IME proxy settings. See CLI configuration guide for information about the no service-policy command.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1435163]What to Do Next

 
     [bookmark: pgfId-1435164]Once you have enabled the TLS proxy for SIP inspection, if necessary, configure TLS within the enterprise. See (Optional) Configuring TLS within the Local Enterprise. 

 
    
 
     
      [bookmark: pgfId-1435169][bookmark: 35398](Optional) Configuring TLS within the Local Enterprise 

 
     [bookmark: pgfId-1435170]This task is not required if TCP is allowable within the inside network. 

 
     [bookmark: pgfId-1435171]TLS within the enterprise refers to the security status of the Cisco Intercompany Media Engine trunk as seen by the ASA. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1435175]Note If the transport security for the Cisco Intercompany Media Engine trunk changes on Cisco UCM, it must be changed on the ASA as well. A mismatch will result in call failure. The ASA does not support SRTP with non-secure IME trunks. The ASA assumes SRTP is allowed with secure trunks. So ‘SRTP Allowed’ must be checked for IME trunks if TLS is used. The ASA supports SRTP fallback to RTP for secure IME trunk calls. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1435188]Prerequisites

 
     [bookmark: pgfId-1435189]On the local Cisco UCM, download the Cisco UCM certificate. See the Cisco Unified Communications Manager documentation for information. You will need this certificate when performing Step 6 of this procedure.

 
     [bookmark: pgfId-1435193]Procedure

 
     [bookmark: pgfId-1435196]To configure TLS within the local enterprise, perform the following steps on the local ASA:

 
     [bookmark: pgfId-1435399] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1435200]  
          
  
         		 
           
           [bookmark: pgfId-1435202]Commands 
          
  
         		 
           
           [bookmark: pgfId-1435204]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1435207]Step 1[bookmark: 39005]

  
         		 
           
           [bookmark: pgfId-1435209]hostname(config)# 
            crypto key generate rsa label 
            key-pair-label  
          
 
           
           [bookmark: pgfId-1435210]hostname(config)# 
            crypto ca trustpoint 
            trustpoint_name 
          
 
           
           [bookmark: pgfId-1435211]hostname(config-ca-trustpoint)# 
            enroll self 
          
 
           
           [bookmark: pgfId-1435212]hostname(config-ca-trustpoint)# 
            keypair 
            keyname 
          
 
           
           [bookmark: pgfId-1435213]hostname(config-ca-trustpoint)# 
            subject-name 
            x.500_name 
          
 
           
           [bookmark: pgfId-1435214] 
            Example:  
          
 
           
           [bookmark: pgfId-1435215]hostname(config)# crypto key generate rsa label local-ent-key 
          
 
           
           [bookmark: pgfId-1435216]hostname(config)# crypto ca trustpoint local-asa 
          
 
           
           [bookmark: pgfId-1435217]hostname(config-ca-trustpoint)# enroll self 
          
 
           
           [bookmark: pgfId-1435218]hostname(config-ca-trustpoint)# keypair key-local-asa 
          
 
           
           [bookmark: pgfId-1435219]hostname(config-ca-trustpoint)# subject-name 
            cn=Ent-local-domain-name** ., o="Example Corp" 
          
  
         		[bookmark: pgfId-1435221]Creates an RSA key and trustpoint for the self-signed certificate.

 [bookmark: pgfId-1435222]Where key-pair-label is the RSA key for the local ASA.

 [bookmark: pgfId-1435226]Where trustpoint_name is the trustpoint for the local ASA.

 [bookmark: pgfId-1435232]Where keyname is key pair for the local ASA. 

 [bookmark: pgfId-1435234]Where x.500_name includes the X.500 distinguished name of the local ASA; for example, cn=Ent-local-domain-name**. 

 [bookmark: pgfId-1435238]Note The domain name that you enter here must match the domain name that has been set for the local Cisco UCM. For information about how to configure the domain name for Cisco UCM, see the Cisco Unified Communications Manager documentation for information. 

  
        

 
         
         		[bookmark: pgfId-1435240]Step 2

  
         		 
           
           [bookmark: pgfId-1435242]hostname(config-ca-trustpoint)# 
            exit 
          
  
         		[bookmark: pgfId-1435244]Exits from Trustpoint Configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435246]Step 3

  
         		 
           
           [bookmark: pgfId-1435248]hostname(config)# 
            crypto ca export 
            trustpoint  
            identity-certificate 
          
 
           
           [bookmark: pgfId-1435249] 
            Example:  
          
 
           
           [bookmark: pgfId-1435250]hostname(config)# crypto ca export local-asa identity-certificate 
          
  
         		[bookmark: pgfId-1435255]Exports the certificate you created in Step 1. The certificate contents appear on the terminal screen. 

 [bookmark: pgfId-1435256]Copy the certificate from the terminal screen. This certificate enables Cisco UCM to validate the certificate that the ASA sends in the TLS handshake. 

 [bookmark: pgfId-1435260]On the local Cisco UCM, upload the certificate into the Cisco UCM trust store. See the Cisco Unified Communications Manager documentation for information.

 [bookmark: pgfId-1435261]Note The subject name you enter while uploading the certificate to the local Cisco UCM is compared with the X.509 Subject Name field entered on the SIP Trunk Security Profile on Cisco UCM. For example, “Ent-local-domain-name” was entered in Step 1 of this task; therefore, “Ent-local-domain-name” should be entered in the Cisco UCM configuration. 

  
        

 
         
         		[bookmark: pgfId-1435267]Step 4[bookmark: 18723]

  
         		 
           
           [bookmark: pgfId-1435269]hostname(config)# 
            crypto ca trustpoint 
            trustpoint_name 
          
 
           
           [bookmark: pgfId-1435270]hostname(config-ca-trustpoint)# 
            enroll terminal 
          
 
           
           [bookmark: pgfId-1435271] 
            Example:  
          
 
           
           [bookmark: pgfId-1435272]hostname(config)# crypto ca trustpoint local-ent-ucm 
          
 
           
           [bookmark: pgfId-1435273]hostname(config-ca-trustpoint)# enroll terminal 
          
  
         		[bookmark: pgfId-1435275]Creates a trustpoint for local Cisco UCM.

 [bookmark: pgfId-1435276]Where trustpoint_name is the trustpoint for the local Cisco UCM.

  
        

 
         
         		[bookmark: pgfId-1435278]Step 5

  
         		 
           
           [bookmark: pgfId-1435280]hostname(config-ca-trustpoint)# 
            exit 
          
  
         		[bookmark: pgfId-1435282]Exits from Trustpoint Configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435285]Step 6[bookmark: 59049]

  
         		 
           
           [bookmark: pgfId-1435287]hostname(config)# 
            crypto ca authenticate 
            trustpoint 
          
 
           
           [bookmark: pgfId-1435288] 
            Example:  
          
 
           
           [bookmark: pgfId-1435289]hostname(config)# crypto ca authenticate local-ent-ucm 
          
  
         		[bookmark: pgfId-1435291]Imports the certificate from local Cisco UCM. 

 [bookmark: pgfId-1435292]Where trustpoint is the trustpoint for the local Cisco UCM. 

 [bookmark: pgfId-1435293]Paste the certificate downloaded from the local Cisco UCM. This certificate enables the ASA to validate the certificate that Cisco UCM sends in the TLS handshake. 

  
        

 
         
         		[bookmark: pgfId-1435298]Step 7

  
         		 
           
           [bookmark: pgfId-1435300]hostname(config)# 
            tls-proxy  
            proxy_name 
          
 
           
           [bookmark: pgfId-1435301]hostname(config-tlsp)# 
            server trust-point 
            proxy_trustpoint 
          
 
           
           [bookmark: pgfId-1435302]hostname(config-tlsp)# 
            client trust-point 
            proxy_trustpoint 
          
 
           
           [bookmark: pgfId-1435303]hostname(config-tlsp)# 
            client cipher-suite aes128-sha1 aes256-sha1 3des-sha1 null-sha1 
          
 
           
           [bookmark: pgfId-1435304] 
            Example:  
          
 
           
           [bookmark: pgfId-1435305]hostname(config)# tls-proxy local_to_remote-ent 
          
 
           
           [bookmark: pgfId-1435306]hostname(config-tlsp)# server trust-point local-ent-ucm 
          
 
           
           [bookmark: pgfId-1435307]hostname(config-tlsp)# client trust-point local-ent 
          
 
           
           [bookmark: pgfId-1435308]hostname(config-tlsp)# client cipher-suite aes128-sha1 aes256-sha1 3des-sha1 null-sha1 
          
  
         		[bookmark: pgfId-1435310]Updates the TLS proxy for outbound connections.

 [bookmark: pgfId-1435311]Where proxy_name is the name you entered in Step 1 of the task Creating the TLS Proxy. 

 [bookmark: pgfId-1435318]Where proxy_trustpoint for the server trust-point command is the name you entered in Step 4 of this procedure. 

 [bookmark: pgfId-1435322]Where proxy_trustpoint for the client trust-point command is the name you entered in Step 2 of the task Creating Trustpoints and Generating Certificates. 

 [bookmark: pgfId-1435329]Note In this step, you are creating different trustpoints for the client and the server. 

  
        

 
         
         		[bookmark: pgfId-1435331]Step 8

  
         		 
           
           [bookmark: pgfId-1435333]hostname(config-tlsp)# 
            exit 
          
  
         		[bookmark: pgfId-1435335]Exits from TLS Proxy Configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435337]Step 9

  
         		 
           
           [bookmark: pgfId-1435339]hostname(config)# 
            tls-proxy proxy_name 
          
 
           
           [bookmark: pgfId-1435340]hostname(config-tlsp)# 
            server trust-point 
            proxy_trustpoint 
          
 
           
           [bookmark: pgfId-1435341]hostname(config-tlsp)# 
            client trust-point 
            proxy_trustpoint 
          
 
           
           [bookmark: pgfId-1435342]hostname(config-tlsp)# 
            client cipher-suite aes128-sha1 aes256-sha1 3des-sha1 null-sha1 
          
 
           
           [bookmark: pgfId-1435343] 
            Example:  
          
 
           
           [bookmark: pgfId-1435344]hostname(config)# tls-proxy remote_to_local-ent 
          
 
           
           [bookmark: pgfId-1435345]hostname(config-tlsp)# server trust-point local-ent 
          
 
           
           [bookmark: pgfId-1435346]hostname(config-tlsp)# client trust-point local-ent-ucm 
          
 
           
           [bookmark: pgfId-1435347]hostname(config-tlsp)# client cipher-suite aes128-sha1 aes256-sha1 3des-sha1 null-sha1 
          
  
         		[bookmark: pgfId-1435349]Updates the TLS proxy for inbound connections.

 [bookmark: pgfId-1435350]Where proxy_name is the name you entered in Step 5 of the task Creating the TLS Proxy. 

 [bookmark: pgfId-1435357]Where proxy_trustpoint for the server trust-point command is the name you entered in Step 2 of the task Creating Trustpoints and Generating Certificates. 

 [bookmark: pgfId-1435364]Where proxy_trustpoint for the client trust-point command is the name you entered in Step 4 of this procedure.

  
        

 
         
         		[bookmark: pgfId-1435369]Step 10

  
         		 
           
           [bookmark: pgfId-1435371]hostname(config-tlsp)# 
            exit 
          
  
         		[bookmark: pgfId-1435373]Exits from TLS Proxy Configuration mode.

  
        

 
         
         		[bookmark: pgfId-1435376]Step 11[bookmark: 92195]

  
         		 
           
           [bookmark: pgfId-1435378]hostname(config)# 
            uc-ime 
            uc_ime_name 
          
 
           
           [bookmark: pgfId-1435379]hostname(config-uc-ime)# 
            ucm address 
            ip_address 
            trunk-security-mode secure 
          
 
           
           [bookmark: pgfId-1435380] 
            Example: 
          
 
           
           [bookmark: pgfId-1435381]hostname(config)# uc-ime local-ent-ime 
          
 
           
           [bookmark: pgfId-1435382]hostname(config-uc-ime)# ucm address 192.168.10.30 trunk-security-mode secure 
          
  
         		[bookmark: pgfId-1435384]Updates the Cisco Intercompany Media Engine Proxy for trunk-security-mode.

 [bookmark: pgfId-1435385]Where uc_ime_name is the name you entered in Step 1 of the task Creating the Cisco Intercompany Media Engine Proxy. 

 [bookmark: pgfId-1435392]Only perform this step if you entered nonsecure in Step 3 of the task Creating the Cisco Intercompany Media Engine Proxy.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1435400]What to Do Next

 
     [bookmark: pgfId-1435401]Once you have configured the TLS within the enterprise, if necessary, configure off path signaling for an off path deployment. See (Optional) Configuring Off Path Signaling. 

 
    
 
     
      [bookmark: pgfId-1435406][bookmark: 50771](Optional) Configuring Off Path Signaling

 
     [bookmark: pgfId-1435407]Perform this task only when you are configuring the Cisco Intercompany Media Engine Proxy as part of an off path deployment. You might choose to have an off path deployment when you want to use the Cisco Intercompany Media Engine but do not want to replace your existing Internet firewall with an ASA enabled with the Cisco Intercompany Media Engine Proxy. 

 
     [bookmark: pgfId-1435411]In an off path deployment, the existing firewall that you have deployed in your environment is not capable of transmitting Cisco Intercompany Media Engine traffic. 

 
     [bookmark: pgfId-1435412]Off path signaling requires that outside IP addresses translate to an inside IP address. The inside interface address can be used for this mapping service configuration. For the Cisco Intercompany Media Engine Proxy, the ASA creates dynamic mappings for external addresses to the internal IP address; therefore, using the dynamic NAT configuration on outbound calls, Cisco UCM sends SIP traffic to this internal IP address, and the ASA uses that mapping to determine the real destination on inbound calls. The static NAT or PAT mapping is used for inbound calls in an off path configuration.

 
     [bookmark: pgfId-1435419]Figure 21-9 Example for Configuring Off Path Signaling in an Off Path Deployment

 
     [bookmark: pgfId-1435423] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1435426]After you configure off path signaling, the ASA mapping service listens on interface “inside” for requests. When it receives a request, it creates a dynamic mapping for the “outside” as the destination interface. 

 
     [bookmark: pgfId-1435428]To configure off path signaling for the Cisco Intercompany Media Engine Proxy, perform the following steps:

 
     [bookmark: pgfId-1435510] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1435431]  
          
  
         		 
           
           [bookmark: pgfId-1435433]Command 
          
  
         		 
           
           [bookmark: pgfId-1435435]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1435437]Step 1

  
         		 
           
           [bookmark: pgfId-1435439]hostname(config)# 
            object network 
            name 
          
 
           
           [bookmark: pgfId-1435440] 
            Example: 
          
 
           
           [bookmark: pgfId-1435441]hostname(config)# object network outside-any 
          
  
         		[bookmark: pgfId-1435445]For the off path ASA, creates a network object to represent all outside addresses.

  
        

 
         
         		[bookmark: pgfId-1435448]Step 2

  
         		 
           
           [bookmark: pgfId-1435450]hostname(config-network-object)# 
            subnet 
            ip_address 
          
 
           
           [bookmark: pgfId-1435451] 
            Example: 
          
 
           
           [bookmark: pgfId-1435452]hostname(config-network-object)# subnet 0.0.0.0 0.0.0.0 
          
  
         		[bookmark: pgfId-1435454]Specifies the IP address of the subnet.

  
        

 
         
         		[bookmark: pgfId-1435456]Step 3

  
         		 
           
           [bookmark: pgfId-1435458]hostname(config-network-object)# 
            nat (outside,inside) dynamic interface inside 
          
  
         		[bookmark: pgfId-1435460]Creates a mapping for the Cisco UCM of remote enterprises.

  
        

 
         
         		[bookmark: pgfId-1435462]Step 4

  
         		 
           
           [bookmark: pgfId-1435464]hostname(config-network-object)# 
            exit 
          
  
         		[bookmark: pgfId-1435466]Exits from the objects configuration mode. 

  
        

 
         
         		[bookmark: pgfId-1435468]Step 5

  
         		 
           
           [bookmark: pgfId-1435470]hostname(config)# 
            uc-ime 
            uc_ime_name 
          
 
           
           [bookmark: pgfId-1435471] 
            Example: 
          
 
           
           [bookmark: pgfId-1435472]hostname(config)# uc-ime local-ent-ime 
          
  
         		[bookmark: pgfId-1435474]Specifies the Cisco Intercompany Media Engine Proxy that you created in the task Creating the Cisco Intercompany Media Engine Proxy. 

 [bookmark: pgfId-1435478]Where uc_ime_name is the name you specified in Step 1 of Creating the Cisco Intercompany Media Engine Proxy.

  
        

 
         
         		[bookmark: pgfId-1435486]Step 6

  
         		 
           
           [bookmark: pgfId-1435488]hostname(config)# 
            mapping-service 
            listening-interface 
            interface_name [ 
            listening-port 
            port ] 
            uc-ime-interface 
            uc-ime-interface_name 
          
 
           
           [bookmark: pgfId-1435489] 
            Example: 
          
 
           
           [bookmark: pgfId-1435490]hostname(config-uc-ime)# mapping-service listening-interface inside listening-port 8060 uc-ime-interface outside 
          
  
         		[bookmark: pgfId-1435494]For the off path ASA, adds the mapping service to the Cisco Intercompany Media Engine Proxy.

 [bookmark: pgfId-1435496]Specifies the interface and listening port for the ASA mapping service.

 [bookmark: pgfId-1435500]You can only configure one mapping server for the Cisco Intercompany Media Engine Proxy. 

 [bookmark: pgfId-1435501]Where interface_name is the name of the interface on which the ASA listens for the mapping requests.

 [bookmark: pgfId-1435507]Where port is the TCP port on which the ASA listens for the mapping requests. The port number must be between 1024 and 65535 to avoid conflicts with other services on the device, such as Telnet or SSH. By default, the port number is TCP 8060.

 [bookmark: pgfId-1435509]Where uc-ime-interface_name is the name of the interface that connects to the remote Cisco UCM.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1433677]This section contains the following sections:

 
      
      		 [bookmark: pgfId-1433680]Configuring the Cisco UC-IMC Proxy by using the UC-IME Proxy Pane

 
      		 [bookmark: pgfId-1433684]Configuring the Cisco UC-IMC Proxy by using the Unified Communications Wizard

 
     

 
    
 
     
      [bookmark: pgfId-1433687][bookmark: 86745]Configuring the Cisco UC-IMC Proxy by using the UC-IME Proxy Pane

 
     [bookmark: pgfId-1433688]Use the Configure Cisco Intercompany Media Engine (UC-IME) proxy pane to add or edit a Cisco Intercompany Media Engine Proxy instance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433689]Note The Cisco Intercompany Media Engine Proxy does not appear as an option under the Unified Communications section of the navigation pane unless the license required for this proxy is installed on the ASA.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433693]Use this pane to create the proxy instance; however, for the UC-IME proxy to be fully functionally, you must complete additional tasks, such as create the required NAT statements, ACLs, and MTA, set up the certificates, create the TLS Proxy, and enable SIP inspection. 

 
     [bookmark: pgfId-1433694]Depending on whether the UC-IME proxy is deployed off path or in-line of Internet traffic, you must create the appropriate network objects with embedded NAT/PAT statements for the Cisco UCMs. 

 
     [bookmark: pgfId-1433695]This pane is available from the Configuration > Firewall > Unified Communications > UC-IME Proxy.

 
     
 
     [bookmark: pgfId-1433696]Step 1 Open the Configuration > Firewall > Unified Communications > UC-IME Proxy pane. 

 
     [bookmark: pgfId-1433697]Step 2 Check the Enable Cisco UC-IME proxy check box to enable the feature. 

 
     [bookmark: pgfId-1433698]Step 3 In the Unified CM Servers area, enter an IP address or hostname for the Cisco Unified Communications Manager (Cisco UCM) or click the ellipsis to open a dialog and browse for an IP address or hostname. 

 
     [bookmark: pgfId-1433699]Step 4 In the Trunk Security Mode field, click a security option. Specifying secure for Cisco UCM or Cisco UCM cluster indicates that Cisco UCM or Cisco UCM cluster is initiating TLS.

 
     [bookmark: pgfId-1433700]Step 5 Click Add to add the Cisco UCM for the Cisco Intercompany Media Engine Proxy. You must include an entry for each Cisco UCM in the cluster with Cisco Intercompany Media Engine that has a SIP trunk enabled.

 
     [bookmark: pgfId-1433701]Step 6 In the Ticket Epoch field, enter an integer from 1-255. 

 
     [bookmark: pgfId-1433702]The epoch contains an integer that updates each time that the password is changed. When the proxy is configured the first time and a password entered for the first time, enter 1 for the epoch integer. Each time you change the password, increment the epoch to indicate the new password. You must increment the epoch value each time your change the password. 

 
     [bookmark: pgfId-1433705]Typically, you increment the epoch sequentially; however, the ASA allows you to choose any value when you update the epoch. 

 
     [bookmark: pgfId-1433707]If you change the epoch value, the current password is invalidated and you must enter a new password. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433710]Note The epoch and password that you configure in this step on the ASA must match the epoch and password that you configure on the Cisco Intercompany Media Engine server. See the Cisco Intercompany Media Engine server documentation for information. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433712]Step 7 In the Ticket Password field, enter a minimum of 10 printable character from the US-ASCII character set. The allowed characters include 0x21 to 0x73 inclusive, and exclude the space character. The ticket password can be up to 64 characters. Confirm the password you entered. Only one password can be configured at a time. 

 
     [bookmark: pgfId-1433713]Step 8 Check the Apply MTA to UC-IME Link proxy check box to associate the media termination address with the Cisco Intercompany Media Engine Proxy. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433714]Note You must create the media termination instance before you associate it with the Cisco Intercompany Media Engine Proxy. If necessary, click the Configure MTA button to configure a media termination address instance. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433715]Step 9 If the Cisco Intercompany Media Engine Proxy is being configured as part of off path deployment, check the Enable off path address mapping service checkbox and configure the off path deployment settings: 

 
     [bookmark: pgfId-1433718] a. From the Listening Interface field, select an ASA interface. This is the interface on which the ASA listens for the mapping requests.

 
     [bookmark: pgfId-1433725] b. In the Port field, enter a number between 1024 and 65535 as the TCP port on which the ASA listens for the mapping requests. The port number must be 1024 or higher to avoid conflicts with other services on the device, such as Telnet or SSH. By default, the port number is TCP 8060.

 
     [bookmark: pgfId-1433727] c. From the UC-IME Interface field, select an interface from the list. This is the interface that the ASA uses to connect to the remote Cisco UCM.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433733]Note In an off path deployment any existing ASA that you have deployed in your environment are not capable of transmitting Cisco Intercompany Media Engine traffic. Off-path signaling requires that outside addresses are translated (using NAT) to an inside IP address. The inside interface address can be used for this mapping service configuration. For the Cisco Intercompany Media Engine Proxy, the ASA creates dynamic mappings for external addresses to the internal IP address. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433738]Step 10 In the Fallback area, configure the fallback timer for the Cisco Intercompany Media Engine by specifying the following settings: 

 
     [bookmark: pgfId-1433741] a. In the Fallback Sensitivity File field, enter the path to a file in flash memory that the ASA uses for mid-call PSTN fallback. The file name that you enter must be the name of a file on disk that includes the .fbs file extension. Alternatively, click the Browse Flash button to locate and select the file from flash memory.

 
     [bookmark: pgfId-1433743] b. In the Call Quality Evaluation Interval field, enter a number between 10-600 (in milliseconds). This number controls the frequency at which the ASA samples the RTP packets received from the Internet. The ASA uses the data sample to determine if fallback to the PSTN is needed for a call. By default, the length is 100 milliseconds for the timer.

 
     [bookmark: pgfId-1433750] c. In the Notification Interval field, enter a number between 10-360 (in seconds). This number controls the amount of time that the ASA waits before notifying Cisco UCM whether to fall back to PSTN. By default, the length is 20 seconds for this timer. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433754]Note When you change the fallback timer for the Cisco Intercompany Media Engine Proxy, ASDM automatically removes the proxy from SIP inspection and then reapplies SIP inspection when the proxy is re-enabled.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433755]Step 11 Click Apply to save the configuration changes for the Cisco Intercompany Media Engine Proxy. 

 
     [bookmark: pgfId-1433756]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1433758][bookmark: 47405]Configuring the Cisco UC-IMC Proxy by using the Unified Communications Wizard

 
     [bookmark: pgfId-1433759]To configure the Cisco Intercompany Media Engine Proxy by using ASDM, choose Wizards > Unified Communications Wizard from the menu. The Unified Communications Wizard opens. From the first page, select the Cisco Intercompany Media Engine Proxy option under the Business-to-Business section. 

 
     [bookmark: pgfId-1433760]The wizard automatically creates the necessary TLS proxy, then guides you through creating the Intercompany Media Engine proxy, importing and installing the required certificates, and finally enables the SIP inspection for the Intercompany Media Engine traffic automatically. 

 
     [bookmark: pgfId-1433761]The wizard guides you through these steps to create the Cisco Intercompany Media Engine Proxy:

 
     
 
     [bookmark: pgfId-1433762]Step 1 Select the Intercompany Media Engine Proxy option.

 
     [bookmark: pgfId-1433765]Step 2 Select the topology of the Cisco Intercompany Media Engine Proxy, namely whether the ASA is an edge firewall with all Internet traffic flowing through it or whether the ASA is off the path of the main Internet traffic (referred to as an off path deployment). 

 
     [bookmark: pgfId-1433770]Step 3 Specify private network settings such as the Cisco UCM IP addresses and the ticket settings. 

 
     [bookmark: pgfId-1433771]Step 4 Specify the public network settings.

 
     [bookmark: pgfId-1433772]Step 5 Specify the media termination address settings of Cisco UCM.

 
     [bookmark: pgfId-1433773]Step 6 Configure the local-side certificate management, namely the certificates that are exchanged between the local Cisco Unified Communications Manager servers and the ASA. The identity certificate that the wizard generates in this step needs to be installed on each Cisco Unified Communications Manager (UCM) server in the cluster with the proxy and each identity certificate from the Cisco UCMs need to be installed on the ASA. The certificates are used by the ASA and the Cisco UCMs to authenticate each other, respectively, during TLS handshakes. The wizard only supports self-signed certificates for this step. 

 
     [bookmark: pgfId-1433783]Step 7 Configure the remote-side certificate management, namely the certificates that are exchanged between the remote server and the ASA. In this step, the wizard generates a certificate signing request (CSR). After successfully generating the identity certificate request for the proxy, the wizard prompts you to save the file. 

 
     [bookmark: pgfId-1433787]You must send the CSR text file to a certificate authority (CA), for example, by pasting the text file into the CSR enrollment page on the CA website. When the CA returns the Identity Certificate, you must install it on the ASA. This certificate is presented to remote servers so that they can authenticate the ASA as a trusted server.

 
     [bookmark: pgfId-1433794]Finally, this step of the wizard assists you in installing the root certificates of the CA from the remote servers so that the ASA can determine that the remote servers are trusted.

 
     [bookmark: pgfId-1433798]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1433799]The wizard completes by displaying a summary of the configuration created for Cisco Intercompany Media Engine. See the Unified Communications Wizard section in this documentation for more information. 

 
     [bookmark: pgfId-1415569] 

 
     [bookmark: pgfId-1433806]This section describes how to certain options of the show uc-ime command to obtain troubleshooting information for the Cisco Intercompany Media Engine Proxy. See the command reference for detailed information about the syntax for these commands. 

 
     [bookmark: pgfId-1433810]show uc-ime signaling-sessions 

 
     [bookmark: pgfId-1433811]Displays the corresponding SIP signaling sessions stored by the Cisco Intercompany Media Engine Proxy. Use this command to troubleshoot media or signaling failure. The command also displays the fallback parameters extracted from the SIP message headers, whether RTP monitoring is enabled or disabled, and whether SRTP keys are set. 

 
     [bookmark: pgfId-1433812]Through the use of the Cisco Intercompany Media Engine Proxy, not only signaling but also media is secured for communication. It provides signaling encryption and SRTP/RTP conversion with SRTP enforced on the Internet side. The Cisco Intercompany Media Engine Proxy inserts itself into the media path by modifying the SIP signaling messages from Cisco UCMs.The Cisco Intercompany Media Engine Proxy sits on the edge of the enterprise and inspects SIP signaling between SIP trunks created between enterprises. It terminates TLS signaling from the Internet and initiates TCP or TLS to the local Cisco UCM. 

 
      
      [bookmark: pgfId-1433813]hostname# show uc-ime signaling-sessions 
     
 
      
      [bookmark: pgfId-1433814] 1 in use, 3 most used 
     
 
      
      [bookmark: pgfId-1433815] inside 192.168.10.30:39608 outside 10.194.108.118:5070 
     
 
      
      [bookmark: pgfId-1433816] Local Media (audio) conn: 10.194.108.119/29824 to 10.194.108.109/21558 
     
 
      
      [bookmark: pgfId-1433817] Local SRTP key set : Remote SRTP key set 
     
 
      
      [bookmark: pgfId-1433818] Remote Media (audio) conn: 192.168.10.51/19520 to 192.168.10.3/30930 
     
 
      
      [bookmark: pgfId-1433819] Call-ID: ab6d7980-a7d11b08-50-1e0aa8c0@192.168.10.30 
     
 
      
      [bookmark: pgfId-1433820] FB Sensitivity: 3 
     
 
      
      [bookmark: pgfId-1433821] Session ID: 2948-32325449-0@81a985c9-f3a1-55a0-3b19-96549a027259 
     
 
      
      [bookmark: pgfId-1433822] SIP Trunk URI: 81a985c9-f3a1-55a0-3b19-9654@UCM-30;maddr=192.168.10.30 
     
 
      
      [bookmark: pgfId-1433823] Codec-name: G722 
     
 
      
      [bookmark: pgfId-1433824] Payload type: 9 
     
 
      
      [bookmark: pgfId-1433825]  
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433826]Note If calls are not going through the Cisco Intercompany Media Engine, you can also use the show tls-proxy session command to troubleshoot the success of the TLS handshake between the components in the Cisco Intercompany Media Engine system. See the command reference for information about this command.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433830]show uc-ime signaling-sessions statistics 

 
     [bookmark: pgfId-1433831]Displays statistical information about corresponding signaling sessions stored by Cisco Intercompany Media Engine Proxy. Failure of signaling sessions in the Cisco Intercompany Media Engine can occur for different call-related reasons; such as failure of ticket verification or domain name verification, or offering RTP over the Internet. 

 
      
      [bookmark: pgfId-1433832]hostname# show uc-ime signaling-sessions statistics 
     
 
      
      [bookmark: pgfId-1433833]10 in use, 20 most used  
     
 
      
      [bookmark: pgfId-1433834]15 terminated 
     
 
      
      [bookmark: pgfId-1433835] Ticket integrity check failed: 2 
     
 
      
      [bookmark: pgfId-1433836] Ticket decode failed: 1 
     
 
      
      [bookmark: pgfId-1433837] Ticket epoch mismatch: 1  
     
 
      
      [bookmark: pgfId-1433838] Ticket DID mismatch: 0  
     
 
      
      [bookmark: pgfId-1433839] Ticket timestamp invalid: 4 
     
 
      
      [bookmark: pgfId-1433840] Ticket domain check failed: 2 
     
 
      
      [bookmark: pgfId-1433841] Ticket not found: 0 
     
 
      
      [bookmark: pgfId-1433842] Route domain name check failed: 1 
     
 
      
      [bookmark: pgfId-1433843] RTP over UC-IME: 2 
     
 
      
      [bookmark: pgfId-1433844]  
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1433845]Note Call-related failures, for example, can be due to the service policy rule being reconfigured or the primary ASA operating in failover mode. If a service policy rule for the Cisco Intercompany Media Engine Proxy is removed (by using the no service policy command) and reconfigured, the first call trasversing the ASA will fail. To resolve this issue, you must additionally enter the clear connection command and restart the ASA. If the failure is due to failover, the connections from the primary ASA are not synchronized to the standby ASA. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1433861]show uc-ime media-sessions detail

 
     [bookmark: pgfId-1433862]Displays the details about all active media sessions (calls) stored for the Cisco Intercompany Media Engine Proxy. Use this command to display output from successful calls. Additionally, use this command to troubleshoot problems with IP phone audio, such as one-way audio. If no calls are currently up, this output will be blank.

 
      
      [bookmark: pgfId-1433863]hostname(config)# show uc-ime media-sessions detail 
     
 
      
      [bookmark: pgfId-1433864] 2 in use, 5 most used 
     
 
      
      [bookmark: pgfId-1433865] Media-session: 10.194.108.109/21558 :: client ip 192.168.10.51/19520 
     
 
      
      [bookmark: pgfId-1433866] Call ID: ab6d7980-a7d11b08-50-1e0aa8c0@192.168.10.30 
     
 
      
      [bookmark: pgfId-1433867] Session ID: 2948-32325449-0@81a985c9-f3a1-55a0-3b19-96549a027259 
     
 
      
      [bookmark: pgfId-1433868] Lcl SRTP conn 10.194.108.109/21558 to 10.194.108.119/29824 tx_pkts 20203 rx_pkts 20200 
     
 
      
      [bookmark: pgfId-1433869] refcnt 3 : created by Inspect SIP, passthrough not set 
     
 
      
      [bookmark: pgfId-1433870] RTP monitoring is enabled 
     
 
      
      [bookmark: pgfId-1433871] Failover_state : 0 
     
 
      
      [bookmark: pgfId-1433872] Sum_all_packets : 20196 
     
 
      
      [bookmark: pgfId-1433873] Codec_payload_format : 9 
     
 
      
      [bookmark: pgfId-1433874] RTP_ptime_ms : 20 
     
 
      
      [bookmark: pgfId-1433875] Max_RBLR_pct_x100 : 0 
     
 
      
      [bookmark: pgfId-1433876] Max_ITE_count_in_8_sec : 0 
     
 
      
      [bookmark: pgfId-1433877] Max_BLS_ms : 0 
     
 
      
      [bookmark: pgfId-1433878] Max_PDV_usec : 1000 
     
 
      
      [bookmark: pgfId-1433879] Min_PDV_usec : 0 
     
 
      
      [bookmark: pgfId-1433880] Mov_avg_PDV_usec : 109 
     
 
      
      [bookmark: pgfId-1433881] Total_ITE_count : 0 
     
 
      
      [bookmark: pgfId-1433882] Total_sec_count : 403 
     
 
      
      [bookmark: pgfId-1433883] Concealed_sec_count : 0 
     
 
      
      [bookmark: pgfId-1433884] Severely_concealed_sec_count : 0 
     
 
      
      [bookmark: pgfId-1433885] Max_call_interval_ms : 118 
     
 
      
      [bookmark: pgfId-1433886] Total_SequenceNumber_Resets : 0 
     
 
      
      [bookmark: pgfId-1433887] Media-session: 192.168.10.3/30930 :: client ip 10.194.108.119/29824 
     
 
      
      [bookmark: pgfId-1433888] Call ID: N/A 
     
 
      
      [bookmark: pgfId-1433889] Lcl RTP conn 192.168.10.3/30930 to 192.168.10.51/19520 tx_pkts 20201 rx_pkts 20203 
     
 
      
      [bookmark: pgfId-1433890]  
     
 
     [bookmark: pgfId-1433891]show uc-ime fallback-notification statistics

 
     [bookmark: pgfId-1433892]Displays statistics about the PSTN fallback notifications to the Cisco UMC. Even if a call is sent over VoIP because the quality of the connection was good, the connection quality might worsen mid-call. To ensure an overall good experience for the end user, Cisco Intercompany Media Engine attempts to perform a mid-call fallback. Performing a mid-call fallback requires the adaptive security appliance to monitor the RTP packets coming from the Internet. If fallback is required, the adaptive security appliance sends a REFER message to Cisco UCM to tell it that it needs to fallback the call to PSTN.

 
     [bookmark: pgfId-1433893]Cisco Intercompany Media Engine uses a configurable hold-down timer to set the amount of time that adaptive security appliance waits before notifying Cisco UCM whether to fall back to PSTN.

 
      
      [bookmark: pgfId-1433894]hostname# show uc-ime fallback-notification statistics 
     
 
      
      [bookmark: pgfId-1433895]UCM address: 172.23.32.37 
     
 
      
      [bookmark: pgfId-1433896] Total Notifications Sent: 10 
     
 
      
      [bookmark: pgfId-1433897]  
     
 
     [bookmark: pgfId-1433898]show uc-ime mapping-service-sessions 

 
     [bookmark: pgfId-1433899]When the Cisco Intercompany Media Engine Proxy is configured for an off path deployment, displays mapping-service requests and replies between the proxy and the local Cisco UMC. A TCP port on the ASA is configured to listen for mapping requests. 

 
     [bookmark: pgfId-1433903]The port number must be 1024 or higher to avoid conflicts with other services on the device, such as Telnet or SSH. By default, the port number is TCP 8060.

 
      
      [bookmark: pgfId-1433904]Hostname# show uc-b2blink mapping-service-sessions 
     
 
      
      [bookmark: pgfId-1433905]Total active sessions: 2 
     
 
      
      [bookmark: pgfId-1433906]Session client (IP:Port) Idle time  
     
 
      
      [bookmark: pgfId-1433907]192.168.1.10:2001 0:01:01 
     
 
      
      [bookmark: pgfId-1433908]192.168.1.20:3001 0:10:20 
     
 
      
      [bookmark: pgfId-1433909]  
     
 
     [bookmark: pgfId-1433910]show uc-ime mapping-service-sessions statistics

 
     [bookmark: pgfId-1433911]Displays statistical information about the Cisco Intercompany Media Engine Proxy mapping service used in off path signaling.

 
      
      [bookmark: pgfId-1433912]Hostname# show uc-ime mapping-service-sessions statistics 
     
 
      
      [bookmark: pgfId-1433913]Total active sessions: 2 
     
 
      
      [bookmark: pgfId-1433914]Session client Total Responses Failed Pending Idle  
     
 
      
      [bookmark: pgfId-1433915](IP:Port) requests sent requests responses time  
     
 
      
      [bookmark: pgfId-1433916]192.168.1.10:2001 10 9 1 0 0:01:01 
     
 
      
      [bookmark: pgfId-1433917]192.168.1.20:3001 19 19 0 0 0:10:20 
     
 
    
 
   
 
    
     [bookmark: pgfId-1374221][bookmark: 64621]Feature History for Cisco Intercompany Media Engine Proxy

 
    [bookmark: pgfId-1374225]Table 21-1 lists the release history for this feature.

 
    [bookmark: pgfId-1245541] 

 
     
      
       
       [bookmark: pgfId-1245524]Table 21-1 [bookmark: 12416]Feature History for Cisco Phone Proxy 

 
       
       
        
        		 
          
          [bookmark: pgfId-1245530]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1245532]Releases 
         
  
        		 
          
          [bookmark: pgfId-1245534]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1245536]Cisco Intercompany Media Engine Proxy

  
        		[bookmark: pgfId-1245538]8.3(1)

  
        		[bookmark: pgfId-1245540]The Cisco Intercompany Media Engine Proxy was introduced. 

 [bookmark: pgfId-1452605]The following pane was added to the ASDM:

 [bookmark: pgfId-1452606]Configuration > Firewall > Unified Communications > UC-IME Proxy

 [bookmark: pgfId-1452607]The following wizard was added to ASDM, which allows you to configure the Unified Communication proxies (including the Cisco Intercompany Media Engine Proxy):

 [bookmark: pgfId-1285285]Wizards > Unified Communications Wizard 

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1233513] 
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     [bookmark: pgfId-1050709][bookmark: 13223]Using the Cisco Unified Communication Wizard 
      
      
 
     
 

 
    [bookmark: pgfId-1050727]This chapter describes how to configure the adaptive security appliance for Cisco Unified Communications Proxy features. 

 
    [bookmark: pgfId-1051135]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1057910]Information about the Cisco Unified Communication Wizard

 
     		 [bookmark: pgfId-1142492]Licensing Requirements for the Unified Communication Wizard

 
     		 [bookmark: pgfId-1233125]Guidelines and Limitations

 
     		 [bookmark: pgfId-1273754]Configuring the Phone Proxy by using the Unified Communication Wizard

 
     		 [bookmark: pgfId-1233134]Configuring the Mobility Advantage by using the Unified Communication Wizard

 
     		 [bookmark: pgfId-1233154]Configuring the Presence Federation Proxy by using the Unified Communication Wizard

 
     		 [bookmark: pgfId-1233170]Configuring the UC-IME by using the Unified Communication Wizard

 
     		 [bookmark: pgfId-1260109]Working with Certificates in the Unified Communication Wizard

 
    

 
   
 
    
     [bookmark: pgfId-1057004][bookmark: 98252]Information about the Cisco Unified Communication Wizard

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1233348]Note The Unified Communication Wizard is supported for the ASA version 8.3(1) and later.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1258981]The Unified Communication Wizard assists you in configuring the following Unified Communications proxies on the ASA:

 
     
     		 [bookmark: pgfId-1261758]Cisco Phone Proxy

 
    

 
    [bookmark: pgfId-1261762]See Configuring the Phone Proxy by using the Unified Communication Wizard.

 
     
     		 [bookmark: pgfId-1233365]Cisco Mobility Advantage Proxy

 
    

 
    [bookmark: pgfId-1233399]See Configuring the Mobility Advantage by using the Unified Communication Wizard.

 
     
     		 [bookmark: pgfId-1233422]Cisco Presence Federation Proxy

 
    

 
    [bookmark: pgfId-1233423]See Configuring the Presence Federation Proxy by using the Unified Communication Wizard.

 
     
     		 [bookmark: pgfId-1233424]Cisco Intercompany Media Engine Proxy

 
    

 
    [bookmark: pgfId-1233434]See Configuring the UC-IME by using the Unified Communication Wizard.

 
    [bookmark: pgfId-1251625]The wizard simplifies the configuration of the Unified Communications proxies in the following ways:

 
     
     		 [bookmark: pgfId-1251626]You enter all required data in the wizard steps. You are not required to navigate various ASDM screens to configure the Unified Communications proxies.

 
     		 [bookmark: pgfId-1251627]The wizard generates configuration settings for the Unified Communications proxies where possible, automatically, without requiring you to enter data. For example, the wizard configures the required ACLs, IP address translation (NAT and PAT) statements, self-signed certificates, TLS proxies, and application inspection. 

 
     		 [bookmark: pgfId-1284258]The wizard displays network diagrams to illustrate data collection. 

 
    

 
    [bookmark: pgfId-1284260]To access the Unified Communication Wizard, choose one of the following paths in the main ASDM application window:

 
     
     		 [bookmark: pgfId-1251538] Wizards > Unified Communication Wizard .

 
     		 [bookmark: pgfId-1251539] Configuration > Firewall > Unified Communications, and then click  Unified Communication Wizard .

 
    

 
    [bookmark: pgfId-1261698]Phone Proxy: Secure remote access for Cisco encrypted endpoints, and VLAN traversal for Cisco softphones 

 
    [bookmark: pgfId-1261699]The phone proxy feature enables termination of Cisco SRTP/TLS-encrypted endpoints for secure remote access. The phone proxy allows large scale deployments of secure phones without a large scale VPN remote access hardware deployment. End-user infrastructure is limited to just the IP endpoint, without VPN tunnels or hardware. 

 
    [bookmark: pgfId-1261703]The Cisco adaptive security appliance phone proxy is the replacement product for the Cisco Unified Phone Proxy. Additionally, the phone proxy can be deployed for voice/data VLAN traversal for softphone applications. Cisco IP Communicator (CIPC) traffic (both media and signaling) can be proxied through the ASA, thus traversing calls securely between voice and data VLANs.

 
    [bookmark: pgfId-1261707]For information about the differences between the TLS proxy and phone proxy, go to the following URL for Unified Communications content, including TLS Proxy vs. Phone Proxy white paper:

 
    [bookmark: pgfId-1261709]http://www.cisco.com/go/secureuc

 
    [bookmark: pgfId-1251522][bookmark: marker-1232255]Mobility Advantage Proxy: Secure connectivity between Cisco Mobility Advantage server and Cisco Unified Mobile Communicator clients

 
    [bookmark: pgfId-1233370]Cisco Mobility Advantage solutions include the Cisco Unified Mobile Communicator (Cisco UMC), an easy-to-use software application for mobile handsets that extends enterprise communications applications and services to mobile phones and the Cisco Unified Mobility Advantage (Cisco UMA) server. The Cisco Mobility Advantage solution streamlines the communication experience, enabling single number reach and integration of mobile endpoints into the Unified Communications infrastructure. 

 
    [bookmark: pgfId-1232258]The security appliance acts as a proxy, terminating and reoriginating the TLS signaling between the Cisco UMC and Cisco UMA. As part of the proxy security functionality, inspection is enabled for the Cisco UMA Mobile Multiplexing Protocol (MMP), the protocol between Cisco UMC and Cisco UMA.

 
    [bookmark: pgfId-1232260][bookmark: marker-1232259]Presence Federation Proxy: Secure connectivity between Cisco Unified Presence servers and Cisco/Microsoft Presence servers

 
    [bookmark: pgfId-1232261]Cisco Unified Presence solution collects information about the availability and status of users, such as whether they are using communication devices, such as IP phones at particular times. It also collects information regarding their communications capabilities, such as whether web collaboration or video conferencing is enabled. Using user information captured by Cisco Unified Presence, applications such as Cisco Unified Personal Communicator and Cisco UCM can improve productivity by helping users connect with colleagues more efficiently through determining the most effective way for collaborative communication.

 
    [bookmark: pgfId-1232265]Using the ASA as a secure presence federation proxy, businesses can securely connect their Cisco Unified Presence (Cisco UP) servers to other Cisco or Microsoft Presence servers, enabling intra-enterprise communications. The security appliance terminates the TLS connectivity between the servers, and can inspect and apply policies for the SIP communications between the servers. 

 
    [bookmark: pgfId-1232266]Cisco Intercompany Media Engine Proxy: Secure connectivity between Cisco UCM servers in different enterprises for IP Phone traffic

 
    [bookmark: pgfId-1232267]As more unified communications are deployed within enterprises, cases where business-to-business calls utilize unified communications on both sides with the Public Switched Network (PSTN) in the middle become increasingly common. All outside calls go over circuits to telephone providers and from there are delivered to all external destinations.

 
    [bookmark: pgfId-1232268]The Cisco Intercompany Media Engine (UC-IME) gradually creates dynamic, encrypted VoIP connections between businesses, so that a collection of enterprises that work together end up looking like one giant business with secure VoIP interconnections between them. 

 
    [bookmark: pgfId-1232269]There are three components to a Cisco Intercompany Media Engine deployment within an enterprise: a Cisco Intercompany Media Engine server, a call agent (the Cisco Unified Communications Manager) and an ASA running the Cisco Intercompany Media Engine Proxy. 

 
    [bookmark: pgfId-1232276]The ASA provides perimeter security by encrypting signaling connections between enterprises and preventing unauthorized calls. An ASA running the Cisco Intercompany Media Engine Proxy can either be deployed as an Internet firewall or be designated as a Cisco Intercompany Media Engine Proxy and placed in the DMZ, off the path of the regular Internet traffic.

 
   
 
    
     [bookmark: pgfId-1232312][bookmark: 23721]Licensing Requirements for the Unified Communication Wizard[bookmark: marker-1232311]

 
    [bookmark: pgfId-1232313]To run the Unified Communication Wizard in ASDM, you require the following license:

 
    [bookmark: pgfId-1232323] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1232316]Model 
         
  
        		 
          
          [bookmark: pgfId-1232318]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1232320]All models

  
        		[bookmark: pgfId-1232322]Base License

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1232324]However, to run each of the Unified Communications proxy features created by the wizard, you must have the appropriate Unified Communications Proxy licenses. 

 
    [bookmark: pgfId-1232328]The Cisco Unified Communications proxy features supported by the ASA require a Unified Communications Proxy license:

 
     
     		 [bookmark: pgfId-1261804]Cisco Phone Proxy

 
     		 [bookmark: pgfId-1232330]TLS proxy for encrypted voice inspection

 
     		 [bookmark: pgfId-1232332]Presence Federation Proxy

 
     		 [bookmark: pgfId-1232333]Cisco Intercompany Media Engine Proxy

 
    

 
    [bookmark: pgfId-1232230]See Licensing for Cisco Unified Communications Proxy Features for more information.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1258855]Note The Cisco Intercompany Media Engine Proxy does not appear as an option in the Unified Communication Wizard unless the license required for this proxy is installed on the ASA.

 
     
     
 
    
 
    

 
   
 
    
     [bookmark: pgfId-1232904][bookmark: 31400]Guidelines and Limitations

 
    [bookmark: pgfId-1232905]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1233218][bookmark: 87419]Context Mode Guidelines

 
    [bookmark: pgfId-1233219]Supported in single and multiple context mode.

 
    [bookmark: pgfId-1233221][bookmark: 16807]Firewall Mode Guidelines

 
    [bookmark: pgfId-1233222]Supported in routed and transparent firewall mode.

 
    [bookmark: pgfId-1233224][bookmark: 84518]IPv6 Guidelines

 
    [bookmark: pgfId-1233225]Supports IPv6 addresses.

 
    [bookmark: pgfId-1233227][bookmark: 23253]Additional Guidelines and Limitations 

 
    [bookmark: pgfId-1233228]Using the Unified Communication Wizard to create the Unified Communications proxies has the following limitations and requirements:

 
     
     		 [bookmark: pgfId-1234210]You must configure at least two interfaces on the ASA to use the UC Wizard to configure a Unified Communications proxy. 

 
     		 [bookmark: pgfId-1246039]For all Unified Communications proxies to function correctly, you must synchronize the clock on the ASA and all servers associated with each proxy, such as the Cisco Unified Communication Manager server, the Cisco Mobility Advantage server, the Cisco Unified Presence server, and the Cisco Intercompany Media Engine server. 

 
     		 [bookmark: pgfId-1243521]When you configure the Cisco Intercompany Media Engine Proxy for an off-path deployment, you must ensure that the public IP addresses and ports of the Cisco Unified Communications Manager servers and the public IP address for the media termination address are accessible from the Internet. The summary page of the Unified Communication Wizard reminds you of the requirements.

 
     		 [bookmark: pgfId-1246051]If the ASA on which you configure the Cisco Mobility Advantage Proxy and the Cisco Presence Federation Proxy is located behind another firewall, you must ensure that the public IP addresses for the Cisco Mobility Advantage server and the Cisco Unified Presence server are accessible from the Internet. 

 
     		 [bookmark: pgfId-1245987]If you use the Unified Communication Wizard to create to the Presence Federation Proxy and the Cisco Intercompany Media Engine Proxy, you might be required to adjust the configuration of the ACLs created automatically by the wizard for each proxy. See Chapter 20, â��Configuring Cisco Unified Presenceâ�� and Chapter 21, â��Configuring Cisco Intercompany Media Engine Proxyâ��, respectively, for information about the ACL requirements required by each proxy. 

 
    

 
   
 
    
     [bookmark: pgfId-1261824][bookmark: 47818]Configuring the Phone Proxy by using the Unified Communication Wizard

 
    [bookmark: pgfId-1262353]To configure the Cisco Unified Presence proxy by using ASDM, choose Wizards > Unified Communications Wizard from the menu. The Unified Communications Wizard opens. From the first page, select the Phone Proxy option under the Remote Access section. 

 
    [bookmark: pgfId-1262354]The wizard automatically creates the necessary TLS proxy, then guides you through creating the Phone Proxy instance, importing and installing the required certificates, and finally enables the SIP and SCCP inspection for the Phone Proxy traffic automatically. 

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1285237]Note Any configuration created by the wizard should be maintained through the wizard to ensure proper synchronization. For example, if you create a phone proxy configuration through the UC wizard and then modify the configuration outside of the wizard, the rest of the wizard configuration is not updated, and the wizard configuration is not synchronized.

Therefore, if you choose to change some part of the phone proxy configuration outside of the wizard, it is your responsibility to keep the rest of the configuration in synchronization.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1262355]The wizard guides you through four steps to configure the Phone Proxy:

 
    
 
    [bookmark: pgfId-1262356]Step 1 Select the Phone Proxy option.

 
    [bookmark: pgfId-1262573]Step 2 Specify settings to define the Cisco Unified Communications Manager (UCM) servers and TFTP servers, such the IP address and the address translation settings of each server, and the Cisco UCM cluster security mode. See Configuring the Private Network for the Phone Proxy and Configuring Servers for the Phone Proxy. 

 
    [bookmark: pgfId-1262358]Step 3 If required, enable Certificate Authority Proxy Function (CAPF). See Enabling Certificate Authority Proxy Function (CAPF) for IP Phones. 

 
    [bookmark: pgfId-1262583]Step 4 Configure the public IP phone network, such as address translation settings for remote IP phones, whether to enable service setting for IP phones, and the HTTP proxy used by the IP phones. Configuring the Public IP Phone Network

 
    [bookmark: pgfId-1262362]Step 5 Specify the media termination address settings of the Cisco UCM. Configuring the Media Termination Address for Unified Communication Proxies.

 
    [bookmark: pgfId-1262363]

 
     
     
 
    
  
    

 
    [bookmark: pgfId-1262364]The wizard completes by displaying a summary of the configuration created for Phone Proxy. 

 
     
      [bookmark: pgfId-1262586][bookmark: 48850]Configuring the Private Network for the Phone Proxy

 
     [bookmark: pgfId-1269128]The values that you specify in this page configure the connection from the ASA to the Cisco UCMs and TFTP servers by creating the necessary address translation settings and access control list entries. 

 
     [bookmark: pgfId-1276377]Additionally, you specify the security mode for the Cisco UCM cluster. In a nonsecure cluster mode or a mixed mode where the phones are configured as nonsecure, the phone proxy behaves in the following ways:

 
      
      		 [bookmark: pgfId-1269132]The TLS connections from the phones are terminated on the ASA and a TCP connection is initiated to the Cisco UCM.

 
      		 [bookmark: pgfId-1269135]SRTP sent from external IP phones to the internal network IP phone via the ASA is converted to RTP.

 
     

 
     [bookmark: pgfId-1269137]In a mixed mode cluster where the internal IP phones are configured as authenticated, the TLS connection is not converted to TCP to the Cisco UCM but the SRTP is converted to RTP.

 
     [bookmark: pgfId-1269138]In a mixed mode cluster where the internal IP phone is configured as encrypted, the TLS connection remains a TLS connection to the Cisco UCM and the SRTP from the remote phone remains SRTP to the internal IP phone.

 
     
 
     [bookmark: pgfId-1270010]Step 1 From the Interface drop-down list, choose the interface on which the ASA listens for the Cisco UCM servers and TFTP servers. The Cisco UCM servers and TFTP servers must reside on the same interface.

 
     [bookmark: pgfId-1269999]Step 2 Specify each entity in the network (all Cisco UCM and TFTP servers) that the IP phones must trust. Click Add to add the servers. See Configuring Servers for the Phone Proxy. 

 
     [bookmark: pgfId-1272199]To modify the configuration of a server already added to the configuration, select the server in the table and click Edit. The Edit Server dialog appears. See Configuring Servers for the Phone Proxy. At least one Cisco UCM and at least one TFTP server must be configured for the phone proxy.

 
     [bookmark: pgfId-1263667]Step 3 Specify the security mode of the Cisco UCM cluster by clicking one of the following options in the Unified CM Cluster Mode field:

 
      
      		 [bookmark: pgfId-1263668]Non-secureâ��Specifies the cluster to be in nonsecure mode when configuring the Phone Proxy feature.

 
      		 [bookmark: pgfId-1263488]Mixedâ��Specifies the cluster to be in mixed mode when configuring the Phone Proxy feature.

 
     

 
     [bookmark: pgfId-1263732]If you selected the Mixed security mode, the Generate and Export LDC Certificate button becomes available. 

 
     [bookmark: pgfId-1263497]Step 4 For a Mixed security mode only, configure local dynamic certificates (LDC) for the IP phones by performing the following steps:

 
     [bookmark: pgfId-1266057] a. Click the Generate and Export LDC Certificate button.

 
     [bookmark: pgfId-1266230]A dialog box appears stating â��Enrollment succeeded,â�� which indicates that the LDC was generated. 

 
     [bookmark: pgfId-1266231] b. Click OK to close the Enrollment Status dialog box. The Export certificate dialog box appears. 

 
     [bookmark: pgfId-1266061] c. In the Export to File field, enter the file name and path for the LDC or click browse to locate and select an existing file. 

 
     [bookmark: pgfId-1266062] d. Click the Export Certificate button. A dialog box appears indicating that the file was exported successfully.

 
     [bookmark: pgfId-1266267] e. Click OK to close the dialog box. A dialog box appears reminding you to install the LDC on the Cisco UCMs.

 
     [bookmark: pgfId-1266322] f. Click OK to close the dialog box. 

 
     [bookmark: pgfId-1266130]Once configured, the ASA presents this unique, dynamically-created certificate to the Cisco UCM on behalf of the IP phones.

 
     [bookmark: pgfId-1264168]Step 5 Click Next.

 
     [bookmark: pgfId-1264163]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1262602][bookmark: 66207]Configuring Servers for the Phone Proxy

 
     [bookmark: pgfId-1268453]The values that you specify in this page generate address translation settings, access list entries, trustpoints, and the corresponding CTL file entries for each server. 

 
     [bookmark: pgfId-1275422]You must add a server for each entity in the network that the IP phones must trust. These servers include all Cisco UCM servers in the cluster and all the TFTP servers. 

 
     [bookmark: pgfId-1275452]You must add at least one TFTP server and at least one Cisco UCM server for the phone proxy. You can configure up to five TFTP servers for the phone proxy. The TFTP server is assumed to be behind the firewall on the trusted network; therefore, the phone proxy intercepts the requests between the IP phones and TFTP server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1301721]Note When you delete a TFTP server from the Server list in Step 2 of the wizard, ASDM deletes only the TFTP server IP address from the configuration and does not remove from the configuration all the ACLs, NAT statements, object groups, etc. attached to the TFTP server. To remove those attached configuration statements, you must delete them manually by using the appropriate area of ASDM or rerun the Unified Communications wizard without making any changes and apply the configuration to to remove these statements.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1275668]The servers that the IP phones must trust can be deployed on the network in one of the following ways: 

 
      
      		 [bookmark: pgfId-1275592]All the services required by the Cisco UCM server, namely the Cisco UCM, TFTP, and CAPF services, are running on one server. In this deployment, only one instance of each service exists. For this deployment, you can select Unified CM+ TFTP as the server type. You can either use Address only or Address and ports for address translation. Cisco recommends that you specify Address and ports for increased security. 

 
      		 [bookmark: pgfId-1275593]Deployments for larger enterprises might have redundant Cisco UCMs and dedicated servers for TFTP and CAPF services. In that type of deployment, use Address only for voice address translation and Address only or Address and ports for TFTP. 

 
     

 
     [bookmark: pgfId-1278263]Table 16-1 lists the ports that are configured for Address and port translation by default: 

 
     [bookmark: pgfId-1278302] 

 
      
       
        
        [bookmark: pgfId-1278267]Table 16-1 [bookmark: 52975]Port Configuration

 
        
        
         
         		 
           
           [bookmark: pgfId-1278273]Address 
          
  
         		 
           
           [bookmark: pgfId-1278275]Default Port 
          
  
         		 
           
           [bookmark: pgfId-1278277]Description 
          
  
        

 
         
         		[bookmark: pgfId-1278279]TFTP Server

  
         		[bookmark: pgfId-1278281]69

  
         		[bookmark: pgfId-1278283]Allows incoming TFTP

  
        

 
         
         		[bookmark: pgfId-1278285]Cisco UCM

  
         		[bookmark: pgfId-1278287]2000

  
         		[bookmark: pgfId-1278289]Allows incoming non-secure SCCP 

  
        

 
         
         		[bookmark: pgfId-1278291]Cisco UCM

  
         		[bookmark: pgfId-1278293]2443

  
         		[bookmark: pgfId-1278295]Allows incoming secure SCCP

  
        

 
         
         		[bookmark: pgfId-1278297]Cisco UCM

  
         		[bookmark: pgfId-1278299]5061

  
         		[bookmark: pgfId-1278301]Allows incoming secure SIP

  
        

 
        
      

 
     
 
     
 
     [bookmark: pgfId-1263515]Step 1 In the Server Type field, select the server from the drop-down list: Unified CM, TFTP, or Unified CM + TFTP. Select Unified CM + TFTP when the Cisco UCM and TFTP server reside on the same device.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1271512]Note Depending on which type of server you select (Unified CM or TFTP), only the necessary fields in this dialog box become available. Specifically, if the server type is Unified CM, the TFTP section in the dialog is unavailable. If the server type is TFTP, the Voice section is unavailable.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1263516]Step 2 In the Private Address field, specify the actual internal IP address of the server. 

 
     [bookmark: pgfId-1272813]Step 3 In the FQDN field, enter the fully-qualified domain name of the server, which includes the hostname and domain name; for example, ucm.cisco.com (where ucm is the hostname and cisco.com is the domain name). 

 
     [bookmark: pgfId-1280585]If you are configuring a Unified CM server, enter the fully-qualified domain name configured on the Cisco UCM. 

 
     [bookmark: pgfId-1280593]If you are configuring a TFTP server, only specify the TFTP server fully-qualified domain name when that server is configured with FQDN. If the TFTP server is not configured with FQDN, you can leave the field blank.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1278627]Note Entering the fully-qualified domain name allows the ASA to perform hostname resolution when DNS lookup is not configured on the ASA or the configured DNS servers are unavailable.See the command reference for information about the dns domain-lookup command.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1275050]Step 4 In the Address Translation section, select whether to use the interface IP address or to enter a different IP address.

 
     [bookmark: pgfId-1275095]Selecting the Use interface IP radio button configures the server to use the IP address of the public interface. You select the public interface in step 4 of the wizard when you configure the public network for the phone proxy.

 
     [bookmark: pgfId-1279543]If the Use interface IP radio button is selected, you must specify port translation settings in the Voice and TFTP sections. Address-only translation is available only when you specify an IP address other than the IP address of the public interface.

 
     [bookmark: pgfId-1280807]When you select the Address only radio button, the ASA performs address translation on all traffic between the server and the IP phones. Selecting the Address and ports radio button limits address translation to the specified ports.

 
     [bookmark: pgfId-1266335]Step 5 (Unified CM or Unified CM + TFTP servers only) In the Voice section, configure inspection of SIP or SCCP protocol traffic, or both SIP and SCCP protocol traffic by completing the following fields:

 
     [bookmark: pgfId-1273030] a. In the Translation Type field, specify whether to use the Address only or the Address and ports. 

 
     [bookmark: pgfId-1278977]When the deployment has redundant Cisco UCM servers and dedicated servers for TFTP and CAPF services, select Address only for voice address translation. 

 
     [bookmark: pgfId-1279573]Select the Address and ports option when you want to limit address translation to the specified ports.

 
     [bookmark: pgfId-1273074] b. In the Voice Protocols field, select the inspection protocols supported by the IP phones deployed in the enterprise. Depending on which inspection protocols you selectâ��SCCP, SIP, or SCCP and SIPâ��only the ports fields for the selected voice protocols are available.

 
     [bookmark: pgfId-1273083] c. In the Port Translation section, enter the private and public ports for the voice protocols. 

 
     [bookmark: pgfId-1274329]The default values for the voice ports appear in the text fields. If necessary, change the private ports to match the settings on the Cisco UCM. The values you set for the public ports are used by the IP phones to traverse the ASA and communicate with the Cisco UCM. 

 
     [bookmark: pgfId-1274345]The secure SCCP private port and public port are automatically configured. These port numbers are automatically set to the value of the non-secure port number plus 443. 

 
     [bookmark: pgfId-1278746]Step 6 (TFTP or Unified CM + TFTP servers only) In the TFTP section, you can select either Address only or Address and port for address translation. Cisco recommends that you specify Address and port for increased security. Specifying Address and port configures the TFTP server to listen on port 69 for TFTP requests. 

 
     [bookmark: pgfId-1280832]When the server type is Unified CM + TFTP, the wizard configures the same type of address translation for Voice and TFTP; for example, when the server type is Unified CM + TFTP and the Address only option is selected, the wizard creates a global address translation rule for all traffic to and from the server. In this case, configuring port translation for the TFTP server would be redundant. 

 
     [bookmark: pgfId-1272178]Step 7 Click OK to add the server to the phone proxy configuration and return to step 2 of the wizard.

 
     [bookmark: pgfId-1266378]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1262650][bookmark: 84572]Enabling Certificate Authority Proxy Function (CAPF) for IP Phones

 
     [bookmark: pgfId-1274540]As an alternative to authenticating remote IP phones through the TLS handshake, you can configure authentication via locally significant certificate (LSC) provisioning. With LSC provisioning, you create a password for each remote IP phone user and each user enters the password on the remote IP phones to retrieve the LSC. 

 
     [bookmark: pgfId-1265160]Because using LSC provisioning to authenticate remote IP phones requires the IP phones first register in nonsecure mode, Cisco recommends LSC provisioning be done inside the corporate network before giving the IP phones to end-users. Otherwise, having the IP phones register in nonsecure mode requires the Administrator to open the nonsecure signaling port for SIP and SCCP on the ASA. 

 
     [bookmark: pgfId-1265151]See also the Cisco Unified Communications Manager Security Guide for information on Using the Certificate Authority Proxy Function (CAPF) to install a locally significant certificate (LSC).

 
     [bookmark: pgfId-1265754]If your network includes Cisco IP Communicators (CIPC) or you have LSC enabled IP phones, you must import the CAPF certificate from the Cisco UCM. The certificate will be used to generate the LSC on the IP phones.

 
     [bookmark: pgfId-1276476]If the Cisco UCM has more than one CAPF certificate, you must import all of them to the ASA. However, the wizard supports configuring only one CAPF certificate, which is the default. To import more than one CAPF certificate, go to Configuration > Device Management > Certificate Management > Identity Certificates.

 
     [bookmark: pgfId-1265759]You can configure LSC provisioning for additional end-user authentication. See the Cisco Unified Communications Manager configuration guide for information. 

 
     
 
     [bookmark: pgfId-1263560]Step 1 Check the Enable Certificate Authority Proxy Function check box. The remaining fields in the page become available. 

 
     [bookmark: pgfId-1263561]Step 2 Enter the private IP address of the LSC provider. 

 
     [bookmark: pgfId-1266482]Step 3 In the Public Address field, specify whether to use the IP address of the ASA public interface or enter an IP address. 

 
     [bookmark: pgfId-1266791]Specifying the private and public IP addresses for the LSC provider, creates an access list entry that allows the IP phones to contact the Cisco UCM by opening the CAPF port for LSC provisioning. 

 
     [bookmark: pgfId-1263562]Step 4 In the Translation Type field, select the Address only or Address and ports radio button. 

 
     [bookmark: pgfId-1266512]The IP phones must contact the CAPF service on the Cisco UCM. The address translation type (Address only versus Address and ports) you select for CAPF must match the address translation type of the Cisco UCM on which the CAPF service is running. You set the address translation type for that Cisco UCM server in the previous step of this wizard (see Configuring Servers for the Phone Proxy),

 
     [bookmark: pgfId-1277027]By default, the CAPF Service uses port 3804. Modify this default value only when it is modified on the Cisco UCM.

 
     [bookmark: pgfId-1276990]Step 5 If you selected the Address and ports radio button, enter the private and public ports for the CAPF service. 

 
     [bookmark: pgfId-1266856]Step 6 Click the Install CAPF Certificate button. The Install Certificate dialog box appears. See Installing a Certificate. 

 
     [bookmark: pgfId-1264229]Step 7 Click Next.

 
     [bookmark: pgfId-1264230]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1262690][bookmark: 66014]Configuring the Public IP Phone Network

 
     [bookmark: pgfId-1262786]The values that you specify in this page generate the address translation rules used for the IP phones and configure how the ASA handles IP phone settings. 

 
     
 
     [bookmark: pgfId-1266467]Step 1 From the Interface drop-down list, choose the interface on which the ASA listens for connections from IP phones.

 
     [bookmark: pgfId-1263786]Step 2 To preserve Call Manager configuration on the IP phones, check the Preserve the Unified CMâ��s configuration on the phoneâ��s service check box. When this check box is uncheck, the following service settings are disabled on the IP phones: 

 
      
       
       		 [bookmark: pgfId-1276508]Web Access

 
       		 [bookmark: pgfId-1276551]PC Port

 
       		 [bookmark: pgfId-1276552]Voice VLAN access

 
       		 [bookmark: pgfId-1276560]Gratuitous ARP

 
       		 [bookmark: pgfId-1276562]Span to PC Port

 
      

 
     

 
     [bookmark: pgfId-1263606]Step 3 To configure address translation for IP phones, check the Enable address translation for IP phones check box. Select whether to use the IP address of the ASA private interface (which you selected in step 2 of the wizard) or enter an IP address. 

 
     [bookmark: pgfId-1278889]Configuring address translation for IP phone configures the address used by the IP phones. All traffic from the outside network converges into one source IP address so that, if there is another corporate firewall in the network, a pinhole needs to be opened only for that IP address rather than for all traffic. 

 
     [bookmark: pgfId-1263834]Step 4 To configure an HTTP proxy for the Phone Proxy feature that is written into the IP phone's configuration file under the <proxyServerURL> tag, do the following:

 
     [bookmark: pgfId-1263835] a. Check the Configure an HTTP proxy to redirect phone URLs... check box.

 
     [bookmark: pgfId-1263836] b. In the IP Address field, type the IP address of the HTTP proxy 

 
     [bookmark: pgfId-1263945] c. In the Port field, enter the listening port of the HTTP proxy. 

 
     [bookmark: pgfId-1263837]The IP address you enter should be the global IP address based on where the IP phone and HTTP proxy server is located. You can enter a hostname in the IP Address field when that hostname can be resolved to an IP address by the adaptive security appliance (for example, DNS lookup is configured) because the adaptive security appliance will resolve the hostname to an IP address. If a port is not specified, the default will be 8080. 

 
     [bookmark: pgfId-1263838] d. In the Interface field, select the interface on which the HTTP proxy resides on the adaptive security appliance.

 
     [bookmark: pgfId-1263828]Setting the proxy server configuration option for the Phone Proxy allows for an HTTP proxy on the DMZ or external network in which all the IP phone URLs are directed to the proxy server for services on the phones. This setting accommodates nonsecure HTTP traffic, which is not allowed back into the corporate network. 

 
     [bookmark: pgfId-1264253]Step 5 Click Next.

 
     [bookmark: pgfId-1264254]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1263188][bookmark: 35955]Configuring the Media Termination Address for Unified Communication Proxies

 
     [bookmark: pgfId-1263189]The data from this step generates the MTA instance to be added to the Phone Proxy and the UC-IME proxy. 

 
     [bookmark: pgfId-1277309]The phone proxy and the UC-IME proxy use the media termination address for Secure RTP (SRTP) and RTP traffic. SRTP traffic sent from external IP phones to the internal network IP phone via the ASA is converted to RTP traffic. The traffic is terminated on the adaptive security appliance. SRTP provides message authentication and replay protection to Internet media traffic such as audio and video. RTP defines a standardized packet format for delivering audio and video over the Internet.

 
     [bookmark: pgfId-1263190]For the UC-IME proxy and the Phone Proxy to be fully functional, you must ensure that the public IP address for the media termination address (MTA) is accessible from the Internet. The summary page of the Unified Communication Wizard reminds you of this requirement.

 
     [bookmark: pgfId-1263193]The MTA IP addresses that you specify must meet specific requirements. See Media Termination Instance Prerequisites for information. 

 
     
 
     [bookmark: pgfId-1263195]Step 1 In the field for the private IP address, enter the IP address on which private media traffic terminates. The IP address must be within the same subnet as the private interface IP address. The correct subnet range is provided to the right of the field for the private IP address. 

 
     [bookmark: pgfId-1263196]Step 2 In the field for the public IP address, enter the IP address on which public media traffic terminates. The IP address must be within the same subnet as the public interface IP address. The correct subnet range is provided to the right of the field for the public IP address. 

 
     [bookmark: pgfId-1263975]Step 3 Specify the minimum and maximum values for the RTP port range for the media termination instance. 

 
     [bookmark: pgfId-1263964]Port values must be within the range of 1024 to 65535.

 
     [bookmark: pgfId-1263197]Step 4 Click Next. 

 
     [bookmark: pgfId-1263198]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1264026]The wizard completes by displaying a summary of the configuration created for proxy. 

 
    
 
   
 
    
     [bookmark: pgfId-1232574][bookmark: 71803][bookmark: 29449]Configuring the Mobility Advantage by using the Unified Communication Wizard

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1259069]Note The Unified Communication Wizard is supported for the ASA version 8.3(1) and later.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1232474]The Unified Communication wizard guides you through the steps to configure the Mobility Advantage proxy. Choose Wizards > Unified Communication Wizard from the menu. The Unified Communication Wizard opens. Click the Cisco Mobility Advantage Proxy radio button under the Remote Access section. 

 
    [bookmark: pgfId-1232896]When using the wizard to create the Mobility Advantage proxy, ASDM automatically creates the necessary TLS proxies, enables MMP inspection for the Mobility Advantage traffic, generates address translation (NAT) statements, and creates the access rules that are necessary to allow traffic between the Cisco Mobility Advantage server and the mobility clients.

 
    [bookmark: pgfId-1233573]The following steps provide the high-level overview for configuring the Mobility Advantage proxy:

 
    
 
    [bookmark: pgfId-1233574]Step 1 Specify settings to define the private and public network topology, such the public and private network interfaces, and the IP addresses of the Cisco Mobility Advantage server. See Configuring the Topology for the Cisco Mobility Advantage Proxy.

 
    [bookmark: pgfId-1232478]Step 2 Configure the certificates that are exchanged between the Cisco Mobility Advantage server and the ASA. See Configuring the Server-Side Certificates for the Cisco Mobility Advantage Proxy. 

 
    [bookmark: pgfId-1232688]Step 3 Configure the client-side certificate management, namely the certificates that are exchanged between the Unified Mobile Communicator clients and the ASA. See Configuring the Client-Side Certificates for the Cisco Mobility Advantage Proxy. 

 
    [bookmark: pgfId-1232486]

 
     
     
 
    
  
    

 
    [bookmark: pgfId-1232471]The wizard completes by displaying a summary of the configuration created for Mobility Advantage Proxy. 

 
     
      [bookmark: pgfId-1233459][bookmark: 66584]Configuring the Topology for the Cisco Mobility Advantage Proxy

 
     [bookmark: pgfId-1238169]When configuring the Mobility Advantage Proxy, you specify settings to define the private and public network topology, such the private and public network interfaces, and the private and public IP addresses of the Cisco Mobility Advantage server.

 
     [bookmark: pgfId-1238144]The values that you specify in this page generate the following configuration settings for the Mobility Advantage Proxy: 

 
      
      		 [bookmark: pgfId-1238146]Static PAT for the Cisco Mobility Advantage server

 
      		 [bookmark: pgfId-1238147]Static NAT for Cisco Unified Mobile Communicator clients if the Enable address translation for Mobility clients check box is checked. 

 
      		 [bookmark: pgfId-1251862]ACLs to allow Cisco Unified Mobile Communicator clients to access the Cisco Mobility Advantage server

 
     

 
     
 
     [bookmark: pgfId-1238108]Step 1 In the Private Network area, choose the interface from the drop-down list. 

 
     [bookmark: pgfId-1238248]Step 2 In the Unified MA Server area, enter the private and public IP address for the Cisco Mobility Advantage server. Entering ports for these IP addresses is optional. By default port number 5443 is entered, which is the default TCP port for MMP inspection. 

 
     [bookmark: pgfId-1238300]Step 3 In the FQDN field, enter the domain name for the Cisco Mobility Advantage server. This domain name is included in the certificate signing request that you generate later in this wizard. 

 
     [bookmark: pgfId-1238346]Step 4 In the Public Network area, choose an interface from the drop-down list. 

 
     [bookmark: pgfId-1251911]The proxy uses this interface for configuring static PAT for the Cisco Mobility Advantage server and the ACLs to allow Cisco Unified Mobile Communicator clients to access the Cisco Mobility Advantage server. 

 
     [bookmark: pgfId-1251877]Step 5 To configure whether address translation (NAT) is used by Cisco Unified Mobile Communicator clients, check the Enable address translation for Mobility clients check box and choose whether to use the IP address of the public interface or whether to enter an IP address. 

 
     [bookmark: pgfId-1233825]Step 6 Click Next.

 
     [bookmark: pgfId-1238398]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1233482][bookmark: 48870]Configuring the Server-Side Certificates for the Cisco Mobility Advantage Proxy

 
     [bookmark: pgfId-1238494]A trusted relationship between the ASA and the Cisco UMA server can be established with self-signed certificates. The ASA's identity certificate is exported, and then uploaded on the Cisco UMA server truststore. The Cisco UMA server certificate is downloaded, and then uploaded on the ASA truststore.

 
     [bookmark: pgfId-1257506]The supports using self-signed certificates only at this step.

 
     
 
     [bookmark: pgfId-1233940]Step 1 In the ASAâ��s Identity Certificate area, click Generate and Export ASAâ��s Identity Certificate. 

 
     [bookmark: pgfId-1238668]An information dialog boxes appear indicating that the enrollment seceded. In the Enrollment Status dialog box, click OK. The Export certificate dialog box appears. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1238704]Note â�¢ If an identity certificate for the ASA has already been created, the button in this area appears as Export ASAâ��s Identity Certificate and the Export certificate dialog box immediately appears. 

 
      
      		 [bookmark: pgfId-1246872]When using the wizard to configure the Cisco Mobility Advantage proxy, the wizard only supports installing self-signed certificates.

 
     

 
     [bookmark: pgfId-1249778]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1238674]Step 2 Export the identity certificate generated by the wizard for the ASA. See Exporting an Identity Certificate. 

 
     [bookmark: pgfId-1238614]Step 3 In the Unified MA Serverâ��s Certificate area, click Install Unified MA Serverâ��s Certificate. The Install Certificate dialog appears.

 
     [bookmark: pgfId-1238797]Step 4 Locate the file containing the Cisco Mobility Advantage server certificate or paste the certificate details in the dialog box. See Installing a Certificate. 

 
     [bookmark: pgfId-1254171]Step 5 Click Next. 

 
     [bookmark: pgfId-1239628]
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     [bookmark: pgfId-1243768]Note See the Cisco Mobility Advantage server documentation for information on how to export the certificate for this server. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1233500][bookmark: 50829]Configuring the Client-Side Certificates for the Cisco Mobility Advantage Proxy

 
     [bookmark: pgfId-1239329]To establish a trust relationship between the Cisco Unified Mobile Communicator (UMC) clients and the ASA, the ASA uses a CA-signed certificate that is configured with the Cisco Mobility Advantage serverâ��s FQDN (also referred to as certificate impersonation). 

 
     [bookmark: pgfId-1239323]In the Client-Side Certificate Management page, you enter both the intermediate CA certificate (if applicable, as in the cases of Verisign) and the signed ASA identity certificate. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1252752]Note If the ASA already has a signed identity certificate, you can skip Step 1 in this procedure and proceed directly to Step 2.

 
      
      
 
     
 
     

 
     
 
     [bookmark: pgfId-1233502]Step 1 [bookmark: 97691]In the ASAâ��s Identity Certificate area, click Generate CSR. The CSR parameters dialog box appears.

 
     [bookmark: pgfId-1252656]For information about specifying additional parameters for the certificate signing request (CSR), see Generating a Certificate Signing Request (CSR) for a Unified Communications Proxy. 

 
     [bookmark: pgfId-1250756]Information dialog boxes appear indicating that the wizard is delivering the settings to the ASA and retrieving the certificate key pair information. The Identity Certificate Request dialog box appears. 

 
     [bookmark: pgfId-1252686]For information about saving the CSR that was generated and submitting it to a CA, see Saving the Identity Certificate Request. 

 
     [bookmark: pgfId-1250700]Step 2 [bookmark: 13527]Click Install ASAâ��s Identity Certificate. Install the certificate. See Installing the ASA Identity Certificate on the Mobility Advantage Server. 

 
     [bookmark: pgfId-1250702]Step 3 Click Install Root CAâ��s Certificate. The Install Certificate dialog box appears. Install the certificate. See Installing a Certificate.

 
     [bookmark: pgfId-1234245]Step 4 Click Next. 

 
     [bookmark: pgfId-1239082]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1254211]The wizard completes by displaying a summary of the configuration created for Mobility Advantage Proxy. 

 
    
 
   
 
    
     [bookmark: pgfId-1232555][bookmark: 20989]Configuring the Presence Federation Proxy by using the Unified Communication Wizard 

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1259124]Note The Unified Communication Wizard is supported for the ASA version 8.3(1) and later.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1232521]To configure the Cisco Unified Presence proxy by using ASDM, choose Wizards > Unified Communication Wizard from the menu. The Unified Communication Wizard opens. From the first page, select the Cisco Unified Presence Proxy option under the Business-to-Business section. 

 
    [bookmark: pgfId-1252798]When using the wizard to create the Cisco Presence Federation proxy, ASDM automatically creates the necessary TLS proxies, enables SIP inspection for the Presence Federation traffic, generates address translation (static PAT) statements for the local Cisco Unified Presence server, and creates ACLs to allow traffic between the local Cisco Unified Presence server and remote servers.

 
    [bookmark: pgfId-1236220]The following steps provide the high-level overview for configuring the Presence Federation Proxy:

 
    
 
    [bookmark: pgfId-1236221]Step 1 Specify settings to define the private and public network topology, such the private and public IP address of the Presence Federation server. See Configuring the Topology for the Cisco Presence Federation Proxy. 

 
    [bookmark: pgfId-1232526]Step 2 Configure the local-side certificate management, namely the certificates that are exchanged between the local Unified Presence Federation server and the ASA. See Configuring the Local-Side Certificates for the Cisco Presence Federation Proxy. 

 
    [bookmark: pgfId-1232530]Step 3 Configure the remote-side certificate management, namely the certificates that are exchanged between the remote server and the ASA. See Configuring the Remote-Side Certificates for the Cisco Presence Federation Proxy. 

 
    [bookmark: pgfId-1232534]

 
     
     
 
    
  
    

 
    [bookmark: pgfId-1232518]The wizard completes by displaying a summary of the configuration created for the Presence Federation proxy. 

 
     
      [bookmark: pgfId-1235212][bookmark: 34390]Configuring the Topology for the Cisco Presence Federation Proxy

 
     [bookmark: pgfId-1239113]When configuring the Presence Federation Proxy, you specify settings to define the private and public network topology, such the private and public network interfaces, and the private and public IP addresses of the Cisco Unified Presence server.

 
     [bookmark: pgfId-1239114]The values that you specify in this page generate the following configuration settings for the Presence Federation Proxy: 

 
      
      		 [bookmark: pgfId-1239116]Static PAT for the local Cisco Unified Presence server

 
      		 [bookmark: pgfId-1239117]ACLs for traffic between the local Cisco Unified Presence server and remote servers

 
     

 
     
 
     [bookmark: pgfId-1239118]Step 1 In the Private Network area, choose the interface from the drop-down list. 

 
     [bookmark: pgfId-1239195]Step 2 In the Unified Presence Server area, enter the private and public IP address for the Unified Presence server. Entering ports for these IP addresses is optional. By default port number 5061 is entered, which is the default TCP port for SIP inspection. 

 
     [bookmark: pgfId-1239120]Step 3 In the FQDN field, enter the domain name for the Unified Presence server. This domain name is included in the certificate signing request that you generate later in this wizard. 

 
     [bookmark: pgfId-1253744]Step 4 In the Public Network area, choose the interface of the public network from the drop-down list. The proxy uses this interface for configuring static PAT for the local Cisco Unified Presence server and for configuring ACLs to allow remote servers to access the Cisco Unified Presence server. 

 
     [bookmark: pgfId-1239126]Step 5 Click Next.

 
     [bookmark: pgfId-1239293]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1235243][bookmark: 26269]Configuring the Local-Side Certificates for the Cisco Presence Federation Proxy

 
     [bookmark: pgfId-1257512]Within an enterprise, setting up a trust relationship is achievable by using self-signed certificates. The supports using self-signed certificates only at this step.

 
     
 
     [bookmark: pgfId-1239455]Step 1 In the ASAâ��s Identity Certificate area, click Generate and Export ASAâ��s Identity Certificate. 

 
     [bookmark: pgfId-1239456]An information dialog box appears indicating that enrollment succeeded. In the Enrollment Status dialog box, click OK. The Export certificate dialog box appears. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1249816]Note â�¢ If an identity certificate for the ASA has already been created, the button in this area appears as Export ASAâ��s Identity Certificate and the Export certificate dialog box immediately appears. 

 
      
      		 [bookmark: pgfId-1249817]When using the wizard to configure the Cisco Presence Federation proxy, the wizard only supports installing self-signed certificates.

 
     

 
     [bookmark: pgfId-1249818]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1239466]Step 2 Export the identity certificate generated by the wizard for the ASA. See Exporting an Identity Certificate. 

 
     [bookmark: pgfId-1239468]Step 3 Local Unified Presence Serverâ��s Certificate area, click Install Serverâ��s Certificate. The Install Certificate dialog appears.

 
     [bookmark: pgfId-1239469]Step 4 Locate the file containing the Cisco Unified Presence server certificate or paste the certificate details in the dialog box. See Installing a Certificate. 

 
     [bookmark: pgfId-1253903]Step 5 Click Next.

 
     [bookmark: pgfId-1239431]
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     [bookmark: pgfId-1243846]Note See the Cisco Unified Presence server documentation for information on how to export the certificate for this server. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1235269][bookmark: 49221]Configuring the Remote-Side Certificates for the Cisco Presence Federation [bookmark: marker-1235292]Proxy

 
     [bookmark: pgfId-1239385]Establishing a trust relationship across enterprises or across administrative domains is key for federation. Across enterprises you must use a trusted third-party CA (such as, VeriSign). The security appliance obtains a certificate with the FQDN of the Cisco Unified Presence server (certificate impersonation). 

 
     [bookmark: pgfId-1239386]For the TLS handshake, the two entities, namely the local entity and a remote entity, could validate the peer certificate via a certificate chain to trusted third-party certificate authorities. The local entity and the remote entity enroll with the CAs. The ASA as the TLS proxy must be trusted by both the local and remote entities. The security appliance is always associated with one of the enterprises. Within that enterprise, the entity and the security appliance authenticate each other by using a self-signed certificate. 

 
     [bookmark: pgfId-1239387]To establish a trusted relationship between the security appliance and the remote entity, the security appliance can enroll with the CA on behalf of the Cisco Unified Presence server for the local entity. In the enrollment request, the local entity identity (domain name) is used. 

 
     [bookmark: pgfId-1235630]To establish the trust relationship, the security appliance enrolls with the third party CA by using the Cisco Unified Presence server FQDN as if the security appliance is the Cisco Unified Presence server. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1254468]Note If the ASA already has a signed identity certificate, you can skip Step 1 in this procedure and proceed directly to Step 2.

 
      
      
 
     
 
     

 
     
 
     [bookmark: pgfId-1239676]Step 1 [bookmark: 76080]In the ASAâ��s Identity Certificate area, click Generate CSR. The CSR parameters dialog box appears. 

 
     [bookmark: pgfId-1254499]For information about specifying additional parameters for the certificate signing request (CSR), see Generating a Certificate Signing Request (CSR) for a Unified Communications Proxy. 

 
     [bookmark: pgfId-1239683]Information dialog boxes appear indicating that the wizard is delivering the settings to the ASA and retrieving the certificate key pair information. The Identity Certificate Request dialog box appears. 

 
     [bookmark: pgfId-1254617]For information about saving the CSR that was generated and submitting it to a CA, see Saving the Identity Certificate Request. 

 
     [bookmark: pgfId-1239686]Step 2 [bookmark: 50494]Click Install ASAâ��s Identity Certificate. See Installing the ASA Identity Certificate on the Presence Federation and Cisco Intercompany Media Engine Servers.

 
     [bookmark: pgfId-1239687]Step 3 Click Remote Serverâ��s CAâ��s Certificate. The Install Certificate dialog box appears. Install the certificate. See Installing a Certificate. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1255026]Note You must install a root CA certificate for each remote entity that communicates with the ASA because different organizations might be using different CAs.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1239691]Step 4 Click Next. 

 
     [bookmark: pgfId-1235643]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1254241]The wizard completes by displaying a summary of the configuration created for the Presence Federation proxy. 

 
    
 
   
 
    
     [bookmark: pgfId-1232410][bookmark: 34946]Configuring the UC-IME by using the Unified Communication Wizard

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1259156]Note The Unified Communication Wizard is supported for the ASA version 8.3(1) and later.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1232411]To configure the Cisco Intercompany Media Engine Proxy by using ASDM, choose Wizards > Unified Communication Wizard from the menu. The Unified Communication Wizard opens. From the first page, select the Cisco Intercompany Media Engine Proxy option under the Business-to-Business section and click Next. 

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1258868]Note The Cisco Intercompany Media Engine Proxy does not appear as an option in the Unified Communication Wizard unless the license required for this proxy is installed on the ASA.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1232412]When using the wizard to create the Cisco Intercompany Media Engine Proxy, ASDM automatically creates the necessary TLS proxies, enables SIP inspection for Cisco Intercompany Media Engine traffic, generates address translation (static PAT) statements for local Cisco Unified Communications Manager servers, and creates ACLs to allow traffic between the local Cisco Unified Communications Manager servers and the remote servers.

 
    [bookmark: pgfId-1236293]The following steps provide the high-level overview for configuring the Cisco Intercompany Media Engine Proxy:

 
    
 
    [bookmark: pgfId-1236294]Step 1 Select the topology of the Cisco Intercompany Media Engine Proxy, namely whether the security appliance is an edge firewall with all Internet traffic flowing through it or whether the security appliance is off the path of the main Internet traffic (referred to as an off-path deployment). See Configuring the Topology for the Cisco Intercompany Media Engine Proxy. 

 
    [bookmark: pgfId-1232419]Step 2 Specify private network settings such as the Cisco UCM IP addresses and the ticket settings. See Configuring the Private Network Settings for the Cisco Intercompany Media Engine Proxy.

 
    [bookmark: pgfId-1232420]Step 3 Specify the public network settings. See Configuring the Public Network Settings for the Cisco Intercompany Media Engine Proxy. 

 
    [bookmark: pgfId-1232421]Step 4 Specify the media termination address settings of the Cisco UMC. See Configuring the Media Termination Address for Unified Communication Proxies. 

 
    [bookmark: pgfId-1235293]Step 5 Configure the local-side certificate management, namely the certificates that are exchanged between the local Cisco Unified Communications Manager servers and the security appliance. See Configuring the Local-Side Certificates for the Cisco Intercompany Media Engine Proxy.

 
    [bookmark: pgfId-1244577]Step 6 Configure the remote-side certificate management, namely the certificates that are exchanged between the remote server and the ASA. This certificate is presented to remote servers so that they can authenticate the ASA as a trusted server. See Configuring the Remote-Side Certificates for the Cisco Intercompany Media Engine Proxy.

 
    [bookmark: pgfId-1232426]

 
     
     
 
    
  
    

 
    [bookmark: pgfId-1232405]The wizard completes by displaying a summary of the configuration created for the Cisco Intercompany Media Engine. 

 
     
      [bookmark: pgfId-1232398][bookmark: 76182]Configuring the Topology for the Cisco Intercompany Media Engine Proxy

 
     
 
     [bookmark: pgfId-1239742]Step 1 Select the topology of your ICME deployment by clicking one of the following options:

 
      
       
       		 [bookmark: pgfId-1235661]All Internet traffic flows through the ASA radio button. This option is also referred to as a basic deployment. 

 
       		 [bookmark: pgfId-1235684]This ASA is off the path of the regular Internet traffic. This option is also referred to as an off-path deployment. 

 
      

 
     

 
     [bookmark: pgfId-1239794]Step 2 Click Next. 

 
     [bookmark: pgfId-1239816]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1235700]Basic Deployment

 
     [bookmark: pgfId-1235701]In a basic deployment, the Cisco Intercompany Media Engine Proxy sits in-line with the Internet firewall such that all Internet traffic traverses the ASA. In this deployment, a single Cisco UCM or a Cisco UCM cluster is centrally deployed within the enterprise, along with a Cisco Intercompany Media Engine server (and perhaps a backup). A single Internet connection traverses the ASA, which is enabled with the Cisco Intercompany Media Engine Proxy.

 
     [bookmark: pgfId-1235702]The ASA sits on the edge of the enterprise and inspects SIP signaling by creating dynamic SIP trunks between enterprises.

 
     [bookmark: pgfId-1235704]Off-path Deployment

 
     [bookmark: pgfId-1235705]In an off path deployment, inbound and outbound Cisco Intercompany Media Engine calls pass through an ASA enabled with the Cisco Intercompany Media Engine Proxy. The ASA is located in the DMZ and configured to support primarily Cisco Intercompany Media Engine. Normal Internet facing traffic does not flow through this ASA. 

 
     [bookmark: pgfId-1235706]For all inbound calls, the signaling is directed to the ASA because destined Cisco UCMs are configured with the global IP address on the ASA. For outbound calls, the called party could be any IP address on the Internet; therefore, the ASA is configured with a mapping service that dynamically provides an internal IP address on the ASA for each global IP address of the called party on the Internet. 

 
     [bookmark: pgfId-1235707]Cisco UCM sends all outbound calls directly to the mapped internal IP address on the ASA instead of the global IP address of the called party on the Internet. The ASA then forwards the calls to the global IP address of the called party. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1240461]Note When you configure the Cisco Intercompany Media Engine for an off-path deployment, you must ensure that the public IP addresses and ports of the Cisco Unified Communications Manager servers and the public IP address for the media termination address are accessible from the Internet. The summary page of the Unified Communication Wizard reminds you of the requirements.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1235304][bookmark: 78465]Configuring the Private Network Settings for the Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1240840]When configuring the Cisco Intercompany Media Engine Proxy, you specify settings to define the private network topology, such the private network interface, the IP addresses of the Cisco Unified Communications servers, and ticket verification. Additionally, when the Cisco Unified Communications servers are operating in secure mode, you specify the X.509 subject name for the Cisco Intercompany Media Engine Proxy, 

 
     [bookmark: pgfId-1240877]The values that you specify in this page generate the following configuration settings for the Cisco Intercompany Media Engine Proxy: 

 
      
      		 [bookmark: pgfId-1241547]The list of Cisco Unified Communications servers

 
      		 [bookmark: pgfId-1241571]The ticket epoch and password used by the Cisco Intercompany Media Engine Proxy

 
      		 [bookmark: pgfId-1255987]For an off-path deployment only, the mapping service on the same interface as the Cisco Unified Communications server

 
     

 
     
 
     [bookmark: pgfId-1241715]Step 1 To configure the Cisco Intercompany Media Engine Proxy as part of a basic deployment, select the interface that connects to the local Cisco Unified Communications servers. 

 
     [bookmark: pgfId-1241696]Or

 
     [bookmark: pgfId-1241697]To configure the Cisco Intercompany Media Engine Proxy as part of an off-path deployment, complete the following steps:

 
     [bookmark: pgfId-1244838] a. From the Listening Interface drop-down list, choose the interface on which the ASA listens for the mapping requests.

 
     [bookmark: pgfId-1244858] b. In the Port field, enter a number between 1024 and 65535 as the TCP port on which the ASA listens for the mapping requests. The port number must be 1024 or higher to avoid conflicts with other services on the device, such as Telnet or SSH. By default, the port number is TCP 8060. 

 
     [bookmark: pgfId-1244863] c. From the UC-IME Interface drop-down list, choose the interface that the ASA uses to connect to the remote ASA that is enabled with the Cisco Intercompany Media Engine Proxy.
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     [bookmark: pgfId-1256188]Note In a basic and an off-path deployment, all Cisco Unified Communications servers must be on the same interface.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1242031]Step 2 In the Unified CM Servers area, the wizard displays the private IP address, public IP address, and security mode of any Cisco Unified Communications server configured on the ASA. If necessary, click Add to add a Cisco Unified Communications server. You must include an entry for each Cisco UCM in the cluster with Cisco Intercompany Media Engine that has a SIP trunk enabled.

 
     [bookmark: pgfId-1242035]Step 3 In the Ticket Epoch field, enter a integer from 1-255. 

 
     [bookmark: pgfId-1244530]The epoch indicates the number of times that password has changed. When the proxy is configured the first time and a password entered for the first time, enter 1 for the epoch integer. Each time you change the password, increment the epoch to indicate the new password. You must increment the epoch value each time your change the password. Typically, you increment the epoch sequentially; however, the security appliance allows you to choose any value when you update the epoch. 

 
     [bookmark: pgfId-1244517]If you change the epoch value, the current password is invalidated and you must enter a new password. 

 
     [bookmark: pgfId-1242063]Step 4 In the Ticket Password field, enter a minimum of 10 and a maximum of 64 printable character from the US-ASCII character set. The allowed characters include 0x21 to 0x73 inclusive, and exclude the space character. The ticket password is stored onto flash.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1242101]Note We recommend a password of at least 20 characters. Only one password can be configured at a time.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1242203]The epoch and password that you configure on the ASA must match the epoch and password configured on the Cisco Intercompany Media Engine server. See the Cisco Intercompany Media Engine server documentation for information. 

 
     [bookmark: pgfId-1242099]Step 5 In the Confirm Password field, reenter the password. 

 
     [bookmark: pgfId-1242314]Step 6 In the X.509 Subject Name field, enter the distinguished name (DN) of the local enterprise. The name that you enter must match the name configured for the Cisco Unified Communications servers in the cluster. See the Cisco Unified Communications server documentation for information. 

 
     [bookmark: pgfId-1239853]Step 7 Click Next. 

 
     [bookmark: pgfId-1239886]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1235996]Adding a Cisco Unified Communications Manager Server for the UC-IME Proxy

 
     [bookmark: pgfId-1242464]You must include an entry for each Cisco UCM in the cluster with Cisco Intercompany Media Engine Proxy that has a SIP trunk enabled. 

 
     
 
     [bookmark: pgfId-1242465]Step 1 Enter the private IP address and port number (in the range 5000-6000) for the Cisco UCM server. 

 
     [bookmark: pgfId-1242480]Step 2 In the Address Translation area, enter the public IP address for the Cisco UCM server. 

 
     [bookmark: pgfId-1256295]Step 3 If necessary, enter the port number for the public IP address by clicking the Translate address and port radio button and entering a number (in the range 5000-6000) in the Port field. 

 
     [bookmark: pgfId-1242415]Step 4 In the Security Mode area, click the Secure or Non-secure radio button. Specifying secure for Cisco UCM or Cisco UCM cluster indicates that Cisco UCM or Cisco UCM cluster is initiating TLS. 

 
     [bookmark: pgfId-1244278]If you specify that some of the Cisco UCM servers are operating in secure mode, the Unified Communications Wizard includes a step in the proxy configuration to generate certificates for the local-side communication between the ASA and that Cisco UCM server. See Configuring the Local-Side Certificates for the Cisco Intercompany Media Engine Proxy. 

 
     [bookmark: pgfId-1239940]Step 5 Click OK. 

 
     [bookmark: pgfId-1239941]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1235316][bookmark: 21489]Configuring the Public Network Settings for the Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1242684]The public network configuration depends on the deployment scenario you selected in the topology step of this wizard. Specifically, when you are configuring the UC-IME proxy as part of an off-path deployment, this step of the wizard displays fields for address translation, requiring that you specify the private IP address for the UC-IME proxy. Specifying this private IP address, translates IP addresses for inbound traffic.

 
     [bookmark: pgfId-1242844]In an off-path deployment, any existing ASA that you have deployed in your environment are not capable of transmitting Cisco Intercompany Media Engine traffic. Therefore, off-path signaling requires that outside addresses translate to an inside (private) IP address. The inside interface address can be used for this mapping service configuration. For the Cisco Intercompany Media Engine Proxy, the ASA creates dynamic mappings for external addresses to the internal IP address. 

 
     [bookmark: pgfId-1256669]The values that you specify in this page generate the following configuration settings for the Cisco Intercompany Media Engine Proxy: 

 
      
      		 [bookmark: pgfId-1256646]Static PAT for the Cisco Unified Communications servers 

 
      		 [bookmark: pgfId-1256647]ACLs for traffic between the local and the remote servers

 
     

 
     
 
     [bookmark: pgfId-1239974]Step 1 In the Configure public network area, choose an interface from the Interface drop-down list. 

 
     [bookmark: pgfId-1242614]Step 2 When configuring an off-path deployment, in the Address Translation area, specify whether to use the private IP address for the public network. 

 
     [bookmark: pgfId-1242762]Or

 
     [bookmark: pgfId-1236087]Click the Specify IP address radio button and enter an IP address in the field. 

 
     [bookmark: pgfId-1239980]Step 3 Click Next. 

 
     [bookmark: pgfId-1239985]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1235331][bookmark: 90589][bookmark: 38073]Configuring the Local-Side Certificates for the Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1255240]Completing this step of the wizard generates a self-signed certificate for the ASA. The server proxy certificate is automatically generated using the subject name provided in an earlier step of this wizard. 

 
     [bookmark: pgfId-1257504]The wizard supports using self-signed certificates only. 

 
     [bookmark: pgfId-1257056]A trusted relationship between the ASA and the Cisco UMA server can be established with self-signed certificates. The certificates are used by the security appliance and the Cisco UCMs to authenticate each other, respectively, during TLS handshakes. 

 
     [bookmark: pgfId-1257012]The ASA's identity certificate is exported, and then needs to be installed on each Cisco Unified Communications Manager (UCM) server in the cluster with the proxy and each identity certificate from the Cisco UCMs need to be installed on the security appliance.

 
     [bookmark: pgfId-1243227]This step in the Unified Communications Wizard only appears when the UC-IME proxy that you are creating has at least one secure Cisco Unified Communications Manager server defined. See Configuring the Topology for the Cisco Intercompany Media Engine Proxy for information.

 
     
 
     [bookmark: pgfId-1240764]Step 1 In the ASAâ��s Identity Certificate area, click Generate and Export ASAâ��s Identity Certificate. 

 
     [bookmark: pgfId-1257362]An information dialog boxes appear indicating that the enrollment seceded. In the Enrollment Status dialog box, click OK. The Export certificate dialog box appears. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1249947]Note â�¢ If an identity certificate for the ASA has already been created, the button in this area appears as Export ASAâ��s Identity Certificate and the Export certificate dialog box immediately appears. 

 
      
      		 [bookmark: pgfId-1249948]When using the wizard to configure the Cisco Intercompany Media Engine Proxy, the wizard only supports installing self-signed certificates.

 
     

 
     [bookmark: pgfId-1249949]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1240775]Step 2 Export the identity certificate generated by the wizard for the ASA. See Exporting an Identity Certificate. 

 
     [bookmark: pgfId-1240777]Step 3 In the Local Unified CMâ��s Certificate area, click Install Local Unified CMâ��s Certificate. The Install Certificate dialog appears.

 
     [bookmark: pgfId-1240778]Step 4 Locate the file containing the certificate from the Cisco Unified Communications Manager server or paste the certificate details in the dialog box. See Installing a Certificate. You must install the certificate from each Cisco Unified Communications Manager server in the cluster.

 
     [bookmark: pgfId-1255124]Step 5 Click Next. 

 
     [bookmark: pgfId-1240783]

 
      
      
 
     
  
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1243946]Note See the Cisco Intercompany Media Engine server documentation for information on how to export the certificate for this server. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1235420][bookmark: 52630]Configuring the Remote-Side Certificates for the Cisco Intercompany Media Engine Proxy

 
     [bookmark: pgfId-1243275]Establishing a trust relationship cross enterprises or across administrative domains is key. Cross enterprises you must use a trusted third-party CA (such as, VeriSign). The ASA obtains a certificate with the FQDN of the Cisco Unified Communications Manager server (certificate impersonation). 

 
     [bookmark: pgfId-1243276]For the TLS handshake, the two entities could validate the peer certificate via a certificate chain to trusted third-party certificate authorities. Both entities enroll with the CAs. The ASA as the TLS proxy must be trusted by both entities. The ASA is always associated with one of the enterprises. Within that enterprise, the entity and the ASA could authenticate each other via a local CA, or by using self-signed certificates. 

 
     [bookmark: pgfId-1243277]To establish a trusted relationship between the ASA and the remote entity, the ASA can enroll with the CA on behalf of the local enterprise. In the enrollment request, the local Cisco UCM identity (domain name) is used. 

 
     [bookmark: pgfId-1243260]To establish the trust relationship, the ASA enrolls with the third party CA by using the Cisco Unified Communications Manager server FQDN as if the security appliance is the Cisco UCM. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1257759]Note If the ASA already has a signed identity certificate, you can skip Step 1 in this procedure and proceed directly to Step 3.

 
      
      
 
     
 
     

 
     
 
     [bookmark: pgfId-1257948]Step 1 [bookmark: 40115]In the ASAâ��s Identity Certificate area, click Generate CSR. The CSR parameters dialog box appears. 

 
     [bookmark: pgfId-1257949]For information about specifying additional parameters for the certificate signing request (CSR), see Generating a Certificate Signing Request (CSR) for a Unified Communications Proxy. 

 
     [bookmark: pgfId-1257955]Information dialog boxes appear indicating that the wizard is delivering the settings to the ASA and retrieving the certificate key pair information. The Identity Certificate Request dialog box appears. 

 
     [bookmark: pgfId-1251076]For information about saving the CSR that was generated and submitting it to a CA, see Saving the Identity Certificate Request. 

 
     [bookmark: pgfId-1244707]Step 2 [bookmark: 79093]In the ASAâ��s Identity Certificate area, click Install ASAâ��s Identity Certificate. Installing the ASA Identity Certificate on the Presence Federation and Cisco Intercompany Media Engine Servers. 

 
     [bookmark: pgfId-1244734]Step 3 [bookmark: 24259]In the Remote Serverâ��s CAâ��s Certificate area, click Install Remote Serverâ��s CAâ��s Certificate. Installing the root certificates of the CA for the remote servers is necessary so that the ASA can determine that the remote servers are trusted. 

 
     [bookmark: pgfId-1244711]The Install Certificate dialog box appears. Install the certificate. See Installing a Certificate. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1244678]Note You must install the root certificates only when the root certificates for the remote servers are received from a CA other than the one that provided the identity certificate for the ASA

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1240824]Step 4 Click Next. 

 
     [bookmark: pgfId-1240825]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1254266]The wizard completes by displaying a summary of the configuration created for the Cisco Intercompany Media Engine.

 
    
 
   
 
    
     [bookmark: pgfId-1246422][bookmark: 86338]Working with Certificates in the Unified Communication Wizard

 
    [bookmark: pgfId-1246423]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1246427]Exporting an Identity Certificate

 
     		 [bookmark: pgfId-1246431]Installing a Certificate

 
     		 [bookmark: pgfId-1246435]Generating a Certificate Signing Request (CSR) for a Unified Communications Proxy

 
     		 [bookmark: pgfId-1246443]Saving the Identity Certificate Request

 
     		 [bookmark: pgfId-1246447]Installing the ASA Identity Certificate on the Mobility Advantage Server

 
     		 [bookmark: pgfId-1246450]Installing the ASA Identity Certificate on the Presence Federation and Cisco Intercompany Media Engine Servers

 
    

 
     
      [bookmark: pgfId-1246454][bookmark: 30494]Exporting an Identity Certificate

 
     [bookmark: pgfId-1246455]The Cisco Mobility Advantage Proxy, Cisco Presence Federation Proxy, or Cisco Intercompany Media Engine Proxy require that you export the ASA identity certificate to install on the Cisco Mobility Advantage server, Cisco Presence Federation server, and Cisco Unified Communications server, respectfully. 

 
     [bookmark: pgfId-1246462]You use the wizard to export a self-signed identity certificate. The identity certificate has all associated keys and is in PKCS12 format, which is the public key cryptography standard. When configuring a Unified Communications proxy by using the wizard, you click the Generate and Export ASAâ��s Identify Certificate button while in the local-side or server-side certificate management step of the wizard. The Export certificate dialog box appears. 

 
     [bookmark: pgfId-1246463]From the Export certificate dialog box, perform these steps:

 
     
 
     [bookmark: pgfId-1246464]Step 1 Enter the name of the PKCS12 format file to use in exporting the certificate configuration. Alternatively, click Browse to display the Export ID Certificate File dialog box to find the file to which you want to export the certificate configuration.

 
     [bookmark: pgfId-1246465]Step 2 Click Export Certificate to export the certificate configuration.

 
     [bookmark: pgfId-1246466]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1246467]An information dialog box appears informing you that the certificate configuration file has been successfully exported to the location that you specified.

 
     [bookmark: pgfId-1246468]You complete the configuration of the Cisco Mobility Advantage Proxy, Cisco Presence Federation Proxy, or Cisco Intercompany Media Engine Proxy, you must import the generated ASA identify certificate in to the Cisco Mobility Advantage server, Cisco Presence Federation server, and Cisco Unified Communications server, respectfully, depending on which proxy you are configuring. 

 
     [bookmark: pgfId-1246472]See the documentation for the for each of these products for information about importing an identity certificate into each. 

 
    
 
     
      [bookmark: pgfId-1246475][bookmark: 51179]Installing a Certificate

 
     [bookmark: pgfId-1246476]When configuring certificates for the Phone Proxy, Cisco Mobility Advantage Proxy, the Cisco Presence Federation Proxy, and Cisco Intercompany Media Engine Proxy, you must install the certificates from the Cisco Unified Communications Manager servers, the Cisco Mobility Advantage server, the Cisco Presence Federation server, and the Cisco Unified Communications Manager servers, respectively, on the ASA. See the documentation for each of these products for information about obtaining the identity certificates from each. 

 
     [bookmark: pgfId-1266886]When configuring the Cisco Phone Proxy, if LSC provisioning is required or you have LSC enabled IP phones, you must install the CAPF certificate from the Cisco UCM on the ASA. If the Cisco UCM has more than one CAPF certificate, you must import all of them to the ASA. See Enabling Certificate Authority Proxy Function (CAPF) for IP Phones. 

 
     [bookmark: pgfId-1258734]Additionally, when configuring the Cisco Mobility Advantage Proxy, you use the Install Certificate dialog box to install the root certificate received from the certificate authority. The root certificate from the certificate authority is used to sign other certificates. The root certificate is used by the ASA to authenticate your signed identity certificate received from the certificate authority.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1246663]Note When using the wizard to configure the Unified Communications proxies, the wizard only supports installing self-signed certificates. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1246480]From the Install Certificate dialog box, perform these steps:

 
     
 
     [bookmark: pgfId-1246481]Step 1 Perform one of the following actions:

 
      
       
       		 [bookmark: pgfId-1246482]To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting). Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
       		 [bookmark: pgfId-1246483]To enroll manually, click the  Paste certificate in PEM format radio button. Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided. 

 
      

 
     

 
     [bookmark: pgfId-1246484]Step 2 Click Install Certificate.

 
     [bookmark: pgfId-1246485]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1246488]An information dialog box appears informing you that the certificate was installed on the ASA successfully.

 
    
 
     
      [bookmark: pgfId-1249987][bookmark: 33364]Generating a Certificate Signing Request (CSR) for a Unified Communications Proxy

 
     [bookmark: pgfId-1249989]When configuring certificates for the Cisco Mobility Advantage Proxy, Cisco Presence Federation Proxy, or Cisco Intercompany Media Engine Proxy, you must generate and identity certificate request for the ASA.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1250468]Note If the ASA already has a signed identity certificate, you do not need to generate a CSR and can proceed directly to installing this certificate on the ASA. See Installing the ASA Identity Certificate on the Mobility Advantage Server and Installing the ASA Identity Certificate on the Presence Federation and Cisco Intercompany Media Engine Servers for the steps to install the identity certificate.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1250161]The identify certificate that you receive is presented to the following entities for each of the Unified Communication Proxies:

 
      
      		 [bookmark: pgfId-1250162]Unified Mobile Communicator clients for the Cisco Mobility Advantage Proxy

 
      		 [bookmark: pgfId-1250179]Remote Presence Federation servers for the Cisco Presence Federation Proxy

 
      		 [bookmark: pgfId-1250188]The remote ASAfor the Cisco Intercompany Media Engine Proxy

 
     

 
     [bookmark: pgfId-1246494]Before generating the CSR, you can enter additional parameters. 

 
     [bookmark: pgfId-1250225]When configuring a Unified Communications proxy by using the wizard, you click the Generate CSR button while in the client-side or remote-side certificate management step of the wizard. The CSR Parameters dialog box appears. 

 
     [bookmark: pgfId-1250214]In the CSR Parameters dialog box, perform the following steps:

 
     
 
     [bookmark: pgfId-1246495]Step 1 From the Key Pair Size drop-down list, choose the size required for you certificate. 

 
     [bookmark: pgfId-1250250]The key size that you select depends on the level of security that you want to configure and on any limitations imposed by the CA from which you are obtaining the certificate. The larger the number that you select, the higher the security level will be for the certificate. Most CAs recommend 2048 for the key modulus size; however, GoDaddy requires a key modulus size of 2048. 

 
     [bookmark: pgfId-1250008]Step 2 (Cisco Intercompany Media Engine Proxy only) In the CN field, enter the domain name used by your enterprise or network. The subject DN you configure for the Cisco Intercompany Media Engine Proxy must match the domain name that set in the local Cisco Unified Communications Manager server.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1250115]Note For the Cisco Mobility Advantage Proxy and Cisco Presence Federation Proxy, the wizard provides the common name (CN), which is the FQDN of the Cisco Mobility Advantage server or Cisco Unified Presence server, respectively. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1246496]Step 3 In the Additional DN Attributes field, enter an attribute.

 
     [bookmark: pgfId-1250325]Or

 
     [bookmark: pgfId-1250344]Click Select to display the Additional DN Attributes dialog box. 

 
     [bookmark: pgfId-1250353] a. In the Additional DN Attributes dialog box, choose an attribute from the drop-down list.

 
     [bookmark: pgfId-1250364] b. Enter a value for the attribute.

 
     [bookmark: pgfId-1250366] c. Click Add. The attribute appears in the list. 

 
     [bookmark: pgfId-1250374] d. Click OK to return to the CSR Parameters dialog box. 

 
     [bookmark: pgfId-1250379]The value you added appears in the Additional DN Attributes field in the CSR Parameters dialog box.

 
     [bookmark: pgfId-1246497]Step 4 Click OK. 

 
     [bookmark: pgfId-1246498]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1246512][bookmark: 26645]Saving the Identity Certificate Request

 
     [bookmark: pgfId-1246513]After successfully generating the identity certificate request for one of the Unified Communications proxies, the Identity Certificate Request dialog box appears and prompts you to save the request. 

 
     
 
     [bookmark: pgfId-1246514]Step 1 In the Save CSR to File field, enter the CSR file name and path; for example, c:\asa-csr.txt.

 
     [bookmark: pgfId-1246515]Step 2 Click OK. An information dialog box appears indicating the CSR was saved successfully. 

 
     [bookmark: pgfId-1252621]Step 3 Click OK to close the dialog and return to the wizard.

 
     [bookmark: pgfId-1246516]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1252611]Submit the CSR to the certificate authority (CA), for example, by pasting the CSR text into the CSR enrollment page on the CA website.

 
     [bookmark: pgfId-1246518]When the CA returns the signed identity certificate, rerun the Unified Communications Wizard. From the client-side or remote-side certificate management step of the wizard, click Install ASAâ��s Identity Certificate. See Installing the ASA Identity Certificate on the Mobility Advantage Server and Installing the ASA Identity Certificate on the Presence Federation and Cisco Intercompany Media Engine Servers for the steps to install the identity certificate.

 
    
 
     
      [bookmark: pgfId-1246527][bookmark: 25452]Installing the ASA Identity Certificate on the Mobility Advantage Server

 
     [bookmark: pgfId-1246530]When configuring certificates for the Cisco Mobility Advantage Proxy, you must install the ASA identity certificate on the Cisco Mobility Advantage server.

 
     [bookmark: pgfId-1258446]Typically, a certificate authority returns two certificates: your signed identity certificate and the certificate authorityâ��s certificate (referred to as the root certificate). However, some certificate authorities (for example, VeriSign) might also send you an intermediate certificate. 

 
     [bookmark: pgfId-1258722]The root certificate from the certificate authority is used to sign other certificates. The root certificate is used by the ASA to authenticate your signed identity certificate received from the certificate authority.

 
     [bookmark: pgfId-1258662]If the certificate authority provided an intermediate certificate, you must enter the certificate text in the Intermediate Certificate (If Applicable) area of the Install ASAâ��s Identity Certificate dialog box. 

 
     [bookmark: pgfId-1258669]For the Cisco Mobility Advantage Proxy, you install the root certificate in another dialog box. See Installing a Certificate for the steps to install the root certificate. 

 
     
 
     [bookmark: pgfId-1246536]Step 1 In the Intermediate Certificate (If Applicable) area, perform on of the following actions:

 
      
       
       		 [bookmark: pgfId-1246537]To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting). Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
       		 [bookmark: pgfId-1246538]To enroll manually, click the  Paste the certificate data in base-64 format  radio button. Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided. 

 
      

 
     

 
     [bookmark: pgfId-1246539]Step 2 In the ASAâ��s Identity Certificate area, perform on of the following actions:

 
      
       
       		 [bookmark: pgfId-1246540]To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting). Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
       		 [bookmark: pgfId-1246541]To enroll manually, click the  Paste the certificate data in base-64 format radio button. Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided. 

 
      

 
     

 
     [bookmark: pgfId-1246542]Step 3 Click Install Certificate.

 
     [bookmark: pgfId-1246543]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1246545][bookmark: 75287]Installing the ASA Identity Certificate on the Presence Federation and Cisco Intercompany Media Engine Servers

 
     [bookmark: pgfId-1246547]When configuring certificates for the Cisco Presence Federation Proxy and Cisco Intercompany Media Engine Proxy, you must install the ASA identity certificate and the root certificate on the Cisco Presence Federation server and Cisco Intercompany Media Engine server, respectively.

 
     [bookmark: pgfId-1258602]Typically, a certificate authority returns two certificates: your signed identity certificate and the certificate authorityâ��s certificate (referred to as the root certificate). The root certificate from the certificate authority is used to sign other certificates. The root certificate is used by the ASA to authenticate your signed identity certificate received from the certificate authority.

 
     
 
     [bookmark: pgfId-1246552]Step 1 In the Root CAâ��s Certificate area, perform on of the following actions:

 
      
       
       		 [bookmark: pgfId-1246553]To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting). Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
       		 [bookmark: pgfId-1246554]To enroll manually, click the  Paste the certificate data in base-64 format radio button. Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided. 

 
      

 
     

 
     [bookmark: pgfId-1246555]Step 2 In the ASAâ��s Identity Certificate area, perform on of the following actions:

 
      
       
       		 [bookmark: pgfId-1246556]To add a certificate configuration from an existing file, click the Install from a file radio button (this is the default setting). Enter the path and file name, or click  Browse to search for the file. Then click  Install Certificate . 

 
       		 [bookmark: pgfId-1246557]To enroll manually, click the  Paste the certificate data in base-64 format radio button. Copy and paste the PEM format (base64 or hexadecimal) certificate into the area provided. 

 
      

 
     

 
     [bookmark: pgfId-1246558]Step 3 Click Install Certificate.

 
     [bookmark: pgfId-1246559]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1240691] 
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     [bookmark: pgfId-1105818][bookmark: 44865]Configuring Network Object NA[bookmark: marker-1150476]T (ASA 8.3 and Later) 
      
      
 
     
 

 
    [bookmark: pgfId-1105819]All NAT rules that are configured as a parameter of a network object are considered to be network object NAT rules. Network object NAT is a quick and easy way to configure NAT for a single IP address, a range of addresses, or a subnet. After you configure the network object, you can then identify the mapped address for that object.

 
    [bookmark: pgfId-1043202]This chapter describes how to configure network object NAT, and it includes the following sections:

 
     
     		 [bookmark: pgfId-1057264]Information About Network Object NAT

 
     		 [bookmark: pgfId-1057268]Licensing Requirements for Network Object NAT

 
     		 [bookmark: pgfId-1043236]Prerequisites for Network Object NAT

 
     		 [bookmark: pgfId-1046652]Guidelines and Limitations

 
     		 [bookmark: pgfId-1391163]Default Settings

 
     		 [bookmark: pgfId-1046685]Configuring Network Object NAT

 
     		 [bookmark: pgfId-1219867]Monitoring Network Object NAT

 
     		 [bookmark: pgfId-1835107]Configuration Examples for Network Object NAT

 
     		 [bookmark: pgfId-1068119]Feature History for Network Object NAT

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1105152]Note For detailed information about how NAT works, see Chapter3, “Information About NAT (ASA 8.3 and Later)”

 
     
     
 
    
 
    

 
   
 
    
     [bookmark: pgfId-1056837][bookmark: 15525]Information About Network Object NAT

 
    [bookmark: pgfId-1105871]When a packet enters the ASA, both the source and destination IP addresses are checked against the network object NAT rules. The source and destination address in the packet can be translated by separate rules if separate matches are made. These rules are not tied to each other; different combinations of rules can be used depending on the traffic.

 
    [bookmark: pgfId-1105872]Because the rules are never paired, you cannot specify that a source address should be translated to A when going to destination X, but be translated to B when going to destination Y. Use twice NAT for that kind of functionality (twice NAT lets you identify the source and destination address in a single rule).

 
    [bookmark: pgfId-1112864]For detailed information about the differences between twice NAT and network object NAT, see the “How NAT is Implemented” section.

 
    [bookmark: pgfId-1096330]Network object NAT rules are added to section 2 of the NAT rules table. For more information about NAT ordering, see the “NAT Rule Order” section.

 
   
 
    
     [bookmark: pgfId-1046838][bookmark: 29596]Licensing Requirements for Network Object NAT

 
    [bookmark: pgfId-1067555]The following table shows the licensing requirements for this feature:

 
    [bookmark: pgfId-1841098] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1841091]Model 
         
  
        		 
          
          [bookmark: pgfId-1841093]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1841095]All models

  
        		[bookmark: pgfId-1841097]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1103116][bookmark: 79269]Prerequisites for Network Object NA[bookmark: marker-1150477]T

 
    [bookmark: pgfId-1212163]Depending on the configuration, you can configure the mapped address inline if desired or you can create a separate network object or network object group for the mapped address. Network object groups are particularly useful for creating a mapped address pool with discontinous IP address ranges or multiple hosts or subnets. To create a network object or group, see the “Configuring Network Objects and Groups” section in the general operations configuration guide.

 
    [bookmark: pgfId-1212169]For specific guidelines for objects and groups, see the configuration section for the NAT type you want to configure. See also the “Guidelines and Limitations” section.

 
   
 
    
     [bookmark: pgfId-1057302][bookmark: 16098][bookmark: 58316]Guidelines and Limitations[bookmark: marker-1150478]

 
    [bookmark: pgfId-1071231][bookmark: 87419]Context Mode Guidelines

 
    [bookmark: pgfId-1071232]Supported in single and multiple context mode.

 
    [bookmark: pgfId-1071235][bookmark: 16807]Firewall Mode Guidelines

 
     
     		 [bookmark: pgfId-1071236]Supported in routed and transparent firewall mode.

 
     		 [bookmark: pgfId-1102623]In transparent mode, you must specify the real and mapped interfaces; you cannot use --Any--.

 
     		 [bookmark: pgfId-1102649]In transparent mode, you cannot configure interface PAT, because the transparent mode interfaces do not have IP addresses. You also cannot use the management IP address as a mapped address.

 
     		 [bookmark: pgfId-1532404]In transparent mode, translating between IPv4 and IPv6 networks is not supported. Translating between two IPv6 networks, or between two IPv4 networks is supported.

 
    

 
    [bookmark: pgfId-1082960][bookmark: 84518]IPv6 Guidelines

 
     
     		 [bookmark: pgfId-1532423]Supports IPv6. See also the “NAT and IPv6” section.

 
     		 [bookmark: pgfId-1532433]For routed mode, you can also translate between IPv4 and IPv6.

 
     		 [bookmark: pgfId-1532440]For transparent mode, translating between IPv4 and IPv6 networks is not supported. Translating between two IPv6 networks, or between two IPv4 networks is supported.

 
     		 [bookmark: pgfId-1575902]For transparent mode, a PAT pool is not supported for IPv6.

 
     		 [bookmark: pgfId-1577039]For static NAT, you can specify an IPv6 subnet up to /64. Larger subnets are not supported.

 
     		 [bookmark: pgfId-1577070]When using FTP with NAT46, when an IPv4 FTP client connects to an IPv6 FTP server, the client must use either the extended passive mode (EPSV) or extended port mode (EPRT); PASV and PORT commands are not supported with IPv6.

 
    

 
    [bookmark: pgfId-1116834][bookmark: 33416]Additional Guidelines

 
     
     		 [bookmark: pgfId-1233782]You can only define a single NAT rule for a given object; if you want to configure multiple NAT rules for an object, you need to create multiple objects with different names that specify the same IP address, for example,  object network obj-10.10.10.1-01 ,  object network obj-10.10.10.1-02 , and so on.

 
     		 [bookmark: pgfId-1233768]If you change the NAT configuration, and you do not want to wait for existing translations to time out before the new NAT configuration is used, you can clear the translation table using the  clear xlate command. However, clearing the translation table disconnects all current connections that use translations.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1203326]Note If you remove a dynamic NAT or PAT rule, and then add a new rule with mapped addresses that overlap the addresses in the removed rule, then the new rule will not be used until all connections associated with the removed rule time out or are cleared using the clear xlate command. This safeguard ensures that the same address is not assigned to multiple hosts.

 
     
     
 
    
 
    

 
     
     		 [bookmark: pgfId-1116835]Objects and object groups used in NAT cannot be undefined; they must include IP addresses.

 
     		 [bookmark: pgfId-1532066]You cannot use an object group with both IPv4 and IPv6 addresses; the object group must include only one type of address.

 
     		 [bookmark: pgfId-1375993]You can use the same mapped object or group in multiple NAT rules.

 
     		 [bookmark: pgfId-1124162]The mapped IP address pool cannot include:

 
    

 
    [bookmark: pgfId-1124331] – The mapped interface IP address. If you specify --Any-- interface for the rule, then all interface IP addresses are disallowed. For interface PAT (routed mode only), use the interface name instead of the IP address.

 
    [bookmark: pgfId-1124332] – (Transparent mode) The management IP address.

 
    [bookmark: pgfId-1124103] – (Dynamic NAT) The standby interface IP address when VPN is enabled.

 
    [bookmark: pgfId-1124104] – Existing VPN pool addresses.

 
     
     		 [bookmark: pgfId-1428331]For application inspection limitations with NAT or PAT, see the “Default Settings and NAT Limitations” section in Chapter10, “Getting Started with Application Layer Protocol Inspection”

 
    

 
   
 
    
     [bookmark: pgfId-1391073][bookmark: 92290]Default Settings

 
     
     		 [bookmark: pgfId-1391152](Routed mode) The default real and mapped interface is Any, which applies the rule to all interfaces.

 
     		 [bookmark: pgfId-1391118](8.3(1), 8.3(2), and 8.4(1)) The default behavior for identity NAT has proxy ARP disabled. You cannot configure this setting. (8.4(2) and later) The default behavior for identity NAT has proxy ARP enabled, matching other static NAT rules. You can disable proxy ARP if desired. See the “Routing NAT Packets” section for more information.

 
     		 [bookmark: pgfId-1532388]If you specify an optional interface, then the ASA uses the NAT configuration to determine the egress interface. (8.3(1) through 8.4(1)) The only exception is for identity NAT, which always uses a route lookup, regardless of the NAT configuration. (8.4(2) and later) For identity NAT, the default behavior is to use the NAT configuration, but you have the option to always use a route lookup instead. See the “Routing NAT Packets” section for more information.

 
    

 
   
 
    
     [bookmark: pgfId-1074591][bookmark: 60355][bookmark: 71793]Configuring Network Object NAT

 
    [bookmark: pgfId-1106166]This section describes how to configure network object NAT and includes the following topics:

 
     
     		 [bookmark: pgfId-1698319]Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool

 
     		 [bookmark: pgfId-1106915]Configuring Dynamic PAT (Hide)

 
     		 [bookmark: pgfId-1106948]Configuring Static NAT or Static NAT-with-Port-Translation

 
     		 [bookmark: pgfId-1534458]Configuring Identity NAT

 
     		 [bookmark: pgfId-1534462]Configuring Per-Session PAT Rules

 
    

 
     
      [bookmark: pgfId-1534465][bookmark: 18425]Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool[bookmark: marker-1534464]

 
     [bookmark: pgfId-1441530]This section describes how to configure network object NAT for dynamic NAT or for dynamic PAT using a PAT pool. For more information, see the “Dynamic NAT” section or the “Dynamic PAT” section.

 
    
 
     
      [bookmark: pgfId-1819659]Guidelines

 
     [bookmark: pgfId-1819660]For a PAT pool:

 
      
      		 [bookmark: pgfId-1819661]If available, the real source port number is used for the mapped port. However, if the real port is  not available, by default the mapped ports are chosen from the same range of ports as the real port number: 0 to 511, 512 to 1023, and 1024 to 65535. The[bookmark: marker-1819662]refore, ports below 1024 have only a small PAT pool that can be used. (8.4(3) and later, not including 8.5(1) or 8.6(1)) If you have a lot of traffic that uses the lower port ranges, you can now specify for a PAT pool a flat range of ports to be used instead of the three unequal-sized tiers: either 1024 to 65535, or 1 to 65535.

 
      		 [bookmark: pgfId-1819664]If you use the same PAT pool object in two separate rules, then be sure to specify the same options for each rule. For example, if one rule specifies extended PAT and a flat range, then the other rule must also specify extended PAT and a flat range.

 
     

 
     [bookmark: pgfId-1819666]For ext[bookmark: marker-1819665]ended PAT for a PAT pool:

 
      
      		 [bookmark: pgfId-1819669]Many application inspections do not support extended PAT. See the “Default Settings and NAT Limitations” section in “Getting Started with Application Layer Protocol Inspection,” for a complete list of unsupported inspections.

 
      		 [bookmark: pgfId-1819674]If you enable extended PAT for a dynamic PAT rule, then you cannot also use an address in the PAT pool as the PAT address in a separate static NAT with port translation rule. For example, if the PAT pool includes 10.1.1.1, then you cannot create a static NAT-with-port-translation rule using 10.1.1.1 as the PAT address.

 
      		 [bookmark: pgfId-1819675]If you use a PAT pool and specify an interface for fallback, you cannot specify extended PAT.

 
      		 [bookmark: pgfId-1819676]For VoIP deployments that use ICE or TURN, do not use extended PAT. ICE and TURN rely on the PAT binding to be the same for all destinations.

 
     

 
     [bookmark: pgfId-1819677]For round robin for a PAT pool:

 
      
      		 [bookmark: pgfId-1819678]If a host has an existing connection, then subsequent connections from that host will use the same PAT IP address if ports are available.  Note : This “stickiness” does not survive a failover. If the ASA fails over, then subsequent connections from a host may not use the initial IP address.

 
      		 [bookmark: pgfId-1819682]Round robin, especially when combined with extended PAT, can consume a large amount of memory. Because NAT pools are created for every mapped protocol/IP address/port range, round robin results in a large number of concurrent NAT pools, which use memory. Extended PAT results in an even larger number of concurrent NAT pools.

 
     

 
    
 
     
      [bookmark: pgfId-1430890]Detailed Steps

 
     
 
     [bookmark: pgfId-1819687]Step 1 Add NAT to a new or existing network object:

 
      
       
       		 [bookmark: pgfId-1819688]To add a new network object, choose  Configuration >  Firewall >  NAT Rules , then click Add > Add Network Object NAT Rule .

 
      

 
     

 
     [bookmark: pgfId-1835318] 

 
      
      [image: ] 
     
 
      
       
       		 [bookmark: pgfId-1819693]To add NAT to an existing network object, choose  Configuration > Firewall > Objects > Network Objects/Groups , and then double-click a network object.

 
      

 
     

 
     [bookmark: pgfId-1819699]For more information, see the “Configuring a Network Object” section in the general operations configuration guide.

 
     [bookmark: pgfId-1819701]The Add/Edit Network Object dialog box appears.

 
     [bookmark: pgfId-1819702]Step 2 For a new object, enter values for the following fields:

 
     [bookmark: pgfId-1819703] a. Name—The object name. Use characters a to z, A to Z, 0 to 9, a period, a dash, a comma, or an underscore. The name must be 64 characters or less.

 
     [bookmark: pgfId-1819704] b. Type—Host, Network, or Range.

 
     [bookmark: pgfId-1819705] c. IP Address—An IPv4 or IPv6 address. If you select Range as the object type, the IP Address field changes to allow you to enter a Start Address and an End address.

 
     [bookmark: pgfId-1819706] d. Netmask/Prefix Length—Enter the subnet mask or prefix length.

 
     [bookmark: pgfId-1819707] e. Description—(Optional) The description of the network object (up to 200 characters in length).

 
     [bookmark: pgfId-1835326] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819712]Step 3 If the NAT section is hidden, click NAT to expand the section.

 
     [bookmark: pgfId-1835334] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819717]Step 4 Check the Add Automatic Translation Rules check box. 

 
     [bookmark: pgfId-1819718]Step 5 From the Type drop-down list, choose Dynamic. Choose Dynamic even if you are configuring dynamic PAT with a PAT pool.

 
     [bookmark: pgfId-1819719]Step 6 Configure either dynamic NAT, or dynamic PAT with a PAT pool:

 
      
       
       		 [bookmark: pgfId-1819720]Dynamic NAT—To the right of the Translated Addr field, click the browse button and choose an existing network object or create a new object from the Browse Translated Addr dialog box.

 
      

 
     

 
     [bookmark: pgfId-1835342] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819725]Note The object or group cannot contain a subnet. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only. 
     

 
      
      		 [bookmark: pgfId-1819727]Dynamic PAT using a PAT pool—[bookmark: 83204]Enable a PAT pool:

 
     

 
     [bookmark: pgfId-1835355] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819732] a. Do not enter a value for the Translated Addr. field; leave it blank.

 
     [bookmark: pgfId-1819734] b. C[bookmark: marker-1819733]heck the PAT Pool Translated Address check box, then click the browse button and choose an existing network object or create a new network object from the Browse Translated PAT Pool Address dialog box.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1819735]Note The PAT pool object or group cannot contain a subnet. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1819737] c. (Optional) Check th[bookmark: marker-1819736]e Round Robin check box to assign addresses/ports in a round-robin fashion. By default without round robin, all ports for a PAT address will be allocated before the next PAT address is used. The round-robin method assigns one address/port from each PAT address in the pool before returning to use the first address again, and then the second address, and so on.

 
     [bookmark: pgfId-1819738] d. (Optional, 8.4(3) and later, not including 8.5(1) or 8.6(1)) Check the Extend PAT uniqueness to per destination instead of per interface check box to use extended PAT. Extended PAT uses 65535 ports per service, as opposed to per IP address, by including the destination address and port in the translation information. Normally, the destination port and address are not considered when creating PAT translations, so you are limited to 65535 ports per PAT address. For example, with extended PAT, you can create a translation of 10.1.1.1:1027 when going to 192.168.1.7:23 as well as a translation of 10.1.1.1:1027 when going to 192.168.1.7:80.

 
     [bookmark: pgfId-1819739] e. (Optional, 8.4(3) and later, not including 8.5(1) or 8.6(1)) Check the Translate TCP or UDP ports into flat range (1024-65535) check box to use the 1024 to 65535 port range as a single flat range when allocating ports. When choosing the mapped port number for a translation, the ASA uses the real source port number if it is available. However, without this option, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 1 to 511, 512 to 1023, and 1024 to 65535. To avoid running out of ports at the low ranges, configure this setting. To use the entire range of 1 to 65535, also check the Include range 1 to 1023 check box.

 
     [bookmark: pgfId-1819743]Step 7 (Optional, Routed Mode Only) To use the interface IP address as a backup method when the other mapped addresses are already allocated, check the Fall through to interface PAT (dest intf) check box, and choose the interface from the drop-down list. To use the IPv6 address of the interface, also check the Use IPv6 for interface PAT checkbox.

 
     [bookmark: pgfId-1835363] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819749]Step 8 [bookmark: 61360](Optional) Click Advanced, and configure the following options in the Advanced NAT Settings dialog box.

 
     [bookmark: pgfId-1835371] 

 
      
      [image: ] 
     
 
      
       
       		 [bookmark: pgfId-1819754]Translate DNS replies for rule—Translates the IP address in DNS replies. Be sure DNS inspection is enabled (it is enabled by default). See the “DNS and NAT” section for more information.

 
       		 [bookmark: pgfId-1819758](Required for Transparent Firewall Mode) Source Interface—Specifies the real interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
       		 [bookmark: pgfId-1819759](Required for Transparent Firewall Mode) Destination Interface—Specifies the mapped interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
      

 
     

 
     [bookmark: pgfId-1819760]When you are finished, click OK. You return to the Add/Edit Network Object dialog box.

 
     [bookmark: pgfId-1819761]Step 9 Click OK, and then Apply.

 
     [bookmark: pgfId-1819762]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1455942][bookmark: 82951]Configuring Dynamic PAT (Hide)[bookmark: marker-1455941]

 
     [bookmark: pgfId-1455943]This section describes how to configure network object NAT for dynamic PAT (hide). For dynamic PAT using a PAT pool, see the “Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool” section instead of using this section. For more information, see the “Dynamic PAT” section.

 
    
 
     
      [bookmark: pgfId-1105956]Detailed Steps

 
     
 
     [bookmark: pgfId-1819775]Step 1 Add NAT to a new or existing network object:

 
      
       
       		 [bookmark: pgfId-1819776]To add a new network object, choose  Configuration >  Firewall >  NAT Rules , then click Add > Add Network Object NAT Rule .

 
      

 
     

 
     [bookmark: pgfId-1835610] 

 
      
      [image: ] 
     
 
      
       
       		 [bookmark: pgfId-1819781]To add NAT to an existing network object, choose  Configuration > Firewall > Objects > Network Objects/Groups , and then double-click a network object.

 
      

 
     

 
     [bookmark: pgfId-1819787]For more information, see the “Configuring a Network Object” section in the general operations configuration guide.

 
     [bookmark: pgfId-1819789]The Add/Edit Network Object dialog box appears.

 
     [bookmark: pgfId-1819790]Step 2 For a new object, enter values for the following fields:

 
     [bookmark: pgfId-1819791] a. Name—The object name. Use characters a to z, A to Z, 0 to 9, a period, a dash, a comma, or an underscore. The name must be 64 characters or less.

 
     [bookmark: pgfId-1819792] b. Type—Host, Network, or Range.

 
     [bookmark: pgfId-1819793] c. IP Address—An IPv4 or IPv6 address. If you select Range as the object type, the IP Address field changes to allow you to enter a Start Address and an End address.

 
     [bookmark: pgfId-1819794] d. Netmask/Prefix Length—Enter the subnet mask or prefix length.

 
     [bookmark: pgfId-1819795] e. Description—(Optional) The description of the network object (up to 200 characters in length).

 
     [bookmark: pgfId-1835618] 
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     [bookmark: pgfId-1819800]Step 3 If the NAT section is hidden, click NAT to expand the section.

 
     [bookmark: pgfId-1835626] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819805]Step 4 Check the Add Automatic Translation Rules check box. 

 
     [bookmark: pgfId-1819806]Step 5 From the Type drop-down list, choose Dynamic PAT (Hide).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1819809]Note To configure dynamic PAT using a PAT pool instead of a single address, see the “Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool” section.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1819811]Step 6 Specify a single mapped address. In the Translated Addr. field, specify the mapped IP address by doing one of the following:

 
      
      		 [bookmark: pgfId-1819812]Type a host IP address.

 
      		 [bookmark: pgfId-1819813]Type an interface name or click the browse button, and choose an interface from the Browse Translated Addr dialog box.

 
     

 
     [bookmark: pgfId-1835634] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819818]If you specify an interface name, then you enable interface PAT, where the specified interface IP address is used as the mapped address. To use the IPv6 interface address, you must also check the Use IPv6 for interface PAT checkbox. With interface PAT, the NAT rule only applies to the specified mapped interface. (If you do not use interface PAT, then the rule applies to all interfaces by default.) See Step 7 to optionally also configure the real interface to be a specific interface instead of --Any--.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1819822]Note You cannot specify an interface in transparent mode.

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1819823]Click the browse button, and choose an existing host address from the Browse Translated Addr dialog box.

 
      		 [bookmark: pgfId-1819824]Click the browse button, and create a new named object from the Browse Translated Addr dialog box.

 
     

 
     [bookmark: pgfId-1819826]Step 7 [bookmark: 37085](Optional) Click Advanced, and configure the following options in the Advanced NAT Settings dialog box.

 
     [bookmark: pgfId-1835642] 

 
      
      [image: ] 
     
 
      
       
       		 [bookmark: pgfId-1819831]Translate DNS replies for rule—Translates the IP address in DNS replies. Be sure DNS inspection is enabled (it is enabled by default). See the “DNS and NAT” section for more information.

 
       		 [bookmark: pgfId-1819835](Required for Transparent Firewall Mode) Source Interface—Specifies the real interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
       		 [bookmark: pgfId-1819836](Required for Transparent Firewall Mode) Destination Interface—Specifies the mapped interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
      

 
     

 
     [bookmark: pgfId-1819837]When you are finished, click OK. You return to the Add/Edit Network Object dialog box.

 
     [bookmark: pgfId-1819838]Step 8 Click OK, and then Apply.

 
     [bookmark: pgfId-1819839]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1106703][bookmark: 92074]Configuring Static NAT or Static NAT-with-Port-Translation[bookmark: marker-1150481]

 
     [bookmark: pgfId-1106972]This section describes how to configure a static NAT rule using network object NAT. For more information, see the “Static NAT” section.

 
    
 
     
      [bookmark: pgfId-1106705]Detailed Steps

 
     
 
     [bookmark: pgfId-1819844]Step 1 Add NAT to a new or existing network object:

 
      
       
       		 [bookmark: pgfId-1819845]To add a new network object, choose  Configuration >  Firewall >  NAT Rules , then click Add > Add Network Object NAT Rule .

 
      

 
     

 
     [bookmark: pgfId-1835782] 
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       		 [bookmark: pgfId-1819850]To add NAT to an existing network object, choose  Configuration > Firewall > Objects > Network Objects/Groups , and then double-click a network object.

 
      

 
     

 
     [bookmark: pgfId-1819856]For more information, see the “Configuring a Network Object” section in the general operations configuration guide.

 
     [bookmark: pgfId-1819858]The Add/Edit Network Object dialog box appears.

 
     [bookmark: pgfId-1819859]Step 2 For a new object, enter values for the following fields:

 
     [bookmark: pgfId-1819860] a. Name—The object name. Use characters a to z, A to Z, 0 to 9, a period, a dash, a comma, or an underscore. The name must be 64 characters or less.

 
     [bookmark: pgfId-1819861] b. Type—Network, Host, or Range.

 
     [bookmark: pgfId-1819862] c. IP Address—An IPv4 or IPv6 address. If you select Range as the object type, the IP Address field changes to allow you to enter a Start Address and an End address.

 
     [bookmark: pgfId-1819863] d. Netmask/Prefix Length—Enter the subnet mask or prefix length.

 
     [bookmark: pgfId-1819864] e. Description—(Optional) The description of the network object (up to 200 characters in length).

 
     [bookmark: pgfId-1835790] 
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     [bookmark: pgfId-1819869]Step 3 If the NAT section is hidden, click NAT to expand the section.

 
     [bookmark: pgfId-1835798] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819874]Step 4 Check the Add Automatic Translation Rules check box. 

 
     [bookmark: pgfId-1819875]Step 5 From the Type drop-down list, choose Static.

 
     [bookmark: pgfId-1819876]Step 6 In the Translated Addr. field, do one of the following:

 
      
       
       		 [bookmark: pgfId-1819877]Type an IP address.

 
      

 
     

 
     [bookmark: pgfId-1819878]When you type an IP address, the netmask or range for the mapped network is the same as that of the real network. For example, if the real network is a host, then this address will be a host address. In the case of a range, then the mapped addresses include the same number of addresses as the real range. For example, if the real address is defined as a range from 10.1.1.1 through 10.1.1.6, and you specify 172.20.1.1 as the mapped address, then the mapped range will include 172.20.1.1 through 172.20.1.6.

 
      
       
       		 [bookmark: pgfId-1819879](For static NAT-with-port-translation only) Type an interface name or click the browse button, and choose an interface from the Browse Translated Addr dialog box.

 
      

 
     

 
     [bookmark: pgfId-1835806] 
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     [bookmark: pgfId-1819884]To use the IPv6 interface address, you must also check the Use IPv6 for interface PAT checkbox. Be sure to also configure a service on the Advanced NAT Settings dialog box (see Step 8). (You cannot specify an interface in transparent mode).

 
      
       
       		 [bookmark: pgfId-1819888]Click the browse button, and choose an existing address from the Browse Translated Addr dialog box. 

 
       		 [bookmark: pgfId-1819889]Click the browse button, and create a new address from the Browse Translated Addr dialog box. 

 
      

 
     

 
     [bookmark: pgfId-1835814] 
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     [bookmark: pgfId-1819894]Typically, you configure the same number of mapped addresses as real addresses for a one-to-one mapping. You can, however, have a mismatched number of addresses. For more information, see the “Static NAT” section.

 
     [bookmark: pgfId-1819898]Step 7 (Optional) For NAT46, check Use one-to-one address translation. For NAT 46, specify one-to-one to translate the first IPv4 address to the first IPv6 address, the second to the second, and so on. Without this option, the IPv4-embedded method is used. For a one-to-one translation, you must use this keyword.

 
     [bookmark: pgfId-1819900]Step 8 [bookmark: 96446](Optional) Click Advanced, and configure the following options in the Advanced NAT Settings dialog box.

 
     [bookmark: pgfId-1835822] 
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       		 [bookmark: pgfId-1819905]Translate DNS replies for rule—Translates the IP address in DNS replies. Be sure DNS inspection is enabled (it is enabled by default). See the “DNS and NAT” section for more information.

 
       		 [bookmark: pgfId-1819909]Disable Proxy ARP on egress interface—Disables proxy ARP for incoming packets to the mapped IP addresses. See the “Mapped Addresses and Routing” section for more information.

 
       		 [bookmark: pgfId-1819913](Required for Transparent Firewall Mode) Interface:

 
      

 
     

 
     [bookmark: pgfId-1819914] – Source Interface—Specifies the real interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
     [bookmark: pgfId-1819915] – Destination Interface—Specifies the mapped interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
      
       
       		 [bookmark: pgfId-1819916]Service:

 
      

 
     

 
     [bookmark: pgfId-1819917] – Protocol—Configures static NAT-with-port-translation. Choose tcp or udp. 

 
     [bookmark: pgfId-1819918] – Real Port—You can type either a port number or a well-known port name (such as “ftp”).

 
     [bookmark: pgfId-1819919] – Mapped Port—You can type either a port number or a well-known port name (such as “ftp”).

 
     [bookmark: pgfId-1819920]When you are finished, click OK. You return to the Add/Edit Network Object dialog box.

 
     [bookmark: pgfId-1819921]Step 9 Click OK, and then Apply.

 
     [bookmark: pgfId-1819922]Because static rules are bidirectional (allowing initiation to and from the real host), the NAT Rules table show two rows for each static rule, one for each direction.

 
     [bookmark: pgfId-1835830] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819927]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1108647][bookmark: 29926]Configuring Identity NAT[bookmark: marker-1150482]

 
     [bookmark: pgfId-1108648]This section describes how to configure an identity NAT rule using network object NAT. For more information, see the “Identity NAT” section.

 
    
 
     
      [bookmark: pgfId-1108652]Detailed Steps

 
     
 
     [bookmark: pgfId-1819932]Step 1 Add NAT to a new or existing network object:

 
      
       
       		 [bookmark: pgfId-1819933]To add a new network object, choose  Configuration >  Firewall >  NAT Rules , then click Add > Add Network Object NAT Rule .

 
      

 
     

 
     [bookmark: pgfId-1836004] 
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       		 [bookmark: pgfId-1819938]To add NAT to an existing network object, choose  Configuration > Firewall > Objects > Network Objects/Groups , and then double-click a network object.

 
      

 
     

 
     [bookmark: pgfId-1819944]For more information, see the “Configuring a Network Object” section in the general operations configuration guide.

 
     [bookmark: pgfId-1819946]The Add/Edit Network Object dialog box appears.

 
     [bookmark: pgfId-1819947]Step 2 For a new object, enter values for the following fields:

 
     [bookmark: pgfId-1819948] a. Name—The object name. Use characters a to z, A to Z, 0 to 9, a period, a dash, a comma, or an underscore. The name must be 64 characters or less.

 
     [bookmark: pgfId-1819949] b. Type—Network, Host, or Range.

 
     [bookmark: pgfId-1819950] c. IP Address—An IPv4 or IPv6 address. If you select Range as the object type, the IP Address field changes to allow you to enter a Start Address and an End address.

 
     [bookmark: pgfId-1819951] d. Netmask/Prefix Length—Enter the subnet mask or prefix length.

 
     [bookmark: pgfId-1819952] e. Description—(Optional) The description of the network object (up to 200 characters in length).

 
     [bookmark: pgfId-1836012] 
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     [bookmark: pgfId-1819957]Step 3 If the NAT section is hidden, click NAT to expand the section.

 
     [bookmark: pgfId-1836020] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819962]Step 4 Check the Add Automatic Translation Rules check box. 

 
     [bookmark: pgfId-1819963]Step 5 From the Type drop-down list, choose Static.

 
     [bookmark: pgfId-1819964]Step 6 In the Translated Addr. field, do one of the following:

 
      
       
       		 [bookmark: pgfId-1819965]Type the same IP address that you used for the real address.

 
       		 [bookmark: pgfId-1819966]Click the browse button, and choose a network object with a matching IP address definition from the Browse Translated Addr dialog box.

 
       		 [bookmark: pgfId-1819967]Click the browse button, and create a new network object with a matching IP address definition from the Browse Translated Addr dialog box. 

 
      

 
     

 
     [bookmark: pgfId-1836028] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819973]Step 7 [bookmark: 89434](Optional) Click Advanced, and configure the following options in the Advanced NAT Settings dialog box.

 
     [bookmark: pgfId-1836036] 

 
      
      [image: ] 
     
 
      
       
       		 [bookmark: pgfId-1819979]Disable Proxy ARP on egress interface—[bookmark: marker-1819978]Disables proxy ARP for incoming packets to the mapped IP addresses. See the “Mapped Addresses and Routing” section for more information.

 
      

 
      		 [bookmark: pgfId-1819984](Routed mode; i[bookmark: marker-1819983]nterface(s) specified) Lookup route table to locate egress interface—Determines the egress interface using a route lookup instead of using the interface specified in the NAT command. See the “Determining the Egress Interface” section for more information.

 
       
       		 [bookmark: pgfId-1819988](Required for Transparent Firewall Mode) Interface:

 
      

 
     

 
     [bookmark: pgfId-1819989] – Source Interface—Specifies the real interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
     [bookmark: pgfId-1819990] – Destination Interface—Specifies the mapped interface where this NAT rule applies. By default, the rule applies to all interfaces.

 
     [bookmark: pgfId-1819991]Do not configure any other options on this dialog box. When you are finished, click OK. You return to the Add/Edit Network Object dialog box.

 
     [bookmark: pgfId-1819992]Step 8 Click OK, and then Apply.

 
     [bookmark: pgfId-1819993]Because static rules are bidirectional (allowing initiation to and from the real host), the NAT Rules table show two rows for each static rule, one for each direction.

 
     [bookmark: pgfId-1836044] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1819998]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1531171][bookmark: 69674]Configuring Per-Se[bookmark: marker-1533772]ssion PAT Rules

 
     [bookmark: pgfId-1531172]By default, all TCP PAT traffic and all UDP DNS traffic uses per-session PAT. To use multi-session PAT for traffic, you can configure per-session PAT rules: a permit rule uses per-session PAT, and a deny rule uses multi-session PAT. For more information about per-session vs. multi-session PAT, see the “Per-Session PAT vs. Multi-Session PAT (Version 9.0(1) and Later)” section.

 
    
 
     
      [bookmark: pgfId-1531176]Defaults

 
     [bookmark: pgfId-1531177]By default, the following rules are installed:

 
      
      		 [bookmark: pgfId-1820003]Permit TCP from any (IPv4 and IPv6) to any (IPv4 and IPv6)

 
      		 [bookmark: pgfId-1820004]Permit UDP from any (IPv4 and IPv6) to domain

 
     

 
     [bookmark: pgfId-1820005]These rules do not appear in the rule table.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1534351]Note You cannot remove these rules, and they always exist after any manually-created rules. Because rules are evaluated in order, you can override the default rules. For example, to completely negate these rules, you could add the following:

 
      
      		 [bookmark: pgfId-1820010]Deny TCP from any (IPv4 and IPv6) to any (IPv4 and IPv6)

 
      		 [bookmark: pgfId-1820011]Deny UDP from any (IPv4 and IPv6) to domain

 
     

 
     [bookmark: pgfId-1694915]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1534112]Detailed Steps

 
     
 
     [bookmark: pgfId-1820016]Step 1 Choose Configuration > Firewall > Advanced > Per-Session NAT Rules, and click Add > Add Per-Session NAT Rule.

 
     [bookmark: pgfId-1836152] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1820021]Step 2 Click Permit or Deny.

 
     [bookmark: pgfId-1836160] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1820026]A permit rule uses per-session PAT; a deny rule uses multi-session PAT.

 
     [bookmark: pgfId-1820027]Step 3 Specify the Source Address either by typing an address or clicking the ... button to choose an object.

 
     [bookmark: pgfId-1820028]Step 4 Specify the Source Service, UDP or TCP. You can optionally specify a source port, although normally you only specify the destination port. Either type in UDP/port or TCP/port, or click the ... button to select a common value or object.

 
     [bookmark: pgfId-1820029]Step 5 Specify the Destination Address either by typing an address or clicking the ... button to choose an object.

 
     [bookmark: pgfId-1820030]Step 6 Specify the Destination Service, UDP or TCP; this must match the source service. You can optionally specify a destination port. Either type in UDP/port or TCP/port, or click the ... button to select a common value or object.

 
     [bookmark: pgfId-1820031]Step 7 Click OK.

 
     [bookmark: pgfId-1820032]Step 8 Click Apply.

 
     [bookmark: pgfId-1820033]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1220477][bookmark: 47786]Monitoring Network Object NAT[bookmark: marker-1220476]

 
    [bookmark: pgfId-1820040]The Monitoring > Properties > Connection Graphs > Xlates pane lets you view the active Network Address Translations in a graphical format. You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
    [bookmark: pgfId-1820041]Fields

 
     
     		 [bookmark: pgfId-1820042]Available Graphs—Lists the components you can graph.

 
    

 
    [bookmark: pgfId-1820046] – Xlate Utilization—Displays the ASA NAT utilization.

 
     
     		 [bookmark: pgfId-1820047]Graph Window Title—Shows the graph window name to which you want to add a graph type. To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title.

 
     		 [bookmark: pgfId-1820048]Add—Click to move the selected entries in the Available Graphs list to the Selected Graphs list.

 
     		 [bookmark: pgfId-1820049]Remove—Click to remove the selected entry from the Selected Graphs list.

 
     		 [bookmark: pgfId-1820050]Show Graphs—Click to display a new or updated graph window.

 
    

 
    [bookmark: pgfId-1820051]The Monitoring > Properties > Connection Graphs > Perfmon pane lets you view the performance information in a graphical format. You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
    [bookmark: pgfId-1820052]Fields

 
     
     		 [bookmark: pgfId-1820053]Available Graphs—Lists the components you can graph.

 
    

 
    [bookmark: pgfId-1820057] – AAA Perfmon—Displays the ASA AAA performance information.

 
    [bookmark: pgfId-1820061] – Inspection Perfmon—Displays the ASA inspection performance information.

 
    [bookmark: pgfId-1820065] – Web Perfmon—Displays the ASA web performance information, including URL access and URL server requests.

 
    [bookmark: pgfId-1820069] – Connections Perfmon—Displays the ASA connections performance information.

 
    [bookmark: pgfId-1820073] – Xlate Perfmon—Displays the ASA NAT performance information.

 
     
     		 [bookmark: pgfId-1820074]Graph Window Title—Shows the graph window name to which you want to add a graph type. To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title. 

 
     		 [bookmark: pgfId-1820075]Add—Click to move the selected entries in the Available Graphs list to the Selected Graphs list.

 
     		 [bookmark: pgfId-1820076]Remove—Click to remove the selected statistic type from the Selected Graphs list.

 
     		 [bookmark: pgfId-1820077]Show Graphs—Click to display a new or updated graph window.

 
    

 
   
 
    
     [bookmark: pgfId-1836227][bookmark: 49240][bookmark: 97834]Configuration Examples for Network Object NAT[bookmark: marker-1836226]

 
    [bookmark: pgfId-1836228]This section includes the following configuration examples:

 
     
     		 [bookmark: pgfId-1836232]Providing Access to an Inside Web Server (Static NAT)

 
     		 [bookmark: pgfId-1836236]NAT for Inside Hosts (Dynamic NAT) and NAT for an Outside Web Server (Static NAT)

 
     		 [bookmark: pgfId-1836240]Inside Load Balancer with Multiple Mapped Addresses (Static NAT, One-to-Many)

 
     		 [bookmark: pgfId-1836244]Single Address for FTP, HTTP, and SMTP (Static NAT-with-Port-Translation)

 
     		 [bookmark: pgfId-1836247]DNS Server on Mapped Interface, Web Server on Real Interface (Static NAT with DNS Modification)

 
     		 [bookmark: pgfId-1836251]DNS Server and FTP Server on Mapped Interface, FTP Server is Translated (Static NAT with DNS Modification)

 
     		 [bookmark: pgfId-1836255]IPv4 DNS Server and FTP Server on Mapped Interface, IPv6 Host on Real Interface (Static NAT64 with DNS64 Modification)

 
    

 
     
      [bookmark: pgfId-1836258][bookmark: 30173]Providing Access to an Inside Web Server (Static NAT)

 
     [bookmark: pgfId-1836259]The following example performs static NAT for an inside web server. The real address is on a private network, so a public address is required. Static NAT is necessary so hosts can initiate traffic to the web server at a fixed address. (See Figure 4-1).

 
     [bookmark: pgfId-1836264]Figure 4-1 [bookmark: 63543]Static NAT for an Inside Web Server

 
      
      [bookmark: pgfId-1836268]  
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1836269]Step 1 Create a network object for the internal web server:

 
     [bookmark: pgfId-1836278] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836279]Step 2 Define the web server address:

 
     [bookmark: pgfId-1836288] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836289]Step 3 Configure static NAT for the object:

 
     [bookmark: pgfId-1836298] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836299]Step 4 Configure the real and mapped interfaces by clicking Advanced:

 
     [bookmark: pgfId-1836303] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836304]Step 5 Click OK to return to the Edit Network Object dialog box, click OK again, and then click Apply.

 
     [bookmark: pgfId-1836305]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1836307][bookmark: 74772]NAT for Inside Hosts (Dynamic NAT) and NAT for an Outside Web Server (Static NAT)

 
     [bookmark: pgfId-1836308]The following example configures dynamic NAT for inside users on a private network when they access the outside. Also, when inside users connect to an outside web server, that web server address is translated to an address that appears to be on the inside network. (See Figure 4-2).

 
     [bookmark: pgfId-1836313]Figure 4-2 [bookmark: 53095]Dynamic NAT for Inside, Static NAT for Outside Web Server

 
     [bookmark: pgfId-1836317] 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1836338]Step 1 Create a network object for the inside network:

 
     [bookmark: pgfId-1836342] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836343]Step 2 Define the addresses for the inside network:

 
     [bookmark: pgfId-1836347] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836348]Step 3 Enable dynamic NAT for the inside network:

 
     [bookmark: pgfId-1836357] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836358]Step 4 For the Translated Addr field, add a new network object for the dynamic NAT pool to which you want to translate the inside addresses by clicking the browse button.

 
     [bookmark: pgfId-1836359] a. Add the new network object.

 
     [bookmark: pgfId-1836363] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836364] b. Define the NAT pool addresses, and click OK.

 
     [bookmark: pgfId-1836368] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836369] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1836373] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836374]Step 5 Configure the real and mapped interfaces by clicking Advanced:

 
     [bookmark: pgfId-1836378] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836379]Step 6 Click OK to return to the Edit Network Object dialog box, click then click OK again to return to the NAT Rules table.

 
     [bookmark: pgfId-1836380]Step 7 Create a network object for the outside web server:

 
     [bookmark: pgfId-1836389] 
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     [bookmark: pgfId-1836390]Step 8 Define the web server address:

 
     [bookmark: pgfId-1836399] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836400]Step 9 Configure static NAT for the web server:

 
     [bookmark: pgfId-1836409] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836410]Step 10 Configure the real and mapped interfaces by clicking Advanced:

 
     [bookmark: pgfId-1836414] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836415]Step 11 Click OK to return to the Edit Network Object dialog box, click OK again, and then click Apply.

 
     [bookmark: pgfId-1836416]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1836418][bookmark: 56270]Inside Load Balancer with Multiple Mapped Addresses (Static NAT, One-to-Many)

 
     [bookmark: pgfId-1836419]The following example shows an inside load balancer that is translated to multiple IP addresses. When an outside host accesses one of the mapped IP addresses, it is untranslated to the single load balancer address. Depending on the URL requested, it redirects traffic to the correct web server. (See Figure 4-3).

 
     [bookmark: pgfId-1836424]Figure 4-3 [bookmark: 58609]Static NAT with One-to-Many for an Inside Load Balancer

 
     [bookmark: pgfId-1836428] 
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     [bookmark: pgfId-1836445]Step 1 Create a network object for the load balancer:

 
     [bookmark: pgfId-1836449] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836450]Step 2 Define the load balancer address:

 
     [bookmark: pgfId-1836459] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836460]Step 3 Configure static NAT for the load balancer:

 
     [bookmark: pgfId-1836469] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836470]Step 4 For the Translated Addr field, add a new network object for the static NAT group of addresses to which you want to translate the load balancer address by clicking the browse button.

 
     [bookmark: pgfId-1836471] a. Add the new network object.

 
     [bookmark: pgfId-1836475] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836476] b. Define the static NAT group of addresses, and click OK.

 
     [bookmark: pgfId-1836480] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836481] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1836485] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836486]Step 5 Configure the real and mapped interfaces by clicking Advanced:

 
     [bookmark: pgfId-1836490] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836491]Step 6 Click OK to return to the Edit Network Object dialog box, click OK again, and then click Apply.

 
     [bookmark: pgfId-1836492]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1836494][bookmark: 67001]Single Address for FTP, HTTP, and SMTP (Static NAT-with-Port-Translation)

 
     [bookmark: pgfId-1836495]The following static NAT-with-port-translation example provides a single address for remote users to access FTP, HTTP, and SMTP. These servers are actually different devices on the real network, but for each server, you can specify static NAT-with-port-translation rules that use the same mapped IP address, but different ports. (See Figure 4-4.)

 
     [bookmark: pgfId-1836500]Figure 4-4 [bookmark: 40720]Static NAT-with-Port-Translation

 
     [bookmark: pgfId-1836504] 
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     [bookmark: pgfId-1836505]Step 1 Create a network object for the FTP server address:

 
     [bookmark: pgfId-1836514] 
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     [bookmark: pgfId-1836515]Step 2 Define the FTP server address, and configure static NAT with identity port translation for the FTP server:

 
     [bookmark: pgfId-1836528] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836529]Step 3 Click Advanced to configure the real and mapped interfaces and port translation for FTP.

 
     [bookmark: pgfId-1836533] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836534]Step 4 Create a network object for the HTTP server address:

 
     [bookmark: pgfId-1836543] 
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     [bookmark: pgfId-1836544]Step 5 Define the HTTP server address, and configure static NAT with identity port translation for the HTTP server:

 
     [bookmark: pgfId-1836557] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836558]Step 6 Click Advanced to configure the real and mapped interfaces and port translation for HTTP.

 
     [bookmark: pgfId-1836562] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836563]Step 7 Create a network object for the SMTP server address:

 
     [bookmark: pgfId-1836572] 
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     [bookmark: pgfId-1836573]Step 8 Define the SMTP server address, and configure static NAT with identity port translation for the SMTP server:

 
     [bookmark: pgfId-1836586] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836587]Step 9 Click Advanced to configure the real and mapped interfaces and port translation for SMTP.

 
     [bookmark: pgfId-1836591] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836592]Step 10 Click OK to return to the Edit Network Object dialog box, click OK again, and then click Apply.

 
     [bookmark: pgfId-1836593]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1836595][bookmark: 87185]DNS Server on Mapped Interface, Web Server on Real Interface (Static NAT with DNS Modification)

 
     [bookmark: pgfId-1836596]For example, a DNS server is accessible from the outside interface. A server, ftp.cisco.com, is on the inside interface. You configure the ASA to statically translate the ftp.cisco.com real address (10.1.3.14) to a mapped address (209.165.201.10) that is visible on the outside network. (See Figure 4-5.) In this case, you want to enable DNS reply modification on this static rule so that inside users who have access to ftp.cisco.com using the real address receive the real address from the DNS server, and not the mapped address.

 
     [bookmark: pgfId-1836603]When an inside host sends a DNS request for the address of ftp.cisco.com, the DNS server replies with the mapped address (209.165.201.10). The ASA refers to the static rule for the inside server and translates the address inside the DNS reply to 10.1.3.14. If you do not enable DNS reply modification, then the inside host attempts to send traffic to 209.165.201.10 instead of accessing ftp.cisco.com directly.

 
     [bookmark: pgfId-1836608]Figure 4-5 [bookmark: 80741]DNS Reply Modification

 
     [bookmark: pgfId-1836612] 
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     [bookmark: pgfId-1836613]Step 1 Create a network object for the FTP server address:

 
     [bookmark: pgfId-1836622] 
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     [bookmark: pgfId-1836623]Step 2 Define the FTP server address, and configure static NAT with DNS modification:

 
     [bookmark: pgfId-1836636] 
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     [bookmark: pgfId-1836637]Step 3 Click Advanced to configure the real and mapped interfaces and DNS modification.

 
     [bookmark: pgfId-1836641] 
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     [bookmark: pgfId-1836642]Step 4 Click OK to return to the Edit Network Object dialog box, click OK again, and then click Apply.

 
     [bookmark: pgfId-1836643]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1836645][bookmark: 28368]DNS Server and FTP Server on Mapped Interface, FTP Server is Translated (Static NAT with DNS Modification)

 
     [bookmark: pgfId-1836652]Figure 4-6 shows an FTP server and DNS server on the outside. The ASA has a static translation for the outside server. In this case, when an inside user requests the address for ftp.cisco.com from the DNS server, the DNS server responds with the real address, 209.165.201.10. Because you want inside users to use the mapped address for ftp.cisco.com (10.1.2.56) you need to configure DNS reply modification for the static translation.

 
     [bookmark: pgfId-1836654]Figure 4-6 [bookmark: 32827]DNS Reply Modification Using Outside NAT

 
     [bookmark: pgfId-1836658] 
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     [bookmark: pgfId-1836659]Step 1 Create a network object for the FTP server address:

 
     [bookmark: pgfId-1836668] 
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     [bookmark: pgfId-1836669]Step 2 Define the FTP server address, and configure static NAT with DNS modification:

 
     [bookmark: pgfId-1836682] 
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     [bookmark: pgfId-1836683]Step 3 Click Advanced to configure the real and mapped interfaces and DNS modification.

 
     [bookmark: pgfId-1836687] 
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     [bookmark: pgfId-1836688]Step 4 Click OK to return to the Edit Network Object dialog box, click OK again, and then click Apply.

 
     [bookmark: pgfId-1836689]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1836691]IPv4 [bookmark: 90025]DNS Server and FTP Server on Mapped Interface, IPv6 Host on Real Interface (Static NAT64 with DNS64 Modification)

 
     [bookmark: pgfId-1836698]Figure 4-6 shows an FTP server and DNS server on the outside IPv4 network. The ASA has a static translation for the outside server. In this case, when an inside IPv6 user requests the address for ftp.cisco.com from the DNS server, the DNS server responds with the real address, 209.165.200.225. Because you want inside users to use the mapped address for ftp.cisco.com (2001:DB8::D1A5:C8E1) you need to configure DNS reply modification for the static translation. This example also includes a static NAT translation for the DNS server, and a PAT rule for the inside IPv6 hosts.

 
     [bookmark: pgfId-1836699]Figure 4-7 DNS Reply Modification Using Outside NAT

 
     [bookmark: pgfId-1836703] 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1836704]Step 1 Configure static NAT with DNS modification for the FTP server.

 
     [bookmark: pgfId-1836705] a. Create a network object for the FTP server address.

 
     [bookmark: pgfId-1836714] 
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     [bookmark: pgfId-1836715] b. Define the FTP server address, and configure static NAT with DNS modification and, because this is a one-to-one translation, configure the one-to-one method for NAT46.

 
     [bookmark: pgfId-1836728] 
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     [bookmark: pgfId-1836729] c. Click Advanced to configure the real and mapped interfaces and DNS modification.

 
     [bookmark: pgfId-1836733] 
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     [bookmark: pgfId-1836734] d. Click OK to return to the Edit Network Object dialog box.

 
     [bookmark: pgfId-1836735]Step 2 Configure NAT for the DNS server.

 
     [bookmark: pgfId-1836736] a. Create a network object for the DNS server address.

 
     [bookmark: pgfId-1836742] b. Define the DNS server address, and configure static NAT using the one-to-one method.

 
     [bookmark: pgfId-1836755] 
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     [bookmark: pgfId-1836756] c. Click Advanced to configure the real and mapped interfaces.

 
     [bookmark: pgfId-1836760] 
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     [bookmark: pgfId-1836761] d. Click OK to return to the Edit Network Object dialog box.

 
     [bookmark: pgfId-1836762]Step 3 Configure an IPv4 PAT pool for translating the inside IPv6 network.

 
     [bookmark: pgfId-1836775] 
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     [bookmark: pgfId-1836776]Under NAT, uncheck the Add Automatic Address Translation Rules check box.

 
     [bookmark: pgfId-1836780] 
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     [bookmark: pgfId-1836781]Step 4 Configure PAT for the inside IPv6 network.

 
     [bookmark: pgfId-1836782] a. Create a network object for the inside IPv6 network.

 
     [bookmark: pgfId-1836788] b. Define the IPv6 network address, and configure dynamic NAT using a PAT pool.

 
     [bookmark: pgfId-1836801] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1836802] c. Next to the PAT Pool Translated Address field, click the ... button to choose the PAT pool you created earlier, and click OK.

 
     [bookmark: pgfId-1836806] 
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     [bookmark: pgfId-1836807] d. Click Advanced to configure the real and mapped interfaces.

 
     [bookmark: pgfId-1836811] 
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     [bookmark: pgfId-1836812] e. Click OK to return to the Edit Network Object dialog box.

 
     [bookmark: pgfId-1836813]Step 5 Click OK, and then click Apply.

 
     [bookmark: pgfId-1836814]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1140519][bookmark: 92503]Feature History for Network Object NAT

 
    [bookmark: pgfId-1090228]Table 4-1 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1068794] 

 
     
      
       
       [bookmark: pgfId-1090235]Table 4-1 [bookmark: 50557]Feature History for Network Object NAT 

 
       
       
        
        		 
          
          [bookmark: pgfId-1090241]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1090243]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1090245]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1090247]Network Object NAT

  
        		[bookmark: pgfId-1090250]8.3(1)

  
        		[bookmark: pgfId-1090252]Configures NAT for a network object IP address(es).

 [bookmark: pgfId-1090254]We introduced or modified the following screens:
Configuration > Firewall > NAT Rules
Configuration > Firewall > Objects > Network Objects/Groups

  
       

 
        
        		[bookmark: pgfId-1299705]Identity NAT configurable proxy ARP and route lookup

  
        		[bookmark: pgfId-1299711]8.4(2)/8.5(1)

  
        		[bookmark: pgfId-1299761]In earlier releases for identity NAT, proxy ARP was disabled, and a route lookup was always used to determine the egress interface. You could not configure these settings. In 8.4(2) and later, the default behavior for identity NAT was changed to match the behavior of other static NAT configurations: proxy ARP is enabled, and the NAT configuration determines the egress interface (if specified) by default. You can leave these settings as is, or you can enable or disable them discretely. Note that you can now also disable proxy ARP for regular static NAT.

 [bookmark: pgfId-1299762]When upgrading to 8.4(2) from 8.3(1), 8.3(2), and 8.4(1), all identity NAT configurations will now include the no-proxy-arp and route-lookup keywords, to maintain existing functionality.

 [bookmark: pgfId-1299764]We modified the following screen: Configuration > Firewall > NAT Rules > Add/Edit Network Object > Advanced NAT Settings.

  
       

 
        
        		[bookmark: pgfId-1309913]PAT pool and round robin address assignment

  
        		[bookmark: pgfId-1309968]8.4(2)/8.5(1)

  
        		[bookmark: pgfId-1309955]You can now specify a pool of PAT addresses instead of a single address. You can also optionally enable round-robin assignment of PAT addresses instead of first using all ports on a PAT address before using the next address in the pool. These features help prevent a large number of connections from a single PAT address from appearing to be part of a DoS attack and makes configuration of large numbers of PAT addresses easy.

 [bookmark: pgfId-1309957]We modified the following screens: Configuration > Firewall > NAT Rules > Add/Edit Network Object.

  
       

 
        
        		[bookmark: pgfId-1427014]Round robin PAT pool allocation uses the same IP address for existing hosts

  
        		[bookmark: pgfId-1427016]8.4(3)

  
        		[bookmark: pgfId-1433651]When using a PAT pool with round robin allocation, if a host has an existing connection, then subsequent connections from that host will use the same PAT IP address if ports are available.

 [bookmark: pgfId-1820440]We did not modify any screens.

 [bookmark: pgfId-1427064]This feature is not available in 8.5(1) or 8.6(1).

  
       

 
        
        		[bookmark: pgfId-1427100]Flat range of PAT ports for a PAT pool

  
        		[bookmark: pgfId-1427102]8.4(3)

  
        		[bookmark: pgfId-1427104]If available, the real source port number is used for the mapped port. However, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 0 to 511, 512 to 1023, and 1024 to 65535. Therefore, ports below 1024 have only a small PAT pool.

 [bookmark: pgfId-1427248]If you have a lot of traffic that uses the lower port ranges, when using a PAT pool, you can now specify a flat range of ports to be used instead of the three unequal-sized tiers: either 1024 to 65535, or 1 to 65535.

 [bookmark: pgfId-1433712]We modified the following screens: Configuration > Firewall > NAT Rules > Add/Edit Network Object.

 [bookmark: pgfId-1433253]This feature is not available in 8.5(1) or 8.6(1).

  
       

 
        
        		[bookmark: pgfId-1433201]Extended PAT for a PAT pool

  
        		[bookmark: pgfId-1433222]8.4(3)

  
        		[bookmark: pgfId-1433356]Each PAT IP address allows up to 65535 ports. If 65535 ports do not provide enough translations, you can now enable extended PAT for a PAT pool. Extended PAT uses 65535 ports per service, as opposed to per IP address, by including the destination address and port in the translation information.

 [bookmark: pgfId-1433772]We modified the following screens: Configuration > Firewall > NAT Rules > Add/Edit Network Object.

 [bookmark: pgfId-1433275]This feature is not available in 8.5(1) or 8.6(1).

  
       

 
        
        		[bookmark: pgfId-1467929]Automatic NAT rules to translate a VPN peer’s local IP address back to the peer’s real IP address

  
        		[bookmark: pgfId-1467931]8.4(3)

  
        		[bookmark: pgfId-1489788]In rare situations, you might want to use a VPN peer’s real IP address on the inside network instead of an assigned local IP address. Normally with VPN, the peer is given an assigned local IP address to access the inside network. However, you might want to translate the local IP address back to the peer’s real public IP address if, for example, your inside servers and network security is based on the peer’s real IP address.

 [bookmark: pgfId-1467934]You can enable this feature on one interface per tunnel group. Object NAT rules are dynamically added and deleted when the VPN session is established or disconnected. You can view the rules using the show nat command.

 [bookmark: pgfId-1467935]Note Because of routing issues, we do not recommend using this feature unless you know you need this feature; contact Cisco TAC to confirm feature compatibility with your network. See the following limitations:

 
          
          		 [bookmark: pgfId-1467936]Only supports Cisco IPsec and AnyConnect Client.

 
          		 [bookmark: pgfId-1467937]Return traffic to the public IP addresses must be routed back to the ASA so the NAT policy and VPN policy can be applied.

 
          		 [bookmark: pgfId-1467941]Does not support load-balancing (because of routing issues).

 
          		 [bookmark: pgfId-1467942]Does not support roaming (public IP changing).

 
         

 [bookmark: pgfId-1467944]ASDM does not support this command; enter the command using the Command Line Tool.

  
       

 
        
        		[bookmark: pgfId-1532354]NAT support for IPv6

  
        		[bookmark: pgfId-1532313]9.0(1)

  
        		[bookmark: pgfId-1532345]NAT now supports IPv6 traffic, as well as translating between IPv4 and IPv6. Translating between IPv4 and IPv6 is not supported in transparent mode.

 [bookmark: pgfId-1532347]We modified the following screen: Configuration > Firewall > Objects > Network Objects/Group.

  
       

 
        
        		[bookmark: pgfId-1784367]NAT support for reverse DNS lookups

  
        		[bookmark: pgfId-1784369]9.0(1)

  
        		[bookmark: pgfId-1784371]NAT now supports translation of the DNS PTR record for reverse DNS lookups when using IPv4 NAT, IPv6 NAT, and NAT64 with DNS inspection enabled for the NAT rule.

  
       

 
        
        		[bookmark: pgfId-1532368]Per-session PAT

  
        		[bookmark: pgfId-1532370]9.0(1)

  
        		[bookmark: pgfId-1532372]The per-session PAT feature improves the scalability of PAT and, for clustering, allows each member unit to own PAT connections; multi-session PAT connections have to be forwarded to and owned by the master unit. At the end of a per-session PAT session, the ASA sends a reset and immediately removes the xlate. This reset causes the end node to immediately release the connection, avoiding the TIME_WAIT state. Multi-session PAT, on the other hand, uses the PAT timeout, by default 30 seconds. For “hit-and-run” traffic, such as HTTP or HTTPS, the per-session feature can dramatically increase the connection rate supported by one address. Without the per-session feature, the maximum connection rate for one address for an IP protocol is approximately 2000 per second. With the per-session feature, the connection rate for one address for an IP protocol is 65535/average-lifetime.

 [bookmark: pgfId-1532376]By default, all TCP traffic and UDP DNS traffic use a per-session PAT xlate. For traffic that requires multi-session PAT, such as H.323, SIP, or Skinny, you can disable per-session PAT by creating a per-session deny rule.

 [bookmark: pgfId-1532378]We introduced the following screen: Configuration > Firewall > Advanced > Per-Session NAT Rules.
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     [bookmark: pgfId-1002608][bookmark: 56368]Configuring Filtering Services 
      
      
 
     
 

 
    [bookmark: pgfId-1069328]This chapter describes how to use filtering services to provide greater control over traffic passing through the ASA and includes the following sections:

 
     
     		 [bookmark: pgfId-1069874]Information About Web Traffic Filtering

 
     		 [bookmark: pgfId-1281433]Configuring Filtering Rules

 
     		 [bookmark: pgfId-1281437]Filtering the Rule Table

 
     		 [bookmark: pgfId-1281441]Defining Queries

 
     		 [bookmark: pgfId-1069340]Filtering URLs and FTP Requests with an External Server 

 
    

 
   
 
    
     [bookmark: pgfId-1069318][bookmark: 1H_Head1. Information About Web Traffic Filtering]Information About Web Traffic Filtering

 
    [bookmark: pgfId-1069566]You can use web traffic filtering in two distinct ways:

 
     
     		 [bookmark: pgfId-1054225]Filtering ActiveX objects or Java applets

 
     		 [bookmark: pgfId-1054226]Filtering with an external filtering server

 
    

 
    [bookmark: pgfId-1054227]Instead of blocking access altogether, you can remove specific undesirable objects from web traffic, such as ActiveX objects or Java applets, that may pose a security threat in certain situations. 

 
    [bookmark: pgfId-1054228][bookmark: marker-1085650]You can use web traffic filtering to direct specific traffic to an external filtering server, such an Secure Computing SmartFilter (formerly N2H2) or the Websense filtering server. You can enable long URL, HTTPS, and FTP filtering using either Websense or Secure Computing SmartFilter for web traffic filtering. Filtering servers can block traffic to specific sites or types of sites, as specified by the security policy.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1054229]Note URL caching will only work if the version of the URL server software from the URL server vendor supports it.

 
     
     
 
    
 
    

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1301585]Model 
         
  
        		 
          
          [bookmark: pgfId-1301587]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1301589]All models

  
        		[bookmark: pgfId-1301591]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1045692][bookmark: 20299]Filtering URLs and FTP Requests with an External Server

 
    [bookmark: pgfId-1045693]This section describes how to filter URLs and FTP requests with an external server and includes the following topics:

 
     
     		 [bookmark: pgfId-1074143]Information About URL Filtering

 
     		 [bookmark: pgfId-1074210]Licensing Requirements for URL Filtering

 
     		 [bookmark: pgfId-1074144]Guidelines and Limitations for URL Filtering

 
     		 [bookmark: pgfId-1074148]Identifying the Filtering Server

 
     		 [bookmark: pgfId-1079666]Configuring Additional URL Filtering Settings

 
     		 [bookmark: pgfId-1079907]Feature History for URL Filtering

 
    

 
     
      [bookmark: pgfId-1042342][bookmark: 2H_Head2. Information About URL Filtering]Information About [bookmark: 87358]URL Filtering 

 
     [bookmark: pgfId-1056274]You can apply filtering to connection requests originating from a more secure network to a less secure network. Although you can use ACLs to prevent outbound access to specific content servers, managing usage this way is difficult because of the size and dynamic nature of the Internet. You can simplify configuration and improve ASA performance by using a separate server running one of the following Internet filtering products: [bookmark: marker-1085681]

 
      
      		 [bookmark: pgfId-1056280]Websense Enterprise for filtering HTTP, HTTPS, and FTP. 

 
      		 [bookmark: pgfId-1074271]McAfee SmartFilter (formerly N2H2) for filtering HTTP, HTTPS, FTP, and long URL filtering. 

 
     

 
     [bookmark: pgfId-1170339]In long URLs, the URL in the Referer field might contain a “host:” text string, which could cause the HTTP GET header to be incorrectly parsed as containing the HTTP Host parameter. The ASA, however, correctly parses the Referer field even when it contains a “host:” text string and forwards the header to the McAfee SmartFilter server with the correct Referer URL.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1170265]Note URL caching will only work if the version of the URL server software from the URL server vendor supports it. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1170269]Although ASA performance is less affected when using an external server, you might notice longer access times to websites or FTP servers when the filtering server is remote from the ASA. [bookmark: wp1042366]

 
     [bookmark: pgfId-1056304]When filtering is enabled and a request for content is directed through the ASA, the request is sent to the content server and to the filtering server at the same time. If the filtering server allows the connection, the ASA forwards the response from the content server to the originating client. If the filtering server denies the connection, the ASA drops the response and sends a message or return code indicating that the connection was not successful. [bookmark: wp1042379]

 
     [bookmark: pgfId-1074079]If user authentication is enabled on the ASA, then the ASA also sends the username to the filtering server. The filtering server can use user-specific filtering settings or provide enhanced reporting about usage. [bookmark: marker-1074080][bookmark: marker-1074081][bookmark: marker-1074082]

 
    
 
     
      [bookmark: pgfId-1057480][bookmark: 2H_Head2. Licensing Requirements for URL Filtering]Licensing Requirements for URL Filtering

 
     [bookmark: pgfId-1057481]The following table shows the licensing requirements for URL filtering:

 
     [bookmark: pgfId-1057495] 

 
      
       
        
        [bookmark: pgfId-1057484]Table 29-3 Licensing Requirements

 
        
        
         
         		 
           
           [bookmark: pgfId-1057488]Model 
          
  
         		 
           
           [bookmark: pgfId-1057490]License Requirement 
          
  
        

 
         
         		[bookmark: pgfId-1057492]All models

  
         		[bookmark: pgfId-1057494]Base License.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1074002][bookmark: 2H_Head2. Guidelines and Limitations for URL Filtering]Guidelines and Limitations for URL Filtering

 
     [bookmark: pgfId-1074003]This section includes the guidelines and limitations for this feature.

 
     [bookmark: pgfId-1074005]Context Mode Guidelines

 
     [bookmark: pgfId-1074006]Supported in single and multiple context mode.

 
     [bookmark: pgfId-1074008]Firewall Mode Guidelines

 
     [bookmark: pgfId-1074009]Supported in routed and transparent firewall mode.

 
     [bookmark: pgfId-1074010]IPv6 Guidelines

 
     [bookmark: pgfId-1074011]Does not support IPv6.

 
    
 
     
      [bookmark: pgfId-1042420][bookmark: 23060][bookmark: 27730]Identifying the Filtering Server

 
     [bookmark: pgfId-1042424]You can identify up to four filtering servers per context. The ASA uses the servers in order until a server responds. In single mode, a maximum of 16 of the same type of filtering servers are allowed. You can only configure a single type of server (Websense or Secure Computing SmartFilter) in your configuration.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1070617]Note You must add the filtering server before you can configure filtering for HTTP or HTTPS. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1070618]To specify the external filtering server, perform the following steps:

 
     
 
     [bookmark: pgfId-1281452]Step 1 In the ASDM main window, choose Configuration > Firewall > URL Filtering Servers.

 
     [bookmark: pgfId-1281453]Step 2 In the URL Filtering Server Type area, click one of the following options:

 
      
       
       		 [bookmark: pgfId-1281455] Websense [bookmark: marker-1281454]

 
       		 [bookmark: pgfId-1281457] Secure Computing SmartFilter [bookmark: marker-1281456]

 
      

 
     

 
     [bookmark: pgfId-1281458]Step 3 If you chose the second option, enter the Secure Computing SmartFilter port number if it is different than the default port number, which is 4005.

 
     [bookmark: pgfId-1281461]Step 4 In the URL Filtering Servers area, click Add. 

 
     [bookmark: pgfId-1281462]If you chose the Websense option, the Add Parameters for Websense URL Filtering dialog box appears.

 
      
       
       		 [bookmark: pgfId-1281463]Choose the interface on which the URL filtering server is connected from the drop-down list.

 
       		 [bookmark: pgfId-1281464]Enter the IP address of the URL filtering server.

 
       		 [bookmark: pgfId-1281465]Enter the number of seconds after which the request to the URL filtering server times out. The default is 30 seconds.

 
       		 [bookmark: pgfId-1281466]In the Protocol area, to specify which TCP version to use to communicate with the URL filtering server, click one of the following radio buttons:

 
      

 
     

 
     [bookmark: pgfId-1281467] – TCP 1

 
     [bookmark: pgfId-1281468] – TCP 4

 
     [bookmark: pgfId-1281469] – UDP 4

 
      
       
       		 [bookmark: pgfId-1281470]Enter the maximum number of TCP connections allowed for communicating with the URL filtering server, and click  OK .

 
      

 
     

 
     [bookmark: pgfId-1281471]The new Websense URL filtering server properties appear in the URL Filtering Servers pane. To change these properties, click Edit. To add more Websense URL filtering servers after you have added the first Websense URL filtering server, click Add or Insert. To remove a Websense URL filtering server, click Delete.

 
     [bookmark: pgfId-1281472]If you chose the Secure Computing SmartFilter URL Filtering option, the Add Parameters for Secure Computing SmartFilter URL Filtering dialog box appears.

 
      
       
       		 [bookmark: pgfId-1281473]Choose the interface on which the URL filtering server is connected from the drop-down list.

 
       		 [bookmark: pgfId-1281474]Enter the IP address of the URL filtering server.

 
       		 [bookmark: pgfId-1281475]Enter the number of seconds after which the request to the URL filtering server times out. The default is 30 seconds.

 
       		 [bookmark: pgfId-1281476]In the Protocol area, to specify which protocol type to use to communicate with the URL filtering server, click one of the following radio buttons:

 
      

 
     

 
     [bookmark: pgfId-1281477] – TCP 

 
     [bookmark: pgfId-1281478] – UDP 

 
      
       
       		 [bookmark: pgfId-1281479]Enter the maximum number of TCP connections allowed for communicating with the URL filtering server, and click  OK .

 
      

 
     

 
     [bookmark: pgfId-1281480]The new Secure Computing SmartFilter URL filtering server properties appear in the URL Filtering Servers pane. To change these properties, click Edit. To add more Secure Computing SmartFilter URL filtering servers after you have defined the first Secure Computing SmartFilter URL filtering server, click Add or Insert. To remove a Secure Computing SmartFilter URL filtering server, click Delete.

 
     [bookmark: pgfId-1281481]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1076343][bookmark: 2H_Head2. Configuring Additional URL Filtering Settings]Configuring Additional URL Filtering Settings

 
     [bookmark: pgfId-1076462]After you have accessed a website, the filtering server can allow the ASA to cache the server address for a certain period of time, as long as each website hosted at the address is in a category that is permitted at all times. When you access the server again, or if another user accesses the server, the ASA does not need to consult the filtering server again to obtain the server address.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1076466]Note Requests for cached IP addresses are not passed to the filtering server and are not logged. As a result, this activity does not appear in any reports.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1076552]This section describes how to configure additional URL filtering settings and includes the following topics:

 
      
      		 [bookmark: pgfId-1076571]Buffering the Content Server Response

 
      		 [bookmark: pgfId-1076644]Caching Server Addresses

 
      		 [bookmark: pgfId-1079377]Filtering HTTP URLs

 
     

 
    
 
     
      [bookmark: pgfId-1079380][bookmark: 66124]Buffering the Content Server Response

 
     [bookmark: pgfId-1076262]When you issue a request to connect to a content server, the ASA sends the request to the content server and to the filtering server at the same time. If the filtering server does not respond before the content server, the server response is dropped. This behavior delays the web server response for the web client, because the web client must reissue the request. 

 
     [bookmark: pgfId-1077560]By enabling the HTTP response buffer, replies from web content servers are buffered, and the responses are forwarded to the requesting client if the filtering server allows the connection. This behavior prevents the delay that might otherwise occur.

 
     [bookmark: pgfId-1077561]To configure buffering for responses to HTTP or FTP requests, perform the following steps:

 
     
 
     [bookmark: pgfId-1281491]Step 1 In the URL Filtering Servers pane, click Advanced to display the Advanced URL Filtering dialog box.

 
     [bookmark: pgfId-1281492]Step 2 In the URL Buffer Size area, check the Enable buffering check box.

 
     [bookmark: pgfId-1281493]Step 3 Enter the number of 1550-byte buffers. Valid values range from 1 to 128.

 
     [bookmark: pgfId-1281494]Step 4 Click OK to close this dialog box.

 
     [bookmark: pgfId-1281495]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1042499][bookmark: 22653]Caching Server Addresses

 
     [bookmark: pgfId-1042503]After you access a website, the filtering server can allow the ASA to cache the server address for a certain period of time, as long as each website hosted at the address is in a category that is permitted at all times. When you access the server again, or if another user accesses the server, the ASA does not need to consult the filtering server again.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1042507]Note Requests for cached IP addresses are not passed to the filtering server and are not logged. As a result, this activity does not appear in any reports. You can accumulate Websense run logs before using the url-cache command.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1042508]To improve throughput, perform the following steps:

 
     
 
     [bookmark: pgfId-1281505]Step 1 In the URL Filtering Servers pane, click Advanced to display the Advanced URL Filtering dialog box.

 
     [bookmark: pgfId-1281506]Step 2 In the URL Cache Size area, check the Enable caching based on check box to enable caching according to the specified criteria.

 
     [bookmark: pgfId-1281507]Step 3 Click one of the following radio buttons:

 
      
       
       		 [bookmark: pgfId-1281508]Destination Address—This option caches entries according to the URL destination address. Choose this setting if all users share the same URL filtering policy on the Websense server.

 
       		 [bookmark: pgfId-1281509]Source/Destination Address—This option caches entries according to both the source address that initiates the URL request and the URL destination address. Choose this setting if users do not share the same URL filtering policy on the server.

 
      

 
     

 
     [bookmark: pgfId-1281510]Step 4 Enter the cache size within the range from 1 to 128 (KB).

 
     [bookmark: pgfId-1281511]Step 5 Click OK to close this dialog box.

 
     [bookmark: pgfId-1281512]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1077339][bookmark: 80626]Filtering HTTP URLs

 
     [bookmark: pgfId-1077340]This section describes how to configure HTTP filtering with an external filtering server and includes the following topics:

 
      
      		 [bookmark: pgfId-1042528]Enabling Filtering of Long HTTP URLs

 
     

 
    
 
     
      [bookmark: pgfId-1042559][bookmark: 36527]Enabling Filtering of Long HTTP URLs

 
     [bookmark: pgfId-1042563]By default, the ASA considers an HTTP URL to be a long URL if it is greater than 1159 characters. You can increase the maximum length allowed.

 
     [bookmark: pgfId-1042564]To configure the maximum size of a single URL, perform the following steps:

 
     
 
     [bookmark: pgfId-1281522]Step 1 In the URL Filtering Servers pane, click Advanced to display the Advanced URL Filtering dialog box.

 
     [bookmark: pgfId-1281523]Step 2 In the Long URL Support area, check the Use Long URL check box to enable long URLs for filtering servers.

 
     [bookmark: pgfId-1281524]Step 3 Enter the maximum URL length allowed, up to a maximum of 4 KB.

 
     [bookmark: pgfId-1281525]Step 4 Enter the memory allocated for long URLs in KB.

 
     [bookmark: pgfId-1281526]Step 5 Click OK to close this dialog box.

 
     [bookmark: pgfId-1281527]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1281535][bookmark: 34900][bookmark: 82564][bookmark: 14347][bookmark: 2H_Head2. Configuring Filtering Rules]Configuring Filtering Rules

 
     [bookmark: pgfId-1281536]Before you can add an HTTP, HTTPS, or FTP filter rule, you must enable a URL filtering server. To enable a URL filtering server, choose Configuration > Firewall > URL Filtering Servers.

 
     [bookmark: pgfId-1281538]To configure filtering rules, perform the following steps:[bookmark: marker-1281537]

 
     
 
     [bookmark: pgfId-1281539]Step 1 From the ASDM main window, choose Configuration > Firewall > Filter Rules.

 
     [bookmark: pgfId-1281540]Step 2 In the toolbar, click Add to display the types of filter rules that are available to add from the following list:

 
      
       
       		 [bookmark: pgfId-1281541]Add Filter ActiveX Rule

 
       		 [bookmark: pgfId-1281542]Add Filter Java Rule

 
       		 [bookmark: pgfId-1281543]Add Filter HTTP Rule

 
       		 [bookmark: pgfId-1281544]Add Filter HTTPS Rule

 
       		 [bookmark: pgfId-1281545]Add Filter FTP Rule

 
      

 
     

 
     [bookmark: pgfId-1281546]Step 3 If you chose Add Filter ActiveX Rule, specify the following settings:

 
      
       
       		 [bookmark: pgfId-1281547]Click one of the following radio buttons:  Filter ActiveX or  Do not filter ActiveX .

 
       		 [bookmark: pgfId-1281548]Enter the source of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281549] – Enter any to indicate any source address.

 
     [bookmark: pgfId-1281550] – Enter a hostname.

 
     [bookmark: pgfId-1281551] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281552] – Click the ellipses to display the Browse Source dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281553]Enter the destination of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281554] – Enter any to indicate any destination address.

 
     [bookmark: pgfId-1281555] – Enter a hostname.

 
     [bookmark: pgfId-1281556] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281557] – Click the ellipses to display the Browse Destination dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281558]Identify the service of the traffic to which the filtering action applies. To identify the service, enter one of the following:

 
      

 
     

 
     [bookmark: pgfId-1281559] – tcp/port—The port number can range from 1 to 65535. Additionally, you can use the following modifiers with the TCP service:

 
     [bookmark: pgfId-1281560]!=—Not equal to. For example, !=tcp/443.

 
     [bookmark: pgfId-1281561]<—Less than. For example, <tcp/2000.

 
     [bookmark: pgfId-1281562]>—Greater than. For example, >tcp/2000.

 
     [bookmark: pgfId-1281563]- —Range. For example, tcp/2000-3000.

 
     [bookmark: pgfId-1281564] – Enter a well-known service name, such as HTTP or FTP.

 
     [bookmark: pgfId-1281565] – Click the ellipses to display the Browse Service dialog box. Choose a service from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281566]Click  OK to close this dialog box.

 
       		 [bookmark: pgfId-1281567]Click  Apply to save your changes.

 
      

 
     

 
     [bookmark: pgfId-1281568]Step 4 If you chose Add Filter Java Rule, specify the following settings:

 
      
       
       		 [bookmark: pgfId-1281569]Click one of the following radio buttons:  Filter Java or  Do not filter Java .

 
       		 [bookmark: pgfId-1281570]Enter the source of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281571] – Enter any to indicate any source address.

 
     [bookmark: pgfId-1281572] – Enter a hostname.

 
     [bookmark: pgfId-1281573] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281574] – Click the ellipses to display the Browse Source dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281575]Enter the destination of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281576] – Enter any to indicate any destination address.

 
     [bookmark: pgfId-1281577] – Enter a hostname.

 
     [bookmark: pgfId-1281578] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281579] – Click the ellipses to display the Browse Destination dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281580]Identify the service of the traffic to which the filtering action applies. To identify the service, enter one of the following:

 
      

 
     

 
     [bookmark: pgfId-1281581] – tcp/port—The port number can be from 1 to 65535. Additionally, you can use the following modifiers with the TCP service:

 
     [bookmark: pgfId-1281582]!=—Not equal to. For example, !=tcp/443.

 
     [bookmark: pgfId-1281583]<—Less than. For example, <tcp/2000.

 
     [bookmark: pgfId-1281584]>—Greater than. For example, >tcp/2000.

 
     [bookmark: pgfId-1281585]- —Range. For example, tcp/2000-3000.

 
     [bookmark: pgfId-1281586] – Enter a well-known service name, such as HTTP or FTP.

 
     [bookmark: pgfId-1281587] – Click the ellipses to display the Browse Service dialog box. Choose a service from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281588]Click  OK to close this dialog box.

 
       		 [bookmark: pgfId-1281589]Click  Apply to save your changes.

 
      

 
     

 
     [bookmark: pgfId-1281590]Step 5 If you chose Add Filter HTTP Rule, specify the following settings:

 
      
       
       		 [bookmark: pgfId-1281591]Click one of the following radio buttons:  Filter HTTP or  Do not filter HTTP .

 
       		 [bookmark: pgfId-1281592]Enter the source of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281593] – Enter any to indicate any source address.

 
     [bookmark: pgfId-1281594] – Enter a hostname.

 
     [bookmark: pgfId-1281595] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281596] – Click the ellipses to display the Browse Source dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281597]Enter the destination of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281598] – Enter any to indicate any destination address.

 
     [bookmark: pgfId-1281599] – Enter a hostname.

 
     [bookmark: pgfId-1281600] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281601] – Click the ellipses to display the Browse Destination dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281602]Identify the service of the traffic to which the filtering action applies. To identify the service, enter one of the following:

 
      

 
     

 
     [bookmark: pgfId-1281603] – tcp/port—The port number can range from 1 to 65535. Additionally, you can use the following modifiers with the TCP service:

 
     [bookmark: pgfId-1281604]!=—Not equal to. For example, !=tcp/443.

 
     [bookmark: pgfId-1281605]<—Less than. For example, <tcp/2000.

 
     [bookmark: pgfId-1281606]>—Greater than. For example, >tcp/2000.

 
     [bookmark: pgfId-1281607]- —Range. For example, tcp/2000-3000.

 
     [bookmark: pgfId-1281608] – Enter a well-known service name, such as HTTP or FTP.

 
     [bookmark: pgfId-1281609] – Click the ellipses to display the Browse Service dialog box. Choose a service from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281610]Choose the action to take when the URL exceeds the specified size from the drop-down list.

 
       		 [bookmark: pgfId-1281611]Check the  Allow outbound traffic if URL server is not available check box  to connect without URL filtering being performed. When this check box is unchecked, you cannot connect to Internet websites if the URL server is unavailable. 

 
       		 [bookmark: pgfId-1281612]Check the  Block users from connecting to an HTTP proxy server check box to  prevent HTTP requests made through a proxy server.

 
       		 [bookmark: pgfId-1281616]Check the Truncate CGI parameters from URL sent to URL server check box to have the ASA forward only the CGI script location and the script name, without any parameters, to the filtering server.

 
       		 [bookmark: pgfId-1281617]Click  OK to close this dialog box.

 
       		 [bookmark: pgfId-1281618]Click  Apply to save your changes.

 
      

 
     

 
     [bookmark: pgfId-1281620]Step 6 If you chose Add Filter HTTPS Rule, specify the following settings:[bookmark: marker-1281619]

 
      
       
       		 [bookmark: pgfId-1281621]Click one of the following radio buttons:  Filter HTTPS or  Do not filter HTTPS .

 
       		 [bookmark: pgfId-1281622]Enter the source of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281623] – Enter any to indicate any source address.

 
     [bookmark: pgfId-1281624] – Enter a hostname.

 
     [bookmark: pgfId-1281625] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281626] – Click the ellipses to display the Browse Source dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281627]Enter the destination of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281628] – Enter any to indicate any destination address.

 
     [bookmark: pgfId-1281629] – Enter a hostname.

 
     [bookmark: pgfId-1281630] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281631] – Click the ellipses to display the Browse Destination dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281632]Identify the service of the traffic to which the filtering action applies. To identify the service, enter one of the following:

 
      

 
     

 
     [bookmark: pgfId-1281633] – tcp/port—The port number can range from 1 to 65535. Additionally, you can use the following modifiers with the TCP service:

 
     [bookmark: pgfId-1281634]!=—Not equal to. For example, !=tcp/443

 
     [bookmark: pgfId-1281635]<—Less than. For example, <tcp/2000.

 
     [bookmark: pgfId-1281636]>—Greater than. For example, >tcp/2000.

 
     [bookmark: pgfId-1281637]- —Range. For example, tcp/2000-3000.

 
     [bookmark: pgfId-1281638] – Enter a well-known service name, such as HTTP or FTP.

 
     [bookmark: pgfId-1281639] – Click the ellipses to display the Browse Service dialog box. Choose a service from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281640]Check the  Allow outbound traffic if URL server is not available check box  to connect without URL filtering being performed. When this check box is unchecked, you cannot connect to Internet websites if the URL server is unavailable. 

 
       		 [bookmark: pgfId-1281641]Click  OK to close this dialog box.

 
       		 [bookmark: pgfId-1281642]Click  Apply to save your changes.

 
      

 
     

 
     [bookmark: pgfId-1281644]Step 7 If you chose Add Filter FTP Rule, specify the following settings:[bookmark: marker-1281643]

 
      
       
       		 [bookmark: pgfId-1281645]Click one of the following radio buttons:  Filter FTP or  Do not filter FTP .

 
       		 [bookmark: pgfId-1281646]Enter the source of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281647] – Enter any to indicate any source address.

 
     [bookmark: pgfId-1281648] – Enter a hostname.

 
     [bookmark: pgfId-1281649] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281650] – Click the ellipses to display the Browse Source dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281651]Enter the destination of the traffic to which the filtering action applies. To enter the source, choose from the following options:

 
      

 
     

 
     [bookmark: pgfId-1281652] – Enter any to indicate any destination address.

 
     [bookmark: pgfId-1281653] – Enter a hostname.

 
     [bookmark: pgfId-1281654] – Enter an IP address and optional network mask. You can express the netmask in CIDR or dotted decimal notation. For example, you can enter 10.1.1.0/24 or 10.1.1.0/255.255.255.0.

 
     [bookmark: pgfId-1281655] – Click the ellipses to display the Browse Destination dialog box. Choose a host or address from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281656]Identify the service of the traffic to which the filtering action applies. To identify the service, enter one of the following:

 
      

 
     

 
     [bookmark: pgfId-1281657] – tcp/port—The port number can range from 1 to 65535. Additionally, you can use the following modifiers with the TCP service:

 
     [bookmark: pgfId-1281658]!=—Not equal to. For example, !=tcp/443

 
     [bookmark: pgfId-1281659]<—Less than. For example, <tcp/2000.

 
     [bookmark: pgfId-1281660]>—Greater than. For example, >tcp/2000.

 
     [bookmark: pgfId-1281661]- —Range. For example, tcp/2000-3000.

 
     [bookmark: pgfId-1281662] – Enter a well-known service name, such as http or ftp.

 
     [bookmark: pgfId-1281663] – Click the ellipses to display the Browse Service dialog box. Choose a service from the drop-down list.

 
      
       
       		 [bookmark: pgfId-1281664]Check the  Allow outbound traffic if URL server is not available check box  to connect without URL filtering being performed. When this check box is unchecked, you cannot connect to Internet websites if the URL server is unavailable. 

 
       		 [bookmark: pgfId-1281665]Check the  Block interactive FTP sessions (block if absolute FTP path is not provided)  check box to drop FTP requests if they use a relative path name to the FTP directory.

 
       		 [bookmark: pgfId-1281666]Click  OK to close this dialog box.

 
       		 [bookmark: pgfId-1281667]Click  Apply to save your changes.

 
      

 
     

 
     [bookmark: pgfId-1281668]Step 8 To modify a filtering rule, select it and click Edit to display the Edit Filter Rule dialog box for the specified filtering rule. 

 
     [bookmark: pgfId-1281669]Step 9 Make the required changes, then click OK to close this dialog box.

 
     [bookmark: pgfId-1281670]Step 10 Click Apply to save your changes.

 
     [bookmark: pgfId-1281671]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1281673][bookmark: 77657]Filtering the Rule Table

 
     [bookmark: pgfId-1281674]To find a specific rule if your rule table includes a lot of entries, you can apply a filter to the rule table to show only the rules specified by the filter. To filter the rule table, perform the following steps:

 
     
 
     [bookmark: pgfId-1281675]Step 1 Click Find on the toolbar to display the Filter toolbar.

 
     [bookmark: pgfId-1281676]Step 2 Choose the type of filter from the Filter drop-down list:

 
      
       
       		 [bookmark: pgfId-1281677]Source—Displays rules based on the specified source address or hostname.

 
       		 [bookmark: pgfId-1281678]Destination—Displays rules based on the specified destination address or hostname.

 
       		 [bookmark: pgfId-1281679]Source or Destination—Displays rules based on the specified source or destination address or hostname.

 
       		 [bookmark: pgfId-1281680]Service—Displays rules based on the specified service.

 
       		 [bookmark: pgfId-1281681]Rule Type—Displays rules based on the specified rule type.

 
       		 [bookmark: pgfId-1281682]Query—Displays rules based on a complex query composed of source, destination, service, and rule type information.

 
      

 
     

 
     [bookmark: pgfId-1281683]Step 3 For Source, Destination, Source or Destination, and Service filters, perform the following steps:

 
     [bookmark: pgfId-1281684] a. Enter the string to match using one of the following methods:

 
     [bookmark: pgfId-1281685] – Type the source, destination, or service name in the adjacent field.

 
     [bookmark: pgfId-1281686] – Click the ellipses to open a Browse dialog box from which you can choose existing services, IP addresses, or host names.

 
     [bookmark: pgfId-1281687] b. Choose the match criteria from the drop-down list. Choose is for exact string matches or contains for partial string matches. 

 
     [bookmark: pgfId-1281688]Step 4 For Rule Type filters, choose the rule type from the list.

 
     [bookmark: pgfId-1281691]Step 5 For Query filters, click Define Query. To define queries, see the “Defining Queries” section.

 
     [bookmark: pgfId-1281693]Step 6 To apply the filter to the rule table, click Filter.

 
     [bookmark: pgfId-1281694]Step 7 To remove the filter from the rule table and display all rule entries, click Clear.

 
     [bookmark: pgfId-1281695]Step 8 To show the packet trace for the selected rule, click Packet Trace.

 
     [bookmark: pgfId-1281696]Step 9 To show and hide the selected rule diagram, click Diagram.

 
     [bookmark: pgfId-1281697]Step 10 To remove a filter rule and place it elsewhere, click Cut.

 
     [bookmark: pgfId-1281698]Step 11 To copy a filter rule, click Copy. Then to move the copied filter rule elsewhere, click Paste.

 
     [bookmark: pgfId-1281699]Step 12 To delete a selected filter rule, click Delete.

 
     [bookmark: pgfId-1281700]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1281706][bookmark: 2H_Head2. Defining Queries]Defining Queries

 
     [bookmark: pgfId-1281707]To define queries, perform the following steps:

 
     
 
     [bookmark: pgfId-1281708]Step 1 Enter the IP address or hostname of the source. Choose is for an exact match or choose contains for a partial match. Click the ellipses to display the Browse Source dialog box. You can specify a network mask using CIDR notation (address/bit-count). You can specify multiple addresses by separating them with commas.

 
     [bookmark: pgfId-1281709]Step 2 Enter the IP address or hostname of the destination. Choose is for an exact match or choose contains for a partial match. Click the ellipses to display the Browse Destination dialog box. You can specify a network mask using CIDR notation (address/bit-count). You can specify multiple addresses by separating them with commas.

 
     [bookmark: pgfId-1281710]Step 3 Enter the IP address or hostname of the source or destination. Choose is for an exact match or choose contains for a partial match. Click the ellipses to display the Browse Source dialog box. You can specify a network mask using CIDR notation (address/bit-count). You can specify multiple addresses by separating them with commas.

 
     [bookmark: pgfId-1281711]Step 4 Enter the protocol, port, or name of a service. Choose is for an exact match or choose contains for a partial match. Click the ellipses to display the Browse Service dialog box. You can specify a network mask using CIDR notation (address/bit-count). You can specify multiple addresses by separating them with commas.

 
     [bookmark: pgfId-1281712]Step 5 Choose the rule type from the drop-down list.

 
     [bookmark: pgfId-1281713]Step 6 Click OK to close this dialog box.

 
     [bookmark: pgfId-1281714]After you click OK, the filter is immediately applied to the rule table. To remove the filter, click Clear.

 
     [bookmark: pgfId-1281715]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1058506][bookmark: 2H_Head2. Feature History for URL Filtering]Feature History for URL Filtering

 
      
       
        
        [bookmark: pgfId-1058513]Table 29-4 [bookmark: 36726]Feature History for URL Filtering

 
        
        
         
         		 
           
           [bookmark: pgfId-1058519]Feature Name 
          
  
         		 
           
           [bookmark: pgfId-1058521]Platform Releases 
          
  
         		 
           
           [bookmark: pgfId-1058523]Feature Information 
          
  
        

 
         
         		[bookmark: pgfId-1058525]URL filtering

  
         		[bookmark: pgfId-1058527]7.0(1)

  
         		[bookmark: pgfId-1058529]Filters URLs based on an established set of filtering criteria.
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     [bookmark: pgfId-1209827][bookmark: nat][bookmark: 82872]Configuring NAT (ASA 8.2 and Earlier) 
      
      
 
     
 

 
    [bookmark: pgfId-1055000]This chapter describes Network Address Translation, and includes the following sections:

 
     
     		 [bookmark: pgfId-1055004]NAT Overview

 
     		 [bookmark: pgfId-1055008]Configuring NAT Control

 
     		 [bookmark: pgfId-1055012]Using Dynamic NAT

 
     		 [bookmark: pgfId-1055016]Using Static NAT

 
     		 [bookmark: pgfId-1055024]Using NAT Exemption

 
    

 
   
 
    
     [bookmark: pgfId-1055031][bookmark: 14132]NAT Overvie[bookmark: marker-1055030]w

 
    [bookmark: pgfId-1055035]This section describes how NAT works on the ASA, and includes the following topics:

 
     
     		 [bookmark: pgfId-1055039]Introduction to NAT

 
     		 [bookmark: pgfId-1154393]NAT in Routed Mode

 
     		 [bookmark: pgfId-1154404]NAT in Transparent Mode

 
     		 [bookmark: pgfId-1055043]NAT Control

 
     		 [bookmark: pgfId-1055047]NAT Types

 
     		 [bookmark: pgfId-1055051]Policy NAT

 
     		 [bookmark: pgfId-1055055]NAT and Same Security Level Interfaces

 
     		 [bookmark: pgfId-1055059]Order of NAT Rules Used to Match Real Addresses

 
     		 [bookmark: pgfId-1055063]Mapped Address Guidelines

 
     		 [bookmark: pgfId-1055067]DNS and NAT

 
    

 
     
      [bookmark: pgfId-1055070][bookmark: 19487]Introductio[bookmark: marker-1055069]n to NAT

 
     [bookmark: pgfId-1055071]Address translation substitutes the real address in a packet with a mapped address that is routable on the destination network. NAT is composed of two steps: the process by which a real address is translated into a mapped address, and the process to undo translation for returning traffic.

 
     [bookmark: pgfId-1195574]The ASA translates an address when a NAT rule matches the traffic. If no NAT rule matches, processing for the packet continues. The exception is when you enable NAT control. NAT control requires that packets traversing from a higher security interface (inside) to a lower security interface (outside) match a NAT rule, or processing for the packet stops. See the “Security Levels” section in the general operations configuration guide for more information about security levels. See the “NAT Control” for more information about NAT control.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1055082]Note In this document, all types of translation are referred to as NAT. When describing NAT, the terms inside and outside represent the security relationship between any two interfaces. The higher security level is inside and the lower security level is outside. For example, interface 1 is at 60 and interface 2 is at 50; therefore, interface 1 is “inside” and interface 2 is “outside.”

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1055083]Some of the benefits of NAT are as follows:

 
      
      		 [bookmark: pgfId-1055084]You can use private addresses on your inside networks. Private addresses are not routable on the Internet. 

 
      		 [bookmark: pgfId-1055088]NAT hides the real addresses from other networks, so attackers cannot learn the real address of a host.

 
      		 [bookmark: pgfId-1055089]You can resolve IP routing problems such as overlapping addresses.

 
     

 
     [bookmark: pgfId-1055093]See Table 10-1 for information about protocols that do not support NAT.

 
    
 
     
      [bookmark: pgfId-1055095][bookmark: 89544]NAT in Routed Mode

 
     [bookmark: pgfId-1055099]Figure 6-1 shows a typical NAT example in routed mode, with a private network on the inside. When the inside host at 10.1.1.27 sends a packet to a web server, the real source address, 10.1.1.27, of the packet is changed to a mapped address, 209.165.201.10. When the server responds, it sends the response to the mapped address, 209.165.201.10, and the security appliance receives the packet. The security appliance then changes the translation of the mapped address, 209.165.201.10 back to the real address, 10.1.1.1.27 before sending it to the host.

 
     [bookmark: pgfId-1055100]Figure 6-1 [bookmark: 14738]NAT Example: Routed Mode

 
     [bookmark: pgfId-1055104] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1055116][bookmark: 31590]NAT in Transparent Mode

 
     [bookmark: pgfId-1055117]Using NAT in transparent mode eliminates the need for the upstream or downstream routers to perform NAT for their networks. For example, a transparent firewall ASA is useful between two VRFs so you can establish BGP neighbor relations between the VRFs and the global table. However, NAT per VRF might not be supported. In this case, using NAT in transparent mode is essential.

 
     [bookmark: pgfId-1055121]NAT in transparent mode has the following requirements and limitations:

 
      
      		 [bookmark: pgfId-1055122]When the mapped addresses are not on the same network as the transparent firewall, then on the upstream router, you need to add a static route for the mapped addresses that points to the downstream router (through the ASA).

 
      		 [bookmark: pgfId-1154413]When you have VoIP or DNS traffic with NAT and inspection enabled, to successfully translate the IP address inside VoIP and DNS packets, the ASA needs to perform a route lookup. Unless the host is on a directly-connected network, then you need to add a static route on the ASA for the real host address that is embedded in the packet.

 
      		 [bookmark: pgfId-1055139]The  alias command is not supported.

 
      		 [bookmark: pgfId-1055140]Because the transparent firewall does not have any interface IP addresses, you cannot use interface PAT.

 
      		 [bookmark: pgfId-1055141]ARP inspection is not supported. Moreover, if for some reason a host on one side of the firewall sends an ARP request to a host on the other side of the firewall, and the initiating host real address is mapped to a different address on the same subnet, then the real address remains visible in the ARP request.

 
     

 
     [bookmark: pgfId-1055146]Figure 6-2 shows a typica[bookmark: marker-1055145]l NAT scenario in transparent mode, with the same network on the inside and outside interfaces. The transparent firewall in this scenario is performing the NAT service so that the upstream router does not have to perform NAT. When the inside host at 10.1.1.27 sends a packet to a web server, the real source address of the packet, 10.1.1.27, is changed to a mapped address, 209.165.201.10. When the server responds, it sends the response to the mapped address, 209.165.201.10, and the ASA receives the packet because the upstream router includes this mapped network in a static route directed through the ASA. The ASA then undoes the translation of the mapped address, 209.165.201.10 back to the real address, 10.1.1.1.27. Because the real address is directly-connected, the ASA sends it directly to the host.

 
     [bookmark: pgfId-1055160]Figure 6-2 [bookmark: 59658]NAT Example: Transparent Mode

 
     [bookmark: pgfId-1055164] 
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      [bookmark: pgfId-1055176][bookmark: 49001]NAT Control

 
     [bookmark: pgfId-1055177]NAT control requires that packets traversing from an inside interface to an outside interface match a NAT rule; for any host on the inside network to access a host on the outside network, you must configure NAT to translate the inside host address, as shown in Figure 6-3.

 
     [bookmark: pgfId-1055182]Figure 6-3 [bookmark: 25070]NAT Control and Outbound Traffic

 
     [bookmark: pgfId-1055186] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1055187]Interfaces at the same security level are not required to use NAT to communicate. However, if you configure dynamic NAT or PAT on a same security interface, then all traffic from the interface to a same security interface or an outside interface must match a NAT rule, as shown in Figure 6-4.

 
     [bookmark: pgfId-1055192]Figure 6-4 [bookmark: 61071]NAT Control and Same Security Traffic

 
     [bookmark: pgfId-1055196] 
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     [bookmark: pgfId-1055197]Similarly, if you enable outside dynamic NAT or PAT, then all outside traffic must match a NAT rule when it accesses an inside interface (see Figure 6-5).

 
     [bookmark: pgfId-1055202]Figure 6-5 [bookmark: 34912]NAT Control and Inbound Traffic

 
     [bookmark: pgfId-1055206] 
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     [bookmark: pgfId-1055207]Static NAT does not cause these restrictions.

 
     [bookmark: pgfId-1055208]By default, NAT control is disabled; therefore, you do not need to perform NAT on any networks unless you want to do so. If you upgraded from an earlier version of software, however, NAT control might be enabled on your system. Even with NAT control disabled, you need to perform NAT on any addresses for which you configure dynamic NAT. See the “Dynamic NAT Implementation” section for more information about how dynamic NAT is applied.

 
     [bookmark: pgfId-1055212]If you want the added security of NAT control but do not want to translate inside addresses in some cases, you can apply a NAT exemption or identity NAT rule on those addresses. (See the “Using NAT Exemption” for more information).

 
     [bookmark: pgfId-1055219]To configure NAT control, see the “Configuring NAT Control” section.
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     [bookmark: pgfId-1055220]Note In multiple context mode, the packet classifier might rely on the NAT configuration to assign packets to contexts if you do not enable unique MAC addresses for shared interfaces. See the “How the ASA Classifies Packets” section in the general operations configuration guide for more information about the relationship between the classifier and NAT.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1055226][bookmark: 91605]NAT Typ[bookmark: marker-1055225]es

 
     [bookmark: pgfId-1055227]This section describes the available NAT types, and includes the following topics:

 
      
      		 [bookmark: pgfId-1055231]Dynamic NAT

 
      		 [bookmark: pgfId-1055235]PAT

 
      		 [bookmark: pgfId-1055239]Static NAT

 
      		 [bookmark: pgfId-1055243]Static PAT

 
      		 [bookmark: pgfId-1055247]Bypassing NAT When NAT Control is Enabled

 
     

 
     [bookmark: pgfId-1055248]You can implement address translation as dynamic NAT, Port Address Translation, static NAT, static PAT, or as a mix of these types. You can also configure rules to bypass NAT; for example, to enable NAT control when you do not want to perform NAT. 

 
    
 
     
      [bookmark: pgfId-1055252]Dynamic [bookmark: 66654]NA[bookmark: marker-1055251]T

 
     [bookmark: pgfId-1055253]Dynamic NAT translates a group of real addresses to a pool of mapped addresses that are routable on the destination network. The mapped pool may include fewer addresses than the real group. When a host you want to translate accesses the destination network, the ASA assigns the host an IP address from the mapped pool. The translation is added only when the real host initiates the connection. The translation is in place only for the duration of the connection, and a given user does not keep the same IP address after the translation times out. Users on the destination network, therefore, cannot initiate a reliable connection to a host that uses dynamic NAT, although the connection is allowed by an ACL, and the ASA rejects any attempt to connect to a real host address directly. See the “Static NAT” or “Static PAT” section for information on how to obtain reliable access to hosts.
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     [bookmark: pgfId-1055269]Note In some cases, a translation is added for a connection, although the session is denied by the ASA. This condition occurs with an outbound ACL, a management-only interface, or a backup interface in which the translation times out normally.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1222312]Figure 6-6 shows a remote host attempting to connect to the real address. The connection is denied, because the ASA only allows returning connections to the mapped address.

 
     [bookmark: pgfId-1222317]Figure 6-6 [bookmark: 74923]Remote Host Attempts to Connect to the Real Address

 
     [bookmark: pgfId-1222321] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1222325]Figure 6-7 shows a remote host attempting to initiate a connection to a mapped address. This address is not currently in the translation table; therefore, the ASA drops the packet.

 
     [bookmark: pgfId-1222330]Figure 6-7 [bookmark: 31704]Remote Host Attempts to Initiate a Connection to a Mapped Address

 
     [bookmark: pgfId-1222334] 
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     [bookmark: pgfId-1055302]Note For the duration of the translation, a remote host can initiate a connection to the translated host if an ACL allows it. Because the address is unpredictable, a connection to the host is unlikely. Nevertheless, in this case, you can rely on the security of the ACL.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1055303]Dynamic NAT has these disadvantages:

 
      
      		 [bookmark: pgfId-1055304]If the mapped pool has fewer addresses than the real group, you could run out of addresses if the amount of traffic is more than expected.

 
     

 
     [bookmark: pgfId-1055305]Use PAT if this event occurs often, because PAT provides over 64,000 translations using ports of a single address.

 
      
      		 [bookmark: pgfId-1055306]You have to use a large number of routable addresses in the mapped pool; if the destination network requires registered addresses, such as the Internet, you might encounter a shortage of usable addresses.

 
     

 
     [bookmark: pgfId-1055307]The advantage of dynamic NAT is that some protocols cannot use PAT. PAT does not work with the following:

 
      
      		 [bookmark: pgfId-1055308]IP protocols that do not have a port to overload, such as GRE version 0. 

 
      		 [bookmark: pgfId-1055309]Some multimedia applications that have a data stream on one port, the control path on another port, and are not open standard. 

 
     

 
     [bookmark: pgfId-1055313]See the “When to Use Application Protocol Inspection” section for more information about NAT and PAT support.

 
    
 
     
      [bookmark: pgfId-1209435][bookmark: 67872]PAT[bookmark: marker-1209434]

 
     [bookmark: pgfId-1209439]PAT translates multiple real addresses to a single mapped IP address by translating the real address and source port to the mapped address and a unique port. If available, the real source port number is used for the mapped port. However, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 0 to 511, 512 to 1023, and 1024 to 65535. Therefore, ports below 1024 have only a small PAT pool that can be used.

 
     [bookmark: pgfId-1209440]Each connection requires a separate translation, because the source port differs for each connection. For example, 10.1.1.1:1025 requires a separate translation from 10.1.1.1:1026.

 
     [bookmark: pgfId-1055319]After the connection expires, the port translation also expires after 30 seconds of inactivity. The timeout is not configurable. Users on the destination network cannot reliably initiate a connection to a host that uses PAT (even if the connection is allowed by an ACL). Not only can you not predict the real or mapped port number of the host, but the ASA does not create a translation at all unless the translated host is the initiator. See the following “Static NAT” or “Static PAT” sections for reliable access to hosts.

 
     [bookmark: pgfId-1055329]PAT lets you use a single mapped address, thus conserving routable addresses. You can even use the ASA interface IP address as the PAT address. PAT does not work with some multimedia applications that have a data stream that is different from the control path. See the “When to Use Application Protocol Inspection” section for more information about NAT and PAT support.
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     [bookmark: pgfId-1055336]Note For the duration of the translation, a remote host can initiate a connection to the translated host if an ACL allows it. Because the port address (both real and mapped) is unpredictable, a connection to the host is unlikely. Nevertheless, in this case, you can rely on the security of the ACL. However, policy PAT does not support time-based ACLs.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1055340][bookmark: 11671]Stati[bookmark: marker-1055338]c NAT

 
     [bookmark: pgfId-1055341]Static NAT creates a fixed translation of real address(es) to mapped address(es).With dynamic NAT and PAT, each host uses a different address or port for each subsequent translation. Because the mapped address is the same for each consecutive connection with static NAT, and a persistent translation rule exists, static NAT allows hosts on the destination network to initiate traffic to a translated host (if an ACL exists that allows it).

 
     [bookmark: pgfId-1055342]The main difference between dynamic NAT and a range of addresses for static NAT is that static NAT allows a remote host to initiate a connection to a translated host (if an ACL exists that allows it), while dynamic NAT does not. You also need an equal number of mapped addresses as real addresses with static NAT.

 
    
 
     
      [bookmark: pgfId-1055346][bookmark: 45059]Sta[bookmark: marker-1055344]tic P[bookmark: marker-1055345]AT

 
     [bookmark: pgfId-1055347]Static PAT is the same as static NAT, except that it lets you specify the protocol (TCP or UDP) and port for the real and mapped addresses.

 
     [bookmark: pgfId-1055348]This feature lets you identify the same mapped address across many different static statements, provided the port is different for each statement. You cannot use the same mapped address for multiple static NAT statements.

 
     [bookmark: pgfId-1055349]For applications that require inspection for secondary channels (for example, FTP and VoIP), the ASA automatically translates the secondary ports.

 
     [bookmark: pgfId-1055353]For example, if you want to provide a single address for remote users to access FTP, HTTP, and SMTP, but these are all actually different servers on the real network, you can specify static PAT statements for each server that uses the same mapped IP address, but different ports (see Figure 6-8).

 
     [bookmark: pgfId-1222348]Figure 6-8 [bookmark: 97552]Static PAT

 
     [bookmark: pgfId-1222352] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1055377]You can also use static PAT to translate a well-known port to a non-standard port or vice versa. For example, if inside web servers use port 8080, you can allow outside users to connect to port 80, and then undo translation to the original port 8080. Similarly, to provide extra security, you can tell web users to connect to non-standard port 6785, and then undo translation to port 80.

 
    
 
     
      [bookmark: pgfId-1055380][bookmark: 97004][bookmark: 85258]Bypassing NAT When NAT Control is Enabled

 
     [bookmark: pgfId-1055381]If you enable NAT control, then inside hosts must match a NAT rule when accessing outside hosts. If you do not want to perform NAT for some hosts, then you can bypass NAT for those hosts or you can disable NAT control. You might want to bypass NAT, for example, if you are using an application that does not support NAT. See the “When to Use Application Protocol Inspection” section for information about inspection engines that do not support NAT.

 
     [bookmark: pgfId-1055385]You can configure traffic to bypass NAT using one of three methods. All methods achieve compatibility with inspection engines. However, each method offers slightly different capabilities, as follows:

 
      
      		 [bookmark: pgfId-1055388]Identity NA[bookmark: marker-1055386][bookmark: marker-1055387]T—When you configure identity NAT (which is similar to dynamic NAT), you do not limit translation for a host on specific interfaces; you must use identity NAT for connections through all interfaces. Therefore, you cannot choose to perform normal translation on real addresses when you access interface A, but use identity NAT when accessing interface B. Regular dynamic NAT, on the other hand, lets you specify a particular interface on which to translate the addresses. Make sure that the real addresses for which you use identity NAT are routable on all networks that are available according to your ACLs.

 
     

 
     [bookmark: pgfId-1055389]For identity NAT, even though the mapped address is the same as the real address, you cannot initiate a connection from the outside to the inside (even if the interface ACL allows it). Use static identity NAT or NAT exemption for this functionality.

 
      
      		 [bookmark: pgfId-1055390]Static identity NAT—Static identity NAT lets you specify the interface on which you want to allow the real addresses to appear, so you can use identity NAT when you access interface A, and use regular translation when you access interface B. Static identity NAT also lets you use policy NAT, which identifies the real and destination addresses when determining the real addresses to translate (see the “Policy NAT” section for more information about policy NAT). For example, you can use static identity NAT for an inside address when it accesses the outside interface and the destination is server A, but use a normal translation when accessing the outside server B.

 
      		 [bookmark: pgfId-1055395]NAT ex[bookmark: marker-1055394]emption—NAT exemption allows both translated and remote hosts to initiate connections. Like identity NAT, you do not limit translation for a host on specific interfaces; you must use NAT exemption for connections through all interfaces. However, NAT exemption does let you specify the real and destination addresses when determining the real addresses to translate (similar to policy NAT), so you have greater control using NAT exemption. However unlike policy NAT, NAT exemption does not consider the ports in the ACL. NAT exemption also does not let you configure connection limits such as maximum TCP connections.

 
     

 
    
 
     
      [bookmark: pgfId-1055398][bookmark: 18047]Policy N[bookmark: marker-1055397]AT

 
     [bookmark: pgfId-1055400]Poli[bookmark: marker-1055399]cy NAT lets you identify real addresses for address translation by specifying the source and destination addresses. You can also optionally specify the source and destination ports. Regular NAT can only consider the source addresses, and not the destination. For example, with policy NAT, you can translate the real address to mapped address A when it accesses server A, but translate the real address to mapped address B when it accesses server B.

 
     [bookmark: pgfId-1055402]For applications that require application inspection for secondary channels (for example, FTP and VoIP), the policy specified in the policy NAT rule should include the secondary ports. When the ports cannot be predicted, the policy should specify only the IP addresses for the secondary channel. With this configuration, the security appliance translates the secondary ports.

 
     [bookmark: pgfId-1055410]Figure 6-9 shows a host on the 10.1.2.0/24 network accessing two different servers. When the host accesses the server at 209.165.201.11, the real address is translated to 209.165.202.129. When the host accesses the server at 209.165.200.225, the real address is translated to 209.165.202.130. Consequently, the host appears to be on the same network as the servers, which can help with routing.

 
     [bookmark: pgfId-1055412]Figure 6-9 [bookmark: 52522]Policy NAT with Different Destination Addresses

 
     [bookmark: pgfId-1055416] 
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     [bookmark: pgfId-1055446]Figure 6-10 shows the use of source and destination ports. The host on the 10.1.2.0/24 network accesses a single host for both web services and Telnet services. When the host accesses the server for web services, the real address is translated to 209.165.202.129. When the host accesses the same server for Telnet services, the real address is translated to 209.165.202.130.

 
     [bookmark: pgfId-1183373]Figure 6-10 [bookmark: 92288]Policy NAT with Different Destination Ports

 
     [bookmark: pgfId-1183377] 
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     [bookmark: pgfId-1183378]For policy static NAT, both translated and remote hosts can originate traffic. For traffic originated on the translated network, the NAT rule specifies the real addresses and the destination addresses, but for traffic originated on the remote network, the rule identifies the real addresses and the source addresses of remote hosts who are allowed to connect to the host using this translation.

 
     [bookmark: pgfId-1055483]Figure 6-11 shows a remote host connecting to a translated host. The translated host has a policy static NAT translation that translates the real address only for traffic to and from the 209.165.201.0/27 network. A translation does not exist for the 209.165.200.224/27 network, so the translated host cannot connect to that network, nor can a host on that network connect to the translated host.

 
     [bookmark: pgfId-1055485]Figure 6-11 [bookmark: 29489]Policy Static NAT with Destination Address Translation

 
     [bookmark: pgfId-1055489] 
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     [bookmark: pgfId-1055502]Note Policy NAT does not support SQL*Net, but it is supported by regular NAT. See the “When to Use Application Protocol Inspection” section for information about NAT support for other protocols.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1055507][bookmark: 77088]NAT and Sa[bookmark: marker-1055505][bookmark: marker-1055506]me Security Level Interfaces

 
     [bookmark: pgfId-1055508]NAT is not required between same security level interfaces even if you enable NAT control. You can optionally configure NAT if desired. However, if you configure dynamic NAT when NAT control is enabled, then NAT is required. See the “NAT Control” section for more information. Also, when you specify a group of IP address(es) for dynamic NAT or PAT on a same security interface, then you must perform NAT on that group of addresses when they access any lower or same security level interface (even when NAT control is not enabled). Traffic identified for static NAT is not affected.
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     [bookmark: pgfId-1055519]Note The ASA does not support VoIP inspection engines when you configure NAT on same security interfaces. These inspection engines include Skinny, SIP, and H.323. See the “When to Use Application Protocol Inspection” section for supported inspection engines.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1055525][bookmark: 19135]Order of NAT Rules [bookmark: marker-1055524]Used to Match Real Addresses

 
     [bookmark: pgfId-1055529]The ASA matches real addresses to NAT rules in the following order:

 
     [bookmark: pgfId-1055530] 1. NAT exemption—In order, until the first match.

 
     [bookmark: pgfId-1055531] 2. Static NAT and Static PAT (regular and policy)—In order, until the first match. Static identity NAT is included in this category.

 
     [bookmark: pgfId-1055532] 3. Policy dynamic NAT—In order, until the first match. Overlapping addresses are allowed.

 
     [bookmark: pgfId-1055533] 4. Regular dynamic NAT—Best match. Regular identity NAT is included in this category. The order of the NAT rules does not matter; the NAT rule that best matches the real address is used. For example, you can create a general rule to translate all addresses (0.0.0.0) on an interface. If you want to translate a subset of your network (10.1.1.1) to a different address, then you can create a rule to translate only 10.1.1.1. When 10.1.1.1 makes a connection, the specific rule for 10.1.1.1 is used because it matches the real address best. We do not recommend using overlapping rules; they use more memory and can slow the performance of the ASA.

 
    
 
     
      [bookmark: pgfId-1055542][bookmark: 94324][bookmark: 31793][bookmark: 33371][bookmark: 77575]Mapped Address Guidelines[bookmark: marker-1055541]

 
     [bookmark: pgfId-1055543]When you translate the real address to a mapped address, you can use the following mapped addresses:

 
      
      		 [bookmark: pgfId-1055544]Addresses on the same network as the mapped interface.

 
     

 
     [bookmark: pgfId-1055545]If you use addresses on the same network as the mapped interface (through which traffic exits the ASA), the ASA uses proxy ARP to answer any requests for mapped addresses, and thus intercepts traffic destined for a real address. This solution simplifies routing, because the ASA does not have to be the gateway for any additional networks. However, this approach does put a limit on the number of available addresses used for translations.

 
     [bookmark: pgfId-1055555]For PAT, you can even use the IP address of the mapped interface.

 
      
      		 [bookmark: pgfId-1055556]Addresses on a unique network.

 
     

 
     [bookmark: pgfId-1055557]If you need more addresses than are available on the mapped interface network, you can identify addresses on a different subnet. The ASA uses proxy ARP to answer any requests for mapped addresses, and thus intercepts traffic destined for a real address. If you use OSPF, and you advertise routes on the mapped interface, then the ASA advertises the mapped addresses. If the mapped interface is passive (not advertising routes) or you are using static routing, then you need to add a static route on the upstream router that sends traffic destined for the mapped addresses to the ASA.

 
    
 
     
      [bookmark: pgfId-1055570][bookmark: 20365]DNS and N[bookmark: marker-1055568][bookmark: marker-1055569]AT

 
     [bookmark: pgfId-1055574]You might need to configure the ASA to modify DNS replies by replacing the address in the reply with an address that matches the NAT configuration. You can configure DNS modification when you configure each translation.

 
     [bookmark: pgfId-1055575]For example, a DNS server is accessible from the outside interface. A server, ftp.cisco.com, is on the inside interface. You configure the ASA to statically translate the ftp.cisco.com real address (10.1.3.14) to a mapped address (209.165.201.10) that is visible on the outside network (see Figure 6-12). In this case, you want to enable DNS reply modification on this static statement so that inside users who have access to ftp.cisco.com using the real address receive the real address from the DNS server, and not the mapped address.

 
     [bookmark: pgfId-1055582]When an inside host sends a DNS request for the address of ftp.cisco.com, the DNS server replies with the mapped address (209.165.201.10). The ASA refers to the static statement for the inside server and translates the address inside the DNS reply to 10.1.3.14. If you do not enable DNS reply modification, then the inside host attempts to send traffic to 209.165.201.10 instead of accessing ftp.cisco.com directly.

 
     [bookmark: pgfId-1055587]Figure 6-12 [bookmark: 80741]DNS Reply Modification

 
     [bookmark: pgfId-1055591] 
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     [bookmark: pgfId-1091622]Note If a user on a different network (for example, DMZ) also requests the IP address for ftp.cisco.com from the outside DNS server, then the IP address in the DNS reply is also modified for this user, even though the user is not on the Inside interface referenced by the static rule.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1055604]Figure 6-13 shows a web server and DNS server on the outside. The ASA has a static translation for the outside server. In this case, when an inside user requests the address for ftp.cisco.com from the DNS server, the DNS server responds with the real address, 209.165.20.10. Because you want inside users to use the mapped address for ftp.cisco.com (10.1.2.56) you need to configure DNS reply modification for the static translation.

 
     [bookmark: pgfId-1055606]Figure 6-13 [bookmark: 32827]DNS Reply Modification Using Outside NAT

 
     [bookmark: pgfId-1055610] 
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     [bookmark: pgfId-1055618][bookmark: 25122]Configuring NAT Control

 
    [bookmark: pgfId-1055619]NAT control requires that packets traversing from an inside interface to an outside interface match a NAT rule. See the “NAT Control” section for more information.

 
    [bookmark: pgfId-1079430]To enable NAT control, in the Configuration > Firewall > NAT Rules pane, check the Enable traffic through the firewall without address translation check box.

 
   
 
    
     [bookmark: pgfId-1079436][bookmark: 59521][bookmark: 33325]Using Dynamic NAT[bookmark: marker-1155536] [bookmark: marker-1155537]

 
    [bookmark: pgfId-1079437]This section describes how to configure dynamic NAT, including dynamic NAT and PAT, dynamic policy NAT and PAT, and identity NAT.

 
    [bookmark: pgfId-1063243]Policy NAT lets you identify real addresses for address translation by specifying the source and destination addresses. You can also optionally specify the source and destination ports. Regular NAT can only consider the source addresses, and not the destination. See the “Policy NAT” section for more information.

 
    [bookmark: pgfId-1063214]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1055637]Dynamic NAT Implementation

 
     		 [bookmark: pgfId-1092020]Managing Global Pools

 
     		 [bookmark: pgfId-1055641]Configuring Dynamic NAT, PAT, or Identity NAT

 
     		 [bookmark: pgfId-1059240]Configuring Dynamic Policy NAT or PAT

 
    

 
     
      [bookmark: pgfId-1058266][bookmark: 71468]Dynamic NAT Impl[bookmark: marker-1058264][bookmark: marker-1058265]ementation

 
     [bookmark: pgfId-1065292]This section describes how dynamic NAT is implemented, and includes the following topics:

 
      
      		 [bookmark: pgfId-1065332]Real Addresses and Global Pools Paired Using a Pool ID

 
      		 [bookmark: pgfId-1065988]NAT Rules on Different Interfaces with the Same Global Pools

 
      		 [bookmark: pgfId-1066165]Global Pools on Different Interfaces with the Same Pool ID

 
      		 [bookmark: pgfId-1066342]Multiple NAT Rules with Different Global Pools on the Same Interface

 
      		 [bookmark: pgfId-1066519]Multiple Addresses in the Same Global Pool

 
      		 [bookmark: pgfId-1066696]Outside NAT

 
      		 [bookmark: pgfId-1066873]Real Addresses in a NAT Rule Must be Translated on All Lower or Same Security Interfaces

 
     

 
    
 
     
      [bookmark: pgfId-1058267][bookmark: 84324]Real Addresses and Global Pools Paired Using a Pool ID

 
     [bookmark: pgfId-1068038]In a dynamic NAT rule, you specify real addresses and then pair them with a global pool of addresses to which the real addresses are mapped when they exit another interface (in the case of PAT, this is one address, and in the case of identity NAT, this is the same as the real address). Each global pool is assigned a pool ID. 

 
    
 
     
      [bookmark: pgfId-1068488][bookmark: 27292]NAT Rules on Different Interfaces with the Same Global Pools

 
     [bookmark: pgfId-1067058]You can create a NAT rule for each interface using the same global address pool. For example, you can configure NAT rules for Inside and DMZ interfaces, both using global pool 1 on the outside interface. Traffic from the Inside interface and the DMZ interface share a mapped pool or a PAT address when exiting the Outside interface (see Figure 6-14).

 
     [bookmark: pgfId-1058282]Figure 6-14 [bookmark: 20466]NAT Rules on Multiple Interfaces Using the Same Global Pool

 
     [bookmark: pgfId-1058286] 
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      [bookmark: pgfId-1058287][bookmark: 18080]Global Pools on Different Interfaces with the Same Pool ID

 
     [bookmark: pgfId-1065574]You can create a global pool for each interface using the same pool ID. If you create a global pool for the Outside and DMZ interfaces on ID 1, then a single NAT rule associated with ID 1 identifies traffic to be translated when going to both the Outside and the DMZ interfaces. Similarly, if you create a NAT rule for the DMZ interface on ID 1, then all global pools on ID 1 are also used for DMZ traffic. (See Figure 6-15).

 
     [bookmark: pgfId-1058292]Figure 6-15 [bookmark: 86186]NAT Rules and Global Pools using the Same ID on Multiple Interfaces

 
     [bookmark: pgfId-1058296] 
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      [bookmark: pgfId-1058297][bookmark: 99460]Multiple NAT Rules with Different Global Pools on the Same Interface

 
     [bookmark: pgfId-1065644]You can identify different sets of real addresses to have different mapped addresses. For example, on the Inside interface, you can have two NAT rules on two different pool IDs. On the Outside interface, you configure two global pools for these two IDs. Then, when traffic from Inside network A exits the Outside interface, the IP addresses are translated to pool 1 addresses; while traffic from Inside network B are translated to pool 2 addresses (see Figure 6-16). If you use policy NAT, you can specify the same real addresses for multiple NAT rules, as long as the destination addresses and ports are unique in each ACL.

 
     [bookmark: pgfId-1058302]Figure 6-16 [bookmark: 27886]Different NAT IDs

 
     [bookmark: pgfId-1058306] 
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      [bookmark: pgfId-1058310][bookmark: 22109]Multiple Addresses in the Same Global Pool

 
     [bookmark: pgfId-1065688]You can have multiple addresses in the same global pool; the ASA uses the dynamic NAT ranges of addresses first, in the order they are in the configuration, and then uses the PAT single addresses in order. You might want to add both a range of addresses and a PAT address if you need to use dynamic NAT for a particular application, but want to have a backup PAT rule in case all the dynamic NAT addresses are depleted. Similarly, you might want two PAT addresses in the pool if you need more than the approximately 64,000 PAT sessions that a single PAT mapped address supports (see Figure 6-17).

 
     [bookmark: pgfId-1058315]Figure 6-17 [bookmark: 47443]NAT and PAT Together

 
     [bookmark: pgfId-1058319] 
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      [bookmark: pgfId-1058320][bookmark: 78764]Outside NAT

 
     [bookmark: pgfId-1065733]If a NAT rule translates addresses from an outside interface to an inside interface, then the rule is an outside NAT rule, and you need to specify that it translates inbound traffic. If you also want to translate the same traffic when it accesses a lower security interface (for example, traffic on a DMZ is translated when accessing the Inside and the Outside interfaces), then you can create a second NAT rule using the same NAT ID (see Figure 6-18), but specifying outbound. Note that for outside NAT (DMZ interface to Inside interface), the inside host uses a static rule to allow outside access, so both the source and destination addresses are translated.

 
     [bookmark: pgfId-1058325]Figure 6-18 [bookmark: 63253]Outside NAT and Inside NAT Combined

 
     [bookmark: pgfId-1058329] 
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      [bookmark: pgfId-1058330][bookmark: 12182]Real Addresses in a NAT Rule Must be Translated on All Lower or Same Security Interfaces

 
     [bookmark: pgfId-1065769]When you create a NAT rule for a group of IP addresses, then you must perform NAT on that group of addresses when they access any lower or same security level interface; you must create a global pool with the same pool ID on each interface, or use a static rule. NAT is not required for that group when it accesses a higher security interface. If you create an outside NAT rule, then the NAT requirements preceding come into effect for that group of addresses when they access all higher security interfaces. Traffic identified by a static rule is not affected.

 
    
 
     
      [bookmark: pgfId-1091868][bookmark: 88196]Managing Global Pools

 
     [bookmark: pgfId-1092145]Dynamic NAT uses global pools for translation. For information about how global pools work, see the “Dynamic NAT Implementation” section.

 
     [bookmark: pgfId-1092149]To manage a global pool, perform the following steps:

 
     
 
     [bookmark: pgfId-1091927]Step 1 In the Configuration > Firewall > Objects > Global Pools pane, click Add to add a new pool, or select a pool, and click Edit.

 
     [bookmark: pgfId-1092208]You can also manage global pools from the Add/Edit Dynamic NAT Rule dialog box by clicking Manage.

 
     [bookmark: pgfId-1091930]The Add/Edit Global Address Pool dialog box appears.

 
     [bookmark: pgfId-1091931]Step 2 For a new pool, from the Interface drop-down list, choose the interface where you want to use the mapped IP addresses.

 
     [bookmark: pgfId-1092272]Step 3 For a new pool, in the Pool ID field, enter a number between 1 and 2147483647. Do not enter a pool ID that is already in use, or your configuration will be rejected.

 
     [bookmark: pgfId-1092293]Step 4 In the IP Addresses to Add area, click Range, Port Address Translation (PAT), or PAT Address Translation (PAT) Using IP Address of the interface.

 
     [bookmark: pgfId-1091937]If you specify a range of addresses, the ASA performs dynamic NAT. If you specify a subnet mask in the Netmask field, the value specifies the subnet mask assigned to the mapped address when it is assigned to a host. If you do not specify a mask, then the default mask for the address class is used.

 
     [bookmark: pgfId-1091938]Step 5 Click Add to add the addresses to the Addresses Pool pane.

 
     [bookmark: pgfId-1092304]Step 6 (Optional) You can add multiple addresses to the global pool. If you want to add a PAT address after you configure a dynamic range, for example, then complete the value for PAT and click Add again. See the “Multiple Addresses in the Same Global Pool” section for information about using multiple addresses on the same pool ID for an interface.

 
     [bookmark: pgfId-1092325]Step 7 Click OK.

 
     [bookmark: pgfId-1092336]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1060846][bookmark: 67679][bookmark: 90367][bookmark: 49145][bookmark: 33056]Configuring Dynamic N[bookmark: marker-1057355][bookmark: marker-1057356]AT, PAT, or Identity NAT

 
     [bookmark: pgfId-1222360]Figure 6-19 shows typical dynamic NAT, dynamic PAT, and identity NAT scenarios. Only real hosts can initiate connections.

 
     [bookmark: pgfId-1222362]Figure 6-19 [bookmark: 76166]Dynamic NAT Scenarios

 
     [bookmark: pgfId-1222366] 
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     [bookmark: pgfId-1058761]To configure a dynamic NAT, PAT, or identity NAT rule, perform the following steps.

 
     
 
     [bookmark: pgfId-1057389]Step 1 In the Configuration > Firewall > NAT Rules pane, choose Add > Add Dynamic NAT Rule.

 
     [bookmark: pgfId-1064176]The Add Dynamic NAT Rule dialog box appears.

 
     [bookmark: pgfId-1064177]Step 2 In the Original area, from the Interface drop-down list, choose the interface that is connected to the hosts with real addresses that you want to translate.

 
     [bookmark: pgfId-1074757]Step 3 Enter the real addresses in the Source field, or click the ... button to select an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1077922]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     [bookmark: pgfId-1069321]Step 4 To choose a global pool, use one of the following options:

 
      
       
       		 [bookmark: pgfId-1064485]Select an already-defined global pool.

 
      

 
     

 
     [bookmark: pgfId-1064541]If the pool includes a range of addresses, then the ASA performs dynamic NAT. If the pool includes a single address, then the ASA performs dynamic PAT. If a pool includes both ranges and single addresses, then the ranges are used in order, and then the PAT addresses are used in order. See the “Multiple Addresses in the Same Global Pool” section for more information.

 
     [bookmark: pgfId-1064746]Pools are identified by a pool ID. If multiple global pools on different interfaces share the same pool ID, then they are grouped. If you choose a multi-interface pool ID, then traffic is translated as specified when it accesses any of the interfaces in the pool. For more information about pool IDs, see the “Dynamic NAT Implementation” section.

 
      
       
       		 [bookmark: pgfId-1064751]Create a new global pool or edit an existing pool by clicking  Manage . See the “Managing Global Pools” section.

 
       		 [bookmark: pgfId-1067183]Choose identity NAT by selecting  global pool 0 .

 
      

 
     

 
     [bookmark: pgfId-1067187]Step 5 (Optional) To enable translation of addresses inside DNS replies, expand the Connection Settings area, and check the Translate the DNS replies that match the translation rule check box.

 
     [bookmark: pgfId-1069955]If your NAT rule includes the real address of a host that has an entry in a DNS server, and the DNS server is on a different interface from a client, then the client and the DNS server need different addresses for the host; one needs the mapped address and one needs the real address. This option rewrites the address in the DNS reply to the client. The mapped host needs to be on the same interface as either the client or the DNS server. Typically, hosts that need to allow access from other interfaces use a static translation, so this option is more likely to be used with a static rule. See the “DNS and NAT” section for more information. 

 
     [bookmark: pgfId-1069861]Step 6 (Optional) To enable connection settings, expand the Connection Settings area, and set one or more of the following options:

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1070267]Note You can also set these values using a security policy rule (see Chapter 22, “Configuring Connection Settings”). If you set them in both places, then the ASA uses the lower limit. For TCP sequence randomization, if it is disabled using either method, then the ASA disables TCP sequence randomization.

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1093306] Randomize sequence number —With this check box checked (the default), the ASA randomizes the sequence number of TCP packets. Each TCP connection has two ISNs: one generated by the client and one generated by the server. The ASA randomizes the ISN of the TCP SYN passing in both the inbound and outbound directions.

 
      

 
     

 
     [bookmark: pgfId-1093310]Randomizing the ISN of the protected host prevents an attacker from predicting the next ISN for a new connection and potentially hijacking the new session.

 
     [bookmark: pgfId-1093311]TCP initial sequence number randomization can be disabled if required. For example:

 
     [bookmark: pgfId-1093312] – If another in-line firewall is also randomizing the initial sequence numbers, there is no need for both firewalls to be performing this action, even though this action does not affect the traffic.

 
     [bookmark: pgfId-1093316] – If you use eBGP multi-hop through the ASA, and the eBGP peers are using MD5. Randomization breaks the MD5 checksum.

 
     [bookmark: pgfId-1093320] – You use a WAAS device that requires the ASA not to randomize the sequence numbers of connections.

 
      
       
       		 [bookmark: pgfId-1070868] Maximum TCP Connections —Specifies the maximum number of TCP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1071136] Maximum UDP Connections  — Specifies the maximum number of UDP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1070872] Maximum Embryonic Connections  — Specifies the maximum number of embryonic connections per host up to 65,536. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. This limit enables the TCP Intercept feature. The default is  0 , which means the maximum embryonic connections. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help to minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server.

 
      

 
     

 
     [bookmark: pgfId-1071220]Step 7 Click OK.

 
     [bookmark: pgfId-1057447]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1058946][bookmark: 47841]Configuring Dynamic Policy NAT or PAT

 
     [bookmark: pgfId-1222374]Figure 6-20 shows typical dynamic policy NAT and PAT scenarios. Only real hosts can initiate connections.

 
     [bookmark: pgfId-1222376]Figure 6-20 [bookmark: 18193]Dynamic Policy NAT Scenarios

 
     [bookmark: pgfId-1222380] 
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     [bookmark: pgfId-1074027]To configure dynamic policy NAT or PAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1072272]Step 1 In the Configuration > Firewall > NAT Rules pane, choose Add > Advanced > Add Dynamic Policy NAT Rule.

 
     [bookmark: pgfId-1072273]The Add Dynamic Policy NAT Rule dialog box appears.

 
     [bookmark: pgfId-1072274]Step 2 In the Original area, from the Interface drop-down list, choose the interface that is connected to the hosts with real addresses that you want to translate.

 
     [bookmark: pgfId-1072275]Step 3 Enter the real addresses in the Source field, or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078039]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     [bookmark: pgfId-1077252]Separate multiple real addresses by a comma.

 
     [bookmark: pgfId-1074311]Step 4 Enter the destination addresses in the Destination field, or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078193]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     [bookmark: pgfId-1074866]Separate multiple destination addresses by a comma.

 
     [bookmark: pgfId-1077237]By default, the field shows any, which allows any destination address.

 
     [bookmark: pgfId-1072278]Step 5 To choose a global pool, use one of the following options:

 
      
       
       		 [bookmark: pgfId-1072279]Choose an already-defined global pool.

 
      

 
     

 
     [bookmark: pgfId-1072283]If the pool includes a range of addresses, then the ASA performs dynamic NAT. If the pool includes a single address, then the ASA performs dynamic PAT. If a pool includes both ranges and single addresses, then the ranges are used in order, and then the PAT addresses are used in order. See the “Multiple Addresses in the Same Global Pool” section for more information.

 
     [bookmark: pgfId-1072290]Pools are identified by a pool ID. If multiple global pools on different interfaces share the same pool ID, then they are grouped. If you choose a multi-interface pool ID, then traffic is translated as specified when it accesses any of the interfaces in the pool. For more information about pool IDs, see the “Dynamic NAT Implementation” section.

 
      
       
       		 [bookmark: pgfId-1092552]Create a new global pool or edit an existing pool by clicking  Manage . See the “Managing Global Pools” section.

 
       		 [bookmark: pgfId-1072312]Choose identity NAT by choosing global pool 0.

 
      

 
     

 
     [bookmark: pgfId-1077065]Step 6 (Optional) Enter a description in the Description field.

 
     [bookmark: pgfId-1072313]Step 7 (Optional) To enable translation of addresses inside DNS replies, expand the Connection Settings area, and check the Translate the DNS replies that match the translation rule check box.

 
     [bookmark: pgfId-1072314]If your NAT rule includes the real address of a host that has an entry in a DNS server, and the DNS server is on a different interface from a client, then the client and the DNS server need different addresses for the host; one needs the mapped address and one needs the real address. This option rewrites the address in the DNS reply to the client. The mapped host needs to be on the same interface as either the client or the DNS server. Typically, hosts that need to allow access from other interfaces use a static translation, so this option is more likely to be used with a static rule. See the “DNS and NAT” section for more information. 

 
     [bookmark: pgfId-1072318]Step 8 (Optional) To enable connection settings, expand the Connection Settings area, and set one or more of the following options:
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     [bookmark: pgfId-1072321]Note You can also set these values using a security policy rule. To set the number of rate intervals maintained for host statistics, on the Configuration > Firewall > Threat Detection > Scanning Threat Statistics area, choose 1, 2, or 3 from the User can specify the number of rate for Threat Detection Host drop-down list. Because host statistics use a lot of memory, reducing the number of rate intervals from the default of 3 reduces the memory usage. By default, the Firewall Dashboard Tab shows information for three rate intervals, for example, for the last 1 hour, 8 hours, and 24 hours. If you set this keyword to 1, then only the shortest rate interval statistics are maintained. If you set the value to 2, then the two shortest intervals are maintained. If you set them in both places, then the ASA uses the lower limit. For TCP sequence randomization, if it is disabled using either method, then the ASA disables TCP sequence randomization.

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1093381] Randomize sequence number —With this check box checked (the default), the ASA randomizes the sequence number of TCP packets. Each TCP connection has two ISNs: one generated by the client and one generated by the server. The ASA randomizes the ISN of the TCP SYN passing in both the inbound and outbound directions.

 
      

 
     

 
     [bookmark: pgfId-1093385]Randomizing the ISN of the protected host prevents an attacker from predicting the next ISN for a new connection and potentially hijacking the new session.

 
     [bookmark: pgfId-1093386]TCP initial sequence number randomization can be disabled if required. For example:

 
     [bookmark: pgfId-1093387] – If another in-line firewall is also randomizing the initial sequence numbers, there is no need for both firewalls to be performing this action, even though this action does not affect the traffic.

 
     [bookmark: pgfId-1093391] – If you use eBGP multi-hop through the ASA, and the eBGP peers are using MD5. Randomization breaks the MD5 checksum.

 
     [bookmark: pgfId-1093395] – You use a WAAS device that requires the ASA not to randomize the sequence numbers of connections.

 
      
       
       		 [bookmark: pgfId-1072339] Maximum TCP Connections —Specifies the maximum number of TCP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1072340] Maximum UDP Connections  — Specifies the maximum number of UDP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1072341] Maximum Embryonic Connections  — Specifies the maximum number of embryonic connections per host up to 65,536. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. This limit enables the TCP Intercept feature. The default is  0 , which means the maximum embryonic connections. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help to minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server.

 
      

 
     

 
     [bookmark: pgfId-1072342]Step 9 Click OK.

 
     [bookmark: pgfId-1072343]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1057544][bookmark: 74710][bookmark: 24763][bookmark: 69052]Using Static NAT[bookmark: marker-1057543] 

 
    [bookmark: pgfId-1057545]This section describes how to configure a static translation, using regular or policy static NAT, PAT, or identity NAT.

 
    [bookmark: pgfId-1073508]For more information about static NAT, see the “Static NAT” section.

 
    [bookmark: pgfId-1063564]Policy NAT lets you identify real addresses for address translation by specifying the source and destination addresses. You can also optionally specify the source and destination ports. Regular NAT can only consider the source addresses, and not the destination. See the “Policy NAT” section for more information.

 
    [bookmark: pgfId-1073270]Static PAT lets you translate the real IP address to a mapped IP address, as well as the real port to a mapped port. You can choose to translate the real port to the same port, which lets you translate only specific types of traffic, or you can take it further by translating to a different port. For applications that require application inspection for secondary channels (for example, FTP and VoIP), the ASA automatically translates the secondary ports. For more information about static PAT, see the “Static PAT” section.

 
    [bookmark: pgfId-1073411]You cannot use the same real or mapped address in multiple static rules between the same two interfaces unless you use static PAT. Do not use a mapped address in the static rule that is also defined in a global pool for the same mapped interface.

 
    [bookmark: pgfId-1073416]Static identity NAT translates the real IP address to the same IP address.

 
    [bookmark: pgfId-1063611]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1063739]Configuring Static NAT, PAT, or Identity NAT

 
     		 [bookmark: pgfId-1063694]Configuring Static Policy NAT, PAT, or Identity NAT

 
    

 
     
      [bookmark: pgfId-1072634][bookmark: 94376]Configuring Static NAT, PAT, or Identity NAT

 
     [bookmark: pgfId-1222388]Figure 6-21 shows typical static NAT, static PAT, and static identity NAT scenarios. The translation is always active so both translated and remote hosts can originate connections.

 
     [bookmark: pgfId-1222390]Figure 6-21 [bookmark: 56790]Static NAT Scenarios

 
     [bookmark: pgfId-1222394] 
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     [bookmark: pgfId-1075132]To configure static NAT, PAT, or identity NAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1074924]Step 1 In the Configuration > Firewall > NAT Rules pane, choose Add > Add Static NAT Rule.

 
     [bookmark: pgfId-1074925]The Add Static NAT Rule dialog box appears.

 
     [bookmark: pgfId-1074926]Step 2 In the Original area, from the Interface drop-down list, choose the interface that is connected to the hosts with real addresses that you want to translate.

 
     [bookmark: pgfId-1074927]Step 3 Enter the real addresses in the Source field, or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078107]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     [bookmark: pgfId-1075293]Step 4 In the Translated area, from the Interface drop-down list, choose the interface where you want to use the mapped addresses.

 
     [bookmark: pgfId-1075478]Step 5 Specify the mapped IP address by clicking one of the following:

 
      
       
       		 [bookmark: pgfId-1076436] Use IP Address 

 
      

 
     

 
     [bookmark: pgfId-1076499]Enter the IP address or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078180]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
      
       
       		 [bookmark: pgfId-1076441] Use Interface IP Address 

 
      

 
     

 
     [bookmark: pgfId-1076652]The real and mapped addresses must have the same subnet mask.
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     [bookmark: pgfId-1077032]Note For identity NAT, enter the same IP address in the Original and Translated fields.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1074965]Step 6 (Optional) To use static PAT, check Enable Port Address Translation (PAT).

 
     [bookmark: pgfId-1076776] a. For the Protocol, click TCP or UDP.

 
     [bookmark: pgfId-1076842] b. In the Original Port field, enter the real port number.

 
     [bookmark: pgfId-1076871] c. In the Translated Port field, enter the mapped port number.

 
     [bookmark: pgfId-1076712]Step 7 (Optional) To enable translation of addresses inside DNS replies, expand the Connection Settings area, and check the Translate the DNS replies that match the translation rule check box.

 
     [bookmark: pgfId-1074966]If your NAT rule includes the real address of a host that has an entry in a DNS server, and the DNS server is on a different interface from a client, then the client and the DNS server need different addresses for the host; one needs the mapped address and one needs the real address. This option rewrites the address in the DNS reply to the client. The mapped host needs to be on the same interface as either the client or the DNS server. See the “DNS and NAT” section for more information. 

 
     [bookmark: pgfId-1074970]Step 8 (Optional) To enable connection settings, expand the Connection Settings area, and set one or more of the following options:
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     [bookmark: pgfId-1074973]Note You can also set these values using a security policy rule. To set the number of rate intervals maintained for host statistics, on the Configuration > Firewall > Threat Detection > Scanning Threat Statistics area, choose 1, 2, or 3 from the User can specify the number of rate for Threat Detection Host drop-down list. Because host statistics use a lot of memory, reducing the number of rate intervals from the default of 3 reduces the memory usage. By default, the Firewall Dashboard Tab shows information for three rate intervals, for example, for the last 1 hour, 8 hours, and 24 hours. If you set this keyword to 1, then only the shortest rate interval statistics are maintained. If you set the value to 2, then the two shortest intervals are maintained. If you set them in both places, then the ASA uses the lower limit. For TCP sequence randomization, if it is disabled using either method, then the ASA disables TCP sequence randomization.

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1093416] Randomize sequence number —With this check box checked (the default), the ASA randomizes the sequence number of TCP packets. Each TCP connection has two ISNs: one generated by the client and one generated by the server. The ASA randomizes the ISN of the TCP SYN passing in both the inbound and outbound directions.

 
      

 
     

 
     [bookmark: pgfId-1093420]Randomizing the ISN of the protected host prevents an attacker from predicting the next ISN for a new connection and potentially hijacking the new session.

 
     [bookmark: pgfId-1093421]TCP initial sequence number randomization can be disabled if required. For example:

 
     [bookmark: pgfId-1093422] – If another in-line firewall is also randomizing the initial sequence numbers, there is no need for both firewalls to be performing this action, even though this action does not affect the traffic.

 
     [bookmark: pgfId-1093426] – If you use eBGP multi-hop through the ASA, and the eBGP peers are using MD5. Randomization breaks the MD5 checksum.

 
     [bookmark: pgfId-1093430] – You use a WAAS device that requires the ASA not to randomize the sequence numbers of connections.

 
      
       
       		 [bookmark: pgfId-1074991] Maximum TCP Connections —Specifies the maximum number of TCP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1074992] Maximum UDP Connections  — Specifies the maximum number of UDP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1074993] Maximum Embryonic Connections  — Specifies the maximum number of embryonic connections per host up to 65,536. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. This limit enables the TCP Intercept feature. The default is  0 , which means the maximum embryonic connections. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help to minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server.

 
      

 
     

 
     [bookmark: pgfId-1074994]Step 9 Click OK.

 
     [bookmark: pgfId-1074995]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1072637][bookmark: 65305]Configuring Static Policy NAT, PAT, or Identity NAT

 
     [bookmark: pgfId-1222402]Figure 6-22 shows typical static policy NAT, static policy PAT, and static policy identity NAT scenarios. The translation is always active so both translated and remote hosts can originate connections.

 
     [bookmark: pgfId-1222404]Figure 6-22 [bookmark: 82806]Static Policy NAT Scenarios

 
     [bookmark: pgfId-1222408] 
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     [bookmark: pgfId-1076926]To configure static policy NAT, PAT, or identity NAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1076927]Step 1 In the Configuration > Firewall > NAT Rules pane, choose Add > Advanced > Add Static Policy NAT Rule.

 
     [bookmark: pgfId-1076928]The Add Static Policy NAT Rule dialog box appears.

 
     [bookmark: pgfId-1076929]Step 2 In the Original area, from the Interface drop-down list, choose the interface that is connected to the hosts with real addresses that you want to translate.

 
     [bookmark: pgfId-1076930]Step 3 Enter the real addresses in the Source field, or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078116]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     [bookmark: pgfId-1077173]Step 4 Enter the destination addresses in the Destination field, or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078172]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     [bookmark: pgfId-1077239]Separate multiple destination addresses by a comma.

 
     [bookmark: pgfId-1077174]By default, the field shows any, which allows any destination address.

 
     [bookmark: pgfId-1076931]Step 5 In the Translated area, from the Interface drop-down list, choose the interface where you want to use the mapped addresses.

 
     [bookmark: pgfId-1076932]Step 6 Specify the mapped IP address by clicking one of the following:

 
      
       
       		 [bookmark: pgfId-1076933] Use IP Address 

 
      

 
     

 
     [bookmark: pgfId-1076934]Enter the IP address or click the ... button to choose an IP address that you already defined in ASDM.

 
     [bookmark: pgfId-1078217]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
      
       
       		 [bookmark: pgfId-1076935] Use Interface IP Address 

 
      

 
     

 
     [bookmark: pgfId-1076936]The real and mapped addresses must have the same subnet mask.

 
     [bookmark: pgfId-1076937]Step 7 (Optional) To use static PAT, check Enable Port Address Translation (PAT).

 
     [bookmark: pgfId-1076938] a. For the Protocol, click TCP or UDP.

 
     [bookmark: pgfId-1076939] b. In the Original Port field, enter the real port number.

 
     [bookmark: pgfId-1076940] c. In the Translated Port field, enter the mapped port number.

 
     [bookmark: pgfId-1077135]Step 8 (Optional) Enter a description in the Description field.

 
     [bookmark: pgfId-1076941]Step 9 (Optional) To enable translation of addresses inside DNS replies, expand the Connection Settings area, and check the Translate the DNS replies that match the translation rule check box.

 
     [bookmark: pgfId-1076942]If your NAT rule includes the real address of a host that has an entry in a DNS server, and the DNS server is on a different interface from a client, then the client and the DNS server need different addresses for the host; one needs the mapped address and one needs the real address. This option rewrites the address in the DNS reply to the client. The mapped host needs to be on the same interface as either the client or the DNS server. See the “DNS and NAT” section for more information. 

 
     [bookmark: pgfId-1076946]Step 10 (Optional) To enable connection settings, expand the Connection Settings area, and set one or more of the following options:

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1076949]Note You can also set these values using a security policy rule. To set the number of rate intervals maintained for host statistics, on the Configuration > Firewall > Threat Detection > Scanning Threat Statistics area, choose 1, 2, or 3 from the User can specify the number of rate for Threat Detection Host drop-down list. Because host statistics use a lot of memory, reducing the number of rate intervals from the default of 3 reduces the memory usage. By default, the the Firewall Dashboard Tab shows information for three rate intervals, for example, for the last 1 hour, 8 hours, and 24 hours. If you set this keyword to 1, then only the shortest rate interval statistics are maintained. If you set the value to 2, then the two shortest intervals are maintained. If you set them in both places, then the ASA uses the lower limit. For TCP sequence randomization, if it is disabled using either method, then the ASA disables TCP sequence randomization.

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1093443] Randomize sequence number —With this check box checked (the default), the ASA randomizes the sequence number of TCP packets. Each TCP connection has two ISNs: one generated by the client and one generated by the server. The ASA randomizes the ISN of the TCP SYN passing in both the inbound and outbound directions.

 
      

 
     

 
     [bookmark: pgfId-1093447]Randomizing the ISN of the protected host prevents an attacker from predicting the next ISN for a new connection and potentially hijacking the new session.

 
     [bookmark: pgfId-1093448]TCP initial sequence number randomization can be disabled if required. For example:

 
     [bookmark: pgfId-1093449] – If another in-line firewall is also randomizing the initial sequence numbers, there is no need for both firewalls to be performing this action, even though this action does not affect the traffic.

 
     [bookmark: pgfId-1093453] – If you use eBGP multi-hop through the ASA, and the eBGP peers are using MD5. Randomization breaks the MD5 checksum.

 
     [bookmark: pgfId-1093457] – You use a WAAS device that requires the ASA not to randomize the sequence numbers of connections.

 
      
       
       		 [bookmark: pgfId-1076967] Maximum TCP Connections —Specifies the maximum number of TCP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1076968] Maximum UDP Connections  — Specifies the maximum number of UDP connections, between 0 and 65,535. If this value is set to 0, the number of connections is unlimited.

 
       		 [bookmark: pgfId-1076969] Maximum Embryonic Connections  — Specifies the maximum number of embryonic connections per host up to 65,536. An embryonic connection is a connection request that has not finished the necessary handshake between source and destination. This limit enables the TCP Intercept feature. The default is  0 , which means the maximum embryonic connections. TCP Intercept protects inside systems from a DoS attack perpetrated by flooding an interface with TCP SYN packets. When the embryonic limit has been surpassed, the TCP intercept feature intercepts TCP SYN packets from clients to servers on a higher security level. SYN cookies are used during the validation process and help to minimize the amount of valid traffic being dropped. Thus, connection attempts from unreachable hosts will never reach the server.

 
      

 
     

 
     [bookmark: pgfId-1076970]Step 11 Click OK.

 
     [bookmark: pgfId-1076971]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1057805][bookmark: 32473][bookmark: 35467][bookmark: 41017]Using NAT Exemption[bookmark: 60147] 

 
    [bookmark: pgfId-1057943]NAT exemption exempts addresses from translation and allows both real and remote hosts to originate connections. NAT exemption lets you specify the real and destination addresses when determining the real traffic to exempt (similar to policy NAT), so you have greater control using NAT exemption than dynamic identity NAT. However unlike policy NAT, NAT exemption does not consider the ports. Use static policy identity NAT to consider ports.

 
    [bookmark: pgfId-1079558]For more information about NAT exemption, see the “Bypassing NAT When NAT Control is Enabled” section.

 
    [bookmark: pgfId-1222416]Figure 6-23 shows a typical NAT exemption scenario.

 
    [bookmark: pgfId-1222418]Figure 6-23 [bookmark: 90168]NAT Exemption

 
    [bookmark: pgfId-1222422] 

 
     
     [image: ] 
    
 
    [bookmark: pgfId-1077204]To configure NAT exemption, perform the following steps:

 
    
 
    [bookmark: pgfId-1077361]Step 1 In the Configuration > Firewall > NAT Rules pane, choose Add > Add NAT Exempt Rule.

 
    [bookmark: pgfId-1077362]The Add NAT Exempt Rule dialog box appears.

 
    [bookmark: pgfId-1077363]Step 2 Click Action: Exempt.

 
    [bookmark: pgfId-1077857]Step 3 [bookmark: 74609]In the Original area, from the Interface drop-down list, choose the interface that is connected to the hosts with real addresses that you want to exempt.

 
    [bookmark: pgfId-1077364]Step 4 Enter the real addresses in the Source field, or click the ... button to choose an IP address that you already defined in ASDM.

 
    [bookmark: pgfId-1078157]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1078158]Note You can later specify addresses that you do not want to exempt. For example, you can specify a subnet to exempt such as 10.1.1.0/24, but if you want to translate 10.1.1.50, then you can create a separate rule for that address that removes the exemption.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1077516]Separate multiple real addresses by a comma.

 
    [bookmark: pgfId-1077709]Step 5 Enter the destination addresses in the Destination field, or click the ... button to choose an IP address that you already defined in ASDM.

 
    [bookmark: pgfId-1078167]Specify the address and subnet mask using prefix/length notation, such as 10.1.1.0/24. If you enter an IP address without a mask, it is considered to be a host address, even if it ends with a 0.

 
    [bookmark: pgfId-1077710]Separate multiple destination addresses by a comma.

 
    [bookmark: pgfId-1077878]By default, the field shows any, which allows any destination address.

 
    [bookmark: pgfId-1093885]Step 6 In the NAT Exempt Direction area, choose whether you want to exempt traffic going to lower security interfaces (the default) or to higher security interfaces by clicking the appropriate radio button.

 
    [bookmark: pgfId-1077879]Step 7 (Optional) Enter a description in the Description field.

 
    [bookmark: pgfId-1077880]Step 8 [bookmark: 43879]Click OK.

 
    [bookmark: pgfId-1077915]Step 9 (Optional) If you do not want to exempt some addresses that were included in your NAT exempt rule, then create another rule to remove the exemption. Right-click the existing NAT Exempt rule, and choose Insert.

 
    [bookmark: pgfId-1078267]The Add NAT Exempt Rule dialog box appears.

 
    [bookmark: pgfId-1078268] a. Click Action: Do not exempt.

 
    [bookmark: pgfId-1078284] b. Complete Steps 3 through 8 to complete the rule.

 
    [bookmark: pgfId-1078304]The No Exempt rule is added before the Exempt rule. The order of Exempt and No Exempt rules is important. When the ASA decides whether to exempt a packet, the ASA tests the packet against each NAT exempt and No Exempt rule in the order in which the rules are listed. After a match is found, no more rules are checked.

 
    [bookmark: pgfId-1077432]
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     [bookmark: pgfId-1002608][bookmark: 94883]Configuring AAA Rules for Network Access 
      
      
 
     
 

 
    [bookmark: pgfId-1042098]This chapter describes how to enable AAA (pronounced “triple A”) for network access.

 
    [bookmark: pgfId-1059101]For information about AAA for management access, see the “Configuring AAA for System Administrators” section in the general operations configuration guide.

 
    [bookmark: pgfId-1049506]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1222577]AAA Performance

 
     		 [bookmark: pgfId-1222585]Licensing Requirements for AAA Rules

 
     		 [bookmark: pgfId-1222601]Guidelines and Limitations

 
     		 [bookmark: pgfId-1222606]Configuring Authentication for Network Access

 
     		 [bookmark: pgfId-1222614]Configuring Authorization for Network Access

 
     		 [bookmark: pgfId-1222619]Configuring Accounting for Network Access

 
     		 [bookmark: pgfId-1222624]Using MAC Addresses to Exempt Traffic from Authentication and Authorization

 
     		 [bookmark: pgfId-1222849]Feature History for AAA Rules

 
    

 
   
 
    
     [bookmark: pgfId-1042182][bookmark: 35007]AAA Per[bookmark: marker-1058839]formance[bookmark: marker-1047539]

 
    [bookmark: pgfId-1042187]The ASA uses “[bookmark: marker-1047520]cut-through proxy” to significantly improve performance compared to a traditional proxy server. The performance of a traditional proxy server suffers because it analyzes every packet at the application layer of the OSI model. The ASA cut-through proxy challenges a user initially at the application layer and then authenticates with standard AAA servers or the local database. After the ASA authenticates the user, it shifts the session flow, and all traffic flows directly and quickly between the source and destination while maintaining session state information.

 
   
 
    
     [bookmark: pgfId-1169599][bookmark: 94523]Licensing Requirements for AAA Rules

 
    [bookmark: pgfId-1169600]The following table shows the licensing requirements for this feature:

 
    [bookmark: pgfId-1412714] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1412707]Model 
         
  
        		 
          
          [bookmark: pgfId-1412709]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1412711]All models

  
        		[bookmark: pgfId-1412713]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1169616][bookmark: 54139]Guidelines and Limitations

 
    [bookmark: pgfId-1169617]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1169618]Context Mode Guidelines

 
    [bookmark: pgfId-1169619]Supported in single and multiple context mode.

 
    [bookmark: pgfId-1169620]Firewall Mode Guidelines

 
    [bookmark: pgfId-1169621]Supported in routed and transparent firewall mode.

 
    [bookmark: pgfId-1169622]IPv6 Guidelines

 
    [bookmark: pgfId-1256303]Supports IPv6.

 
    [bookmark: pgfId-1256361]Additional Guidelines

 
    [bookmark: pgfId-1256335]In clustering, this feature is only supported on the master unit.

 
   
 
    
     [bookmark: pgfId-1256307][bookmark: 38092]Configuring Authentication for Network Access[bookmark: marker-1256305][bookmark: marker-1256306]

 
    [bookmark: pgfId-1256308]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1223375]Information About Authentication

 
     		 [bookmark: pgfId-1223386]Configuring Network Access Authentication

 
     		 [bookmark: pgfId-1399919]Enabling the Redirection Method of Authentication for HTTP and HTTPS

 
     		 [bookmark: pgfId-1223656]Enabling Secure Authentication of Web Clients

 
     		 [bookmark: pgfId-1223709]Authenticating Directly with the ASA

 
     		 [bookmark: pgfId-1399927]Configuring the Authentication Proxy Limit

 
    

 
     
      [bookmark: pgfId-1150065][bookmark: 82854]Information About Authentication

 
     [bookmark: pgfId-1150069]The ASA lets you configure network access authentication using AAA servers. This section includes the following topics:

 
      
      		 [bookmark: pgfId-1224364]One-Time Authentication

 
      		 [bookmark: pgfId-1224375]Applications Required to Receive an Authentication Challenge

 
      		 [bookmark: pgfId-1224585]ASA Authentication Prompts

 
      		 [bookmark: pgfId-1304953]AAA Prompts and Identity Firewall

 
      		 [bookmark: pgfId-1331850]AAA Rules as a Backup Authentication Method

 
      		 [bookmark: pgfId-1224638]Static PAT and HTTP

 
     

 
    
 
     
      [bookmark: pgfId-1150091][bookmark: 94045]One-Time Authentication

 
     [bookmark: pgfId-1150092]A user at a given IP address only needs to authenticate one time for all rules and types, until the authentication session expires. (See the Configuration > Firewall > Advanced > Global Timeouts pane for timeout values.) For example, if you configure the ASA to authenticate Telnet and FTP, and a user first successfully authenticates for Telnet, then as long as the authentication session exists, the user does not also have to authenticate for FTP.

 
    
 
     
      [bookmark: pgfId-1150100][bookmark: 46775]Applications Required to Receive an Authentication Challenge

 
     [bookmark: pgfId-1150104]Although you can configure the ASA to require authentication for network access to any protocol or service, users can authenticate directly with HTTP, HTTPS, Telnet, or FTP only. A user must first authenticate with one of these services before the ASA allows other traffic requiring authentication.

 
     [bookmark: pgfId-1150111]The authentication ports that the ASA supports for AAA are fixed as follows:

 
      
      		 [bookmark: pgfId-1150112]Port 21 for FTP

 
      		 [bookmark: pgfId-1150113]Port 23 for Telnet

 
      		 [bookmark: pgfId-1150114]Port 80 for HTTP

 
      		 [bookmark: pgfId-1150115]Port 443 for HTTPS

 
     

 
    
 
     
      [bookmark: pgfId-1150117][bookmark: 33272]ASA Authentication Prompts

 
     [bookmark: pgfId-1150122]For Telnet[bookmark: marker-1150118] and FTP, the ASA generates an authentication prompt.

 
     [bookmark: pgfId-1150126]For HTTP, the ASA uses basic HTTP authentication by default, and provides an authentication prompt. You can optionally configure the ASA to redirect users to an internal web page where they can enter their username and password (configured in the Configuration > Firewall > AAA Rules > Advanced > AAA Rules Advanced Options dialog box; see the “Enabling the Redirection Method of Authentication for HTTP and HTTPS” section).

 
     [bookmark: pgfId-1216826]For HTTPS[bookmark: marker-1216819], the ASA generates a custom login screen. You can optionally configure the ASA to redirect users to an internal web page where they can enter their username and password (configured in the Configuration > Firewall > AAA Rules > Advanced > AAA Rules Advanced Options dialog box; see the “Enabling the Redirection Method of Authentication for HTTP and HTTPS” section).

 
     [bookmark: pgfId-1216830]Redirection is an improvement over the basic method because it provides an improved user experience during authentication, and an identical user experience for HTTP and HTTPS in both Easy VPN and firewall modes. It also supports authentication directly with the ASA.

 
     [bookmark: pgfId-1150144]You might want to continue to use basic HTTP authentication for the following reasons: 

 
      
      		 [bookmark: pgfId-1151666]You do not want the ASA to open listening ports. 

 
      		 [bookmark: pgfId-1151675]You use NAT on a router and you do not want to create a translation rule for the web page served by the ASA. 

 
      		 [bookmark: pgfId-1151680]Basic HTTP authentication might work better with your network. 

 
     

 
     [bookmark: pgfId-1151687]For example non-browser applications, as when a URL is embedded in e-mail, might be more compatible with basic authentication.

 
     [bookmark: pgfId-1150152]After you authenticate correctly, the ASA redirects you to your original destination. If the destination server also has its own authentication, the user enters another username and password. If you use basic HTTP authentication and need to enter another username and password for the destination server, then you need to configure virtual HTTP [bookmark: marker-1399953](see the Configuration >Firewall > Advanced Options > Virtual Access pane).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1150154]Note If you use HTTP authentication, by default the username and password are sent from the client to the ASA in clear text; in addition, the username and password are sent on to the destination web server as well. See the “Enabling Secure Authentication of Web Clients” section for information to secure your credentials.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1150166]For FTP[bookmark: marker-1150161][bookmark: marker-1150162], a user has the option of entering the ASA username followed by an at sign (@) and then the FTP username (name1@name2). For the password, the user enters the ASA password followed by an at sign (@) and then the FTP password (password1@password2). For example, enter the following text:

 
      
      [bookmark: pgfId-1150170]name> name1@name2 
     
 
      
      [bookmark: pgfId-1150171]password> password1@password2 
     
 
      
      [bookmark: pgfId-1150172]  
     
 
     [bookmark: pgfId-1150173]This feature is useful when you have cascaded firewalls that require multiple logins. You can separate several names and passwords by multiple at signs (@).

 
    
 
     
      [bookmark: pgfId-1300479][bookmark: 78464]AAA Prompts and Identity Firewall

 
     [bookmark: pgfId-1300480]In an enterprise, some users log into the network by using other authentication mechanisms, such as authenticating with a web portal (cut-through proxy). For example, users with a Mac and Linux client might log into a web portal (cut-through proxy). Therefore, you must configure the identity firewall to allow these types of authentication in connection with identity-based access policies.

 
     [bookmark: pgfId-1300484]Figure 8-1 shows a deployment to support a cut-through proxy authentication captive portal. Active Directory servers and the AD Agent are installed on the main site LAN. However, the identity firewall is configured to support authentication of clients that are not part of the Active Directory domain. 

 
     [bookmark: pgfId-1300489]Figure 8-1 [bookmark: 59546]Deployment Supporting Cut-through Proxy Authentication

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1300490] 

 
     [bookmark: pgfId-1300494]The ASA designates users logging in through a web portal (cut-through proxy) as belonging to the Active Directory domain with which they authenticated.

 
     [bookmark: pgfId-1300502]The ASA reports users logging in through a web portal (cut-through proxy) to the AD Agent, which distributes the user information to all registered ASA devices. In this case, the identity firewall can associate the users with their Active Directory domain. Specifically, the user identity-IP address mappings of authenticated users are forwarded to all ASA contexts that contain the input interface where packets are received and authenticated.

 
     [bookmark: pgfId-1300506]Users can log in by using HTTP/HTTPS, FTP, Telnet, or SSH. When users log in with these authentication methods, the following guidelines apply:

 
      
      		 [bookmark: pgfId-1300507]For HTTP/HTTPS traffic, an authentication window appears for unauthenticated users. 

 
      		 [bookmark: pgfId-1300508]For Telnet and FTP traffic, users must log in through the cut-through proxy server and again to the Telnet and FTP servers.

 
      		 [bookmark: pgfId-1300509]A user can specify an Active Directory domain while providing login credentials (in the format, domain\username). The ASA automatically selects the associated AAA server group for the specified domain.

 
      		 [bookmark: pgfId-1300513]If a user specifies an Active Directory domain while providing login credentials (in the format, domain\username), the ASA parses the domain and uses it to select an authentication server from the AAA servers that have been configured for the identity firewall. Only the username is passed to the AAA server.

 
      		 [bookmark: pgfId-1300520]If the backslash (\) delimiter is not found in the login credentials, the ASA does not parse the domain and authentication is conducted with the AAA server that corresponds to the default domain configured for the identity firewall. 

 
      		 [bookmark: pgfId-1300524]If a default domain or a server group is not configured for that default domain, the ASA rejects the authentication.

 
      		 [bookmark: pgfId-1331731]If the domain is not specified, the ASA selects the AAA server group for the default domain that is configured for the identity firewall. 

 
     

 
    
 
     
      [bookmark: pgfId-1331756][bookmark: 39482]AAA Rules as a Backup Authentication Method

 
     [bookmark: pgfId-1331837]An authentication rule (also known as “cut-through proxy”) controls network access based on the user. Because this function is very similar to an access rule plus an identity firewall, AAA rules can now be used as a backup method of authentication if a user AD login expires or a valid user has not yet logged into AD. For example, for any user without a valid login, you can trigger a AAA rule. To ensure that the AAA rule is only triggered for users that do not have valid logins, you can specify special usernames in the extended ACL that are used for the access rule and for the AAA rule: None (users without a valid login) and Any (users with a valid login). In the access rule, configure your policy as usual for users and groups, but then include a rule that permits all None users before deny any any; you must permit these users so they can later trigger a AAA rule. Then, configure a AAA rule that does not match Any users (these users are not subject to the AAA rule, and were handled already by the access rule), but matches all None users only to trigger AAA authentication for these users. After the user has successfully logged in via cut-through proxy, the traffic will flow normally again. 

 
    
 
     
      [bookmark: pgfId-1331733][bookmark: 73214]Static PAT and HTTP

 
     [bookmark: pgfId-1331737]For HTTP authentication, the ASA checks real ports when static PAT is configured. If it detects traffic destined for real port 80, regardless of the mapped port, the ASA intercepts the HTTP connection and enforces authentication.

 
     [bookmark: pgfId-1150183]For example, assume that outside TCP port 889 is translated to port 80 and that any relevant ACLs permit the traffic:

 
      
      [bookmark: pgfId-1150184]object network obj-192.168.123.10-01 
     
 
      
      [bookmark: pgfId-1186395]host 192.168.123.10 
     
 
      
      [bookmark: pgfId-1186423]nat (inside,outside) static 10.48.66.155 service tcp 80 889 
     
 
      
      [bookmark: pgfId-1150185]  
     
 
     [bookmark: pgfId-1150189]Then when users try to access 10.48.66.155 on port 889, the ASA intercepts the traffic and enforces HTTP authentication. Users see the HTTP authentication page in their web browsers before the ASA allows HTTP connection to complete.

 
     [bookmark: pgfId-1150193]If the local port is different than port 80, as in the following example:

 
      
      [bookmark: pgfId-1186451]object network obj-192.168.123.10-02 
     
 
      
      [bookmark: pgfId-1186452]host 192.168.123.10 
     
 
      
      [bookmark: pgfId-1186453]nat (inside,outside) static 10.48.66.155 service tcp 111 889 
     
 
      
      [bookmark: pgfId-1186454]  
     
 
     [bookmark: pgfId-1150199]Then users do not see the authentication page. Instead, the ASA sends an error message to the web browser, indicating that the user must be authenticated before using the requested service.

 
     [bookmark: pgfId-1389398]When a mapped address is used for static PAT, it is automatically placed into the dynamic PAT pool.

 
     [bookmark: pgfId-1389401]For instance, this configuration,

 
      
      [bookmark: pgfId-1389403]object network my-ftp-server 
     
 
      
      [bookmark: pgfId-1389404]host <real-server> 
     
 
      
      [bookmark: pgfId-1389405]nat (inside,outside) static <mapped-server> ftp ftp 
     
 
      
      [bookmark: pgfId-1390185]  
     
 
     [bookmark: pgfId-1389688]is equivalent to

 
      
      [bookmark: pgfId-1389409]object network my-ftp-server 
     
 
      
      [bookmark: pgfId-1389410]host <real-server> 
     
 
      
      [bookmark: pgfId-1389411]nat (inside,outside) static <mapped-server> ftp ftp 
     
 
      
      [bookmark: pgfId-1389719]  
     
 
      
      [bookmark: pgfId-1389413]object network <internal> 
     
 
      
      [bookmark: pgfId-1389414]nat (inside,outside) dynamic <mapped-server> 
     
 
      
      [bookmark: pgfId-1389745]  
     
 
     [bookmark: pgfId-1389416]The second line ensures that all PAT bindings are accounted for.This accounting is necessary to avoid connection failure from port collision.

 
     [bookmark: pgfId-1389784]As the the mapped address is placed under dynamic PAT, any additional service that is to be accessed through the mapped address, must also be explicitly configured.

 
     [bookmark: pgfId-1389424]For example, the following is the correct configuration for three services through address 192.150.49.10. Additionally, the SMTP and HTTP services also reside at a host with the same address as the mapped address, 192.150.49.10.

 
      
      [bookmark: pgfId-1389936]object network my-ftp-server 
     
 
      
      [bookmark: pgfId-1389937]host <real-server> 
     
 
      
      [bookmark: pgfId-1389938]nat (inside,outside) static <mapped-server> ftp ftp 
     
 
      
      [bookmark: pgfId-1389987]  
     
 
      
      [bookmark: pgfId-1390048]object network my-ftp-server 
     
 
      
      [bookmark: pgfId-1390049]host "192.150.49.10" 
     
 
      
      [bookmark: pgfId-1390050]nat (inside,outside) static 192.150.49.10 smtp smtp 
     
 
      
      [bookmark: pgfId-1390084]  
     
 
      
      [bookmark: pgfId-1389437]object network my-ftp-server 
     
 
      
      [bookmark: pgfId-1389438]host "192.150.49.10" 
     
 
      
      [bookmark: pgfId-1389396]nat (inside,outside) static 192.150.49.10 http http 
     
 
    
 
     
      [bookmark: pgfId-1150203][bookmark: 97363]Configuring Network Access Authentication[bookmark: marker-1150202]

 
     [bookmark: pgfId-1150204]To configure network access authentication, perform the following steps:

 
     
 
     [bookmark: pgfId-1399959]Step 1 In the Configuration > Firewall > AAA Rules pane, choose Add > Add Authentication Rule.

 
     [bookmark: pgfId-1399960]The Add Authentication Rule dialog box appears.

 
     [bookmark: pgfId-1399961]Step 2 In the Interface drop-down list, choose the interface for applying the rule.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1399962]Tip In the Action field, click one of the following, depending on the implementation:

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1399963] Authenticate 

 
       		 [bookmark: pgfId-1399964] Do not Authenticate 

 
      

 
     

 
     [bookmark: pgfId-1399965]Step 3 In the AAA Server Group drop-down list, choose a server group. To add a AAA server to the server group, click Add Server.

 
     [bookmark: pgfId-1399966]If you chose LOCAL for the AAA server group, you can optionally add a new user by clicking Add User. See the “Adding a User Account to the Local Database” section in the general operations configuration guide for more information.

 
     [bookmark: pgfId-1399973]Step 4 In the Source field, add the source IP address, or click the ellipsis (...) to choose an IP address already defined in ASDM.

 
     [bookmark: pgfId-1399974]Step 5 In the Destination field, enter the destination IP address, or click the ellipsis (...) to choose an IP address already defined in ASDM.

 
     [bookmark: pgfId-1399975]Step 6 In the Service field, enter an IP service name or number for the destination service, or click the ellipsis (...) to choose a service.

 
     [bookmark: pgfId-1399976]Step 7 (Optional) In the Description field, enter a description.

 
     [bookmark: pgfId-1399977]Step 8 (Optional) Click More Options to do any of the following:

 
      
       
       		 [bookmark: pgfId-1399978]To specify a source service for TCP or UDP, enter a TCP or UDP service in the Source Service field.

 
       		 [bookmark: pgfId-1399979]The destination service and source service must be the same. Copy and paste the destination Service field to the Source Service field.

 
       		 [bookmark: pgfId-1399980]To make the rule inactive, clear the  Enable Rule check box.

 
      

 
     

 
     [bookmark: pgfId-1399981]You may not want to remove a rule, but instead turn it off.

 
      
       
       		 [bookmark: pgfId-1399982]To set a time range for the rule, In the Time Range drop-down list, choose an existing time range. To add a new time range, click the ellipsis (...). For more information, see the “Configuring Time Ranges” section in the general operations configuration guide.

 
      

 
     

 
     [bookmark: pgfId-1399989]Step 9 Click OK.

 
     [bookmark: pgfId-1399990]The Add Authentication Rule dialog box closes and the rule appears in the AAA Rules table.

 
     [bookmark: pgfId-1399991]Step 10 Click Apply.

 
     [bookmark: pgfId-1399992]The changes are saved to the running configuration.

 
     [bookmark: pgfId-1399993]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1155032]For more information about authentication, see the “Information About Authentication” section.

 
    
 
     
      [bookmark: pgfId-1399999][bookmark: 75682]Enabling the Redirection Method of Authentication for HTTP and HTTPS

 
     [bookmark: pgfId-1400001]This method of authentication enables HTTP(S) listening ports to authenticate network users. When you enable a listening port, the ASA serves an authentication page for direct connections and, by enabling redirection, for through traffic. This method also prevents the authentication credentials from continuing to the destination server. See the “ASA Authentication Prompts” section for more information about the redirection method compared to the basic method.

 
     [bookmark: pgfId-1400008]To enable a AAA listener, perform the following steps:

 
     
 
     [bookmark: pgfId-1400009]Step 1 In the Configuration > Firewall > AAA Rules pane, click Advanced.

 
     [bookmark: pgfId-1400010]The AAA Rules Advanced Options dialog box appears.

 
     [bookmark: pgfId-1400011]Step 2 Under Interactive Authentication, click Add.

 
     [bookmark: pgfId-1400012]The Add Interactive Authentication Entry dialog box appears.

 
     [bookmark: pgfId-1400013]Step 3 For the Protocol, choose either HTTP or HTTPS. You can enable both by repeating this procedure and creating two separate rules.

 
     [bookmark: pgfId-1400014]Step 4 In the Interface drop-down list, choose the interface on which you want to enable the listener.

 
     [bookmark: pgfId-1400015]Step 5 In the Port drop-down list, choose the port or enter a number. 

 
     [bookmark: pgfId-1400019]This is the port that the ASA listens on for direct or redirected traffic; the defaults are 80 (HTTP) and 443 (HTTPS). You can use any port number and retain the same functionality, but be sure your direct authentication users know the port number; redirected traffic is sent to the correct port number automatically, but direct authenticators must specify the port number manually.

 
     [bookmark: pgfId-1400020]Step 6 (Optional) Check Redirect network users for authentication request.

 
     [bookmark: pgfId-1400024]This option redirects through traffic to an authentication web page served by the ASA. Without this option, only traffic directed to the ASA interface can access the authentication web pages.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1400028]Note If you enable the redirect option, you cannot also configure static PAT for the same interface where you translate the interface IP address and the same port that is used for the listener; NAT succeeds, but authentication fails.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1400029]Step 7 Click OK, and then click OK again to close the AAA Rules Advanced Options dialog box.

 
     [bookmark: pgfId-1400030]Step 8 Click Apply.

 
     [bookmark: pgfId-1400031]The changes are saved to the running configuration.

 
     [bookmark: pgfId-1400032]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1150372][bookmark: 66940]Enabling Secure Authentication of Web Clients

 
     [bookmark: pgfId-1150373]If you use HTTP authentication, by default the username and password are sent from the client to the ASA in clear text; in addition, the username and password are sent to the destination web server as well.

 
     [bookmark: pgfId-1150383][bookmark: marker-1150377][bookmark: marker-1150378][bookmark: marker-1150379]The ASA provides the following methods for securing HTTP authentication:

 
      
      		 [bookmark: pgfId-1150384]Enable the redirection method of authentication for HTTP—See the “Enabling the Redirection Method of Authentication for HTTP and HTTPS” section. This method prevents the authentication credentials from continuing to the destination server. [bookmark: marker-1155056][bookmark: marker-1155057][bookmark: marker-1155058]See the “ASA Authentication Prompts” section for more information about the redirection method compared to the basic method.

 
      		 [bookmark: pgfId-1155083]Enable virtual HTTP— Virtual HTTP lets you authenticate separately with the ASA and with the HTTP server. Even if the HTTP server does not need a second authentication, this command achieves the effect of stripping the basic authentication credentials from the HTTP GET request. See the “Authenticating HTTP(S) Connections with a Virtual Server” section for more information.

 
      		 [bookmark: pgfId-1400058]Enable the exchange of usernames and passwords between a web client and the ASA with HTTPS—To enable the exchange of usernames and passwords between a web client and the ASA with HTTPS, perform the following steps:

 
     

 
     [bookmark: pgfId-1400059] a. In the Configuration > Firewall > AAA Rules pane, click Advanced. The AAA Rules Advanced Options dialog box appears.

 
     [bookmark: pgfId-1400060] b. Under Secure HTTP, click Enable Secure HTTP.

 
     [bookmark: pgfId-1400061] c. Click OK, and then click OK again to close the AAA Rules Advanced Options dialog box.

 
     [bookmark: pgfId-1400062] d. Click Apply.

 
     [bookmark: pgfId-1155108]This is the only method that protects credentials between the client and the ASA, as well as between the ASA and the destination server. You can use this method alone, or in conjunction with either of the other methods so you can maximize your security.

 
     [bookmark: pgfId-1150407]After enabling this feature, when a user requires authentication when using HTTP, the ASA redirects the HTTP user to an HTTPS prompt. After you authenticate correctly, the ASA redirects you to the original HTTP URL.

 
     [bookmark: pgfId-1150412]Secured, web-client authentication has the following limitations:

 
     [bookmark: pgfId-1150413] – A maximum of 64 concurrent HTTPS authentication sessions are allowed. If all 64 HTTPS authentication processes are running, a new connection requiring authentication will not succeed.

 
     [bookmark: pgfId-1150414] – When the uauth timeout is set to unlimited, HTTPS authentication might not work. If a browser initiates multiple TCP connections to load a web page after HTTPS authentication, the first connection is let through, but the subsequent connections trigger authentication. As a result, users are continuously presented with an authentication page, even if the correct username and password are entered each time. To work around this, set the uauth timeout to one second (see the Configuration > Firewall > Advanced > Global Timeouts pane). However, this workaround opens a 1-second window of opportunity that might allow unauthenticated users to go through the firewall if they are coming from the same source IP address.

 
     [bookmark: pgfId-1161331]Because HTTPS authentication occurs on the SSL port 443, users must not configure an access ruleto block traffic from the HTTP client to the HTTP server on port 443. Furthermore, if static PAT is configured for web traffic on port 80, it must also be configured for the SSL port.

 
    
 
     
      [bookmark: pgfId-1161351][bookmark: 87682]Authenticating Directly with the ASA 

 
     [bookmark: pgfId-1155488]If you do not want to allow HTTP, HTTPS, Telnet, or FTP through the ASA but want to authenticate other types of traffic, you can authenticate with the ASA directly using HTTP, HTTPS, or Telnet.

 
     [bookmark: pgfId-1155615]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1225034]Authenticating HTTP(S) Connections with a Virtual Server

 
      		 [bookmark: pgfId-1225172]Authenticating Telnet Connections with a Virtual Server

 
     

 
    
 
     
      [bookmark: pgfId-1157043][bookmark: 42923]Authenticating HTTP(S) Connections with a Virtual Server

 
     [bookmark: pgfId-1150441]If you enabled the redirection method of HTTP and HTTPS authentication in the “Configuring Network Access Authentication” section, then you have also automatically enabled direct authentication.

 
     [bookmark: pgfId-1150443]When you use HTTP authentication on the ASA (see the“Configuring Network Access Authentication” section), the ASA uses basic HTTP authentication by default. 

 
     [bookmark: pgfId-1400085]You can change the authentication method so that the ASA redirects HTTP connections to web pages generated by the ASA itself using the “Enabling the Redirection Method of Authentication for HTTP and HTTPS” section.

 
     [bookmark: pgfId-1400092]However, if you continue to use basic HTTP authentication, then you might need the virtual HTTP server when you have cascading HTTP authentications. 

 
     [bookmark: pgfId-1400096]If the destination HTTP server requires authentication in addition to the ASA, then virtual HTTP lets you authenticate separately with the ASA (via a AAA server) and with the HTTP server. Without virtual HTTP, the same username and password that you used to authenticate with the ASA is sent to the HTTP server; you are not prompted separately for the HTTP server username and password. Assuming the username and password are not the same for the AAA and HTTP servers, then the HTTP authentication fails.

 
     [bookmark: pgfId-1400103]This feature redirects all HTTP connections that require AAA authentication to the virtual HTTP server on the ASA. The ASA prompts for the AAA server username and password. After the AAA server authenticates the user, the ASA redirects the HTTP connection back to the original server, but it does not include the AAA server username and password. Because the username and password are not included in the HTTP packet, the HTTP server prompts the user separately for the HTTP server username and password.

 
     [bookmark: pgfId-1400113]For inbound users (from lower security to higher security), you must also include the virtual HTTP address as a destination interface in the access rule applied to the source interface. Moreover, you must add a static NAT rule for the virtual HTTP IP address, even if NAT is not required. An identity NAT rule is typically used (where you translate the address to itself).

 
     [bookmark: pgfId-1400114]For outbound users, there is an explicit permit for traffic, but if you apply an access rule to an inside interface, be sure to allow access to the virtual HTTP address. A static NAT rule is not required.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1400115]Note Do not set the uauth timeout duration to 0 seconds when using virtual HTTP, because this setting prevents HTTP connections to the real web server. See the “Configuring Global Timeouts” section.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1400122]You can authenticate directly with the ASA at the following URLs when you enable AAA for the interface:

 
      
      [bookmark: pgfId-1400123]http://interface_ip[:port]/netaccess/connstatus.html 
     
 
      
      [bookmark: pgfId-1400124]https://interface_ip[:port]/netaccess/connstatus.html 
     
 
      
      [bookmark: pgfId-1400125]  
     
 
     [bookmark: pgfId-1400129]To allow users to authenticate with the ASA virtual server separately from the HTTP server, perform the following steps: 

 
     
 
     [bookmark: pgfId-1400130]Step 1 In the Configuration > Firewall > Advanced > Virtual Access > Virtual HTTP Server area, check the Enable check box.

 
     [bookmark: pgfId-1400131]Step 2 In the Virtual HTTP Server field, add the IP address of the virtual HTTP server.

 
     [bookmark: pgfId-1400135]Make sure this address is an unused address that is routed to the ASA. For example, if you perform NAT for inside addresses accessing an outside server, and you want to provide outside access to the virtual HTTP server, you can use one of the global NAT addresses for the virtual HTTP server address.

 
     [bookmark: pgfId-1400136]Step 3 (Optional) If you are using text-based browsers, where redirection does not happen automatically, check the Display redirection warning check box. This enables an alert to notify users when the HTTP connection is being redirected.

 
     [bookmark: pgfId-1400137]Step 4 Click Apply.

 
     [bookmark: pgfId-1400138]The virtual server is added and the changes are saved to the running configuration. 

 
     [bookmark: pgfId-1400139]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1150511][bookmark: 16361]Authenticating Telnet Connections with a Virtual Server

 
     [bookmark: pgfId-1159626]Although you can configure network access authentication for any protocol or service(see the “Configuring Network Access Authentication” section), you can authenticate directly with HTTP, Telnet, or FTP only. A user must first authenticate with one of these services before other traffic that requires authentication is allowed through. If you do not want to allow HTTP, Telnet, or FTP traffic through the ASA, but want to authenticate other types of traffic, you can configure virtual Telnet; the user Telnets to a given IP address configured on the ASA, and the ASA issues a Telnet prompt.

 
     [bookmark: pgfId-1400152]When an unauthenticated user connects to the virtual Telnet IP address, the user is challenged for a username and password, and then authenticated by the AAA server. After the user is authenticated, the message “Authentication Successful” appears. Then the user can successfully access other services that require authentication.

 
     [bookmark: pgfId-1400153]For inbound users (from lower security to higher security), you must also include the virtual Telnet address as a destination interface in the access rule applied to the source interface. In addition, you must add a static NAT rule for the virtual Telnet IP address, even if NAT is not required. An identity NAT rule is typically used (where you translate the address to itself).

 
     [bookmark: pgfId-1400154]For outbound users, there is an explicit permit for traffic, but if you apply an access rule to an inside interface, be sure to allow access to the virtual Telnet address. A static NAT rule is not required.

 
     [bookmark: pgfId-1400158]To log out from the ASA, reconnect to the virtual Telnet IP address; you are prompted to log out.

 
      
      [bookmark: pgfId-1186693]  
     
 
     [bookmark: pgfId-1400163]To enable direct authentication using Telnet, perform the following steps:

 
     
 
     [bookmark: pgfId-1400164]Step 1 In the Configuration > Firewall > Advanced > Virtual Access > Virtual Telnet Server area, check the Enable check box.

 
     [bookmark: pgfId-1400165]Step 2 In the Virtual Telnet Server field, enter the IP address of the virtual Telnet server.

 
     [bookmark: pgfId-1400169]Make sure that this address is an unused address that is routed to the ASA. For example, if you perform NAT for inside addresses accessing an outside server, and you want to provide outside access to the virtual HTTP server, you can use one of the global NAT addresses for the virtual HTTP server address.

 
     [bookmark: pgfId-1400170]Step 3 Click Apply.

 
     [bookmark: pgfId-1400171]The virtual server is added and the changes are saved to the running configuration.

 
     [bookmark: pgfId-1400172]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1400175][bookmark: 66472]Configuring the Authentication Pro[bookmark: marker-1400174]xy Limit

 
     [bookmark: pgfId-1400176]You can manually configure the uauth session limit by setting the maximum number of concurrent proxy connections allowed per user.

 
     [bookmark: pgfId-1400177]To set the proxy limit, perform the following steps:

 
     
 
     [bookmark: pgfId-1400178]Step 1 Choose Configuration > Firewall > AAA Rules, then click Advanced.

 
     [bookmark: pgfId-1400179]The AAA Rules Advanced Options dialog box appears.

 
     [bookmark: pgfId-1400180]Step 2 In the Proxy Limit area, check the Enable Proxy Limit check box.

 
     [bookmark: pgfId-1400181]Step 3 In the Proxy Limit field, enter the number of concurrent proxy connections allowed per user, from 1 to 128.

 
     [bookmark: pgfId-1400182]Step 4 Click OK, then click Apply.

 
     [bookmark: pgfId-1400183]The changes are saved to the running configuration.

 
     [bookmark: pgfId-1400184]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1150608][bookmark: 83802]Configuring Authorization for Network Access[bookmark: marker-1150606][bookmark: marker-1150607]

 
    [bookmark: pgfId-1150612]After a user authenticates for a given connection, the ASA can use authorization to further control traffic from the user.

 
    [bookmark: pgfId-1150613]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1225205]Configuring TACACS+ Authorization

 
     		 [bookmark: pgfId-1225225]Configuring RADIUS Authorization

 
    

 
     
      [bookmark: pgfId-1150624][bookmark: 51228]Configuring TACACS+ Authorization[bookmark: marker-1150623]

 
     [bookmark: pgfId-1157072]You can configure the ASA to perform network access authorization with TACACS+. Authentication and authorization statements are independent; however, any unauthenticated traffic matched by an authorization rule will be denied.For authorization to succeed:

 
     [bookmark: pgfId-1157076] 1. A user must first authenticate with the ASA.

 
     [bookmark: pgfId-1157077]Because a user at a given IP address only needs to authenticate one time for all rules and types, if the authentication session has not expired, authorization can occur even if the traffic is not matched by an authentication rule.

 
     [bookmark: pgfId-1157081] 2. After a user authenticates, the ASA checks the authorization rules for matching traffic.

 
     [bookmark: pgfId-1157085] 3. If the traffic matches the authorization rule, the ASA sends the username to the TACACS+ server.

 
     [bookmark: pgfId-1157089] 4. The TACACS+ server responds to the ASA with a permit or a deny for that traffic, based on the user profile.

 
     [bookmark: pgfId-1157093] 5. The ASA enforces the authorization rule in the response.

 
     [bookmark: pgfId-1157094]See the documentation for your TACACS+ server for information about configuring network access authorizations for a user.

 
     [bookmark: pgfId-1150630]To configure TACACS+ authorization, perform the following steps:

 
     
 
     [bookmark: pgfId-1400191]Step 1 Enable authentication. For more information, see the “Configuring Network Access Authentication” section. If you have already enabled authentication, continue to the next step.

 
     [bookmark: pgfId-1400193]Step 2 In the Configuration > Firewall > AAA Rules pane, choose Add > Add Authorization Rule.

 
     [bookmark: pgfId-1400194]The Add Authorization Rule dialog box appears.

 
     [bookmark: pgfId-1400195]Step 3 In the Interface drop-down list, choose the interface for applying the rule.

 
     [bookmark: pgfId-1400196]Step 4 In the Action field, click one of the following, depending on the implementation:

 
      
       
       		 [bookmark: pgfId-1400197] Authorize 

 
       		 [bookmark: pgfId-1400198] Do not Authorize 

 
      

 
     

 
     [bookmark: pgfId-1400199]Step 5 In the AAA Server Group drop-down list, choose a server group. To add a AAA server to the server group, click Add Server.

 
     [bookmark: pgfId-1400200]Only TACACS+ servers are supported.

 
     [bookmark: pgfId-1400201]Step 6 In the Source field, add the source IP address, or click the ellipsis (...) to choose an IP address already defined in ASDM.

 
     [bookmark: pgfId-1400202]Step 7 In the Destination field, enter the destination IP address, or click the ellipsis (...) to choose an IP address already defined in ASDM.

 
     [bookmark: pgfId-1400203]Step 8 In the Service field, enter an IP service name or number for the destination service, or click the ellipsis (...) to choose a service.

 
     [bookmark: pgfId-1400204]Step 9 (Optional) In the Description field, enter a description.

 
     [bookmark: pgfId-1400205]Step 10 (Optional) Click More Options to do any of the following:

 
      
       
       		 [bookmark: pgfId-1400206]To specify a source service for TCP or UDP, enter a TCP or UDP service in the Source Service field.

 
       		 [bookmark: pgfId-1400207]The destination service and source service must be the same. Copy and paste the Destination Service field content into the Source Service field.

 
       		 [bookmark: pgfId-1400208]To make the rule inactive, clear the  Enable Rule check box.

 
      

 
     

 
     [bookmark: pgfId-1400209]You may not want to remove a rule, but instead turn it off.

 
      
       
       		 [bookmark: pgfId-1400210]To set a time range for the rule, in the Time Range drop-down list, choose an existing time range. To add a new time range, click the ellipsis (...). For more information, see the “Configuring Time Ranges” section in the general operations configuration guide.

 
      

 
     

 
     [bookmark: pgfId-1400217]Step 11 Click OK.

 
     [bookmark: pgfId-1400218]The Add Authorization Rule dialog box closes, and the rule appears in the AAA Rules table.

 
     [bookmark: pgfId-1400219]Step 12 Click Apply.

 
     [bookmark: pgfId-1400220]The changes are saved to the running configuration.

 
     [bookmark: pgfId-1400221]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1150820][bookmark: 44679]Configuring RADIUS Authorization[bookmark: marker-1150818][bookmark: marker-1150819]

 
     [bookmark: pgfId-1150821]When authentication succeeds, the RADIUS protocol returns user authorizations in the access-accept message sent by a RADIUS server. For more information about configuring authentication, see the “Configuring Network Access Authentication” section.

 
     [bookmark: pgfId-1150828]When you configure the ASA to authenticate users for network access, you are also implicitly enabling RADIUS authorizations; therefore, this section contains no information about configuring RADIUS authorization on the ASA. It does provide information about how the ASA handles ACL information received from RADIUS servers.

 
     [bookmark: pgfId-1150838]You can configure a RADIUS server to download an ACL to the ASA or an ACL name at the time of authentication. The user is authorized to do only what is permitted in the user-specific ACL.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1150839]Note If you have enabled the Per User Override Setting (see the Configuration > Firewall > Access Rules > Advanced > Access Rules Advanced Options dialog box), be aware of the following effects of the per-user-override featureon authorization by user-specific ACLs: 

 
      
      		 [bookmark: pgfId-1150840]Without the per-user-override feature, traffic for a user session must be permitted by both the interface ACL and the user-specific ACL.

 
      		 [bookmark: pgfId-1150841]With the per-user-override feature, the user-specific ACL determines what is permitted.

 
     

 
     [bookmark: pgfId-1225278]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1225293]Configuring a RADIUS Server to Send Downloadable Access Control Lists

 
      		 [bookmark: pgfId-1225297]Configuring a RADIUS Server to Download Per-User Access Control List Names

 
     

 
    
 
     
      [bookmark: pgfId-1150860][bookmark: 95267]Configuring a RADIUS Server to Send Downloadable Access Control Lists[bookmark: marker-1150857][bookmark: marker-1150858][bookmark: marker-1150859]

 
     [bookmark: pgfId-1150861]This section describes how to configure Cisco Secure ACS or a third-party RADIUS server and includes the following topics:

 
      
      		 [bookmark: pgfId-1225317]About the Downloadable ACL Feature and Cisco Secure ACS

 
      		 [bookmark: pgfId-1225325]Configuring Cisco Secure ACS for Downloadable ACLs

 
      		 [bookmark: pgfId-1225337]Configuring Any RADIUS Server for Downloadable ACLs

 
      		 [bookmark: pgfId-1225342]Converting Wildcard Netmask Expressions in Downloadable ACLs

 
     

 
    
 
     
      [bookmark: pgfId-1150879][bookmark: 93900]About the Downloadable ACL Feature and Cisco Secure ACS

 
     [bookmark: pgfId-1150880]Downloadable ACLs is the most scalable means of using Cisco Secure ACS to provide the appropriate ACLs for each user. It provides the following capabilities:

 
      
      		 [bookmark: pgfId-1150881]Unlimited ACL size—Downloadable ACLs are sent using as many RADIUS packets as required to transport the full ACL from Cisco Secure ACS to the ASA.

 
      		 [bookmark: pgfId-1150885]Simplified and centralized management of ACLs—Downloadable ACLs enable you to write a set of ACLs once and apply it to many user or group profiles and distribute it to many ASAs.

 
     

 
     [bookmark: pgfId-1150889]This approach is most useful when you have very large ACL sets that you want to apply to more than one Cisco Secure ACS user or group; however, its ability to simplify Cisco Secure ACS user and group management makes it useful for ACLs of any size.

 
     [bookmark: pgfId-1150893]The ASA receives downloadable ACLs from Cisco Secure ACS using the following process:

 
     [bookmark: pgfId-1150897] 1. The ASA sends a RADIUS authentication request packet for the user session.

 
     [bookmark: pgfId-1150898] 2. If Cisco Secure ACS successfully authenticates the user, Cisco Secure ACS returns a RADIUS access-accept message that includes the internal name of the applicable downloadable ACL. The Cisco IOS cisco-av-pair RADIUS VSA (vendor 9, attribute 1) includes the following attribute-value pair to identify the downloadable ACL set:

 
      
      [bookmark: pgfId-1150899]ACS:CiscoSecure-Defined-ACL=acl-set-name 
     
 
      
      [bookmark: pgfId-1150900]  
     
 
     [bookmark: pgfId-1150901]where acl-set-name is the internal name of the downloadable ACL, which is a combination of the name assigned to the ACL by the Cisco Secure ACS administrator and the date and time that the ACL was last modified.

 
     [bookmark: pgfId-1150905] 3. The ASA examines the name of the downloadable ACL and determines if it has previously received the named downloadable ACL.

 
     [bookmark: pgfId-1150909] – If the ASA has previously received the named downloadable ACL, communication with Cisco Secure ACS is complete and the ASA applies the ACL to the user session. Because the name of the downloadable ACL includes the date and time that it was last modified, matching the name sent by Cisco Secure ACS to the name of an ACL previously downloaded means that the ASA has the most recent version of the downloadable ACL.

 
     [bookmark: pgfId-1150919] – If the ASA has not previously received the named downloadable ACL, it may have an out-of-date version of the ACL or it may not have downloaded any version of the ACL. In either case, the ASA issues a RADIUS authentication request using the downloadable ACL name as the username in the RADIUS request and a null password attribute. In a cisco-av-pair RADIUS VSA, the request also includes the following attribute-value pairs:

 
      
      [bookmark: pgfId-1150923]AAA:service=ip-admission 
     
 
      
      [bookmark: pgfId-1150924]AAA:event=acl-download 
     
 
      
      [bookmark: pgfId-1150925]  
     
 
     [bookmark: pgfId-1150929]In addition, the ASA signs the request with the Message-Authenticator attribute (IETF RADIUS attribute 80).

 
     [bookmark: pgfId-1150930] 4. After receipt of a RADIUS authentication request that has a username attribute that includes the name of a downloadable ACL, Cisco Secure ACS authenticates the request by checking the Message-Authenticator attribute. If the Message-Authenticator attribute is missing or incorrect, Cisco Secure ACS ignores the request. The presence of the Message-Authenticator attribute prevents malicious use of a downloadable ACL name to gain unauthorized network access. The Message-Authenticator attribute and its use are defined in RFC 2869, RADIUS Extensions, available at http://www.ietf.org.

 
     [bookmark: pgfId-1150932] 5. If the ACL required is less than approximately 4 KB in length, Cisco Secure ACS responds with an access-accept message that includes the ACL. The largest ACL that can fit in a single access-accept message is slightly less than 4 KB, because part of the message must be other required attributes.

 
     [bookmark: pgfId-1150933]Cisco Secure ACS sends the downloadable ACL in a cisco-av-pair RADIUS VSA. The ACL is formatted as a series of attribute-value pairs that each include an ACE and are numbered serially:

 
      
      [bookmark: pgfId-1150934]ip:inacl#1=ACE-1 
     
 
      
      [bookmark: pgfId-1150935]ip:inacl#2=ACE-2 
     
 
      
      [bookmark: pgfId-1150936]. 
     
 
      
      [bookmark: pgfId-1150937]. 
     
 
      
      [bookmark: pgfId-1150938]. 
     
 
      
      [bookmark: pgfId-1150939]ip:inacl#n=ACE-n 
     
 
      
      [bookmark: pgfId-1308501]  
     
 
      
      [bookmark: pgfId-1308503]ip:inacl#1=permit tcp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1150943]  
     
 
     [bookmark: pgfId-1150944] 6. If the ACL required is more than approximately 4 KB in length, Cisco Secure ACS responds with an access-challenge message that includes a portion of the ACL, formatted as described previously, and a State attribute (IETF RADIUS attribute 24), which includes control data used by Cisco Secure ACS to track the progress of the download. Cisco Secure ACS fits as many complete attribute-value pairs into the cisco-av-pair RADIUS VSA as it can without exceeding the maximum RADIUS message size.

 
     [bookmark: pgfId-1150948]The ASA stores the portion of the ACL received and responds with another access-request message that includes the same attributes as the first request for the downloadable ACL, plus a copy of the State attribute received in the access-challenge message.

 
     [bookmark: pgfId-1150949]This process repeats until Cisco Secure ACS sends the last of the ACL in an access-accept message.

 
    
 
     
      [bookmark: pgfId-1150951][bookmark: 70367]Configuring Cisco Secure ACS for Downloadable ACLs

 
     [bookmark: pgfId-1150952]You can configure downloadable ACLs on Cisco Secure ACS as a shared profile component and then assign the ACL to a group or to an individual user.

 
     [bookmark: pgfId-1150956]The ACL definition consists of one or more ASA commands that are similar to the extended access-list command (see command reference), except without the following prefix:

 
      
      [bookmark: pgfId-1150960]access-list acl_name extended 
     
 
      
      [bookmark: pgfId-1150961]  
     
 
     [bookmark: pgfId-1150962]The following example is a downloadable ACL definition on Cisco Secure ACS version 3.3:

 
      
      [bookmark: pgfId-1150963]+--------------------------------------------+ 
     
 
      
      [bookmark: pgfId-1150964]| Shared profile Components | 
     
 
      
      [bookmark: pgfId-1150965]| | 
     
 
      
      [bookmark: pgfId-1150966]| Downloadable IP ACLs Content | 
     
 
      
      [bookmark: pgfId-1150967]| | 
     
 
      
      [bookmark: pgfId-1150968]| Name: acs_ten_acl | 
     
 
      
      [bookmark: pgfId-1150969]| | 
     
 
      
      [bookmark: pgfId-1150970]| ACL Definitions | 
     
 
      
      [bookmark: pgfId-1150971]| | 
     
 
      
      [bookmark: pgfId-1150972]| permit tcp any host 10.0.0.254 | 
     
 
      
      [bookmark: pgfId-1150973]| permit udp any host 10.0.0.254 | 
     
 
      
      [bookmark: pgfId-1150974]| permit icmp any host 10.0.0.254 | 
     
 
      
      [bookmark: pgfId-1150975]| permit tcp any host 10.0.0.253 | 
     
 
      
      [bookmark: pgfId-1150976]| permit udp any host 10.0.0.253 | 
     
 
      
      [bookmark: pgfId-1150977]| permit icmp any host 10.0.0.253 | 
     
 
      
      [bookmark: pgfId-1150978]| permit tcp any host 10.0.0.252 | 
     
 
      
      [bookmark: pgfId-1150979]| permit udp any host 10.0.0.252 | 
     
 
      
      [bookmark: pgfId-1150980]| permit icmp any host 10.0.0.252 | 
     
 
      
      [bookmark: pgfId-1150981]| permit ip any any | 
     
 
      
      [bookmark: pgfId-1150982]+--------------------------------------------+ 
     
 
      
      [bookmark: pgfId-1150983]  
     
 
     [bookmark: pgfId-1150984]For more information about creating downloadable ACLs and associating them with users, see the user guide for your version of Cisco Secure ACS.

 
     [bookmark: pgfId-1150988]On the ASA, the downloaded ACL has the following name:

 
      
      [bookmark: pgfId-1150989]#ACSACL#-ip-acl_name-number 
     
 
      
      [bookmark: pgfId-1150990]  
     
 
     [bookmark: pgfId-1150991]The acl_name argument is the name that is defined on Cisco Secure ACS (acs_ten_acl in the preceding example), and number is a unique version ID generated by Cisco Secure ACS.

 
     [bookmark: pgfId-1150995]The downloaded ACL on the ASA consists of the following lines:

 
      
      [bookmark: pgfId-1150996]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit tcp any host 10.0.0.254 
     
 
      
      [bookmark: pgfId-1150997]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit udp any host 10.0.0.254 
     
 
      
      [bookmark: pgfId-1150998]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit icmp any host 10.0.0.254 
     
 
      
      [bookmark: pgfId-1150999]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit tcp any host 10.0.0.253 
     
 
      
      [bookmark: pgfId-1151000]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit udp any host 10.0.0.253 
     
 
      
      [bookmark: pgfId-1151001]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit icmp any host 10.0.0.253 
     
 
      
      [bookmark: pgfId-1151002]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit tcp any host 10.0.0.252 
     
 
      
      [bookmark: pgfId-1151003]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit udp any host 10.0.0.252 
     
 
      
      [bookmark: pgfId-1151004]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit icmp any host 10.0.0.252 
     
 
      
      [bookmark: pgfId-1151005]access-list #ACSACL#-ip-asa-acs_ten_acl-3b5385f7 permit ip any any 
     
 
      
      [bookmark: pgfId-1151006]  
     
 
    
 
     
      [bookmark: pgfId-1151008][bookmark: 62100]Configuring Any RADIUS Server for Downloadable ACLs

 
     [bookmark: pgfId-1151009]You can configure any RADIUS server that supports Cisco IOS RADIUS VSAs to send user-specific ACLs to the ASA in a Cisco IOS RADIUS cisco-av-pair VSA (vendor 9, attribute 1).

 
     [bookmark: pgfId-1151013]In the cisco-av-pair VSA, configure one or more ACEs that are similar to the access-list extended command (see command reference), except that you replace the following command prefix:

 
      
      [bookmark: pgfId-1151017]access-list acl_name extended 
     
 
      
      [bookmark: pgfId-1151018]  
     
 
     [bookmark: pgfId-1151019]with the following text:

 
      
      [bookmark: pgfId-1151020]ip:inacl#nnn= 
     
 
      
      [bookmark: pgfId-1151021]  
     
 
     [bookmark: pgfId-1151022]The nnn argument is a number in the range from 0 to 999999999 that identifies the order of the command statement to be configured on the ASA. If this parameter is omitted, the sequence value is 0, and the order of the ACEs inside the cisco-av-pair RADIUS VSA is used.

 
     [bookmark: pgfId-1151026]The following example is an ACL definition as it should be configured for a cisco-av-pair VSA on a RADIUS server:

 
      
      [bookmark: pgfId-1151027]ip:inacl#1=permit tcp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1151028]ip:inacl#99=deny tcp any any 
     
 
      
      [bookmark: pgfId-1151029]ip:inacl#2=permit udp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1151030]ip:inacl#100=deny udp any any 
     
 
      
      [bookmark: pgfId-1151031]ip:inacl#3=permit icmp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1151032]  
     
 
     [bookmark: pgfId-1151033]For information about making unique per user the ACLs that are sent in the cisco-av-pair attribute, see the documentation for your RADIUS server.

 
     [bookmark: pgfId-1151037]On the ASA, the downloaded ACL name has the following format:

 
      
      [bookmark: pgfId-1151038]AAA-user-username 
     
 
      
      [bookmark: pgfId-1151039]  
     
 
     [bookmark: pgfId-1151040]The username argument is the name of the user that is being authenticated.

 
     [bookmark: pgfId-1151044]The downloaded ACL on the ASA consists of the following lines. Notice the order based on the numbers identified on the RADIUS server.

 
      
      [bookmark: pgfId-1151045]access-list AAA-user-bcham34-79AD4A08 permit tcp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1151046]access-list AAA-user-bcham34-79AD4A08 permit udp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1151047]access-list AAA-user-bcham34-79AD4A08 permit icmp 10.1.0.0 255.0.0.0 10.0.0.0 255.0.0.0 
     
 
      
      [bookmark: pgfId-1151048]access-list AAA-user-bcham34-79AD4A08 deny tcp any any 
     
 
      
      [bookmark: pgfId-1151049]access-list AAA-user-bcham34-79AD4A08 deny udp any any 
     
 
      
      [bookmark: pgfId-1151050]  
     
 
     [bookmark: pgfId-1151051]Downloaded ACLs have two spaces between the word “access-list” and the name. These spaces serve to differentiate a downloaded ACL from a local ACL. In this example, “79AD4A08” is a hash value generated by the ASA to help determine when ACL definitions have changed on the RADIUS server.

 
    
 
     
      [bookmark: pgfId-1151057][bookmark: 13969]Converting Wildcard Netmask Expressions in Downloadable ACLs[bookmark: marker-1151056]

 
     [bookmark: pgfId-1151058]If a RADIUS server provides downloadable ACLs to Cisco VPN 3000 series concentrators as well as to the ASA, you may need the ASA to convert wildcard netmask expressions to standard netmask expressions. This is because Cisco VPN 3000 series concentrators support wildcard netmask expressions, but the ASA only supports standard netmask expressions. Configuring the ASA to convert wildcard netmask expressions helps minimize the effects of these differences on how you configure downloadable ACLs on your RADIUS servers. Translation of wildcard netmask expressions means that downloadable ACLs written for Cisco VPN 3000 series concentrators can be used by the ASA without altering the configuration of the downloadable ACLs on the RADIUS server.

 
     [bookmark: pgfId-1379709]You configure ACL netmask conversion on a per-server basis when you add a server to a server group in the Configuration > Device Management > Users/AAA > AAA Server Groups > AAA Server Groups area.

 
    
 
     
      [bookmark: pgfId-1151082][bookmark: 38417]Configuring a RADIUS Server to Download Per-User Access Control List Names

 
     [bookmark: pgfId-1151086]To download a name for an ACL that you already created on the ASA from the RADIUS server when a user authenticates, configure the IETF RADIUS filter-id attribute (attribute number 11) as follows:

 
      
      [bookmark: pgfId-1151087]filter-id=acl_name 
     
 
      
      [bookmark: pgfId-1151088]  
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1151089]Note In Cisco Secure ACS, the values for filter-id attributes are specified in boxes in the HTML interface, omitting filter-id= and entering only acl_name.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1151090]For information about making the filter-id attribute value unique per user, see the documentation for your RADIUS server.

 
     [bookmark: pgfId-1151096]To create an ACL on the ASA, see “Using the ACL Manager,” in the general operations configuration guide.

 
    
 
   
 
    
     [bookmark: pgfId-1362566][bookmark: 21017]Configuring Accounting for Network Access

 
    [bookmark: pgfId-1362571][bookmark: marker-1362567]The ASA can send accounting information to a RADIUS or TACACS+ server about any TCP or UDP traffic that passes through the ASA. If that traffic is also authenticated, then the AAA server can maintain accounting information by username. If the traffic is not authenticated, the AAA server can maintain accounting information by IP address. Accounting information includes session start and stop times, username, the number of bytes that pass through the ASA for the session, the service used, and the duration of each session.

 
    [bookmark: pgfId-1151115]To configure accounting, perform the following steps:

 
    
 
    [bookmark: pgfId-1400262]Step 1 If you want the ASA to provide accounting data per user, you must enable authentication. For more information, see the “Configuring Network Access Authentication” section. If you want the ASA to provide accounting data per IP address, enabling authentication is not necessary and you can continue to the next step.

 
    [bookmark: pgfId-1400269]Step 2 In the Configuration > Firewall > AAA Rules pane, choose Add > Add Accounting Rule.

 
    [bookmark: pgfId-1400270]The Add Accounting Rule dialog box appears.

 
    [bookmark: pgfId-1400271]Step 3 In the Interface drop-down list, choose the interface for applying the rule.

 
    [bookmark: pgfId-1400272]Step 4 In the Action field, click one of the following, depending on the implementation:

 
     
      
      		 [bookmark: pgfId-1400273] Account 

 
      		 [bookmark: pgfId-1400274] Do not Account 

 
     

 
    

 
    [bookmark: pgfId-1400275]Step 5 In the AAA Server Group drop-down list, choose a server group. To add a AAA server to the server group, click Add Server.

 
    [bookmark: pgfId-1400276]Step 6 In the Source field, enter the source IP address, or click the ellipsis (...) to choose an IP address already defined in ASDM.

 
    [bookmark: pgfId-1400277]Step 7 In the Destination field, enter the destination IP address, or click the ellipsis (...) to choose an IP address already defined in ASDM.

 
    [bookmark: pgfId-1400278]Step 8 In the Service field, enter an IP service name or number for the destination service, or click the ellipsis (...) to choose a service.

 
    [bookmark: pgfId-1400279]Step 9 (Optional) In the Description field, enter a description.

 
    [bookmark: pgfId-1400280]Step 10 (Optional) Click More Options to do any of the following:

 
     
      
      		 [bookmark: pgfId-1400281]To specify a source service for TCP or UDP, enter a TCP or UDP service in the Source Service field.

 
      		 [bookmark: pgfId-1400282]The destination service and source service must be the same. Copy and paste the Destination Service field content to the Source Service field.

 
      		 [bookmark: pgfId-1400283]To make the rule inactive, clear the  Enable Rule check box.

 
     

 
    

 
    [bookmark: pgfId-1400284]You may not want to remove a rule, but instead turn it off.

 
     
      
      		 [bookmark: pgfId-1400285]To set a time range for the rule, In the Time Range drop-down list, choose an existing time range. To add a new time range, click the ellipsis (...). For more information, see the “Configuring Time Ranges” section in the general operations configuration guide.

 
     

 
    

 
    [bookmark: pgfId-1400292]Step 11 Click OK.

 
    [bookmark: pgfId-1400293]The Add Accounting Rule dialog box closes and the rule appears in the AAA Rules table.

 
    [bookmark: pgfId-1400294]Step 12 Click Apply.

 
    [bookmark: pgfId-1400295]The changes are saved to the running configuration.

 
    [bookmark: pgfId-1400296]

 
     
     
 
    
  
    

 
    [bookmark: pgfId-1362600]AAA provides an extra level of protection and control for user access than using ACLs alone. For example, you can create an ACL allowing all outside users to access Telnet on a server on the DMZ network. If you want only some users to access the server and you might not always know IP addresses of these users, you can enable AAA to allow only authenticated and/or authorized users to connect through the ASA. (The Telnet server enforces authentication, too; the ASA prevents unauthorized users from attempting to access the server.)

 
   
 
    
     [bookmark: pgfId-1151216][bookmark: 64734]Using MAC Addresses to Exempt Traffic from Authentication and Authorization

 
    [bookmark: pgfId-1400304]The ASA can exempt from authentication and authorization any traffic from specific MAC addresses.

 
    [bookmark: pgfId-1400308]For example, if the ASA authenticates TCP traffic originating on a particular network but you want to allow unauthenticated TCP connections from a specific server, you would use a MAC exempt rule to exempt from authentication and authorization any traffic from the server specified by the rule. This feature is particularly useful to exempt devices such as IP phones that cannot respond to authentication prompts.

 
    [bookmark: pgfId-1400309]The order of entries matters, because the packet uses the first entry it matches, instead of a best match scenario. If you have a permit entry, and you want to deny an address that is allowed by the permit entry, be sure to enter the deny entry before the permit entry.

 
    [bookmark: pgfId-1400310]To use MAC addresses to exempt traffic from authentication and authorization, perform the following steps:

 
    
 
    [bookmark: pgfId-1400311]Step 1 In the Configuration > Firewall > AAA Rules pane, choose Add > Add MAC Exempt Rule.

 
    [bookmark: pgfId-1400312]The Add MAC Exempt Rule dialog box appears.

 
    [bookmark: pgfId-1400313]Step 2 In the Action drop-down list, click one of the following options, depending on the implementation:

 
     
      
      		 [bookmark: pgfId-1400314] MAC Exempt 

 
      		 [bookmark: pgfId-1400315] No MAC Exempt 

 
     

 
    

 
    [bookmark: pgfId-1400316]The MAC Exempt option allows traffic from the MAC address without having to authenticate or authorize. The No MAC Exempt option specifies a MAC address that is not exempt from authentication or authorization. You might need to add a deny entry if you permit a range of MAC addresses using a MAC address mask such as ffff.ffff.0000, and you want to force a MAC address in that range to be authenticated and authorized.

 
    [bookmark: pgfId-1400317]Step 3 In the MAC Address field, specify the source MAC address in 12-digit hexadecimal form; that is, nnnn.nnnn.nnnn.

 
    [bookmark: pgfId-1400318]Step 4 In the MAC Mask field, specify the portion of the MAC address that should be used for matching. For example, ffff.ffff.ffff matches the MAC address exactly. ffff.ffff.0000 matches only the first 8 digits.

 
    [bookmark: pgfId-1400319]Step 5 Click OK.

 
    [bookmark: pgfId-1400320]The Add MAC Exempt Rule dialog box closes and the rule appears in the AAA Rules table.

 
    [bookmark: pgfId-1400321]Step 6 Click Apply.

 
    [bookmark: pgfId-1400322]The changes are saved to the running configuration.

 
    [bookmark: pgfId-1400323]

 
     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1122740][bookmark: 40255]Feature History for AAA Rules

 
    [bookmark: pgfId-1122744]Table 8-1 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1122767] 

 
     
      
       
       [bookmark: pgfId-1122748]Table 8-1 [bookmark: 90304]Feature History for AAA Rules

 
       
       
        
        		 
          
          [bookmark: pgfId-1122754]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1122756]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1122758]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1122760]AAA Rules

  
        		[bookmark: pgfId-1122762]7.0(1)

  
        		[bookmark: pgfId-1122764]AAA Rules describe how to enable AAA for network access.

 [bookmark: pgfId-1400333]We introduced the following screens:

 [bookmark: pgfId-1122766]Configuration > Firewall > AAA Rules
Configuration > Firewall > Advanced > Virtual Access.

  
       

 
        
        		[bookmark: pgfId-1315424]Authentication using Cut-Through Proxy

  
        		[bookmark: pgfId-1315426]9.0(1)

  
        		[bookmark: pgfId-1315428]You can authenticate using AAA rules in conjunction with the Identity Firewall feature. 

 [bookmark: pgfId-1315439]  

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1073841] 
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     [bookmark: pgfId-1240397][bookmark: 46163]Troubleshooting Connections and Resources 
      
      
 
     
 

 
    [bookmark: pgfId-1240401]This chapter describes how to troubleshoot the ASA and includes the following sections:

 
     
     		 [bookmark: pgfId-1093135]Testing Your Configuration

 
     		 [bookmark: pgfId-1287147]Monitoring Performance

 
     		 [bookmark: pgfId-1287151]Monitoring System Resources

 
     		 [bookmark: pgfId-1287155]Monitoring Connections

 
     		 [bookmark: pgfId-1242184]Monitoring Per-Process CPU Usage

 
    

 
   
 
    
     [bookmark: pgfId-1048374][bookmark: 21227][bookmark: 83972]Testing Your Conf[bookmark: marker-1048372]iguration[bookmark: marker-1048373]

 
    [bookmark: pgfId-1059557]This sect[bookmark: marker-1059554]ion describes how to test connectivity for the single mode ASA or for each security context, how to ping the ASA interfaces, and how to allow hosts on one interface to ping through to hosts on another interface.

 
    [bookmark: pgfId-1059569]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1059576]Pinging ASA Interfaces

 
     		 [bookmark: pgfId-1287163]Verifying ASA Configuration and Operation, and Testing Interfaces Using Ping

 
     		 [bookmark: pgfId-1135475]Determining Packet Routing with Traceroute

 
     		 [bookmark: pgfId-1094405]Tracing Packets with Packet Tracer

 
    

 
     
      [bookmark: pgfId-1093069][bookmark: 87790]Pinging ASA Interfaces

 
     [bookmark: pgfId-1093075]To test whether the ASA interfaces are up and running and that the ASA and connected routers are operating correctly, you can ping the ASA interfaces. 

 
     [bookmark: pgfId-1199396]To ping the ASA interfaces, perform the following steps:

 
     
 
     [bookmark: pgfId-1062066]Step 1 Draw a diagram of your single-mode ASA or security context that shows the interface names, security levels, and IP addresses. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1062338]Note Although this procedure uses IP addresses, the ping command also supports DNS names and names that are assigned to a local IP address with the name command. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1249277]The diagram should also include any directly connected routers and a host on the other side of the router from which you will ping the ASA. (See Figure 24-1.)

 
     [bookmark: pgfId-1249288]Figure 24-1 [bookmark: 33710]Network Diagram with Interfaces, Routers, and Hosts

 
     [bookmark: pgfId-1059674] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1059687]Step 2 Ping each ASA interface from the directly connected routers. For transparent mode, ping the management IP address. This test ensures that the ASA interfaces are active and that the interface configuration is correct.

 
     [bookmark: pgfId-1059695]A ping might fail if the ASA interface is not active, the interface configuration is incorrect, or if a switch between the ASA and a router is down (see Figure 24-2). In this case, no debugging messages or syslog messages appear, because the packet never reaches the ASA.

 
     [bookmark: pgfId-1059707]Figure 24-2 [bookmark: 55831]Ping Failure at the ASA Interface

 
     [bookmark: pgfId-1059711] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1059714]If the ping reaches the ASA, and it responds, debugging messages similar to the following appear:

 
      
      [bookmark: pgfId-1059719]ICMP echo reply (len 32 id 1 seq 256) 209.165.201.1 > 209.165.201.2 
     
 
      
      [bookmark: pgfId-1059720]ICMP echo request (len 32 id 1 seq 512) 209.165.201.2 > 209.165.201.1 
     
 
      
      [bookmark: pgfId-1059721]  
     
 
     [bookmark: pgfId-1059722]If the ping reply does not return to the router, then a switch loop or redundant IP addresses may exist (see Figure 24-3).

 
     [bookmark: pgfId-1059727]Figure 24-3 [bookmark: 84861]Ping Failure Because of IP Addressing Problems

 
     [bookmark: pgfId-1059731] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1059734]Step 3 Ping each ASA interface from a remote host. For transparent mode, ping the management IP address. This test checks whether the directly connected router can route the packet between the host and the ASA, and whether the ASA can correctly route the packet back to the host.

 
     [bookmark: pgfId-1059745]A ping might fail if the ASA does not have a return route to the host through the intermediate router (see Figure 24-4). In this case, the debugging messages show that the ping was successful, but syslog message 110001 appears, indicating a routing failure has occurred.

 
     [bookmark: pgfId-1059751]Figure 24-4 [bookmark: 67429]Ping Failure Because the ASA Has No Return Route

 
     [bookmark: pgfId-1059755] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1059756]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1287171][bookmark: 98463]Verifying ASA Configuration and Operation, and Testing Interfaces Using Ping 

 
     [bookmark: pgfId-1287177]The Ping [bookmark: marker-1287173]tool is useful for verifying the configuration and operation of the ASA and surrounding communications links, as well as for testing other network devices.

 
     [bookmark: pgfId-1287178]This section includes the following topics:

 
      
      		 [bookmark: pgfId-1287182]Information About Ping

 
      		 [bookmark: pgfId-1287186]Pinging From an ASA Interface

 
      		 [bookmark: pgfId-1287190]Pinging to an ASA Interface

 
      		 [bookmark: pgfId-1287194]Pinging Through the ASA Interface

 
      		 [bookmark: pgfId-1287198]Troubleshooting the Ping Tool

 
      		 [bookmark: pgfId-1287202]Using the Ping Tool

 
     

 
    
 
     
      [bookmark: pgfId-1287204][bookmark: 92527]Information About Ping

 
     [bookmark: pgfId-1287205]A ping is sent to an IP address and it returns a reply. This process enables network devices to discover, identify, and test each other.

 
     [bookmark: pgfId-1287206]The Ping tool uses ICMP (as described in RFC 777 and RFC 792) to define an echo request-and-reply transaction between two network devices. The echo request packet is sent to the IP address of a network device. The receiving device reverses the source and destination address and sends the packet back as the echo reply.

 
     [bookmark: pgfId-1287210]Administrators can use the ASDM Ping interactive diagnostic tool in these ways:

 
      
      		 [bookmark: pgfId-1287211]Loopback testing of two interfaces—A ping may be initiated from one interface to another on the same ASA, as an external loopback test to verify basic “up” status and operation of each interface. 

 
      		 [bookmark: pgfId-1287221]Pinging to an ASA—The Ping tool can ping an interface on another ASA to verify that it is up and responding.

 
      		 [bookmark: pgfId-1287225]Pinging through an ASA—Ping packets originating from the Ping tool may pass through an intermediate ASA on their way to a device. The echo packets will also pass through two of its interfaces as they return. This procedure can be used to perform a basic test of the interfaces, operation, and response time of the intermediate unit. 

 
      		 [bookmark: pgfId-1287232]Pinging to test questionable operation of a network device—A ping may be initiated from an ASA interface to a network device that is suspected of functioning incorrectly. If the interface is configured correctly and an echo is not received, there may be problems with the device. 

 
      		 [bookmark: pgfId-1287236]Pinging to test intermediate communications—A ping may be initiated from an ASA interface to a network device that is known to be functioning correctly and returning echo requests. If the echo is received, the correct operation of any intermediate devices and physical connectivity is confirmed. 

 
     

 
    
 
     
      [bookmark: pgfId-1287242][bookmark: WP0072troubleshooting][bookmark: 32496]Pinging From an ASA Interface

 
     [bookmark: pgfId-1287246]For basic testing of an interface, you can initiate a ping from an ASA interface to a network device that you know is functioning correctly and returning replies through the intermediate communications path. For basic testing, make sure you do the following:

 
      
      		 [bookmark: pgfId-1287250]Verify receipt of the ping from the ASA interface by the “known good” device. If the ping is not received, a problem with the transmitting hardware or interface configuration may exist. 

 
      		 [bookmark: pgfId-1287254]If the ASA interface is configured correctly and it does not receive an echo reply from the “known good” device, problems with the interface hardware receiving function may exist. If a different interface with “known good” receiving capability can receive an echo after pinging the same “known good” device, the hardware receiving problem of the first interface is confirmed. 

 
     

 
    
 
     
      [bookmark: pgfId-1287260][bookmark: WP0072ping_to_pix][bookmark: 52647]Pinging to an ASA Interface

 
     [bookmark: pgfId-1287264]When you try to ping to an ASA interface, verify that the pinging response (ICMP echo reply) is enabled for that interface by choosing Tools > Ping. When pinging is disabled, the ASA cannot be detected by other devices or software applications, and does not respond to the ASDM Ping tool.

 
    
 
     
      [bookmark: pgfId-1287275][bookmark: 3H_Head3. Pinging Through the Adaptive Security Appliance]Pinging Through the ASA Interface

 
     [bookmark: pgfId-1287276]To verify that other types of network traffic from “known good” sources are being passed through the ASA, choose Monitoring > Interfaces > Interface Graphs or an SNMP management station. 

 
     [bookmark: pgfId-1287280]To enable internal hosts to ping external hosts, configure ICMP inspection. Choose Configuration > Firewall > Service Policies. [bookmark: WP0073][bookmark: WP0073top_entry]

 
    
 
     
      [bookmark: pgfId-1287284][bookmark: 3H_Head3. Troubleshooting the Ping Tool]Troubleshooting the Ping Tool

 
     [bookmark: pgfId-1287288]When pings fail to receive an echo, it may be the result of a configuration or operational error in an ASA, and not necessarily because of no response from the IP address being pinged. Before using the Ping tool to ping from, to, or through an ASA interface, perform the following basic checks:

 
      
      		 [bookmark: pgfId-1287292]Verify that interfaces are configured. Choose  Configuration > Device Setup > Interfaces . 

 
      		 [bookmark: pgfId-1287293]Verify that devices in the intermediate communications path, such as switches or routers, are correctly delivering other types of network traffic. 

 
      		 [bookmark: pgfId-1287294]Make sure that traffic of other types from “known good” sources is being passed. Choose  Monitoring > Interfaces > Interface Graphs . 

 
     

 
    
 
     
      [bookmark: pgfId-1287296][bookmark: 3H_Head3. Using the Ping Tool]Using the Ping Tool

 
     [bookmark: pgfId-1287297]To use the Ping tool, perform the following steps:

 
     
 
     [bookmark: pgfId-1287298]Step 1 In the main ASDM application window, choose Tools > Ping.

 
     [bookmark: pgfId-1287299]The Ping dialog box appears.

 
     [bookmark: pgfId-1287300]Step 2 Enter the destination IP address for the ICMP echo request packets in the IP Address field. 

 
     [bookmark: pgfId-1287301]Ping also supports IPv6 addresses.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1287302]Note If a hostname has been assigned in the Configuration > Firewall > Objects > Service Objects/Groups pane, you can use the hostname in place of the IP address. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1287306]Step 3 (Optional) Choose the ASA interface that transmits the echo request packets from the drop-down list. If it is not specified, the ASA checks the routing table to find the destination address and uses the required interface.

 
     [bookmark: pgfId-1287310]Step 4 Click Ping to send an ICMP echo request packet from the specified or default interface to the specified IP address and start the response timer. 

 
     [bookmark: pgfId-1287311]The response appears in the Ping Output area. Three attempts are made to ping the IP address, and results display the following fields:

 
      
       
       		 [bookmark: pgfId-1287312]The IP address of the device pinged or a device name, if available. The name of the device, if assigned, may be displayed, even if NO response is the result. 

 
       		 [bookmark: pgfId-1287313]When the ping is transmitted, a millisecond timer starts with a specified maximum, or timeout value. This timer is useful for testing the relative response times of different routes or activity levels. 

 
       		 [bookmark: pgfId-1287314] Example Ping output: 

 
      

 
     

 
      
      [bookmark: pgfId-1287315]Sending 5, 100-byte ICMP Echos to out-pc, timeout is 2 seconds: 
     
 
      
      [bookmark: pgfId-1287316]!!!!! 
     
 
      
      [bookmark: pgfId-1287317]Success rate is 100 percent (5/5), round-trip min/avg/max = 1/1/1 ms 
     
 
      
      [bookmark: pgfId-1287318]  
     
 
     [bookmark: pgfId-1287319]If the ping fails, the output is as follows:

 
      
      [bookmark: pgfId-1287320]Sending 5, 100-byte ICMP Echos to 10.132.80.101, timeout is 2 seconds: 
     
 
      
      [bookmark: pgfId-1287321]????? 
     
 
      
      [bookmark: pgfId-1287322]Success rate is 0 percent (0/5) 
     
 
      
      [bookmark: pgfId-1287323]  
     
 
     [bookmark: pgfId-1287324]Step 5 To enter a new IP address, click Clear Screen to remove the previous response from the Ping output area.

 
     [bookmark: pgfId-1287325]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1092342][bookmark: 2H_Head2. Determining Packet Routing with Traceroute]Determining Packet Routing with Traceroute

 
     [bookmark: pgfId-1287331]The Traceroute tool helps you to determine the route that [bookmark: marker-1287330]packets will take to their destination. The tool prints the result of each probe sent. Every line of output corresponds to a TTL value in increasing order. The following table lists the output symbols printed by this tool.

 
      
       
        
        [bookmark: pgfId-1287334] 

 
        
        
         
         		 
           
           [bookmark: pgfId-1287341]Output Symbol 
          
  
         		 
           
           [bookmark: pgfId-1287346]Description 
          
  
        

 
         
         		[bookmark: pgfId-1287348]*

  
         		[bookmark: pgfId-1287350]No response was received for the probe within the timeout period.

  
        

 
         
         		[bookmark: pgfId-1287352]nn msec

  
         		[bookmark: pgfId-1287354]For each node, the round-trip time (in milliseconds) for the specified number of probes.

  
        

 
         
         		[bookmark: pgfId-1287356]!N.

  
         		[bookmark: pgfId-1287358]ICMP network unreachable.

  
        

 
         
         		[bookmark: pgfId-1287360]!H

  
         		[bookmark: pgfId-1287362]ICMP host unreachable.

  
        

 
         
         		[bookmark: pgfId-1287364]!P

  
         		[bookmark: pgfId-1287366]ICMP unreachable.

  
        

 
         
         		[bookmark: pgfId-1287368]!A

  
         		[bookmark: pgfId-1287370]ICMP administratively prohibited.

  
        

 
         
         		[bookmark: pgfId-1287372]?

  
         		[bookmark: pgfId-1287374]Unknown ICMP error.

  
        

 
        
      

 
     
 
     [bookmark: pgfId-1287375]To use the Traceroute tool, perform the following steps:

 
     
 
     [bookmark: pgfId-1287376]Step 1 In the main ASDM application window, choose Tools > Traceroute.

 
     [bookmark: pgfId-1287377]The Traceroute dialog box appears.

 
     [bookmark: pgfId-1287378]Step 2 Enter hostname or IP address to which the route is traced. If the hostname is given, define it by choosing Configuration > Firewall > Objects > Service Objects/Groups, or configure a DNS server to enable this tool to resolve the hostname to an IP address.

 
     [bookmark: pgfId-1287379]Step 3 Enter the amount of time in seconds to wait for a response before the connection times out. The default is three seconds.

 
     [bookmark: pgfId-1287380]Step 4 Type the destination port used by the UDP probe messages. The default is 33434.

 
     [bookmark: pgfId-1287381]Step 5 Enter the number of probes to be sent at each TTL level. The default is three.

 
     [bookmark: pgfId-1287382]Step 6 Specify the minimum and maximum TTL values for the first probes. The minimum default is one, but it can be set to a higher value to suppress the display of known hops. The maximum default is 30. The traceroute terminates when the packet reaches the destination or when the maximum value is reached.

 
     [bookmark: pgfId-1287383]Step 7 Check the Specify source interface or IP address check box. Choose the source interface or IP address for the packet trace from the drop-down list. This IP address must be the IP address of one of the interfaces. In transparent mode, it must be the management IP address of the ASA.

 
     [bookmark: pgfId-1287387]Step 8 Check the Reverse Resolve check box to have the output display the names of hops encountered if name resolution is configured. Leave this check box unchecked to have the output display IP addresses.

 
     [bookmark: pgfId-1287388]Step 9 Check the Use ICMP check box to specify the use of ICMP probe packets instead of UDP probe packets.

 
     [bookmark: pgfId-1287389]Step 10 Click Trace Route to start the traceroute.

 
     [bookmark: pgfId-1287390]The Traceroute Output area displays detailed messages about the traceroute results. 

 
     [bookmark: pgfId-1287391]Step 11 Click Clear Output to start a new traceroute.

 
     [bookmark: pgfId-1287392]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1092412][bookmark: 2H_Head2. Tracing Packets with Packet Tracer]Tracing Packets with Packet Tracer

 
     [bookmark: pgfId-1093743]The packet tracer tool provides packet tracing for [bookmark: marker-1093742]packet sniffing and network fault isolation, as well as detailed information about the packets and how they are processed by the ASA. If a configuration command did not cause the packet to drop, the packet tracer tool can provide information about the cause in an easily readable format. 

 
     [bookmark: pgfId-1093880]In addition, you can trace the lifespan of a packet through the ASA to see whether the packet is operating correctly with the packet tracer tool. This tool enables you to do the following:

 
      
      		 [bookmark: pgfId-1093750]Debug all packet drops in a production network.

 
      		 [bookmark: pgfId-1093751]Verify the configuration is working as intended.

 
      		 [bookmark: pgfId-1093752]Show all rules applicable to a packet, along with the CLI commands that caused the rule addition.

 
      		 [bookmark: pgfId-1093753]Show a time line of packet changes in a data path.

 
      		 [bookmark: pgfId-1093754]Inject tracer packets into the data path.

 
      		 [bookmark: pgfId-1205086]Search for an IPv4 or IPv6 address based on the user identity and the FQDN.

 
     

 
     [bookmark: pgfId-1287397]To use the packet tracer, perform the following steps:

 
     
 
     [bookmark: pgfId-1287398]Step 1 In the main ASDM application window, choose Tools > Packet Tracer.

 
     [bookmark: pgfId-1287399]The Cisco ASDM Packet Tracer dialog box appears.

 
     [bookmark: pgfId-1287400]Step 2 Choose the source interface for the packet trace from the drop-down list.

 
     [bookmark: pgfId-1287401]Step 3 Specify the protocol type for the packet trace. Available protocol types include ICMP, IP, TCP, and UDP.

 
     [bookmark: pgfId-1287402]Step 4 In the Source drop-down list, select one of the following options:

 
      
       
       		 [bookmark: pgfId-1287403]IP Address

 
       		 [bookmark: pgfId-1287404]User

 
       		 [bookmark: pgfId-1287405]FQDN

 
       		 [bookmark: pgfId-1287406]Security Tag

 
       		 [bookmark: pgfId-1287407]Security Name

 
      

 
     

 
     [bookmark: pgfId-1287408]Select the Security Tag or Security Name options when you want to trace packets sent by the ASA when integrated with the Cisco TrustSec solution. Security names are created on the Cisco ISE and provide user-friendly names for security groups. 

 
     [bookmark: pgfId-1287409]If a security policy is configured on the ASA with that security tags or security names, the ASA enforces the policy. (You can create security policies on the ASA that contain security tags or security names. To enforce policies based on security group names, the ASA needs the security group table to map security names to security tags.)

 
     [bookmark: pgfId-1287415]See the “Configuring the ASA to Integrate with Cisco TrustSec” section in the general operations configuration guide for information about configuring the ASA to integrate with the Cisco TrustSec solution. 

 
     [bookmark: pgfId-1287417]Step 5 Based on the option you selected from the Source drop-down list, enter the corresponding text for the item you want to trace; for example, enter the source IP address for the packet trace in the Source IP Address field.

 
     [bookmark: pgfId-1287418]Step 6 For TCP and UDP only, choose the source port for the packet trace from the drop-down list.

 
     [bookmark: pgfId-1287419]Step 7 In the Destination drop-down list, select one of the following options:

 
      
       
       		 [bookmark: pgfId-1287420]IP Address

 
       		 [bookmark: pgfId-1287421]FQDN

 
       		 [bookmark: pgfId-1287422]Security Tag

 
       		 [bookmark: pgfId-1287423]Security Name

 
      

 
     

 
     [bookmark: pgfId-1287424]Step 8 Based on the option you selected from the Destination drop-down list, enter the corresponding text for the item you want to trace; for example, enter the source IP address for the packet trace in the Destination IP Address field.

 
     [bookmark: pgfId-1287425]Step 9 For TCP and UDP only, choose the destination port for the packet trace from the drop-down list.

 
     [bookmark: pgfId-1287426]Step 10 For ICMP only, choose the type of packet trace from the Type drop-down list. Then enter the trace code and trace ID in the appropriate fields.

 
     [bookmark: pgfId-1287427]Step 11 For IP only, enter the protocol number in the Protocol field. Valid values range from 0 to 255.

 
     [bookmark: pgfId-1287428]Step 12 Click Start to trace the packet.

 
     [bookmark: pgfId-1287429]The Information Display Area shows detailed messages about the results of the packet trace.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1287430]Note To display a graphical representation of the packet trace, check the Show animation check box.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1287431]Step 13 Click Clear to start a new packet trace.

 
     [bookmark: pgfId-1287432]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1287438][bookmark: 61727][bookmark: 46374]Monitoring Performance

 
    [bookmark: pgfId-1287442]To view ASA performance information in a graphical or tabular format, perform the following steps: 

 
    
 
    [bookmark: pgfId-1287443]Step 1 In the ASDM main window, choose Monitoring > Properties > Connection Graphs > Perfmon.

 
    [bookmark: pgfId-1287444]Step 2 Select one or more entries from the Available Graphs list, then click Add to move them to the Selected Graphs list. To remove an entry from the Selected Graphs list, click Remove. The available options are the following:

 
     
      
      		 [bookmark: pgfId-1287448]AAA Perfmon—Displays the ASA AAA performance information.

 
      		 [bookmark: pgfId-1287452]Inspection Perfmon—Displays the ASA inspection performance information.

 
      		 [bookmark: pgfId-1287456]Web Perfmon—Displays the ASA web performance information, including URL access and URL server requests.

 
      		 [bookmark: pgfId-1287460]Connections Perfmon—Displays the ASA connections performance information.

 
      		 [bookmark: pgfId-1287464]Xlate Perfmon—Displays the ASA NAT performance information.

 
     

 
    

 
    [bookmark: pgfId-1287465]You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
    [bookmark: pgfId-1287466]Step 3 To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title in the Graph Window Title field. 

 
    [bookmark: pgfId-1287467]Step 4 Click Show Graphs to view performance statistics in a new or updated graph window.

 
    [bookmark: pgfId-1287468]Step 5 Click the Table tab to view the same performance statistics in a tabular format. 

 
    [bookmark: pgfId-1287469]Step 6 From the View drop-down list on either tab, choose to display updates to information in the following time periods: Real-time, data every 10 sec; Last 10 minutes, data every 10 sec; Last 60 minutes, data every 1 min; Last 12 hours, data every 12 minutes; or Last 5 days, data every two hours.

 
    [bookmark: pgfId-1287470]Step 7 (Optional) Click Export to display the Export Graph Data dialog box. The selected performance statistics to export are already checked.

 
    [bookmark: pgfId-1287471]Step 8 (Optional) Click Export again to display the Save dialog box. 

 
    [bookmark: pgfId-1287472]Step 9 (Optional) Click Save to save the performance statistics to a text file (.txt) on your local drive for future reference.

 
    [bookmark: pgfId-1287473]Step 10 (Optional) Click Print to display the Print Graph dialog box.

 
    [bookmark: pgfId-1287474]Step 11 (Optional) Choose the graph or table name from the drop-down list, then click Print to display the Print dialog box.

 
    [bookmark: pgfId-1287475]Step 12 (Optional) Click OK to print the selected performance statistics.

 
    [bookmark: pgfId-1287476]

 
     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1287482][bookmark: 91600]Monitoring System Resources

 
    [bookmark: pgfId-1287483]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1287487]Blocks

 
     		 [bookmark: pgfId-1287491]CPU

 
     		 [bookmark: pgfId-1287495]Memory

 
    

 
     
      [bookmark: pgfId-1287498][bookmark: 75750]Blocks

 
     [bookmark: pgfId-1287499]To view the free and used memory blocks, perform the following steps:

 
     
 
     [bookmark: pgfId-1287500]Step 1 In the ASDM main window, choose Monitoring > Properties > System Resources Graphs > Blocks. 

 
     [bookmark: pgfId-1287501]Step 2 Select one or more entries from the Available Graphs list, then click Add to move them to the Selected Graphs list. To remove an entry from the Selected Graphs list, click Remove. The available options are the following:

 
      
       
       		 [bookmark: pgfId-1287505]Blocks Used—Displays the ASA used memory blocks.

 
       		 [bookmark: pgfId-1287509]Blocks Free—Displays the ASA free memory blocks.

 
      

 
     

 
     [bookmark: pgfId-1287510]You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
     [bookmark: pgfId-1287511]Step 3 To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title in the Graph Window Title field. 

 
     [bookmark: pgfId-1287512]Step 4 Click Show Graphs to view system resource statistics in a new or updated graph window.

 
     [bookmark: pgfId-1287513]Step 5 Click the Table tab to view the same performance statistics in a tabular format. 

 
     [bookmark: pgfId-1287514]Step 6 From the View drop-down list on either tab, choose to display updates to information in the following time periods: Real-time, data every 10 sec; Last 10 minutes, data every 10 sec; Last 60 minutes, data every 1 min; Last 12 hours, data every 12 minutes; or Last 5 days, data every two hours.

 
     [bookmark: pgfId-1287515]Step 7 (Optional) Click Export to display the Export Graph Data dialog box. The selected memory block statistics to export are already checked.

 
     [bookmark: pgfId-1287516]Step 8 (Optional) Click Export again to display the Save dialog box. 

 
     [bookmark: pgfId-1287517]Step 9 (Optional) Click Save to save the memory block statistics to a text file (.txt) on your local drive for future reference.

 
     [bookmark: pgfId-1287518]Step 10 (Optional) Click Print to display the Print Graph dialog box.

 
     [bookmark: pgfId-1287519]Step 11 (Optional) Choose the graph or table name from the drop-down list, then click Print to display the Print dialog box.

 
     [bookmark: pgfId-1287520]Step 12 (Optional) Click OK to print the selected memory block statistics.

 
     [bookmark: pgfId-1287521]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1287524][bookmark: 84982]CPU

 
     [bookmark: pgfId-1287525]To view the CPU utilization, perform the following steps: 

 
     
 
     [bookmark: pgfId-1287526]Step 1 In the ASDM main window, choose Monitoring > Properties > System Resources Graphs > CPU. 

 
     [bookmark: pgfId-1287527]Step 2 Select one or more entries from the Available Graphs list, then click Add to move them to the Selected Graphs list. To remove an entry from the Selected Graphs list, click Remove. 

 
     [bookmark: pgfId-1287528]You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
     [bookmark: pgfId-1287529]Step 3 To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title in the Graph Window Title field. 

 
     [bookmark: pgfId-1287530]Step 4 Click Show Graphs to view system resource statistics in a new or updated graph window.

 
     [bookmark: pgfId-1287531]Step 5 Click the Table tab to view the same performance statistics in a tabular format. 

 
     [bookmark: pgfId-1287532]Step 6 From the View drop-down list on either tab, choose to display updates to information in the following time periods: Real-time, data every 10 sec; Last 10 minutes, data every 10 sec; Last 60 minutes, data every 1 min; Last 12 hours, data every 12 minutes; or Last 5 days, data every two hours.

 
     [bookmark: pgfId-1287533]Step 7 (Optional) Click Export to display the Export Graph Data dialog box. The selected CPU utilization statistics to export are already checked.

 
     [bookmark: pgfId-1287534]Step 8 (Optional) Click Export again to display the Save dialog box. 

 
     [bookmark: pgfId-1287535]Step 9 (Optional) Click Save to save the CPU utilization statistics to a text file (.txt) on your local drive for future reference.

 
     [bookmark: pgfId-1287536]Step 10 (Optional) Click Print to display the Print Graph dialog box.

 
     [bookmark: pgfId-1287537]Step 11 (Optional) Choose the graph or table name from the drop-down list, then click Print to display the Print dialog box.

 
     [bookmark: pgfId-1287538]Step 12 (Optional) Click OK to print the selected CPU utilization statistics.

 
     [bookmark: pgfId-1287539]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1287542][bookmark: 43819]Memory

 
     [bookmark: pgfId-1287543]To view the memory utilization, perform the following steps:

 
     
 
     [bookmark: pgfId-1287544]Step 1 In the ASDM main window, choose Monitoring > Properties > System Resources Graphs > Blocks. 

 
     [bookmark: pgfId-1287545]Step 2 Select one or more entries from the Available Graphs list, then click Add to move them to the Selected Graphs list. To remove an entry from the Selected Graphs list, click Remove. The available options are the following:

 
      
       
       		 [bookmark: pgfId-1287549]Free Memory—Displays the ASA free memory.

 
       		 [bookmark: pgfId-1287553]Used Memory—Displays the ASA used memory.

 
      

 
     

 
     [bookmark: pgfId-1287554]You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
     [bookmark: pgfId-1287555]Step 3 To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title in the Graph Window Title field. 

 
     [bookmark: pgfId-1287556]Step 4 Click Show Graphs to view system resource statistics in a new or updated graph window.

 
     [bookmark: pgfId-1287557]Step 5 Click the Table tab to view the same performance statistics in a tabular format. 

 
     [bookmark: pgfId-1287558]Step 6 From the View drop-down list on either tab, choose to display updates to information in the following time periods: Real-time, data every 10 sec; Last 10 minutes, data every 10 sec; Last 60 minutes, data every 1 min; Last 12 hours, data every 12 minutes; or Last 5 days, data every two hours.

 
     [bookmark: pgfId-1287559]Step 7 (Optional) Click Export to display the Export Graph Data dialog box. The selected memory utilization statistics to export are already checked.

 
     [bookmark: pgfId-1287560]Step 8 (Optional) Click Export again to display the Save dialog box. 

 
     [bookmark: pgfId-1287561]Step 9 (Optional) Click Save to save the memory utilization statistics to a text file (.txt) on your local drive for future reference.

 
     [bookmark: pgfId-1287562]Step 10 (Optional) Click Print to display the Print Graph dialog box.

 
     [bookmark: pgfId-1287563]Step 11 (Optional) Choose the graph or table name from the drop-down list, then click Print to display the Print dialog box.

 
     [bookmark: pgfId-1287564]Step 12 (Optional) Click OK to print the selected memory utilization statistics.

 
     [bookmark: pgfId-1287565]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1287568][bookmark: 20032]Monitoring Connections

 
    [bookmark: pgfId-1287569]To view current connections in a tabular format, in the ASDM main window, choose Monitoring > Properties > Connections. Each connection is identified by the following parameters:

 
     
     		 [bookmark: pgfId-1287570]Protocol

 
     		 [bookmark: pgfId-1287571]Source:

 
    

 
    [bookmark: pgfId-1287572] – Security ID

 
    [bookmark: pgfId-1287573] – Security Name

 
    [bookmark: pgfId-1287574] – IP address

 
    [bookmark: pgfId-1287575] – Port

 
     
     		 [bookmark: pgfId-1287576]Destination:

 
    

 
    [bookmark: pgfId-1287577] – Security ID

 
    [bookmark: pgfId-1287578] – Security Name

 
    [bookmark: pgfId-1287579] – IP address

 
    [bookmark: pgfId-1287580] – Port

 
     
     		 [bookmark: pgfId-1287581]Idle time since the last packet was sent or received

 
     		 [bookmark: pgfId-1287582]Amount of sent and received traffic on the connection

 
    

 
   
 
    
     [bookmark: pgfId-1240131][bookmark: 98672]Monitoring Per-Process CPU Usage

 
    [bookmark: pgfId-1212587]You can monitor the processes that run on the CPU. You can obtain information about the percentage of CPU that is used by a certain process. CPU usage statistics are sorted in descending order to display the highest consumer at the top. Also included is information about the load on the CPU per process, at 5 seconds, 1 minute, and 5 minutes before the log time. This information is updated automatically every 5 seconds to provide real-time statistics. In ASDM, it is updated every 30 seconds. 

 
    [bookmark: pgfId-1287592]To view CPU usage on a per-process basis, perform the following steps:

 
    
 
    [bookmark: pgfId-1287593]Step 1 In the ASDM main window, choose Monitoring > Properties > Per-Process CPU Usage.

 
    [bookmark: pgfId-1287594]Step 2 To pause the auto-refresh of the screen, click Stop auto-refresh.

 
    [bookmark: pgfId-1287595]Step 3 To save the information on the screen to a local text file, click Save log to local file.

 
    [bookmark: pgfId-1287596]The Save dialog box appears.

 
    [bookmark: pgfId-1287597]Step 4 Enter the name of the text file, then click Save.

 
    [bookmark: pgfId-1287598]To color code processes according to their CPU usage range, click Configure CPU usage.

 
    [bookmark: pgfId-1287599]The Color Settings dialog box appears.

 
    [bookmark: pgfId-1287600]Step 5 Choose one of the following range options: 49% and below, 50% to 79%, and 80% and above. 

 
    [bookmark: pgfId-1287601]Step 6 Click the foreground or background cell to display the Pick a Color dialog box, and select the foreground and background colors for the given ranges. 

 
    [bookmark: pgfId-1287602]Step 7 Click one of the following tabs to pick the color palette: Swatches, HSB, or RGB. When you are done, click OK.

 
    [bookmark: pgfId-1287603]Step 8 Click OK to view the color-coded entries.

 
    [bookmark: pgfId-1287604]Step 9 Click Refresh to refresh the data manually at any time.

 
    [bookmark: pgfId-1287605]

 
     
     
 
    
  
    

 
    [bookmark: pgfId-1238721] 
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OPS/conns_qos.html
  
   
    
     [bookmark: pgfId-1047446][bookmark: 99006]Configuring QoS 
      
      
 
     
 

 
    [bookmark: pgfId-1066927]Have you ever participated in a long-distance phone call that involved a satellite connection? The conversation might be interrupted with brief, but perceptible, gaps at odd intervals. Those gaps are the time, called the [bookmark: marker-1066928]latency, between the arrival of packets being transmitted over the network. Some network traffic, such as voice and video, cannot tolerate long latency times. [bookmark: marker-1066929]Quality of service (QoS) is a feature that lets you give priority to critical traffic, prevent bandwidth hogging, and manage network bottlenecks to prevent packet drops.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1245543]Note For the ASASM, we suggest performing QoS on the switch instead of the ASASM. Switches have more capability in this area.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1049968]This chapter describes how to apply [bookmark: marker-1050504]QoS policies and includes the following sections:

 
     
     		 [bookmark: pgfId-1049969]Information About QoS

 
     		 [bookmark: pgfId-1112169]Licensing Requirements for QoS

 
     		 [bookmark: pgfId-1112202]Guidelines and Limitations

 
     		 [bookmark: pgfId-1096125]Configuring QoS

 
     		 [bookmark: pgfId-1196640]Monitoring QoS

 
     		 [bookmark: pgfId-1155888]Feature History for QoS

 
    

 
   
 
    
     [bookmark: pgfId-1042022]Information About QoS[bookmark: 85585][bookmark: marker-1050505]

 
    [bookmark: pgfId-1073094]You should consider that in an ever-changing network environment, QoS is not a one-time deployment, but an ongoing, essential part of network design. 

 
    [bookmark: pgfId-1077775]This section describes the QoS features supported by the ASA and includes the following topics:

 
     
     		 [bookmark: pgfId-1067058]Supported QoS Features

 
     		 [bookmark: pgfId-1067910]What is a Token Bucket?

 
     		 [bookmark: pgfId-1067077]Information About Policing

 
     		 [bookmark: pgfId-1067089]Information About Priority Queuing

 
     		 [bookmark: pgfId-1067131]Information About Traffic Shaping

 
     		 [bookmark: pgfId-1067164]DSCP and DiffServ Preservation

 
    

 
     
      [bookmark: pgfId-1064207][bookmark: 17659]Supported QoS Features

 
     [bookmark: pgfId-1064172]The ASA supports the following QoS features:

 
      
      		 [bookmark: pgfId-1064184]Policing—To prevent individual flows from hogging the network bandwidth, you can limit the maximum bandwidth used per flow. See the “Information About Policing” section for more information.

 
      		 [bookmark: pgfId-1064196]Priority queuing—For critical traffic that cannot tolerate latency, such as Voice over IP (VoIP), you can identify traffic for [bookmark: marker-1067348][bookmark: marker-1067349]Low Latency Queuing (LLQ) so that it is always transmitted ahead of other traffic. See the “Information About Priority Queuing” section for more information.

 
      		 [bookmark: pgfId-1064204]Traffic shaping—If you have a device that transmits packets at a high speed, such as a ASA with Fast Ethernet, and it is connected to a low speed device such as a cable modem, then the cable modem is a bottleneck at which packets are frequently dropped. To manage networks with differing line speeds, you can configure the ASA to transmit packets at a fixed slower rate. See the “Information About Traffic Shaping” section for more information.

 
     

 
    
 
     
      [bookmark: pgfId-1067538][bookmark: 40890]What is a Toke[bookmark: marker-1077041]n Bucket?

 
     [bookmark: pgfId-1072397]A token bucket is used to manage a device that regulates the data in a flow. For example, the regulator might be a traffic policer or a traffic shaper. A token bucket itself has no discard or priority policy. Rather, a token bucket discards tokens and leaves to the flow the problem of managing its transmission queue if the flow overdrives the regulator.

 
     [bookmark: pgfId-1067539]A token bucket is a formal definition of a rate of transfer. It has three components: a burst size, an average rate, and a time interval. Although the average rate is generally represented as bits per second, any two values may be derived from the third by the relation shown as follows:

 
     [bookmark: pgfId-1067540]average rate = burst size / time interval

 
     [bookmark: pgfId-1067541]Here are some definitions of these terms:

 
      
      		 [bookmark: pgfId-1067542]Average rate—Also called the committed information rate (CIR), it specifies how much data can be sent or forwarded per unit time on average.

 
      		 [bookmark: pgfId-1067543]Burst size—Also called the Committed Burst (Bc) size, it specifies in bits or bytes per burst how much traffic can be sent within a given unit of time to not create scheduling concerns. (For traffic shaping, it specifies bits per burst; for policing, it specifies bytes per burst.)

 
      		 [bookmark: pgfId-1067544]Time interval—Also called the measurement interval, it specifies the time quantum in seconds per burst.

 
     

 
     [bookmark: pgfId-1067546]In the token bucket metaphor, tokens are put into the bucket at a certain rate. The bucket itself has a specified capacity. If the bucket fills to capacity, newly arriving tokens are discarded. Each token is permission for the source to send a certain number of bits into the network. To send a packet, the regulator must remove from the bucket a number of tokens equal in representation to the packet size.

 
     [bookmark: pgfId-1067547]If not enough tokens are in the bucket to send a packet, the packet either waits until the bucket has enough tokens (in the case of traffic shaping) or the packet is discarded or marked down (in the case of policing). If the bucket is already full of tokens, incoming tokens overflow and are not available to future packets. Thus, at any time, the largest burst a source can send into the network is roughly proportional to the size of the bucket.

 
     [bookmark: pgfId-1067548]Note that the token bucket mechanism used for traffic shaping has both a token bucket and a data buffer, or queue; if it did not have a data buffer, it would be a policer. For traffic shaping, packets that arrive that cannot be sent immediately are delayed in the data buffer.

 
     [bookmark: pgfId-1067549]For traffic shaping, a token bucket permits burstiness but bounds it. It guarantees that the burstiness is bounded so that the flow will never send faster than the token bucket capacity, divided by the time interval, plus the established rate at which tokens are placed in the token bucket. See the following formula:

 
     [bookmark: pgfId-1067550](token bucket capacity in bits / time interval in seconds) + established rate in bps = maximum flow speed in bps

 
     [bookmark: pgfId-1067551]This method of bounding burstiness also guarantees that the long-term transmission rate will not exceed the established rate at which tokens are placed in the bucket.

 
    
 
     
      [bookmark: pgfId-1065257][bookmark: marker-1063841] Information About Policing [bookmark: 34685][bookmark: marker-1065256]

 
     [bookmark: pgfId-1068262]Policing is a way of ensuring that no traffic exceeds the maximum rate (in bits/second) that you configure, thus ensuring that no one traffic flow or class can take over the entire resource. When traffic exceeds the maximum rate, the ASA drops the excess traffic. Policing also sets the largest single burst of traffic allowed.

 
    
 
     
      [bookmark: pgfId-1065649] Information About Priority Queuing [bookmark: 34423]

 
     [bookmark: pgfId-1072436][bookmark: marker-1072438][bookmark: marker-1072439]LLQ priority queuing lets you prioritize certain traffic flows (such as latency-sensitive traffic like voice and video) ahead of other traffic.

 
     [bookmark: pgfId-1072463]The ASA supports two types of priority queuing:

 
      
      		 [bookmark: pgfId-1072467]Standard priority queuing—Standard priority queuing uses an LLQ priority queue on an interface (see the “Configuring the Standard Priority Queue for an Interface” section), while all other traffic goes into the “best effort” queue. Because queues are not of infinite size, they can fill and overflow. When a queue is full, any additional packets cannot get into the queue and are dropped. This is called  tail drop [bookmark: marker-1072530]. To avoid having the queue fill up, you can increase the queue buffer size. You can also fine-tune the maximum number of packets allowed into the transmit queue. These options let you control the latency and robustness of the priority queuing. Packets in the LLQ queue are always transmitted before packets in the best effort queue.

 
      		 [bookmark: pgfId-1072638]Hierarchical priority queuing—Hierarchical priority queuing is used on interfaces on which you enable a traffic shaping queue. A subset of the shaped traffic can be prioritized. The standard priority queue is not used. See the following guidelines about hierarchical priority queuing:

 
     

 
     [bookmark: pgfId-1072893] – Priority packets are always queued at the head of the shape queue so they are always transmitted ahead of other non-priority queued packets.

 
     [bookmark: pgfId-1072899] – Priority packets are never dropped from the shape queue unless the sustained rate of priority traffic exceeds the shape rate.

 
     [bookmark: pgfId-1072804] – For IPsec-encrypted packets, you can only match traffic based on the DSCP or precedence setting.

 
     [bookmark: pgfId-1072805] – IPsec-over-TCP is not supported for priority traffic classification.

 
    
 
     
      [bookmark: pgfId-1065249][bookmark: 44445]Information About Traffic Sh[bookmark: marker-1077042]aping

 
     [bookmark: pgfId-1067902]Traffic shaping is used to match device and link speeds, thereby controlling packet loss, variable delay, and link saturation, which can cause jitter and delay.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1097090]Note Traffic shaping is only supported on the ASA 5505, 5510, 5520, 5540, and 5550.

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1071245]Traffic shaping must be applied to all outgoing traffic on a physical interface or in the case of the ASA 5505, on a VLAN. You cannot configure traffic shaping for specific types of traffic.

 
      		 [bookmark: pgfId-1067820]Traffic shaping is implemented when packets are ready to be transmitted on an interface, so the rate calculation is performed based on the actual size of a packet to be transmitted, including all the possible overhead such as the IPsec header and L2 header. 

 
      		 [bookmark: pgfId-1067821]The shaped traffic includes both through-the-box and from-the-box traffic.

 
      		 [bookmark: pgfId-1067822]The shape rate calculation is based on the standard token bucket algorithm. The token bucket size is twice the Burst Size value. See the “What is a Token Bucket?” section.

 
      		 [bookmark: pgfId-1067823]When bursty traffic exceeds the specified shape rate, packets are queued and transmitted later. Following are some characteristics regarding the shape queue (for information about hierarchical priority queuing, see the “Information About Priority Queuing” section):

 
     

 
     [bookmark: pgfId-1067824] – The queue size is calculated based on the shape rate. The queue can hold the equivalent of 200-milliseconds worth of shape rate traffic, assuming a 1500-byte packet. The minimum queue size is 64.

 
     [bookmark: pgfId-1067826] – When the queue limit is reached, packets are tail-dropped.

 
     [bookmark: pgfId-1067828] – Certain critical keep-alive packets such as OSPF Hello packets are never dropped.

 
     [bookmark: pgfId-1067829] – The time interval is derived by time_interval = burst_size / average_rate. The larger the time interval is, the burstier the shaped traffic might be, and the longer the link might be idle. The effect can be best understood using the following exaggerated example:

 
     [bookmark: pgfId-1067830]Average Rate = 1000000

 
     [bookmark: pgfId-1067831]Burst Size = 1000000

 
     [bookmark: pgfId-1067832]In the above example, the time interval is 1 second, which means, 1 Mbps of traffic can be bursted out within the first 10 milliseconds of the 1-second interval on a 100 Mbps FE link and leave the remaining 990 milliseconds idle without being able to send any packets until the next time interval. So if there is delay-sensitive traffic such as voice traffic, the Burst Size should be reduced compared to the average rate so the time interval is reduced.

 
    
 
     
      [bookmark: pgfId-1071702][bookmark: 99819]How QoS Fea[bookmark: marker-1077043]tures Interact

 
     [bookmark: pgfId-1071805]You can configure each of the QoS features alone if desired for the ASA. Often, though, you configure multiple QoS features on the ASA so you can prioritize some traffic, for example, and prevent other traffic from causing bandwidth problems.

 
     [bookmark: pgfId-1071905]See the following supported feature combinations per interface:

 
      
      		 [bookmark: pgfId-1071921]Standard priority queuing (for specific traffic) + Policing (for the rest of the traffic).

 
     

 
     [bookmark: pgfId-1072282]You cannot configure priority queuing and policing for the same set of traffic. 

 
      
      		 [bookmark: pgfId-1071938]Traffic shaping (for all traffic on an interface) + Hierarchical priority queuing (for a subset of traffic).

 
     

 
     [bookmark: pgfId-1071976]You cannot configure traffic shaping and standard priority queuing for the same interface; only hierarchical priority queuing is allowed. For example, if you configure standard priority queuing for the global policy, and then configure traffic shaping for a specific interface, the feature you configured last is rejected because the global policy overlaps the interface policy.

 
     [bookmark: pgfId-1072671]Typically, if you enable traffic shaping, you do not also enable policing for the same traffic, although the ASA does not restrict you from configuring this.

 
    
 
     
      [bookmark: pgfId-1066568][bookmark: 95478]DSCP and DiffServ Preserv[bookmark: marker-1077044]ation

 
      
      		 [bookmark: pgfId-1073067]DSCP markings are preserved on all traffic passing through the ASA.

 
      		 [bookmark: pgfId-1068312]The ASA does not locally mark/remark any classified traffic, but it honors the Expedited Forwarding (EF) DSCP bits of every packet to determine if it requires “priority” handling and will direct those packets to the LLQ.

 
      		 [bookmark: pgfId-1112080]DiffServ marking is preserved on packets when they traverse the service provider backbone so that QoS can be applied in transit (QoS tunnel pre-classification).

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1112081][bookmark: 54846]Licensing Requirements for QoS

 
    [bookmark: pgfId-1112082]The following table shows the licensing requirements for this feature:

 
    [bookmark: pgfId-1291963] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1291956]Model 
         
  
        		 
          
          [bookmark: pgfId-1291958]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1291960]All models

  
        		[bookmark: pgfId-1291962]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1111709][bookmark: 87069]Guidelines and Limitations

 
    [bookmark: pgfId-1111710]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1111712][bookmark: 87419]Context Mode Guidelines

 
    [bookmark: pgfId-1111715]Supported in single context mode only. Does not support multiple context mode.

 
    [bookmark: pgfId-1112086][bookmark: 16807]Firewall Mode Guidelines

 
    [bookmark: pgfId-1112089]Supported in routed firewall mode only. Does not support transparent firewall mode.

 
    [bookmark: pgfId-1111725]IPv6 Guidelines

 
    [bookmark: pgfId-1112138]Does not support IPv6.

 
    [bookmark: pgfId-1111730][bookmark: 34265]Model Guidelines

 
     
     		 [bookmark: pgfId-1245562]Traffic shaping is only supported on the ASA 5505, 5510, 5520, 5540, and 5550. Multi-core models (such as the ASA 5500-X) do not support shaping.

 
     		 [bookmark: pgfId-1245563](ASA 5580) You cannot create a standard priority queue for a Ten Gigabit Ethernet interface.  Note : For the ASA 5585-X, standard priority queuing is supported on a Ten Gigabit Interface.

 
     		 [bookmark: pgfId-1245564](ASA 5512-X through ASA 5555-X) Priority queuing is not supported on the Management 0/0 interface.

 
     		 [bookmark: pgfId-1245565](ASASM) Only policing is supported.

 
    

 
    [bookmark: pgfId-1161312]Additional Guidelines and Limitations

 
     
     		 [bookmark: pgfId-1161362]QoS is applied unidirectionally; only traffic that enters (or exits, depending on the QoS feature) the interface to which you apply the policy map is affected. See the “Feature Directionality” section for more information.

 
     		 [bookmark: pgfId-1256955]For traffic shaping, you can only use the  class-default class map, which is automatically created by the ASA, and which matches all traffic.

 
     		 [bookmark: pgfId-1161369]For priority traffic, you cannot use the  class-default class map.

 
     		 [bookmark: pgfId-1161370]For hierarchical priority queuing, for encrypted VPN traffic, you can only match traffic based on the DSCP or precedence setting; you cannot match a tunnel group.

 
     		 [bookmark: pgfId-1161371]For hierarchical priority queuing, IPsec-over-TCP traffic is not supported.

 
     		 [bookmark: pgfId-1161390]You cannot configure traffic shaping and standard priority queuing for the same interface; only hierarchical priority queuing is allowed.

 
     		 [bookmark: pgfId-1205236]For standard priority queuing, the queue must be configured for a physical interface or, for the ASA 5505 or ASASM, a VLAN.

 
     		 [bookmark: pgfId-1256874]For policing, to-the-box traffic is not supported.

 
     		 [bookmark: pgfId-1256937]For policing, traffic to and from a VPN tunnel bypass interface is not supported.

 
     		 [bookmark: pgfId-1256938]For policing, when you match a tunnel group class map, only outbound policing is supported.

 
    

 
   
 
    
     [bookmark: pgfId-1256940][bookmark: 27460]Configuring QoS

 
    [bookmark: pgfId-1089807]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1089837]Determining the Queue and TX Ring Limits for a Standard Priority Queue

 
     		 [bookmark: pgfId-1162300]Configuring the Standard Priority Queue for an Interface

 
     		 [bookmark: pgfId-1089991]Configuring a Service Rule for Standard Priority Queuing and Policing

 
     		 [bookmark: pgfId-1090023]Configuring a Service Rule for Traffic Shaping and Hierarchical Priority Queuing

 
    

 
     
      [bookmark: pgfId-1161961][bookmark: 52760]Determining the Queue and TX Ring Limits for a Standard Priority Queue

 
     [bookmark: pgfId-1161962]To determine the priority queue and TX ring limits, use the worksheets below.

 
     [bookmark: pgfId-1161966]Table 23-1 shows how to calculate the priority queue size. Because queues are not of infinite size, they can fill and overflow. When a queue is full, any additional packets cannot get into the queue and are dropped (called tail drop). To avoid having the queue fill up, you can adjust the queue buffer size according to the “Configuring the Standard Priority Queue for an Interface” section.

 
     [bookmark: pgfId-1162078] 

 
      
       
        
        [bookmark: pgfId-1161973]Table 23-1 [bookmark: 12666]Queue Limit Worksheet

 
        
        
         
         		 [bookmark: pgfId-1161991]Step 1

  
         		 [bookmark: pgfId-1161993] 

 [bookmark: pgfId-1161994]__________

 [bookmark: pgfId-1161995]Outbound bandwidth (Mbps or Kbps)1

  
         		[bookmark: pgfId-1162000] 

 [bookmark: pgfId-1162001]Mbps

  
         		 
           
           [bookmark: pgfId-1162003]  
          
 
           
           [bookmark: pgfId-1162004]x 
          
  
         		[bookmark: pgfId-1162006] 

 [bookmark: pgfId-1162007]125

  
         		 
           
           [bookmark: pgfId-1162009]  
          
 
           
           [bookmark: pgfId-1162010]= 
          
  
         		[bookmark: pgfId-1162012] 

 [bookmark: pgfId-1162013]__________

 [bookmark: pgfId-1162014]# of bytes/ms

  
         		[bookmark: pgfId-1162016] 

  
         		[bookmark: pgfId-1162018] 

  
        

 
         
         		[bookmark: pgfId-1162024] 

 [bookmark: pgfId-1162025]Kbps

  
         		 
           
           [bookmark: pgfId-1162027]  
          
 
           
           [bookmark: pgfId-1162028]x 
          
  
         		[bookmark: pgfId-1162030] 

 [bookmark: pgfId-1162031].125

  
         		 
           
           [bookmark: pgfId-1162033]  
          
 
           
           [bookmark: pgfId-1162034]= 
          
  
         		[bookmark: pgfId-1162036] 

 [bookmark: pgfId-1162037]__________

 [bookmark: pgfId-1162038]# of bytes/ms

  
         		[bookmark: pgfId-1162040] 

  
         		[bookmark: pgfId-1162042] 

  
        

 
         
         		[bookmark: pgfId-1162044]Step 2

  
         		[bookmark: pgfId-1162046] 

 [bookmark: pgfId-1162047]___________

 [bookmark: pgfId-1162048]# of bytes/ms from Step 1

  
         		[bookmark: pgfId-1162050] 

  
         		 
           
           [bookmark: pgfId-1162052]  
          
 
           
           [bookmark: pgfId-1162053]÷ 
          
  
         		[bookmark: pgfId-1162055]  

 [bookmark: pgfId-1162056]__________

 [bookmark: pgfId-1162057]Average packet size (bytes)2

  
         		 
           
           [bookmark: pgfId-1162062]  
          
 
           
           [bookmark: pgfId-1162063]x 
          
  
         		[bookmark: pgfId-1162065] 

 [bookmark: pgfId-1162066]__________

 [bookmark: pgfId-1162070]Delay (ms)3

  
         		 
           
           [bookmark: pgfId-1162072]  
          
 
           
           [bookmark: pgfId-1162073]= 
          
  
         		[bookmark: pgfId-1162075] 

 [bookmark: pgfId-1162076]__________

 [bookmark: pgfId-1162077]Queue limit
(# of packets)

  
        

 
        
      

 
     
 
      
       
        
        		 1.[bookmark: pgfId-1161998]For example, DSL might have an uplink speed of 768 Kbps. Check with your provider.

 2.[bookmark: pgfId-1162060]Determine this value from a codec or sampling size. For example, for VoIP over VPN, you might use 160 bytes. We recommend 256 bytes if you do not know what size to use.

 3.[bookmark: pgfId-1162069]The delay depends on your application. For example, the recommended maximum delay for VoIP is 200 ms. We recommend 500 ms if you do not know what delay to use.

  
       

 
       
     

 
     [bookmark: pgfId-1162082]Table 23-2 shows how to calculate the TX ring limit. This limit determines the maximum number of packets allowed into the Ethernet transmit driver before the driver pushes back to the queues on the interface to let them buffer packets until the congestion clears. This setting guarantees that the hardware-based transmit ring imposes a limited amount of extra latency for a high-priority packet.

 
     [bookmark: pgfId-1162191] 

 
      
       
        
        [bookmark: pgfId-1162086]Table 23-2 [bookmark: 12069]TX Ring Limit Worksheet

 
        
        
         
         		 [bookmark: pgfId-1162104]Step 1

  
         		 [bookmark: pgfId-1162106] 

 [bookmark: pgfId-1162107]__________

 [bookmark: pgfId-1162108]Outbound bandwidth (Mbps or Kbps)4

  
         		[bookmark: pgfId-1162113] 

 [bookmark: pgfId-1162114]Mbps

  
         		 
           
           [bookmark: pgfId-1162116]  
          
 
           
           [bookmark: pgfId-1162117]x 
          
  
         		[bookmark: pgfId-1162119] 

 [bookmark: pgfId-1162120]125

  
         		 
           
           [bookmark: pgfId-1162122]  
          
 
           
           [bookmark: pgfId-1162123]= 
          
  
         		[bookmark: pgfId-1162125] 

 [bookmark: pgfId-1162126]__________

 [bookmark: pgfId-1162127]# of bytes/ms

  
         		[bookmark: pgfId-1162129] 

  
         		[bookmark: pgfId-1162131] 

  
        

 
         
         		[bookmark: pgfId-1162137] 

 [bookmark: pgfId-1162138]Kbps

  
         		 
           
           [bookmark: pgfId-1162140]  
          
 
           
           [bookmark: pgfId-1162141]x 
          
  
         		[bookmark: pgfId-1162143] 

 [bookmark: pgfId-1162144]0.125

  
         		 
           
           [bookmark: pgfId-1162146]  
          
 
           
           [bookmark: pgfId-1162147]= 
          
  
         		[bookmark: pgfId-1162149] 

 [bookmark: pgfId-1162150]__________

 [bookmark: pgfId-1162151]# of bytes/ms

  
         		[bookmark: pgfId-1162153] 

  
         		[bookmark: pgfId-1162155] 

  
        

 
         
         		[bookmark: pgfId-1162157]Step 2

  
         		[bookmark: pgfId-1162159] 

 [bookmark: pgfId-1162160]___________

 [bookmark: pgfId-1162161]# of bytes/ms from Step 1

  
         		[bookmark: pgfId-1162163] 

  
         		 
           
           [bookmark: pgfId-1162165]  
          
 
           
           [bookmark: pgfId-1162166]÷ 
          
  
         		[bookmark: pgfId-1162168]  

 [bookmark: pgfId-1162169]__________

 [bookmark: pgfId-1162170]Maximum packet size (bytes)5

  
         		 
           
           [bookmark: pgfId-1162175]  
          
 
           
           [bookmark: pgfId-1162176]x 
          
  
         		[bookmark: pgfId-1162178] 

 [bookmark: pgfId-1162179]__________

 [bookmark: pgfId-1162183]Delay (ms)6

  
         		 
           
           [bookmark: pgfId-1162185]  
          
 
           
           [bookmark: pgfId-1162186]= 
          
  
         		[bookmark: pgfId-1162188] 

 [bookmark: pgfId-1162189]__________

 [bookmark: pgfId-1162190]TX ring limit
(# of packets)

  
        

 
        
      

 
     
 
      
       
        
        		 4.[bookmark: pgfId-1162111]For example, DSL might have an uplink speed of 768 Kbps.Check with your provider.

 5.[bookmark: pgfId-1162173]Typically, the maximum size is 1538 bytes, or 1542 bytes for tagged Ethernet. If you allow jumbo frames (if supported for your platform), then the packet size might be larger.

 6.[bookmark: pgfId-1162182]The delay depends on your application. For example, to control jitter for VoIP, you should use 20 ms.

  
       

 
       
     

 
    
 
     
      [bookmark: pgfId-1067962][bookmark: 88320]Configuring the Standard Priority Queue for an Interface

 
     [bookmark: pgfId-1083458]If you enable standard priority queuing for traffic on a physical interface, then you need to also create the priority queue on each interface. Each physical interface uses two queues: one for priority traffic, and the other for all other traffic. For the other traffic, you can optionally configure policing.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1083459]Note The standard priority queue is not required for hierarchical priority queuing with traffic shaping; see the “Information About Priority Queuing” section for more information.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1089362][bookmark: 51929]Restrictions

 
      
      		 [bookmark: pgfId-1245648](ASASM) The ASASM does not support priority queuing.

 
      		 [bookmark: pgfId-1190055](ASA 5580) You cannot create a standard priority queue for a Ten Gigabit Ethernet interface.  Note : For the ASA 5585-X, standard priority queuing is supported on a Ten Gigabit Interface.

 
      		 [bookmark: pgfId-1207887](ASA 5512-X through ASA 5555-X) Priority queuing is not supported on the Management 0/0 interface.

 
     

 
    
 
     
      [bookmark: pgfId-1157085]Detailed Steps

 
     [bookmark: pgfId-1157353] 

 
     
 
     [bookmark: pgfId-1283234]Step 1 Go to Configuration > Device Management > Advanced > Priority Queue, and click Add.

 
     [bookmark: pgfId-1283235]The Add Priority Queue dialog box displays.

 
     [bookmark: pgfId-1283236]Step 2 From the Interface drop-down list, choose the physical interface name on which you want to enable the priority queue, or for the ASA 5505 or ASASM, the VLAN interface name.

 
     [bookmark: pgfId-1283241]Step 3 To cha[bookmark: marker-1283240]nge the size of the priority queues, in the Queue Limit field, enter the number of average, 256-byte packets that the specified interface can transmit in a 500-ms interval.

 
     [bookmark: pgfId-1283242]A packet that stays more than 500 ms in a network node might trigger a timeout in the end-to-end application. Such a packet can be discarded in each network node. 

 
     [bookmark: pgfId-1283243]Because queues are not of infinite size, they can fill and overflow. When a queue is full, any additional packets cannot get into the queue and are dropped (called tail drop). To avoid having the queue fill up, you can use this option to increase the queue buffer size.

 
     [bookmark: pgfId-1283244]The upper limit of the range of values for this option is determined dynamically at run time. The key determinants are the memory needed to support the queues and the memory available on the device.

 
     [bookmark: pgfId-1283245]The Queue Limit that you specify affects both the higher priority low-latency queue and the best effort queue.

 
     [bookmark: pgfId-1283246]Step 4 To specify the depth of the priority queues, in the Transmission Ring Limit field, enter the number of maximum 1550-byte packets that the specified interface can transmit in a 10-ms interval.

 
     [bookmark: pgfId-1283247]This setting guarantees that the hardware-based transmit ring imposes no more than 10-ms of extra latency for a high-priority packet.

 
     [bookmark: pgfId-1283248]This option sets the maximum number of low-latency or normal priority packets allowed into the Ethernet transmit driver before the driver pushes back to the queues on the interface to let them buffer packets until the congestion clears. 

 
     [bookmark: pgfId-1283249]The upper limit of the range of values is determined dynamically at run time. The key determinants are the memory needed to support the queues and the memory available on the device.

 
     [bookmark: pgfId-1283250]The Transmission Ring Limit that you specify affects both the higher priority low-latency queue and the best-effort queue.

 
     [bookmark: pgfId-1283251]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1071334][bookmark: 51676]Configuring a Service Rule for Standard Priority Queuing and Policing

 
     [bookmark: pgfId-1157016]You can configure standard priority queuing and policing for different class maps within the same policy map. See the “How QoS Features Interact” section for information about valid QoS configurations.

 
     [bookmark: pgfId-1074417]To create a policy map, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1156696]Restrictions

 
      
      		 [bookmark: pgfId-1156999]You cannot use the  class-default class map for priority traffic.

 
      		 [bookmark: pgfId-1157056]You cannot configure traffic shaping and standard priority queuing for the same interface; only hierarchical priority queuing is allowed.

 
      		 [bookmark: pgfId-1245661](ASASM) The ASASM only supports policing.

 
      		 [bookmark: pgfId-1257005]For policing, to-the-box traffic is not supported.

 
      		 [bookmark: pgfId-1257006]For policing, traffic to and from a VPN tunnel bypass interface is not supported.

 
      		 [bookmark: pgfId-1257007]For policing, when you match a tunnel group class map, only outbound policing is supported.

 
     

 
    
 
     
      [bookmark: pgfId-1157000]Guidelines

 
      
      		 [bookmark: pgfId-1157001]For priority traffic, identify only latency-sensitive traffic.

 
      		 [bookmark: pgfId-1156539]For policing traffic, you can choose to police all other traffic, or you can limit the traffic to certain types. 

 
     

 
    
 
     
      [bookmark: pgfId-1089462]Detailed Steps

 
     [bookmark: pgfId-1158691] 

 
     
 
     [bookmark: pgfId-1283256]Step 1 To configure priority queuing, configure a service policy rule in the Configuration > Firewall > Service Policy Rules pane according to Chapter1, “Configuring a Service Policy”

 
     [bookmark: pgfId-1283260]You can configure QoS as part of a new service policy rule, or you can edit an existing service policy.

 
     [bookmark: pgfId-1283261]Step 2 In the Rule Actions dialog box, click the QoS tab.

 
     [bookmark: pgfId-1283262]Step 3 Click Enable priority for this flow.

 
     [bookmark: pgfId-1283263]If this service policy rule is for an individual interface, ASDM automatically creates the priority queue for the interface (Configuration > Device Management > Advanced > Priority Queue; for more information, see the “Configuring the Standard Priority Queue for an Interface” section). If this rule is for the global policy, then you need to manually add the priority queue to one or more interfaces before you configure the service policy rule.

 
     [bookmark: pgfId-1283267]Step 4 Click Finish. The service policy rule is added to the rule table. 

 
     [bookmark: pgfId-1283268]Step 5 To configure policing, configure a service policy rule for the same interface in the Configuration > Firewall > Service Policy Rules pane according to Chapter1, “Configuring a Service Policy”

 
     [bookmark: pgfId-1283272]For policing traffic, you can choose to police all traffic that you are not prioritizing, or you can limit the traffic to certain types.

 
     [bookmark: pgfId-1283273]Step 6 In the Rule Actions dialog box, click the QoS tab.

 
     [bookmark: pgfId-1283274]Step 7 Click Enable policing, then check the Input policing or Output policing (or both) check boxes to enable the specified type of traffic policing. For each type of traffic policing, configure the following fields:

 
      
       
       		 [bookmark: pgfId-1283275]Committed Rate—The rate limit for this traffic flow; this is a value in the range 8000-2000000000, specifying the maximum speed (bits per second) allowed.

 
       		 [bookmark: pgfId-1283276]Conform Action—The action to take when the rate is less than the conform-burst value. Values are transmit or drop.

 
       		 [bookmark: pgfId-1283277]Exceed Action—Take this action when the rate is between the conform-rate value and the conform-burst value. Values are transmit or drop.

 
       		 [bookmark: pgfId-1283278]Burst Rate—A value in the range 1000-512000000, specifying the maximum number of instantaneous bytes allowed in a sustained burst before throttling to the conforming rate value.

 
      

 
     

 
     [bookmark: pgfId-1283279]Step 8 Click Finish. The service policy rule is added to the rule table.

 
     [bookmark: pgfId-1283280]Step 9 Click Apply to send the configuration to the device.

 
     [bookmark: pgfId-1283281]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1074879][bookmark: 75446]Configuring a Service Rule for Traffic Shaping and Hierarchical Priority Queuing

 
     [bookmark: pgfId-1075678]You can configure traffic shaping for all traffic on an interface, and optionally hierarchical priority queuing for a subset of latency-sensitive traffic.

 
    
 
     
      [bookmark: pgfId-1157145]Guidelines

 
      
      		 [bookmark: pgfId-1248772]One side-effect of priority queuing is packet re-ordering. For IPsec packets, out-of-order packets that are not within the anti-replay window generate warning syslog messages. These warnings are false alarms in the case of priority [bookmark: marker-1205906]queuing. You can configure the IPsec anti-replay window size to avoid possible false alarms. See the Configuration > VPN > IPsec > IPsec Rules > Enable Anti-replay window [bookmark: marker-1283286]size option in the “Adding Crypto Maps” section in the VPN configuration guide.

 
      		 [bookmark: pgfId-1161264]For hierarchical priority queuing, you do not need to create a priority queue on an interface.

 
     

 
    
 
     
      [bookmark: pgfId-1205934]Restrictions

 
      
      		 [bookmark: pgfId-1205935]For hierarchical priority queuing, for encrypted VPN traffic, you can only match traffic based on the DSCP or precedence setting; you cannot match a tunnel group.

 
      		 [bookmark: pgfId-1205936]For hierarchical priority queuing, IPsec-over-TCP traffic is not supported.

 
      		 [bookmark: pgfId-1166016]Traffic shaping is only supported on the ASA 5505, 5510, 5520, 5540, and 5550. Multi-core models (such as the ASA 5500-X) do not support shaping.

 
      		 [bookmark: pgfId-1163633]For traffic shaping, you can only use the  class-default class map, which is automatically created by the ASA, and which matches all traffic.

 
      		 [bookmark: pgfId-1163637]You cannot configure traffic shaping and standard priority queuing for the same interface; only hierarchical priority queuing is allowed. See the “How QoS Features Interact” section for information about valid QoS configurations.

 
      		 [bookmark: pgfId-1163641]You cannot configure traffic shaping in the global policy.

 
     

 
    
 
     
      [bookmark: pgfId-1075682]Detailed Steps

 
     [bookmark: pgfId-1160141] 

 
     
 
     [bookmark: pgfId-1283298]Step 1 Configure a service policy on the Configuration > Firewall > Service Policy Rules pane according to Chapter1, “Configuring a Service Policy”

 
     [bookmark: pgfId-1283302]You can configure QoS as part of a new service policy rule, or you can edit an existing service policy.

 
     [bookmark: pgfId-1283303]Step 2 In the Rule Actions dialog box, click the QoS tab.

 
     [bookmark: pgfId-1283304]Step 3 Click Enable traffic shaping, and configure the following fields:

 
      
       
       		 [bookmark: pgfId-1283305]Average Rate—Sets the average rate of traffic in bits per second over a given fixed time period, between 64000 and 154400000. Specify a value that is a multiple of 8000.

 
       		 [bookmark: pgfId-1283306]Burst Size—Sets the average burst size in bits that can be transmitted over a given fixed time period, between 2048 and 154400000. Specify a value that is a multiple of 128. If you do not specify the Burst Size, the default value is equivalent to 4-milliseconds of traffic at the specified Average Rate. For example, if the average rate is 1000000 bits per second, 4 ms worth = 1000000 * 4/1000 = 4000.

 
      

 
     

 
     [bookmark: pgfId-1283307]Step 4 (Optional) To configure priority queuing for a subset of shaped traffic:

 
     [bookmark: pgfId-1283309] a. Click Enforce priority to selected shape traffic[bookmark: marker-1283308].

 
     [bookmark: pgfId-1283310] b. Click Configure to identify the traffic that you want to prioritize.

 
     [bookmark: pgfId-1283311]You are prompted to identify the traffic for which you want to apply priority queuing.

 
     [bookmark: pgfId-1283314] c. After you identify the traffic (see the “Adding a Service Policy Rule for Through Traffic” section), click Next.

 
     [bookmark: pgfId-1283316] d. Click Enable priority for this flow.

 
     [bookmark: pgfId-1283317] e. Click Finish.

 
     [bookmark: pgfId-1283318]You return to the QoS tab.

 
     [bookmark: pgfId-1283319]Step 5 Click Finish. The service policy rule is added to the rule table.

 
     [bookmark: pgfId-1283320]Step 6 Click Apply to send the configuration to the device.

 
     [bookmark: pgfId-1283321]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1197331][bookmark: 38121][bookmark: 76030]Monitoring [bookmark: marker-1197329]QoS[bookmark: marker-1197330]

 
    [bookmark: pgfId-1197332]To monitor QoS in ASDM, you can enter commands at the Command Line Interface tool. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1197336]Viewing QoS Police Statistics

 
     		 [bookmark: pgfId-1197340]Viewing QoS Standard Priority Statistics

 
     		 [bookmark: pgfId-1197344]Viewing QoS Shaping Statistics

 
     		 [bookmark: pgfId-1197348]Viewing QoS Standard Priority Queue Statistics

 
    

 
     
      [bookmark: pgfId-1197351][bookmark: marker-1197349][bookmark: 67046]Viewing QoS Police Statistics

 
     [bookmark: pgfId-1197352]To view the QoS statistics for traffic policing, use the show service-policy command with the police keyword:

 
      
      [bookmark: pgfId-1197356]ciscoasa# show service-policy police 
     
 
      
      [bookmark: pgfId-1197357]  
     
 
     [bookmark: pgfId-1197358]The following is sample output for the show service-policy police command:

 
      
      [bookmark: pgfId-1197362]ciscoasa# show service-policy police 
     
 
      
      [bookmark: pgfId-1197363]  
     
 
      
      [bookmark: pgfId-1197364]Global policy: 
     
 
      
      [bookmark: pgfId-1197365] Service-policy: global_fw_policy 
     
 
      
      [bookmark: pgfId-1197366]  
     
 
      
      [bookmark: pgfId-1197367]Interface outside: 
     
 
      
      [bookmark: pgfId-1197368] Service-policy: qos 
     
 
      
      [bookmark: pgfId-1197369] Class-map: browse 
     
 
      
      [bookmark: pgfId-1197370] police Interface outside: 
     
 
      
      [bookmark: pgfId-1197371] cir 56000 bps, bc 10500 bytes 
     
 
      
      [bookmark: pgfId-1197372] conformed 10065 packets, 12621510 bytes; actions: transmit 
     
 
      
      [bookmark: pgfId-1197373] exceeded 499 packets, 625146 bytes; actions: drop 
     
 
      
      [bookmark: pgfId-1197374] conformed 5600 bps, exceed 5016 bps 
     
 
      
      [bookmark: pgfId-1197375] Class-map: cmap2 
     
 
      
      [bookmark: pgfId-1197376] police Interface outside: 
     
 
      
      [bookmark: pgfId-1197377] cir 200000 bps, bc 37500 bytes 
     
 
      
      [bookmark: pgfId-1197378] conformed 17179 packets, 20614800 bytes; actions: transmit 
     
 
      
      [bookmark: pgfId-1197379] exceeded 617 packets, 770718 bytes; actions: drop 
     
 
      
      [bookmark: pgfId-1197380] conformed 198785 bps, exceed 2303 bps 
     
 
      
      [bookmark: pgfId-1197381]  
     
 
    
 
     
      [bookmark: pgfId-1197383][bookmark: 78833]Viewing QoS Standard Priority Statistics

 
     [bookmark: pgfId-1197384]To view statistics for service policies implementing the priority command, use the show service-policy command with the priority keyword:

 
      
      [bookmark: pgfId-1197388]ciscoasa# show service-policy priority 
     
 
      
      [bookmark: pgfId-1197389]  
     
 
     [bookmark: pgfId-1197390]The following is sample output for the show service-policy priority command:

 
      
      [bookmark: pgfId-1197394]ciscoasa# show service-policy priority 
     
 
      
      [bookmark: pgfId-1197395]Global policy: 
     
 
      
      [bookmark: pgfId-1197396] Service-policy: global_fw_policy 
     
 
      
      [bookmark: pgfId-1197397]Interface outside: 
     
 
      
      [bookmark: pgfId-1197398] Service-policy: qos 
     
 
      
      [bookmark: pgfId-1197399] Class-map: TG1-voice 
     
 
      
      [bookmark: pgfId-1197400] Priority: 
     
 
      
      [bookmark: pgfId-1197401] Interface outside: aggregate drop 0, aggregate transmit 9383 
     
 
      
      [bookmark: pgfId-1197402]  
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1197403]Note “Aggregate drop” denotes the aggregated drop in this interface; “aggregate transmit” denotes the aggregated number of transmitted packets in this interface.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1197405][bookmark: 36655]Viewing QoS Shaping Statistics

 
     [bookmark: pgfId-1197406]To view statistics for service policies implementing the shape command, use the show service-policy command with the shape keyword:

 
      
      [bookmark: pgfId-1197410]ciscoasa# show service-policy shape 
     
 
      
      [bookmark: pgfId-1197411]  
     
 
     [bookmark: pgfId-1197412]The following is sample output for the show service-policy shape command:

 
      
      [bookmark: pgfId-1197416]ciscoasa# show service-policy shape 
     
 
      
      [bookmark: pgfId-1197417]Interface outside  
     
 
      
      [bookmark: pgfId-1197418] Service-policy: shape 
     
 
      
      [bookmark: pgfId-1197419] Class-map: class-default 
     
 
      
      [bookmark: pgfId-1197420]  
     
 
      
      [bookmark: pgfId-1197421] Queueing 
     
 
      
      [bookmark: pgfId-1197422] queue limit 64 packets 
     
 
      
      [bookmark: pgfId-1197423] (queue depth/total drops/no-buffer drops) 0/0/0 
     
 
      
      [bookmark: pgfId-1197424] (pkts output/bytes output) 0/0 
     
 
      
      [bookmark: pgfId-1197425]  
     
 
      
      [bookmark: pgfId-1197426] shape (average) cir 2000000, bc 8000, be 8000  
     
 
      
      [bookmark: pgfId-1197427]  
     
 
     [bookmark: pgfId-1197428]The following is sample output of the show service policy shape command, which includes service policies that include the shape command and the service-policy command that calls the hierarchical priority policy and the related statistics:

 
      
      [bookmark: pgfId-1197432]ciscoasa# show service-policy shape 
     
 
      
      [bookmark: pgfId-1197433]  
     
 
      
      [bookmark: pgfId-1197434]Interface outside: 
     
 
      
      [bookmark: pgfId-1197435] Service-policy: shape 
     
 
      
      [bookmark: pgfId-1197436] Class-map: class-default 
     
 
      
      [bookmark: pgfId-1197437]  
     
 
      
      [bookmark: pgfId-1197438] Queueing 
     
 
      
      [bookmark: pgfId-1197439] queue limit 64 packets 
     
 
      
      [bookmark: pgfId-1197440] (queue depth/total drops/no-buffer drops) 0/0/0 
     
 
      
      [bookmark: pgfId-1197441] (pkts output/bytes output) 0/0 
     
 
      
      [bookmark: pgfId-1197442]  
     
 
      
      [bookmark: pgfId-1197443] shape (average) cir 2000000, bc 16000, be 16000 
     
 
      
      [bookmark: pgfId-1197444]  
     
 
      
      [bookmark: pgfId-1197445] Service-policy: voip 
     
 
      
      [bookmark: pgfId-1197446] Class-map: voip 
     
 
      
      [bookmark: pgfId-1197447]  
     
 
      
      [bookmark: pgfId-1197448] Queueing 
     
 
      
      [bookmark: pgfId-1197449] queue limit 64 packets 
     
 
      
      [bookmark: pgfId-1197450] (queue depth/total drops/no-buffer drops) 0/0/0 
     
 
      
      [bookmark: pgfId-1197451] (pkts output/bytes output) 0/0 
     
 
      
      [bookmark: pgfId-1197452] Class-map: class-default 
     
 
      
      [bookmark: pgfId-1197453]  
     
 
      
      [bookmark: pgfId-1197454] queue limit 64 packets 
     
 
      
      [bookmark: pgfId-1197455] (queue depth/total drops/no-buffer drops) 0/0/0 
     
 
      
      [bookmark: pgfId-1197456] (pkts output/bytes output) 0/0 
     
 
      
      [bookmark: pgfId-1197457]  
     
 
    
 
     
      [bookmark: pgfId-1197459][bookmark: 42909]Viewing QoS Standard Priority Queue Statistics

 
     [bookmark: pgfId-1197460]To display the priority-queue statistics for an interface, use the show priority-queue statistics command in privileged EXEC mode. The results show the statistics for both the best-effort (BE) queue and the low-latency queue (LLQ). The following example shows the use of the show priority-queue statistics command for the interface named test, and the command output.

 
      
      [bookmark: pgfId-1197464]ciscoasa# show priority-queue statistics test 
     
 
      
      [bookmark: pgfId-1197465]  
     
 
      
      [bookmark: pgfId-1197466]Priority-Queue Statistics interface test 
     
 
      
      [bookmark: pgfId-1197467]  
     
 
      
      [bookmark: pgfId-1197468]Queue Type = BE 
     
 
      
      [bookmark: pgfId-1197469]Packets Dropped = 0 
     
 
      
      [bookmark: pgfId-1197470]Packets Transmit = 0 
     
 
      
      [bookmark: pgfId-1197471]Packets Enqueued = 0 
     
 
      
      [bookmark: pgfId-1197472]Current Q Length = 0 
     
 
      
      [bookmark: pgfId-1197473]Max Q Length = 0 
     
 
      
      [bookmark: pgfId-1197474]  
     
 
      
      [bookmark: pgfId-1197475]Queue Type = LLQ 
     
 
      
      [bookmark: pgfId-1197476]Packets Dropped = 0 
     
 
      
      [bookmark: pgfId-1197477]Packets Transmit = 0 
     
 
      
      [bookmark: pgfId-1197478]Packets Enqueued = 0 
     
 
      
      [bookmark: pgfId-1197479]Current Q Length = 0 
     
 
      
      [bookmark: pgfId-1197480]Max Q Length = 0 
     
 
      
      [bookmark: pgfId-1197484]ciscoasa# 
     
 
      
      [bookmark: pgfId-1197485]  
     
 
     [bookmark: pgfId-1197486]In this statistical report, the meaning of the line items is as follows:

 
      
      		 [bookmark: pgfId-1197487]“Packets Dropped” denotes the overall number of packets that have been dropped in this queue. 

 
      		 [bookmark: pgfId-1197488]“Packets Transmit” denotes the overall number of packets that have been transmitted in this queue.

 
      		 [bookmark: pgfId-1197489]“Packets Enqueued” denotes the overall number of packets that have been queued in this queue.

 
      		 [bookmark: pgfId-1197490]“Current Q Length” denotes the current depth of this queue.

 
      		 [bookmark: pgfId-1197491]“Max Q Length” denotes the maximum depth that ever occurred in this queue.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1155026][bookmark: 92503]Feature History for QoS

 
    [bookmark: pgfId-1155030]Table 23-3 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1155078] 

 
     
      
       
       [bookmark: pgfId-1155037]Table 23-3 [bookmark: 50557]Feature History for QoS 

 
       
       
        
        		 
          
          [bookmark: pgfId-1155043]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1155045]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1155047]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1155050]Priority queuing and policing

  
        		[bookmark: pgfId-1155052]7.0(1)

  
        		[bookmark: pgfId-1155054]We introduced QoS priority queuing and policing.

 [bookmark: pgfId-1283341]We introduced the following screens:

 [bookmark: pgfId-1155773]Configuration > Device Management > Advanced > Priority Queue
Configuration > Firewall > Service Policy Rules

  
       

 
        
        		[bookmark: pgfId-1155804]Shaping and hierarchical priority queuing

  
        		[bookmark: pgfId-1155806]7.2(4)/8.0(4)

  
        		[bookmark: pgfId-1155808]We introduced QoS shaping and hierarchical priority queuing.

 [bookmark: pgfId-1155810]We modified the following screen: Configuration > Firewall > Service Policy Rules.

  
       

 
        
        		[bookmark: pgfId-1197750]Ten Gigabit Ethernet support for a standard priority queue on the ASA 5585-X

  
        		[bookmark: pgfId-1197752]8.2(3)/8.4(1)

  
        		[bookmark: pgfId-1197754]We added support for a standard priority queue on Ten Gigabit Ethernet interfaces for the ASA 5585-X.
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     [bookmark: pgfId-1336775][bookmark: 62651]Configuring the ASA IPS Module 
      
      
 
     
 

 
    [bookmark: pgfId-1141051]This chapter describes how to configure the ASA IPS module. The ASA IPS module might be a hardware module or a software module, depending on your ASA model. For a list of supported ASA IPS modules per ASA model, see the Cisco ASA Compatibility Matrix:

 
    [bookmark: pgfId-1141057]http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

 
    [bookmark: pgfId-1060052]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1059391]Information About the ASA IPS Module

 
     		 [bookmark: pgfId-1104619]Licensing Requirements for the ASA IPS module

 
     		 [bookmark: pgfId-1104627]Guidelines and Limitations

 
     		 [bookmark: pgfId-1177305]Default Settings

 
     		 [bookmark: pgfId-1104606]Configuring the ASA IPS module

 
     		 [bookmark: pgfId-1251864]Managing the ASA IPS module

 
     		 [bookmark: pgfId-1295943]Monitoring the ASA IPS module

 
     		 [bookmark: pgfId-1167911]Feature History for the ASA IPS module

 
    

 
   
 
    
     [bookmark: pgfId-1067381]Information About the [bookmark: 42923]ASA IPS Module[bookmark: marker-1067400][bookmark: marker-1110641]

 
    [bookmark: pgfId-1067385]The ASA IPS module runs advanced IPS software that provides proactive, full-featured intrusion prevention services to stop malicious traffic, including worms and network viruses, before they can affect your network. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1087301]How the ASA IPS Module Works with the ASA

 
     		 [bookmark: pgfId-1088263]Operating Modes

 
     		 [bookmark: pgfId-1088324]Using Virtual Sensors (ASA 5510 and Higher)

 
     		 [bookmark: pgfId-1174966]Information About Management Access

 
    

 
     
      [bookmark: pgfId-1087140][bookmark: 73577]How the ASA IPS Module Works wit[bookmark: marker-1110642]h the ASA

 
     [bookmark: pgfId-1087077]The ASA IPS module runs a separate application from the ASA. The ASA IPS module might include an external management interface so you can connect to the ASA IPS module directly; if it does not have a management interface, you can connect to the ASA IPS module through the ASA interface. The ASA IPS SSP on the ASA 5585-X includes data interfaces; these interfaces provide additional port-density for the ASA. However, the overall through-put of the ASA is not increased.

 
     [bookmark: pgfId-1124444]Traffic goes through the firewall checks before being forwarded to the ASA IPS module. When you identify traffic for IPS inspection on the ASA, traffic flows through the ASA and the ASA IPS module as follows. Note: This example is for “inline mode.” See the “Operating Modes” section for information about “promiscuous mode,” where the ASA only sends a copy of the traffic to the ASA IPS module.

 
     [bookmark: pgfId-1090588] 1. Traffic enters the ASA.

 
     [bookmark: pgfId-1147745] 2. Incoming VPN traffic is decrypted.

 
     [bookmark: pgfId-1147752] 3. Firewall policies are applied.

 
     [bookmark: pgfId-1147759] 4. Traffic is sent to the ASA IPS module.

 
     [bookmark: pgfId-1090664] 5. The ASA IPS module applies its security policy to the traffic, and takes appropriate actions.

 
     [bookmark: pgfId-1147820] 6. Valid traffic is sent back to the ASA; the ASA IPS module might block some traffic according to its security policy, and that traffic is not passed on.

 
     [bookmark: pgfId-1147821] 7. Outgoing VPN traffic is encrypted.

 
     [bookmark: pgfId-1147969] 8. Traffic exits the ASA.

 
     [bookmark: pgfId-1091068]Figure 31-1 shows the traffic flow when running the ASA IPS module in inline mode. In this example, the ASA IPS module automatically blocks traffic that it identified as an attack. All other traffic is forwarded through the ASA.

 
     [bookmark: pgfId-1090830]Figure 31-1 [bookmark: 12935]ASA IPS module Traffic Flow in the ASA: Inline Mode

 
     [bookmark: pgfId-1090831] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1087111][bookmark: 31061]Operating M[bookmark: marker-1110643]odes

 
     [bookmark: pgfId-1091104]You can send traffic to the ASA IPS module using one of the following modes:

 
      
      		 [bookmark: pgfId-1091111]Inline mode—This mode places the ASA IPS module directly in the traffic flow (see Figure 31-1). No traffic that you identified for IPS inspection can continue through the ASA without first passing through, and being inspected by, the ASA IPS module. This mode is the most secure because every packet that you identify for inspection is analyzed before being allowed through. Also, the ASA IPS module can implement a blocking policy on a packet-by-packet basis. This mode, however, can affect throughput.

 
      		 [bookmark: pgfId-1059758]Promiscuous mode—This mode sends a duplicate stream of traffic to the ASA IPS module. This mode is less secure, but has little impact on traffic throughput. Unlike inline mode, in promiscuous mode the ASA IPS module can only block traffic by instructing the ASA to shun the traffic or by resetting a connection on the ASA. Also, while the ASA IPS module is analyzing the traffic, a small amount of traffic might pass through the ASA before the ASA IPS module can shun it. Figure 31-2 shows the ASA IPS module in promiscuous mode. In this example, the ASA IPS module sends a shun message to the ASA for traffic it identified as a threat.

 
     

 
     [bookmark: pgfId-1091154]Figure 31-2 [bookmark: 35587]ASA IPS module Traffic Flow in the ASA: Promiscuous Mode

 
     [bookmark: pgfId-1091158] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1088096][bookmark: 54509]Using Virtual Sensors (ASA 5510 and Higher)

 
     [bookmark: pgfId-1088131]The ASA IPS module running IPS software Version 6.0 and later can run multiple virtual sensors, which means you can configure multiple security policies on the ASA IPS module. You can assign each ASA security context or single mode ASA to one or more virtual sensors, or you can assign multiple security contexts to the same virtual sensor. See the IPS documentation for more information about virtual sensors, including the maximum number of sensors supported.

 
     [bookmark: pgfId-1091914]Figure 31-3 shows one security context paired with one virtual sensor (in inline mode), while two security contexts share the same virtual sensor.

 
     [bookmark: pgfId-1091748]Figure 31-3 [bookmark: 55144]Security Contexts and Virtual Sensors

 
     [bookmark: pgfId-1091752] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1092842]Figure 31-4 shows a single mode ASA paired with multiple virtual sensors (in inline mode); each defined traffic flow goes to a different sensor.

 
     [bookmark: pgfId-1092779]Figure 31-4 [bookmark: 39892]Single Mode ASA with Multiple Virtual Sensors

 
     [bookmark: pgfId-1092783] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1174444][bookmark: 59068]Information About Management A[bookmark: marker-1174443]ccess

 
     [bookmark: pgfId-1174445]You can manage the IPS application using the following methods:

 
      
      		 [bookmark: pgfId-1174467][bookmark: 69072]Sessioning to the module from the ASA—If you have CLI access to the ASA, then you can session to the module and access the module CLI. See the “Sessioning to the Module from the ASA (May Be Required)” section.

 
      		 [bookmark: pgfId-1185083][bookmark: 24712]Connecting to the IPS management interface using ASDM or SSH—After you launch ASDM from the ASA, your management station connects to the module management interface to configure the IPS application. For SSH, you can access the module CLI directly on the module management interface. (Telnet access requires additional configuration in the module application). The module management interface can also be used for sending syslog messages or allowing updates for the module application, such as signature database updates.

 
     

 
     [bookmark: pgfId-1177228]See the following information about the management interface:

 
     [bookmark: pgfId-1175427] – ASA 5510, ASA 5520, ASA 5540, ASA 5580, ASA 5585-X—The IPS management interface is a separate external Gigabit Ethernet interface.

 
     [bookmark: pgfId-1233737] – ASA 5512-X, ASA 5515-X, ASA 5525-X, ASA 5545-X, ASA 5555-X—These models run the ASA IPS module as a software module. The IPS management interface shares the Management 0/0 interface with the ASA. Separate MAC addresses and IP addresses are supported for the ASA and ASA IPS module. You must perform configuration of the IPS IP address within the IPS operating system (using the CLI or ASDM). However, physical characteristics (such as enabling the interface) are configured on the ASA. You can remove the ASA interface configuration (specifically the interface name) to dedicate this interface as an IPS-only interface. This interface is management-only.

 
     [bookmark: pgfId-1175428] – ASA 5505—You can use an ASA VLAN to allow access to an internal management IP address over the backplane.

 
    
 
   
 
    
     [bookmark: pgfId-1104578][bookmark: 53684][bookmark: 87160]Licensing Requirements for the ASA IPS module

 
    [bookmark: pgfId-1192086]The following table shows the licensing requirements for this feature:

 
    [bookmark: pgfId-1384014] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1383993]Model 
         
  
        		 
          
          [bookmark: pgfId-1383995]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1383997]ASA 5512-X, ASA 5515-X, ASA 5525-X, ASA 5545-X, ASA 5555-X

  
        		[bookmark: pgfId-1383999]IPS Module License.

 [bookmark: pgfId-1384003]Note The IPS module license lets you run the IPS software module on the ASA. You must also purchase a separate IPS signature subscription; for failover, purchase a subscription for each unit. To obtain IPS signature support, you must purchase the ASA with IPS pre-installed (the part number must include “IPS”). The combined failover cluster license does not let you pair non-IPS and IPS units. For example, if you buy the IPS version of the ASA 5515-X (part number ASA5515-IPS-K9) and try to make a failover pair with a non-IPS version (part number ASA5515-K9), then you will not be able to obtain IPS signature updates for the ASA5515-K9 unit, even though it has an IPS module license inherited from the other unit.

  
       

 
        
        		[bookmark: pgfId-1384011]All other models

  
        		[bookmark: pgfId-1384013]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1259904][bookmark: 58316]Guidelines and Limitations

 
    [bookmark: pgfId-1104733]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1104737][bookmark: 87419]Context Mode Guidelines

 
    [bookmark: pgfId-1104739]The ASA 5505 does not support multiple context mode, so multiple context features, such as virtual sensors, are not supported on the AIP SSC.

 
    [bookmark: pgfId-1104741][bookmark: 16807]Firewall Mode Guidelines

 
    [bookmark: pgfId-1106524]Supported in routed and transparent firewall mode.

 
    [bookmark: pgfId-1106529][bookmark: 34265]Model Guidelines

 
     
     		 [bookmark: pgfId-1104751]See the  Cisco ASA Compatibility Matrix  for information about which models support which modules:

 
    

 
    [bookmark: pgfId-1162467]http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

 
     
     		 [bookmark: pgfId-1111975]The ASA 5505 does not support multiple context mode, so multiple context features, such as virtual sensors, are not supported on the AIP SSC.

 
     		 [bookmark: pgfId-1185027][bookmark: 93505]The ASA IPS module for the ASA 5510 and higher supports higher performance requirements, while the ASA IPS module for the ASA 5505 is designed for a small office installation. The following features are not supported for the ASA 5505:

 
    

 
    [bookmark: pgfId-1185028] – Virtual sensors

 
    [bookmark: pgfId-1185029] – Anomaly detection

 
    [bookmark: pgfId-1214657] – Unretirement of default retired signatures

 
    [bookmark: pgfId-1214662]Additional Guidelines

 
     
     		 [bookmark: pgfId-1172688]The total throughput for the ASA plus the IPS module is lower than ASA throughput alone.

 
    

 
    [bookmark: pgfId-1301429] – ASA 5512-X through ASA 5555-X—See http://www.cisco.com/en/US/prod/collateral/vpndevc/ps6032/ps6094/ps6120/qa_c67-700608.html

 
    [bookmark: pgfId-1301556] – ASA 5585-X—See http://www.cisco.com/en/US/prod/collateral/vpndevc/ps6032/ps6094/ps6120/qa_c67-617018.html

 
    [bookmark: pgfId-1301621] – ASA 5505 through ASA 5540—See http://www.cisco.com/en/US/prod/collateral/vpndevc/ps6032/ps6094/ps6120/product_data_sheet0900aecd802930c5.html

 
     
     		 [bookmark: pgfId-1301298]You cannot change the software type installed on the module; if you purchase an ASA IPS module, you cannot later install other software on it.

 
    

 
   
 
    
     [bookmark: pgfId-1172934][bookmark: 54487]Default Set[bookmark: marker-1172933]tings

 
    [bookmark: pgfId-1172938]Table 31-1 lists the default settings for the ASA IPS module.

 
    [bookmark: pgfId-1172968] 

 
     
      
       
       [bookmark: pgfId-1172945]Table 31-1 [bookmark: 51687]Default Network Parameters 

 
       
       
        
        		 
          
          [bookmark: pgfId-1172949]Parameters 
         
  
        		 
          
          [bookmark: pgfId-1172951]Default 
         
  
       

 
        
        		[bookmark: pgfId-1172953]Management VLAN (ASA 5505 only)

  
        		[bookmark: pgfId-1172955]VLAN 1

  
       

 
        
        		[bookmark: pgfId-1172957]Management IP address

  
        		[bookmark: pgfId-1172959]192.168.1.2/24

  
       

 
        
        		[bookmark: pgfId-1172965]Gateway

  
        		[bookmark: pgfId-1172967]192.168.1.1/24 (the default ASA management IP address)

  
       

 
        
        		[bookmark: pgfId-1183535]Username

  
        		[bookmark: pgfId-1183537]cisco

  
       

 
        
        		[bookmark: pgfId-1183531]Password

  
        		[bookmark: pgfId-1183533]cisco

  
       

 
       
     

 
    
 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1172972]Note The default management IP address on the ASA is 192.168.1.1/24.

 
     
     
 
    
 
    

 
   
 
    
     [bookmark: pgfId-1111978][bookmark: 97360][bookmark: 61249]Configuring the ASA IPS module

 
    [bookmark: pgfId-1111979]This section describes how to configure the ASA IPS module and includes the following topics:

 
     
     		 [bookmark: pgfId-1106217]Task Flow for the ASA IPS Module

 
     		 [bookmark: pgfId-1106224]Connecting the ASA IPS Management Interface

 
     		 [bookmark: pgfId-1322673]Sessioning to the Module from the ASA (May Be Required)

 
     		 [bookmark: pgfId-1259514]Configuring Basic IPS Module Network Settings

 
     		 [bookmark: pgfId-1264757](ASA 5512-X through ASA 5555-X) Booting the Software Module

 
     		 [bookmark: pgfId-1177412]Configuring the Security Policy on the ASA IPS Module

 
     		 [bookmark: pgfId-1106253]Assigning Virtual Sensors to a Security Context (ASA 5510 and Higher)

 
     		 [bookmark: pgfId-1106277]Diverting Traffic to the ASA IPS module

 
    

 
     
      [bookmark: pgfId-1097278][bookmark: 43748][bookmark: marker-1097274][bookmark: marker-1097277]Task Flow for the ASA IPS Module

 
     [bookmark: pgfId-1107334]Configuring the ASA IPS module is a process that includes configuration of the IPS security policy on the ASA IPS module and then configuration of the ASA to send traffic to the ASA IPS module. To configure the ASA IPS module, perform the following steps:

 
     
 
     [bookmark: pgfId-1178227]Step 1 Cable the ASA IPS management interface. See the “Connecting the ASA IPS Management Interface” section.

 
     [bookmark: pgfId-1295994]Step 2 Session to the module. Access the IPS CLI over the backplane. For ASDM users, you may need to session to the module to boot the IPS software if it is not running. See the “Sessioning to the Module from the ASA (May Be Required)” section.

 
     [bookmark: pgfId-1296540]Step 3 (ASA 5512-X through ASA 5555-X; may be required) Install the software module. See the “(ASA 5512-X through ASA 5555-X) Booting the Software Module” section.

 
     [bookmark: pgfId-1259707]Step 4 Depending on your ASA model:

 
      
      		 [bookmark: pgfId-1259788](ASA 5510 and higher) Configure basic network settings for the IPS module. See the “(ASA 5510 and Higher) Configuring Basic Network Settings” section.

 
      		 [bookmark: pgfId-1259652](ASA 5505) Configure the management VLAN and IP address for the IPS module. See the “(ASA 5505) Configuring Basic Network Settings” section.

 
     

 
     [bookmark: pgfId-1263754]Step 5 On the module, configure the inspection and protection policy, which determines how to inspect traffic and what to do when an intrusion is detected. See the “Configuring the Security Policy on the ASA IPS Module” section.

 
     [bookmark: pgfId-1105083]Step 6 (ASA 5510 and higher, optional) On the ASA in multiple context mode, specify which IPS virtual sensors are available for each context (if you configured virtual sensors). See the “Assigning Virtual Sensors to a Security Context (ASA 5510 and Higher)” section.

 
     [bookmark: pgfId-1105094]Step 7 On the ASA, identify traffic to divert to the ASA IPS module. See the “Diverting Traffic to the ASA IPS module” section.

 
     [bookmark: pgfId-1105095]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1181923][bookmark: 60816]Connecting the ASA IPS Management Interface

 
     [bookmark: pgfId-1293720]In addition to providing management access to the IPS module, the IPS management interface needs access to an HTTP proxy server or a DNS server and the Internet so it can download global correlation, signature updates, and license requests. This section describes recommended network configurations. Your network may differ.

 
      
      		 [bookmark: pgfId-1293966]ASA 5510, ASA 5520, ASA 5540, ASA 5580, ASA 5585-X (Hardware Module)

 
      		 [bookmark: pgfId-1294248]ASA 5512-X through ASA 5555-X (Software Module)

 
      		 [bookmark: pgfId-1294341]ASA 5505

 
     

 
    
 
     
      [bookmark: pgfId-1293721][bookmark: 71546]ASA 5510, ASA 5520, ASA 5540, ASA 5580, ASA 5585-X (Hardware Module)

 
     [bookmark: pgfId-1293725]The IPS module includes a separate management interface from the ASA.

 
     [bookmark: pgfId-1293729] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1293730]If you have an inside router

 
     [bookmark: pgfId-1293731]If you have an inside router, you can route between the management network, which can include both the ASA Management 0/0 and IPS Management 1/0 interfaces, and the ASA inside network. Be sure to also add a route on the ASA to reach the Management network through the inside router.

 
     [bookmark: pgfId-1293744] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1293746][bookmark: 64939]If you do not have an inside router

 
     [bookmark: pgfId-1293747]If you have only one inside network, then you cannot also have a separate management network, which would require an inside router to route between the networks. In this case, you can manage the ASA from the inside interface instead of the Management 0/0 interface. Because the IPS module is a separate device from the ASA, you can configure the IPS Management 1/0 address to be on the same network as the inside interface.

 
     [bookmark: pgfId-1293757] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1293758][bookmark: 55671]ASA 5512-X through ASA 5555-X (Software Module)

 
     [bookmark: pgfId-1293759]These models run the IPS module as a software module, and the IPS management interface shares the Management 0/0 interface with the ASA. 

 
     [bookmark: pgfId-1293766] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1293767]If you have an inside router

 
     [bookmark: pgfId-1293768]If you have an inside router, you can route between the Management 0/0 network, which includes both the ASA and IPS management IP addresses, and the inside network. Be sure to also add a route on the ASA to reach the Management network through the inside router.

 
     [bookmark: pgfId-1293778] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1293780][bookmark: 73633]If you do not have an inside router

 
     [bookmark: pgfId-1293781]If you have only one inside network, then you cannot also have a separate management network. In this case, you can manage the ASA from the inside interface instead of the Management 0/0 interface. If you remove the ASA-configured name from the Management 0/0 interface, you can still configure the IPS IP address for that interface. Because the IPS module is essentially a separate device from the ASA, you can configure the IPS management address to be on the same network as the inside interface.

 
     [bookmark: pgfId-1293794] 

 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1293798]Note You must remove the ASA-configured name for Management 0/0; if it is configured on the ASA, then the IPS address must be on the same network as the ASA, and that excludes any networks already configured on other ASA interfaces. If the name is not configured, then the IPS address can be on any network, for example, the ASA inside network.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1293811][bookmark: 34994]ASA 5505

 
     [bookmark: pgfId-1293816]The ASA[bookmark: marker-1293812] 5505 does not have a dedicated management interface. You must use an ASA VLAN to access an internal management IP address over the backplane. Connect the management PC to one of the following ports: Ethernet 0/1 through 0/7, which are assigned to VLAN 1.

 
     [bookmark: pgfId-1293820] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1192897]What to Do Next

 
      
      		 [bookmark: pgfId-1259922](ASA 5510 and higher) Configure basic network settings. See the “(ASA 5510 and Higher) Configuring Basic Network Settings” section.

 
      		 [bookmark: pgfId-1183612](ASA 5505) Configure management interface settings. See the “(ASA 5505) Configuring Basic Network Settings” section.

 
     

 
    
 
     
      [bookmark: pgfId-1260695][bookmark: 31988]Sessioning to the Module from the ASA (May Be Required)

 
     [bookmark: pgfId-1260888]To access the IPS module CLI from the ASA, you can session from the ASA. For software modules, you can either session to the module (using Telnet) or create a virtual console session. A console session might be useful if the control plane is down and you cannot establish a Telnet session.

 
     [bookmark: pgfId-1371090]You may need to access the CLI if you are using multiple context mode and you need to set basic network settings using the CLI, or for troubleshooting.

 
    
 
     
      [bookmark: pgfId-1260699]Detailed Steps

 
     [bookmark: pgfId-1260706] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1260714]Command 
          
  
         		 
           
           [bookmark: pgfId-1260716]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1260768]Telnet session.

 [bookmark: pgfId-1260769]For a hardware module (for example, the ASA 5585-X):

 
           
           [bookmark: pgfId-1260770] 
            session 1 
          
 
           
           [bookmark: pgfId-1260771]  
          
 [bookmark: pgfId-1260772]For a software module (for example, the ASA 5545-X):

 
           
           [bookmark: pgfId-1260773] 
            session ips 
          
 
           
           [bookmark: pgfId-1260774]  
          
 
           
           [bookmark: pgfId-1260775]  
          
 [bookmark: pgfId-1260779]ciscoasa# session 1

 [bookmark: pgfId-1260780] 

 [bookmark: pgfId-1260781]Opening command session with slot 1.

 [bookmark: pgfId-1260782]Connected to slot 1. Escape character sequence is 'CTRL-^X'.

 [bookmark: pgfId-1260783] 

 [bookmark: pgfId-1260784]sensor login: cisco

 [bookmark: pgfId-1260785]Password: cisco

  
         		[bookmark: pgfId-1260787]Accesses the module using Telnet. You are prompted for the username and password. The default username is cisco, and the default password is cisco.

 [bookmark: pgfId-1260788]Note The first time you log in to the module, you are prompted to change the default password. Passwords must be at least eight characters long and cannot be a word in the dictionary.

  
        

 
         
         		[bookmark: pgfId-1260751]Console session (software module only).

 
           
           [bookmark: pgfId-1260752] 
            session ips console 
          
 
           
           [bookmark: pgfId-1260753]  
          
 [bookmark: pgfId-1260757]ciscoasa# session ips console

 [bookmark: pgfId-1260758] 

 [bookmark: pgfId-1260759]Establishing console session with slot 1

 [bookmark: pgfId-1260760]Opening console session with module ips.

 [bookmark: pgfId-1260761]Connected to module ips. Escape character sequence is 'CTRL-SHIFT-6 then x'.

 [bookmark: pgfId-1260762] 

 [bookmark: pgfId-1260763]sensor login: cisco

 [bookmark: pgfId-1260764]Password: cisco

  
         		[bookmark: pgfId-1260766]Accesses the module console. You are prompted for the username and password. The default username is cisco, and the default password is cisco.

 command instead.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1296287][bookmark: 29979](ASA 5512-X through ASA 5555-X) Booting the Software Module

 
     [bookmark: pgfId-1296291]Your ASA typically ships with IPS module software present on Disk0. If the module is not running, or if you are adding the IPS module to an existing ASA, you must boot the module software. If you are unsure if the module is running, you will not see the IPS Basic Configuration screen when you run the Startup Wizard (see the “Configuring Basic IPS Module Network Settings” section).

 
    
 
     
      [bookmark: pgfId-1296295]Detailed Steps

 
     
 
     [bookmark: pgfId-1296296]Step 1 Do one of the following:

 
      
       
       		 [bookmark: pgfId-1296300]New ASA with IPS pre-installed—To view the IPS module software filename in flash memory, choose  Tools > File Management .

 
      

 
     

 
     [bookmark: pgfId-1296306]For example, look for a filename like IPS-SSP_5512-K9-sys-1.1-a-7.1-4-E4.aip. Note the filename; you will need this filename later in the procedure.

 
      
       
       		 [bookmark: pgfId-1296310]Existing ASA with new IPS installation—Download the IPS software from Cisco.com to your computer.  If you have a Cisco.com login, you can obtain the software from the following website: 

 
      

 
     

 
     [bookmark: pgfId-1296311]http://www.cisco.com/cisco/software/navigator.html?mdfid=282164240

 
     [bookmark: pgfId-1296322]Choose Tools > File Management, then choose File Transfer > Between Local PC and Flash to upload the new image to disk0. Note the filename; you will need this filename later in the procedure. 

 
     [bookmark: pgfId-1371118]Step 2 Choose Tools > Command Line Interface.

 
     [bookmark: pgfId-1296324]Step 3 To set the IPS module software location in disk0, enter the following command and then click Send:

 
      
      [bookmark: pgfId-1296328]sw-module module ips recover configure image disk0:file_path 
     
 
      
      [bookmark: pgfId-1296329]  
     
 
     [bookmark: pgfId-1296330]For example, using the filename in the example in Step 1, enter:

 
      
      [bookmark: pgfId-1296334]sw-module module ips recover configure image disk0:IPS-SSP_5512-K9-sys-1.1-a-7.1-4-E4.aip 
     
 
      
      [bookmark: pgfId-1296335]  
     
 
     [bookmark: pgfId-1296336]Step 4 To install and load the IPS module software, enter the following command and then click Send:

 
      
      [bookmark: pgfId-1296340]sw-module module ips recover boot 
     
 
      
      [bookmark: pgfId-1296341]  
     
 
     [bookmark: pgfId-1296342]Step 5 To check the progress of the image transfer and module restart process, enter the following command and then click Send:

 
      
      [bookmark: pgfId-1296346]show module ips details 
     
 
      
      [bookmark: pgfId-1296347]  
     
 
     [bookmark: pgfId-1296348]The Status field in the output indicates the operational status of the module. A module operating normally shows a status of “Up.” While the ASA transfers an application image to the module, the Status field in the output reads “Recover.” When the ASA completes the image transfer and restarts the module, the newly transferred image is running.

 
     [bookmark: pgfId-1296355]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1254976][bookmark: 36508]Configuring Basic IPS Module Network Settings

 
      
      		 [bookmark: pgfId-1260388](ASA 5510 and Higher) Configuring Basic Network Settings

 
      		 [bookmark: pgfId-1260407](ASA 5505) Configuring Basic Network Settings

 
     

 
    
 
     
      [bookmark: pgfId-1260379][bookmark: 60650](ASA 5510 and Higher) Configuring Basic Network Settings[bookmark: marker-1260471]

 
     [bookmark: pgfId-1371138]In single context mode, you can use the Startup Wizard in ASDM to configure basic IPS network configuration. These settings are saved to the IPS configuration, not the ASA configuration.

 
     [bookmark: pgfId-1257533]In multiple context mode, session to the module from the ASA and configure basic settings using the setup command.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1264538]Note (ASA 5512-X through ASA 5555-X) If you do not see the IPS Basic Configuration screen in your wizard, then the IPS module is not running. See the “(ASA 5512-X through ASA 5555-X) Booting the Software Module” section, and then repeat this procedure after you install the module.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1371152]Detailed Steps—Single Mode

 
     
 
     [bookmark: pgfId-1371153]Step 1 Choose Wizards > Startup Wizard.

 
     [bookmark: pgfId-1371154]Step 2 Click Next to advance through the initial screens until you reach the IPS Basic Configuration screen.

 
     [bookmark: pgfId-1371155]Step 3 In the Network Settings area, configure the following:

 
      
       
       		 [bookmark: pgfId-1371156]IP Address—The management IP address. By default, the address is 192.168.1.2.

 
       		 [bookmark: pgfId-1371157]Subnet Mask—The subnet mask for the management IP address.

 
       		 [bookmark: pgfId-1371158]Gateway—The IP address of the upstream router. The IP address of the next hop router. See the “Connecting the ASA IPS Management Interface” section to understand the requirements for your network. The default setting of the ASA management IP address will not work.

 
       		 [bookmark: pgfId-1371165]HTTP Proxy Server—(Optional) The HTTP proxy server address. You can use a proxy server to download global correlation updates and other information instead of downloading over the Internet. 

 
       		 [bookmark: pgfId-1371166]HTTP Proxy Port—(Optional) The HTTP proxy server port.

 
       		 [bookmark: pgfId-1371167]DNS Primary—(Optional) The primary DNS server address. If you are using a DNS server, you must configure at least one DNS server and it must be reachable for global correlation updates to be successful.

 
      

 
     

 
     [bookmark: pgfId-1371168]For global correlation to function, you must have either a DNS server or an HTTP proxy server configured at all times. DNS resolution is supported only for accessing the global correlation update server.

 
     [bookmark: pgfId-1371169]Step 4 In the Management Access List area, enter an IP address and subnet mask for any hosts that are allowed to access the IPS management interface, and click Add. You can add multiple IP addresses.

 
     [bookmark: pgfId-1371170]Step 5 In the Cisco Account Password area, set the password for the username cisco and confirm it. The username cisco and this password are used for Telnet sessions from hosts specified by the management ACL and when accessing the IPS module from ASDM (Configuration > IPS). By default, the password is cisco.

 
     [bookmark: pgfId-1371171]Step 6 In the Network Participation area, which you use to have the IPS module participate in SensorBase data sharing, click Full, Partial, or Off. 

 
     [bookmark: pgfId-1371172]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1259385]Detailed Steps—Multiple Mode Using the CLI

 
     [bookmark: pgfId-1259054] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1258992]  
          
  
         		 
           
           [bookmark: pgfId-1258994]Command 
          
  
         		 
           
           [bookmark: pgfId-1258996]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1258998]Step 1

  
         		[bookmark: pgfId-1259000]Session to the IPS module according to the “Sessioning to the Module from the ASA (May Be Required)” section.

  
         		[bookmark: pgfId-1259002] 

  
        

 
         
         		[bookmark: pgfId-1259047]Step 2

  
         		 
           
           [bookmark: pgfId-1259049] 
            setup 
          
 
           
           [bookmark: pgfId-1259050]  
          
 [bookmark: pgfId-1259051]sensor# setup

  
         		[bookmark: pgfId-1294501]Runs the setup utility for initial configuration of the ASA IPS module. You are prompted for basic settings. For the default gateway, specify the IP address of the upstream router. See the “Connecting the ASA IPS Management Interface” section to understand the requirements for your network. The default setting of the ASA management IP address will not work.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1169743](ASA 5505) [bookmark: 48289]Configuring Basic Network Settings[bookmark: marker-1169741]

 
     [bookmark: pgfId-1169744]An ASA IPS module on the ASA 5505 does not have any external interfaces. You can configure a VLAN to allow access to an internal IPS management IP address over the backplane. By default, VLAN 1 is enabled for IPS management. You can only assign one VLAN as the management VLAN. This section describes how to change the management VLAN and IP address if you do not want to use the default, and how to set other required network parameters.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1182782]Note Perform this configuration on the ASA 5505, not on the ASA IPS module.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1169748]Prerequisites

 
     [bookmark: pgfId-1185328]When you change the IPS VLAN and management address from the default, be sure to also configure the matching ASA VLAN and switch port(s) according to the procedures listed in “Starting Interface Configuration (ASA 5505),” in the general operations configuration guide. You must define and configure the VLAN for the ASA so the IPS management interface is accessible on the network.

 
    
 
     
      [bookmark: pgfId-1178434]Restrictions

 
     [bookmark: pgfId-1169754]Do not configure NAT for the management address if you intend to access it using ASDM. For initial setup with ASDM, you need to access the real address. After initial setup (where you set the password on the ASA IPS module), you can configure NAT and supply ASDM with the translated address for accessing the ASA IPS module.

 
    
 
     
      [bookmark: pgfId-1169755]Detailed Steps

 
     
 
     [bookmark: pgfId-1371182]Step 1 In ASDM, choose Configuration > Device Setup > SSC Setup.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1371183]Note The following settings are written to the ASA IPS module application configuration, not the ASA configuration.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1371187]Step 2 In the Management Interface area, set the following:

 
     [bookmark: pgfId-1371188] a. Choose the Interface VLAN from the drop-down list.

 
     [bookmark: pgfId-1371189]This setting allows you to manage the ASA IPS module using this VLAN.

 
     [bookmark: pgfId-1371190] b. Enter the IPS management IP address. Make sure this address is on the same subnet as the ASA VLAN IP address. For example, if you assigned 10.1.1.1 to the VLAN for the ASA, then assign another address on that network, such as 10.1.1.2, for the IPS management address. By default, the address is 192.168.1.2

 
     [bookmark: pgfId-1371191] c. Choose the subnet mask from the drop-down list.

 
     [bookmark: pgfId-1371192] d. Enter the default gateway IP address.

 
     [bookmark: pgfId-1371193]Set the gateway to be the ASA IP address for the management VLAN. By default, this IP address is 192.168.1.1.

 
     [bookmark: pgfId-1371194]Step 3 In the Management Access List area, enter the following:

 
     [bookmark: pgfId-1371195] a. Enter the IP address for the management host network.

 
     [bookmark: pgfId-1371196] b. Choose the subnet mask from the drop-down list.

 
     [bookmark: pgfId-1371197] c. Click Add to add these settings to the Allowed Hosts/Networks list. 

 
     [bookmark: pgfId-1371199]Step 4 [bookmark: SN_StepNext. Step. 4 In the IPS Password area]In the IPS Password area, do the following:

 
     [bookmark: pgfId-1371200] a. Enter the current password. The default password is cisco.

 
     [bookmark: pgfId-1371201] b. Enter the new password, and confirm the change. 

 
     [bookmark: pgfId-1371202]Step 5 Click Apply to save the settings to the running configuration. 

 
     [bookmark: pgfId-1371203]Step 6 To launch the IPS Startup Wizard, click the Configure the IPS SSC module link. 

 
     [bookmark: pgfId-1371204]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1092401][bookmark: 85498][bookmark: 95720][bookmark: 28907]Configuring the Security Policy on the ASA IPS Module

 
     [bookmark: pgfId-1092520]This section describes how to configure the ASA IPS module application.

 
    
 
     
      [bookmark: pgfId-1109444]Detailed Steps

 
     
 
     [bookmark: pgfId-1371214]Step 1 Connect to ASDM using the ASA management IP address. See the “Starting ASDM” section in the general operations configuration guide.

 
     [bookmark: pgfId-1371222]Step 2 To access the IPS Device Manager (IDM) from ASDM, click Configuration > IPS.

 
     [bookmark: pgfId-1371226] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1371229]Step 3 Enter the IP address, username and password that you set in the “Configuring Basic IPS Module Network Settings” section, as well as the port. The default IP address and port is 192.168.1.2:443. The default username and password is cisco and cisco.

 
     [bookmark: pgfId-1371236]If the password to access IDM is lost, you can reset the password using ASDM. See the “Resetting the Password” section, for more information.

 
     [bookmark: pgfId-1371238]Step 4 To save the login information on your local PC, check the Save IPS login information on local host check box. 

 
     [bookmark: pgfId-1371239]Step 5 Click Continue.

 
     [bookmark: pgfId-1371240]The Startup Wizard pane appears.

 
     [bookmark: pgfId-1371244] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1371245]Step 6 Click Launch Startup Wizard. Complete the screens as prompted. For more information, see the IDM online help.

 
     [bookmark: pgfId-1371249] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1371250](ASA 5510 and higher) If you configure virtual sensors, you identify one of the sensors as the default. If the ASA series does not specify a virtual sensor name in its configuration, the default sensor is used.

 
     [bookmark: pgfId-1371251]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1109433]What to Do Next

 
      
      		 [bookmark: pgfId-1113667]For the ASA in multiple context mode, see the “Assigning Virtual Sensors to a Security Context (ASA 5510 and Higher)” section.

 
      		 [bookmark: pgfId-1109522]For the ASA in single context mode, see the “Diverting Traffic to the ASA IPS module” section.

 
     

 
    
 
     
      [bookmark: pgfId-1091984][bookmark: 30698]Assigning Virtual Sensors to a Security Con[bookmark: marker-1110645]text (ASA 5510 and Higher)

 
     [bookmark: pgfId-1092007]If the ASA is in multiple context mode, then you can assign one or more IPS virtual sensors to each context. Then, when you configure the context to send traffic to the ASA IPS module, you can specify a sensor that is assigned to the context; you cannot specify a sensor that you did not assign to the context. If you do not assign any sensors to a context, then the default sensor configured on the ASA IPS module is used. You can assign the same sensor to multiple contexts.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1093186]Note You do not need to be in multiple context mode to use virtual sensors; you can be in single mode and use different sensors for different traffic flows.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1093233]Prerequisites

 
     [bookmark: pgfId-1108238]For more information about configuring contexts, see the “Configuring Multiple Contexts” section in the general operations configuration guide.

 
    
 
     
      [bookmark: pgfId-1108201]Detailed Steps

 
     [bookmark: pgfId-1108565] 

 
     
 
     [bookmark: pgfId-1371257]Step 1 [bookmark: 39028]In the ASDM Device List pane, double-click System under the active device IP address.

 
     [bookmark: pgfId-1371258]Step 2 On the Context Management > Security Contexts pane, choose a context that you want to configure, and click Edit.

 
     [bookmark: pgfId-1371259]The Edit Context dialog box appears. For more information about configuring contexts, see the “Configuring Multiple Contexts” section in the general operations configuration guide.

 
     [bookmark: pgfId-1371267]Step 3 [bookmark: 11584]In the IPS Sensor Allocation area, click Add.

 
     [bookmark: pgfId-1371268]The IPS Sensor Selection dialog box appears.

 
     [bookmark: pgfId-1371269]Step 4 From the Sensor Name drop-down list, choose a sensor name from those configured on the ASA IPS module.

 
     [bookmark: pgfId-1371270]Step 5 (Optional) To assign a mapped name to the sensor, enter a value in the Mapped Sensor Name field.

 
     [bookmark: pgfId-1371271]This sensor name can be used within the context instead of the actual sensor name. If you do not specify a mapped name, the sensor name is used within the context. For security purposes, you might not want the context administrator to know which sensors are being used by the context. Or you might want to genericize the context configuration. For example, if you want all contexts to use sensors called “sensor1” and “sensor2,” then you can map the “highsec” and “lowsec” sensors to sensor1 and sensor2 in context A, but map the “medsec” and “lowsec” sensors to sensor1 and sensor2 in context B.

 
     [bookmark: pgfId-1371272]Step 6 Click OK to return to the Edit Context dialog box.

 
     [bookmark: pgfId-1371273]Step 7 (Optional) To set one sensor as the default sensor for this context, from the Default Sensor drop-down list, choose a sensor name.

 
     [bookmark: pgfId-1371274]If you do not specify a sensor name when you configure IPS within the context configuration, the context uses this default sensor. You can only configure one default sensor per context. If you do not specify a sensor as the default, and the context configuration does not include a sensor name, then traffic uses the default sensor on the ASA IPS module.

 
     [bookmark: pgfId-1371275]Step 8 Repeat this procedure for each security context.

 
     [bookmark: pgfId-1371276]Step 9 Change to each context to configure the IPS security policy as described in “Diverting Traffic to the ASA IPS module” section.

 
     [bookmark: pgfId-1371280]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1108290]What to Do Next

 
     [bookmark: pgfId-1124507]Change to each context to configure the IPS security policy as described in “Diverting Traffic to the ASA IPS module” section.

 
    
 
     
      [bookmark: pgfId-1124512][bookmark: 44497]Diverting Traffic to the ASA IPS module[bookmark: marker-1124510]

 
     [bookmark: pgfId-1124516]This section identifies traffic to divert from the ASA to the ASA IPS module. 

 
    
 
     
      [bookmark: pgfId-1109757]Prerequisites

 
     [bookmark: pgfId-1109758]In multiple context mode, perform these steps in each context execution space. To change to a context, in the Configuration > Device List pane, double-click the context name under the active device IP address.

 
    
 
     
      [bookmark: pgfId-1109086]Detailed Steps

 
     [bookmark: pgfId-1109173] 

 
     
 
     [bookmark: pgfId-1371291]Step 1 C[bookmark: 56720]hoose Configuration > Firewall > Service Policy Rules.

 
     [bookmark: pgfId-1371295] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1371296]Step 2 Choose Add > Add Service Policy Rule. The Add Service Policy Rule Wizard - Service Policy dialog box appears.

 
     [bookmark: pgfId-1371297]Step 3 Complete the Service Policy dialog box as desired. See the ASDM online help for more information about these screens.

 
     [bookmark: pgfId-1371298]Step 4 Click Next. The Add Service Policy Rule Wizard - Traffic Classification Criteria dialog box appears.

 
     [bookmark: pgfId-1371299]Step 5 Complete the Traffic Classification Criteria dialog box as desired. See the ASDM online help for more information about these screens.

 
     [bookmark: pgfId-1371300]Step 6 Click Next to show the Add Service Policy Rule Wizard - Rule Actions dialog box.

 
     [bookmark: pgfId-1371301]Step 7 Click the Intrusion Prevention tab.

 
     [bookmark: pgfId-1371305] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1371306]Step 8 Check the Enable IPS for this traffic flow check box.

 
     [bookmark: pgfId-1371309]Step 9 In the Mode area, click Inline Mode or Promiscuous Mode. See the “Operating Modes” section for more information.

 
     [bookmark: pgfId-1371311]Step 10 In the If IPS Card Fails area, click Permit traffic or Close traffic. The Close traffic option sets the ASA to block all traffic if the ASA IPS module is unavailable. The Permit traffic option sets the ASA to allow all traffic through, uninspected, if the ASA IPS module is unavailable. For information about the IPS Sensor Selection area, see the ASDM online help.

 
     [bookmark: pgfId-1371318]Step 11 (ASA 5510 and higher) From the IPS Sensor to use drop-down list, choose a virtual sensor name.

 
     [bookmark: pgfId-1371319]If you use virtual sensors, you can specify a sensor name using this option. If you use multiple context mode on the ASA, you can only specify sensors that you assigned to the context (see the “Assigning Virtual Sensors to a Security Context (ASA 5510 and Higher)” section). If you do not specify a sensor name, then the traffic uses the default sensor. In multiple context mode, you can specify a default sensor for the context. In single mode or if you do not specify a default sensor in multiple mode, the traffic uses the default sensor that is set on the ASA IPS module.

 
     [bookmark: pgfId-1371326]Step 12 Click OK and then Apply.

 
     [bookmark: pgfId-1371327]Step 13 Repeat this procedure to configure additional traffic flows as desired.

 
     [bookmark: pgfId-1371328]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1295614][bookmark: 84647]Managing the ASA IPS module

 
    [bookmark: pgfId-1295616]This section includes procedures that help you recover or troubleshoot the module and includes the following topics:

 
     
     		 [bookmark: pgfId-1295620]Installing and Booting an Image on the Module

 
     		 [bookmark: pgfId-1295624]Shutting Down the Module

 
     		 [bookmark: pgfId-1295628]Uninstalling a Software Module Image

 
     		 [bookmark: pgfId-1295632]Resetting the Password

 
     		 [bookmark: pgfId-1295636]Reloading or Resetting the Module

 
    

 
     
      [bookmark: pgfId-1295643][bookmark: 73926][bookmark: 34678][bookmark: 37556]Installing and Booting an Image on the Module[bookmark: marker-1295640][bookmark: marker-1295641][bookmark: marker-1295642]

 
     [bookmark: pgfId-1295644]If the module suffers a failure, and the module application image cannot run, you can reinstall a new image on the module from a TFTP server (for a hardware module), or from the local disk (software module).

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1295645]Note Do not use the upgrade command within the module software to install the image.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1295646]Prerequisites

 
      
      		 [bookmark: pgfId-1295647]Hardware module—Be sure the TFTP server that you specify can transfer files up to 60 MB in size.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1295648]Note This process can take approximately 15 minutes to complete, depending on your network and the size of the image.

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-1295649]Software module—Copy the image to the ASA internal flash (disk0) before completing this procedure.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1295650]Note Before you download the IPS software to disk0, make sure at least 50% of the flash memory is free. When you install IPS, IPS reserves 50% of the internal flash memory for its file system.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1295651]Detailed Steps

 
     [bookmark: pgfId-1295720] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1295654]  
          
  
         		 
           
           [bookmark: pgfId-1295656]Command 
          
  
         		 
           
           [bookmark: pgfId-1295658]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1295660]Step 1

  
         		[bookmark: pgfId-1295662]For a hardware module (for example, the ASA 5585-X):

 
           
           [bookmark: pgfId-1295663] 
            hw-module module  
            1  
            recover configure 
          
 
           
           [bookmark: pgfId-1295664]  
          
 [bookmark: pgfId-1295665]For a software module (for example, the ASA 5545-X):

 [bookmark: pgfId-1295666]sw-module module ips recover configure image disk0:file_path

 
           
           [bookmark: pgfId-1295667]  
          
 [bookmark: pgfId-1295671]ciscoasa# hw-module module 1 recover configure

 [bookmark: pgfId-1295672]Image URL [tftp://127.0.0.1/myimage]: tftp://10.1.1.1/ids-newimg

 [bookmark: pgfId-1295673]Port IP Address [127.0.0.2]: 10.1.2.10

 [bookmark: pgfId-1295674]Port Mask [255.255.255.254]: 255.255.255.0

 [bookmark: pgfId-1295675]Gateway IP Address [1.1.2.10]: 10.1.2.254

 [bookmark: pgfId-1295676]VLAN ID [0]: 100

  
         		[bookmark: pgfId-1295678]Specifies the location of the new image.

 [bookmark: pgfId-1295679]For a hardware module—This command prompts you for the URL for the TFTP server, the management interface IP address and netmask, gateway address, and VLAN ID (ASA 5505 only). These network parameters are configured in ROMMON; the network parameters you configured in the module application configuration are not available to ROMMON, so you must set them separately here.

 [bookmark: pgfId-1295680]For a software module—Specify the location of the image on the local disk.

 [bookmark: pgfId-1295681]You can view the recovery configuration using the show module {1 | ips} recover command.

 [bookmark: pgfId-1295682]In multiple context mode, enter this command in the system execution space.

  
        

 
         
         		[bookmark: pgfId-1295684]Step 2

  
         		[bookmark: pgfId-1295686]For a hardware module:

 
           
           [bookmark: pgfId-1295687] 
            hw-module module  
            1 
            recover boot 
          
 
           
           [bookmark: pgfId-1295688]  
          
 [bookmark: pgfId-1295689]For a software module:

 
           
           [bookmark: pgfId-1295690] 
            sw-module module  
            ips 
            recover boot 
          
 
           
           [bookmark: pgfId-1295691]  
          
 [bookmark: pgfId-1295695]ciscoasa# hw-module module 1 recover boot

  
         		[bookmark: pgfId-1295697]Installs and boots the IPS module software.

  
        

 
         
         		[bookmark: pgfId-1295699]Step 3

  
         		[bookmark: pgfId-1295701]For a hardware module:

 
           
           [bookmark: pgfId-1295702] 
            show module  
            1 
             
            details 
          
 
           
           [bookmark: pgfId-1295703]  
          
 [bookmark: pgfId-1295704]For a software module:

 
           
           [bookmark: pgfId-1295705] 
            show module  
            ips 
             
            details 
          
 
           
           [bookmark: pgfId-1295706]  
          
 [bookmark: pgfId-1295710]ciscoasa# show module 1 details

  
         		[bookmark: pgfId-1295712]Checks the progress of the image transfer and module restart process. 

 [bookmark: pgfId-1295713]The Status field in the output indicates the operational status of the module. A module operating normally shows a status of “Up.” While the ASA transfers an application image to the module, the Status field in the output reads “Recover.” When the ASA completes the image transfer and restarts the module, the newly transferred image is running.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1295723][bookmark: 56378]Shutting Down the Module[bookmark: marker-1295722]

 
     [bookmark: pgfId-1295724]Shutting down the module software prepares the module to be safely powered off without losing configuration data. Note: If you reload the ASA, the module is not automatically shut down, so we recommend shutting down the module before reloading the ASA. To gracefully shut down the module, perform the following steps at the ASA CLI.

 
    
 
     
      [bookmark: pgfId-1295734]Detailed Steps

 
     [bookmark: pgfId-1295754][bookmark: 31943] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1295737]Command 
          
  
         		 
           
           [bookmark: pgfId-1295739]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1295741]For a hardware module (for example, the ASA 5585-X):

 
           
           [bookmark: pgfId-1295742] 
            hw-module module 1 shutdown 
          
 
           
           [bookmark: pgfId-1295743]  
          
 [bookmark: pgfId-1295744]For a software module (for example, the ASA 5545-X):

 
           
           [bookmark: pgfId-1295745] 
            sw-module module ips shutdown 
          
 
           
           [bookmark: pgfId-1295746]  
          
 [bookmark: pgfId-1295750]ciscoasa# hw-module module 1 shutdown

  
         		[bookmark: pgfId-1295752]Shuts down the module.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1295759][bookmark: 40995]Uninstalling a Software Module Image[bookmark: marker-1295756][bookmark: marker-1295757][bookmark: marker-1295758]

 
     [bookmark: pgfId-1295760]To uninstall a software module image and associated configuration, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1295761]Detailed Steps

 
     [bookmark: pgfId-1311811] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1312052]  
          
  
         		 
           
           [bookmark: pgfId-1312054]Command 
          
  
         		 
           
           [bookmark: pgfId-1312056]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1312058]Step 1

  
         		[bookmark: pgfId-1312060]sw-module module ips uninstall

 
           
           [bookmark: pgfId-1312061]  
          
 [bookmark: pgfId-1312065]ciscoasa# sw-module module ips uninstall

 [bookmark: pgfId-1312066]Module ips will be uninstalled. This will completely remove the

 [bookmark: pgfId-1312067]disk image associated with the sw-module including any configuration

 [bookmark: pgfId-1312068]that existed within it.

 [bookmark: pgfId-1312069] 

 [bookmark: pgfId-1312070]Uninstall module <id>? [confirm]

  
         		[bookmark: pgfId-1312072]Permanently uninstalls the software module image and associated configuration.

  
        

 
         
         		[bookmark: pgfId-1312074]Step 2

  
         		[bookmark: pgfId-1312076]reload

 
           
           [bookmark: pgfId-1312077]  
          
 [bookmark: pgfId-1312081]ciscoasa# reload

  
         		[bookmark: pgfId-1312086]Reloads the ASA. You must reload the ASA before you can install a new module type.

  
        

 
        
      

 
     
 
    
 
     
      [bookmark: pgfId-1295784]Resetting the [bookmark: 70014]Passw[bookmark: marker-1295783]ord

 
     [bookmark: pgfId-1295787][bookmark: 74370][bookmark: 87026]You can reset the module password to the default. For the user cisco, the default password is cisco. After resetting the password, you should change it to a unique value using the module application.

 
     [bookmark: pgfId-1295788]Resetting the module password causes the module to reboot. Services are not available while the module is rebooting.

 
     [bookmark: pgfId-1371333]If you cannot connect to ASDM with the new password, restart ASDM and try to log in again. If you defined a new password and still have an existing password in ASDM that is different from the new password, clear the password cache by choosing File > Clear ASDM Password Cache, then restart ASDM and try to log in again.

 
     [bookmark: pgfId-1295790]To reset the module password to the default of cisco, perform the following steps.

 
    
 
     
      [bookmark: pgfId-1295791]Detailed Steps

 
     [bookmark: pgfId-1295810] 

 
     
 
     [bookmark: pgfId-1371341]Step 1 From the ASDM menu bar, choose Tools > module Password Reset.

 
     [bookmark: pgfId-1371342]The Password Reset confirmation dialog box appears.

 
     [bookmark: pgfId-1371343]Step 2 Click OK to reset the password to the default. 

 
     [bookmark: pgfId-1371344]A dialog box displays the success or failure of the password reset.

 
     [bookmark: pgfId-1371345]Step 3 Click Close to close the dialog box.

 
     [bookmark: pgfId-1371346]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1295822][bookmark: 60064]Reloading or Resetting the Module[bookmark: marker-1295821]

 
     [bookmark: pgfId-1295826]To reload or reset the module, enter one of the following commands at the ASA CLI.

 
    
 
     
      [bookmark: pgfId-1295827]Detailed Steps

 
     [bookmark: pgfId-1295859] 

 
      
       
        
         
         		 
           
           [bookmark: pgfId-1295830]Command 
          
  
         		 
           
           [bookmark: pgfId-1295832]Purpose 
          
  
        

 
         
         		[bookmark: pgfId-1295834]For a hardware module (for example, the ASA 5585-X):

 
           
           [bookmark: pgfId-1295835] 
            hw-module module 1 reload 
          
 
           
           [bookmark: pgfId-1295836]  
          
 [bookmark: pgfId-1295837]For a software module (for example, the ASA 5545-X):

 
           
           [bookmark: pgfId-1295838] 
            sw-module module ips reload 
          
 
           
           [bookmark: pgfId-1295839]  
          
 [bookmark: pgfId-1295843]ciscoasa# hw-module module 1 reload

  
         		[bookmark: pgfId-1295845]Reloads the module software.

  
        

 
         
         		[bookmark: pgfId-1295847]For a hardware module:

 
           
           [bookmark: pgfId-1295848] 
            hw-module module 1 reset 
          
 
           
           [bookmark: pgfId-1295849]  
          
 [bookmark: pgfId-1295850]For a software module:

 
           
           [bookmark: pgfId-1295851] 
            sw-module module ips reset 
          
 
           
           [bookmark: pgfId-1295852]  
          
 [bookmark: pgfId-1295856]ciscoasa# hw-module module 1 reset

  
         		[bookmark: pgfId-1295858]Performs a reset, and then reloads the module.

  
        

 
        
      

 
     
 
    
 
   
 
    
     [bookmark: pgfId-1252529][bookmark: 65102]Monitoring the ASA IPS module

 
    [bookmark: pgfId-1371357]See the “Intrusion Prevention Tab” section in the general operations configuration guide.

 
    [bookmark: pgfId-1263212] 

 
   
 
    
     [bookmark: pgfId-1105767][bookmark: 31892][bookmark: 55352]Feature History for the ASA IPS module

 
    [bookmark: pgfId-1115677]Table 31-2 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1105805] 

 
     
      
       
       [bookmark: pgfId-1105778]Table 31-2 [bookmark: 50557]Feature History for the ASA IPS module 

 
       
       
        
        		 
          
          [bookmark: pgfId-1115681]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1115683]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1115685]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1105790]AIP SSM

  
        		[bookmark: pgfId-1105793]7.0(1)

  
        		[bookmark: pgfId-1141591]We introduced support for the AIP SSM for the ASA 5510, 5520, and 5540.

 [bookmark: pgfId-1115656]The following screen was introduced: Configuration > Firewall > Service Policy Rules > Add/Edit Service Policy Rule > Intrusion Prevention.

  
       

 
        
        		[bookmark: pgfId-1105799]Virtual sensors (ASA 5510 and higher)

  
        		[bookmark: pgfId-1105801]8.0(2)

  
        		[bookmark: pgfId-1105804]Virtual sensor support was introduced. Virtual sensors let you configure multiple security policies on the ASA IPS module. 

 [bookmark: pgfId-1115641]The following screen was modified: Context Management > Security Contexts > Edit Context.

  
       

 
        
        		[bookmark: pgfId-1105936]AIP SSC for the ASA 5505

  
        		[bookmark: pgfId-1105938]8.2(1)

  
        		[bookmark: pgfId-1105940]We introduced support for the AIP SSC for the ASA 5505.

 [bookmark: pgfId-1115622]The following screen was introduced: Configuration > Device Setup > SSC Setup.

  
       

 
        
        		 
          
          [bookmark: pgfId-1162480]Support for the ASA IPS SSP-10, -20, -40, and -60 for the ASA 5585-X 
         
  
        		[bookmark: pgfId-1162482]8.2(5)/
8.4(2)

  
        		[bookmark: pgfId-1162508]We introduced support for the ASA IPS SSP-10, -20, -40, and -60 for the ASA 5585-X. You can only install the ASA IPS SSP with a matching-level SSP; for example, SSP-10 and ASA IPS SSP-10.

 [bookmark: pgfId-1162521]Note The ASA 5585-X is not supported in Version 8.3.

  
       

 
        
        		[bookmark: pgfId-1168463]Support for Dual SSPs for SSP-40 and SSP-60

  
        		[bookmark: pgfId-1168446]8.4(2)

  
        		[bookmark: pgfId-1168471]For SSP-40 and SSP-60, you can use two SSPs of the same level in the same chassis. Mixed-level SSPs are not supported (for example, an SSP-40 with an SSP-60 is not supported). Each SSP acts as an independent device, with separate configurations and management. You can use the two SSPs as a failover pair if desired.

 [bookmark: pgfId-1168472]Note When using two SSPs in the chassis, VPN is not supported; note, however, that VPN has not been disabled.

 [bookmark: pgfId-1168474]We did not modify any screens.

  
       

 
        
        		[bookmark: pgfId-1197352]Support for the ASA IPS SSP for the ASA 5512-X through ASA 5555-X

  
        		[bookmark: pgfId-1197354]8.6(1)

  
        		[bookmark: pgfId-1197356]We introduced support for the ASA IPS SSP software module for the ASA 5512-X, ASA 5515-X, ASA 5525-X, ASA 5545-X, and ASA 5555-X.

 [bookmark: pgfId-1197404]We did not modify any screens.
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     [bookmark: pgfId-1042020][bookmark: 80031]Using Protection Tools 
      
      
 
     
 

 
    [bookmark: pgfId-1053006]This chapter describes some of the many tools available to protect your network and includes the following sections:

 
     
     		 [bookmark: pgfId-1050096] Preventing IP Spoofing 

 
     		 [bookmark: pgfId-1052984] Configuring the Fragment Size 

 
     		 [bookmark: pgfId-1148270] Configuring TCP Options 

 
     		 [bookmark: pgfId-1056440] Configuring IP Audit for Basic IPS Support 

 
    

 
   
 
    
     [bookmark: pgfId-1042625][bookmark: 11923]Preventing IP S[bookmark: marker-1056694]poofing

 
    [bookmark: pgfId-1042626]This section lets you enable Unicast Reverse Path Forwarding on an interface. Unicast RPF guards against IP spoofing (a packet uses an incorrect source IP address to obscure its true source) by ensuring that all packets have a source IP address that matches the correct source interface according to the routing table.

 
    [bookmark: pgfId-1051795]Normally, the ASA only looks at the destination address when determining where to forward the packet. Unicast RPF instructs the ASA to also look at the source address; this is why it is called Reverse Path Forwarding. For any traffic that you want to allow through the ASA, the ASA routing table must include a route back to the source address. See RFC 2267 for more information.

 
    [bookmark: pgfId-1051808]For outside traffic, for example, the ASA can use the default route to satisfy the Unicast RPF protection. If traffic enters from an outside interface, and the source address is not known to the routing table, the ASA uses the default route to correctly identify the outside interface as the source interface.

 
    [bookmark: pgfId-1051813]If traffic enters the outside interface from an address that is known to the routing table, but is associated with the inside interface, then the ASA drops the packet. Similarly, if traffic enters the inside interface from an unknown source address, the ASA drops the packet because the matching route (the default route) indicates the outside interface.

 
    [bookmark: pgfId-1051820]Unicast RPF is implemented as follows:

 
     
     		 [bookmark: pgfId-1051821]ICMP packets have no session, so each packet is checked.

 
     		 [bookmark: pgfId-1051822]UDP and TCP have sessions, so the initial packet requires a reverse route lookup. Subsequent packets arriving during the session are checked using an existing state maintained as part of the session. Non-initial packets are checked to ensure they arrived on the same interface used by the initial packet.

 
    

 
    [bookmark: pgfId-1148275]Configuration > Firewall > Advanced > Anti-Spoofing Fields

 
     
     		 [bookmark: pgfId-1148276]Interface—Lists the interface names.

 
     		 [bookmark: pgfId-1148277]Anti-Spoofing Enabled—Shows whether an interface has Unicast RPF enabled, Yes or No.

 
     		 [bookmark: pgfId-1148278]Enable—Enables Unicast RPF for the selected interface.

 
     		 [bookmark: pgfId-1148279]Disable—Disables Unicast RPF for the selected interface.

 
    

 
   
 
    
     [bookmark: pgfId-1042721][bookmark: 54218]Configuring the Fragme[bookmark: marker-1056693]nt Size

 
    [bookmark: pgfId-1042725]By default, the ASA allows up to 24 fragments per IP packet, and up to 200 fragments awaiting reassembly. You might need to let fragments on your network if you have an application that routinely fragments packets, such as NFS over UDP. However, if you do not have an application that fragments traffic, we recommend that you do not allow fragments through the ASA. Fragmented packets are often used as DoS attacks.

 
    [bookmark: pgfId-1148284]To modify the IP fragment database parameters of an interface, perform the following steps: 

 
    
 
    [bookmark: pgfId-1148285]Step 1 Choose the Configuration > Firewall > Advanced > Fragment pane, choose the interface to change in the Fragment table, and click Edit.

 
    [bookmark: pgfId-1148286]The Edit Fragment dialog box appears.

 
    [bookmark: pgfId-1148287]Step 2 In the Size field, set the maximum number of packets that can be in the IP reassembly database waiting for reassembly. The default is 200.

 
    [bookmark: pgfId-1148288]Step 3 In the Chain field, set the maximum number of packets into which a full IP packet can be fragmented. The default is 24 packets.

 
    [bookmark: pgfId-1148289]Step 4 In the Timeout field, set the maximum number of seconds to wait for an entire fragmented packet to arrive.

 
    [bookmark: pgfId-1148290]The timer starts after the first fragment of a packet arrives. If all fragments of the packet do not arrive by the number of seconds specified, all fragments of the packet that were already received will be discarded. The default is 5 seconds.

 
    [bookmark: pgfId-1148291]Step 5 Click OK.

 
    [bookmark: pgfId-1148292]Step 6 Click Apply.

 
    [bookmark: pgfId-1148295]Step 7 To view the fragment statistics, click Show Fragment. See the “Show Fragment” section for more information.

 
    [bookmark: pgfId-1148297]

 
     
     
 
    
  
    

 
     
      [bookmark: pgfId-1148300][bookmark: 79840]Show Fragment

 
     [bookmark: pgfId-1148303]The [bookmark: marker-1148301][bookmark: marker-1148302]Configuration > Properties > Fragment > Show Fragment pane displays the current IP fragment database statistics for each interface.

 
     [bookmark: pgfId-1148305][bookmark: WP0127screenelementdescriptions]Fields

 
      
      		 [bookmark: pgfId-1148306]Size— Display only . Displays the number of packets in the IP reassembly database waiting for reassembly. The default is 200. 

 
      		 [bookmark: pgfId-1148307]Chain— Display only . Displays the number of packets into which a full IP packet can be fragmented. The default is 24 packets.

 
      		 [bookmark: pgfId-1148308]Timeout— Display only . Displays the number of seconds to wait for an entire fragmented packet to arrive. The timer starts after the first fragment of a packet arrives. If all fragments of the packet do not arrive by the number of seconds displayed, all fragments of the packet that were already received will be discarded. The default is 5 seconds.

 
      		 [bookmark: pgfId-1148309]Threshold— Display only . Displays the IP packet threshold, or the limit after which no new chains can be created in the reassembly module.

 
      		 [bookmark: pgfId-1148310]Queue— Display only . Displays the number of IP packets waiting in the queue for reassembly.

 
      		 [bookmark: pgfId-1148311]Assembled— Display only . Displays the number of IP packets successfully reassembled.

 
      		 [bookmark: pgfId-1148312]Fail— Display only . Displays the number of failed reassembly attempts.

 
      		 [bookmark: pgfId-1148313]Overflow— Display only . Displays the number of IP packets in the overflow queue.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1148321]Configuring [bookmark: marker-1148318][bookmark: 49848]TCP Options

 
    [bookmark: pgfId-1148322]The Configuration > Firewall > Advanced > TCP Options pane lets you set parameters for TCP connections.

 
    [bookmark: pgfId-1148323]Fields

 
     
     		 [bookmark: pgfId-1148324]Inbound and Outbound Reset—Sets whether to reset denied TCP connections for inbound and outbound traffic.

 
    

 
    [bookmark: pgfId-1148325] – Interface—Shows the interface name.

 
    [bookmark: pgfId-1148326] – Inbound Reset—Shows the interface reset setting for inbound TCP traffic, Yes or No. Enabling this setting c[bookmark: marker-1148327]auses the ASA to send TCP resets for all inbound TCP sessions that attempt to transit the ASA and are denied by the ASA based on ACLs or AAA settings. Traffic between same security level interfaces is also affected. When this option is not enabled, the ASA silently discards denied packets.

 
    [bookmark: pgfId-1148340] – Outbound Reset—Shows the interface reset setting for outbound TCP traffic, Yes or No. Enabling this setting [bookmark: marker-1148341]causes the ASA to send TCP resets for all outbound TCP sessions that attempt to transit the ASA and are denied by the ASA based on ACLs or AAA settings. Traffic between same security level interfaces is also affected. When this option is not enabled, the ASA silently discards denied packets.

 
    [bookmark: pgfId-1148354] – Edit—Sets the inbound and outbound reset settings for the interface.

 
     
     		 [bookmark: pgfId-1148355]Other Options—Sets additional TCP options.

 
    

 
    [bookmark: pgfId-1148356] – Send Reset Reply for Denied Outside TCP Packets—Enables resets for TCP packets that terminate at the least secure interface and are denied by the ASA based on ACLs or AAA settings[bookmark: marker-1148360]. When this option is not enabled, the ASA silently discards denied packets. If you enable Inbound Resets for the least secure interface (see TCP Reset Settings), then you do not also have to enable this setting; Inbound Resets handle to-the-ASA traffic as well as through the ASA traffic.

 
    [bookmark: pgfId-1148373] – Force Maximum Segment Size for TCP—Sets the maximum TCP segment size in bytes, between 48 and any maximum number. The default value is 1380 bytes. You can disable this feature by setting[bookmark: marker-1148374] the bytes to 0. Both the host and the server can set the maximum segment size when they first establish a connection. If either maximum exceeds the value you set here, then the ASA overrides the maximum and inserts the value you set. For example, if you set a maximum size of 1200 bytes, when a host requests a maximum size of 1300 bytes, then the ASA alters the packet to request 1200 bytes. See the “Controlling Fragmentation with the Maximum Transmission Unit and TCP Maximum Segment Size” section for more information.

 
    [bookmark: pgfId-1148384] – Force Minimum Segment Size for TCP—Overrides the maximum segment size to be no less than the number of bytes you set, between 48 and any maximum number. This feature is disabled by default (set to 0). Both the host and the server can set the maximum segment size when they first establish a connection. If either maximum is less than the value you set for the Force Minimum Segment Size for TCP Proxy field, then the ASA overrides the maximum and inserts the “minimum” value you set (the minimum value is actually the smallest maximum allowed). For example, if you set a minimum size of 400 bytes, if a host requests a maximum value of 300 bytes, then the ASA alters the packet to request 400 bytes.

 
    [bookmark: pgfId-1148393] – Force TCP Connection to Li[bookmark: marker-1148391]nger in TIME_WAIT[bookmark: marker-1148392] State for at Least 15 Seconds—Forces each TCP connection to linger in a shortened TIME_WAIT state of at least 15 seconds after the final normal TCP close-down sequence. You might want to use this feature if an end host application default TCP terminating sequence is a simultaneous close. The default behavior of the ASA is to track the shutdown sequence and release the connection after two FINs and the ACK of the last FIN segment. This quick release heuristic enables the ASA to sustain a high connection rate, based on the most common closing sequence, known as the normal close sequence. However, in a simultaneous close, both ends of the transaction initiate the closing sequence, as opposed to the normal close sequence where one end closes and the other end acknowledges prior to initiating its own closing sequence (see RFC 793). Thus, in a simultaneous close, the quick release forces one side of the connection to linger in the CLOSING state. Having many sockets in the CLOSING state can degrade the performance of an end host. For example, some WinSock mainframe clients are known to exhibit this behavior and degrade the performance of the mainframe server. Using this feature creates a window for the simultaneous close down sequence to complete.

 
     
      [bookmark: pgfId-1148402][bookmark: 96516]TCP Reset Settings

 
     [bookmark: pgfId-1148403]The Configuration > Firewall > Advanced > TCP Options > TCP Reset Settings dialog box sets the inbound and outbound reset settings for an interface.

 
     [bookmark: pgfId-1148405]Fields

 
      
      		 [bookmark: pgfId-1148406]Send Reset Reply for Denied Inbound TCP Packets—Sends TCP resets for all inbound TCP sessions that attempt to transit the ASA and are denied by the ASA based on ACLs or AAA settings. Traffic between same security level interfaces is also affected. When this option is not enabled, the ASA silently discards denied packets.

 
     

 
     [bookmark: pgfId-1148416]You might want to explicitly send resets for inbound traffic if you need to reset identity request (IDENT) connections. When you send a TCP RST (reset flag in the TCP header) to the denied host, the RST stops the incoming IDENT process so that you do not have to wait for IDENT to time out. Waiting for IDENT to time out can cause traffic to slow because outside hosts keep retransmitting the SYN until the IDENT times out, so the service resetinbound command might improve performance.

 
      
      		 [bookmark: pgfId-1148417]Send Reset Reply for Denied Outbound TCP Packets—Sends TCP resets for all outbound TCP sessions that attempt to transit the ASA and are denied by the ASA based on ACLs or AAA settings. Traffic between same security level interfaces is also affected. When this option is not enabled, the ASA silently discards denied packets. This option is enabled by default. You might want to disable outbound resets to reduce the CPU load during traffic storms, for example.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1056358][bookmark: 26683]Configuring IP Audit for Basic IPS Support[bookmark: 46698]

 
    [bookmark: pgfId-1056365]The IP audit feature provides basic IPS support for the ASA that does not have an AIP SSM. It supports a basic list of signatures, and you can configure the ASA to perform one or more actions on traffic that matches a signature.

 
    [bookmark: pgfId-1090669]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1148434]IP Audit Policy

 
     		 [bookmark: pgfId-1148438]Add/Edit IP Audit Policy Configuration

 
     		 [bookmark: pgfId-1148442]IP Audit Signatures

 
     		 [bookmark: pgfId-1090747]IP Audit Signature List

 
    

 
     
      [bookmark: pgfId-1148449][bookmark: 60163]IP Audit Policy

 
     [bookmark: pgfId-1148451]The Configuration > Firewall > Advanced > IP Audit > IP Audit Policy pa[bookmark: marker-1148450]ne lets you add audit policies and assign them to interfaces. You can assign an attack policy and an informational policy to each interface. The attack policy determines the action to take with packets that match an attack signature; the packet might be part of an attack on your network, such as a DoS attack. The informational policy determines the action to take with packets that match an informational signature; the packet is not currently attacking your network, but could be part of an information-gathering activity, such as a port sweep. For a complete list of signatures, see the IP Audit Signature List.

 
     [bookmark: pgfId-1148455]Fields

 
      
      		 [bookmark: pgfId-1148456]Name—Shows the names of the defined IP audit policies. Although the default actions for a named policy are listed in this table (“--Default Action--”), they are not named policies that you can assign to an interface. Default actions are used by named policies if you do not set an action for the policy. You can modify the default actions by selecting them and clicking the Edit button.

 
      		 [bookmark: pgfId-1148457]Type—Shows the policy type, either Attack or Info.

 
      		 [bookmark: pgfId-1148458]Action—Shows the actions taken against packets that match the policy, Alarm, Drop, and/or Reset. Multiple actions can be listed.

 
      		 [bookmark: pgfId-1148459]Add—Adds a new IP audit policy.

 
      		 [bookmark: pgfId-1148460]Edit—Edits an IP audit policy or the default actions.

 
      		 [bookmark: pgfId-1148461]Delete—Deletes an IP audit policy. You cannot delete a default action.

 
      		 [bookmark: pgfId-1148462]Policy-to-Interface Mappings—Assigns an attack and informational policy to each interface.

 
     

 
     [bookmark: pgfId-1148463] – Interface—Shows the interface name.

 
     [bookmark: pgfId-1148464] – Attack Policy—Lists the attack audit policy names available. Assign a policy to an interface by clicking the name in the list.

 
     [bookmark: pgfId-1148465] – Info Policy—Lists the informational audit policy names available. Assign a policy to an interface by clicking the name in the list.

 
    
 
     
      [bookmark: pgfId-1148468][bookmark: 97047]Add/Edit IP Audit Policy Configuration

 
     [bookmark: pgfId-1148469]The Configuration > Firewall > Advanced > IP Audit > IP Audit Policy > Add/Edit IP Audit Policy Configuration dialog box lets you add or edit a named IP audit policy that you can assign to interfaces, and lets you modify the default actions for each signature type.

 
     [bookmark: pgfId-1148470]Fields

 
      
      		 [bookmark: pgfId-1148471]Policy Name—Sets the IP audit policy name. You cannot edit the name after you add it.

 
      		 [bookmark: pgfId-1148472]Policy Type—Sets the policy type. You cannot edit the policy type after you add it.

 
     

 
     [bookmark: pgfId-1148473] – Attack—Sets the policy type as attack.

 
     [bookmark: pgfId-1148474] – Information—Sets the policy type as informational.

 
      
      		 [bookmark: pgfId-1148475]Action—Sets one or more actions to take when a packet matches a signature. If you do not choose an action, then the default policy is used.

 
     

 
     [bookmark: pgfId-1148476] – Alarm—Generates a system message showing that a packet matched a signature. For a complete list of signatures, see IP Audit Signature List.

 
     [bookmark: pgfId-1148480] – Drop—Drops the packet.

 
     [bookmark: pgfId-1148481] – Reset—Drops the packet and closes the connection.

 
    
 
     
      [bookmark: pgfId-1148484][bookmark: 87987]IP Audit Signatures

 
     [bookmark: pgfId-1148486]The Configuration > Firewall > Advanced > IP Audit > IP Audit Signatures [bookmark: marker-1148485]pane lets you disable audit signatures. You might want to disable a signature if legitimate traffic continually matches a signature, and you are willing to risk disabling the signature to avoid large numbers of alarms.

 
     [bookmark: pgfId-1148490]For a complete list of signatures, see the “IP Audit Signature List” section.

 
     [bookmark: pgfId-1148492]Fields

 
      
      		 [bookmark: pgfId-1148493]Enabled—Lists the enabled signatures.

 
      		 [bookmark: pgfId-1148494]Disabled—Lists the disabled signatures.

 
      		 [bookmark: pgfId-1148495]Disable—Moves the selected signature to the Disabled pane.

 
      		 [bookmark: pgfId-1148496]Enable—Moves the selected signature to the Enabled pane.

 
     

 
    
 
     
      [bookmark: pgfId-1089667][bookmark: 25703]IP Audit Signature List

 
      
       
        
        [bookmark: pgfId-1089678]Table 28-1 [bookmark: 18407]Signature IDs and System Message Numbers 

 
        
        
         
         		 
           
           [bookmark: pgfId-1089688]Signature ID 
          
  
         		 
           
           [bookmark: pgfId-1089690]Message Number 
          
  
         		 
           
           [bookmark: pgfId-1089692]Signature Title 
          
  
         		 
           
           [bookmark: pgfId-1089694]Signature Type 
          
  
         		 
           
           [bookmark: pgfId-1089696]Description 
          
  
        

 
         
         		[bookmark: pgfId-1089698]1000

  
         		[bookmark: pgfId-1089700]400000

  
         		[bookmark: pgfId-1089702]IP options-Bad Option List

  
         		[bookmark: pgfId-1089704]Informational

  
         		[bookmark: pgfId-1089706]Triggers on receipt of an IP datagram where the list of IP options in the IP datagram header is incomplete or malformed. The IP options list contains one or more options that perform various network management or debugging tasks.

  
        

 
         
         		[bookmark: pgfId-1089708]1001

  
         		[bookmark: pgfId-1089710]400001

  
         		[bookmark: pgfId-1089712]IP options-Record Packet Route

  
         		[bookmark: pgfId-1089714]Informational

  
         		[bookmark: pgfId-1089716]Triggers on receipt of an IP datagram where the IP option list for the datagram includes option 7 (Record Packet Route).

  
        

 
         
         		[bookmark: pgfId-1089718]1002

  
         		[bookmark: pgfId-1089720]400002

  
         		[bookmark: pgfId-1089722]IP options-Timestamp

  
         		[bookmark: pgfId-1089724]Informational

  
         		[bookmark: pgfId-1089726]Triggers on receipt of an IP datagram where the IP option list for the datagram includes option 4 (Timestamp).

  
        

 
         
         		[bookmark: pgfId-1089728]1003

  
         		[bookmark: pgfId-1089730]400003

  
         		[bookmark: pgfId-1089732]IP options-Security

  
         		[bookmark: pgfId-1089734]Informational

  
         		[bookmark: pgfId-1089736]Triggers on receipt of an IP datagram where the IP option list for the datagram includes option 2 (Security options).

  
        

 
         
         		[bookmark: pgfId-1089738]1004

  
         		[bookmark: pgfId-1089740]400004

  
         		[bookmark: pgfId-1089742]IP options-Loose Source Route

  
         		[bookmark: pgfId-1089744]Informational

  
         		[bookmark: pgfId-1089746]Triggers on receipt of an IP datagram where the IP option list for the datagram includes option 3 (Loose Source Route).

  
        

 
         
         		[bookmark: pgfId-1089748]1005

  
         		[bookmark: pgfId-1089750]400005

  
         		[bookmark: pgfId-1089752]IP options-SATNET ID

  
         		[bookmark: pgfId-1089754]Informational

  
         		[bookmark: pgfId-1089756]Triggers on receipt of an IP datagram where the IP option list for the datagram includes option 8 (SATNET stream identifier).

  
        

 
         
         		[bookmark: pgfId-1089758]1006

  
         		[bookmark: pgfId-1089760]400006

  
         		[bookmark: pgfId-1089762]IP options-Strict Source Route

  
         		[bookmark: pgfId-1089764]Informational

  
         		[bookmark: pgfId-1089766]Triggers on receipt of an IP datagram in which the IP option list for the datagram includes option 9(Strict Source Routing).

  
        

 
         
         		[bookmark: pgfId-1089768]1100

  
         		[bookmark: pgfId-1089770]400007

  
         		[bookmark: pgfId-1089774]IP Fragm[bookmark: marker-1089772][bookmark: marker-1089773]ent Attack

  
         		[bookmark: pgfId-1089776]Attack

  
         		[bookmark: pgfId-1089778]Triggers when any IP datagram is received with an offset value less than 5 but greater than 0 indicated in the offset field.

  
        

 
         
         		[bookmark: pgfId-1089780]1102 

  
         		[bookmark: pgfId-1089782]400008

  
         		[bookmark: pgfId-1089786]IP Impossible Pack[bookmark: marker-1089784][bookmark: marker-1089785]et

  
         		[bookmark: pgfId-1089788]Attack

  
         		[bookmark: pgfId-1089790]Triggers when an IP packet arrives with source equal to destination address. This signature will catch the so-called Land Attack.

  
        

 
         
         		[bookmark: pgfId-1089792]1103

  
         		[bookmark: pgfId-1089794]400009

  
         		[bookmark: pgfId-1089797]IP Overlapping Fragments (Tear[bookmark: marker-1089796]drop)

  
         		[bookmark: pgfId-1089799]Attack

  
         		[bookmark: pgfId-1089801]Triggers when two fragments contained within the same IP datagram have offsets that indicate that they share positioning within the datagram. This could mean that fragment A is being completely overwritten by fragment B, or that fragment A is partially being overwritten by fragment B. Some operating systems do not properly handle fragments that overlap in this manner and may throw exceptions or behave in other undesirable ways upon receipt of overlapping fragments, which is how the Teardrop attack works to create a DoS.

  
        

 
         
         		[bookmark: pgfId-1089803]2000

  
         		[bookmark: pgfId-1089805]400010

  
         		[bookmark: pgfId-1089807]ICMP Echo Reply

  
         		[bookmark: pgfId-1089809]Informational

  
         		[bookmark: pgfId-1089811]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 0 (Echo Reply).

  
        

 
         
         		[bookmark: pgfId-1089813]2001

  
         		[bookmark: pgfId-1089815]400011

  
         		[bookmark: pgfId-1089817]ICMP Host Unreachable

  
         		[bookmark: pgfId-1089819]Informational

  
         		[bookmark: pgfId-1089821]Triggers when an IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 3 (Host Unreachable).

  
        

 
         
         		[bookmark: pgfId-1089823]2002

  
         		[bookmark: pgfId-1089825]400012

  
         		[bookmark: pgfId-1089827]ICMP Source Quench

  
         		[bookmark: pgfId-1089829]Informational

  
         		[bookmark: pgfId-1089831]Triggers when an IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 4 (Source Quench).

  
        

 
         
         		[bookmark: pgfId-1089833]2003

  
         		[bookmark: pgfId-1089835]400013

  
         		[bookmark: pgfId-1089837]ICMP Redirect

  
         		[bookmark: pgfId-1089839]Informational

  
         		[bookmark: pgfId-1089841]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 5 (Redirect).

  
        

 
         
         		[bookmark: pgfId-1089843]2004

  
         		[bookmark: pgfId-1089845]400014

  
         		[bookmark: pgfId-1089847]ICMP Echo Request

  
         		[bookmark: pgfId-1089849]Informational

  
         		[bookmark: pgfId-1089851]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 8 (Echo Request).

  
        

 
         
         		[bookmark: pgfId-1089853]2005

  
         		[bookmark: pgfId-1089855]400015

  
         		[bookmark: pgfId-1089857]ICMP Time Exceeded for a Datagram

  
         		[bookmark: pgfId-1089859]Informational

  
         		[bookmark: pgfId-1089861]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 11(Time Exceeded for a Datagram).

  
        

 
         
         		[bookmark: pgfId-1089863]2006

  
         		[bookmark: pgfId-1089865]400016

  
         		[bookmark: pgfId-1089867]ICMP Parameter Problem on Datagram

  
         		[bookmark: pgfId-1089869]Informational

  
         		[bookmark: pgfId-1089871]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 12 (Parameter Problem on Datagram).

  
        

 
         
         		[bookmark: pgfId-1089873]2007

  
         		[bookmark: pgfId-1089875]400017

  
         		[bookmark: pgfId-1089877]ICMP Timestamp Request 

  
         		[bookmark: pgfId-1089879]Informational

  
         		[bookmark: pgfId-1089881]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 13 (Timestamp Request).

  
        

 
         
         		[bookmark: pgfId-1089883]2008

  
         		[bookmark: pgfId-1089885]400018

  
         		[bookmark: pgfId-1089887]ICMP Timestamp Reply

  
         		[bookmark: pgfId-1089889]Informational

  
         		[bookmark: pgfId-1089891]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 14 (Timestamp Reply).

  
        

 
         
         		[bookmark: pgfId-1089893]2009

  
         		[bookmark: pgfId-1089895]400019

  
         		[bookmark: pgfId-1089897]ICMP Information Request

  
         		[bookmark: pgfId-1089899]Informational

  
         		[bookmark: pgfId-1089901]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 15 (Information Request).

  
        

 
         
         		[bookmark: pgfId-1089903]2010

  
         		[bookmark: pgfId-1089905]400020

  
         		[bookmark: pgfId-1089907]ICMP Information Reply

  
         		[bookmark: pgfId-1089909]Informational

  
         		[bookmark: pgfId-1089911]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 16 (ICMP Information Reply).

  
        

 
         
         		[bookmark: pgfId-1089913]2011

  
         		[bookmark: pgfId-1089915]400021

  
         		[bookmark: pgfId-1089917]ICMP Address Mask Request

  
         		[bookmark: pgfId-1089919]Informational

  
         		[bookmark: pgfId-1089921]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 17 (Address Mask Request).

  
        

 
         
         		[bookmark: pgfId-1089923]2012

  
         		[bookmark: pgfId-1089925]400022

  
         		[bookmark: pgfId-1089927]ICMP Address Mask Reply

  
         		[bookmark: pgfId-1089929]Informational

  
         		[bookmark: pgfId-1089931]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and the type field in the ICMP header set to 18 (Address Mask Reply).

  
        

 
         
         		[bookmark: pgfId-1089933]2150

  
         		[bookmark: pgfId-1089935]400023

  
         		[bookmark: pgfId-1089939][bookmark: marker-1089937][bookmark: marker-1089938]Fragmented ICMP Traffic

  
         		[bookmark: pgfId-1089941]Attack

  
         		[bookmark: pgfId-1089943]Triggers when a IP datagram is received with the protocol field of the IP header set to 1 (ICMP) and either the more fragments flag is set to 1 (ICMP) or there is an offset indicated in the offset field.

  
        

 
         
         		[bookmark: pgfId-1089945]2151

  
         		[bookmark: pgfId-1089947]400024

  
         		[bookmark: pgfId-1089951][bookmark: marker-1089949][bookmark: marker-1089950]Large ICMP Traffic

  
         		[bookmark: pgfId-1089953]Attack

  
         		[bookmark: pgfId-1089955]Triggers when a IP datagram is received with the protocol field of the IP header set to 1(ICMP) and the IP length > 1024.

  
        

 
         
         		[bookmark: pgfId-1089957]2154

  
         		[bookmark: pgfId-1089959]400025

  
         		[bookmark: pgfId-1089963][bookmark: marker-1089961][bookmark: marker-1089962]Ping of Death Attack 

  
         		[bookmark: pgfId-1089965]Attack

  
         		[bookmark: pgfId-1089967]Triggers when a IP datagram is received with the protocol field of the IP header set to 1(ICMP), the Last Fragment bit is set, and (IP offset * 8) + (IP data length) > 65535 that is to say, the IP offset (which represents the starting position of this fragment in the original packet, and which is in 8 byte units) plus the rest of the packet is greater than the maximum size for an IP packet.

  
        

 
         
         		[bookmark: pgfId-1089969]3040

  
         		[bookmark: pgfId-1089971]400026

  
         		[bookmark: pgfId-1089975][bookmark: marker-1089973][bookmark: marker-1089974]TCP NULL flags

  
         		[bookmark: pgfId-1089977]Attack

  
         		[bookmark: pgfId-1089979]Triggers when a single TCP packet with none of the SYN, FIN, ACK, or RST flags set has been sent to a specific host.

  
        

 
         
         		[bookmark: pgfId-1089981]3041

  
         		[bookmark: pgfId-1089983]400027

  
         		[bookmark: pgfId-1089987][bookmark: marker-1089985][bookmark: marker-1089986]TCP SYN+FIN flags

  
         		[bookmark: pgfId-1089989]Attack

  
         		[bookmark: pgfId-1089991]Triggers when a single TCP packet with the SYN and FIN flags are set and is sent to a specific host.

  
        

 
         
         		[bookmark: pgfId-1089993]3042

  
         		[bookmark: pgfId-1089995]400028

  
         		[bookmark: pgfId-1089999][bookmark: marker-1089997][bookmark: marker-1089998]TCP FIN only flags

  
         		[bookmark: pgfId-1090001]Attack

  
         		[bookmark: pgfId-1090003]Triggers when a single orphaned TCP FIN packet is sent to a privileged port (having port number less than 1024) on a specific host.

  
        

 
         
         		[bookmark: pgfId-1090005]3153

  
         		[bookmark: pgfId-1090007]400029

  
         		[bookmark: pgfId-1090009]FTP Improper Address Specified

  
         		[bookmark: pgfId-1090011]Informational

  
         		[bookmark: pgfId-1090013]Triggers if a port command is issued with an address that is not the same as the requesting host.

  
        

 
         
         		[bookmark: pgfId-1090015]3154

  
         		[bookmark: pgfId-1090017]400030

  
         		[bookmark: pgfId-1090019]FTP Improper Port Specified 

  
         		[bookmark: pgfId-1090021]Informational

  
         		[bookmark: pgfId-1090023]Triggers if a port command is issued with a data port specified that is <1024 or >65535.

  
        

 
         
         		[bookmark: pgfId-1090025]4050

  
         		[bookmark: pgfId-1090027]400031

  
         		[bookmark: pgfId-1090031][bookmark: marker-1090029][bookmark: marker-1090030]UDP Bomb attack

  
         		[bookmark: pgfId-1090033]Attack

  
         		[bookmark: pgfId-1090035]Triggers when the UDP length specified is less than the IP length specified. This malformed packet type is associated with a denial of service attempt.

  
        

 
         
         		[bookmark: pgfId-1090037]4051

  
         		[bookmark: pgfId-1090039]400032

  
         		[bookmark: pgfId-1090043][bookmark: marker-1090041][bookmark: marker-1090042]UDP Snork attack

  
         		[bookmark: pgfId-1090045]Attack

  
         		[bookmark: pgfId-1090047]Triggers when a UDP packet with a source port of either 135, 7, or 19 and a destination port of 135 is detected.

  
        

 
         
         		[bookmark: pgfId-1090049]4052

  
         		[bookmark: pgfId-1090051]400033

  
         		[bookmark: pgfId-1090055][bookmark: marker-1090053][bookmark: marker-1090054]UDP Chargen DoS attack

  
         		[bookmark: pgfId-1090057]Attack

  
         		[bookmark: pgfId-1090059]This signature triggers when a UDP packet is detected with a source port of 7 and a destination port of 19.

  
        

 
         
         		[bookmark: pgfId-1090061]6050

  
         		[bookmark: pgfId-1090063]400034

  
         		[bookmark: pgfId-1090067][bookmark: marker-1090065][bookmark: marker-1090066]DNS HINFO Request

  
         		[bookmark: pgfId-1090069]Informational

  
         		[bookmark: pgfId-1090071]Triggers on an attempt to access HINFO records from a DNS server.

  
        

 
         
         		[bookmark: pgfId-1090073]6051

  
         		[bookmark: pgfId-1090075]400035

  
         		[bookmark: pgfId-1090079][bookmark: marker-1090077][bookmark: marker-1090078]DNS Zone Transfer

  
         		[bookmark: pgfId-1090081]Informational

  
         		[bookmark: pgfId-1090083]Triggers on normal DNS zone transfers, in which the source port is 53.

  
        

 
         
         		[bookmark: pgfId-1090085]6052

  
         		[bookmark: pgfId-1090087]400036

  
         		[bookmark: pgfId-1090091][bookmark: marker-1090089][bookmark: marker-1090090]DNS Zone Transfer from High Port 

  
         		[bookmark: pgfId-1090093]Informational

  
         		[bookmark: pgfId-1090095]Triggers on an illegitimate DNS zone transfer, in which the source port is not equal to 53.

  
        

 
         
         		[bookmark: pgfId-1090097]6053

  
         		[bookmark: pgfId-1090099]400037

  
         		[bookmark: pgfId-1090103][bookmark: marker-1090101][bookmark: marker-1090102]DNS Request for All Records

  
         		[bookmark: pgfId-1090105]Informational

  
         		[bookmark: pgfId-1090107]Triggers on a DNS request for all records.

  
        

 
         
         		[bookmark: pgfId-1090109]6100

  
         		[bookmark: pgfId-1090111]400038

  
         		[bookmark: pgfId-1090113]RPC Port Registration 

  
         		[bookmark: pgfId-1090115]Informational

  
         		[bookmark: pgfId-1090117]Triggers when attempts are made to register new RPC services on a target host.

  
        

 
         
         		[bookmark: pgfId-1090119]6101

  
         		[bookmark: pgfId-1090121]400039

  
         		[bookmark: pgfId-1090123]RPC Port Unregistration

  
         		[bookmark: pgfId-1090125]Informational

  
         		[bookmark: pgfId-1090127]Triggers when attempts are made to unregister existing RPC services on a target host.

  
        

 
         
         		[bookmark: pgfId-1090129]6102

  
         		[bookmark: pgfId-1090131]400040

  
         		[bookmark: pgfId-1090133]RPC Dump

  
         		[bookmark: pgfId-1090135]Informational

  
         		[bookmark: pgfId-1090137]Triggers when an RPC dump request is issued to a target host.

  
        

 
         
         		[bookmark: pgfId-1090139]6103

  
         		[bookmark: pgfId-1090141]400041

  
         		[bookmark: pgfId-1090145][bookmark: marker-1090143][bookmark: marker-1090144]Proxied RPC Request

  
         		[bookmark: pgfId-1090147]Attack

  
         		[bookmark: pgfId-1090149]Triggers when a proxied RPC request is sent to the portmapper of a target host.

  
        

 
         
         		[bookmark: pgfId-1090151]6150

  
         		[bookmark: pgfId-1090153]400042

  
         		[bookmark: pgfId-1090155]ypserv (YP server daemon) Portmap Request 

  
         		[bookmark: pgfId-1090157]Informational

  
         		[bookmark: pgfId-1090159]Triggers when a request is made to the portmapper for the YP server daemon (ypserv) port.

  
        

 
         
         		[bookmark: pgfId-1090161]6151

  
         		[bookmark: pgfId-1090163]400043

  
         		[bookmark: pgfId-1090165]ypbind (YP bind daemon) Portmap Request 

  
         		[bookmark: pgfId-1090167]Informational

  
         		[bookmark: pgfId-1090169]Triggers when a request is made to the portmapper for the YP bind daemon (ypbind) port.

  
        

 
         
         		[bookmark: pgfId-1090171]6152

  
         		[bookmark: pgfId-1090173]400044

  
         		[bookmark: pgfId-1090175]yppasswdd (YP password daemon) Portmap Request

  
         		[bookmark: pgfId-1090177]Informational

  
         		[bookmark: pgfId-1090179]Triggers when a request is made to the portmapper for the YP password daemon (yppasswdd) port.

  
        

 
         
         		[bookmark: pgfId-1090181]6153

  
         		[bookmark: pgfId-1090183]400045

  
         		[bookmark: pgfId-1090185]ypupdated (YP update daemon) Portmap Request 

  
         		[bookmark: pgfId-1090187]Informational

  
         		[bookmark: pgfId-1090189]Triggers when a request is made to the portmapper for the YP update daemon (ypupdated) port.

  
        

 
         
         		[bookmark: pgfId-1090191]6154

  
         		[bookmark: pgfId-1090193]400046

  
         		[bookmark: pgfId-1090195]ypxfrd (YP transfer daemon) Portmap Request 

  
         		[bookmark: pgfId-1090197]Informational

  
         		[bookmark: pgfId-1090199]Triggers when a request is made to the portmapper for the YP transfer daemon (ypxfrd) port.

  
        

 
         
         		[bookmark: pgfId-1090201]6155

  
         		[bookmark: pgfId-1090203]400047

  
         		[bookmark: pgfId-1090205]mountd (mount daemon) Portmap Request 

  
         		[bookmark: pgfId-1090207]Informational

  
         		[bookmark: pgfId-1090209]Triggers when a request is made to the portmapper for the mount daemon (mountd) port.

  
        

 
         
         		[bookmark: pgfId-1090211]6175

  
         		[bookmark: pgfId-1090213]400048

  
         		[bookmark: pgfId-1090215]rexd (remote execution daemon) Portmap Request

  
         		[bookmark: pgfId-1090217]Informational

  
         		[bookmark: pgfId-1090219]Triggers when a request is made to the portmapper for the remote execution daemon (rexd) port.

  
        

 
         
         		[bookmark: pgfId-1090221]6180

  
         		[bookmark: pgfId-1090223]400049

  
         		[bookmark: pgfId-1090225]rexd (remote execution daemon) Attempt

  
         		[bookmark: pgfId-1090227]Informational

  
         		[bookmark: pgfId-1090229]Triggers when a call to the rexd program is made. The remote execution daemon is the server responsible for remote program execution. This may be indicative of an attempt to gain unauthorized access to system resources.

  
        

 
         
         		[bookmark: pgfId-1090231]6190

  
         		[bookmark: pgfId-1090233]400050

  
         		[bookmark: pgfId-1090237][bookmark: marker-1090235][bookmark: marker-1090236]statd Buffer Overflow

  
         		[bookmark: pgfId-1090239]Attack

  
         		[bookmark: pgfId-1090241]Triggers when a large statd request is sent. This could be an attempt to overflow a buffer and gain access to system resources.
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     [bookmark: pgfId-1050709]Configuring Cisco Mobility Advantage 
      
      
 
     
 

 
    [bookmark: pgfId-1282247]This chapter describes how to configure the ASA for Cisco Unified Communications Mobility Advantage Proxy features. 

 
    [bookmark: pgfId-1282248]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1142597]Information about the Cisco Mobility Advantage Proxy Feature

 
     		 [bookmark: pgfId-1235609]Licensing for the Cisco Mobility Advantage Proxy Feature

 
     		 [bookmark: pgfId-1235622]Configuring Cisco Mobility Advantage

 
     		 [bookmark: pgfId-1235679]Feature History for Cisco Mobility Advantage

 
    

 
   
 
    
     [bookmark: pgfId-1096839][bookmark: 45660][bookmark: 92532]Information about the Cisco Mobility Advantage Proxy Feature

 
    [bookmark: pgfId-1235721]This section contains the following topics:

 
     
     		 [bookmark: pgfId-1235726]Cisco Mobility Advantage Proxy Functionality

 
     		 [bookmark: pgfId-1235772]Mobility Advantage Proxy Deployment Scenarios

 
     		 [bookmark: pgfId-1235793]Trust Relationships for Cisco UMA Deployments

 
    

 
     
      [bookmark: pgfId-1096855][bookmark: 10089]Cisco Mobility Advantage Proxy Functionality

 
     [bookmark: pgfId-1235731]To support[bookmark: marker-1139938] Cisco UMA for the Cisco Mobility Advantage solution, the mobility advantage proxy (implemented as a TLS proxy) includes the following functionality:

 
      
      		 [bookmark: pgfId-1096856]The ability to allow no client authentication during the handshake with clients.

 
      		 [bookmark: pgfId-1096857]Allowing an imported PKCS-12 certificate to server as a proxy certificate.

 
     

 
     [bookmark: pgfId-1096858]The ASA includes an inspection engine to validate the Cisco UMA[bookmark: marker-1139939] Mobile Multiplexing Protocol (MMP). 

 
     [bookmark: pgfId-1096859]MMP is a data transport protocol for transmitting data entities between Cisco UMA clients and servers. As shown in Figure 19-1, MMP must be run on top of a connection-oriented protocol (the underlying transport) and is intended to be run on top of a secure transport protocol such as TLS. The Orative Markup Language (OML) protocol is intended to be run on top of MMP for the purposes of data synchronization, as well as the HTTP protocol for uploading and downloading large files. 

 
     [bookmark: pgfId-1335982]Figure 19-1 [bookmark: 57651]MMP Stack

 
     [bookmark: pgfId-1335986] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1096870]The TCP/TLS default port is 5443. There are no embedded NAT or secondary connections.

 
     [bookmark: pgfId-1096871]Cisco UMA client and server communications can be proxied via TLS, which decrypts the data, passes it to the inspect MMP module, and re-encrypt the data before forwarding it to the endpoint. The inspect MMP module verifies the integrity of the MMP headers and passes the OML/HTTP to an appropriate handler. The ASA takes the following actions on the MMP headers and data:

 
      
      		 [bookmark: pgfId-1096872]Verifies that client MMP headers are well-formed. Upon detection of a malformed header, the TCP session is terminated. 

 
      		 [bookmark: pgfId-1096873]Verifies that client to server MMP header lengths are not exceeded. If an MMP header length is exceeded (4096), then the TCP session is terminated. 

 
      		 [bookmark: pgfId-1096874]Verifies that client to server MMP content lengths are not exceeded. If an entity content length is exceeded (4096), the TCP session is terminated. 

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1096875]Note 4096 is the value currently used in MMP implementations.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1096876]Because MMP headers and entities can be split across packets, the ASA buffers data to ensure consistent inspection. The SAPI (stream API) handles data buffering for pending inspection opportunities. MMP header text is treated as case insensitive and a space is present between header text and values. Reclaiming of MMP state is performed by monitoring the state of the TCP connection. 

 
    
 
     
      [bookmark: pgfId-1096877][bookmark: 98305]Mobility Advantage Proxy Deployment Scenarios[bookmark: marker-1139940]

 
     [bookmark: pgfId-1096884]Figure 19-2 and Figure 19-3 show the two deployment scenarios for the TLS proxy used by the Cisco Mobility Advantage solution. In scenario 1 (the recommended deployment architecture), the ASA functions as both the firewall and TLS proxy. In scenario 2, the ASA functions as the TLS proxy only and works with an existing firewall. In both scenarios, the clients connect from the Internet. 

 
     [bookmark: pgfId-1096885]In the scenario 1 deployment, the ASA is between a Cisco UMA client and a Cisco UMA server. The Cisco UMA client is an executable that is downloaded to each smartphone. The Cisco UMA client applications establishes a data connection, which is a TLS connection, to the corporate Cisco UMA server. The ASA intercepts the connections and inspects the data that the client sends to the Cisco UMA server. 

 
     [bookmark: pgfId-1096888]Figure 19-2 The TLS proxy for the Cisco Mobility Advantage solution does not support client authentication because the Cisco UMA client cannot present a certificate. [bookmark: 75451]Security Appliance as Firewall with Mobility Advantage Proxy and MMP Inspection

 
     [bookmark: pgfId-1124887] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1096897]In Figure 19-2, the ASA performs static NAT by translating the Cisco UMA server 10.1.1.2 IP address to 192.0.2.140. 

 
     [bookmark: pgfId-1096901]Figure 19-3 shows deployment scenario 2, where the ASA functions as the TLS proxy only and does not function as the corporate firewall. In this scenario, the ASA and the corporate firewall are performing NAT. The corporate firewall will not be able to predict which client from the Internet needs to connect to the corporate Cisco UMA server. Therefore, to support this deployment, you can take the following actions: 

 
      
      		 [bookmark: pgfId-1096902]Set up a[bookmark: marker-1139941] NAT rule for inbound traffic that translates the destination IP address 192.0.2.41 to 172.16.27.41. 

 
      		 [bookmark: pgfId-1096903]Set up an interface PAT rule for inbound traffic translating the source IP address of every packet so that the corporate firewall does not need to open up a wildcard pinhole. The Cisco UMA server receives packets with the source IP address 192.0.12.183.

 
     

 
     [bookmark: pgfId-1243706]See Chapter 4, “Configuring Network Object NAT (ASA 8.3 and Later)” and Chapter 5, “Configuring Twice NAT (ASA 8.3 and Later)” for information. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1096906]Note This interface PAT rule converges the Cisco UMA client IP addresses on the outside interface of the ASA into a single IP address on the inside interface by using different source ports. Performing this action is often referred as “outside PAT”. “Outside PAT” is not recommended when TLS proxy for Cisco Mobility Advantage is enabled on the same interface of the ASA with phone proxy, Cisco Unified Presence, or any other features involving application inspection. “Outside PAT” is not supported completely by application inspection when embedded address translation is needed.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1096908]Figure 19-3 [bookmark: 69943]Cisco UMC/Cisco UMA Architecture – Scenario 2: Security Appliance as Mobility Advantage Proxy Only

 
     [bookmark: pgfId-1123105] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1096913]Mobility Advantage Proxy Using NAT/PAT[bookmark: marker-1139944]

 
     [bookmark: pgfId-1096920]In both scenarios (Figure 19-2 and Figure 19-3), NAT can be used to hide the private address of the Cisco UMA servers.

 
     [bookmark: pgfId-1096924]In scenario 2 (Figure 19-3), PAT can be used to converge all client traffic into one source IP, so that the firewall does not have to open up a wildcard pinhole for inbound traffic.

 
    
 
     
      [bookmark: pgfId-1096929][bookmark: 52523]Trust Relationships for Cisco UMA Deployments[bookmark: marker-1139945] [bookmark: marker-1139946][bookmark: marker-1139947][bookmark: marker-1140000]

 
     [bookmark: pgfId-1096930]To establish a trust relationship between the Cisco UMC client and the ASA, the ASA uses the Cisco UMA server certificate and keypair or the ASA obtains a certificate with the Cisco UMA server FQDN (certificate impersonation). Between the ASA and the Cisco UMA server, the ASA and Cisco UMA server use self-signed certificates or certificates issued by a local certificate authority. 

 
     [bookmark: pgfId-1096934]Figure 19-4 shows how you can import the Cisco UMA server certificate onto the ASA. When the Cisco UMA server has already enrolled with a third-party CA, you can import the certificate with the private key onto the ASA. Then, the ASA has the full credentials of the Cisco UMA server. When a Cisco UMA client connects to the Cisco UMA server, the ASA intercepts the handshake and uses the Cisco UMA server certificate to perform the handshake with the client. The ASA also performs a handshake with the server. 

 
     [bookmark: pgfId-1096936]Figure 19-4 [bookmark: 50228]How the Security Appliance Represents Cisco UMA – Private Key Sharing

 
     [bookmark: pgfId-1129588] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1138683] 

 
     [bookmark: pgfId-1096948]Figure 19-5 shows another way to establish the trust relationship. Figure 19-5 shows a green field deployment, because each component of the deployment has been newly installed. The ASA enrolls with the third-party CA by using the Cisco UMA server FQDN as if the ASA is the Cisco UMA server. When the Cisco UMA client connects to the ASA, the ASA presents the certificate that has the Cisco UMA server FQDN. The Cisco UMA client believes it is communicating to with the Cisco UMA server. 

 
     [bookmark: pgfId-1096950]Figure 19-5 [bookmark: 32276]How the Security Appliance Represents Cisco UMA – Certificate Impersonation

 
     [bookmark: pgfId-1130626] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1106934]A trusted relationship between the ASA and the Cisco UMA server can be established with self-signed certificates. The ASA's identity certificate is exported, and then uploaded on the Cisco UMA server truststore. The Cisco UMA server certificate is downloaded, and then uploaded on the ASA truststore by creating a trustpoint and using the crypto ca authenticate command.

 
    
 
   
 
    
     [bookmark: pgfId-1235431][bookmark: 48492]Licensing for the Cisco Mobility Advantage Proxy Feature[bookmark: marker-1235429] [bookmark: marker-1235430]

 
    [bookmark: pgfId-1242172]The Cisco Unified Communications proxy features (Cisco Phone Proxy, TLS proxy for encrypted voice inspection, and the Cisco Presence Federation Proxy) supported by the ASA require a Unified Communications Proxy license. However, in Version 8.2(2) and later, the Mobility Advantage proxy no longer requires a Unified Communications Proxy license.

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1337412]Model 
         
  
        		 
          
          [bookmark: pgfId-1337414]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1337416]All models

  
        		[bookmark: pgfId-1337418]Base License.

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1242230]For more information about licensing, see “Managing Feature Licenses,” in the general operations configuration guide.

 
   
 
    
     [bookmark: pgfId-1236055][bookmark: 41763]Configuring Cisco Mobility Advantage 

 
    [bookmark: pgfId-1236122]This section includes the following topic:

 
     
     		 [bookmark: pgfId-1235996]Task Flow for Configuring Cisco Mobility Advantage

 
    

 
     
      [bookmark: pgfId-1236106][bookmark: 99185]Task Flow for Configuring Cisco Mobility Advantage

 
     [bookmark: pgfId-1236090]To configure for the ASA to perform TLS proxy and MMP inspection as shown in Figure 19-2 and Figure 19-3, perform the following tasks. 

 
     [bookmark: pgfId-1235989]It is assumed that self-signed certificates are used between the ASA and the Cisco UMA server.

 
     [bookmark: pgfId-1332064]To configure the Cisco Mobility Advantage Proxy by using ASDM, choose Wizards > Unified Communications Wizard from the menu. The Unified Communications Wizard opens. From the first page, select the Cisco Mobility Advantage Proxy option under the Remote Access section. 

 
     [bookmark: pgfId-1332065]The wizard automatically creates the necessary TLS proxy, then guides you through creating the Unified Presence Proxy instance, importing and installing the required certificates, and finally enables the MMP inspection for the Mobility Advantage traffic automatically. 

 
     [bookmark: pgfId-1332066]The wizard guides you through four steps to create the Mobility Advantage Proxy:

 
     
 
     [bookmark: pgfId-1332067]Step 1 Select the Mobility Advantage Proxy option.

 
     [bookmark: pgfId-1332068]Step 2 Specify setting to define the proxy topology, such the IP address of the Mobility Advantage server.

 
     [bookmark: pgfId-1332069]Step 3 Configure the server-side certificate management, namely the certificates that are exchanged between the local Mobility Advantage server and the ASA.

 
     [bookmark: pgfId-1332073]Step 4 Configure the client-side certificate management, namely the certificates that are exchanged between the Unified Mobile Communicator and the ASA

 
     [bookmark: pgfId-1332077]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1332078]The wizard completes by displaying a summary of the configuration created for Mobility Advantage Proxy. See Chapter 16, “Using the Cisco Unified Communication Wizard” for more information. 

 
    
 
   
 
    
     [bookmark: pgfId-1235702][bookmark: 94255]Feature History for Cisco Mobility Advantage

 
    [bookmark: pgfId-1239032]Table 19-1 lists the release history for this feature.

 
    [bookmark: pgfId-1239056] 

 
     
      
       
       [bookmark: pgfId-1239039]Table 19-1 [bookmark: 12416]Feature History for Cisco Phone Proxy 

 
       
       
        
        		 
          
          [bookmark: pgfId-1239045]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1239047]Releases 
         
  
        		 
          
          [bookmark: pgfId-1239049]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1239051]Cisco Mobility Advantage Proxy

  
        		[bookmark: pgfId-1239053]8.0(4)

  
        		[bookmark: pgfId-1239055]The Cisco Mobility Advantage Proxy feature was introduced.

  
       

 
        
        		[bookmark: pgfId-1249392]Cisco Mobility Advantage Proxy

  
        		[bookmark: pgfId-1249394]8.3(1)
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     [bookmark: pgfId-1050709][bookmark: 63868]Configuring the T LS Proxy for Encrypted Voice Inspection 
      
      
 
     
 

 
    [bookmark: pgfId-1050727]This chapter describes how to configure the ASA for the TLS Proxy for Encrypted Voice Inspection feature.

 
    [bookmark: pgfId-1051135]This chapter includes the following sections: 

 
     
     		 [bookmark: pgfId-1222110]Information about the TLS Proxy for Encrypted Voice Inspection

 
     		 [bookmark: pgfId-1234542]Licensing for the TLS Proxy

 
     		 [bookmark: pgfId-1235827]Prerequisites for the TLS Proxy for Encrypted Voice Inspection

 
     		 [bookmark: pgfId-1235223]Configuring the TLS Proxy for Encrypted Voice Inspection

 
     		 [bookmark: pgfId-1235259]Feature History for the TLS Proxy for Encrypted Voice Inspection

 
    

 
   
 
    
     [bookmark: pgfId-1236230] Information about the TLS Proxy for Encrypted Voice Inspection [bookmark: 42585]

 
    [bookmark: pgfId-1236232]End-to-end encryption often leaves network security appliances “blind” to media and signaling traffic, which can compromise access control and threat prevention security functions. This lack of visibility can result in a lack of interoperability between the firewall functions and the encrypted voice, leaving businesses unable to satisfy both of their key security requirements.

 
    [bookmark: pgfId-1234582]The ASA is able to intercept and decrypt encrypted signaling from Cisco encrypted endpoints to the Cisco Unified Communications Manager (Cisco UCM), and apply the required threat protection and access control. It can also ensure confidentiality by re-encrypting the traffic onto the Cisco UCM servers. 

 
    [bookmark: pgfId-1234586]Typically, the ASA TLS Proxy functionality is deployed in campus unified communications network. This solution is ideal for deployments that utilize end to end encryption and firewalls to protect Unified Communications Manager servers.

 
    [bookmark: pgfId-1477864]The security appliance in Figure 18-1 serves as a proxy for both client and server, with Cisco IP Phone and Cisco UCM interaction.

 
    [bookmark: pgfId-1477869]Figure 18-1 [bookmark: 15378]TLS Proxy Flow

 
     
     [image: ] 
    
 
    [bookmark: pgfId-1236077] 

 
     
      [bookmark: pgfId-1236242][bookmark: 93148]Decryption and Inspection of Unified Communications Encrypted Signaling 

 
     [bookmark: pgfId-1221387]With encrypted voice inspection, the security appliance decrypts, inspects and modifies (as needed, for example, performing NAT fixup), and re-encrypts voice signaling traffic while all of the existing VoIP inspection functions for Skinny and SIP protocols are preserved. Once voice signaling is decrypted, the plaintext signaling message is passed to the existing inspection engines. 

 
     [bookmark: pgfId-1221388]The security appliance acts as a TLS proxy between the Cisco IP Phone and Cisco UCM. The proxy is transparent for the voice calls between the phone and theCisco UCM. Cisco IP Phones download a Certificate Trust List from the Cisco UCM before registration which contains identities (certificates) of the devices that the phone should trust, such as TFTP servers and Cisco UCM servers. To support server proxy, the CTL file must contain the certificate that the security appliance creates for the Cisco UCMs. To proxy calls on behalf of the Cisco IP Phone, the security appliance presents a certificate that the Cisco UCM can verify, which is a Local Dynamic Certificate for the phone, issued by the certificate authority on the security appliance.

 
     [bookmark: pgfId-1221389]TLS proxy is supported by the Cisco Unified CallManager Release 5.1 and later. You should be familiar with the security features of the Cisco UCM. For background and detailed description of Cisco UCM security, see the Cisco Unified CallManager document:

 
     [bookmark: pgfId-1221391]http://www.cisco.com/univercd/cc/td/doc/product/voice/c_callmg/5_0/sec_vir/ae/sec504/index.htm

 
     [bookmark: pgfId-1221392]TLS proxy applies to the encryption layer and must be configured with an application layer protocol inspection. You should be familiar with the inspection features on the ASA, especially Skinny and SIP inspection. 

 
    
 
     
      [bookmark: pgfId-1432358]Supported Cisco UCM and IP Phones for the TLS Proxy

 
     [bookmark: pgfId-1432360]Cisco Unified Communications Manager[bookmark: marker-1432359]

 
     [bookmark: pgfId-1432361]The following releases of the Cisco Unified Communications Manager are supported with the TLS proxy: 

 
      
      		 [bookmark: pgfId-1432362]Cisco Unified CallManager Version 4. x 

 
      		 [bookmark: pgfId-1432363]Cisco Unified CallManager Version 5.0

 
      		 [bookmark: pgfId-1432364]Cisco Unified CallManager Version 5.1

 
      		 [bookmark: pgfId-1432365]Cisco Unified Communications Manager 6.1

 
      		 [bookmark: pgfId-1432366]Cisco Unified Communications Manager 7.0

 
      		 [bookmark: pgfId-1432367]Cisco Unified Communications Manager 8.0

 
     

 
     [bookmark: pgfId-1432370]Cisco Unified IP Phones[bookmark: marker-1432368][bookmark: marker-1432369]

 
     [bookmark: pgfId-1432371]The following IP phones in the Cisco Unified IP Phones 7900 Series are supported with the TLS proxy:

 
      
      		 [bookmark: pgfId-1432372]Cisco Unified IP Phone 7985

 
      		 [bookmark: pgfId-1432373]Cisco Unified IP Phone 7975

 
      		 [bookmark: pgfId-1432374]Cisco Unified IP Phone 7971

 
      		 [bookmark: pgfId-1432375]Cisco Unified IP Phone 7970

 
      		 [bookmark: pgfId-1432376]Cisco Unified IP Phone 7965

 
      		 [bookmark: pgfId-1432377]Cisco Unified IP Phone 7962

 
      		 [bookmark: pgfId-1432378]Cisco Unified IP Phone 7961

 
      		 [bookmark: pgfId-1432379]Cisco Unified IP Phone 7961G-GE

 
      		 [bookmark: pgfId-1432380]Cisco Unified IP Phone 7960

 
      		 [bookmark: pgfId-1432381]Cisco Unified IP Phone 7945

 
      		 [bookmark: pgfId-1432382]Cisco Unified IP Phone 7942

 
      		 [bookmark: pgfId-1432383]Cisco Unified IP Phone 7941

 
      		 [bookmark: pgfId-1432384]Cisco Unified IP Phone 7941G-GE

 
      		 [bookmark: pgfId-1432385]Cisco Unified IP Phone 7940

 
      		 [bookmark: pgfId-1432386]Cisco Unified Wireless IP Phone 7921

 
      		 [bookmark: pgfId-1432387]Cisco Unified Wireless IP Phone 7925 

 
      		 [bookmark: pgfId-1432388]Cisco IP Communicator (CIPC) for softphones 

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1234780][bookmark: 84219][bookmark: 45660]Licensing for the TLS Proxy [bookmark: marker-1234778][bookmark: marker-1234779]

 
    [bookmark: pgfId-1234784]The TLS proxy for encrypted voice inspection feature supported by the ASA require a Unified Communications Proxy license. 

 
    [bookmark: pgfId-1234793]The following table shows the Unified Communications Proxy license details by platform:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1480562]Note This feature is not available on No Payload Encryption models.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1480658] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1480565]Model 
         
  
        		 
          
          [bookmark: pgfId-1480574]License Requirement 
          1 
         
  
       

 
        
        		[bookmark: pgfId-1480576]ASA 5505

  
        		[bookmark: pgfId-1480578]Base License and Security Plus License: 2 sessions.

 [bookmark: pgfId-1480579]Optional license: 24 sessions.

  
       

 
        
        		[bookmark: pgfId-1480581]ASA 5510

  
        		[bookmark: pgfId-1480583]Base License and Security Plus License: 2 sessions.

 [bookmark: pgfId-1480584]Optional licenses: 24, 50, or 100 sessions.

  
       

 
        
        		[bookmark: pgfId-1480586]ASA 5520

  
        		[bookmark: pgfId-1480588]Base License: 2 sessions.

 [bookmark: pgfId-1480589]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480591]ASA 5540

  
        		[bookmark: pgfId-1480593]Base License: 2 sessions.

 [bookmark: pgfId-1480594]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480596]ASA 5550

  
        		[bookmark: pgfId-1480598]Base License: 2 sessions.

 [bookmark: pgfId-1480599]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480601]ASA 5580

  
        		[bookmark: pgfId-1480603]Base License: 2 sessions.

 [bookmark: pgfId-1480608]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
        
        		[bookmark: pgfId-1480610]ASA 5512-X

  
        		[bookmark: pgfId-1480612]Base License: 2 sessions.

 [bookmark: pgfId-1480613]Optional licenses: 24, 50, 100, 250, or 500 sessions.

  
       

 
        
        		[bookmark: pgfId-1480615]ASA 5515-X

  
        		[bookmark: pgfId-1480617]Base License: 2 sessions.

 [bookmark: pgfId-1480618]Optional licenses: 24, 50, 100, 250, or 500 sessions.

  
       

 
        
        		[bookmark: pgfId-1480620]ASA 5525-X

  
        		[bookmark: pgfId-1480622]Base License: 2 sessions.

 [bookmark: pgfId-1480623]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480625]ASA 5545-X

  
        		[bookmark: pgfId-1480627]Base License: 2 sessions.

 [bookmark: pgfId-1480628]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480630]ASA 5555-X

  
        		[bookmark: pgfId-1480632]Base License: 2 sessions.

 [bookmark: pgfId-1480633]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480635]ASA 5585-X with SSP-10

  
        		[bookmark: pgfId-1480637]Base License: 2 sessions.

 [bookmark: pgfId-1480638]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1480640]ASA 5585-X with SSP-20, -40, or -60

  
        		[bookmark: pgfId-1480642]Base License: 2 sessions.

 [bookmark: pgfId-1480646]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
        
        		[bookmark: pgfId-1480651]ASASM

  
        		[bookmark: pgfId-1480653]Base License: 2 sessions.

 [bookmark: pgfId-1480657]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
       
     

 
    
 
     
      
       
       		 1.[bookmark: pgfId-1480570][bookmark: 98139]The following applications use TLS proxy sessions for their connections. Each TLS proxy session used by these applications (and only these applications) is counted against the UC license limit:
- Phone Proxy
- Presence Federation Proxy
- Encrypted Voice Inspection

Other applications that use TLS proxy sessions do not count towards the UC limit, for example, Mobility Advantage Proxy (which does not require a license) and IME (which requires a separate IME license).

Some UC applications might use multiple sessions for a connection. For example, if you configure a phone with a primary and backup Cisco Unified Communications Manager, there are 2 TLS proxy connections, so 2 UC Proxy sessions are used.

You independently set the TLS proxy limit using the Configuration > Firewall > Unified Communications > TLS Proxy pane. When you apply a UC license that is higher than the default TLS proxy limit, the ASA automatically sets the TLS proxy limit to match the UC limit. The TLS proxy limit takes precedence over the UC license limit; if you set the TLS proxy limit to be less than the UC license, then you cannot use all of the sessions in your UC license.

Note: For license part numbers ending in “K8” (for example, licenses under 250 users), TLS proxy sessions are limited to 1000. For license part numbers ending in “K9” (for example, licenses 250 users or larger), the TLS proxy limit depends on the configuration, up to the model limit. K8 and K9 refer to whether the license is restricted for export: K8 is unrestricted, and K9 is restricted.

Note: If you clear the configuration, then the TLS proxy limit is set to the default for your model; if this default is lower than the UC license limit, then you see an error message to use the to raise the limit again (in ASDM, use the TLS Proxy pane). If you use failover and use File > Save Running Configuration to Standby Unit on the primary unit to force a configuration synchronization, the clear configure all command is generated on the secondary unit automatically, so you may see the warning message on the secondary unit. Because the configuration synchronization restores the TLS proxy limit set on the primary unit, you can ignore the warning.

You might also use SRTP encryption sessions for your connections:
- For K8 licenses, SRTP sessions are limited to 250.
- For K9 licenses, there is not limit.

Note: Only calls that require encryption/decryption for media are counted towards the SRTP limit; if passthrough is set for the call, even if both legs are SRTP, they do not count towards the limit.

 2.[bookmark: pgfId-1480607][bookmark: 21190]With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of Phone Proxy sessions is 5000.

  
      

 
      
    

 
    [bookmark: pgfId-1285087]Table 18-1 shows the default and maximum TLS session details by platform. 

 
    [bookmark: pgfId-1285138] 

 
     
      
       
       [bookmark: pgfId-1285091]Table 18-1 [bookmark: 64493]Default and Maximum TLS Sessions on the Security Appliance

 
       
       
        
        		 
          
          [bookmark: pgfId-1285097]Security Appliance Platform 
         
  
        		 
          
          [bookmark: pgfId-1285099]Default TLS Sessions 
         
  
        		 
          
          [bookmark: pgfId-1285101]Maximum TLS Sessions 
         
  
       

 
        
        		[bookmark: pgfId-1285103]ASA 5505

  
        		[bookmark: pgfId-1285105]10

  
        		[bookmark: pgfId-1285107]80

  
       

 
        
        		[bookmark: pgfId-1285109]ASA 5510

  
        		[bookmark: pgfId-1285111]100

  
        		[bookmark: pgfId-1285113]200

  
       

 
        
        		[bookmark: pgfId-1285115]ASA 5520

  
        		[bookmark: pgfId-1285117]300

  
        		[bookmark: pgfId-1285119]1200

  
       

 
        
        		[bookmark: pgfId-1285121]ASA 5540

  
        		[bookmark: pgfId-1285123]1000

  
        		[bookmark: pgfId-1285125]4500

  
       

 
        
        		[bookmark: pgfId-1285127]ASA 5550

  
        		[bookmark: pgfId-1285129]2000

  
        		[bookmark: pgfId-1285131]4500

  
       

 
        
        		[bookmark: pgfId-1285133]ASA 5580

  
        		[bookmark: pgfId-1285135]4000

  
        		[bookmark: pgfId-1285137]13,000

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1285078]For more information about licensing, see “Managing Feature Licenses,” in the general operations configuration guide.

 
   
 
    
     [bookmark: pgfId-1235743][bookmark: 30453]Prerequisites for the TLS Proxy for Encrypted Voice Inspection

 
    [bookmark: pgfId-1235757]Before configuring TLS proxy, the following prerequisites are required:

 
     
     		 [bookmark: pgfId-1235758]You must set clock on the security appliance before configuring TLS proxy. To set the clock manually and display clock, use the clock set and show clock commands. We recommend that the security appliance use the same NTP server as the Cisco Unified CallManager cluster. TLS handshake may fail due to certificate validation failure if clock is out of sync between the security appliance and the Cisco Unified CallManager server.

 
     		 [bookmark: pgfId-1235759]3DES-AES license is needed to interoperate with the Cisco Unified CallManager. AES is the default cipher used by the Cisco Unified CallManager and Cisco IP Phone.

 
     		 [bookmark: pgfId-1236499]Import the following certificates which are stored on the Cisco UCM. These certificates are required by the ASA for the phone proxy. 

 
    

 
    [bookmark: pgfId-1236503] – Cisco_Manufacturing_CA

 
    [bookmark: pgfId-1236504] – CAP-RTP-001

 
    [bookmark: pgfId-1236505] – CAP-RTP-002

 
    [bookmark: pgfId-1236506] – CAPF certificate (Optional)

 
    [bookmark: pgfId-1236507]If LSC provisioning is required or you have LSC enabled IP phones, you must import the CAPF certificate from the Cisco UCM. If the Cisco UCM has more than one CAPF certificate, you must import all of them to the ASA.

 
    [bookmark: pgfId-1236514]See Chapter17, “Configuring the Cisco Phone Proxy”For example, the CA Manufacturer certificate is required by the phone proxy to validate the IP phone certificate. 

 
   
 
    
     [bookmark: pgfId-1235316][bookmark: 97365]Configuring the TLS Proxy for Encrypted Voice Inspection

 
    [bookmark: pgfId-1236761]This section includes the following topics:

 
     
     		 [bookmark: pgfId-1469610]Configure TLS Proxy Pane

 
     		 [bookmark: pgfId-1469614]Adding a TLS Proxy Instance

 
     		 [bookmark: pgfId-1469618]Add TLS Proxy Instance Wizard – Server Configuration

 
     		 [bookmark: pgfId-1469622]Add TLS Proxy Instance Wizard – Client Configuration

 
     		 [bookmark: pgfId-1469626]Add TLS Proxy Instance Wizard – Other Steps

 
     		 [bookmark: pgfId-1469630]Edit TLS Proxy Instance – Server Configuration

 
     		 [bookmark: pgfId-1469634]Edit TLS Proxy Instance – Client Configuration

 
    

 
   
 
    
     [bookmark: pgfId-1469640][bookmark: 13147][bookmark: 79997][bookmark: 78013]CTL Provider

 
    [bookmark: pgfId-1469641]Use the CTL Provider option to configure Certificate Trust List provider service. 

 
    [bookmark: pgfId-1469642]The CTL Provider pane lets you define and configure Certificate Trust List provider service to enable inspection of encrypted traffic.

 
    [bookmark: pgfId-1469643]Fields

 
     
     		 [bookmark: pgfId-1469644]CTL Provider Name—Lists the CTL Provider name.

 
     		 [bookmark: pgfId-1469645]Client Details—Lists the name and IP address of the client.

 
    

 
    [bookmark: pgfId-1469646] – Interface Name—Lists the defined interface name.

 
    [bookmark: pgfId-1469647] – IP Address—Lists the defined interface IP address.

 
     
     		 [bookmark: pgfId-1469648]Certificate Name—Lists the certificate to be exported.

 
     		 [bookmark: pgfId-1469649]Add—Adds a CTL Provider.

 
     		 [bookmark: pgfId-1469650]Edit—Edits a CTL Provider.

 
     		 [bookmark: pgfId-1469651]Delete—Deletes a CTL Provider.

 
    

 
     
      [bookmark: pgfId-1469654][bookmark: 28177]Add/Edit CTL Provider

 
     [bookmark: pgfId-1469655]The Add/Edit CTL Provider dialog box lets you define the parameters for the CTL Provider.

 
     [bookmark: pgfId-1469656]Fields

 
      
      		 [bookmark: pgfId-1469657]CTL Provider Name—Specifies the CTL Provider name.

 
      		 [bookmark: pgfId-1469658]Certificate to be Exported—Specifies the certificate to be exported to the client.

 
     

 
     [bookmark: pgfId-1469659] – Certificate Name—Specifies the name of the certificate to be exported to the client. 

 
     [bookmark: pgfId-1469660] – Manage—Manages identity certificates. 

 
      
      		 [bookmark: pgfId-1469661]Client Details—Specifies the clients allowed to connect.

 
     

 
     [bookmark: pgfId-1469662] – Client to be Added—Specifies the client interface and IP address to add to the client list.

 
     [bookmark: pgfId-1469663]Interface—Specifies client interface.

 
     [bookmark: pgfId-1469664]IP Address—Specifies the client IP address.

 
     [bookmark: pgfId-1469665]Add—Adds the new client to the client list.

 
     [bookmark: pgfId-1469666]Delete—Deletes the selected client from the client list.

 
      
      		 [bookmark: pgfId-1469667]More Options—Specifies the available and active algorithms to be announced or matched during the TLS handshake.

 
     

 
     [bookmark: pgfId-1469668] – Parse the CTL file provided by the CTL Client and install trustpoints—Trustpoints installed by this option have names prefixed with “_internal_CTL_.” If disabled, each Call Manager server and CAPF certificate must be manually imported and installed.

 
     [bookmark: pgfId-1469669] – Port Number—Specifies the port to which the CTL provider listens. The port must be the same as the one listened to by the CallManager servers in the cluster (as configured under Enterprise Parameters on the CallManager administration page). The default is 2444.

 
     [bookmark: pgfId-1469670] – Authentication—Specifies the username and password that the client authenticates with the provider.

 
     [bookmark: pgfId-1469671]Username—Client username.

 
     [bookmark: pgfId-1469672]Password—Client password.

 
     [bookmark: pgfId-1469673]Confirm Password—Client password.

 
     [bookmark: pgfId-1469674] 

 
    
 
     
      [bookmark: pgfId-1469681][bookmark: 11933]Configure TLS Proxy Pane

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469682]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469683]You can configure the TLS Proxy from the Configuration > Firewall > Unified Communications > TLS Proxy pane.

 
     [bookmark: pgfId-1469684]Configuring a TLS Proxy lets you use the TLS Proxy to enable inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco Call Manager and enable the ASA for the Cisco Unified Communications features:

 
      
      		 [bookmark: pgfId-1469688]TLS Proxy for the Cisco Unified Presence Server (CUPS), part of Presence Federation

 
      		 [bookmark: pgfId-1469689]TLS Proxy for the Cisco Unified Mobility Advantage (CUMA) server, part of Mobile Advantage

 
      		 [bookmark: pgfId-1469690]Phone Proxy

 
     

 
     [bookmark: pgfId-1469691]Fields

 
      
      		 [bookmark: pgfId-1469692]TLS Proxy Name—Lists the TLS Proxy name.

 
      		 [bookmark: pgfId-1469693]Server Proxy Certificate—Lists the trustpoint, which is either self-signed or enrolled with a certificate server. 

 
      		 [bookmark: pgfId-1469694]Local Dynamic Certificate Issuer—Lists the local certificate authority to issue client or server dynamic certificates.

 
      		 [bookmark: pgfId-1469698]Client Proxy Certificate—Lists the proxy certificate for the TLS client. The ASA uses the client proxy certificate to authenticate the TLS client during the handshake between the proxy and the TLS client. The certificate can be either self-signed, enrolled with a certificate authority, or issued by the third party.

 
      		 [bookmark: pgfId-1469701]Add—Adds a TLS Proxy by launching the Add TLS Proxy Instance Wizard. See Adding a TLS Proxy Instance for the steps to create a TLS Proxy instance. 

 
      		 [bookmark: pgfId-1469703]Edit—Edits a TLS Proxy. The fields in the Edit panel area identical to the fields displayed when you add a TLS Proxy instance. See Edit TLS Proxy Instance – Server Configuration and Edit TLS Proxy Instance – Client Configuration. 

 
      		 [bookmark: pgfId-1469710]Delete—Deletes a TLS Proxy.

 
      		 [bookmark: pgfId-1469711]Maximum Sessions—Lets you specify the maximum number of TLS Proxy sessions to support.

 
     

 
     [bookmark: pgfId-1469712] – Specify the maximum number of TLS Proxy sessions that the ASA needs to support.

 
     [bookmark: pgfId-1469713] – Maximum number of sessions—The minimum is 1. The maximum is dependent on the platform:

 
     [bookmark: pgfId-1469714]Cisco ASA 5505 security appliance: 10

 
     [bookmark: pgfId-1469718]Cisco ASA 5510 security appliance: 100

 
     [bookmark: pgfId-1469722]Cisco ASA 5520 security appliance: 300

 
     [bookmark: pgfId-1469726]Cisco ASA 5540 security appliance: 1000

 
     [bookmark: pgfId-1469727]Cisco ASA 5550 security appliance: 2000

 
     [bookmark: pgfId-1469728]Cisco ASA 5580 security appliance: 4000

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469729]Note The maximum number of sessions is global to all TLS proxy sessions.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1469732][bookmark: 21673]Adding a TLS Proxy Instance

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469733]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469734]Use the Add TLS Proxy Instance Wizard to add a TLS Proxy to enable inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco Call Manager and to support the Cisco Unified Communications features on the ASA.

 
     [bookmark: pgfId-1469738]This wizard is available from the Configuration > Firewall > Unified Communications > TLS Proxy pane. 

 
     
 
     [bookmark: pgfId-1469739]Step 1 Open the Configuration > Firewall > Unified Communications > TLS Proxy pane. 

 
     [bookmark: pgfId-1469740]Step 2 To add a new TLS Proxy Instance, click Add.

 
     [bookmark: pgfId-1469741]The Add TLS Proxy Instance Wizard opens. 

 
     [bookmark: pgfId-1469742]Step 3 In the TLS Proxy Name field, type the TLS Proxy name. 

 
     [bookmark: pgfId-1469743]Step 4 Click Next. 

 
     [bookmark: pgfId-1469744]The Add TLS Proxy Instance Wizard – Server Configuration dialog box opens. In this step of the wizard, configure the server proxy parameters for original TLS Server—the Cisco Unified Call Manager (CUCM) server, the Cisco Unified Presence Server (CUPS), or the Cisco Unified Mobility Advantage (CUMA) server. See Add TLS Proxy Instance Wizard – Server Configuration. 

 
     [bookmark: pgfId-1469748]After configuring the server proxy parameters, the wizard guides you through configuring client proxy parameters (see Add TLS Proxy Instance Wizard – Client Configuration) and provides instructions on the steps to complete outside the ASDM to make the TLS Proxy fully functional (see Add TLS Proxy Instance Wizard – Other Steps). 

 
     [bookmark: pgfId-1469755]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1469758][bookmark: 19764]Add TLS Proxy Instance Wizard – Server Configuration

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469759]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469760]Use the Add TLS Proxy Instance Wizard to add a TLS Proxy to enable inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco Call Manager and to support the Cisco Unified Communications features on the ASA.

 
     [bookmark: pgfId-1469764]The Add TLS Proxy Instance Wizard is available from the Configuration > Firewall > Unified Communications > TLS Proxy pane. 

 
     
 
     [bookmark: pgfId-1469767]Step 1 Complete the first step of the Add TLS Proxy Instance Wizard. See Adding a TLS Proxy Instance. 

 
     [bookmark: pgfId-1469769]The Add TLS Proxy Instance Wizard – Server Configuration dialog box opens.

 
     [bookmark: pgfId-1469770]Step 2 Specify the server proxy certificate by doing one of the following:

 
      
       
       		 [bookmark: pgfId-1469771]To add a new certificate, click  Manage . The Manage Identify Certificates dialog box opens. 

 
      

 
     

 
     [bookmark: pgfId-1469772]When the Phone Proxy is operating in a mixed-mode CUCM cluster, you must import the CUCM certificate by clicking Add in the Manage Identify Certificates dialog box. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide. 

 
      
       
       		 [bookmark: pgfId-1469779]To select an existing certificate, select one from the drop-down list. 

 
      

 
     

 
     [bookmark: pgfId-1469780]When you are configuring the TLS Proxy for the Phone Proxy, select the certificate that has a filename beginning with _internal_PP_. When you create the CTL file for the Phone Proxy, the ASA, creates an internal trustpoint used by the Phone Proxy to sign the TFTP files. The trustpoint is named _internal_PP_ctl-instance_filename. 

 
     [bookmark: pgfId-1469784]The server proxy certificate is used to specify the trustpoint to present during the TLS handshake. The trustpoint can be self-signed or enrolled locally with the certificate service on the proxy. For example, for the Phone Proxy, the server proxy certificate is used by the Phone Proxy during the handshake with the IP phones.

 
     [bookmark: pgfId-1469791]Step 3 To install the TLS server certificate in the ASA trust store, so that the ASA can authenticate the TLS server during TLS handshake between the proxy and the TLS server, click Install TLS Server’s Certificate.

 
     [bookmark: pgfId-1469794]The Manage CA Certificates dialog box opens. See the “Guidelines and Limitations” section in the general operations configuration guide. Click Add to open the Install Certificate dialog box. See the “Adding or Installing a CA Certificate” section in the general operations configuration guide. 

 
     [bookmark: pgfId-1469805]When you are configuring the TLS Proxy for the Phone Proxy, click Install TLS Server’s Certificate and install the Cisco Unified Call Manager (CUCM) certificate so that the proxy can authenticate the IP phones on behalf of the CUCM server. 

 
     [bookmark: pgfId-1469809]Step 4 To require the ASA to present a certificate and authenticate the TLS client during TLS handshake, check the Enable client authentication during TLS Proxy handshake check box. 

 
     [bookmark: pgfId-1469810]When adding a TLS Proxy Instance for Mobile Advantage (the CUMC client and CUMA server), disable the check box when the client is incapable of sending a client certificate.

 
     [bookmark: pgfId-1469811]Step 5 Click Next. 

 
     [bookmark: pgfId-1469812]The Add TLS Proxy Instance Wizard – Client Configuration dialog box opens. In this step of the wizard, configure the client proxy parameters for original TLS Client—the CUMC client for Mobile Advantage, CUP or MS LCS/OCS client for Presence Federation, or the IP phone for the Phone Proxy. See Add TLS Proxy Instance Wizard – Client Configuration. 

 
     [bookmark: pgfId-1469816]After configuring the client proxy parameters, the wizard provides instructions on the steps to complete outside the ASDM to make the TLS Proxy fully functional (see Add TLS Proxy Instance Wizard – Other Steps). 

 
     [bookmark: pgfId-1469820]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1469824][bookmark: 61370][bookmark: 42073]Add TLS Proxy Instance Wizard – Client Configuration

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469825]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469826]Use the Add TLS Proxy Instance Wizard to add a TLS Proxy to enable inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco Call Manager and to support the Cisco Unified Communications features on the ASA.

 
     [bookmark: pgfId-1469830]This wizard is available from the Configuration > Firewall > Unified Communications > TLS Proxy pane. 

 
     
 
     [bookmark: pgfId-1469833]Step 1 Complete the first two steps of the Add TLS Proxy Instance Wizard. See Adding a TLS Proxy Instance and Add TLS Proxy Instance Wizard – Client Configuration. 

 
     [bookmark: pgfId-1469838]The Add TLS Proxy Instance Wizard – Client Configuration dialog box opens.

 
     [bookmark: pgfId-1469839]Step 2 To specify a client proxy certificate to use for the TLS Proxy, perform the following. Select this option when the client proxy certificate is being used between two servers; for example, when configuring the TLS Proxy for Presence Federation, which uses the Cisco Unified Presence Server (CUPS), both the TLS client and TLS server are both servers. 

 
     [bookmark: pgfId-1469840] a. Check the Specify the proxy certificate for the TLS Client... check box. 

 
     [bookmark: pgfId-1469841] b. Select a certificate from the drop-down list.

 
     [bookmark: pgfId-1469842]Or

 
     [bookmark: pgfId-1469843]To create a new client proxy certificate, click Manage. The Manage Identify Certificates dialog box opens. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469850]Note When you are configuring the TLS Proxy for the Phone Proxy and it is using the mixed security mode for the CUCM cluster, you must configure the LDC Issuer. The LDC Issuer lists the local certificate authority to issue client or server dynamic certificates.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469851]Step 3 To specify an LDC Issuer to use for the TLS Proxy, perform the following. When you select and configure the LDC Issuer option, the ASA acts as the certificate authority and issues certificates to TLS clients. 

 
     [bookmark: pgfId-1469855] a. Click the Specify the internal Certificate Authority to sign the local dynamic certificate for phones... check box.

 
     [bookmark: pgfId-1469856] b. Click the Certificates radio button and select a self-signed certificate from the drop-down list or click Manage to create a new LDC Issuer. The Manage Identify Certificates dialog box opens. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide.

 
     [bookmark: pgfId-1469863]Or

 
     [bookmark: pgfId-1469864]Click the Certificate Authority radio button to specify a Certificate Authority (CA) server. When you specify a CA server, it needs to be created and enabled in the ASA. To create and enable the CA server, click Manage. The Edit CA Server Settings dialog box opens. See the “Authenticating Using the Local CA” section in the general operations configuration guide. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469874]Note To make configuration changes after the local certificate authority has been configured for the first time, disable the local certificate authority.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469875] c. In the Key-Pair Name field, select a key pair from the drop-list. The list contains the already defined RSA key pair used by client dynamic certificates. To see the key pair details, including generation time, usage, modulus size, and key data, click Show. 

 
     [bookmark: pgfId-1469876]Or 

 
     [bookmark: pgfId-1469879]To create a new key pair, click New. The Add Key Pair dialog box opens. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide for details about the Key Pair fields.

 
     [bookmark: pgfId-1469884]Step 4 In the Security Algorithms area, specify the available and active algorithms to be announced or matched during the TLS handshake.

 
      
      		 [bookmark: pgfId-1469885]Available Algorithms—Lists the available algorithms to be announced or matched during the TLS handshake: des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, and null-sha1. 

 
     

 
     [bookmark: pgfId-1469886]Add—Adds the selected algorithm to the active list.

 
     [bookmark: pgfId-1469887]Remove—Removes the selected algorithm from the active list.

 
      
      		 [bookmark: pgfId-1469888]Active Algorithms—Lists the active algorithms to be announced or matched during the TLS handshake: des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, and null-sha1. For client proxy (acting as a TLS client to the server), the user-defined algorithms replace the original ones from the hello message for asymmetric encryption method between the two TLS legs. For example, the leg between the proxy and Call Manager may be NULL cipher to offload the Call Manager.

 
     

 
     [bookmark: pgfId-1469889]Move Up—Moves an algorithm up in the list.

 
     [bookmark: pgfId-1469890]Move Down—Moves an algorithm down in the list.

 
     [bookmark: pgfId-1469891]Step 5 Click Next. 

 
     [bookmark: pgfId-1469892]The Add TLS Proxy Instance Wizard – Other Steps dialog box opens. The Other Steps dialog box provides instructions on the steps to complete outside the ASDM to make the TLS Proxy fully functional (see Add TLS Proxy Instance Wizard – Other Steps). 

 
     [bookmark: pgfId-1469896]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1469899][bookmark: 94462]Add TLS Proxy Instance Wizard – Other Steps

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469900]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469901]The last dialog box of the Add TLS Proxy Instance Wizard specifies the additional steps required to make TLS Proxy fully functional. In particular, you need to perform the following tasks to complete the TLS Proxy configuration:

 
      
      		 [bookmark: pgfId-1469902]Export the local CA certificate or LDC Issuer and install them on the original TLS server. 

 
     

 
     [bookmark: pgfId-1469903]To export the LDC Issuer, go to Configuration > Firewall > Advanced > Certificate Management > Identity Certificates > Export. See the “Exporting an Identity Certificate” section in the general operations configuration guide.

 
      
      		 [bookmark: pgfId-1469910]For the TLS Proxy, enable Skinny and SIP inspection between the TLS server and TLS clients. See SIP Inspection and Skinny (SCCP) Inspection. When you are configuring the TLS Proxy for Presence Federation (which uses CUP), you only enable SIP inspection because the feature supports only the SIP protocol.

 
      		 [bookmark: pgfId-1469917]For the TLS Proxy for CUMA, enable MMP inspection.

 
      		 [bookmark: pgfId-1469921]When using the internal Certificate Authority of the ASA to sign the LDC Issuer for TLS clients, perform the following:

 
     

 
     [bookmark: pgfId-1469922] – Use the Cisco CTL Client to add the server proxy certificate to the CTL file and install the CTL file on the ASA. 

 
     [bookmark: pgfId-1469926]For information on the Cisco CTL Client, see “Configuring the Cisco CTL Client” in Cisco Unified CallManager Security Guide.

 
     [bookmark: pgfId-1469928]http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/security/5_0_4/secuauth.html

 
     [bookmark: pgfId-1469932]To install the CTL file on the ASA, go to Configuration > Firewall > Unified Communications > CTL Provider > Add. The Add CTL Provider dialog box opens. For information on using this dialog box to install the CTL file, see Add/Edit CTL Provider. 

 
     [bookmark: pgfId-1469938] – Create a CTL provider instance for connections from the CTL clients. See Add/Edit CTL Provider. 

 
    
 
     
      [bookmark: pgfId-1469942][bookmark: 75505]Edit TLS Proxy Instance – Server Configuration

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469943]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1469944]The TLS Proxy enables inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco Call Manager and to support the Cisco Unified Communications features on the ASA.

 
     [bookmark: pgfId-1469948]Use the Edit TLS Proxy – Server Configuration tab to edit the server proxy parameters for the original TLS Server—the Cisco Unified Call Manager (CUCM) server, the Cisco Unified Presence Server (CUPS), or the Cisco Unified Mobility Advantage (CUMA) server. 

 
     
 
     [bookmark: pgfId-1469949]Step 1 Open the Configuration > Firewall > Unified Communications > TLS Proxy pane. 

 
     [bookmark: pgfId-1469950]Step 2 To edit a TLS Proxy Instance, click Edit.

 
     [bookmark: pgfId-1469951]The Edit TLS Proxy Instance dialog box opens. 

 
     [bookmark: pgfId-1469952]Step 3 If necessary, click the Server Configuration tab.

 
     [bookmark: pgfId-1469953]Step 4 Specify the server proxy certificate by doing one of the following:

 
      
       
       		 [bookmark: pgfId-1469954]To add a new certificate, click  Manage . The Manage Identify Certificates dialog box opens. 

 
      

 
     

 
     [bookmark: pgfId-1469955]When the Phone Proxy is operating in a mixed-mode CUCM cluster, you must import the CUCM certificate by clicking Add in the Manage Identify Certificates dialog box. See the “Configuring CA Certificate Authentication” section in the general operations configuration guide. 

 
      
       
       		 [bookmark: pgfId-1469962]To select an existing certificate, select one from the drop-down list. 

 
      

 
     

 
     [bookmark: pgfId-1469963]When you are configuring the TLS Proxy for the Phone Proxy, select the certificate that has a filename beginning with _internal_PP_. When you create the CTL file for the Phone Proxy, the ASA, creates an internal trustpoint used by the Phone Proxy to sign the TFTP files. The trustpoint is named _internal_PP_ctl-instance_filename. 

 
     [bookmark: pgfId-1469967]The server proxy certificate is used to specify the trustpoint to present during the TLS handshake. The trustpoint can be self-signed or enrolled locally with the certificate service on the proxy. For example, for the Phone Proxy, the server proxy certificate is used by the Phone Proxy during the handshake with the IP phones.

 
     [bookmark: pgfId-1469974]Step 5 To install the TLS server certificate in the ASA trust store, so that the ASA can authenticate the TLS server during TLS handshake between the proxy and the TLS server, click Install TLS Server’s Certificate.

 
     [bookmark: pgfId-1469977]The Manage CA Certificates dialog box opens. See the “Guidelines and Limitations” section in the general operations configuration guide. Click Add to open the Install Certificate dialog box. See the “Configuring CA Certificate Authentication” section in the general operations configuration guide. 

 
     [bookmark: pgfId-1469988]When you are configuring the TLS Proxy for the Phone Proxy, click Install TLS Server’s Certificate and install the Cisco Unified Call Manager (CUCM) certificate so that the proxy can authenticate the IP phones on behalf of the CUCM server. 

 
     [bookmark: pgfId-1469992]Step 6 To require the ASA to present a certificate and authenticate the TLS client during TLS handshake, check the Enable client authentication during TLS Proxy handshake check box. 

 
     [bookmark: pgfId-1469993]When adding a TLS Proxy Instance for Mobile Advantage (the CUMC client and CUMA server), disable the check box when the client is incapable of sending a client certificate.

 
     [bookmark: pgfId-1469994]Step 7 Click Apply to save the changes.

 
     [bookmark: pgfId-1469995]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1469998][bookmark: 10679]Edit TLS Proxy Instance – Client Configuration

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1469999]Note This feature is not supported for the Adaptive Security Appliance version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1470000]The TLS Proxy enables inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco Call Manager and to support the Cisco Unified Communications features on the ASA.

 
     [bookmark: pgfId-1470004]The fields in the Edit TLS Proxy dialog box are identical to the fields displayed when you add a TLS Proxy instance. Use the Edit TLS Proxy – Client Configuration tab to edit the client proxy parameters for the original TLS Client, such as IP phones, CUMA clients, the Cisco Unified Presence Server (CUPS), or the Microsoft OCS server. 

 
     
 
     [bookmark: pgfId-1470005]Step 1 Open the Configuration > Firewall > Unified Communications > TLS Proxy pane. 

 
     [bookmark: pgfId-1470006]Step 2 To edit a TLS Proxy Instance, click Edit.

 
     [bookmark: pgfId-1470007]The Edit TLS Proxy Instance dialog box opens. 

 
     [bookmark: pgfId-1470008]Step 3 If necessary, click the Client Configuration tab.

 
     [bookmark: pgfId-1470009]Step 4 To specify a client proxy certificate to use for the TLS Proxy, perform the following. Select this option when the client proxy certificate is being used between two servers; for example, when configuring the TLS Proxy for Presence Federation, which uses the Cisco Unified Presence Server (CUPS), both the TLS client and TLS server are both servers. 

 
     [bookmark: pgfId-1470010] a. Check the Specify the proxy certificate for the TLS Client... check box. 

 
     [bookmark: pgfId-1470011] b. Select a certificate from the drop-down list.

 
     [bookmark: pgfId-1470012]Or

 
     [bookmark: pgfId-1470013]To create a new client proxy certificate, click Manage. The Manage Identify Certificates dialog box opens. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1470020]Note When you are configuring the TLS Proxy for the Phone Proxy and it is using the mixed security mode for the CUCM cluster, you must configure the LDC Issuer. The LDC Issuer lists the local certificate authority to issue client or server dynamic certificates.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1470021]Step 5 To specify an LDC Issuer to use for the TLS Proxy, perform the following. When you select and configure the LDC Issuer option, the ASA acts as the certificate authority and issues certificates to TLS clients. 

 
     [bookmark: pgfId-1470025] a. Click the Specify the internal Certificate Authority to sign the local dynamic certificate for phones... check box.

 
     [bookmark: pgfId-1470026] b. Click the Certificates radio button and select a self-signed certificate from the drop-down list or click Manage to create a new LDC Issuer. The Manage Identify Certificates dialog box opens. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide.

 
     [bookmark: pgfId-1470033]Or

 
     [bookmark: pgfId-1470034]Click the Certificate Authority radio button to specify a Certificate Authority (CA) server. When you specify a CA server, it needs to be created and enabled in the ASA. To create and enable the CA server, click Manage. The Edit CA Server Settings dialog box opens. See the “Authenticating Using the Local CA” section in the general operations configuration guide. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1470044]Note To make configuration changes after the local certificate authority has been configured for the first time, disable the local certificate authority.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1470045] c. In the Key-Pair Name field, select a key pair from the drop-list. The list contains the already defined RSA key pair used by client dynamic certificates. To see the key pair details, including generation time, usage, modulus size, and key data, click Show. 

 
     [bookmark: pgfId-1470046]Or 

 
     [bookmark: pgfId-1470049]To create a new key pair, click New. The Add Key Pair dialog box opens. See the “Configuring Identity Certificates Authentication” section in the general operations configuration guide for details about the Key Pair fields.

 
     [bookmark: pgfId-1470054]Step 6 In the Security Algorithms area, specify the available and active algorithms to be announced or matched during the TLS handshake.

 
      
      		 [bookmark: pgfId-1470055]Available Algorithms—Lists the available algorithms to be announced or matched during the TLS handshake: des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, and null-sha1. 

 
     

 
     [bookmark: pgfId-1470056]Add—Adds the selected algorithm to the active list.

 
     [bookmark: pgfId-1470057]Remove—Removes the selected algorithm from the active list.

 
      
      		 [bookmark: pgfId-1470058]Active Algorithms—Lists the active algorithms to be announced or matched during the TLS handshake: des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, and null-sha1. For client proxy (acting as a TLS client to the server), the user-defined algorithms replace the original ones from the hello message for asymmetric encryption method between the two TLS legs. For example, the leg between the proxy and Call Manager may be NULL cipher to offload the Call Manager.

 
     

 
     [bookmark: pgfId-1470059]Move Up—Moves an algorithm up in the list.

 
     [bookmark: pgfId-1470060]Move Down—Moves an algorithm down in the list.

 
     [bookmark: pgfId-1470061]Step 7 Click Apply to save the changes.

 
     [bookmark: pgfId-1470062]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1470065][bookmark: 61735]TLS Proxy

 
    [bookmark: pgfId-1470066]This feature is supported only for ASA versions 8.0.x prior to 8.0.4 and for version 8.1.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1470067]Note This feature is not supported for the Adaptive Security Appliance versions prior to 8.0.4 and for version 8.1.2.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1470068]Use the TLS Proxy option to enable inspection of SSL encrypted VoIP signaling, namely Skinny and SIP, interacting with Cisco CallManager.

 
    [bookmark: pgfId-1470069]The TLS Proxy pane lets you define and configure Transaction Layer Security Proxy to enable inspection of encrypted traffic.

 
    [bookmark: pgfId-1470070]Fields

 
     
     		 [bookmark: pgfId-1470071]TLS Proxy Name—Lists the TLS Proxy name.

 
     		 [bookmark: pgfId-1470072]Server—Lists the trustpoint, which is either self-signed or enrolled with a certificate server. 

 
     		 [bookmark: pgfId-1470073]Local Dynamic Certificate Issuer—Lists the local certificate authority to issue client or server dynamic certificates.

 
     		 [bookmark: pgfId-1470074]Local Dynamic Certificate Key Pair—Lists the RSA key pair used by client or server dynamic certificates.

 
     		 [bookmark: pgfId-1470075]Add—Adds a TLS Proxy.

 
     		 [bookmark: pgfId-1470076]Edit—Edits a TLS Proxy.

 
     		 [bookmark: pgfId-1470077]Delete—Deletes a TLS Proxy.

 
     		 [bookmark: pgfId-1470078]Maximum Sessions—Lets you specify the maximum number of TLS Proxy sessions to support.

 
    

 
    [bookmark: pgfId-1470079] – Specify the maximum number of TLS Proxy sessions that the ASA needs to support. By default, ASA supports 300 sessions.—Enables maximum number of sessions option.

 
    [bookmark: pgfId-1470080] – Maximum number of sessions:—The minimum is 1. The maximum is dependent on the platform. The default is 300.

 
     
      [bookmark: pgfId-1470083][bookmark: 22960]Add/Edit TLS Proxy

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1470084]Note This feature is not supported for the Adaptive Security Appliance versions prior to 8.0.4 and for version 8.1.2.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1470085]The Add/Edit TLS Proxy dialog box lets you define the parameters for the TLS Proxy.

 
     [bookmark: pgfId-1470086]Fields

 
      
      		 [bookmark: pgfId-1470087]TLS Proxy Name—Specifies the TLS Proxy name.

 
      		 [bookmark: pgfId-1470088]Server Configuration—Specifies the proxy certificate name.

 
     

 
     [bookmark: pgfId-1470089] – Server—Specifies the trustpoint to be presented during the TLS handshake. The trustpoint could be self-signed or enrolled locally with the certificate service on the proxy. 

 
      
      		 [bookmark: pgfId-1470090]Client Configuration—Specifies the local dynamic certificate issuer and key pair.

 
     

 
     [bookmark: pgfId-1470091] – Local Dynamic Certificate Issuer—Lists the local certificate authority to issue client or server dynamic certificates.

 
     [bookmark: pgfId-1470092]Certificate Authority Server—Specifies the certificate authority server.

 
     [bookmark: pgfId-1470093]Certificate—Specifies a certificate.

 
     [bookmark: pgfId-1470094]Manage—Configures the local certificate authority. To make configuration changes after it has been configured for the first time, disable the local certificate authority.

 
     [bookmark: pgfId-1470095] – Local Dynamic Certificate Key Pair—Lists the RSA key pair used by client dynamic certificates.

 
     [bookmark: pgfId-1470096]Key-Pair Name—Specifies a defined key pair.

 
     [bookmark: pgfId-1470097]Show—Shows the key pair details, including generation time, usage, modulus size, and key data.

 
     [bookmark: pgfId-1470098]New—Lets you define a new key pair.

 
      
      		 [bookmark: pgfId-1470099]More Options—Specifies the available and active algorithms to be announced or matched during the TLS handshake.

 
     

 
     [bookmark: pgfId-1470100] – Available Algorithms—Lists the available algorithms to be announced or matched during the TLS handshake: des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, and null-sha1. 

 
     [bookmark: pgfId-1470101]Add—Adds the selected algorithm to the active list.

 
     [bookmark: pgfId-1470102]Remove—Removes the selected algorithm from the active list.

 
     [bookmark: pgfId-1470103] – Active Algorithms—Lists the active algorithms to be announced or matched during the TLS handshake: des-sha1, 3des-sha1, aes128-sha1, aes256-sha1, and null-sha1. For client proxy (acting as a TLS client to the server), the user-defined algorithms replace the original ones from the hello message for asymmetric encryption method between the two TLS legs. For example, the leg between the proxy and CallManager may be NULL cipher to offload the CallManager.

 
     [bookmark: pgfId-1470104]Move Up—Moves an algorithm up in the list.

 
     [bookmark: pgfId-1470105]Move Down—Moves an algorithm down in the list.

 
     [bookmark: pgfId-1470106] 

 
    
 
   
 
    
     [bookmark: pgfId-1136934][bookmark: 60302][bookmark: 84476]Feature History for the TLS Proxy for Encrypted Voice Inspection

 
    [bookmark: pgfId-1244505]Table 18-2 lists the release history for this feature.

 
    [bookmark: pgfId-1244540] 

 
     
      
       
       [bookmark: pgfId-1244512]Table 18-2 [bookmark: 12416]Feature History for Cisco Phone Proxy 

 
       
       
        
        		 
          
          [bookmark: pgfId-1244518]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1244520]Releases 
         
  
        		 
          
          [bookmark: pgfId-1244522]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1244524]TLS Proxy

  
        		[bookmark: pgfId-1244526]8.0(2)

  
        		[bookmark: pgfId-1244528]The TLS proxy feature was introduced.

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1244559] 
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     [bookmark: pgfId-1058568][bookmark: 28488]Configuring Special Actions for Application Ins[bookmark: marker-1160308]pections (Inspection Policy Map) 
      
      
 
     
 

 
    [bookmark: pgfId-1099600]Modular Policy Framework lets you configure special actions for many application inspections. When you enable an inspection engine in the service policy, you can also optionally enable actions as defined in an inspection policy map. When the inspection policy map matches traffic within the service policy for which you have defined an inspection action, then that subset of traffic will be acted upon as specified (for example, dropped or rate-limited).

 
    [bookmark: pgfId-1124543]This chapter includes the following sections:

 
     
     		 [bookmark: pgfId-1124596]Information About Inspection Policy Maps

 
     		 [bookmark: pgfId-1166631]Guidelines and Limitations

 
     		 [bookmark: pgfId-1162530]Default Inspection Policy Maps

 
     		 [bookmark: pgfId-1162036]Defining Actions in an Inspection Policy Map

 
     		 [bookmark: pgfId-1128480]Identifying Traffic in an Inspection Class Map

 
     		 [bookmark: pgfId-1162589]Where to Go Next

 
     		 [bookmark: pgfId-1167610]Feature History for Inspection Policy Maps

 
    

 
   
 
    
     [bookmark: pgfId-1161993][bookmark: 79883]Information About Inspection Policy Maps

 
    [bookmark: pgfId-1161997]See the “Configuring Application Layer Protocol Inspection” section for a list of applications that support inspection policy maps.

 
    [bookmark: pgfId-1161998]An inspection policy map consists of one or more of the following elements. The exact options available for an inspection policy map depends on the application.

 
     
     		 [bookmark: pgfId-1161999]Traffic matching option—You can define a traffic matching option directly in the inspection policy map to match application traffic to criteria specific to the application, such as a URL string, for which you then enable actions.

 
    

 
    [bookmark: pgfId-1162000] – Some traffic matching options can specify regular expressions to match text inside a packet. Be sure to create and test the regular expressions before you configure the policy map, either singly or grouped together in a regular expression class map.

 
     
     		 [bookmark: pgfId-1162001]Inspection class map—An inspection class map includes multiple traffic matching options. You then identify the class map in the policy map and enable actions for the class map as a whole. The difference between creating a class map and defining the traffic match directly in the inspection policy map is that you can create more complex match criteria and you can reuse class maps. However, you cannot set different actions for different matches. Note:  Not all inspections support inspection class maps.

 
     		 [bookmark: pgfId-1162003]Parameters—Parameters affect the behavior of the inspection engine.

 
    

 
   
 
    
     [bookmark: pgfId-1166624][bookmark: 70719][bookmark: 99972]Guidelines and Limitations

 
     
     		 [bookmark: pgfId-1166628]HTTP inspection policy maps—If you modify an in-use HTTP inspection policy map, you must remove and reapply the inspection policy map action for the changes to take effect. For example, if you modify the “http-map” inspection policy map, you must remove, apply changes, and readd the inspection policy map to the service policy.

 
     		 [bookmark: pgfId-1171140]All inspection policy maps—If you want to exchange an in-use inspection policy map for a different map name, you must remove, apply changes, and readd the new inspection policy map to the service policy.

 
     		 [bookmark: pgfId-1171264]You can specify multiple inspection class maps or direct matches in the inspection policy map.

 
    

 
    [bookmark: pgfId-1171265]If a packet matches multiple different matches, then the order in which the ASA applies the actions is determined by internal ASA rules, and not by the order they are added to the inspection policy map. The internal rules are determined by the application type and the logical progression of parsing a packet, and are not user-configurable. For example for HTTP traffic, parsing a Request Method field precedes parsing the Header Host Length field; an action for the Request Method field occurs before the action for the Header Host Length field.

 
    [bookmark: pgfId-1171277]If an action drops a packet, then no further actions are performed in the inspection policy map. For example, if the first action is to reset the connection, then it will never match any further match criteria. If the first action is to log the packet, then a second action, such as resetting the connection, can occur.

 
    [bookmark: pgfId-1171278]If a packet matches multiple match criteria that are the same, then they are matched in the order they appear in the policy map. 

 
    [bookmark: pgfId-1171284]A class map is determined to be the same type as another class map or direct match based on the lowest priority match option in the class map (the priority is based on the internal rules). If a class map has the same type of lowest priority match option as another class map, then the class maps are matched according to the order they are added to the policy map. If the lowest priority match for each class map is different, then the class map with the higher priority match option is matched first.

 
   
 
    
     [bookmark: pgfId-1162062][bookmark: 86532]Default Inspection Policy Maps

 
    [bookmark: pgfId-1171062]DNS inspection is enabled by default, using the preset_dns_map inspection class map:

 
     
     		 [bookmark: pgfId-1171063]The maximum DNS message length is 512 bytes.

 
     		 [bookmark: pgfId-1171064]The maximum client DNS message length is automatically set to match the Resource Record.

 
     		 [bookmark: pgfId-1171068]DNS Guard is enabled, so the ASA tears down the DNS session associated with a DNS query as soon as the DNS reply is forwarded by the ASA. The ASA also monitors the message exchange to ensure that the ID of the DNS reply matches the ID of the DNS query.

 
     		 [bookmark: pgfId-1171075]Translation of the DNS record based on the NAT configuration is enabled.

 
     		 [bookmark: pgfId-1171076]Protocol enforcement is enabled, which enables DNS message format check, including domain name length of no more than 255 characters, label length of 63 characters, compression, and looped pointer check.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1170604]Note There are other default inspection policy maps such as _default_esmtp_map. For example, an ESMTP inspection rule implicitly uses the policy map “_default_esmtp_map.”[bookmark: 43845]

 
     
     
 
    
 
    

 
   
 
    
     [bookmark: pgfId-1128180][bookmark: 82434]Defining Actions in an Inspection Poli[bookmark: marker-1128178]cy M[bookmark: marker-1128179]ap

 
    [bookmark: pgfId-1162630]When you enable an inspection engine in the service policy, you can also optionally enable actions as defined in an inspection policy map.

 
     
      [bookmark: pgfId-1128183]Detailed Steps

 
     
 
     [bookmark: pgfId-1175072]Step 1 (Optional) Create an inspection class map. Alternatively, you can identify the traffic directly within the policy map. See the “Identifying Traffic in an Inspection Class Map” section.

 
     [bookmark: pgfId-1175076]Step 2 (Optional) For policy map types that support regular expressions, create a regular expression. See the “Configuring Regular Expressions” section in the general operations configuration guide.

 
     [bookmark: pgfId-1175083]Step 3 Choose Configuration > Firewall > Objects > Inspect Maps .

 
     [bookmark: pgfId-1175084]Step 4 Choose the inspection type you want to configure.

 
     [bookmark: pgfId-1175085]Step 5 Click Add to add a new inspection policy map.

 
     [bookmark: pgfId-1175086]Step 6 Follow the instructions for your inspection type in the inspection chapter.

 
     [bookmark: pgfId-1175087]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1127677][bookmark: 38008]Identifyin[bookmark: marker-1127675]g Traffic in an Inspection Clas[bookmark: marker-1127676]s Map

 
    [bookmark: pgfId-1127678]This type of class map allows you to match criteria that is specific to an application. For example, for DNS traffic, you can match the domain name in a DNS query.

 
    [bookmark: pgfId-1127680]A class map groups multiple traffic matches (in a match-all class map), or lets you match any of a list of matches (in a match-any class map). The difference between creating a class map and defining the traffic match directly in the inspection policy map is that the class map lets you group multiple match commands, and you can reuse class maps. For the traffic that you identify in this class map, you can specify actions such as dropping, resetting, and/or logging the connection in the inspection policy map. If you want to perform different actions on different types of traffic, you should identify the traffic directly in the policy map.

 
     
      [bookmark: pgfId-1153109]Restrictions

 
     [bookmark: pgfId-1153150]Not all applications support inspection class maps.

 
    
 
     
      [bookmark: pgfId-1127682]Detailed Steps

 
     
 
     [bookmark: pgfId-1175092]Step 1 Choose Configuration > Firewall > Objects > Class Maps .

 
     [bookmark: pgfId-1175093]Step 2 Choose the inspection type you want to configure.

 
     [bookmark: pgfId-1175094]Step 3 Click Add to add a new inspection class map.

 
     [bookmark: pgfId-1175095]Step 4 Follow the instructions for your inspection type in the inspection chapter.

 
     [bookmark: pgfId-1175096]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1162430][bookmark: 82220]Where to Go Next

 
    [bookmark: pgfId-1162584]To use an inspection policy, see Chapter1, “Configuring a Service Policy”

 
   
 
    
     [bookmark: pgfId-1167544][bookmark: 52709]Feature History for Inspection Policy Maps

 
    [bookmark: pgfId-1167548]Table 2-1 lists the release history for this feature.

 
    [bookmark: pgfId-1167596] 

 
     
      
       
       [bookmark: pgfId-1167555]Table 2-1 [bookmark: 50557]Feature History for Service Policies 

 
       
       
        
        		 
          
          [bookmark: pgfId-1167561]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1167563]Releases 
         
  
        		 
          
          [bookmark: pgfId-1167565]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1167579]Inspection policy maps

  
        		[bookmark: pgfId-1167581]7.2(1)

  
        		[bookmark: pgfId-1167583]The inspection policy map was introduced. The following command was introduced: class-map type inspect.

  
       

 
        
        		[bookmark: pgfId-1167585]Regular expressions and policy maps

  
        		[bookmark: pgfId-1167587]7.2(1)

  
        		[bookmark: pgfId-1167589]Regular expressions and policy maps were introduced to be used under inspection policy maps. The following commands were introduced: class-map type regex, regex, match regex.

  
       

 
        
        		[bookmark: pgfId-1167591]Match any for inspection policy maps

  
        		[bookmark: pgfId-1167593]8.0(2)

  
        		[bookmark: pgfId-1167595]The match any keyword was introduced for use with inspection policy maps: traffic can match one or more criteria to match the class map. Formerly, only match all was available.
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     [bookmark: pgfId-1313159][bookmark: 59098]Configuring Inspection of Basic Internet Protocols 
      
      
 
     
 

 
    [bookmark: pgfId-1434717]This chapter describes how to configure application layer protocol inspection. Inspection engines are required for services that embed IP addressing information in the user data packet or that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep packet inspection instead of passing the packet through the fast path. As a result, inspection engines can affect overall throughput.

 
    [bookmark: pgfId-1543211]Several common inspection engines are enabled on the ASA by default, but you might need to enable others depending on your network. 

 
    [bookmark: pgfId-2013723]This chapter includes the following sections:[bookmark: marker-1543212]

 
     
     		 [bookmark: pgfId-1543216]DNS Inspection

 
     		 [bookmark: pgfId-1543220]FTP Inspection

 
     		 [bookmark: pgfId-1303361]HTTP Inspection

 
     		 [bookmark: pgfId-1541631]ICMP Inspection

 
     		 [bookmark: pgfId-1541372]ICMP Error Inspection

 
     		 [bookmark: pgfId-1554650]Instant Messaging Inspection

 
     		 [bookmark: pgfId-1601441]IP Options Inspection

 
     		 [bookmark: pgfId-1554651]IPsec Pass Through Inspection

 
     		 [bookmark: pgfId-1956689]IPv6 Inspection

 
     		 [bookmark: pgfId-1554655]NetBIOS Inspection

 
     		 [bookmark: pgfId-1536429]PPTP Inspection

 
     		 [bookmark: pgfId-1303431]SMTP and Extended SMTP Inspection

 
     		 [bookmark: pgfId-1347753]TFTP Inspection

 
    

 
   
 
    
     [bookmark: pgfId-1335632][bookmark: 39177][bookmark: 10154]DNS Inspection

 
    [bookmark: pgfId-1335843][bookmark: marker-1350376]This section describes DNS application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1335847]Information About DNS Inspection

 
     		 [bookmark: pgfId-1335851]Default Settings for DNS Inspection

 
     		 [bookmark: pgfId-2326565](Optional) Configuring a DNS Inspection Policy Map and Class Map

 
     		 [bookmark: pgfId-2326583]Configuring DNS Inspection

 
    

 
     
      [bookmark: pgfId-2348059][bookmark: 18101]Information About DNS Inspection[bookmark: marker-2348058]

 
      
      		 [bookmark: pgfId-2348063]General Information About DNS

 
      		 [bookmark: pgfId-2348068]DNS Inspection Actions

 
     

 
    
 
     
      [bookmark: pgfId-2348065][bookmark: 84033]General Information About DNS

 
     [bookmark: pgfId-2326142]A single connection is created for multiple DNS sessions, as long as they are between the same two hosts, and the sessions have the same 5-tuple (source/destination IP address, source/destination port, and protocol). DNS identification is tracked by app_id, and the idle timer for each app_id runs independently. Because the app_id expires independently, a legitimate DNS response can only pass through the ASA within a limited period of time and there is no resource build-up.

 
    
 
     
      [bookmark: pgfId-2326961][bookmark: 35169]DNS Inspection Actions

 
     [bookmark: pgfId-2331068]DNS inspection is enabled by default. You can customize DNS inspection to perform many tasks:

 
      
      		 [bookmark: pgfId-1335874]Translate the DNS record based on the NAT configuration. For more information, see the “DNS and NAT” section.

 
      		 [bookmark: pgfId-1335878]Enforce message length, domain-name length, and label length.

 
      		 [bookmark: pgfId-1335879]Verify the integrity of the domain-name referred to by the pointer if compression pointers are encountered in the DNS message.

 
      		 [bookmark: pgfId-1335880]Check to see if a compression pointer loop exists.

 
      		 [bookmark: pgfId-2348100]Inspect packets based on the DNS header, type, class and more.

 
     

 
    
 
     
      [bookmark: pgfId-2323498][bookmark: 35538]Default Settings for DNS Inspection

 
     [bookmark: pgfId-2323551]DNS inspection is enabled by default, using the preset_dns_map inspection class map:

 
      
      		 [bookmark: pgfId-2325963]The maximum DNS message length is 512 bytes.

 
      		 [bookmark: pgfId-2348985]The maximum client DNS message length is automatically set to match the Resource Record.

 
      		 [bookmark: pgfId-2349096]DNS Guard is enabled, so the ASA tears down the DNS session associated with a DNS query as soon as the DNS reply is forwarded by the ASA. The ASA also monitors the message exchange to ensure that the ID of the DNS reply matches the ID of the DNS query.

 
      		 [bookmark: pgfId-2346464]Translation of the DNS record based on the NAT configuration is enabled.

 
      		 [bookmark: pgfId-2349152]Protocol enforcement is enabled, which enables DNS message format check, including domain name length of no more than 255 characters, label length of 63 characters, compression, and looped pointer check.

 
     

 
    
 
     
      [bookmark: pgfId-2312709][bookmark: 52780](Optional) Configuring a DNS Inspection Policy Map and Class Map

 
     [bookmark: pgfId-2329004]To match DNS packets with certain characteristics and perform special actions, create a DNS inspection policy map. You can also configure a DNS inspection class map to group multiple match criteria for reference within the inspection policy map. You can then apply the inspection policy map when you enable DNS inspection.

 
    
 
     
      [bookmark: pgfId-2327062][bookmark: 70884]Prerequisites

 
     [bookmark: pgfId-2337798]If you want to match a DNS message domain name list, then create a regular expression using one of the methods below:

 
      
      		 [bookmark: pgfId-2328032]“Creating a Regular Expression” section in the general operations configuration guide.

 
      		 [bookmark: pgfId-2328042]“Creating a Regular Expression Class Map” section in the general operations configuration guide.

 
     

 
    
 
     
      [bookmark: pgfId-2326313]Detailed Steps

 
     
 
     [bookmark: pgfId-2382956]Step 1 Choose Configuration > Firewall > Objects > Inspect Maps > DNS.

 
     [bookmark: pgfId-2382957]The Configure DNS Maps pane appears. 

 
     [bookmark: pgfId-2382958]Step 2 Click Add.

 
     [bookmark: pgfId-2382959]The Add IPv6 Inspection Map dialog box appears.

 
     [bookmark: pgfId-2402041] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2382964]Step 3 In the Name field, name the inspection policy map.

 
     [bookmark: pgfId-2382965]Step 4 (Optional) In the Description field, add a description.

 
     [bookmark: pgfId-2382966]Step 5 Do one of the following:

 
      
       
       		 [bookmark: pgfId-2382967]To use one of the preset security levels (Low, Medium, or High), drag the Security Level knob, then click  OK to add the inspection policy map. You can skip the rest of this procedure.

 
       		 [bookmark: pgfId-2382968]To customize each parameter and/or to configure packet matching inspection, click  Details .

 
      

 
     

 
     [bookmark: pgfId-2382969]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2382970]Detailed Steps—Protocol Conformance

 
     
 
     [bookmark: pgfId-2382971]Step 1 Configure the following Protocol Conformance parameters:

 
     [bookmark: pgfId-2402049] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2382979]Step 2 Enable DNS guard function—Enables DNS Guard. The ASA tears down the DNS session associated with a DNS query as soon as the DNS reply is forwarded by the ASA. The ASA also monitors the message exchange to ensure that the ID of the DNS reply matches the ID of the DNS query.

 
     [bookmark: pgfId-2382986]Step 3 Enable NAT re-write function—Translates the DNS record based on the NAT configuration.

 
     [bookmark: pgfId-2382987]Step 4 Enable protocol enforcement—Enables DNS message format check, including domain name length of no more than 255 characters, label length of 63 characters, compression, and looped pointer check.

 
     [bookmark: pgfId-2382988]Step 5 Randomize the DNS identifier for DNS query—Randomizes the DNS identifier for a DNS query.

 
     [bookmark: pgfId-2382989]Step 6 Enforce TSIG resource record to be present in DNS message—Requires a TSIG resource record to be present. Actions include:

 
      
      		 [bookmark: pgfId-2382990]Action:  Drop packet or  Log —Drop or log a non-conforming packet.

 
      		 [bookmark: pgfId-2382991]Log:  Enable or  Disable —If you selected Drop packet, you can also enable logging.

 
     

 
     [bookmark: pgfId-2382992]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2382993]Detailed Steps—Filtering

 
     
 
     [bookmark: pgfId-2382994]Step 1 Click the Filtering tab.

 
     [bookmark: pgfId-2402057] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2382999]Step 2 Global Settings: Drop packets that exceed specified maximum length (global)—Sets the maximum DNS message length, from 512 to 65535 bytes.

 
     [bookmark: pgfId-2383000]Step 3 Server Settings: Drop packets that exceed specified maximum length and Drop packets sent to server that exceed length indicated by the RR—Sets the maximum server DNS message length, from 512 to 65535 bytes, or sets the maximum length to the value in the Resource Record. If you enable both settings, the lower value is used.

 
     [bookmark: pgfId-2383001]Step 4 Client Settings: Drop packets that exceed specified maximum length and Drop packets sent to server that exceed length indicated by the RR—Sets the maximum client DNS message length, from 512 to 65535 bytes, or sets the maximum length to the value in the Resource Record. If you enable both settings, the lower value is used.

 
     [bookmark: pgfId-2383002]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2383003]Detailed Steps—Mismatch Rate

 
     
 
     [bookmark: pgfId-2383004]Step 1 Click the Mismatch Rate tab.

 
     [bookmark: pgfId-2402065] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383009]Step 2 Enable logging when DNS ID mismatch rate exceeds specified rate—Enables logging for excessive DNS ID mismatches, where the Mismatch Instance Threshold and Time Interval fields specify the maximum number of mismatch instances per x seconds before a system message log is sent.

 
     [bookmark: pgfId-2383010]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2383011]Detailed Steps—Inspections

 
     
 
     [bookmark: pgfId-2383012]Step 1 Click the Inspections tab.

 
     [bookmark: pgfId-2402073] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383017]Step 2 Click Add.

 
     [bookmark: pgfId-2383018]The Add DNS Inspect dialog box appears.

 
     [bookmark: pgfId-2402081] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383024]Step 3 [bookmark: 80053]You can configure DNS inspections using the following methods:

 
      
       
       		 [bookmark: pgfId-2383025] Single Match —Match a single criterion, and identify the action for the match.

 
       		 [bookmark: pgfId-2383026] Multiple matches —Match multiple criteria by creating an inspection class map.

 
      

 
     

 
     [bookmark: pgfId-2383027]The difference between creating a class map and defining the traffic match directly in the inspection policy map is that the class map lets you create more complex match criteria, and you can reuse class maps. If you want different actions for each criteria, use the single match option; you can only set one action for the entire class map.

 
     [bookmark: pgfId-2383028]You can add multiple class maps and single matches in the same policy map.

 
     [bookmark: pgfId-2383029]Actions for each Single Match, or for a Multiple match class map include:

 
      
       
       		 [bookmark: pgfId-2383030]Primary Action:

 
      

 
     

 
     [bookmark: pgfId-2383031] – Mask

 
     [bookmark: pgfId-2383032] – Drop Packet

 
     [bookmark: pgfId-2383033] – Drop Connection

 
     [bookmark: pgfId-2383034] – None

 
      
       
       		 [bookmark: pgfId-2383035]Log:

 
      

 
     

 
     [bookmark: pgfId-2383036] – Enable

 
     [bookmark: pgfId-2383037] – Disable

 
      
       
       		 [bookmark: pgfId-2383038]Enforce TSIG: Requires a TSIG resource record to be present.

 
      

 
     

 
     [bookmark: pgfId-2383039] – Do not enforce

 
     [bookmark: pgfId-2383040] – Drop packet

 
     [bookmark: pgfId-2383041] – Log

 
     [bookmark: pgfId-2383042] – Drop packet and log

 
     [bookmark: pgfId-2383043]Not all combinations are valid for all matching criteria. For example, you can configure both Mask and Enforce TSIG together only for the Criterion: Header Flag option.

 
     [bookmark: pgfId-2383044]Step 4 For Multiple matches, if you predefined a class map on the Configuration > Firewall > Objects > Class Maps > DNS pane, you can select it from the drop-down list, set the Actions, and click OK.

 
     [bookmark: pgfId-2383045]To add a new class map:

 
     [bookmark: pgfId-2383046] a. Click Manage.

 
     [bookmark: pgfId-2383047]The Manage DNS Class Maps dialog box appears

 
     [bookmark: pgfId-2402089] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383052] b. Click Add.

 
     [bookmark: pgfId-2383053]The Add DNS Traffic Class Map dialog box appears.

 
     [bookmark: pgfId-2402097] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383058] c. Click Add.

 
     [bookmark: pgfId-2383059]The Add DNS Match Criterion dialog box appears.

 
     [bookmark: pgfId-2383060]The match criteria are the same for a class map or for single matches; the following steps apply to both methods. The only difference is that you do not set an Action for each criterion in a class map.

 
     [bookmark: pgfId-2383061]Step 5 From the Criterion drop-down list, choose one of the following criteria:

 
      
       
       		 [bookmark: pgfId-2383062] Header Flag :

 
      

 
     

 
     [bookmark: pgfId-2402105] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383067]Set the following Value parameters:

 
     [bookmark: pgfId-2383068] – Match Option: Equals or Contains. If you choose Header Flag Name, and check multiple flags, you can set the ASA to match a packet only if all flags are present (Equals) or if any one of the flags is present (Contains).

 
     [bookmark: pgfId-2383072] – Match Value: Header Flag Name or Header Flag Value. If you click Header Flag Name, you can check one or more well-known flag values. If you want to specify a hex value, click the Header Flag Value radio button, and enter the hex value in the field.

 
      
       
       		 [bookmark: pgfId-2383073] Type :

 
      

 
     

 
     [bookmark: pgfId-2402113] 
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     [bookmark: pgfId-2383078]Set the following Value parameters:

 
     [bookmark: pgfId-2383079] – DNS Type Field Name—Lists the DNS types to select.

 
     [bookmark: pgfId-2383080]A—IPv4 address

 
     [bookmark: pgfId-2383081]AXFR—Full (zone) transfer

 
     [bookmark: pgfId-2383082]CNAME—Canonical name

 
     [bookmark: pgfId-2383083]IXFR—Incremental (zone) transfer

 
     [bookmark: pgfId-2383084]NS—Authoritative name server

 
     [bookmark: pgfId-2383085]SOA—Start of a zone of authority

 
     [bookmark: pgfId-2383086]TSIG—Transaction signature

 
     [bookmark: pgfId-2383087] – DNS Type Field Value:

 
     [bookmark: pgfId-2383088]Value—Lets you enter a value between 0 and 65535 to match.

 
     [bookmark: pgfId-2383089]Range—Lets you enter a range match. Both values between 0 and 65535.

 
      
       
       		 [bookmark: pgfId-2383090] Class :

 
      

 
     

 
     [bookmark: pgfId-2402121] 
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     [bookmark: pgfId-2383095]Set the following Value parameters:

 
     [bookmark: pgfId-2383096] – DNS Class Field Name: Internet—Internet is the only option.

 
     [bookmark: pgfId-2383097] – DNS Class Field Value:

 
     [bookmark: pgfId-2383098]Value—Lets you enter a value between 0 and 65535.

 
     [bookmark: pgfId-2383099]Range—Lets you enter a range match. Both values between 0 and 65535.

 
      
       
       		 [bookmark: pgfId-2383100] Question : Matches a DNS question.

 
      

 
     

 
     [bookmark: pgfId-2402129] 

 
      
      [image: ] 
     
 
      
       
       		 [bookmark: pgfId-2383105] Resource Record :

 
      

 
     

 
     [bookmark: pgfId-2402137] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383110]Set the following Value parameters:

 
     [bookmark: pgfId-2383111] – Resource Record:

 
     [bookmark: pgfId-2383112]additional—DNS additional resource record

 
     [bookmark: pgfId-2383113]answer—DNS answer resource record

 
     [bookmark: pgfId-2383114]authority—DNS authority resource record

 
      
       
       		 [bookmark: pgfId-2383115] Domain Name :

 
      

 
     

 
     [bookmark: pgfId-2402145] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-2383120]Set the following Value parameters:

 
     [bookmark: pgfId-2383121] – Regular Expression—Choose an existing regular expression from the drop-down menu, or click Manage to add a new one. See the “Creating a Regular Expression” section in the general operations configuration guide.

 
     [bookmark: pgfId-2383128] – Regular Expression Class—Choose an existing regular expression class map from the drop-down menu, or click Manage to add a new one. See the “Creating a Regular Expression Class Map” section in the general operations configuration guide.

 
     [bookmark: pgfId-2383135]Step 6 For a class map:

 
     [bookmark: pgfId-2383136] a. Click OK to add the match to the map.

 
     [bookmark: pgfId-2383137] b. Add more matches as desired.

 
     [bookmark: pgfId-2383138] c. Click OK to finish the class map.

 
     [bookmark: pgfId-2383139] d. Click OK to return to the Add DNS Inspect Map dialog box.

 
     [bookmark: pgfId-2383140]Step 7 Set the action for the Single Match, or for the Multiple matches class map; see Step 3 for actions.

 
     [bookmark: pgfId-2383144]Step 8 Click OK to return to the Add DNS Inspect dialog box.

 
     [bookmark: pgfId-2383145]Step 9 In some cases when you have more than one match in the inspection policy map, you can order the matches using the Move Up and Move Down buttons. Generally, the order is determined by internal ASA rules, so these buttons are not available for most entries. However, if you have a direct match and a class map that have the same match, then the order in the configuration determines which match is used, so these buttons are enabled. See the “Guidelines and Limitations” section for more information.

 
     [bookmark: pgfId-2383152]Step 10 Click OK to save the DNS inspect map.

 
     [bookmark: pgfId-2383153]Step 11 Click Apply.

 
     [bookmark: pgfId-2383154]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2326339][bookmark: 70278]Configuring DNS Inspection

 
     [bookmark: pgfId-2354376]The default ASA configuration includes many default inspections on default ports applied globally on all interfaces. A common method for customizing the inspection configuration is to customize the default global policy. The steps in this section show how to edit the default global policy, but you can alternatively create a new service policy as desired, for example, an interface-specific policy.

 
    
 
     
      [bookmark: pgfId-2354377]Detailed Steps

 
     
 
     [bookmark: pgfId-2383159]Step 1 Configure a service policy on the Configuration > Firewall > Service Policy Rules pane according to Chapter1, “Configuring a Service Policy”

 
     [bookmark: pgfId-2383163]You can configure DNS inspection as part of a new service policy rule, or you can edit an existing service policy.

 
     [bookmark: pgfId-2383164]Step 2 On the Rule Actions dialog box, click the Protocol Inspections tab.

 
     [bookmark: pgfId-2383165]Step 3 (To change an in-use policy) If you are editing any in-use policy to use a different DNS inspection policy map, you must disable the DNS inspection, and then re-enable it with the new DNS inspection policy map name:

 
     [bookmark: pgfId-2383166] a. Uncheck the DNS check box.

 
     [bookmark: pgfId-2383167] b. Click OK.

 
     [bookmark: pgfId-2383168] c. Click Apply.

 
     [bookmark: pgfId-2383169] d. Repeat these steps to return to the Protocol Inspections tab.

 
     [bookmark: pgfId-2383170]Step 4 Check the DNS check box.

 
     [bookmark: pgfId-2383171]Step 5 Click Configure.

 
     [bookmark: pgfId-2383172]The Select DNS Inspect Map dialog appears.

 
     [bookmark: pgfId-2383173]Step 6 Choose the inspection map:

 
      
       
       		 [bookmark: pgfId-2383174]To use the default map, click  Use the default DNS inspection map (preset_dns_map).

 
       		 [bookmark: pgfId-2383177]To use a DNS inspection policy map that you configured in the “(Optional) Configuring a DNS Inspection Policy Map and Class Map” section, select the map name.

 
       		 [bookmark: pgfId-2383181]To add a new map, click  Add . See the “(Optional) Configuring a DNS Inspection Policy Map and Class Map” section for more information.

 
      

 
     

 
     [bookmark: pgfId-2383183]Step 7 If you use the Botnet Traffic Filter, click Enable Botnet traffic filter DNS snooping. Botnet Traffic Filter snooping compares the domain name with those on the dynamic database or static database, and adds the name and IP address to the Botnet Traffic Filter DNS reverse lookup cache. This cache is then used by the Botnet Traffic Filter when connections are made to the suspicious address. We suggest that you enable DNS snooping only on interfaces where external DNS requests are going. Enabling DNS snooping on all UDP DNS traffic, including that going to an internal DNS server, creates unnecessary load on the ASA. For example, if the DNS server is on the outside interface, you should enable DNS inspection with snooping for all UDP DNS traffic on the outside interface. See the “Enabling DNS Snooping” section.

 
     [bookmark: pgfId-2383190]Step 8 Click OK to return to the Protocol Inspections tab.

 
     [bookmark: pgfId-2383191]Step 9 Click OK to finish editing the service policy.

 
     [bookmark: pgfId-2383192]Step 10 Click Apply.

 
     [bookmark: pgfId-2383193]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1234738][bookmark: 82191]  [bookmark: 40250]FTP Inspe[bookmark: marker-1345372]ction

 
    [bookmark: pgfId-1234739]This section describes the FTP inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1310917]FTP Inspection Overview

 
     		 [bookmark: pgfId-2383201]Using Strict FTP

 
     		 [bookmark: pgfId-2383209]Select FTP Map

 
     		 [bookmark: pgfId-2383213]FTP Class Map

 
     		 [bookmark: pgfId-2383217]Add/Edit FTP Traffic Class Map

 
     		 [bookmark: pgfId-2383221]Add/Edit FTP Match Criterion

 
     		 [bookmark: pgfId-2383225]FTP Inspect Map

 
    

 
     
      [bookmark: pgfId-1144247][bookmark: 32151]FTP Inspection [bookmark: marker-1345373]Overview

 
     [bookmark: pgfId-1148500]The FTP application inspection inspects the FTP sessions and performs four tasks:

 
      
      		 [bookmark: pgfId-1148501]Prepares dynamic secondary data connection

 
      		 [bookmark: pgfId-1148502]Tracks the FTP command-response sequence

 
      		 [bookmark: pgfId-1148503]Generates an audit trail

 
      		 [bookmark: pgfId-1148504]Translates the embedded IP address

 
     

 
     [bookmark: pgfId-1353387]FTP application inspection prepares secondary channels for FTP data transfer. Ports for these channels are negotiated through PORT or PASV commands. The channels are allocated in response to a file upload, a file download, or a directory listing event.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1148506]Note If you disable FTP inspection engines with the no inspect ftp command, outbound users can start connections only in passive mode, and all inbound FTP is disabled.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-2383231][bookmark: 57395]Using Strict FTP

 
     [bookmark: pgfId-2383232]Using strict FTP increases the security of protected networks by preventing web browsers from sending embedded commands in FTP requests. To enable strict FTP, click the Configure button next to FTP on the Configuration > Firewall > Service Policy Rules > Edit Service Policy Rule > Rule Actions > Protocol Inspection tab.

 
     [bookmark: pgfId-1353407]After you enable the strict option on an interface, FTP inspection enforces the following behavior:

 
      
      		 [bookmark: pgfId-1353411]An FTP command must be acknowledged before the ASA allows a new command.

 
      		 [bookmark: pgfId-1353415]The ASA drops connections that send embedded commands.

 
      		 [bookmark: pgfId-1353416]The 227 and PORT commands are checked to ensure they do not appear in an error string.

 
     

 
      
      [image: ] 
     
 
     
 
      
      [bookmark: pgfId-1353424] 
      Caution Using the 
      strict option may cause the failure of FTP clients that are not strictly compliant with FTP RFCs. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1148511]If the strict option is enabled, each FTP command and response sequence is tracked for the following anomalous activity:

 
      
      		 [bookmark: pgfId-1148512]Truncated command—Number of commas in the PORT and PASV reply command is checked to see if it is five. If it is not five, then the PORT command is assumed to be truncated and the TCP connection is closed.

 
      		 [bookmark: pgfId-1148513]Incorrect command—Checks the FTP command to see if it ends with <CR><LF> characters, as required by the RFC. If it does not, the connection is closed.

 
      		 [bookmark: pgfId-1148514]Size of RETR and STOR commands—These are checked against a fixed constant. If the size is greater, then an error message is logged and the connection is closed.

 
      		 [bookmark: pgfId-1148515]Command spoofing—The PORT command should always be sent from the client. The TCP connection is denied if a PORT command is sent from the server. 

 
      		 [bookmark: pgfId-1148516]Reply spoofing—PASV reply command (227) should always be sent from the server. The TCP connection is denied if a PASV reply command is sent from the client. This prevents the security hole when the user executes “227 xxxxx a1, a2, a3, a4, p1, p2.”

 
      		 [bookmark: pgfId-1353433]TCP stream editing—The ASA closes the connection if it detects TCP stream editing.

 
      		 [bookmark: pgfId-1148518]Invalid port negotiation—The negotiated dynamic port value is checked to see if it is less than 1024. As port numbers in the range from 1 to 1024 are reserved for well-known connections, if the negotiated port falls in this range, then the TCP connection is freed.

 
      		 [bookmark: pgfId-1148519]Command pipelining—The number of characters present after the port numbers in the PORT and PASV reply command is cross checked with a constant value of 8. If it is more than 8, then the TCP connection is closed.

 
      		 [bookmark: pgfId-1328743]The ASA replaces the FTP server response to the SYST command with a series of Xs. to prevent the server from revealing its system type to FTP clients. To override this default behavior, use the  no mask-syst-reply command in the FTP map.

 
     

 
    
 
     
      [bookmark: pgfId-2383239][bookmark: 38617]Select FTP Map 

 
     [bookmark: pgfId-2383240]The Select FTP Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383241]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select FTP Map

 
     [bookmark: pgfId-2383242]The Select FTP Map dialog box lets you enable strict FTP application inspection, select an FTP map, or create a new FTP map. An FTP map lets you change the configuration values used for FTP application inspection.The Select FTP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2383243]Fields

 
      
      		 [bookmark: pgfId-2383244]FTP Strict (prevent web browsers from sending embedded commands in FTP requests) — Enables strict FTP application inspection, which causes the ASA to drop the connection when an embedded command is included in an FTP request. 

 
      		 [bookmark: pgfId-2383248]Use the default FTP inspection map—Specifies to use the default FTP map.

 
      		 [bookmark: pgfId-2383249]Select an FTP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2383250]Add—Opens the Add Policy Map dialog box for the inspection. 

 
     

 
    
 
     
      [bookmark: pgfId-2383256][bookmark: 54588]FTP Class Map

 
     [bookmark: pgfId-2383257]The FTP Class Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383258]Configuration > Global Objects > Class Maps > FTP

 
     [bookmark: pgfId-2383259]The FTP Class Map pane lets you configure FTP class maps for FTP inspection.

 
     [bookmark: pgfId-2383260]An inspection class map matches application traffic with criteria specific to the application. You then identify the class map in the inspect map and enable actions. The difference between creating a class map and defining the traffic match directly in the inspect map is that you can create more complex match criteria and you can reuse class maps. The applications that support inspection class maps are DNS, FTP, H.323, HTTP, IM, and SIP.

 
     [bookmark: pgfId-2383261]Fields

 
      
      		 [bookmark: pgfId-2383262]Name—Shows the FTP class map name.

 
      		 [bookmark: pgfId-2383263]Match Conditions—Shows the type, match criterion, and value in the class map.

 
     

 
     [bookmark: pgfId-2383264] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2383265] – Criterion—Shows the criterion of the FTP class map.

 
     [bookmark: pgfId-2383266] – Value—Shows the value to match in the FTP class map.

 
      
      		 [bookmark: pgfId-2383267]Description—Shows the description of the class map.

 
      		 [bookmark: pgfId-2383268]Add—Adds an FTP class map.

 
      		 [bookmark: pgfId-2383269]Edit—Edits an FTP class map.

 
      		 [bookmark: pgfId-2383270]Delete—Deletes an FTP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2383273][bookmark: 23344]Add/Edit FTP Traffic Class Map

 
     [bookmark: pgfId-2383274]The Add/Edit FTP Traffic Class Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383275]Configuration > Global Objects > Class Maps > FTP > Add/Edit FTP Traffic Class Map

 
     [bookmark: pgfId-2383276]The Add/Edit FTP Traffic Class Map dialog box lets you define a FTP class map.

 
     [bookmark: pgfId-2383277]Fields

 
      
      		 [bookmark: pgfId-2383278]Name—Enter the name of the FTP class map, up to 40 characters in length.

 
      		 [bookmark: pgfId-2383279]Description—Enter the description of the FTP class map.

 
      		 [bookmark: pgfId-2383280]Add—Adds an FTP class map.

 
      		 [bookmark: pgfId-2383281]Edit—Edits an FTP class map.

 
      		 [bookmark: pgfId-2383282]Delete—Deletes an FTP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2383285][bookmark: 82220]Add/Edit FTP Match Criterion

 
     [bookmark: pgfId-2383286]The Add/Edit FTP Match Criterion dialog box is accessible as follows:

 
     [bookmark: pgfId-2383287]Configuration > Global Objects > Class Maps > FTP > Add/Edit FTP Traffic Class Map > Add/Edit FTP Match Criterion

 
     [bookmark: pgfId-2383288]The Add/Edit FTP Match Criterion dialog box lets you define the match criterion and value for the FTP class map.

 
     [bookmark: pgfId-2383289]Fields 

 
      
      		 [bookmark: pgfId-2383290]Match Type—Specifies whether the class map includes traffic that matches the criterion, or traffic that does not match the criterion. 

 
     

 
     [bookmark: pgfId-2383291]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2383292]Criterion—Specifies which criterion of FTP traffic to match.

 
     

 
     [bookmark: pgfId-2383293] – Request-Command—Match an FTP request command.

 
     [bookmark: pgfId-2383294] – File Name—Match a filename for FTP transfer.

 
     [bookmark: pgfId-2383295] – File Type—Match a file type for FTP transfer.

 
     [bookmark: pgfId-2383296] – Server—Match an FTP server.

 
     [bookmark: pgfId-2383297] – User Name—Match an FTP user.

 
      
      		 [bookmark: pgfId-2383298]Request-Command Criterion Values—Specifies the value details for the FTP request command match.

 
     

 
     [bookmark: pgfId-2383299] – Request Command—Lets you select one or more request commands to match.

 
     [bookmark: pgfId-2383300]APPE—Append to a file.

 
     [bookmark: pgfId-2383301]CDUP—Change to the parent of the current directory.

 
     [bookmark: pgfId-2383302]DELE—Delete a file at the server site.

 
     [bookmark: pgfId-2383303]GET—FTP client command for the retr (retrieve a file) command.

 
     [bookmark: pgfId-2383304]HELP—Help information from the server.

 
     [bookmark: pgfId-2383305]MKD—Create a directory.

 
     [bookmark: pgfId-2383306]PUT—FTP client command for the stor (store a file) command.

 
     [bookmark: pgfId-2383307]RMD—Remove a directory.

 
     [bookmark: pgfId-2383308]RNFR—Rename from.

 
     [bookmark: pgfId-2383309]RNTO—Rename to.

 
     [bookmark: pgfId-2383310]SITE—Specify a server specific command.

 
     [bookmark: pgfId-2383311]STOU—Store a file with a unique name.

 
      
      		 [bookmark: pgfId-2383312]File Name Criterion Values—Specifies to match on the FTP transfer filename.

 
     

 
     [bookmark: pgfId-2383313] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383314] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383315] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383316] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383317]File Type Criterion Values—Specifies to match on the FTP transfer file type.

 
     

 
     [bookmark: pgfId-2383318] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383319] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383320] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383321] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383322]Server Criterion Values—Specifies to match on the FTP server.

 
     

 
     [bookmark: pgfId-2383323] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383324] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383325] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383326] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383327]User Name Criterion Values—Specifies to match on the FTP user.

 
     

 
     [bookmark: pgfId-2383328] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383329] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383330] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383331] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
    
 
     
      [bookmark: pgfId-2383334][bookmark: 63128]FTP Inspect Map

 
     [bookmark: pgfId-2383335]The FTP Inspect Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383336]Configuration > Global Objects > Inspect Maps > FTP

 
     [bookmark: pgfId-2383338][bookmark: marker-2383337]The FTP pane lets you view previously configured FTP application inspection maps. An FTP map lets you change the default configuration values used for FTP application inspection. 

 
     [bookmark: pgfId-2383339]FTP command filtering and security checks are provided using strict FTP inspection for improved security and control. Protocol conformance includes packet length checks, delimiters and packet format checks, command terminator checks, and command validation. 

 
     [bookmark: pgfId-2383340]Blocking FTP based on user values is also supported so that it is possible for FTP sites to post files for download, but restrict access to certain users. You can block FTP connections based on file type, server name, and other attributes. System message logs are generated if an FTP connection is denied after inspection.

 
     [bookmark: pgfId-2383341]Fields

 
      
      		 [bookmark: pgfId-2383342]FTP Inspect Maps—Table that lists the defined FTP inspect maps. 

 
      		 [bookmark: pgfId-2383343]Add—Configures a new FTP inspect map. To edit an FTP inspect map, choose the FTP entry in the FTP Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-2383344]Delete—Deletes the inspect map selected in the FTP Inspect Maps table.

 
      		 [bookmark: pgfId-2383345]Security Level—Select the security level (medium or low).

 
     

 
     [bookmark: pgfId-2383346] – Low

 
     [bookmark: pgfId-2383347]Mask Banner Disabled

 
     [bookmark: pgfId-2383348]Mask Reply Disabled

 
     [bookmark: pgfId-2383349] – Medium—Default.

 
     [bookmark: pgfId-2383350]Mask Banner Enabled

 
     [bookmark: pgfId-2383351]Mask Reply Enabled

 
     [bookmark: pgfId-2383352] – File Type Filtering—Opens the Type Filtering dialog box to configure file type filters.

 
     [bookmark: pgfId-2383353] – Customize—Opens the Add/Edit FTP Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2383354] – Default Level—Sets the security level back to the default level of Medium.

 
    
 
     
      [bookmark: pgfId-2383356]File Type Filtering

 
     [bookmark: pgfId-2383357]The File Type Filtering dialog box is accessible as follows:

 
     [bookmark: pgfId-2383358]Configuration > Global Objects > Inspect Maps > FTP > MIME File Type Filtering

 
     [bookmark: pgfId-2383360][bookmark: marker-2383359]The File Type Filtering dialog box lets you configure the settings for a file type filter. 

 
     [bookmark: pgfId-2383361]Fields

 
      
      		 [bookmark: pgfId-2383362]Match Type—Shows the match type, which can be a positive or negative match. 

 
      		 [bookmark: pgfId-2383363]Criterion—Shows the criterion of the inspection.

 
      		 [bookmark: pgfId-2383364]Value—Shows the value to match in the inspection.

 
      		 [bookmark: pgfId-2383365]Action—Shows the action if the match condition is met.

 
      		 [bookmark: pgfId-2383366]Log—Shows the log state.

 
      		 [bookmark: pgfId-2383367]Add—Opens the Add File Type Filter dialog box to add a file type filter.

 
      		 [bookmark: pgfId-2383368]Edit—Opens the Edit File Type Filter dialog box to edit a file type filter.

 
      		 [bookmark: pgfId-2383369]Delete—Deletes a file type filter.

 
      		 [bookmark: pgfId-2383370]Move Up—Moves an entry up in the list.

 
      		 [bookmark: pgfId-2383371]Move Down—Moves an entry down in the list.

 
     

 
    
 
     
      [bookmark: pgfId-2383373]Add/Edit FTP Policy Map (Security Level)

 
     [bookmark: pgfId-2383374]The Add/Edit FTP Policy Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383375]Configuration > Global Objects > Inspect Maps > FTP > FTP Inspect Map > Basic View

 
     [bookmark: pgfId-2383376]The Add/Edit FTP Policy Map pane lets you configure the security level and additional settings for FTP application inspection maps.

 
     [bookmark: pgfId-2383377]Fields

 
      
      		 [bookmark: pgfId-2383378]Name—When adding an FTP map, enter the name of the FTP map. When editing an FTP map, the name of the previously configured FTP map is shown.

 
      		 [bookmark: pgfId-2383379]Description—Enter the description of the FTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2383380]Security Level—Select the security level (medium or low).

 
     

 
     [bookmark: pgfId-2383381] – Low

 
     [bookmark: pgfId-2383382]Mask Banner Disabled

 
     [bookmark: pgfId-2383383]Mask Reply Disabled

 
     [bookmark: pgfId-2383384] – Medium—Default.

 
     [bookmark: pgfId-2383385]Mask Banner Enabled

 
     [bookmark: pgfId-2383386]Mask Reply Enabled

 
     [bookmark: pgfId-2383387] – File Type Filtering—Opens the Type Filtering dialog box to configure file type filters.

 
     [bookmark: pgfId-2383388] – Default Level—Sets the security level back to the default level of Medium.

 
      
      		 [bookmark: pgfId-2383389]Details—Shows the Parameters and Inspections tabs to configure additional settings.

 
     

 
    
 
     
      [bookmark: pgfId-2383391]Add/Edit FTP Policy Map (Details)

 
     [bookmark: pgfId-2383392]The Add/Edit FTP Policy Map (Details) dialog box is accessible as follows:

 
     [bookmark: pgfId-2383393]Configuration > Global Objects > Inspect Maps > FTP > FTP Inspect Map > Advanced View

 
     [bookmark: pgfId-2383394]The Add/Edit FTP Policy Map pane lets you configure the security level and additional settings for FTP application inspection maps.

 
     [bookmark: pgfId-2383395]Fields

 
      
      		 [bookmark: pgfId-2383396]Name—When adding an FTP map, enter the name of the FTP map. When editing an FTP map, the name of the previously configured FTP map is shown.

 
      		 [bookmark: pgfId-2383397]Description—Enter the description of the FTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2383398]Security Level—Shows the security level and file type filtering settings to configure.

 
      		 [bookmark: pgfId-2383399]Parameters—Tab that lets you configure the parameters for the FTP inspect map.

 
     

 
     [bookmark: pgfId-2383400] – Mask greeting banner from the server—Masks the greeting banner from the FTP server to prevent the client from discovering server information.

 
     [bookmark: pgfId-2383401] – Mask reply to SYST command—Masks the reply to the syst command to prevent the client from discovering server information.

 
      
      		 [bookmark: pgfId-2383402]Inspections—Tab that shows you the FTP inspection configuration and lets you add or edit.

 
     

 
     [bookmark: pgfId-2383403] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2383404] – Criterion—Shows the criterion of the FTP inspection.

 
     [bookmark: pgfId-2383405] – Value—Shows the value to match in the FTP inspection.

 
     [bookmark: pgfId-2383406] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2383407] – Log—Shows the log state.

 
     [bookmark: pgfId-2383408] – Add—Opens the Add FTP Inspect dialog box to add an FTP inspection.

 
     [bookmark: pgfId-2383409] – Edit—Opens the Edit FTP Inspect dialog box to edit an FTP inspection.

 
     [bookmark: pgfId-2383410] – Delete—Deletes an FTP inspection.

 
     [bookmark: pgfId-2383411] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-2383412] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-2383414]Add/Edit FTP Map

 
     [bookmark: pgfId-2383415]The Add/Edit FTP Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383416]Configuration > Global Objects > Inspect Maps > FTP > FTP Inspect Map > Advanced View > Add/Edit FTP Inspect

 
     [bookmark: pgfId-2383417]The Add/Edit FTP Inspect dialog box lets you define the match criterion and value for the FTP inspect map.

 
     [bookmark: pgfId-2383418]Fields 

 
      
      		 [bookmark: pgfId-2383419]Single Match—Specifies that the FTP inspect has only one match statement.

 
      		 [bookmark: pgfId-2383420]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2383421]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2383422]Criterion—Specifies which criterion of FTP traffic to match.

 
     

 
     [bookmark: pgfId-2383423] – Request Command—Match an FTP request command.

 
     [bookmark: pgfId-2383424] – File Name—Match a filename for FTP transfer.

 
     [bookmark: pgfId-2383425] – File Type—Match a file type for FTP transfer.

 
     [bookmark: pgfId-2383426] – Server—Match an FTP server.

 
     [bookmark: pgfId-2383427] – User Name—Match an FTP user.

 
      
      		 [bookmark: pgfId-2383428]Request Command Criterion Values—Specifies the value details for FTP request command match.

 
     

 
     [bookmark: pgfId-2383429] – Request Command:

 
     [bookmark: pgfId-2383431][bookmark: marker-2383430]APPE—Command that appends to a file.

 
     [bookmark: pgfId-2383433][bookmark: marker-2383432]CDUP—Command that changes to the parent directory of the current working directory.

 
     [bookmark: pgfId-2383434]DELE—Command that deletes a file.

 
     [bookmark: pgfId-2383435]GET—Command that gets a file.

 
     [bookmark: pgfId-2383437][bookmark: marker-2383436]HELP—Command that provides help information.

 
     [bookmark: pgfId-2383438]MKD—Command that creates a directory.

 
     [bookmark: pgfId-2383439]PUT—Command that sends a file.

 
     [bookmark: pgfId-2383440]RMD—Command that deletes a directory.

 
     [bookmark: pgfId-2383442][bookmark: marker-2383441]RNFR—Command that specifies rename-from filename.

 
     [bookmark: pgfId-2383444][bookmark: marker-2383443]RNTO—Command that specifies rename-to filename.

 
     [bookmark: pgfId-2383446][bookmark: marker-2383445]SITE—Commands that are specific to the server system. Usually used for remote administration.

 
     [bookmark: pgfId-2383448][bookmark: marker-2383447]STOU—Command that stores a file using a unique filename.

 
      
      		 [bookmark: pgfId-2383449]File Name Criterion Values—Specifies the value details for FTP filename match.

 
     

 
     [bookmark: pgfId-2383450] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383451] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383452] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383453] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383454]File Type Criterion Values—Specifies the value details for FTP file type match.

 
     

 
     [bookmark: pgfId-2383455] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383456] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383457] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383458] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383459]Server Criterion Values—Specifies the value details for FTP server match.

 
     

 
     [bookmark: pgfId-2383460] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383461] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383462] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383463] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383464]User Name Criterion Values—Specifies the value details for FTP user name match.

 
     

 
     [bookmark: pgfId-2383465] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383466] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383467] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383468] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383469]Multiple Matches—Specifies multiple matches for the FTP inspection.

 
     

 
     [bookmark: pgfId-2383470] – FTP Traffic Class—Specifies the FTP traffic class match.

 
     [bookmark: pgfId-2383471] – Manage—Opens the Manage FTP Class Maps dialog box to add, edit, or delete FTP Class Maps.

 
      
      		 [bookmark: pgfId-2383472]Action—Reset.

 
      		 [bookmark: pgfId-2383473]Log—Enable or disable.

 
     

 
    
 
     
      [bookmark: pgfId-1144250][bookmark: 37986][bookmark: 90030]Verifying and Monitoring FTP Inspection

 
     [bookmark: pgfId-1191872]FTP application inspection generates the following log messages:

 
      
      		 [bookmark: pgfId-1191873]An Audit record 303002 is generated for each file that is retrieved or uploaded. 

 
      		 [bookmark: pgfId-1191874]The FTP command is checked to see if it is RETR or STOR and the retrieve and store commands are logged. 

 
      		 [bookmark: pgfId-1191875]The username is obtained by looking up a table providing the IP address.

 
      		 [bookmark: pgfId-1191876]The username, source IP address, destination IP address, NAT address, and the file operation are logged.

 
      		 [bookmark: pgfId-1191877]Audit record 201005 is generated if the secondary dynamic channel preparation failed due to memory shortage.

 
     

 
     [bookmark: pgfId-1191878]In conjunction with NAT, the FTP application inspection translates the IP address within the application payload. This is described in detail in RFC 959.

 
    
 
   
 
    
     [bookmark: pgfId-1514315] HTTP Inspection [bookmark: 53649][bookmark: marker-1514314]

 
    [bookmark: pgfId-1151964]This section describes the HTTP inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1311195]HTTP Inspection Overview

 
     		 [bookmark: pgfId-2383481]Select HTTP Map

 
     		 [bookmark: pgfId-2383485]HTTP Class Map

 
     		 [bookmark: pgfId-2383489]Add/Edit HTTP Traffic Class Map

 
     		 [bookmark: pgfId-2383493]Add/Edit HTTP Match Criterion

 
     		 [bookmark: pgfId-2383497]HTTP Inspect Map

 
     		 [bookmark: pgfId-2383501]“URI Filtering” section

 
     		 [bookmark: pgfId-2383505]“Add/Edit HTTP Policy Map (Security Level)” section

 
     		 [bookmark: pgfId-2383509]“Add/Edit HTTP Policy Map (Details)” section

 
     		 [bookmark: pgfId-2383513]“Add/Edit HTTP Map” section

 
    

 
     
      [bookmark: pgfId-1144259][bookmark: 15570]HTTP Inspection Overv[bookmark: marker-1345381]iew

 
     [bookmark: pgfId-1149160]Use the HTTP inspection engine to protect against specific attacks and other threats that are associated with HTTP traffic. HTTP inspection performs several functions:

 
      
      		 [bookmark: pgfId-1149161]Enhanced HTTP inspection

 
      		 [bookmark: pgfId-1149162]URL screening through N2H2 or Websense 

 
     

 
     [bookmark: pgfId-2014065]See Information About URL Filtering for information.

 
      
      		 [bookmark: pgfId-1149163]Java and ActiveX filtering

 
     

 
     [bookmark: pgfId-2383518]The latter two features are configured in conjunction with Filter rules.

 
     [bookmark: pgfId-1533748]The enhanced HTTP inspection feature, which is also known as an application firewall and is available when you configure an HTTP map, can help prevent attackers from using HTTP messages for circumventing network security policy. It verifies the following for all HTTP messages:

 
      
      		 [bookmark: pgfId-1360797]Conformance to RFC 2616

 
      		 [bookmark: pgfId-1360798]Use of RFC-defined methods only.

 
      		 [bookmark: pgfId-1360802]Compliance with the additional criteria.

 
     

 
    
 
     
      [bookmark: pgfId-2383525][bookmark: 21816]Select HTTP Map

 
     [bookmark: pgfId-2383526]The Select HTTP Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383527]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select HTTP Map

 
     [bookmark: pgfId-2383528]The Select HTTP Map dialog box lets you select or create a new HTTP map. An HTTP map lets you change the configuration values used for HTTP application inspection. The Select HTTP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2383529]Fields

 
      
      		 [bookmark: pgfId-2383530]Use the default HTTP inspection map—Specifies to use the default HTTP map.

 
      		 [bookmark: pgfId-2383531]Select an HTTP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2383532]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2383535][bookmark: 32661]HTTP Class Map

 
     [bookmark: pgfId-2383536]The HTTP Class Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383537]Configuration > Global Objects > Class Maps > HTTP

 
     [bookmark: pgfId-2383538]The HTTP Class Map pane lets you configure HTTP class maps for HTTP inspection.

 
     [bookmark: pgfId-2383539]An inspection class map matches application traffic with criteria specific to the application. You then identify the class map in the inspect map and enable actions. The difference between creating a class map and defining the traffic match directly in the inspect map is that you can create more complex match criteria and you can reuse class maps. The applications that support inspection class maps are DNS, FTP, H.323, HTTP, IM, and SIP.

 
     [bookmark: pgfId-2383540]Fields

 
      
      		 [bookmark: pgfId-2383541]Name—Shows the HTTP class map name.

 
      		 [bookmark: pgfId-2383542]Match Conditions—Shows the type, match criterion, and value in the class map.

 
     

 
     [bookmark: pgfId-2383543] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2383544] – Criterion—Shows the criterion of the HTTP class map.

 
     [bookmark: pgfId-2383545] – Value—Shows the value to match in the HTTP class map.

 
      
      		 [bookmark: pgfId-2383546]Description—Shows the description of the class map.

 
      		 [bookmark: pgfId-2383547]Add—Adds an HTTP class map.

 
      		 [bookmark: pgfId-2383548]Edit—Edits an HTTP class map.

 
      		 [bookmark: pgfId-2383549]Delete—Deletes an HTTP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2383552][bookmark: 42318]Add/Edit HTTP Traffic Class Map

 
     [bookmark: pgfId-2383553]The Add/Edit HTTP Traffic Class Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383554]Configuration > Global Objects > Class Maps > HTTP > Add/Edit HTTP Traffic Class Map

 
     [bookmark: pgfId-2383555]The Add/Edit HTTP Traffic Class Map dialog box lets you define a HTTP class map.

 
     [bookmark: pgfId-2383556]Fields

 
      
      		 [bookmark: pgfId-2383557]Name—Enter the name of the HTTP class map, up to 40 characters in length.

 
      		 [bookmark: pgfId-2383558]Description—Enter the description of the HTTP class map.

 
      		 [bookmark: pgfId-2383559]Add—Adds an HTTP class map.

 
      		 [bookmark: pgfId-2383560]Edit—Edits an HTTP class map.

 
      		 [bookmark: pgfId-2383561]Delete—Deletes an HTTP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2383564][bookmark: 43224]Add/Edit HTTP Match Criterion

 
     [bookmark: pgfId-2383565]The Add/Edit HTTP Match Criterion dialog box is accessible as follows:

 
     [bookmark: pgfId-2383566]Configuration > Global Objects > Class Maps > HTTP > Add/Edit HTTP Traffic Class Map > Add/Edit HTTP Match Criterion

 
     [bookmark: pgfId-2383567]The Add/Edit HTTP Match Criterion dialog box lets you define the match criterion and value for the HTTP class map.

 
     [bookmark: pgfId-2383568]Fields 

 
      
      		 [bookmark: pgfId-2383569]Match Type—Specifies whether the class map includes traffic that matches the criterion, or traffic that does not match the criterion. 

 
     

 
     [bookmark: pgfId-2383570]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2383571]Criterion—Specifies which criterion of HTTP traffic to match.

 
     

 
     [bookmark: pgfId-2383572] – Request/Response Content Type Mismatch—Specifies that the content type in the response must match one of the MIME types in the accept field of the request.

 
     [bookmark: pgfId-2383573] – Request Arguments—Applies the regular expression match to the arguments of the request.

 
     [bookmark: pgfId-2383574]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383575]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383576]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383577]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383578] – Request Body Length—Applies the regular expression match to the body of the request with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383579]Greater Than Length—Enter a field length value in bytes that request field lengths will be matched against.

 
     [bookmark: pgfId-2383580] – Request Body—Applies the regular expression match to the body of the request.

 
     [bookmark: pgfId-2383581]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383582]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383583]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383584]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383585] – Request Header Field Count—Applies the regular expression match to the header of the request with a maximum number of header fields.

 
     [bookmark: pgfId-2383586]Predefined—Specifies the request header fields: accept, accept-charset, accept-encoding, accept-language, allow, authorization, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, cookie, date, expect, expires, from, host, if-match, if-modified-since, if-none-match, if-range, if-unmodified-since, last-modified, max-forwards, pragma, proxy-authorization, range, referer, te, trailer, transfer-encoding, upgrade, user-agent, via, warning.

 
     [bookmark: pgfId-2383587]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383588]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383589]Greater Than Count—Enter the maximum number of header fields.

 
     [bookmark: pgfId-2383590] – Request Header Field Length—Applies the regular expression match to the header of the request with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383591]Predefined—Specifies the request header fields: accept, accept-charset, accept-encoding, accept-language, allow, authorization, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, cookie, date, expect, expires, from, host, if-match, if-modified-since, if-none-match, if-range, if-unmodified-since, last-modified, max-forwards, pragma, proxy-authorization, range, referer, te, trailer, transfer-encoding, upgrade, user-agent, via, warning.

 
     [bookmark: pgfId-2383592]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383593]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383594]Greater Than Length—Enter a field length value in bytes that request field lengths will be matched against.

 
     [bookmark: pgfId-2383595] – Request Header Field—Applies the regular expression match to the header of the request.

 
     [bookmark: pgfId-2383596]Predefined—Specifies the request header fields: accept, accept-charset, accept-encoding, accept-language, allow, authorization, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, cookie, date, expect, expires, from, host, if-match, if-modified-since, if-none-match, if-range, if-unmodified-since, last-modified, max-forwards, pragma, proxy-authorization, range, referer, te, trailer, transfer-encoding, upgrade, user-agent, via, warning.

 
     [bookmark: pgfId-2383597]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383598]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383599]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383600]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383601] – Request Header Count—Applies the regular expression match to the header of the request with a maximum number of headers.

 
     [bookmark: pgfId-2383602]Greater Than Count—Enter the maximum number of headers.

 
     [bookmark: pgfId-2383603] – Request Header Length—Applies the regular expression match to the header of the request with length greater than the bytes specified.

 
     [bookmark: pgfId-2383604]Greater Than Length—Enter a header length value in bytes.

 
     [bookmark: pgfId-2383605] – Request Header non-ASCII—Matches non-ASCII characters in the header of the request.

 
     [bookmark: pgfId-2383606] – Request Method—Applies the regular expression match to the method of the request.

 
     [bookmark: pgfId-2383607]Method—Specifies to match on a request method: bcopy, bdelete, bmove, bpropfind, bproppatch, connect, copy, delete, edit, get, getattribute, getattributenames, getproperties, head, index, lock, mkcol, mkdir, move, notify, options, poll, post, propfind, proppatch, put, revadd, revlabel, revlog, revnum, save, search, setattribute, startrev, stoprev, subscribe, trace, unedit, unlock, unsubscribe. 

 
     [bookmark: pgfId-2383608]Regular Expression—Specifies to match on a regular expression.

 
     [bookmark: pgfId-2383609]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383610]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383611]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383612]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383613] – Request URI Length—Applies the regular expression match to the URI of the request with length greater than the bytes specified.

 
     [bookmark: pgfId-2383614]Greater Than Length—Enter a URI length value in bytes.

 
     [bookmark: pgfId-2383615] – Request URI—Applies the regular expression match to the URI of the request.

 
     [bookmark: pgfId-2383616]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383617]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383618]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383619]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383620] – Response Body—Applies the regex match to the body of the response.

 
     [bookmark: pgfId-2383621]ActiveX—Specifies to match on ActiveX.

 
     [bookmark: pgfId-2383622]Java Applet—Specifies to match on a Java Applet.

 
     [bookmark: pgfId-2383623]Regular Expression—Specifies to match on a regular expression.

 
     [bookmark: pgfId-2383624]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383625]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383626]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383627]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383628] – Response Body Length—Applies the regular expression match to the body of the response with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383629]Greater Than Length—Enter a field length value in bytes that response field lengths will be matched against.

 
     [bookmark: pgfId-2383630] – Response Header Field Count—Applies the regular expression match to the header of the response with a maximum number of header fields.

 
     [bookmark: pgfId-2383631]Predefined—Specifies the response header fields: accept-ranges, age, allow, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, date, etag, expires, last-modified, location, pragma, proxy-authenticate, retry-after, server, set-cookie, trailer, transfer-encoding, upgrade, vary, via, warning, www-authenticate.

 
     [bookmark: pgfId-2383632]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383633]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383634]Greater Than Count—Enter the maximum number of header fields.

 
     [bookmark: pgfId-2383635] – Response Header Field Length—Applies the regular expression match to the header of the response with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383636]Predefined—Specifies the response header fields: accept-ranges, age, allow, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, date, etag, expires, last-modified, location, pragma, proxy-authenticate, retry-after, server, set-cookie, trailer, transfer-encoding, upgrade, vary, via, warning, www-authenticate.

 
     [bookmark: pgfId-2383637]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383638]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383639]Greater Than Length—Enter a field length value in bytes that response field lengths will be matched against.

 
     [bookmark: pgfId-2383640] – Response Header Field—Applies the regular expression match to the header of the response.

 
     [bookmark: pgfId-2383641]Predefined—Specifies the response header fields: accept-ranges, age, allow, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, date, etag, expires, last-modified, location, pragma, proxy-authenticate, retry-after, server, set-cookie, trailer, transfer-encoding, upgrade, vary, via, warning, www-authenticate.

 
     [bookmark: pgfId-2383642]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383643]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383644]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383645]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383646] – Response Header Count—Applies the regular expression match to the header of the response with a maximum number of headers.

 
     [bookmark: pgfId-2383647]Greater Than Count—Enter the maximum number of headers.

 
     [bookmark: pgfId-2383648] – Response Header Length—Applies the regular expression match to the header of the response with length greater than the bytes specified.

 
     [bookmark: pgfId-2383649]Greater Than Length—Enter a header length value in bytes.

 
     [bookmark: pgfId-2383650] – Response Header non-ASCII—Matches non-ASCII characters in the header of the response.

 
     [bookmark: pgfId-2383651] – Response Status Line—Applies the regular expression match to the status line.

 
     [bookmark: pgfId-2383652]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383653]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383654]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383655]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
    
 
     
      [bookmark: pgfId-2383658][bookmark: 34996]HTTP Inspect Map

 
     [bookmark: pgfId-2383659]The HTTP Inspect Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383660]Configuration > Global Objects > Inspect Maps > HTTP

 
     [bookmark: pgfId-2383663][bookmark: marker-2383661][bookmark: marker-2383662]The HTTP pane lets you view previously configured HTTP application inspection maps. An HTTP map lets [bookmark: marker-2383664]you change the default configuration values used for HTTP application inspection.

 
     [bookmark: pgfId-2383665]HTTP application inspection scans HTTP headers and body, and performs various checks on the data. These checks prevent various HTTP constructs, content types, and tunneling and messaging protocols from traversing the security appliance. 

 
     [bookmark: pgfId-2383666]HTTP application inspection can block tunneled applications and non-ASCII characters in HTTP requests and responses, preventing malicious content from reaching the web server. Size limiting of various elements in HTTP request and response headers, URL blocking, and HTTP server header type spoofing are also supported.

 
     [bookmark: pgfId-2383667]Fields

 
      
      		 [bookmark: pgfId-2383668]HTTP Inspect Maps—Table that lists the defined HTTP inspect maps. 

 
      		 [bookmark: pgfId-2383669]Add—Configures a new HTTP inspect map. To edit an HTTP inspect map, choose the HTTP entry in the HTTP Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-2383670]Delete—Deletes the inspect map selected in the HTTP Inspect Maps table.

 
      		 [bookmark: pgfId-2383671]Security Level—Select the security level (low, medium, or high).

 
     

 
     [bookmark: pgfId-2383672] – Low—Default.

 
     [bookmark: pgfId-2383673]Protocol violation action: Drop connection

 
     [bookmark: pgfId-2383674]Drop connections for unsafe methods: Disabled

 
     [bookmark: pgfId-2383675]Drop connections for requests with non-ASCII headers: Disabled

 
     [bookmark: pgfId-2383676]URI filtering: Not configured

 
     [bookmark: pgfId-2383677]Advanced inspections: Not configured

 
     [bookmark: pgfId-2383678] – Medium

 
     [bookmark: pgfId-2383679]Protocol violation action: Drop connection

 
     [bookmark: pgfId-2383680]Drop connections for unsafe methods: Allow only GET, HEAD, and POST

 
     [bookmark: pgfId-2383681]Drop connections for requests with non-ASCII headers: Disabled

 
     [bookmark: pgfId-2383682]URI filtering: Not configured

 
     [bookmark: pgfId-2383683]Advanced inspections: Not configured

 
     [bookmark: pgfId-2383684] – High

 
     [bookmark: pgfId-2383685]Protocol violation action: Drop connection and log

 
     [bookmark: pgfId-2383686]Drop connections for unsafe methods: Allow only GET and HEAD.

 
     [bookmark: pgfId-2383687]Drop connections for requests with non-ASCII headers: Enabled

 
     [bookmark: pgfId-2383688]URI filtering: Not configured

 
     [bookmark: pgfId-2383689]Advanced inspections: Not configured

 
     [bookmark: pgfId-2383690] – URI Filtering—Opens the URI Filtering dialog box to configure URI filters.

 
     [bookmark: pgfId-2383691] – Customize—Opens the Edit HTTP Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2383692] – Default Level—Sets the security level back to the default level of Medium.

 
    
 
     
      [bookmark: pgfId-2383695][bookmark: 92985]URI Filtering

 
     [bookmark: pgfId-2383696]The URI Filtering dialog box is accessible as follows:

 
     [bookmark: pgfId-2383697]Configuration > Global Objects > Inspect Maps > HTTP > URI Filtering

 
     [bookmark: pgfId-2383699][bookmark: marker-2383698]The URI Filtering dialog box lets you configure the settings for an URI filter. 

 
     [bookmark: pgfId-2383700]Fields

 
      
      		 [bookmark: pgfId-2383701]Match Type—Shows the match type, which can be a positive or negative match. 

 
      		 [bookmark: pgfId-2383702]Criterion—Shows the criterion of the inspection.

 
      		 [bookmark: pgfId-2383703]Value—Shows the value to match in the inspection.

 
      		 [bookmark: pgfId-2383704]Action—Shows the action if the match condition is met.

 
      		 [bookmark: pgfId-2383705]Log—Shows the log state.

 
      		 [bookmark: pgfId-2383706]Add—Opens the Add URI Filtering dialog box to add a URI filter.

 
      		 [bookmark: pgfId-2383707]Edit—Opens the Edit URI Filtering dialog box to edit a URI filter.

 
      		 [bookmark: pgfId-2383708]Delete—Deletes an URI filter.

 
      		 [bookmark: pgfId-2383709]Move Up—Moves an entry up in the list.

 
      		 [bookmark: pgfId-2383710]Move Down—Moves an entry down in the list.

 
     

 
    
 
     
      [bookmark: pgfId-2383713][bookmark: 14654]Add/Edit HTTP Policy Map (Security Level)

 
     [bookmark: pgfId-2383714]The Add/Edit HTTP Policy Map (Security Level) dialog box is accessible as follows:

 
     [bookmark: pgfId-2383715]Configuration > Global Objects > Inspect Maps > HTTP > HTTP Inspect Map > Basic View

 
     [bookmark: pgfId-2383716]The Add/Edit HTTP Policy Map pane lets you configure the security level and additional settings for HTTP application inspection maps.

 
     [bookmark: pgfId-2383717]Fields

 
      
      		 [bookmark: pgfId-2383718]Name—When adding an HTTP map, enter the name of the HTTP map. When editing an HTTP map, the name of the previously configured HTTP map is shown.

 
      		 [bookmark: pgfId-2383719]Description—Enter the description of the HTTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2383720]Security Level—Select the security level (low, medium, or high).

 
     

 
     [bookmark: pgfId-2383721] – Low—Default.

 
     [bookmark: pgfId-2383722]Protocol violation action: Drop connection

 
     [bookmark: pgfId-2383723]Drop connections for unsafe methods: Disabled

 
     [bookmark: pgfId-2383724]Drop connections for requests with non-ASCII headers: Disabled

 
     [bookmark: pgfId-2383725]URI filtering: Not configured

 
     [bookmark: pgfId-2383726]Advanced inspections: Not configured

 
     [bookmark: pgfId-2383727] – Medium

 
     [bookmark: pgfId-2383728]Protocol violation action: Drop connection

 
     [bookmark: pgfId-2383729]Drop connections for unsafe methods: Allow only GET, HEAD, and POST

 
     [bookmark: pgfId-2383730]Drop connections for requests with non-ASCII headers: Disabled

 
     [bookmark: pgfId-2383731]URI filtering: Not configured

 
     [bookmark: pgfId-2383732]Advanced inspections: Not configured

 
     [bookmark: pgfId-2383733] – High

 
     [bookmark: pgfId-2383734]Protocol violation action: Drop connection and log

 
     [bookmark: pgfId-2383735]Drop connections for unsafe methods: Allow only GET and HEAD.

 
     [bookmark: pgfId-2383736]Drop connections for requests with non-ASCII headers: Enabled

 
     [bookmark: pgfId-2383737]URI filtering: Not configured

 
     [bookmark: pgfId-2383738]Advanced inspections: Not configured

 
     [bookmark: pgfId-2383739] – URI Filtering—Opens the URI Filtering dialog box which lets you configure the settings for an URI filter.

 
     [bookmark: pgfId-2383740] – Default Level—Sets the security level back to the default.

 
      
      		 [bookmark: pgfId-2383741]Details—Shows the Parameters and Inspections tabs to configure additional settings.

 
     

 
    
 
     
      [bookmark: pgfId-2383744][bookmark: 53791]Add/Edit HTTP Policy Map (Details)

 
     [bookmark: pgfId-2383745]The Add/Edit HTTP Policy Map (Details) dialog box is accessible as follows:

 
     [bookmark: pgfId-2383746]Configuration > Global Objects > Inspect Maps > HTTP > HTTP Inspect Map > Advanced View

 
     [bookmark: pgfId-2383747]The Add/Edit HTTP Policy Map pane lets you configure the security level and additional settings for HTTP application inspection maps.

 
     [bookmark: pgfId-2383748]Fields

 
      
      		 [bookmark: pgfId-2383749]Name—When adding an HTTP map, enter the name of the HTTP map. When editing an HTTP map, the name of the previously configured HTTP map is shown.

 
      		 [bookmark: pgfId-2383750]Description—Enter the description of the HTTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2383751]Security Level—Shows the security level and URI filtering settings to configure.

 
      		 [bookmark: pgfId-2383752]Parameters—Tab that lets you configure the parameters for the HTTP inspect map.

 
     

 
     [bookmark: pgfId-2383753] – Check for protocol violations—Checks for HTTP protocol violations.

 
     [bookmark: pgfId-2383754]Action—Drop Connection, Reset, Log.

 
     [bookmark: pgfId-2383755]Log—Enable or disable.

 
     [bookmark: pgfId-2383756] – Spoof server string—Replaces the server HTTP header value with the specified string.

 
     [bookmark: pgfId-2383757]Spoof String—Enter a string to substitute for the server header field. Maximum is 82 characters.

 
     [bookmark: pgfId-2383758] – Body Match Maximum—The maximum number of characters in the body of an HTTP message that should be searched in a body match. Default is 200 bytes. A large number will have a significant impact on performance.

 
      
      		 [bookmark: pgfId-2383759]Inspections—Tab that shows you the HTTP inspection configuration and lets you add or edit.

 
     

 
     [bookmark: pgfId-2383760] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2383761] – Criterion—Shows the criterion of the HTTP inspection.

 
     [bookmark: pgfId-2383762] – Value—Shows the value to match in the HTTP inspection.

 
     [bookmark: pgfId-2383763] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2383764] – Log—Shows the log state.

 
     [bookmark: pgfId-2383765] – Add—Opens the Add HTTP Inspect dialog box to add an HTTP inspection.

 
     [bookmark: pgfId-2383766] – Edit—Opens the Edit HTTP Inspect dialog box to edit an HTTP inspection.

 
     [bookmark: pgfId-2383767] – Delete—Deletes an HTTP inspection.

 
     [bookmark: pgfId-2383768] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-2383769] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-2383772][bookmark: 32706]Add/Edit HTTP Map

 
     [bookmark: pgfId-2383773]The Add/Edit HTTP Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383774]Configuration > Global Objects > Inspect Maps > HTTP > HTTP Inspect Map > Advanced View > Add/Edit HTTP Inspect

 
     [bookmark: pgfId-2383775]The Add/Edit HTTP Inspect dialog box lets you define the match criterion and value for the HTTP inspect map.

 
     [bookmark: pgfId-2383776]Fields 

 
      
      		 [bookmark: pgfId-2383777]Single Match—Specifies that the HTTP inspect has only one match statement.

 
      		 [bookmark: pgfId-2383778]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2383779]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2383780]Criterion—Specifies which criterion of HTTP traffic to match.

 
     

 
     [bookmark: pgfId-2383781] – Request/Response Content Type Mismatch—Specifies that the content type in the response must match one of the MIME types in the accept field of the request.

 
     [bookmark: pgfId-2383782] – Request Arguments—Applies the regular expression match to the arguments of the request.

 
     [bookmark: pgfId-2383783]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383784]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383785]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383786]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383787] – Request Body Length—Applies the regular expression match to the body of the request with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383788]Greater Than Length—Enter a field length value in bytes that request field lengths will be matched against.

 
     [bookmark: pgfId-2383789] – Request Body—Applies the regular expression match to the body of the request.

 
     [bookmark: pgfId-2383790]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383791]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383792]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383793]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383794] – Request Header Field Count—Applies the regular expression match to the header of the request with a maximum number of header fields.

 
     [bookmark: pgfId-2383795]Predefined—Specifies the request header fields: accept, accept-charset, accept-encoding, accept-language, allow, authorization, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, cookie, date, expect, expires, from, host, if-match, if-modified-since, if-none-match, if-range, if-unmodified-since, last-modified, max-forwards, pragma, proxy-authorization, range, referer, te, trailer, transfer-encoding, upgrade, user-agent, via, warning.

 
     [bookmark: pgfId-2383796]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383797]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383798]Greater Than Count—Enter the maximum number of header fields.

 
     [bookmark: pgfId-2383799] – Request Header Field Length—Applies the regular expression match to the header of the request with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383800]Predefined—Specifies the request header fields: accept, accept-charset, accept-encoding, accept-language, allow, authorization, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, cookie, date, expect, expires, from, host, if-match, if-modified-since, if-none-match, if-range, if-unmodified-since, last-modified, max-forwards, pragma, proxy-authorization, range, referer, te, trailer, transfer-encoding, upgrade, user-agent, via, warning.

 
     [bookmark: pgfId-2383801]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383802]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383803]Greater Than Length—Enter a field length value in bytes that request field lengths will be matched against.

 
     [bookmark: pgfId-2383804] – Request Header Field—Applies the regular expression match to the header of the request.

 
     [bookmark: pgfId-2383805]Predefined—Specifies the request header fields: accept, accept-charset, accept-encoding, accept-language, allow, authorization, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, cookie, date, expect, expires, from, host, if-match, if-modified-since, if-none-match, if-range, if-unmodified-since, last-modified, max-forwards, pragma, proxy-authorization, range, referer, te, trailer, transfer-encoding, upgrade, user-agent, via, warning.

 
     [bookmark: pgfId-2383806]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383807]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383808]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383809]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383810] – Request Header Count—Applies the regular expression match to the header of the request with a maximum number of headers.

 
     [bookmark: pgfId-2383811]Greater Than Count—Enter the maximum number of headers.

 
     [bookmark: pgfId-2383812] – Request Header Length—Applies the regular expression match to the header of the request with length greater than the bytes specified.

 
     [bookmark: pgfId-2383813]Greater Than Length—Enter a header length value in bytes.

 
     [bookmark: pgfId-2383814] – Request Header non-ASCII—Matches non-ASCII characters in the header of the request.

 
     [bookmark: pgfId-2383815] – Request Method—Applies the regular expression match to the method of the request.

 
     [bookmark: pgfId-2383816]Method—Specifies to match on a request method: bcopy, bdelete, bmove, bpropfind, bproppatch, connect, copy, delete, edit, get, getattribute, getattributenames, getproperties, head, index, lock, mkcol, mkdir, move, notify, options, poll, post, propfind, proppatch, put, revadd, revlabel, revlog, revnum, save, search, setattribute, startrev, stoprev, subscribe, trace, unedit, unlock, unsubscribe. 

 
     [bookmark: pgfId-2383817]Regular Expression—Specifies to match on a regular expression.

 
     [bookmark: pgfId-2383818]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383819]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383820]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383821]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383822] – Request URI Length—Applies the regular expression match to the URI of the request with length greater than the bytes specified.

 
     [bookmark: pgfId-2383823]Greater Than Length—Enter a URI length value in bytes.

 
     [bookmark: pgfId-2383824] – Request URI—Applies the regular expression match to the URI of the request.

 
     [bookmark: pgfId-2383825]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383826]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383827]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383828]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383829] – Response Body—Applies the regex match to the body of the response.

 
     [bookmark: pgfId-2383830]ActiveX—Specifies to match on ActiveX.

 
     [bookmark: pgfId-2383831]Java Applet—Specifies to match on a Java Applet.

 
     [bookmark: pgfId-2383832]Regular Expression—Specifies to match on a regular expression.

 
     [bookmark: pgfId-2383833]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383834]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383835]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383836]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383837] – Response Body Length—Applies the regular expression match to the body of the response with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383838]Greater Than Length—Enter a field length value in bytes that response field lengths will be matched against.

 
     [bookmark: pgfId-2383839] – Response Header Field Count—Applies the regular expression match to the header of the response with a maximum number of header fields.

 
     [bookmark: pgfId-2383840]Predefined—Specifies the response header fields: accept-ranges, age, allow, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, date, etag, expires, last-modified, location, pragma, proxy-authenticate, retry-after, server, set-cookie, trailer, transfer-encoding, upgrade, vary, via, warning, www-authenticate.

 
     [bookmark: pgfId-2383841]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383842]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383843]Greater Than Count—Enter the maximum number of header fields.

 
     [bookmark: pgfId-2383844] – Response Header Field Length—Applies the regular expression match to the header of the response with field length greater than the bytes specified.

 
     [bookmark: pgfId-2383845]Predefined—Specifies the response header fields: accept-ranges, age, allow, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, date, etag, expires, last-modified, location, pragma, proxy-authenticate, retry-after, server, set-cookie, trailer, transfer-encoding, upgrade, vary, via, warning, www-authenticate.

 
     [bookmark: pgfId-2383846]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383847]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383848]Greater Than Length—Enter a field length value in bytes that response field lengths will be matched against.

 
     [bookmark: pgfId-2383849] – Response Header Field—Applies the regular expression match to the header of the response.

 
     [bookmark: pgfId-2383850]Predefined—Specifies the response header fields: accept-ranges, age, allow, cache-control, connection, content-encoding, content-language, content-length, content-location, content-md5, content-range, content-type, date, etag, expires, last-modified, location, pragma, proxy-authenticate, retry-after, server, set-cookie, trailer, transfer-encoding, upgrade, vary, via, warning, www-authenticate.

 
     [bookmark: pgfId-2383851]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383852]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383853]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383854]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2383855] – Response Header Count—Applies the regular expression match to the header of the response with a maximum number of headers.

 
     [bookmark: pgfId-2383856]Greater Than Count—Enter the maximum number of headers.

 
     [bookmark: pgfId-2383857] – Response Header Length—Applies the regular expression match to the header of the response with length greater than the bytes specified.

 
     [bookmark: pgfId-2383858]Greater Than Length—Enter a header length value in bytes.

 
     [bookmark: pgfId-2383859] – Response Header non-ASCII—Matches non-ASCII characters in the header of the response.

 
     [bookmark: pgfId-2383860] – Response Status Line—Applies the regular expression match to the status line.

 
     [bookmark: pgfId-2383861]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2383862]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2383863]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2383864]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2383865]Multiple Matches—Specifies multiple matches for the HTTP inspection.

 
     

 
     [bookmark: pgfId-2383866] – H323 Traffic Class—Specifies the HTTP traffic class match.

 
     [bookmark: pgfId-2383867] – Manage—Opens the Manage HTTP Class Maps dialog box to add, edit, or delete HTTP Class Maps.

 
      
      		 [bookmark: pgfId-2383868]Action—Drop connection, reset, or log.

 
      		 [bookmark: pgfId-2383869]Log—Enable or disable.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1541255][bookmark: 53480]ICMP Inspection

 
    [bookmark: pgfId-1541256]The ICMP inspection engine allows ICMP traffic to have a “session” so it can be inspected like TCP and UDP traffic. Without the ICMP inspection engine, we recommend that you do not allow ICMP through the ASA in an ACL. Without stateful inspection, ICMP can be used to attack your network. The ICMP inspection engine ensures that there is only one response for each request, and that the sequence number is correct.

 
   
 
    
     [bookmark: pgfId-1541261][bookmark: 24298]ICMP Error Inspection

 
    [bookmark: pgfId-1541265]When this feature is enabled, the ASA creates translation sessions for intermediate hops that send ICMP error messages, based on the NAT configuration. The ASA overwrites the packet with the translated IP addresses.

 
    [bookmark: pgfId-1541272]When disabled, the ASA does not create translation sessions for intermediate nodes that generate ICMP error messages. ICMP error messages generated by the intermediate nodes between the inside host and the ASA reach the outside host without consuming any additional NAT resource. This is undesirable when an outside host uses the traceroute command to trace the hops to the destination on the inside of the ASA. When the ASA does not translate the intermediate hops, all the intermediate hops appear with the mapped destination IP address.

 
    [bookmark: pgfId-1541282]The ICMP payload is scanned to retrieve the five-tuple from the original packet. Using the retrieved five-tuple, a lookup is performed to determine the original address of the client. The ICMP error inspection engine makes the following changes to the ICMP packet:

 
     
     		 [bookmark: pgfId-1541283]In the IP Header, the mapped IP is changed to the real IP (Destination Address) and the IP checksum is modified.

 
     		 [bookmark: pgfId-1541284]In the ICMP Header, the ICMP checksum is modified due to the changes in the ICMP packet.

 
     		 [bookmark: pgfId-1541285]In the Payload, the following changes are made:

 
    

 
    [bookmark: pgfId-1541286] – Original packet mapped IP is changed to the real IP

 
    [bookmark: pgfId-1541287] – Original packet mapped port is changed to the real Port

 
    [bookmark: pgfId-1541288] – Original packet IP checksum is recalculated

 
   
 
    
     [bookmark: pgfId-1479354][bookmark: 71266]Instant Messaging Inspection

 
    [bookmark: pgfId-1480821]This section describes the IM inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1480825]IM Inspection Overview

 
     		 [bookmark: pgfId-2383877]Select IM Map

 
    

 
     
      [bookmark: pgfId-1480861][bookmark: 78910]IM Inspection Overview

 
     [bookmark: pgfId-1480883]The IM inspect engine lets you apply fine grained controls on the IM application to control the network usage and stop leakage of confidential data, propagation of worms, and other threats to the corporate network. 

 
    
 
     
      [bookmark: pgfId-2383883]Adding a Class Map for IM Inspection

 
     [bookmark: pgfId-2383884]Use the Add Service Policy Rule Wizard - Rule Actions dialog box to configure IP Options inspection. 

 
     [bookmark: pgfId-2383885]This wizard is available from the Configuration > Firewall > Service Policy Rules > Add > Add Service Policy Rule Wizard - Rule Actions dialog box. 

 
     
 
     [bookmark: pgfId-2383886]Step 1 Choose Configuration > Firewall > Objects > Class Maps > Instant Messaging (IM). The table displaying the configured class maps for Instant Messaging Inspection appears. 

 
     [bookmark: pgfId-2383887]Step 2 To add a new class map, click Add. The Add Instant Messaging (IM) Traffic Class Map dialog box appears. 

 
     [bookmark: pgfId-2383888]Step 3 Enter a name for the class map. 

 
     [bookmark: pgfId-2383889]Step 4 (Optional) Enter a description for the class map. The description can contain up to 200 characters. 

 
     [bookmark: pgfId-2383890]Step 5 In the Match Option field, click an option for the class map:

 
      
       
       		 [bookmark: pgfId-2383891]Match All—Specifies that traffic must match all criteria to match the class map. By default, the Match All option is selected.

 
       		 [bookmark: pgfId-2383892]Match Any—Specifies that the traffic matches the class map if it matches at least one of the criteria. 

 
      

 
     

 
     [bookmark: pgfId-2383894]Step 6 Click Add to add a match criteria for the class map. The Add Instant Messaging (IM) Match Criterion dialog box appears. 

 
     [bookmark: pgfId-2383895]Step 7 In the Match Type field, click the Match or No Match radio button. 

 
     [bookmark: pgfId-2383896]Step 8 In the Criterion drop-down list, select one of the following options and specify the criteria value. Depending on which option you select, the Value fields dynamically refresh to display the appropriate values for that criteria.

 
      
       
       		 [bookmark: pgfId-2383897]Protocol—Select to match traffic of a specific IM protocol, such as Yahoo Messenger or MSN Messenger.

 
       		 [bookmark: pgfId-2383898]Service—Select to match a specific IM service, such as chat, file-transfer, webcam, voice-chat, conference, or games.

 
       		 [bookmark: pgfId-2383899]Version—Select to match the version of the IM message. In the Value fields, click the  Regular Expression or  Regular Expression Class option and select an expression from the drop-down list. 

 
      

 
     

 
     [bookmark: pgfId-2383906]See Configuring Regular Expressions in the general operations configuration guide. 

 
      
       
       		 [bookmark: pgfId-2383907]Client Login Name—Select to match the source login name of the IM message. In the Value fields, click the  Regular Expression or  Regular Expression Class option and select an expression from the drop-down list. 

 
      

 
     

 
     [bookmark: pgfId-2383914]See Configuring Regular Expressions in the general operations configuration guide.

 
      
       
       		 [bookmark: pgfId-2383915]Client Peer Login Name—Select to match the destination login name of the IM message. In the Value fields, click the  Regular Expression or  Regular Expression Class option and select an expression from the drop-down list. 

 
      

 
     

 
     [bookmark: pgfId-2383922]See Configuring Regular Expressions in the general operations configuration guide.

 
      
       
       		 [bookmark: pgfId-2383923]Source IP Address—Select to match the source IP address of the IM message. In the Value fields, enter the IP address and netmask of the message source.

 
       		 [bookmark: pgfId-2383924]Destination IP Address—Select to match the destination IP address of the IM message. In the Value fields, enter the IP address and netmask of the message destination. 

 
       		 [bookmark: pgfId-2383925]Filename—Select to match the filename of the IM message. In the Value fields, click the  Regular Expression or  Regular Expression Class option and select an expression from the drop-down list. 

 
      

 
     

 
     [bookmark: pgfId-2383932]See Configuring Regular Expressions in the general operations configuration guide.

 
     [bookmark: pgfId-2383933]Step 9 Click OK to save the criteria. The Add Instant Messaging (IM) Match Criterion dialog box closes and the criteria appears in the Match Criterion table. 

 
     [bookmark: pgfId-2383934]Step 10 Click OK to save the class map. 

 
     [bookmark: pgfId-2383935]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2383943][bookmark: 52811]Select IM Map 

 
     [bookmark: pgfId-2383944]The Select IM Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2383945]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select IM Map

 
     [bookmark: pgfId-2383946]The Select IM Map dialog box lets you select or create a new IM map. An IM map lets you change the configuration values used for IM application inspection. The Select IM Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2383947]Fields

 
      
      		 [bookmark: pgfId-2383948]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1601468][bookmark: 68330]IP Options Inspection

 
    [bookmark: pgfId-1601469]This section describes the IP Options inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1601473]IP Options Inspection Overview

 
     		 [bookmark: pgfId-2383956]Configuring IP Options Inspection

 
     		 [bookmark: pgfId-2383960]Select IP Options Inspect Map

 
     		 [bookmark: pgfId-2383964]IP Options Inspect Map

 
     		 [bookmark: pgfId-2383968]Add/Edit IP Options Inspect Map

 
    

 
     
      [bookmark: pgfId-1601479][bookmark: 57363]IP Options Inspection Overview

 
     [bookmark: pgfId-1601480]Each IP packet contains an IP header with the Options field. The Options field, commonly referred to as IP Options, provide for control functions that are required in some situations but unnecessary for most common communications. In particular, IP Options include provisions for time stamps, security, and special routing. Use of IP Options is optional, and the field can contain zero, one, or more options. 

 
     [bookmark: pgfId-1601481]You can configure IP Options inspection to control which IP packets with specific IP options are allowed through the ASA. Configuring this inspection instructs the ASA to allow a packet to pass or to clear the specified IP options and then allow the packet to pass. 

 
     [bookmark: pgfId-1601488]IP Options inspection can check for the following three IP options in a packet:

 
      
      		 [bookmark: pgfId-1601489]End of Options List (EOOL) or IP Option 0—This option, which contains just a single zero byte, appears at the end of all options to mark the end of a list of options. This might not coincide with the end of the header according to the header length. 

 
      		 [bookmark: pgfId-1601490]No Operation (NOP) or IP Option 1—The Options field in the IP header can contain zero, one, or more options, which makes the total length of the field variable. However, the IP header must be a multiple of 32 bits. If the number of bits of all options is not a multiple of 32 bits, the NOP option is used as “internal padding” to align the options on a 32-bit boundary. 

 
      		 [bookmark: pgfId-1601491]Router Alert (RTRALT) or IP Option 20—This option notifies transit routers to inspect the contents of the packet even when the packet is not destined for that router. This inspection is valuable when implementing RSVP and similar protocols require relatively complex processing from the routers along the packets delivery path.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1601494]Note IP Options inspection is included by default in the global inspection policy. Therefore, the ASA allows RSVP traffic that contains packets with the Router Alert option (option 20) when the ASA is in routed mode.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1601499]Dropping RSVP packets containing the Router Alert option can cause problems in VoIP implementations. 

 
     [bookmark: pgfId-1601503]When you configure the ASA to clear the Router Alert option from IP headers, the IP header changes in the following ways: 

 
      
      		 [bookmark: pgfId-1601504]The Options field is padded so that the field ends on a 32 bit boundary. 

 
      		 [bookmark: pgfId-1601505]Internet header length (IHL) changes. 

 
      		 [bookmark: pgfId-1601506]The total length of the packet changes.

 
      		 [bookmark: pgfId-1601507]The checksum is recomputed. 

 
     

 
     [bookmark: pgfId-1601508]If an IP header contains additional options other than EOOL, NOP, or RTRALT, regardless of whether the ASA is configured to allow these options, the ASA will drop the packet. 

 
    
 
     
      [bookmark: pgfId-2383974][bookmark: 97080]Configuring IP Options Inspection

 
     [bookmark: pgfId-2383975]Use the Add Service Policy Rule Wizard - Rule Actions dialog box to configure IP Options inspection. 

 
     [bookmark: pgfId-2383976]This wizard is available from the Configuration > Firewall > Service Policy Rules > Add > Add Service Policy Rule Wizard - Rule Actions dialog box. 

 
     
 
     [bookmark: pgfId-2383977]Step 1 Open the Add Service Policy Rule Wizard by selecting Configuration > Firewall > Service Policy Rules > Add.

 
     [bookmark: pgfId-2383978]Perform the steps to complete the Service Policy, Traffic Classification Criteria, and Traffic Match - Destination Port pages of the wizard. See the “Adding a Service Policy Rule for Through Traffic” section.

 
     [bookmark: pgfId-2383982]The Add Service Policy Rule Wizard - Rule Actions dialog box opens. 

 
     [bookmark: pgfId-2383983]Step 2 Check the IP-Options check box. 

 
     [bookmark: pgfId-2383984]Step 3 Click Configure.

 
     [bookmark: pgfId-2383985]The Select IP Options Inspect Map dialog box opens. 

 
     [bookmark: pgfId-2383986]Step 4 Perform one of the following:

 
      
      		 [bookmark: pgfId-2383987]Click the  Use the default IP-Options inspection map radio button to use the default IP Options map. The default map drops packets containing all the inspected IP options, namely End of Options List (EOOL), No Operation (NOP), and Router Alert (RTRALT).

 
      		 [bookmark: pgfId-2383988]Click the  Select an IP-Options inspect map for fine control over inspection radio button to select a defined application inspection map.

 
      		 [bookmark: pgfId-2383989]Click Add to open the Add IP-Options Inspect Map dialog box and create a new inspection map. 

 
     

 
     [bookmark: pgfId-2383990]Step 5 (Optional) If you clicked Add to create a new inspection map, define the following values for IP Options Inspection:

 
     [bookmark: pgfId-2383991] a. Enter a name for the inspection map. 

 
     [bookmark: pgfId-2383992] b. Enter a description for the inspection map, up to 200 characters long.

 
     [bookmark: pgfId-2383996] c. From the Parameters area, select which IP options you want to pass through the ASA or clear and then pass through the ASA:

 
     [bookmark: pgfId-2384000] – Allow packets with the End of Options List (EOOL) option

 
     [bookmark: pgfId-2384001]This option, which contains just a single zero byte, appears at the end of all options to mark the end of a list of options. This might not coincide with the end of the header according to the header length. 

 
     [bookmark: pgfId-2384002] – Allow packets with the No Operation (NOP) option

 
     [bookmark: pgfId-2384003]The Options field in the IP header can contain zero, one, or more options, which makes the total length of the field variable. However, the IP header must be a multiple of 32 bits. If the number of bits of all options is not a multiple of 32 bits, the NOP option is used as “internal padding” to align the options on a 32-bit boundary.

 
     [bookmark: pgfId-2384004] – Allow packets with the Router Alert (RTRALT) option

 
     [bookmark: pgfId-2384005]This option notifies transit routers to inspect the contents of the packet even when the packet is not destined for that router. This inspection is valuable when implementing RSVP and similar protocols require relatively complex processing from the routers along the packets delivery path.

 
     [bookmark: pgfId-2384006] – Clear the option value from the packets

 
     [bookmark: pgfId-2384007]When an option is checked, the Clear the option value from the packets check box becomes available for that option. Select the Clear the option value from the packets check box to clear the option from the packet before allowing the packet through the ASA.

 
     [bookmark: pgfId-2384011] d. Click OK.

 
     [bookmark: pgfId-2384012]Step 6 Click OK.

 
     [bookmark: pgfId-2384013]Step 7 Click Finish.

 
     [bookmark: pgfId-2384014]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2384017][bookmark: 22520]Select IP Options Inspect Map

 
     [bookmark: pgfId-2384018]The Select IP Options Inspect Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384019]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select IM Map

 
     [bookmark: pgfId-2384020]The Select IP-Options Inspect Map dialog box lets you select or create a new IP Options inspection map. Use this inspection map to control whether the ASA drops, passes, or clears IP packets containing the following IP options—End of Options List, No Operations, and Router Alert. 

 
     [bookmark: pgfId-2384024]Fields

 
      
      		 [bookmark: pgfId-2384025]Use the default IP-Options inspection map—Specifies to use the default IP Options map. The default map drops packets containing all the inspected IP options, namely End of Options List (EOOL), No Operation (NOP), and Router Alert (RTRALT).

 
      		 [bookmark: pgfId-2384026]Select an IP-Options map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2384027]Add—Opens the Add IP Options Inspect Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2384030][bookmark: 89688]IP Options Inspect Map

 
     [bookmark: pgfId-2384031]The IP Options Inspect Maps pane lets you view previously configured IP Options inspection maps. An IP Options inspection map lets you change the default configuration values used for IP Option inspection. 

 
     [bookmark: pgfId-2384032]You can configure IP Options inspection to control which IP packets with specific IP options are allowed through the security appliance. Configuring this inspection instructs the security appliance to allow a packet to pass or to clear the specified IP options and then allow the packet to pass. 

 
     [bookmark: pgfId-2384033]In particular, you can control whether the security appliance drops, clears, or passes packets containing the Router Alert (RTRALT) option. Dropping RSVP packets containing the Router Alert option can cause problems in VoIP implementations. Therefore, you can create IP Options inspection maps to pass packets containing the RTRALT option. 

 
     [bookmark: pgfId-2384034]Fields 

 
     [bookmark: pgfId-2384035]IP Options Inspect Maps—Table that lists the defined IP Options inspect maps. 

 
     [bookmark: pgfId-2384036]Add—Configures a new IP Options inspect map. 

 
     [bookmark: pgfId-2384037]Edit—Edits an existing IP Options inspect map. To edit an IP Options inspect map, choose the entry in the table and click Edit. 

 
     [bookmark: pgfId-2384038]Delete—Deletes the inspect map selected in the IP Options Inspect Maps table. 

 
    
 
     
      [bookmark: pgfId-2384041][bookmark: 72403]Add/Edit IP Options Inspect Map

 
     [bookmark: pgfId-2384042]The Add/Edit IP Options Inspect Map lets you configure the settings for IP Options inspection maps.

 
     [bookmark: pgfId-2384043]Fields 

 
      
      		 [bookmark: pgfId-2384044]Name—When adding an IP Options inspection map, enter the name of the map. When editing a map, the name of the previously configured map is shown. 

 
      		 [bookmark: pgfId-2384045]Description—Enter the description of the IP Options inspection map, up to 200 characters in length. 

 
      		 [bookmark: pgfId-2384049]Parameters—Select which IP options you want to pass through the ASA or clear and then pass through the ASA:

 
     

 
     [bookmark: pgfId-2384053] – Allow packets with the End of Options List (EOOL) option

 
     [bookmark: pgfId-2384054]This option, which contains just a single zero byte, appears at the end of all options to mark the end of a list of options. This might not coincide with the end of the header according to the header length. 

 
     [bookmark: pgfId-2384055] – Allow packets with the No Operation (NOP) option

 
     [bookmark: pgfId-2384056]The Options field in the IP header can contain zero, one, or more options, which makes the total length of the field variable. However, the IP header must be a multiple of 32 bits. If the number of bits of all options is not a multiple of 32 bits, the NOP option is used as “internal padding” to align the options on a 32-bit boundary.

 
     [bookmark: pgfId-2384057] – Allow packets with the Router Alert (RTRALT) option

 
     [bookmark: pgfId-2384058]This option notifies transit routers to inspect the contents of the packet even when the packet is not destined for that router. This inspection is valuable when implementing RSVP and similar protocols require relatively complex processing from the routers along the packets delivery path.

 
     [bookmark: pgfId-2384059] – Clear the option value from the packets

 
     [bookmark: pgfId-2384060]When an option is checked, the Clear the option value from the packets check box becomes available for that option. Select the Clear the option value from the packets check box to clear the option from the packet before allowing the packet through the ASA.

 
    
 
   
 
    
     [bookmark: pgfId-1553398][bookmark: 51666]IPsec Pass Through Inspection

 
    [bookmark: pgfId-1669473]This section describes the IPsec Pass Through inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1669523]IPsec Pass Through Inspection Overview

 
     		 [bookmark: pgfId-2384071]Select IPsec-Pass-Thru Map

 
     		 [bookmark: pgfId-2384075]IPsec Pass Through Inspect Map

 
     		 [bookmark: pgfId-2384079]Add/Edit IPsec Pass Thru Policy Map (Security Level)

 
     		 [bookmark: pgfId-2384083]Add/Edit IPsec Pass Thru Policy Map (Details)

 
    

 
     
      [bookmark: pgfId-1669442][bookmark: 15057]IPsec Pass Through Inspection Overview

 
     [bookmark: pgfId-1553438]Internet Protocol Security (IPsec) is a protocol suite for securing IP communications by authenticating and encrypting each IP packet of a data stream. IPsec also includes protocols for establishing mutual authentication between agents at the beginning of the session and negotiation of cryptographic keys to be used during the session. IPsec can be used to protect data flows between a pair of hosts (for example, computer users or servers), between a pair of security gateways (such as routers or firewalls), or between a security gateway and a host.

 
     [bookmark: pgfId-1553440]IPsec Pass Through application inspection provides convenient traversal of ESP (IP protocol 50) and AH (IP protocol 51) traffic associated with an IKE UDP port 500 connection. It avoids lengthy ACL configuration to permit ESP and AH traffic and also provides security using timeout and max connections. 

 
     [bookmark: pgfId-1553442]Specify IPsec Pass Through inspection parameters to identify a specific map to use for defining the parameters for the inspection. Configure a policy map for Specify IPsec Pass Through inspection to access the parameters configuration, which lets you specify the restrictions for ESP or AH traffic. You can set the per client max connections and the idle timeout in parameters configuration. 

 
     [bookmark: pgfId-1553820]NAT and non-NAT traffic is permitted. However, PAT is not supported. 

 
    
 
     
      [bookmark: pgfId-2384090][bookmark: 24901]Select IPsec-Pass-Thru Map

 
     [bookmark: pgfId-2384091]The Select IPsec-Pass-Thru Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384092]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select IPsec-Pass-Thru Map

 
     [bookmark: pgfId-2384093]The Select IPsec-Pass-Thru dialog box lets you select or create a new IPsec map. An IPsec map lets you change the configuration values used for IPsec application inspection. The Select IPsec Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2384094]Fields

 
      
      		 [bookmark: pgfId-2384095]Use the default IPsec inspection map—Specifies to use the default IPsec map.

 
      		 [bookmark: pgfId-2384096]Select an IPsec map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2384097]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2384100][bookmark: 85695]IPsec Pass Through Inspect Map

 
     [bookmark: pgfId-2384101]The IPsec Pass Through Inspect Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384102]Configuration > Global Objects > Inspect Maps > IPsec Pass Through

 
     [bookmark: pgfId-2384104][bookmark: marker-2384103]The IPsec Pass Through pane lets you view previously configured IPsec Pass Through application inspection maps. An IPsec Pass Through map lets you change the default configuration values used for IPsec Pass Through application inspection. You can use an IPsec Pass Through map to permit certain flows without using an ACL.

 
     [bookmark: pgfId-2384105]Fields

 
      
      		 [bookmark: pgfId-2384106]IPsec Pass Through Inspect Maps—Table that lists the defined IPsec Pass Through inspect maps. 

 
      		 [bookmark: pgfId-2384107]Add—Configures a new IPsec Pass Through inspect map. To edit an IPsec Pass Through inspect map, select the IPsec Pass Through entry in the IPsec Pass Through Inspect Maps table and click Customize.

 
      		 [bookmark: pgfId-2384108]Delete—Deletes the inspect map selected in the IPsec Pass Through Inspect Maps table.

 
      		 [bookmark: pgfId-2384109]Security Level—Select the security level (high or low).

 
     

 
     [bookmark: pgfId-2384110] – Low—Default.

 
     [bookmark: pgfId-2384111]Maximum ESP flows per client: Unlimited.

 
     [bookmark: pgfId-2384112]ESP idle timeout: 00:10:00.

 
     [bookmark: pgfId-2384113]Maximum AH flows per client: Unlimited.

 
     [bookmark: pgfId-2384114]AH idle timeout: 00:10:00.

 
     [bookmark: pgfId-2384115] – High

 
     [bookmark: pgfId-2384116]Maximum ESP flows per client:10.

 
     [bookmark: pgfId-2384117]ESP idle timeout: 00:00:30.

 
     [bookmark: pgfId-2384118]Maximum AH flows per client: 10.

 
     [bookmark: pgfId-2384119]AH idle timeout: 00:00:30.

 
     [bookmark: pgfId-2384120] – Customize—Opens the Add/Edit IPsec Pass Thru Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2384121] – Default Level—Sets the security level back to the default level of Low.

 
    
 
     
      [bookmark: pgfId-2384124][bookmark: 30247]Add/Edit IPsec Pass Thru Policy Map (Security Level)

 
     [bookmark: pgfId-2384125]The Add/Edit IPsec Pass Thru Policy Map (Security Level) dialog box is accessible as follows:

 
     [bookmark: pgfId-2384126]Configuration > Global Objects > Inspect Maps > IPsec Pass Through> IPsec Pass Through Inspect Map > Basic View

 
     [bookmark: pgfId-2384127]The Add/Edit IPsec Pass Thru Policy Map pane lets you configure the security level and additional settings for IPsec Pass Thru application inspection maps.

 
     [bookmark: pgfId-2384128]Fields

 
      
      		 [bookmark: pgfId-2384129]Name—When adding an IPsec Pass Thru map, enter the name of the IPsec Pass Thru map. When editing an IPsec Pass Thru map, the name of the previously configured IPsec Pass Thru map is shown.

 
      		 [bookmark: pgfId-2384130]Security Level—Select the security level (high or low).

 
     

 
     [bookmark: pgfId-2384131] – Low—Default.

 
     [bookmark: pgfId-2384132]Maximum ESP flows per client: Unlimited.

 
     [bookmark: pgfId-2384133]ESP idle timeout: 00:10:00.

 
     [bookmark: pgfId-2384134]Maximum AH flows per client: Unlimited.

 
     [bookmark: pgfId-2384135]AH idle timeout: 00:10:00.

 
     [bookmark: pgfId-2384136] – High

 
     [bookmark: pgfId-2384137]Maximum ESP flows per client:10.

 
     [bookmark: pgfId-2384138]ESP idle timeout: 00:00:30.

 
     [bookmark: pgfId-2384139]Maximum AH flows per client: 10.

 
     [bookmark: pgfId-2384140]AH idle timeout: 00:00:30.

 
     [bookmark: pgfId-2384141] – Default Level—Sets the security level back to the default level of Low.

 
      
      		 [bookmark: pgfId-2384142]Details—Shows additional parameter settings to configure.

 
     

 
    
 
     
      [bookmark: pgfId-2384145][bookmark: 13798]Add/Edit IPsec Pass Thru Policy Map (Details)

 
     [bookmark: pgfId-2384146]The Add/Edit IPsec Pass Thru Policy Map (Details) dialog box is accessible as follows:

 
     [bookmark: pgfId-2384147]Configuration > Global Objects > Inspect Maps >IPsec Pass Through > IPsec Pass Through Inspect Map > Advanced View

 
     [bookmark: pgfId-2384148]The Add/Edit IPsec Pass Thru Policy Map pane lets you configure the security level and additional settings for IPsec Pass Thru application inspection maps.

 
     [bookmark: pgfId-2384149]Fields

 
      
      		 [bookmark: pgfId-2384150]Name—When adding an IPsec Pass Thru map, enter the name of the IPsec Pass Thru map. When editing an IPsec Pass Thru map, the name of the previously configured IPsec Pass Thru map is shown.

 
      		 [bookmark: pgfId-2384151]Description—Enter the description of the IPsec Pass Through map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2384152]Security Level—Shows the security level settings to configure.

 
      		 [bookmark: pgfId-2384153]Parameters—Configures ESP and AH parameter settings.

 
     

 
     [bookmark: pgfId-2384154] – Limit ESP flows per client—Limits ESP flows per client.

 
     [bookmark: pgfId-2384155]Maximum—Specify maximum limit.

 
     [bookmark: pgfId-2384156] – Apply ESP idle timeout—Applies ESP idle timeout.

 
     [bookmark: pgfId-2384157]Timeout—Specify timeout.

 
     [bookmark: pgfId-2384158] – Limit AH flows per client—Limits AH flows per client.

 
     [bookmark: pgfId-2384159]Maximum—Specify maximum limit.

 
     [bookmark: pgfId-2384160] – Apply AH idle timeout—Applies AH idle timeout.

 
     [bookmark: pgfId-2384161]Timeout—Specify timeout.

 
    
 
   
 
    
     [bookmark: pgfId-1553824][bookmark: 44632]IPv6 Inspection

 
     
     		 [bookmark: pgfId-2319685]Information about IPv6 Inspection

 
     		 [bookmark: pgfId-2319699]Default Settings for IPv6 Inspection

 
     		 [bookmark: pgfId-2319711](Optional) Configuring an IPv6 Inspection Policy Map

 
     		 [bookmark: pgfId-2319719]Configuring IPv6 Inspection

 
    

 
     
      [bookmark: pgfId-2318135][bookmark: 95476]Information about IPv6 Inspection

 
     [bookmark: pgfId-2319670]IPv6 inspection lets you selectively log or drop IPv6 traffic based on the extension header. In addition, IPv6 inspection can check conformance to RFC 2460 for type and order of extension headers in IPv6 packets.

 
    
 
     
      [bookmark: pgfId-2319521][bookmark: 53464]Default Settings for IPv6 Inspection

 
     [bookmark: pgfId-2319581]If you enable IPv6 inspection and do not specify an inspection policy map, then the default IPv6 inspection policy map is used, and the following actions are taken:

 
      
      		 [bookmark: pgfId-2319906]Allows only known IPv6 extension headers

 
      		 [bookmark: pgfId-2319907]Enforces the order of IPv6 extension headers as defined in the RFC 2460 specification

 
     

 
     [bookmark: pgfId-2322383]If you create an inspection policy map, the above actions are taken by default unless you explicitly disable them.

 
    
 
     
      [bookmark: pgfId-2322388][bookmark: 28092](Optional) Configuring an IPv6 Inspection Policy Map 

 
     [bookmark: pgfId-2322389]To identify extension headers to drop or log, and/or to disable packet verification, create an IPv6 inspection policy map to be used by the service policy.

 
    
 
     
      [bookmark: pgfId-2314779]Detailed Steps

 
     
 
     [bookmark: pgfId-2384166]Step 1 Choose Configuration > Firewall > Objects > Inspect Maps > IPv6. The Configure IPv6 Maps pane appears. 

 
     [bookmark: pgfId-2384167]Step 2 Click Add. The Add IPv6 Inspection Map dialog box appears. 

 
     [bookmark: pgfId-2384168]Step 3 Enter a name and description for the inspection map.

 
     [bookmark: pgfId-2384169]By default, the Enforcement tab is selected and the following options are selected:

 
      
       
       		 [bookmark: pgfId-2384170]Permit only known extension headers

 
       		 [bookmark: pgfId-2384171]Enforce extension header order

 
      

 
     

 
     [bookmark: pgfId-2384175]When Permit only known extension headers is selected, the ASA verifies the IPv6 extension header. 

 
     [bookmark: pgfId-2384176]When Enforce extension header order is selected, the order of IPv6 extension headers as defined in the RFC 2460 Specification is enforced. 

 
     [bookmark: pgfId-2384180]When these options are specified and an error is detected, the ASA drops the packet and logs the action.

 
     [bookmark: pgfId-2384181]Step 4 To configure matching in the extension header, click the Header Matches tab.

 
     [bookmark: pgfId-2384183]Step 5 [bookmark: 72033]Click Add to add a match. The Add IPv6 Inspect dialog box appears. 

 
     [bookmark: pgfId-2384185] a. [bookmark: 62634]Select a criterion for the match.

 
     [bookmark: pgfId-2384189]When you select any of the following criteria, you can configure to the ASA to drop or log when an IPv6 packet arrives matching the criterion:

 
     [bookmark: pgfId-2384190] – Authentication (AH) header

 
     [bookmark: pgfId-2384191] – Destination Options header

 
     [bookmark: pgfId-2384192] – Encapsulating Security Payload (ESP) header

 
     [bookmark: pgfId-2384193] – Fragment header

 
     [bookmark: pgfId-2384194] – Hop-by-Hop Options header

 
     [bookmark: pgfId-2384195] – Routing header—When Routing header is selected and an IPv6 routing extension header is detected, the ASA takes the specified action when the routing type is matched or a number when the specified routing type range is matched. 

 
     [bookmark: pgfId-2384199] – Header count—When Header count is selected and an IPv6 routing extension header is detected, the ASA takes the specified action when number of IPv6 extension headers in the packet is more than the specified value.

 
     [bookmark: pgfId-2384203] – Routing header address count—When Routing header address count is selected, and an IPv6 routing extension header is detected, the ASA takes the specified action when the number of addresses in the type 0 routing header is more than the value you configure. 

 
     [bookmark: pgfId-2384207] b. Click OK to save the match criterion.

 
     [bookmark: pgfId-2384211]Step 6 Repeat Step 5 for each header you want to match.

 
     [bookmark: pgfId-2384212]Step 7 Click OK to save the IPv6 inspect map.

 
     [bookmark: pgfId-2384213]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-2322375][bookmark: 95358]Configuring IPv6 Inspection

 
     [bookmark: pgfId-2322376]To enable IPv6 inspection, perform the following steps.

 
    
 
     
      [bookmark: pgfId-2321652]Detailed Steps

 
     
 
     [bookmark: pgfId-2384218]Step 1 Configure a service policy on the Configuration > Firewall > Service Policy Rules pane according to Chapter1, “Configuring a Service Policy”

 
     [bookmark: pgfId-2384222]You can configure IPv6 inspection as part of a new service policy rule, or you can edit an existing service policy.

 
     [bookmark: pgfId-2384223]Step 2 On the Rule Actions dialog box, click the Protocol Inspections tab.

 
     [bookmark: pgfId-2384224]Step 3 Check the IPv6 check box.

 
     [bookmark: pgfId-2384225]Step 4 (Optional) To add an IPv6 inspection policy map that you configured in the “(Optional) Configuring an IPv6 Inspection Policy Map” section:

 
     [bookmark: pgfId-2384229] a. Click Configure.

 
     [bookmark: pgfId-2384230]The Select IPv6 Inspect Map dialog box appears.

 
     [bookmark: pgfId-2384231] b. Select the map name, and click OK.

 
     [bookmark: pgfId-2384232]Alternatively, you can click the Add button to add a new inspection policy map.

 
     [bookmark: pgfId-2384233]Step 5 Click OK or Finish.

 
     [bookmark: pgfId-2384234]

 
      
      
 
     
  
     

 
      
      [bookmark: pgfId-2318667]  
     
 
    
 
   
 
    
     [bookmark: pgfId-1956702][bookmark: 29467][bookmark: 22695]NetBIOS Inspection

 
    [bookmark: pgfId-1542124]This section describes the IM inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1542128]NetBIOS Inspection Overview

 
     		 [bookmark: pgfId-2384242]Select NETBIOS Map

 
     		 [bookmark: pgfId-2384246]“NetBIOS Inspect Map” section

 
     		 [bookmark: pgfId-2384250]“Add/Edit NetBIOS Policy Map” section

 
    

 
     
      [bookmark: pgfId-1542134][bookmark: 28149]NetBIOS Inspection Overview

 
     [bookmark: pgfId-1432890]NetBIOS inspection is enabled by default. The NetBios inspection engine translates IP addresses in the NetBios name service (NBNS) packets according to the ASA NAT configuration.

 
    
 
     
      [bookmark: pgfId-2384256][bookmark: 69768]Select NETBIOS Map

 
     [bookmark: pgfId-2384257]The Select NETBIOS Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384258]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select NetBIOS Map

 
     [bookmark: pgfId-2384259]The Select NETBIOS Map dialog box lets you select or create a new NetBIOS map. A NetBIOS map lets you change the configuration values used for NetBIOS application inspection. The Select NetBIOS Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2384260]Fields

 
      
      		 [bookmark: pgfId-2384261]Use the default IM inspection map—Specifies to use the default NetBIOS map.

 
      		 [bookmark: pgfId-2384262]Select a NetBIOS map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2384263]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2384266][bookmark: 46203]NetBIOS Inspect Map

 
     [bookmark: pgfId-2384267]The NetBIOS Inspect Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384268]Configuration > Global Objects > Inspect Maps > NetBIOS

 
     [bookmark: pgfId-2384269]The NetBIOS pane lets you view previously configured NetBIOS application inspection maps. A NetBIOS map lets you change the default configuration values used for NetBIOS application inspection. 

 
     [bookmark: pgfId-2384270]NetBIOS application inspection performs NAT for the embedded IP address in the NetBIOS name service packets and NetBIOS datagram services packets. It also enforces protocol conformance, checking the various count and length fields for consistency.

 
     [bookmark: pgfId-2384271]Fields

 
      
      		 [bookmark: pgfId-2384272]NetBIOS Inspect Maps—Table that lists the defined NetBIOS inspect maps. 

 
      		 [bookmark: pgfId-2384273]Add—Configures a new NetBIOS inspect map. 

 
      		 [bookmark: pgfId-2384274]Edit—Edits the selected NetBIOS entry in the NetBIOS Inspect Maps table.

 
      		 [bookmark: pgfId-2384275]Delete—Deletes the inspect map selected in the NetBIOS Inspect Maps table.

 
     

 
    
 
     
      [bookmark: pgfId-2384278][bookmark: 25452]Add/Edit NetBIOS Policy Map

 
     [bookmark: pgfId-2384279]The Add/Edit NetBIOS Policy Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384280]Configuration > Global Objects > Inspect Maps > NetBIOS > NetBIOS Inspect Map > View

 
     [bookmark: pgfId-2384281]The Add/Edit NetBIOS Policy Map pane lets you configure the protocol violation settings for NetBIOS application inspection maps.

 
     [bookmark: pgfId-2384282]Fields

 
      
      		 [bookmark: pgfId-2384283]Name—When adding a NetBIOS map, enter the name of the NetBIOS map. When editing an NetBIOS map, the name of the previously configured NetBIOS map is shown.

 
      		 [bookmark: pgfId-2384284]Description—Enter the description of the NetBIOS map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2384285]Check for protocol violations—Checks for protocol violations and executes specified action.

 
     

 
     [bookmark: pgfId-2384286] – Action—Drop packet or log.

 
     [bookmark: pgfId-2384287] – Log—Enable or disable.

 
    
 
   
 
    
     [bookmark: pgfId-1432892][bookmark: 20153]PPTP Inspection

 
    [bookmark: pgfId-1432913]PPTP is a protocol for tunneling PPP traffic. A PPTP session is composed of one TCP channel and usually two PPTP GRE tunnels. The TCP channel is the control channel used for negotiating and managing the PPTP GRE tunnels. The GRE tunnels carries PPP sessions between the two hosts.

 
    [bookmark: pgfId-1432914]When enabled, PPTP application inspection inspects PPTP protocol packets and dynamically creates the GRE connections and xlates necessary to permit PPTP traffic. Only Version 1, as defined in RFC 2637, is supported. 

 
    [bookmark: pgfId-1432915]PAT is only performed for the modified version of GRE [RFC 2637] when negotiated over the PPTP TCP control channel. Port Address Translation is not performed for the unmodified version of GRE [RFC 1701, RFC 1702].

 
    [bookmark: pgfId-1432919]Specifically, the ASA inspects the PPTP version announcements and the outgoing call request/response sequence. Only PPTP Version 1, as defined in RFC 2637, is inspected. Further inspection on the TCP control channel is disabled if the version announced by either side is not Version 1. In addition, the outgoing-call request and reply sequence are tracked. Connections and xlates are dynamic allocated as necessary to permit subsequent secondary GRE data traffic.

 
    [bookmark: pgfId-1432920]The PPTP inspection engine must be enabled for PPTP traffic to be translated by PAT. Additionally, PAT is only performed for a modified version of GRE (RFC2637) and only if it is negotiated over the PPTP TCP control channel. PAT is not performed for the unmodified version of GRE (RFC 1701 and RFC 1702).

 
    [bookmark: pgfId-1432921]As described in RFC 2637, the PPTP protocol is mainly used for the tunneling of PPP sessions initiated from a modem bank PAC (PPTP Access Concentrator) to the headend PNS (PPTP Network Server). When used this way, the PAC is the remote client and the PNS is the server.

 
    [bookmark: pgfId-1432922]However, when used for VPN by Windows, the interaction is inverted. The PNS is a remote single-user PC that initiates connection to the head-end PAC to gain access to a central network.

 
   
 
    
     [bookmark: pgfId-1224614][bookmark: 43596]SMTP and Extend[bookmark: marker-1345394]ed SMTP Inspection

 
    [bookmark: pgfId-1542168]This section describes the IM inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1631227]SMTP and ESMTP Inspection Overview

 
     		 [bookmark: pgfId-2384295]Select ESMTP Map

 
     		 [bookmark: pgfId-2384299]ESMTP Inspect Map

 
     		 [bookmark: pgfId-2384303]MIME File Type Filtering

 
     		 [bookmark: pgfId-2384307]Add/Edit ESMTP Policy Map (Security Level)

 
     		 [bookmark: pgfId-2384311]Add/Edit ESMTP Policy Map (Details)

 
     		 [bookmark: pgfId-2384315]Add/Edit ESMTP Inspect

 
    

 
     
      [bookmark: pgfId-1542178][bookmark: 42934]SMTP and ESMTP Inspection Overview

 
     [bookmark: pgfId-1224630]ESMTP application inspection provides improved protection against SMTP-based attacks by restricting the types of SMTP commands that can pass through the ASA and by adding monitoring capabilities. 

 
     [bookmark: pgfId-1224634]ESMTP is an enhancement to the SMTP protocol and is similar is most respects to SMTP. For convenience, the term SMTP is used in this document to refer to both SMTP and ESMTP. The application inspection process for extended SMTP is similar to SMTP application inspection and includes support for SMTP sessions. Most commands used in an extended SMTP session are the same as those used in an SMTP session but an ESMTP session is considerably faster and offers more options related to reliability and security, such as delivery status notification. 

 
     [bookmark: pgfId-1224635]Extended SMTP application inspection adds support for these extended SMTP commands, including AUTH, EHLO, ETRN, HELP, SAML, SEND, SOML, STARTTLS, and VRFY. Along with the support for seven RFC 821 commands (DATA, HELO, MAIL, NOOP, QUIT, RCPT, RSET), the ASA supports a total of fifteen SMTP commands. 

 
     [bookmark: pgfId-1224639]Other extended SMTP commands, such as ATRN, ONEX, VERB, CHUNKING, and private extensions and are not supported. Unsupported commands are translated into Xs, which are rejected by the internal server. This results in a message such as “500 Command unknown: 'XXX'.” Incomplete commands are discarded.

 
     [bookmark: pgfId-1224644]The ESMTP inspection engine changes the characters in the server SMTP banner to asterisks except for the “2”, “0”, “0” characters. Carriage return (CR) and linefeed (LF) characters are ignored.

 
     [bookmark: pgfId-1224645]With SMTP inspection enabled, a Telnet session used for interactive SMTP may hang if the following rules are not observed: SMTP commands must be at least four characters in length; must be terminated with carriage return and line feed; and must wait for a response before issuing the next reply.

 
     [bookmark: pgfId-1224647]An SMTP server responds to client requests with numeric reply codes and optional human-readable strings. SMTP application inspection controls and reduces the commands that the user can use as well as the messages that the server returns. SMTP inspection performs three primary tasks:

 
      
      		 [bookmark: pgfId-1224648]Restricts SMTP requests to seven basic SMTP commands and eight extended commands.

 
      		 [bookmark: pgfId-1224649]Monitors the SMTP command-response sequence.

 
      		 [bookmark: pgfId-1224650]Generates an audit trail—Audit record 108002 is generated when invalid character embedded in the mail address is replaced. For more information, see RFC 821. 

 
     

 
     [bookmark: pgfId-1224651]SMTP inspection monitors the command and response sequence for the following anomalous signatures:

 
      
      		 [bookmark: pgfId-1224652]Truncated commands.

 
      		 [bookmark: pgfId-1224653]Incorrect command termination (not terminated with <CR><LR>).

 
      		 [bookmark: pgfId-2264943]The MAIL and RCPT commands specify who are the sender and the receiver of the mail. Mail addresses are scanned for strange characters. The pipeline character (|) is deleted (changed to a blank space) and “<” ‚”>” are only allowed if they are used to define a mail address (“>” must be preceded by “<”). 

 
      		 [bookmark: pgfId-1224655]Unexpected transition by the SMTP server.

 
      		 [bookmark: pgfId-1224659]For unknown commands, the ASA changes all the characters in the packet to X. In this case, the server generates an error code to the client. Because of the change in the packed, the TCP checksum has to be recalculated or adjusted.

 
      		 [bookmark: pgfId-1224660]TCP stream editing.

 
      		 [bookmark: pgfId-1224661]Command pipelining.

 
     

 
    
 
     
      [bookmark: pgfId-2384322][bookmark: 77710]Select ESMTP Map

 
     [bookmark: pgfId-2384323]The Select ESMTP Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384324]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab >Select ESMTP Map

 
     [bookmark: pgfId-2384325]The Select ESMTP Map dialog box lets you select or create a new ESMTP map. An ESMTP map lets you change the configuration values used for ESMTP application inspection. The Select ESMTP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2384326]Fields

 
      
      		 [bookmark: pgfId-2384327]Use the default ESMTP inspection map—Specifies to use the default ESMTP map.

 
      		 [bookmark: pgfId-2384328]Select an ESMTP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2384329]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2384332][bookmark: 97900]ESMTP Inspect Map

 
     [bookmark: pgfId-2384333]The ESMTP Inspect Map dialog box is accessible as follows:

 
     [bookmark: pgfId-2384334]Configuration > Global Objects > Inspect Maps > ESMTP

 
     [bookmark: pgfId-2384337][bookmark: marker-2384335][bookmark: marker-2384336]The ESMTP pane lets you view previously configured ESMTP application inspection maps. An ESMTP map lets you change the default configuration values used for ESMTP application inspection. 

 
     [bookmark: pgfId-2384338]Since ESMTP traffic can be a main source of attack from spam, phising, malformed messages, buffer overflows, and buffer underflows, detailed packet inspection and control of ESMTP traffic are supported. Application security and protocol conformance enforce the sanity of the ESMTP message as well as detect several attacks, block senders and receivers, and block mail relay.

 
     [bookmark: pgfId-2384339]Fields

 
      
      		 [bookmark: pgfId-2384340]ESMTP Inspect Maps—Table that lists the defined ESMTP inspect maps. 

 
      		 [bookmark: pgfId-2384341]Add—Configures a new ESMTP inspect map. To edit an ESMTP inspect map, choose the ESMTP entry in the ESMTP Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-2384342]Delete—Deletes the inspect map selected in the ESMTP Inspect Maps table.

 
      		 [bookmark: pgfId-2384343]Security Level—Select the security level (high, medium, or low).

 
     

 
     [bookmark: pgfId-2384344] – Low—Default.

 
     [bookmark: pgfId-2384345]Log if command line length is greater than 512

 
     [bookmark: pgfId-2384346]Log if command recipient count is greater than 100

 
     [bookmark: pgfId-2384347]Log if body line length is greater than 1000

 
     [bookmark: pgfId-2384348]Log if sender address length is greater than 320

 
     [bookmark: pgfId-2384349]Log if MIME file name length is greater than 255

 
     [bookmark: pgfId-2384350] – Medium

 
     [bookmark: pgfId-2384351]Obfuscate Server Banner

 
     [bookmark: pgfId-2384352]Drop Connections if command line length is greater than 512

 
     [bookmark: pgfId-2384353]Drop Connections if command recipient count is greater than 100

 
     [bookmark: pgfId-2384354]Drop Connections if body line length is greater than 1000

 
     [bookmark: pgfId-2384355]Drop Connections if sender address length is greater than 320

 
     [bookmark: pgfId-2384356]Drop Connections if MIME file name length is greater than 255

 
     [bookmark: pgfId-2384357] – High

 
     [bookmark: pgfId-2384358]Obfuscate Server Banner

 
     [bookmark: pgfId-2384359]Drop Connections if command line length is greater than 512

 
     [bookmark: pgfId-2384360]Drop Connections if command recipient count is greater than 100

 
     [bookmark: pgfId-2384361]Drop Connections if body line length is greater than 1000

 
     [bookmark: pgfId-2384362]Drop Connections and log if sender address length is greater than 320

 
     [bookmark: pgfId-2384363]Drop Connections and log if MIME file name length is greater than 255

 
     [bookmark: pgfId-2384364] – MIME File Type Filtering—Opens the MIME Type Filtering dialog box to configure MIME file type filters.

 
     [bookmark: pgfId-2384365] – Customize—Opens the Add/Edit ESMTP Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2384366] – Default Level—Sets the security level back to the default level of Low.

 
    
 
     
      [bookmark: pgfId-2384369][bookmark: 24002]MIME File Type Filtering

 
     [bookmark: pgfId-2384370]The MIME File Type Filtering dialog box is accessible as follows:

 
     [bookmark: pgfId-2384371]Configuration > Global Objects > Inspect Maps > ESMTP > MIME File Type Filtering

 
     [bookmark: pgfId-2384373][bookmark: marker-2384372]The MIME File Type Filtering dialog box lets you configure the settings for a MIME file type filter. 

 
     [bookmark: pgfId-2384374]Fields

 
      
      		 [bookmark: pgfId-2384375]Match Type—Shows the match type, which can be a positive or negative match. 

 
      		 [bookmark: pgfId-2384376]Criterion—Shows the criterion of the inspection.

 
      		 [bookmark: pgfId-2384377]Value—Shows the value to match in the inspection.

 
      		 [bookmark: pgfId-2384378]Action—Shows the action if the match condition is met.

 
      		 [bookmark: pgfId-2384379]Log—Shows the log state.

 
      		 [bookmark: pgfId-2384380]Add—Opens the Add MIME File Type Filter dialog box to add a MIME file type filter.

 
      		 [bookmark: pgfId-2384381]Edit—Opens the Edit MIME File Type Filter dialog box to edit a MIME file type filter.

 
      		 [bookmark: pgfId-2384382]Delete—Deletes a MIME file type filter.

 
      		 [bookmark: pgfId-2384383]Move Up—Moves an entry up in the list.

 
      		 [bookmark: pgfId-2384384]Move Down—Moves an entry down in the list.

 
     

 
    
 
     
      [bookmark: pgfId-2384387][bookmark: 88519]Add/Edit ESMTP Policy Map (Security Level)

 
     [bookmark: pgfId-2384388]The Add/Edit ESMTP Policy Map (Security Level) dialog box is accessible as follows:

 
     [bookmark: pgfId-2384389]Configuration > Global Objects > Inspect Maps > ESMTP > ESMTP Inspect Map > Basic View

 
     [bookmark: pgfId-2384390]The Add/Edit ESMTP Policy Map pane lets you configure the security level and additional settings for ESMTP application inspection maps.

 
     [bookmark: pgfId-2384391]Fields

 
      
      		 [bookmark: pgfId-2384392]Name—When adding an ESMTP map, enter the name of the ESMTP map. When editing an ESMTP map, the name of the previously configured ESMTPS map is shown.

 
      		 [bookmark: pgfId-2384393]Description—Enter the description of the ESMTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2384394]Security Level—Select the security level (high, medium, or low).

 
     

 
     [bookmark: pgfId-2384395] – Low—Default.

 
     [bookmark: pgfId-2384396]Log if command line length is greater than 512

 
     [bookmark: pgfId-2384397]Log if command recipient count is greater than 100

 
     [bookmark: pgfId-2384398]Log if body line length is greater than 1000

 
     [bookmark: pgfId-2384399]Log if sender address length is greater than 320

 
     [bookmark: pgfId-2384400]Log if MIME file name length is greater than 255

 
     [bookmark: pgfId-2384401] – Medium

 
     [bookmark: pgfId-2384402]Obfuscate Server Banner

 
     [bookmark: pgfId-2384403]Drop Connections if command line length is greater than 512

 
     [bookmark: pgfId-2384404]Drop Connections if command recipient count is greater than 100

 
     [bookmark: pgfId-2384405]Drop Connections if body line length is greater than 1000

 
     [bookmark: pgfId-2384406]Drop Connections if sender address length is greater than 320

 
     [bookmark: pgfId-2384407]Drop Connections if MIME file name length is greater than 255

 
     [bookmark: pgfId-2384408] – High

 
     [bookmark: pgfId-2384409]Obfuscate Server Banner

 
     [bookmark: pgfId-2384410]Drop Connections if command line length is greater than 512

 
     [bookmark: pgfId-2384411]Drop Connections if command recipient count is greater than 100

 
     [bookmark: pgfId-2384412]Drop Connections if body line length is greater than 1000

 
     [bookmark: pgfId-2384413]Drop Connections and log if sender address length is greater than 320

 
     [bookmark: pgfId-2384414]Drop Connections and log if MIME file name length is greater than 255

 
     [bookmark: pgfId-2384415] – MIME File Type Filtering—Opens the MIME Type Filtering dialog box to configure MIME file type filters.

 
     [bookmark: pgfId-2384416] – Default Level—Sets the security level back to the default level of Low.

 
      
      		 [bookmark: pgfId-2384417]Details—Shows the Parameters and Inspections tabs to configure additional settings.

 
     

 
    
 
     
      [bookmark: pgfId-2384420][bookmark: 34968]Add/Edit ESMTP Policy Map (Details)

 
     [bookmark: pgfId-2384421]The Add/Edit ESMTP Policy Map (Details) dialog box is accessible as follows:

 
     [bookmark: pgfId-2384422]Configuration > Global Objects > Inspect Maps > ESMTP > ESMTP Inspect Map > Advanced View

 
     [bookmark: pgfId-2384423]The Add/Edit ESMTP Policy Map pane lets you configure the security level and additional settings for ESMTP application inspection maps.

 
     [bookmark: pgfId-2384424]Fields

 
      
      		 [bookmark: pgfId-2384425]Name—When adding an ESMTP map, enter the name of the ESMTP map. When editing an ESMTP map, the name of the previously configured ESMTP map is shown.

 
      		 [bookmark: pgfId-2384426]Description—Enter the description of the ESMTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2384427]Security Level—Shows the security level and mime file type filtering settings to configure.

 
      		 [bookmark: pgfId-2384428]Parameters—Tab that lets you configure the parameters for the ESMTP inspect map.

 
     

 
     [bookmark: pgfId-2384429] – Mask server banner—Enforces banner obfuscation.

 
     [bookmark: pgfId-2384430] – Configure Mail Relay—Enables ESMTP mail relay.

 
     [bookmark: pgfId-2384431]Domain Name—Specifies a local domain.

 
     [bookmark: pgfId-2384432]Action—Drop connection or log.

 
     [bookmark: pgfId-2384433]Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384434]Inspections—Tab that shows you the ESMTP inspection configuration and lets you add or edit.

 
     

 
     [bookmark: pgfId-2384435] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2384436] – Criterion—Shows the criterion of the ESMTP inspection.

 
     [bookmark: pgfId-2384437] – Value—Shows the value to match in the ESMTP inspection.

 
     [bookmark: pgfId-2384438] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2384439] – Log—Shows the log state.

 
     [bookmark: pgfId-2384440] – Add—Opens the Add ESMTP Inspect dialog box to add an ESMTP inspection.

 
     [bookmark: pgfId-2384441] – Edit—Opens the Edit ESMTP Inspect dialog box to edit an ESMTP inspection.

 
     [bookmark: pgfId-2384442] – Delete—Deletes an ESMTP inspection.

 
     [bookmark: pgfId-2384443] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-2384444] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-2384447][bookmark: 71768]Add/Edit ESMTP Inspect 

 
     [bookmark: pgfId-2384448]The Add/Edit ESMTP Inspect dialog box is accessible as follows:

 
     [bookmark: pgfId-2384449]Configuration > Global Objects > Inspect Maps > ESMTP > ESMTP Inspect Map > Advanced View > Add/Edit ESMTP Inspect

 
     [bookmark: pgfId-2384450]The Add/Edit ESMTP Inspect dialog box lets you define the match criterion and value for the ESMTP inspect map.

 
     [bookmark: pgfId-2384451]Fields 

 
      
      		 [bookmark: pgfId-2384452]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2384453]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2384454]Criterion—Specifies which criterion of ESMTP traffic to match.

 
     

 
     [bookmark: pgfId-2384455] – Body Length—Match body length at specified length in bytes.

 
     [bookmark: pgfId-2384456] – Body Line Length—Match body line length matching at specified length in bytes.

 
     [bookmark: pgfId-2384457] – Commands—Match commands exchanged in the ESMTP protocol.

 
     [bookmark: pgfId-2384458] – Command Recipient Count—Match command recipient count greater than number specified.

 
     [bookmark: pgfId-2384459] – Command Line Length—Match command line length greater than length specified in bytes.

 
     [bookmark: pgfId-2384460] – EHLO Reply Parameters—Match an ESMTP ehlo reply parameter.

 
     [bookmark: pgfId-2384461] – Header Length—Match header length at length specified in bytes.

 
     [bookmark: pgfId-2384462] – Header To Fields Count—Match header To fields count greater than number specified.

 
     [bookmark: pgfId-2384463] – Invalid Recipients Count—Match invalid recipients count greater than number specified.

 
     [bookmark: pgfId-2384464] – MIME File Type—Match MIME file type.

 
     [bookmark: pgfId-2384465] – MIME Filename Length—Match MIME filename.

 
     [bookmark: pgfId-2384466] – MIME Encoding—Match MIME encoding.

 
     [bookmark: pgfId-2384467] – Sender Address—Match sender email address.

 
     [bookmark: pgfId-2384468] – Sender Address Length—Match sender email address length.

 
      
      		 [bookmark: pgfId-2384469]Body Length Criterion Values—Specifies the value details for body length match.

 
     

 
     [bookmark: pgfId-2384470] – Greater Than Length—Body length in bytes.

 
     [bookmark: pgfId-2384471] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384472] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384473]Body Line Length Criterion Values—Specifies the value details for body line length match.

 
     

 
     [bookmark: pgfId-2384474] – Greater Than Length—Body line length in bytes.

 
     [bookmark: pgfId-2384475] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384476] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384477]Commands Criterion Values—Specifies the value details for command match.

 
     

 
     [bookmark: pgfId-2384478] – Available Commands Table:

 
     [bookmark: pgfId-2384479]AUTH

 
     [bookmark: pgfId-2384480]DATA

 
     [bookmark: pgfId-2384481]EHLO

 
     [bookmark: pgfId-2384482]ETRN

 
     [bookmark: pgfId-2384483]HELO

 
     [bookmark: pgfId-2384484]HELP

 
     [bookmark: pgfId-2384485]MAIL

 
     [bookmark: pgfId-2384486]NOOP

 
     [bookmark: pgfId-2384487]QUIT

 
     [bookmark: pgfId-2384488]RCPT

 
     [bookmark: pgfId-2384489]RSET

 
     [bookmark: pgfId-2384490]SAML

 
     [bookmark: pgfId-2384491]SOML

 
     [bookmark: pgfId-2384492]VRFY

 
     [bookmark: pgfId-2384493] – Add—Adds the selected command from the Available Commands table to the Selected Commands table.

 
     [bookmark: pgfId-2384494] – Remove—Removes the selected command from the Selected Commands table.

 
     [bookmark: pgfId-2384495] – Primary Action—Mask, Reset, Drop Connection, None, Limit Rate (pps).

 
     [bookmark: pgfId-2384496] – Log—Enable or disable.

 
     [bookmark: pgfId-2384497] – Rate Limit—Do not limit rate, Limit Rate (pps).

 
      
      		 [bookmark: pgfId-2384498]Command Recipient Count Criterion Values—Specifies the value details for command recipient count match.

 
     

 
     [bookmark: pgfId-2384499] – Greater Than Count—Specify command recipient count.

 
     [bookmark: pgfId-2384500] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384501] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384502]Command Line Length Criterion Values—Specifies the value details for command line length.

 
     

 
     [bookmark: pgfId-2384503] – Greater Than Length—Command line length in bytes.

 
     [bookmark: pgfId-2384504] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384505] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384506]EHLO Reply Parameters Criterion Values—Specifies the value details for EHLO reply parameters match.

 
     

 
     [bookmark: pgfId-2384507] – Available Parameters Table:

 
     [bookmark: pgfId-2384508]8bitmime

 
     [bookmark: pgfId-2384509]auth

 
     [bookmark: pgfId-2384510]binarymime

 
     [bookmark: pgfId-2384511]checkpoint

 
     [bookmark: pgfId-2384512]dsn

 
     [bookmark: pgfId-2384513]ecode

 
     [bookmark: pgfId-2384514]etrn

 
     [bookmark: pgfId-2384515]others

 
     [bookmark: pgfId-2384516]pipelining

 
     [bookmark: pgfId-2384517]size

 
     [bookmark: pgfId-2384518]vrfy

 
     [bookmark: pgfId-2384519] – Add—Adds the selected parameter from the Available Parameters table to the Selected Parameters table.

 
     [bookmark: pgfId-2384520] – Remove—Removes the selected command from the Selected Commands table.

 
     [bookmark: pgfId-2384521] – Action—Reset, Drop Connection, Mask, Log.

 
     [bookmark: pgfId-2384522] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384523]Header Length Criterion Values—Specifies the value details for header length match.

 
     

 
     [bookmark: pgfId-2384524] – Greater Than Length—Header length in bytes.

 
     [bookmark: pgfId-2384525] – Action—Reset, Drop Connection, Mask, Log.

 
     [bookmark: pgfId-2384526] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384527]Header To Fields Count Criterion Values—Specifies the value details for header To fields count match.

 
     

 
     [bookmark: pgfId-2384528] – Greater Than Count—Specify command recipient count.

 
     [bookmark: pgfId-2384529] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384530] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384531]Invalid Recipients Count Criterion Values—Specifies the value details for invalid recipients count match.

 
     

 
     [bookmark: pgfId-2384532] – Greater Than Count—Specify command recipient count.

 
     [bookmark: pgfId-2384533] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384534] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384535]MIME File Type Criterion Values—Specifies the value details for MIME file type match.

 
     

 
     [bookmark: pgfId-2384536] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2384537] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2384538] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2384539] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2384540] – Action—Reset, drop connection, log.

 
     [bookmark: pgfId-2384541] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384542]MIME Filename Length Criterion Values—Specifies the value details for MIME filename length match.

 
     

 
     [bookmark: pgfId-2384543] – Greater Than Length—MIME filename length in bytes.

 
     [bookmark: pgfId-2384544] – Action—Reset, Drop Connection, Log.

 
     [bookmark: pgfId-2384545] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384546]MIME Encoding Criterion Values—Specifies the value details for MIME encoding match.

 
     

 
     [bookmark: pgfId-2384547] – Available Encodings table

 
     [bookmark: pgfId-2384548]7bit

 
     [bookmark: pgfId-2384549]8bit

 
     [bookmark: pgfId-2384550]base64

 
     [bookmark: pgfId-2384551]binary

 
     [bookmark: pgfId-2384552]others

 
     [bookmark: pgfId-2384553]quoted-printable

 
     [bookmark: pgfId-2384554] – Add—Adds the selected parameter from the Available Encodings table to the Selected Encodings table.

 
     [bookmark: pgfId-2384555] – Remove—Removes the selected command from the Selected Commands table.

 
     [bookmark: pgfId-2384556] – Action—Reset, Drop Connection, Log.

 
     [bookmark: pgfId-2384557] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384558]Sender Address Criterion Values—Specifies the value details for sender address match.

 
     

 
     [bookmark: pgfId-2384559] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2384560] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2384561] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2384562] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-2384563] – Action—Reset, Drop Connection, Log.

 
     [bookmark: pgfId-2384564] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2384565]Sender Address Length Criterion Values—Specifies the value details for sender address length match.

 
     

 
     [bookmark: pgfId-2384566] – Greater Than Length—Sender address length in bytes.

 
     [bookmark: pgfId-2384567] – Action—Reset, Drop Connection, Log.

 
     [bookmark: pgfId-2384568] – Log—Enable or disable.

 
    
 
   
 
    
     [bookmark: pgfId-1541089][bookmark: 56118]TFTP Inspection

 
    [bookmark: pgfId-1347086]TFTP inspection is enabled by default.

 
    [bookmark: pgfId-1438186]TFTP, described in RFC 1350, is a simple protocol to read and write files between a TFTP server and client. 

 
    [bookmark: pgfId-1438190]The ASA inspects TFTP traffic and dynamically creates connections and translations, if necessary, to permit file transfer between a TFTP client and server. Specifically, the inspection engine inspects TFTP read request (RRQ), write request (WRQ), and error notification (ERROR).

 
    [bookmark: pgfId-1438191]A dynamic secondary channel and a PAT translation, if necessary, are allocated on a reception of a valid read (RRQ) or write (WRQ) request. This secondary channel is subsequently used by TFTP for file transfer or error notification.

 
    [bookmark: pgfId-1438192]Only the TFTP server can initiate traffic over the secondary channel, and at most one incomplete secondary channel can exist between the TFTP client and server. An error notification from the server closes the secondary channel.

 
    [bookmark: pgfId-1438193]TFTP inspection must be enabled if static PAT is used to redirect TFTP traffic.

 
    [bookmark: pgfId-1438219] 
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OPS/access_public_servers.html
  
   
    
     [bookmark: pgfId-1043201]Configuring Public Servers 
      
      
 
     
 

 
    [bookmark: pgfId-1090082]This section describes how to configure public servers, and includes the following topics:

 
     
     		 [bookmark: pgfId-1090086]Information About Public Servers

 
     		 [bookmark: pgfId-1093522]Licensing Requirements for Public Servers

 
     		 [bookmark: pgfId-1093535]Guidelines and Limitations

 
     		 [bookmark: pgfId-1090090]Adding a Public Server that Enables Static NAT

 
     		 [bookmark: pgfId-1090094]Adding a Public Server that Enables Static NAT with PAT

 
     		 [bookmark: pgfId-1093402]Editing Settings for a Public Server

 
     		 [bookmark: pgfId-1093671]Feature History for Public Servers

 
    

 
   
 
    
     [bookmark: pgfId-1090096][bookmark: 26456]Information About Public Servers

 
    [bookmark: pgfId-1093461]The Public Servers pane enables an administrator to provide internal and external users access to various application servers. This pane displays a list of public servers. internal and external addresses, the interfaces to which the internal or external addresses apply, the ability to translate the addresses, and the service that is exposed. You can add, edit, delete, or modify settings for existing public servers.

 
   
 
    
     [bookmark: pgfId-1093486][bookmark: 25313]Licensing Requirements for Public Servers

 
    [bookmark: pgfId-1097182] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1097175]Model 
         
  
        		 
          
          [bookmark: pgfId-1097177]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1097179]All models

  
        		[bookmark: pgfId-1097181]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1093503][bookmark: 11347]Guidelines and Limitations

 
    [bookmark: pgfId-1093504]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1093505]Context Mode Guidelines

 
    [bookmark: pgfId-1093506]Supported in single and multiple context mode.

 
    [bookmark: pgfId-1093507]Firewall Mode Guidelines

 
    [bookmark: pgfId-1093508]Supported in routed and transparent firewall mode.

 
   
 
    
     [bookmark: pgfId-1093464][bookmark: 74472]Adding a Public Server that Enables Static NAT

 
    [bookmark: pgfId-1093465]To add a public server that enables static NAT and creates a fixed translation of a real address to a mapped address, perform the following steps:

 
    
 
    [bookmark: pgfId-1090155]Step 1 In the Configuration > Firewall > Public Servers pane, click Add to add a new server.

 
    [bookmark: pgfId-1090156]The Add Public Server dialog box appears.

 
    [bookmark: pgfId-1090157]Step 2 From the Private Interface drop-down menu, select the name of the private interface to which the real server is connected.

 
    [bookmark: pgfId-1090677]Step 3 In the Private IP address field, enter the real IP address of the server (IPv4 only). 

 
    [bookmark: pgfId-1090672]Step 4 In the Private Service field, click Browse to display the Browse Service dialog box, choose the actual service that is exposed to the outside, and click OK.

Optionally, from the Browse Service dialog box you can click Add to create a new service or service group. Multiple services from various ports can be opened to the outside. For more information about service objects and service groups, see the “Configuring Service Objects and Service Groups” section in the general operations configuration guide.

 
    [bookmark: pgfId-1090171]Step 5 From the Public Interface drop-down menu, enter the interface through which users from the outside can access the real server.

 
    [bookmark: pgfId-1091055]Step 6 In the Public Address field, enter the mapped IP address of the server, which is the address that is seen by the outside user. 

 
    [bookmark: pgfId-1092403]Step 7 (Optional) To enable static PAT, check the Specify if Public Service is different from private service check box .

 
    [bookmark: pgfId-1091108]Step 8 Click OK. The configuration appears in the main pane.

 
    [bookmark: pgfId-1091125]Step 9 Click Apply to generate static NAT and a corresponding access rule for the traffic flow and to save the configuration.

 
    [bookmark: pgfId-1092065]For information about static NAT, see the “Information About Static NAT” section. 

 
    [bookmark: pgfId-1091255]

 
     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1091646][bookmark: 33920]Adding a Public Server that Enables Static NAT with PAT

 
    [bookmark: pgfId-1091703]To add a public server that lets you specify a real and mapped protocol (TCP or UDP) to a port, perform the following steps:

 
    
 
    [bookmark: pgfId-1091708]Step 1 Choose Configuration > Firewall > Public Servers, then click Add.

 
    [bookmark: pgfId-1091709]The Add Public Server dialog box appears.

 
    [bookmark: pgfId-1091710]Step 2 From the Private Interface drop-down menu, choose the name of the private interface to which the real server is connected.

 
    [bookmark: pgfId-1091711]Step 3 In the Private IP address field, enter the real IP address of the server (only IPv4 is supported).

 
    [bookmark: pgfId-1091712]Step 4 In the Private Service field, click Browse to display the Browse Service dialog box

 
    [bookmark: pgfId-1093769]Step 5 Choose the actual service that is exposed to the outside, and click OK.

 
    [bookmark: pgfId-1093752]Optionally, from the Browse Service dialog box, click Add to create a new service or service group. Multiple services from various ports can be opened to the outside. For more information about service objects and service groups, see the “Configuring Service Objects and Service Groups” section in the general operations configuration guide.

 
    [bookmark: pgfId-1091716]Step 6 From the Public Interface drop-down menu, enter the interface through which users from the outside can access the real server.

 
    [bookmark: pgfId-1091706]Step 7 In the Public Address field, enter the mapped IP address of the server, which is the address that the outside user sees. 

 
    [bookmark: pgfId-1091740]Step 8 Check the Specify Public Service if different from Private Service check box to enable static PAT.

 
    [bookmark: pgfId-1091749]Step 9 In the Public Service field, enter the mapped protocol (TCP or UDP only), or click Browse to choose a protocol from the list. 

 
    [bookmark: pgfId-1091774]Step 10 Click OK.

 
    [bookmark: pgfId-1091779]Step 11 Click Apply to generate static NAT with PAT and a corresponding access rule for the traffic flow, and to save the configuration.

 
    [bookmark: pgfId-1092111]For information about static NAT with port address translation, see the “Information About Static NAT with Port Translation” section.

 
    [bookmark: pgfId-1091844]

 
     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1090185][bookmark: 69993]Editing Settings for a Public Server

 
    [bookmark: pgfId-1090186]To edit the settings for a public server, perform the following steps:

 
    
 
    [bookmark: pgfId-1090187]Step 1 Choose Configuration > Firewall > Public Servers, choose an existing public server, then click Edit.

 
    [bookmark: pgfId-1090188]The Edit Public Server dialog box appears.

 
    [bookmark: pgfId-1090189]Step 2 Make any necessary changes to the following settings:

 
     
      
      		 [bookmark: pgfId-1091299]Private Interface—The interface to which the real server is connected.

 
      		 [bookmark: pgfId-1091314]Private IP Address—The real IP address of the server. 

 
      		 [bookmark: pgfId-1091320]Private Service—The actual service that is running on the real server.

 
      		 [bookmark: pgfId-1091325]Public Interface—The interface through which outside users can access the real server.

 
      		 [bookmark: pgfId-1091327]Public Address—The IP address that is seen by outside users.

 
      		 [bookmark: pgfId-1091837]Public Service—The service that is running on the translated address. Click the  Information icon to view information about supported public services. 

 
     

 
    

 
    [bookmark: pgfId-1090212]Step 3 Click OK, then click Apply to save your changes.

 
    [bookmark: pgfId-1090214]

 
     
     
 
    
  
    

 
   
 
    
     [bookmark: pgfId-1093546][bookmark: 87627]Feature History for Public Servers

 
     
      
       
       [bookmark: pgfId-1093554]Table 9-1 [bookmark: 67500]Feature History for Public Servers

 
       
       
        
        		 
          
          [bookmark: pgfId-1093560]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1093562]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1093564]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1093566]Public Servers

  
        		[bookmark: pgfId-1093568]8.3(1)

  
        		[bookmark: pgfId-1093570]Public servers provide internal and external users access to various application servers.

 [bookmark: pgfId-1093573]We introduced the following screen:

 [bookmark: pgfId-1093574]Configuration > Firewall > Public Servers
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OPS/inspect_mgmt.html
  
   
    
     [bookmark: pgfId-1313159][bookmark: 59098]Configuring Inspection for Management Application Protocols 
      
      
 
     
 

 
    [bookmark: pgfId-1434717]This chapter describes how to configure application layer protocol inspection. Inspection engines are required for services that embed IP addressing information in the user data packet or that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep packet inspection instead of passing the packet through the fast path. As a result, inspection engines can affect overall throughput.

 
    [bookmark: pgfId-1063234]Several common inspection engines are enabled on the ASA by default, but you might need to enable others depending on your network. 

 
    [bookmark: pgfId-1678885]This chapter includes the following sections:[bookmark: marker-1350354]

 
     
     		 [bookmark: pgfId-1492314]DCERPC Inspection

 
     		 [bookmark: pgfId-1303337]GTP Inspection

 
     		 [bookmark: pgfId-1347666]RADIUS Accounting Inspection

 
     		 [bookmark: pgfId-1504997]RSH Inspection

 
     		 [bookmark: pgfId-1303451]SNMP Inspection

 
     		 [bookmark: pgfId-1347768]XDMCP Inspection

 
    

 
   
 
    
     [bookmark: pgfId-1478733][bookmark: 84945]DCERPC Inspection

 
    [bookmark: pgfId-1488359]This section describes the DCERPC inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1488363]DCERPC Overview

 
     		 [bookmark: pgfId-1770259]“Select DCERPC Map” section

 
     		 [bookmark: pgfId-1770263]“DCERPC Inspect Map” section

 
     		 [bookmark: pgfId-1770267]“Add/Edit DCERPC Policy Map” section

 
    

 
     
      [bookmark: pgfId-1488387][bookmark: 98719]DCERPC Overview

 
     [bookmark: pgfId-1506202]DCERPC is a protocol widely used by Microsoft distributed client and server applications that allows software clients to execute programs on a server remotely. 

 
     [bookmark: pgfId-1506203]This typically involves a client querying a server called the Endpoint Mapper listening on a well known port number for the dynamically allocated network information of a required service. The client then sets up a secondary connection to the server instance providing the service. The security appliance allows the appropriate port number and network address and also applies NAT, if needed, for the secondary connection.

 
     [bookmark: pgfId-1506198]DCERPC inspect maps inspect for native TCP communication between the EPM and client on well known TCP port 135. Map and lookup operations of the EPM are supported for clients. Client and server can be located in any security zone. The embedded server IP address and Port number are received from the applicable EPM response messages. Since a client may attempt multiple connections to the server port returned by EPM, multiple use of pinholes are allowed, which have user configurable timeouts.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1542162]Note DCERPC inspection only supports communication between the EPM and clients to open pinholes through theASA. Clients using RPC communication that does not use the EPM is not supported with DCERPC inspection. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1770274][bookmark: 16910][bookmark: 21529]Select DCERPC Map

 
     [bookmark: pgfId-1770275]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab >Select DCERPC Map

 
     [bookmark: pgfId-1770276]The Select DCERPC Map dialog box lets you select or create a new DCERPC map. A DCERPC map lets you change the configuration values used for DCERPC application inspection. The Select DCERPC Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-1770277]Fields

 
      
      		 [bookmark: pgfId-1770278]Use the default DCERPC inspection map—Specifies to use the default DCERPC map.

 
      		 [bookmark: pgfId-1770279]Select a DCERPC map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-1770280]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-1770283][bookmark: 68409]DCERPC Inspect Map

 
     [bookmark: pgfId-1770284]Configuration > Global Objects > Inspect Maps > DCERPC

 
     [bookmark: pgfId-1770287][bookmark: marker-1770285][bookmark: marker-1770286]The DCERPC pane lets you view previously configured DCERPC application inspection maps. A DCERPC map lets you change the default configuration values used for DCERPC application inspection. 

 
     [bookmark: pgfId-1770288]DCERPC is a protocol widely used by Microsoft distributed client and server applications that allows software clients to execute programs on a server remotely. 

 
     [bookmark: pgfId-1770289]This typically involves a client querying a server called the Endpoint Mapper (EPM) listening on a well known port number for the dynamically allocated network information of a required service. The client then sets up a secondary connection to the server instance providing the service. The security appliance allows the appropriate port number and network address and also applies NAT, if needed, for the secondary connection.

 
     [bookmark: pgfId-1770290]DCERPC inspect maps inspect for native TCP communication between the EPM and client on well known TCP port 135. Map and lookup operations of the EPM are supported for clients. Client and server can be located in any security zone. The embedded server IP address and Port number are received from the applicable EPM response messages. Because a client may attempt multiple connections to the server port returned by EPM, multiple use of pinholes are allowed, which have user configurable timeouts.

 
     [bookmark: pgfId-1770291]Fields

 
      
      		 [bookmark: pgfId-1770292]DCERPC Inspect Maps—Table that lists the defined DCERPC inspect maps.

 
      		 [bookmark: pgfId-1770293]Add—Configures a new DCERPC inspect map. To edit a DCERPC inspect map, choose the DCERPC entry in the DCERPC Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-1770294]Delete—Deletes the inspect map selected in the DCERPC Inspect Maps table.

 
      		 [bookmark: pgfId-1770295]Security Level—Select the security level (high, medium, or low).

 
     

 
     [bookmark: pgfId-1770296] – Low

 
     [bookmark: pgfId-1770297]Pinhole timeout: 00:02:00

 
     [bookmark: pgfId-1770298]Endpoint mapper service: not enforced

 
     [bookmark: pgfId-1770299]Endpoint mapper service lookup: enabled

 
     [bookmark: pgfId-1770300]Endpoint mapper service lookup timeout: 00:05:00

 
     [bookmark: pgfId-1770301] – Medium—Default.

 
     [bookmark: pgfId-1770302]Pinhole timeout: 00:01:00

 
     [bookmark: pgfId-1770303]Endpoint mapper service: not enforced

 
     [bookmark: pgfId-1770304]Endpoint mapper service lookup: disabled.

 
     [bookmark: pgfId-1770305] – High

 
     [bookmark: pgfId-1770306]Pinhole timeout: 00:01:00

 
     [bookmark: pgfId-1770307]Endpoint mapper service: enforced

 
     [bookmark: pgfId-1770308]Endpoint mapper service lookup: disabled

 
     [bookmark: pgfId-1770309] – Customize—Opens the Add/Edit DCERPC Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-1770310] – Default Level—Sets the security level back to the default level of Medium.

 
    
 
     
      [bookmark: pgfId-1770313][bookmark: 27796]Add/Edit DCERPC Policy Map

 
     [bookmark: pgfId-1770314]Configuration > Global Objects > Inspect Maps > DCERPC > DCERPC Inspect Map > Basic/Advanced View

 
     [bookmark: pgfId-1770315]The Add/Edit DCERPC Policy Map pane lets you configure the security level and parameters for DCERPC application inspection maps. 

 
     [bookmark: pgfId-1770316]Fields

 
      
      		 [bookmark: pgfId-1770317]Name—When adding a DCERPC map, enter the name of the DCERPC map. When editing a DCERPC map, the name of the previously configured DCERPC map is shown.

 
      		 [bookmark: pgfId-1770318]Description—Enter the description of the DCERPC map, up to 200 characters in length.

 
      		 [bookmark: pgfId-1770319]Security Level—Select the security level (high, medium, or low).

 
     

 
     [bookmark: pgfId-1770320] – Low

 
     [bookmark: pgfId-1770321]Pinhole timeout: 00:02:00

 
     [bookmark: pgfId-1770322]Endpoint mapper service: not enforced

 
     [bookmark: pgfId-1770323]Endpoint mapper service lookup: enabled

 
     [bookmark: pgfId-1770324]Endpoint mapper service lookup timeout: 00:05:00

 
     [bookmark: pgfId-1770325] – Medium—Default.

 
     [bookmark: pgfId-1770326]Pinhole timeout: 00:01:00

 
     [bookmark: pgfId-1770327]Endpoint mapper service: not enforced

 
     [bookmark: pgfId-1770328]Endpoint mapper service lookup: disabled.

 
     [bookmark: pgfId-1770329] – High

 
     [bookmark: pgfId-1770330]Pinhole timeout: 00:01:00

 
     [bookmark: pgfId-1770331]Endpoint mapper service: enforced

 
     [bookmark: pgfId-1770332]Endpoint mapper service lookup: disabled

 
     [bookmark: pgfId-1770333] – Default Level—Sets the security level back to the default level of Medium.

 
      
      		 [bookmark: pgfId-1770334]Details—Shows the Parameters to configure additional settings.

 
     

 
     [bookmark: pgfId-1770335] – Pinhole Timeout—Sets the pinhole timeout. Because a client may use the server information returned by the endpoint mapper for multiple connections, the timeout value is configurable based on the client application environment. Range is from 0:0:1 to 1193:0:0. Default is 2 minutes.

 
     [bookmark: pgfId-1770336] – Enforce endpoint-mapper service—Enforces endpoint mapper service during binding. 

 
     [bookmark: pgfId-1770337] – Enable endpoint-mapper service lookup—Enables the lookup operation of the endpoint mapper service. If disabled, the pinhole timeout is used.

 
     [bookmark: pgfId-1770338]Enforce Service Lookup Timeout—Enforces the service lookup timeout specified.

 
     [bookmark: pgfId-1770339]Service Lookup Timeout—Sets the timeout for pinholes from lookup operation. 

 
    
 
   
 
    
     [bookmark: pgfId-1144252]  [bookmark: 48146]GTP Inspect[bookmark: marker-1345374]ion

 
    [bookmark: pgfId-1151897]This section describes the GTP inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1310994]GTP Inspection Overview

 
     		 [bookmark: pgfId-1770347]“Select GTP Map” section

 
     		 [bookmark: pgfId-1770351]“GTP Inspect Map” section

 
     		 [bookmark: pgfId-1770355]“IMSI Prefix Filtering” section

 
     		 [bookmark: pgfId-1770359]“Add/Edit GTP Policy Map (Security Level)” section

 
     		 [bookmark: pgfId-1770363]“Add/Edit GTP Policy Map (Details)” section

 
     		 [bookmark: pgfId-1770367]“Add/Edit GTP Map” section

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1200367]Note GTP inspection requires a special license. 

 
     
     
 
    
 
    

 
     
      [bookmark: pgfId-1144253][bookmark: 48152]GTP Inspection Over[bookmark: marker-1345375]view

 
     [bookmark: pgfId-1148079]GPRS provides uninterrupted connectivity for mobile subscribers between GSM networks and corporate networks or the Internet. The GGSN is the interface between the GPRS wireless data network and other networks. The SGSN performs mobility, data session management, and data compression (See Figure 14-1). 

 
     [bookmark: pgfId-1775606]Figure 14-1 [bookmark: 17915]GPRS Tunneling Protocol

 
     [bookmark: pgfId-1775610] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1148086]The UMTS is the commercial convergence of fixed-line telephony, mobile, Internet and computer technology. UTRAN is the networking protocol used for implementing wireless networks in this system. GTP allows multi-protocol packets to be tunneled through a UMTS/GPRS backbone between a GGSN, an SGSN and the UTRAN.

 
     [bookmark: pgfId-1148090]GTP does not include any inherent security or encryption of user data, but using GTP with the ASA helps protect your network against these risks. 

 
     [bookmark: pgfId-1148097]The SGSN is logically connected to a GGSN using GTP. GTP allows multiprotocol packets to be tunneled through the GPRS backbone between GSNs. GTP provides a tunnel control and management protocol that allows the SGSN to provide GPRS network access for a mobile station by creating, modifying, and deleting tunnels. GTP uses a tunneling mechanism to provide a service for carrying user data packets.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1344147]Note When using GTP with failover, if a GTP connection is established and the active unit fails before data is transmitted over the tunnel, the GTP data connection (with a “j” flag set) is not replicated to the standby unit. This occurs because the active unit does not replicate embryonic connections to the standby unit. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1770392][bookmark: 20062]Select GTP Map

 
     [bookmark: pgfId-1770393]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab >Select GTP Map

 
     [bookmark: pgfId-1770394]The Select GTP Map dialog box lets you select or create a new GTP map. A GTP map lets you change the configuration values used for GTP application inspection. The Select GTP Map table provides a list of previously configured maps that you can select for application inspection.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1770395]Note GTP inspection requires a special license. If you try to enable GTP application inspection on a ASA without the required license, the ASA displays an error message. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1770402]Fields

 
      
      		 [bookmark: pgfId-1770403]Use the default GTP inspection map—Specifies to use the default GTP map.

 
      		 [bookmark: pgfId-1770404]Select an GTP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-1770405]Add—Opens the Add Policy Map dialog box for the inspection. 

 
     

 
    
 
     
      [bookmark: pgfId-1770408][bookmark: 42405]GTP Inspect Map

 
     [bookmark: pgfId-1770409]Configuration > Global Objects > Inspect Maps > GTP 

 
     [bookmark: pgfId-1770411][bookmark: marker-1770410]The GTP pane lets you view previously configured GTP application inspection maps. A GTP map lets you change the default configuration values used for GTP application inspection. 

 
     [bookmark: pgfId-1770412]GTP is a relatively new protocol designed to provide security for wireless connections to TCP/IP networks, such as the Internet. You can use a GTP map to control timeout values, message sizes, tunnel counts, and GTP versions traversing the security appliance.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1770413]Note GTP inspection is not available without a special license. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1770414]Fields

 
      
      		 [bookmark: pgfId-1770415]GTP Inspect Maps—Table that lists the defined GTP inspect maps. 

 
      		 [bookmark: pgfId-1770416]Add—Configures a new GTP inspect map. To edit a GTP inspect map, choose the GTP entry in the GTP Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-1770417]Delete—Deletes the inspect map selected in the GTP Inspect Maps table.

 
      		 [bookmark: pgfId-1770418]Security Level—Security level low only.

 
     

 
     [bookmark: pgfId-1770419] – Do not Permit Errors

 
     [bookmark: pgfId-1770420] – Maximum Number of Tunnels: 500

 
     [bookmark: pgfId-1770421] – GSN timeout: 00:30:00

 
     [bookmark: pgfId-1770422] – Pdp-Context timeout: 00:30:00

 
     [bookmark: pgfId-1770423] – Request timeout: 00:01:00

 
     [bookmark: pgfId-1770424] – Signaling timeout: 00:30:00.

 
     [bookmark: pgfId-1770425] – Tunnel timeout: 01:00:00.

 
     [bookmark: pgfId-1770426] – T3-response timeout: 00:00:20.

 
     [bookmark: pgfId-1770427] – Drop and log unknown message IDs.

 
      
      		 [bookmark: pgfId-1770428]IMSI Prefix Filtering—Opens the IMSI Prefix Filtering dialog box to configure IMSI prefix filters.

 
      		 [bookmark: pgfId-1770429]Customize—Opens the Add/Edit GTP Policy Map dialog box for additional settings.

 
      		 [bookmark: pgfId-1770430]Default Level—Sets the security level back to the default.

 
     

 
    
 
     
      [bookmark: pgfId-1770433][bookmark: 22817]IMSI Prefix Filtering

 
     [bookmark: pgfId-1770434]Configuration > Global Objects > Inspect Maps > GTP > IMSI Prefix Filtering

 
     [bookmark: pgfId-1770435]The IMSI Prefix tab lets you define the IMSI prefix to allow within GTP requests.

 
     [bookmark: pgfId-1770436]Fields

 
      
      		 [bookmark: pgfId-1770437]Mobile Country Code—Defines the non-zero, three-digit value identifying the mobile country code. One or two-digit entries will be prepended by 0 to create a three-digit value.

 
      		 [bookmark: pgfId-1770438]Mobile Network Code—Defines the two or three-digit value identifying the network code.

 
      		 [bookmark: pgfId-1770439]Add—Add the specified country code and network code to the IMSI Prefix table.

 
      		 [bookmark: pgfId-1770440]Delete—Deletes the specified country code and network code from the IMSI Prefix table.

 
     

 
    
 
     
      [bookmark: pgfId-1770443][bookmark: 72905]Add/Edit GTP Policy Map (Security Level)

 
     [bookmark: pgfId-1770444]Configuration > Global Objects > Inspect Maps > GTP > GTP Inspect Map > Basic View

 
     [bookmark: pgfId-1770445]The Add/Edit GTP Policy Map pane lets you configure the security level and additional settings for GTP application inspection maps.

 
     [bookmark: pgfId-1770446]Fields

 
      
      		 [bookmark: pgfId-1770447]Name—When adding a GTP map, enter the name of the GTP map. When editing a GTP map, the name of the previously configured GTP map is shown.

 
      		 [bookmark: pgfId-1770448]Description—Enter the description of the GTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-1770449]Security Level—Security level low only.

 
     

 
     [bookmark: pgfId-1770450]Do not Permit Errors

 
     [bookmark: pgfId-1770451]Maximum Number of Tunnels: 500

 
     [bookmark: pgfId-1770452]GSN timeout: 00:30:00

 
     [bookmark: pgfId-1770453]Pdp-Context timeout: 00:30:00

 
     [bookmark: pgfId-1770454]Request timeout: 00:01:00

 
     [bookmark: pgfId-1770455]Signaling timeout: 00:30:00.

 
     [bookmark: pgfId-1770456]Tunnel timeout: 01:00:00.

 
     [bookmark: pgfId-1770457]T3-response timeout: 00:00:20.

 
     [bookmark: pgfId-1770458]Drop and log unknown message IDs.

 
     [bookmark: pgfId-1770459] – IMSI Prefix Filtering—Opens the IMSI Prefix Filtering dialog box to configure IMSI prefix filters.

 
     [bookmark: pgfId-1770460] – Default Level—Sets the security level back to the default.

 
      
      		 [bookmark: pgfId-1770461]Details—Shows the Parameters, IMSI Prefix Filtering, and Inspections tabs to configure additional settings.

 
     

 
    
 
     
      [bookmark: pgfId-1770464][bookmark: 38250]Add/Edit GTP Policy Map (Details)

 
     [bookmark: pgfId-1770465]Configuration > Global Objects > Inspect Maps > GTP > GTP Inspect Map > Advanced View

 
     [bookmark: pgfId-1770466]The Add/Edit GTP Policy Map pane lets you configure the security level and additional settings for GTP application inspection maps.

 
     [bookmark: pgfId-1770467]Fields

 
      
      		 [bookmark: pgfId-1770468]Name—When adding a GTP map, enter the name of the GTP map. When editing a GTP map, the name of the previously configured GTP map is shown.

 
      		 [bookmark: pgfId-1770469]Description—Enter the description of the GTP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-1770470]Security Level—Shows the security level and IMSI prefix filtering settings to configure.

 
      		 [bookmark: pgfId-1770471]Permit Parameters—Tab that lets you configure the permit parameters for the GTP inspect map.

 
     

 
     [bookmark: pgfId-1770472] – Object Groups to Add

 
     [bookmark: pgfId-1770473]From object group—Specify an object group or use the browse button to open the Add Network Object Group dialog box.

 
     [bookmark: pgfId-1770474]To object group—Specify an object group or use the browse button to open the Add Network Object Group dialog box.

 
     [bookmark: pgfId-1770475] – Add—Add the specified country code and network code to the IMSI Prefix table.

 
     [bookmark: pgfId-1770476] – Delete—Deletes the specified country code and network code from the IMSI Prefix table.

 
     [bookmark: pgfId-1770477] – Permit Errors—Lets any packets that are invalid or that encountered an error during inspection to be sent through the ASA instead of being dropped. By default, all invalid packets or packets that failed during parsing are dropped.

 
      
      		 [bookmark: pgfId-1770481]General Parameters—Tab that lets you configure the general parameters for the GTP inspect map.

 
     

 
     [bookmark: pgfId-1770482] – Maximum Number of Requests—Lets you change the default for the maximum request queue size allowed. The default for the maximum request queue size is 200. Specifies the maximum number of GTP requests that will be queued waiting for a response. The permitted range is from 1 to 9999999. 

 
     [bookmark: pgfId-1770483] – Maximum Number of Tunnels—Lets you change the default for the maximum number of tunnels allowed. The default tunnel limit is 500. Specifies the maximum number of tunnels allowed. The permitted range is from 1 to 9999999 for the global overall tunnel limit.

 
     [bookmark: pgfId-1770484] – Timeouts

 
     [bookmark: pgfId-1770485]GSN timeout—Lets you change the default for the maximum period of inactivity before a GSN is removed. The default is 30 minutes. Timeout is in the format hh:mm:ss, where hh specifies the hour, mm specifies the minutes, and ss specifies the seconds. A value 0 means never tear down.

 
     [bookmark: pgfId-1770486]PDP-Context timeout—Lets you change the default for the maximum period of inactivity before receiving the PDP Context for a GTP session. The default is 30 minutes.[bookmark: marker-1770487] Timeout is in the format hh:mm:ss, where hh specifies the hour, mm specifies the minutes, and ss specifies the seconds. A value 0 means never tear down.

 
     [bookmark: pgfId-1770488]Request Queue—Lets you change the default for the maximum period of inactivity before receiving the GTP message during a GTP session. The default is 1 minute. Timeout is in the format hh:mm:ss, where hh specifies the hour, mm specifies the minutes, and ss specifies the seconds. A value 0 means never tear down.

 
     [bookmark: pgfId-1770489]Signaling—Lets you change the default for the maximum period of inactivity before a GTP signaling is removed. The default is 30 minutes. Timeout is in the format hh:mm:ss, where hh specifies the hour, mm specifies the minutes, and ss specifies the seconds. A value 0 means never tear down.

 
     [bookmark: pgfId-1770490]Tunnel—Lets you change the default for the maximum period of inactivity for the GTP tunnel. The default is 1 hour. Timeout is in the format hh:mm:ss, where hh specifies the hour, mm specifies the minutes, and ss specifies the seconds. A value 0 means never tear down Request timeout—Specifies the GTP Request idle timeout.

 
     [bookmark: pgfId-1770491]T3-Response timeout—Specifies the maximum wait time for a response before removing the connection.

 
      
      		 [bookmark: pgfId-1770492]IMSI Prefix Filtering—Tab that lets you configure the IMSI prefix filtering for the GTP inspect map.

 
     

 
     [bookmark: pgfId-1770493] – Mobile Country Code—Defines the non-zero, three-digit value identifying the mobile country code. One or two-digit entries will be prepended by 0 to create a three-digit value.

 
     [bookmark: pgfId-1770494] – Mobile Network Code—Defines the two or three-digit value identifying the network code.

 
     [bookmark: pgfId-1770495] – Add—Add the specified country code and network code to the IMSI Prefix table.

 
     [bookmark: pgfId-1770496] – Delete—Deletes the specified country code and network code from the IMSI Prefix table.

 
      
      		 [bookmark: pgfId-1770497]Inspections—Tab that lets you configure the GTP inspect maps.

 
     

 
     [bookmark: pgfId-1770498] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-1770499] – Criterion—Shows the criterion of the GTP inspection.

 
     [bookmark: pgfId-1770500] – Value—Shows the value to match in the GTP inspection.

 
     [bookmark: pgfId-1770501] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-1770502] – Log—Shows the log state.

 
     [bookmark: pgfId-1770503] – Add—Opens the Add GTP Inspect dialog box to add an GTP inspection.

 
     [bookmark: pgfId-1770504] – Edit—Opens the Edit GTP Inspect dialog box to edit an GTP inspection.

 
     [bookmark: pgfId-1770505] – Delete—Deletes an GTP inspection.

 
     [bookmark: pgfId-1770506] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-1770507] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-1770510][bookmark: 58202]Add/Edit GTP Map

 
     [bookmark: pgfId-1770511]Configuration > Global Objects > Inspect Maps > GTP > GTP Inspect Map > Add/Edit GTP Map

 
     [bookmark: pgfId-1770512]The Add/Edit GTP Inspect dialog box lets you define the match criterion and value for the GTP inspect map.

 
     [bookmark: pgfId-1770513]Fields

 
      
      		 [bookmark: pgfId-1770514]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-1770515]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-1770516]Criterion—Specifies which criterion of GTP traffic to match.

 
     

 
     [bookmark: pgfId-1770517] – Access Point Name—Match on access point name.

 
     [bookmark: pgfId-1770518] – Message ID—Match on the message ID.

 
     [bookmark: pgfId-1770519] – Message Length—Match on the message length

 
     [bookmark: pgfId-1770520] – Version—Match on the version.

 
      
      		 [bookmark: pgfId-1770521]Access Point Name Criterion Values—Specifies an access point name to be matched. By default, all messages with valid APNs are inspected, and any [bookmark: marker-1770522]APN is allowed.

 
     

 
     [bookmark: pgfId-1770523] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-1770524] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-1770525] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-1770526] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
     [bookmark: pgfId-1770527] – Action—Drop.

 
     [bookmark: pgfId-1770528] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-1770529]Message ID Criterion Values—Specifies the numeric identifier for the message that you want to match. The valid range is 1 to 255. By default, all valid message IDs are allowed.

 
     

 
     [bookmark: pgfId-1770530] – Value—Specifies whether value is an exact match or a range.

 
     [bookmark: pgfId-1770531]Equals—Enter a value.

 
     [bookmark: pgfId-1770532]Range—Enter a range of values.

 
     [bookmark: pgfId-1770533] – Action—Drop packet or limit rate (pps).

 
     [bookmark: pgfId-1770534] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-1770535]Message Length Criterion Values—Lets you change the default for the maximum message length for the UDP payload that is allowed. 

 
     

 
     [bookmark: pgfId-1770536] – Minimum value—Specifies the minimum number of bytes in the UDP payload. The range is from 1 to 65536.

 
     [bookmark: pgfId-1770537] – Maximum value—Specifies the maximum number of bytes in the UDP payload. The range is from 1 to 65536.

 
     [bookmark: pgfId-1770538] – Action—Drop packet.

 
     [bookmark: pgfId-1770539] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-1770540]Version Criterion Values—Specifies the GTP version for messages that you want to match. The valid range is 0-255. Use 0 to identify Version 0 and 1 to identify Version 1. Version 0 of GTP uses port 3386, while Version 1 uses port 2123. By default all GTP versions are allowed.

 
     

 
     [bookmark: pgfId-1770541] – Value—Specifies whether value is an exact match or a range.

 
     [bookmark: pgfId-1770542]Equals—Enter a value.

 
     [bookmark: pgfId-1770543]Range—Enter a range of values.

 
     [bookmark: pgfId-1770544] – Action—Drop packet.

 
     [bookmark: pgfId-1770545] – Log—Enable or disable.

 
    
 
   
 
    
     [bookmark: pgfId-1504796][bookmark: 53218][bookmark: 98097]RADIUS Accounting Inspection

 
    [bookmark: pgfId-1541422]This section describes the IM inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1541426]RADIUS Accounting Inspection Overview

 
     		 [bookmark: pgfId-1770553]Select RADIUS Accounting Map

 
     		 [bookmark: pgfId-1770557]Add RADIUS Accounting Policy Map

 
     		 [bookmark: pgfId-1770561]RADIUS Inspect Map

 
     		 [bookmark: pgfId-1770565]RADIUS Inspect Map Host

 
     		 [bookmark: pgfId-1770569]RADIUS Inspect Map Other

 
    

 
     
      [bookmark: pgfId-1541432][bookmark: 78910]RADIUS Accounting Inspection Overview

 
     [bookmark: pgfId-1504811]One of the well known problems is the over-billing attack in GPRS networks. The over-billing attack can cause consumers anger and frustration by being billed for services that they have not used. In this case, a malicious attacker sets up a connection to a server and obtains an IP address from the SGSN. When the attacker ends the call, the malicious server will still send packets to it, which gets dropped by the GGSN, but the connection from the server remains active. The IP address assigned to the malicious attacker gets released and reassigned to a legitimate user who will then get billed for services that the attacker will use. 

 
     [bookmark: pgfId-1504813]RADIUS accounting inspection prevents this type of attack by ensuring the traffic seen by the GGSN is legitimate. With the RADIUS accounting feature properly configured, the security appliance tears down a connection based on matching the Framed IP attribute in the Radius Accounting Request Start message with the Radius Accounting Request Stop message. When the Stop message is seen with the matching IP address in the Framed IP attribute, the security appliance looks for all connections with the source matching the IP address.

 
     [bookmark: pgfId-1504797]You have the option to configure a secret pre-shared key with the RADIUS server so the security appliance can validate the message. If the shared secret is not configured, the security appliance does not need to validate the source of the message and will only check that the source IP address is one of the configured addresses allowed to send the RADIUS messages.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1542106]Note When using RADIUS accounting inspection with GPRS enabled, theASA checks for the 3GPP-Session-Stop-Indicator in the Accounting Request STOP messages to properly handle secondary PDP contexts. Specifically, the ASA requires that the Accounting Request STOP messages include the 3GPP-SGSN-Address attribute before it will temrinate the user sessions and all associated connections. Some third-party GGSNs might not send this attribute by default.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1770576][bookmark: X98097_1H_Head1_RAD]Select RADIUS Accounting Map

 
     [bookmark: pgfId-1770577]The Select RADIUS Accounting Map dialog box lets you select a defined RADIUS accounting map or define a new one.

 
     [bookmark: pgfId-1770578]Fields

 
      
      		 [bookmark: pgfId-1770579]Add—Lets you add a new RADIUS accounting map.

 
     

 
    
 
     
      [bookmark: pgfId-1770581][bookmark: 23452]Add RADIUS Accounting Policy Map

 
     [bookmark: pgfId-1770582]The Add RADIUS Accounting Policy Map dialog box lets you add the basic settings for the RADIUS accounting map.

 
     [bookmark: pgfId-1770583]Fields

 
      
      		 [bookmark: pgfId-1770584]Name—Enter the name of the previously configured RADIUS accounting map. 

 
      		 [bookmark: pgfId-1770585]Description—Enter the description of the RADIUS accounting map, up to 100 characters in length. 

 
      		 [bookmark: pgfId-1770586]Host Parameters tab:

 
     

 
     [bookmark: pgfId-1770587] – Host IP Address—Specify the IP address of the host that is sending the RADIUS messages.

 
     [bookmark: pgfId-1770588] – Key: (optional)—Specify the key.

 
     [bookmark: pgfId-1770589] – Add—Adds the host entry to the Host table. 

 
     [bookmark: pgfId-1770590] – Delete—Deletes the host entry from the Host table.

 
      
      		 [bookmark: pgfId-1770591]Other Parameters tab:

 
     

 
     [bookmark: pgfId-1770592] – Attribute Number—Specify the attribute number to validate when an Accounting Start is received.

 
     [bookmark: pgfId-1770593] – Add—Adds the entry to the Attribute table.

 
     [bookmark: pgfId-1770594] – Delete—Deletes the entry from the Attribute table.

 
     [bookmark: pgfId-1770595] – Send response to the originator of the RADIUS message—Sends a message back to the host from which the RADIUS message was sent.

 
     [bookmark: pgfId-1770596] – Enforce timeout—Enables the timeout for users.

 
      
      		 [bookmark: pgfId-1770597]Users Timeout—Timeout for the users in the database (hh:mm:ss).

 
     

 
    
 
     
      [bookmark: pgfId-1770598] 

 
    
 
     
      [bookmark: pgfId-1770600][bookmark: 55385]RADIUS Inspect Map

 
     [bookmark: pgfId-1770602][bookmark: marker-1770601]The RADIUS pane lets you view previously configured RADIUS application inspection maps. A RADIUS map lets you change the default configuration values used for RADIUS application inspection. You can use a RADIUS map to protect against an overbilling attack.

 
     [bookmark: pgfId-1770603]Fields

 
      
      		 [bookmark: pgfId-1770604]Name—Enter the name of the inspect map, up to 40 characters in length.

 
      		 [bookmark: pgfId-1770605]Description—Enter the description of the inspect map, up to 200 characters in length.

 
      		 [bookmark: pgfId-1770606]RADIUS Inspect Maps—Table that lists the defined RADIUS inspect maps. The defined inspect maps are also listed in the RADIUS area of the Inspect Maps tree.

 
      		 [bookmark: pgfId-1770607]Add—Adds the new RADIUS inspect map to the defined list in the RADIUS Inspect Maps table and to the RADIUS area of the Inspect Maps tree. To configure the new RADIUS map, select the RADIUS entry in Inspect Maps tree.

 
      		 [bookmark: pgfId-1770608]Delete—Deletes the application inspection map selected in the RADIUS Inspect Maps table and from the RADIUS area of the Inspect Maps tree.

 
     

 
    
 
     
      [bookmark: pgfId-1770611][bookmark: 12327]RADIUS Inspect Map Host

 
     [bookmark: pgfId-1770612]The RADIUS Inspect Map Host Parameters pane lets you configure the host parameter settings for the inspect map.

 
     [bookmark: pgfId-1770613]Fields

 
      
      		 [bookmark: pgfId-1770614]Name—Shows the name of the previously configured RADIUS accounting map.

 
      		 [bookmark: pgfId-1770615]Description—Enter the description of the RADIUS accounting map, up to 200 characters in length.

 
      		 [bookmark: pgfId-1770616]Host Parameters—Lets you configure host parameters.

 
     

 
     [bookmark: pgfId-1770617] – Host IP Address—Specify the IP address of the host that is sending the RADIUS messages.

 
     [bookmark: pgfId-1770618] – Key: (optional)—Specify the key.

 
      
      		 [bookmark: pgfId-1770619]Add—Adds the host entry to the Host table.

 
      		 [bookmark: pgfId-1770620]Delete—Deletes the host entry from the Host table.

 
     

 
    
 
     
      [bookmark: pgfId-1770623][bookmark: X29656_2H_Head2_RAD]RADIUS Inspect Map Other

 
     [bookmark: pgfId-1770624]The RADIUS Inspect Map Other Parameters pane lets you configure additional parameter settings for the inspect map.

 
     [bookmark: pgfId-1770625]Fields

 
      
      		 [bookmark: pgfId-1770626]Name—Shows the name of the previously configured RADIUS accounting map.

 
      		 [bookmark: pgfId-1770627]Description—Enter the description of the RADIUS accounting map, up to 200 characters in length.

 
      		 [bookmark: pgfId-1770628]Other Parameters—Lets you configure additional parameters.

 
     

 
     [bookmark: pgfId-1770629] – Send response to the originator of the RADIUS message—Sends a message back to the host from which the RADIUS message was sent.

 
     [bookmark: pgfId-1770630] – Enforce timeout—Enables the timeout for users.

 
     [bookmark: pgfId-1770631]Users Timeout—Timeout for the users in the database (hh:mm:ss).

 
     [bookmark: pgfId-1770632] – Enable detection of GPRS accounting—Enables detection of GPRS accounting. This option is only available when GTP/GPRS license is enabled.

 
     [bookmark: pgfId-1770633] – Validate Attribute—Attribute information.

 
     [bookmark: pgfId-1770634]Attribute Number—Specify the attribute number to validate when an Accounting Start is received.

 
     [bookmark: pgfId-1770635]Add—Adds the entry to the Attribute table.

 
     [bookmark: pgfId-1770636]Delete—Deletes the entry from the Attribute table.

 
    
 
   
 
    
     [bookmark: pgfId-1346945][bookmark: 22901]RSH Inspection

 
    [bookmark: pgfId-1433255]RSH inspection is enabled by default. The RSH protocol uses a TCP connection from the RSH client to the RSH server on TCP port 514. The client and server negotiate the TCP port number where the client listens for the STDERR output stream. RSH inspection supports NAT of the negotiated port number if necessary.

 
   
 
    
     [bookmark: pgfId-1541521][bookmark: 26311][bookmark: 30899][bookmark: 63532]SNMP Inspection[bookmark: 49327]

 
    [bookmark: pgfId-1541533]This section describes the IM inspection engine. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1541537]SNMP Inspection Overview

 
     		 [bookmark: pgfId-1770644]“Select SNMP Map” section

 
     		 [bookmark: pgfId-1770648]“SNMP Inspect Map” section

 
    

 
     
      [bookmark: pgfId-1541543][bookmark: 36703]SNMP Inspection Overview

 
     [bookmark: pgfId-1541523]SNMP application inspection lets you restrict SNMP traffic to a specific version of SNMP. Earlier versions of SNMP are less secure; therefore, denying certain SNMP versions may be required by your security policy. The ASA can deny SNMP versions 1, 2, 2c, or 3. You control the versions permitted by creating an SNMP map. 

 
     [bookmark: pgfId-1545340]You then apply the SNMP map when you enable SNMP inspection according to the “Configuring Application Layer Protocol Inspection” section.

 
    
 
     
      [bookmark: pgfId-1770655][bookmark: 44994][bookmark: 42610]Select SNMP Map

 
     [bookmark: pgfId-1770656]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select SNMP Map

 
     [bookmark: pgfId-1770657]The Select SNMP Map dialog box lets you select or create a new SNMP map. An SNMP map lets you change the configuration values used for SNMP application inspection. The Select SNMP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-1770658]Fields

 
      
      		 [bookmark: pgfId-1770659]Use the default SNMP inspection map—Specifies to use the default SNMP map.

 
      		 [bookmark: pgfId-1770660]Select an SNMP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-1770661]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-1770664][bookmark: 71925]SNMP Inspect Map

 
     [bookmark: pgfId-1770665]Configuration > Global Objects > Inspect Maps > SNMP 

 
     [bookmark: pgfId-1770667][bookmark: marker-1770666]The SNMP pane lets you view previously configured SNMP application inspection maps. An SNMP map lets you change the default configuration values used for SNMP application inspection. 

 
     [bookmark: pgfId-1770668]Fields

 
      
      		 [bookmark: pgfId-1770669]Map Name—Lists previously configured application inspection maps. Select a map and click  Edit to view or change an existing map. 

 
      		 [bookmark: pgfId-1770670]Add—Configures a new SNMP inspect map. 

 
      		 [bookmark: pgfId-1770671]Edit—Edits the selected SNMP entry in the SNMP Inspect Maps table.

 
      		 [bookmark: pgfId-1770672]Delete—Deletes the inspect map selected in the SNMP Inspect Maps table.

 
     

 
    
 
     
      [bookmark: pgfId-1770674]Add/Edit SNMP Map

 
     [bookmark: pgfId-1770675]Configuration > Global Objects > Inspect Maps > SNMP > Add/Edit SNMP Map (You can get to this dialog box through various paths.)

 
     [bookmark: pgfId-1770676]The Add/Edit SNMP Map dialog box lets you create a new SNMP map for controlling SNMP application inspection.

 
     [bookmark: pgfId-1770677]Fields

 
      
      		 [bookmark: pgfId-1770678]SNMP Map Name—Defines the name of the application inspection map.

 
      		 [bookmark: pgfId-1770679]SNMP version 1—Enables application inspection for SNMP version 1.

 
      		 [bookmark: pgfId-1770680]SNMP version 2 (party based)—Enables application inspection for SNMP version 2.

 
      		 [bookmark: pgfId-1770681]SNMP version 2c (community based)—Enables application inspection for SNMP version 2c.

 
      		 [bookmark: pgfId-1770682]SNMP version 3—Enables application inspection for SNMP version 3.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1347092][bookmark: 35754][bookmark: 24395][bookmark: 95409]XDMCP Inspection

 
    [bookmark: pgfId-1347093]XDMCP inspection is enabled by default; however, the XDMCP inspection engine is dependent upon proper configuration of the established command.

 
    [bookmark: pgfId-1438204]XDMCP is a protocol that uses UDP port 177 to negotiate X sessions, which use TCP when established.

 
    [bookmark: pgfId-1438208]For successful negotiation and start of an XWindows session, the ASA must allow the TCP back connection from the Xhosted computer. To permit the back connection, use the established command on the ASA. Once XDMCP negotiates the port to send the display, The established command is consulted to verify if this back connection should be permitted.

 
    [bookmark: pgfId-1438212]During the XWindows session, the manager talks to the display Xserver on the well-known port 6000 | n. Each display has a separate connection to the Xserver, as a result of the following terminal setting.

 
     
     [bookmark: pgfId-1438213]setenv DISPLAY Xserver:n 
    
 
     
     [bookmark: pgfId-1438214]  
    
 
    [bookmark: pgfId-1438215]where n is the display number.

 
    [bookmark: pgfId-1438219]When XDMCP is used, the display is negotiated using IP addresses, which the ASA can NAT if needed. XDCMP inspection does not support PAT. 
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     [bookmark: pgfId-1619278][bookmark: 59098]Configuring Inspection for Voice and Video Protocols 
      
      
 
     
 

 
    [bookmark: pgfId-1434717]This chapter describes how to configure application layer protocol inspection. Inspection engines are required for services that embed IP addressing information in the user data packet or that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep packet inspection instead of passing the packet through the fast path. As a result, inspection engines can affect overall throughput.

 
    [bookmark: pgfId-1063234]Several common inspection engines are enabled on the ASA by default, but you might need to enable others depending on your network. 

 
    [bookmark: pgfId-1881607]This chapter includes the following sections:[bookmark: marker-1350354]

 
     
     		 [bookmark: pgfId-1303297]CTIQBE Inspection

 
     		 [bookmark: pgfId-1303349]H.323 Inspection

 
     		 [bookmark: pgfId-1303370]MGCP Inspection

 
     		 [bookmark: pgfId-1303378]RTSP Inspection

 
     		 [bookmark: pgfId-1303386]SIP Inspection

 
     		 [bookmark: pgfId-1536259]Skinny (SCCP) Inspection

 
    

 
   
 
    
     [bookmark: pgfId-1228401][bookmark: 39177][bookmark: 72382][bookmark: 54870]CTIQBE Inspection

 
    [bookmark: pgfId-1228402]This section describes CTIQBE application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1310798]CTIQBE Inspection Overview

 
     		 [bookmark: pgfId-1310809]Limitations and Restrictions

 
    

 
     
      [bookmark: pgfId-1228420][bookmark: 42895]CTIQBE Inspection Overview

 
     [bookmark: pgfId-1228423]CTIQBE protocol inspection supports NAT, PAT, and bidirectional NAT. This enables Cisco IP SoftPhone and other Cisco TAPI/JTAPI applications to work successfully with Cisco CallManager for call setup across the ASA.

 
     [bookmark: pgfId-1228427]TAPI and JTAPI are used by many Cisco VoIP applications. CTIQBE is used by Cisco TSP to communicate with Cisco CallManager.

 
    
 
     
      [bookmark: pgfId-1228437][bookmark: 63115]Limitations and Restrictions

 
     [bookmark: pgfId-1264006]The following summarizes limitations that apply when using CTIQBE application inspection:

 
      
      		 [bookmark: pgfId-1264007]CTIQBE application inspection does not support configurations with the alias command.

 
      		 [bookmark: pgfId-1264008]Stateful failover of CTIQBE calls is not supported.

 
      		 [bookmark: pgfId-1253936]Debugging CTIQBE inspection may delay message transmission, which may have a performance impact in a real-time environment. When you enable this debugging or logging and Cisco IP SoftPhone seems unable to complete call setup through the ASA, increase the timeout values in the Cisco TSP settings on the system running Cisco IP SoftPhone.

 
     

 
     [bookmark: pgfId-1228438]The following summarizes special considerations when using CTIQBE application inspection in specific scenarios:

 
      
      		 [bookmark: pgfId-1228439]If two Cisco IP SoftPhones are registered with different Cisco CallManagers, which are connected to different interfaces of the ASA, calls between these two phones fails.

 
      		 [bookmark: pgfId-1228443]When Cisco CallManager is located on the higher security interface compared to Cisco IP SoftPhones, if NAT or outside NAT is required for the Cisco CallManager IP address, the mapping must be static as Cisco IP SoftPhone requires the Cisco CallManager IP address to be specified explicitly in its Cisco TSP configuration on the PC.

 
      		 [bookmark: pgfId-1396596]When using PAT or Outside PAT, if the Cisco CallManager IP address is to be translated, its TCP port 2748 must be statically mapped to the same port of the PAT (interface) address for Cisco IP SoftPhone registrations to succeed. The CTIQBE listening port (TCP 2748) is fixed and is not user-configurable on Cisco CallManager, Cisco IP SoftPhone, or Cisco TSP.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1229306][bookmark: 25357][bookmark: 84945][bookmark: 11763]H.323 Inspe[bookmark: marker-1345376]ction

 
    [bookmark: pgfId-1229307]This section describes the H.323 application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1311079]H.323 Inspection Overview

 
     		 [bookmark: pgfId-1311091]How H.323 Works

 
     		 [bookmark: pgfId-1597258]H.239 Support in H.245 Messages

 
     		 [bookmark: pgfId-1311107]Limitations and Restrictions

 
     		 [bookmark: pgfId-2115911]Select H.323 Map

 
     		 [bookmark: pgfId-2115915]H.323 Class Map

 
     		 [bookmark: pgfId-2115919]Add/Edit H.323 Traffic Class Map

 
     		 [bookmark: pgfId-2115923]Add/Edit H.323 Match Criterion

 
     		 [bookmark: pgfId-2115927]H.323 Inspect Map

 
     		 [bookmark: pgfId-2115931]Phone Number Filtering

 
     		 [bookmark: pgfId-2115935]Add/Edit H.323 Policy Map (Security Level)

 
     		 [bookmark: pgfId-2115939]Add/Edit H.323 Policy Map (Details)

 
     		 [bookmark: pgfId-2115943]Add/Edit HSI Group

 
     		 [bookmark: pgfId-2115947]Add/Edit H.323 Map

 
    

 
     
      [bookmark: pgfId-1229333][bookmark: 60746]H.323 Inspection Overvie[bookmark: marker-1345377]w

 
     [bookmark: pgfId-1229334]H.323 inspection provides support for H.323 compliant applications such as Cisco CallManager and VocalTec Gatekeeper. H.323 is a suite of protocols defined by the International Telecommunication Union for multimedia conferences over LANs. The ASA supports H.323 through Version 6, including H.323 v3 feature Multiple Calls on One Call Signaling Channel.

 
     [bookmark: pgfId-1229341]With H.323 inspection enabled, the ASA supports multiple calls on the same call signaling channel, a feature introduced with H.323 Version 3. This feature reduces call setup time and reduces the use of ports on the ASA. 

 
     [bookmark: pgfId-1229345]The two major functions of H.323 inspection are as follows:

 
      
      		 [bookmark: pgfId-1229346]NAT the necessary embedded IPv4 addresses in the H.225 and H.245 messages. Because H.323 messages are encoded in PER encoding format, the ASA uses an ASN.1 decoder to decode the H.323 messages. 

 
      		 [bookmark: pgfId-1229350]Dynamically allocate the negotiated H.245 and RTP/RTCP connections.

 
     

 
    
 
     
      [bookmark: pgfId-1229352][bookmark: 13458]How H.323 Works

 
     [bookmark: pgfId-1229353]The H.323 collection of protocols collectively may use up to two TCP connection and four to eight UDP connections. FastConnect uses only one TCP connection, and RAS uses a single UDP connection for registration, admissions, and status.

 
     [bookmark: pgfId-1229354]An H.323 client can initially establish a TCP connection to an H.323 server using TCP port 1720 to request Q.931 call setup. As part of the call setup process, the H.323 terminal supplies a port number to the client to use for an H.245 TCP connection. In environments where H.323 gatekeeper is in use, the initial packet is transmitted using UDP.

 
     [bookmark: pgfId-1229355]H.323 inspection monitors the Q.931 TCP connection to determine the H.245 port number. If the H.323 terminals are not using FastConnect, the ASA dynamically allocates the H.245 connection based on the inspection of the H.225 messages.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1543616]Note The H.225 connection can also be dynamically allocated when using RAS. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1229359]Within each H.245 message, the H.323 endpoints exchange port numbers that are used for subsequent UDP data streams. H.323 inspection inspects the H.245 messages to identify these ports and dynamically creates connections for the media exchange. RTP uses the negotiated port number, while RTCP uses the next higher port number.

 
     [bookmark: pgfId-1229360]The H.323 control channel handles H.225 and H.245 and H.323 RAS. H.323 inspection uses the following ports.

 
      
      		 [bookmark: pgfId-1229361]1718—Gate Keeper Discovery UDP port

 
      		 [bookmark: pgfId-1229362]1719—RAS UDP port 

 
      		 [bookmark: pgfId-1229363]1720—TCP Control Port 

 
     

 
     [bookmark: pgfId-1229364]You must permit traffic for the well-known H.323 port 1719 for RAS signaling. Additionally, you must permit traffic for the well-known H.323 port 1720 for the H.225 call signaling; however, the H.245 signaling ports are negotiated between the endpoints in the H.225 signaling. When an H.323 gatekeeper is used, the ASA opens an H.225 connection based on inspection of the ACF and RCF nmessages.

 
     [bookmark: pgfId-1359085]After inspecting the H.225 messages, the ASA opens the H.245 channel and then inspects traffic sent over the H.245 channel as well. All H.245 messages passing through the ASA undergo H.245 application inspection, which translates embedded IP addresses and opens the media channels negotiated in H.245 messages.

 
     [bookmark: pgfId-1359100]The H.323 ITU standard requires that a TPKT header, defining the length of the message, precede the H.225 and H.245, before being passed on to the reliable connection. Because the TPKT header does not necessarily need to be sent in the same TCP packet as H.225 and H.245 messages, the ASA must remember the TPKT length to process and decode the messages properly. For each connection, the ASA keeps a record that contains the TPKT length for the next expected message.

 
     [bookmark: pgfId-1359136]If the ASA needs to perform NAT on IP addresses in messages, it changes the checksum, the UUIE length, and the TPKT, if it is included in the TCP packet with the H.225 message. If the TPKT is sent in a separate TCP packet, the ASA proxy ACKs that TPKT and appends a new TPKT to the H.245 message with the new length.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1229392]Note The ASA does not support TCP options in the Proxy ACK for the TPKT.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-2115952]Each UDP connection with a packet going through H.323 inspection is marked as an H.323 connection and times out with the H.323 timeout as configured in the Configuration > Firewall > Advanced > Global Timeouts pane.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1627918]Note You can enable call setup between H.323 endpoints when the Gatekeeper is inside the network. The ASA includes options to open pinholes for calls based on the RegistrationRequest/RegistrationConfirm (RRQ/RCF) messages. Because these RRQ/RCF messages are sent to and from the Gatekeeper, the calling endpoint's IP address is unknown and the ASA opens a pinhole through source IP address/port 0/0. By default, this option is disabled. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1541265][bookmark: 11654]H.239 Support in H.245 Messages

 
     [bookmark: pgfId-1541861]The ASA sits between two H.323 endpoints. When the two H.323 endpoints set up a telepresentation session so that the endpoints can send and receive a data presentation, such as spreadsheet data, the ASA ensure successful H.239 negotiation between the endpoints. 

 
     [bookmark: pgfId-1541977]H.239 is a standar that provides the ability for H.300 series endpoints to open an additional video channel in a single call. In a call, an endpoint (such as a video phone), sends a channel for video and a channel for data presentation. The H.239 negotiation occurs on the H.245 channel. 

 
     [bookmark: pgfId-1542022]The ASA opens pinholes for the additional media channel and the media control channel. The endpoints use open logical channel message (OLC) to signal a new channel creation. The message extension is part of H.245 version 13.

 
     [bookmark: pgfId-1541277]The decoding and encoding of of the telepresentation session is enabled by default. H.239 encoding and decoding is preformed by ASN.1 coder. 

 
    
 
     
      [bookmark: pgfId-1229395][bookmark: 39072]Limitations and Restricti[bookmark: marker-1345378]ons

 
     [bookmark: pgfId-1229396]The following are some of the known issues and limitations when using H.323 application inspection:

 
      
      		 [bookmark: pgfId-2110754]Only static NAT is fully supported. Static PAT may not properly translate IP addresses embedded in optional fields within H.323 messages. If you experience this kind of problem, do not use static PAT with H.323.

 
      		 [bookmark: pgfId-2110755]Not supported with dynamic NAT or PAT.

 
      		 [bookmark: pgfId-2110756]Not supported with extended PAT.

 
      		 [bookmark: pgfId-2110757]Not supported with NAT between same-security-level interfaces.

 
      		 [bookmark: pgfId-2110758]Not supported with outside NAT.

 
      		 [bookmark: pgfId-2110759]Not supported with NAT64.

 
      		 [bookmark: pgfId-1359163]When a NetMeeting client registers with an H.323 gatekeeper and tries to call an H.323 gateway that is also registered with the H.323 gatekeeper, the connection is established but no voice is heard in either direction. This problem is unrelated to the ASA.

 
      		 [bookmark: pgfId-1229402]If you configure a network static address where the network static address is the same as a third-party netmask and address, then any outbound H.323 connection fails.

 
     

 
    
 
     
      [bookmark: pgfId-2115959][bookmark: 77187][bookmark: 71535]Select H.323 Map

 
     [bookmark: pgfId-2115960]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select H.323 Map

 
     [bookmark: pgfId-2115961]The Select H.323 Map dialog box lets you select or create a new H.323 map. An H.323 map lets you change the configuration values used for H.323 application inspection. The Select H.323 Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2115962]Fields

 
      
      		 [bookmark: pgfId-2115963]Use the default H.323 inspection map—Specifies to use the default H.323 map.

 
      		 [bookmark: pgfId-2115964]Select an H.323 map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2115965]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2115968][bookmark: 94260]H.323 Class Map

 
     [bookmark: pgfId-2115969]Configuration > Global Objects > Class Maps > H.323

 
     [bookmark: pgfId-2115970]The H.323 Class Map pane lets you configure H.323 class maps for H.323 inspection.

 
     [bookmark: pgfId-2115971]An inspection class map matches application traffic with criteria specific to the application. You then identify the class map in the inspect map and enable actions. The difference between creating a class map and defining the traffic match directly in the inspect map is that you can create more complex match criteria and you can reuse class maps. The applications that support inspection class maps are DNS, FTP, H.323, HTTP, IM, and SIP.

 
     [bookmark: pgfId-2115972]Fields

 
      
      		 [bookmark: pgfId-2115973]Name—Shows the H.323 class map name.

 
      		 [bookmark: pgfId-2115974]Match Conditions—Shows the type, match criterion, and value in the class map.

 
     

 
     [bookmark: pgfId-2115975] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2115976] – Criterion—Shows the criterion of the H.323 class map.

 
     [bookmark: pgfId-2115977] – Value—Shows the value to match in the H.323 class map.

 
      
      		 [bookmark: pgfId-2115978]Description—Shows the description of the class map.

 
      		 [bookmark: pgfId-2115979]Add—Adds an H.323 class map.

 
      		 [bookmark: pgfId-2115980]Edit—Edits an H.323 class map.

 
      		 [bookmark: pgfId-2115981]Delete—Deletes an H.323 class map.

 
     

 
    
 
     
      [bookmark: pgfId-2115984][bookmark: 74853]Add/Edit H.323 Traffic Class Map

 
     [bookmark: pgfId-2115985]Configuration > Global Objects > Class Maps > H.323 > Add/Edit H.323 Traffic Class Map

 
     [bookmark: pgfId-2115986]The Add/Edit H.323 Traffic Class Map dialog box lets you define a H.323 class map.

 
     [bookmark: pgfId-2115987]Fields

 
      
      		 [bookmark: pgfId-2115988]Name—Enter the name of the H.323 class map, up to 40 characters in length.

 
      		 [bookmark: pgfId-2115989]Description—Enter the description of the H.323 class map.

 
      		 [bookmark: pgfId-2115990]Add—Adds an H.323 class map.

 
      		 [bookmark: pgfId-2115991]Edit—Edits an H.323 class map.

 
      		 [bookmark: pgfId-2115992]Delete—Deletes an H.323 class map.

 
     

 
    
 
     
      [bookmark: pgfId-2115995][bookmark: 99650]Add/Edit H.323 Match Criterion

 
     [bookmark: pgfId-2115996]Configuration > Global Objects > Class Maps > H.323 > Add/Edit H.323 Traffic Class Map > Add/Edit H.323 Match Criterion

 
     [bookmark: pgfId-2115997]The Add/Edit H.323 Match Criterion dialog box lets you define the match criterion and value for the H.323 class map.

 
     [bookmark: pgfId-2115998]Fields 

 
      
      		 [bookmark: pgfId-2115999]Match Type—Specifies whether the class map includes traffic that matches the criterion, or traffic that does not match the criterion. 

 
     

 
     [bookmark: pgfId-2116000]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2116001]Criterion—Specifies which criterion of H.323 traffic to match.

 
     

 
     [bookmark: pgfId-2116002] – Called Party—Match the called party.

 
     [bookmark: pgfId-2116003] – Calling Party—Match the calling party.

 
     [bookmark: pgfId-2116004] – Media Type—Match the media type.

 
      
      		 [bookmark: pgfId-2116005]Called Party Criterion Values—Specifies to match on the H.323 called party.

 
     

 
     [bookmark: pgfId-2116006] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116007] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116008] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116009] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116010]Calling Party Criterion Values—Specifies to match on the H.323 calling party.

 
     

 
     [bookmark: pgfId-2116011] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116012] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116013] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116014] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116015]Media Type Criterion Values—Specifies which media type to match.

 
     

 
     [bookmark: pgfId-2116016] – Audio—Match audio type.

 
     [bookmark: pgfId-2116017] – Video—Match video type.

 
     [bookmark: pgfId-2116018] – Data—Match data type.

 
    
 
     
      [bookmark: pgfId-2116021][bookmark: 67033]H.323 Inspect Map

 
     [bookmark: pgfId-2116022]Configuration > Global Objects > Inspect Maps > H.323

 
     [bookmark: pgfId-2116026][bookmark: marker-2116023][bookmark: marker-2116024][bookmark: marker-2116025]The H.323 pane lets you view previously configured H.323 application inspection maps. An H.323 map lets you change the default configuration values used for H.323 application inspection. 

 
     [bookmark: pgfId-2116027]H.323 inspection supports RAS, H.225, and H.245, and its functionality translates all embedded IP addresses and ports. It performs state tracking and filtering and can do a cascade of inspect function activation. H.323 inspection supports phone number filtering, dynamic T.120 control, H.245 tunneling control, HSI groups, protocol state tracking, H.323 call duration enforcement, and audio/video control.

 
     [bookmark: pgfId-2116028]Fields

 
      
      		 [bookmark: pgfId-2116029]H.323 Inspect Maps—Table that lists the defined H.323 inspect maps. 

 
      		 [bookmark: pgfId-2116030]Add—Configures a new H.323 inspect map. To edit an H.323 inspect map, choose the H.323 entry in the H.323 Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-2116031]Delete—Deletes the inspect map selected in the H.323 Inspect Maps table.

 
      		 [bookmark: pgfId-2116032]Security Level—Select the security level (low, medium, or high).

 
     

 
     [bookmark: pgfId-2116033] – Low—Default.

 
     [bookmark: pgfId-2116034]State Checking h225 Disabled

 
     [bookmark: pgfId-2116035]State Checking ras Disabled

 
     [bookmark: pgfId-2116036]Call Party Number Disabled

 
     [bookmark: pgfId-2116037]Call duration Limit Disabled

 
     [bookmark: pgfId-2116038]RTP conformance not enforced

 
     [bookmark: pgfId-2116039] – Medium

 
     [bookmark: pgfId-2116040]State Checking h225 Enabled

 
     [bookmark: pgfId-2116041]State Checking ras Enabled

 
     [bookmark: pgfId-2116042]Call Party Number Disabled

 
     [bookmark: pgfId-2116043]Call duration Limit Disabled

 
     [bookmark: pgfId-2116044]RTP conformance enforced

 
     [bookmark: pgfId-2116045]Limit payload to audio or video, based on the signaling exchange: no

 
     [bookmark: pgfId-2116046] – High

 
     [bookmark: pgfId-2116047]State Checking h225 Enabled

 
     [bookmark: pgfId-2116048]State Checking ras Enabled

 
     [bookmark: pgfId-2116049]Call Party Number Enabled

 
     [bookmark: pgfId-2116050]Call duration Limit 1:00:00

 
     [bookmark: pgfId-2116051]RTP conformance enforced

 
     [bookmark: pgfId-2116052]Limit payload to audio or video, based on the signaling exchange: yes

 
     [bookmark: pgfId-2116053] – Phone Number Filtering—Opens the Phone Number Filtering dialog box to configure phone number filters.

 
     [bookmark: pgfId-2116054] – Customize—Opens the Add/Edit H.323 Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2116055] – Default Level—Sets the security level back to the default level of Medium.

 
    
 
     
      [bookmark: pgfId-2116058][bookmark: 74717]Phone Number Filtering

 
     [bookmark: pgfId-2116059]Configuration > Global Objects > Inspect Maps > H323 > Phone Number Filtering

 
     [bookmark: pgfId-2116061][bookmark: marker-2116060]The Phone Number Filtering dialog box lets you configure the settings for a phone number filter. 

 
     [bookmark: pgfId-2116062]Fields

 
      
      		 [bookmark: pgfId-2116063]Match Type—Shows the match type, which can be a positive or negative match. 

 
      		 [bookmark: pgfId-2116064]Criterion—Shows the criterion of the inspection.

 
      		 [bookmark: pgfId-2116065]Value—Shows the value to match in the inspection.

 
      		 [bookmark: pgfId-2116066]Action—Shows the action if the match condition is met.

 
      		 [bookmark: pgfId-2116067]Log—Shows the log state.

 
      		 [bookmark: pgfId-2116068]Add—Opens the Add Phone Number Filter dialog box to add a phone number filter.

 
      		 [bookmark: pgfId-2116069]Edit—Opens the Edit Phone Number Filter dialog box to edit a phone number filter.

 
      		 [bookmark: pgfId-2116070]Delete—Deletes a phone number filter.

 
      		 [bookmark: pgfId-2116071]Move Up—Moves an entry up in the list.

 
      		 [bookmark: pgfId-2116072]Move Down—Moves an entry down in the list.

 
     

 
    
 
     
      [bookmark: pgfId-2116075][bookmark: 83213]Add/Edit H.323 Policy Map (Security Level)

 
     [bookmark: pgfId-2116076]Configuration > Global Objects > Inspect Maps > H323 > H323 Inspect Map > Basic View

 
     [bookmark: pgfId-2116077]The Add/Edit H.323 Policy Map pane lets you configure the security level and additional settings for H.323 application inspection maps.

 
     [bookmark: pgfId-2116078]Fields

 
      
      		 [bookmark: pgfId-2116079]Name—When adding an H.323 map, enter the name of the H.323 map. When editing an H.323 map, the name of the previously configured H.323 map is shown.

 
      		 [bookmark: pgfId-2116080]Description—Enter the description of the H323 map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116081]Security Level—Select the security level (low, medium, or high).

 
     

 
     [bookmark: pgfId-2116082] – Low—Default.

 
     [bookmark: pgfId-2116083]State Checking h225 Disabled

 
     [bookmark: pgfId-2116084]State Checking ras Disabled

 
     [bookmark: pgfId-2116085]Call Party Number Disabled

 
     [bookmark: pgfId-2116086]Call duration Limit Disabled

 
     [bookmark: pgfId-2116087]RTP conformance not enforced

 
     [bookmark: pgfId-2116088] – Medium

 
     [bookmark: pgfId-2116089]State Checking h225 Enabled

 
     [bookmark: pgfId-2116090]State Checking ras Enabled

 
     [bookmark: pgfId-2116091]Call Party Number Disabled

 
     [bookmark: pgfId-2116092]Call duration Limit Disabled

 
     [bookmark: pgfId-2116093]RTP conformance enforced

 
     [bookmark: pgfId-2116094]Limit payload to audio or video, based on the signaling exchange: no

 
     [bookmark: pgfId-2116095] – High

 
     [bookmark: pgfId-2116096]State Checking h225 Enabled

 
     [bookmark: pgfId-2116097]State Checking ras Enabled

 
     [bookmark: pgfId-2116098]Call Party Number Enabled

 
     [bookmark: pgfId-2116099]Call duration Limit 1:00:00

 
     [bookmark: pgfId-2116100]RTP conformance enforced

 
     [bookmark: pgfId-2116101]Limit payload to audio or video, based on the signaling exchange: yes

 
     [bookmark: pgfId-2116102] – Phone Number Filtering—Opens the Phone Number Filtering dialog box which lets you configure the settings for a phone number filter.

 
     [bookmark: pgfId-2116103] – Default Level—Sets the security level back to the default.

 
      
      		 [bookmark: pgfId-2116104]Details—Shows the State Checking, Call Attributes, Tunneling and Protocol Conformance, HSI Group Parameters, and Inspections tabs to configure additional settings.

 
     

 
    
 
     
      [bookmark: pgfId-2116107][bookmark: 51710]Add/Edit H.323 Policy Map (Details)

 
     [bookmark: pgfId-2116108]Configuration > Global Objects > Inspect Maps > H323 > H323 Inspect Map > Advanced View

 
     [bookmark: pgfId-2116109]The Add/Edit H.323 Policy Map pane lets you configure the security level and additional settings for H.323 application inspection maps.

 
     [bookmark: pgfId-2116110]Fields

 
      
      		 [bookmark: pgfId-2116111]Name—When adding an H.323 map, enter the name of the H.323 map. When editing an H.323 map, the name of the previously configured H.323 map is shown.

 
      		 [bookmark: pgfId-2116112]Description—Enter the description of the H.323 map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116113]Security Level—Shows the security level and phone number filtering settings to configure.

 
      		 [bookmark: pgfId-2116114]State Checking—Tab that lets you configure state checking parameters for the H.323 inspect map.

 
     

 
     [bookmark: pgfId-2116115] – Check state transition of H.225 messages—Enforces H.323 state checking on H.225 messages.

 
     [bookmark: pgfId-2116116] – Check state transition of RAS messages—Enforces H.323 state checking on RAS messages.

 
     [bookmark: pgfId-2116117] – Check RFC messages and open pinholes for call signal addresses in RFQ messages

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-2116118]Note You can enable call setup between H.323 endpoints when the Gatekeeper is inside the network. The ASA includes options to open pinholes for calls based on the RegistrationRequest/RegistrationConfirm (RRQ/RCF) messages. Because these RRQ/RCF messages are sent to and from the Gatekeeper, the calling endpoint's IP address is unknown and the ASA opens a pinhole through source IP address/port 0/0. By default, this option is disabled. You can enable this option by setting the option in the H.323 Inspect Map.

 
      
      
 
     
 
     

 
      
      		 [bookmark: pgfId-2116125]Call Attributes—Tab that lets you configure call attributes parameters for the H.323 inspect map.

 
     

 
     [bookmark: pgfId-2116126] – Enforce call duration limit—Enforces the absolute limit on a call.

 
     [bookmark: pgfId-2116127]Call Duration Limit—Time limit for the call (hh:mm:ss).

 
     [bookmark: pgfId-2116128] – Enforce presence of calling and called party numbers—Enforces sending call party numbers during call setup.

 
      
      		 [bookmark: pgfId-2116129]Tunneling and Protocol Conformance—Tab that lets you configure tunneling and protocol conformance parameters for the H.323 inspect map.

 
     

 
     [bookmark: pgfId-2116130] – Check for H.245 tunneling—Allows H.245 tunneling.

 
     [bookmark: pgfId-2116131]Action—Drop connection or log.

 
     [bookmark: pgfId-2116132] – Check RTP packets for protocol conformance—Checks RTP/RTCP packets on the pinholes for protocol conformance.

 
     [bookmark: pgfId-2116133]Limit payload to audio or video, based on the signaling exchange—Enforces the payload type to be audio or video based on the signaling exchange.

 
      
      		 [bookmark: pgfId-2116134]HSI Group Parameters—Tab that lets you configure an HSI group.

 
     

 
     [bookmark: pgfId-2116135] – HSI Group ID—Shows the HSI Group ID.

 
     [bookmark: pgfId-2116136] – IP Address—Shows the HSI Group IP address.

 
     [bookmark: pgfId-2116137] – Endpoints—Shows the HSI Group endpoints.

 
     [bookmark: pgfId-2116138] – Add—Opens the Add HSI Group dialog box to add an HSI group.

 
     [bookmark: pgfId-2116139] – Edit—Opens the Edit HSI Group dialog box to edit an HSI group.

 
     [bookmark: pgfId-2116140] – Delete—Deletes an HSI group.

 
      
      		 [bookmark: pgfId-2116141]Inspections—Tab that shows you the H.323 inspection configuration and lets you add or edit.

 
     

 
     [bookmark: pgfId-2116142] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2116143] – Criterion—Shows the criterion of the H.323 inspection.

 
     [bookmark: pgfId-2116144] – Value—Shows the value to match in the H.323 inspection.

 
     [bookmark: pgfId-2116145] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2116146] – Log—Shows the log state.

 
     [bookmark: pgfId-2116147] – Add—Opens the Add H.323 Inspect dialog box to add an H.323 inspection.

 
     [bookmark: pgfId-2116148] – Edit—Opens the Edit H.323 Inspect dialog box to edit an H.323 inspection.

 
     [bookmark: pgfId-2116149] – Delete—Deletes an H.323 inspection.

 
     [bookmark: pgfId-2116150] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-2116151] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-2116154][bookmark: 83093]Add/Edit HSI Group

 
     [bookmark: pgfId-2116155]Configuration > Global Objects > Inspect Maps > H323 > H323 Inspect Map > Advanced View > Add/Edit HSI Group

 
     [bookmark: pgfId-2116156]The Add/Edit HSI Group dialog box lets you configure HSI Groups.

 
     [bookmark: pgfId-2116157]Fields

 
      
      		 [bookmark: pgfId-2116158]Group ID—Enter the HSI group ID.

 
      		 [bookmark: pgfId-2116159]IP Address—Enter the HSI IP address.

 
      		 [bookmark: pgfId-2116160]Endpoints—Lets you configure the IP address and interface of the endpoints.

 
     

 
     [bookmark: pgfId-2116161] – IP Address—Enter an endpoint IP address.

 
     [bookmark: pgfId-2116162] – Interface—Specifies an endpoint interface.

 
      
      		 [bookmark: pgfId-2116163]Add—Adds the HSI group defined.

 
      		 [bookmark: pgfId-2116164]Delete—Deletes the selected HSI group.

 
     

 
    
 
     
      [bookmark: pgfId-2116167][bookmark: 64872]Add/Edit H.323 Map

 
     [bookmark: pgfId-2116168]Configuration > Global Objects > Inspect Maps > H232 > H323 Inspect Map > Advanced View > Add/Edit H323 Inspect

 
     [bookmark: pgfId-2116169]The Add/Edit H.323 Inspect dialog box lets you define the match criterion and value for the H.323 inspect map.

 
     [bookmark: pgfId-2116170]Fields 

 
      
      		 [bookmark: pgfId-2116171]Single Match—Specifies that the H.323 inspect has only one match statement.

 
      		 [bookmark: pgfId-2116172]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2116173]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2116174]Criterion—Specifies which criterion of H.323 traffic to match.

 
     

 
     [bookmark: pgfId-2116175] – Called Party—Match the called party.

 
     [bookmark: pgfId-2116176] – Calling Party—Match the calling party.

 
     [bookmark: pgfId-2116177] – Media Type—Match the media type.

 
      
      		 [bookmark: pgfId-2116178]Called Party Criterion Values—Specifies to match on the H.323 called party.

 
     

 
     [bookmark: pgfId-2116179] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116180] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116181] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116182] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116183]Calling Party Criterion Values—Specifies to match on the H.323 calling party.

 
     

 
     [bookmark: pgfId-2116184] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116185] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116186] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116187] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116188]Media Type Criterion Values—Specifies which media type to match.

 
     

 
     [bookmark: pgfId-2116189] – Audio—Match audio type.

 
     [bookmark: pgfId-2116190] – Video—Match video type.

 
     [bookmark: pgfId-2116191] – Data—Match data type.

 
      
      		 [bookmark: pgfId-2116192]Multiple Matches—Specifies multiple matches for the H.323 inspection.

 
     

 
     [bookmark: pgfId-2116193] – H323 Traffic Class—Specifies the H.323 traffic class match.

 
     [bookmark: pgfId-2116194] – Manage—Opens the Manage H323 Class Maps dialog box to add, edit, or delete H.323 Class Maps.

 
      
      		 [bookmark: pgfId-2116195]Action—Drop packet, drop connection, or reset.

 
     

 
    
 
   
 
    
     [bookmark: pgfId-1227190]  [bookmark: 53649][bookmark: 83696]MGCP Insp[bookmark: marker-1345382]ection

 
    [bookmark: pgfId-1227191]This section describes MGCP application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1311241]MGCP Inspection Overview

 
     		 [bookmark: pgfId-2116203]Select MGCP Map

 
     		 [bookmark: pgfId-2116207]MGCP Inspect Map

 
     		 [bookmark: pgfId-2116211]Gateways and Call Agents

 
     		 [bookmark: pgfId-2116215]Add/Edit MGCP Policy Map

 
     		 [bookmark: pgfId-2116219]Add/Edit MGCP Group

 
    

 
     
      [bookmark: pgfId-1227213][bookmark: 83351]MGCP Inspection Overv[bookmark: marker-1345383]iew

 
     [bookmark: pgfId-1227214]MGCP is a master/slave protocol used to control media gateways from external call control elements called media gateway controllers or call agents. A media gateway is typically a network element that provides conversion between the audio signals carried on telephone circuits and data packets carried over the Internet or over other packet networks. Using NAT and PAT with MGCP lets you support a large number of devices on an internal network with a limited set of external (global) addresses. Examples of media gateways are:

 
      
      		 [bookmark: pgfId-1245756]Trunking gateways, that interface between the telephone network and a Voice over IP network. Such gateways typically manage a large number of digital circuits.

 
      		 [bookmark: pgfId-1245757]Residential gateways, that provide a traditional analog (RJ11) interface to a Voice over IP network. Examples of residential gateways include cable modem/cable set-top boxes, xDSL devices, broad-band wireless devices.

 
      		 [bookmark: pgfId-1245758]Business gateways, that provide a traditional digital PBX interface or an integrated  soft PBX interface to a Voice over IP network.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1529021]Note To avoid policy failure when upgrading from ASA version 7.1, all layer 7 and layer 3 policies must have distinct names. For instance, a previously configured policy map with the same name as a previously configured MGCP map must be changed before the upgrade.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1265394]MGCP messages are transmitted over UDP. A response is sent back to the source address (IP address and UDP port number) of the command, but the response may not arrive from the same address as the command was sent to. This can happen when multiple call agents are being used in a failover configuration and the call agent that received the command has passed control to a backup call agent, which then sends the response. Figure 12-1 illustrates how NAT can be used with MGCP.

 
     [bookmark: pgfId-2128903]Figure 12-1 [bookmark: 54494]Using NAT with MGCP

 
     [bookmark: pgfId-2128907] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1227221]MGCP endpoints are physical or virtual sources and destinations for data. Media gateways contain endpoints on which the call agent can create, modify and delete connections to establish and control media sessions with other multimedia endpoints. Also, the call agent can instruct the endpoints to detect certain events and generate signals. The endpoints automatically communicate changes in service state to the call agent. 

 
     [bookmark: pgfId-1227223]MGCP transactions are composed of a command and a mandatory response. There are eight types of commands:

 
      
      		 [bookmark: pgfId-1227224]CreateConnection

 
      		 [bookmark: pgfId-1227225]ModifyConnection

 
      		 [bookmark: pgfId-1227226]DeleteConnection

 
      		 [bookmark: pgfId-1227227]NotificationRequest

 
      		 [bookmark: pgfId-1227228]Notify

 
      		 [bookmark: pgfId-1227229]AuditEndpoint

 
      		 [bookmark: pgfId-1227230]AuditConnection

 
      		 [bookmark: pgfId-1227231]RestartInProgress

 
     

 
     [bookmark: pgfId-1227233]The first four commands are sent by the call agent to the gateway. The Notify command is sent by the gateway to the call agent. The gateway may also send a DeleteConnection. The registration of the MGCP gateway with the call agent is achieved by the RestartInProgress command. The AuditEndpoint and the AuditConnection commands are sent by the call agent to the gateway. 

 
     [bookmark: pgfId-1227235]All commands are composed of a Command header, optionally followed by a session description. All responses are composed of a Response header, optionally followed by a session description.

 
      
      		 [bookmark: pgfId-1362541]The port on which the gateway receives commands from the call agent. Gateways usually listen to UDP port 2427.

 
      		 [bookmark: pgfId-1362542]The port on which the call agent receives commands from the gateway. Call agents usually listen to UDP port 2727.

 
     

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1362543]Note MGCP inspection does not support the use of different IP addresses for MGCP signaling and RTP data. A common and recommended practice is to send RTP data from a resilient IP address, such as a loopback or virtual IP address; however, the ASA requires the RTP data to come from the same address as MGCP signalling.

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-2116244][bookmark: 17653]Select MGCP Map

 
     [bookmark: pgfId-2116245]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select MGCP Map

 
     [bookmark: pgfId-2116246]The Select MGCP Map dialog box lets you select or create a new MGCP map. An MGCP map lets you change the configuration values used for MGCP application inspection. The Select MGCP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2116247]Fields

 
      
      		 [bookmark: pgfId-2116248]Use the default MGCP inspection map—Specifies to use the default MGCP map.

 
      		 [bookmark: pgfId-2116249]Select an MGCP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2116250]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2116256][bookmark: 38304]MGCP Inspect Map

 
     [bookmark: pgfId-2116257]Configuration > Global Objects > Inspect Maps > MGCP

 
     [bookmark: pgfId-2116259][bookmark: marker-2116258]The MGCP pane lets you view previously configured MGCP application inspection maps. An MGCP map lets you change the default configuration values used for MGCP application inspection. You can use an MGCP map to manage connections between VoIP devices and MGCP call agents.

 
     [bookmark: pgfId-2116260]Fields

 
      
      		 [bookmark: pgfId-2116261]MGCP Inspect Maps—Table that lists the defined MGCP inspect maps. 

 
      		 [bookmark: pgfId-2116262]Add—Configures a new MGCP inspect map. 

 
      		 [bookmark: pgfId-2116263]Edit—Edits the selected MGCP entry in the MGCP Inspect Maps table.

 
      		 [bookmark: pgfId-2116264]Delete—Deletes the inspect map selected in the MGCP Inspect Maps table.

 
     

 
    
 
     
      [bookmark: pgfId-2116267][bookmark: 67713]Gateways and Call Agents

 
     [bookmark: pgfId-2116268]Configuration > Global Objects > Inspect Maps > MGCP > Gateways and Call Agents

 
     [bookmark: pgfId-2116270][bookmark: marker-2116269]The Gateways and Call Agents dialog box lets you configure groups of gateways and call agents for the map. 

 
     [bookmark: pgfId-2116271]Fields

 
      
      		 [bookmark: pgfId-2116272]Group ID—Identifies the ID of the call agent group. A call agent group associates one or more call agents with one or more MGCP media gateways. The gateway IP address can only be associated with one group ID. You cannot use the same gateway with different group IDs. The valid range is from 0 to 2147483647Criterion—Shows the criterion of the inspection.

 
      		 [bookmark: pgfId-2116273]Gateways—Identifies the IP address of the media gateway that is controlled by the associated call agent. A media gateway is typically a network element that provides conversion between the audio signals carried on telephone circuits and data packets carried over the Internet or over other packet networks. Normally, a gateway sends commands to the default MGCP port for call agents, 2727.

 
      		 [bookmark: pgfId-2116275][bookmark: marker-2116274]Call Agents—Identifies the IP address of a call agent that controls the MGCP media gateways in the call agent group. Normally, a call agent sends commands to the default MGCP port for gateways, 2427.

 
      		 [bookmark: pgfId-2116276]Add—Displays the Add MGCP dialog box, which you can use to define a new application inspection map. 

 
      		 [bookmark: pgfId-2116277]Edit—Displays the Edit MGCP dialog box, which you can use to modify the application inspection map selected in the application inspection map table.

 
      		 [bookmark: pgfId-2116278]Delete—Deletes the application inspection map selected in the application inspection map table.

 
     

 
    
 
     
      [bookmark: pgfId-2116281][bookmark: 33612]Add/Edit MGCP Policy Map

 
     [bookmark: pgfId-2116282]Configuration > Global Objects > Inspect Maps > MGCP > MGCP Inspect Map > View

 
     [bookmark: pgfId-2116283]The Add/Edit MGCP Policy Map pane lets you configure the command queue, gateway, and call agent settings for MGCP application inspection maps.

 
     [bookmark: pgfId-2116284]Fields

 
      
      		 [bookmark: pgfId-2116285]Name—When adding an MGCP map, enter the name of the MGCP map. When editing an MGCP map, the name of the previously configured MGCP map is shown.

 
      		 [bookmark: pgfId-2116286]Description—Enter the description of the MGCP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116287]Command Queue—Tab that lets you specify the permitted queue size for MGCP commands.

 
     

 
     [bookmark: pgfId-2116288] – Command Queue Size—Specifies the maximum number of commands to queue. The valid range is from 1 to 2147483647.

 
      
      		 [bookmark: pgfId-2116289]Gateways and Call Agents—Tab that lets you configure groups of gateways and call agents for this map.

 
     

 
     [bookmark: pgfId-2116290] – Group ID—Identifies the ID of the call agent group. A call agent group associates one or more call agents with one or more MGCP media gateways. The gateway IP address can only be associated with one group ID. You cannot use the same gateway with different group IDs. The valid range is from 0 to 2147483647Criterion—Shows the criterion of the inspection.

 
     [bookmark: pgfId-2116291] – Gateways—Identifies the IP address of the media gateway that is controlled by the associated call agent. A media gateway is typically a network element that provides conversion between the audio signals carried on telephone circuits and data packets carried over the Internet or over other packet networks. Normally, a gateway sends commands to the default MGCP port for call agents, 2727.

 
     [bookmark: pgfId-2116293] – [bookmark: marker-2116292]Call Agents—Identifies the IP address of a call agent that controls the MGCP media gateways in the call agent group. Normally, a call agent sends commands to the default MGCP port for gateways, 2427.

 
     [bookmark: pgfId-2116294] – Add—Displays the Add MGCP Group dialog box, which you can use to define a new MGCP group of gateways and call agents. 

 
     [bookmark: pgfId-2116295] – Edit—Displays the Edit MGCP dialog box, which you can use to modify the MGCP group selected in the Gateways and Call Agents table.

 
     [bookmark: pgfId-2116296] – Delete—Deletes the MGCP group selected in the Gateways and Call Agents table.

 
    
 
     
      [bookmark: pgfId-2116299][bookmark: 32706]Add/Edit MGCP Group

 
     [bookmark: pgfId-2116300]Configuration > Global Objects > Inspect Maps > MGCP > Add/Edit MGCP Group

 
     [bookmark: pgfId-2116302][bookmark: marker-2116301]The Add/Edit MGCP Group dialog box lets you define the configuration of an MGCP group that will be used when MGCP application inspection is enabled. 

 
     [bookmark: pgfId-2116303]Fields

 
      
      		 [bookmark: pgfId-2116304]Group ID—Specifies the ID of the call agent group. A call agent group associates one or more call agents with one or more MGCP media gateways. The valid range is from 0 to 2147483647.

 
     

 
     [bookmark: pgfId-2116306] – [bookmark: marker-2116305]Gateway to Be Added—Specifies the IP address of the media gateway that is controlled by the associated call agent. A media gateway is typically a network element that provides conversion between the audio signals carried on telephone circuits and data packets carried over the Internet or over other packet networks. Normally, a gateway sends commands to the default MGCP port for call agents, 2727.

 
     [bookmark: pgfId-2116307] – Add—Adds the specified IP address to the IP address table.

 
     [bookmark: pgfId-2116308] – Delete—Deletes the selected IP address from the IP address table.

 
     [bookmark: pgfId-2116309] – IP Address—Lists the IP addresses of the gateways in the call agent group.

 
      
      		 [bookmark: pgfId-2116310]Call Agents

 
     

 
     [bookmark: pgfId-2116311] – Call Agent to Be Added—Specifies the IP address of a call agent that controls the MGCP media gateways in the call agent group. Normally, a call agent sends commands to the default MGCP port for gateways, 2427.

 
     [bookmark: pgfId-2116312] – Add—Adds the specified IP address to the IP address table.

 
     [bookmark: pgfId-2116313] – Delete—Deletes the selected IP address from the IP address table.

 
     [bookmark: pgfId-2116314] – IP Address—Lists the IP addresses of the call agents in the call agent group.

 
    
 
   
 
    
     [bookmark: pgfId-1433203][bookmark: 22695][bookmark: 26311]RTSP Inspec[bookmark: marker-1433202]tion

 
    [bookmark: pgfId-1433204]This section describes RTSP application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1311270]RTSP Inspection Overview

 
     		 [bookmark: pgfId-1311282]Using RealPlayer

 
     		 [bookmark: pgfId-1311330]Restrictions and Limitations

 
     		 [bookmark: pgfId-2116322]Select RTSP Map

 
     		 [bookmark: pgfId-2116326]RTSP Inspect Map

 
     		 [bookmark: pgfId-2116330]Add/Edit RTSP Policy Map

 
     		 [bookmark: pgfId-2116334]RTSP Class Map

 
     		 [bookmark: pgfId-2116338]Add/Edit RTSP Traffic Class Map

 
    

 
     
      [bookmark: pgfId-1619563][bookmark: 30551]RTSP Inspection Overview[bookmark: marker-1619562]

 
     [bookmark: pgfId-1363553]The RTSP inspection engine lets the ASA pass RTSP packets. RTSP is used by RealAudio, RealNetworks, Apple QuickTime 4, [bookmark: marker-1363557]RealPlayer, and Cisco IP/TV connections. 

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1204466]Note For Cisco IP/TV, use RTSP TCP port 554 and TCP 8554.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1204467]RTSP applications use the well-known port 554 with TCP (rarely UDP) as a control channel. The ASA only supports TCP, in conformity with RFC 2326. This TCP control channel is used to negotiate the data channels that is used to transmit audio/video traffic, depending on the transport mode that is configured on the client.

 
     [bookmark: pgfId-1204471]The supported RDT transports are: rtp/avp, rtp/avp/udp, x-real-rdt, x-real-rdt/udp, and x-pn-tng/udp.

 
     [bookmark: pgfId-1204475]The ASA parses Setup response messages with a status code of 200. If the response message is travelling inbound, the server is outside relative to the ASA and dynamic channels need to be opened for connections coming inbound from the server. If the response message is outbound, then the ASA does not need to open dynamic channels. 

 
     [bookmark: pgfId-1204482]Because RFC 2326 does not require that the client and server ports must be in the SETUP response message, the ASA keeps state and remembers the client ports in the SETUP message. QuickTime places the client ports in the SETUP message and then the server responds with only the server ports. 

 
     [bookmark: pgfId-1204489]RTSP inspection does not support PAT or dual-NAT. Also, the ASA cannot recognize HTTP cloaking where RTSP messages are hidden in the HTTP messages. 

 
    
 
     
      [bookmark: pgfId-1204490][bookmark: 76995]Using RealPlayer

 
     [bookmark: pgfId-1204494]When using RealPlayer, it is important to properly configure transport mode. For the ASA, add an access-list command from the server to the client or vice versa. For RealPlayer, change transport mode by clicking Options>Preferences>Transport>RTSP Settings.

 
     [bookmark: pgfId-1204495]If using TCP mode on the RealPlayer, select the Use TCP to Connect to Server and Attempt to use TCP for all content check boxes. On the ASA, there is no need to configure the inspection engine. 

 
     [bookmark: pgfId-1204499]If using UDP mode on the RealPlayer, select the Use TCP to Connect to Server and Attempt to use UDP for static content check boxes, and for live content not available via Multicast. On the ASA, add an inspect rtsp port command.

 
    
 
     
      [bookmark: pgfId-1204503][bookmark: 10056]Restrictions and Limitations

 
     [bookmark: pgfId-1204504]The following restrictions apply to the RSTP inspection.

 
      
      		 [bookmark: pgfId-1363574]The ASA does not support multicast RTSP or RTSP messages over UDP.

 
      		 [bookmark: pgfId-1204514]The ASA does not have the ability to recognize HTTP cloaking where RTSP messages are hidden in the HTTP messages. 

 
      		 [bookmark: pgfId-1204518]The ASA cannot perform NAT on RTSP messages because the embedded IP addresses are contained in the SDP files as part of HTTP or RTSP messages. Packets could be fragmented and ASA cannot perform NAT on fragmented packets. 

 
      		 [bookmark: pgfId-1204525]With Cisco IP/TV, the number of translates the ASA performs on the SDP part of the message is proportional to the number of program listings in the Content Manager (each program listing can have at least six embedded IP addresses). 

 
      		 [bookmark: pgfId-1204526]You can configure NAT for Apple QuickTime 4 or RealPlayer. Cisco IP/TV only works with NAT if the Viewer and Content Manager are on the outside network and the server is on the inside network.

 
     

 
    
 
     
      [bookmark: pgfId-2116345][bookmark: 85277]Select RTSP Map

 
     [bookmark: pgfId-2116346]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select NetBIOS Map

 
     [bookmark: pgfId-2116347]The Select RTSP Map dialog box lets you select or create a new RTSP map. An RTSP map lets you change the configuration values used for RTSP application inspection. The Select RTSP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2116348]Fields

 
      
      		 [bookmark: pgfId-2116349]Use the default RTSP inspection map—Specifies to use the default RTSP inspection map.

 
      		 [bookmark: pgfId-2116350]Select a RTSP inspect map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2116351]Add—Opens the Add Policy Map dialog box for the inspection.

 
     

 
    
 
     
      [bookmark: pgfId-2116355][bookmark: 99898][bookmark: 67140]RTSP Inspect Map

 
     [bookmark: pgfId-2116356]Configuration > Global Objects > Inspect Maps > RADIUS

 
     [bookmark: pgfId-2116358][bookmark: marker-2116357]The RTSP pane lets you view previously configured RTSP application inspection maps. An RTSP map lets you change the default configuration values used for RTSP application inspection. You can use an RTSP map to protect RTSP traffic.

 
     [bookmark: pgfId-2116359]Fields

 
      
      		 [bookmark: pgfId-2116360]RTSP Inspect Maps—Table that lists the defined RTSP inspect maps. 

 
      		 [bookmark: pgfId-2116361]Add—Configures a new RTSP inspect map. 

 
      		 [bookmark: pgfId-2116362]Edit—Edits the selected RTSP entry in the RTSP Inspect Maps table.

 
      		 [bookmark: pgfId-2116363]Delete—Deletes the inspect map selected in the RTSP Inspect Maps table.

 
     

 
    
 
     
      [bookmark: pgfId-2116366][bookmark: 13459]Add/Edit RTSP Policy Map

 
     [bookmark: pgfId-2116367]Configuration > Global Objects > Inspect Maps > MGCP > MGCP Inspect Map > View

 
     [bookmark: pgfId-2116368]The Add/Edit RTSP Policy Map pane lets you configure the parameters and inspections settings for RTSP application inspection maps.

 
     [bookmark: pgfId-2116369]Fields

 
      
      		 [bookmark: pgfId-2116370]Name—When adding an RTSP map, enter the name of the RTSP map. When editing an RTSP map, the name of the previously configured RTSP map is shown.

 
      		 [bookmark: pgfId-2116371]Description—Enter the description of the RTSP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116372]Parameters—Tab that lets you restrict usage on reserved ports during media port negotiation, and lets you set the URL length limit.

 
     

 
     [bookmark: pgfId-2116373] – Enforce Reserve Port Protection—Lets you restrict the use of reserved ports during media port negotiation.

 
     [bookmark: pgfId-2116374] – Maximum URL Length—Specifies the maximum length of the URL allowed in the message. Maximum value is 6000.

 
      
      		 [bookmark: pgfId-2116375]Inspections—Tab that shows you the RTSP inspection configuration and lets you add or edit.

 
     

 
     [bookmark: pgfId-2116376] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2116377] – Criterion—Shows the criterion of the RTSP inspection.

 
     [bookmark: pgfId-2116378] – Value—Shows the value to match in the RTSP inspection.

 
     [bookmark: pgfId-2116379] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2116380] – Log—Shows the log state.

 
     [bookmark: pgfId-2116381] – Add—Opens the Add RTSP Inspect dialog box to add a RTSP inspection.

 
     [bookmark: pgfId-2116382] – Edit—Opens the Edit RTSP Inspect dialog box to edit a RTSP inspection.

 
     [bookmark: pgfId-2116383] – Delete—Deletes a RTSP inspection.

 
     [bookmark: pgfId-2116384] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-2116385] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-2116389][bookmark: 14879]RTSP Class Map

 
     [bookmark: pgfId-2116390]Configuration > Firewall > Objects > Class Maps > RTSP

 
     [bookmark: pgfId-2116391]The RTSP Class Map pane lets you configure RTSP class maps for RTSP inspection.

 
     [bookmark: pgfId-2116392]An inspection class map matches application traffic with criteria specific to the application. You then identify the class map in the inspect map and enable actions. The difference between creating a class map and defining the traffic match directly in the inspect map is that you can create more complex match criteria and you can reuse class maps. The applications that support inspection class maps are DNS, FTP, H.323, HTTP, IM, SIP, and RTSP.

 
     [bookmark: pgfId-2116393]Fields

 
      
      		 [bookmark: pgfId-2116394]Name—Shows the RTSP class map name.

 
      		 [bookmark: pgfId-2116395]Match Conditions—Shows the type, match criterion, and value in the class map.

 
     

 
     [bookmark: pgfId-2116396] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2116397] – Criterion—Shows the criterion of the RTSP class map.

 
     [bookmark: pgfId-2116398] – Value—Shows the value to match in the RTSP class map.

 
      
      		 [bookmark: pgfId-2116399]Description—Shows the description of the class map.

 
      		 [bookmark: pgfId-2116400]Add—Adds a RTSP class map.

 
      		 [bookmark: pgfId-2116401]Edit—Edits a RTSP class map.

 
      		 [bookmark: pgfId-2116402]Delete—Deletes a RTSP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2116404][bookmark: 59859]Add/Edit RTSP Traffic Class Map

 
     [bookmark: pgfId-2116405]Configuration > Firewall > Objects > Class Maps > RTSP > Add/Edit RTSP Traffic Class Map

 
     [bookmark: pgfId-2116407]The Add/Edit RTSP Traffic Class Map dialog box lets you define the match criterion, values, and actions for the RTSP traffic class map.

 
     [bookmark: pgfId-2116408]Fields

 
      
      		 [bookmark: pgfId-2116409]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2116410]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2116411]Criterion—Specifies which criterion of RTSP traffic to match.

 
     

 
     [bookmark: pgfId-2116412] – URL Filter—Match URL filtering.

 
     [bookmark: pgfId-2116413] – Request Method—Match an RTSP request method.

 
      
      		 [bookmark: pgfId-2116415]URL Filter Criterion Values—Specifies to match URL filtering. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116416] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116417] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116418] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116419] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116420]URL Filter Actions—Primary action and log settings.

 
     

 
     [bookmark: pgfId-2116421] – Action—Drop connection or log. 

 
     [bookmark: pgfId-2116422] – Log—Enable or disable.

 
      
      		 [bookmark: pgfId-2116423]Request Method Criterion Values—Specifies to match an RTSP request method.

 
     

 
     [bookmark: pgfId-2116424] – Request Method—Specifies a request method: announce, describe, get_parameter, options, pause, play, record, redirect, setup, set_parameters, teardown.

 
      
      		 [bookmark: pgfId-2116425]Request Method Actions—Primary action settings.

 
     

 
     [bookmark: pgfId-2116426] – Action—Limit rate (pps).

 
    
 
   
 
    
     [bookmark: pgfId-1204403][bookmark: 24223]SIP I[bookmark: marker-1345390]nspection

 
    [bookmark: pgfId-1206537]This section describes SIP application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1311521]SIP Inspection Overview

 
     		 [bookmark: pgfId-1439707]SIP Instant Messaging

 
     		 [bookmark: pgfId-2116434]Select SIP Map

 
     		 [bookmark: pgfId-2116438]SIP Class Map

 
     		 [bookmark: pgfId-2116442]Add/Edit SIP Traffic Class Map

 
     		 [bookmark: pgfId-2116446]Add/Edit SIP Match Criterion

 
     		 [bookmark: pgfId-2116450]SIP Inspect Map

 
     		 [bookmark: pgfId-2116454]Add/Edit SIP Policy Map (Security Level)

 
     		 [bookmark: pgfId-2116458]Add/Edit SIP Policy Map (Details)

 
     		 [bookmark: pgfId-2116462]Add/Edit SIP Inspect

 
     		 [bookmark: pgfId-1311615] 

 
    

 
     
      [bookmark: pgfId-1439430][bookmark: 81319]SIP Inspection Ove[bookmark: marker-1439429]rview

 
     [bookmark: pgfId-1439431]SIP, as defined by the IETF, enables call handling sessions, particularly two-party audio conferences, or “calls.” SIP works with SDP for call signalling. SDP specifies the ports for the media stream. Using SIP, the ASA can support any SIP VoIP gateways and [bookmark: marker-1439435]VoIP [bookmark: marker-1439436]proxy servers. SIP and SDP are defined in the following RFCs:

 
      
      		 [bookmark: pgfId-1439437]SIP: Session Initiation Protocol, RFC 3261

 
      		 [bookmark: pgfId-1439438]SDP: Session Description Protocol, RFC 2327

 
     

 
     [bookmark: pgfId-1439442]To support SIP calls through the ASA, signaling messages for the media connection addresses, media ports, and embryonic connections for the media must be inspected, because while the signaling is sent over a well-known destination port (UDP/TCP 5060), the media streams are dynamically allocated. Also, SIP embeds IP addresses in the user-data portion of the IP packet. SIP inspection applies NAT for these embedded IP addresses.

 
     [bookmark: pgfId-1439443]The following limitations and restrictions apply when using PAT with SIP:

 
      
      		 [bookmark: pgfId-1439446]If a remote endpoint tries to register with a SIP proxy on a network protected by the ASA, the registration fails under very specific conditions, as follows:

 
     

 
     [bookmark: pgfId-1439448] – PAT is configured for the remote endpoint.

 
     [bookmark: pgfId-1439449] – The SIP registrar server is on the outside network.

 
     [bookmark: pgfId-1439450] – The port is missing in the contact field in the REGISTER message sent by the endpoint to the proxy server.

 
     [bookmark: pgfId-1709091] – Configuring static PAT is not supported with SIP inspection. If static PAT is configured for the Cisco Unified Communications Manager, SIP inspection cannot rewrite the SIP packet. Configure one-to-one static NAT for the Cisco Unified Communications Manager.

 
      
      		 [bookmark: pgfId-1439451]If a SIP device transmits a packet in which the SDP portion has an IP address in the owner/creator field (o=) that is different than the IP address in the connection field (c=), the IP address in the o= field may not be properly translated. This is due to a limitation in the SIP protocol, which does not provide a port value in the o= field.

 
      		 [bookmark: pgfId-2132698]When using PAT, any SIP header field which contains an internal IP address without a port might not be translated and hence the internal IP address will be leaked outside. If you want to avoid this leakage, configure NAT instead of PAT.

 
     

 
    
 
     
      [bookmark: pgfId-1439454][bookmark: 54459]SIP Instant Messa[bookmark: marker-1439453]ging

 
     [bookmark: pgfId-1439458][bookmark: marker-1439455][bookmark: marker-1439456][bookmark: marker-1439457]Instant Messaging refers to the transfer of messages between users in near real-time. SIP supports the Chat feature on Windows XP using Windows Messenger RTC Client version 4.7.0105 only. The MESSAGE/INFO methods and 202 Accept response are used to support IM as defined in the following RFCs:

 
      
      		 [bookmark: pgfId-1439459]Session Initiation Protocol (SIP)-Specific Event Notification, RFC 3265

 
      		 [bookmark: pgfId-1439460]Session Initiation Protocol (SIP) Extension for Instant Messaging, RFC 3428

 
     

 
     [bookmark: pgfId-1439461]MESSAGE/INFO requests can come in at any time after registration/subscription. For example, two users can be online at any time, but not chat for hours. Therefore, the SIP inspection engine opens pinholes that time out according to the configured SIP timeout value. This value must be configured at least five minutes longer than the subscription duration. The subscription duration is defined in the Contact Expires value and is typically 30 minutes.

 
     [bookmark: pgfId-1439462]Because MESSAGE/INFO requests are typically sent using a dynamically allocated port other than port 5060, they are required to go through the SIP inspection engine.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1439463]Note Only the Chat feature is currently supported. Whiteboard, File Transfer, and Application Sharing are not supported. RTC Client 5.0 is not supported.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1439465][bookmark: 39303]SIP inspection translates the SIP text-based messages, recalculates the content length for the SDP portion of the message, and recalculates the packet length and checksum. It dynamically opens media connections for ports specified in the SDP portion of the SIP message as address/ports on which the endpoint should listen.

 
     [bookmark: pgfId-1439466]SIP inspection has a database with indices CALL_ID/FROM/TO from the SIP payload. These indices identify the call, the source, and the destination. This database contains the media addresses and media ports found in the SDP media information fields and the media type. There can be multiple media addresses and ports for a session. The ASA opens RTP/RTCP connections between the two endpoints using these media addresses/ports.

 
     [bookmark: pgfId-1439470]The well-known port 5060 must be used on the initial call setup (INVITE) message; however, subsequent messages may not have this port number. The SIP inspection engine opens signaling connection pinholes, and marks these connections as SIP connections. This is done for the messages to reach the SIP application and be translated.

 
     [bookmark: pgfId-1439471]As a call is set up, the SIP session is in the “transient” state until the media address and media port is received from the called endpoint in a Response message indicating the RTP port the called endpoint listens on. If there is a failure to receive the response messages within one minute, the signaling connection is torn down.

 
     [bookmark: pgfId-1439472]Once the final handshake is made, the call state is moved to active and the signaling connection remains until a BYE message is received.

 
     [bookmark: pgfId-1439473]If an inside endpoint initiates a call to an outside endpoint, a media hole is opened to the outside interface to allow RTP/RTCP UDP packets to flow to the inside endpoint media address and media port specified in the INVITE message from the inside endpoint. Unsolicited RTP/RTCP UDP packets to an inside interface does not traverse the ASA, unless the ASA configuration specifically allows it.

 
    
 
     
      [bookmark: pgfId-2116469][bookmark: 78698]Select SIP Map

 
     [bookmark: pgfId-2116470]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select SIP Map

 
     [bookmark: pgfId-2116471]The Select SIP Map dialog box lets you select or create a new SIP map. A SIP map lets you change the configuration values used for SIP application inspection. The Select SIP Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2116472]Fields

 
      
      		 [bookmark: pgfId-2116473]Use the default SIP inspection map—Specifies to use the default SIP map.

 
      		 [bookmark: pgfId-2116474]Select a SIP map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2116475]Add—Opens the Add Policy Map dialog box for the inspection.

 
      		 [bookmark: pgfId-2116476]Enable encrypted traffic inspection check box—Select to enable the radio buttons to select a proxy type.

 
      		 [bookmark: pgfId-2116477]Proxy Type

 
     

 
     [bookmark: pgfId-2116478] – TLS Proxy radio button—Use TLS Proxy to enable inspection of encrypted traffic.

 
     [bookmark: pgfId-2116479] – Phone Proxy radio button—Specifies to associate the Phone Proxy with the TLS Proxy that you select from the TLS Proxy Name field.

 
     [bookmark: pgfId-2116480]Configure button—Opens the Configure the Phone Proxy dialog box so that you can specify or edit Phone Proxy configuration settings.

 
     [bookmark: pgfId-2116481] – UC-IME Proxy ratio button—Specifies to associate the UC-IME Proxy (Cisco Intercompany Media Engine proxy) with the TLS Proxy that you select from the TLS Proxy Name field.

 
     [bookmark: pgfId-2116482]Configure button—Opens the Configure the UC-IME Proxy dialog box so that you can specify or edit UC-IME Proxy configuration settings.

 
      
      		 [bookmark: pgfId-2116483]TLS Proxy Name:—Name of existing TLS Proxy.

 
      		 [bookmark: pgfId-2116484]Manage—Opens the Add TLS Proxy dialog box to add a TLS Proxy.

 
     

 
     [bookmark: pgfId-2116485]Only one TLS proxy can be assigned to the Phone Proxy or UC-IME Proxy at a time. If you configure more than one service policy rule for Phone Proxy or UC-IME Proxy inspection and attempt to assign a different TLS proxy to them, ASDM displays a warning that all other service policy rules with Phone Proxy or UC-IME inspection will be changed to use the latest selected TLS proxy.

 
     [bookmark: pgfId-2116486]The UC-IME Proxy configuration requires two TLS proxies – one for outbound traffic and one for inbound. Rather than associating the TLS proxies directly with the UC-IME Proxy, as is the case with phone proxy, the TLS proxies are associated with it indirectly via SIP inspection rules.

 
     [bookmark: pgfId-2116487]You associate a TLS proxy with the Phone Proxy while defining a SIP inspection action . ASDM will convert the association to the existing phone proxy.

 
    
 
     
      [bookmark: pgfId-2116490][bookmark: 45453]SIP Class Map

 
     [bookmark: pgfId-2116491]Configuration > Global Objects > Class Maps > SIP

 
     [bookmark: pgfId-2116492]The SIP Class Map pane lets you configure SIP class maps for SIP inspection.

 
     [bookmark: pgfId-2116493]An inspection class map matches application traffic with criteria specific to the application. You then identify the class map in the inspect map and enable actions. The difference between creating a class map and defining the traffic match directly in the inspect map is that you can create more complex match criteria and you can reuse class maps. The applications that support inspection class maps are DNS, FTP, H.323, HTTP, IM, and SIP.

 
     [bookmark: pgfId-2116494]Fields

 
      
      		 [bookmark: pgfId-2116495]Name—Shows the SIP class map name.

 
      		 [bookmark: pgfId-2116496]Match Conditions—Shows the type, match criterion, and value in the class map.

 
     

 
     [bookmark: pgfId-2116497] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2116498] – Criterion—Shows the criterion of the SIP class map.

 
     [bookmark: pgfId-2116499] – Value—Shows the value to match in the SIP class map.

 
      
      		 [bookmark: pgfId-2116500]Description—Shows the description of the class map.

 
      		 [bookmark: pgfId-2116501]Add—Adds a SIP class map.

 
      		 [bookmark: pgfId-2116502]Edit—Edits a SIP class map.

 
      		 [bookmark: pgfId-2116503]Delete—Deletes a SIP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2116506][bookmark: 24583]Add/Edit SIP Traffic Class Map

 
     [bookmark: pgfId-2116507]Configuration > Global Objects > Class Maps > SIP > Add/Edit SIP Traffic Class Map

 
     [bookmark: pgfId-2116508]The Add/Edit SIP Traffic Class Map dialog box lets you define a SIP class map.

 
     [bookmark: pgfId-2116509]Fields

 
      
      		 [bookmark: pgfId-2116510]Name—Enter the name of the SIP class map, up to 40 characters in length.

 
      		 [bookmark: pgfId-2116511]Description—Enter the description of the SIP class map.

 
      		 [bookmark: pgfId-2116512]Add—Adds a SIP class map.

 
      		 [bookmark: pgfId-2116513]Edit—Edits a SIP class map.

 
      		 [bookmark: pgfId-2116514]Delete—Deletes a SIP class map.

 
     

 
    
 
     
      [bookmark: pgfId-2116517][bookmark: 96547]Add/Edit SIP Match Criterion

 
     [bookmark: pgfId-2116518]Configuration > Global Objects > Class Maps > SIP > Add/Edit SIP Traffic Class Map > Add/Edit SIP Match Criterion

 
     [bookmark: pgfId-2116519]The Add/Edit SIP Match Criterion dialog box lets you define the match criterion and value for the SIP class map.

 
     [bookmark: pgfId-2116520]Fields 

 
      
      		 [bookmark: pgfId-2116521]Match Type—Specifies whether the class map includes traffic that matches the criterion, or traffic that does not match the criterion. 

 
     

 
     [bookmark: pgfId-2116522]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2116523]Criterion—Specifies which criterion of SIP traffic to match.

 
     

 
     [bookmark: pgfId-2116524] – Called Party—Match the called party as specified in the To header.

 
     [bookmark: pgfId-2116525] – Calling Party—Match the calling party as specified in the From header.

 
     [bookmark: pgfId-2116526] – Content Length—Match the Content Length header, between 0 and 65536.

 
     [bookmark: pgfId-2116527] – Content Type—Match the Content Type header.

 
     [bookmark: pgfId-2116528] – IM Subscriber—Match the SIP IM subscriber.

 
     [bookmark: pgfId-2116529] – Message Path—Match the SIP Via header.

 
     [bookmark: pgfId-2116530] – Request Method—Match the SIP request method.

 
     [bookmark: pgfId-2116531] – Third-Party Registration—Match the requester of a third-party registration.

 
     [bookmark: pgfId-2116532] – URI Length—Match a URI in the SIP headers, between 0 and 65536.

 
      
      		 [bookmark: pgfId-2116533]Called Party Criterion Values—Specifies to match the called party. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116534] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116535] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116536] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116537] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116538]Calling Party Criterion Values—Specifies to match the calling party. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116539] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116540] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116541] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116542] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116543]Content Length Criterion Values—Specifies to match a SIP content header of a length greater than specified.

 
     

 
     [bookmark: pgfId-2116544] – Greater Than Length—Enter a header length value in bytes.

 
      
      		 [bookmark: pgfId-2116545]Content Type Criterion Values—Specifies to match a SIP content header type.

 
     

 
     [bookmark: pgfId-2116546] – SDP—Match an SDP SIP content header type.

 
     [bookmark: pgfId-2116547] – Regular Expression—Match a regular expression.

 
     [bookmark: pgfId-2116548]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116549]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116550]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116551]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116552]IM Subscriber Criterion Values—Specifies to match the IM subscriber. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116553] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116554] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116555] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116556] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116557]Message Path Criterion Values—Specifies to match a SIP Via header. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116558] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116559] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116560] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116561] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116562]Request Method Criterion Values—Specifies to match a SIP request method.

 
     

 
     [bookmark: pgfId-2116563] – Request Method—Specifies a request method: ack, bye, cancel, info, invite, message, notify, options, prack, refer, register, subscribe, unknown, update.

 
      
      		 [bookmark: pgfId-2116564]Third-Party Registration Criterion Values—Specifies to match the requester of a third-party registration. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116565] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116566] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116567] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116568] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116569]URI Length Criterion Values—Specifies to match a URI of a selected type and greater than the specified length in the SIP headers.

 
     

 
     [bookmark: pgfId-2116570] – URI type—Specifies to match either SIP URI or TEL URI.

 
     [bookmark: pgfId-2116571] – Greater Than Length—Length in bytes.

 
    
 
     
      [bookmark: pgfId-2116577][bookmark: 19160]SIP Inspect Map

 
     [bookmark: pgfId-2116578]Configuration > Global Objects > Inspect Maps > SIP

 
     [bookmark: pgfId-2116580][bookmark: marker-2116579]The SIP pane lets you view previously configured SIP application inspection maps. A SIP map lets you change the default configuration values used for SIP application inspection. 

 
     [bookmark: pgfId-2116581]SIP is a widely used protocol for Internet conferencing, telephony, presence, events notification, and instant messaging. Partially because of its text-based nature and partially because of its flexibility, SIP networks are subject to a large number of security threats.

 
     [bookmark: pgfId-2116582]SIP application inspection provides address translation in message header and body, dynamic opening of ports and basic sanity checks. It also supports application security and protocol conformance, which enforce the sanity of the SIP messages, as well as detect SIP-based attacks.

 
     [bookmark: pgfId-2116583]Fields

 
      
      		 [bookmark: pgfId-2116584]SIP Inspect Maps—Table that lists the defined SIP inspect maps. 

 
      		 [bookmark: pgfId-2116585]Add—Configures a new SIP inspect map. To edit a SIP inspect map, choose the SIP entry in the SIP Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-2116586]Delete—Deletes the inspect map selected in the SIP Inspect Maps table.

 
      		 [bookmark: pgfId-2116587]Security Level—Select the security level (high or low).

 
     

 
     [bookmark: pgfId-2116588] – Low—Default.

 
     [bookmark: pgfId-2116589]SIP instant messaging (IM) extensions: Enabled.

 
     [bookmark: pgfId-2116590]Non-SIP traffic on SIP port: Permitted.

 
     [bookmark: pgfId-2116591]Hide server’s and endpoint’s IP addresses: Disabled.

 
     [bookmark: pgfId-2116592]Mask software version and non-SIP URIs: Disabled.

 
     [bookmark: pgfId-2116593]Ensure that the number of hops to destination is greater than 0: Enabled.

 
     [bookmark: pgfId-2116594]RTP conformance: Not enforced.

 
     [bookmark: pgfId-2116595]SIP conformance: Do not perform state checking and header validation.

 
     [bookmark: pgfId-2116596] – Medium

 
     [bookmark: pgfId-2116597]SIP instant messaging (IM) extensions: Enabled.

 
     [bookmark: pgfId-2116598]Non-SIP traffic on SIP port: Permitted.

 
     [bookmark: pgfId-2116599]Hide server’s and endpoint’s IP addresses: Disabled.

 
     [bookmark: pgfId-2116600]Mask software version and non-SIP URIs: Disabled.

 
     [bookmark: pgfId-2116601]Ensure that the number of hops to destination is greater than 0: Enabled.

 
     [bookmark: pgfId-2116602]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116603]Limit payload to audio or video, based on the signaling exchange: No

 
     [bookmark: pgfId-2116604]SIP conformance: Drop packets that fail state checking.

 
     [bookmark: pgfId-2116605] – High

 
     [bookmark: pgfId-2116606]SIP instant messaging (IM) extensions: Enabled.

 
     [bookmark: pgfId-2116607]Non-SIP traffic on SIP port: Denied.

 
     [bookmark: pgfId-2116608]Hide server’s and endpoint’s IP addresses: Disabled.

 
     [bookmark: pgfId-2116609]Mask software version and non-SIP URIs: Enabled.

 
     [bookmark: pgfId-2116610]Ensure that the number of hops to destination is greater than 0: Enabled.

 
     [bookmark: pgfId-2116611]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116612]Limit payload to audio or video, based on the signaling exchange: Yes

 
     [bookmark: pgfId-2116613]SIP conformance: Drop packets that fail state checking and packets that fail header validation.

 
     [bookmark: pgfId-2116614] – Customize—Opens the Add/Edit SIP Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2116615] – Default Level—Sets the security level back to the default level of Low.

 
    
 
     
      [bookmark: pgfId-2116618][bookmark: 28257]Add/Edit SIP Policy Map (Security Level)

 
     [bookmark: pgfId-2116619]Configuration > Global Objects > Inspect Maps > SIP > SIP Inspect Map > Basic View

 
     [bookmark: pgfId-2116620]The Add/Edit SIP Policy Map pane lets you configure the security level and additional settings for SIP application inspection maps.

 
     [bookmark: pgfId-2116621]Fields

 
      
      		 [bookmark: pgfId-2116622]Name—When adding a SIP, enter the name of the SIP map. When editing a SIP map, the name of the previously configured SIP map is shown.

 
      		 [bookmark: pgfId-2116623]Description—Enter the description of the SIP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116624]Security Level—Select the security level (high or low).

 
     

 
     [bookmark: pgfId-2116625] – Low—Default.

 
     [bookmark: pgfId-2116626]SIP instant messaging (IM) extensions: Enabled.

 
     [bookmark: pgfId-2116627]Non-SIP traffic on SIP port: Permitted.

 
     [bookmark: pgfId-2116628]Hide server’s and endpoint’s IP addresses: Disabled.

 
     [bookmark: pgfId-2116629]Mask software version and non-SIP URIs: Disabled.

 
     [bookmark: pgfId-2116630]Ensure that the number of hops to destination is greater than 0: Enabled.

 
     [bookmark: pgfId-2116631]RTP conformance: Not enforced.

 
     [bookmark: pgfId-2116632]SIP conformance: Do not perform state checking and header validation.

 
     [bookmark: pgfId-2116633] – Medium

 
     [bookmark: pgfId-2116634]SIP instant messaging (IM) extensions: Enabled.

 
     [bookmark: pgfId-2116635]Non-SIP traffic on SIP port: Permitted.

 
     [bookmark: pgfId-2116636]Hide server’s and endpoint’s IP addresses: Disabled.

 
     [bookmark: pgfId-2116637]Mask software version and non-SIP URIs: Disabled.

 
     [bookmark: pgfId-2116638]Ensure that the number of hops to destination is greater than 0: Enabled.

 
     [bookmark: pgfId-2116639]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116640]Limit payload to audio or video, based on the signaling exchange: No

 
     [bookmark: pgfId-2116641]SIP conformance: Drop packets that fail state checking.

 
     [bookmark: pgfId-2116642] – High

 
     [bookmark: pgfId-2116643]SIP instant messaging (IM) extensions: Enabled.

 
     [bookmark: pgfId-2116644]Non-SIP traffic on SIP port: Denied.

 
     [bookmark: pgfId-2116645]Hide server’s and endpoint’s IP addresses: Disabled.

 
     [bookmark: pgfId-2116646]Mask software version and non-SIP URIs: Enabled.

 
     [bookmark: pgfId-2116647]Ensure that the number of hops to destination is greater than 0: Enabled.

 
     [bookmark: pgfId-2116648]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116649]Limit payload to audio or video, based on the signaling exchange: Yes

 
     [bookmark: pgfId-2116650]SIP conformance: Drop packets that fail state checking and packets that fail header validation.

 
     [bookmark: pgfId-2116651] – Default Level—Sets the security level back to the default.

 
      
      		 [bookmark: pgfId-2116652]Details—Shows additional filtering, IP address privacy, hop count, RTP conformance, SIP conformance, field masking, and inspections settings to configure.

 
     

 
    
 
     
      [bookmark: pgfId-2116655][bookmark: 41643]Add/Edit SIP Policy Map (Details)

 
     [bookmark: pgfId-2116656]Configuration > Global Objects > Inspect Maps > SIP > SIP Inspect Map > Advanced View

 
     [bookmark: pgfId-2116657]The Add/Edit SIP Policy Map pane lets you configure the security level and additional settings for SIP application inspection maps.

 
     [bookmark: pgfId-2116658]Fields

 
      
      		 [bookmark: pgfId-2116659]Name—When adding a SIP, enter the name of the SIP map. When editing a SIP map, the name of the previously configured SIP map is shown.

 
      		 [bookmark: pgfId-2116660]Description—Enter the description of the SIP map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116661]Security Level—Shows the security level settings to configure

 
      		 [bookmark: pgfId-2116662]Filtering—Tab that lets you configure the filtering settings for SIP.

 
     

 
     [bookmark: pgfId-2116663] – Enable SIP instant messaging (IM) extensions—Enables Instant Messaging extensions. Default is enabled.

 
     [bookmark: pgfId-2116664] – Permit non-SIP traffic on SIP port—Permits non-SIP traffic on SIP port. Permitted by default.

 
      
      		 [bookmark: pgfId-2116665]IP Address Privacy—Tab that lets you configure the IP address privacy settings for SIP.

 
     

 
     [bookmark: pgfId-2116666] – Hide server’s and endpoint’s IP addresses—Enables IP address privacy. Disabled by default.

 
      
      		 [bookmark: pgfId-2116667]Hop Count—Tab that lets you configure the hop count settings for SIP.

 
     

 
     [bookmark: pgfId-2116668] – Ensure that number of hops to destination is greater than 0—Enables check for the value of Max-Forwards header is zero.

 
     [bookmark: pgfId-2116669]Action—Drop packet, Drop Connection, Reset, Log.

 
     [bookmark: pgfId-2116670]Log—Enable or Disable.

 
      
      		 [bookmark: pgfId-2116671]RTP Conformance—Tab that lets you configure the RTP conformance settings for SIP.

 
     

 
     [bookmark: pgfId-2116672] – Check RTP packets for protocol conformance—Checks RTP/RTCP packets flowing on the pinholes for protocol conformance.

 
     [bookmark: pgfId-2116673]Limit payload to audio or video, based on the signaling exchange—Enforces payload type to be audio/video based on the signaling exchange.

 
      
      		 [bookmark: pgfId-2116674]SIP Conformance—Tab that lets you configure the SIP conformance settings for SIP.

 
     

 
     [bookmark: pgfId-2116675] – Enable state transition checking—Enables SIP state checking.

 
     [bookmark: pgfId-2116676]Action—Drop packet, Drop Connection, Reset, Log.

 
     [bookmark: pgfId-2116677]Log—Enable or Disable.

 
     [bookmark: pgfId-2116678] – Enable strict validation of header fields—Enables validation of SIP header fields.

 
     [bookmark: pgfId-2116679]Action—Drop packet, Drop Connection, Reset, Log.

 
     [bookmark: pgfId-2116680]Log—Enable or Disable.

 
      
      		 [bookmark: pgfId-2116681]Field Masking—Tab that lets you configure the field masking settings for SIP.

 
     

 
     [bookmark: pgfId-2116682] – Inspect non-SIP URIs—Enables non-SIP URI inspection in Alert-Info and Call-Info headers.

 
     [bookmark: pgfId-2116683]Action—Mask or Log.

 
     [bookmark: pgfId-2116684]Log—Enable or Disable.

 
     [bookmark: pgfId-2116685] – Inspect server’s and endpoint’s software version—Inspects SIP endpoint software version in User-Agent and Server headers.

 
     [bookmark: pgfId-2116686]Action—Mask or Log.

 
     [bookmark: pgfId-2116687]Log—Enable or Disable.

 
      
      		 [bookmark: pgfId-2116688]Inspections—Tab that shows you the SIP inspection configuration and lets you add or edit.

 
     

 
     [bookmark: pgfId-2116689] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2116690] – Criterion—Shows the criterion of the SIP inspection.

 
     [bookmark: pgfId-2116691] – Value—Shows the value to match in the SIP inspection.

 
     [bookmark: pgfId-2116692] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2116693] – Log—Shows the log state.

 
     [bookmark: pgfId-2116694] – Add—Opens the Add SIP Inspect dialog box to add a SIP inspection.

 
     [bookmark: pgfId-2116695] – Edit—Opens the Edit SIP Inspect dialog box to edit a SIP inspection.

 
     [bookmark: pgfId-2116696] – Delete—Deletes a SIP inspection.

 
     [bookmark: pgfId-2116697] – Move Up—Moves an inspection up in the list.

 
     [bookmark: pgfId-2116698] – Move Down—Moves an inspection down in the list.

 
    
 
     
      [bookmark: pgfId-2116701][bookmark: 27905]Add/Edit SIP Inspect

 
     [bookmark: pgfId-2116702]Configuration > Global Objects > Inspect Maps > SIP > SIP Inspect Map > Advanced View > Add/Edit SIP Inspect

 
     [bookmark: pgfId-2116703]The Add/Edit SIP Inspect dialog box lets you define the match criterion and value for the SIP inspect map.

 
     [bookmark: pgfId-2116704]Fields 

 
      
      		 [bookmark: pgfId-2116705]Single Match—Specifies that the SIP inspect has only one match statement.

 
      		 [bookmark: pgfId-2116706]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2116707]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2116708]Criterion—Specifies which criterion of SIP traffic to match.

 
     

 
     [bookmark: pgfId-2116709] – Called Party—Match a called party as specified in the To header.

 
     [bookmark: pgfId-2116710] – Calling Party—Match a calling party as specified in the From header.

 
     [bookmark: pgfId-2116711] – Content Length—Match a content length header.

 
     [bookmark: pgfId-2116712] – Content Type—Match a content type header.

 
     [bookmark: pgfId-2116713] – IM Subscriber—Match a SIP IM subscriber.

 
     [bookmark: pgfId-2116714] – Message Path—Match a SIP Via header.

 
     [bookmark: pgfId-2116715] – Request Method—Match a SIP request method.

 
     [bookmark: pgfId-2116716] – Third-Party Registration—Match the requester of a third-party registration.

 
     [bookmark: pgfId-2116717] – URI Length—Match a URI in the SIP headers.

 
      
      		 [bookmark: pgfId-2116718]Called Party Criterion Values—Specifies to match the called party. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116719] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116720] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116721] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116722] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116723]Calling Party Criterion Values—Specifies to match the calling party. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116724] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116725] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116726] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116727] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116728]Content Length Criterion Values—Specifies to match a SIP content header of a length greater than specified.

 
     

 
     [bookmark: pgfId-2116729] – Greater Than Length—Enter a header length value in bytes.

 
      
      		 [bookmark: pgfId-2116730]Content Type Criterion Values—Specifies to match a SIP content header type.

 
     

 
     [bookmark: pgfId-2116731] – SDP—Match an SDP SIP content header type.

 
     [bookmark: pgfId-2116732] – Regular Expression—Match a regular expression.

 
     [bookmark: pgfId-2116733]Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116734]Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116735]Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116736]Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116737]IM Subscriber Criterion Values—Specifies to match the IM subscriber. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116738] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116739] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116740] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116741] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116742]Message Path Criterion Values—Specifies to match a SIP Via header. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116743] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116744] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116745] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116746] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116747]Request Method Criterion Values—Specifies to match a SIP request method.

 
     

 
     [bookmark: pgfId-2116748] – Request Method—Specifies a request method: ack, bye, cancel, info, invite, message, notify, options, prack, refer, register, subscribe, unknown, update.

 
      
      		 [bookmark: pgfId-2116749]Third-Party Registration Criterion Values—Specifies to match the requester of a third-party registration. Applies the regular expression match.

 
     

 
     [bookmark: pgfId-2116750] – Regular Expression—Lists the defined regular expressions to match.

 
     [bookmark: pgfId-2116751] – Manage—Opens the Manage Regular Expressions dialog box, which lets you configure regular expressions.

 
     [bookmark: pgfId-2116752] – Regular Expression Class—Lists the defined regular expression classes to match.

 
     [bookmark: pgfId-2116753] – Manage—Opens the Manage Regular Expression Class dialog box, which lets you configure regular expression class maps.

 
      
      		 [bookmark: pgfId-2116754]URI Length Criterion Values—Specifies to match a URI in the SIP headers greater than specified length.

 
     

 
     [bookmark: pgfId-2116755] – URI type—Specifies to match either SIP URI or TEL URI.

 
     [bookmark: pgfId-2116756] – Greater Than Length—Length in bytes.

 
      
      		 [bookmark: pgfId-2116757]Multiple Matches—Specifies multiple matches for the SIP inspection.

 
     

 
     [bookmark: pgfId-2116758] – SIP Traffic Class—Specifies the SIP traffic class match.

 
     [bookmark: pgfId-2116759] – Manage—Opens the Manage SIP Class Maps dialog box to add, edit, or delete SIP Class Maps.

 
      
      		 [bookmark: pgfId-2116760]Actions—Primary action and log settings.

 
     

 
     [bookmark: pgfId-2116761] – Action—Drop packet, drop connection, reset, log. Note: Limit rate (pps) action is available for request methods invite and register.

 
     [bookmark: pgfId-2116762] – Log—Enable or disable.

 
    
 
   
 
    
     [bookmark: pgfId-1148989][bookmark: 44615]Skinny (SCC[bookmark: marker-1345388]P) Inspection

 
    [bookmark: pgfId-1206562]This section describes SCCP application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1311759]SCCP Inspection Overview

 
     		 [bookmark: pgfId-1311781]Supporting Cisco IP Phones

 
     		 [bookmark: pgfId-1311785]Restrictions and Limitations

 
     		 [bookmark: pgfId-2116770]Select SCCP (Skinny) Map

 
     		 [bookmark: pgfId-2116774]SCCP (Skinny) Inspect Map

 
     		 [bookmark: pgfId-2116778]Message ID Filtering

 
     		 [bookmark: pgfId-2116782]Add/Edit SCCP (Skinny) Policy Map (Security Level)

 
     		 [bookmark: pgfId-2116786]Add/Edit SCCP (Skinny) Policy Map (Details)

 
     		 [bookmark: pgfId-2116790]Add/Edit Message ID Filter

 
    

 
     
      [bookmark: pgfId-1206564][bookmark: 52039]SCCP Inspection [bookmark: marker-1364865]Overview[bookmark: marker-1345389]

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1913326]Note For specific information about setting up the Phone Proxy on the ASA, which is part of the Cisco Unified Communications architecture and supports IP phone deployment, see Chapter17, “Configuring the Cisco Phone Proxy”. 

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1364880]Skinny (SCCP) is a [bookmark: marker-1364878]simplified protocol used in VoIP networks. [bookmark: marker-1364879]Cisco IP Phones using SCCP can coexist in an H.323 environment. When used with Cisco CallManager, the SCCP client can interoperate with H.323 compliant terminals. 

 
     [bookmark: pgfId-1554223]The ASA supports PAT and NAT for SCCP. PAT is necessary if you have more IP phones than global IP addresses for the IP phones to use. By supporting NAT and PAT of SCCP Signaling packets, Skinny application inspection ensures that all SCCP signalling and media packets can traverse the ASA.

 
     [bookmark: pgfId-1364894]Normal traffic between Cisco CallManager and Cisco IP Phones uses SCCP and is handled by SCCP inspection without any special configuration. The ASA also supports DHCP options 150 and 66, which it accomplishes by sending the location of a TFTP server to Cisco IP Phones and other DHCP clients. Cisco IP Phones might also include DHCP option 3 in their requests, which sets the default route.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1554224]Note The ASA supports inspection of traffic from Cisco IP Phones running SCCP protocol version 19 and earlier. 

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-1149609][bookmark: 52611]Supporting Cisco IP Phones

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1913353]Note For specific information about setting up the Phone Proxy on the ASA, which is part of the Cisco Unified Communications architecture and supports IP phone deployment, see Chapter17, “Configuring the Cisco Phone Proxy”

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1561444]In topologies where Cisco CallManager is located on the higher security interface with respect to the Cisco IP Phones, if NAT is required for the Cisco CallManager IP address, the mapping must be static as a Cisco IP Phone requires the Cisco CallManager IP address to be specified explicitly in its configuration. An static identity entry allows the Cisco CallManager on the higher security interface to accept registrations from the Cisco IP Phones.

 
     [bookmark: pgfId-1149611]Cisco IP Phones require access to a TFTP server to download the configuration information they need to connect to the Cisco CallManager server.

 
     [bookmark: pgfId-1149612]When the Cisco IP Phones are on a lower security interface compared to the TFTP server, you must use an ACL to connect to the protected TFTP server on UDP port 69. While you do need a static entry for the TFTP server, this does not have to be an identity static entry. When using NAT, an identity static entry maps to the same IP address. When using PAT, it maps to the same IP address and port.

 
     [bookmark: pgfId-1149613]When the Cisco IP Phones are on a higher security interface compared to the TFTP server and Cisco CallManager, no ACL or static entry is required to allow the Cisco IP Phones to initiate the connection. 

 
    
 
     
      [bookmark: pgfId-1149614][bookmark: 70432]Restrictions and Limitations

 
     [bookmark: pgfId-1149615]The following are limitations that apply to the current version of PAT and NAT support for SCCP:

 
      
      		 [bookmark: pgfId-1149616]PAT does not work with configurations containing the alias command. 

 
      		 [bookmark: pgfId-1328379]Outside NAT or PAT is  not supported.

 
     

 
     [bookmark: pgfId-1365162]If the address of an internal Cisco CallManager is configured for NAT or PAT to a different IP address or port, registrations for external Cisco IP Phones fail because the ASA currently does not support NAT or PAT for the file content transferred over TFTP. Although the ASA supports NAT of TFTP messages and opens a pinhole for the TFTP file, the ASA cannot translate the Cisco CallManager IP address and port embedded in the Cisco IP Phone configuration files that are transferred by TFTP during phone registration.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1364923]Note The ASA supports stateful failover of SCCP calls except for calls that are in the middle of call setup.[bookmark: 77503]

 
      
      
 
     
 
     

 
    
 
     
      [bookmark: pgfId-2116797][bookmark: 40386]Select SCCP (Skinny) Map

 
     [bookmark: pgfId-2116798]Add/Edit Service Policy Rule Wizard > Rule Actions > Protocol Inspection Tab > Select SCCP Map

 
     [bookmark: pgfId-2116799]The Select SCCP (Skinny) Map dialog box lets you select or create a new SCCP (Skinny) map. An SCCP (Skinny) map lets you change the configuration values used for SCCP (Skinny) application inspection. The Select SCCP (Skinny) Map table provides a list of previously configured maps that you can select for application inspection.

 
     [bookmark: pgfId-2116800]Fields

 
      
      		 [bookmark: pgfId-2116801]Use the default SCCP (Skinny) inspection map—Specifies to use the default SCCP (Skinny)  map.

 
      		 [bookmark: pgfId-2116802]Select an SCCP (Skinny) map for fine control over inspection — Lets you select a defined application inspection map or add a new one.

 
      		 [bookmark: pgfId-2116803]Add—Opens the Add Policy Map dialog box for the inspection.

 
      		 [bookmark: pgfId-2116804]Encrypted Traffic Inspection—Lets you specify TLS proxy settings for the inspect map.

 
     

 
     [bookmark: pgfId-2116805] – Do not inspect Encrypted Traffic—Disables the inspection of Skinny application inspection. 

 
     [bookmark: pgfId-2116806] – Use Phone Proxy to enable inspection of encrypted traffic—Uses the Phone Proxy configured on the ASA to inspect Skinny application traffic. See Chapter17, “Configuring the Cisco Phone Proxy”

 
     [bookmark: pgfId-2116813] – Use TLS Proxy to enable inspection of encrypted traffic—Specifies to use Transaction Layer Security Proxy to enable inspection of encryped traffic.

 
     [bookmark: pgfId-2116814]TLS Proxy Name:—Name of existing TLS Proxy.

 
     [bookmark: pgfId-2116815]New—Opens the Add TLS Proxy dialog box to add a TLS Proxy.

 
    
 
     
      [bookmark: pgfId-2116821][bookmark: 81271]SCCP (Skinny) Inspect Map

 
     [bookmark: pgfId-2116822]Configuration > Global Objects > Inspect Maps > SCCP (Skinny)

 
     [bookmark: pgfId-2116825][bookmark: marker-2116823][bookmark: marker-2116824]The SCCP (Skinny) pane lets you view previously configured SCCP (Skinny) application inspection maps. An SCCP (Skinny) map lets you change the default configuration values used for SCCP (Skinny) application inspection. 

 
     [bookmark: pgfId-2116826]Skinny application inspection performs translation of embedded IP address and port numbers within the packet data, and dynamic opening of pinholes. It also performs additional protocol conformance checks and basic state tracking.

 
     [bookmark: pgfId-2116827]Fields

 
      
      		 [bookmark: pgfId-2116828]SCCP (Skinny) Inspect Maps—Table that lists the defined SCCP (Skinny) inspect maps. 

 
      		 [bookmark: pgfId-2116829]Add—Configures a new SCCP (Skinny) inspect map. To edit an SCCP (Skinny) inspect map, choose the SCCP (Skinny) entry in the SCCP (Skinny) Inspect Maps table and click  Customize .

 
      		 [bookmark: pgfId-2116830]Delete—Deletes the inspect map selected in the SCCP (Skinny) Inspect Maps table.

 
      		 [bookmark: pgfId-2116831]Security Level—Select the security level (high or low).

 
     

 
     [bookmark: pgfId-2116832] – Low—Default.

 
     [bookmark: pgfId-2116833]Registration: Not enforced.

 
     [bookmark: pgfId-2116834]Maximum message ID: 0x181.

 
     [bookmark: pgfId-2116835]Minimum prefix length: 4

 
     [bookmark: pgfId-2116836]Media timeout: 00:05:00

 
     [bookmark: pgfId-2116837]Signaling timeout: 01:00:00.

 
     [bookmark: pgfId-2116838]RTP conformance: Not enforced.

 
     [bookmark: pgfId-2116839] – Medium

 
     [bookmark: pgfId-2116840]Registration: Not enforced.

 
     [bookmark: pgfId-2116841]Maximum message ID: 0x141.

 
     [bookmark: pgfId-2116842]Minimum prefix length: 4.

 
     [bookmark: pgfId-2116843]Media timeout: 00:01:00.

 
     [bookmark: pgfId-2116844]Signaling timeout: 00:05:00.

 
     [bookmark: pgfId-2116845]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116846]Limit payload to audio or video, based on the signaling exchange: No.

 
     [bookmark: pgfId-2116847] – High

 
     [bookmark: pgfId-2116848]Registration: Enforced.

 
     [bookmark: pgfId-2116849]Maximum message ID: 0x141.

 
     [bookmark: pgfId-2116850]Minimum prefix length: 4.

 
     [bookmark: pgfId-2116851]Maximum prefix length: 65536.

 
     [bookmark: pgfId-2116852]Media timeout: 00:01:00.

 
     [bookmark: pgfId-2116853]Signaling timeout: 00:05:00.

 
     [bookmark: pgfId-2116854]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116855]Limit payload to audio or video, based on the signaling exchange: Yes.

 
     [bookmark: pgfId-2116856] – Message ID Filtering—Opens the Messaging ID Filtering dialog box for configuring message ID filters.

 
     [bookmark: pgfId-2116857] – Customize—Opens the Add/Edit SCCP (Skinny) Policy Map dialog box for additional settings.

 
     [bookmark: pgfId-2116858] – Default Level—Sets the security level back to the default level of Low.

 
    
 
     
      [bookmark: pgfId-2116861][bookmark: 51494]Message ID Filtering

 
     [bookmark: pgfId-2116862]Configuration > Global Objects > Inspect Maps > SCCP (Skinny) > Message ID Filtering

 
     [bookmark: pgfId-2116864][bookmark: marker-2116863]The Message ID Filtering dialog box lets you configure the settings for a message ID filter. 

 
     [bookmark: pgfId-2116865]Fields

 
      
      		 [bookmark: pgfId-2116866]Match Type—Shows the match type, which can be a positive or negative match. 

 
      		 [bookmark: pgfId-2116867]Criterion—Shows the criterion of the inspection.

 
      		 [bookmark: pgfId-2116868]Value—Shows the value to match in the inspection.

 
      		 [bookmark: pgfId-2116869]Action—Shows the action if the match condition is met.

 
      		 [bookmark: pgfId-2116870]Log—Shows the log state.

 
      		 [bookmark: pgfId-2116871]Add—Opens the Add Message ID Filtering dialog box to add a message ID filter.

 
      		 [bookmark: pgfId-2116872]Edit—Opens the Edit Message ID Filtering dialog box to edit a message ID filter.

 
      		 [bookmark: pgfId-2116873]Delete—Deletes a message ID filter.

 
      		 [bookmark: pgfId-2116874]Move Up—Moves an entry up in the list.

 
      		 [bookmark: pgfId-2116875]Move Down—Moves an entry down in the list.

 
     

 
    
 
     
      [bookmark: pgfId-2116878][bookmark: 42778]Add/Edit SCCP (Skinny) Policy Map (Security Level)

 
     [bookmark: pgfId-2116879]Configuration > Global Objects > Inspect Maps > SCCP (Skinny) > SCCP (Skinny) Inspect Map > Basic View

 
     [bookmark: pgfId-2116880]The Add/Edit SCCP (Skinny) Policy Map pane lets you configure the security level and additional settings for SCCP (Skinny) application inspection maps.

 
     [bookmark: pgfId-2116881]Fields

 
      
      		 [bookmark: pgfId-2116882]Name—When adding an SCCP (Skinny) map, enter the name of the SCCP (Skinny) map. When editing an SCCP (Skinny) map, the name of the previously configured SCCP (Skinny) map is shown.

 
      		 [bookmark: pgfId-2116883]Description—Enter the description of the SCCP (Skinny) map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116884]Security Level—Select the security level (high or low).

 
     

 
     [bookmark: pgfId-2116885] – Low—Default.

 
     [bookmark: pgfId-2116886]Registration: Not enforced.

 
     [bookmark: pgfId-2116887]Maximum message ID: 0x181.

 
     [bookmark: pgfId-2116888]Minimum prefix length: 4

 
     [bookmark: pgfId-2116889]Media timeout: 00:05:00

 
     [bookmark: pgfId-2116890]Signaling timeout: 01:00:00.

 
     [bookmark: pgfId-2116891]RTP conformance: Not enforced.

 
     [bookmark: pgfId-2116892] – Medium

 
     [bookmark: pgfId-2116893]Registration: Not enforced.

 
     [bookmark: pgfId-2116894]Maximum message ID: 0x141.

 
     [bookmark: pgfId-2116895]Minimum prefix length: 4.

 
     [bookmark: pgfId-2116896]Media timeout: 00:01:00.

 
     [bookmark: pgfId-2116897]Signaling timeout: 00:05:00.

 
     [bookmark: pgfId-2116898]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116899]Limit payload to audio or video, based on the signaling exchange: No.

 
     [bookmark: pgfId-2116900] – High

 
     [bookmark: pgfId-2116901]Registration: Enforced.

 
     [bookmark: pgfId-2116902]Maximum message ID: 0x141.

 
     [bookmark: pgfId-2116903]Minimum prefix length: 4.

 
     [bookmark: pgfId-2116904]Maximum prefix length: 65536.

 
     [bookmark: pgfId-2116905]Media timeout: 00:01:00.

 
     [bookmark: pgfId-2116906]Signaling timeout: 00:05:00.

 
     [bookmark: pgfId-2116907]RTP conformance: Enforced.

 
     [bookmark: pgfId-2116908]Limit payload to audio or video, based on the signaling exchange: Yes.

 
     [bookmark: pgfId-2116909] – Message ID Filtering—Opens the Messaging ID Filtering dialog box for configuring message ID filters.

 
     [bookmark: pgfId-2116910] – Default Level—Sets the security level back to the default.

 
      
      		 [bookmark: pgfId-2116911]Details—Shows additional parameter, RTP conformance, and message ID filtering settings to configure.

 
     

 
    
 
     
      [bookmark: pgfId-2116914][bookmark: 62246]Add/Edit SCCP (Skinny) Policy Map (Details)

 
     [bookmark: pgfId-2116915]Configuration > Global Objects > Inspect Maps > SCCP (Skinny) > SCCP (Skinny) Inspect Map > Advanced View

 
     [bookmark: pgfId-2116916]The Add/Edit SCCP (Skinny) Policy Map pane lets you configure the security level and additional settings for SCCP (Skinny) application inspection maps.

 
     [bookmark: pgfId-2116917]Fields

 
      
      		 [bookmark: pgfId-2116918]Name—When adding an SCCP (Skinny) map, enter the name of the SCCP (Skinny) map. When editing an SCCP (Skinny) map, the name of the previously configured SCCP (Skinny) map is shown.

 
      		 [bookmark: pgfId-2116919]Description—Enter the description of the DNS map, up to 200 characters in length.

 
      		 [bookmark: pgfId-2116920]Security Level—Shows the security level and message ID filtering settings to configure.

 
      		 [bookmark: pgfId-2116921]Parameters—Tab that lets you configure the parameter settings for SCCP (Skinny).

 
     

 
     [bookmark: pgfId-2116922] – Enforce endpoint registration—Enforce that Skinny endpoints are registered before placing or receiving calls.

 
     [bookmark: pgfId-2116923]Maximum Message ID—Specify value of maximum SCCP message ID allowed.

 
     [bookmark: pgfId-2116924] – SCCP Prefix Length—Specifies prefix length value in Skinny messages.

 
     [bookmark: pgfId-2116925]Minimum Prefix Length—Specify minimum value of SCCP prefix length allowed.

 
     [bookmark: pgfId-2116926]Maximum Prefix Length—Specify maximum value of SCCP prefix length allowed.

 
     [bookmark: pgfId-2116927] – Media Timeout—Specify timeout value for media connections.

 
     [bookmark: pgfId-2116928] – Signaling Timeout—Specify timeout value for signaling connections.

 
      
      		 [bookmark: pgfId-2116929]RTP Conformance—Tab that lets you configure the RTP conformance settings for SCCP (Skinny).

 
     

 
     [bookmark: pgfId-2116930] – Check RTP packets for protocol conformance—Checks RTP/RTCP packets flowing on the pinholes for protocol conformance.

 
     [bookmark: pgfId-2116931]Limit payload to audio or video, based on the signaling exchange—Enforces the payload type to be audio/video based on the signaling exchange.

 
      
      		 [bookmark: pgfId-2116932]Message ID Filtering—Tab that lets you configure the message ID filtering settings for SCCP (Skinny).

 
     

 
     [bookmark: pgfId-2116933] – Match Type—Shows the match type, which can be a positive or negative match. 

 
     [bookmark: pgfId-2116934] – Criterion—Shows the criterion of the inspection.

 
     [bookmark: pgfId-2116935] – Value—Shows the value to match in the inspection.

 
     [bookmark: pgfId-2116936] – Action—Shows the action if the match condition is met.

 
     [bookmark: pgfId-2116937] – Log—Shows the log state.

 
     [bookmark: pgfId-2116938] – Add—Opens the Add Message ID Filtering dialog box to add a message ID filter.

 
     [bookmark: pgfId-2116939] – Edit—Opens the Edit Message ID Filtering dialog box to edit a message ID filter.

 
     [bookmark: pgfId-2116940] – Delete—Deletes a message ID filter.

 
     [bookmark: pgfId-2116941] – Move Up—Moves an entry up in the list.

 
     [bookmark: pgfId-2116942] – Move Down—Moves an entry down in the list.

 
    
 
     
      [bookmark: pgfId-2116945][bookmark: 50944]Add/Edit Message ID Filter

 
     [bookmark: pgfId-2116946]Configuration > Global Objects > Inspect Maps > SCCP (Skinny) > SCCP (Skinny) Inspect Map > Advanced View > Add/Edit Message ID Filter

 
     [bookmark: pgfId-2116947]The Add Message ID Filter dialog box lets you configure message ID filters.

 
     [bookmark: pgfId-2116948]Fields

 
      
      		 [bookmark: pgfId-2116949]Match Type—Specifies whether traffic should match or not match the values. 

 
     

 
     [bookmark: pgfId-2116950]For example, if No Match is selected on the string “example.com,” then any traffic that contains “example.com” is excluded from the class map.

 
      
      		 [bookmark: pgfId-2116951]Criterion—Specifies which criterion of SCCP (Skinny) traffic to match.

 
     

 
     [bookmark: pgfId-2116952] – Message ID—Match specified message ID.

 
     [bookmark: pgfId-2116953]Message ID—Specify value of maximum SCCP message ID allowed. 

 
     [bookmark: pgfId-2116954] – Message ID Range—Match specified message ID range.

 
     [bookmark: pgfId-2116955]Lower Message ID—Specify lower value of SCCP message ID allowed.

 
     [bookmark: pgfId-2116956]Upper Message ID—Specify upper value of SCCP message ID allowed.

 
      
      		 [bookmark: pgfId-2116957]Action—Drop packet.

 
      		 [bookmark: pgfId-2116958]Log—Enable or disable.

 
     

 
     [bookmark: pgfId-1540927][bookmark: 15283] 
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     [bookmark: pgfId-1043201][bookmark: 17102]Configuring Twice NAT (ASA 8.3 and Later)[bookmark: marker-1127646] 
      
      
 
     
 

 
    [bookmark: pgfId-1094014]Twice NAT lets you identify both the source and destination address in a single rule. This chapter shows you how to configure twice NAT and includes the following sections:

 
     
     		 [bookmark: pgfId-1057264]Information About Twice NAT

 
     		 [bookmark: pgfId-1057268]Licensing Requirements for Twice NAT

 
     		 [bookmark: pgfId-1101840]Prerequisites for Twice NAT

 
     		 [bookmark: pgfId-1046652]Guidelines and Limitations

 
     		 [bookmark: pgfId-1384420]Default Settings

 
     		 [bookmark: pgfId-1046685]Configuring Twice NAT

 
     		 [bookmark: pgfId-1216748]Monitoring Twice NAT

 
     		 [bookmark: pgfId-1803092]Configuration Examples for Twice NAT

 
     		 [bookmark: pgfId-1068119]Feature History for Twice NAT

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1132638]Note For detailed information about how NAT works, see Chapter3, “Information About NAT (ASA 8.3 and Later)”

 
     
     
 
    
 
    

 
   
 
    
     [bookmark: pgfId-1132640][bookmark: 15525]Information About Twice NAT

 
    [bookmark: pgfId-1132641]Twice NAT lets you identify both the source and destination address in a single rule. Specifying both the source and destination addresses lets you specify that a source address should be translated to A when going to destination X, but be translated to B when going to destination Y, for example.

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1230616]Note For static NAT, the rule is bidirectional, so be aware that “source” and “destination” are used in commands and descriptions throughout this guide even though a given connection might originate at the “destination” address. For example, if you configure static NAT with port address translation, and specify the source address as a Telnet server, and you want all traffic going to that Telnet server to have the port translated from 2323 to 23, then in the command, you must specify the source ports to be translated (real: 23, mapped: 2323). You specify the source ports because you specified the Telnet server address as the source address.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1416283]The destination address is optional. If you specify the destination address, you can either map it to itself (identity NAT), or you can map it to a different address. The destination mapping is always a static mapping.

 
    [bookmark: pgfId-1416284]Twice NAT also lets you use service objects for static NAT-with-port-translation; network object NAT only accepts inline definition.

 
    [bookmark: pgfId-1101876]For detailed information about the differences between twice NAT and network object NAT, see the “How NAT is Implemented” section.

 
    [bookmark: pgfId-1101901]Twice NAT rules are added to section 1 of the NAT rules table, or if specified, section 3. For more information about NAT ordering, see the “NAT Rule Order” section.

 
   
 
    
     [bookmark: pgfId-1207713][bookmark: 29596]Licensing Requirements for Twice NAT

 
    [bookmark: pgfId-1808728] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1808721]Model 
         
  
        		 
          
          [bookmark: pgfId-1808723]License Requirement 
         
  
       

 
        
        		[bookmark: pgfId-1808725]All models

  
        		[bookmark: pgfId-1808727]Base License.

  
       

 
       
     

 
    
 
   
 
    
     [bookmark: pgfId-1099660][bookmark: 79269]Prerequisites for Twice NAT[bookmark: marker-1127647]

 
     
     		 [bookmark: pgfId-1623327]For both the real and mapped addresses, configure network objects or network object groups. Network object groups are particularly useful for creating a mapped address pool with discontinuous IP address ranges or multiple hosts or subnets. To create a network object or group, see the “Configuring Network Objects and Groups” section in the general operations configuration guide.

 
     		 [bookmark: pgfId-1623334]For static NAT-with-port-translation, configure TCP or UDP service objects. To create a service object, see the “Configuring Service Objects and Service Groups” section in the general operations configuration guide. 

 
    

 
    [bookmark: pgfId-1623321]For specific guidelines for objects and groups, see the configuration section for the NAT type you want to configure. See also the “Guidelines and Limitations” section.

 
   
 
    
     [bookmark: pgfId-1099670][bookmark: 16098]Guidelines and Limitations[bookmark: marker-1127648]

 
    [bookmark: pgfId-1099671]This section includes the guidelines and limitations for this feature.

 
    [bookmark: pgfId-1099673]Context Mode Guidelines

 
    [bookmark: pgfId-1099674]Supported in single and multiple context mode.

 
    [bookmark: pgfId-1099676]Firewall Mode Guidelines

 
     
     		 [bookmark: pgfId-1117009]Supported in routed and transparent firewall mode.

 
     		 [bookmark: pgfId-1117010]In transparent mode, you must specify the real and mapped interfaces; you cannot use --Any--.

 
     		 [bookmark: pgfId-1117011]In transparent mode, you cannot configure interface PAT, because the transparent mode interfaces do not have IP addresses. You also cannot use the management IP address as a mapped address.

 
     		 [bookmark: pgfId-1496793]In transparent mode, translating between IPv4 and IPv6 networks is not supported. Translating between two IPv6 networks, or between two IPv4 networks is supported.

 
    

 
    [bookmark: pgfId-1496795][bookmark: 84518]IPv6 Guidelines

 
     
     		 [bookmark: pgfId-1496796]Supports IPv6.

 
     		 [bookmark: pgfId-1496797]For routed mode, you can also translate between IPv4 and IPv6.

 
     		 [bookmark: pgfId-1496798]For transparent mode, translating between IPv4 and IPv6 networks is not supported. Translating between two IPv6 networks, or between two IPv4 networks is supported.

 
     		 [bookmark: pgfId-1539766]For transparent mode, a PAT pool is not supported for IPv6.

 
     		 [bookmark: pgfId-1539767]For static NAT, you can specify an IPv6 subnet up to /64. Larger subnets are not supported.

 
     		 [bookmark: pgfId-1539779]When using FTP with NAT46, when an IPv4 FTP client connects to an IPv6 FTP server, the client must use either the extended passive mode (EPSV) or extended port mode (EPRT); PASV and PORT commands are not supported with IPv6.

 
    

 
    [bookmark: pgfId-1105693]Additional Guidelines

 
     
     		 [bookmark: pgfId-1201630](This limitation is for 9.1.0 to 9.1.5; this limitation was removed in 9.1.6 and following maintenance releases.) You cannot configure FTP destination port translation when the source IP address is a subnet (or any other application that uses a secondary connection); the FTP data channel establishment does not succeed. 

 
     		 [bookmark: pgfId-1631327]If you change the NAT configuration, and you do not want to wait for existing translations to time out before the new NAT information is used, you can clear the translation table using the  clear xlate command. However, clearing the translation table disconnects all current connections that use translations.

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1201631]Note If you remove a dynamic NAT or PAT rule, and then add a new rule with mapped addresses that overlap the addresses in the removed rule, then the new rule will not be used until all connections associated with the removed rule time out or are cleared using the clear xlate command. This safeguard ensures that the same address is not assigned to multiple hosts.

 
     
     
 
    
 
    

 
     
     		 [bookmark: pgfId-1539506]You cannot use an object group with both IPv4 and IPv6 addresses; the object group must include only one type of address.

 
     		 [bookmark: pgfId-1105673]When using the  any keyword in a NAT rule, the definition of “any” traffic (IPv4 vs. IPv6) depends on the rule. Before the ASA performs NAT on a packet, the packet must be IPv6-to-IPv6 or IPv4-to-IPv4; with this prerequisite, the ASA can determine the value of  any in a NAT rule. For example, if you configure a rule from “any” to an IPv6 server, and that server was mapped from an IPv4 address, then  any means “any IPv6 traffic.” If you configure a rule from “any” to “any,” and you map the source to the interface IPv4 address, then  any means “any IPv4 traffic” because the mapped interface address implies that the destination is also IPv4.

 
     		 [bookmark: pgfId-1537155]Objects and object groups used in NAT cannot be undefined; they must include IP addresses.

 
     		 [bookmark: pgfId-1362274]You can use the same objects in multiple rules.

 
     		 [bookmark: pgfId-1115189]The mapped IP address pool cannot include:

 
    

 
    [bookmark: pgfId-1115190] – The mapped interface IP address. If you specify --Any-- interface for the rule, then all interface IP addresses are disallowed. For interface PAT (routed mode only), use the interface name instead of the IP address.

 
    [bookmark: pgfId-1115191] – (Transparent mode) The management IP address.

 
    [bookmark: pgfId-1115192] – (Dynamic NAT) The standby interface IP address when VPN is enabled.

 
    [bookmark: pgfId-1115193] – Existing VPN pool addresses.

 
   
 
    
     [bookmark: pgfId-1384347][bookmark: 67652]Default Settings

 
     
     		 [bookmark: pgfId-1384409]By default, the rule is added to the end of section 1 of the NAT table.

 
     		 [bookmark: pgfId-1384410](Routed mode) The default real and mapped interface is Any, which applies the rule to all interfaces.

 
     		 [bookmark: pgfId-1786213](8.3(1), 8.3(2), and 8.4(1)) The default behavior for identity NAT has proxy ARP disabled. You cannot configure this setting. (8.4(2) and later) The default behavior for identity NAT has proxy ARP enabled, matching other static NAT rules. You can disable proxy ARP if desired.

 
     		 [bookmark: pgfId-1384437]If you specify an optional interface, then the ASA uses the NAT configuration to determine the egress interface. (8.3(1) through 8.4(1)) The only exception is for identity NAT, which always uses a route lookup, regardless of the NAT configuration. (8.4(2) and later) For identity NAT, the default behavior is to use the NAT configuration, but you have the option to always use a route lookup instead.

 
    

 
   
 
    
     [bookmark: pgfId-1099300][bookmark: 23253][bookmark: 60355][bookmark: 71793]Configuring Twice NAT

 
    [bookmark: pgfId-1101580]This section describes how to configure twice NAT. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1642631]Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool

 
     		 [bookmark: pgfId-1111678]Configuring Dynamic PAT (Hide)

 
     		 [bookmark: pgfId-1111703]Configuring Static NAT or Static NAT-with-Port-Translation

 
     		 [bookmark: pgfId-1111724]Configuring Identity NAT

 
     		 [bookmark: pgfId-1496755]Configuring Per-Session PAT Rules

 
    

 
     
      [bookmark: pgfId-1101587][bookmark: 78961][bookmark: 30332]Configuring Dynamic NAT[bookmark: marker-1127649] or Dynamic PAT Using a PAT Pool

 
     [bookmark: pgfId-1101588]This section describes how to configure twice NAT for dynamic NAT or for dynamic PAT using a PAT pool. For more information, see the “Dynamic NAT” section or the “Dynamic PAT” section.

 
    
 
     
      [bookmark: pgfId-1786241]Guidelines

 
     [bookmark: pgfId-1786242]For a PAT pool:

 
      
      		 [bookmark: pgfId-1786243]If available, the real source port number is used for the mapped port. However, if the real port is  not available, by default the mapped ports are chosen from the same range of ports as the real port number: 0 to 511, 512 to 1023, and 1024 to 65535. Therefore, p[bookmark: marker-1786244]orts below 1024 have only a small PAT pool that can be used. (8.4(3) and later, not including 8.5(1) or 8.6(1)) If you have a lot of traffic that uses the lower port ranges, you can now specify for a PAT pool a flat range of ports to be used instead of the three unequal-sized tiers: either 1024 to 65535, or 1 to 65535.

 
      		 [bookmark: pgfId-1786246](8.4(3) and later, not including 8.5(1) or 8.6(1)) If you use the same PAT pool object in two separate rules, then be sure to specify the same options for each rule. For example, if one rule specifies extended PAT and a flat range, then the other rule must also specify extended PAT and a flat range.

 
     

 
     [bookmark: pgfId-1786248]For exte[bookmark: marker-1786247]nded PAT for a PAT pool (8.4(3) and later, not including 8.5(1) or 8.6(1)):

 
      
      		 [bookmark: pgfId-1786251]Many application inspections do not support extended PAT. See the “Default Settings and NAT Limitations” section in “Getting Started with Application Layer Protocol Inspection,” for a complete list of unsupported inspections.

 
      		 [bookmark: pgfId-1786256]If you enable extended PAT for a dynamic PAT rule, then you cannot also use an address in the PAT pool as the PAT address in a separate static NAT with port translation rule. For example, if the PAT pool includes 10.1.1.1, then you cannot create a static NAT-with-port-translation rule using 10.1.1.1 as the PAT address.

 
      		 [bookmark: pgfId-1786257]Extended PAT can consume a large amount of memory because NAT pools are created for each unique destination, which in turn uses up memory. This may lead to memory exhaustion quickly even with less number of connections.

 
      		 [bookmark: pgfId-1786258]If you use a PAT pool and specify an interface for fallback, you cannot specify extended PAT.

 
      		 [bookmark: pgfId-1786259]For VoIP deployments that use ICE or TURN, do not use extended PAT. ICE and TURN rely on the PAT binding to be the same for all destinations.

 
     

 
     [bookmark: pgfId-1786260]For round robin for a PAT pool:

 
      
      		 [bookmark: pgfId-1786261](8.4(3) and later, not including 8.5(1) or 8.6(1)) If a host has an existing connection, then subsequent connections from that host will use the same PAT IP address if ports are available.  Note : This “stickiness” does not survive a failover. If the ASA fails over, then subsequent connections from a host may not use the initial IP address.

 
      		 [bookmark: pgfId-1786265](8.4(2), 8.5(1), and 8.6(1)) If a host has an existing connection, then subsequent connections from that host will likely use  different PAT addresses for each connection because of the round robin allocation. In this case, you may have problems when accessing two websites that exchange information about the host, for example an e-commerce site and a payment site. When these sites see two different IP addresses for what is supposed to be a single host, the transaction may fail.

 
      		 [bookmark: pgfId-1786266]Round robin, especially when combined with extended PAT, can consume a large amount of memory. Because NAT pools are created for every mapped protocol/IP address/port range, round robin results in a large number of concurrent NAT pools, which use memory. Extended PAT results in an even larger number of concurrent NAT pools.

 
     

 
    
 
     
      [bookmark: pgfId-1091674]Detailed Steps

 
     [bookmark: pgfId-1786271]To configure dynamic NAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1786272]Step 1 Choose Configuration > Firewall > NAT Rules, and then click Add.

 
     [bookmark: pgfId-1786273]If you want to add this rule to section 3 after the network object rules, then click the down arrow next to Add, and choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1803421] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786278]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1803429] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786284]Step 2 [bookmark: 74790]Set the source and destination interfaces.

 
     [bookmark: pgfId-1786285]By default in routed mode, both interfaces are set to --Any--. In transparent firewall mode, you must set specific interfaces.

 
     [bookmark: pgfId-1786286] a. From the Match Criteria: Original Packet > Source Interface drop-down list, choose the source interface.

 
     [bookmark: pgfId-1786287] b. From the Match Criteria: Original Packet > Destination Interface drop-down list, choose the destination interface.

 
     [bookmark: pgfId-1803437] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786292]Step 3 Identify the original packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the source interface network (the real source address and the mapped destination address). See the following figure for an example of the original packet vs. the translated packet.

 
     [bookmark: pgfId-1786296] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786297] a. For the Match Criteria: Original Packet > Source Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Original Source Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only. The default is any. 

 
     [bookmark: pgfId-1803445] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786302] b. (Optional) For the Match Criteria: Original Packet > Destination Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Original Destination Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only.

 
     [bookmark: pgfId-1786303]Although the main feature of twice NAT is the inclusion of the destination IP address, the destination address is optional. If you do specify the destination address, you can configure static translation for that address or just use identity NAT for it. You might want to configure twice NAT without a destination address to take advantage of some of the other qualities of twice NAT, including the use of network object groups for real addresses, or manually ordering of rules. For more information, see the “Main Differences Between Network Object NAT and Twice NAT” section.

 
     [bookmark: pgfId-1786307]Step 4 (Optional) Identify the original packet port (the mapped destination port). For the Match Criteria: Original Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Original Service dialog box.

 
     [bookmark: pgfId-1786308]Dynamic NAT does not support port translation. However, because the destination translation is always static, you can perform port translation for the destination port. A service object can contain both a source and destination port, but only the destination port is used in this case. If you specify the source port, it will be ignored. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1803453] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1803457] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786317]Step 5 Choose Dynamic from the Match Criteria: Translated Packet > Source NAT Type drop-down list.

 
     [bookmark: pgfId-1786318]This setting only applies to the source address; the destination translation is always static.

 
     [bookmark: pgfId-1803465] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786324]Step 6 [bookmark: 91093]Identify the translated packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the destination interface network (the mapped source address and the real destination address). You can translate between IPv4 and IPv6 if desired. See the following figure for an example of the original packet vs. the translated packet.

 
     [bookmark: pgfId-1786328] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786329] a. You can perform either dynamic NAT or Dynamic PAT using a PAT pool:

 
      
       
       		 [bookmark: pgfId-1786330]Dynamic NAT—For the Match Criteria: Translated Packet > Source Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Translated Source Address dialog box.

 
      

 
     

 
     [bookmark: pgfId-1786331]For dynamic NAT, you typically configure a larger group of source addresses to be mapped to a smaller group.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1786332]Note The object or group cannot contain a subnet.

 
      
      
 
     
 
     

 
      
       
       		 [bookmark: pgfId-1786334]Dynamic PAT using a PAT pool—.T[bookmark: marker-1786335]o configure a PAT pool, check the  PAT Pool Translated Address check box, then click the browse button and choose an existing network object or group or create a new object or group from the Browse Translated PAT Pool Address dialog box.  Note : Leave the Source Address field empty.

 
      

 
     

 
     [bookmark: pgfId-1803479] 
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     [bookmark: pgfId-1786340]Note The object or group cannot contain a subnet.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1786341](Optional) For a PAT pool, configure the following options:

 
     [bookmark: pgfId-1786343] – To assign addresses/ports in a round-robin fashion, check th[bookmark: marker-1786342]e Round Robin check box. Without round-robin, by default, all ports for a PAT address will be allocated before the next PAT address is used. The round-robin method assigns an address/port from each PAT address in the pool before returning to use the first address again, and then the second address, and so on.

 
     [bookmark: pgfId-1786344] – (8.4(3) and later, not including 8.5(1) or 8.6(1)) Check the Extend PAT uniqueness to per destination instead of per interface check box to use extended PAT. Extended PAT uses 65535 ports per service, as opposed to per IP address, by including the destination address and port in the translation information. Normally, the destination port and address are not considered when creating PAT translations, so you are limited to 65535 ports per PAT address. For example, with extended PAT, you can create a translation of 10.1.1.1:1027 when going to 192.168.1.7:23 as well as a translation of 10.1.1.1:1027 when going to 192.168.1.7:80.

 
     [bookmark: pgfId-1786345] – (8.4(3) and later, not including 8.5(1) or 8.6(1)) Check the Translate TCP or UDP ports into flat range (1024-65535) check box to use the 1024 to 65535 port range as a single flat range when allocating ports. When choosing the mapped port number for a translation, the ASA uses the real source port number if it is available. However, without this option, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 1 to 511, 512 to 1023, and 1024 to 65535. To avoid running out of ports at the low ranges, configure this setting. To use the entire range of 1 to 65535, also check the Include range 1 to 1023 check box.

 
     [bookmark: pgfId-1786349] b. (Optional, Routed Mode Only) To use the interface IP address as a backup method if the other mapped source addresses are already allocated, check the Fall through to interface PAT check box. To use the IPv6 interface address, also check the Use IPv6 for interface PAT check box.

 
     [bookmark: pgfId-1786350]The destination interface IP address is used. This option is only available if you configure a specific Destination Interface.

 
     [bookmark: pgfId-1803487] 
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     [bookmark: pgfId-1786355] c. For the Match Criteria: Translated Packet > Destination Address, click the browse button and choose an existing network object, group, or interface or create a new object or group from the Browse Translated Destination Address dialog box.

 
     [bookmark: pgfId-1786356]For identity NAT for the destination address, simply use the same object or group for both the real and mapped addresses.

 
     [bookmark: pgfId-1786357]If you want to translate the destination address, then the static mapping is typically one-to-one, so the real addresses have the same quantity as the mapped addresses. You can, however, have different quantities if desired. For more information, see the “Static NAT” section. See the “Guidelines and Limitations” section for information about disallowed mapped IP addresses.

 
     [bookmark: pgfId-1786364]For static interface NAT with port translation only, choose an interface from the Browse dialog box. Be sure to also configure a service translation (see Step 7). For this option, you must configure a specific interface for the Source Interface in Step 2. See the “Static Interface NAT with Port Translation” section for more information.

 
     [bookmark: pgfId-1803495] 
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     [bookmark: pgfId-1786379]Step 7 [bookmark: 36547](Optional) Identify the translated packet port (the real destination port). For the Match Criteria: Translated Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Translated Service dialog box.

 
     [bookmark: pgfId-1786380]Dynamic NAT does not support port translation. However, because the destination translation is always static, you can perform port translation for the destination port. A service object can contain both a source and destination port, but only the destination port is used in this case. If you specify the source port, it will be ignored. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1803503] 
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     [bookmark: pgfId-1803507] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786389]Step 8 (Optional) Configure NAT options in the Options area.

 
     [bookmark: pgfId-1803515] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786394] a. Enable rule —Enables this NAT rule. The rule is enabled by default.

 
     [bookmark: pgfId-1786395] b. (For a source-only rule) Translate DNS replies that match this rule—Rewrites the DNS A record in DNS replies. Be sure DNS inspection is enabled (it is enabled by default). You cannot configure DNS modification if you configure a destination address. See the “DNS and NAT” section for more information. 

 
     [bookmark: pgfId-1786399] c. Description—Adds a description about the rule up to 200 characters in length.

 
     [bookmark: pgfId-1786400]Step 9 Click OK.

 
     [bookmark: pgfId-1786401]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1101628][bookmark: 40794]Configuring Dynamic PAT (Hide)[bookmark: marker-1127650]

 
     [bookmark: pgfId-1419857]This section describes how to configure twice NAT for dynamic PAT (hide). For dynamic PAT using a PAT pool, see the “Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool” section instead of using this section. For more information, see the “Dynamic PAT” section.

 
    
 
     
      [bookmark: pgfId-1110278]Detailed Steps

 
     [bookmark: pgfId-1786414]To configure dynamic PAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1786415]Step 1 Choose Configuration > Firewall > NAT Rules, and then click Add.

 
     [bookmark: pgfId-1786416]If you want to add this rule to section 3 after the network object rules, then click the down arrow next to Add, and choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1803762] 
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     [bookmark: pgfId-1786421]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1803770] 
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     [bookmark: pgfId-1786427]Step 2 [bookmark: 87413]Set the source and destination interfaces.

 
     [bookmark: pgfId-1786428]By default in routed mode, both interfaces are set to --Any--. In transparent firewall mode, you must set specific interfaces.

 
     [bookmark: pgfId-1786429] a. From the Match Criteria: Original Packet > Source Interface drop-down list, choose the source interface.

 
     [bookmark: pgfId-1786430] b. From the Match Criteria: Original Packet > Destination Interface drop-down list, choose the destination interface.

 
     [bookmark: pgfId-1803778] 
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     [bookmark: pgfId-1786435]Step 3 Identify the original packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the source interface network (the real source address and the mapped destination address). See the following figure for an example of the original packet vs. the translated packet.

 
     [bookmark: pgfId-1786439] 
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     [bookmark: pgfId-1786440] a. For the Match Criteria: Original Packet > Source Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Original Source Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only. The default is any.

 
     [bookmark: pgfId-1803786] 

 
      
      [image: ] 
     
 and choose an existing network object or group or create a new object or group from the Browse Original Destination Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only. 
     

 
     [bookmark: pgfId-1786449]Although the main feature of twice NAT is the inclusion of the destination IP address, the destination address is optional. If you do specify the destination address, you can configure static translation for that address or just use identity NAT for it. You might want to configure twice NAT without a destination address to take advantage of some of the other qualities of twice NAT, including the use of network object groups for real addresses, or manually ordering of rules. For more information, see the “Main Differences Between Network Object NAT and Twice NAT” section.

 
     [bookmark: pgfId-1786453]Step 4 (Optional) Identify the original packet port (the mapped destination port). For the Match Criteria: Original Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Original Service dialog box.

 
     [bookmark: pgfId-1786454]Dynamic PAT does not support additional port translation. However, because the destination translation is always static, you can perform port translation for the destination port. A service object can contain both a source and destination port, but only the destination port is used in this case. If you specify the source port, it will be ignored. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1803794] 
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     [bookmark: pgfId-1803798] 
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     [bookmark: pgfId-1786463]Step 5 Choose Dynamic PAT (Hide) from the Match Criteria: Translated Packet > Source NAT Type drop-down list.

 
     [bookmark: pgfId-1786464]This setting only applies to the source address; the destination translation is always static.
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     [bookmark: pgfId-1786465]Note To configure dynamic PAT using a PAT pool, choose Dynamic instead of Dynamic PAT (Hide), see the “Configuring Dynamic NAT or Dynamic PAT Using a PAT Pool” section.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1803806] 
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     [bookmark: pgfId-1786474]Step 6 [bookmark: 73758]Identify the translated packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the destination interface network (the mapped source address and the real destination address). You can translate between IPv4 and IPv6 if desired. See the following figure for an example of the original packet vs. the translated packet.

 
     [bookmark: pgfId-1803814] 
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     [bookmark: pgfId-1786479] a. For the Match Criteria: Translated Packet > Source Address, click the browse button and choose an existing network object or interface or create a new object from the Browse Translated Source Address dialog box. 

 
     [bookmark: pgfId-1803822] 
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     [bookmark: pgfId-1786484]If you want to use the IPv6 address of the interface, check the Use IPv6 for interface PAT check box.

 
     [bookmark: pgfId-1803830] 
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     [bookmark: pgfId-1786489] b. For the Match Criteria: Translated Packet > Destination Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Translated Destination Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only.

 
     [bookmark: pgfId-1786490]For identity NAT for the destination address, simply use the same object or group for both the real and mapped addresses.

 
     [bookmark: pgfId-1786491]If you want to translate the destination address, then the static mapping is typically one-to-one, so the real addresses have the same quantity as the mapped addresses. You can, however, have different quantities if desired. For more information, see the “Static NAT” section. See the “Guidelines and Limitations” section for information about disallowed mapped IP addresses.

 
     [bookmark: pgfId-1786498]For static interface NAT with port translation only, choose an interface from the Browse dialog box. Be sure to also configure a service translation (see Step 7). For this option, you must configure a specific interface for the Source Interface in Step 2. See the “Static Interface NAT with Port Translation” section for more information.

 
     [bookmark: pgfId-1786509]Step 7 [bookmark: 95040](Optional) Identify the translated packet port (the real destination port). For the Match Criteria: Translated Packet > Service, click the browse button and choose an existing TCP or UDP service object from the Browse Translated Service dialog box.

 
     [bookmark: pgfId-1786510]You can also create a new service object from the Browse Translated Service dialog box and use this object as the mapped destination port.

 
     [bookmark: pgfId-1786511]Dynamic PAT does not support additional port translation. However, because the destination translation is always static, you can perform port translation for the destination port. A service object can contain both a source and destination port, but only the destination port is used in this case. If you specify the source port, it will be ignored. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1803838] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1803842] 
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     [bookmark: pgfId-1786520]Step 8 (Optional) Configure NAT options in the Options area.

 
     [bookmark: pgfId-1803850] 
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     [bookmark: pgfId-1786525] a. Enable rule —Enables this NAT rule. The rule is enabled by default.

 
     [bookmark: pgfId-1786526] b. (For a source-only rule) Translate DNS replies that match this rule—Rewrites the DNS A record in DNS replies. Be sure DNS inspection is enabled (it is enabled by default). You cannot configure DNS modification if you configure a destination address. See the “DNS and NAT” section for more information. 

 
     [bookmark: pgfId-1786530] c. Description—Adds a description about the rule up to 200 characters in length.

 
     [bookmark: pgfId-1786531]Step 9 Click OK.

 
     [bookmark: pgfId-1786532]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1416253][bookmark: 62600]Configuring Static NAT or Static NAT-with-Port-Translation[bookmark: marker-1416252]

 
     [bookmark: pgfId-1416254]This section describes how to configure a static NAT rule using twice NAT. For more information about static NAT, see the “Static NAT” section.

 
    
 
     
      [bookmark: pgfId-1111895]Detailed Steps

 
     [bookmark: pgfId-1786537]To configure static NAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1786538]Step 1 Choose Configuration > Firewall > NAT Rules, and then click Add.

 
     [bookmark: pgfId-1786539]If you want to add this rule to section 3 after the network object rules, then click the down arrow next to Add, and choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1804057] 
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     [bookmark: pgfId-1786544]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1804065] 
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     [bookmark: pgfId-1786549]Step 2 Set the source and destination interfaces.

 
     [bookmark: pgfId-1786550]By default in routed mode, both interfaces are set to --Any--. In transparent firewall mode, you must set specific interfaces.

 
     [bookmark: pgfId-1786551] a. From the Match Criteria: Original Packet > Source Interface drop-down list, choose the source interface.

 
     [bookmark: pgfId-1786552] b. From the Match Criteria: Original Packet > Destination Interface drop-down list, choose the destination interface.

 
     [bookmark: pgfId-1804073] 
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     [bookmark: pgfId-1786557]Step 3 Identify the original packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the source interface network (the real source address and the mapped destination address). See the following figure for an example of the original packet vs. the translated packet.

 
     [bookmark: pgfId-1786561] 
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     [bookmark: pgfId-1786562] a. For the Match Criteria: Original Packet > Source Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Original Source Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only. The default is any, but do not use this option except for identity NAT. See the “Configuring Identity NAT” section for more information.

 
     [bookmark: pgfId-1804081] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786570] b. (Optional) For the Match Criteria: Original Packet > Destination Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Original Destination Address dialog box.

 
     [bookmark: pgfId-1786571]Although the main feature of twice NAT is the inclusion of the destination IP address, the destination address is optional. If you do specify the destination address, you can configure static translation for that address or just use identity NAT for it. You might want to configure twice NAT without a destination address to take advantage of some of the other qualities of twice NAT, including the use of network object groups for real addresses, or manually ordering of rules. For more information, see the “Main Differences Between Network Object NAT and Twice NAT” section.

 
     [bookmark: pgfId-1786575]Step 4 (Optional) Identify the original packet source or destination port (the real source port or the mapped destination port). For the Match Criteria: Original Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Original Service dialog box.

 
     [bookmark: pgfId-1786576]A service object can contain both a source and destination port. You should specify either the source or the destination port for both the real and mapped service objects. You should only specify both the source and destination ports if your application uses a fixed source port (such as some DNS servers); but fixed source ports are rare. In the rare case where you specify both the source and destination ports in the object, the original packet service object contains the real source port/mapped destination port; the translated packet service object contains the mapped source port/real destination port. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1804089] 
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     [bookmark: pgfId-1804093] 
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     [bookmark: pgfId-1786585]Step 5 Choose Static from the Match Criteria: Translated Packet > Source NAT Type drop-down list. Static is the default setting.

 
     [bookmark: pgfId-1786586]This setting only applies to the source address; the destination translation is always static.

 
     [bookmark: pgfId-1804101] 
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     [bookmark: pgfId-1786591]Step 6 Identify the translated packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the destination interface network (the mapped source address and the real destination address). You can translate between IPv4 and IPv6 if desired. See the following figure for an example of the original packet vs. the translated packet.

 
     [bookmark: pgfId-1786595] 
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     [bookmark: pgfId-1786596] a. For the Match Criteria: Translated Packet > Source Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Translated Source Address dialog box.

 
     [bookmark: pgfId-1804109] 
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     [bookmark: pgfId-1786601]For static NAT, the mapping is typically one-to-one, so the real addresses have the same quantity as the mapped addresses. You can, however, have different quantities if desired.

 
     [bookmark: pgfId-1786602]For static interface NAT with port translation, you can specify the interface instead of a network object/group for the mapped address. If you want to use the IPv6 address of the interface, check the Use IPv6 for interface PAT check box.

 
     [bookmark: pgfId-1804117] 
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     [bookmark: pgfId-1786610]For more information, see the “Static Interface NAT with Port Translation” section. See the “Guidelines and Limitations” section for information about disallowed mapped IP addresses.

 
     [bookmark: pgfId-1786614] b. For the Match Criteria: Translated Packet > Destination Address, click the browse button and choose an existing network object, group, or interface or create a new object or group from the Browse Translated Destination Address dialog box.

 
     [bookmark: pgfId-1786615]For static NAT, the mapping is typically one-to-one, so the real addresses have the same quantity as the mapped addresses. You can, however, have different quantities if desired.

 
     [bookmark: pgfId-1786616]For static interface NAT with port translation, you can specify the interface instead of a network object/group for the mapped address. For more information, see the “Static Interface NAT with Port Translation” section. See the “Guidelines and Limitations” section for information about disallowed mapped IP addresses.

 
     [bookmark: pgfId-1786623]Step 7 (Optional) Identify the translated packet source or destination port (the mapped source port or the real destination port). For the Match Criteria: Translated Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Translated Service dialog box.

 
     [bookmark: pgfId-1786624]A service object can contain both a source and destination port. You should specify either the source or the destination port for both real and mapped service objects. You should only specify both the source and destination ports if your application uses a fixed source port (such as some DNS servers); but fixed source ports are rare. In the rare case where you specify both the source and destination ports in the object, the original packet service object contains the real source port/mapped destination port; the translated packet service object contains the mapped source port/real destination port. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1804125] 
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     [bookmark: pgfId-1804129] 
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     [bookmark: pgfId-1786633]Step 8 (Optional) For NAT46, check the Use one-to-one address translation check box. For NAT46, specify one-to-one to translate the first IPv4 address to the first IPv6 address, the second to the second, and so on. Without this option, the IPv4-embedded method is used. For a one-to-one translation, you must use this keyword.

 
     [bookmark: pgfId-1786634]Step 9 (Optional) Configure NAT options in the Options area.

 
     [bookmark: pgfId-1804137] 
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     [bookmark: pgfId-1786639] a. Enable rule —Enables this NAT rule. The rule is enabled by default.

 
     [bookmark: pgfId-1786640] b. (For a source-only rule) Translate DNS replies that match this rule—Rewrites the DNS A record in DNS replies. Be sure DNS inspection is enabled (it is enabled by default). You cannot configure DNS modification if you configure a destination address. See the “DNS and NAT” section for more information.

 
     [bookmark: pgfId-1786644] c. Disable Proxy ARP on egress interface—Disables proxy ARP for incoming packets to the mapped IP addresses. See the “Mapped Addresses and Routing” section for more information.

 
     [bookmark: pgfId-1786648] d. Direction—To make the rule unidirectional, choose Unidirectional. The default is Both. Making the rule unidirectional prevents traffic from initiating connections to the real addresses.

 
     [bookmark: pgfId-1786649] e. Description—Adds a description about the rule up to 200 characters in length.

 
     [bookmark: pgfId-1786650]Step 10 Click OK.

 
     [bookmark: pgfId-1786651]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1232160][bookmark: 57073]Configuring Identity NAT[bookmark: marker-1232159]

 
     [bookmark: pgfId-1113912]This section describes how to configure an identity NAT rule using twice NAT. For more information about identity NAT, see the “Identity NAT” section.

 
    
 
     
      [bookmark: pgfId-1113919]Detailed Steps

 
     [bookmark: pgfId-1786656]To configure identity NAT, perform the following steps:

 
     
 
     [bookmark: pgfId-1786657]Step 1 Choose Configuration > Firewall > NAT Rules, and then click Add.

 
     [bookmark: pgfId-1786658]If you want to add this rule to section 3 after the network object rules, then click the down arrow next to Add, and choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1804308] 
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     [bookmark: pgfId-1786663]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1804316] 
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     [bookmark: pgfId-1786668]Step 2 Set the source and destination interfaces.

 
     [bookmark: pgfId-1786669]By default in routed mode, both interfaces are set to --Any--. In transparent firewall mode, you must set specific interfaces.

 
     [bookmark: pgfId-1786670] a. From the Match Criteria: Original Packet > Source Interface drop-down list, choose the source interface.

 
     [bookmark: pgfId-1786671] b. From the Match Criteria: Original Packet > Destination Interface drop-down list, choose the destination interface.

 
     [bookmark: pgfId-1804324] 
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     [bookmark: pgfId-1786676]Step 3 Identify the original packet addresses, either IPv4 or IPv6; namely, the packet addresses as they appear on the source interface network (the real source address and the mapped destination address). See the following figure for an example of the original packet vs. the translated packet where you perform identity NAT on the inside host but translate the outside host.

 
     [bookmark: pgfId-1786680] 
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     [bookmark: pgfId-1786681] a. For the Match Criteria: Original Packet > Source Address, click the browse button and choose an existing network object or group or create a new object or group from the Browse Original Source Address dialog box. The group cannot contain both IPv4 and IPv6 addresses; it must contain one type only. The default is any; only use this option when also setting the mapped address to any.

 
     [bookmark: pgfId-1804332] 
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 and choose an existing network object or group or create a new object or group from the Browse Original Destination Address dialog box. 
     

 
     [bookmark: pgfId-1786690]Although the main feature of twice NAT is the inclusion of the destination IP address, the destination address is optional. If you do specify the destination address, you can configure static translation for that address or just use identity NAT for it. You might want to configure twice NAT without a destination address to take advantage of some of the other qualities of twice NAT, including the use of network object groups for real addresses, or manually ordering of rules. For more information, see the “Main Differences Between Network Object NAT and Twice NAT” section.

 
     [bookmark: pgfId-1786694]Step 4 (Optional) Identify the original packet source or destination port (the real source port or the mapped destination port). For the Match Criteria: Original Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Original Service dialog box.

 
     [bookmark: pgfId-1786695]A service object can contain both a source and destination port. You should specify either the source or the destination port for both service objects. You should only specify both the source and destination ports if your application uses a fixed source port (such as some DNS servers); but fixed source ports are rare. In the rare case where you specify both the source and destination ports in the object, the original packet service object contains the real source port/mapped destination port; the translated packet service object contains the mapped source port/real destination port. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1804340] 
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     [bookmark: pgfId-1804344] 
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     [bookmark: pgfId-1786704]Step 5 Choose Static from the Match Criteria: Translated Packet > Source NAT Type drop-down list. Static is the default setting.

 
     [bookmark: pgfId-1786705]This setting only applies to the source address; the destination translation is always static. 

 
     [bookmark: pgfId-1804352] 
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     [bookmark: pgfId-1786710]Step 6 Identify the translated packet addresses; namely, the packet addresses as they appear on the destination interface network (the mapped source address and the real destination address). See the following figure for an example of the original packet vs. the translated packet where you perform identity NAT on the inside host but translate the outside host.

 
     [bookmark: pgfId-1786714] 
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     [bookmark: pgfId-1786715] a. For the Match Criteria: Translated Packet > Source Address, click the browse button and choose the same network object or group from the Browse Translated Source Address dialog box that you chose for the real source address. Use any if you specified any for the real address.

 
     [bookmark: pgfId-1786716] b. For the Match Criteria: Translated Packet > Destination Address, click the browse button and choose an existing network object, group, or interface or create a new object or group from the Browse Translated Destination Address dialog box.

 
     [bookmark: pgfId-1786717]For identity NAT for the destination address, simply use the same object or group for both the real and mapped addresses.

 
     [bookmark: pgfId-1786718]If you want to translate the destination address, then the static mapping is typically one-to-one, so the real addresses have the same quantity as the mapped addresses. You can, however, have different quantities if desired. For more information, see the “Static NAT” section. See the “Guidelines and Limitations” section for information about disallowed mapped IP addresses.

 
     [bookmark: pgfId-1786725]For static interface NAT with port translation only, choose an interface. If you specify an interface, be sure to also configure a a service translation. For more information, see the “Static Interface NAT with Port Translation” section.

 
     [bookmark: pgfId-1786729]Step 7 (Optional) Identify the translated packet source or destination port (the mapped source port or the real destination port). For the Match Criteria: Translated Packet > Service, click the browse button and choose an existing TCP or UDP service object or create a new object from the Browse Translated Service dialog box.

 
     [bookmark: pgfId-1786730]A service object can contain both a source and destination port. You should specify either the source or the destination port for both service objects. You should only specify both the source and destination ports if your application uses a fixed source port (such as some DNS servers); but fixed source ports are rare. In the rare case where you specify both the source and destination ports in the object, the original packet service object contains the real source port/mapped destination port; the translated packet service object contains the mapped source port/real destination port. NAT only supports TCP or UDP. When translating a port, be sure the protocols in the real and mapped service objects are identical (both TCP or both UDP). For identity NAT, you can use the same service object for both the real and mapped ports. The “not equal” (!=) operator is not supported.

 
     [bookmark: pgfId-1804360] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1804364] 
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     [bookmark: pgfId-1786739]Step 8 (Optional) Configure NAT options in the Options area.

 
     [bookmark: pgfId-1804372] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1786744] a. Enable rule —Enables this NAT rule. The rule is enabled by default.

 
     [bookmark: pgfId-1786745] b. Disable Proxy ARP on egress interface—Disables proxy ARP for incoming packets to the mapped IP addresses. See the “Mapped Addresses and Routing” section for more information.

 
     [bookmark: pgfId-1786750] c. (Routed mode; i[bookmark: marker-1786749]nterface(s) specified) Lookup route table to locate egress interface—Determines the egress interface using a route lookup instead of using the interface specified in the NAT command. See the “Determining the Egress Interface” section for more information.

 
     [bookmark: pgfId-1786754] d. Direction—To make the rule unidirectional, choose Unidirectional. The default is Both. Making the rule unidirectional prevents traffic from initiating connections to the real addresses. You might want to use this setting for testing purposes.

 
     [bookmark: pgfId-1786755] e. Description—Adds a description about the rule up to 200 characters in length.

 
      
      [image: ] 
     
 
     
 
     [bookmark: pgfId-1786756]Note Although the “Translate DNS replies that match this rule” check box is available if you do not configure a destination address, this option is not applicable to identity NAT because you are translating the address to itself, so the DNS reply does not need modification. See the “DNS and NAT” section for more information.

 
      
      
 
     
 
     

 
     [bookmark: pgfId-1786760]Step 9 Click OK.

 
     [bookmark: pgfId-1786761]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1496573][bookmark: 69674]Configuring Per-Session PAT Rules

 
     [bookmark: pgfId-1496574]By default, all TCP PAT traffic and all UDP DNS traffic uses per-session PAT. To use multi-session PAT for traffic, you can configure per-session PAT rules: a permit rule uses per-session PAT, and a deny rule uses multi-session PAT. For more information about per-session vs. multi-session PAT, see the “Per-Session PAT vs. Multi-Session PAT (Version 9.0(1) and Later)” section.

 
    
 
     
      [bookmark: pgfId-1496691]Detailed Steps

 
     [bookmark: pgfId-1496651]To configure a per-session PAT rule, see the “Configuring Per-Session PAT Rules” section.

 
    
 
   
 
    
     [bookmark: pgfId-1217626][bookmark: 47786]Monitoring Twice NAT[bookmark: marker-1217625]

 
    [bookmark: pgfId-1786767]The Monitoring > Properties > Connection Graphs > Xlates pane lets you view the active Network Address Translations in a graphical format. You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
    [bookmark: pgfId-1786768]Fields

 
     
     		 [bookmark: pgfId-1786769]Available Graphs—Lists the components you can graph.

 
    

 
    [bookmark: pgfId-1786773] – Xlate Utilization—Displays the ASA NAT utilization.

 
     
     		 [bookmark: pgfId-1786774]Graph Window Title—Shows the graph window name to which you want to add a graph type. To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title.

 
     		 [bookmark: pgfId-1786775]Add—Click to move the selected entries in the Available Graphs list to the Selected Graphs list.

 
     		 [bookmark: pgfId-1786776]Remove—Click to remove the selected entry from the Selected Graphs list.

 
     		 [bookmark: pgfId-1786777]Show Graphs—Click to display a new or updated graph window.

 
    

 
    [bookmark: pgfId-1786779]The Monitoring > Properties > Connection Graphs > Perfmon pane lets you view the performance information in a graphical format. You can choose up to four types of statistics to show in one graph window. You can open multiple graph windows at the same time.

 
    [bookmark: pgfId-1786780]Fields

 
     
     		 [bookmark: pgfId-1786781]Available Graphs—Lists the components you can graph.

 
    

 
    [bookmark: pgfId-1786785] – AAA Perfmon—Displays the ASA AAA performance information.

 
    [bookmark: pgfId-1786789] – Inspection Perfmon—Displays the ASA inspection performance information.

 
    [bookmark: pgfId-1786793] – Web Perfmon—Displays the ASA web performance information, including URL access and URL server requests.

 
    [bookmark: pgfId-1786797] – Connections Perfmon—Displays the ASA connections performance information.

 
    [bookmark: pgfId-1786801] – Xlate Perfmon—Displays the ASA NAT performance information.

 
     
     		 [bookmark: pgfId-1786802]Graph Window Title—Shows the graph window name to which you want to add a graph type. To use an existing window title, select one from the drop-down list. To display graphs in a new window, enter a new window title. 

 
     		 [bookmark: pgfId-1786803]Add—Click to move the selected entries in the Available Graphs list to the Selected Graphs list.

 
     		 [bookmark: pgfId-1786804]Remove—Click to remove the selected statistic type from the Selected Graphs list.

 
     		 [bookmark: pgfId-1786805]Show Graphs—Click to display a new or updated graph window.

 
    

 
   
 
    
     [bookmark: pgfId-1804407][bookmark: 85708]Configuration Examples for Twice NAT[bookmark: marker-1804406]

 
    [bookmark: pgfId-1804408]This section includes the following configuration examples:

 
     
     		 [bookmark: pgfId-1804412]Different Translation Depending on the Destination (Dynamic PAT)

 
     		 [bookmark: pgfId-1804416]Different Translation Depending on the Destination Address and Port (Dynamic PAT)

 
    

 
     
      [bookmark: pgfId-1804421][bookmark: 21449]Different Translation Depending on the Destination (Dynamic PAT)

 
     [bookmark: pgfId-1804425]Figure 5-1 shows a host on the 10.1.2.0/24 network accessing two different servers. When the host accesses the server at 209.165.201.11, the real address is translated to 209.165.202.129:port. When the host accesses the server at 209.165.200.225, the real address is translated to 209.165.202.130:port.

 
     [bookmark: pgfId-1804427]Figure 5-1 [bookmark: 11178]Twice NAT with Different Destination Addresses

 
     [bookmark: pgfId-1804431] 
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     [bookmark: pgfId-1804500]Step 1 Add a NAT rule for traffic from the inside network to DMZ network 1:

 
     [bookmark: pgfId-1804504] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1804505]By default, the NAT rule is added to the end of section 1. If you want to add a NAT rule to section 3, after the network object NAT rules, choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1804506]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1804510] 
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     [bookmark: pgfId-1804511]Step 2 Set the source and destination interfaces:

 
     [bookmark: pgfId-1804515] 
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     [bookmark: pgfId-1804516]Step 3 For the Original Source Address, click the browse button to add a new network object for the inside network in the Browse Original Source Address dialog box.

 
     [bookmark: pgfId-1804517] a. Add the new network object.

 
     [bookmark: pgfId-1804521] 
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     [bookmark: pgfId-1804522] b. Define the inside network addresses, and click OK.

 
     [bookmark: pgfId-1804526] 
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     [bookmark: pgfId-1804527] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804531] 
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     [bookmark: pgfId-1804532]Step 4 For the Original Destination Address, click the browse button to add a new network object for DMZ network 1 in the Browse Original Destination Address dialog box.

 
     [bookmark: pgfId-1804533] a. Add the new network object.

 
     [bookmark: pgfId-1804537] 
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     [bookmark: pgfId-1804538] b. Define the DMZ network 1 addresses, and click OK.

 
     [bookmark: pgfId-1804542] 
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     [bookmark: pgfId-1804543] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804547] 
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     [bookmark: pgfId-1804548]Step 5 Set the NAT Type to Dynamic PAT (Hide):

 
     [bookmark: pgfId-1804552] 
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     [bookmark: pgfId-1804553]Step 6 For the Translated Source Address, click the browse button to add a new network object for the PAT address in the Browse Translated Source Address dialog box.

 
     [bookmark: pgfId-1804554] a. Add the new network object.

 
     [bookmark: pgfId-1804558] 
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     [bookmark: pgfId-1804559] b. Define the PAT address, and click OK.

 
     [bookmark: pgfId-1804563] 
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     [bookmark: pgfId-1804564] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804568] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1804569]Step 7 For the Translated Destination Address, type the name of the Original Destination Address (DMZnetwork1) or click the browse button to choose it.

 
     [bookmark: pgfId-1804570]Because you do not want to translate the destination address, you need to configure identity NAT for it by specifying the same address for the Original and Translated destination addresses.

 
     [bookmark: pgfId-1804574] 
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     [bookmark: pgfId-1804575]Step 8 Click OK to add the rule to the NAT table.

 
     [bookmark: pgfId-1804576]Step 9 Add a NAT rule for traffic from the inside network to DMZ network 2:

 
     [bookmark: pgfId-1804580] 
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     [bookmark: pgfId-1804581]By default, the NAT rule is added to the end of section 1. If you want to add a NAT rule to section 3, after the network object NAT rules, choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1804582]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1804586] 
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     [bookmark: pgfId-1804587]Step 10 Set the source and destination interfaces:

 
     [bookmark: pgfId-1804591] 
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     [bookmark: pgfId-1804592]Step 11 For the Original Source Address, type the name of the inside network object (myInsideNetwork) or click the browse button to choose it.

 
     [bookmark: pgfId-1804593]Step 12 For the Original Destination Address, click the browse button to add a new network object for DMZ network 2 in the Browse Original Destination Address dialog box.

 
     [bookmark: pgfId-1804594] a. Add the new network object.

 
     [bookmark: pgfId-1804598] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1804599] b. Define the DMZ network 2 addresses, and click OK.

 
     [bookmark: pgfId-1804603] 
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     [bookmark: pgfId-1804604] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804608] 
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     [bookmark: pgfId-1804609]Step 13 Set the NAT Type to Dynamic PAT (Hide):

 
     [bookmark: pgfId-1804613] 
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     [bookmark: pgfId-1804614]Step 14 For the Translated Source Address, click the browse button to add a new network object for the PAT address in the Browse Translated Source Address dialog box.

 
     [bookmark: pgfId-1804615] a. Add the new network object.

 
     [bookmark: pgfId-1804619] 
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     [bookmark: pgfId-1804620] b. Define the PAT address, and click OK.

 
     [bookmark: pgfId-1804624] 
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     [bookmark: pgfId-1804625] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804629] 
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     [bookmark: pgfId-1804630]Step 15 For the Translated Destination Address, type the name of the Original Destination Address (DMZnetwork2) or click the browse button to choose it.

 
     [bookmark: pgfId-1804631]Because you do not want to translate the destination address, you need to configure identity NAT for it by specifying the same address for the Original and Translated destination addresses.

 
     [bookmark: pgfId-1804635] 
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     [bookmark: pgfId-1804636]Step 16 Click OK to add the rule to the NAT table.

 
     [bookmark: pgfId-1804637]Step 17 Click Apply.

 
     [bookmark: pgfId-1804638]

 
      
      
 
     
  
     

 
    
 
     
      [bookmark: pgfId-1804640][bookmark: 77896]Different Translation Depending on the Destination Address and Port (Dynamic PAT)

 
     [bookmark: pgfId-1804644]Figure 5-2 shows the use of source and destination ports. The host on the 10.1.2.0/24 network accesses a single host for both web services and Telnet services. When the host accesses the server for Telnet services, the real address is translated to 209.165.202.129:port. When the host accesses the same server for web services, the real address is translated to 209.165.202.130:port.

 
     [bookmark: pgfId-1804646]Figure 5-2 [bookmark: 57995]Twice NAT with Different Destination Ports

 
     [bookmark: pgfId-1804650] 
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     [bookmark: pgfId-1804729]Step 1 Add a NAT rule for traffic from the inside network to the Telnet server:

 
     [bookmark: pgfId-1804733] 
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     [bookmark: pgfId-1804734]By default, the NAT rule is added to the end of section 1. If you want to add a NAT rule to section 3, after the network object NAT rules, choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1804735]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1804739] 
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     [bookmark: pgfId-1804740]Step 2 Set the source and destination interfaces:

 
     [bookmark: pgfId-1804744] 
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     [bookmark: pgfId-1804745]Step 3 For the Original Source Address, click the browse button to add a new network object for the inside network in the Browse Original Source Address dialog box.

 
     [bookmark: pgfId-1804746] a. Add the new network object.

 
     [bookmark: pgfId-1804750] 
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     [bookmark: pgfId-1804751] b. Define the inside network addresses, and click OK.

 
     [bookmark: pgfId-1804755] 
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     [bookmark: pgfId-1804756] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804760] 
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     [bookmark: pgfId-1804761]Step 4 For the Original Destination Address, click the browse button to add a new network object for the Telnet/Web server in the Browse Original Destination Address dialog box.

 
     [bookmark: pgfId-1804762] a. Add the new network object.

 
     [bookmark: pgfId-1804766] 
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     [bookmark: pgfId-1804767] b. Define the server address, and click OK.

 
     [bookmark: pgfId-1804771] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1804772] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804776] 
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     [bookmark: pgfId-1804777]Step 5 For the Original Service, click the browse button to add a new service object for Telnet in the Browse Original Service dialog box.

 
     [bookmark: pgfId-1804778] a. Add the new service object.

 
     [bookmark: pgfId-1804782] 
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     [bookmark: pgfId-1804783] b. Define the protocol and port, and click OK.

 
     [bookmark: pgfId-1804787] 
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     [bookmark: pgfId-1804788] c. Choose the new service object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804792] 
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     [bookmark: pgfId-1804793]Step 6 Set the NAT Type to Dynamic PAT (Hide):

 
     [bookmark: pgfId-1804797] 
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     [bookmark: pgfId-1804798]Step 7 For the Translated Source Address, click the browse button to add a new network object for the PAT address in the Browse Translated Source Address dialog box.

 
     [bookmark: pgfId-1804799] a. Add the new network object.

 
     [bookmark: pgfId-1804803] 
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     [bookmark: pgfId-1804804] b. Define the PAT address, and click OK.

 
     [bookmark: pgfId-1804808] 
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     [bookmark: pgfId-1804809] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804813] 
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     [bookmark: pgfId-1804814]Step 8 For the Translated Destination Address, type the name of the Original Destination Address (TelnetWebServer) or click the browse button to choose it.

 
     [bookmark: pgfId-1804815]Because you do not want to translate the destination address, you need to configure identity NAT for it by specifying the same address for the Original and Translated destination addresses.

 
     [bookmark: pgfId-1804819] 
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     [bookmark: pgfId-1804820]Step 9 Click OK to add the rule to the NAT table.

 
     [bookmark: pgfId-1804821]Step 10 Add a NAT rule for traffic from the inside network to the web server:

 
     [bookmark: pgfId-1804825] 
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     [bookmark: pgfId-1804826]By default, the NAT rule is added to the end of section 1. If you want to add a NAT rule to section 3, after the network object NAT rules, choose Add NAT Rule After Network Object NAT Rules.

 
     [bookmark: pgfId-1804827]The Add NAT Rule dialog box appears.

 
     [bookmark: pgfId-1804831] 
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     [bookmark: pgfId-1804832]Step 11 Set the real and mapped interfaces:

 
     [bookmark: pgfId-1804836] 
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     [bookmark: pgfId-1804837]Step 12 For the Original Source Address, type the name of the inside network object (myInsideNetwork) or click the browse button to choose it.

 
     [bookmark: pgfId-1804838]Step 13 For the Original Destination Address, type the name of the Telnet/web server network object (TelnetWebServer) or click the browse button to choose it.

 
     [bookmark: pgfId-1804839]Step 14 For the Original Service, click the browse button to add a new service object for HTTP in the Browse Original Service dialog box.

 
     [bookmark: pgfId-1804840] a. Add the new service object.

 
     [bookmark: pgfId-1804844] 
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     [bookmark: pgfId-1804845] b. Define the protocol and port, and click OK.

 
     [bookmark: pgfId-1804849] 
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     [bookmark: pgfId-1804850] c. Choose the new service object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804854] 
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     [bookmark: pgfId-1804855]Step 15 Set the NAT Type to Dynamic PAT (Hide):

 
     [bookmark: pgfId-1804859] 
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     [bookmark: pgfId-1804860]Step 16 For the Translated Source Address, click the browse button to add a new network object for the PAT address in the Browse Translated Source Address dialog box.

 
     [bookmark: pgfId-1804861] a. Add the new network object.

 
     [bookmark: pgfId-1804865] 
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     [bookmark: pgfId-1804866] b. Define the PAT address, and click OK.

 
     [bookmark: pgfId-1804870] 
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     [bookmark: pgfId-1804871] c. Choose the new network object by double-clicking it. Click OK to return to the NAT configuration.

 
     [bookmark: pgfId-1804875] 
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     [bookmark: pgfId-1804876]Step 17 For the Translated Destination Address, type the name of the Original Destination Address (TelnetWebServer) or click the browse button to choose it.

 
     [bookmark: pgfId-1804877]Because you do not want to translate the destination address, you need to configure identity NAT for it by specifying the same address for the Original and Translated destination addresses.

 
     [bookmark: pgfId-1804881] 
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     [bookmark: pgfId-1804882]Step 18 Click OK to add the rule to the NAT table.

 
     [bookmark: pgfId-1804883]Step 19 Click Apply.

 
     [bookmark: pgfId-1804884]

 
      
      
 
     
  
     

 
    
 
   
 
    
     [bookmark: pgfId-1232849][bookmark: 76148][bookmark: 92503]Feature History for Twice NAT

 
    [bookmark: pgfId-1090228]Table 5-1 lists each feature change and the platform release in which it was implemented. ASDM is backwards-compatible with multiple platform releases, so the specific ASDM release in which support was added is not listed.

 
    [bookmark: pgfId-1068794] 

 
     
      
       
       [bookmark: pgfId-1434812]Table 5-1 [bookmark: 50557]Feature History for Twice NAT 

 
       
       
        
        		 
          
          [bookmark: pgfId-1434818]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1434820]Platform Releases 
         
  
        		 
          
          [bookmark: pgfId-1434822]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1434824]Twice NAT

  
        		[bookmark: pgfId-1434826]8.3(1)

  
        		[bookmark: pgfId-1434828]Twice NAT lets you identify both the source and destination address in a single rule.

 [bookmark: pgfId-1434831]We modified the following screen: Configuration > Firewall > NAT Rules.

  
       

 
        
        		[bookmark: pgfId-1434833]Identity NAT configurable proxy ARP and route lookup

  
        		[bookmark: pgfId-1434836]8.4(2)/8.5(1)

  
        		[bookmark: pgfId-1434838]In earlier releases for identity NAT, proxy ARP was disabled, and a route lookup was always used to determine the egress interface. You could not configure these settings. In 8.4(2) and later, the default behavior for identity NAT was changed to match the behavior of other static NAT configurations: proxy ARP is enabled, and the NAT configuration determines the egress interface (if specified) by default. You can leave these settings as is, or you can enable or disable them discretely. Note that you can now also disable proxy ARP for regular static NAT.

 [bookmark: pgfId-1434839]For pre-8.3 configurations, the migration of NAT exempt rules (the nat 0 access-list command) to 8.4(2) and later now includes the following keywords to disable proxy ARP and to use a route lookup: no-proxy-arp and route-lookup. The unidirectional keyword that was used for migrating to 8.3(2) and 8.4(1) is no longer used for migration. When upgrading to 8.4(2) from 8.3(1), 8.3(2), and 8.4(1), all identity NAT configurations will now include the no-proxy-arp and route-lookup keywords, to maintain existing functionality. The unidirectional keyword is removed.

 [bookmark: pgfId-1434842]We modified the following screen: Configuration > Firewall > NAT Rules > Add/Edit NAT Rule

  
       

 
        
        		[bookmark: pgfId-1434844]PAT pool and round robin address assignment

  
        		[bookmark: pgfId-1434847]8.4(2)/8.5(1)

  
        		[bookmark: pgfId-1434849]You can now specify a pool of PAT addresses instead of a single address. You can also optionally enable round-robin assignment of PAT addresses instead of first using all ports on a PAT address before using the next address in the pool. These features help prevent a large number of connections from a single PAT address from appearing to be part of a DoS attack and makes configuration of large numbers of PAT addresses easy.

 [bookmark: pgfId-1434852]We modified the following screens: Configuration > Firewall > NAT Rules > Add/Edit NAT Rule.

  
       

 
        
        		[bookmark: pgfId-1434854]Round robin PAT pool allocation uses the same IP address for existing hosts

  
        		[bookmark: pgfId-1434856]8.4(3)

  
        		[bookmark: pgfId-1434858]When using a PAT pool with round robin allocation, if a host has an existing connection, then subsequent connections from that host will use the same PAT IP address if ports are available.

 [bookmark: pgfId-1787133]We did not modify any screens.

 [bookmark: pgfId-1434862]This feature is not available in 8.5(1) or 8.6(1).

  
       

 
        
        		[bookmark: pgfId-1434864]Flat range of PAT ports for a PAT pool

  
        		[bookmark: pgfId-1434866]8.4(3)

  
        		[bookmark: pgfId-1434868]If available, the real source port number is used for the mapped port. However, if the real port is not available, by default the mapped ports are chosen from the same range of ports as the real port number: 0 to 511, 512 to 1023, and 1024 to 65535. Therefore, ports below 1024 have only a small PAT pool.

 [bookmark: pgfId-1434869]If you have a lot of traffic that uses the lower port ranges, when using a PAT pool, you can now specify a flat range of ports to be used instead of the three unequal-sized tiers: either 1024 to 65535, or 1 to 65535.

 [bookmark: pgfId-1787138]We modified the following screens: Configuration > Firewall > NAT Rules > Add/Edit NAT Rule.

 [bookmark: pgfId-1434873]This feature is not available in 8.5(1) or 8.6(1).

  
       

 
        
        		[bookmark: pgfId-1434875]Extended PAT for a PAT pool

  
        		[bookmark: pgfId-1434877]8.4(3)

  
        		[bookmark: pgfId-1434879]Each PAT IP address allows up to 65535 ports. If 65535 ports do not provide enough translations, you can now enable extended PAT for a PAT pool. Extended PAT uses 65535 ports per service, as opposed to per IP address, by including the destination address and port in the translation information.

 [bookmark: pgfId-1434882]We modified the following screens: Configuration > Firewall > NAT Rules > Add/Edit NAT Rule.

 [bookmark: pgfId-1434884]This feature is not available in 8.5(1) or 8.6(1).

  
       

 
        
        		[bookmark: pgfId-1434939]Automatic NAT rules to translate a VPN peer’s local IP address back to the peer’s real IP address

  
        		[bookmark: pgfId-1434945]8.4(3)

  
        		[bookmark: pgfId-1434902]In rare situations, you might want to use a VPN peer’s real IP address on the inside network instead of an assigned local IP address. Normally with VPN, the peer is given an assigned local IP address to access the inside network. However, you might want to translate the local IP address back to the peer’s real public IP address if, for example, your inside servers and network security is based on the peer’s real IP address.

 [bookmark: pgfId-1434903]You can enable this feature on one interface per tunnel group. Object NAT rules are dynamically added and deleted when the VPN session is established or disconnected. You can view the rules using the show nat command.

 [bookmark: pgfId-1434904]Note Because of routing issues, we do not recommend using this feature unless you know you need this feature; contact Cisco TAC to confirm feature compatibility with your network. See the following limitations:

 
          
          		 [bookmark: pgfId-1434905]Only supports Cisco IPsec and AnyConnect Client.

 
          		 [bookmark: pgfId-1434909]Return traffic to the public IP addresses must be routed back to the ASA so the NAT policy and VPN policy can be applied.

 
          		 [bookmark: pgfId-1434910]Does not support load-balancing (because of routing issues).

 
          		 [bookmark: pgfId-1434911]Does not support roaming (public IP changing).

 
         

 [bookmark: pgfId-1434913]ASDM does not support this command; enter the command using the Command Line Tool.

  
       

 
        
        		[bookmark: pgfId-1496330]NAT support for IPv6

  
        		[bookmark: pgfId-1496332]9.0(1)

  
        		[bookmark: pgfId-1496334]NAT now supports IPv6 traffic, as well as translating between IPv4 and IPv6. Translating between IPv4 and IPv6 is not supported in transparent mode.

 [bookmark: pgfId-1496336]We modified the following screen: Configuration > Firewall > NAT Rules.

  
       

 
        
        		[bookmark: pgfId-1748656]NAT support for reverse DNS lookups

  
        		[bookmark: pgfId-1748658]9.0(1)

  
        		[bookmark: pgfId-1748660]NAT now supports translation of the DNS PTR record for reverse DNS lookups when using IPv4 NAT, IPv6 NAT, and NAT64 with DNS inspection enabled for the NAT rule.

  
       

 
        
        		[bookmark: pgfId-1496358]Per-session PAT

  
        		[bookmark: pgfId-1496368]9.0(1)

  
        		[bookmark: pgfId-1496370]The per-session PAT feature improves the scalability of PAT and, for clustering, allows each member unit to own PAT connections; multi-session PAT connections have to be forwarded to and owned by the master unit. At the end of a per-session PAT session, the ASA sends a reset and immediately removes the xlate. This reset causes the end node to immediately release the connection, avoiding the TIME_WAIT state. Multi-session PAT, on the other hand, uses the PAT timeout, by default 30 seconds. For “hit-and-run” traffic, such as HTTP or HTTPS, the per-session feature can dramatically increase the connection rate supported by one address. Without the per-session feature, the maximum connection rate for one address for an IP protocol is approximately 2000 per second. With the per-session feature, the connection rate for one address for an IP protocol is 65535/average-lifetime.

 [bookmark: pgfId-1496374]By default, all TCP traffic and UDP DNS traffic use a per-session PAT xlate. For traffic that requires multi-session PAT, such as H.323, SIP, or Skinny, you can disable per-session PAT by creating a per-session deny rule.

 [bookmark: pgfId-1496376]We introduced the following screen: Configuration > Firewall > Advanced > Per-Session NAT Rules.
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     [bookmark: pgfId-1050709][bookmark: 90789]Configuring Cisco Unified Presence 
      
      
 
     
 

 
    [bookmark: pgfId-1050727]This chapter describes how to configure the adaptive security appliance for Cisco Unified Presence. 

 
    [bookmark: pgfId-1051135]This chapter includes the following sections: 

 
     
     		 [bookmark: pgfId-1054670]Information About Cisco Unified Presence

 
     		 [bookmark: pgfId-1233283]Licensing for Cisco Unified Presence

 
     		 [bookmark: pgfId-1233361]Configuring Cisco Unified Presence Proxy for SIP Federation

 
     		 [bookmark: pgfId-1233515]Feature History for Cisco Unified Presence

 
    

 
   
 
    
     [bookmark: pgfId-1146517][bookmark: 17751]Information About Cisco Unified Presence

 
    [bookmark: pgfId-1146518]This section includes the following topics: 

 
     
     		 [bookmark: pgfId-1146522]Architecture for Cisco Unified Presence for SIP Federation Deployments

 
     		 [bookmark: pgfId-1233426]Trust Relationship in the Presence Federation

 
     		 [bookmark: pgfId-1233451]Security Certificate Exchange Between Cisco UP and the Security Appliance

 
     		 [bookmark: pgfId-1256235]XMPP Federation Deployments

 
     		 [bookmark: pgfId-1256271]Configuration Requirements for XMPP Federation

 
    

 
     
      [bookmark: pgfId-1146534][bookmark: 43113]Architecture for Cisco Unified Presence for SIP Federation Deployments[bookmark: marker-1146533]

 
     [bookmark: pgfId-1146541]Figure 20-1 depicts a Cisco Unified Presence/LCS Federation scenario with the ASA as the presence federation proxy (implemented as a TLS proxy). The two entities with a TLS connection are the “Routing Proxy” (a dedicated Cisco UP) in Enterprise X and the [bookmark: marker-1146542]Microsoft Access Proxy in Enterprise Y. However, the deployment is not limited to this scenario. Any Cisco UP or Cisco UP cluster could be deployed on the left side of the ASA; the remote entity could be any server (an LCS, an OCS, or another Cisco UP). 

 
     [bookmark: pgfId-1146549]The following architecture is generic for two servers using SIP (or other ASA inspected protocols) with a TLS connection.

 
     [bookmark: pgfId-1146550]Entity X: Cisco UP/Routing Proxy in Enterprise X

 
     [bookmark: pgfId-1146551]Entity Y: Microsoft Access Proxy/Edge server for LCS/OCS in Enterprise Y

 
     [bookmark: pgfId-1146554]Figure 20-1 [bookmark: 54327]Typical Cisco Unified Presence/[bookmark: marker-1146553]LCS Federation Scenario

 
     [bookmark: pgfId-1146558] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1146563]In the above architecture, the ASA functions as a firewall, NAT, and TLS proxy, which is the recommended architecture. However, the ASA can also function as NAT and the TLS proxy alone, working with an existing firewall. 

 
     [bookmark: pgfId-1146567]Either server can initiate the TLS handshake (unlike IP Telephony or Cisco Unified Mobility, where only the clients initiate the TLS handshake). There are by-directional TLS proxy rules and configuration. Each enterprise can have an ASA as the TLS proxy.

 
     [bookmark: pgfId-1146575][bookmark: marker-1146571]In Figure 20-1, NAT or PAT can be used to hide the private address of Entity X. In this situation, static NAT or PAT must be configured for foreign server (Entity Y) initiated connections or the TLS handshake (inbound). Typically, the public port should be 5061. The following static PAT command is required for the Cisco UP that accepts inbound connections:

 
      
      [bookmark: pgfId-1278220]ciscoasa(config)# object network obj-10.0.0.2-01 
     
 
      
      [bookmark: pgfId-1278221]ciscoasa(config-network-object)# host 10.0.0.2 
     
 
      
      [bookmark: pgfId-1278222]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5061 5061 
     
 
      
      [bookmark: pgfId-1278218]  
     
 
     [bookmark: pgfId-1146581]The following static PAT must be configured for each Cisco UP that could initiate a connection (by sending SIP SUBSCRIBE) to the foreign server.

 
     [bookmark: pgfId-1146582]For Cisco UP with the address 10.0.0.2, enter the following command:

 
      
      [bookmark: pgfId-1278332]ciscoasa(config)# object network obj-10.0.0.2-02 
     
 
      
      [bookmark: pgfId-1278336]ciscoasa(config-network-object)# host 10.0.0.2 
     
 
      
      [bookmark: pgfId-1278340]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5062 5062 
     
 
      
      [bookmark: pgfId-1278359]ciscoasa(config)# object network obj-10.0.0.2-03 
     
 
      
      [bookmark: pgfId-1278363]ciscoasa(config-network-object)# host 10.0.0.2 
     
 
      
      [bookmark: pgfId-1278367]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service udp 5070 5070 
     
 
      
      [bookmark: pgfId-1278430]ciscoasa(config)# object network obj-10.0.0.2-04 
     
 
      
      [bookmark: pgfId-1278434]ciscoasa(config-network-object)# host 10.0.0.2 
     
 
      
      [bookmark: pgfId-1278438]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5060 5060 
     
 
      
      [bookmark: pgfId-1278341]  
     
 
     [bookmark: pgfId-1146596]For another Cisco UP with the address 10.0.0.3, you must use a different set of PAT ports, such as 45062 or 45070:

 
      
      [bookmark: pgfId-1278515]ciscoasa(config)# object network obj-10.0.0.3-01 
     
 
      
      [bookmark: pgfId-1278519]ciscoasa(config-network-object)# host 10.0.0.3 
     
 
      
      [bookmark: pgfId-1278523]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5061 45061 
     
 
      
      [bookmark: pgfId-1278527]ciscoasa(config)# object network obj-10.0.0.3-02 
     
 
      
      [bookmark: pgfId-1278531]ciscoasa(config-network-object)# host 10.0.0.3 
     
 
      
      [bookmark: pgfId-1278535]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5062 45062 
     
 
      
      [bookmark: pgfId-1278539]ciscoasa(config)# object network obj-10.0.0.3-03 
     
 
      
      [bookmark: pgfId-1278543]ciscoasa(config-network-object)# host 10.0.0.3 
     
 
      
      [bookmark: pgfId-1278547]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service udp 5070 5070 
     
 
      
      [bookmark: pgfId-1278760]ciscoasa(config)# object network obj-10.0.0.2-03 
     
 
      
      [bookmark: pgfId-1278764]ciscoasa(config-network-object)# host 10.0.0.2 
     
 
      
      [bookmark: pgfId-1278768]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5070 45070 
     
 
      
      [bookmark: pgfId-1278801]ciscoasa(config)# object network obj-10.0.0.3-04 
     
 
      
      [bookmark: pgfId-1278805]ciscoasa(config-network-object)# host 10.0.0.3 
     
 
      
      [bookmark: pgfId-1278809]ciscoasa(config-network-object)# nat (inside,outside) static 192.0.2.1 service tcp 5060 45060 
     
 
      
      [bookmark: pgfId-1278548]  
     
 
     [bookmark: pgfId-1146618]Dynamic NAT or PAT can be used for the rest of the outbound connections or the TLS handshake. The ASA SIP inspection engine takes care of the necessary translation (fixup).

 
      
      [bookmark: pgfId-1146625]ciscoasa(config)# object network obj-0.0.0.0-01 
     
 
      
      [bookmark: pgfId-1277609]ciscoasa(config-network-object)# subnet 0.0.0.0 0.0.0.0 
     
 
      
      [bookmark: pgfId-1277618]ciscoasa(config-network-object)# nat (inside,outside) dynamic 192.0.2.1 
     
 
      
      [bookmark: pgfId-1146630]  
     
 
     [bookmark: pgfId-1146636]Figure 20-2 illustrates an abstracted scenario with Entity X connected to Entity Y through the presence federation proxy on the ASA. The proxy is in the same administrative domain as Entity X. Entity Y could have another ASA as the proxy but this is omitted for simplicity.

 
     [bookmark: pgfId-1146642]Figure 20-2 [bookmark: 13151]Abstracted Presence Federation Proxy Scenario between Two Server Entities

 
     [bookmark: pgfId-1146646] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1146647] 

 
     [bookmark: pgfId-1146651]For the Entity X domain name to be resolved correctly when the ASA holds its credential, the ASA could be configured to perform NAT for Entity X, and the domain name is resolved as the Entity X public address for which the ASA provides proxy service.

 
     [bookmark: pgfId-1256296]For further information about configuring Cisco Unified Presence Federation for SIP Federation, see the Integration Guide for Configuring Cisco Unified Presence for Interdomain Federation.:

 
     [bookmark: pgfId-1256316]http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.html

 
    
 
     
      [bookmark: pgfId-1146661][bookmark: 81679]Trust Relationship in the Presence Federation[bookmark: marker-1146658] [bookmark: marker-1146659][bookmark: marker-1146660]

 
     [bookmark: pgfId-1146662]Within an enterprise, setting up a trust relationship is achievable by using self-signed certificates or you can set it up on an internal CA. 

 
     [bookmark: pgfId-1146663]Establishing a trust relationship cross enterprises or across administrative domains is key for federation. Cross enterprises you must use a trusted third-party CA (such as, VeriSign). The ASA obtains a certificate with the FQDN of the Cisco UP (certificate impersonation). 

 
     [bookmark: pgfId-1146667]For the TLS handshake, the two entities could validate the peer certificate via a certificate chain to trusted third-party certificate authorities. Both entities enroll with the CAs. The ASA as the TLS proxy must be trusted by both entities. The ASA is always associated with one of the enterprises. Within that enterprise (Enterprise X in Figure 20-1), the entity and the ASA could authenticate each other via a local CA, or by using self-signed certificates. 

 
     [bookmark: pgfId-1146683]To establish a trusted relationship between the ASA and the remote entity (Entity Y), the ASA can enroll with the CA on behalf of Entity X (Cisco UP). In the enrollment request, the Entity X identity (domain name) is used. 

 
     [bookmark: pgfId-1146693]Figure 20-3 shows the way to establish the trust relationship. The ASA enrolls with the third party CA by using the Cisco UP FQDN as if the ASA is the Cisco UP. 

 
     [bookmark: pgfId-1146698]Figure 20-3 [bookmark: 52814]How the Security Appliance Represents Cisco Unified Presence – Certificate Impersonate

 
     [bookmark: pgfId-1146702] 

 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1146703][bookmark: 23475]Security Certificate Exchange Between Cisco UP and the Security Appliance

 
     [bookmark: pgfId-1146706]You need to generate the keypair for the certificate (such as cup_proxy_key) used by the ASA, and configure a trustpoint to identify the self-signed certificate sent by the ASA to Cisco UP (such as cup_proxy) in the TLS handshake. 

 
     [bookmark: pgfId-1146714]For the ASA to trust the Cisco UP certificate, you need to create a trustpoint to identify the certificate from the Cisco UP (such as cert_from_cup), and specify the enrollment type as terminal to indicate that you will paste the certificate received from the Cisco UP into the terminal.

 
    
 
     
      [bookmark: pgfId-1255671][bookmark: 90846]XMPP Federation Deployments

 
     [bookmark: pgfId-1255717]Figure 20-4 provides an example of an XMPP federated network between Cisco Unified Presence enterprise deployment and an IBM Sametime enterprise deployment. TLS is optional for XMPP federation. ASA acts only as a firewall for XMPP federation; it does not provide TLS proxy functionality or PAT for XMPP federation.

 
     [bookmark: pgfId-1255729]Figure 20-4 [bookmark: 90287]Basic XMPP Federated Network between Cisco Unified Presence and IBM Sametime

 
     [bookmark: pgfId-1328818] 

 
      
      [image: ] 
     
 
     [bookmark: pgfId-1256254]There are two DNS servers within the internal Cisco Unified Presence enterprise deployment. One DNS server hosts the Cisco Unified Presence private address. The other DNS server hosts the Cisco Unified Presence public address and a DNS SRV records for SIP federation (_sipfederationtle), and XMPP federation (_xmpp-server) with Cisco Unified Presence. The DNS server that hosts the Cisco Unified Presence public address is located in the local DMZ.

 
     [bookmark: pgfId-1256343]For further information about configuring Cisco Unified Presence Federation for XMPP Federation, see the Integration Guide for Configuring Cisco Unified Presence Release 8.0 for Interdomain Federation:

 
     [bookmark: pgfId-1256345]http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list.html

 
    
 
     
      [bookmark: pgfId-1256259][bookmark: 22043]Configuration Requirements for XMPP Federation 

 
     [bookmark: pgfId-1256263]For XMPP Federation, ASA acts as a firewall only. You must open port 5269 for both incoming and outgoing XMPP federated traffic on ASA.

 
     [bookmark: pgfId-1255821]These are sample ACLs to open port 5269 on ASA.

 
     [bookmark: pgfId-1255822]Allow traffic from any address to any address on port 5269:

 
     [bookmark: pgfId-1255823]access-list ALLOW-ALL extended permit tcp any any eq 5269

 
      
      [bookmark: pgfId-1255824]  
     
 
     [bookmark: pgfId-1255825]Allow traffic from any address to any single node on port 5269:

 
     [bookmark: pgfId-1255826]access-list ALLOW-ALL extended permit tcp any host <private cup IP address> eq 5269

 
     [bookmark: pgfId-1255903] 

 
     [bookmark: pgfId-1255828]If you do not configure the ACL above, and you publish additional XMPP federation nodes in DNS, you must configure access to each of these nodes, for example:

 
      
      [bookmark: pgfId-1255829]object network obj_host_<private cup ip address> 
     
 
      
      [bookmark: pgfId-1255830]#host <private cup ip address> 
     
 
      
      [bookmark: pgfId-1255831]object network obj_host_<private cup2 ip address> 
     
 
      
      [bookmark: pgfId-1255832]#host <private cup2 ip address> 
     
 
      
      [bookmark: pgfId-1255833]object network obj_host_<public cup ip address> 
     
 
      
      [bookmark: pgfId-1255834]#host <public cup ip address> 
     
 
     [bookmark: pgfId-1255835]....

 
     [bookmark: pgfId-1255836]Configure the following NAT commands:

 
      
      [bookmark: pgfId-1255837]nat (inside,outside) source static obj_host_<private cup1 IP> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255838]obj_udp_source_eq_5269 obj_udp_source_eq_5269 
     
 
      
      [bookmark: pgfId-1255839]nat (inside,outside) source static obj_host_<private cup1 IP> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255840]obj_tcp_source_eq_5269 obj_tcp_source_eq_5269 
     
 
      
      [bookmark: pgfId-1255841]  
     
 
     [bookmark: pgfId-1255842]If you publish a single public IP address in DNS, and use arbitrary ports, configure the following:

 
     [bookmark: pgfId-1255843](This example is for two additional XMPP federation nodes) 

 
      
      [bookmark: pgfId-1255844]nat (inside,outside) source static obj_host_<private cup2 ip> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255845]obj_udp_source_eq_5269 obj_udp_source_eq_25269 
     
 
      
      [bookmark: pgfId-1255846]nat (inside,outside) source static obj_host_<private cup2 ip> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255847]obj_tcp_source_eq_5269 obj_tcp_source_eq_25269 
     
 
      
      [bookmark: pgfId-1255848]  
     
 
      
      [bookmark: pgfId-1255849]nat (inside,outside) source static obj_host_<private cup3 ip> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255850]obj_udp_source_eq_5269 obj_udp_source_eq_35269 
     
 
      
      [bookmark: pgfId-1255851]nat (inside,outside) source static obj_host_<private cup3 ip> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255852]obj_tcp_source_eq_5269 obj_tcp_source_eq_35269 
     
 
      
      [bookmark: pgfId-1255853]  
     
 
     [bookmark: pgfId-1255854]If you publish multiple public IP addresses in DNS all using port 5269, configure the following:

 
     [bookmark: pgfId-1255855](This example is for two additional XMPP federation nodes) 

 
      
      [bookmark: pgfId-1255856]nat (inside,outside) source static obj_host_<private cup2 ip> obj_host_<public cup2 IP> service 
     
 
      
      [bookmark: pgfId-1255857]obj_udp_source_eq_5269 obj_udp_source_eq_5269 
     
 
      
      [bookmark: pgfId-1255858]nat (inside,outside) source static obj_host_<private cup2 ip> obj_host_<public cup2 IP> service 
     
 
      
      [bookmark: pgfId-1255859]obj_tcp_source_eq_5269 obj_tcp_source_eq_5269 
     
 
      
      [bookmark: pgfId-1255860]  
     
 
      
      [bookmark: pgfId-1255861]nat (inside,outside) source static obj_host_<private cup3 ip> obj_host_<public cup3 IP> service 
     
 
      
      [bookmark: pgfId-1255862]obj_udp_source_eq_5269 obj_udp_source_eq_5269 
     
 
      
      [bookmark: pgfId-1255863]nat (inside,outside) source static obj_host_<private cup3 ip> obj_host_<public cup IP> service 
     
 
      
      [bookmark: pgfId-1255864]obj_tcp_source_eq_5269 obj_tcp_source_eq_5269 
     
 
    
 
   
 
    
     [bookmark: pgfId-1233143][bookmark: 97407]Licensing for Cisco Unified Presence[bookmark: marker-1233141][bookmark: marker-1233142]

 
    [bookmark: pgfId-1244516]The Cisco Unified Presence feature supported by the ASA require a Unified Communications Proxy license.

 
    [bookmark: pgfId-1244517]The following table shows the Unified Communications Proxy license details by platform:

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1382010]Note This feature is not available on No Payload Encryption models.

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1382106] 

 
     
      
       
        
        		 
          
          [bookmark: pgfId-1382013]Model 
         
  
        		 
          
          [bookmark: pgfId-1382022]License Requirement 
          1 
         
  
       

 
        
        		[bookmark: pgfId-1382024]ASA 5505

  
        		[bookmark: pgfId-1382026]Base License and Security Plus License: 2 sessions.

 [bookmark: pgfId-1382027]Optional license: 24 sessions.

  
       

 
        
        		[bookmark: pgfId-1382029]ASA 5510

  
        		[bookmark: pgfId-1382031]Base License and Security Plus License: 2 sessions.

 [bookmark: pgfId-1382032]Optional licenses: 24, 50, or 100 sessions.

  
       

 
        
        		[bookmark: pgfId-1382034]ASA 5520

  
        		[bookmark: pgfId-1382036]Base License: 2 sessions.

 [bookmark: pgfId-1382037]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382039]ASA 5540

  
        		[bookmark: pgfId-1382041]Base License: 2 sessions.

 [bookmark: pgfId-1382042]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382044]ASA 5550

  
        		[bookmark: pgfId-1382046]Base License: 2 sessions.

 [bookmark: pgfId-1382047]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382049]ASA 5580

  
        		[bookmark: pgfId-1382051]Base License: 2 sessions.

 [bookmark: pgfId-1382056]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
        
        		[bookmark: pgfId-1382058]ASA 5512-X

  
        		[bookmark: pgfId-1382060]Base License: 2 sessions.

 [bookmark: pgfId-1382061]Optional licenses: 24, 50, 100, 250, or 500 sessions.

  
       

 
        
        		[bookmark: pgfId-1382063]ASA 5515-X

  
        		[bookmark: pgfId-1382065]Base License: 2 sessions.

 [bookmark: pgfId-1382066]Optional licenses: 24, 50, 100, 250, or 500 sessions.

  
       

 
        
        		[bookmark: pgfId-1382068]ASA 5525-X

  
        		[bookmark: pgfId-1382070]Base License: 2 sessions.

 [bookmark: pgfId-1382071]Optional licenses: 24, 50, 100, 250, 500, 750, or 1000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382073]ASA 5545-X

  
        		[bookmark: pgfId-1382075]Base License: 2 sessions.

 [bookmark: pgfId-1382076]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, or 2000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382078]ASA 5555-X

  
        		[bookmark: pgfId-1382080]Base License: 2 sessions.

 [bookmark: pgfId-1382081]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382083]ASA 5585-X with SSP-10

  
        		[bookmark: pgfId-1382085]Base License: 2 sessions.

 [bookmark: pgfId-1382086]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, or 3000 sessions.

  
       

 
        
        		[bookmark: pgfId-1382088]ASA 5585-X with SSP-20, -40, or -60

  
        		[bookmark: pgfId-1382090]Base License: 2 sessions.

 [bookmark: pgfId-1382094]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
        
        		[bookmark: pgfId-1382099]ASASM

  
        		[bookmark: pgfId-1382101]Base License: 2 sessions.

 [bookmark: pgfId-1382105]Optional licenses: 24, 50, 100, 250, 500, 750, 1000, 2000, 3000, 5000, or 10,000 sessions.2

  
       

 
       
     

 
    
 
     
      
       
       		 1.[bookmark: pgfId-1382018][bookmark: 98139]The following applications use TLS proxy sessions for their connections. Each TLS proxy session used by these applications (and only these applications) is counted against the UC license limit:
- Phone Proxy
- Presence Federation Proxy
- Encrypted Voice Inspection

Other applications that use TLS proxy sessions do not count towards the UC limit, for example, Mobility Advantage Proxy (which does not require a license) and IME (which requires a separate IME license).

Some UC applications might use multiple sessions for a connection. For example, if you configure a phone with a primary and backup Cisco Unified Communications Manager, there are 2 TLS proxy connections, so 2 UC Proxy sessions are used.

You independently set the TLS proxy limit using the Configuration > Firewall > Unified Communications > TLS Proxy pane. When you apply a UC license that is higher than the default TLS proxy limit, the ASA automatically sets the TLS proxy limit to match the UC limit. The TLS proxy limit takes precedence over the UC license limit; if you set the TLS proxy limit to be less than the UC license, then you cannot use all of the sessions in your UC license.

Note: For license part numbers ending in “K8” (for example, licenses under 250 users), TLS proxy sessions are limited to 1000. For license part numbers ending in “K9” (for example, licenses 250 users or larger), the TLS proxy limit depends on the configuration, up to the model limit. K8 and K9 refer to whether the license is restricted for export: K8 is unrestricted, and K9 is restricted.

Note: If you clear the configuration, then the TLS proxy limit is set to the default for your model; if this default is lower than the UC license limit, then you see an error message to use the to raise the limit again (in ASDM, use the TLS Proxy pane). If you use failover and use File > Save Running Configuration to Standby Unit on the primary unit to force a configuration synchronization, the clear configure all command is generated on the secondary unit automatically, so you may see the warning message on the secondary unit. Because the configuration synchronization restores the TLS proxy limit set on the primary unit, you can ignore the warning.

You might also use SRTP encryption sessions for your connections:
- For K8 licenses, SRTP sessions are limited to 250.
- For K9 licenses, there is not limit.

Note: Only calls that require encryption/decryption for media are counted towards the SRTP limit; if passthrough is set for the call, even if both legs are SRTP, they do not count towards the limit.

 2.[bookmark: pgfId-1382055][bookmark: 21190]With the 10,000-session UC license, the total combined sessions can be 10,000, but the maximum number of Phone Proxy sessions is 5000.

  
      

 
      
    

 
    [bookmark: pgfId-1233229]For more information about licensing, see “Managing Feature Licenses,” in the general operations configuration guide.

 
   
 
    
     [bookmark: pgfId-1146718][bookmark: 64121]Configuring [bookmark: marker-1146716]Cisco Unified Presence Proxy for SIP Federation[bookmark: marker-1146717]

 
    [bookmark: pgfId-1233779]This section contains the following topic:

 
     
     		 [bookmark: pgfId-1234073]Task Flow for Configuring Cisco Unified Presence Federation Proxy for SIP Federation

 
    

 
     
      [bookmark: pgfId-1233796][bookmark: 95081]Task Flow for Configuring Cisco Unified Presence Federation Proxy for SIP Federation

 
     [bookmark: pgfId-1146722]To configure a Cisco Unified Presence/LCS Federation scenario with the ASA as the TLS proxy where there is a single Cisco UP that is in the local domain and self-signed certificates are used between the Cisco UP and the ASA (like the scenario shown in Figure 20-1), perform the following tasks. 

 
     [bookmark: pgfId-1374517]To configure the Cisco Unified Presence proxy by using ASDM, choose Wizards > Unified Communications Wizard from the menu. The Unified Communications Wizard opens. From the first page, select the Cisco Unified Presence Proxy option under the Business-to-Business section. 

 
     [bookmark: pgfId-1374518]The wizard automatically creates the necessary TLS proxy, then guides you through creating the Unified Presence Proxy instance, importing and installing the required certificates, and finally enables the SIP and SCCP inspection for the Presence Federation traffic automatically. 

 
     [bookmark: pgfId-1374519]The wizard guides you through four steps to create the Presence Federation Proxy:

 
     
 
     [bookmark: pgfId-1374520]Step 1 Select the Presence Federation Proxy option.

 
     [bookmark: pgfId-1374521]Step 2 Specify setting to define the proxy topology, such the IP address of the Presence Federation server.

 
     [bookmark: pgfId-1374522]Step 3 Configure the local-side certificate management, namely the certificates that are exchanged between the local Unified Presence Federation server and the ASA.

 
     [bookmark: pgfId-1374526]Step 4 Configure the remote-side certificate management, namely the certificates that are exchanged between the remote server and the ASA

 
     [bookmark: pgfId-1374530]

 
      
      
 
     
  
     

 
     [bookmark: pgfId-1374531]The wizard completes by displaying a summary of the configuration created for Presence Federation. See the Unified Communications Wizard section in this documentation for more information. 

 
     [bookmark: pgfId-1276680] 

 
    
 
   
 
    
     [bookmark: pgfId-1233508][bookmark: 64621]Feature History for Cisco Unified Presence

 
    [bookmark: pgfId-1241030]Table 20-1 lists the release history for this feature.

 
    [bookmark: pgfId-1241054] 

 
     
      
       
       [bookmark: pgfId-1241037]Table 20-1 [bookmark: 12416]Feature History for Cisco Unified Presence

 
       
       
        
        		 
          
          [bookmark: pgfId-1241043]Feature Name 
         
  
        		 
          
          [bookmark: pgfId-1241045]Releases 
         
  
        		 
          
          [bookmark: pgfId-1241047]Feature Information 
         
  
       

 
        
        		[bookmark: pgfId-1241049]Cisco Presence Federation Proxy

  
        		[bookmark: pgfId-1241051]8.0(4)

  
        		[bookmark: pgfId-1241053]The Cisco Unified Presence proxy feature was introduced.

  
       

 
        
        		[bookmark: pgfId-1251873]Cisco Presence Federation Proxy

  
        		[bookmark: pgfId-1251875]8.3(1)

  
        		[bookmark: pgfId-1251877]The Unified Communications Wizard was added to ASDM. By using the wizard, you can configure the Cisco Presence Federation Proxy.

 [bookmark: pgfId-1255904]Support for XMPP Federation was introduced.

  
       

 
       
     

 
    
 
    [bookmark: pgfId-1241055] 
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     [bookmark: pgfId-1535334][bookmark: 59098]Configuring Inspection of Database and Directory Protocols 
      
      
 
     
 

 
    [bookmark: pgfId-1535335]This chapter describes how to configure application layer protocol inspection. Inspection engines are required for services that embed IP addressing information in the user data packet or that open secondary channels on dynamically assigned ports. These protocols require the ASA to do a deep packet inspection instead of passing the packet through the fast path. As a result, inspection engines can affect overall throughput.

 
    [bookmark: pgfId-1063234]Several common inspection engines are enabled on the ASA by default, but you might need to enable others depending on your network. 

 
    [bookmark: pgfId-1564270]This chapter includes the following sections:[bookmark: marker-1350354]

 
     
     		 [bookmark: pgfId-1347223]ILS Inspection

 
     		 [bookmark: pgfId-1347721]SQL*Net Inspection

 
     		 [bookmark: pgfId-1538119]Sun RPC Inspection

 
    

 
   
 
    
     [bookmark: pgfId-1346911][bookmark: 53218]ILS Inspection

 
    [bookmark: pgfId-1430900][bookmark: marker-1430899]The ILS inspection engine provides NAT support for Microsoft NetMeeting, SiteServer, and Active Directory products that use LDAP to exchange directory information with an ILS server.

 
    [bookmark: pgfId-1430905]The ASA supports NAT for ILS, which is used to register and locate endpoints in the ILS or SiteServer Directory. PAT cannot be supported because only IP addresses are stored by an LDAP database. 

 
    [bookmark: pgfId-1430906]For search responses, when the LDAP server is located outside, NAT should be considered to allow internal peers to communicate locally while registered to external LDAP servers. For such search responses, xlates are searched first, and then DNAT entries to obtain the correct address. If both of these searches fail, then the address is not changed. For sites using NAT 0 (no NAT) and not expecting DNAT interaction, we recommend that the inspection engine be turned off to provide better performance.

 
    [bookmark: pgfId-1430910]Additional configuration may be necessary when the ILS server is located inside the ASA border. This would require a hole for outside clients to access the LDAP server on the specified port, typically TCP 389. 

 
    [bookmark: pgfId-1430911]Because ILS traffic only occurs on the secondary UDP channel, the TCP connection is disconnected after the TCP inactivity interval. By default, this interval is 60 minutes and can be adjusted using the timeout command.

 
    [bookmark: pgfId-1430912]ILS/LDAP follows a client/server model with sessions handled over a single TCP connection. Depending on the client's actions, several of these sessions may be created.

 
    [bookmark: pgfId-1430913]During connection negotiation time, a BIND PDU is sent from the client to the server. Once a successful BIND RESPONSE from the server is received, other operational messages may be exchanged (such as ADD, DEL, SEARCH, or MODIFY) to perform operations on the ILS Directory. The ADD REQUEST and SEARCH RESPONSE PDUs may contain IP addresses of NetMeeting peers, used by H.323 (SETUP and CONNECT messages) to establish the NetMeeting sessions. Microsoft NetMeeting v2.X and v3.X provides ILS support.

 
    [bookmark: pgfId-1430914]The ILS inspection performs the following operations:

 
     
     		 [bookmark: pgfId-1430915]Decodes the LDAP REQUEST/RESPONSE PDUs using the BER decode functions

 
     		 [bookmark: pgfId-1430916]Parses the LDAP packet

 
     		 [bookmark: pgfId-1430917]Extracts IP addresses

 
     		 [bookmark: pgfId-1430918]Translates IP addresses as necessary

 
     		 [bookmark: pgfId-1430919]Encodes the PDU with translated addresses using BER encode functions 

 
     		 [bookmark: pgfId-1430920]Copies the newly encoded PDU back to the TCP packet 

 
     		 [bookmark: pgfId-1430921]Performs incremental TCP checksum and sequence number adjustment

 
    

 
    [bookmark: pgfId-1430922]ILS inspection has the following limitations: 

 
     
     		 [bookmark: pgfId-1430923]Referral requests and responses are not supported

 
     		 [bookmark: pgfId-1430924]Users in multiple directories are not unified

 
     		 [bookmark: pgfId-1430925]Single users having multiple identities in multiple directories cannot be recognized by NAT

 
    

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1583330]Note Because H.225 call signalling traffic only occurs on the secondary UDP channel, the TCP connection is disconnected after the interval specified by the TCP option in the Configuration > Firewall > Advanced > Global Timeouts pane. By default, this interval is set at 60 minutes.

 
     
     
 
    
 
    

 
   
 
    
     [bookmark: pgfId-1347071]  [bookmark: 83696][bookmark: 10328]SQL*Net Inspection

 
    [bookmark: pgfId-1347072]SQL*Net inspection is enabled by default.

 
    [bookmark: pgfId-1438057]The SQL*Net protocol consists of different packet types that the ASA handles to make the data stream appear consistent to the Oracle applications on either side of the ASA. 

 
    [bookmark: pgfId-1438061]The default port assignment for SQL*Net is 1521. This is the value used by Oracle for SQL*Net, but this value does not agree with IANA port assignments for Structured Query Language (SQL). 

 
     
     [image: ] 
    
 
    
 
    [bookmark: pgfId-1538178]Note Disable SQL*Net inspection when SQL data transfer occurs on the same port as the SQL control TCP port 1521. The security appliance acts as a proxy when SQL*Net inspection is enabled and reduces the client window size from 65000 to about 16000 causing data transfer issues. 

 
     
     
 
    
 
    

 
    [bookmark: pgfId-1438065]The ASA translates all addresses and looks in the packets for all embedded ports to open for SQL*Net Version 1.

 
    [bookmark: pgfId-1438066]For SQL*Net Version 2, all DATA or REDIRECT packets that immediately follow REDIRECT packets with a zero data length will be fixed up. 

 
    [bookmark: pgfId-1438067]The packets that need fix-up contain embedded host/port addresses in the following format:

 
     
     [bookmark: pgfId-1438068](ADDRESS=(PROTOCOL=tcp)(DEV=6)(HOST=a.b.c.d)(PORT=a)) 
    
 
     
     [bookmark: pgfId-1438069]  
    
 
    [bookmark: pgfId-1438070]SQL*Net Version 2 TNSFrame types (Connect, Accept, Refuse, Resend, and Marker) will not be scanned for addresses to NAT nor will inspection open dynamic connections for any embedded ports in the packet. 

 
    [bookmark: pgfId-1438071]SQL*Net Version 2 TNSFrames, Redirect, and Data packets will be scanned for ports to open and addresses to NAT, if preceded by a REDIRECT TNSFrame type with a zero data length for the payload. When the Redirect message with data length zero passes through the ASA, a flag will be set in the connection data structure to expect the Data or Redirect message that follows to be translated and ports to be dynamically opened. If one of the TNS frames in the preceding paragraph arrive after the Redirect message, the flag will be reset.

 
    [bookmark: pgfId-1438075]The SQL*Net inspection engine will recalculate the checksum, change IP, TCP lengths, and readjust Sequence Numbers and Acknowledgment Numbers using the delta of the length of the new and old message. 

 
    [bookmark: pgfId-1438076]SQL*Net Version 1 is assumed for all other cases. TNSFrame types (Connect, Accept, Refuse, Resend, Marker, Redirect, and Data) and all packets will be scanned for ports and addresses. Addresses will be translated and port connections will be opened.

 
   
 
    
     [bookmark: pgfId-1537975][bookmark: 71592]Su[bookmark: marker-1537974]n RPC Inspection

 
    [bookmark: pgfId-1537976]This section describes Sun RPC application inspection. This section includes the following topics:

 
     
     		 [bookmark: pgfId-1537980]Sun RPC Inspection Overview

 
     		 [bookmark: pgfId-1583338]“SUNRPC Server” section

 
     		 [bookmark: pgfId-1583342]“Add/Edit SUNRPC Service” section

 
    

 
     
      [bookmark: pgfId-1537991][bookmark: 98377]Sun RPC Inspection Overvi[bookmark: marker-1537990]ew

 
     [bookmark: pgfId-1537992]The Sun RPC inspection engine enables or disables application inspection for the Sun RPC protocol. Sun RPC is used by NFS and NIS. Sun RPC services can run on any port. When a client attempts to access an Sun RPC service on a server, it must learn the port that service is running on. It does this by querying the port mapper process, usually rpcbind, on the well-known port of 111. 

 
     [bookmark: pgfId-1537993]The client sends the Sun RPC program number of the service and the port mapper process responds with the port number of the service. The client sends its Sun RPC queries to the server, specifying the port identified by the port mapper process. When the server replies, the ASA intercepts this packet and opens both embryonic TCP and UDP connections on that port.

 
     [bookmark: pgfId-1548553]The following limitations apply to Sun RPC inspection:

 
      
      		 [bookmark: pgfId-1537998][bookmark: marker-1537997]NAT or PAT of Sun RPC payload information is not supported.

 
      		 [bookmark: pgfId-1548582]Sun RPC inspection supports inbound ACLs only. Sun RPC inspection does not support outbound ACLs because the inspection engine uses dynamic ACLs instead of secondary connections. Dynamic ACLs are always added on the ingress direction and not on egress; therefore, this inspection engine does not support outbound ACLs. To view the dynamic ACLs configured for the ASA, use the  show asp table classify domain permit command. For information about the  show asp table classify domain permit command, see the CLI configuration guide.

 
     

 
    
 
     
      [bookmark: pgfId-1583349][bookmark: 60768][bookmark: 15057][bookmark: 20118]SUNRPC Server

 
     [bookmark: pgfId-1583350]Configuration > Properties > SUNRPC Server

 
     [bookmark: pgfId-1583351]The Configuration > Firewall > Advanced > SUNRPC Server pane shows which SunRPC services can traverse the ASA and their specific timeout, on a per server basis. 

 
     [bookmark: pgfId-1583355]Fields

 
      
      		 [bookmark: pgfId-1583356]Interface—Displays the interface on which the SunRPC server resides. 

 
      		 [bookmark: pgfId-1583357]IP address — Displays the IP address of the SunRPC server. 

 
      		 [bookmark: pgfId-1583358]Mask—Displays the subnet mask of the IP Address of the SunRPC server. 

 
      		 [bookmark: pgfId-1583362]Service ID — Displays the SunRPC program number, or service ID, allowed to traverse the ASA.

 
      		 [bookmark: pgfId-1583363]Protocol—Displays the SunRPC transport protocol (TCP or UDP).

 
      		 [bookmark: pgfId-1583364]Port—Displays the SunRPC protocol port range.

 
      		 [bookmark: pgfId-1583365]Timeout—Displays the idle time after which the access for the SunRPC service traffic is closed.

 
     

 
    
 
     
      [bookmark: pgfId-1583368][bookmark: 67866]Add/Edit SUNRPC Service

 
     [bookmark: pgfId-1583369]Configuration > Properties > SUNRPC Server > Add/Edit SUNRPC Service

 
     [bookmark: pgfId-1583370]The Configuration > Firewall > Advanced > SUNRPC Server > Add/Edit SUNRPC Service dialog box lets you specify what SunRPC services are allowed to traverse the ASA and their specific timeout, on a per-server basis. 

 
     [bookmark: pgfId-1583374]Fields

 
      
      		 [bookmark: pgfId-1583375]Interface Name — Specifies the interface on which the SunRPC server resides. 

 
      		 [bookmark: pgfId-1583376]Protocol—Specifies the SunRPC transport protocol (TCP or UDP).

 
      		 [bookmark: pgfId-1583377]IP address — Specifies the IP address of the SunRPC server. 

 
      		 [bookmark: pgfId-1583378]Port—Specifies the SunRPC protocol port range.

 
      		 [bookmark: pgfId-1583379]Mask—Specifies the subnet mask of the IP Address of the SunRPC server. 

 
      		 [bookmark: pgfId-1583380]Timeout—Specifies the idle time after which the access for the SunRPC service traffic is closed. Format is HH:MM:SS.

 
      		 [bookmark: pgfId-1583384]Service ID—Specifies the SunRPC program number, or service ID, allowed to traverse the ASA.

 
     

 
     [bookmark: pgfId-1438219] 
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